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Preface

Welcome to Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces. This guide describes the runtime behavior of the Spaces application. Much of this information also applies to WebCenter Portal: Framework applications, though it is written with Spaces application users in mind. (For information about WebCenter Portal: Framework applications, see Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.)

This guide provides instructions for such tasks as creating a company, team, or departmental portal; creating, populating, and managing portal pages; and working with services and portlets.




	
Note:

This guide depicts the application user interface (UI) in screenshots. Users can apply different templates to the application UI to adjust its look and feel; therefore, your view of the application may differ somewhat from the views depicted in screenshots.








Audience

This document is intended for WebCenter Portal: Spaces application users who are interested in creating online communities centering around a group project or a shared area of interest. It is also intended for business developers interested in creating enterprise mashups through runtime component wiring.


Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.


Related Documents

For more information, see the following documents in the Oracle Fusion Middleware 11g Release 1 (11.1.1.6.0) documentation set:

	
Oracle Fusion Middleware Tutorial for Oracle WebCenter Spaces Users


	
Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal


	
Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal





Conventions

We use the following text conventions in this document:


	Convention	Meaning
	boldface	Boldface type indicates user interface elements associated with an action.
	italic	Italic type indicates book titles, emphasis, placeholder variables for which you supply particular values, or terms defined in text or in the glossary.
	monospace	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.











What's New

What's new in Release 11.1.1.6? Faster performance, simplified connection interfaces, and enhanced design- and runtime experiences to name a few. Read this quick-reference page for a concise summary of what's new in this release and for pointers to more detailed information.




	
Note:

Release 11.1.1.6.0 is part of a patch set. A patch set is a single-installation collection of patches that are designed to be applied together. Patching involves copying a small collection of files over an existing installation.
A patch is normally associated with a particular version of an Oracle product and involves updating from one minor version of the product to a newer minor version of the same product (for example, from Release 11.1.1.5.0 to Release 11.1.1.6.0).

You must install the Release 11.1.1.6.0 patch set for continued support.










New Features for Release 11.1.1.6

The following table lists and describes new features in this release and provides links to more detailed information in our guides.


	Feature	Description	For More Information, See…
	Blogs	More special characters allowed in blog names:
	
When you create a blog, you can now use the following special characters in blog names in addition to letters and numbers:

? \ / : [ ] * ' " |




Enhanced commenting:

	
Commenting is now available when you view the list of blog entries and not on just the entry itself.




	
	Chapter 48, "Working with Blogs"




	Certification	More technologies certified against the WebCenter Portal application platform:
	
Microsoft Lync 2010 for IMP


	
WebSphere Application Server V7


	
Internet Explorer 9 Browser


	
Chrome Browser 10 and chrome support


	
Microsoft Office 2010 on Windows XP (32-bit)




	
	"Microsoft Lync Prerequisites," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal
	
Oracle Fusion Middleware Supported System Configurations page at http://www.oracle.com/technology/software/products/ias/files/fusion_certification.html.


	
Chapter 46, "Working with Microsoft Office and Explorer Integration"





	Discussions service	
	Discussions task flows are streamlined for greater ease of use.


	
	Chapter 60, "Working with the Discussions Service"




	Documents service	
	Follow a clearer set of steps to connect to the Oracle WebCenter Content repository.
	
Upload multiple files from your desktop by drag and drop.


	
Select and upload multiple files from the Document Explorer in one step.


	
View file upload progress.


	
Share documents more easily.


	
Perform in-context workflow approval. Approver can view and approve or reject unreleased content from the contribution mode without needing to enter edit mode.


	
Enter contribution approval mode on a page with content (either HTML or Site Studio) in a workflow. View and approve or reject unreleased content from contribution approval mode without entering edit mode.




	
	"Managing Content Repositories," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal
	
"Configuring the Documents Service Content Repository Connection," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal


	
Section 41.8.1, "Uploading Files"


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components"


	
Chapter 40, "Publishing Content Using Content Presenter"


	
Section 40.11, "Approving and Rejecting Files in Workflow"





	Events service	
	Task flows are streamlined to enhance usability. For example, users can now view links to events from both calendar and list views.


	
	Chapter 61, "Working with the Events Service"




	Notifications	
	Subscription messages now use IMIP rather than iCal for notifications about events. Consequently, event notifications are added automatically to your Outlook Calendar, without your having to open the notification attachment and add it yourself.


	
	Section 61.2.8, "Subscribing to Events"




	Pagelet Producer
	More robust Pagelet Producer:
	
Use SharePoint web parts, including those requiring Kerberos authentication.


	
Includes support for logging of HTTP traffic between a proxy and a resource.


	
Added detailed pagelet debug logging.


	
Available as a unified producer for non-standards-compliant web applications.


	
Enables consumption of gadgets from other OpenSocial containers, such as iGoogle, and exposure of them as pagelets that can be consumed by WebCenter Portal sites, other Oracle portals, or Oracle Web Content Management for WebCenter sites.


	
Enables production of OpenSocial gadgets and exposure of all existing pagelets as gadgets.




	
	"Creating Pagelets with Oracle WebCenter Portal's Pagelet Producer," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal
	
"Managing the Oracle WebCenter Portal's Pagelet Producer," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal





	Pages	
	New Administrator-level Delete Personalization option enables removal of all users' customizations from business role pages or personal pages in one step.
	
New system pages are available to support viewing and managing application metrics, space memberships, spaces, and space templates.


	
The Subscribe system page is now named Self-Service Membership to more-closely reflect its use case.




	
	Section 7.1.10, "Removing All User Customizations from a Business Role Page"
	
Section 7.2.8, "Removing All User Customizations from a Personal Page"


	
Section 7.3, "Working with System Pages"






	Performance	Accelerated performance at design time and runtime:
	
Experience faster initial page downloads.


	
Realize faster creation times for WebCenter Portal: Framework applications.




	—

	Portlet producers	
	New Enterprise 2.0 portlet producer is available for exposing task flows from WebCenter Portal services as portlets. Integrate portlets with WebCenter Portal applications, Oracle WebLogic Portal, and Oracle WebCenter Interaction.
The new Enterprise 2.0 portlet producer is certified with WebSphere, MySQL, Internet Explorer 9, and Chrome 10.




	
	"Overview of Portlets," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal
	
"Consuming E2.0 Portlet Producer Portlets," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal


	
"Configuring the E2.0 Portlet Producer," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal





	Publisher	
	Upload multiple files at once through the Publisher task flow.


	
	Section 34.3.3.3, "Sharing Files Through the Publisher Task Flow"




	Search service	
	There are more task flow parameters to limit the scope of searches. Administrators can narrow the scope of searches to specific spaces, services, and document types. They also can add attributes to the list of standard attributes returned with each search result item, and they can hide standard refiners available to users with search results.
	
You can now build portals using a navigation model that enables SES and public search engines, such as Google and Bing, to crawl and index the full text content of pages.




	
	Chapter 56, "Working with the Search Service"
	
"Building a Navigation Model for Your Portal," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal


	
"Integrating the Search Service," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal


	
"Managing Oracle SES Search in WebCenter Portal," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal





	Security	
	Support is available for an OAuth2 Provider in an OAuth client.
	
Support is available for dynamically determining group membership via integration with Oracle Entitlements Server.




	
	"Securing Your WebCenter Portal: Framework Application," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal
	
"Managing WebCenter Portal Application Security," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal


	
Chapter 20, "Understanding Security"





	Tags service	
	We have updated the edit tags user interface in the Document Explorer task flow.
	
The Tags button component and the Edit Tags task flow have a new parameter that enables developers to disable the Shared control.


	
The previously-named "Tag Cloud" task flow is now called the "Tag Selection" task flow; and a new standalone Tag Cloud task flow is available in the design-time catalog.




	
	Chapter 57, "Working with the Tags Service"
	
"Integrating the Tags Service," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal





	Wikis	
	Access wiki creation features with greater ease: Use a New Wiki Document button in a Documents service task flow or in the wiki itself.
	
Experience improved performance in loading wikis, launching the wiki editor, and saving changes to your wiki.




	
	Section 47.4.1, "Creating a Wiki Document Using the New Wiki Document Action"















Part I


Getting Started with WebCenter Portal: Spaces

Part I of the User's Guide introduces WebCenter Portal: Spaces portals and communities and describes the features that are readily available to assist you in their creation.

Part I includes the following chapters:

	
Chapter 1, "Introducing WebCenter Portal: Spaces"


	
Chapter 2, "Leveraging Content Management"


	
Chapter 3, "Leveraging Social and Collaborative Services"


	
Chapter 4, "Accessing Spaces Administration Pages"










1 Introducing WebCenter Portal: Spaces

Welcome to Oracle WebCenter Portal: Spaces! The Spaces application furnishes all the tools you require to rapidly create portals, communities, and social networking sites capable of accommodating thousands of users and encompassing diverse populations with differing language requirements.

This chapter defines a few useful terms and provides a sampling of some of the types of portals, communities, and social networking sites you can create using the Spaces application. It also supplies a table of references to details about the resources discussed in this chapter.

This chapter includes the following sections:

	
Section 1.1, "Understanding Portals, Communities, and Social Networking Sites"


	
Section 1.2, "Planning Your Portals, Communities, and Social Networking Sites"


	
Section 1.3, "Where to Look for More Information"







	
Learn More:

For more detailed information about Spaces application features that support social networking, see Chapter 3, "Leveraging Social and Collaborative Services."









1.1 Understanding Portals, Communities, and Social Networking Sites

Your decision about what to build naturally falls in line with what you plan to accomplish. This section assists you in that decision by clarifying what is meant by portals, communities, and social networking sites. It includes the following subsections:

	
Section 1.1.1, "What Is a Portal?"


	
Section 1.1.2, "What Is a Community?"


	
Section 1.1.3, "What Is a Social Networking Site?"






1.1.1 What Is a Portal?

A portal is a web destination that presents information and resources that are diverse in location, technology, and derivation, through a single point of entry. Content and technology that originate from widespread sources appear to your users as a cohesive set of information and services that are easily available from one location.

For example, in a Spaces portal, a user can look at all the Worklist items coming from their organization's eBusiness Suite, the detailed customer information coming from a CRM suite, and the latest sales figure charts coming from a Business Intelligence tool. Despite these multiple sources, to your user, all of this content is available in one place and appears to be coming from a single source.

Portals offer solutions for aggregating disparate content into one or multiple libraries. Authorized users are provided with controls for uploading and managing such content so that consumers have easy access to what appears to be a cohesive body of knowledge available in one location.

Applications from multiple sources can appear as a family of applications, once again, available from a single source: the portal. Through their portals, users have a go-to destination for all of their self-service applications, such as expense and time reporting, no matter the multiple points of origin. The portal provides an efficient delivery platform that saves users time and effort and creates a positive experience between the enterprise and its employees.

Also contributing to that positive experience, portals deliver personalization capabilities. Personalization provides a means of leveraging the information in a user's Profile to tailor the user's experience of the portal. For example, Mary the manager logs in and sees department-wide results information and links to reporting applications, while Sal the salesman logs in and sees his reports on his own results and links to leads.

Spaces portals provide two arenas for the presentation of resources and information: a space and the Home space.

Spaces are typically used to create portals and communities that are scoped to a specific audience, for example, a specific division, department, project, or community. Subspaces, which are hierarchically lower than their parent spaces, enable you to set up, for example, a divisional portal (the space), with child portals for each subdivision (subspaces).

You can use the Home space to address all of your company's employees. In addition to its inherent broad appeal—by default, the Home space is accessible to all authenticated users—the Home space can be set up to provide a personal experience for each user. For example, each user can have a dashboard of all the information they require for starting their daily work. That is, a portal just for them.






1.1.2 What Is a Community?

A community is a group of individuals gathered together to accomplish a common goal or share a common interest. Communities can be used in conjunction with portals as well as social networks—they are not mutually exclusive.

In the Spaces application, the idea of community is realized in spaces that are designed to support collaboration among space members.

Spaces support the formation and collaboration of project teams and communities of interest. They provide a dedicated and readily accessible area for relevant services, pages, and content.

Spaces support the assembly of team and community members through direct addition, invitation, and self-registration. They support internal hierarchies through the assignment of permissions and roles, which offer differing levels of access to space features and resources. They support structural hierarchies through the creation of subspaces, the management of which can be delegated to subteams or different lines of business (LOBs).

Spaces bring people together in a virtual environment for ongoing interaction and information sharing.




	
Learn More:

For more detailed information about spaces, see Part XI, "Planning and Building a Space".












1.1.3 What Is a Social Networking Site?

Any number of social networking sites, such as Facebook and MySpace, may have already given you a strong understanding of web-based social networking. Users forge connections to each other. That connection provides a free pass to information about each other's activities and the resulting content. That is, links to sites of interest, photo slide shows, and statements reflecting the connection's current state of mind. A connection between two people increases exponentially as each user's connections introduce themselves through recommendations and by commenting and liking streamed posts and links.

The Spaces application does not reimagine social networking, but rather focuses it on the more purposeful environment of your enterprise. Users with common interests and goals can forge connections that expose them to content of interest and enable them to follow and benefit from each other's activities.

You can provide social networking capabilities in both portals and communities—they are not mutually exclusive.

The Home space is an excellent venue for setting up a site that is focussed on social networking. The Home space is accessible to all employees, provided they are logged in, making it the best foundation for a broad social network.

In the Home space, social networking capability is greatly enhanced by the People Connections service. This service provides features for forging connections to other users, viewing and customizing personal profile information, viewing the activities of other users, and sharing such activities, as well as files and links, with a broader audience.

The Home space may include a set of pages that are created by application administrators and pushed to targeted users. Such pages are called business role pages. Use business role pages to provide content of interest to a specific group of users, such as the Sales team, and prevent uninterested users from seeing it.

Provided they are enabled to do so, users may have the ability to create and customize pages in the Home space for their eyes only. They can add or upload content of interest specifically to them, and share that content with whomever they choose.




	
Learn More:

For more detailed information about Spaces application social network capabilities, see Chapter 3, "Leveraging Social and Collaborative Services."














1.2 Planning Your Portals, Communities, and Social Networking Sites

This section provides an overview of the types of portals, communities, and social networking sites you can build and describes the resources and roles you would need to build them. It also supplies pointers to relevant information in the rest of the guide. This section includes the following subsections:

	
Section 1.2.1, "Planning a Home Space to Serve All Users"


	
Section 1.2.2, "Planning Multiple Portals Serving All LOBs"


	
Section 1.2.3, "Planning a Department Portal"


	
Section 1.2.4, "Planning a Department Portal with Diverse Collaborative Teams and Communities"


	
Section 1.2.5, "Planning a Division Portal with Teams, Communities, and Social Networks"






1.2.1 Planning a Home Space to Serve All Users


Requirement

Build a highly controlled, secure, and performant corporate portal that focusses on social networking among thousands of users.


Who Will It Serve?

This corporate portal is intended to serve all internal users. Its purpose is to disseminate information about corporate events, accomplishments, and initiatives, and to provide access to corporate resources, such as Payroll, Human Resources, Purchasing, and the like. Additionally, it is meant to enable employees to connect with each other and share all kinds of information about themselves and their endeavors.

To a limited degree, this portal confines access to targeted information to specific audiences. For example, only the sales people see a link to the Sales Manager's blog; only the decision makers see a link to the Purchasing page. All users see the link to the page From the CEO. In some ways, this is like the corporate "family" site. It might replace and improve upon the traditional corporate newsletter as well as provide links to resources that are available to all employees.


What Type of Access Should Users Have?

A small group of people are responsible for creating and managing pages and managing the site's look and feel. Authenticated users—that is, users who are logged in—can interact with social networking services, such as People Connections and they can set personal Preferences. But they cannot create Personal pages nor perform page management tasks.


What Types of Resources Should Be in Place?

Portal builders require access to site resources, such as application Skins and Navigation, Page templates and Styles, and so on. They require access to application Administration pages where they can specify which resources to apply. They are also likely interested in analyzing Usage and Performance Metrics to determine heavy traffic areas and possible bottlenecks. The Analytics service will be useful to this end.

Within the small set of users who are tasked with building and maintaining the portal, a subset of users should be given the responsibility of establishing and maintaining site Security through the creation and assignment of application roles and permissions.

Such a portal could be based on the Home space, with its application-wide scope. Basing the portal on a Home space would simplify and centralize site resource management, and call for a security model with a fairly simple structure.

This type of portal will also make use of a few System pages and Business role pages. System pages are prebuilt utility pages, such as the application login page, that authorized users can customize in terms of content and look and feel. Business role pages are pages targeted to a specific business role, such as a salesperson, an HR representative, a Corporate Trainer, and so on. Each business role page is pushed into the Home space views of its target audience.

The Documents service, which encompasses files, Blogs, and Wikis, should be made available to the limited set of users who are allowed to provide content to the portal. The People Connections service should be made available to all authenticated users to enable them to interact with social networking features, such as Profile, Activity Stream, and Connections.

Connections and Activity Stream are a particularly essential components of a robust social network. Connections enable users to create the network. Within the Home space, Activity Stream streams the activities of each user's connections. Within a space, it streams the activities of each space member.

Liking, Commenting, and Sharing should be available on the Activity Stream to enable users to interact with each other by expressing approval for and commenting on streamed activities and for sharing objects of interest and useful links.

The Activity Graph service will also be of great use. It provides a means of enlarging your users' spheres of interest in the Spaces application by offering recommendations for new connections, suitable items, and relevant spaces.

You might include the Polls service to provide a means of administering simple polls to the entire corporate population regarding issues, ideas, and events of interest to all.






1.2.2 Planning Multiple Portals Serving All LOBs


Requirement

Build highly controlled, secure, and performant portals to be accessed by thousands of users. Each portal is targeted to a particular LOB. All portals must have consistent branding that is controlled by a limited set of users. The content of each portal is maintained by specific roles within each LOB.


Who Will It Serve?

This portal provides a central landing place for all LOBs with the intention of directing each LOB to its own dedicated portal. Each LOB portal in turn offers information of specific interest to that LOB as well as access to External Applications aimed at the LOB's reporting requirements (status, expense, results, and the like).


What Type of Access Should Users Have?

All users have access to the central landing page, which might be the Home space or the parent space in a set of Hierarchical spaces. There are advantages to both. For example, basing the landing page on the Home space simplifies the security model, at least for that page. Basing it on a parent space in a hierarchy enables you to take advantage of inheritance of configuration settings, simplifying the task of maintaining consistent branding across portals.

Security would likely be set up in a steeper hierarchy than discussed with the first model. Like the first model, a small set of users control the site resources for all portals, such as the templates, skins, and Resource Catalogs (these provide access to the components one adds to a page). In this multiportal environment, however, management of each portal is delegated to a few people from each LOB, each controlling access, Content management, and maintenance of their specific sites.


What Types of Resources Should Be in Place?

In addition to portal resources, such as Skins, Navigation, Page templates, and the like, LOB portals would find Announcements useful for spreading information of interest to a like-minded group, immediately or on a selected date and time. The Activity Graph service would be useful for providing recommendations for pages and documents of interest based on an analysis of user activity. The Instant Messaging and Presence service (IMP), would keep department members alert to each others' online status and provide options for contacting another user on the spot. Finally, the Worklist service would be useful for keeping track of workflow notifications and messages channeled through the User Messaging Service (UMS).






1.2.3 Planning a Department Portal


Requirement

Enable each department to build multiple portals in one environment. These portals serve as information-sharing vehicles for their users.


Who Will It Serve?

Each of these portals serves a very large department with internal subdivisions. For example, imagine a large manufacturing corporation that is primarily divided into Marketing, Sales, Accounting, Manufacturing, Fulfillment, and Distribution. Every employee will likely fit under one of those umbrellas, but under a given umbrella there are subdivisions. Accounting will have at least two: one for Accounts Payable and one for Accounts Receivable. They may also handle Budgets, Collections, and Payroll.

Each of these departments has a portal based on a parent space, such as the Accounting home page, with a hierarchy of subspaces, each purposed with addressing the information requirements of a given subdivision (Accounts Receivable, Accounts Payable, and so on).


What Type of Access Should Users Have?

All department members have access to the parent space, which is the landing page for the department. Limited access is provided for subspaces: users belonging to a subdivision have access to the subdivision's dedicated subspace in a group of Hierarchical spaces.

A limited set of users would manage the portal's Resources. These users might control resources for all portals, or there might be a like group of resource managers for each portal, and possibly for each child portal. A limited set of users would handle Content management. It is likely that each portal would have its own team handling Security, and subdivisions may also handle their own.


What Types of Resources Should Be in Place?

Portal Resources and Security are useful to all portals. Hierarchical spaces are of particular importance in this model. They provide a number of relevant benefits, such as grouping of related content under a given space; logical navigation for drilling down into required areas for more information; delegated administration; inherited membership; and a flexible security model, where you can configure access to be identical to the parent space, or allow it to be completely overridden by the administrator of the subspace.

Services in support of information dissemination, such as the Documents service, the Announcements service, and the Activity Graph service, will likely come into play. Polls scoped to the department or to a subdivision could also prove useful.






1.2.4 Planning a Department Portal with Diverse Collaborative Teams and Communities


Requirement

Enable a controlled set of users to build portal sites, while the rest of the users can build team sites.


Who Will It Serve?

This is another type of departmental portal that provides information of interest to all department members as well as access to spaces serving project-focussed teams and communities of interest.


What Type of Access Should Users Have?

All users have view access to the department portal. A small set of users serve as portal administrators, who control the look and feel and content of the main site and delegate responsibilities to managers of teams and communities. A larger pool of users are assigned space moderator roles, to enable them to manage and monitor their team and community spaces.


What Types of Resources Should Be in Place?

In addition to all the portal-building Resources mentioned in other models, many collaborative tools will come into play. For example, the Lists service will provide useful features for creating things like project issues lists, milestones lists, and lists of deliverables. Project teams can leverage the Events service for meeting planning and event scheduling. The Members task flow is vital for keeping track of who is on the team or who belongs to the community. Team member can use Wikis for preserving meeting agendas and note taking. Teams and Communities can use Blogs for evangelizing technologies and ideas and disseminating expertise.

It will serve the users of this portal to provide the Links service to enable the creation of connections between relevant application objects, for example, from a list of project milestones to project design documents and functional specifications. Naturally, the Documents service will frequently come into play.

The Discussions service will be essential for enabling the creation and capture of discussions among colleagues. This is particularly useful for retaining a record of such exchanges and for enabling a widely distributed workforce to participate in their own time.






1.2.5 Planning a Division Portal with Teams, Communities, and Social Networks


Requirement

Enable a controlled set of users to build portal sites, while the rest of the users can build team sites and socialize using social networking features.


Who Will It Serve?

This portal will be lively and robust and serve a corporate division with a fairly open policy toward internal collaboration and communication.


What Type of Access Should Users Have?

All users will have access to the Home space and may have permission to create their own Personal pages in their view of it. Users belonging to a subdivision will have access to the portal dedicated to that subdivision. A small team of users will control division and subdivision home pages, including Security and Content management, but control of team sites and communities will be delegated to key members of those teams and communities. All users should have permission to update People Connections data, which would enable them to make connections, update their profiles, view the activities of their connections, and share resources.


What Types of Resources Should Be in Place?

Resources for building portals and managing portal Security should be readily available to the small set of users administering the division and subdivision portals. Resources for securing spaces, creating space pages, and managing services within the space scope should be available to users tasked with such activities. A collaborative environment, either teams or communities, will benefit tremendously from the availability of the Discussions service. The Search service will be useful for searching a large set of portals with a large volume of content. The Tags service will enable users to add their own personally meaningful search terms and share them with other users. Naturally, you will want Content management, People Connections, Lists, and Events services to support the capture, delivery, and preservation of schedules, ideas, goals, and headway. Polls will be useful across the board for taking stock. The Links service will enable users to provide links from one location to another or from a location to an application object, such as a document, a note, an event, and so on.

Connections and Activity Stream are a particularly essential components of a robust social network. Connections enable users to create the network. Within a Home space, Activity Stream streams the activities of each user's connections. Within a space, it streams the activities of each space member.

Liking, Commenting, and Sharing should be available on the Activity Stream to enable users to interact with each other by expressing approval for and commenting on streamed activities and for sharing objects of interest and useful links.

The Activity Graph service will also be of great use. It provides a means of enlarging your users' spheres of interest in the Spaces application by offering recommendations for new connections, suitable items, and relevant spaces.

You might include the Polls service to provide a means of administering simple polls to the entire corporate population regarding issues, ideas, and events of interest to all.

To assist your users in keeping informed of changes to their connections and to spaces and application objects of interest, you can incorporate Notifications into these portals. This gives users a means of subscribing to be notified over selected messaging channels when their subscribed objects change.








1.3 Where to Look for More Information

Table 1-1 provides links to information about all the resources discussed in this chapter.


Table 1-1 Where to Look for More Information

	Resource	Where to Look
	
Activity Graph

	
Section 58, "Working with the Activity Graph Service"



	
Administration pages

	
	
Part II, "Designing a Portal or Community"


	
Section 4, "Accessing Spaces Administration Pages"






	
Analytics

	
Chapter 55, "Analyzing Usage and Performance Metrics"



	
Announcements

	
Chapter 59, "Working with the Announcements Service"



	
Blogs

	
Chapter 48, "Working with Blogs"



	
Business role pages

	
Section 7.1, "Working with Business Role Pages"



	
Content management

	
Part X, "Working with Content"



	
Discussions

	
Chapter 60, "Working with the Discussions Service"



	
Documents

	
Chapter 39, "Introduction to Adding and Managing Content"



	
Events

	
Chapter 61, "Working with the Events Service"



	
External Applications

	
Chapter 6, "Configuring Services, Portlet Producers, and External Applications"



	
Hierarchical spaces

	
Chapter 54, "Working with a Space Hierarchy"



	
Home space


	
	
Section 7.2, "Working with Personal Pages"


	
Chapter 29, "Exploring the Home Space"






	
Instant Messaging and Presence

	
Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)"



	
Languages

	
Chapter 24, "Working with Multilanguage Portals"



	
Liking, Commenting, and Sharing

	
Chapter 34, "Liking, Commenting On, and Sharing Objects"



	
Links

	
Chapter 63, "Working with the Links Service"



	
Lists

	
Chapter 64, "Working with the Lists Service"



	
Members task flow

	
Section 52.4, "Working with the Members Task Flow"



	
Navigation

	
Chapter 11, "Working with Navigation"



	
Notifications

	
Chapter 36, "Setting Up Your Personal Subscriptions and Notifications"



	
Page templates

	
	
Chapter 12, "Working with Page Templates"


	
Chapter 13, "Adding Spaces Components to Your Templates"






	
People Connections

	
Connections


	
Activity Stream


	
Profile


	
Message Board


	
Feedback




	
	
Chapter 30, "Managing Your Profile"


	
Chapter 31, "Creating Your Social Network"


	
Chapter 32, "Tracking Your Connections' Activities"


	
Chapter 33, "Posting and Managing Messages and Feedback"


	
Section 34.3.3.1, "What You Should Know About the Publisher Task Flow"






	
Personal pages

	
	
Section 7.2, "Working with Personal Pages"


	
Chapter 38, "Creating and Managing Personal Pages"






	
Polls

	
Chapter 67, "Working with the Polls Service"



	
Preferences

	
Chapter 35, "Setting Your Personal Preferences"



	
Resource Catalogs

	
Chapter 16, "Working with Resource Catalogs"



	
Resources

	
Chapter 10, "Working with the Resources that Compose a Portal or Community"



	
Search

	
Chapter 56, "Working with the Search Service"



	
Security

	
Part VI, "Securing Your Portal"



	
Skins

	
Chapter 14, "Working with Skins"



	
Styles

	
Chapter 15, "Working with Page Styles"



	
System pages

	
Section 7.3, "Working with System Pages"



	
Tags

	
Chapter 57, "Working with the Tags Service"



	
Usage and Performance Metrics

	
Chapter 55, "Analyzing Usage and Performance Metrics"



	
Wikis

	
Chapter 47, "Working with Wiki Documents"



	
Worklist

	
Chapter 70, "Working with the Worklist Service"
















2 Leveraging Content Management

The Documents service and the flexibility of Content Presenter are available to you in WebCenter Portal: Spaces for including content from connected content repositories.

In addition to selecting and displaying content on a page in a Spaces application, you can define workflows on content in a space, create and edit content at runtime, collaborate on documents, integrate with Microsoft Office and Explorer, and add wikis and blogs to an application.

This chapter provides a survey of content management features and offers pointers to the information that will assist you in implementing them. It includes the following sections:

	
Section 2.1, "What Is Content Management?"


	
Section 2.2, "Leveraging Content Management Features"





Audience

This chapter is intended for Spaces users interested in leveraging content management features to manage and provide access to content in connected content repositories using Spaces.



2.1 What Is Content Management?

Content management refers to the functionality available in Spaces to add content from one or more connected content repositories to an application, enabling application developers and end users with appropriate permissions to manipulate and display that content in a variety of ways:

	
Content Presenter. Enables you to precisely customize the selection and presentation of content in a Spaces application. The Content Presenter task flow is available only when the connected content repository is Content Server and your Spaces administrator has completed the prerequisite configuration. With Content Presenter, you can select an Oracle Site Studio file, a single item of content, multiple content items, query for content, or select content based on the results of a Personalization Conductor scenario, and then select a template to render the content on a page in a Spaces application. Content Presenter has no dependency on the Documents service for adding or managing the content it displays.




	
Learn More:

For more information about Content Presenter, see Chapter 40, "Publishing Content Using Content Presenter."








	
Documents service task flows. Provide a variety of formats to display folders and files, including wikis and blogs, on a page in a Spaces application. You can choose the task flows appropriate for your application to provide features for accessing, adding, and managing folders and files; configuring and viewing file and folder properties; and searching file and folder content in the connected content repositories. The Documents service task flows enable you to manage content in Content Server, Oracle Portal, or SharePoint, and your Spaces administrator has completed the prerequisite configuration.




	
Learn More:

For information about the Documents Service task flows available in Spaces, and the unique characteristics of each task flow, see Section 41.1, "What You Should Know About the Documents Service Task Flows."








	
Document components. Display an individual file on a page as a linked document, an inline preview, or an image.




	
Learn More:

For information about document components you can add to a page in a Spaces application, see Section 41.2, "What You Should Know About Document Components."








	
Wikis. Enable multiple users to create and edit content that is relevant, useful, and up-to-date.




	
Learn More:

For information about including wikis in a Spaces application, see Chapter 47, "Working with Wiki Documents."








	
Blogs. Enable users to create, edit, and manage personal blogs to record experiences and opinions, and group related blog posts.




	
Learn More:

For information about including blogs in a Spaces application, see Chapter 48, "Working with Blogs."















2.2 Leveraging Content Management Features

Content is the backbone of any Web-based project. This section provides a summary of the full scope of content management functionality available to you in Spaces. It includes the following subsections:

	
Section 2.2.1, "Displaying Individual Files"


	
Section 2.2.2, "Displaying and Managing the Contents of a Folder"


	
Section 2.2.3, "Adding and Managing Document Workflow"


	
Section 2.2.4, "Creating and Managing Content at Runtime"


	
Section 2.2.5, "Collaborating on Documents"


	
Section 2.2.6, "Integrating with Microsoft Office and Explorer"


	
Section 2.2.7, "Adding and Managing Wikis"


	
Section 2.2.8, "Adding and Managing Blogs"






2.2.1 Displaying Individual Files

You can add dynamic previews of individual files using document components (link, image, and inline frame), a Content Presenter task flow, or a Documents service task flow:

	
Document components:

	
A Link displays the name of a selected file as a link, which you can click to display the file content in its native application.


	
An Inline Frame displays the content of a selected file as a preview.


	
An Image displays a selected file as an image.





	
A Content Presenter task flow displays a selected file in the default display template for its file type. For information about the out-of-the-box display templates, see Section 40.5, "Selecting a Display Template."


	
Documents service task flows:

	
A Document Viewer task flow displays a preview of a file, or file properties for files that do not support a preview.


	
A Document Mini Properties task flow displays the Basic properties of a file in a read-only view.


	
A Document Properties task flow displays both Basic and Advanced properties of a file, along with an Edit button to allow you to modify property values.


	
A Document Version History task flow displays a list of versions of a file, allowing for deletion of a selected version.










	
Learn More:

For more information, see:
	
Chapter 40, "Publishing Content Using Content Presenter"


	
Section 41.1, "What You Should Know About the Documents Service Task Flows"


	
Section 41.2, "What You Should Know About Document Components"


	
Section 41.3, "Adding a Selected Folder or File to a Page"


	
Section 41.4, "Adding a Documents Service Task Flow to a Page"


	
Section 41.5, "Understanding the Documents Service Task Flow Menus and Actions"

















2.2.2 Displaying and Managing the Contents of a Folder

The content task flows available in Spaces provide flexibility in how content displays on a page. You can display and manage the contents of a folder using the Content Presenter task flow to precisely customize the selection and presentation of content, or you can use one of the Documents service task flows that suits your purposes for presenting content management functionality:

	
A Content Presenter task flow displays a selected folder in the default display template for folder content: List View. For information about the out-of-the-box display templates, see Section 40.5, "Selecting a Display Template" (Table 40-2 and Table 40-3).


	
Documents service task flows:

	
A Document Explorer task flow displays folders and files in two panes, combining the functionality of the Document Navigator and Folder Viewer task flows. It provides in-place previewing and editing, and robust management capabilities.


	
A Document List Viewer task flow displays folders and files in a single pane as a flat listing. It provides preview and editing in a separate window, and some management capabilities.


	
A Document Manager task flow displays folders and files as specified by its Layout property: Explorer, Table, or Tree Table.


	
A Document Navigator task flow displays a simple listing of folders and files in a single pane, providing expand/collapse on folders to show the full hierarchy.


	
A Folder Viewer task flow displays the contents of a folder in a single pane as a flat listing, providing in-place preview and editing, and robust management capabilities.


	
A Recent Documents task flow displays a list of the files most recently created or modified in the current folder.










	
Learn More:

For more information, see:
	
Chapter 40, "Publishing Content Using Content Presenter"


	
Section 41.1, "What You Should Know About the Documents Service Task Flows"


	
Section 41.3, "Adding a Selected Folder or File to a Page"


	
Section 41.4, "Adding a Documents Service Task Flow to a Page"


	
Section 41.5, "Understanding the Documents Service Task Flow Menus and Actions"

















2.2.3 Adding and Managing Document Workflow

From Spaces, you can define workflows on space folders that reside in Content Server. When a folder is assigned a workflow, any file (including wiki documents and blog posts) checked in or uploaded to that folder must be approved or rejected by one or more assigned approvers. Documents service task flows, Content Presenter, and the Oracle Workflow Queue portlet from the Universal Content Management Portlet Suite provide access to the workflow-enabled content. Additionally, Content Presenter provides support for managing workflow when it displays a file that is assigned a workflow.




	
Learn More:

Chapter 43, "Working with Workflow-Enabled Content"












2.2.4 Creating and Managing Content at Runtime

End users of a Spaces application can create and manage content at runtime using the content task flows:

	
The Documents service task flows offer capabilities to create, open, edit, delete, copy, rename, move, share, search, view, or manage information about folders and files in the connected content repository, including wikis and blogs.


	
In a Content Presenter task flow, end users can edit wiki documents, HTML files, or Site Studio files in-context, and create new Site Studio files in the connected Content Server content repository.







	
Learn More:

Chapter 44, "Creating and Managing Content at Runtime"












2.2.5 Collaborating on Documents

Almost every enterprise spends a lot of time collaborating on documents. This includes joint authoring, sharing, reviewing, approving, editing, and so on. Spaces provides several ways to collaborate on documents, both during the development of a document, or when a document is available to all users of a Spaces application. You can collaborate on documents using the features available through the Documents service, through workflows, and using Oracle AutoVue.




	
Learn More:

Chapter 45, "Collaborating on Documents"












2.2.6 Integrating with Microsoft Office and Explorer

Spaces integrates with Microsoft Office and Windows Explorer to provide you with flexibility in managing files in a space when the content repository is Content Server:

	
Using the Microsoft Office shared document management functionality, you can work with Word, PowerPoint, or Excel files in any space, including the Home space, from the task pane in the Office application.


	
If you use Microsoft Office Outlook as your mail client, you can interact with your favorite spaces right from the familiar Outlook interface. From Outlook, you can access your activities, manage your mail attachments, and track the discussions in your spaces. Additionally, you can create a new space based on a mail message to kick-start a collaborative project, automatically adding the mail recipients as space members, email attachments as documents, and email content as discussion topics.


	
In Windows Explorer, you can manage the folders and files in a space. To use this functionality, you create a network place in Windows Explorer for the space documents







	
Learn More:

Chapter 46, "Working with Microsoft Office and Explorer Integration"












2.2.7 Adding and Managing Wikis

Spaces enables you to create wiki documents, which multiple users can use to create and edit content that is relevant, useful, and up-to-date.




	
Learn More:

	Chapter 47, "Working with Wiki Documents"















2.2.8 Adding and Managing Blogs

Spaces enables you to create and manage personal blogs to record experiences and opinions, and group related blog posts.




	
Learn More:

	Chapter 48, "Working with Blogs"




















3 Leveraging Social and Collaborative Services

Today no modern portal deployment is complete without some notion of social interaction—whether it's blogs or discussions or integration with social media (such as Facebook or Twitter). Your CEO may blog about product direction, your product teams may initiate discussions in online forums. All of these activities, once exotic, are now fundamental. Support must be available for virtual team sites, where representatives from different lines of business, or even different enterprises—such as your partners and suppliers—can communicate, collaborate, and socialize on a specific business task.

A powerful and easy-to-master array of services and features are available in WebCenter Portal: Spaces for integrating social networking application-wide and enhancing communication and collaboration within communities and teams.

This chapter provides a survey of these features and offers pointers to the information that will assist you in implementing them.

This chapter includes the following sections:

	
Section 3.1, "What Is Social Networking?"


	
Section 3.2, "What Are Communities and Teams?"


	
Section 3.3, "Leveraging Social and Collaborative Features and Services"





Audience

This chapter is intended for application administrators interested in leveraging social networking features to build highly collaborative communities using WebCenter Portal: Spaces.



3.1 What Is Social Networking?

Any number of social networking sites, such as Facebook and MySpace, may have already given you a strong understanding of web-based social networking. Users forge connections to each other. That connection provides a free pass to information about each other's activities and the resulting content. That is, links to sites of interest, photo slide shows, and statements reflecting the connection's current state of mind. A connection between two people increases exponentially as each user's connections introduce themselves through recommendations and by commenting and liking streamed posts and links.

The Spaces application does not reimagine social networking, but rather focuses it on the more purposeful environment of your enterprise. Users with common interests and goals can forge connections that expose them to content of interest and enable them to follow and benefit from each other's activities.


Example: John and Mary

For example, Mary is the Manager of Financial Applications at myCorp. She meets John, the myCorp Director of Accounting, at a company-sponsored seminar. They forge a connection. In his Activity Stream, John sees that Mary has published a white paper on Financial Application Futures. John reads it and realizes that one of the innovations Mary hypothesizes would introduce valuable efficiencies into his own operation. John gives the paper a thumbs up (through Liking) and comments on the streamed item. In his comment, John tells Mary that he sees an immediate and beneficial application of her ideas and suggests a meeting. Out of that meeting, the Internal Accounting Refit community is born.






3.2 What Are Communities and Teams?

Communities and teams are groups of people gathered together to accomplish a common goal or share a common interest. In the Spaces application, the idea of communities and teams is realized in a space.

Spaces support the formation and collaboration of project teams and communities of interest by providing a dedicated and readily accessible area for relevant services, pages, and content. Spaces support the assembly of team and community members through direct addition, invitation, and self-registration. They support internal hierarchies through the assignment of permissions and roles, which offer differing levels of access to space features and resources. They support structural hierarchies through the creation of subspaces, the management of which can be delegated to subteams or different lines of business (LOBs).

Spaces bring people together in a virtual environment for ongoing interaction and information sharing. In essence, spaces enable the formation and support of social networks.


Example: Internal Accounting Refit Project

For example, the space that John created, Internal Accounting Refit, supports the goal of customizing, deploying, and training for the department's accounting software. John assembles a team from many LOBs to accomplish this goal. He starts by creating space roles and assigning them various levels of permissions. He adds team members to the space and assigns them roles according to the level of access he intends each to have. He creates a shallow space hierarchy by adding a subspace for each LOB. Then he delegates the moderation of each subspace to each LOB lead. He enables and configures useful services to ensure all members have access to the collaborative tools that will promote project success.




	
Learn More:

For information about creating and managing spaces and subspaces, see Part XI, "Planning and Building a Space".












3.3 Leveraging Social and Collaborative Features and Services

A significant number of space services and features support the formation and success of project- and interest-based communities.

This section offers an overview of these services and features and provides a view of them through the lens of accomplishing John's goals. It includes the following subsections:

	
Section 3.3.1, "What Are Social Networking and Collaborative Services?"


	
Section 3.3.2, "Leveraging People Connections"


	
Section 3.3.3, "Leveraging Announcements, Discussions, and Events"


	
Section 3.3.4, "Leveraging Liking, Commenting, and Sharing"


	
Section 3.3.5, "Leveraging Instant Messaging and Presence"


	
Section 3.3.6, "Leveraging Polls and Activity Graph"


	
Section 3.3.7, "Leveraging Tagging and Linking"


	
Section 3.3.8, "Leveraging Wikis and Blogs"


	
Section 3.3.9, "Leveraging Lists"






3.3.1 What Are Social Networking and Collaborative Services?

Table 3-1 provides a high-level overview of the social and collaborative services and features offered through the Spaces application. Each description includes a link to more information.


Table 3-1 Social and Collaborative Services and Features in WebCenter Portal: Spaces

	Service or Feature	Description
	
Activity Graph service

	
Provides recommendations of people with whom a user may be interested in connecting, based on existing connections and shared interaction with objects in the application. It also directs users to spaces or items that may be of interest, based on similar interactions with those spaces or items the user is currently viewing. For more information, see Chapter 58, "Working with the Activity Graph Service."


	
Announcements service

	
Provides a quick, convenient way to create and distribute messages to all users within the current space, instantly or at a specified date and time. For more information, see Chapter 59, "Working with the Announcements Service."


	
Blogs

	
An offering of the Documents service, blogs provide a means of producing an online, open diary for recording thoughts and opinions that, in a business setting, evangelize technologies, share expertise, and ruminate about future directions. For more information, see Chapter 48, "Working with Blogs."


	
Commenting

	
Provides a means of adding your thoughts, opinions, and questions directly to a given application object. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Discussions service

	
Provides text-based discussions with other members of a space. Use Discussions service task flows to create forums, post questions, and search for answers. Discussion forums additionally provide the means to preserve and revisit discussions. For more information, see Chapter 60, "Working with the Discussions Service."


	
Events service

	
Provides calendars for scheduling meetings, appointments, and any other type of occasion on view for all members of a given space. Also provides users with a means of viewing their personal Microsoft Exchange calendar within the Home space and overlaying space calendars on top of the personal calendar to view a full schedule in a single calendar. For more information, see Chapter 61, "Working with the Events Service."


	
Instant Messaging and Presence service

	
Provides a means of viewing the presence status of other authenticated users and offers on-the-spot access to instant messaging and mail. Additionally, when users travel, they can connect to a 3rd-party network presence service, such as Yahoo! Messenger. For more information, see Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)."


	
Liking

	
Provides an accumulative rating system that enables you to see at a glance which objects are viewed most favorably by you and other users. A counter keeps track of the number of users who like the object. In a group of objects, you can determine the most favored by its number of likes. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Links service

	
Provides a means of explicitly associating two objects with each other through easy-access reference points, called links. The Links service assists with setting up these links from one application object to another. For example, you can associate a project plan document with a list of project issues. When users access the list, they can also immediately access the project plan by clicking a link that appears on the list. The Links service also provides a quick way to create new objects when establishing a link. For more information, see Chapter 63, "Working with the Links Service."


	
Lists service

	
Provides tools for creating, publishing, and managing lists. Users can create lists from Excel spreadsheets, from prebuilt templates, or from scratch. As lists are developed, they become available in the Resource Catalog. Users can add lists from the catalog to any page in the space in which they were created. For more information, see Chapter 64, "Working with the Lists Service."


	
People Connections service

	
The real workhorse of social networking in WebCenter Portal: Spaces, the People Connections service, provides a means of forging connections between users and, as a result, partaking of the fruits of this service's other features. View connections' activities in the Activity Stream. Access their Profiles. Send them messages with attachments, such as files and links through the Publisher task flow or Message Board. Post remarks on their efforts through Feedback. For more information, see:

	
Chapter 30, "Managing Your Profile"


	
Chapter 31, "Creating Your Social Network"


	
Chapter 32, "Tracking Your Connections' Activities"


	
Chapter 33, "Posting and Managing Messages and Feedback"


	
Section 34.3.3.1, "What You Should Know About the Publisher Task Flow"





	
Polls service

	
Provides tools for creating, administering, and taking online polls. Use polls to survey your audience, check their recall of important information, gather feedback on the efficacy of presentations—that is, solicit responses on anything that promotes the excellence of the team. For more information, see Chapter 67, "Working with the Polls Service."


	
Sharing

	
Provides on-the-spot distribution of items, files, and URLs of particular interest to a selected audience. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Tags service

	
Provides a means of associating a personally meaningful search term to an application object, making that object easy to find through search results. Classifying an item with a tag enables you to gather disparate items into a cohesive body of knowledge and share that knowledge with others. For more information, see Chapter 57, "Working with the Tags Service."


	
Wikis

	
Epitomizes the concepts of community and collaboration by allowing all authorized community members to contribute their information to the greater body of knowledge through the wiki. For more information, see Chapter 47, "Working with Wiki Documents."












3.3.2 Leveraging People Connections

The People Connections service delivers core social networking functionality through such features as Connections, Activity Stream, Profile, Message Board, and Feedback.

Connections furnishes the means of forging connections between Spaces application users. When one user connects to another, it opens each to a flow of information about the other's activities and provides instant access to other social networking capabilities through People Connections.

Activity Stream provides a continuous stream of information about your own and other users' activities. The files your connections upload are available in the stream as are status messages, links, and notifications about specific types of activities. Such activities can include:

	
John is now connected to Mary


	
Mary revised the document financialApplicationFutures.docx


	
John created the space Internal Accounting Refit


	
And so on




Each streamed item that alludes to an object provides a link to that object, and, in some cases, a preview of the object itself.

Profile offers a window onto information about a given connection, most of which comes from your company's LDAP identity store. A user's connections can view authorized sections of his Profile for such useful information as his contact numbers, his department, his job title, his management chain, and the like.

Message Board and Feedback supply features for entering and viewing messages between connections or posting feedback.

You can configure an instance of the Activity Stream task flow to stream only those activities occurring in the scope of a named space.


Example: Internal Accounting Refit Project

And that's what John has done. He recognizes the value of streaming the activities of his community. After all, seeing the streamed item about Mary's white paper is what got him started on this project. He appreciates that all members of the Internal Accounting Refit space will automatically see the space-related activities of other members in the scoped Activity Stream. To alert team members to this feature, he places an Announcement task flow on the space home page and posts the following announcement:


Keep your eye on the stream! You can view all space-related activities streaming from every space member. Watch for activities, documents, and links of interest.





	
Learn More:

For information about the many features of the People Connections service, see:
	
Chapter 30, "Managing Your Profile"


	
Chapter 31, "Creating Your Social Network"


	
Chapter 32, "Tracking Your Connections' Activities"


	
Chapter 33, "Posting and Managing Messages and Feedback"

















3.3.3 Leveraging Announcements, Discussions, and Events

The Announcements service offers a means of broadcasting an announcement instantly or at a time you choose to all members of a given space.

While announcements offer effective one-way communication, the Discussions service supplies an excellent instrument for creating and managing discussion forums and topics. Members can add to the community's knowledge base by asking or answering questions that are relevant to the current effort and preserving that information for others to reference or challenge. Discussions provides a virtual meeting place where community members can deliberate, discuss, and collaborate, each according to the restrictions of his or her own schedule.

But when common scheduling times can be orchestrated, meetings and events can be arranged easily through the Events service. The Events service provides a community calendar, which can be used to schedule and post project and community meetings and events. The Events calendar is scoped to its current space, preventing clutter and noise from other teams.


Example: Internal Accounting Refit Project

John schedules a meeting with all LOB leads using the Events calendar. His agenda is to open the question of the best technology to use going forward. He captures meeting minutes on the LOB Meeting Minutes wiki that he created for this purpose in his team's space. The LOBs are able to narrow the list down to three brands. John opens the discussion to the entire team through the Technology discussion forum. On this, John solicits the teams' opinions on each potential selection. Alok provides insight into one of the options, pointing out a weakness the LOB leads hadn't considered. Fifteen team members express agreement with Alok's reservations by liking his topic reply. This seems to be a very strong endorsement for omitting this option and selecting from the other two.




	
Learn More:

For information about Announcements, Discussions, and Events, see:
	
Chapter 59, "Working with the Announcements Service"


	
Chapter 60, "Working with the Discussions Service"


	
Chapter 61, "Working with the Events Service"

















3.3.4 Leveraging Liking, Commenting, and Sharing

Liking, commenting, and sharing are integrated with many WebCenter Portal services right out of the box. They furnish the opportunity to team members to share, comment on, and express approval for a document, a topic reply, a streamed item, a wiki, and a blog.

You can view Liking as a type of quick poll that captures and returns on-the-spot information about the relative popularity of an application object.

You can find more verbose opinions about application objects in Comments. Wherever there is liking, there is commenting, where users can enter suggestions, opinions, questions, and other relevant communication directly on the objects to which they apply.

Sharing provides a means of sending links to content of interest to a selected audience.


Example: Internal Accounting Refit Project

John shares frequently. As information that is relevant to his project streams in from his other space memberships, he shares slide presentations, charts, technology updates, and the like with his project team. Today, he sent a paper to Alok that supports Alok's reservations about the candidate technology.

Alok is pleased that John shared this document. He expresses his liking for the document, clicks the link to read the document, and then clicks John's name on the document to open an instant dialog with him.




	
Learn More:

For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."












3.3.5 Leveraging Instant Messaging and Presence

The Instant Messaging and Presence (IMP) service provides a means of observing the presence status of other authenticated users (for online, busy, away, and offline) and delivers interaction options, such as instant messaging and mail.

When Instant Messaging and Presence is available, every application object that publishes a user name with a presence icon becomes a conduit to different forms of instant communication. Any WebCenter service that exposes a user name can integrate with the IMP service. Such services include Discussions, Documents, Mail, and Lists.


Example: Internal Accounting Refit Project

Once Alok has read the document, he notices that John's presence status is Online. He clicks John's name on the technology article, and a context menu opens with options for contacting John. Alok selects instant messaging and starts a conversation. Here is a portion of this exchange:


...
ALOK: will do! :) ... btw, is there a code name for this project?
JOHN: no, why?
ALOK: internal acct'ng refit is a mouthful.
JOHN: true
ALOK: how about AIR
JOHN: accounting internal refit? i like air, but
ALOK: right ... was discussing with team
ALOK: popular selections were zip, freeway, and bux (air was mine)
JOHN: if team is interested, let's run a poll
JOHN: i'm ok with any of these
ALOK: i'm on it!





	
Learn More:

For more information about IMP, see Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)."












3.3.6 Leveraging Polls and Activity Graph

The Polls service provides tools for creating, administering, and taking online polls. Use polls to survey your audience, check their recall of important information, gather feedback on the efficacy of presentations—that is, solicit responses on anything that promotes the excellence of the team.

While polls solicit the opinions of others, the Activity Graph service gathers intelligence behind the scene to generate opinions tailored to individual users.

The Activity Graph service provides a means of enlarging a user's sphere of interest in the Spaces application by offering recommendations for new connections, suitable items, and relevant spaces. It does this by tracking each user's application activity in an activity graph. The Activity Graph engine provides a central repository for actions that are collected by enterprise applications. Activities are analyzed and returned as specific recommendations for individual users. The Activity Graph service is also extensible by allowing customers to track their custom events and recommend their own business objects.


Example: Bux Project

In John's research on his technology options, he accesses a number of articles that discuss the pros and cons of each selection. As a result, he finds recommendations for similar articles in his personal view of an Activity Graph task flow. He tags one of these bux so he can easily find it in a Search, and adds a link to it from the page he creates to make his case to Finance and Operations.




	
Learn More:

For more information about Polls and Activity Graph, see:
	
Chapter 67, "Working with the Polls Service"


	
Chapter 58, "Working with the Activity Graph Service"

















3.3.7 Leveraging Tagging and Linking

Tagging provides a means of associating a personally meaningful search term to an application object, making that object easy to find through search results. Your tags provide a higher level of relevance from search results for yourself and others by augmenting results with additional items that you or others have tagged. Classifying an item with a tag enables you to gather disparate items into a cohesive body of knowledge and share that knowledge with others through the Tag Center or a shared saved search.

Linking offers a mechanism for creating a form of ad hoc navigation by enabling you to associate a relevant and useful object with the current context. For example, you can link from a page to a document, a list to a discussion, a list row to an event. You can link to an existing object or create the target object on the spot.


Example: Bux Project

John and Mary have collaborated on a list of project milestones. The first planned milestone is the project kickoff meeting. From the milestones list, Mary creates a link to an Event using the Link to New option. A dialog opens where she is able to schedule a date and time for the meeting and provide location details. The entire team can refresh their memories anytime they need to by clicking the link on the milestones list or referring to the community calendar.

Mary creates the blog buxBashBlog, to track the progress of the upcoming kickoff and generate buzz. Eighty percent of the team expresses approval or comments on different blog posts. The air is buzzing with excited anticipation.




	
Learn More:

For more information about tagging and linking, see:
	
Chapter 57, "Working with the Tags Service"


	
Chapter 63, "Working with the Links Service"

















3.3.8 Leveraging Wikis and Blogs

In the Spaces application, the creation of blogs and wikis has been vastly simplified. All you must do is select a blog or wiki option from the Create Page dialog. No additional configuration is required.

Blogs provide an excellent medium for evangelizing selected technologies, logistical changes, and any other organizational shifts you are eager to promote.

Wikis epitomize the concepts of community and collaboration by enabling all authorized community members to contribute their information to a greater body of knowledge. Wiki pages are web pages that offer in-place editing using HTML or a simple mark-up language. Users with sufficient permissions on a wiki page can add, revise, or delete content.

Wikipedia is a prime example of a wiki (http://www.wikipedia.com). Users from all over the world collaborate to create and edit Wikipedia pages, resulting in a rich, dynamic knowledge base for everyone's benefit.


Example: Bux Project

Alok and his team have mapped out the logical flow of information for the upcoming customization. They collaborate on a wiki that captures each decision point in a table and describes the conditions that influence the options available at each point. Tina, the training LOB lead, adds a column to the table and makes suggestions or asks questions about each point.

Alok, IMs Doris with a link to the wiki, asking her to address Tina's questions. Doris edits the wiki, as requested. Then she IMs Tina, suggesting a follow-up meeting to ensure all is clear. Tina schedules the meeting on the community Calendar. She navigates to the Training Project Issues list in her LOB's subspace and checks off the issues, clarify project details and identify subject matter expert, entering Doris' name in the list's Contacts column. She adds a link to the scheduled meeting on the second row.




	
Learn More:

For more information about wikis and blogs, see:
	
Chapter 47, "Working with Wiki Documents"


	
Chapter 48, "Working with Blogs"

















3.3.9 Leveraging Lists

Lists are useful for so many space activities, such as tracking issues, capturing project milestones, publishing project assignments, and much more. The lists you create in the Spaces application can be widely varied in their complexity. For example, you can start with a list of team members, and then include columns for contact information, project role, and links to relevant documents, such as any plans or proposals associated with a listed team member.


Example: Bux Project

Finance and Operations approves John's project and provides a budget. John posts an announcement and IMs Mary to congratulate her on their mutual success. John creates a master list of project milestones, and links each row of high-level milestones to the pages containing each LOB's milestones. The project Activity Stream flows with information about new pages, new documents, new connections, and the like. Discussion topics proliferate. Polls are launched. Everyone is communicating, collaborating, and generating informed, consistent content.




	
Learn More:

For more information about Lists, see Chapter 64, "Working with the Lists Service."

















4 Accessing Spaces Administration Pages

This chapter describes how to access administration pages for the Spaces application. It contains the following sections.

	
Section 4.1, "Accessing the Spaces Administration Page"


	
Section 4.2, "Performing Actions From Spaces Administration Pages"





Audience

The content of this chapter is intended for Spaces administrators. Users granted the Spaces Administrator role or a custom role that grants one of the following permissions:

	
Application-Manage All


	
Application-Manage Configuration


	
Application-Manage Membership






4.1 Accessing the Spaces Administration Page

Many administrative actions are performed from Spaces Administration pages. Once you log in as the application administrator, there are a couple of ways to access this page:

	
Click the Administration link.


	
Use the following URL to navigate to the Spaces Administration page:


http://host:port/webcenter/spaces/admin







	
See Also:

Appendix A, "Spaces User Interface URLs."












4.2 Performing Actions From Spaces Administration Pages

In the Spaces application, there are five main Administration pages: Spaces, Pages, Resources, Security, and Configuration (Figure 4-1):


Figure 4-1 Spaces Administration Pages

[image: Spaces Administration pages]



Table 4-1 describes the actions administrators can perform from Administration pages and lists the permission required to perform them.


Table 4-1 Spaces Administration Pages

	Page	Description	Required Permission
	
Spaces

	
Spaces


	
Space Templates




	
Use this page to manage spaces and space templates. For more information, see:

Performing Administrative Tasks for All Spaces

Performing Administrative Tasks for All Space Templates

Importing and Exporting Spaces and Space Templates

	
Manage All

or

Manage Configuration


	
Pages

	
Business Role Pages


	
Personal Pages


	
System Pages




	
Use this page to manage business role pages, personal pages, and system pages in the Spaces application. For more information, see:

Working with Business Role Pages

Working with Personal Pages

Working with System Pages

	
Manage All

or

Manage Configuration


	
Resources

	
Use this page to manage application-level resources for the Spaces application, such as page templates, skins, and task flows. For more information, see:

Working with the Resources that Compose a Portal or Community

	
Manage All

or

Manage Configuration


	
Security

	
Users and Groups


	
Roles




	
Use this page to manage users and roles. For more information, see:

Managing Users, Roles, and Permissions

	
Manage All

or

Manage Members


	
Configuration

	
General


	
Services




	
Use the Configuration page to customize the Spaces application. For example, you can specify a default language, application name, and so on. For more information, see:

Configuring Global Defaults

Use the Services page to set application-wide properties for discussion forums, announcements, mail, and people connection components such as activity streams, personal profiles, connections, messages boards, and feedback. For more information, see:

Configuring Discussion Forum Options for the Spaces Application

Configuring Send Mail Notifications for the Spaces Application

Configuring People Connections Defaults for the Spaces Application

You can also register portlet producers and external applications from the Services tab:

Registering Portlet Producers

Registering External Applications

	
Manage All

or

Manage Configuration















Part II


Designing a Portal or Community

Part II of the User's Guide steps you through the process of setting up global defaults for your portal or community. It also describes how to customize task flows so that all instances are affected or just those instances appearing within a given space.

Part II includes the following chapters:

	
Chapter 5, "Configuring Global Defaults"


	
Chapter 6, "Configuring Services, Portlet Producers, and External Applications"


	
Chapter 7, "Preparing Your Initial Portal Pages "


	
Chapter 8, "Customizing Task Flows at Runtime"










5 Configuring Global Defaults

Out-of-the-box, the Spaces application is pre-configured with various default settings which administrators may customize to suit their audience. This chapter includes the following sections:

	
Section 5.1, "Customizing the Name and Logo"


	
Section 5.2, "Customizing Copyright and Privacy Statements"


	
Section 5.3, "Customizing the Online Help Link"


	
Section 5.4, "Choosing a Default Display Language"


	
Section 5.5, "Customizing the Language List"


	
Section 5.6, "Choosing a Default Start (or Landing) Page"


	
Section 5.7, "Choosing a Default Skin"


	
Section 5.8, "Choosing a Default Page Template"


	
Section 5.9, "Choosing a Default Navigation"


	
Section 5.10, "Choosing Default Resource Catalogs"


	
Section 5.11, "Choosing a Default Look and Feel for New Pages"


	
Section 5.12, "Enabling and Disabling Access to the Home Space"


	
Section 5.13, "Setting up Defaults for WebCenter Services"




See also, Chapter 6, "Configuring Services, Portlet Producers, and External Applications"


Audience

This chapter is intended for Spaces administrators with the Manage Configuration permissions.



5.1 Customizing the Name and Logo

Out-of-the-box, the application name WebCenter Portal: Spaces appears in the banner (see Figure 5-1). If you prefer, you can change the name to better suit your target audience. For example, you might want to display your company name here or the name of a department within your company.

Another way to apply corporate branding to the Spaces application, is to add your company logo (Figure 5-1). If your company's logo is not suitable, any graphic that brings visual interest can be used.

The logo you specify will resize according to the application's page template. If you want to adjust the logo size, you can modify the page template. See, Section 12.3, "Editing a Page Template".

If you want, you can reference your application name and logo in EL expressions. For details, see Section B.4.2, "EL Expressions Relevant to the Spaces Application".


Figure 5-1 Naming Your Spaces Application and Changing the Logo

[image: Naming your Spaces application and changing the logo]



To change the name or logo for the Spaces application:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration, then General.


	
In the Application Name field, enter the new name.

Alphanumeric characters are allowed and also spaces, underscores (_) and dashes (-). For example, Finance Department - My Corporation.


	
Click Browse for the Application Logo property.

The File Upload dialog box opens.


	
Select the logo you want to use.

The logo is uploaded to the application's image directory (/webcenter/images) and the new logo immediately appears in the top left corner of the application banner.


	
Click Apply.









5.2 Customizing Copyright and Privacy Statements

Administrators can customize or hide copyright and privacy statements for the Spaces application:

	
Copyright - Displays a copyright statement for the entire application.


	
Privacy URL - Links to a document that contains a privacy policy for the entire application.




In the default page template, the copyright and privacy URL appear in the application's page footer (Figure 5-2).

If you want, you can reference your copyright message and privacy document in EL expressions. For details, see Section B.4.2, "EL Expressions Relevant to the Spaces Application".


Figure 5-2 Customizing the Copyright and Privacy URL

[image: Customizing the Copyright and Privacy URL]



Individual spaces may provide their own copyright and privacy statements. For details, see Section 51.4.14, "Customizing the Copyright Statement and Privacy URL".

To customize or hide copyright and privacy statements:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration, then General.


	
Do one of the following:

	
Select Display Page Footer to display copyright and privacy information.


	
Deselect Display Page Footer to hide the page footer. No legal notices or other information that normally displays in the footer will display.





	
If you have chosen to display legal notices:

	
Copyright - Enter a suitable copyright statement for the Spaces application. If no copyright information is required, leave this field blank.


	
Privacy URL - Specify the location of the application's privacy policy. Enter a fully qualified URL. If no privacy information is required, leave this field blank.





	
Click Apply to save.









5.3 Customizing the Online Help Link

Online help for Spaces displays when you click the Help link for the application (see Figure 5-3). Out-of-the-box, this Help link opens Oracle's built-in help. If you want, you can write online help specifically aimed at your end-users and redirect the Help link to a different help location.

If you want, you can reference the Help location in EL expressions. For details, see Section B.4.2, "EL Expressions Relevant to the Spaces Application".


Figure 5-3 Customizing the Online Help Link
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When you customize the Help link, built-in help for Spaces is still available through help buttons, help icons, and so on.

To customize the main Help link:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration, then General.


	
In the Global Help URL field, enter the location of your help.

Ensure that you enter a fully qualified URL in the format:


http://host:port/helplocation 



For example:


http://myhost:8888/myhelp 



The default Global Help URL is /webcenterhelp/spaces?topic=welcome_main. This URL opens Oracle Help for the Web (OHW) and displays Oracle's built-in help for Spaces. Enter this URL if you want to return to the default setting.




	
Note:

If you leave the Global Help URL field blank, the Help link is not displayed.








	
Click Apply.




Click Help in your application to check whether your custom help opens correctly.






5.4 Choosing a Default Display Language

Out-of-the-box, the Spaces application supports 27 languages and 100 different locales. It is the administrator's job to choose a default application display language for the Spaces application. When picking the default language, consider which language suits the majority of people using the application. Alternatively, enter an EL expression that determines the default language dynamically based on certain criteria. For example, you may prefer the default display language to change according to the location or organization of the user that is logged in.

The first time a user logs in to Spaces the default language displays but individuals can personalize their display language through user preferences. See, Section 35.2, "Choosing Your Preferred Display Language".

The default display language only applies when users log in to Spaces. Public pages, such as the welcome page and the login page, display in the browser language. If no default language is provided, the browser language is used. See also, Section 24.1.1, "Display Language Precedence".




	
Note:

Moderators can nominate a display language for a particular Space. When defined, the Space language overrides both the default language and any user language preference. See also, Section 51.4.15, "Setting a Space Display Language".







To select the default display language for the Spaces application:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration tab, then General.


	
Do one of the following:

	
Choose a Default Language from the list available.

If the language you want is not available in the dropdown list, click Customize, select the check box for the language you require, and click Save.

To add a completely new language, your localization team must translate WebCenter Spaces resource bundles into the new language, and then these translations must be deployed to the managed server on which the Spaces application is deployed. For details, see "Adding Support for a New Language" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Click the Expression Builder icon, and enter an EL expression that determines the default language dynamically based on certain criteria.





	
Click Apply.




The display languages that are available for selection here are also offered to users and space moderators through user preferences. As the administrator, you can reduce the range of languages available to users. For details, see Section 5.5, "Customizing the Language List".






5.5 Customizing the Language List

Out-of-the-box, the Spaces application offers 27 languages and 100 different locales and all these languages are available to users by default. As an administrator, you can tailor the languages that are on offer to suit your audience. For example, you may prefer to remove all the territory language variants in favor of a more simplified language list or only offer European languages if your portal is specifically aimed at a European audience.

To customize the languages available to users:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration tab, then General.


	
Click Customize (below Default Language).


	
Choose which languages to offer by selecting (or deselecting) each language check box.


Figure 5-4 Choosing Which Languages Are Available

[image: Choosing Which Languages are Available]



	
Click Save.









5.6 Choosing a Default Start (or Landing) Page

By default, users see the Home space when they log in but you can configure the initial landing page to be a specific space or page.


To select the landing page for Spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration tab, then General.


	
In the Login section, choose what users see first when they login--the Home space, or a specific space or page.

	
To specify that a particular space displays, select Open a Specific Space and enter the space name or click Browse to select from a list of spaces.


	
To specify that a particular page displays, select Open a Specific Page URL and enter the page location.

Typically this is an internal page. You can enter a full or relative page URL as shown in these examples:

http://mywebcenter.com:8888/webcenter/spaces/page/landingpage

http://mywebcenter.com:8888/webcenter/spaces/myspace/page/landingpage

/spaces/myspace/page/landingpage

If you specify an external page, ensure that you specify the full URL.





	
Click Apply.









5.7 Choosing a Default Skin

As administrator, you may customize the default appearance of the Spaces application for all users by changing the default skin. A skin changes the way the user interface appears, but does not change the application's behavior. See Section 14.5.1, "Applying a Skin to the Spaces Application".

If you want, you can reference the default skin in EL expressions. For details, see Section B.4.2, "EL Expressions Relevant to the Spaces Application".

Individual users can change the skin applied to their Home space view through user preferences if they do not like the default skin that you specify. See Section 14.5.3, "Applying a Skin to the Home Space".






5.8 Choosing a Default Page Template

In the Spaces application, page templates define how individual pages and groups of pages display on a user's screen. Every page displays within a page template. Administrators can define the default page template used to display pages in:

	
The Home space


	
New spaces, when the space's template does not specify that a particular page template must be used




Space moderators can override the default selection within their space but users cannot override the page template applied to the Home space.

See also, Chapter 12, "Working with Page Templates".

To select the default page template for the whole Spaces application:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration tab, then General.


	
Do one of the following:

	
Choose a Default Page Template from the list available.

To learn how to add page templates to this list, read Section 12.5.1, "Showing and Hiding a Page Template".


	
Click the Expression Builder icon, and enter an EL expression that determines the default page template dynamically based on certain criteria.

For example, you may like the default page template to change depending on which department or organization the logged in user belongs to.





	
Click Apply.









5.9 Choosing a Default Navigation

In the Spaces application, navigation models enable users to see and navigate to information quickly and easily. Administrators can specify which navigation is used to present Home space information.

Alternatively, you can enter an EL expression that determines the navigation dynamically based on certain criteria. For example, you may like to display different navigations depending on which department or organization the logged in user belongs to.

See also, Chapter 11, "Working with Navigation".

To select a navigation model for the Home space:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration tab, then General.


	
Do one of the following:

	
Choose a Navigation for Home Space from the list available.

To learn how to add navigations to this list, read Section 10.4.3, "Showing and Hiding Resources".


	
Click the Expression Builder icon, and enter an EL expression that determines the navigation dynamically based on certain criteria.





	
Click Apply.









5.10 Choosing Default Resource Catalogs

In the Spaces application, a series of Resource Catalogs display when you edit a page or a page template in Composer and click Add Content. Each catalog presents available resources in a series of folders and subfolders and the content on offer changes dynamically depending on which services are currently available and the permissions of the person who is editing the page or page template. Available resources include task flows, portlets, and page layout components, such as images, content boxes, hyperlinks, and the like.Spaces provides several default catalogs out-of-the-box but you can add new task flows, remove task flows, or reorganize the folder hierarchy to better suit your audience or create brand new ones of your own. For details, see Chapter 16, "Working with Resource Catalogs".

Administrators can specify default page catalogs for:

	
New spaces


	
Home space


	
Business role pages




As well as, default page template catalogs for:

	
New spaces


	
Home space




It is entirely up to you whether you specify a different catalog for each scenario or use the same catalog throughout.

To select default resource catalogs for the application:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration tab, then General.


	
Choose default resource catalogs for the following:

	
Resource Catalog for Spaces


	
Resource Catalog for Home Space


	
Resource Catalog for Business Role Pages


	
Resource Catalog for Page Templates in Space


	
Resource Catalog for Page Templates in Home Space




To learn how to add resource catalogs to this list, read Section 16.4, "Showing and Hiding a Resource Catalog".

Click the Expression Builder icon, and enter an EL expression that determines the default resource catalog dynamically based on certain criteria. For example, you may like the default resource catalog to change depending on the which role the logged in user belongs to.


	
Click Apply.









5.11 Choosing a Default Look and Feel for New Pages

Administrators can set up a default look and feel for personal and business role pages. Use this feature to simplify page creation for first-time users or to steer users toward a particular page scheme and style. See Chapter 7, "Preparing Your Initial Portal Pages ".

Individuals may personalize the default settings in their Home space view. See Section 38.1.1, "Setting Page Creation Defaults for Personal Pages".






5.12 Enabling and Disabling Access to the Home Space

Access to the Home space is optional—it is not mandatory to provide users with a private work area where they can store personal content and perform personal tasks. Users can fully participate in collaborative projects without access to the Home space.

Users who do not have access to the Home space, cannot use personal productivity tools (such as favorites), create personal pages, or see personal pages that other users might share.

The View Application permission controls whether users have access to the Home space. Administrators can disable access to everyone using the Spaces application or specific users only. Use the table shown in Step 3 to determine which permission settings you require.

To enable or disable access to the Home space:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Roles.


	
Select or clear the View Application check box as follows:


	Role	Select View Application	Clear View Application
	Authenticated-User	Everyone can access the Home space.	Users cannot access the Home space unless you grant them another role that specifies otherwise.
	Any Custom Role	Users assigned the custom role have access to the Home space.	Users with the custom role cannot access the Home space. Foot 1 
	Public-User	Unauthenticated users can see personal pages and content marked public.	Unauthenticated users only see the login page.
	Administrator	Users assigned this role can always access the Home space.	Not applicable for administrators.






Footnote 1 Assumes the View Application permission is disabled for the Authenticated-User and the Public-User.


	
Click Apply to save.




New permissions are effective immediately.






5.13 Setting up Defaults for WebCenter Services

The Spaces administrator is responsible for setting up default service options for the entire application. For more information, read:

	
Section 6.2, "Configuring Discussion Forum Options for the Spaces Application"


	
Section 6.3, "Configuring Send Mail Notifications for the Spaces Application"


	
Section 6.4, "Configuring People Connections Defaults for the Spaces Application"












6 Configuring Services, Portlet Producers, and External Applications

In the Spaces application, a series of WebCenter Portal services expose portal, team collaboration, and social features through various task flows. Some services, such as Lists, are ready to use out-of-the-box and require no further configuration. Other services, such as Discussions and Mail, require connections to external back-end servers, and additional configuration within Spaces to get things up and running.

This chapter describes how to enable, disable, and configure WebCenter Portal services in the Spaces application. It does not describe how to set up connections to back-end servers—this is a job for your Fusion Middleware Administrator. For details, see "Getting the Spaces application Up and Running" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

This chapter includes the following sections:

	
Section 6.1, "Enabling and Disabling Services"


	
Section 6.2, "Configuring Discussion Forum Options for the Spaces Application"


	
Section 6.3, "Configuring Send Mail Notifications for the Spaces Application"


	
Section 6.4, "Configuring People Connections Defaults for the Spaces Application"


	
Section 6.5, "Registering Portlet Producers" *


	
Section 6.6, "Registering External Applications" *




See also, Chapter 5, "Configuring Global Defaults"


Audience

This chapter is intended for Spaces administrators with the Manage Configuration permissions.

Additional permissions are required to manage portlet producers and external applications for the Spaces application, that is, you must have the appConnectionManager role.



6.1 Enabling and Disabling Services

In the Spaces application, a series of services expose portal, team collaboration, and social features through various task flows. Some services, like Tags, are available and work out-of-the-box, but other services, such as Mail, require connection to an external back-end server. Table 6-1 describes the services available in WebCenter Portal.


Table 6-1 WebCenter Portal: Services

	Service	Description	For More Information
	
Activity Graph

	
Leverages collective intelligence to benefit search and social applications.

	
Chapter 58, "Working with the Activity Graph Service"



	
Analytics

	
Enables you to display usage and performance metrics for your Framework application.

	
Chapter 55, "Analyzing Usage and Performance Metrics"



	
Announcements

	
Provides the ability to post announcements about important activities and events to all authenticated users.

	
Chapter 59, "Working with the Announcements Service"



	
Discussions

	
Provides the ability to create threaded discussions, posing and responding to questions and searching for answers. Also provides an effective group communication mechanism for important activities and events.

	
Chapter 60, "Working with the Discussions Service"



	
Documents (includes Wikis and Blogs)

	
Provides content management and storage capabilities, including content upload, file and folder creation and management, file check out, versioning, and so on.

	
Chapter 39, "Introduction to Adding and Managing Content"



	
Events

	
Provides the ability to create and maintain a schedule of events relevant to a wider group of users. Events are published to all authenticated users.

	
Chapter 61, "Working with the Events Service"



	
Instant Messaging and Presence (IMP)

	
Provides the ability to observe the status of other authenticated users (whether online, offline, busy, or away) and to contact them instantly.

	
Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)"



	
Links

	
Provides the ability to view, access, and associate related information; for example you can link to a solution document from a discussion thread.

	
Chapter 63, "Working with the Links Service"



	
Lists

	
Provides the ability to create, publish, and manage lists. Users can create lists from prebuilt structures or create their own custom lists.

	
Chapter 64, "Working with the Lists Service"



	
Mail

	
Provides easy integration with IMAP and SMTP mail servers to enable users to perform simple mail functions such as reading messages, creating messages with attachments, replying to or forwarding existing messages, and deleting messages.

	
Chapter 65, "Working with the Mail Service"



	
Notes

	
Provides the ability to "jot down" and retain quick bits of personally relevant information.

Note: This service is available only in Oracle WebCenter Portal: Spaces.

	
Chapter 66, "Working with the Notes Service"



	
Notifications

	
Provides a means of subscribing to services and application objects and, when those objects change, receiving notification across one or more selected messaging channels.

	
Chapter 36, "Setting Up Your Personal Subscriptions and Notifications"



	
People Connections

	
Provides social networking capabilities, such as creating a personal profile, displaying current status, and viewing other users' recent activities.

	
Chapter 31, "Creating Your Social Network"



	
Personalization

	
Enables you to deliver content within your application to targeted application users based on selected criteria.

	
Chapter 9, "Using Personalization for WebCenter Portal"



	
Polls

	
Enables you to survey your audience (such as their opinions and their experience level), check whether they can recall important information, and gather feedback.

	
Chapter 67, "Working with the Polls Service"



	
RSS

	
Provides the ability to access the content of many different web sites from a single location—a news reader.

	
Chapter 68, "Working with the RSS Service"



	
Recent Activities

	
Provides a summary view of recent changes to documents, discussions, and announcements.

	
Chapter 69, "Working with the Recent Activities Service"



	
Search

	
Provides the ability to search services, the application, or an entire site.

(This includes integrating Oracle Secure Enterprise Search for WebCenter Portal searches.)

	
Chapter 56, "Working with the Search Service"



	
Tags

	
Provides the ability to assign one or more personally relevant keywords to a given page or document.

	
Chapter 57, "Working with the Tags Service"



	
Worklist

	
Provides a personal, at-a-glance view of business processes that require attention (including a request for document review, and other types of business process that come directly from enterprise applications).

	
Chapter 70, "Working with the Worklist Service"









The following services require a connection to an external data repository (such as a content server, a presence server, a discussions server, a mail server) where relevant information is stored.

	
Analytics


	
Announcements


	
Discussions


	
Documents, including wikis and blogs


	
Events


	
Instant Messaging and Presence (IMP)


	
Mail


	
Search (for Oracle SES adapter)


	
Worklist




Some services require a connection to a database schema where relevant information (such as relationship mapping) is stored.

	
Activity Graph


	
Analytics


	
Documents (for documents, wikis and blogs that want to include the comments and Activity Stream)


	
Links


	
Lists


	
People Connections


	
Polls


	
Tags




The Fusion Middleware Administrator is responsible for managing connections to external servers and also maintains the database schema and Metadata Service (MDS) repositories where application data, specific to Spaces, is stored. For details, see "Maintaining the Spaces Application" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

When a valid connection exists, the associated service becomes available. If you want to verify whether a service, such as Mail, is available in the Spaces application, check:

	
Associated task flows display in the resource catalog.


	
Existing task flows function as expected.


	
Space moderators can choose whether to enable or disable that service in their Space—through Space Administration Settings




When a back-end server is not configured, intentionally or otherwise, the Spaces application cannot offer features or functionality related to that service:

	
Associated task flows are not available in the resource catalog.


	
Existing task flows display a message indicating that the service is currently unavailable.


	
Service is not listed, as available, to space moderators—through Space Administration Settings





Reporting Temporary Issues with WebCenter Portal Services

When a service is temporarily unavailable, report the issue to the Fusion Middleware Administrator. The Fusion Middleware Administrator can use Enterprise Manager to investigate, diagnose, and solve issues relating to services. See also, "Navigating to the Home Page for the Spaces Application" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


Hiding Task Flows When Services Unavailable

Most WebCenter Portal services are optional. If you decide not to offer a particular service in the Spaces application, temporarily or permanently, consider removing any associated task flows that display, by default, out-of-the-box.


Enabling and Disabling Services for a Particular Space

Moderators can enable or disable available services within their space. See, Section 51.10, "Managing Space Services."






6.2 Configuring Discussion Forum Options for the Spaces Application

Discussion forums allow members to capture, share, and preserve content that is relevant to their project or community goals.

As administrator, you are responsible for setting discussion forum options for the entire application through Spaces Administration pages (Figure 6-1).


Figure 6-1 Setting Discussion Forum Options

[image: Setting Discussion Forum Options]



From here you configure discussion-related setting, as well as access discussions server administration pages:

	
Section 6.2.1, "Accessing the Discussions Server Admin Console"


	
Section 6.2.2, "Specifying Where Discussions and Announcements are Stored on the Discussions Server"


	
Section 6.2.3, "Choosing How Many Discussion Topics to Save In Space Templates"







	
Note:

The Fusion Middleware administrator maintains the connection between the Spaces application and the discussions server. If you are experiencing issues with this connection, report the problem to the Fusion Middleware Administrator. See also, "Registering Discussions Servers" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









6.2.1 Accessing the Discussions Server Admin Console

For convenience, you can access the discussions server's Admin Console, a Web-based tool for configuring and managing discussion forums, from Spaces Administration. From the Admin Console, you can navigate all categories and forums and edit their properties, create new categories and forums, as well as set cache, security, and various other properties for the discussions server.

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, Services, and then select Discussions.


	
Click Forum Administration.


	
Enter your discussions server administrator Username and Password.









6.2.2 Specifying Where Discussions and Announcements are Stored on the Discussions Server

Administrators can change the root category (on the discussions server) under which all Spaces discussions and announcements are stored.

The default system root category is suitable in most cases but you can choose a different location. This might be useful when Spaces is connected to a discussions server that is hosting discussion forums for multiple applications.

Oracle recommendations:

	
Choose a category that is dedicated to this Spaces application. There may be conflicts when multiple Spaces applications share the same root category.


	
Do not switch the root category after the Spaces application is up and running. If you change the root category, then all the discussion forums under the old root continue to work, but you cannot use the Links service to create links to discussions or announcements stored in the old category.




You can retain existing discussions in a space template saved with the data copy option. For example, on the Administration - Configuration - Services - Discussions page, enter the number (between 1 and 25) of most recent topics and replies to be copied over to the template.

Space templates support single or multiple forums under the root category that you specify. With some templates, one forum is created automatically under the root category for each new space based on that template.

To specify where discussion forums are stored:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, Services, and then select Discussions.


	
Specify an appropriate Root Category for storing discussions.

Click the Find icon to view the categories available and then select the most appropriate location.

To create a new category especially for this Spaces application, click Create Category. You must have system administrator permissions on the Discussions server to create new categories.


	
Click Apply to save the settings.









6.2.3 Choosing How Many Discussion Topics to Save In Space Templates

Administrators can limit how many recent topics and replies are copied to space templates. As copying large amounts of data has performance implications, there is an upper limit of 25 topics/replies.

Some of you may prefer not to include any recent topics/replies in space templates, in which case you can specify zero.

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, Services, and then select Discussions.


	
Specify an appropriate number of Topics and Replies to save in space templates.


	
Click Apply to save the settings.











6.3 Configuring Send Mail Notifications for the Spaces Application

Administrators are responsible for setting mail options through Spaces administration (Figure 6-2).


Figure 6-2 Setting Mail Options
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From this page, you can assign the mail client for the "Send Mail" feature. This feature allows application resources to send mail directly from them, with the Send Mail icon (Figure 6-3).


Figure 6-3 Send Mail Icon

[image: Send Mail icon]



For example, from an announcement, users can click the Send Mail icon to open a mail window prepopulated with information including the announcement text, author, date created, and location. They can edit and add to the mail, as necessary. The way the mail window is prepopulated depends on the resource sending it. For example, from a wiki, Send Mail opens a mail window prepopulated with the name of the wiki, the size, who created it and when, who modified it and when, and a URL link to the wiki.

Within a space, the mail can be addressed to all members of the space. Space moderators (and anyone granted the Manage Configuration permission on the Space) set this through the Services page in the administration settings. See Section 51.10.2, "Configuring a Custom Space Mail Distribution List."

If the number of recipients is so large that the mail cannot be prepopulated with the addresses, then you must either enter the addresses manually or set up a distribution list for the space.

For all Send Mail notifications throughout the Spaces application, you can choose to use the local mail client, such as Microsoft Outlook or Mozilla Thunderbird, or WebCenter Portal's own Mail service. The local mail client is the default. The Send Mail feature does not require the Mail service, that is, if the Mail service is not yet configured, you can still use the Send Mail feature with your local mail client.




	
Note:

With the Internet Explorer browser, Send Mail notifications are garbled for many non-English languages. When multibyte characters are encoded (required for the "mailto:" protocol), the URL length exceeds the Internet Explorer limit. As a workaround, configure the Send Mail feature to use WebCenter Portal's Mail service instead of the local mail client.







As administrator, you can also specify whether users may override the default mail client setting.




	
Note:

The Fusion Middleware administrator maintains the connection between the Spaces application and the mail server. If you are experiencing issues with this connection, report the problem to the Fusion Middleware Administrator. See, "Registering Mail Servers" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









6.3.1 Enabling Shared Mail Connections for Send Mail Notifications

Users do not need to specify credentials when sending mails using WebCenter Portal's Mail service when shared credentials are configured for the external application that is associated with the mail server connection.

To enable shared mail connections in Spaces:

	
Confirm that Spaces is using WebCenter Portal's Mail service to send mail.

	
Open Spaces Administration.


	
Click Configuration, Services, and then select Mail.


	
Ensure that Default Mail Client for 'Send Mail' is set to WebCenter Portal's Mail Service.




See also, Section 6.3, "Configuring Send Mail Notifications for the Spaces Application."


	
Ask the Fusion Middleware administrator to set up a mail connection that uses an external application configured with the shared credentials and record the mail connection name.

For details, see "Setting Up a Shared Mail Connection" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Open the space where shared mail credentials are required and specify the name of the shared mail connection.

For details, see Section 51.10.5, "Configuring a Shared Mail Connection for a Space."











6.4 Configuring People Connections Defaults for the Spaces Application

This section describes how to set application defaults for the People Connections service. You must be a Spaces administrator or granted Application-Configure and Manage People Connections permissions to set any of the application-wide properties described here.

This section includes the following subsections:

	
Section 6.4.1, "What You Should Know About Administering the People Connections Service"


	
Section 6.4.2, "People Connections Prerequisites"


	
Section 6.4.3, "Configuring the People Connections Service for Spaces"


	
Section 6.4.4, "Archiving the Activity Stream Schema"


	
Section 6.4.5, "Troubleshooting Issues with the People Connections Service"






6.4.1 What You Should Know About Administering the People Connections Service

People Connections administrative settings are useful for controlling all users' initial views of People Connections features, including:

	
Activity Stream—A streaming view of user activity


	
Connections—An organically formed community of users who share a greater level of information with each other than with the unconnected


	
Profile—A summary of user information, such as contact information, job position, chain of management, and the like


	
Message Board—A feature for posting and receiving messages


	
Feedback—A feature for posting and receiving feedback




Use the People Connections administrative settings to enforce the values you specify or to enable users to override these values with their own People Connections Preferences (for more information, see the chapters covering specific features of the People Connections service, available in Part IX, "Organizing Your Collaborative and Social Networking Environment").

Setting default values on the Spaces Administration page affects all users' views of People Connections features. There are a few levels at which these values can be set, and they are subject to an order of precedence:

	
Administrative settings affect all users' views of People Connections features.


	
Preferences settings affect the view of the user who sets them, and they override administrative settings.


	
Settings on a particular task flow affect just that task flow instance, and they override Preference settings:

	
Values set in edit mode (application customization) affect all users' views of the task flow instance.


	
Values set in view mode (user customization) affect only that user's view of the task flow instance, and they override application customizations in that user's view.












6.4.2 People Connections Prerequisites

No special set up is required to enable users to access People Connections services. The People Connections service uses the WebCenter Portal repository, installed with WebCenter Portal: Spaces, to store information.

For Profile information, all but three attributes are stored and read from the LDAP identity store that is configured for the Spaces application. There are three exceptions: the Profile photo, expertise, and the Publisher status message. These are stored with other Spaces data in the WebCenter Portal repository.




	
See Also:

For information about Spaces and the LDAP identity store, see "Configuring the Identity Store" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.












6.4.3 Configuring the People Connections Service for Spaces

This section steps you through the process of setting application-wide values for People Connections features. It includes the following subsections:

	
Section 6.4.3.1, "Accessing People Connections Administrative Settings"


	
Section 6.4.3.2, "Configuring Activity Stream"


	
Section 6.4.3.3, "Configuring Connections"


	
Section 6.4.3.4, "Configuring Profile"


	
Section 6.4.3.5, "Configuring Message Board"


	
Section 6.4.3.6, "Configuring Feedback"






6.4.3.1 Accessing People Connections Administrative Settings

To access People Connections administrative settings:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, Services, and then select People Connections.

Alternatively, use the following URL, and then select People Connections:


http://host:port/webcenter/spaces/admin/services


Tabs with the names of People Connections features appear to the right (Figure 6-4).


Figure 6-4 Configuration Settings for the People Connections Service
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Description of "Figure 6-4 Configuration Settings for the People Connections Service"












6.4.3.2 Configuring Activity Stream

Activity Stream provides a means of publishing and tracking users' application activity. Activity Stream configuration settings specify from which users and services activities are streamed, who can see a user's streamed activities, and whether liking and commenting is available on each streamed activity (Figure 6-5).


Figure 6-5 Configuration Options for Activity Stream
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Description of "Figure 6-5 Configuration Options for Activity Stream"





Who can view a user's activities and the types of activities tracked depend on Activity Stream configuration. Table 6-2 lists the types of activities that may be tracked by Activity Stream.


Table 6-2 Activities Tracked by Activity Stream

	Service	Tracked Activities	Scope	Activities Shared or Private
	
Announcements

	
	
Create announcement


	
Edit announcement




	
Space

	
Shared with other space members


	
Blogs

	
	
Create blog


	
Update blog




	
	
Space


	
Home space





	
	
Activities on space blogs are shared with other space members.


	
Activities on Home space blogs are shared with the blogger's connections.





	
Connections

	
	
Invitations to connect


	
People are connected




	
Home space


	
Shared with invitor and invitee's connections


	
Discussions

	
	
Create forum


	
Create topic


	
Reply to topic




	
Space


	
Shared with other space members


	
Documents

	
	
Create document


	
Edit document


	
Add tag


	
Remove tag




	
	
Space


	
Home space





	
	
Activities on space documents are shared with other space members.


	
Activities on Home space documents are private to user.





	
Feedback

	
	
Feedback left


	
Feedback received




	
Home space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 33.2, "Setting Message Board and Feedback Preferences."


	
Lists

	
	
Create a list


	
Add a row to a list


	
Edit a list row




	
Space

	
Shared with other space members


	
Message Board

	
	
Message left


	
Message received




	
Home space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 33.2, "Setting Message Board and Feedback Preferences."


	
Pages

	
	
Create page


	
Edit page


	
Add tag


	
Remove tag




	
	
Space


	
Home space




	
	
Activities on space pages are shared with other space members.


	
Activities on Home space pages are private to user.





	
Profiles

	
	
Photo updated


	
Profile updated


	
Personal status note updated




	
Home space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 30.3, "Setting Profile Preferences."


	
Space Events

	
	
Create an event


	
Edit an Event




	
Space

	
Shared with other space members


	
Spaces Management

	
	
Create space


	
Join space




	
Space

	
Shared with other space members


	
Tagging

	
	
Add tag


	
Remove tag




	
Space

	
	
Activities in a space are shared with all space members.


	
Activities in a Home space are shared with whomever is permitted to view such activities (for more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences").











Activity Stream configuration falls under the following categories:

	
People—For determining whose activities to show, either the current user's or both the current user and the user's connections.


	
Spaces—For determining whether to show activities from all available spaces or just the Home space.


	
Service Categories—For selecting the services from which to report activities and enabling users to override these default selections in their personal preferences or preventing users from overriding.


	
Privacy—For selecting who may see the current user's activities.


	
Comments and Likes—For enabling users to comment on a posted activity and express a liking for a posted activity




To configure Activity Stream for all users:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Activity Stream tab to bring it forward.


	
Expand the People node, and select whose activities to show:

	
Only Me—Show only the current user's activities in his or her view of the Activity Stream.


	
Me and My Connections—Show the current user's activities and the activities of that user's connections in his or her view of the Activity Stream.


	
No Personal—Omit all activities streamed from Home spaces in the current user's view of his Activity Stream.





	
Expand the Spaces node, and select to show activities from:

	
All Spaces—All spaces to which the user has access


	
My Spaces—All spaces of which the user is the moderator


	
No Spaces—Only the Home space





	
Expand the Service Categories node, and select the services from which to publish activity.




	
Note:

The activities of services that are not selected are still tracked, but they do not appear in the Activity Stream. If you select to show the service activities at some later point, all of the activities that occurred when the service was not selected now appear in the Activity Stream.







Table 6-2 lists the activities tracked by the Activity Stream.


	
Optionally, select Allow Owner Override to enable users to override a setting for a given service through their personal preferences.

Clear this checkbox to prevent users from overriding the application defaults you set here.


	
Expand the Privacy node, and specify who can view the current user's activities as well as whether the user can override this setting in their personal preferences.

Table 6-3 lists and describes each option.


Table 6-3 Activity Stream Privacy Options

	Option	Description
	
Allow all of my activities to be viewed by

	
Specify who can view another user's activities

Choose from:

	
Everyone—Any user, whether logged in or not, can view other users' activities.


	
Authenticated Users—Users who have logged in can view other users' activities.


	
My Connections—User A can view user B's activities if user B has accepted user A as a connection. User A can also view user A's activities.


	
Myself—Only user A can view user A's activities.





	
Allow Owner Override

	
Enable users to override the application default settings using their own People Connections Preferences (for more information, see Section 32.2, "Setting Activity Stream Preferences").








	
Expand the Likes and Comments node, and specify whether liking and commenting are allowed:

	
Select Enable comments on objects in the Activity Stream to enable users to comment on a given Activity Stream item. Clear the checkbox to prevent users from commenting.


	
Select Enable others to like objects in the Activity Stream to enable users to express a liking for an Activity Stream item. Clear the checkbox to prevent users from commenting.







	
Tip:

Users can like and comment on streamed items that include objects. For example, users can like or comment on "Jack has updated doc.xml," but cannot like or comment on "Jack and Jill are now connected."
For additional information about liking and commenting, see Chapter 34, "Liking, Commenting On, and Sharing Objects."










	
Click Apply to save your configuration settings.









6.4.3.3 Configuring Connections

Connections configuration involves specifying who can view another user's connections and whether users accept invitations to connect automatically (Figure 6-6).


Figure 6-6 Configuration Settings for Connections
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To configure Connections:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Connections tab to bring it forward.

Table 6-4 lists and describes each option.


Table 6-4 Connections Configuration Options

	Option	Description
	
Grant View Access to

	
Classes of users to whom to grant automatic view access to a user's connections

The users you select can view and interact with another user's connections.

Choose from:

	
Everyone—All users, including users who are not logged in, can see other users' connections.


	
Authenticated users—Only users who are logged in can see other users' connections.


	
User's Connections—Only the user and the user's connections can see the user's connections.


	
User Only—Only a user can see his or her own connections.





	
Allow Owner Override

	
Option to allow or prohibit users from overriding the administrator View access setting:

	
Select to allow users to override the administrative View access setting specified here using their personal Preferences (for more information, see the "Setting People Connections Preferences" section in the Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces).


	
Clear to prohibit users from overriding the administrative View access setting.





	
Accept Invitations Automatically

	
	
Select to specify that, by default, all invitations to connect are accepted automatically.


	
Clear to specify that, by default, a user must explicitly accept or reject invitations to connect.











	
Click Apply to save your configuration settings.









6.4.3.4 Configuring Profile

Every authenticated user has a profile that displays personal information, such as the user's email address, phone number, office location, department, manager, direct reports, and so on. All but three attributes are stored and read from the LDAP identity store that is configured for the Spaces application. The three exceptions include the Profile photo and expertise and Publisher status messages.

Use administrative configuration settings for Profile to specify whether users are allowed to change their application passwords, which profile sections display, whether users are allowed to update their profile details, and the profile attributes that users may update (Figure 6-7).


Figure 6-7 Configuration Settings for Profile
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Personal profiles are presented in four sections: Summary, Employee, Business Contact, Personal Information. Each section provides information related to the section heading. For example, Summary includes a collection of basic details, such as the user's name, email address, and office location.

In configuration settings, the access setting for the Summary section controls who can search for the user (for example, through global search, people pickers, and the searches one uses to find and invite other users to connect). For example, if Everyone is allowed to view the Summary section, then the user can be searched for by unauthenticated (public) users. If only Authenticated Users can view another user's Summary section, then only logged in users can search for the user. If None is the selected value for Who can view this section, then the user will not appear in search results.

The Summary section is the only Profile section for which the privacy setting cannot be changed by the end-user through Preferences (for more information, see Section 30.3, "Setting Profile Preferences"). It is controlled at a global level for all users through the settings described in this section.

It is the administrator's job to specify the information to show in each section and determine whether users are allowed to edit their profile data and their application password within the Spaces application.




	
Note:

Whether users can enter edit mode in the Profile task flow is affected by administrative settings (Can Edit); however, whether users can enter edit mode on the About subpage of the My Profile page is not affected. The Edit button is always available on the default version of the About subpage.
Note also that Administrative settings do affect which sections appear on the About subpage (and in the Profile task flow) and whether users can change given details in each section.









To configure Profile:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Profile tab to bring it forward.

Table 6-5 lists and describes each option.


Table 6-5 Profile Configuration Options

	Option	Description
	
Allow Password Change

	
Specify whether users are allowed to change their application password

	
Select to enable users to change their application password.


	
Clear to prevent users from changing their application password. This option is useful when your organization provides a single, separate application for managing user credentials and, consequently, prefers not to offer password management through each application.





	
Profile Access

	
Specify which Profile sections to show and whether users are allowed to update their profile details

Set application defaults in the following table columns:

Profile Section—Identifies the groups of information shown in a user profile.

View Settings—Specify which users can view a particular profile section, and indicate whether users can change these defaults in their personal Preferences.

View Settings for the Summary section control not only who can view summary details but also for whom the user appears in people search results.

Set values for:

	
Who can view this section—Specify which class of users can view the associated profile section by default. Choose from:

User's Connections—The users to whom the current user is connected can see the associated profile section in other users' profiles. This option is available for all sections except Summary.

Everyone—All users, including users who are not logged in, can see the associated profile section in other users' profiles.

Authenticated users—Only users who are logged in can see the associated profile section in other users' profiles.

User Only—Only the user can see his or her own details in the associated profile section.

None—The section is hidden from all users.


	
Allow Owner Override—Enable or disable users' from overriding the default application settings you specify here. Select to enable; clear to disable.




Can Edit—Select to enable users to edit the associated profile section of their own personal profiles; clear to prohibit users from editing the associated profile section.

This setting also controls whether an Edit link appears in the Profile task flow, but it does not affect the appearance of the Edit button on the default version of the My Profile About subpage. On the default version of the About subpage, the Edit button always appears, though you can use the other Profile administrative settings to prohibit users from actually changing any Profile details.


	
Profile Attributes - Edit Settings

	
Indicate the section attributes that users are allowed to edit by default

Under Allow Update:

	
Select an attribute to enable users to edit its value in their own profiles.


	
Clear an attribute to prohibit users from editing it in their own profiles.





	
Profile Cache settings

	
A means of enabling and configuring a cache for Profile details

Provide values for:

	
Number of profile objects to keep in cache—Enter or select a value for the size of the cache.


	
Idle time in minutes to keep a profile object in cache—Enter or select the number of minutes to hold objects in cache before the cache is refreshed.




Cache settings take effect once you restart the Spaces application.








	
Click Apply to save your configuration settings.









6.4.3.5 Configuring Message Board

Message Boards provide users with a means of viewing and posting messages to their connections. Configuration settings for Message Board provide controls for who can view and post messages, who can edit and delete the messages they leave, who can delete and change the visibility of messages they receive, and whether commenting and liking are available on each message (Figure 6-8).


Figure 6-8 Configuration Settings for Message Board
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See Also:

For information about likes and comments, see Chapter 34, "Liking, Commenting On, and Sharing Objects."







To configure Message Board:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Message Board tab to bring it forward.

Table 6-6 lists and describes each option.


Table 6-6 Message Board Configuration Options

	Option	Description
	
Grant View Access to

	
Specify who can view Message Board messages.

	
Everyone—All users, whether logged in or not, can see users' Message Board messages.


	
Authenticated Users—Only logged in users can see users' Message Board messages.


	
User's Connections—Only the user and the user's connections can view the user's Message Board.


	
User Only—Only the user can see the messages on his or her Message Board.





	
Grant Post Access to

	
Specify who can post Message Board Messages.

	
Everyone—All users, whether logged in or not, can post Message Board messages.


	
Authenticated Users—Only logged in users can post messages to Message Boards.


	
User's Connections—Only the user and the user's connections can post messages to the user's Message Board.


	
User Only—Only the user can post messages to his or her Message Board.





	
Allow Owner Override

	
Specify whether users can override these administrative defaults.

	
Select to enable users to edit the default settings through user Preferences (for more information, see the "Setting People Connections Preferences" section in the Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces).


	
Clear to enforce the administrator default application settings.





	
Enable users to act on messages they post on other Message Boards

	
Specify whether users are allowed to act on the messages they post.

	
Edit message—Select to enable users to edit their own Message Board posts; clear to prohibit users from editing the messages they post.


	
Delete message—Select to enable users to delete their own Message Board posts; clear to prohibit users from deleting the messages they post.





	
Enable users to act on messages they receive from others

	
Specify whether users can act on messages they receive from others

	
Delete message—Select to enable users to delete messages they receive from other users; clear to prohibit users from deleting the messages they receive.


	
Change the visibility of the message—Select to enable users to hide or show the messages from a given user; clear to prohibit users from hiding or showing messages.





	
Enable commenting on messages from Message Board

	
Specify whether users can comment on messages that are posted on a Message Board.

	
Select to permit users to so comment. A Comment link appears below each message. Users click this to enter a comment. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Clear to prohibit commenting.





	
Enable liking of messages from Message Board

	
Specify whether to enable users to indicate that they like a message.

	
Select to permit users to click a Like link on a given message. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Clear to prohibit liking.











	
Click Apply to save your configuration settings.









6.4.3.6 Configuring Feedback

Feedback provides a means of viewing and posting user feedback for other application users. Configuration settings for Feedback (Figure 6-9).


Figure 6-9 Configuration Settings for Feedback
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Feedback configuration settings offer controls for identifying who can view, post, and delete feedback.

To configure Feedback:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Feedback tab to bring it forward.

Table 6-7 lists and describes each option.


Table 6-7 Feedback Configuration Options

	Option	Description
	
Grant View Access to

	
Specifies who can view the current user's Feedback

	
Everyone—All users, whether logged in or not, can see a given user's Feedback.


	
Authenticated Users—Only users who are logged in can see a given user's Feedback.


	
User's Connections—Only the user and the user's connections can see a given user's Feedback.


	
User Only—Disables other users from viewing a given user's Feedback.





	
Grant Post Access to

	
Specifies who can post user Feedback

	
Everyone—All users, whether logged in or not, can post Feedback for a given user.


	
Authenticated Users—Only logged in users can post Feedback for a given user.


	
User's Connections—Only the user and the user's connections can post Feedback for a given user.


	
User Only—Users can post Feedback only for themselves. Effectively disables Feedback.





	
Grant View Feedback Given Access to

	
Specifies who can see the View menu to switch between Feedback Given and Feedback Received in a Feedback task flow

	
Everyone—All users, whether logged in or not, can see the options on the View menu.


	
Authenticated Users—Only logged in users can see the options on the View menu.


	
User's Connections—Only the user and the user's connections can see the View menu.


	
User Only—Disables the View menu for all but the current user. When users visit the current user's Feedback task flow, they can view only the Feedback the current user has received.





	
Allow Owner Override

	
Specifies whether users can override these administrative defaults

	
Select to enable users to revise application default settings through user Preferences (for more information, see Section 33.2, "Setting Message Board and Feedback Preferences").


	
Clear to prevent users from altering administrator settings for Feedback.





	
Enable users to act on the feedback given to others

	
Indicates whether users can delete the Feedback they post

	
Select Delete Feedback to enable users to delete the Feedback they post.


	
Clear Delete Feedback to prohibit users from deleting the Feedback they post.





	
Enable owner of the feedback to act on feedback posted by others

	
Indicate whether to enable users to hide or show Feedback from another user.

	
Select Change the visibility of the feedback to enable users to hide or show the Feedback from another user.


	
Clear Change the visibility of the feedback to prohibit users from hiding or showing Feedback left by others.











	
Click Apply to save your configuration settings.











6.4.4 Archiving the Activity Stream Schema

As the application administrator, you can use WLST commands to archive and restore data in the Activity Stream schema. The following commands are available:

	
archiveASByDate—Archive activity stream data that is older than a specified date.


	
archiveASByDeletedObjects—Archive activity stream data associated with deleted objects.


	
archiveASByClosedSpaces—Archive activity stream data associated with Spaces that are currently closed.


	
archiveASByInactiveSpaces—Archive activity stream data associated with Spaces that have been inactive since a specified date.


	
restoreASByDate—Restore archived activity stream data from a specified date into production tables.




For more information, see the section, "Activity Stream," in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.






6.4.5 Troubleshooting Issues with the People Connections Service

This section identifies the types of problems that may occur with each People Connections feature and provides suggestions for how to respond to them. It includes the following subsections:

	
Section 6.4.5.1, "Troubleshooting Activity Stream"


	
Section 6.4.5.2, "Troubleshooting Connections"


	
Section 6.4.5.3, "Troubleshooting Profile"


	
Section 6.4.5.4, "Troubleshooting Message Board"


	
Section 6.4.5.5, "Troubleshooting Feedback"






6.4.5.1 Troubleshooting Activity Stream

Table 6-8 lists problems and responses for troubleshooting Activity Stream in Spaces.


Table 6-8 Activity Stream Errors and Responses

	Problem	Response
	
Unexpected error or exception

	
Contact Oracle Support Services.


	
Connections exception is thrown

	
Check the exception's detail for an explanation of the exception.


	
Service Framework exception is thrown

	
Check the exception's detail for an explanation of the exception.


	
Settings exception is thrown

	
Check the exception's detail for an explanation of the exception.


	
Property value entered is not reflected in task flow

	
An invalid value may have been entered for the task flow property. In such cases, the default value is used. Ensure that task flow properties have valid values. For more information, see the chapters covering features associated with the People Connections service in Part IX, "Organizing Your Collaborative and Social Networking Environment".


	
Database exception in EclipseLink module

	
Contact Oracle Support Services.


	
Query exception in EclipseLink module

	
Contact Oracle Support Services.


	
Unable to publish analytics event

	
Contact Oracle Support Services.


	
Operation not supported

	
Contact Oracle Support Services.


	
Cannot retrieve user Profile information

	
Contact Oracle Support Services.


	
Check for valid repository failed

	
Either the database is down or the WebCenter Portal repository is not installed. Check the exception's detail for an explanation of the exception, and respond accordingly.


	
Activity exception during bulk publish

	
Check the individual activity exception's detail for an explanation of the exception.












6.4.5.2 Troubleshooting Connections

Table 6-9 lists problems and responses for troubleshooting Connections in Spaces.


Table 6-9 Connections Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
User name null or blank

	
Supply a valid user name.


	
Could not find user name

	
Supply a valid user name.


	
Connection list name not specified

	
An invalid value may have been entered for the task flow property. Ensure that task flow properties have valid values. For more information, see the chapters covering features associated with the People Connections service in Part IX, "Organizing Your Collaborative and Social Networking Environment".


	
Insufficient privileges

	
Contact the Spaces administrator, and request the required permission.


	
Cannot invite oneself as a connection

	
Supply a user name other than your own.


	
Cannot invite a user who has been invited

	
Wait for the invited user to act on your invitation.


	
Cannot invite a user who has invited you

	
Accept the invitation you have received from the user.


	
Cannot invite a user to whom you are connected

	
Supply a user name other than that of your existing connection.












6.4.5.3 Troubleshooting Profile

Table 6-10 lists problems and responses for troubleshooting Profile in Spaces.


Table 6-10 Profile Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
Personal status message cannot be changed

	
Only you can change your personal status message.


	
User cannot view Profile.

	
Contact the Spaces administrator, and request the required permission.


	
User cannot edit Profile.

	
Contact the Spaces administrator, and request the required permission.


	
User was not specified

	
The supplied user name was null or blank. Enter a valid user name.


	
Modifying property is not allowed

	
The task flow property may be read-only. In this case, you cannot supply a value.


	
Error getting an Instant Message address

	
Contact the Spaces administrator.


	
Error getting tag data

	
Contact the Spaces administrator.


	
Tried to upload an invalid image

	
Try again with a valid image type. The file must have the mime-type image, and cannot have the extension *.ico.


	
Error instantiating object

	
Contact the Spaces administrator.


	
Error instantiating Profile

	
Contact Oracle Support Services.












6.4.5.4 Troubleshooting Message Board

Table 6-11 lists problems and responses for troubleshooting Message Board in Spaces.


Table 6-11 Message Board Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
Failed to create an instance of Message Board

	
Make sure the user is logged in.


	
Failed to persist Message Board message

	
Contact Oracle Support Services.


	
Failed to publish Message Board activity

	
Verify the reason for the failure in the Activity Stream subsystem.


	
Message Board message cannot be deleted

	
The Spaces administrator must explicitly allow users to delete the messages they send. Contact the application administrator, and request the required permission. For more information, see Section 6.4.3.5, "Configuring Message Board."


	
Message Board message cannot be updated

	
Contact the Spaces administrator, and request the required permission.


	
Message Board message cannot be added

	
Message content is empty. Enter message content, and try again. Otherwise, contact Oracle Support Services.


	
Message Board message cannot be hidden

	
User does not have permission to hide the message. You can hide only those messages you receive, and not the ones you send.


	
Failed to query preferences for Message Board

	
Contact Oracle Support Services.












6.4.5.5 Troubleshooting Feedback

Table 6-12 lists problems and responses for troubleshooting Feedback in Spaces.


Table 6-12 Feedback Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
Failed to create an instance of Feedback

	
Make sure the user is logged in.


	
Failed to persist Feedback message

	
Contact Oracle Support Services.


	
Failed to publish Feedback activity

	
Verify the reason for the failure in the Activity Stream subsystem.


	
Feedback cannot be deleted

	
The Spaces administrator must explicitly allow users to delete the Feedback they post. Contact the application administrator, and request the required permission. For more information, see Section 6.4.3.6, "Configuring Feedback."

Otherwise, contact Oracle Support Services.


	
Feedback cannot be updated

	
Contact the Spaces administrator, and request the required permission.


	
Feedback cannot be added

	
Feedback content is empty. Enter Feedback content, and try again. Otherwise, contact Oracle Support Services.


	
Feedback cannot be hidden

	
User does not have permission to hide the Feedback. You can hide only the Feedback you receive; you cannot hide the Feedback you give.


	
Failed to query preferences for Feedback

	
Contact Oracle Support Services.
















6.5 Registering Portlet Producers

A portlet producer is the object that owns portlets and makes them available to applications. To make a portlet available in Spaces, you must register the portlet's producer with the Spaces application.

This section includes the following subsections:

	
Section 6.5.1, "What You Should Know About Registering Portlet Producers"


	
Section 6.5.2, "Registering Portlet Producers Through Spaces Administration"


	
Section 6.5.3, "Working with the Producer Registration Task Flow"


	
Section 6.5.4, "Deregistering Portlet Producers"






6.5.1 What You Should Know About Registering Portlet Producers

To be able to register and manage portlet producers in the Spaces application, a user must be assigned the AppConnectionManager role. By default, users with the Administrator role in Spaces are assigned this role; and therefore, administrators can configure portlet producers.

You can grant any other user this capability through Fusion Middleware Control or using the WLST command grantAppRole. For example, the following grantAppRole WLST command grants the AppConnectionManager role to the user monty.


grantAppRole(appStripe='webcenter', appRoleName='AppConnectionManager',  principalClass='weblogic.security.principal.WLSUserImpl', principalName='monty')


For more information about this command, see the section "grantAppRole" in the Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.




	
See Also:

"Granting Application Roles Using Fusion Middleware Control" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.












6.5.2 Registering Portlet Producers Through Spaces Administration

To register portlet producers through Spaces Administration, you must have the following roles and permissions:

	
AppConnectionManager role—Enables you to manage portlet producers. See the section "Granting Application Roles Using Fusion Middleware Control" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Application - Manage Configuration permission—Enables access to the Spaces Administration page. See Chapter 21, "Managing Users, Roles, and Permissions."




You can register portlet producers in Spaces through Spaces Administration. You can also add the Portlet Producer task flow to any page to enable users with administration privileges to register portlet producers.

This section includes the following subsection:

	
Section 6.5.2.1, "Registering a WSRP Producer."


	
Section 6.5.2.2, "Registering an Oracle PDK-Java Producer."


	
Section 6.5.2.3, "Registering a Pagelet Producer."






6.5.2.1 Registering a WSRP Producer

When you register a WSRP portlet producer, you provide basic information that describes the producer's operational parameters. This information is used by the Spaces application to communicate with the producer and with the portlets through the producer.

Oracle WebCenter Portal: Framework supports both WSRP 1.0 and WSRP 2.0 producers. The WSRP 2.0 standard, among others, provides support for inter-portlet communication and export and import of portlet customizations. You can leverage the benefits of WSRP 2.0 while building standards-based JSR 286 portlets.

To register a WSRP producer for use in Spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
From the menu bar, click Register.


	
In the Register Portlet Producer page, in the Name and Type section, enter basic information for the portlet producer. See Table 6-13.


Table 6-13 WSRP Producer Registration - Name and Type

	Field	Description
	
Producer Name

	
Enter a unique name to identify this portlet producer registration within Spaces. The name must be unique within the application.


	
Producer Type

	
Select WSRP Producer.








	
In the Portlet Producer URL section, enter connection details for the WSRP producer. See Table 6-14.


Table 6-14 WSRP Portlet Producer Registration - Portlet Producer URL

	Field	Description
	
WSDL URL

	
Enter the registration URL for the WSRP portlet producer.

The syntax varies according to your WSRP implementation. For example, possible URL formats for a portlet deployed to the Oracle WSRP container include:


http://host:port/context_root/portlets/wsrp2?WDSL
http://host:port/context_root/portlets/wsrp1?WSDL
http://host:port/context_root/portlets/?WSDL


where:

	
host is the server where the producer is deployed


	
port is the HTTP Listener port


	
context_root is the Web application's context root




In Spaces, only v2 WSDLs are supported for Oracle WebLogic Portal Producers.


	
Use Proxy?

	
Select if the Spaces application and the remote portlet producer are separated by a firewall and must use an HTTP proxy for communication. If selected, enter values for Proxy Host and Proxy Port.


	
Proxy Host

	
Enter the address for the proxy server.

Do not prefix http:// to the proxy server name.


	
Proxy Port

	
Enter the port number on which the proxy server listens. The default port is 80.








	
In the Advanced Configuration section, specify additional information for the WSRP producer. See Table 6-15.


Table 6-15 WSRP Portlet Producer Registration - Advanced Configuration

	Field	Description
	
Default Execution Timeout

	
Enter a suitable timeout for design time operations. For example, the maximum time the producer may take to register, deregister, or display portlets on pages in the Spaces application. The default is 30 seconds.

Individual portlets may define their own timeout period, which takes precedence over the value specified here.








	
In the Security section, from the Token Profile dropdown list, select the type of security token to use for the identity propagation/assertion. The other fields in this section vary depending on the security token selected. See Table 6-16.

The security token with the propagated or asserted user information is represented as an XML element in the SOAP header. The security token and the SOAP message body are then digitally signed to prove the authenticity of the SOAP message origin from the Spaces application. The Spaces application supports six types of security tokens: WSS 1.0 Username Token Without Password, WSS 1.0 Username Token With Password, WSS 1.0 SAML Token, WSS 1.0 SAML Token With Message Integrity, WSS 1.0 SAML Token With Message Protection, and WSS 1.1 SAML Token With Message Protection.


Table 6-16 WSRP Portlet Producer Registration - Security

	Field	Description
	
Token Profile

	
Select the type of token profile to use for authentication with this WSRP producer:

	
None—No security on this connection. If you select None, no WS-Security header is attached to the SOAP message.


	
WSS 1.0 SAML Token—This policy provides SAML-based authentication for outbound SOAP request messages in accordance with the WS-Security 1.0 standard. The policy propagates user identity and is typically used in intra departmental deployments where message protection and integrity checks are not required.

This policy does not require any keystore configuration.


	
WSS 1.0 SAML Token with Message Integrity—This policy provides message-level integrity protection and SAML-based authentication for outbound SOAP requests in accordance with the WS-Security 1.0 standard. A SAML token, included in the SOAP message, is used in SAML-based authentication with sender vouches confirmation. This policy uses WS-Security's Basic 128 suite of asymmetric key technologies and SHA-1 hashing algorithm for message integrity.


	
WSS 1.0 SAML Token with Message Protection—This policy provides message-level protection (integrity and confidentiality) and SAML-based authentication for outbound SOAP requests in accordance with the WS-Security 1.0 standard. The Web service consumer includes a SAML token in the SOAP header and the confirmation type is sender-vouches. This policy uses WS-Security's Basic 128 suite of asymmetric key technologies. Specifically, RSA key mechanisms for message confidentiality, SHA-1 hashing algorithm for message integrity, and AES-128 bit encryption.

When you select this policy, you must also specify the Recipient Alias.


	
WSS 1.0 Username Token with Password—This policy provides username (with password) token profile based identity propagation with certificate based message protection for outbound SOAP requests in accordance with the WS-Security v1.0 standard. Both plain text and digest mechanisms are supported. This policy uses WS-Security's Basic128 suite of asymmetric key technologies. Specifically, RSA key mechanism for message confidentiality, SHA-1 hashing algorithm for message integrity, and AES-128 bit encryption.

Use this token profile if the WSRP producer has a different identity store. You must define an external application pertaining to the producer and associate the external application with this producer. The external application defined here is used to retrieve and propagate the user credentials to the producer. The producer verifies this against the identity store configured for the external application.

When you select this policy, you must also specify the Recipient Alias.





	
Token Profile (Cont.)

	
	
WSS 1.0 Username Token without Password—This policy provides username (with password) token profile based identity propagation with certificate based message protection for outbound SOAP requests in accordance with the WS-Security 1.0 standard. Credentials (username only) are included in outbound SOAP request messages through a WS-Security UsernameToken header. No password is included. Message protection is provided using WS-Security 1.0's Basic128 suite of asymmetric key technologies. Specifically, RSA key mechanisms for message confidentiality, SHA-1 hashing algorithm for message integrity, and AES-128 bit encryption.

When you select this policy, you must also specify the Recipient Alias.


	
WSS 1.1 SAML Token with Message Protection—This policy provides message-level protection (integrity and confidentiality) and SAML token population for outbound SOAP requests in accordance with the WS-Security 1.1 standard. A SAML token, included in the SOAP message, is used in SAML-based authentication with sender vouches confirmation. This policy uses the symmetric key technology for signing and encryption, and WS-Security's Basic128 suite of asymmetric key technologies for endorsing signatures.





	
Recipient Alias

	
Specify the key store alias that is associated with the producer's certificate.

This certificate is used to encrypt the message to the producer.

Valid for: WSS 1.0 SAML Token With Message Protection, WSS 1.1 SAML Token with Message Protection and WSS 1.0 Username Without Password.


	
Default User

	
Enter a user name to assert to the remote producer when the user is not authenticated with the Spaces application.

When unauthenticated, the identity anonymous is associated with the application user. OWSM does not currently support the propagation of an anonymous identity, so you must specify an alternative identity here. Keep in mind though, that in this case, the Spaces application has not authenticated the user so the default user you specify should be a low privileged user in the remote producer that is an appropriate identity to use for showing public content. For example, you may want to create a guest account in the identity store for this purpose. If the user has authenticated to the application, then the user's identity is asserted rather than the default user.

The remote WSRP producer must be set up to accept this information. You must also add a grant to the policy store as described in the section "Adding a Grant to the Policy Store for a Mapped User Identity" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Valid for: WSS 1.0 SAML Token With Message Integrity, WSS 1.0 SAML Token With Message Protection, WSS 1.0 SAML Token, WSS 1.1 SAML Token with Message Protection and WSS 1.0 Username Without Password.


	
Associated External Application

	
If this producer uses an external application for authentication, use the Associated External Application dropdown list to identify the application.

An external application is required to support producers using the security option WSS 1.0 Username Token With Password. The external application stores and supplies the user credentials. See also Section 6.6, "Registering External Applications."

Valid for: WSS 1.0 Username With Password only.








	
Click Test to test the registration.


	
Click Ok.









6.5.2.2 Registering an Oracle PDK-Java Producer

When you register a PDK-Java portlet producer, you provide basic information that describes the producer's operational parameters. This information is used by the Spaces application to communicate with the producer and with the portlets through the producer.

To register an Oracle PDK-Java portlet producer for use in Spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
From the menu bar, click Register.


	
In the Register Portlet Producer page, in the Name and Type section, enter basic information for the portlet producer. See Table 6-17.


Table 6-17 PDK-Java Portlet Producer Registration - Name and Type

	Field	Description
	
Producer Name

	
Enter a unique name to identify this portlet producer registration within the Spaces application. The name must be unique across all connection types within the application.


	
Producer Type

	
Select Oracle PDK-Java Producer.








	
In the Portlet Producer URL section, enter connection details for the Oracle PDK-Java producer. See Table 6-18.


Table 6-18 PDK-Java Portlet Producer Registration - Portlet Producer URL

	Field	Description
	
URL Endpoint

	
Enter the Oracle PDK-Java producer's URL using the following syntax:


http://host:port/context_root/providers


where:

	
host is the server where the producer is deployed


	
port is the HTTP Listener port number


	
context_root is the Web application's context root





	
Service ID

	
Enter the unique identifier for this producer.

PDK-Java enables you to deploy multiple producers under a single adapter servlet. Producers are identified by their unique service ID. A service ID is required only if the service ID is not appended to the URL Endpoint.

The service ID is used to look up a file called serviceId.properties, which defines the characteristics of the portlet producer, such as whether to display its test page. If you do not specify a service ID, the _default.properties file is used instead.


	
Use Proxy?

	
Select if the Spaces application and the remote portlet producer are separated by a firewall and must use an HTTP proxy for communication. If selected, enter values for Proxy Host and Proxy Port.


	
Proxy Host

	
Enter the address for the proxy server.

Do not prefix http:// to the proxy server name.


	
Proxy Port

	
Enter the port number on which the proxy server listens. The default port is 80.


	
Associated External Application

	
Select the relevant external application if one of this producer's portlets requires authentication.

See also Section 6.6, "Registering External Applications."


	
Establish Session?

	
Select to enable a user session when executing portlets from this producer. When sessions are enabled, they are maintained on the producer server. This allows the portlet code to maintain information in the session.

Message authentication uses sessions, so if you specify a shared key, you must also select this option.

For sessionless communication between the producer and the server, do not select this option.








	
In the Advanced Configuration section, specify additional information for the PDK-Java producer. See Table 6-19.


Table 6-19 PDK-Java Portlet Producer Registration - Advanced Configuration

	Field	Description
	
Default Execution Timeout

	
Enter a suitable timeout for communications with the producer, in seconds. For example, the maximum time the producer may take to register, deregister, or display portlets on pages. The default is 30 seconds.

Individual portlets may define their own timeout period, which takes precedence over the value specified here.


	
Subscriber ID

	
Enter a string to identify the consumer of the producer being registered.

When a producer is registered with an application, a call is made to the producer. During the call, the consumer ( Spaces in this instance) passes the value for Subscriber ID to the producer. If the producer does not see the expected value for Subscriber ID, it might reject the registration call.


	
Shared Key

	
Enter a shared key to use for producers that are set up to handle encryption.

The shared key is used by the encryption algorithm to generate a message signature for message authentication. Note that producer registration fails if the producer is set up with a shared key and you enter an incorrect shared key here. The shared key can contain between 10 and 20 alphanumeric characters.

This key is also used when registering a producer using the Federated Portal Adapter (FPA). The Shared Key is also known as the HMAC key.








	
Click Test to test the registration.


	
Click Ok.









6.5.2.3 Registering a Pagelet Producer

This section describes how to register a Pagelet Producer using Spaces Administration.

To register a pagelet producer for use in Spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
From the menu bar, click Register.


	
In the Register Portlet Producer page, in the Name and Type section, enter basic information for the pagelet producer. See Table 6-20.


Table 6-20 Pagelet Producer Registration - Name and Type

	Field	Description
	
Producer Name

	
Enter a unique name to identify this pagelet producer registration within the Spaces application. The name must be unique across within the application.

The name you specify here appears in Composer under the Mash-ups >Pagelet Producers folder (by default).


	
Producer Type

	
Select Pagelet Producer.








	
In the Portlet Producer URL section, enter connection details for the pagelet producer. See Table 6-21.


Table 6-21 Pagelet Producer Registration - Portlet Producer URL

	Field	Description	Producer Type
	
Server URL

	
Enter the URL of the WebCenter Portal's Pagelet Producer. The URL must include a fully-qualified domain name. Use the following syntax:


protocol://host:port/pagelets


For example: http://myhost.example.com:7778/pageletsIf pagelets carry secure data, the URL registered must use the HTPPS protocol. For example: https://myhost.com:7779/pagelets

In the Spaces application, if the Pagelet Producer URL is protected by OAM, the URL to the pagelet catalog must be excluded (mapped directly without access control), or the catalog will appear to be empty when using REST. The pagelet catalog URL is: http://proxy_host:proxy_port/pagelets/api/v2/ensemble/pagelets

	
Pagelet








	
Click Test to test the registration.


	
Click Ok.











6.5.3 Working with the Producer Registration Task Flow

To manage portlet producers through the Producer Registration task flow, you must have the following roles and permissions:

	
AppConnectionManager role—Enables you to manage portlet producers.


	
View Page permission—Enables access to the page containing the task flow. See Section 23.1, "Setting Access on a Page."




This section includes the following subsections:

	
Section 6.5.3.1, "Adding the Producer Registration Task Flow to a Page"


	
Section 6.5.3.2, "Registering Producers Through the Producer Administration Task Flow."


	
Section 6.5.3.3, "Setting Producer Task Flow Properties."






6.5.3.1 Adding the Producer Registration Task Flow to a Page

To add a Producer Registration task flow:

	
Go to the page where you want to add the task flow, and open it in Composer.

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Composer, click the Add Content button to open the Add Content dialog.


	
In the Add Content dialog, open Portlets.


	
In the Portlets folder, open Administration.


	
In the Administration folder, click the Add link next to the Producer Registration task flow. This adds the task flow to the page.


	
Click Close to exit Add Content dialog.









6.5.3.2 Registering Producers Through the Producer Administration Task Flow

When you have added the Producer Administration task flow to your page, you can register any portlet producer as described in the following tables in Section 6.5.2, "Registering Portlet Producers Through Spaces Administration":

	
WSRP Producers

	
Table 6-13, "WSRP Producer Registration - Name and Type"


	
Table 6-14, "WSRP Portlet Producer Registration - Portlet Producer URL"


	
Table 6-15, "WSRP Portlet Producer Registration - Advanced Configuration"


	
Table 6-16, "WSRP Portlet Producer Registration - Security"





	
Oracle PDK-Java Producers

	
Table 6-17, "PDK-Java Portlet Producer Registration - Name and Type"


	
Table 6-18, "PDK-Java Portlet Producer Registration - Portlet Producer URL"


	
Table 6-19, "PDK-Java Portlet Producer Registration - Advanced Configuration"





	
Pagelet Producers

	
Table 6-20, "Pagelet Producer Registration - Name and Type"


	
Table 6-21, "Pagelet Producer Registration - Portlet Producer URL"







See also, Section 6.5.4, "Deregistering Portlet Producers."






6.5.3.3 Setting Producer Task Flow Properties

The Producer Registration task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 6-10).

Most properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components".


Figure 6-10 Producer Registration Task Flow Component Properties

[image: Description of Figure 6-10 follows]

Description of "Figure 6-10 Producer Registration Task Flow Component Properties"





Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties".

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events".

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components".

All properties on Display Options tab provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions".




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.
















6.5.4 Deregistering Portlet Producers

If you no longer want to use a particular producer in Spaces, you can deregister the producer. When you deregister a producer, registration data is removed from both the Spaces application and the remote producer:

	
Spaces - The producer connection is deleted and producer metadata is also deleted.


	
Remote producer - Portlet instances are deleted (not the portlets themselves).




Portlet instances are not removed from Spaces pages. In place of the portlet, users see a "Portlet unavailable" message.

To deregister a portlet producer:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
Select the portlet producer that you want to remove.


	
From the menu bar, click Deregister.











6.6 Registering External Applications

An external application is any application that implements its own authentication process. Specifically, it is an application that does not take part in your Spaces single sign-on process. If Spaces interacts with another application that handles its own authentication, you can associate Spaces with an external application definition to allow for credential provisioning. In doing so, you use an external application definition to provide a means of accessing content from these independently authenticated applications. The WebCenter Portal services such as, Mail, IMP, Documents, portlet producers associate external applications with their connections to use the user credential management feature and to connect and access content from these independently authenticated applications.

You can manage external applications through the Services tab in the Spaces Administration page, the External Application task flow, and the Application Navigator task flow. These features are discussed in details in the following subsections:

	
Section 6.6.1, "What You Should Know About External Applications"


	
Section 6.6.2, "Registering External Applications Through Spaces Administration"


	
Section 6.6.3, "Working with Task Flows for External Applications"


	
Section 6.6.4, "Deleting External Applications"






6.6.1 What You Should Know About External Applications

To be able to register and manage external applications in Spaces, a user be assigned the AppConnectionManager role. By default, users with the Spaces Administrator role are assigned this role; and therefore, administrators can configure external applications.

You can grant any other user this capability through Fusion Middleware Control or WLST command grantAppRole. For example, the following grantAppRole WLST command grants the AppConnectionManager role to the user monty.


grantAppRole(appStripe='webcenter', appRoleName='AppConnectionManager',
principalClass='weblogic.security.principal.WLSUserImpl', principalName='monty')


For more information about this command, see the section "grantAppRole" in the Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.

See also, "Granting Application Roles Through Fusion Middleware Control" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.






6.6.2 Registering External Applications Through Spaces Administration

To register external applications through Spaces Administration you must have the following roles and permissions:

	
AppConnectionManager role - Enables you to manage external applications. See also, "Granting Application Roles Through Fusion Middleware Control" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Application - Manage Configuration permission - Enables access to the Spaces Administration page.




To register an external application for use in the Spaces application:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, select External Applications.


	
To register a new external application, click Register (Figure 6-11).


Figure 6-11 Registering External Applications

[image: Configuring External Applications]

Description of "Figure 6-11 Registering External Applications"





External application options display (Figure 6-12).


Figure 6-12 Configuring External Application Connections
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Enter a unique name for the external application and a display name that Spaces users working with this external application will see.

See also, Table 6-22.


Table 6-22 External Application Connection - Name

	Field	Description
	
Application Name

	
Enter a name to identify the application within the Spaces application. The name must be unique (across all connection types) within the Spaces application.

For example: yahoo

Note: Once registered, you cannot edit the Application Name.


	
Display Name

	
Enter a user friendly name for the application that Spaces users will recognize. Spaces end-users working with this external application will see the display name you specify here.

The display name must be unique across all external applications within Spaces.

For example: My Yahoo

If you leave this field blank, the Application Name is used.








	
Enter login details for the external application.

For details, see Table 6-23.


Table 6-23 External Application Connection - Login Details

	Field	Description
	
Enable Automatic Login

	
Select to allow automatically log users in to this application. Choosing this option requires you to complete the Login URL, HTML User ID Field Name, and HTML User Password Field Name fields

With automated single sign-on, the user directly links to the application and is authenticated automatically, as their credentials are retrieved from the credential store. Selecting this option provides the end user with a seamless single sign-on experience.

Note: Automated login is not supported for:

	
External applications using BASIC authentication.


	
External applications configured for SSO.


	
External applications with a customized login form (built using ADF Faces) that does not implement the J2EE security container login method j_security_check for authentication.


	
External sites that do not support UTF8 encoding.





	
Login URL

	
Enter the login URL for the external application.

To determine the URL, navigate to the application's login page and record the URL.

For example: http://login.yahoo.com/config/login

Note: A login URL is not required if the sole purpose of this external application is to store and supply user credentials on behalf of another service.


	
HTML User ID Field Name

	
Enter the name that identifies the "user name" or "user ID" field on the login form.

Tip: To find this name, look at the HTML source for the login page.

This property does not specify user credentials.

Note: Mandatory if the Authentication Method is GET or POST and a Login URL is specified. Leave this field blank if the application uses the basic authentication.


	
HTML User Password Field Name

	
Enter the name that identifies the "password" field on the login form.

Tip: To find this name, look at the HTML source for the login page.

Note: You must complete this field if the Authentication Method is GET or POST. Leave this field blank if the application uses basic authentication (see Authentication Method).








	
Select the authentication method used by the external application.

For details, see Table 6-24.


Table 6-24 External Application Connection - Authentication Details

	Field	Description
	
Authentication Method

	
Select the form submission method used by the external application. Choose from one of the following:

	
GET: Presents a page request to a server, submitting the login credentials as part of the login URL. This authentication method may pose a security risk because the user name and password are exposed in the URL.


	
POST: Submits login credentials within the body of the form. This is the default.


	
BASIC: Submits login credentials to the server as an authentication header in the request. This authentication method may pose a security risk because the credentials can be intercepted easily and this scheme also provides no protection for the information passed back from the server. The assumption is that the connection between the client and server computers is secure and can be trusted.




The Authentication Method specifies how message data is sent by the browser. You can find this value by viewing the HTML source for the external application's login form, for example, <form method="POST" action="https://login.yahoo.com/config/login?" AutoComplete="off">








	
Specify additional login fields and details, if required.

For details, see Table 6-25.


Table 6-25 External Application Connection - Additional Login Fields

	Field	Description
	
Additional Login Fields

	
If your application requires additional login criteria, expand Additional Login Fields.

For example, in addition to user name and password, the Lotus Notes application requires two additional fields - Host and MailFilename.

Click Add to specify an additional field for the login form. For each new field, do the following:

	
Name - Enter the name that identifies the field on the HTML login form that may require user input to log in. This field is not applicable if the application uses basic authentication.


	
Value - Enter a default value for the field or leave blank for a user to specify. This field is not applicable if the application uses basic authentication.


	
Display to User - Select to display the field on the external application login screen. If the field is not displayed (unchecked), then a default Value must be specified.




Click Delete to remove a login field.








	
Specify shared and public user credentials, if required.

For details, see Table 6-26.


Table 6-26 External Application Connection - Shared User and Public User Credentials

	Field	Description
	
Enable Shared Credentials

	
Indicate whether this external application enables shared user credentials, and specify the credentials. Select Enable Shared Credentials, and then enter User Name and Password credentials for the shared user.

When shared credentials are specified, every user accessing this external application, through Spaces, is authenticated using the user name and password defined here. Users are not presented with a login form.

Because users do not need to define personal credentials of their own, external applications with shared credentials are not listed in the external application's change password task flows such as My Accounts (see also Section 35.7, "Providing Login Information for External Applications".)


	
Enable Public Credentials

	
Indicate whether unauthenticated users (public users) may access this external application. Select Enable Public Credentials, and then enter User Name and Password credentials for the public user.

When public credentials are specified, public users accessing this external application through Spaces public pages are logged in using the user name and password defined here. If public credentials are not specified, public users will see an authorization error indicating this external application is not accessible to public users.








	
Click OK to register the application.









6.6.3 Working with Task Flows for External Applications

To register external applications through an external application task flow you must have the following roles and permissions:

	
AppConnectionManager role - Enables you to manage external applications. See also, "Granting Application Roles Through Fusion Middleware Control" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
View Page permission - Enables access to the page containing the task flow. See also, Section 23.1, "Setting Access on a Page."




This section includes the following subsections:

	
Section 6.6.3.1, "Adding an External Application Task Flow to a Page"


	
Section 6.6.3.2, "Registering External Applications Through the External Application Task Flow"


	
Section 6.6.3.3, "Adding an Application Navigator Task Flow to a Page"


	
Section 6.6.3.4, "Making External Applications Available through the Application Navigator Task Flow"


	
Section 6.6.3.5, "Setting External Application Task Flow Properties"






6.6.3.1 Adding an External Application Task Flow to a Page




	
Note:

External applications links exposed in the Application Navigator task flow are not automatically removed when an external application is deleted. To prevent unsuccessful access attempts, administrators are advised to remove links to unavailable applications.







To add an External Application task flow:

	
Go to the page where you want to add a task flow, and open it in Composer.

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Composer, click the Add Content button to open the Add Content dialog.


	
In the Add Content dialog, open Portlet Administration, as shown in Figure 6-13.


Figure 6-13 Add Content dialog - Portlet Administration
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In the Portlet Administration folder, click the Add link next to the External Application task flow.


	
In the Add Content dialog, click Close. This adds the task flow to the page, as shown in Figure 6-14.


Figure 6-14 External Application Task Flow in a Page
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6.6.3.2 Registering External Applications Through the External Application Task Flow

Once you have added the External Application task flow to your page, you can register any external application as described in the following tables in Section 6.6.2, "Registering External Applications Through Spaces Administration":

	
Table 6-22, "External Application Connection - Name"


	
Table 6-23, "External Application Connection - Login Details"


	
Table 6-24, "External Application Connection - Authentication Details"


	
Table 6-25, "External Application Connection - Additional Login Fields"


	
Table 6-26, "External Application Connection - Shared User and Public User Credentials"




See also, Section 6.6.4, "Deleting External Applications."






6.6.3.3 Adding an Application Navigator Task Flow to a Page

The Application Navigator task flow enables centralized access to frequently used Web applications. Once links to your applications are set up, you simply click links to launch your day-to-day applications, and if necessary, supply your user name and password information.

Other users may not want to see all the applications offered through the Applications Navigator. If this is the case, individuals may personalize their view to show only those applications they want to access.

The Applications Navigator can launch different types of application:

	
External Applications - Web-based, external applications that perform their own user authentication.


	
Task Flows - Built-in task flows specific to WebCenter Portal: Spaces. Any of these can be launched directly from the Applications Navigator.





Before You Begin:

	
Ensure that the Application Navigator task flow is included in the Resource Catalog you will use for your page. The Application Navigator task flow is not available in the Resource Catalog by default. To add this task flow to your Resource Catalog, follow the steps described in Section 16.3.1.2, "Adding Resources" and select Task Flows from the library. The Task Flows option in the Add Resource Catalog Item dialog includes the Application Navigator task flow, as shown in Figure 6-15.


Figure 6-15 Add Resource Catalog Item
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Description of "Figure 6-15 Add Resource Catalog Item"





	
Consider the points described in Section 6.6.1, "What You Should Know About External Applications."




To add an Application Navigator task flow:

	
Go to the page in which you want to add a task flow, and open it in Composer.

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Composer, click the Add Content button to open the Add Content dialog.


	
In the Add Content dialog, select Application Navigator, as shown in Figure 6-16, and click the Add link.


Figure 6-16 Add Content - Application Navigator
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In the Add Content dialog, click Close.

This adds the task flow to the page, as shown in Figure 6-17.


Figure 6-17 Application Navigator Task Flow in a Page
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Section 6.6.3.4, "Making External Applications Available through the Application Navigator Task Flow" describes how to add links to frequently used applications or task flows.









6.6.3.4 Making External Applications Available through the Application Navigator Task Flow

Use the Application Navigator to display links to external applications registered with Spaces and also links to any of the built-in task flows.

Some users may not want to see all the applications offered through the Applications Navigator. If this is the case, individuals may personalize their view to show only those applications they want to access.

To expose an application or task flows through the Applications Navigator:

	
In the page in which you added the Application Navigator task flow, click Edit applications (spanner icon) available for the task flow.

If you do not have edit privileges you will not see this icon.


	
To add a link to an application, select the folder where you want the link to appear, and then click the green Add icon.

To add a new folder, click the New icon. To create a subfolder, expand the parent folder first.


	
Navigate to the external application or task flow you require, and click its associated Add link.

	
To navigate to a previously registered external application, expand the External Applications node, and then expand the required application.

Only registered external applications which have a Login URL defined appear in this list. If the application you want is not listed, ask your Spaces administrator to register the application for you. See also Section 6.6.3.2, "Registering External Applications Through the External Application Task Flow".


	
To navigate to a task flow, expand the WebCenter Task Flows node. If necessary, expand one or more subfolders to access the required task flow.




If you are not sure of the exact name, enter a full or partial search term in the Search box, and then click Find to search for the application. Application names matching your search criteria are displayed.

An information message displays indicating whether the application link was successful.


	
Click OK to dismiss the message box.


	
To add another application, repeat steps 4 and 5.


	
Click OK to return to the Edit Applications dialog.

The selected application(s) appears within your chosen folder. From here, you can change the display name for the application link and set other display-related properties.


	
To edit link details for an application, highlight the row in the table and then click the Edit icon.

The Edit Application Link dialog opens.


	
Edit the link display properties, as required.

For details, see Table 6-27, "Application Link Properties":


Table 6-27 Application Link Properties

	Property	Description
	
Name

	
Enter the link text that Spaces users will click to launch the application.


	
Location

	
(Read-only) Displays the internal name for the application or task flow.


	
Open Behavior

	
Choose how the application displays when users click the link:

	
WebCenter Tab - Application displays as a tab, and the application displays there. The current Spaces context is maintained.


	
New Window - Application opens in a new browser window. The current Spaces context is maintained. This is the default selection.


	
Current Window - Application opens in the current browser window (in place of the Spaces application).





	
Type

	
(Read-only) Displays the link type: EXTAPP - External application or TASKFLOW - WebCenter task flow


	
Icon

	
Associate an icon with the application. Enter a full qualified URL or a relative URL that specifies the location of a valid icon.

The icon displays alongside the link in the Application Navigator. For best results, choose an icon that is 16 x 16 pixels.


	
Created On

	
Shows when the link was created.


	
Last Visited On

	
Shows the last time a user clicked the link.

If a link is not used very often or at all, you might consider removing it from the Application Navigator.


	
Locked

	
Indicate whether users are allowed to show/hide the link.

Select Locked to prevent users from showing/hiding the link. Deselect Locked to let the user decide whether the link displays in their personal view. Individuals users can show or hide the link depending of whether they need access to the application from the Sidebar.


	
Visible

	
Indicate whether users see a link to this application in the Applications pane.

Select Visible to show the link. Deselect Visible to hide the link.








	
Click OK to save.


	
Click Close to dismiss the Edit Application Link dialog.




If you choose not to lock application links, other users, including yourself, can hide/show links in the Application Navigator task flow by clicking Personalize applications (pencil icon), as shown in Figure 6-18.


Figure 6-18 Personalize Applications
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6.6.3.5 Setting External Application Task Flow Properties

The External Application task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 6-19).

The properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components".


Figure 6-19 External Application Task Flow Component Properties
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Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties".

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events".

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components".

All properties on Display Options tab provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions".








6.6.4 Deleting External Applications

To delete an external application:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration, then Services.


	
Under Services & Providers, select External Applications.


	
Select the name of the external application you want to remove, and click Deregister.







	
Note:

If you also manage external applications through the Application Navigator task flow, ensure that you manually remove the external applications links added through this task flow, to prevent unsuccessful access attempts.

















7 Preparing Your Initial Portal Pages

In the process of constructing your portal, you may want to brand the Welcome page that all users see when they first access your portal, add a hint to the login page or the self-registration page, or place additional components on the default pages that users see in their view of the Home space. Such pages, called system pages, are provided out of the box and are partly or wholly customizable.

You can also start your portal out with a set of pages that are targeted to a specific type of user, such as a page for all members of your sales team, all department heads, all engineers, and the like. Such pages, called business role pages, are exposed to targeted users in their views of the Home space.

Finally, as an application administrator, you can view, revise, and manage all personal pages that users have added to their views of the Home space.

This chapter provides overviews of personal, business role, and system pages and describes how to work with them. It includes the following sections:

	
Section 7.1, "Working with Business Role Pages"


	
Section 7.2, "Working with Personal Pages"


	
Section 7.3, "Working with System Pages"





Audience

This chapter is intended for administrator-level users tasked with setting up the pages users see when they access your portal. Among these are the welcome, login, and self-registration pages; pages that are targeted to a particular business role, such as sales, engineering, and finance; and the like. This chapter includes information about providing administrative services for the personal pages that users create in their views of the Home space.

Application administrators are users who are granted the Administrator role or a custom role that grants the Application-Manage permission.




	
Note:

To enable a user to edit, delete, or perform all actions on system and business role pages, you must grant them the Application-Manage permission.









7.1 Working with Business Role Pages

Business role pages provide a means of exposing highly relevant content to a specific audience. Business role pages are pages targeted to a particular type of group, or user (or user role), such as your sales force, your accounting team, your administrative staff. Business role pages are exposed to targeted users in their views of the Home space.

This section describes how to create and target business role pages and how to perform other related business role page management tasks. It includes the following subsections:

	
Section 7.1.1, "What You Should Know About Business Role Pages"


	
Section 7.1.2, "Setting Page Creation Defaults for Business Role Pages"


	
Section 7.1.3, "Creating a Business Role Page"


	
Section 7.1.4, "Specifying the Target Audience for a Business Role Page"


	
Section 7.1.5, "Revoking Access to a Custom Business Role Page"


	
Section 7.1.6, "Providing Navigation to Business Role Pages"


	
Section 7.1.7, "Setting a Default Display Order for Business Role Pages"


	
Section 7.1.8, "Editing a Business Role Page"


	
Section 7.1.9, "Copying a Business Role Page"


	
Section 7.1.10, "Removing All User Customizations from a Business Role Page"


	
Section 7.1.11, "Deleting a Custom Business Role Page"






7.1.1 What You Should Know About Business Role Pages

A business role page appears in the Home space views of all users who share the targeted business role, provided the administrator has set up a navigation model that publishes business role pages. For example, a business role page that targets all users assigned the HR_ORG role appears in the Home space views of all users assigned the role HR_ORG.




	
Tip:

Irrespective of the applied navigation model, business role pages are always available to targeted users on the Personalize Pages page For information about navigating to pages, see Section 29.3, "Hiding, Opening, and Rearranging Pages."







If an individual user who is not assigned the HR_ORG role wants to see the page, the application administrator can grant access to this user. This is true for the business role pages that you, as the administrator, create. Seeded business role pages (see Table 7-1) have preconfigured access settings that cannot be altered through the Spaces application UI. For information about how to alter access settings on seeded business role pages, see Section 7.1.4.3, "Setting Access on a Seeded Business Role Page."

A Spaces application administrator is the only type of user who can create a business role page. Only when an administrator grants permission to do so can other users edit, copy, and delete business role pages and change page permissions (for more information, see Section 7.1.4, "Specifying the Target Audience for a Business Role Page").

Table 7-1 lists and describes the seeded business role pages included in a default WebCenter Portal: Spaces installation and provides information about the context in which they appear.


Table 7-1 Seeded Business Role Pages

	Page	Description	Context
	
Activities

	
Displays the Activity Stream from the People Connections service and a Publisher task flow, which can be used to post content to the stream. For more information, see Section 32, "Tracking Your Connections' Activities," and Section 33, "Posting and Managing Messages and Feedback."

	
Appears by default in the Home space views of every authenticated (logged-in) user.


	
Analytics

	
Displays performance metrics related to the application, spaces, portlets, and services. For more information, see Chapter 55, "Analyzing Usage and Performance Metrics."

	
Is hidden by default, but can be accessed by application administrators on the Personalize Pages page in an administrator's view of the Home space.


	
Documents

	
Displays the Document Explorer task flow. For more information, see Section 41.1, "What You Should Know About the Documents Service Task Flows."

This page also appears on the System Pages subtab (for more information, see Section 7.3, "Working with System Pages").

	
Appears by default in the Home space views of every authenticated user.


	
My Profile

	
Displays the current user's Profile Gallery, which includes subpages for Activity Stream, Connections, Documents, an organization chart (Organization), and the user's profile details (About). For more information, see Chapter 30, "Managing Your Profile," and Section 41.1, "What You Should Know About the Documents Service Task Flows."

This page also appears on the System Pages subtab (for more information, see Section 7.3, "Working with System Pages").

	
Appears by default in the Home space views of every authenticated user.


	
Spaces

	
Displays spaces relevant to the current user, such as the spaces to which the user belongs or has access and the spaces that are discoverable by the user. Each listed space has an associated menu with options for performing actions on the space. This page also provides controls for creating spaces and searching for additional spaces.

	
Appears by default in the Home space views of every authenticated user.


	
Space Templates

	
Displays a list of default and custom space templates and provides a means of creating custom space templates and filtering the template list.

	
Is hidden by default, but can be accessed on the Personalize Pages page in the Home space views of every authenticated user.


	
Tag Center

	
Displays the Tag Center that is rendered when users click a tag in a Tags task flow or in search results. For more information, see Chapter 57, "Working with the Tags Service."

	
Invoked when users click tags.












7.1.2 Setting Page Creation Defaults for Business Role Pages

As the application administrator, you have the option of setting page creation defaults to reduce the number of steps required to create business role pages. That is, you can use page creation defaults to specify the options that are selected by default when you open the Create Page dialog. You can take this further by enforcing your selections, turning business role page creation into a one-click operation. When you enforce your selections, you are telling the application that you want to bypass the Create Page dialog and create business role pages based on your default selections.




	
See Also:

Administration-level page creation defaults apply to business role and personal pages. Authorized users can also set page creation defaults for personal pages created within the context of the Home space (for more information, see Section 38.1.1, "Setting Page Creation Defaults for Personal Pages"). Defaults for pages created within the context of a space are controlled by the space moderator (for more information, see Section 51.7, "Creating and Managing Space Pages").







To set page creation defaults for business role pages:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click Business Role Pages to view a list of all business role pages (Figure 7-1).

Alternatively, use the following URL to go to this page:


http://host:port/webcenter/spaces/admin/brpages



Figure 7-1 Business Role Pages
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Description of "Figure 7-1 Business Role Pages"





	
Click Set Page Defaults (Figure 7-2).


Figure 7-2 Set Page Defaults Option
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Description of "Figure 7-2 Set Page Defaults Option"





The Set Page Defaults dialog opens (Figure 7-3):


Figure 7-3 Set Page Defaults Dialog
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Description of "Figure 7-3 Set Page Defaults Dialog"





	
To set page creation defaults:

	
Select a layout from the Style dropdown list.




	
See Also:

For illustrations and descriptions of default page styles, see Table 15-2, "Default Page Styles".








	
Select an option next to Enable One-Click Page Creation:

Yes—When you create a business role page, skip the Create Page dialog, and create the page using the defaults you set here.

No—When you create a business role page, have the defaults you set here preselected in the Create Page dialog.





	
Click Save to save your changes and exit the dialog.




Going forward, when you create business role pages, the defaults you set here determine the style that is preselected for the new page and whether the Create Page dialog opens. When users create personal pages in the Home space, the defaults set here determine page creation behavior, provided authorized users have not overridden this application-level default with their personal page settings.




	
See Also:

Authorized users can also set their own page creation defaults for personal pages created within the context of the Home space (for more information, see Section 38.1.1, "Setting Page Creation Defaults for Personal Pages").












7.1.3 Creating a Business Role Page

To create a new business role page:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click Business Role Pages to view a list of all business role pages (Figure 7-4).

Alternatively, use the following URL to go to this page:


http://host:port/webcenter/spaces/admin/brpages



Figure 7-4 Business Role Pages
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Click Create New Business Role Page.

If you enabled one-click page creation, the new page opens. If you did not enable one-click page creation, continue with the next steps.


	
Enter a unique name for the page (Page Name), and then select a page style.




	
See Also:

For an overview of seeded page styles, see Table 15-2, "Default Page Styles".








	
Click Create to open the newly created page.




	
See Also:

The application administrator can set an attribute on a custom page style that determines whether a newly created page that is based on that style opens in page edit mode or page view mode. For more information, see Section 15.4.2, "Setting Properties on a Custom Page Style."







Later, you can add content to the page. The next section (Section 7.1.4) steps you through setting access permissions for the business role page.


	
Next steps:

	
Define the page audience, see Section 7.1.4, "Specifying the Target Audience for a Business Role Page."


	
Choose the page display order, see Section 7.1.7, "Setting a Default Display Order for Business Role Pages."


	
Add content to the page, see Chapter 18, "Adding and Configuring Page Layout Components," and Chapter 13, "Adding Spaces Components to Your Templates."












7.1.4 Specifying the Target Audience for a Business Role Page

The target audience for business role pages may change from time to time. For example, you may want the whole Sales team to see a page originally designed for a Product Development team. You may want to provide public access to the Marketing department's page. You may want to provide additional access privileges, such as the Edit Page privilege, to a selected department member.




	
Note:

You, as the application administrator, can set access on the business role pages that you create (for more information, see Section 7.1.4.1, "Setting Access on a Custom Business Role Page.").
You cannot alter the default access settings of seeded business role pages through the Spaces application UI (see Table 7-1, "Seeded Business Role Pages"). For information about how to set access on seeded business role pages, see Section 7.1.4.3, "Setting Access on a Seeded Business Role Page."









You can find controls for setting page access in the Personalize Pages page and on the Business Role Pages subtab of the Pages tab in the WebCenter Administration pages (Figure 7-5).


Figure 7-5 Set Page Access Option on a Business Role Page

[image: Set Page Access option on a business role page]

Description of "Figure 7-5 Set Page Access Option on a Business Role Page"





This section describes how to set specific access on a business role page as well as how to make such a page public. It includes the following subsections:

	
Section 7.1.4.1, "Setting Access on a Custom Business Role Page"


	
Section 7.1.4.2, "Providing Public Access to a Custom Business Role Page"


	
Section 7.1.4.3, "Setting Access on a Seeded Business Role Page"






7.1.4.1 Setting Access on a Custom Business Role Page

You, as the application administrator, can go through the Spaces application UI to set access on the business role pages that you create. But you cannot go through the Spaces application UI to set access on seeded business role pages (for information about setting access on seeded business role pages, see Section 7.1.4.3, "Setting Access on a Seeded Business Role Page").

To specify the target audience for a custom business role page that you created:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click Business Role Pages to view a list of all business role pages.

Alternatively, use the following URL to go to this page:


http://host:port/webcenter/spaces/admin/brpages


	
Click the Actions icon on the custom business role page for which you are setting access, and select Set Page Access from the resulting context menu (Figure 7-6).


Figure 7-6 Set Page Access Option on a Business Role Page
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Description of "Figure 7-6 Set Page Access Option on a Business Role Page"





The Set Page Access dialog opens (Figure 7-7).


Figure 7-7 Set Page Access Dialog
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Description of "Figure 7-7 Set Page Access Dialog"





	
To grant access permissions to all authenticated users, that is, to users who are logged in to the Spaces application, click Add Authenticated Access.

The authenticated-access role is added under Role or User.


	
To grant access permissions to all public users, that is, users who have not logged in (as well as those who have), click Add Public Access.

The role anonymous-role is added under Role or User.




	
See Also:

This method of enabling public access to a business role page provides a means of granting more than view access to public users. If you want to give such users view access only, you can set this quickly by following the steps in Section 7.1.4.2, "Providing Public Access to a Custom Business Role Page."








	
To grant access permissions to selected users, groups, and application roles, click Add Access.

The Add Access dialog opens (Figure 7-8).


Figure 7-8 Add Access Dialog
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Identify the users, groups, and application roles for whom to expose this business role page in the Home space.

Choose from all available users, groups, and application roles. Use the Search feature to search your identity store:

	
In the Search field, enter a search term for a user, group, or application role. For tips on searching the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
Tip:

This search is not case sensitive.








	
Click the Search icon.

Users, groups, and application roles matching your search criteria appear in the Add User dialog.


	
Select one or multiple names from the list.

Ctrl-Click to select multiple users.


	
Click Select.

The results of your selection appear in the Set Page Access dialog. By default, selected users have the View Page permission.





	
For each user name, group, or application role, select one or more checkboxes to grant page privileges:

	
View Page—Users can view the page but cannot perform any actions on the page.


	
Edit Page—Users can edit the page. This includes adding, rearranging, and deleting content, and changing the page scheme.


	
Delete Page—Users can delete the page.


	
Perform All Page Actions—Users have full access rights to the page. These users can edit the page, revise the page layout, set additional access privileges for other users, and all other page privileges.


	
Personalize Page—Users can change their personal view of the page. Such changes do not affect any other user's view of the page.







	
Tip:

To revoke a privilege, deselect the checkbox.








	
Click OK to save your changes.

The page is pushed to its target audience, who sees it in their views of the Home space the next time they log in to the Spaces application.









7.1.4.2 Providing Public Access to a Custom Business Role Page

You can specify that any user, whether logged in or not, can view a particular custom business role page. Such a page can be exposed in a public Home space, or you can publish the URL to the public business role page to provide all users easy access.




	
See Also:

The process described in this section enables all public users to view a selected custom business role page. To provide public users with additional permissions on the page, follow the steps described in Section 7.1.4.1, "Setting Access on a Custom Business Role Page."







To make a custom business role page public:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click Business Role Pages to view a list of all business role pages.

Alternatively, use the following URL to go to this page:


http://host:port/webcenter/spaces/admin/brpages


	
Click the Actions icon on the business role page for which you are setting access, and select Make Public (Figure 7-9).


Figure 7-9 Make Public Option on Page Actions Menu
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Description of "Figure 7-9 Make Public Option on Page Actions Menu"












7.1.4.3 Setting Access on a Seeded Business Role Page

Seeded business role pages, such as Activities and Spaces (see Table 7-1, "Seeded Business Role Pages"), are available to all users by default. Currently, the Spaces application UI does not provide a means of performing security-related operations on seeded business role pages. This means you cannot hide seeded business role pages from all users through the Spaces application UI. However, there is a workaround. You can use WSRP commands with MDS to change default values in pages.xml files.

To revise default security settings on seeded business role pages:

	
Export the pages.xml files for anonymous-role and authenticated-role from MDS.


exportMetadata(application='webcenter',server='WC_Spaces',toLocation=
   '/scratch/mdsdump', docs='/oracle/webcenter/page/scopedMD/
   s8bba98ff_4cbb_40b8_beee_296c916a23ed/role/anonymous-role/pages.xml')exportMetadata(application='webcenter',server='WC_Spaces',toLocation=
   '/scratch/mdsdump', docs='/oracle/webcenter/page/scopedMD/
   s8bba98ff_4cbb_40b8_beee_296c916a23ed/role/authenticated-role/pages.xml')


	
Go through these pages.xml files and, based on your requirement, mark business role pages hidden or shown:


<!-- Business Role Pages -->
   <pageDef id="Page_2eb852ac_10f5902cb2f__7ff7" 
   contentMRef="/oracle/webcenter/page/scopedMD/
   s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/
   ActivityStreamMainView.jspx" shared="false" hidden="false"/>...


	
Set hidden="true" for the pages that should be hidden.


	
Set hidden="false" for the pages that should be shown.





	
Upload the changed pages.xml files back to the repository:


importMetadata(application='webcenter',server='WC_Spaces',fromLocation=
   '/scratch/mdsdump', docs='/oracle/webcenter/page/scopedMD/
   s8bba98ff_4cbb_40b8_beee_296c916a23ed/role/anonymous-role/pages.xml')importMetadata(application='webcenter',server='WC_Spaces',fromLocation=
   '/scratch/mdsdump', docs='/oracle/webcenter/page/scopedMD/
   s8bba98ff_4cbb_40b8_beee_296c916a23ed/role/authenticated-role/pages.xml')











7.1.5 Revoking Access to a Custom Business Role Page

To revoke access privileges to a custom business role page:

	
Follow the steps in Section 7.1.4.1, "Setting Access on a Custom Business Role Page," to open the Set Page Access dialog.


	
Select the user, group, or application role from whom to revoke access, and click the Delete Access button (Figure 7-10).


Figure 7-10 Delete Access Option in Set Page Access Dialog
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Description of "Figure 7-10 Delete Access Option in Set Page Access Dialog"





	
Click Delete in the resulting confirmation dialog.









7.1.6 Providing Navigation to Business Role Pages

You have a couple of options for providing your users with navigation to business role pages:

	
You can make the page visible to all authorized users in one step, using the Show Page checkbox.


	
You can create a navigation link to a business role page.




This section describes how to use the Show Page option. It also provides a pointer to information about creating your own navigation.

This section includes the following subsections:

	
Section 7.1.6.1, "Showing and Hiding Business Role Pages"


	
Section 7.1.6.2, "Creating Navigation to a Business Role Page"






7.1.6.1 Showing and Hiding Business Role Pages

A control is available in the Spaces application Administration pages for instantly showing or hiding a business role page to all authorized users (authorized users are users who have been granted access to the business role page). Use the Show Page checkbox to expose the page in the navigation of all authorized users.

To show or hide a business role page in Home space navigation:

	
Go to the Pages page in the Spaces Administration page, and click the Business Role Pages link.

To get to this page, you can use the following URL:

http://host:port/webcenter/spaces/admin/brpages


	
For the page you want to show or hide:

	
Select the checkbox in the Show Page column to show the page in the Home space views of authorized users.


	
Clear the checkbox in the Show Page column to hide the page from view.












7.1.6.2 Creating Navigation to a Business Role Page

Once you make a business role page available to users through page permissions, you will likely also want to make it easy to access by including a link to it in your application navigation. This process is described in detail in Section 11.2.2.1, "Adding Resources to a Navigation Model Using the Edit Dialog."








7.1.7 Setting a Default Display Order for Business Role Pages

If you present business role pages in a logical order, the page content is more accessible and easier for users to navigate. As administrator, you can determine the initial order in which business role pages are presented to their intended audience. You can do this by dragging and dropping pages into the desired order or by clicking Rearrange icons.

Individual users can change the initial display order you specify by accessing the Personalize Pages page and using the provided icons. Additionally, they can hide the business role pages they do not use.




	
Note:

There are two locations from which to define the order and the visibility of pages: from the Administration pages (described here) and from the Personalize Pages page (described in Section 29.3.5, "Rearranging Page Order") . The difference between the two is that the Administration change is an application customization and the Personalize Pages change is a user customization. Keep in mind that user customizations override application customizations in a given user's view.







To change the display order of all business role pages:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to the Spaces Administration page, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Business Role Pages to view all business role pages.


	
Click the arrows in the Reorder column to change the display order (Figure 7-11).


Figure 7-11 Reorder Icons on Business Role Pages
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Alternatively, drag and drop pages into the desired order.









7.1.8 Editing a Business Role Page

Anyone granted the Edit Page permission on a business role page can edit that page. For these users, the editing process is the same as for regular pages (for more information, see Section 38.3, "Editing a Personal Page").

Administrators can also initiate an edit of a business role page from Spaces Administration pages.

To edit a business role page through Spaces Administration:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to the spaces Administration page, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Business Role Pages to view all business role pages.


	
Click the Actions icon on the page you want to edit, and select Edit Page from the resulting context menu (Figure 7-12).


Figure 7-12 Edit Option on Page Actions Menu
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Description of "Figure 7-12 Edit Option on Page Actions Menu"





The page opens in edit mode in Oracle Composer.


	
Edit the page, and click Save and then Close when you have finished.









7.1.9 Copying a Business Role Page

When you copy a business role page, you can save it as another business role page or as a personal page in your view of the Home space. If you make the copy another business role page, you must set access on the new page because access permissions from the original page are not copied (for more information, see Section 7.1.4, "Specifying the Target Audience for a Business Role Page").

To copy a business role page:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to the Spaces Administration page, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Business Role Pages to view all business role pages.


	
Click the Actions icon on the page you want to copy, and select Copy Page from the resulting context menu (Figure 7-13).


Figure 7-13 Copy Page Option on Page Actions Menu
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In the resulting dialog, enter a name for the new page (Figure 7-14).


Figure 7-14 Copy Page Dialog
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Description of "Figure 7-14 Copy Page Dialog"





	
Next to Copy as, specify whether the copy is a personal or business role page:

	
Select Business Role Page if you intend to push the copy out to a group of people with the same job role.


	
Select Personal Page if you intend to expose the copy only in your own application view (that is, as a personal page in your view of the Home space).





	
Click OK.

The new page opens in edit mode in Oracle Composer.


	
Optionally, edit the page, and click Save and then Close when you have finished.









7.1.10 Removing All User Customizations from a Business Role Page

A control is available for removing all user customizations from a selected business role page. Using this control removes such personal changes as rearrangement, resizing, or collapsing of task flows. It does this in each user's personal view of the business role page.

To remove all user customizations from all views of a business role page:

	
Go to the Pages subpage in the Spaces Administration page, and click the Business Role Pages link.

To get to this page, you can use the following URL:

http://host:port/webcenter/spaces/admin/brpages


	
From the Actions menu next to the target page, select Delete Personalization.


	
In the resulting dialog, click OK.

All user customizations added by users to their own views of the page are removed. That is, task flows are returned to their original positions and their original sizes; collapsed task flows are expanded; and so on.









7.1.11 Deleting a Custom Business Role Page

Anyone granted the Delete Page permission on a custom business role page can delete it. For these users, the process is the same as deleting regular pages (for more information, see Section 17.6, "Deleting Pages"). Administrators have the additional option of deleting custom business role pages from the Spaces Administration page.




	
Note:

No one can delete seeded business role pages (see Table 7-1, "Seeded Business Role Pages").







Once a custom business role page is removed from the Spaces application, it cannot be recovered. Deleted pages are permanently removed, and users previously assigned that page no longer see it in their views of the Home space.

To delete a custom business role page through Spaces Administration:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to Administration pages, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Business Role Pages to view all business role pages.


	
Click the Actions icon on the page you want to delete, and select Delete Page from the resulting context menu (Figure 7-15).


Figure 7-15 Delete Page Option on Page Actions Menu
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In the confirmation dialog, click Delete.











7.2 Working with Personal Pages

While individuals are primarily responsible for managing the content of their personal pages, it is important that administrators also have access. Administrators may be required to clean up or manage personal data when owners experience difficulties with their personal pages or leave the organization.

This section describes how to administer personal pages in WebCenter Portal: Spaces. It includes the following sections:

	
Section 7.2.1, "What You Should Know About Personal Page Administration"


	
Section 7.2.2, "Setting Application-Level Page Creation Defaults for Personal Pages"


	
Section 7.2.3, "Changing Access Permissions on a Personal Page"


	
Section 7.2.4, "Preventing Users From Creating Personal Pages"


	
Section 7.2.5, "Providing Navigation to Personal Pages"


	
Section 7.2.6, "Editing Personal Pages with Administrative Privileges"


	
Section 7.2.7, "Copying a Personal Page"


	
Section 7.2.8, "Removing All User Customizations from a Personal Page"


	
Section 7.2.9, "Deleting a Personal Page Through the Spaces Administration Page"






7.2.1 What You Should Know About Personal Page Administration

Personal pages are the pages users create in their personal views of the Home space. As the application administrator, you have full access to all users' personal pages. Full access means you can edit, copy, rename, set access, delete, and perform other like actions on any user's personal pages.

Application administrators can access everyone's personal pages from one, central place: the Spaces Administration page. Under Spaces Administration, the Pages tab provides access to a list of personal pages that includes information about who created the page and when it was last modified.

An Actions menu is associated with each listed page, providing access to options for editing, removing user customizations, copying, renaming, securing, deleting, and making the personal page public (Figure 7-16).


Figure 7-16 Page Actions Menu on a Personal Page

[image: Page Actions menu on Personal Pages subpage]

Description of "Figure 7-16 Page Actions Menu on a Personal Page"





Additional options include sending a mail message containing a link to the page and viewing information about the page.






7.2.2 Setting Application-Level Page Creation Defaults for Personal Pages

In addition to the page creation defaults authorized users can set for themselves (see Section 38.1.1, "Setting Page Creation Defaults for Personal Pages"), application administrators can set application-level page creation defaults for personal pages. Once configured, application-level page creation defaults affect the creation of all personal pages. This control (Set Page Defaults) is available on the Business Role Pages subpage of the Pages page in Spaces Administration (for more information, see Section 7.1.2, "Setting Page Creation Defaults for Business Role Pages").

Note, however, that the page creation defaults that authorized users set for themselves through the Personalize Pages page override the application-level settings described in this chapter.






7.2.3 Changing Access Permissions on a Personal Page

As the administrator, you are authorized to view and manage security for any page in your portal. This includes personal pages. Page owners normally determine who can see their pages, but, occasionally, when a page owner is not available, the administrator may be required to make changes.

To change access permissions for a personal page as the Spaces application administrator:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and click Personal Pages to view all personal pages.

You can also use the following URL to access the Personal Pages page:


http://host:port/webcenter/spaces/admin/personalpages


	
Click the Actions icon on the page you want to secure, and select Set Page Access from the resulting context menu (see Figure 7-16).

The Set Page Access dialog opens (Figure 7-17).


Figure 7-17 Set Page Access Dialog
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Description of "Figure 7-17 Set Page Access Dialog"





	
To set access for authenticated users, click Add Authenticated Access.

The authenticated-role is added under Role or User. Use this to set access permissions for all users who are logged in to your portal.


	
To set access for public users, click Add Public Access.

The anonymous-role is added under Role or User. Use this to set access permissions for all users who are not logged in to your portal.


	
To grant access to other users and roles, click Add Access to open the Add Access dialog (Figure 7-18).


Figure 7-18 Add Access Dialog
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Description of "Figure 7-18 Add Access Dialog"





	
Identify the users to enable to access this page.

Choose from all available users, groups, and application roles. Use the Search feature to search your identity store:

	
In the Search field, enter two or more characters and click the Search icon. For tips on searching the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
Tip:

This search is not case sensitive.







Users, groups, and roles matching your search criteria appear in the Add Access dialog.


	
Select one or more names from the list.

Ctrl-Click to select multiple users.


	
Click Select.

The results of your selection appear in the Set Page Access dialog. By default, users have the View Page permission on the page.





	
To modify the permissions assigned to a current user or role, select or deselect the appropriate permission checkboxes:

	
View Page—The selected user or role can access the page for viewing, but cannot perform any actions on the page.


	
Edit Page—The selected user or role can edit the page. This includes adding, rearranging, and deleting content.


	
Delete Page—The selected user or role can delete the page.


	
Perform All Page Actions—The selected user or role has full access rights to the page. The user can edit the page, revise the page layout, set additional access privileges for other users, and all other page permissions.


	
Personalize—The selected user or role can personalize the page. Personalizations are changes made to a page in view mode. Such changes do not affect any other user's view of the page.




	
Tip:

You can revoke privileges by taking the same steps and deselecting one or multiple privileges for a listed user or role.








	
To revoke access to the page, select the user or role and click Delete Access.





	
Click OK.









7.2.4 Preventing Users From Creating Personal Pages

You can revoke the application-level permission Create-Pages to prevent users from creating personal pages in the Home space. The Create-Pages application-level permission applies only to creating personal pages; the creation of pages in a space is controlled by the given space's own security settings (for information about space security settings, that is, space-level users and roles, see Section 51.5, "Managing Space Roles," and Section 51.6, "Managing Space Members").

The process of revoking an application-level permission is described in Section 21.2.3, "Modifying Application Role Permissions."






7.2.5 Providing Navigation to Personal Pages

If you want to add a link to a personal page in your application navigation, this process is described in detail in Section 11.2.2.1, "Adding Resources to a Navigation Model Using the Edit Dialog." For detailed information about working with application navigation, see Chapter 11, "Working with Navigation."






7.2.6 Editing Personal Pages with Administrative Privileges

As the administrator, you are authorized to view and modify any personal pages that users have created in their view of the Home space. Individuals are primarily responsible for editing content on their personal pages, but, occasionally, administrators may be required to clean up or edit such content.

To edit a personal page as the Spaces application administrator:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to Administration pages, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Personal Pages to view all personal pages.


	
Click the Actions icon on the page you want to edit, and select Edit Page from the resulting context menu (see Figure 7-16).

The page opens in Composer.




	
See Also:

To find out more about editing a page through Composer, see Section 17.3, "Editing Pages."








	
Update the page, and click Save and then Close when you have finished.









7.2.7 Copying a Personal Page

As the administrator, you are authorized to copy any page in the Spaces application. This includes other users' personal pages. When you copy a personal page as an administrator, you can save it as a business role page to be pushed to other users or as a personal page in your own view of the Home space.




	
Tip:

If you create another business role page, you must set access on the new page because access permissions from the original page are not copied. For more information, see Section 7.1.4, "Specifying the Target Audience for a Business Role Page."







To copy a personal page as an administrator:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to Administration pages, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Personal Pages to view all personal pages.


	
Click the Actions icon on the page you want to copy, and select Copy Page from the resulting context menu (Figure 7-19).


Figure 7-19 Copy Page Option on Page Actions Menu
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Description of "Figure 7-19 Copy Page Option on Page Actions Menu"





The Copy Page dialog opens (Figure 7-20).


Figure 7-20 Copy Page Dialog

[image: Copy Page dialog]

Description of "Figure 7-20 Copy Page Dialog"





	
Enter a name for the new page.


	
Next to Copy as, specify whether the copy is one of your personal pages or a business role page:

	
Select Business Role Page if you intend to push the page out to a group of people with the same job role.


	
Select Personal Page if you intend to expose the copy only in your own application view.





	
Click OK.

The new page opens in edit mode in Composer.


	
Optionally, update the page, and click Save and then Close to exit Composer.









7.2.8 Removing All User Customizations from a Personal Page

A control is available for removing all user customizations from a selected personal page. Using this control removes such personal changes as rearrangement, resizing, or collapsing of task flows. It does this in each user's personal view of the page.

To remove all user customizations from all views of a personal page:

	
Go to the Pages page in the Spaces Administration pages, and click the Personal Pages link.

To get to this page, you can use the following URL:

http://host:port/webcenter/spaces/admin/personalpages


	
From the Actions menu next to the target page, select Delete Personalization.


	
In the resulting dialog, click OK.

All user customizations added by users to their own views of the page are removed. That is, task flows are returned to their original positions and their original sizes; collapsed task flows are expanded; and so on.









7.2.9 Deleting a Personal Page Through the Spaces Administration Page

In addition to having full access to users' personal pages, an administrator can delete them. Once a personal page is removed, it cannot be recovered. Deleted pages are removed permanently.

To delete a personal page through Spaces Administration:

	
Navigate to the Spaces Administration page, and click the Pages tab to bring it forward.




	
See Also:

For information about navigating to Administration pages, see Section 4.1, "Accessing the Spaces Administration Page."








	
Click Personal Pages to view all personal pages.


	
Click the Actions icon on the page you want to delete, and select Delete Page from the resulting context menu.


	
In the confirmation dialog, click Delete.











7.3 Working with System Pages

System pages are provided out-of-the-box and are designed to fulfill a specific purpose. For example, in a default installation, users who are not logged in when they visit the Spaces application see the public WebCenter Welcome Page. The Welcome page appears because it allows access to the role anonymous-role that is provided to accommodate users who are not logged in, also known as public users.

System pages include a variety of utility pages that you can customize to reflect your company brand, to provide useful hints, or to display some other enhancement that you determine.

This section provides information about working with system pages. It includes the following subsections:

	
Section 7.3.1, "What You Should Know About System Pages"


	
Section 7.3.2, "Customizing System Pages"


	
Section 7.3.3, "Removing All Page Customizations from a System Page"






7.3.1 What You Should Know About System Pages

System pages are provided to support a rapid deployment of your portal. They fulfill a range of needs, from a finished introductory page (the Welcome page) to pages that provide content that is generated on the spot and tailored to the individual user (the Activity Stream page).

System pages are preconfigured with page access settings that target their anticipated audience. For example, the Welcome page is configured to target the anonymous-role, the Activity Stream page is targeted to individual users, with dynamic content that is tailored to each user. In view of this preconfiguration, you cannot alter the security settings of a system page.

You can, however, customize system pages. Customization enables you to enhance the seeded content of a system page to apply your company brand, add hint text, provide additional functionality (such as task flows and portlets), and the like.

System pages also make task flow customization possible. The system page Task Flow Editor provides an environment for customizing all instances of a seeded task flow in a given scope in one operation. (Custom task flows created through the Resource Manager cannot be edited using this page.) Authorized users can add seeded task flows to this page and then customize all instances of the task flow. For more information, see Chapter 8, "Customizing Task Flows at Runtime."

Table 7-2 lists and describes the system pages that are delivered out-of-the-box and provides information about the context in which they appear.


Table 7-2 Seeded System Pages

	Page	Description	Context
	
Activities

	
For the Home space, displays the Publisher task flow and the Activity Stream task flow from the People Connections service. For more information, see Chapter 32, "Tracking Your Connections' Activities."

	
This is an application-level system page.


	
Activity Stream

	
For a space, displays the Publisher task flow and the Activity Stream task flow from the People Connections service. For more information, see Chapter 32, "Tracking Your Connections' Activities."

	
Appears by default in the Home space of every authenticated (logged-in) user.

Both application- and space-level system pages are available.


	
Analytics

	
Provides information about application usage and performance metrics. For more information, see Chapter 55, "Analyzing Usage and Performance Metrics."

For Analytics task flows to work, the Analytics schema(ACTIVITIES) must be installed and configured, and a connection set up between the Spaces application and the Analytics Collector. For information about the Analytics schema and managing the Analytics service backend, see “Managing the Analytics Service” in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

	
Available for showing in the Home space through the Personalize Page. Useful only when configuration requirements are met (see information in Description column).

This is an application-level system page.


	
Announcements

	
Displays the Announcement Manager task flow. For more information, see Chapter 59, "Working with the Announcements Service."

	
Appears by default in many out-of-the-box space templates.

Both application- and space-level system pages are available.


	
Discussions

	
Displays the Discussion Forum Manager task flow. For more information, see Section 60.1, "What You Should Know About the Discussions Service."

	
Appears by default in many out-of-the-box space templates.

Both application- and space-level system pages are available.


	
Documents

	
Displays the Document Explorer task flow.

There are two Documents system pages: for the Home space, which shows the current user's personal documents; and one for spaces, which shows documents uploaded to that space.

For more information, see Section 41.1.1, "Understanding the Document Explorer Task Flow."

	
Appears by default in many out-of-the-box space templates.

Both application- and space-level system pages are available.


	
Error Encountered

	
Displays an error page when an error occurs

	
Appears when an application error occurs

This is an application-level system page.


	
Events

	
Displays the Events task flow. For more information, see Section 61.1, "What You Should Know About the Events Service."

	
Appears by default in many out-of-the-box space templates.

Both application- and space-level system pages are available.


	
Lists

	
Displays the List Manager task flow. For more information, see Section 64.1, "What You Should Know About the Lists Service."

	
Appears by default in many out-of-the-box space templates.

Both application- and space-level system pages are available.


	
Login

	
Provides fields for logging in to your portal.

	
Appears in lieu of the WebCenter Welcome Page when you disable public access to all application pages and when your current session expires.

This is an application-level system page.


	
Members

	
Provides features for managing the members of a space. For more information, see Chapter 52, "Managing Space Members and Roles."

	
Appears in the default navigation as the Members page in some seeded space templates, for example, the Team Space template.

Both application- and space-level system pages are available.


	
My Profile

	
Displays the current user's Profile Gallery, which includes subpages for Activity Stream, Connections, Documents, an organization chart (Organization), and the user's profile details (About). For more information, see Chapter 30, "Managing Your Profile," and Section 41.1, "What You Should Know About the Documents Service Task Flows."

	
Appears by default in the Home space of every authenticated (logged-in) user.

Both application- and space-level system pages are available.


	
No Pages Accessible

	
Displays a message telling the user that no pages are accessible.

	
Appears when a user navigates to a space in which he has no access permissions on the space's pages.

Both application- and space-level system pages are available.


	
Outlook Add-in Discussions

	
Displays content from the Discussions service in the context of an Outlook window. For more information, see Chapter 46, "Working with Microsoft Office and Explorer Integration."

	
Appears when you access content from the Discussions service through Microsoft Outlook

This is an application-level system page.


	
Outlook Add-in Documents

	
Displays content from the Documents service in the context of an Outlook window. For more information, see Chapter 46, "Working with Microsoft Office and Explorer Integration."

	
Appears when you access content from the Documents service through Microsoft Outlook

This is an application-level system page.


	
Outlook Add-in Events

	
Displays content from the Events service in the context of an Outlook window. For more information, see Chapter 46, "Working with Microsoft Office and Explorer Integration."

	
Appears when you access content from the Events service through Microsoft Outlook

This is an application-level system page.


	
Outlook Add-in Members

	
Displays content about space members in the context of an Outlook window. For more information, see Chapter 46, "Working with Microsoft Office and Explorer Integration."

	
Appears when you access content about the members of a given space through Microsoft Outlook

This is an application-level system page.


	
Outlook Add-in Space Home

	
Displays content from a space home page when you view it in the context of an Outlook window. For more information, see Chapter 46, "Working with Microsoft Office and Explorer Integration."

	
Appears when you access content from a space home page through Microsoft Outlook

This is an application-level system page.


	
Page Not Found

	
Displays a message telling the user that the page to which to navigate cannot be found

	
Appears when users navigate to a page that is no longer available in the Spaces application

This is an application-level system page.


	
Page Viewer

	
Displays an external web site (such as google.com) in a space, surrounded by the page template. For more information, see Chapter 11, "Working with Navigation."

	
Used when you create a Navigation model that contains an External URL item (with target Same Page). When users click on such links in the navigation, the Page Viewer is used.

Both application- and space-level system pages are available.


	
Resource Viewer

	
Displays a resource in a space, surrounded by the page template. For more information, see Chapter 11, "Working with Navigation."

	
Used when you create a Navigation model that contains a resource item (with target Same Page). When users click on such links in the navigation, the Resource Viewer is used.

Both application- and space-level system pages are available.


	
Search

	
Displays the Search Results page. For more information, see Chapter 56, "Working with the Search Service."

	
Renders dynamically to display the results of a search.

Both application- and space-level system pages are available.


	
Self Registration

	
Provides a means of enabling users to create their own login accounts to your portal. For more information, see Section 29.2, "Registering Yourself with WebCenter Portal: Spaces."

	
Opens in response to clicking the Register button on the Login or WebCenter Welcome Page.

This is an application-level system page.


	
Self-Service Membership

	
Provides a means of subscribing to a space that is configured to allow membership by subscription. For more information, see Section 49.7, "Joining a Space."

Note: This is a renamed system page. Its previous name was Subscribe.

	
Appears when a user initiates a subscription to a space.

Both application- and space-level system pages are available.


	
space Not Found

	
Displays a message telling the user that the space to which to navigate cannot be found

	
Appears when users navigate to a space that is no longer available in the Spaces application

This is an application-level system page.


	
Spaces

	
Provides a view of all spaces that the current user can access. Additionally provides features for creating, searching for, sorting, and filtering spaces. For more information, see Part XI, "Planning and Building a Space".

	
Appears when users select Browse Spaces from the Spaces menu.

This is an application-level system page.


	
Space Templates

	
Provides a view of all available space templates. Includes controls for creating, editing, and filtering space templates and viewing information about a selected space template. For more information, see Chapter 53, "Administering Spaces and Templates."

	
Appears in application administration pages on the Spaces page.

This is an application-level system page.


	
Tag Center

	
Displays the Tag Center task flow. For more information, see Chapter 57, "Working with the Tags Service," and particularly Section 57.2.7, "Working with Tags and Tagged Items in the Tag Center."

	
Appears when a user navigates to the Tag Center by one of several methods.

Both application- and space-level system pages are available.


	
Task Flow Editor

	
Provides an environment for customizing all instances of a seeded task flow in a given scope in one operation. (Custom task flows created through the Resource Manager are not supported.) For more information, see Chapter 8, "Customizing Task Flows at Runtime."

	
Authorized users can add seeded task flows to this page and then customize all instances of the task flow.

Both application- and space-level system pages are available.


	
Task Flow Viewer

	
Displays a task flow in a space, surrounded by the page template. For more information, see Chapter 11, "Working with Navigation."

	
Used when you create a Navigation model that contains a task flow item (with target Same Page). When users click on such links in the navigation, the Task Flow Viewer is used.

Both application- and space-level system pages are available.


	
Unauthorized

	
Displays a message telling users that they are not authorized to access a space or a page.

	
Appears when a user navigates to a space or a page on which he does not have access permission.

Both application- and space-level system pages are available.


	
Unavailable

	
Displays a message telling users that the space is not available.

	
Appears when a user navigates to a space that is offline.

Both application- and space-level system pages are available.


	
User Profile

	
Displays the Profile Gallery of a user other than the current user, which, by default, displays the same subpages and task flows as the current user's Profile Gallery. It differs in that it displays information associated with the other user.

	
Renders dynamically when the current user accesses another user's profile.

Both application- and space-level system pages are available.


	
WebCenter Portal Welcome Page

	
Displays login fields, a self-registration button, boilerplate information with links to help topics about specific features, a link to public spaces, and a language changer for the selection of an alternate session language.

	
This is the public welcome page. It is the first page users see when they access WebCenter Portal: Spaces.

If you decide to disable public access to all application pages, the public welcome page is not shown and users are directed to the Login page.

This is an application-level system page.











	
Caution:

Avoid adding a Connections - Network task flow to a system page. Adding the Connections - Network task flow to a system page causes an error that prevents you from editing any other task flow on the page. You can work around this issue by clicking the Restore Default link on the system page to undo all changes made to the page, including removing the Connections - Network task flow.
For information about the Restore Default link, see Section 7.3.3, "Removing All Page Customizations from a System Page."














7.3.2 Customizing System Pages

Users granted the permissions Application: Manage All and Pages: Create, Edit, and Delete Pages can customize certain aspects of system pages through Composer.




	
Note:

For convenience, we will call such users Administrators.







This section describes how to customize system pages at the application or space level. It includes the following subsections:

	
Section 7.3.2.1, "What You Should Know About System Page Customization"


	
Section 7.3.2.2, "Customizing an Application-Level System Page"


	
Section 7.3.2.3, "Customizing a Space-Level System Page"






7.3.2.1 What You Should Know About System Page Customization

You can customize out-of-the-box system pages to bring them in line with your organization's brand or look and feel. As a Spaces application administrator, you can remove existing components, add new components, and change the page layout. For example, you can customize the My Profile and User Profile system pages to show content other than its defined default content.

You cannot, however, edit or delete system page input fields and buttons.

System pages enable task flow customization in Composer's Source view. Use task flow customization to change the appearance and behavior of all instances of a task flow in the current scope—that is, either application- or space-wide. For more information, see Chapter 8, "Customizing Task Flows at Runtime."






7.3.2.2 Customizing an Application-Level System Page

The process of customizing a system page is the same for each page. This section generally describes the steps you take to customize any system page that is editable in the Spaces application.

To customize a system page:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click System Pages to view all system pages.

You can use the following URL to get to this location:


http://host:port/webcenter/spaces/admin/systempages


	
Click the Customize link next to the system page to open it in Composer (Figure 7-21).


Figure 7-21 Customize Link Next to a System Page
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Description of "Figure 7-21 Customize Link Next to a System Page"





	
Revise the page.




	
See Also:

For information about editing pages, see Section 17.3, "Editing Pages."
For information about the types of components you can add to a page, see the following:

	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Part X, "Working with Content"













	
Click Save and then Close to exit Composer.









7.3.2.3 Customizing a Space-Level System Page

You can customize system pages such that the customizations render only within a selected space. To do so, simply customize the system page as described in Section 7.3.2.2, "Customizing an Application-Level System Page,", but do so through the space's Settings page.

To customize a space-level systems page:

	
Navigate to the System Pages subpage under space Settings.

You can use the following URL to get to this location:


http://host:port/webcenter/spaces/spaceName/admin/systempages


	
Click the Customize link next to the system page to open it in Composer (Figure 7-22).


Figure 7-22 Customize Link Next to a System Page
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Description of "Figure 7-22 Customize Link Next to a System Page"





	
Revise the page.




	
See Also:

For information about editing pages, see Section 17.3, "Editing Pages."
For information about the types of components you can add to a page, see the following:

	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Part X, "Working with Content"













	
Click Save and then Close to exit Composer.











7.3.3 Removing All Page Customizations from a System Page

You can return a system page to its default, out-of-the-box state, removing all page customizations.




	
Note:

This process does not also remove task flow customizations. To remove task flow customizations, you must revise the given task flow on a system page. For more information, see Chapter 8, "Customizing Task Flows at Runtime."







To remove all customizations from a system page:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click System Pages to view all system pages.

You can also use the following URL to get to this location:


http://host:port/webcenter/spaces/admin/systempages


	
Click the Restore Default link next to the system page (Figure 7-23).


Figure 7-23 Restore Default Link Next to a System Page
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Description of "Figure 7-23 Restore Default Link Next to a System Page"





	
In the resulting confirmation dialog, click the Restore button.

All customizations are permanently removed from the selected system page.














8 Customizing Task Flows at Runtime

Through the Task Flow Editor system page, you can customize a task flow at application runtime so that all instances are affected. You can change all task flow instances at the application level or just those instances in a given space.

This chapter provides details about runtime task flow customization and steps you through the process of customizing task flows application-wide and space-wide. It includes the following sections:

	
Section 8.1, "What You Should Know About Runtime Task Flow Customization"


	
Section 8.2, "Customizing Task Flows at the Application Level"


	
Section 8.3, "Customizing Task Flows at the Space Level"


	
Section 8.4, "Removing Task Flow Customizations"







	
See Also:

For information about system pages, see Section 7.3, "Working with System Pages." Task flow customization is also possible at design time through Oracle JDeveloper. The process differs significantly from the runtime procedure we discuss in this chapter. For more information, see the chapter, "Customizing Task Flows," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.









8.1 What You Should Know About Runtime Task Flow Customization

Runtime Task flow customization provides a means of configuring a particular task flow in a way that all instances of that task flow within the current scope are affected.

The task flow customization feature is available exclusively on the Task Flow Editor system page. The Task Flow Editor system page is available at both the application and space levels:

	
To change all instances of a given task flow across all spaces (including the Home space), customize the task flow on the application-level Task Flow Editor system page.


	
To change only those instances exposed in a given space, customize the task flow on the space-level Task Flow Editor system page.







	
Note:

When you customize a task flow element at the application level, and another user customizes the same task flow element at the space level, the space-level customization take precedence in that space.







The Task Flow Editor system page is provided to enable customization of any seeded task flow (custom task flows that are created through the Resource Manager cannot be customized in this way). Edit the Task Flow Editor page, and add any seeded task flow to it. Edit the task flow by selecting any of its elements on the page and then editing the selected element's properties.

The changes you make to task flows on the Task Flow Editor system page affect all instances of the task flow at the application level, when you customize the application-level system page, or within the scope of the current space, when you customize the space-level system page.

System pages at both the application and space level have a Restore Default feature that enables authorized users to remove all page customizations and restore a system page to its out-of-the-box state. It is important to note that Restore Default does not also restore customized task flows to their default states. A separate control, Reset Task Flow, is available to remove task flow customizations (for more information, see Section 8.4, "Removing Task Flow Customizations").




	
Note:

Customizations made to task flows created at runtime—that is, created through the Resource Manager—are base document edits rather than layered customizations. Consequently, they cannot be reset. When you edit a task flow created at runtime in Composer, edits are saved, even if you do not explicitly click Save.










	
See Also:

For information about the Restore Default feature for system pages, see Section 7.3.3, "Removing All Page Customizations from a System Page."







Make runtime task flow customizations in page edit mode Source view. In Source view, an Edit Task Flow link is provided next to the region that represents the task flow. You can click this link to start the customization process (Figure 8-1).


Figure 8-1 Edit Task Flow Link Next to a Region Tag

[image: Edit Task Flow link next to a region tag]

Description of "Figure 8-1 Edit Task Flow Link Next to a Region Tag"





Once in, you can select different task flow elements directly on the page and edit their properties through the Component Properties dialog. All changes made in this way affect all instances of the task flow either application-wide or within the scope of a space, depending on where you initiated the customization. Changes to one element affect all like elements. For example, if you select a folder in the Document Explorer task flow, and change its icon, all folder icons in all Document Explorer task flows within the current scope are affected.






8.2 Customizing Task Flows at the Application Level

This section describes how to perform runtime task flow customizations at the application level.




	
Note:

When you customize a task flow element at the application level, and another user customizes the same task flow element at the space level, the space-level customization take precedence in that space.







To perform runtime task flow customizations application-wide:

	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click System Pages to view all system pages.

You can use the following URL to get to this location:


http://host:port/webcenter/spaces/admin/systempages


	
Click the Customize link next to the Task Flow Editor system page to open it in page edit mode (Figure 8-2).


Figure 8-2 Customize Link Next to the Task Flow Editor System Page

[image: Customize link next to system page]

Description of "Figure 8-2 Customize Link Next to the Task Flow Editor System Page"





	
Add the task flow of interest to the application-level Task Flow Editor system page.




	
See Also:

For more information, see Section 17.5.1, "Adding a Component to a Page."








	
From the View menu, select Source to view the page source (Figure 8-3).


Figure 8-3 Source Option on View Menu

[image: Source option on View menu]

Description of "Figure 8-3 Source Option on View Menu"





	
Click the Edit Task Flow link next to the task flow you want to customize (Figure 8-4).


Figure 8-4 Edit Task Flow Link Next to a Region Tag

[image: Edit Task Flow link next to a region tag]

Description of "Figure 8-4 Edit Task Flow Link Next to a Region Tag"





	
In the resulting Confirm Task Flow Edit dialog, click Edit.

Source view zooms into the source code hierarchy of the task flow being edited (Figure 8-5)


Figure 8-5 Zoomed-In View of Task Flow

[image: Zoomed-in view of task flow]

Description of "Figure 8-5 Zoomed-In View of Task Flow"








	
Tip:

Use the Show Hierarchy icon (arrow) in Source view to navigate back up the source hierarchy. [image: Show Hierarchy icon]

Description of the illustration wcsug_ctf_up.gif








	
Select a task flow element by clicking it on the page (Figure 8-6).


Figure 8-6 Selected Task Flow Element on a Page in Source View

[image: Selected task flow element in Source view]

Description of "Figure 8-6 Selected Task Flow Element on a Page in Source View"





	
Click the Show the properties of selected_element to open the Component Properties dialog (Figure 8-7).


Figure 8-7 Show the Properties of Everyone Icon

[image: Show the properties icon]

Description of "Figure 8-7 Show the Properties of Everyone Icon"





	
Make your changes to the element's properties.




	
Note:

Remember that changes to one element affect all like elements in the task flow within the current scope. For example, a change to the font used on a folder name affects all folder names within the scope and not just the selected instance.








	
Click Apply to view the effect of your changes; click OK to save your changes and exit the dialog.

Every instance of the customized task flow within the current scope renders with your customizations.


	
Click Save then Close to exit Composer.









8.3 Customizing Task Flows at the Space Level

This section describes how to perform task flow customizations at the space level.




	
Note:

When you customize a task flow element at the application level, and another user customizes the same task flow element at the space level, the space-level customization take precedence in that space.







To perform space-wide task flow customizations through the Task Flow Editor system page:

	
Navigate to the System Pages subpage under space Settings.

You can use the following URL to get to this location:


http://host:port/webcenter/spaces/spaceName/admin/systempages


	
Click the Customize link next to the Task Flow Editor system page to open it in page edit mode (Figure 8-8).


Figure 8-8 Customize Link on the Space-Level System Page Task Flow Editor

[image: Customize link on a Space system page]

Description of "Figure 8-8 Customize Link on the Space-Level System Page Task Flow Editor"





	
Add the task flow of interest to the space-level Task Flow Editor system page.




	
See Also:

For more information, see Section 17.5.1, "Adding a Component to a Page."








	
From the View menu, select Source to view the page source (Figure 8-9).


Figure 8-9 Source Option on View Menu

[image: Source option on View menu]

Description of "Figure 8-9 Source Option on View Menu"





	
Click the Edit Task Flow link next to the task flow you want to customize (Figure 8-10).


Figure 8-10 Edit Task Flow Link In Source View

[image: Edit Task Flow link in Source view]

Description of "Figure 8-10 Edit Task Flow Link In Source View"





	
In the resulting Confirm Task Flow Edit dialog, click Edit.

Source view zooms into the source code hierarchy of the task flow being edited (Figure 8-11)


Figure 8-11 Zoomed-In View of Task Flow in Edit Mode

[image: Zoomed-in view of task flow in edit mode]

Description of "Figure 8-11 Zoomed-In View of Task Flow in Edit Mode"








	
Tip:

Use the Show Hierarchy icon (arrow) in Source view to navigate back up the source hierarchy. [image: Show Hierarchy icon]

Description of the illustration wcsug_ctf_up2.gif








	
Select a task flow element by clicking it on the page.


	
Click the Show the properties of selected_element to open the Component Properties dialog (Figure 8-12).


Figure 8-12 Show the Properties of folderclosed_qualifier.png

[image: Show the properties of calendar icon]

Description of "Figure 8-12 Show the Properties of folderclosed_qualifier.png"





	
Make your changes to the element's properties.




	
Note:

Remember that changes to one element affect all like elements in the task flow within the current scope. For example, a change to the font used on a button affects all like buttons on every instance of the selected task flow within the scope and not just the selected instance.








	
Click Apply to view the effect of your changes; click OK to save your changes and exit the dialog.

Every instance of the customized task flow within the current scope renders with your customizations.


	
Click Save then Close to exit Composer.









8.4 Removing Task Flow Customizations

Use the Reset Task Flow feature to remove customizations from seeded task flows.




	
Note:

Reset Task Flow does not apply to task flows created at runtime. That is, task flows created through the Resource Manager. Changes made to a task flow created through the Resource Manager are base edits rather than layered customizations; therefore, when you click Reset Task Flow, there are no customization layers to remove.







To remove task flow customizations made at the application or space level:

	
Navigate to the System Pages subpage at the application or space level.

To navigate to the application Systems Pages subpage, use the following URL:


http://host:port/webcenter/spaces/admin/systempages


To navigate to a space Systems Pages subpage, use the following URL:


http://host:port/webcenter/spaces/spaceName/admin/systempages


	
Click the Customize link next to the Task Flow Editor system page to open it in page edit mode (Figure 8-13).


Figure 8-13 Customize Link Next to a System Page

[image: Customize link next to a system page]

Description of "Figure 8-13 Customize Link Next to a System Page"





	
In Source view, select the customized task flow, and click Reset Task Flow (Figure 8-14).


Figure 8-14 A Selected Task Flow and the Reset Task Flow Button

[image: Selected task flow and Reset Task Flow button]

Description of "Figure 8-14 A Selected Task Flow and the Reset Task Flow Button"





	
Click Reset Task Flow in the confirmation dialog.












Part III


Personalizing Your Portal

Part III of the User's Guide describes a way to vary the presentation of page content and templates in accordance with the current user.

Part III includes the following chapter:

	
Chapter 9, "Using Personalization for WebCenter Portal"










9 Using Personalization for WebCenter Portal

WebCenter Portal's Personalization provides a dynamically derived user experience that can be applied to any Oracle WebCenter Portal: Spaces object that can be used in conjunction with Expression Language (EL) expressions. This chapter provides an overview of how the Personalization engine can be used to determine which WebCenter Portal: Spaces objects are presented to the user and how these objects are presented based on the outcome of a Personalization scenario.

This chapter includes the following sections:

	
Section 9.1, "Introduction to Personalization"


	
Section 9.2, "Driving Content Using Personalization"


	
Section 9.3, "Driving Portal Look and Feel Using Personalization"






9.1 Introduction to Personalization

WebCenter Portal's Personalization provides a mechanism with which to vary the user experience based on dynamically evaluated criteria defined in a Personalization scenario. The scenario evaluates defined sources of input data, and generates a decision. The results of that decision or outcome can be applied in WebCenter Portal: Spaces using Expression Language (EL) expressions.

To use Personalization for WebCenter Portal in WebCenter Portal: Spaces, you first need to create a scenario in a WebCenter Portal: Framework application. You then use ELs to execute and return the results of the scenario, and modify the user experience accordingly in WebCenter Portal: Spaces. For information about how to create Personalization scenarios, see "Personalizing WebCenter Portal Applications" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal. The Personalization ELs used to run a scenario are cataloged in Section B.4.11, "EL Expressions Relevant to the Personalization Conductor."

Once you've set up your scenario, you can use ELs in WebCenter Portal: Spaces to present targeted content or shape the way content is presented based on information about the user. For example, you can use a Personalization scenario to determine a user's role within an enterprise, and based on that selectively show content for that role. You can also tailor the presentation (such as page templates, page styles, skins, resource catalogs, and so on) for the user.






9.2 Driving Content Using Personalization

WebCenter Portal's Personalization can deliver targeted content based on both user and application context. Personalization, for example, can return content or change application flow based on information about a user in a Human Resources database, targeting the WebCenter Portal: Spaces experience for that specific user.

You can define the content sources, or data providers, that are used to evaluate or provide data for a scenario. The default data provider for Personalization is the Oracle WebCenter Content Server, but a data provider for Activity Graph and a locator for People Connections is also available out of the box. You can also define your own data providers for other data sources. For more information about data providers, see "Personalization Providers" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

You can create a simple example of using Personalization to drive content based on information about the user by creating a scenario that returns “true” if the employee hire date is within the last two months (see "Authoring Personalized Scenarios in JDeveloper" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal to learn how to create a Personalization scenario). After creating the scenario:

	
Log in as an administrator in WebCenter Portal: Spaces.


	
Create a page for new hires, naming it New Hire.


	
Edit the navigation model for the site, and add a new navigation link to the New Hire page.


	
Select New Hire and click the Edit (Pencil) icon.


Figure 9-1 Navigation Model

[image: Description of Figure 9-1 follows]

Description of "Figure 9-1 Navigation Model"





	
For the Visible attribute, open the Expression Editor, select Type a value or expression and enter:


#{p13nContext.conductor.default.namespaces['p13nApp'].scenario['NewHire'].results}


Where p13nApp is the name of the WebCenter Portal application containing the scenario, and NewHire is the name of the scenario. This will execute the scenario and return the results (True or False in this case). If the user is a new hire (True) based on the results of the scenario, then the menu item will display when the user logs in.


Figure 9-2 Expression Editor

[image: Description of Figure 9-2 follows]

Description of "Figure 9-2 Expression Editor"












9.3 Driving Portal Look and Feel Using Personalization

As well as targeting content to the user, you can also use Personalization and Personalization ELs to select the page templates, page styles, skins, and navigation flow within which that content is presented.









Part IV


Building a Portal or Community

Part IV of the User's Guide introduces the resources you use to create your portal or community.

Part IV includes the following chapters:

	
Chapter 10, "Working with the Resources that Compose a Portal or Community"


	
Chapter 11, "Working with Navigation"


	
Chapter 12, "Working with Page Templates"


	
Chapter 13, "Adding Spaces Components to Your Templates"


	
Chapter 14, "Working with Skins"


	
Chapter 15, "Working with Page Styles"


	
Chapter 16, "Working with Resource Catalogs"










10 Working with the Resources that Compose a Portal or Community

Out-of-the-box, Spaces provides a range of built-in resources that you can use to define and enrich your application and spaces. If these resources do not meet your specific requirements, you can create your own custom resources.

This chapter provides an introduction to Spaces resources and describes how you can create and manage them. It includes the following sections:

	
Section 10.1, "What You Should Know About Resources"


	
Section 10.2, "Creating Resources"


	
Section 10.3, "Editing Resources"


	
Section 10.4, "Managing Resources"


	
Section 10.5, "Using JDeveloper to Build Resources for the Spaces Application"







	
Note:

For detailed information about a particular resource, refer to the resource-specific chapter listed in Table 10-1.









10.1 What You Should Know About Resources

Though Spaces comes with an out-of-the-box application framework, it is a constantly evolving application. Users with appropriate privileges can continue to customize it by creating and applying various types of resources that define the structure, look and feel, and the content of the entire Spaces application or a particular space. Users can customize Spaces without redeploying resources or restarting the application.

This section provides an overview of the various resources and the permissions required to work with them, and describes how you can access resources. It includes the following subsections:

	
Section 10.1.1, "Introducing Resources"


	
Section 10.1.2, "Understanding Application-Level and Space-Level Resources"


	
Section 10.1.3, "Permissions Required to Work with Resources"


	
Section 10.1.4, "Accessing Resources"


	
Section 10.1.5, "Viewing Information About a Resource"






10.1.1 Introducing Resources

Spaces categorizes resources under the following categories: Structure, Look and Layout, and Mashups. Figure 10-4 shows the various types of resources available under each of these categories.


Figure 10-1 Resources Available in Spaces

[image: Resources available in WebCenter Spaces]

Description of "Figure 10-1 Resources Available in Spaces"





Table 10-1 describes the various types of resources, and provides links to the chapters where you can find more information about each resource.


Table 10-1 Resources Available in Spaces

	Resource	Description	Documentation
	
Structure

	
Resources under this category help you define templates, navigation, and catalogs

	

	
Page Templates

	
Define how individual pages and groups of pages display on a user's screen.

	
See Chapter 12, "Working with Page Templates"


	
Navigations

	
Define how to link together information from multiple sources, such as spaces, pages, content repositories, and even external web pages.

	
See Chapter 11, "Working with Navigation"


	
Resource Catalogs

	
Define the components and connections that users can add to their pages, page templates, and task flows.

	
See Chapter 16, "Working with Resource Catalogs"


	
Look and Layout

	
Resources under this category help you define the appearance and layout

	

	
Skins

	
Define the appearance and look and feel, including colors and fonts, of a specific space or the entire application.

	
See Chapter 14, "Working with Skins"


	
Page Styles

	
Define the layout of a newly created page, and may also dictate the type of content the page supports.

	
See Chapter 15, "Working with Page Styles"


	
Content Presenter

	
Manage Content Presenter templates for presenting content.

	
See Chapter 40, "Publishing Content Using Content Presenter"


	
Mashup Styles

	
Manage the templates available for creating task flows.

	
See Section 26.3.4, "Managing Mashup Styles"


	
Mashups

	
Resources under this category help you define task flows and data controls

	

	
Data Controls

	
Create and manage data controls, which connect to and read data from external repositories, particularly for use in business mashups. Spaces does not provide any built-in data controls.

	
See Section 26.2, "Creating and Managing Data Controls"


	
Task Flows

	
Create and manage task flows based on a selected mashup style. Spaces does not provide any built-in task flows.

	
See Section 26.3, "Creating and Managing Task Flows"












10.1.2 Understanding Application-Level and Space-Level Resources

Out-of-the-box, Spaces provides various built-in resources at the application level and the space level (Home spaces or any other spaces). You cannot modify or download built-in resources.

To meet your business requirements, you can create custom resources at the application level or at the space level. At both these levels, the resources available and their functionality are the same. The difference between application- and space-level resources is that of scope:

	
Application-level resources are available for use to all spaces, unless a space has been specifically excluded.


	
Space-level resources are available for use only in the space in which they are created.




By default, application-level resource settings, such as the page template, skin, resource catalog, and navigation model, are applied to all spaces. However, in a space, you can choose to use the default application-level resource settings or specify your own resource settings. If your space uses application-level settings, any changes to an application-level setting are reflected in your space too. For example, consider that your application uses the Fusion FX skin, and there are two spaces in your application, SpaceA and SpaceB. By default, both your spaces will use the Fusion FX skin. Consider that you configure the application to use the skin named Dew, and SpaceB to use the Mist skin. Now, SpaceA, which is still using an application-level setting for its skin, is automatically updated to use the Dew skin; however SpaceB continues to use Mist.

When you create and publish a custom, application-level resource, it automatically becomes available to all spaces. However, an application-level resource can be edited only at the application level.






10.1.3 Permissions Required to Work with Resources

To create and manage resources, you require appropriate application-level and space-level permissions.

To create and manage application-level resources, you must be a Spaces administrator. Or, you must have either of the following permissions:

	
Application-Manage All (Figure 10-2)


	
Application-Manage Configuration and the permission to create, edit, and delete the required resource. For example, the Create, Edit, and Delete Page Styles permission for page styles (Figure 10-3).





Figure 10-2 Manage All Permission for Application

[image: Manage All permission for the entire Spaces application]

Description of "Figure 10-2 Manage All Permission for Application"






Figure 10-3 Permissions Required to Manage Resources at the Application Level

[image: Permissions required to manage resources]

Description of "Figure 10-3 Permissions Required to Manage Resources at the Application Level"





To create and manage a resource for a particular space, you must be granted the following permissions:

	
Standard Permission Model: You must be granted the Resources-Create, Edit, and Delete Resources (Figure 10-4) and either Manage All or Manage Configuration for space Administration (Figure 10-5).


Figure 10-4 Role with the Create, Edit, and Delete Resources Permission for a Space

[image: Create, Edit, and Delete Resources permission]

Description of "Figure 10-4 Role with the Create, Edit, and Delete Resources Permission for a Space"





	
Advanced Permission Model: You must be granted the permission to create, edit, and delete the desired resource. For example, you require the Create, Edit, and Delete Content Presenter permission to create and manage content presenter templates. You must also be granted either Manage All or Manage Configuration for space Administration (Figure 10-5).


Figure 10-5 Permissions Required for Creating Content Presenter Templates in a Space

[image: Description of Figure 10-5 follows]

Description of "Figure 10-5 Permissions Required for Creating Content Presenter Templates in a Space"












10.1.4 Accessing Resources

You use the Resources page to manage resources. This section describes how to access resources in your application and in a specific space. It includes the following subsections:

	
Section 10.1.4.1, "Accessing Application-Level Resources"


	
Section 10.1.4.2, "Accessing Space-Level Resources"






10.1.4.1 Accessing Application-Level Resources

To access the application-level Resources page:

	
Log on to Spaces with administrative privileges.


	
After you log on as the application administrator, you can access the Resources page in either of the following ways:

	
Use the following URL:


http://host:port/webcenter/spaces/admin/resources


Where, host and port refer to the host name and the port number of the server where the Spaces application is deployed.




	
See Also:

For more information about Spaces user interface URLs, see Appendix A, "Spaces User Interface URLs."








	
Click the Administration link (Figure 10-6). If you use this option, proceed to step 3.


Figure 10-6 Administration Link

[image: Administration Link]

Description of "Figure 10-6 Administration Link"








	
In SpacesAdministration, click the Resources tab.

The application-level Resources page opens, as shown in Figure 10-7.


Figure 10-7 Application-Level Resources Page

[image: Resources page in Spaces Administration]

Description of "Figure 10-7 Application-Level Resources Page"












10.1.4.2 Accessing Space-Level Resources

To access the Resources page of a space:

	
Log on to Spaces with space moderator privileges.


	
You can access the space's Resources page in either of the following ways:

	
Use the following URL:


http://host:port/webcenter/spaces/spaceName/admin/resources


Where, host:port refer to the host name and the port number of the server where the Spaces application is deployed, and spaceName refers to the name of the space whose resources you want to access.




	
See Also:

For more information about the Spaces application's user interface URLs, see Appendix A, "Spaces User Interface URLs."








	
Use the Spaces navigation. For details, proceed to step 3.





	
In your Home space, click Spaces.




	
Tip:

The way you access this page depends on the page template in use. For example, in a top navigation template, you may access it through a Spaces menu (Figure 10-8).
See also Section 29.3.1, "Opening Spaces."










Figure 10-8 Accessing a Space

[image: Accessing a Space]

Description of "Figure 10-8 Accessing a Space"





	
On the Spaces page, select the required space.


	
Display the space administration page.




	
Tip:

The way you access the space administration pages depends on the page template in use. For example, in a top navigation template, you may access space administration pages through a Manage menu (Figure 10-9).
You can also navigate to these pages using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 10-9 Manage Menu in a Top Navigation Template

[image: Manage Menu in a Top Navigation Template]

Description of "Figure 10-9 Manage Menu in a Top Navigation Template"





	
Click the Resources tab.

The Resources page for the selected space displays, as shown in Figure 10-10.


Figure 10-10 Resources Page of a Space

[image: Resources page of a Space]

Description of "Figure 10-10 Resources Page of a Space"














10.1.5 Viewing Information About a Resource

Each resource has an associated About dialog that summarizes useful information about it. For information about the properties displayed in the About dialog, see Section 10.4.2.1, "What You Should Know About a Resource's Properties."

You cannot edit the properties displayed in the About dialog of a resource.

To access the About dialog of a resource:

	
Navigate to the Resources page of the application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the navigation panel on the left, select the resource type.


	
From the list of resources displayed on the right, select the resource whose details you want to view.


	
On the menu bar, click About.

The About dialog displays, showing the properties related to the selected resource (Figure 10-11).


Figure 10-11 About Dialog of a Resource

[image: About dialog of a resource]

Description of "Figure 10-11 About Dialog of a Resource"














10.2 Creating Resources

This section includes the following subsections:

	
Section 10.2.1, "What You Should Know About Resource Creation"


	
Section 10.2.2, "Creating a Resource"






10.2.1 What You Should Know About Resource Creation

In Spaces, you can create certain resources from scratch, and there are certain resources that you can create only by making a copy of an existing resource. For example, you can create a task flow from scratch, but you can create a skin only by making a copy of an existing skin. Further, there are certain resources, such as Content Presenter templates, that Spaces restricts you from creating.

Table 10-1 describes the support available for creating various resources in Spaces.


Table 10-2 Support for Creating Resources in Spaces

	Resource	Can You Create the Resource in Spaces?	How can the Resource be Created?
	
Page Templates

	
Yes

	
Only by extending another page template


	
Navigations

	
Yes

	
From scratch or by extending another navigation resource


	
Resource Catalogs

	
Yes

	
From scratch or by extending another Resource Catalog


	
Skins

	
Yes

	
Only by making a copy of another skin


	
Page Styles

	
No

	
(Not applicable)


	
Content Presenter templates

	
No

	
(Not applicable)


	
Mashup styles

	
No

	
(Not applicable)


	
Data Controls

	
Yes

	
Only from scratch


	
Task flows

	
Yes

	
Only from scratch












10.2.2 Creating a Resource

To create a resource in Spaces:




	
Note:

The procedure for creating a data control is different than other resources. For information about how to create a data control, see Chapter 26, "Creating Business Mashups."







	
Navigate to the Resources page of your application or the space in which you want to create a resource, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
On the menu bar, click Create.


	
In the Create dialog, in the Name field, enter the name of the resource.


Figure 10-12 Creating a Resource

[image: Creating a Resource]

Description of "Figure 10-12 Creating a Resource"





	
In the Description field, enter a description of the resource.


	
From the Copy from list, select the existing resource that you want to extend for creating a new resource.




	
Note:

The Copy From list is available only for page template, navigation, Resource Catalog, and skin resources. It is not available for a data control or task flow resource.
For a task flow resource, you need to select the page layout. For information, see Section 26.3.1, "Creating a Task Flow."










	
Click Create.

The newly created resource is listed on the Resources page. The gray icon next to a resource indicates that it is not yet published and hence not available to users for use. For information about publishing resources, see Section 10.4.3, "Showing and Hiding Resources."











10.3 Editing Resources

This section includes the following sections:

	
Section 10.3.1, "What You Should Know about Resource Editing"


	
Section 10.3.2, "Editing the Source Code of a Resource"


	
Section 10.3.3, "Editing a Resource by Using the Edit Dialog"






10.3.1 What You Should Know about Resource Editing

Spaces enables you to edit custom resources. It supports two types of resource editing:

	
Simple editing - provides a simple means of editing a resource's basic settings. Use the Edit dialog to perform simple editing.


	
Source editing - enables you to work with the source code of a resource. Use the Edit Source dialog to perform source editing.

You may want to edit a resource's source file to make advanced edits to its code without having to download the file, edit it in JDeveloper, and upload it back into the Spaces application. You can even use the Edit Source option to create a resource from the beginning—by creating a resource and then replacing its default source code with your own original code. Note, however, that, due to the heavy hand-coding requirement, this scenario is not recommended.




You cannot edit built-in resources. If you want to modify a built-in resource, consider creating a copy of the resource and then editing the copy according to your preferences.

Oracle WebCenter Portal supports round-trip development of resources. To get enhanced functionality for your resources, you can download your resource, edit it in JDeveloper, and then upload it back into the Spaces application. For information, see Section 10.5, "Using JDeveloper to Build Resources for the Spaces Application."






10.3.2 Editing the Source Code of a Resource

Use the Edit Source dialog to get more control over resource editing at runtime. You can edit the underlying source code of any custom resource except data controls. Changes made to a resource are saved to the MDS, and are made available immediately.

To edit the source code of a resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
On the Resources page, from the navigation panel on the left, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource whose code you want to edit.


	
From the Edit menu, choose Edit Source.

The Edit Source dialog displays the resource definition.


	
Edit the code as required.

The XML syntax in the code is validated and an error message is displayed if you miss any tags or add them incorrectly. Validation is not performed for non-XML files, such as a CSS file.

Figure 10-13 shows the sample source code of a skin's CSS file.


Figure 10-13 Editing the Source Code of a Resource

[image: Editing the source of a resource]

Description of "Figure 10-13 Editing the Source Code of a Resource"





	
Click OK.









10.3.3 Editing a Resource by Using the Edit Dialog

Use the Edit dialog to make simple changes to your resource. The properties displayed in the Edit dialog vary from resource to resource. For information about editing a resource, refer to the resource-specific chapter listed in Table 10-1.








10.4 Managing Resources

This section includes the following subsections:

	
Section 10.4.1, "Copying a Resource"


	
Section 10.4.2, "Setting Properties on a Resource"


	
Section 10.4.3, "Showing and Hiding Resources"


	
Section 10.4.4, "Setting Security for a Resource"


	
Section 10.4.5, "Deleting a Resource"


	
Section 10.4.6, "Previewing a Resource" 


	
Section 10.4.7, "Querying for a Resource Through the Expression Builder"


	
Section 10.4.8, "Applying Resources Dynamically Using EL Expressions"






10.4.1 Copying a Resource

Spaces enables you to create a copy of a resource. This feature is useful when you want to:

	
Create a backup of a resource.


	
Update a resource while keeping the original in use.


	
Use a built-in resource as a sample to build a new resource. Built-in resources cannot be edited, but you can create a copy of a resource to use it as a starting point for further refinement.




You can create a copy of all types of resources except Content Presenter templates. When you create a copy of a resource, the copy is marked as hidden.

To make a copy of a resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource whose copy you want to create.


	
From the Edit menu, choose Copy.


	
In the Copy dialog, in the Display Name field, enter a name for the resource copy (Figure 10-14).


Figure 10-14 Copying a Resource

[image: Copying a resource]

Description of "Figure 10-14 Copying a Resource"





	
In the Description field, enter a description of the resource copy.


	
Click OK.









10.4.2 Setting Properties on a Resource

Each resource has certain associated properties that define its display properties, availability, and attributes. This section describes how to access and modify these properties for custom resources. It includes the following sections:

	
Section 10.4.2.1, "What You Should Know About a Resource's Properties"


	
Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource"


	
Section 10.4.2.3, "Renaming, Describing, and Categorizing a Resource"


	
Section 10.4.2.4, "Associating an Icon with a Resource"


	
Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces"


	
Section 10.4.2.6, "Working with the Attributes of a Resource"






10.4.2.1 What You Should Know About a Resource's Properties

Use the Edit Properties dialog to edit the properties associated with custom resources. The Edit Properties dialog contains these sections: General, Exclude Resource Usage, and Attributes.


General Section

The General section displays details such as the resource's name, location, and internal ID. These properties are common across all resources.

Table 10-3 describes the properties listed in the General section.


Table 10-3 Properties in the General Section of the Edit Properties Dialog

	Property	Description
	
Display Name

	
Specify the name of a resource.


	
Description

	
Enter the description of a resource.


	
Icon URI

	
Specify the URI of the icon that you want to associate with a resource.


	
Category

	
Specify the category, like Sales, that you want to associate with a resource.


	
Resource Type

	
Displays the type of the resource. For example, for a page style resource, the resource type is pageStyle.


	
Internal ID

	
Displays the unique internal identification number assigned to a resource in Spaces.


	
Content Directory

	
Displays the path where dependent objects of a resource, such as images, JavaScripts, stylesheets, and HTML files, are stored on the managed server where the Spaces application is deployed.


	
JSPx File

	
Displays the path to the .jspx file of a resource.


	
Page Definition

	
Displays the path where the page definition (.xml file) of a resource is stored on the Spaces server. Page definitions are used for page templates, task flows, page styles, and mashup styles.


	
Metadata File

	
Displays the path where metadata files, if any, of a resource are stored on the Spaces server.


	
Created By

	
Displays the name of the user who created a resource.


	
Date Created

	
Displays the date and time when a resource was created.


	
Modified By

	
Displays the name of the user who last modified the resource.


	
Date Modified

	
Displays the date and time when a resource was last modified.









Exclude Resource Usage Section

When an application-level resource is marked as available, it becomes available to all spaces and Home space. Spaces gives you the control to choose whether that resource is available in Home space and all spaces, or only in selected spaces. Use the controls in the Exclude Resource Usage section to prevent or promote the display of a selected custom resource (Figure 10-15).

You can set availability of custom resources only at the application level. The Exclude Resource Usage section is not available in Home space and spaces.


Figure 10-15 Setting Availability of a Resource in Other Spaces

[image: Setting availability of a resource in other Spaces]
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Attributes Section

The Attributes section (Figure 10-16) lists the attributes associated with a resource. The attributes displayed in the Attributes section vary from resource to resource. For example, while a page template does not have any default attributes, skins have the following default attributes: skinFamily, skinId, and skinExtends.


Figure 10-16 Attributes of a Resource

[image: Custom attributes of a resource]

Description of "Figure 10-16 Attributes of a Resource"





Attributes determine the behavior of a resource. For example, editPageAfterCreation is a custom attribute of the page style resource and controls whether a newly created page opens in edit or view mode. It takes a value of true or false. When you associate this attribute with a particular page style, every time a user creates a page based on the selected style, the attribute value is considered and the page behaves accordingly.

You can add, edit, or delete attributes as described in Section 10.4.2.6, "Working with the Attributes of a Resource." For information about resource-specific attributes, if any, refer to the relevant chapter listed in Table 10-1.






10.4.2.2 Accessing the Edit Properties Dialog of a Resource

To access the Edit Properties dialog of a resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
From the left navigation panel, select the type of resource you want to edit.


	
From the list displayed on the right, select the relevant resource, and from the Edit menu, choose Edit Properties.

The Edit Properties dialog opens (Figure 10-17).


Figure 10-17 Edit Properties Dialog of a Resource

[image: Edit Properties dialog of a resource]

Description of "Figure 10-17 Edit Properties Dialog of a Resource"










	
See Also:

The next thing you do depends on what you want to accomplish. For more information, see:
	
Section 10.4.2.3, "Renaming, Describing, and Categorizing a Resource"


	
Section 10.4.2.4, "Associating an Icon with a Resource"


	
Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces"


	
Section 10.4.2.6, "Working with the Attributes of a Resource"

















10.4.2.3 Renaming, Describing, and Categorizing a Resource

Resources, whether built-in or custom, are sorted on the Resource page according to their display names. To maintain a well-organized set of resources, consider developing a standard naming scheme and method of description. This is not a required step, but it may be useful in identifying and clarifying your intended purpose for a given resource.

You can classify your resources into relevant groups. For example, all page styles associated with Sales could have a sales category. This value is available and exposed only in the Edit Properties dialog.

To provide a name, description, and category for a resource:

	
Open the Edit Properties dialog for the desired resource as described in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Display Name field, edit the display name for the resource, if required.


	
Optionally, in the Description field, enter a description of the resource.


	
Optionally, in the Category field, enter a category name.


	
Click OK to save your changes and exit the dialog.









10.4.2.4 Associating an Icon with a Resource

You can associate an icon with a resource. In the current version of Spaces, the associated icon is visible only for page styles when you create a page using the Create dialog.

To associate an icon with a resource:

	
Open the Edit Properties dialog for the desired resource as described in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Icon URI field, enter a standard URI path to the icon.




	
Note:

You can either specify an absolute URL (where the URL should also work if entered in a browser address field), or a relative URL that points to an image located somewhere in Spaces. To store an image in Spaces, you must upload the required file using the Documents service, as described in Section 41.8.1, "Uploading Files." You can then obtain the image's URL by copying the Download URL value as described in Section 41.26.1, "Retrieving the URL for a Folder or File."








	
Click OK to save your changes and exit the dialog.









10.4.2.5 Setting the Availability of an Application-Level Resource in Other Spaces

Use the Exclude Resource Usage section of the Edit Properties section to set the availability of an application-level resource in a Home space or a space. The Exclude Resource Usage section is available only at the application level, and not in Home space or other spaces.

To set the availability of an application-level resource in Home space and other spaces:

	
Open the Edit Properties dialog for the desired resource as described in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
Under Exclude Resource Usage:

	
For the Exclude From Home Space checkbox:

	
Select to hide the resource on the Resources page of Home spaces


	
Clear to show the resource on the Resources page of Home spaces





	
For Exclude From Space(s), choose:

	
Include in All Spaces - to make the resource available on the Resources page of all spaces


	
Exclude from All Spaces - to exclude the resource from being listed on the Resources page of all spaces


	
Exclude from Selected Spaces - to specify the spaces on whose Resources page the resource will not be listed

When you select this option, an Add/Choose link appears (Figure 10-18).


Figure 10-18 Exclude Resource Usage Section

[image: Exclude Resource Usage section]

Description of "Figure 10-18 Exclude Resource Usage Section"





Clicking this link displays the Add Space dialog. Select the spaces from which to exclude the resource and click OK (Figure 10-19).

A list of the selected spaces is displayed in the Edit Properties dialog.


Figure 10-19 Excluding a Resource from Selected Spaces

[image: Excluding a resource from selected spaces]

Description of "Figure 10-19 Excluding a Resource from Selected Spaces"











	
Click OK to save your changes and exit the Edit Properties dialog.









10.4.2.6 Working with the Attributes of a Resource

This section describes how to associate a custom attribute with a resource and how to remove a custom attribute. It contains the following sections:

	
Section 10.4.2.6.1, "Associating an Attribute with a Resource"


	
Section 10.4.2.6.2, "Deleting an Attribute of a Resource"






10.4.2.6.1 Associating an Attribute with a Resource

To associate an attribute with a resource:

	
Follow the steps outlined in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Attributes section, in the Name field, enter the attribute name (Figure 10-20).


Figure 10-20 Adding an Attribute
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Description of "Figure 10-20 Adding an Attribute"





For information about the attributes, if any, that can be associated with a resource, refer to the resource-specific chapter listed in Table 10-1.


	
In the Value field, enter the value of the attribute.


	
Click Add More if you want to add more attributes.

This adds a new row. You can then enter the required details in the Name and Value fields.


	
Click OK to save your changes and exit the dialog.









10.4.2.6.2 Deleting an Attribute of a Resource

To remove an attribute associated with a resource:

	
Follow the steps outlined in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Attributes section, click the Remove icon displayed next to the attribute you want to delete.


	
Click OK to save your changes and exit the dialog.













10.4.3 Showing and Hiding Resources

This section includes the following subsections:

	
Section 10.4.3.1, "What You Should Know About Showing and Hiding Resources"


	
Section 10.4.3.2, "Showing a Resource"


	
Section 10.4.3.3, "Hiding a Resource"






10.4.3.1 What You Should Know About Showing and Hiding Resources

All resources, whether built-in or custom, can be marked as hidden or available. For all resources that are available for use, a green tick mark and the word "Available" appear next to the resource's name on the Resources page. A gray icon and the word "Hidden" next to a resource's name indicates that the resource is marked as hidden, as shown in Figure 10-21.


Figure 10-21 Showing or Hiding a Resource

[image: Showing or hiding a resource]

Description of "Figure 10-21 Showing or Hiding a Resource"





When you create or upload a resource, by default the resource is marked as hidden. A hidden application-level resource is not available for selection in the resource picker in the application, spaces, or Home space. Similarly, a hidden space-level resource is not listed in the resource picker in that space. For a resource to become available in the resource picker, it must be published.

You can use a hidden resource for creating a new resource. For example, Figure 10-22 shows that the page template MySpaceTemplate is marked as hidden. But it is listed in the Copy from list when you create a new page template. Figure 10-23 shows the list of all page templates that are available for use. Note that MyTemplate is not listed there.


Figure 10-22 A Hidden Resource Available for Creating a New Resource
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Figure 10-23 A Hidden Resource Not Listed in the Resource Picker

[image: A Hidden Resource Not Listed in the Resource Picker]

Description of "Figure 10-23 A Hidden Resource Not Listed in the Resource Picker"









10.4.3.2 Showing a Resource

To mark a hidden resource as available:

	
Navigate to the Resources page of the application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
From the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource that you want to mark as available.


	
From the Edit menu, choose Show.

A green checkmark and the word "Available" appear next to the resource's name, indicating that the resource is available for use.









10.4.3.3 Hiding a Resource

To hide a resource:

	
Navigate to the Resources page of the application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource that you want to hide.


	
From the Edit menu, choose Hide.

A gray icon and the word "Hidden" appear next to the resource's name, indicating that the resource is now hidden and is not available to users.











10.4.4 Setting Security for a Resource

You can control whether all users or only specific users or groups can access the custom resources that you created in the application. By default, resource access is controlled by application-level permissions (see Section 10.1.3, "Permissions Required to Work with Resources"). After you define resource-specific permissions, the permissions defined at the application or space level no longer apply.

To set access permissions for a resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource for which you want to set access permissions.


	
From the Edit menu, choose Security Settings.


	
In the Security Settings dialog, specify an access method by selecting either of the following (Figure 10-24):

	
Use Custom Permissions - Select this option to define who can manage and update the selected resource. When you select this option, the other controls in the dialog become available. Proceed to step 6.




	
Note:

When you choose Use Custom Permissions, ensure that at least one user or group is granted the Manage access.








	
Use Spaces Security Settings - Select this option to inherit the selected resource's access settings from those defined for the application. After selecting this option, click OK to save your changes and exit the dialog.




	
Note:

Selecting Use Spaces Security Settings removes any custom permissions that you may have set.











Figure 10-24 Setting Security for a Resource
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If you selected, Use Custom Permissions, specify the user or group to whom you want to grant resource access. In the Security Settings dialog:

	
Click Add Users to open a dialog that you can use to search for and select individual users available in your identity store.


	
Click Add Groups to open a dialog that you can use to search for and select groups of users available in your identity store.




For tips on searching for a user or group in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


	
For each user or user group listed in the Role or User column, specify the level of access you want to grant:

	
Select the Manage checkbox to grant full access on the resource. Such users can perform tasks such as edit, delete, grant access, show or hide, and the like.


	
Select the Update checkbox to grant the permission to edit the resource. Such users can edit the resource, but they cannot delete it.





	
If you want to revoke permissions from any user or user group, select that entity and click Delete Access.


	
Click OK.









10.4.5 Deleting a Resource

When a resource is no longer required, you may want to remove it. In Spaces, you can delete custom resources, but not built-in resources.




	
Note:

Before you use delete a resource, you must ensure that the resource is not in use. If you mark a resource for deletion, it will be deleted even if it is in use.







To delete a custom resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired resource type.


	
From the list of resources displayed on the right, select the resource you want to delete.


	
From the Edit menu, choose Delete.


	
In the Delete confirmation dialog, click Delete to delete the resource.









10.4.6 Previewing a Resource

Spaces provides a means of previewing certain resources—page templates, mashup styles, and task flows. You can use the Preview option to preview a resource and make adjustments, if required.

To preview a resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
From the left navigation panel, select the desired resource type.


	
From the list of resources on the right, select the resource you want to preview.


	
Click Preview.




	
Note:

The Preview option is not available for all resources. For information about a particular resource, refer to the resource-specific chapter listed in Table 10-1.















10.4.7 Querying for a Resource Through the Expression Builder

You can access any resource anywhere in Spaces through Expression Language (EL) expressions.

For example, the following EL expression returns the first template resource found with a display name myPage:

#{srmContext.resourceType['siteTemplate'].displayName['myPage'].singleResult}

You must set query parameters in the format .property['value'], where property is the name of the resource property, for example, it can be id or resourceScope, and value is the value of that property you want to search for.

For information about EL expressions that you can use to query resources, see Section B.4.5, "EL Expressions Relevant to Resources."






10.4.8 Applying Resources Dynamically Using EL Expressions

Spaces provides a way to dynamically apply certain resources at runtime based on some criteria. For example, you can present content or shape the way content is presented by using Personalization-related ELs to select and apply a page template based on whoever is the current user.

Consider an example where you want the top-navigation page template to be displayed to space moderators, and a side-navigation page template to be displayed to other users. Figure 10-25 shows a sample EL expression that you can use in such scenario. The EL expression uses the resource IDs of the page templates.


Figure 10-25 Specifying an EL Expression for Applying a Page Template Based on User Role

[image: Specifying the Expression Builder statement]
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Instead of using the exact resource ID of the resource that you want to apply, you can also include queries in an EL expression as shown in the following example.


#{WCSecurityContext.userInScopedRole['Moderator'] ?  srmContext.resourceScope['space_name'].resourceType['siteTemplate'].displayName['Top'].singleResult.id :
 srmContext.resourceScope['space_name'].resourceType['siteTemplate'].displayName['Side'].singleResult.id}


Figure 10-26 shows how a space may appear to a space Moderator, and Figure 10-27 shows how the space may appear to other users.


Figure 10-26 A Page Template Dynamically Applied for Space Moderators
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Figure 10-27 A Page Template Dynamically Applied for Other Users

[image: A Page Template Dynamically Applied for Other Users]

Description of "Figure 10-27 A Page Template Dynamically Applied for Other Users"





You can also use EL expressions to execute personalization server scenarios, as described in Appendix B, "EL Expressions Relevant to the Personalization Conductor." For information about common EL expressions that you can use, see Appendix B, "Expression Language Expressions."

To dynamically apply a resource at runtime:

	
Note down the Internal ID of the required resource from its About dialog. For information about how to access this dialog, see Section 10.1.5, "Viewing Information About a Resource."


	
Access the Spaces Administration page as described in Section 4.1, "Accessing the Spaces Administration Page," and open the General sub page of the Configuration page. Or, access a specific space's administration page as described in Section 51.3, "Accessing Space Administration Pages," and open the General page.




	
Tip:

You can use "pretty URLs" to navigate to the settings page:
	
Application-level Configuration page:


http://host:port/webcenter/spaces/admin/general


	
Space-level General page:


http://host:port/webcenter/spaces/spaceName/admin/general













	
Click the icon next to the desired resource field, then click Expression Builder to open the editor.


Figure 10-28 Using the Expression Builder for a Resource

[image: Using the Expression Builder for a Resource]

Description of "Figure 10-28 Using the Expression Builder for a Resource"





	
Select the Type a value or expression radio button, if not already selected.


	
Type the required expression builder statement.


Figure 10-29 Expression Editor Dialog

[image: Specifying the Expression Builder statement]
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For example, if you want to display different page templates depending on whether the page is rendered in a browser on a Windows platform or on a mobile device, you can use the following EL expression:

#{requestContext.agent.platformName=='windows' ? 'gsr3396194a_3a72_44d6_90b4_57fd6efe4ff7' : 'gsr1472d17b_8f10_4689_89fb_7431f561567f'}

This EL expression is an 'if-then-else' statement. The EL requestContext.agent.platformName retrieves the platform information. The page template IDs are the ones noted down from the About dialog.


	
Click Apply.











10.5 Using JDeveloper to Build Resources for the Spaces Application

This section includes the following subsections:

	
Section 10.5.1, "What You Should Know About Building Resources in JDeveloper"


	
Section 10.5.2, "Downloading a Resource"


	
Section 10.5.3, "Uploading a Resource"






10.5.1 What You Should Know About Building Resources in JDeveloper

You may find yourself in a situation where you want to edit or create resources beyond the capabilities of Spaces. Oracle WebCenter Portal provides features for round-trip development of Spaces resources. To further enhance your existing resources, you can download them from Spaces, edit them at a really fine level of granularity in an IDE like JDeveloper, and then upload the updated resources back into the Spaces application. You can upload resources directly to Spaces from within JDeveloper or through Spaces itself.

In JDeveloper, you can also create resources from scratch for the purpose of using them in Spaces. However, you do not necessarily need to start from scratch. An efficient way is to make a copy of an existing Spaces resource and refine it further in JDeveloper without worrying about the prerequisites involved in creating it from scratch in JDeveloper. Oracle WebCenter Portal provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) to help you develop and upload resources to Spaces. For more information about editing custom resources and uploading them into Spaces through JDeveloper, see "Developing Resources for the Spaces Application" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

When you download a resource, its configuration is saved into an export archive (.ear file). You can save the export archive either to your local file system or a remote server file system.

When you upload resources to Spaces:

	
Existing resources, that is, resources with the same internal ID, are overwritten.


	
Space-level resources are uploaded back only into their original space. You cannot upload a space-level resource into a different space.


	
Resources must be in an export archive (.ear) format on your local file system or a remote server









10.5.2 Downloading a Resource

To download a resource:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired resource type.


	
From the list of resources displayed on the right, select the resource you want to download as an EAR file.


	
Click Download.


	
In the Download dialog, in the Archive File Name field, enter the name of the export archive file.


	
In the Download dialog, specify where you want to save the export archive file. Use either of the following options (Figure 10-30):

	
Save to my computer - Click this if you want to save the export archive file to your local file system. Then, specify the path where you want to save the file.


	
Save to WebCenter Portal Server - Click this to save the export archive file to a remote server file system. In the Path field, enter the server path.


Figure 10-30 Download Dialog
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If the resource that you are downloading includes custom content, such as images, javascripts, stylesheets, and HTML files, you must specify whether or not you want to include such resource-specific content in the archive. To include the custom content, select the Export Content directory checkbox.

The Spaces application stores content for all portal resources under a 'shared' directory (oracle/webcenter/siteresources/scopedMD/shared/...) rather than on a space-by-space basis. You can find out the content directory location by selecting the required resource on the Resources page, and clicking About. The location is displayed in the Content Directory field.

Consider the following before exporting content directories for a resource in your archive:

	
Entire content directories are exported rather than individual files. For example, if a skin references two files (.../shared/skins/logos/mylogo.gif and .../shared/skins/icons/myicon.gif), the entire content of both directories (/logos and /icons) are exported.


	
If your Spaces installation utilizes a large number of portal resources (both at the application-level as well as by individual spaces and space templates), then the number of files stored under the /shared directory or its subdirectory is potentially large.


	
On upload, all files under content directories are uploaded to the target application and existing files with the same name are overwritten. While you can opt not to upload content directories on import, it is an all or nothing approach, that is, you cannot upload content specific to a particular resource or space.





	
Click Download.







	
Note:

Spaces administrators can download resources using the WLST command, exportWebCenterResource. For information, see "exportWebCenterResource" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.












10.5.3 Uploading a Resource

To upload a resource in Spaces:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired resource type.


	
Click Upload.


	
In the Upload dialog, specify the location of the resource archive file. Depending on the location of your EAR file, select either of the following (Figure 10-31):

	
Look on my computer: Select if the archive is located on your local file system. Enter the path to the EAR file or use the Browse button.


	
Look on WebCenter Portal Server: Select if the archive is located on a remote server. Enter the path to the EAR file.


Figure 10-31 Upload Dialog
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Click Upload.


	
Click Yes in the Confirm Replace Resource dialog.


	
If the resource that you are uploading contains custom content, such as images and stylesheets, the Overwrite Content Directory dialog displays. (Figure 10-32)

	
Click Yes to import all files from the content directory of the export archive.


	
Click No to import only the new files from the content directory.


Figure 10-32 Overwriting Content Directory Files
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Click OK.







	
Note:

Spaces administrators can upload resources using the WLST command, importWebCenterResource. For information, see "importWebCenterResource" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.

















11 Working with Navigation

Navigation enables the users of your portal to see what information the portal provides and to get to that information quickly and easily.

This chapter describes how to define your portal navigation model in Oracle WebCenter Portal: Spaces and how to use built-in navigation task flows to visualize that model in page templates. It includes the following sections:

	
Section 11.1, "What You Should Know About Navigation"


	
Section 11.2, "Building a Navigation Model"


	
Section 11.3, "Rendering Navigation in Your Portal"


	
Section 11.4, "AviTrust Employee Portal: An Example of Delegated Navigation"




Portal designers with advanced navigation requirements can use development tools, such as Oracle JDeveloper, to build navigation models and then upload them to Spaces. For more information, see Section 11.2.5, "Using JDeveloper to Build Your Navigation Model."

Similarly, page template designers can use those same development tools to build the navigation UI directly into page templates and upload those templates to Spaces. For more information, see Section 11.3.3, "Using JDeveloper to Visualize Your Navigation."

For generic information about adding and editing different types of resources, see Chapter 10, "Working with the Resources that Compose a Portal or Community."


Audience

This chapter is intended for Portal designers with the application permission Application-Navigations-Create, Edit, and Delete.

To build navigation models for a particular space, you need the permission space-Resources-Create, Edit, and Delete Resources (standard permission model) or space-Navigations-Create, Edit, and Delete Navigations (advanced permission model).

To add navigation to page templates, you also need the appropriate page template permissions, that is, Application-Page Templates-Edit to edit an application-wide page template, and either space-Resources-Edit Resources or space-Page Templates-Edit to edit a page template for a particular space.




	
See Also:

For information about roles and permissions, see Chapter 20, "Understanding Security."









11.1 What You Should Know About Navigation

Navigation is a fundamental aspect of your portal. Users need to be able to see what is available in the portal, move around the portal, and orient themselves within the portal.

Navigation is essentially a set of links pointing to the content of the portal, or to external resources. Examples of navigation include:

	
A series of tabs or menus along the top of each page


	
A tree structure or list of links on the side of each page


	
A trail of breadcrumbs showing the path a user has taken to reach the current location in the portal




In Spaces, you can break navigation down into two main concepts:

	
The navigation model defines the content, structure, and metadata of the navigation. For more information, see Section 11.1.1, "What You Should Know About Navigation Models."


	
The navigation visualization determines how the navigation appears on the pages of the portal, say as a menu, a tree, or breadcrumbs. For more information, see Section 11.1.2, "What You Should Know About Navigation Visualization."






11.1.1 What You Should Know About Navigation Models

When you create the navigation model, you specify the resources to which users can navigate. You can link together information from multiple sources, such as spaces, pages, content repositories, and even external web pages. You can also introduce folders and separators to make navigations easier to use. You can include nested navigation models within a navigation model to delegate development of the navigation across multiple teams, or to control access to different items in the navigation.

Navigation models can include the following resources:

	
Spaces (individual spaces and space hierarchies)


	
Pages (individual pages and page hierarchies)


	
Content (individual content items or the results of a content query)


	
Other navigation models


	
Portlets


	
Task flows


	
External applications


	
External links




The navigation model is aware of the security policies that have been applied to the elements (pages, link, task flows, and so on) that the navigation model controls. If the current user is not authorized to see a particular page, the navigation model, by default hides any navigational links to that page. Navigation model metadata can also be determined contextually using EL expressions. These expressions are evaluated at runtime to determine exactly which pieces of the navigation model are rendered in the navigation UI and to whom.

Spaces includes three built-in navigation models to get you started:

	
Spaces Administration Options—This navigation model contains administration options for spaces or the Home space (Figure 11-1). The links displayed when the navigation is rendered on a page vary depending on whether it appears in a space or in a Home space and on the permissions of the current user. By default, this navigation model includes a Manage dropdown menu to provide access to administration settings.


Figure 11-1 The Spaces Administration Options Navigation Model

[image: Description of Figure 11-1 follows]

Description of "Figure 11-1 The Spaces Administration Options Navigation Model"





	
Spaces Default Navigation Model—This navigation model contains the default top level entries for navigation in a space. It includes links to the current space pages, and links to any saved searches and subspaces (Figure 11-2).


Figure 11-2 The Spaces Default Navigation Model

[image: Description of Figure 11-2 follows]

Description of "Figure 11-2 The Spaces Default Navigation Model"





	
Spaces Navigation with Blogs/Wikis/Lists Submenus—This navigation model is similar to the Spaces Default Navigation Model, except it also includes links to any blogs, wikis, and lists for the current space (Figure 11-3).


Figure 11-3 The Navigation with Blogs/Wikis/Lists Navigation Model

[image: Description of Figure 11-3 follows]

Description of "Figure 11-3 The Navigation with Blogs/Wikis/Lists Navigation Model"







You can use these built-in navigations as they are, create copies of them and edit them to support your own requirements, or create a completely new navigation model for your portal.




	
Note:

You cannot edit the built-in navigation models. If you want to edit these navigation models, you must first create a copy, which you can then edit.







Just like other Spaces resources, portal designers can build navigation models that are available to the whole application (application-level resources) and navigation models that are scoped to a particular space (space-level resources).

If the navigation model functionality provided by Spaces does not meet your requirements, you can create the navigation model in a development tool, such as JDeveloper, and upload the model to Spaces using the Resource Manager. For more information, see Section 11.2.5, "Using JDeveloper to Build Your Navigation Model."






11.1.2 What You Should Know About Navigation Visualization

The navigation visualization determines how the navigation model should appear in the portal. For example, the navigation could be provided as a set of tabs along the top of each page, or perhaps as a tree-like structure down the side of the page.

Spaces provides the following built-in navigation task flows that page template designers can add to page templates to quickly visualize a navigation model across the entire portal:

	
Navigation Tree task flow—Tree navigations display navigational links in a hierarchical structure and often contain multiple-level hierarchies (Figure 11-4). Tree navigations can provide relatively simple access to a complex structure and quite often appear on the left in page templates.


Figure 11-4 The Navigation Tree Task Flow

[image: Description of Figure 11-4 follows]

Description of "Figure 11-4 The Navigation Tree Task Flow"





	
Navigation Menu task flow—Menu navigations display navigational links as a series of tabs, menus, bars, buttons, choices, or as a list (Figure 11-5). Menu navigation is appropriate when linking to WebCenter Portal pages, spaces, and documents, and where the number of items is known, such that there is enough room to display all the options that are available.


Figure 11-5 The Navigation Menu Task Flow

[image: Description of Figure 11-5 follows]

Description of "Figure 11-5 The Navigation Menu Task Flow"





	
Navigation Breadcrumb task flow—Breadcrumb navigations display a series of horizontal or vertical links that show users their current position in the navigation hierarchy (Figure 11-6). Breadcrumbs are particularly useful for deep hierarchies, say four levels or more, and when users might want to get back to a specific place.


Figure 11-6 The Navigation Breadcrumb Task Flow

[image: Description of Figure 11-6 follows]

Description of "Figure 11-6 The Navigation Breadcrumb Task Flow"










	
See Also:

For information about how to add these built-in navigation task flows to your page templates, see Section 11.3, "Rendering Navigation in Your Portal."
For information about the different properties you can set for the built-in navigation task flows, see Section 11.3.2, "Setting Navigation Task Flow Properties."









Spaces also provides the Spaces Browser task flow, which displays all the spaces that are available to you. This includes spaces for which you are the moderator, spaces in which you are a member, spaces that are public and available to non-Spaces users, and spaces that are private, which you must be invited to join. For more information, see Section 51.16, "Working with the Space Task Flows."


Figure 11-7 The Spaces Browser Task Flow

[image: Description of Figure 11-7 follows]

Description of "Figure 11-7 The Spaces Browser Task Flow"





If the built-in task flows do not sufficiently satisfy the navigation requirements of your portal, page template designers can also edit page templates in a development tool, for example, JDeveloper, to build the navigation UI directly into the page templates themselves, then upload them to Spaces to use there.

For more information, see Section 11.3.3, "Using JDeveloper to Visualize Your Navigation."








11.2 Building a Navigation Model

The first step in providing navigation for your portal is to define the navigation model; that is, defining the structure and content of the navigation. You do this by creating the basic navigation model, adding navigation items to it, and setting the properties of those navigation items.

This section includes the following subsections:

	
Section 11.2.1, "Creating a Navigation Model"


	
Section 11.2.2, "Editing a Navigation Model"


	
Section 11.2.3, "Managing a Navigation Model"


	
Section 11.2.4, "Selecting the Default Navigation Model"


	
Section 11.2.5, "Using JDeveloper to Build Your Navigation Model"






11.2.1 Creating a Navigation Model

You can either create an entirely new navigation model or create a copy of an existing navigation model to use as a starting point for your navigation model.

You can create navigation models at the application level or at the space level. Application-level navigation models are available for use in all spaces, unless the space has been specifically excluded. For more information, see Section 10.4.2, "Setting Properties on a Resource." Space-level navigation models are available for use only in the space in which they are created.

To create a navigation model:

	
Navigate to the Resources page of your application or the space in which you want to create the navigation model, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
On the menu bar, click Create.


	
In the Create New Navigation dialog (Figure 11-8), in the Name field, enter a name for the navigation model.


Figure 11-8 The Create New Navigation Dialog

[image: Description of Figure 11-8 follows]

Description of "Figure 11-8 The Create New Navigation Dialog"





	
In the Description field, enter a description for the navigation model.

The description is displayed below the name in the Resources page and as a tool tip when selecting a navigation model. You should ensure that the description helps page template designers determine if they want to use this particular navigation model.


	
From the Copy From list, select an existing navigation model to use as the starting point for your new navigation model, if desired. If you leave this blank, a new empty navigation model is created.




	
Tip:

You can also create a copy of an existing navigation model by selecting the existing navigation on the Resources page, clicking Edit and then Copy on the menu bar, and providing a name and description for the new navigation model.








	
Click Create.

The newly created navigation model is listed on the Resources page. The gray circle icon next to the navigation model indicates that it is not yet published and hence is not available to other users. For information about publishing a navigation model, see Section 10.4.3, "Showing and Hiding Resources."









11.2.2 Editing a Navigation Model

After creating the basic navigation model, the next step is to define exactly what to include in it. The resources that you include in the navigation model determine what users can navigate to when the model is displayed on a page.

This section includes the following subsections:

	
Section 11.2.2.1, "Adding Resources to a Navigation Model Using the Edit Dialog"


	
Section 11.2.2.2, "Editing the Source Code of a Navigation Model"






11.2.2.1 Adding Resources to a Navigation Model Using the Edit Dialog

The Edit dialog provides various options for adding resources to your navigation model.

This section includes the following subsections:

	
Section 11.2.2.1.1, "Adding a Document to a Navigation Model"


	
Section 11.2.2.1.2, "Adding Content Based on the Results of a Query to a Navigation Model"


	
Section 11.2.2.1.3, "Adding a Spaces Page, Portlet, Task Flow, External Application, or Web Page to a Navigation Model"


	
Section 11.2.2.1.4, "Adding a List of Pages to a Navigation Model"


	
Section 11.2.2.1.5, "Adding a List of Subspaces to a Navigation Model"


	
Section 11.2.2.1.6, "Nesting a Navigation Model Within a Navigation Model"


	
Section 11.2.2.1.7, "Organizing Navigation Items in a Navigation Model"


	
Section 11.2.2.1.8, "Setting Display Options for Navigation Items"






11.2.2.1.1 Adding a Document to a Navigation Model

You can add a document from your content repository to the navigation model. Selecting a document in the navigation displays that document in the page.




	
Note:

You can also include a set of documents that match particular query criteria in a navigation model. For more information, see Section 11.2.2.1.2, "Adding Content Based on the Results of a Query to a Navigation Model."







To add a document:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
In the Edit dialog, from the Add menu, choose Content Item.




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-9 The Add Content Item Menu Option

[image: Description of Figure 11-9 follows]

Description of "Figure 11-9 The Add Content Item Menu Option"





	
In the Target tab, the ID field is automatically populated with a generated ID. This ID is used to create the URL to access the item in the navigation model, so you may want to change it to something more descriptive.

The ID must be unique within the navigation model. The first character must be either an uppercase or lowercase letter or the underscore character (_). Subsequent characters can be any alphanumeric character or a dash (-), period (.), or underscore (_).

If the resource is at the top level of the navigation model, the ID must not be wc_navtitle or wcnav_externalId; these IDs are reserved.


	
In the Name field, enter a name for the navigation item. This name is displayed in the navigation when it is rendered on a page.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-10 The Edit Navigation Item Dialog for a Content Item

[image: Description of Figure 11-10 follows]

Description of "Figure 11-10 The Edit Navigation Item Dialog for a Content Item"





	
In the Description field, enter a brief description of the navigation item.


	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
In the Path field, enter the path for the content item. If you do not know the path, click the Select icon to browse the content repository for available content.




	
Note:

You can also select a content folder, in which case, you should also select a Content Presenter display template that expects a folder and renders all the content from that folder.








	
From the Content Presenter Template dropdown list, select the Content Presenter display template to use to render the content item when it is selected in the navigation.




	
See Also:

For more information about Content Presenter, see Chapter 40, "Publishing Content Using Content Presenter."








	
From the Page Template dropdown list, select the page template to use to display the navigation item when it is selected in the navigation.

Select [system default] to use the space or application default page template.


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."


	
In the Parameters tab enter values, as desired, for any parameters supported by the selected page template. You can also add custom parameters.


	
Click OK to create the navigation item.


	
Click OK to close the Edit dialog.









11.2.2.1.2 Adding Content Based on the Results of a Query to a Navigation Model

You can add a Content Query navigation item to the navigation model to include all documents that match specific search criteria.




	
See Also:

To add a single document, or all documents within a particular folder to the navigation model, see Section 11.2.2.1.1, "Adding a Document to a Navigation Model."







To add a content query to a navigation model:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
In the Edit dialog, from the Add menu, choose Content Query.




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-11 The Add Content Query Menu Option

[image: Description of Figure 11-11 follows]

Description of "Figure 11-11 The Add Content Query Menu Option"





	
In the Target tab, the ID field is automatically populated with a generated ID. This ID is used to create the URL to access the item in the navigation model, so you may want to change it to something more descriptive.

The ID must be unique within the navigation model. The first character must be either an uppercase or lowercase letter or the underscore character (_). Subsequent characters can be any alphanumeric character or a dash (-), period (.), or underscore (_).

If the resource is at the top level of the navigation model, the ID must not be wc_navtitle or wcnav_externalId; these IDs are reserved.


	
In the Name field, enter a name for the navigation item. This name is displayed in the navigation when it is rendered on a page.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-12 The Edit Navigation Item Dialog for a Content Query

[image: Description of Figure 11-12 follows]

Description of "Figure 11-12 The Edit Navigation Item Dialog for a Content Query"





	
In the Description field, enter a brief description of the navigation item.


	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
In the Query String field, enter the query criteria to identify the content to include in the navigation model, for example:


select * from cmis:document WHERE cmis:name LIKE 'Foo%'


For more information about how to format the query and for more examples, see the Oracle Fusion Middleware Content Management REST Service Developer's Guide.


	
Select Hide Top-Level Folder to display the results of the query directly in the navigation rather than displaying them under a folder.


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."


	
In the Parameters tab you can add custom parameters.


	
Click OK to create the navigation item.


	
Click OK to close the Edit dialog.









11.2.2.1.3 Adding a Spaces Page, Portlet, Task Flow, External Application, or Web Page to a Navigation Model

You can add links to individual resources, such as pages, portlets, task flows, external applications, and web pages.




	
See Also:

The Link navigation item type enables you to include a link to a single page in the navigation. For information about how to include an entire page hierarchy, see Section 11.2.2.1.4, "Adding a List of Pages to a Navigation Model."







To add a link to a spaces page, portlet, task flow, external application, or web page:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
In the Edit dialog, from the Add menu, choose Link (Figure 11-13).




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-13 The Add Link Menu Option

[image: Description of Figure 11-13 follows]

Description of "Figure 11-13 The Add Link Menu Option"








	
Note:

If you provide navigation directly to a portlet or task flow, users cannot customize that portlet or task flow. If you want users to be able to customize the portlet or task flow, add it to a page and create a navigation item for that page.








	
In the Target tab, the ID field is automatically populated with a generated ID. This ID is used to create the URL to access the item in the navigation model, so you may want to change it to something more descriptive.

The ID must be unique within the navigation model. The first character must be either an uppercase or lowercase letter or the underscore character (_). Subsequent characters can be any alphanumeric character or a dash (-), period (.), or underscore (_).

If the resource is at the top level of the navigation model, the ID must not be wc_navtitle or wcnav_externalId; these IDs are reserved.


	
In the Name field, enter a name for the navigation item. This name is displayed in the navigation when it is rendered on a page.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-14 The Edit Navigation Item Dialog for a Link

[image: Description of Figure 11-14 follows]

Description of "Figure 11-14 The Edit Navigation Item Dialog for a Link"





	
In the Description field, enter a brief description of the navigation item.


	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
In the Path field, enter the URL of the web page or click the Select icon to browse for available spaces pages, portlets, task flows, or external applications to include in the navigation model.




	
Note:

In the Select dialog, the Select button is active only when you select an item that can be included in the navigation model. For example, if you expand the Portlets node and select a portlet producer, then the Select button is disabled. If you expand the portlet producer node and select a portlet, then the Select button is enabled.








	
From the Page Template dropdown list, select the page template to use to display the navigation item when it is selected in the navigation.

Select [system default] to use the space or application default page template.


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."




	
Tip:

If you are linking to a page in a different space from the space in which the navigation model will be used, you must select the Redirect option to ensure that the link is displayed correctly.








	
In the Parameters tab enter values, as desired, for any parameters supported by the selected page, task flow, or portlet, or by the page template. You can also add custom parameters.


	
Click OK to create the navigation item.


	
Click OK to close the Edit dialog.









11.2.2.1.4 Adding a List of Pages to a Navigation Model

You can add a list of pages to the navigation model by selecting the starting point for the list and specifying the criteria to use to determine the pages to display. For example, you can include all the pages in a specific space, all the Wiki pages in the current space, or all Home space pages. All pages below the selected starting point that match the criteria are included in the navigation model.




	
See Also:

If you just want to include a single page in the navigation model, use the Link navigation item type. For more information, see Chapter 11, "Adding a Spaces Page, Portlet, Task Flow, External Application, or Web Page to a Navigation Model."







To add a list of pages:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
In the Edit dialog, from the Add menu, choose Pages Query.




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-15 The Add Pages Query Menu Option

[image: Description of Figure 11-15 follows]

Description of "Figure 11-15 The Add Pages Query Menu Option"





	
In the Target tab, the ID field is automatically populated with a generated ID. This ID is used to create the URL to access the item in the navigation model, so you may want to change it to something more descriptive.

The ID must be unique within the navigation model. The first character must be either an uppercase or lowercase letter or the underscore character (_). Subsequent characters can be any alphanumeric character or a dash (-), period (.), or underscore (_).

If the resource is at the top level of the navigation model, the ID must not be wc_navtitle or wcnav_externalId; these IDs are reserved.


	
In the Name field, enter a name for the navigation item. This name is displayed in the navigation when it is rendered on a page.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-16 The Edit Navigation Item Dialog for a Pages Query

[image: Description of Figure 11-16 follows]

Description of "Figure 11-16 The Edit Navigation Item Dialog for a Pages Query"





	
In the Description field, enter a brief description of the navigation item.


	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
In the Find Pages in radio group, select:

	
Home Space to add the current user's Home space and all its subpages to the navigation model.


	
Space to add the home page of a specific space and all its subpages to the navigation model. Enter the name of the space, or click the Select Space icon to select from all available spaces. In the Select Space dialog, you can list all available spaces or you can filter the list of spaces to those that you have joined, those that you moderate, or those that are public.


	
Path to add a specific page and all its subpages to the navigation model. Enter the path of the page, or click the Select Page icon to select from all available pages.





	
From the Page Style dropdown list, select the style of page to include in the navigation model. For example, if you select Wiki, only pages that use the Wiki page style are included in the navigation model.

Selecting [system default] displays all pages, regardless of style.


	
In the Excluded Page Styles field, specify the styles of pages to exclude from the navigation model by entering a comma-separated list of page style paths, for example:


/oracle/webcenter/siteresources/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/
pageStyle/gsr1b60e8a7_2e23_48ff_9571_31ede592de1a/TemplateWiki.jspx, 
/oracle/webcenter/siteresources/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/
pageStyle/gsr1b60e8a7_2e23_48ff_9571_31ede592de1b/TemplateBlog.jspx





	
Tip:

You can find the path of a page style by selecting it in the Resources page and clicking About in the menu bar.







Any pages that use the page styles specified here are not included in the navigation.


	
From the Visibility dropdown list, select whether to include pages even if they have been flagged as hidden in the Personalize Pages page.

Selecting [system default] displays all pages, regardless of visibility.


	
Select Hide Top-Level Folder to display the subpages in the hierarchy directly in the navigation rather than displaying them under a folder for the parent page.


	
From the Page Template dropdown list, select the page template to use to display the navigation item when it is selected in the navigation.

Select [system default] to use the space or application default page template.


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."


	
In the Parameters tab enter values, as desired, for any parameters supported by the selected page template. You can also add custom parameters.


	
Click OK to create the navigation item.


	
Click OK to close the Edit dialog.









11.2.2.1.5 Adding a List of Subspaces to a Navigation Model

You can include a list of all the subspaces of a particular space in your navigation model. You can also include all the pages in those subspaces, or specify a query to further refine which subspaces to include in the list.

To add a list of subspaces:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
In the Edit dialog, from the Add menu, choose Spaces Query.




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-17 The Add Spaces Query Menu Option

[image: Description of Figure 11-17 follows]

Description of "Figure 11-17 The Add Spaces Query Menu Option"





	
In the Target tab, the ID field is automatically populated with a generated ID. This ID is used to create the URL to access the item in the navigation model, so you may want to change it to something more descriptive.

The ID must be unique within the navigation model. The first character must be either an uppercase or lowercase letter or the underscore character (_). Subsequent characters can be any alphanumeric character or a dash (-), period (.), or underscore (_).

If the resource is at the top level of the navigation model, the ID must not be wc_navtitle or wcnav_externalId; these IDs are reserved.


	
In the Name field, enter a name for the navigation item. This name is displayed in the navigation when it is rendered on a page.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-18 The Edit Navigation Item Dialog for a Spaces Query

[image: Description of Figure 11-18 follows]

Description of "Figure 11-18 The Edit Navigation Item Dialog for a Spaces Query"





	
In the Description field, enter a brief description of the navigation item.


	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
In the Space field, enter the name of the space for which you want to display subspaces, or click the Select Space icon to select from the available spaces.

If you leave the field empty, then the current space is used.


	
Select Display Subspace Pages to also include the pages within the subspaces in the navigation.


	
Select Hide Top-Level Folder to display the subspaces directly in the navigation rather than displaying them under a folder for the parent space.


	
In the Advanced Query field, enter an EL expression to further refine the list of subspaces included in the navigation model. For example, you might want to include only community subspaces, or subspaces with a particular string in the title. For more information about using the Expression Language editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."


	
In the Parameters tab you can add custom parameters.


	
Click OK to create the navigation item.


	
Click OK to close the Edit dialog.









11.2.2.1.6 Nesting a Navigation Model Within a Navigation Model

You can nest navigation models within each other. For example, if you have a complex navigation model, it might be easier to break it down into several separate models and then nest them all within a single overarching navigation model. You can also use nested navigation models to delegate the development of navigation models to different users or to control access to different parts of the navigation.

For example, if you are creating a navigation model for a space that contains several subspaces, you may want to delegate the management of the navigation models for the subspaces to the subspace moderators. You can then include navigation references to the subspace navigation models within the main space navigation model. In this way, the person who is most familiar with the content of the subspace creates the navigation model, without having to have access to other areas of the space.

To nest navigation models:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
In the Edit dialog, from the Add menu, choose Navigation Reference.




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-19 The Add Navigation Reference Menu Option

[image: Description of Figure 11-19 follows]

Description of "Figure 11-19 The Add Navigation Reference Menu Option"





	
In the Target tab, the ID field is automatically populated with a generated ID. This ID is used to create the URL to access the item in the navigation model, so you may want to change it to something more descriptive.

The ID must be unique within the navigation model. The first character must be either an uppercase or lowercase letter or the underscore character (_). Subsequent characters can be any alphanumeric character or a dash (-), period (.), or underscore (_).

If the resource is at the top level of the navigation model, the ID must not be wc_navtitle or wcnav_externalId; these IDs are reserved.


	
In the Name field, enter a name for the navigation item. This name is displayed in the navigation when it is rendered on a page.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-20 The Edit Navigation Item Dialog for a Navigation Reference

[image: Description of Figure 11-20 follows]

Description of "Figure 11-20 The Edit Navigation Item Dialog for a Navigation Reference"





	
In the Description field, enter a brief description of the navigation item.


	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
From the Include Navigation dropdown list, select the navigation model that you want to nest within this navigation model.


	
Select Hide Top-Level Folder to display the content of the navigation model directly in the navigation rather than displaying it under a folder.


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."


	
In the Parameters tab you can add custom parameters.


	
Click OK to create the navigation item.


	
Click OK to close the Edit dialog.









11.2.2.1.7 Organizing Navigation Items in a Navigation Model

You can add folders to your navigation model to create subsets of navigation items or to group similar navigation items. You can also add separators to divide the navigation model into distinct groupings of navigation items. Folders and separators enable you to break up the items in the navigation when it is rendered on in a page, making it easier to locate items.

In addition to folders and separators, you can also organize items within the navigation model by moving them up and down in relation to each other and even indenting items to indicate hierarchy.

You can also rearrange items within the navigation model by dragging them up and down in relation to each other and dragging them inside other items to indicate hierarchy.

To organize navigation items:

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model to which you want to add the navigation item.


	
From the Edit menu, choose Edit.


	
To add a separator, in the Edit dialog, from the Add menu, choose Separator.


Figure 11-21 The Add Separator Menu Option

[image: Description of Figure 11-21 follows]

Description of "Figure 11-21 The Add Separator Menu Option"





A separator is added at the end of the navigation model. You can move the separator to the desired location as described later in this procedure.


	
To add a folder:

	
In the Edit dialog, from the Add menu, choose Folder.




	
Tip:

To create a navigation item within a folder, select the folder first and then click Add.








Figure 11-22 The Add Folder Menu Option

[image: Description of Figure 11-22 follows]

Description of "Figure 11-22 The Add Folder Menu Option"





	
In the Target tab, specify an ID, Name, and Description for the navigation item.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-23 The Edit Navigation Item Dialog for a Folder

[image: Description of Figure 11-23 follows]

Description of "Figure 11-23 The Edit Navigation Item Dialog for a Folder"





	
Select Visible if you want to display the navigation item when the navigation model is rendered on a page.

Alternatively, you can specify an EL expression to determine under which conditions the navigation item displays in the navigation. For example, to specify that the navigation item should be visible only to users with the Moderator role, use the following EL expression:


#{WCSecurityContext.userInScopedRole['Moderator']}


	
In the Options tab, set the display options for the navigation item. For more information, see Section 11.2.2.1.8, "Setting Display Options for Navigation Items."


	
In the Parameters tab you can add custom parameters.


	
Click OK to create the navigation item.

The folder is added at the end of the navigation model. You can move the folder to the desired location as described in the next step.





	
To move a navigation item within the navigation model, select the item and click the Move Up or Move Down icon as many times as necessary until the item is in the desired location.


	
To indent one navigation item (child item) under another item (parent item), move the child item so that it is immediately below the parent item, select the child item and click the Indent icon.


	
To move an indented item so that it is no longer indented below another item, select the item and click the Outdent icon.


	
Click OK to close the Edit dialog.









11.2.2.1.8 Setting Display Options for Navigation Items

You can specify various display options for navigation items to determine their appearance and behavior when the navigation is rendered on a page.

The display options available depend on the type of the navigation item.

	
Navigate to the Resources page of your application or the space that contains the navigation model to which you want to add the navigation item, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model that contains the navigation item for which you want to specify display options.


	
From the Edit menu, choose Edit.


	
Select the navigation item.


	
From the menu bar, click Edit.


	
In the Options tab, in the Access Key field, enter a key mnemonic (single character) that can be used to access the navigation item without using the mouse.




	
Tip:

All fields in the Edit dialog provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a field to open the editor. For more information about using the editor and for common EL expressions, see Appendix B, "Expression Language Expressions."








Figure 11-24 The Options Tab of the Edit Navigation Item Dialog

[image: Description of Figure 11-24 follows]

Description of "Figure 11-24 The Options Tab of the Edit Navigation Item Dialog"





	
In the Icon URI field, enter a path and file name of an image to use to represent the navigation item.


	
In the Search Keywords field, enter keywords to facilitate searching of the navigation item.


	
In the Tool Tip field, enter some brief descriptive text to display when users hover the mouse over the navigation item.


	
In the External ID field, enter an ID to enable a direct reference to the navigation item from a static link in the page.

Navigation items in the application's default navigation model with this attribute defined can be accessed using /faces/wcnav_externalId/externalId from an af:goLink component in a page or using /wcnav_externalId/externalId from an External Link navigation item in the navigation model. The alternative is to access the node by its hierarchy, which is faster, but may change as the application develops.




	
Note:

To directly access a node in the default navigation model for a particular space, you must specify the space by setting the wc.contextURL parameter, for example:

/faces/wcnav_externalId/myNavigationItem?wc.contextURL=/spaces/myProjectSpace


To directly access a node in a non-default navigation model, you must specify the path of the navigation model by setting the wcnav.modelPath URL parameter, for example:


/faces/wcnav_externalId/myNavigationItem?wcnav.model=
/oracle/webcenter/siteresources/scopedMD/
s7f446cab_f622_4b68_a83e_b7eaf28b52ec/navigation/
gsr0271c712_721a_4565_9f0e_755784a7093b/myNavigation.xml


Depending on where you are using the link, you may need to encode the URL parameters, for example, %2Fspaces%2FmyProjectSpace.










	
From the Open Link in dropdown list, select how to display the navigation item when it is selected, either in the same browser window, a new window, or a popup.

The options available depend on the type of navigation item.




	
Note:

Popups are not supported for pages.








	
Select Redirect to redirect to the URL specified for the navigation item. If you do not select this checkbox, then the URL is rendered within an IFRAME in the current page template.




	
Note:

This display option is available for all navigation items except for Navigation Reference, Folder, and Separator.
For Link navigation items that point to business role pages (for example, the My Profile page), the Redirect option has no effect; clicking the link always displays the page in the Home space.

For Link navigation items that point to a page in a different space, you must select Redirect to open the page inside the space to which the page belongs. Deselecting Redirect opens the page in the current space and may cause errors with subsequent links.










	
In the New Attribute Name field, enter the name of an attribute that has been defined for the resource but not exposed in the dialog. You can also select an attribute from the dropdown list.


	
In the New Attribute Value field, specify a value for the attribute specified in the New Attribute Name field, and click Add.




	
Note:

You can click Add even without specifying a value for the attribute. You can specify the value once the field is displayed in the dialog, along with other fields.

















11.2.2.2 Editing the Source Code of a Navigation Model

If you prefer working in source code, you can use the Edit Source option.

To edit the source code of a navigation model:

	
Navigate to the Resources page of your application or the space that contains the navigation model that you want to edit, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Navigations.


	
In the main panel, select the navigation model that you want to edit.


	
From the Edit menu, choose Edit Source.

The Edit Source dialog (Figure 11-25) displays the source code of the navigation model.


Figure 11-25 The Edit Source Dialog for a Navigation Model

[image: Description of Figure 11-25 follows]

Description of "Figure 11-25 The Edit Source Dialog for a Navigation Model"





	
Edit the code as required.

The XML syntax in the code is validated and an error message is displayed if you miss any tags or add them incorrectly. Validation is not provided for non-XML files.

You might prefer to copy the code from the dialog and paste it into an editor of your choice, for example, JDeveloper, where further validation can be performed. After editing the code, you can then copy it and paste it back into the Edit Source dialog.




	
Tip:

To make more full use of JDeveloper's capabilities for editing navigation models, you might prefer to download the navigation model from Spaces and import it into JDeveloper for editing. For more information, see Section 11.2.5, "Using JDeveloper to Build Your Navigation Model."








	
Click OK.











11.2.3 Managing a Navigation Model

This section includes the following subsections:

	
Section 11.2.3.1, "Showing and Hiding a Navigation Model"


	
Section 11.2.3.2, "Setting Properties on a Navigation Model"


	
Section 11.2.3.3, "Setting Security on a Navigation Model"


	
Section 11.2.3.4, "Copying a Navigation Model"


	
Section 11.2.3.5, "Deleting a Navigation Model"






11.2.3.1 Showing and Hiding a Navigation Model

When you create a navigation model, by default it is hidden. A hidden navigation model is not available for use in the application, the Home space, or any other space. To make a navigation model available, it must be marked as shown. Further, for a navigation model created at the application level, you can control whether it is available to any, all, or selected spaces in the application.

For generic information about hiding and showing resources, see Section 10.4.3, "Showing and Hiding Resources."

For generic information about resource availability in spaces, see Section 10.4.2, "Setting Properties on a Resource."






11.2.3.2 Setting Properties on a Navigation Model

You can control a navigation model's display attributes and availability by setting the model's properties in the Edit Properties dialog. Setting navigation model properties follows the same procedure as any other resource. For more information, see Section 10.4.2, "Setting Properties on a Resource."

To view the properties associated with a navigation model, use the About menu option.






11.2.3.3 Setting Security on a Navigation Model

You can control whether all users or only specific users or groups can access the navigation model that you created in your application or space. Setting access to a navigation model follows the same procedure as any other resource. For more information, see Section 10.4.4, "Setting Security for a Resource."






11.2.3.4 Copying a Navigation Model

You can make a copy of a page template by selecting it and choosing Copy from the Edit menu on the Resources - Navigations page. Copying a navigation model follows the same procedure as any other resource. For more information, see Section 10.4.1, "Copying a Resource."






11.2.3.5 Deleting a Navigation Model

Provided you are assigned the required permissions, you can delete any custom navigation model. Deleting a navigation model follows the same procedure as deleting any other resource. For more information, see Section 10.4.5, "Deleting a Resource."








11.2.4 Selecting the Default Navigation Model

The default navigation model provides a convenient way to select the navigation model that is used by default at the application or space level. Page template designers can then reference this default navigation model without having to know its actual name. For example, in navigation EL expressions, the default navigation model is often referenced, such as in:


#{navigationContext.defaultNavigationModel}


To specify the navigation model to use as the application-level default navigation model, perform the steps in Section 5.9, "Choosing a Default Navigation."

To specify a different navigation model to use as the default for a specific space, perform the steps in Section 51.4.12, "Changing the Navigation for a Space."






11.2.5 Using JDeveloper to Build Your Navigation Model

You may want to create a navigation model that is beyond the editing capabilities of Spaces. For example, using JDeveloper to create you navigation model enables you to use source control and also provides wizards and other tools to help you build more advanced navigation models. To do this, you have several options:

	
Use the Edit Source option to edit the source code of the navigation model. You can edit the source code directly in the Edit Source dialog or you can copy the contents of the dialog to JDeveloper for editing and then copy the edited code back into the dialog. For more information, see Section 11.2.2.2, "Editing the Source Code of a Navigation Model."


	
Download an existing Spaces navigation model, import the navigation model into JDeveloper for editing, and then upload it back to Spaces.


	
Create a completely new navigation model in JDeveloper and upload it to Spaces.




The steps to download and upload navigation models from Spaces are described in Section 10.5, "Using JDeveloper to Build Resources for the Spaces Application."

Oracle WebCenter Portal provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) for developing Spaces resources, such as navigation models. The workspace offers a design environment in which to create and edit your navigation models, and also enables you to upload your navigation models to Spaces for testing. For more information and to download the JDeveloper workspace, see the section "Developing Resources for Spaces Applications" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

For information about specific considerations for creating navigation models for use in Spaces, see the section "Working with WebCenter Portal: Spaces Navigation Models" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.








11.3 Rendering Navigation in Your Portal

One of the key parts of a page template is the navigation visualization. This determines how the navigation looks and behaves in your portal. You can also add navigation visualization to a page, but typically you add it to a page template so that it can be defined in one place and propagated consistently across the whole portal.

This section includes the following subsections:

	
Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates"


	
Section 11.3.2, "Setting Navigation Task Flow Properties"


	
Section 11.3.3, "Using JDeveloper to Visualize Your Navigation"






11.3.1 Adding Built-in Navigation Task Flows to Page Templates

WebCenter Portal provides several built-in navigation task flows to enable you to quickly add navigation to your portal.




	
Note:

By default the Resource Catalog for pages does not include the built-in navigation task flows because the recommended method of providing navigation is through your page templates. If you want to be able to add the navigation task flows to a page, you must create a custom Resource Catalog that includes the task flows. For more information, see Section 16.2, "Creating Resource Catalogs."







Typically, you first add the desired task flow to the page template and then select the navigation model to use to drive the content of the navigation. This is the method described in this section. However, if you are using a custom Resource Catalog that includes navigation models, you can start by selecting the navigation model and then choosing which task flow to use to visualize that model. Navigation models are not included in the default page template Resource Catalog.

As well as the task flows described in this section, which you associate with navigation models, Spaces also provides the Spaces Browser task flow, which you can use to enable users to navigate to different spaces. For more information, see Section 51.16, "Working with the Space Task Flows."

Additional navigation task flows are available for download from Oracle Technology Network at:

http://www.oracle.com/technetwork/middleware/webcenter/samples-196325.zip

The zip file contains the following navigation task flows:

	
List Navigation—Renders a navigation model in a vertical list format. Folders and their items are rendered as dropdown menus. Empty folders are not rendered.


	
Menu with Links Navigation—Renders a navigation model in a horizontal menu format. For top level navigation items, folders are rendered as dropdown menus, navigable links with no children are rendered as a top level link. Empty folders are not rendered.


	
Tree Navigation—Renders a navigation model in a vertical collapsed tree format.




Download the zip file and extract its contents locally. You can then upload one or more of the EAR files to your application, as described in Section 10.5.3, "Uploading a Resource." The task flows are then available in the Resource Catalog under Mash-Ups, Task Flows.

To add a built-in navigation task flow to a page template:

	
Open the page template in edit mode.

For more information, see Section 12.3, "Editing a Page Template."


	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that contains the built-in navigation task flows.




	
Tip:

The presence or location of this component depends on how the Resource Catalog is configured. For example, in the default Page Templates Resource Catalog, next to Template Development, click Open to expose a list that includes a Navigations folder. Click Open next to this folder to display the list of built-in navigation task flows.








	
Click Add next to the task flow that you want to add to your page.


	
Click Close to exit the Resource Catalog.


	
Hover the mouse over the task flow and, in the menu that pops up, click the Edit icon (wrench) for the task flow.




	
Tip:

Ensure that you click the Edit icon for the task flow and not the one for the region that contains the task flow.








	
In the Component Properties dialog, click the Parameters tab.


	
From the Navigation dropdown list, select the navigation model that you want to associate with the task flow.


	
Set any other properties as desired.

For information about the other properties available for the different navigation task flows, see Section 11.3.2, "Setting Navigation Task Flow Properties."

For some examples of the effects of these properties, see Section 11.3.2.3, "Using Properties to Configure Navigation Task Flow Instances."


	
Click OK.









11.3.2 Setting Navigation Task Flow Properties

The navigation task flows have associated properties, which users with sufficient privileges can access from the Component Properties dialog in Composer (Figure 11-26).


Figure 11-26 Navigation Tree Task Flow - Component Properties

[image: Description of Figure 11-26 follows]

Description of "Figure 11-26 Navigation Tree Task Flow - Component Properties"





This section provides an overview of the navigation task flow properties and steps you through examples of configuring a task flow instance using property values. This section includes the following subsections:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Activity Graph service task flows and describe the properties on the Parameters tab:

	
Section 11.3.2.1, "What You Should Know About Navigation Task Flow Properties."


	
Section 11.3.2.2, "Navigation Task Flow Parameters"


	
Section 11.3.2.3, "Using Properties to Configure Navigation Task Flow Instances."






11.3.2.1 What You Should Know About Navigation Task Flow Properties

When you set property values on a navigation task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 11.3.2.2, "Navigation Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. These properties are unique to the task flow type and are covered in this section. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














11.3.2.2 Navigation Task Flow Parameters

The following tables describe the parameters that are unique to each of the built-in navigation task flows.

Table 11-1 describes the parameters for the Navigation Breadcrumb task flow.


Table 11-1 Navigation Breadcrumb Task Flow Parameters

	Parameter	Description
	
Display Style

	
Specifies whether to display breadcrumbs horizontally or vertically.


	
Navigation

	
The navigation model to associate with this task flow.


	
Show Root

	
Specifies whether to show the start node in the breadcrumbs.


	
Start Path

	
The level in the navigation model at which to start the navigation.

You can enter a path or an EL expression or click the Select Path icon to select the start node.

Valid values are:

	
Start at the Currently Selected Page Path


	
Start at This Level of the Currently Selected Page Path


	
Select Page Path




For more information, see Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation."








Table 11-2 describes the parameters for the Navigation Menu task flow.


Table 11-2 Navigation Menu Task Flow Parameters

	Parameter	Description
	
Navigation

	
The navigation model to associate with this task flow.


	
Second Level Style

	
The style for rendering the second level of navigation items.

Valid values are: Do Not Display, Tabs, Bar, Buttons, Choice, List

Notes:

	
If the resource being rendered is non-navigable, for example, a folder, then it cannot be displayed as a tab, bar, button, choice, or list. It can be displayed only if the style Menu or Menu with Sub-Menus is selected.


	
This property is available only if the Style property is not Menu or Menu with Sub-Menus.





	
Show Icons

	
Specifies whether to render icons for each resource.


	
Start Path

	
The level in the navigation model at which to start the navigation.

You can enter a path or an EL expression or click the Select Path icon to select the start node.

Valid values are:

	
Start at the Currently Selected Page Path


	
Start at This Level of the Currently Selected Page Path


	
Select Page Path




For more information, see Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation."

Note: The Navigation Menu task flow is limited to showing a maximum of two levels of resources.


	
Style

	
The style for rendering the first level of resources.

Valid values are Tabs, Bar, Buttons, Choice, List, Menu, Menu with Sub-Menus

Notes:

	
If the resource being rendered is non-navigable, for example, a folder, then it cannot be displayed as a tab, bar, button, choice, or list. It can be displayed only if the style Menu or Menu with Sub-Menus is selected.


	
If a navigable item is rendered using the Menu with Sub-Menus style, the item is rendered twice, once as a dropdown menu, and once as a link to the item itself.











Table 11-3 describes the parameters for the Navigation Tree task flow.


Table 11-3 Navigation Tree Task Flow Parameters

	Parameter	Description
	
Navigation

	
The navigation model to associate with this task flow.


	
Show Icons

	
Specifies whether to render icons for each resource.


	
Show Levels

	
The number of levels shown when the tree is initially rendered.

Valid values are:

	
1: Show top level nodes only; all other nodes are initially collapsed


	
2: Expand the first level of child nodes


	
3: Expand the second level of child nodes


	
All: Expand all nodes




Note: This option applies only if the tree is rendered with the Style property set to Collapsed Tree. If the Style property is set to Expanded Tree then all nodes are shown expanded regardless of the value of this property.


	
Show Root

	
Specifies whether to render the start node in the tree.

Valid values are:

	
Do Not Show Root: Do not render the start node


	
Show Root: Render the start node


	
Show Root As Box: Render the start node as the header in a box





	
Start Path

	
The level in the navigation model at which to start the navigation.

You can enter a path or an EL expression or click the Select Path icon to select the start node.

Valid values are:

	
Start at the Currently Selected Page Path


	
Start at This Level of the Currently Selected Page Path


	
Select Page Path




For more information, see Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation."


	
Style

	
The style of the navigation.

Valid values are:

	
Collapsed Tree: Render the given levels (as specified by the Show Levels property) as initially collapsed


	
Expanded Tree: Render all tree nodes, expanded to show all children


	
List: Render a flat list of top-level resources. If any of the top-level resources are folders, the content of those folders are provided in dropdown menus.

Note: Selecting the List option overrides the Show Levels and Show Root properties.















11.3.2.3 Using Properties to Configure Navigation Task Flow Instances

This section includes the following subsections:

	
Section 11.3.2.3.1, "Sample Navigation Model"


	
Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation"


	
Section 11.3.2.3.3, "Rendering Navigation as a Tree"


	
Section 11.3.2.3.4, "Rendering Navigation as a Menu"


	
Section 11.3.2.3.5, "Rendering Navigation as Breadcrumbs"


	
Section 11.3.2.3.6, "Linking Navigation Task Flows"






11.3.2.3.1 Sample Navigation Model

The following sections use examples based on the sample navigation model shown in Figure 11-27.


Figure 11-27 The Sample Navigation Model

[image: Description of Figure 11-27 follows]

Description of "Figure 11-27 The Sample Navigation Model"









11.3.2.3.2 Selecting the Start Path for Your Navigation

To select the start path for your navigation:

	
Create your navigation model, as described in Section 11.2, "Building a Navigation Model."


	
Add the Navigation Menu task flow to your application's page template, as described in Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."


	
In the Parameters tab of the Component Properties dialog, next to the Start Path field, click the Select Path icon.


	
In the Select Start Path dialog, select:

	
Start at the Currently Selected Page Path to use the currently selected page as the starting point of the navigation. This populates the Start Path property with the following EL expression:


#{navigationContext.navigationModel['modelPath=path'].currentSelection.prettyUrl}


where path is the path to the navigation model XML file (omitting the trailing .xml), for example:


#{navigationContext.navigationModel['modelPath=/oracle/webcenter/portalapp/navigations/myNavigation'].currentSelection.prettyUrl}


In our banking application example, if this option is selected, when the user navigates to the Current Accounts page, the navigation looks as shown in Figure 11-28.


Figure 11-28 Start at the Currently Selected Page Path

[image: Description of Figure 11-28 follows]

Description of "Figure 11-28 Start at the Currently Selected Page Path"





	
Start at This Level of the Currently Selected Page Path to use the nth level of the path to the currently selected page as the starting point of the navigation (where n is the number specified in the field next to this option). This populates the Start Path property with the following EL expression:


#{navigationContext.navigationModel['modelPath=path'].currentSelection.prettyUrlPath[level]}


where path is the path to the navigation model XML file (omitting the trailing .xml) and level is the number specified in the field.

In our banking application example, if this option is selected with the value of 1, when the user navigates to the Personal Banking page, and then the Current Accounts page, the navigation starts at the first level of this path, that is, Personal Banking (Figure 11-29).


Figure 11-29 Start at Specified Level of the Currently Selected Page Path

[image: Description of Figure 11-29 follows]

Description of "Figure 11-29 Start at Specified Level of the Currently Selected Page Path"





	
Select Page Path to use a specific page as the starting point of the navigation. This populates the Start Path property with the path to the selected page.












11.3.2.3.3 Rendering Navigation as a Tree

To render your navigation model as a tree:

	
Create your navigation model, as described in Section 11.2, "Building a Navigation Model."


	
Add the Navigation Menu task flow to your application's page template, as described in Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."


	
Select the Start Path for the navigation when it is rendered on the page, as illustrated in Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation."


	
From the Show Levels dropdown list, select how many levels to expand when the tree is initially rendered with the Collapsed Tree style.




	
Note:

If the navigation is rendered using the Expanded Tree style, this option is ignored and the navigation is rendered will all nodes fully expanded.








	
From the Show Root dropdown list, select whether to display the start node in the tree.

For example, if the start node is Current Account, select:

	
Show Tree Root to include the Current Account node in the tree (Figure 11-30).


Figure 11-30 Show Tree Root

[image: Description of Figure 11-30 follows]

Description of "Figure 11-30 Show Tree Root"





	
Do Not Show Root to not include the Current Account node (Figure 11-31).


Figure 11-31 Do Not Show Root

[image: Description of Figure 11-31 follows]

Description of "Figure 11-31 Do Not Show Root"





	
Show Root As Box to include the Current Account node as the header of a box that contains the rest of the navigation(Figure 11-32).


Figure 11-32 Show Root As Box

[image: Description of Figure 11-32 follows]

Description of "Figure 11-32 Show Root As Box"








	
From the Style dropdown list, select what style to use for the tree.

	
Collapsed Tree displays the tree initially collapsed according to the levels specified by the Show Levels property.


	
Expanded Tree displays the tree with all levels completely expanded.


	
List displays the tree as a flat list of the top-level resources. If any of the top-level resources are folders, they are displayed as dropdown menus that display the contents of the folders.

Using our banking example, if the start node is Personal Banking, a tree navigation with the List style looks like Figure 11-33.


Figure 11-33 List Style Tree with No Folders

[image: Description of Figure 11-33 follows]

Description of "Figure 11-33 List Style Tree with No Folders"





However, if the start node is Current Account (which contains two folders), it looks like Figure 11-34.


Figure 11-34 List Style Tree with Folders

[image: Description of Figure 11-34 follows]

Description of "Figure 11-34 List Style Tree with Folders"








	
Select Show Icons to display the icons associated with the navigation items in the tree (Figure 11-35).


Figure 11-35 Show Icons

[image: Description of Figure 11-35 follows]

Description of "Figure 11-35 Show Icons"












11.3.2.3.4 Rendering Navigation as a Menu

To render your navigation model as a menu:

	
Create your navigation model, as described in Section 11.2, "Building a Navigation Model."


	
Add the Navigation Menu task flow to your application's page template, as described in Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."


	
Select the Start Path for the navigation when it is rendered on the page, as illustrated in Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation."


	
From the Style dropdown list, select how you want to display the first level of navigation items in the menu. Using our sample banking application, we can illustrate the different options for this property:

	
Tabs


Figure 11-36 Tabs Menu Navigation Style

[image: Description of Figure 11-36 follows]

Description of "Figure 11-36 Tabs Menu Navigation Style"





	
Bar


Figure 11-37 Bar Menu Navigation Style

[image: Description of Figure 11-37 follows]

Description of "Figure 11-37 Bar Menu Navigation Style"





	
Buttons


Figure 11-38 Buttons Menu Navigation Style

[image: Description of Figure 11-38 follows]

Description of "Figure 11-38 Buttons Menu Navigation Style"





	
Choice


Figure 11-39 Choice Menu Navigation Style

[image: Description of Figure 11-39 follows]

Description of "Figure 11-39 Choice Menu Navigation Style"





	
List


Figure 11-40 List Menu Navigation Style

[image: Description of Figure 11-40 follows]

Description of "Figure 11-40 List Menu Navigation Style"





	
Menu


Figure 11-41 Menu Navigation Style

[image: Description of Figure 11-41 follows]

Description of "Figure 11-41 Menu Navigation Style"








	
From the Second Level Style dropdown list, select the style to use for the second level of resources in the navigation.




	
Note:

Menu navigations can render only two levels of resources.








	
Select Show Icons to display the icons associated with the navigation items in the menu.









11.3.2.3.5 Rendering Navigation as Breadcrumbs

To render your navigation model as breadcrumbs:

	
Create your navigation model, as described in Section 11.2, "Building a Navigation Model."


	
Add the Navigation Menu task flow to your application's page template, as described in Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."


	
Select the Start Path for the navigation when it is rendered on the page, as illustrated in Section 11.3.2.3.2, "Selecting the Start Path for Your Navigation."


	
Select Show Root to display the start node in the breadcrumbs.


	
From the Display Style dropdown list, select whether to display the breadcrumbs vertically or horizontally, for example Figure 11-42 shows breadcrumbs displayed horizontally.


Figure 11-42 Horizontal Breadcrumbs

[image: Description of Figure 11-42 follows]

Description of "Figure 11-42 Horizontal Breadcrumbs"





Figure 11-43 shows breadcrumbs displayed vertically.


Figure 11-43 Vertical Breadcrumbs

[image: Description of Figure 11-43 follows]

Description of "Figure 11-43 Vertical Breadcrumbs"












11.3.2.3.6 Linking Navigation Task Flows

You may want to include more than one area of navigation in your portal. For example, you might want to include tabs along the top of the page, displaying the top level of your navigation model, and a second tree structure down the side of the page. You can link the navigation task flows together so that the tree navigation reflects the selected navigation item in the tabbed menu.

The following procedure shows how to do this using our banking example.

To link navigation task flows:

	
Create your navigation model, as described in Section 11.2, "Building a Navigation Model."


	
Add the Navigation Menu task flow to a region along the top of your application's page template, as described in Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."


	
Add the Navigation Tree task flow to a region along the side of your application's page template, as described in Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."


	
Hover the mouse over the Navigation Menu task flow and, in the menu that pops up, click the Edit icon (wrench) for the task flow.




	
Tip:

Ensure that you click the Edit icon for the task flow and not the one for the region that contains the task flow.








	
In the Component Properties dialog, click the Parameters tab.


	
From the Navigation dropdown list, select the desired navigation model, or enter an EL expression.


	
In the Start Path parameter, enter / to start at the root of the navigation model.


	
From the Style dropdown list, select Tabs.


	
From the Second Level Style dropdown list, select Do Not Display.

This restricts this part of the navigation to display only the top level of the navigation model. The rest of the navigation model is displayed in the tree navigation.


	
Click OK.


	
Hover the mouse over the Navigation Tree task flow and, in the menu that pops up, click the Edit icon (wrench) for the task flow.




	
Tip:

Ensure that you click the Edit icon for the task flow and not the one for the region that contains the task flow.








	
In the Component Properties dialog, click the Parameters tab.


	
From the Navigation dropdown list, select the same navigation model as is used for the Navigation Menu task flow, or enter the same EL expression.


	
Next to the Start Path field, click the Select Path icon.


	
In the Select Start Path dialog, select Start at the Currently Selected Page Path and click OK.

This ensures that the tree navigation displays the navigation for whatever has been selected in the menu navigation.


	
From the Show Root dropdown list, select Do Not Show Root.

The root of the navigation model is displayed in the tabs at the top of the page, so there is no need to duplicate it here.


	
Click OK.


	
Save and close the page template.

Figure 11-44 shows how the above procedure might work for our banking example. Selecting the Personal Banking tab at the top of the page displays the rest of the navigation model (from Personal Banking down) on the side of the page.


Figure 11-44 Linking Navigation Task Flows

[image: Description of Figure 11-44 follows]

Description of "Figure 11-44 Linking Navigation Task Flows"
















11.3.3 Using JDeveloper to Visualize Your Navigation

The navigation task flows provided by Spaces enable you to quickly visualize your navigation in your application. However, you may find that these task flows do not quite match your navigation requirements. If you find this is the case, you can use JDeveloper to edit the page templates you create in Spaces and add the navigation UI directly to the templates using the navigation EL APIs provided by WebCenter Portal. You can then upload these edited page templates back into Spaces. You can also create your page templates entirely in JDeveloper before uploading them to Spaces. The Spaces seeded page templates were created in this way.

The steps to download and upload page templates from Spaces are described in Section 10.5, "Using JDeveloper to Build Resources for the Spaces Application."

For information about specific considerations for creating page templates for use in Spaces, see the section "How to Create and Manage WebCenter Portal: Spaces Page Templates" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

For information about how to programmatically add navigation UI to your page templates using JDeveloper, see the section "Programmatically Adding Navigation to a Page Template" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.








11.4 AviTrust Employee Portal: An Example of Delegated Navigation

AviTrust is a fictional financial organization that uses Oracle WebCenter Portal for both its external facing web site and its internal employee portal.

The AviTrust employee portal is created using Spaces (Figure 11-45).


Figure 11-45 The AviTrust Employee Portal Home Page

[image: Description of Figure 11-45 follows]

Description of "Figure 11-45 The AviTrust Employee Portal Home Page"





The AviTrust employee portal consists of a single space containing several subspaces. Some of these subspaces in turn have their own subspaces (Figure 11-46).


Figure 11-46 Structure of the AviTrust Employee Portal

[image: Description of Figure 11-46 follows]

Description of "Figure 11-46 Structure of the AviTrust Employee Portal"





To provide navigation around the portal, the administrator could create a single navigation model and maintain complete control over the structure and content. However, as the subspaces are each maintained by individual department representatives, the administrator is probably not the best person to determine the navigation that is required through those subspaces; the department representatives are much more familiar with the content. Rather than have multiple users attempting to update the same navigation model, the administrator can create several navigation models: one for the main navigation, and one for each of the different subspaces. Each of the subspace navigation models includes only those navigation items applicable to that particular area of the portal. The main navigation model can then include the subspace navigation models by reference.

For example, the Banking navigation model includes a list of the pages within the Banking subspace and a list of its subspaces (East Coast, West Coast, DC Branch, NY Branch, and Boston Branch). These navigation items are then included in the main navigation model by referencing the Banking navigation model (Figure 11-47).


Figure 11-47 Structure of the AviTrust Employee Portal Navigation

[image: Description of Figure 11-47 follows]

Description of "Figure 11-47 Structure of the AviTrust Employee Portal Navigation"





Delegating the design of the navigation model in this way means that the department representatives can determine the navigation within their own specific areas of the portal, leading to more meaningful structure and removing the bottleneck of a single navigation model or a single navigation designer.

The following example steps through the process performed by the portal administrator and department representatives to create the navigation for the AviTrust Employee Portal.




	
Note:

While this example assumes the existence of a partially constructed AviTrust Employee Portal, it is still possible to go through it by creating any portal with the structure shown in Figure 11-46.







To create the navigation for the AviTrust employee portal:

	
Log in to the AviTrust Employee Portal as an administrator.


	
Click the Administration link.


	
Click the Resources tab.


	
In the left panel of the Resources Manager, click Navigations.


	
Click Create to create a new navigation model.


	
In the Create New Navigation dialog, in the Name field, enter AviTrust Intranet Navigation Model.


	
In the Description field, enter Main navigation model for the AviTrust Employee Portal.


	
Leave the Copy From dropdown list empty to create the navigation model from scratch.

Figure 11-48 shows the completed dialog.


Figure 11-48 Create the Main AviTrust Navigation Model

[image: Description of Figure 11-48 follows]

Description of "Figure 11-48 Create the Main AviTrust Navigation Model"





	
Click Create.

This is the main, top-level navigation model for the portal.


	
Next you must create the navigation models for individual departments represented in the portal.

Each of these navigation models must be created at the subspace level, this is so that the appropriate departmental representatives can manage them.


	
First, let's create the navigation model for the HR department.

Go to the Human Resources subspace.


	
Display the space administration pages.




	
Note:

The way you access the space administration pages depends on the page template in use. For example, in a top navigation template, you may access space administration pages through a Manage menu.
You can also navigate to these pages using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Click the Resources tab.


	
In the left panel of the Resources Manager, click Navigations.


	
Click Create to create a new navigation model.


	
Create a navigation model for the HR department with the following details:

	
Name: HRNav


	
Description: Navigation model for the HR subspace


	
Copy From: Leave blank





	
Next, let's create the navigation model for the Banking department.

Go to the Banking subspace.


	
Display the space administration pages.




	
Note:

The way you access the space administration pages depends on the page template in use. For example, in a top navigation template, you may access space administration pages through a Manage menu.
You can also navigate to these pages using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Click the Resources tab.


	
In the left panel of the Resources Manager, click Navigations.


	
Click Create to create a new navigation model.


	
Create a navigation model for the Banking department with the following details:

	
Name: BankingNav


	
Description: Navigation model for the Banking subspace


	
Copy From: Leave blank





	
The next step is to design the navigation models for the individual subspaces.




	
Note:

When implementing delegated navigation development, the following steps would be performed by the moderators of the subspaces. However, for the purposes of this example, we will continue through the steps as the administrator.








	
With the new Banking navigation model selected, click the Edit menu, and then choose Edit.


	
The Banking navigation model includes a list of the pages within the subspace. To do this, you can add a Pages Query navigation item.

In the Edit - BankingNav Model dialog, click the Add menu and choose Pages Query.


	
In the Edit Navigation Item - Pages Query dialog, in the Name field, enter Banking Pages.


	
In the Description field, enter List of pages in the Banking subspace.


	
In the Find Pages in radio group, make sure that Space is selected because we want to list the pages in a space (the Banking subspace).

The Banking subspace is already specified in the adjacent field.


	
From the Visibility dropdown list, select Show only visible items, to ensure that any hidden pages are not included in the navigation.


	
Select Hide Top-Level Folder so that the pages are listed directly, rather than under a folder for the space.

Figure 11-49 shows the completed dialog.


Figure 11-49 The Pages Query in the AviTrust HR Navigation Model

[image: Description of Figure 11-49 follows]

Description of "Figure 11-49 The Pages Query in the AviTrust HR Navigation Model"





	
Click OK.


	
The Banking subspace also contains several subspaces that should be listed in the navigation model. To do this, you can add a Spaces Query navigation item.

In the Edit - BankingNav dialog, click the Add menu and choose Spaces Query.


	
In the Edit Navigation Item - Spaces Query dialog, in the Name field, enter Banking Spaces Query.


	
In the Description field, enter List of subspaces in the Banking subspace.


	
Next to the Visible field, click the Expression Builder icon, and then choose Expression Builder.


	
Select Type a value or expression, and enter the following EL expression in the field:


#{!empty spaceContext.currentSpace}


This means that the subspace is visible when the navigation model is rendered, only if the subspace is not empty.


	
Next to the Space field, click the Select Space icon.


	
In the Select Space dialog, select Banking and click OK.


	
Select Hide Top-Level Folder so that the subspaces are listed directly, rather than under a folder for the space.

Figure 11-50 shows the completed dialog.


Figure 11-50 The Subspaces Query in the AviTrust Banking Navigation Model

[image: Description of Figure 11-50 follows]

Description of "Figure 11-50 The Subspaces Query in the AviTrust Banking Navigation Model"





	
Click OK.


	
Click the Preview tab to check that the Banking pages and subspaces are listed (Figure 11-51).


Figure 11-51 Preview of the AviTrust Banking Navigation Model

[image: Description of Figure 11-51 follows]

Description of "Figure 11-51 Preview of the AviTrust Banking Navigation Model"





	
Click OK.


	
With the navigation model still selected, click the Edit menu and then choose Show.

This makes the navigation model available to use in your application.


	
Now, lets design the HR navigation model.




	
Note:

Again, for real delegated navigation development, the following steps would be performed by the space moderator.







Go to the Human Resources subspace.


	
Display the space administration pages.




	
Note:

The way you access the space administration pages depends on the page template in use. For example, in a top navigation template, you may access space administration pages through a Manage menu.
You can also navigate to these pages using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Click the Resources tab.


	
In the left panel of the Resources Manager, click Navigations.


	
Select HRNav, click the Edit menu, and then choose Edit.


	
The HR navigation model consists of a list of the pages within the HR subspace. To do this, as with the Banking navigation model, you can add a Pages Query navigation item.

In the Edit - HRNav Model dialog, click the Add menu and choose Pages Query.


	
In the Edit Navigation Item - Pages Query dialog, in the Name field, enter HR Pages.


	
In the Description field, enter List of pages in the HR subspace.


	
In the Find Pages in radio group, make sure that Space is selected because we want to list the pages in a space (the HR subspace).

The HR subspace is already specified in the adjacent field.


	
From the Visibility dropdown list, select Show only visible items, to ensure that any hidden pages are not included in the navigation.


	
Select Hide Top-Level Folder so that the pages are listed directly, rather than under a folder for the space.

Figure 11-52 shows the completed dialog.


Figure 11-52 The Pages Query in the AviTrust HR Navigation Model

[image: Description of Figure 11-52 follows]

Description of "Figure 11-52 The Pages Query in the AviTrust HR Navigation Model"





	
Click OK.


	
Click the Preview tab to check that the Human Resources pages are listed (Figure 11-53).


Figure 11-53 Preview of the AviTrust HR Navigation Model

[image: Description of Figure 11-53 follows]

Description of "Figure 11-53 Preview of the AviTrust HR Navigation Model"





	
Now that you have created and populated the department-level navigation models, you can move on to the main navigation model.

Click the Back to the Space link.


	
Click the Administration link.


	
Click the Resources tab.


	
In the left panel of the Resources Manager, click Navigations.


	
Select the AviTrust Intranet Navigation Model.


	
Click the Edit menu, and then choose Edit.


	
First, let's add a link to the home page of the portal.

In the Edit - AviTrust Intranet Navigation Model dialog, click the Add menu and choose Link.


	
In the Edit Navigation Item - Link dialog, in the Name field, enter Home.


	
In the Description field, enter Link to the AviTrust Employee Portal home page.


	
In the Path field, enter the path of the portal home page, for example:


page://oracle/webcenter/page/scopedMD/s730ab705_4b08_438c_ab2a_7ad3b3b0fcf1/
PortalSiteHome.jspx


Figure 11-54 shows the completed dialog.


Figure 11-54 The Home Link in the AviTrust Main Navigation Model

[image: Description of Figure 11-54 follows]

Description of "Figure 11-54 The Home Link in the AviTrust Main Navigation Model"





	
Click OK.


	
Next, the navigation model should link to the home page of the HR subspace.

Click the Add menu and choose Link.


	
In the Edit Navigation Item - Link dialog, in the Name field, enter Human Resources.


	
In the Description field, enter Link to the HR subspace home page.


	
In the Path field, enter the path of the HR subspace home page, for example:


page://oracle/webcenter/page/scopedMD/s712f1d65_900c_418e_be91_b40b27617b47/
Page4.jspx


	
Click OK.


	
Now, add the reference to the HR navigation model to include it in the main navigation model.

Click the Add menu and choose Navigation Reference.


	
In the Edit Navigation Item - Navigation Reference dialog, in the Name field, enter Human Resources Navigation Reference.


	
In the Description field, enter Embedded HR navigation model.


	
Next to the Include Navigation dropdown list, click the Expression Builder icon, then choose Expression Builder.


	
In the Expression Editor dialog, select Type a value or expression.


	
In the field below, enter the path to the HR navigation model, for example:


/oracle/webcenter/siteresources/scopedMD/s712f1d65_900c_418e_be91_b40b27617b47/
navigation/gsr10267cfe_95d0_49df_bca4_1da5f9094082/Navigation.xml





	
Tip:

To obtain the path of the navigation model, select it in the Resource Manager for the HR subspace, choose Edit Properties from the Edit menu, and then copy the value from the Metadata File field.







Figure 11-55 shows the completed dialog.


Figure 11-55 The Expression to Identify the HR Navigation Model

[image: Description of Figure 11-55 follows]

Description of "Figure 11-55 The Expression to Identify the HR Navigation Model"





	
Click OK to return to the Edit Navigation Item - Navigation Reference dialog.

Figure 11-56 shows the completed dialog.


Figure 11-56 The Navigation Reference to the HR Navigation Model

[image: Description of Figure 11-56 follows]

Description of "Figure 11-56 The Navigation Reference to the HR Navigation Model"





	
Click OK.


	
Click the Indent icon to move the navigation reference under the HR home link.


	
Repeat steps 68 to 72 to add a link to the Banking home page.


	
Repeat steps 73 to 80 to add a navigation reference to the Banking navigation model


	
Indent the Banking navigation reference under the Banking home link.


	
Repeat steps 68 to 72 to add a link to the Insurance home page.


	
Click the Preview tab to check the main navigation model (Figure 11-57).


Figure 11-57 Preview of the Main AviTrust Navigation Model

[image: Description of Figure 11-57 follows]

Description of "Figure 11-57 Preview of the Main AviTrust Navigation Model"





	
Click OK.


	
With the navigation model still selected, click the Edit menu and then choose Show.

This makes the navigation model available to use in your application.


	
The next step would be to visualize this navigation within the portal, typically by adding some navigation UI to your portal's page template.

For more information about visualizing portal navigation, see Section 11.3, "Rendering Navigation in Your Portal."












12 Working with Page Templates

Out-of-the-box, Oracle WebCenter Portal: Spaces is pre-configured with a range of page templates that users can apply to spaces and pages. Portal designers can change out-of-the-box page templates and create brand new ones to achieve a look, feel, and layout that suits their organization.

This chapter describes how to create, edit, and apply page templates in Spaces. It contains the following sections:

	
Section 12.1, "What You Should Know About Page Templates"


	
Section 12.2, "Creating a Page Template"


	
Section 12.3, "Editing a Page Template"


	
Section 12.4, "Customizing a Page Template for a Space"


	
Section 12.5, "Managing a Page Template"


	
Section 12.6, "Applying a Page Template to a Space"


	
Section 12.7, "Choosing the Page Template Resource Catalog"


	
Section 12.8, "Using JDeveloper to Build Your Page Templates"




Portal designers with advanced layout requirements can use development tools, such as Oracle JDeveloper, to build page templates and upload them to Spaces.

For generic information about adding and editing different types of resources, see Chapter 10, "Working with the Resources that Compose a Portal or Community."


Audience

This chapter is intended for portal designers with the application permission Application-Page Templates-Create, Edit, and Delete.

To build page templates for a particular space, you need the permission space-Resources-Create, Edit, and Delete Resources (standard permission model) or space-Page Templates-Create, Edit, and Delete Page Templates (advanced permission model).




	
See Also:

For information about roles and permissions, see Chapter 20, "Understanding Security."









12.1 What You Should Know About Page Templates

In Spaces, page templates define how individual pages and groups of pages display on a user's screen. When you use page templates to display pages, the pages are always consistent in structure and layout across the application.

A typical page template, shown below, defines the following:

	
Header on top of the page


	
Navigation structure at the top of the page, or in a sidebar, to link to important targets


	
Page content area


	
Footer at the bottom of the page




Everything that surrounds the "page content" area is referred to as the page template.


Figure 12-1 Page Template - Basic Structure

[image: Page Template]

Description of "Figure 12-1 Page Template - Basic Structure"





Just like other Spaces resources, portal designers can build page templates that are available to the whole application (application-level resources) and page templates that are scoped to a particular space (space-level resources).




	
Note:

If you create a page template at the space level, the template is available only to that space and not to any subspaces beneath it. To make a page template available to a space and all its subspaces, the template must be created at the application level.










	
See Also:

For more information about page templates, see the section "Using Page Templates" in the Oracle Fusion Middleware Web User Interface Developer's Guide for Oracle Application Development Framework.









12.1.1 Out-of-the-Box Page Templates

Spaces provides several out-of-the-box page templates:

	
Collaborative with Top Navigation—A page template designed for use with collaborative spaces.

Navigation: Above the main content area

Layout: Flow. Components in the main content area take as much space as they need and are not stretched to fill the available space. If the page content does not fit in the viewable area, the vertical browser scrollbar is automatically displayed.

Skin: Spaces FX


	
Fusion Side Navigation

Navigation: Side bar

Layout: Stretch. Components are stretched to maximize usage of the viewable area. If the page content does not fit in the viewable area, inner scrollbars are used on the components

Skin: Fusion FX


	
Fusion Top Navigation

Navigation: Above the main content area

Layout: Stretch

Skin: Fusion FX


	
Portal-centric with Top Navigation—A page template for use with portal-centric spaces.

Navigation: Above the main content area

Layout: Flow

Skin: Spaces FX


	
Public Pages Template—The default page template for Spaces public pages


	
Side Navigation

Navigation: Side bar

Layout: Flow

Skin: Spaces FX

This page template is not compatible with spaces created prior to 11.1.1.4.0


	
Side Navigation (Stretch)

Navigation: Side bar

Layout: Stretch

Skin: Spaces FX


	
Top Navigation

Navigation: Above the main content area

Layout: Flow

Skin: Spaces FX

This page template is not compatible with spaces created prior to 11.1.1.4.0


	
Top Navigation (Stretch)

Navigation: Above the main content area

Layout: Stretch

Skin: Spaces FX




You cannot directly edit or customize any of the out-of-the-box page templates listed here. If you want to exclude or display different content within one of these page templates, you must make a copy of the template, and then make changes to your copy rather than the original version.




	
Note:

The out-of-the-box page templates are designed to show two levels of the navigation model. If your navigation model includes more than two levels, only the first two levels will be displayed when using the out-of-the-box templates. To display further levels of the navigation model, you must create your own page template or make a copy of the out-of-the-box page template and edit the copy to match your requirements.














12.2 Creating a Page Template

When you create a page template, you use an existing page template as the starting point for the new page template.

To create a page template:

	
Navigate to the Resources page of your application or the space in which you want to create the page template, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Page Templates.


	
On the menu bar, click Create.


	
In the Create New Page Template dialog, in the Name field, enter a name for the page template.


Figure 12-2 The Create New Page Template Dialog

[image: Description of Figure 12-2 follows]

Description of "Figure 12-2 The Create New Page Template Dialog"





	
In the Description field, enter a description for the page template.

The description is displayed below the name in the Resources page and as a tool tip when selecting a page template. You should ensure that the description helps page designers determine if they want to use this particular page template.


	
From the Copy from dropdown list, select an existing page template to use as the starting point for your new page template.




	
Tip:

You can also create a copy of an existing page template by selecting the existing page template on the Resources page, clicking Edit and then Copy on the menu bar, and providing a name and description for the new page template.








	
Click Create.

The newly created page template is listed on the Resources page. The gray circle icon next to the page template indicates that it is not yet published and hence is not available to other users. For information about publishing a page template, see Section 10.4.3, "Showing and Hiding Resources."









12.3 Editing a Page Template

When you create a new page template, you copy an existing page template. To turn this copy into the page template that you want, you must edit it by using Composer or by editing the source code to change the layout and content of the page template as desired.

This section includes the following subsections:

	
Section 12.3.1, "Editing a Page Template in Composer"


	
Section 12.3.2, "Editing the Source Code of a Page Template"






12.3.1 Editing a Page Template in Composer

The most common way of editing a page template is to use Composer.

To edit a page template in Composer:

	
Navigate to the Resources page of your application or the space that contains the page template that you want to edit, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Page Templates.


	
In the main panel, select the page template that you want to edit.


	
From the Edit menu, choose Edit.

This opens the page template in Composer where you can edit its layout and content.


	
Within Composer, choose whether to work in Design view or Source view:

	
Design view provides a WYSIWYG rendering of the page template, where controls are directly selectable on each component.


	
Source view provides a combined WYSIWYG and hierarchical rendering of page template components, where controls are available on the header of the hierarchical list. You can specify whether to present the page template source on the top, bottom, left, or right of the WYSIWYG portion of the page template.





	
Your page template must include at least one content region. You can create new content regions in the page template by clicking one of the Add Box icons in an existing region. This process is very similar to adding content regions to a page. For more information, see Section 17.3.5.4, "Adding New Content Regions."


	
Aside from the main content area, the other main feature of a page template is the navigation area. The navigation area of a page provides access to the rest of the portal. Spaces provides several task flows for providing navigation within your portal, you can add these task flows anywhere within the page template. For more information, see Section 11.3.1, "Adding Built-in Navigation Task Flows to Page Templates."

If these task flows do not quite meet your requirements for navigation, you must develop your page template further in JDeveloper. You can create the main structure for your page template in Spaces and then download it for importing into JDeveloper, or you can create the page template entirely in JDeveloper and then upload it into Spaces. For more information, see Section 12.8, "Using JDeveloper to Build Your Page Templates."


	
You can add content to a page template by adding components from the Resource Catalog. The catalog is a gateway to a wide range of task flows, portlets, layout components, and other types of resources.

Authorized users can create custom Resource Catalogs and add any variety of the available resources. This means the content of a given Resource Catalog is dependent on the person who designed the catalog. In addition, the Resource Catalog available to application-level page templates may be different from that available for space-level page templates. For more information about Resource Catalogs, including how to create custom Resource Catalogs and how to configure which Resource Catalog to use for page templates, see Chapter 16, "Working with Resource Catalogs."

To add a component from the Resource Catalog, click the Add Content icon in the region to which you want to add the component. Again, the process is very similar to adding components to a page. For more information, see Section 17.5, "Adding Resource Catalog Components to Pages."


	
Spaces provides a range of reusable components that you can add to your page templates. You can customize attributes such as text, label, inlinestyle, and so on, to change the look and feel to suit your page template.




	
Note:

Oracle does not recommend that you modify values for attributes such as id, action, actionListener, destination, because these properties impact the functionality of the component.







Table 12-1 lists all the Spaces components that are available. For more information about each of these components, see Chapter 13, "Adding Spaces Components to Your Templates."


Table 12-1 Reusable Spaces Components

	A to Create Sp	Create Su to I	J to P	R to U
	
About Space

	
Create Subspace

	
Join Space

	
RSS


	
About WebCenter

	
Current User Profile

	
Leave Space

	
Search


	
Add to Favorites

	
Edit Page

	
Login

	
Self Registration


	
Administration

	
Email Members

	
Logout

	
Share Resource


	
Change Membership

	
Email Space Moderators

	
Manage Pages

	
Spaces Switcher


	
Contact Administration

	
Favorites Menu

	
Page Links

	
Status Indicator


	
Copyright Message

	
Global Help

	
Parent Space

	
Subscription Preferences


	
Create Page

	
Home Space

	
Print Preview

	
Tags


	
Create Space

	
Invite People as Connection

	
Privacy URL

	
User Preferences








	
When you have finished editing the page template, click Save and then Close.









12.3.2 Editing the Source Code of a Page Template

If you prefer working in source code, you can use the Edit Source option.

To edit the source code of a page template:

	
Navigate to the Resources page of your application or the space that contains the page template that you want to edit, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Structure, select Page Templates.


	
In the main panel, select the page template that you want to edit.


	
From the Edit menu, choose Edit Source.

The Edit Source dialog (Figure 12-3) displays the source code of the page template.


Figure 12-3 The Edit Source Dialog for a Page Template

[image: Description of Figure 12-3 follows]

Description of "Figure 12-3 The Edit Source Dialog for a Page Template"





	
Edit the code as required.

The XML syntax in the code is validated and an error message is displayed if you miss any tags or add them incorrectly. Validation is not performed for non-XML files.

You might prefer to copy the code from the dialog and paste it into an editor of your choice, for example, JDeveloper, where further validation can be performed. After editing the code, you can then copy it and paste it back into the dialog.




	
Note:

To make more full use of JDeveloper's capabilities for editing page templates, you might prefer to download the page template from Spaces and import it into JDeveloper for editing. For more information, see Section 12.8, "Using JDeveloper to Build Your Page Templates."








	
Click OK.











12.4 Customizing a Page Template for a Space

Page templates created at the application level can also be used in spaces. For example, a portal designer may create several corporate page templates for use in spaces throughout the application. However, you may find that for a particular space, the application-level page template does not quite work and needs a bit of fine tuning.

You could create a copy of the page template within your space and make the changes you require. However, as soon as you create the copy, the new page template is completely separate from the original. Any changes made to the original template are not cascaded down to your copy.

Alternatively, within your space you can customize the application-level page template. The customizations you make apply only to the space in which you perform them. However, the connection to the original page template is retained, so any changes made at the application level are automatically cascaded down to the page template at the space level.

To customize a page template:

	
Navigate to the Resources page of the space that contains the page template that you want to edit, as described in Section 10.1.4.2, "Accessing Space-Level Resources."




	
Note:

You can customize page templates only at the space level. You cannot customize page templates at the application level.








	
In the left navigation panel, under Structure, select Page Templates.


	
In the main panel, select the page template that you want to customize.


	
From the Edit menu, choose Customize.


	
Customize the page template as required.


	
When you have finished customizing the page template, click Save and then Close.









12.5 Managing a Page Template

This section includes the following subsections:

	
Section 12.5.1, "Showing and Hiding a Page Template"


	
Section 12.5.2, "Setting Properties on a Page Template"


	
Section 12.5.3, "Setting Security on a Page Template"


	
Section 12.5.4, "Copying a Page Template"


	
Section 12.5.5, "Deleting a Page Template"


	
Section 12.5.6, "Previewing a Page Template"






12.5.1 Showing and Hiding a Page Template

When you create a page template, by default it is hidden. A hidden page template is not available for use in the application, the Home space, or any other space. To make a page template available, it must be marked as shown. Further, for a page template created at the application level, you can control whether it is available to any, all, or selected spaces in the application.

For generic information about hiding and showing resources, see Section 10.4.3, "Showing and Hiding Resources."

For generic information about resource availability in spaces, see Section 10.4.2, "Setting Properties on a Resource."






12.5.2 Setting Properties on a Page Template

You can control a page template's display attributes and availability by setting the template's properties in the Edit Properties dialog. Setting page template properties follows the same procedure as any other resource. For more information, see Section 10.4.2, "Setting Properties on a Resource."

To view the properties associated with a page template, use the About menu option.






12.5.3 Setting Security on a Page Template

You can control whether all users or only specific users or groups can access the page template that you created in your application or space. Setting access to a page template follows the same procedure as any other resource. For more information, see Section 10.4.4, "Setting Security for a Resource."






12.5.4 Copying a Page Template

You can make a copy of a page template by selecting it and choosing Copy from the Edit menu on the Resources - Page Templates page. Copying a page template follows the same procedure as any other resource. For the generic procedure, see Section 10.4.1, "Copying a Resource."






12.5.5 Deleting a Page Template

Provided you are assigned the required permissions, you can delete any custom page template. Deleting a page template follows the same procedure as deleting any other resource. For more information, see Section 10.4.5, "Deleting a Resource."






12.5.6 Previewing a Page Template

Spaces provides a means of previewing a page template, so that you can see what it looks like while still within the Resources page, enabling you to make adjustments quickly, if required. Previewing a page template follows the same procedure as previewing other resources. For more information, see Section 10.4.6, "Previewing a Resource."








12.6 Applying a Page Template to a Space

When you create a space, the space inherits the page template defined for the space template that you choose for the space.




	
Note:

If the space template does not specify that a particular page template must be used, the space uses the default page template specified by the Spaces administrator. See Section 5.8, "Choosing a Default Page Template."







If you are the space moderator, or have Manage Configuration permission on a space, you can optionally select a different page template for the space. This overrides the space template setting and the application setting. For more information, see Section 51.4.9, "Changing the Page Template for a Space."






12.7 Choosing the Page Template Resource Catalog

The Resource Catalog used by a page template determines which components can be added to the page template.

Spaces provides a Default Page Template Catalog that includes the most commonly required components for page templates. Authorized users can create custom Resource Catalogs for use by page templates. For more information, see Chapter 16, "Working with Resource Catalogs."

By default, a space uses the page template Resource Catalog set by the Spaces administrator for all spaces in the entire application. However, you can override this setting at the space level.

	
For information about setting the page template Resource Catalog at the application level, see Section 5.8, "Choosing a Default Page Template."


	
For information about setting the page template Resource Catalog at the space level, see Section 51.4.11, "Changing the Resource Catalogs for Pages and the Page Template for a Space."









12.8 Using JDeveloper to Build Your Page Templates

In the majority of cases, you are likely to want to create a page template that is beyond the editing capabilities of Spaces. Specifically, to add more complex navigation UI than is available through the built-in navigation task flows, you will need to add the navigation UI programmatically. To do this, you have several options:

	
Use the Edit Source option to edit the source code of the page template. You can edit the source code directly in the Edit Source dialog or you can copy the contents of the dialog to JDeveloper for editing and then copy the edited code back into the dialog. For more information, see Section 12.3.2, "Editing the Source Code of a Page Template."


	
Download an existing Spaces page template, import the page template into JDeveloper for editing, and then upload it back to Spaces.


	
Create a completely new page template in JDeveloper and upload it to Spaces.




The steps to upload and download page templates from Spaces are described in Section 10.5, "Using JDeveloper to Build Resources for the Spaces Application."

Oracle WebCenter Portal provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) for developing Spaces resources, such as page templates. The workspace offers a design environment in which to create and edit your page templates, and also enables you to upload your page templates to Spaces for testing. For more information and to download the JDeveloper workspace, see the section "Developing Resources for the Spaces Application" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

As mentioned earlier, specifically for page template, you might find that the functionality for visualizing portal navigation provided within Spaces is not complex enough for the navigation that you want to expose in your application. Using JDeveloper, you can visualize a much more complex navigation UI in your page template, using ADF navigation components and EL expressions. For more information, see the chapter "Visualizing Your Portal Navigation" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.









13 Adding Spaces Components to Your Templates

Spaces components are prepackaged, fully functional application widgets or tags, such as menus and links, that are available for adding to pages and, most notably, to page templates. Each component provides a ready-to-go piece of the Oracle WebCenter Portal: Spaces user interface (UI).

As an application administrator or space moderator, you can include one or multiple Spaces components in custom Resource Catalogs. In turn, authorized users can add them from the catalog to a page template or a page.




	
See Also:

Many of the components discussed in the chapter are included out-of-the-box in the default Resource Catalogs provided for template development. For information about how to add resources to a custom Catalog, see Section 16.3.1.2, "Adding Resources."







This chapter provides an overview of available components, directs you to information about adding and removing components, and lists and describes component properties. It includes the following sections:

	
Section 13.1, "Making Spaces Components Available"


	
Section 13.2, "Working with Spaces Component Properties"


	
Section 13.3, "Deleting Spaces Components"





Audience

This chapter is intended for administrator-level users who are granted the permissions Resource Catalogs: Create, Edit, and Delete Resource Catalogs and, minimally, Page Templates: Create Page Templates, Edit Page Templates.




	
See Also:

For information about creating custom page templates through Oracle JDeveloper, see "Working with Page Templates," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.









13.1 Making Spaces Components Available

You may need to take some preliminary steps to ensure that Spaces components are available for placement on your pages and page templates. This section provides an overview of the preliminary steps that may be required before you can start working with these components.

This section includes the following subsections:

	
Section 13.1.1, "Adding Spaces Components to a Resource Catalog"


	
Section 13.1.2, "Specifying the Resource Catalogs to Use for Space and Page Templates"


	
Section 13.1.3, "Adding Spaces Components to a Template"


	
Section 13.1.4, "Adding Spaces Components to a Page"






13.1.1 Adding Spaces Components to a Resource Catalog

Spaces components are like any other resource you would add to a Resource Catalog. (For information about adding resources to the Resource Catalog, see Section 16.3.1.2, "Adding Resources.") In the library of components that provides resources for building a custom Resource Catalog, many of these components are grouped under the Spaces Components category (Figure 13-1).


Figure 13-1 Spaces Components in the Add Resource Catalog Item Dialog

[image: Spaces components in the Add Resource Catalog Item dialog]

Description of "Figure 13-1 Spaces Components in the Add Resource Catalog Item Dialog"





The balance of these components are available by default out-of-the-box in the Default Page Template Catalog that is provided for page template development. In this default catalog, you can find Spaces components under the folder Template Development—though keep in mind that Resource Catalog folder names can be customized, and so may be renamed (Figure 13-2).


Figure 13-2 Template Development Folder in Resource Catalog

[image: Template Development folder in Resource Catalog]

Description of "Figure 13-2 Template Development Folder in Resource Catalog"









13.1.2 Specifying the Resource Catalogs to Use for Space and Page Templates


Application Administrators

As the application administrator, you can specify the default Resource Catalog to open under any circumstance: for a page, a space, a page template, a space template, and so on. The General subpage of the Configuration page under the Administration page provides a Resources section for setting these defaults (Figure 13-3).


Figure 13-3 Resources Section on the Application Administration General Page

[image: Resources section on the General page (application)]

Description of "Figure 13-3 Resources Section on the Application Administration General Page"





Administrative settings apply to the entire application, so, barring lower-level overrides, the default catalog you select is the one all authorized users see when they add content. For more information, see Section 16.10.1, "Configuring the Application-Level Resource Catalog."


Space Moderators

As the space moderator, you can specify the default Resource Catalogs to open when users click Add Content for a space page or page template. The General page under the Settings page provides a Display Settings section for setting these defaults (Figure 13-4).


Figure 13-4 Display Settings Section on the Space Settings General Page

[image: Display Settings section on General page (Space)]

Description of "Figure 13-4 Display Settings Section on the Space Settings General Page"





Your selection applies only to the space on which it is set. The space-level setting overrides the same setting specified by the application administrator at the application level. For more information, see Section 16.10.2, "Configuring the Space-Level Resource Catalog."






13.1.3 Adding Spaces Components to a Template

As with any other component available in a Resource Catalog, you can add Spaces components from the catalog to a page template. For information about adding resources to a page template, see Section 12.2, "Creating a Page Template."






13.1.4 Adding Spaces Components to a Page

Provided Spaces components are available in the Resource Catalog, you can add them to a page in a space or the Home space just as you would any other component. For more information, see Section 17.5, "Adding Resource Catalog Components to Pages."








13.2 Working with Spaces Component Properties

Spaces components have associated properties that you can use to refine the appearance and behavior of a component instance.

This section provides information about the properties associated with each component. It includes the following subsections:

	
Section 13.2.1, "Accessing Spaces Component Properties"


	
Table 13-1 links to the remaining subsections in this section. It lists all available Spaces components and links to more information about each one. Additionally, it provides the XML code for placing the component in a Resource Catalog in a an application built using WebCenter Portal: Framework and the tag to use to place the component on a .jspx page.





Table 13-1 Spaces Components

	A to Create Sp	Create Su to I	J to P	R to U
	
About Space


	
Create Subspace


	
Login


	
RSS



	
About WebCenter


	
Current User Profile


	
Logout


	
Search



	
Add to Favorites


	
Edit Page


	
Mail Space Members


	
Self Registration



	
Administration


	
Favorites Menu


	
Mail Space Moderators


	
Share Resource



	
Change Membership


	
Global Help


	
Manage Pages


	
Spaces Switcher



	
Contact Administration


	
Home Space


	
Page Links


	
Status Indicator



	
Copyright Message


	
Invite People as Connection


	
Parent Space


	
Subscription Preferences



	
Create Page


	
Join Space


	
Print Preview


	
Tags



	
Create Space


	
Leave Space


	
Privacy URL


	
User Preferences












	
See Also:

For information about accessing component properties, see Section 17.5.2, "Setting Properties on Page Components."









13.2.1 Accessing Spaces Component Properties

You can access Spaces component properties in page edit mode Source view.




	
Note:

When you enter most types of property values in the Component Properties dialog and then click Apply, the dialog remains open. With values other than expected value types, the dialog closes, and the page is refreshed to reflect the new value. For example, if a component takes a java.util.ArrayList of java.awt.Color classes, then the Component Properties dialog closes and Composer does a full-page-refresh.







To access Spaces component properties:

	
Edit a template.




	
See Also:

For more information, see Section 10.3.3, "Editing a Resource by Using the Edit Dialog."








	
In edit mode, select Source from the View menu (Figure 13-5).


Figure 13-5 Source Option on View Menu

[image: Source option on View menu]

Description of "Figure 13-5 Source Option on View Menu"





	
Select the component on the page, and click Edit to open the Component Properties dialog (Figure 13-6).


Figure 13-6 Show the Properties of userProfile Icon

[image: Show the properties of userProfile icon]

Description of "Figure 13-6 Show the Properties of userProfile Icon"





	
Revise property values as required.




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1. For more information about ELs in Spaces, see Appendix B, "Expression Language Expressions."
EL validation is not performed on non-generic display options.










	
Click Save and then Close to exit edit mode.




	
Tip:

You can try out a change by clicking Apply first and observing the result on the page.















13.2.2 About Space

The About Space component is a link that opens a dialog with information about the current space (Figure 13-7).


Figure 13-7 About Space Component

[image: About Space component]

Description of "Figure 13-7 About Space Component"





Every space has associated information, called metadata. space metadata includes such information as display name, internal identification (GUID), description, current user membership role, user name of the creator, date created, and direct URL. Users click the About Space link to access this information.




	
See Also:

For information about the About Space dialog, see Section 29.9.1, "Accessing Space Information."







This section lists and describes the Display Options associated with the About Space component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.2.1, "About Space Component Display Options"


	
Section 13.2.2.2, "About Space Component Tag and XML"






13.2.2.1 About Space Component Display Options

Table 13-2 lists and describes the Display Options properties associated with the About Space component.




	
See Also:

The About Space component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-2 About Space Component Display Options

	Property	Description
	
Depressed Icon

	
A URL or relative path to an icon that appears when the component is clicked

Use any Web-compatible image from any accessible location. That is, do not put in a path to an image on an external server that requires authentication.

Enter a full URL or a path that is relative to the application root.


	
Disabled Icon

	
A URL or relative path to an image that appears when the component is disabled

See Depressed Icon for more information.


	
Display Type

	
The render mode of the component:

	
link—Show the component as a link


	
button—Show the component as a command button





	
Hover Icon

	
A URL or relative path to an icon that appears when users hover their mouse pointers over the component

See Depressed Icon for more information.


	
Icon

	
A URL or relative path to an icon to represent the active component

See Depressed Icon for more information.


	
Icon Position

	
A selection of options for placement of the link's associated icon:

	
leading—The icon is positioned at the start of its associated text


	
trailing—The icon is positioned at the end of its associated text





	
Scope Name

	
The name of the space to describe in the dialog

The default value is null (defaultScope), which provides information about the current space. You can also enter a space name in lieu of the default.

Note: If you enter a space name, be sure to enter the space's internal name. The space internal name is the name specified by the Space URL on the General Settings page of a space's administration settings.


	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component


	
Text

	
Display text for the component

The default is About Space. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.TITLE_SHOW_GROUP_SPACE_INFO}.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again through Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.












13.2.2.2 About Space Component Tag and XML

The following tag is used to render the About Space component on a .jspx page:


<wcdc:aboutSpaceLink id="#"
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   text="#{uib_o_w_w_r_WebCenter.TITLE_SHOW_GROUP_SPACE_INFO}"/>


Example 13-1 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-1 XML Code for the About Space Component


<tag>
   <name>aboutSpaceLink</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      AboutSpaceLinkTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.3 About WebCenter

The About WebCenter component is a link that opens a dialog with application version and copyright information (Figure 13-8).


Figure 13-8 About WebCenter Component

[image: About WebCenter component]

Description of "Figure 13-8 About WebCenter Component"





This section lists and describes the Display Options associated with the About WebCenter component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.3.1, "About WebCenter Component Display Options"


	
Section 13.2.3.2, "About WebCenter Component Tag and XML"






13.2.3.1 About WebCenter Component Display Options

The About WebCenter component shares many of the same Display Options properties with the About Space component. Table 13-3 lists and describes the Display Options properties associated with the About WebCenter component that are not included in Table 13-2, "About Space Component Display Options" or that have different default values.




	
See Also:

The About WebCenter component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-3 About WebCenter Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Display WebCenter Spaces Information. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ABOUT_DESC}.


	
Text

	
Display text for the component

The default is About Spaces. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ABOUT}.


	
Type

	
The component type

The default is aboutWebcenter.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.3.2 About WebCenter Component Tag and XML

The following tag is used to render the About WebCenter component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="aboutWebcenter" displayType="link" 
   text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ABOUT}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ABOUT_DESC}" 
   inlineStyle="white-space:nowrap;"/>


Example 13-2 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-2 XML Code for the About WebCenter Component


<tag>
   <name>spacesAction</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.SpacesActionTag
      </tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>type</name>
      <required>true</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.4 Add to Favorites

The Add to Favorites component is a link users can click to add an application object to their Spaces Favorites (Figure 13-9).


Figure 13-9 Add to Favorites Component

[image: Add to Favorites component]

Description of "Figure 13-9 Add to Favorites Component"





For example, users can use this component to add a page, wiki, blog, list, event, task, template, and so on.

This section lists and describes the Display Options associated with the Add to Favorites component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.4.1, "Add to Favorites Component Display Options"


	
Section 13.2.4.2, "Add to Favorites Component Tag and XML"






13.2.4.1 Add to Favorites Component Display Options

The Add to Favorites component shares many of the same Display Options properties with the About Space component. Table 13-4 lists and describes the properties for which Add to Favorites has different default values than those described in Table 13-2, "About Space Component Display Options".




	
See Also:

The Add to Favorites component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-4 Add to Favorites Component Display Options

	Property	Description
	
Favorite Title

	
The display name of the application object to add as a favorite


	
Favorite URL

	
The URL to use to navigate to the application object


	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Add To Favorites. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.TITLE_ADD_FAVORITE_DIALOG}.


	
Text

	
Display text for the component.

The default is Add to Favorites. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.TITLE_ADD_FAVORITE_DIALOG}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.4.2 Add to Favorites Component Tag and XML

The following tag is used to render the Add to Favorites component on a .jspx page:


<wcdc:addToFavorites id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib"
   inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.TITLE_ADD_FAVORITE_DIALOG}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.TITLE_ADD_FAVORITE_DIALOG}"/>


Example 13-3 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-3 XML Code for the Add to Favorites Component


<tag>   <name>addToFavorites</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      AddToFavoritesTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>favoriteTitle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>favoriteURL</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.5 Administration

The Administration component is a navigation link that opens the Administration page (Figure 13-10).


Figure 13-10 Administration Component

[image: Administration component]

Description of "Figure 13-10 Administration Component"





Only application administrators can see this link once it is placed on a page or page template.




	
See Also:

For information about Spaces administration, see Part I through Part VIII in this guide, and see the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







This section lists and describes the Display Options associated with the Administration component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.5.1, "Administration Component Display Options"


	
Section 13.2.5.2, "Administration Component Tag and XML"






13.2.5.1 Administration Component Display Options

The Administration component shares many of the same Display Options properties associated with the About Space component. Table 13-5 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Administration component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-5 Administration Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Open WebCenter administration pages. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ADMINISTRATION_DESC}.


	
Text

	
Display text for the component

The default is Administration. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ADMINISTRATION}.


	
Type

	
The component type

The default is administration.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.5.2 Administration Component Tag and XML

The following tag is used to render the Administration component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="administration" displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ADMINISTRATION}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ADMINISTRATION_DESC}"/>


In the Resource Catalog, the Administration component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.6 Change Membership

The Change Membership component is a link users can click to request a change to their space role (Figure 13-11).


Figure 13-11 Change Membership Component

[image: Change Membership component]

Description of "Figure 13-11 Change Membership Component"








	
See Also:

For information about changing a space membership, see Section 49.22, "Changing Your Role in a Space."







This section lists and describes the Display Options associated with the Change Membership component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.6.1, "Change Membership Component Display Options"


	
Section 13.2.6.2, "Change Membership Component Tag and XML"






13.2.6.1 Change Membership Component Display Options

The Change Membership component shares many of the same properties with the About Space component. Table 13-6 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Change Membership component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-6 Change Membership Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default value is Change Membership. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.COMMUNITY_CHANGE_MEMBERSHIP}.


	
Text

	
Display text for the component

The default is Change Membership. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.COMMUNITY_CHANGE_MEMBERSHIP}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.6.2 Change Membership Component Tag and XML

The following tag is used to render the Change Membership component on a .jspx page:


<wcdc:changeSpaceMembership id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   text="#{uib_o_w_s_r_Spaces.COMMUNITY_CHANGE_MEMBERSHIP}" 
   shortDesc="#{uib_o_w_s_r_Spaces.COMMUNITY_CHANGE_MEMBERSHIP}" 
   inlineStyle="white-space:nowrap;"/>


Example 13-4 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-4 XML Code for the Change Membership Component


<tag>
   <name>changeSpaceMembership</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      ChangeSpaceMembershipTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.7 Contact Administration

The Contact Administration component is a link that opens a simple popup window in which users can enter and send a workflow notification to members of the Administrators role (Figure 13-12).




	
Note:

The Contact Administration component requires a connection to the Oracle BPEL Server included with Oracle SOA Suite. For more information, see the "Specifying the BPEL Server Hosting Spaces Workflows" section in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.








Figure 13-12 Contact Administration Component

[image: Description of Figure 13-12 follows]

Description of "Figure 13-12 Contact Administration Component"





This section lists and describes the Display Options associated with the Contact Administration component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.7.1, "Contact Administration Component Display Options"


	
Section 13.2.7.2, "Contact Administration Component Tag and XML"






13.2.7.1 Contact Administration Component Display Options

The Contact Administrator component shares many of the same properties with the About Space component. Table 13-7 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Contact Administration component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-7 Contact Administrator Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default value is Contact the Administrator. The default value is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.CONTACT_ADMINISTRATOR_DESC}.


	
Text

	
Display text for the component

The default is Administrator. The default value is represented by the EL expression #{uib_o_w_w_r_WebCenter.CONTACT_ADMINISTRATOR}.


	
Type

	
The component type

The default is contactAdmin.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.7.2 Contact Administration Component Tag and XML

The following tag is used to render the Contact Administration component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="contactAdmin" displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.CONTACT_ADMINISTRATOR}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.CONTACT_ADMINISTRATOR_DESC}"/>


In the Resource Catalog, the Contact Administration component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.8 Copyright Message

The Copyright Message component renders the following text string:


Copyright © 2010, Oracle and/or its affiliates. All rights reserved.


Figure 13-13 shows an example of the Copyright Message component rendered within the user interface.


Figure 13-13 Copyright Message Component

[image: Copyright Message component]

Description of "Figure 13-13 Copyright Message Component"





This section lists and describes the Display Options associated with the Copyright component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.8.1, "Copyright Message Component Display Options"


	
Section 13.2.8.2, "Copyright Message Component Tag and XML"






13.2.8.1 Copyright Message Component Display Options

The Copyright Message component shares many of the same properties with the About Space component. Table 13-8 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Copyright Message component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-8 Copyright Message Component Display Options

	Property	Description
	
Inline Style

	
A field for entering CSS style values to define the appearance of the component

The default inline style is white-space:nowrap;.


	
Type

	
The component type

The default is copyrightMessage.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.8.2 Copyright Message Component Tag and XML

The following tag is used to render the Copyright Message component on a .jspx page:


wcdc:outputText id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="copyrightMessage" inlineStyle="white-space:nowrap;"/>


Example 13-5 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-5 XML Code for the Copyright Message Component


<tag>
   <name>outputText</name>
   <tag-class>oracle.webcenter.webcenterapp.spacescomponents.internal.view.
      taglib.OutputTextTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
      <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>type</name>
      <required>true</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.9 Create Page

The Create Page component is an icon and a link that users click to open the Create Page dialog (Figure 13-14).


Figure 13-14 Create Page Component

[image: Create Page component]

Description of "Figure 13-14 Create Page Component"








	
See Also:

For information about creating pages, see Chapter 17, "Building Pages," and Chapter 38, "Creating and Managing Personal Pages."







This component is useful for providing an on-the-spot means of creating pages in the current space or Home space. Only authorized users can see and use the Create Page link.

This section lists and describes the Display Options associated with the Create Page component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.9.1, "Create Page Component Display Options"


	
Section 13.2.9.2, "Create Page Component Tag and XML"






13.2.9.1 Create Page Component Display Options

The Create Page component shares many of the same properties with the About Space component. Table 13-9 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Create Page component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-9 Create Page Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Create a new page. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.TOOLTIP_MANAGE_PAGES_CREATE_PAGE}.


	
Task Flow Id

	
The component's unique identifier, for example wcdc4082953494


	
Text

	
Display text for the component

The default is Create Page. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_CREATE_PAGE}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.9.2 Create Page Component Tag and XML

The following tag is used to render the Create Page component on a .jspx page:


<wcdc:createPage id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.LABEL_CREATE_PAGE}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.TOOLTIP_MANAGE_PAGES_CREATE_PAGE}" />


Example 13-6 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-6 XML Code for the Create Page Component


<tag>
   <name>createPage</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      CreatePageTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.10 Create Space

The Create Space component is a link users click to open the Create a Space wizard (Figure 13-15).


Figure 13-15 Create Space Component

[image: Create Space component]

Description of "Figure 13-15 Create Space Component"





This component is useful for providing an on-the-spot means of creating a space. Only authorized users can see and use the Create Space link.




	
See Also:

For information about creating spaces, see Part XI, "Planning and Building a Space".







This section lists and describes the Display Options associated with the Create Space component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.10.1, "Create Space Component Display Options"


	
Section 13.2.10.2, "Create Space Component Tag and XML"






13.2.10.1 Create Space Component Display Options

The Create Space component shares many of the same properties with the About Space component. Table 13-10 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Create Space component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-10 Create Space Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Create a Space. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.HEADING_CREATE_COMMUNITY}.


	
Text

	
Display text for the component

The default is Create a Space. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.HEADING_CREATE_COMMUNITY}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.10.2 Create Space Component Tag and XML

The following tag is used to render the Create Space component on a .jspx page:


<wcdc:createSpace id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_s_r_Spaces.HEADING_CREATE_COMMUNITY}" 
   shortDesc="#{uib_o_w_s_r_Spaces.HEADING_CREATE_COMMUNITY}"/>


Example 13-7 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-7 XML Code for the Create Space Component


<tag>
   <name>createSpace</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      CreateSpaceTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.11 Create Subspace

The Create Subspace component is a link that opens a dialog for creating a subspace (Figure 13-16).


Figure 13-16 Create Subspace Component

[image: Create Subspace component]

Description of "Figure 13-16 Create Subspace Component"





A subspace is a space that is hierarchically lower than its parent space. The Create Subspace component is useful for providing an on-the-spot means of creating subspaces in the current space. Only authorized users can see and use the Create Subspace link.




	
See Also:

For information about creating a subspace, see Section 54.3, "Creating a Subspace."







This section lists and describes the Display Options associated with the Create Subspace component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.11.1, "Create Subspace Component Display Options"


	
Section 13.2.11.2, "Create Subspace Component Tag and XML"






13.2.11.1 Create Subspace Component Display Options

The Create Subspace component shares many of the same properties with the About Space component. Table 13-11 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Create Subspace component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-11 Create Subspace Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Create a Subspace. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.HEADING_CREATE_SUB_COMMUNITY}.


	
Text

	
Display text for the component

The default is Create a Subspace. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.HEADING_CREATE_SUB_COMMUNITY}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.11.2 Create Subspace Component Tag and XML

The following tag is used to render the Create Subspace component on a .jspx page:


<wcdc:createSubSpace id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_s_r_Spaces.HEADING_CREATE_SUB_COMMUNITY}" 
   shortDesc="#{uib_o_w_s_r_Spaces.HEADING_CREATE_SUB_COMMUNITY}"/>


Example 13-8 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-8 XML Code for the Create Subspace Component


<tag>
   <name>createSubSpace</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      CreateSubspaceTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.12 Current User Profile

The Current User Profile component is the name of the current user linked to the user's Profile page (Figure 13-17).


Figure 13-17 Current User Profile Component

[image: Current User Profile component]

Description of "Figure 13-17 Current User Profile Component"





Users click the name to open a Profile page with the user's profile details.




	
See Also:

The Profile page is a customizable business role page that appears in all authenticated users' Home spaces. For more information about business role pages, see Section 7.1, "Working with Business Role Pages." For more information about Profiles, see Chapter 30, "Managing Your Profile."







This section lists and describes the Display Options associated with the Current User Profile component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.12.1, "Current User Profile Component Display Options"


	
Section 13.2.12.2, "Current User Profile Component Tag and XML"






13.2.12.1 Current User Profile Component Display Options

The Current User Profile component shares many of the same properties with the About Space component. Table 13-12 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Current User Profile component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-12 Current User Profile Component Display Options

	Property	Description
	
Short Desc

	
A field for entering a tooltip to display when users hover their mouse pointers over the component

The default is the current user's name. The default is the rendered value of the EL expression #{security.userDisplayName}.


	
Text

	
Display text for the component

The default is the current user's name. The default is the rendered value of the EL expression #{security.userDisplayName}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.12.2 Current User Profile Component Tag and XML

The following tag is used to render the Current User Profile component on a .jspx page:


<wcdc:userProfile id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap" 
   text="#{security.userDisplayName}" shortDesc="#{security.userDisplayName}" />


Example 13-9 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-9 XML Code for the Current User Profile Component


<tag>
   <name>userProfile</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      UserProfileTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.13 Edit Page

The Edit Page component is a link that users click to take the current page into page edit mode (Figure 13-18).


Figure 13-18 Edit Page Component

[image: Edit Page component]

Description of "Figure 13-18 Edit Page Component"





Only users who are authorized to edit the current page can see and use the Edit Page link.




	
See Also:

For information about editing pages, see Section 17.3, "Editing Pages," and Section 38.3, "Editing a Personal Page."







This section lists and describes the Display Options associated with the Edit Page component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.13.1, "Edit Page Component Display Options"


	
Section 13.2.13.2, "Edit Page Component Tag and XML"






13.2.13.1 Edit Page Component Display Options

The Edit Page component shares many of the same properties with the About Space component. Table 13-13 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Edit Page component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-13 Edit Page Component Display Options

	Property	Description
	
Short Desc

	
A field for entering a tooltip to display when users hover their mouse pointers over the component

The default is Edit the Page. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.PAGE_CONTEXT_EDIT_PAGE_DESC}.


	
Task Flow Id

	
The component's unique identifier, for example wcdc4082953494


	
Text

	
Display text for the component

The default is Edit Page. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.PAGE_CONTEXT_EDIT_PAGE}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.13.2 Edit Page Component Tag and XML

The following tag is used to render the Edit Page component on a .jspx page:


<wcdc:editPage id="#" xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.PAGE_CONTEXT_EDIT_PAGE}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.PAGE_CONTEXT_EDIT_PAGE_DESC}" />


Example 13-10 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-10 XML Code for the Edit Page Component


<tag>
   <name>editPage</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      EditPageTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.14 Favorites Menu

The Favorites Menu component is a menu with options for opening the Add to Favorites and Manage Favorites dialogs (Figure 13-19).


Figure 13-19 Favorites Menu Component

[image: Favorites Menu component]

Description of "Figure 13-19 Favorites Menu Component"








	
See Also:

For information about Favorites in Spaces, see Chapter 37, "Creating and Managing Your Personal Favorites."







This section lists and describes the Display Options associated with the Favorites Menu component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.14.1, "Favorites Menu Component Display Options"


	
Section 13.2.14.2, "Favorites Menu Component Tag and XML"






13.2.14.1 Favorites Menu Component Display Options

The Favorites Menu component shares many of the same properties with the About Space component. Table 13-14 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Favorites Menu component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-14 Favorites Menu Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Manage your favorites. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_FAVORITES_DESC}.


	
Task Flow Id

	
The component's unique identifier, for example wcdc4082953494


	
Text

	
Display text for the component

The default is Manage your favorites. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_FAVORITES_DESC}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.14.2 Favorites Menu Component Tag and XML

The following tag is used to render the Favorites Menu component on a .jspx page:


<wcdc:favoritesMenu id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   styleClass="WCLinkMenu" text="#{uib_o_w_w_r_WebCenter.LABEL_FAVORITES_DESC}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.LABEL_FAVORITES_DESC}" />


Example 13-11 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-11 XML Code for the Favorites Menu Component


<tag>
   <name>favoritesMenu</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      FavoritesMenuTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.15 Global Help

The Global Help component is a link that users click to access Spaces online Help topics (Figure 13-20).


Figure 13-20 Global Help Component

[image: Global Help component]

Description of "Figure 13-20 Global Help Component"








	
See Also:

For more information, see Section 29.11, "Accessing WebCenter Portal: Spaces Online Help."







This section lists and describes the Display Options associated with the Global Help component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.15.1, "Global Help Component Display Options"


	
Section 13.2.15.2, "Global Help Component Tag and XML"






13.2.15.1 Global Help Component Display Options

The Global Help component shares many of the same properties with the About Space component. Table 13-15 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Global Help component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-15 Global Help Component Display Options

	Property	Description
	
Short Desc

	
A field for entering a tooltip to display when users hover their mouse pointers over the component

The default is Help for WebCenter Spaces. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_HELP_DESC}.


	
Text

	
The component label

The default is Help. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_HELP}.


	
Type

	
The component type

The default is globalHelp.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.15.2 Global Help Component Tag and XML

The following tag is used to render the Global Help component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="globalHelp" displayType="link" 
   text="#{uib_o_w_w_r_WebCenter.LABEL_HELP}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.LABEL_HELP_DESC}" 
   inlineStyle="white-space:nowrap"/>


In the Resource Catalog, the Global Help component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.16 Home Space

The Home Space component is a link that users click to navigate to their view of the Home space (Figure 13-21).


Figure 13-21 Home Space Component
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Description of "Figure 13-21 Home Space Component"








	
See Also:

For information about Home spaces, see Chapter 29, "Exploring the Home Space."







This section lists and describes the Display Options associated with the Home Space component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.16.1, "Home Space Component Display Options"


	
Section 13.2.16.2, "Home Space Component Tag and XML"






13.2.16.1 Home Space Component Display Options

The Home Space component shares many of the same properties with the About Space component. Table 13-16 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Home Space component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-16 Home Space Component Display Options

	Property	Description
	
Text

	
Display text for the component

The default is Personal Space.


	
Type

	
The component type

The default is personalSpace.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.16.2 Home Space Component Tag and XML

The following tag is used to render the Home Space component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="personalSpace" displayType="link" text="Personal Space" 
   inlineStyle="white-space:nowrap;"/>


In the Resource Catalog, the Home Space component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.17 Invite People as Connection

The Invite People as Connection component is a link that opens a page where users can invite other users to connect (Figure 13-22).


Figure 13-22 Invite People as Connection Component

[image: Invite People as Connection component]

Description of "Figure 13-22 Invite People as Connection Component"








	
See Also:

For information about Connections, see Chapter 31, "Creating Your Social Network."







This section lists and describes the Display Options associated with the Invite People as Connection component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.17.1, "Invite People as Connection Component Display Options"


	
Section 13.2.17.2, "Invite People as Connection Component Tag and XML"






13.2.17.1 Invite People as Connection Component Display Options

The Invite People as Connection component shares many of the same properties with the About Space component. Table 13-17 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Invite People as Connection component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-17 Invite People as Connection Display Options

	Property	Description
	
Short Desc

	
A field for entering a tooltip to display when users hover their mouse pointers over the component

The default is Invite People. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.LABEL_INVITE_PEOPLE}.


	
Text

	
The component label

The default is Invite People. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.LABEL_INVITE_PEOPLE}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.17.2 Invite People as Connection Component Tag and XML

The following tag is used to render the Invite People as Connection component on a .jspx page:


<wcdc:invitePeopleAsConnection id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_s_r_Spaces.LABEL_INVITE_PEOPLE}" 
   shortDesc="#{uib_o_w_s_r_Spaces.LABEL_INVITE_PEOPLE}"/>


Example 13-12 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-12 XML Code for the Invite People as Connection Component


<tag>
   <name>invitePeopleAsConnection</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      InvitePeopleAsConnectionTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.18 Join Space

The Join Space component is a link that initiates the process of becoming a member of a space, usually the current space (Figure 13-23).


Figure 13-23 Join Space Component

[image: Join Space component]

Description of "Figure 13-23 Join Space Component"








	
See Also:

For information about joining a space, see Section 49.7, "Joining a Space."







This section lists and describes the Display Options associated with the Join Space component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.18.1, "Join Space Component Display Options"


	
Section 13.2.18.2, "Join Space Component Tag and XML"






13.2.18.1 Join Space Component Display Options

The Join Space component shares many of the same properties with the About Space component. Table 13-18 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Join Space component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-18 Join Space Component Display Options

	Property	Description
	
Short Desc

	
A field for entering a tooltip to display when users hover their mouse pointers over the component

The default is Join Space. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.GROUP_SPACES_MANAGE_JOIN_SPACE}.


	
Text

	
The component label

The default is Join Space. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.GROUP_SPACES_MANAGE_JOIN_SPACE}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.18.2 Join Space Component Tag and XML

The following tag is used to render the Join Space component on a .jspx page:


<wcdc:joinSpace id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_s_r_Spaces.GROUP_SPACES_MANAGE_JOIN_SPACE}" 
   shortDesc="#{uib_o_w_s_r_Spaces.GROUP_SPACES_MANAGE_JOIN_SPACE}" />


Example 13-13 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-13 XML Code for the Join Space Component


  <tag>
   <name>joinSpace</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      JoinSpaceTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
        <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
        <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.19 Leave Space

The Leave Space component is a link for requesting a removal of a user's own membership in the current space (Figure 13-24).


Figure 13-24 Leave Space Component

[image: Leave Space component]

Description of "Figure 13-24 Leave Space Component"








	
See Also:

For information about requesting an end of membership, see Section 49.23, "Cancelling Space Membership."







This section lists and describes the Display Options associated with the Leave Space component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.19.1, "Leave Space Component Display Options"


	
Section 13.2.19.2, "Leave Space Component Tag and XML"






13.2.19.1 Leave Space Component Display Options

The Leave Space component shares many of the same properties with the About Space component. Table 13-19 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Leave Space component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-19 Leave Space Component Display Options

	Property	Description
	
Short Desc

	
A field for entering a tooltip to display when users hover their mouse pointers over the component

The default is Leave Space. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.LABEL_LEAVE_SPACE}.


	
Text

	
The component label

The default is Leave Space. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.LABEL_LEAVE_SPACE}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.19.2 Leave Space Component Tag and XML

The following tag is used to render the Leave Space component on a .jspx page:


<wcdc:leaveSpace id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   text="#{uib_o_w_s_r_Spaces.LABEL_LEAVE_SPACE}" 
   shortDesc="#{uib_o_w_s_r_Spaces.LABEL_LEAVE_SPACE}" 
   inlineStyle="white-space:nowrap;"/>


Example 13-14 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-14 XML Code for the Leave Space Component


<tag>
   <name>leaveSpace</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      LeaveSpaceTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.20 Login

The Login component is a link for navigating to the application Login page (Figure 13-25).


Figure 13-25 Login Component

[image: Login component]

Description of "Figure 13-25 Login Component"





The Login link appears only to users who are not logged in. That is, if a user is logged in this link is hidden.

This section lists and describes the Display Options associated with the Login component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.20.1, "Login Component Display Options"


	
Section 13.2.20.2, "Login Component Tag and XML"






13.2.20.1 Login Component Display Options

The Login component shares many of the same properties with the About Space component. Table 13-20 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Login component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-20 Login Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Login. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGIN}.


	
Text

	
Display text for the component

The default is Login. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGIN}.


	
Type

	
The component type

The default is login.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.20.2 Login Component Tag and XML

The following tag is used to render the Login component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="login" displayType="link" inlineStyle="white-space:nowrap" 
   text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGIN}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGIN}"/>


In the Resource Catalog, the Login component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.21 Logout

The Logout component is a link for logging out of the application (Figure 13-26).


Figure 13-26 Logout Component
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Description of "Figure 13-26 Logout Component"





The Logout link appears only to logged in users. That is, if a user is logged out, this link is hidden.

This section lists and describes the Display Options associated with the Logout component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.21.1, "Logout Component Display Options"


	
Section 13.2.21.2, "Logout Component Tag and XML"






13.2.21.1 Logout Component Display Options

The Logout component shares many of the same properties with the About Space component. Table 13-21 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Logout component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-21 Logout Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Logout of WebCenter Portal. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGOUT_DESC}.


	
Text

	
Display text for the component

The default is Logout. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGOUT}.


	
Type

	
The component type

The default is logout.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.21.2 Logout Component Tag and XML

The following tag is used to render the Logout component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib"    type="logout" displayType="link" inlineStyle="white-space:nowrap"    text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGOUT}"    shortDesc="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_LOGOUT_DESC}"/>


In the Resource Catalog, the Logout component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.22 Mail Space Members

The Mail Space Members component is a link that opens a simple send-mail window (Figure 13-27).


Figure 13-27 Mail Space Members Component
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Description of "Figure 13-27 Mail Space Members Component"





Such messages are sent to the in-boxes of all members of the current space.

This section lists and describes the Display Options associated with the Mail Space Members component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.22.1, "Mail Space Members Component Display Options"


	
Section 13.2.22.2, "Mail Space Members Component Tag and XML"






13.2.22.1 Mail Space Members Component Display Options

The Email Members component shares many of the same properties with the About Space component. Table 13-22 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".


Table 13-22 Mail Space Members Component Display Options

	Property	Description
	
Text

	
The default is Send Mail to Members. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_SEND_EMAIL_TO_MEMBERS}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.22.2 Mail Space Members Component Tag and XML

The following tag is used to render the Mail Space Members component on a .jspx page:


<wcdc:emailMembersLink id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib"    text="#{uib_o_w_w_r_WebCenter.LABEL_SEND_EMAIL_TO_MEMBERS}"/>


Example 13-15 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-15 XML Code for the Mail Space Members Component


<tag>
   <name>emailMembersLink</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      EmailMembersLinkTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.23 Mail Space Moderators

The Mail Space Moderators component is a link that opens a simple send-mail window (Figure 13-28).


Figure 13-28 Mail Space Moderators Component

[image: Mail Space Moderators component]

Description of "Figure 13-28 Mail Space Moderators Component"





Such messages are sent to the in-boxes of all users assigned the role Moderator for the current space.

This section lists and describes the Display Options associated with the Mail Space Moderators component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.23.1, "Mail Space Moderators Component Display Options"


	
Section 13.2.23.2, "Mail Space Moderators Component Tag and XML"






13.2.23.1 Mail Space Moderators Component Display Options

The Mail Space Moderators component shares many of the same properties with the About Space component. Table 13-23 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Mail Space Moderators component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-23 Mail Space Moderators Component Display Options

	Property	Description
	
Text

	
The default is Send Mail to Moderators. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_SEND_EMAIL_TO_MODERATORS}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.23.2 Mail Space Moderators Component Tag and XML

The following tag is used to render the Mail Space Moderators component on a .jspx page:


<wcdc:emailModeratorsLink id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   text="#{uib_o_w_w_r_WebCenter.LABEL_SEND_EMAIL_TO_MODERATORS}"/>


Example 13-16 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-16 XML Code for the Mail Space Moderators Component


<tag>   <name>emailModeratorsLink</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      EmailModeratorsLinkTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.24 Manage Pages

The Manage Pages component is a link that opens the Manage Pages dialog (Figure 13-29).


Figure 13-29 Manage Pages Component
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Description of "Figure 13-29 Manage Pages Component"





The Manage Pages dialog lists all of the pages to which the current user has access. Manage Pages provides controls for creating more pages, setting page creation defaults (Home space only), and performing actions on pages, such as editing, renaming, setting access, and the like. Additionally, users can click a listed page name to navigate to that page.




	
See Also:

For information about the types of actions users can perform through Manage Pages, see Chapter 17, "Building Pages," and Chapter 38, "Creating and Managing Personal Pages."







This section lists and describes the Display Options associated with the Manage Pages component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.24.1, "Manage Pages Component Display Options"


	
Section 13.2.24.2, "Manage Pages Component Tag and XML"






13.2.24.1 Manage Pages Component Display Options

The Manage Pages component shares many of the same properties with the About Space component. Table 13-24 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Manage Pages component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-24 Manage Pages Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Logout of WebCenter Portal. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.TITLE_MANAGE_PAGES}.


	
Task Flow Id

	
The component's unique identifier, for example wcdc4082953494


	
Text

	
Display text for the component

The default is Logout. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.TITLE_MANAGE_PAGES}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.24.2 Manage Pages Component Tag and XML

The following tag is used to render the Manage Pages component on a .jspx page:


<wcdc:managePages id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.TITLE_MANAGE_PAGES}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.TITLE_MANAGE_PAGES}"/>


Example 13-17 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-17 XML Code for the Manage Pages Component


<tag>
   <name>managePages</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      ManagePagesTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.25 Page Links

The Page Links component is an icon for opening the Links dialog (Figure 13-30).


Figure 13-30 Page Links Component

[image: Page Links component]

Description of "Figure 13-30 Page Links Component"








	
See Also:

For information about linking in Spaces, see Chapter 63, "Working with the Links Service."







The Links dialog enables users to add personal links to related content to the current page and to navigate to those link targets. For more information, see Chapter 63, "Working with the Links Service."

This section lists and describes the Display Options associated with the Page Links component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.25.1, "Page Links Component Display Options"


	
Section 13.2.25.2, "Page Links Component Tag and XML"






13.2.25.1 Page Links Component Display Options

Table 13-25 lists and describes the Display Options properties associated with the Page Links component.


Table 13-25 Page Links Component Display Options

	Property	Description
	
Task Flow Id

	
A unique identifier for the component instance

Caution: Never change this property's default value


	
Show Label

	
Display text for the component

By default, the Page Links component is labeled Links.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again through Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.25.2 Page Links Component Tag and XML

The following tag is used to render the Page Links component on a .jspx page:


<wcdc:pageLinks id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib"/>


Example 13-18 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-18 XML Code for the Page Links Component


<tag>
   <name>pageLinks</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      PageLinksTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>showLabel</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.26 Parent Space

The Parent Space component is a link users click to navigate to the top space in a space hierarchy (Figure 13-31).


Figure 13-31 Parent Space Component

[image: Parent Space component]

Description of "Figure 13-31 Parent Space Component"








	
See Also:

For information about space hierarchies, see Section 54, "Working with a Space Hierarchy."







This section lists and describes the Display Options associated with the Parent Space component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.26.1, "Parent Space Component Display Options"


	
Section 13.2.26.2, "Parent Space Component Tag and XML"






13.2.26.1 Parent Space Component Display Options

The Parent Space component shares many of the same properties with the About Space component. Table 13-24 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Parent Space component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-26 Parent Space Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Navigate to Parent Space. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_NAVIGATE_TO_PARENT_SPACE}.


	
Text

	
Display text for the component

The default is Navigate to Parent Space. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_NAVIGATE_TO_PARENT_SPACE}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.26.2 Parent Space Component Tag and XML

The following tag is used to render the Parent Space component on a .jspx page:


<wcdc:parentSpace id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.LABEL_NAVIGATE_TO_PARENT_SPACE}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.LABEL_NAVIGATE_TO_PARENT_SPACE}"/>


Example 13-19 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-19 XML Code for the Parent Space Component


<tag>
   <name>parentSpace</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      ParentSpaceTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.27 Print Preview

The Print Preview component is a link users click to open a print preview of the current page in the user's browser (Figure 13-32).


Figure 13-32 Print Preview Component

[image: Print Preview component]

Description of "Figure 13-32 Print Preview Component"








	
See Also:

For more information, see Section 29.8, "Previewing and Printing an Application Page."







This section lists and describes the Display Options associated with the Print Preview component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.27.1, "Print Preview Component Display Options"


	
Section 13.2.27.2, "Print Preview Component Tag and XML"






13.2.27.1 Print Preview Component Display Options

The Print Preview component shares many of the same properties with the About Space component. Table 13-27 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Print Preview component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-27 Print Preview Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Print Preview. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_PAGE_PRINT_PREVIEW}.


	
Text

	
Display text for the component

The default is Print Preview. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_PAGE_PRINT_PREVIEW}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.27.2 Print Preview Component Tag and XML

The following tag is used to render the Print Preview component on a .jspx page:


<wcdc:printPreview id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   text="#{uib_o_w_w_r_WebCenter.LABEL_PAGE_PRINT_PREVIEW}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.LABEL_PAGE_PRINT_PREVIEW}" 
   inlineStyle="white-space:nowrap;"/>


Example 13-20 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-20 XML Code for the Print Preview Component


<tag>
   <name>printPreview</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      PrintPreviewTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.28 Privacy URL

The Privacy URL component is a link that users click to navigate to the application privacy statement (Figure 13-33).


Figure 13-33 Privacy URL Component
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Description of "Figure 13-33 Privacy URL Component"





This section lists and describes the Display Options associated with the Privacy URL component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.28.1, "Privacy URL Component Display Options"


	
Section 13.2.28.2, "Privacy URL Component Tag and XML"






13.2.28.1 Privacy URL Component Display Options

The Privacy URL component shares many of the same properties with the About WebCenter component. Table 13-28 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Privacy URL component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-28 Privacy URL Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Display privacy statement. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.PRIVACY_STMT_DESC}.


	
Text

	
Display text for the component

The default is Privacy Statement. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.PRIVACY_STMT}.


	
Type

	
The component type

The default is privacyURL.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.28.2 Privacy URL Component Tag and XML

The following tag is used to render the Privacy URL component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="privacyURL" displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.PRIVACY_STMT}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.PRIVACY_STMT_DESC}"/>


In the Resource Catalog, the Privacy URL component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.29 RSS

The RSS component is a link users click to open the RSS Manager (Figure 13-34).


Figure 13-34 RSS Component
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Description of "Figure 13-34 RSS Component"





The RSS Manager enables users to subscribe to news feeds from WebCenter Portal: Services. For more information, see Chapter 68, "Working with the RSS Service."

This section lists and describes the Display Options associated with the RSS component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.29.1, "RSS Component Display Options"


	
Section 13.2.29.2, "RSS Component Tag and XML"






13.2.29.1 RSS Component Display Options

The RSS component shares many of the same properties with the About Space component. Table 13-29 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The RSS component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-29 RSS Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Open RSS Manager. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_RSS_DESC}.


	
Text

	
Display text for the component

The default is RSS. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_RSS}.


	
Type

	
The component type

The default is rss.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.29.2 RSS Component Tag and XML

The following tag is used to render the RSS component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="rss" displayType="link" text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_RSS}" 
   inlineStyle="white-space:nowrap;"/>


In the Resource Catalog, the RSS component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.30 Search

The Search component provides a means entering search terms against the application or against a scoped space, depending on how its parameters are configured (Figure 13-35).


Figure 13-35 Search Component
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Description of "Figure 13-35 Search Component"








	
See Also:

For more information, see Chapter 56, "Working with the Search Service."










	
Note:

The Search component is a task flow and has no associated XML definition.







Table 13-10 lists and describes the parameters associated with the Search component.




	
See Also:

The Search component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-30 Search Component Parameter

	Property	Description
	
Search Box Size

	
Specifies the width of the Search field to render

Enter a number and a unit of measure, such as 400px.


	
Search Scope ID

	
The intended scope of the search

By default, the current scope is searched. This means that Search components placed on pages in the Home space search the entire application, and Search components placed in a particular space search just that space.

To limit the search to a space other than the current space, set this to the intended space's GUID. For information about obtaining a space's GUID, see Section 29.9.1, "Accessing Space Information."











	
See Also:

Parameters in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.31 Self Registration

The Self Registration component is a link users click to open the Self Registration page (Figure 13-36).


Figure 13-36 Self Registration Component
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Description of "Figure 13-36 Self Registration Component"





The Self Registration page is a system page that enables users to create their own application login credentials. For more information, see Section 7.3, "Working with System Pages," and Section 29.2, "Registering Yourself with WebCenter Portal: Spaces."

This section lists and describes the Display Options associated with the Self Registration component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.31.1, "Self Registration Component Display Options"


	
Section 13.2.31.2, "Self Registration Component Tag and XML"






13.2.31.1 Self Registration Component Display Options

The Self Registration component shares many of the same properties with the About WebCenter component. Table 13-31 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Self Registration component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-31 Self Registration Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Register with WebCenter Spaces. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_SELFREG_DESC}.


	
Text

	
Display text for the component

The default is Register. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_SELFREG}.


	
Type

	
The component type

The default is selfRegistration.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.31.2 Self Registration Component Tag and XML

The following tag is used to render the Self Registration component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="selfRegistration" displayType="link" 
   text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_SELFREG}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_SELFREG_DESC}" 
   inlineStyle="white-space:nowrap"/>


In the Resource Catalog, the Self Registration component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.32 Share Resource

The Share Resource component renders as Share Link. Users click this link to open a popup version of the Publisher task flow for publishing messages, links, and documents (Figure 13-37).


Figure 13-37 Share Resource Component
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Description of "Figure 13-37 Share Resource Component"





Messages, links, and documents are published on the user's own Message Board or a space Message Board, depending on the selected recipient. In turn, if activities on the user's Message Board are shared with the user's connections via Activity Stream, then the published message, document, or link is shared with all of the user's connections through their Activity Streams. Messages published to a space are shared with all members of that space through their Activity Streams.




	
See Also:

For information about the Publisher task flow, see Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow."







This section lists and describes the Display Options associated with the Share Resource component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.32.1, "Share Resource Display Options"


	
Section 13.2.32.2, "Share Resource Component Tag and XML"






13.2.32.1 Share Resource Display Options

The Share Resource component shares many of the same properties with the About WebCenter component. Table 13-32 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Share Resource component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-32 Share Resource Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Share Link. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter['NAV_TOOLS_ACTIONS_FOLDER_SHARE.TITLE']}.


	
Text

	
Display text for the component

The default is Share Link. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter['NAV_TOOLS_ACTIONS_FOLDER_SHARE.TITLE']}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.32.2 Share Resource Component Tag and XML

The following tag is used to render the Share Resource component on a .jspx page:


<wcdc:shareResource id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter['NAV_TOOLS_ACTIONS_FOLDER_SHARE.TITLE']}" 
   shortDesc="#{uib_o_w_w_r_WebCenter
      ['NAV_TOOLS_ACTIONS_FOLDER_SHARE.TITLE']}"/>


Example 13-21 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-21 XML Code for the Share Resource Component


<tag>
   <name>shareResource</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      ShareResourceTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.33 Spaces Switcher

The Spaces Switcher component provides access to a popup window where users can select a space to which to navigate (Figure 13-38).


Figure 13-38 Spaces Switcher Component

[image: Spaces Switcher component]

Description of "Figure 13-38 Spaces Switcher Component"





This section lists and describes the Display Options associated with the Spaces Switcher component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.33.1, "Spaces Switcher Component Display Options"


	
Section 13.2.33.2, "Spaces Switcher Component Tag and XML"






13.2.33.1 Spaces Switcher Component Display Options

The Spaces Switcher component shares many of the same properties with the About WebCenter component. Table 13-33 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".


Table 13-33 Spaces Switcher Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Access spaces and create new ones. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.LABEL_COMMUNITIES_DESC}.


	
Text

	
Display text for the component

The default is Spaces. The default is the rendered value of the EL expression #{uib_o_w_s_r_Spaces.LABEL_COMMUNITIES}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.33.2 Spaces Switcher Component Tag and XML

The following tag is used to render the Spaces Switcher component on a .jspx page:


<wcdc:spacesSwitcher id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   inlineStyle="white-space:nowrap;" styleClass="WCLinkMenu" 
   text="#{uib_o_w_s_r_Spaces.LABEL_COMMUNITIES}" 
   shortDesc="#{uib_o_w_s_r_Spaces.LABEL_COMMUNITIES_DESC}"/>


Example 13-22 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-22 XML Code for the Spaces Switcher Component


<tag>
   <name>spacesSwitcher</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      spacesSwitcherTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.34 Status Indicator

The Status Indicator component is an animated icon that spins when the application is processing information (Figure 13-39).


Figure 13-39 Status Indicator Component

[image: Status Indicator component]

Description of "Figure 13-39 Status Indicator Component"





This section lists and describes the Display Options associated with the Status Indicator component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.34.1, "Status Indicator Component Display Options"


	
Section 13.2.34.2, "Status Indicator Component Tag and XML"






13.2.34.1 Status Indicator Component Display Options

The Status Indicator component shares many of the same properties with the About WebCenter component. Table 13-34 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Status Indicator component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-34 Status Indicator Component Display Options

	Property	Description
	
Type

	
The component type

The default is statusIndicator.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.34.2 Status Indicator Component Tag and XML

The following tag is used to render the Status Indicator component on a .jspx page:


<wcdc:spacesAction id="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   type="statusIndicator" displayType="link" />


In the Resource Catalog, the Status Indicator component uses the same XML code as the About WebCenter component. For more information, see Section 13.2.3.2, "About WebCenter Component Tag and XML."








13.2.35 Subscription Preferences

The Subscription Preferences component is a link users can click to subscribe to be notified about specific types of activities that occur in the context of the space (Figure 13-40).


Figure 13-40 Subscription Preferences Component

[image: Subscription Preferences component]

Description of "Figure 13-40 Subscription Preferences Component"








	
See Also:

For more information, see Section 36.3.2, "Setting Space-Level Subscriptions."







This section lists and describes the Display Options associated with the Subscription Preferences component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.35.1, "Subscription Preferences Component Display Options"


	
Section 13.2.35.2, "Subscription Preferences Component Tag and XML"






13.2.35.1 Subscription Preferences Component Display Options

The Subscription Preferences component shares many of the same properties with the About WebCenter component. Table 13-35 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The Subscription Preferences component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-35 Subscription Preferences Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Subscribe. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_SUBSCRIBE_TO_GET_NOTIFICATION}.


	
Text

	
Display text for the component

The default is Subscribe. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.LABEL_SUBSCRIBE_TO_GET_NOTIFICATION}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.35.2 Subscription Preferences Component Tag and XML

The following tag is used to render the Subscription Preferences component on a .jspx page:


<wcdc:notificationSubscriptionsLink id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   text="#{uib_o_w_w_r_WebCenter.LABEL_SUBSCRIBE_TO_GET_NOTIFICATION}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.LABEL_SUBSCRIBE_TO_GET_NOTIFICATION}" />


Example 13-23 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-23 XML Code for the Subscription Preferences Component


<tag>
   <name>notificationSubscriptionsLink</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.
      taglib.NotificationSubscriptionsLinkTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>scopeName</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.36 Tags

The Tags component is an icon that users click to open the Add Tags dialog (Figure 13-41).


Figure 13-41 Tags Component
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Description of "Figure 13-41 Tags Component"





Add tags to associate personally meaningful search terms to a page or a Spaces item. For more information, see Chapter 57, "Working with the Tags Service."

This section lists and describes the Display Options associated with the Tags component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.36.1, "Tags Component Display Options"


	
Section 13.2.36.2, "Tags Component Tag and XML"






13.2.36.1 Tags Component Display Options

Table 13-36 lists and describes the Display Options associated with the Tags component.




	
See Also:

The Tags component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-36 Tags Component Display Options

	Property	Description
	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again through Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.


	
Show Label

	
Display text for the component

By default, no display text is associated with the Tag icon.


	
Task Flow Id

	
The component's unique identifier, for example wcdc4082953494











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.36.2 Tags Component Tag and XML

The following tag is used to render the Tags component on a .jspx page:


<wcdc:pageTags id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib"/>


Example 13-24 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-24 XML Code for the Tags Component


<tag>
   <name>pageTags</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      PageTagsTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>showLabel</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
</tag>










13.2.37 User Preferences

The User Preferences component is a link that users click to access the Preferences dialog (Figure 13-42).


Figure 13-42 User Preferences Component

[image: User Preferences component]

Description of "Figure 13-42 User Preferences Component"





User preferences enable users to configure their views of the application to suit their working styles. For more information, see Chapter 35, "Setting Your Personal Preferences."

This section lists and describes the Display Options associated with the User Preferences component. Additionally, it provides the tag that invokes this component on a .jspx page and the XML code that defines this component in a Resource Catalog.

This section includes the following subsections:

	
Section 13.2.37.1, "User Preferences Component Display Options"


	
Section 13.2.37.2, "User Preferences Component Tag and XML"






13.2.37.1 User Preferences Component Display Options

The User Preferences component shares many of the same properties with the About WebCenter component. Table 13-37 lists the properties that have defaults other than those specified in Table 13-2, "About Space Component Display Options".




	
See Also:

The User Preferences component has Style properties you can use to change the component's look and feel. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."








Table 13-37 User Preferences Component Display Options

	Property	Description
	
Short Desc

	
A field for entering tooltip text to display when users hover their mouse pointers over the component

The default is Set user preferences. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_PREFERENCES_DESC}.


	
Text

	
Display text for the component

The default is Preferences. The default is the rendered value of the EL expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_PREFERENCES}.











	
See Also:

Display Options properties in the Component Properties dialog provide access to an Expression Language (EL) editor for entering and testing EL values. For more information, see Appendix B, "Expression Language Expressions."












13.2.37.2 User Preferences Component Tag and XML

The following tag is used to render the User Preferences component on a .jspx page:


<wcdc:userPreferences id="#" __taskFlowId="#" 
   xmlns:wcdc="http://xmlns.oracle.com/webcenter/spaces/taglib" 
   displayType="link" inlineStyle="white-space:nowrap;" 
   text="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_PREFERENCES}" 
   shortDesc="#{uib_o_w_w_r_WebCenter.GLOBAL_LINK_PREFERENCES_DESC}"/>


Example 13-25 provides the XML code that represents the component in the Resource Catalog file (SiteTemplateCatalog.xml) in a Framework application.


Example 13-25 XML Code for the User Preferences Component


<tag>
   <name>userPreferences</name>
   <tag-class>oracle.webcenter.webcenterapp.internal.view.taglib.
      UserPreferencesTag</tag-class>
   <body-content>empty</body-content>
   <attribute>
      <name>id</name>
   </attribute>
   <attribute>
      <name>rendered</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>binding</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>clientComponent</name>
      <deferred-value>
         <type>boolean</type>
      </deferred-value>
   </attribute>
   <attribute>
      <name>customizationId</name>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>depressedIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabled</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>disabledIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>displayType</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>hoverIcon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>icon</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>iconPosition</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>inlineStyle</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>shortDesc</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>styleClass</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>__taskFlowId</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
   <attribute>
      <name>text</name>
      <required>false</required>
      <deferred-value/>
   </attribute>
  </tag>












13.3 Deleting Spaces Components

This section points to information about removing Spaces components from the various venues in which they may appear. It includes the following subsections:

	
Section 13.3.1, "Removing Spaces Components from a Resource Catalog"


	
Section 13.3.2, "Removing a Spaces Component from a Template"


	
Section 13.3.3, "Removing a Spaces Component from a Page"






13.3.1 Removing Spaces Components from a Resource Catalog

You can remove a Spaces component from a Resource Catalog as you would any other resource. For more information, see Section 16.3.1.7, "Deleting a Resource."






13.3.2 Removing a Spaces Component from a Template

To remove a Spaces component from a template:

	
Access the template in edit mode as described in Section 12.3, "Editing a Page Template."


	
In Source view, select the Spaces component by clicking it in the hierarchical list of components.




	
Tip:

In Source view, you can also click the component directly on the page to select it.








	
Click Delete.


	
In the resulting confirmation dialog, click Delete.









13.3.3 Removing a Spaces Component from a Page

To remove a Spaces component from a page:

	
Access the page in edit mode as described in Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Source view, select the Spaces component by clicking it in the hierarchical list of components.




	
Tip:

In Source view, you can also click the component directly on the page to select it.








	
Click Delete.


	
In the resulting confirmation dialog, click Delete.














14 Working with Skins

To give individual spaces or the entire Spaces application a distinct personality or to associate with specific branding, portal designers can use skins to achieve the appearance and look and feel that suits their organization.

This chapter describes how to create and manage skins in Spaces. It includes the following sections:

	
Section 14.1, "What You Should Know About Skins"


	
Section 14.2, "Creating a Skin"


	
Section 14.3, "Editing a Custom Skin"


	
Section 14.4, "Managing a Skin"


	
Section 14.5, "Applying a Skin"


	
Section 14.6, "Using JDeveloper to Build Your Skins"




For generic information about adding and editing different types of resources, see Chapter 10, "Working with the Resources that Compose a Portal or Community."


Audience

This chapter is intended for users who want to create and manage skins in their Spaces application.

Portal designers with the application permission Application-Skins-Create, Edit, and Delete Skins can manage application-level skins. Space moderators with the permission Space-Resources-Create, Edit, and Delete Resources (standard permission model) or Space-Skin-Create, Edit, and Delete Skins (advanced permission model) can manage space-level skins. For information about roles and permissions, see Chapter 20, "Understanding Security."



14.1 What You Should Know About Skins

A skin is a resource that defines colors, fonts, and other aspects of various components used on the pages of a space. A skin changes the way the user interface appears, and not how the application functions.

Skins are based on the Cascading Style Sheet (CSS) specification. A skin is made up of various selectors that define the CSS styles or properties of different parts of a component. You can adjust the look and feel of any component by changing its style-related properties. Some selectors, like a background or foreground color or a font style, may be global and affect all components.

Out-of-the-box, Spaces provides certain built-in skins (Figure 14-1). Authorized users can change the appearance of a specific space or the entire application by using built-in skins.


Figure 14-1 Built-in Skins

[image: Built-in default skins]

Description of "Figure 14-1 Built-in Skins"





If built-in skins do not quite match your requirements, you can create custom skins of your own within Spaces to brand your application or specific spaces as desired.

Spaces also gives you the flexibility to use an IDE like Oracle JDeveloper to create new skins or edit custom Spaces skins. You can then upload these skins back into the Spaces application.






14.2 Creating a Skin

If you have specific branding requirements for the way your application looks, you may want to create a custom skin of your own instead of using built-in skins. In Spaces, you can create skins at two levels—application level and space level.

To create a custom skin:

	
Navigate to the Resources page of your Spaces application or the space in which you want to create the custom skin, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Look and Layout, select Skins.


	
On the menu bar, click Create.


	
In the Create New Skin dialog, in the Name field, enter a name for the custom skin (Figure 14-2).


Figure 14-2 The Create New Skin Dialog

[image: Create New Skin Dialog]

Description of "Figure 14-2 The Create New Skin Dialog"





	
In the Description field, enter a description for the custom skin.

The description is displayed below the skin name on the Resources page and as a tool tip when selecting a skin. You should ensure that the description helps users determine if they want to use this particular skin.


	
From the Copy from list, select an existing skin to use as the starting point for your new custom skin.




	
Tip:

You can also create a new custom skin by making a copy of an existing skin, as described in Section 14.4.4, "Copying a Skin."








	
Click OK.

The newly created custom skin is listed on the Resources page. The gray circle icon next to the custom skin indicates that it is not yet published and hence is not available to other users. For information about publishing a skin, see Section 14.4.1, "Showing and Hiding a Skin."







	
Note:

You can also create skins in tools like Oracle JDeveloper that provide you more control and flexibility in skin creation. For information, see Section 14.6, "Using JDeveloper to Build Your Skins."












14.3 Editing a Custom Skin

This section describes how to edit custom skins. It includes the following subsections:

	
Section 14.3.1, "What You Should Know About Skin Editing"


	
Section 14.3.2, "Editing the Source Code of a Custom Skin"


	
Section 14.3.3, "Editing a Custom Skin Using the Edit Dialog"






14.3.1 What You Should Know About Skin Editing

Spaces supports two types of skin editing, source code editing and simple editing.

This section includes the following subsections:

	
Section 14.3.1.1, "About Source Code Editing"


	
Section 14.3.1.2, "About Simple Editing"






14.3.1.1 About Source Code Editing

Source editing enables you to edit the source code of a custom skin in a text editor. This provides a powerful means of editing all the skin selectors available in a skin's CSS file.

Use the Edit Source dialog to edit a custom skin's source code. In this dialog, the source code is presented on the CSS tab (Figure 14-3).


Figure 14-3 Editing Skin Selectors

[image: Editing a skin selector]

Description of "Figure 14-3 Editing Skin Selectors"





A skin's CSS file supports and contains ADF skin selectors and the skin selectors associated with Composer components. For information about ADF skin selectors, refer to Oracle Fusion Middleware Tag Reference for Oracle ADF Faces Skin Selectors. For information about Composer components skin-specific selectors, refer to the section "Style Selectors for Composer Components" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

In addition to ADF and Composer skin selectors, a skin's CSS file contains three Spaces-specific selectors. These include:

	
.WCPageTemplate:alias - Defines the background color and the image and its position for the main area of the page template below the top banner, as shown in the example below:


.WCPageTemplate:alias
{
  background-image:url(/afr/fusion/dbd_centerGradient.png);
  background-repeat:repeat-y;
  background-position:top center;
  background-color: #024296;
  color: white;
}


	
.WCContent - Defines the background color of the area of the page template containing the actual page content.


.WCContent
{
  background-color:#EEF3F8;
  border-top:1px solid #BECFE2;
}


	
.WCPortletContentMedium:alias - Defines the background color and image of task flows and portlets in showDetailFrame components.


.WCPortletContentMedium:alias
{
  background-image:url(/adf/images/gradient-275x275-fcfcfc.png);
  background-repeat:no-repeat;
}




While editing the source code of a custom skin, you can add, edit, or delete any skin selector to suit your requirements. For example, if you want to override the default font size, then in your skin's CSS file, you can specify the required size in the skin selector shown in Example 14-1.


Example 14-1 Overriding the Default Font Size in a Skin's CSS File


.AFDefaultFont:alias
{
font-size:12px;
}




When you edit the code using the Edit Source dialog, the format of the code is validated and an error message is displayed if you miss any tags or add them incorrectly.

For information about how to edit the source code of a skin, see Section 14.3.2, "Editing the Source Code of a Custom Skin."






14.3.1.2 About Simple Editing

Simple editing provides a simple means of editing a skin's basic appearance settings: font, background color, and background image. To perform simple editing, you use the Edit dialog (Figure 14-4).


Figure 14-4 The Edit Dialog

[image: The Edit Dialog used for editing a skin]

Description of "Figure 14-4 The Edit Dialog"





In the Edit dialog, you can define settings for the target areas listed below. Each target area maps to a WebCenter Portal-specific skin selector available in a skin's CSS file (described in Section 14.3.1.1, "About Source Code Editing.")

	
Page Template - Enables you to define the background color, background image, and font for the template used on a page. In a Skin's CSS file, this target area maps to the .WCPageTemplate:alias selector, which is used by all page templates.


	
Page - Enables you to choose the color and image of the page background. This target area sets the .WCContent style selector in the CSS file.


	
Task Flow/Portlet - Enables you to define the background color and image of task flows and portlets on a page. In the CSS file, this sets the .WCPortletContentMedium:alias selector, which defines the background color of Show Detail Frames that use medium background.




For information about how to edit the source code of a skin, see Section 14.3.3, "Editing a Custom Skin Using the Edit Dialog."








14.3.2 Editing the Source Code of a Custom Skin

Use the Edit Source dialog to expose the underlying code of a custom skin and make adjustments to the skin selectors that make up the skin.




	
Caution:

You must have a thorough understanding of CSS specification about selectors if you plan to edit skin selectors. You might get into a situation where you are not sure why your style is not getting picked up, whereas it could very well be that the skin you are extending has a selector that is more specific than your selector.







To edit the source code of a custom skin:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Look and Layout, click Skins.


	
From the list of skins displayed on the right, select the skin whose source code you want to edit.


	
From the Edit menu, choose Edit Source.


	
In the Edit Source dialog, change the required settings (Figure 14-5).


Figure 14-5 Editing Skin Selectors

[image: Editing a skin selector]

Description of "Figure 14-5 Editing Skin Selectors"





	
Click OK.









14.3.3 Editing a Custom Skin Using the Edit Dialog

To perform simple editing of a custom skin using the Edit dialog:

	
Navigate to the Resources page of your application or the desired space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, under Look and Layout, click Skins.


	
From the list of skins displayed on the right, select the skin that you want to edit.


	
From the Edit menu, choose Edit.


Figure 14-6 Editing Skin Properties

[image: Editing skin appearance properties]
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In the Edit dialog, from the Item list, select the target area for which you want to update skin properties.

Select any one of the following options:

	
Page Template - Select to choose the background color, background image, and font for the template used on a page.


	
Page - Select to choose the color and image of the page background.


	
Task Flow/Portlet - Select to choose the background color and image of task flows and portlets on a page.





	
From the Background Color list, select the background color you want to use for the target area.

When you select a background color, its RGB value appears in the Color field, and the selected target area is highlighted with that color in the Preview panel on the right.


	
In the Image field, enter the URI path of the image you want to use as a background image.




	
Note:

You can either specify an absolute URL (where the URL should also work if entered in a browser address field), or a relative URL that points to an image located somewhere in Spaces. To store an image in Spaces, you must upload the required file using the Documents service, as described in Section 41.8.1, "Uploading Files." You can then obtain the image's URL as described in Section 41.26.1, "Retrieving the URL for a Folder or File."








	
You can choose to repeat the background image horizontally and/or vertically. Depending on your requirement, select the following checkboxes:

	
Repeat Horizontally - Select to show the background image aligned horizontally at the top of the page, with the image repeated across the horizontal bar (Figure 14-7).


Figure 14-7 Repeating an Image Horizontally Across a Target Area

[image: Repeating an image horizontally across a target area]

Description of "Figure 14-7 Repeating an Image Horizontally Across a Target Area"





	
Repeat Vertically - Select to show the background image aligned vertically on the left side of the page, with the image repeated across the vertical bar (Figure 14-8).


Figure 14-8 Repeating an Image Vertically Across a Target Area

[image: Repeating an image vertically across a target area]

Description of "Figure 14-8 Repeating an Image Vertically Across a Target Area"







If you select both these checkboxes, copies of the selected image are repeated across the entire target area (Figure 14-9).


Figure 14-9 Repeating an Image Across the Entire Target Area

[image: Repeating an image across the entire target area]

Description of "Figure 14-9 Repeating an Image Across the Entire Target Area"





	
From the Font Family list, select the font you want to use for the Page Template area.

The Font list is displayed only when Page Template is selected as the target area.


	
Click OK.











14.4 Managing a Skin

This section describes the tasks involved in managing skins. It includes the following subsections:

	
Section 14.4.1, "Showing and Hiding a Skin"


	
Section 14.4.2, "Setting Properties on a Skin"


	
Section 14.4.3, "Setting Security on a Skin"


	
Section 14.4.4, "Copying a Skin"


	
Section 14.4.5, "Deleting a Skin"


	
Section 14.4.6, "Viewing Information About a Skin"






14.4.1 Showing and Hiding a Skin

When you create a custom skin, by default it is marked as hidden. A hidden skin is not available for use in the application, Home space, or any other space. To make a skin available, you must publish it. Further, for a custom skin created at the application level, you can control whether it is available to all or only selected spaces in the application.

Showing or hiding a skin follows the same procedure as any other resource. For information, see Section 10.4.3, "Showing and Hiding Resources."

For generic information about resource availability in Spaces, see Section 10.4.2, "Setting Properties on a Resource."






14.4.2 Setting Properties on a Skin

A range of properties is associated with custom skins that authorized users can access through the Edit Properties dialog.

This section includes the following subsections:

	
Section 14.4.2.1, "What You Should Know About Skin Properties"


	
Section 14.4.2.2, "Naming, Describing, and Categorizing a Custom Skin"


	
Section 14.4.2.3, "Associating an Icon with a Custom Skin"


	
Section 14.4.2.4, "Setting the Availability of an Application-Level Custom Skin"


	
Section 14.4.2.5, "Working with a Custom Skin's Attributes"






14.4.2.1 What You Should Know About Skin Properties

Use custom skin properties to:

	
Enter a display name and description


	
Provide an icon for use


	
Apply a category to classify a skin


	
Specify availability (for application-level skins only)


	
Associate attribute name/value pairs, for example, to control whether a page based on a selected page style opens in view or edit mode once it is created




Figure 14-10 shows the Edit Properties dialog of a custom skin. You specify the various properties in the General, Exclude Resource Usage, and Attributes sections.


Figure 14-10 Setting Skin Properties
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With each custom skin, three default attributes are associated: skinId, skinFamily, and skinExtends. Table 14-1 provides a description of these attributes.




	
Note:

As an authorized user, you can add, modify, or delete the attributes of a custom skin. However, you must have a thorough understanding of these attributes if you want to manage them.








Table 14-1 Default Attributes of a Skin

	Attribute	Description
	
skinId

	
Specifies the unique identifier of a skin. Typically, it is a combination of the skin family and the render kit, for example BrightBlue.desktop.


	
skinFamily

	
Specifies the family to which a skin belongs. It is an identifier that can be used by a number of skins with different renderkits. For example, you could have a family named BrightBlue. It can be used with renderkit desktop or mobile.


	
skinExtends

	
Specifies the ID of the skin being extended. For example, suppose you like the midnight skin, but want a different font size in that skin. You can configure your skin to extend the midnight.desktop skin and then you can edit the source code of your skin to override the font size.












14.4.2.2 Naming, Describing, and Categorizing a Custom Skin

Setting the name, description, and category of a custom skin follows the same procedure as any other resource. For information, see Section 10.4.2.3, "Renaming, Describing, and Categorizing a Resource."






14.4.2.3 Associating an Icon with a Custom Skin

Associating an icon with a custom skin follows the same procedure as any other resource. For information, see Section 10.4.2.4, "Associating an Icon with a Resource."






14.4.2.4 Setting the Availability of an Application-Level Custom Skin

Setting the availability of an application-level custom skin in a space follows the same procedure as any other resource. For information, see Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces."






14.4.2.5 Working with a Custom Skin's Attributes

Setting the attributes of a custom skin follows the same procedure as any other resource. For information, see Section 10.4.2.6, "Working with the Attributes of a Resource."

For information about default skin attributes, see Table 14-1.








14.4.3 Setting Security on a Skin

You can control whether all users or only specific users or groups can access the custom skin that you created in your application or a space. Setting access to a custom skin follows the same procedure as any other resource. For more information, see Section 10.4.4, "Setting Security for a Resource."






14.4.4 Copying a Skin

Spaces enables you to create copies of a skin. You can use this feature when you want to back up a skin or update a skin while keeping the original in use.

Copying a skin follows the same procedure as any other resource. For the generic procedure, see Section 10.4.1, "Copying a Resource."






14.4.5 Deleting a Skin

Provided you are assigned the required permissions, you can delete any custom skin. Deleting a skin follows the same procedure as deleting any other resource. For information, see Section 10.4.5, "Deleting a Resource."






14.4.6 Viewing Information About a Skin

Each skin has an associated About page that summarizes useful information about it (Figure 14-11).

Accessing information about a skin follows the same procedure as any other resource. For information about how to access the About dialog, and for a description of the properties displayed in the dialog, see Section 10.1.5, "Viewing Information About a Resource."

For information about skin-specific default attributes, see Table 14-1.


Figure 14-11 About Dialog of a Skin

[image: About dialog of a skin]
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14.5 Applying a Skin

As a Spaces administrator, you may customize the default appearance of the application for all users by changing its skin. As a space moderator, you may customize the appearance of your space for all members by changing its skin. Individual users can change the skin applied to their Home space through user preference settings.

This section includes the following subsections:

	
Section 14.5.1, "Applying a Skin to the Spaces Application"


	
Section 14.5.2, "Applying a Skin to a Space"


	
Section 14.5.3, "Applying a Skin to the Home Space"






14.5.1 Applying a Skin to the Spaces Application

When you set a skin for the Spaces application, the skin is applied to the Home space and all spaces that use the application-level skin setting. The skin is also applied to any new spaces that are created. However, the skin is not applied to existing spaces for which a specific skin has already been set. Also, the skin is not applied to the administration pages. By default, these pages use the Fusion FX skin.

To apply a skin to the Spaces application:

	
Open the Spaces Administration page. See Section 4.1, "Accessing the Spaces Administration Page."


	
Click the Configuration tab.


	
In the Global section of the General tab, select the desired skin from the Application Skin list (Figure 14-12).


Figure 14-12 Applying a Skin to the Spaces Application

[image: Applying a Skin to WebCenter Spaces]

Description of "Figure 14-12 Applying a Skin to the Spaces Application"








	
Note:

If the desired skin does not appear in the Application Skin list, it may be because it is marked as hidden. A skin must be marked as Available to be available for selection. For information, see Section 14.4.1, "Showing and Hiding a Skin."








	
Click Apply.

The skin you select is applied to Home space, any new spaces that are created, and all spaces that use the application-level skin setting. The skin is not applied to the spaces that override the application-level skin setting.









14.5.2 Applying a Skin to a Space

When you apply a skin to a space, the skin is applied to all the pages of the space. However, the administration pages are not affected; they always appear in the default skin. For information about applying a skin to a space, see Section 51.4.10, "Changing the Skin for a Space."






14.5.3 Applying a Skin to the Home Space

For information about applying a skin to your personal view of the Home space, see Section 35.5, "Changing the Home Space Look and Feel in Your View."








14.6 Using JDeveloper to Build Your Skins

You may want to create a skin that is beyond the editing capabilities of Spaces, or you may prefer working in JDeveloper. To do this, you have several options:

	
Use the Edit Source option to edit the source code of the skin. You can edit the source code directly in the Edit Source dialog or you can copy the contents of the dialog to JDeveloper for editing and then copy the edited code back into the dialog. For more information, see Section 14.3.2, "Editing the Source Code of a Custom Skin."


	
Download an existing Spaces skin, import the skin into JDeveloper, edit the skin, and then upload it back to the Spaces application.


	
Create a completely new skin in JDeveloper and upload it to Spaces.




The steps to upload and download skins from Spaces are described in Section 10.5.2, "Downloading a Resource" and Section 10.5.3, "Uploading a Resource."

Oracle provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) for developing Spaces resources, including skins. The workspace offers a design environment in which to create and edit your skins, and also enables you to upload your skins to Spaces for testing. For more information and to download the JDeveloper workspace, see "Developing Resources for the Spaces Application" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

For information about specific considerations for creating skins for use in Spaces, see the chapter "Creating and Managing Skins" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.









15 Working with Page Styles

In planning and building your portal, you may find it useful to offer a wide selection of page styles to your users. It may also be useful to restrict page styles so that users build only the types of pages that you intend.

This chapter provides information about default, out-of-the-box page styles included with WebCenter Portal: Spaces and the custom page styles that you add your portal.

This chapter includes the following sections:

	
Section 15.1, "What You Should Know About Page Styles"


	
Section 15.2, "Creating a Custom Page Style"


	
Section 15.3, "Editing the Source Code of a Custom Page Style"


	
Section 15.4, "Managing Page Styles"


	
Section 15.5, "Applying a Page Style"


	
Section 15.6, "Using JDeveloper to Build Your Page Style"







	
See Also:

For general information about adding and editing different types of resources, see Chapter 10, "Working with the Resources that Compose a Portal or Community."








Audience

This chapter is intended for users who want to provide and manage page styles in a Spaces application. By default, users with an application-level role that includes the permissions Application: Manage All and Page Styles: Create, Edit, and Delete Page Styles or a space role that includes the permissions Administration: Manage All and Resources: Create, Edit, and Delete Resources can perform the actions described in this chapter.



15.1 What You Should Know About Page Styles

When users create a page, a Create dialog opens with a selection of page styles (Figure 15-1).


Figure 15-1 Create Dialog

[image: a Create Page dialog]

Description of "Figure 15-1 Create Dialog"





Page styles describe the layout of a newly created page and may also dictate the type of content the page supports. For example, the Wiki page style provides an instant wiki; a Blank page style has few restrictions on the types of content users can add to the pages that are based on it.

All page styles are published to the Create dialog through the Resource Manager (Figure 15-2).


Figure 15-2 Application-Level Resources Manager

[image: Application-level Resources Manager]

Description of "Figure 15-2 Application-Level Resources Manager"





Application-level page styles are provided on the Resources page accessed through the Administration link. space-level page styles are provided on the Resources page accessed through a space's Settings page.

The difference between application- and space-level page styles is one of scope:

	
Application-level page styles are available to all spaces.


	
Space-level page styles are available only to the space in which they reside.




There may be more page styles available on the Resources page than are available in a Create dialog. The site administrator and the space moderator determine which page styles are shown in the Create dialog through the following considerations:

	
Is the page style shown or hidden?

For more information, see Section 15.4.1, "Showing and Hiding a Page Style in the Create Dialog."


	
Has the page style been configured to appear only in selected spaces (custom application-level page styles only)?

For more information, see Section 15.4.2, "Setting Properties on a Custom Page Style."


	
Has the page style been configured to appear only to selected users or roles (custom page styles only)?

For more information, see Section 15.4.3, "Setting Security on a Custom Page Style."




The Spaces application offers a range of page styles out of the box (default page styles) and provides a means of copying page styles and editing their source (custom page styles). You can also download custom page styles, bring them into Oracle JDeveloper for additional customization, and upload them back into Spaces. The difference between default and custom page styles is one of flexibility: many of the actions available to custom page styles are not available to default page styles.

Table 15-1 compares the types of actions authorized users can perform on default and custom page styles in WebCenter Portal: Spaces.


Table 15-1 Actions Available to Default and Custom Page Styles

	Action	Default	Custom	More Information
	
Upload

	
—


	
Yes

	
Section 10.5.3, "Uploading a Resource"



	
Download

	
No

	
Yes

	
Section 10.5.2, "Downloading a Resource"



	
Preview

	
Yes

	
Yes

	
This control provides a means of previewing the page style. Select a page style and click Preview to render the page style in a page.


	
Copy

	
Yes

	
Yes

	
Section 10.4.1, "Copying a Resource"



	
Security Settings

	
No

	
Yes

	
Section 15.4.3, "Setting Security on a Custom Page Style"



	
Delete

	
No

	
Yes

	
Section 15.4.5, "Deleting a Custom Page Style"



	
Hide/Show

	
Yes

	
Yes

	
Section 15.4.1, "Showing and Hiding a Page Style in the Create Dialog"



	
Edit Source

	
No

	
Yes

	
Section 15.3, "Editing the Source Code of a Custom Page Style"



	
Edit Properties

	
No

	
Yes

	
Section 15.4.2, "Setting Properties on a Custom Page Style"



	
About

	
Yes

	
Yes

	
Section 10.1.5, "Viewing Information About a Resource"









Table 15-2 lists, and describes the default page styles provided with the Spaces application out of the box.


Table 15-2 Default Page Styles

	Name	Illustration	Description
	
Blank

	
[image: Blank page style]


	
A one-column page with one layout box into which you can add content, including additional layout components.


	
Blog

	
[image: Blog page style]


	
A page preconfigured to expose blog controls from the Oracle Content Server. This page style becomes available in the Create dialog when the server is integrated with WebCenter Portal: Spaces.


	
Home Page

	
[image: Home page style]


	
A preseeded Home page, based on the Right Narrow Column Layout page style. The Home page style comes prepopulated with task flows and other content.


	
Left Narrow

	
[image: Left narrow column page style]


	
A two-column page with two layout boxes into which you can add content, including additional layout components. Layout boxes are positioned side-by-side, with the narrower layout box on the left.


	
Right Narrow

	
[image: Right narrow column page style]


	
A two-column page with two layout boxes into which you can add content, including additional layout components. Layout boxes are positioned side-by-side, with the narrower layout box on the right.


	
Three Column

	
[image: Three column page style]


	
A three-column page with three layout boxes into which you can add content, including additional layout components. Layout boxes are positioned side-by-side, with the narrower layout boxes on the left and right sides.


	
Web Page

	
[image: Web page style]


	
A page that takes a URL value, enabling you to expose external web content in your WebCenter Portal: Spaces application.


	
Wiki

	
[image: Wiki page style]


	
A page preconfigured to expose wiki controls from the Oracle Content Server. This page style becomes available in the Create dialog when the server is integrated with WebCenter Portal: Spaces.








For both application- and space-level page styles, the About action opens a dialog that provides information about the selected page style. For more information, see Section 10.1.5, "Viewing Information About a Resource."






15.2 Creating a Custom Page Style

There is no direct way to create a page style in the Spaces application. That is, no Create button is available for starting this process. To create a new page style, you must first copy an existing style and then revise its source code in the source code editor or through JDeveloper. Or, you can create a page style in JDeveloper and upload it to Spaces.

For information about revising a page style's source code, see Section 15.3, "Editing the Source Code of a Custom Page Style." For information about copying a page style, see Section 15.4.4, "Copying a Page Style." For information about working with page styles in Oracle JDeveloper, see the section, "Developing and Uploading WebCenter Portal: Spaces Resources," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.






15.3 Editing the Source Code of a Custom Page Style

Source editing enables you to work with the source code of a custom page style. For example, you can upload a page style you create in JDeveloper and perform additional adjustments to it through the Edit Source dialog. You can even create a style from scratch in the Edit Source dialog, but this entails a lot of hand coding, and we do not recommend it.

This section provides information about editing custom page style source and steps you through the process of editing a custom page style. It includes the following subsections:

	
Section 15.3.1, "What You Should Know About Editing Page Style Source"


	
Section 15.3.2, "Editing Custom Page Style Source"







	
See Also:

For general information about editing a resource, see Section 10.3.2, "Editing the Source Code of a Resource."









15.3.1 What You Should Know About Editing Page Style Source

Use the Edit Source dialog to expose the underlying code of a selected custom page style and make adjustments to it. For example, you can create a new page style in JDeveloper, upload it to Spaces through the Resource Manager, preview it, and edit the source to make adjustments.

In contrast, you can copy a default page style, download the copy to your local drive, bring it into JDeveloper for customization, upload it back into Spaces, and open it in the Edit Source dialog for further adjustments.

You can simply copy a default page style and make adjustments to the copy's source in the Edit Source dialog.

You can even create a page style from the beginning, by copying another page style, and then replacing its code with your own original code through the Edit Source dialog. Note, however, that, due to the heavy hand-coding requirement, we do not recommend this scenario.

In the Edit Source dialog, the custom page style source is presented on two tabs: Page and Page Definition. Page tab content defines the page layout and style. Page Definition tab content holds parameter definitions and task flow and data control bindings. Each represents the underlying *.jspx page and page definition file that comprise the page style.

Example 15-1 illustrates custom page style encoding. It describes a basic page with a two-column layout proportioned at 35 and 65 percent that is designed to flow. This is an example of a custom page style that was created in JDeveloper, imported into Spaces, and opened in the Edit Source dialog Page tab for minor revisions. The relevant code is in bold.


Example 15-1 Source Code of a Custom Page Style


<?xml version='1.0' encoding='utf-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page"
xmlns:pe="http://xmlns.oracle.com/adf/pageeditor"
xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable"
xmlns:f="http://java.sun.com/jsf/core"
xmlns:af="http://xmlns.oracle.com/adf/faces/rich"
xmlns:trh="http://myfaces.apache.org/trinidad/html" version="2.1">
 <jsp:directive.page deferredSyntaxAllowedAsLiteral="true"/>
 <jsp:directive.page contentType="text/html;charset=utf-8"/>
 <f:view>
  <af:document title="#{pageDocBean.title}" id="docrt">
   <af:form usesUpload="true" id="f1">
    <af:pageTemplate value="#{bindings.shellTemplateBinding.templateModel}"
    id="T">
     <f:facet name="content">
      <pe:pageCustomizable id="pcl1">
       <af:panelGroupLayout id="pgl1" layout="scroll"
       styleClass="replace_with_scheme_name"
       inlineStyle="replace_with_inline_style">
        <trh:tableLayout id="tl1" width="100%">
         <trh:rowLayout id="rl1">
          <trh:cellFormat id="cf1" width="35%" valign="top">
           <cust:panelCustomizable id="hm_pnc1" layout="scroll"/>
          </trh:cellFormat>
          <trh:cellFormat id="cf2" width="65%" valign="top">
           <cust:panelCustomizable id="hm_pnc2" layout="scroll"/>
          </trh:cellFormat>
         </trh:rowLayout>
        </trh:tableLayout>
        <trh:tableLayout id="tl2"/>
       </af:panelGroupLayout>
       <f:facet name="editor">
        <pe:pageEditorPanel id="pep1"/>
       </f:facet>
      </pe:pageCustomizable>
     </f:facet>
    </af:pageTemplate>
   </af:form>
  </af:document>
 </f:view>
</jsp:root>








15.3.2 Editing Custom Page Style Source

The following procedure works equally for custom page styles edited at space- and application-levels.

To edit the source of a custom page style:

	
Go to the space- or application-level Resources page, and select Page Styles from the panel on the left.




	
Tip:

You can use the following URLs to navigate to the Resources page:
	
Application-level Resources page:


http://host:port/webcenter/spaces/admin/resources


	
Space-level Resources page:


http://host:port/webcenter/spaces/spaceName/admin/resources













	
Select the custom page style, and then from the Edit menu select Edit Source to open the selected page style in the Source Editor (Figure 15-3).


Figure 15-3 Source Editor

[image: Source editor]

Description of "Figure 15-3 Source Editor"





	
Make changes to the source according to your requirements.


	
When finished, click OK to save your changes and close the editor.











15.4 Managing Page Styles

This section provides information about managing your seeded and custom page styles. It includes the following sections:

	
Section 15.4.1, "Showing and Hiding a Page Style in the Create Dialog"


	
Section 15.4.2, "Setting Properties on a Custom Page Style"


	
Section 15.4.3, "Setting Security on a Custom Page Style"


	
Section 15.4.4, "Copying a Page Style"


	
Section 15.4.5, "Deleting a Custom Page Style"


	
Section 15.4.6, "Previewing a Page Style"






15.4.1 Showing and Hiding a Page Style in the Create Dialog

When you create a page style, by default it is marked as Hidden. A hidden page style is not available for use anywhere in the application. To make a page style available, it must be marked as Available. Further, for a page style created at the application level, you can control whether it is available to any, all, or selected spaces. Finally, you can set access on a selected page style through its security settings.

	
For information about a page style's security settings, see Section 15.4.3, "Setting Security on a Custom Page Style."


	
For information about a page style's exclusion settings, see Section 10.4.2, "Setting Properties on a Resource."


	
For information about hiding and showing application resources, including page styles, see Section 10.4.3, "Showing and Hiding Resources."









15.4.2 Setting Properties on a Custom Page Style

You can control a custom page style's display attributes and availability by setting its properties in the Edit Properties dialog. Setting page style properties follows the same procedure as any other resource. For more information, see Section 10.4.2, "Setting Properties on a Resource."




	
Tip:

To view the properties associated with a resource, use the About option.







In addition to the default attributes exposed through the Edit Properties dialog (Display Name, Description, and the like), you can expose any custom attributes built into a custom page style. The Edit Properties dialog provides a Custom Attributes section for entering attribute name/value pairs (Figure 15-4).


Figure 15-4 Attributes Section of Edit Properties Dialog

[image: Attributes section of Edit Properties dialog]
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For example, the following custom attribute is available to all custom page styles:


editPageAfterCreation


This custom attribute controls whether a newly created page opens in edit or view mode. It takes a value of true or false:

	
Enter ${true} to open a newly created page in edit mode. This is the default value.


	
Enter ${false} to open a newly created page in view mode.




When you associate this custom attribute with a particular page style, every time a user creates a page based on that style, the attribute value is considered and the page behaves accordingly.






15.4.3 Setting Security on a Custom Page Style

You can control whether all users or only specific users or groups can access the page style that you created in your application or space. Setting access to a page style follows the same procedure as any other resource. For more information, see Section 10.4.4, "Setting Security for a Resource."






15.4.4 Copying a Page Style

You can make a copy of a page style by selecting it and choosing Copy from the Edit menu on the Resources - Page Styles page. Copying a page style follows the same procedure as any other resource. For the generic procedure, see Section 10.4.1, "Copying a Resource."






15.4.5 Deleting a Custom Page Style

Provided you are assigned the required permissions, you can delete any custom page style. Deleting a page style follows the same procedure as any other resource. For more information, see Section 10.4.5, "Deleting a Resource."






15.4.6 Previewing a Page Style

You can preview how a page style will look by selecting it on the Resources - Page Styles page and clicking Preview. For more information, see Section 10.4.6, "Previewing a Resource."








15.5 Applying a Page Style

Once you have made a page style available (see Section 15.4.1, "Showing and Hiding a Page Style in the Create Dialog"), you can apply it to a new page. When you create a page, the page style is shown as one of your options in the Create dialog, depending on where you have exposed it (for example, at the application level, in a space, in a selection of spaces, or in the views of selected users, enterprise roles, or groups). To apply a page style, select it in the Create dialog.




	
Tip:

For information about accessing the Create dialog, see Section 17.2, "Creating Pages."












15.6 Using JDeveloper to Build Your Page Style

If you want to create a page style that is beyond the editing capabilities of the Spaces application, you can download the page style, import it into Oracle JDeveloper for editing, and then upload it back to the Spaces application. You can upload page styles directly to the Spaces application from within JDeveloper or through the Spaces application Resources Manager.

The steps to upload and download page styles from the Spaces application are described in Section 10.5.2, "Downloading a Resource," and Section 10.5.3, "Uploading a Resource."

For information about editing resources and uploading custom resources to the Spaces application through JDeveloper, see the section, "Developing and Uploading WebCenter Portal: Spaces Resources," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.









16 Working with Resource Catalogs

Oracle WebCenter Portal: Spaces provides rich Resource Catalogs, also known as Business Dictionaries, which expose components and connections that Spaces users can add to their pages. You can use a Resource Catalog to populate resources such as page templates, navigation models, pages, and task flows. Spaces applications are preconfigured with three Resource Catalogs out-of-the-box. If these catalogs do not meet your business requirements, you can modify them or create new ones.

This chapter provides information about the default, out-of-the-box Resource Catalogs included in Spaces, and also describes how to create and manage custom Resource Catalogs. It includes the following sections:

	
Section 16.1, "What You Should Know About Resource Catalogs"


	
Section 16.2, "Creating Resource Catalogs"


	
Section 16.3, "Editing a Resource Catalog"


	
Section 16.4, "Showing and Hiding a Resource Catalog"


	
Section 16.5, "Setting Properties on a Resource Catalog"


	
Section 16.6, "Setting Security on a Resource Catalog"


	
Section 16.7, "Copying a Resource Catalog"


	
Section 16.8, "Deleting a Resource Catalog"


	
Section 16.9, "Using JDeveloper to Build Your Resource Catalog"


	
Section 16.10, "Configuring Resource Catalogs in Your Application"




For generic information about adding and editing different types of resources, see Chapter 10, "Working with the Resources that Compose a Portal or Community."


Audience

This chapter is intended for users who want to provide and manage Resource Catalogs in their Spaces application. Portal designers with the application permission Application-Resource Catalogs-Create Edit Delete can manage application-level Resource Catalogs. Space moderators with the permission Space-Resources-Create Edit Delete (simple permission model) or Space-Resource Catalogs-Create Edit Delete (detailed permission model) can manage space-level Resource Catalogs. For information about roles and permissions, see Chapter 20, "Understanding Security."



16.1 What You Should Know About Resource Catalogs

The Resource Catalog is displayed when you edit a page or page template in Composer and click Add Content. You can add resources from the catalog on your page or page template.

As a Spaces user, you can use a Resource Catalog to populate pages in Composer.

As an administrator or delegate, you can also use a Resource Catalog to populate the following artifacts in the Resources Manager:

	
Page templates


	
Task flows




This section provides an overview of Resource Catalogs and explains how to manage them at runtime. It includes the following subsections:

	
Section 16.1.1, "Understanding the Out-of-the-Box Resource Catalogs"


	
Section 16.1.2, "Introducing the Resource Catalog Management Page"


	
Section 16.1.3, "Understanding the Resource Registry"






16.1.1 Understanding the Out-of-the-Box Resource Catalogs

WebCenter Portal: Spaces provides the following out-of-the-box Resource Catalogs:

	
Default Home Space Catalog - The application-level Resource Catalog. You see this catalog when you edit a page or task flow in your Home space.


	
Default Space Catalog - The space-level Resource Catalog. You see this catalog when you populate a page or task flow within a space.


	
Default Page Template Catalog - The catalog used for page template creation in both your Home space and other spaces. You see this catalog when you edit a page template.




This section describes these catalogs. It includes the following subsections:

	
Section 16.1.1.1, "Default Home Space Catalog"


	
Section 16.1.1.2, "Default Space Catalog"


	
Section 16.1.1.3, "Default Page Template Catalog"






16.1.1.1 Default Home Space Catalog

This catalog is displayed when designing pages and task flows in your application. The Default Home Space Catalog (Figure 16-1) contains items that users may typically want to add to a task flow or a business role page, such as page layout components, portlets, and WebCenter Portal services task flows.


Figure 16-1 Resource Catalog Used to Populate Pages

[image: Default Resource Catalog for Pages]
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Table 16-1 provides a description of each folder in the default Resource Catalog.


Table 16-1 Resources in the Default Resource Catalog

	Folder Name	Description
	
Alerts and Updates

	
Includes task flows from the following WebCenter Portal services to track alerts and notifications:

	
Activity Stream, to view activities of your connections, actions taken in spaces, and business activities. For more information, see Chapter 32, "Tracking Your Connections' Activities."


	
Announcements, to view current announcements. For more information, see Chapter 59, "Working with the Announcements Service."


	
Discussion Forums, to list the most frequently used and most recently accessed topics. For more information, see Chapter 60, "Working with the Discussions Service."


	
Documents, to list recently created or modified documents. For more information, see Section 41.1, "What You Should Know About the Documents Service Task Flows."


	
Notifications, to view space- and object-level subscriptions. For more information, see Section 36.5, "Working with Notifications Task Flows."


	
Polls, to view available polls. For more information, see Chapter 67, "Working with the Polls Service."


	
RSS, to view feeds from external sources and WebCenter Portal services. For more information, see Section 68.3, "Working with the RSS Task Flow."


	
Worklist, to view all worklist items that require your attention. For more information, see Chapter 70, "Working with the Worklist Service."





	
Analytics

	
Includes the Analytics service task flows. These task flows help to track and display different metrics, such as response times and usage behavior, for the Spaces application.

For more information, see Chapter 55, "Analyzing Usage and Performance Metrics."


	
Content Management

	
Includes the documents task flows, which can be used to access, add, and manage folders and files, or display content in a predefined template.

For more information, see Part X, "Working with Content".


	
Mash-Ups

	
Includes the following resources that enable you to create business mashups:

	
Data Controls: Folder that includes data controls created for the application at design time and runtime.

For more information about these items, see Chapter 26, "Creating Business Mashups."


	
Task Flows: Folder that includes task flows created in the Resource Manager at runtime. These are visualizations created by gathering data from various data sources and publishing to different layouts such as charts, tables, and graphs.

For more information, see Chapter 26, "Creating Business Mashups."


	
Omniportlet: A portlet to publish data from a variety of data sources (including SQL, XML, web services, spreadsheets, and web pages) to several different layouts, such as customizable charts and tables


	
Pagelet Producers: Folder that includes pagelets deployed in the pagelet producer. For more information, see Section 6.5.2.3, "Registering a Pagelet Producer."





	
Polls and Surveys

	
Includes the Polls service task flows that can be used to create, edit, and take online polls on your application pages. Polls let you survey your audience, check whether they can recall important information, and gather feedback on the efficacy of presentations.

For more information, see Chapter 67, "Working with the Polls Service."


	
Portlets

	
Includes the following resources:

	
Administrator-level tools for registering and managing external applications and portlet producers.


	
Portlets, which provide a means of presenting data from multiple sources in a meaningful and related way. Out-of-the-box, this folder contains the Omniportlet and Web Clipping portlets.




For more information, see Chapter 25, "Understanding Portlet Basics."


	
Social and Communication

	
Includes the following resources to enable social networking and communication among users:

	
Lists folder: Includes individual space lists. The folder is displayed only if it contains resources inside it. For more information about these items, see Chapter 64, "Working with the Lists Service."


	
Message Board - Quick View: WebCenter Portal services task flow used for adding, viewing, updating, hiding, and deleting messages. For more information, see Section 33.4, "Working with Message Board and Feedback Task Flows."


	
Message Board: WebCenter Portal services task flow used for adding, viewing, updating, hiding, deleting, and managing your view of messages.


	
Organization View: WebCenter Portal services task flow used for adding a graphical depiction of the current user's position within the company. which provides quick access to contact and status information about you and your connections.


	
Profile - Snapshot: WebCenter Portal services task flow used for viewing a user photo and status message. For more information, see Chapter 30, "Managing Your Profile."


	
Profile: WebCenter Portal services task flow used for displaying a user's profile details and uploading a photo.


	
Profile Gallery: WebCenter Portal services task flow used for accessing all of your social networking information from one view.


	
Connections: WebCenter Portal services task flow used for viewing and managing your connections, and creating connections lists. For more information, see Section 31.1, "What You Should Know About Connections."


	
Connections - Card: WebCenter Portal services task flow used for photos, status messages, and instant contact options to your connections.


	
Connections - Detailed View: WebCenter Portal services task flow used for photos and quick access to your connections and to features for inviting new connections and organizing your connections into lists.


	
Connections - Quick View: WebCenter Portal services task flow used for photos and quick access to your connections.


	
Recommended Connections: WebCenter Portal services task flow used for viewing and connecting to people considered to be similar to you.


	
Similar Items: WebCenter Portal services task flow used for listing items that are similar to the currently selected item on the page. For more information, see Section 58.2, "Working with Activity Graph Service Task Flows."


	
Mail: WebCenter Portal services task flow used for viewing, responding to, and managing your personal mail. For more information, see Section 65.4, "Working with the Mail Service Task Flow."


	
Watched Topics: WebCenter Portal services task flow used for providing a cohesive view of all the topics you have selected to watch from a particular space or from all spaces. For more information, see Section 60.2, "Working with Discussions Service Task Flows."


	
Watched Forums: WebCenter Portal services task flow used for viewing all discussion forums you have selected to watch from a particular space or from all spaces.


	
Forums: WebCenter Portal services task flow used for viewing Recent Topics, Popular Topics, Watched Topics, and Watched Forums.


	
Events: WebCenter Portal services task flow used for adding calendars that you can use to schedule meetings, appointments, and any other type of occasion. For more information, see Section 61.1, "What You Should Know About the Events Service."


	
Blogs: WebCenter Portal services task flow used to expose a blog on a page along with other services instead of having a dedicated blog page. For more information, see Section 48.4.1, "Creating a Blog Using Blog Task Flows."


	
Publisher: WebCenter Portal services task flow used for publishing messages, files, and URLs to the Activity Streams of all of your connections or to those connections who have access to a specified space. For more information, see Section 34.3.3.1, "What You Should Know About the Publisher Task Flow."





	
Tagging and Searching

	
Includes the following WebCenter Portal services task flows to enable effective search of Oracle WebCenter Portal and other sources:

	
Saved Searches folder: For displaying a list of all searches saved by you or other space members.


	
All Saved Searches: For running saved searches within the application. For more information, see Section 56.3, "Working with the Search Service Task Flows."


	
Similarly Tagged Items: For displaying a list of links to other pages that have at least one tag in common with the currently-displayed page.


	
Tags: For adding a view of the tags you have added to your application and the items you have tagged. For more information, see Section 57.2, "Working with Tags Service Features and Task Flows."


	
Tag Cloud: For displaying the tags currently applied to Spaces items. For more information, see Section 57.2, "Working with Tags Service Features and Task Flows."


	
Tag Cloud Related Resources: For displaying related resources for a selected tag. For more information, see Section 57.2, "Working with Tags Service Features and Task Flows."





	
Web Development

	
Includes the following components that you can use to design your pages:

	
Data Controls: Includes data controls created for the application at runtime.

For more information, see Chapter 26, "Creating Business Mashups."


	
Layout components such as Box, HTML Markup, Hyperlink, Image, Movable Box, Separator, Text, and Web Page.

For more information about these components, see Chapter 18, "Adding and Configuring Page Layout Components."














	
Note:

WebCenter Portal service task flows added from the Resource Catalog do not have a fixed height; they take the height of the content in the task flow.







With the default Spaces configuration, this Resource Catalog is displayed when you create pages at the application level.

When creating pages in a space, the Default Space Catalog is displayed. This catalog is similar to the Default Home Space Catalog, except that its resources display content specific to the space, where applicable.






16.1.1.2 Default Space Catalog

The Default Space Catalog is the same as the Default Home Space Catalog, except for a few resources that display data relevant to the current space, for example, the Personal Documents folder, which displays documents associated with the current space. Table 16-2 describes the resources that are exclusive to the Default Space Catalog.


Table 16-2 Resources that Are Exclusive to the Default Space Catalog

	Resource or Folder Name	Description
	
Similar Spaces

	
This resource in the Social and Communication folder displays all spaces that are similar to the one you are currently viewing. For more information, see Section 58.2.3, "Working with the Similar Spaces Task Flow."


	
Lists folder

	
This resource in the Social and Communication folder enables you to add lists to pages in your space. Lists are useful for many space activities, such as tracking issues, capturing project milestones, publishing project assignments, and much more. However, the Lists service is not available to the Home space. For more information, see Chapter 64, "Working with the Lists Service."


	
Members

	
This resource in the Social and Communication folder lists all members in the space. For more information, see Section 52.4, "Working with the Members Task Flow."


	
Spaces documents

	
This resource from the Content Management folder exposes a list of folders and files associated with the current space. For more information, see Section 39.2, "What You Should Know About Content Management Selections in the Resource Catalog."












16.1.1.3 Default Page Template Catalog

This catalog is displayed when designing page templates. A page template defines the layout of your portal. It defines the location of content on the page and contains artifacts that display on each page of the portal; for example, a navigation pane to the left of the page, a header or banner with the company logo at the top, and a copyright notice at the bottom of the page. When you build a page template, you should be able to add all such components to it. To address this requirement, Spaces provides the Default Page Template Catalog to be used for page template creation. For more information about page templates, see Chapter 12, "Working with Page Templates."

In addition to all the folders available in the Default Home Space Catalog (Table 16-1), the Default Page Template Catalog also includes the Template Development folder. This folder includes a Navigations folder and all the resources that are typically used in page templates only, for example logos, navigation components, navigation models, layout components, and copyright statements.

The Navigations subfolder includes three navigation task flows. You can add these task flows, described as follows, to page templates to quickly visualize your portal navigation model:

	
Navigation Breadcrumb, to display a series of horizontal or vertical links that show users their current position in the navigation hierarchy.


	
Navigation Menu, to display navigational links as a series of tabs, menus, bars, buttons, choices, or as a list.


	
Navigation Tree, to display navigational links in a hierarchical structure.




For information about navigation structures, see Chapter 11, "Working with Navigation."

For information about the other resources in the Template Development folder, see Chapter 13, "Adding Spaces Components to Your Templates."








16.1.2 Introducing the Resource Catalog Management Page

If the default catalogs provided in Spaces do not meet your company's requirements, you can create custom Resource Catalogs and offer those to users. The Resource Manager, shown in Figure 16-2, provides options to create and manage custom Resource Catalogs.

Only users with permissions to create, edit, and delete Resource Catalogs can access the Resource Manager.


Figure 16-2 Resource Catalogs Page in the Resource Manager

[image: Resource Catalogs Page in the Resource Manager]
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On this page, you can create, copy, publish, edit, preview, and delete Resource Catalogs. When you publish a custom Resource Catalog, it is available for selection on the application's Configuration page or a space's administration settings.






16.1.3 Understanding the Resource Registry

The Resource Registry is a central repository of all the resources available to the Spaces application. It contains all resources that you can add to Resource Catalogs in the application. In addition to the out-of-the-box resources, it is also updated dynamically to include new resources, such as task flows, data controls, and navigations, as and when they are created in the Resource Manager or deployed as shared libraries from JDeveloper. As a result, a resource that is created and published in the Resource Manager is available for consumption right away.

The Resource Registry (Figure 16-4) is displayed when you click the Add From Library option (Figure 16-3) in the Edit dialog for a Resource Catalog.


Figure 16-3 Add From Library Option to Access the Resource Registry

[image: Add From Library Option in the Resource Catalog Editor]
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Figure 16-4 Add Resource Catalog Item Dialog (Resource Registry)

[image: Add Resource Catalog Item Dialog]
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Table 16-3 describes the folders in the Resource Registry.


Table 16-3 Folders in the Resource Registry

	Resource Folder	Description
	
Runtime DataControls

	
Lists all data controls created at runtime. When you add these data controls in a Resource Catalog, you enable users to consume them in pages or task flows using different visualizations such as tables, graphs, buttons, and so on.

For more information, see Section 26.2, "Creating and Managing Data Controls."

This folder is empty if there are no runtime data controls in your Spaces instance.


	
Design Time DataControls

	
Lists all data controls deployed from JDeveloper. At a minimum, it displays the WebCenter Portal services data controls that are available out-of-the-box. In addition, it also displays data controls that an application developer may have created in JDeveloper and deployed to Spaces.

For information about the data controls available for a WebCenter Portal service, refer to the chapter describing that service.


	
Business Mashups

	
Lists the task flows created at runtime in the Resources Manager. For more information, see Section 26.3, "Creating and Managing Task Flows."

This folder is empty if there are no runtime task flows in your Spaces instance.


	
Spaces Components

	
Lists components, such as menus, links, copyright message, and so on, that are typically used in page templates. These resources are available out-of-the-box in the Default Page Template Catalog, in a folder named Template Development.

For more information, see Chapter 13, "Adding Spaces Components to Your Templates."


	
Components

	
Lists a selection of layout components that you can use to design pages, templates, and task flows. For more information, see Chapter 18, "Adding and Configuring Page Layout Components."


	
All Documents

	
Lists all documents that you have access to. For more information, see Part X, "Working with Content".


	
Portlet Producers

	
Lists all registered portlet producers. For more information, see Chapter 25, "Understanding Portlet Basics."


	
Connections

	
Lists all available repository connections. Many resources, such as portlets, external applications, and some WebCenter Portal services, require a connection to a database schema where relevant information is stored.

The chapters describing the various resources and services provide information about whether a connection is required for that resource or service.


	
Task Flows

	
Lists all task flows deployed from JDeveloper. At a minimum, it displays the WebCenter Portal services task flows that are available out-of-the-box. In addition, it also displays task flows that an application developer may have created in JDeveloper and deployed to Spaces.

For information about the task flows available for a resource or WebCenter Portal service, refer to the chapter describing that service or resource.


	
Resource Catalogs

	
Lists all available Resource Catalogs. You can embed multiple Resource Catalogs inside a catalog.


	
Navigations

	
Lists all available navigations. These resources are available out-of-the-box in the Default Page Template Catalog. For more information, see Chapter 11, "Working with Navigation."


	
Lists

	
Displays all the lists created using the Lists service. For more information, see Chapter 64, "Working with the Lists Service."


	
Saved Searches

	
Displays all saved searches. For more information, see Chapter 56, "Working with the Search Service."


	
Analytics

	
Displays all the Analytics service task flows. These task flows help to track and display different metrics, such as response times and usage behavior, for the Spaces application. For more information, see Chapter 55, "Analyzing Usage and Performance Metrics."














16.2 Creating Resource Catalogs

You can build a custom Resource Catalog either from scratch or by extending an existing Resource Catalog. Creating a Resource Catalog follows the same procedure as any other resource. For information about creating a Resource Catalog, see Section 10.2, "Creating Resources." For information about copying an existing Resource Catalog, see Section 10.4.1, "Copying a Resource."

The new Resource Catalog is listed on the Resources - Resource Catalogs page. However, the catalog is hidden by default. To make the new Resource Catalog available to the application or space, you must do the following:

	
Publish it in the Resource Manager. For more information, see Section 16.4, "Showing and Hiding a Resource Catalog."


	
Configure the application or space to use the new catalog as the default one. For more information, see Section 16.10, "Configuring Resource Catalogs in Your Application."









16.3 Editing a Resource Catalog

When you edit a Resource Catalog in the Resource Manager, you are basically managing its resources. The Resource Manager provides the following two options for editing Resource Catalogs:

	
Managing resources in the Edit dialog.


	
Editing the source code of the Resource Catalog definition file in a text editor.




This section explains both options. It includes the following sections:

	
Section 16.3.1, "Managing Resources in the Edit Dialog"


	
Section 16.3.2, "Editing the Source Code for a Resource Catalog"







	
Note:

To perform certain advanced editing tasks, you may want to download the Resource Catalog to JDeveloper, edit it, and upload it back to your Spaces instance. For more information, see Section 16.9, "Using JDeveloper to Build Your Resource Catalog."









16.3.1 Managing Resources in the Edit Dialog

The Edit option in the Resource Manager opens an Edit dialog (Figure 16-5), which provides various options to manage resources in the selected Resource Catalog.




	
Note:

You cannot edit out-of-the-box catalogs. The Edit option on these catalogs is grayed out.








Figure 16-5 Edit Dialog Used to Edit a Resource Catalog
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You can edit a Resource Catalog to:

	
Create folders


	
Create custom components by providing the XML code


	
Add resources from the Resource Registry


	
Edit resource properties


	
Copy resources


	
Delete resources


	
Rearrange resources


	
Preview the catalog




This section describes the steps to perform these tasks. It includes the following subsections:

	
Section 16.3.1.1, "Creating a Folder"


	
Section 16.3.1.2, "Adding Resources"


	
Section 16.3.1.3, "Creating Custom Components"


	
Section 16.3.1.4, "Rearranging Resources"


	
Section 16.3.1.5, "Setting Properties on a Resource"


	
Section 16.3.1.6, "Copying a Resource"


	
Section 16.3.1.7, "Deleting a Resource"


	
Section 16.3.1.8, "Previewing the Resource Catalog"






16.3.1.1 Creating a Folder

To organize your catalog better, you can group similar resources together; for example, group all layout components or all resources from a particular service.

To add a folder to a catalog:

	
Select the catalog in the Resource Manager and from the Edit menu, select Edit.


	
In the Edit dialog, from the Add menu, select Folder.

The Edit Resource Catalog Item dialog displays with two tabs, Target and Options. The Target tab is selected by default.


	
On the Target tab, specify a name and description for the folder, and leave the Visible option checked to ensure that the folder is displayed in the catalog.


	
Optionally, use the Options tab to define display options for the folder. For more information, see Section 16.3.1.5, "Setting Properties on a Resource."


	
Click OK.

You can now add resources inside this folder, or move resources inside it by dragging and dropping them from the top level folder.









16.3.1.2 Adding Resources

This section describes how to populate your catalog using the Resource Registry. For more information, see Section 16.1.3, "Understanding the Resource Registry."

To add a resource:

	
Select the Resource Catalog in the Resource Manager and from the Edit menu, select Edit.


	
If you have created folders (see Section 16.3.1.1, "Creating a Folder") and want to add resources inside a particular folder, then select the folder in the Edit dialog.


	
From the Add menu, select Add From Library.


	
In the Add Resource Catalog Item dialog (Figure 16-4), select a folder name in the left pane to display its contents in the right pane, or search for a resource by specifying its name in the Search field.

For a description of the available resources, see Section 16.1.3, "Understanding the Resource Registry."


	
Select a resource.




	
Tip:

You can select multiple resources using the standard shortcut keys for selection.








	
Optionally, in the Name field, specify a different name for the resource, if required. You can skip this step to retain the default resource name.




	
Note:

If you selected multiple resources at a time, you cannot rename them at this point. However, you can edit them after adding them to the catalog. For more information, see Section 16.3.1.5, "Setting Properties on a Resource."








	
Click Add.




	
Notes:

	
The Runtime DataControls folder lists the available data controls. You can expand a data control node to display its accessors and methods. However, you can only add the data control as a whole. Adding its accessors, methods, or attributes separately is not supported. You may see catalog errors if you try to add these objects.


	
Avoid adding a data control more than once in a catalog. The data control is added to the catalog as many times, but when you use the catalog to populate a page or task flow, you will not be able to add accessors, methods, or attributes from such data control instances.


	
The Design-Time DataControls folder lists all the WebCenter Portal services data controls. However, adding the ConnectionsNetworkDC and KudosServiceDC data controls at runtime is not supported. Avoid adding these data controls to your page or task flow.













	
Repeat the previous four steps to add more resources from the available folders.


	
Click OK in the Edit dialog.









16.3.1.3 Creating Custom Components

The Resource Registry in Spaces provides a large repository of resources that you can add to a catalog. However, if this is not sufficient and your business requires you to add other resources, such as ADF Faces components, custom JSPX, or raw HTML, you can create a custom component and specify the XML code for the component. Using a custom component is the only way to make such components available to a page in Composer.

You may want to create a custom component for the following purposes:

	
Create seeded layouts that can be added to a page. You can add a layout component and include a combination of design and container components inside it. The container components provide empty content areas that can be filled later.


	
Add external content by including the raw HTML code.


	
Define seeded layouts in which to consume data controls. You can then bind the data control to the layout.




To create a custom component:

	
Select the catalog in the Resource Manager and from the Edit menu, select Edit.


	
If you have created folders and want to add resources inside a particular folder, select the folder in the Edit dialog.


	
From the Add menu, select Component.


	
In the Edit Resource Catalog Item dialog, on the Target tab, specify a name and description for the new resource, and leave the Visible option checked to ensure that the resource is displayed in the catalog.


	
In the XML text area, enter the XML code for the component.

The following are a few examples of custom components:

	
Output Text component:


<af:outputText xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 
                 value="Weather Foercast for the Day" id="#"/>


	
Custom navigation:



<af:forEach xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 
            var="level_1_menu"
             items="#{SiteStructureContext.defaultSiteStructure.listModel['startNode=/, includeStartNode=false']}">
<af:outputText id="#" 
               xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 
               value="#{level_1_menu.title}"/>
</af:forEach>


	
External HTML content:



<f:verbatim xmlns:f="http://java.sun.com/jsf/core">
  <![CDATA[
    <object width="640" height="385">
      <param name="movie" value="http://www.youtube.com/v/KO2ti-B00gw&hl=en_US&fs=1">
      </param>
      <param name="allowFullScreen" value="true">
      </param>
      <param name="allowscriptaccess" value="always">
      </param>
      <embed src="http://www.youtube.com/v/KO2ti-B00gw&hl=en_US&fs=1" 
             type="application/x-shockwave-flash" allowscriptaccess="always" 
             allowfullscreen="true" width="640" height="385">
      </embed>
    </object>]]>
</f:verbatim>


An alternative to this is to create a new task flow in the Resource Manager and add an HTML Markup component inside it.





	
Optionally, use the Options tab to define display options for the folder. For more information, see Section 16.3.1.5, "Setting Properties on a Resource."


	
Click OK.









16.3.1.4 Rearranging Resources

To move a resource within a folder, select the resource and click the Move Up or Move Down icon, shown in Figure 16-6, as many times as necessary until the resource is in the desired location.


Figure 16-6 Up and Down Icons in the Edit Dialog

[image: Up and Down icons in the Edit dialog]






	
Tip:

You can also reorder resources in a folder by dragging and dropping them at a different position.







To indent one resource (child item) under a folder (parent item), move the child item so that it is immediately below the parent item, select the child item and click the Indent icon. The Indent button is grayed out if there is no folder above the selected resource.

To move an indented resource so that it is no longer indented below a folder, select the resource and click the Outdent icon.






16.3.1.5 Setting Properties on a Resource

You can edit properties on a resource to set the resource name and description, the icon to be associated with the resource, and to add new properties.

To edit resource properties:

	
Select the catalog in the Resource Manager and from the Edit menu, select Edit.


	
If the resource you want to edit is inside a folder in the catalog, expand the folder and select the resource.


	
Click Edit.


	
In the Edit Resource Catalog Item dialog, on the Target tab (Figure 16-7), define the following attributes:




	
Note:

Each type of resource has different properties associated with it. The Name, Description, and Visible properties are common to all resources in a catalog. However, you may see all or some of the other attributes depending on the type of resource you are editing.








Figure 16-7 Target Tab on the Edit Resource Catalog Item Dialog

[image: Target Tab on the Edit Resource Catalog Item Dialog]

Description of "Figure 16-7 Target Tab on the Edit Resource Catalog Item Dialog"





	
Name: Name used for the resource in the catalog.


	
Description: A short description that appears below the resource name in the catalog.


	
Visible: Whether the resource must be rendered in the catalog. This field takes true or false values, or an EL value that can be specified using the Expression Builder option on the dropdown menu.


	
Path: The URL to access the resource. This field is displayed only for resources of type Link. The URL format is different for the different link types. Table 16-4 describes the supported URL formats.


Table 16-4 URL Format for the Different Resource Types

	Resource Type	URL Format
	
Task Flow

	

taskflow://Path_to_Task_Flow/Task_Flow_Definition_File_Name#Task_Flow_ID


	
Portlet

	

portlet://Producer_ID/Portlet_ID


	
Content

	

content://Content_Connection_ID/Document_ID








	
Repository: The name of the connection used to lookup the resource. This field is displayed only for resources that require a repository connection, for example, portlets.


	
Include Catalog: Select the catalog that you want to nest within the catalog. Contents from the catalog you select here are included directly under the catalog.

This field is displayed only when you select a nested catalog.


	
Hide Top-Level Folder: Select to include contents from the selected folder directly under the parent folder; for example, if you select this option for the Data Controls folder, then any data controls created at runtime are displayed directly under Mash-Ups. The Data Controls folder is not displayed. You can preview the catalog to see this change.

This field is displayed only for custom folders that are populated dynamically at runtime.


	
Factory Class: The factory class used to create the folder. This field is displayed only for custom folders that are populated dynamically at runtime.

The factory classes for the folders available in the default catalog are as follows:

	
Task flow: oracle.webcenter.portalframework.sitestructure.rc.TaskFlowResourceFactory


	
Portlet: oracle.webcenter.portalframework.sitestructure.rc.PortletResourceFactory


	
Content: oracle.webcenter.content.model.rc.ContentUrlResourceFactory


	
Data control: oracle.webcenter.datacomposer.internal.adapter.datacontrol.DataControlContextFactory








	
Click the Options tab, shown in Figure 16-8, to define display options for the resource.

You can use this tab to assign attributes to the resource. You can assign any arbitrary attribute to a resource. The tab displays standard attributes such as icon and subject and keywords. In addition to these, you can add you own attributes, which can then be used by the drop handlers registered with Composer in Oracle WebCenter Portal. For example, you can add attr.* and parameter.* attributes for task flows because their drop handler recognizes them.


Figure 16-8 Options Tab on the Edit Resource Catalog Item Dialog

[image: Options Tab on the Edit Resource Catalog Item Dialog]

Description of "Figure 16-8 Options Tab on the Edit Resource Catalog Item Dialog"





The fields on the Options tab can be described as follows:

	
Subject and Keywords: Keywords to facilitate keyword searching of the Resource Catalog.


	
attr.ATTRIBUTE_NAME: These are attributes that were explicitly defined on the resource at design time. This field is displayed only for portlets and task flows, which display a chrome around them when consumed in a page. This field is used to set an initial value for an attribute on the task flow or portlet. When the task flow or portlet is consumed in a page, this attribute is exposed along with the enclosing chrome's attributes; for example, attr.text defines the default title for the task flow or portlet and attr.contentStyle defines the CSS style to be applied. This attribute is not exposed on the chrome if you do not set an initial value for it.


	
parameter.PARAMETER_NAME: These are parameters that were explicitly defined on the resource at design time. This field is displayed only for task flows, which are wrapped in a Show Detail Frame or Movable Box component when consumed in a page. This field is used to set an initial value for a task flow parameter. When the task flow is consumed in a page, this parameter is exposed along with the enclosing Show Detail Frame or Movable Box component's properties. This parameter is not exposed on the chrome if you do not set an initial value for it.


	
New Attribute Name: Select one of the following attributes from the dropdown menu:

Tool Tip: Use to specify the tool tip to be displayed when you move the mouse over this resource name in the catalog.

Large Icon URI: Use to specify the path to the icon to be used for the resource.


	
New Attribute Value: Specify a value for the selected attribute.




The new attribute is displayed on the Options tab along with the existing properties.


	
Click the Parameters tab to define parameter values for resources that support wiring, for example, portlets and task flows. For details about supported parameters for a resource, refer to the documentation for that resource.









16.3.1.6 Copying a Resource

You can create a copy of an existing resource and modify it.

To copy a resource, select it in the catalog and click Copy. A copy of the resource is placed just below it in the resource hierarchy. You can select the copy and alter its attributes and parameters.






16.3.1.7 Deleting a Resource

You can delete resources from any custom Resource Catalog.

To delete a resource:

	
Select a resource and click Delete.


	
In the Delete dialog, click Delete to confirm deletion.









16.3.1.8 Previewing the Resource Catalog

Click the Preview tab in the Edit dialog to see how the Resource Catalog appears to users. The preview shows the order in which the resources will be displayed. It also shows how dynamic folders are executed.








16.3.2 Editing the Source Code for a Resource Catalog

The Resource Manager provides the Edit Source option for editing the source code of the catalog definition file. You may want to edit a Resource Catalog's source file to make advanced edits to its code without having to download the file, edit it in JDeveloper, and upload it back into Spaces:

To edit a Resource Catalog's source files:

	
Select the Resource Catalog in the Resource Manager and from the Edit menu, select Edit Source.

A simple Edit Source dialog displays the catalog definition.


	
Edit the catalog definition source code as required.

The format of the code is validated and an error message is displayed if you miss any tags or add them incorrectly. For information about the correct format for catalog definition elements, see "Resource Catalog Properties and Files" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
Click OK.











16.4 Showing and Hiding a Resource Catalog

When you create a Resource Catalog, by default it is hidden. A hidden Resource Catalog is not available for use in the application, the Home space, or any other space. To publish a Resource Catalog, it must be marked as shown. Further, for a Resource Catalog created at the application level, you can control whether it is available to any, all, or selected spaces in the application.

For generic information about hiding and showing resources, see Section 10.4.3, "Showing and Hiding Resources."

For generic information about resource availability in spaces, see Section 10.4.2, "Setting Properties on a Resource."






16.5 Setting Properties on a Resource Catalog

You can control a Resource Catalog's display attributes and availability by setting the catalog's properties in the Edit Properties dialog. Setting Resource Catalog properties follows the same procedure as any other resource. For more information, see Section 10.4.2, "Setting Properties on a Resource."






16.6 Setting Security on a Resource Catalog

You can control whether all users or only specific users or groups can access the custom Resource Catalogs that you created in the application. Setting access to a Resource Catalog follows the same procedure as any other resource. For more information, see Section 10.4.4, "Setting Security for a Resource."






16.7 Copying a Resource Catalog

You can make a copy of a Resource Catalog by selecting it and choosing Copy from the Edit menu on the Resources - Resource Catalogs page. Copying a Resource Catalog follows the same procedure as any other resource. For the generic procedure, see Section 10.4.1, "Copying a Resource."






16.8 Deleting a Resource Catalog

You can delete custom Resource Catalogs created at runtime and those that you imported into your application. Deleting a Resource Catalog follows the same procedure as any other resource. For the generic procedure, see Section 10.4.5, "Deleting a Resource."






16.9 Using JDeveloper to Build Your Resource Catalog

You may want to create a Resource Catalog that is beyond the editing capabilites of WebCenter Portal: Spaces, or you may prefer working in JDeveloper. To do this, you have several options:

	
Use the Edit Source option to edit the source code of the catalog definition file. You can edit the source code directly in the Edit Source dialog or you can copy the contents of the dialog to JDeveloper for editing and then copy the edited code back into the dialog. For more information, see Section 16.3.2, "Editing the Source Code for a Resource Catalog."


	
Download an existing Spaces Resource Catalog, import it into JDeveloper, for editing, and then upload it back to Spaces.


	
Create a completely new Resource Catalog in JDeveloper and upload it to Spaces.




The steps to upload and download a Resource Catalog from Spaces are described in Section 10.5.2, "Downloading a Resource"and Section 10.5.3, "Uploading a Resource."

Oracle provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) for developing Spaces resources, including Resource Catalogs. The workspace offers a design environment in which to create and edit your catalogs, and also enables you to upload them to Spaces for testing. For more information and to download the JDeveloper workspace, see "Developing Spaces Resources" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.




	
Note:

When editing a catalog in JDeveloper, if you add a custom resource such as a task flow, you must also deploy the resource to Spaces as a shared library. For more information, see "Deploying Your Own Custom Code and Task Flows in Shared Libraries" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.







For information about editing a catalog in design time, see the chapter titled "Creating and Managing Resource Catalogs" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.






16.10 Configuring Resource Catalogs in Your Application

Out of the box, your Spaces application is configured with catalogs to be used at the application level. Resource Catalogs are configured for page and page template creation, and for business role page creation. If you want to use custom catalogs in place of the default ones, perform the steps in Section 16.10.1, "Configuring the Application-Level Resource Catalog."

Resource Catalogs are not configured by default at the space level. You can configure the catalogs to be used for page creation and page template creation within a space by performing the steps in Section 16.10.2, "Configuring the Space-Level Resource Catalog."




	
See Also:

Section 5.10, "Choosing Default Resource Catalogs"









16.10.1 Configuring the Application-Level Resource Catalog

From your Home space, click the Administration link at the top of the page, then click the Configurations tab. The Resources section on the Configuration page, shown in Figure 16-9, displays information about the default catalogs used at different levels in the application. Select a catalog of your choice in each field.

Out-of-the-box, Spaces is configured to use the following catalogs:

	
Default Home Space Catalog for Home space pages and Business Role pages.


	
Default Page Template Catalog for page templates in your Home space and other spaces.


	
Default Space Catalog for pages in a space.





Figure 16-9 Default Resource Catalog Configurations at Different Levels in the Application

[image: Application-Level Resource Catalog Configuration]
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16.10.2 Configuring the Space-Level Resource Catalog

By default, the Resource Catalogs for pages and the page templates in a space are inherited from the application-level settings. You can change the Resource Catalogs for a space in the space administration settings. For more information, see Section 51.4.11, "Changing the Resource Catalogs for Pages and the Page Template for a Space."











Part V


Building and Wiring Pages

Part V of the User's Guide provides information about creating pages; working with a page's underlying structure using layout components; and wiring pages, task flows, portlets, and UI components together.

Part V includes the following chapters:

	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components"










17 Building Pages

No matter how you structure your portal, there is always a need for new pages in addition to those that are available out of the box. WebCenter Portal: Spaces provides a variety of prebuilt page styles to simplify page creation. It also offers an embedded page editor for in-place page revision and easy content placement.

This chapter describes how to create, edit, populate, and delete Spaces application pages. It includes the following sections:

	
Section 17.1, "What You Should Know About Pages"


	
Section 17.2, "Creating Pages"


	
Section 17.3, "Editing Pages"


	
Section 17.4, "Personalizing Pages"


	
Section 17.5, "Adding Resource Catalog Components to Pages"


	
Section 17.6, "Deleting Pages"





Audience

This chapter is intended for users with the space-level permission Basic Services: Edit Page Access, Structure, and Content. The users with this permission are typically tasked with creating and editing pages, revising page properties, adding page content, and deleting pages from a space.



17.1 What You Should Know About Pages

The Spaces application provides a variety of page types to suit the requirements of your portal. Some pages are seeded, such as system pages. These offer a ready set of editable, utilitarian pages, such as the Login page and the Self Registration page. System pages are prepopulated with relevant input fields and boilerplate text (for more information about system pages, see Section 7.3, "Working with System Pages").

Another page type, the business role page, can be populated with information of relevance to a particular business role, such as salesperson, accountant, or marketing associate, and then pushed into the Home space views of all users who are assigned that role (for more information about business role pages, see Section 7.1, "Working with Business Role Pages").

Personal pages are the pages users create for themselves in their views of the Home space (for more information about personal pages, see Section 7.2, "Working with Personal Pages," and Chapter 38, "Creating and Managing Personal Pages").

This chapter covers information about pages that are designed to contribute to the knowledge base of the portal. Such pages provide greater flexibility than seeded pages (such as system pages and business role pages), in that you have more control over their content and their availability. You can control user access to such pages and change their properties.

The Spaces application also provides a variety of page layouts (called styles) that you can use to create different types of pages with different layouts. A page style may restrict the type of content that you can add to a page, such as web content only, wiki only, blog only, and the like. Page styles also provide layout information that defines the number of columns and content areas on a page. Layouts are initially determined by the style you select when you create the page. Most page styles produce pages with features that enable recrafting the layout through page parameters or page layout tools (for example, Add Tab and Add Box icons). Web Page and Wiki page styles are the exceptions: the default Wiki page style provides neither parameters nor page layout tools; the default Web Page style provides no page layout parameters, but it does include page layout tools in edit page mode. For more information about page styles, see Chapter 15, "Working with Page Styles."

In addition to the preseeded layouts available through page styles, you can create your own layouts using the layout components available through the Resource Catalog. This chapter provides an overview of that process. For detailed information about the layout components themselves, see Chapter 18, "Adding and Configuring Page Layout Components."






17.2 Creating Pages

To create a page in a space:




	
See Also:

For information about creating pages in the Home space, see Chapter 38, "Creating and Managing Personal Pages."







	
Navigate to the space of interest, and open the Create dialog (Figure 17-1).


Figure 17-1 Create Dialog

[image: a Create Page dialog]

Description of "Figure 17-1 Create Dialog"








	
Note:

Portal administrators can control the options that appear in the Create dialog. So, your view may differ from that depicted in Figure 17-1. For more information, see Section 15.4.1, "Showing and Hiding a Page Style in the Create Dialog."








	
Provide a name for the page, select a page style, and click Create.




	
Note:

For wiki pages, you must not use the following characters in the page name:

? \ / : [ ] * ' " |


For wiki names, you can use letters, numbers, character spaces, and periods (.).












	
See Also:

For information about page styles, see Chapter 15, "Working with Page Styles."







The new page opens in page edit mode (Composer).







	
See Also:

The next step you take depends on what you want to accomplish:
For information about adding content to a page, see one of the following topics:

	
Section 17.5, "Adding Resource Catalog Components to Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Chapter 13, "Adding Spaces Components to Your Templates"




For information about defining who can access the page, see Chapter 23, "Securing Pages and Components."














17.3 Editing Pages

One of the most powerful offerings in a Spaces application is the ability to add and edit page content at application runtime. This capability is delivered through Composer, a fully-integrated page editor for revising the properties, layout, and content of application pages.

Use Composer to change a page layout; add task flows, portlets, documents, layout components, and other objects to a page; to provide values for the properties associated with pages and the objects they contain; and to wire pages, task flows, and portlets to each other.

This section provides an overview of Composer and describes how to perform basic editorial tasks, such as entering and exiting page edit mode, accessing page properties, and the like.

This section includes the following subsections:

	
Section 17.3.1, "Entering and Exiting Page Edit Mode"


	
Section 17.3.2, "Introducing Design View and Source View"


	
Section 17.3.3, "Accessing Portal Resources"


	
Section 17.3.4, "Providing Page Background Color, Image, and CSS Encoding"


	
Section 17.3.5, "Changing the Page Layout"







	
See Also:

Additional tasks that you perform in page edit mode are discussed more thoroughly in their own sections and chapters. These include the following:
	
Section 17.5, "Adding Resource Catalog Components to Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components"














17.3.1 Entering and Exiting Page Edit Mode

When you enter page edit mode, you are opening the page in the Spaces application page editor, Composer. This section describes how to open a page for editing in Composer and how to exit Composer.




	
Note:

When you encounter errors in page edit mode in Spaces applications where the sandbox is enabled, you can recover by closing your browser and then reopening it and relogging in to the application instance.







To enter and exit Composer:

	
Log in, and go to the page you want to edit.


	
Enter page edit mode (Figure 17-2).




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








Figure 17-2 Example of a Page in Edit Mode

[image: Example of a page in edit mode]

Description of "Figure 17-2 Example of a Page in Edit Mode"





	
Edit the page.


	
Click the Save button to save your changes and remain in Composer.


	
Click the Close button to exit Composer.





A Few Notes About Concurrent Users

Because users access the Spaces application from the Web, multiple users may attempt to edit the same page at the same time. In such cases, a concurrency warning appears in Composer that alerts each user to the others (Figure 17-3).


Figure 17-3 A Concurrency Warning in Composer

[image: Concurrency warning in Oracle Composer]

Description of "Figure 17-3 A Concurrency Warning in Composer"





The final state of the page is determined by the last user to save. That is, the last changes saved overwrite the changes made by other concurrent users.




	
Tip:

Time duration is added to the concurrency message only when the first or a subsequent concurrent user has made (but not yet saved) a page customization.







The Spaces application does not support single-user concurrency. That is, one user cannot create multiple, simultaneous application sessions.

Because concurrent page editing by multiple users is supported, there may be occasions when one user deletes a page that another user is editing. In such cases, the user performing the edits sees an error message with each action. For example, a message saying the user does not have permission to edit the page may appear. When the user tries to save changes, a Page Not Found error appears with a link redirecting the user to the Home page. The error message may differ, depending on whether the user is editing a page in a space or the Home space.

If you view a page while another user is editing it, you may not immediately see the results of those edits in your session. To reliably see any changes, view the page after the other user has saved.

If you revise a component in page view mode while another user deletes the same component in page edit mode, an error page opens. Simply navigate back to the original page. The deleted component does not appear, and you can continue working on other components.






17.3.2 Introducing Design View and Source View

Composer provides two views for working with page content: Design view and Source view. To open either of these views, enter Composer, and select Source or Design from the View menu (Figure 17-4).


Figure 17-4 View Menu in Composer

[image: View menu in Oracle Composer]

Description of "Figure 17-4 View Menu in Composer"





Design view provides a WYSIWYG rendering of the page and its content, where controls are directly selectable on each component (Figure 17-5).


Figure 17-5 Design View of Page Edit Mode

[image: Design view of page edit mode]

Description of "Figure 17-5 Design View of Page Edit Mode"





Source view provides a combined WYSIWYG and hierarchical rendering of page components, where controls are available on the header of the hierarchical list (Figure 17-6)


Figure 17-6 Source View of Page Edit Mode

[image: Source view of page edit mode]

Description of "Figure 17-6 Source View of Page Edit Mode"








	
Tip:

In Source view, controls on individual components are inactive, but you can click an individual component to select it.







The Source position option on the View menu is available for specifying whether the page source is presented on the top, bottom, left, or right of the WYSIWYG portion of the page. The Source position option is active when the page is open in Source view (Figure 17-7).


Figure 17-7 Source Position Options on View Menu in Page Edit Mode

[image: Source position options on View menu]

Description of "Figure 17-7 Source Position Options on View Menu in Page Edit Mode"





Source view additionally provides access to page layout components that are otherwise not exposed on the page (for examples, see Section 18.2.10, "Working with Internal Layout Components"). Source view enables the selection and configuration of such components. Select a component on the hierarchical list to also select it on the page. Component selection is indicated by an outline. Access the selected component's properties by clicking the Show the properties of component name icon on the Source view header (Figure 17-8).


Figure 17-8 Show the Properties of Everyone Icon

[image: Show the properties icon]

Description of "Figure 17-8 Show the Properties of Everyone Icon"





You can also select components in Source view by clicking them directly on the page. In Source view, your mouse cursor changes to a magnifying glass when you move it over a selectable component (Figure 17-9).


Figure 17-9 Mouse Cursor as Magnifying Glass

[image: Mouse cursor as magnifying glass]

Description of "Figure 17-9 Mouse Cursor as Magnifying Glass"








	
Tip:

If you reset the page while in Source view, the selection cursor (the magnifying glass) goes away. To get it back, simply click a component on the hierarchical list of components.












17.3.3 Accessing Portal Resources

When you want to add components to a page, you do so through the Resource Catalog. The catalog is a gateway to a wide range of task flows, portlets, layout components, and other types of resources (Figure 17-10).


Figure 17-10 Resource Catalog
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Description of "Figure 17-10 Resource Catalog"





Authorized users can create custom Resource Catalogs and add any variety of the available resources. This means the content of a given Resource Catalog is dependent on the person who designed the catalog.

In Design view of page edit mode, open the catalog by clicking the Add Content button on the region where you want to add content (Figure 17-11).


Figure 17-11 Add Content in Design View of Page Edit Mode

[image: Add Content button in Design view]

Description of "Figure 17-11 Add Content in Design View of Page Edit Mode"





In Source view of page edit mode, open the catalog by selecting the component into which to add content, and clicking the Add Content button (Figure 17-12)


Figure 17-12 Add Content in Source View of Page Edit Mode

[image: Add Content in Source view]

Description of "Figure 17-12 Add Content in Source View of Page Edit Mode"





The content of the catalog is determined by the application administrator or the users to whom the administrator has delegated this task. Different catalogs are available in different venues. For example, the Resource Catalog available to the Home space is likely very different from a Resource Catalog that is available to a space. Users who create Page Templates have access to components that are not available in the catalogs shown in either a space or the Home space. For more information, see Chapter 13, "Adding Spaces Components to Your Templates."

The catalog is organized into components and folders. Some components are readily available at the top level of the catalog. Other components are organized into folders and subfolders, which you can drill into. You can distinguish between the two by noting whether a listing has an Open or Add link next to it (Figure 17-13).


Figure 17-13 Open and Add Links in a Resource Catalog
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Description of "Figure 17-13 Open and Add Links in a Resource Catalog"





When a component has both Open and Add links next to it, it means you can place that component on a page or place a subset of that component on a page. For example, as shown in Figure 17-13, The Personal Documents component can be placed on a page (it will show a list of all the documents in that folder); or you can open it and select to add a file from Personal Documents to the page.

Navigate the Resource Catalog hierarchy using the Up icon (Figure 17-14)


Figure 17-14 Up Icon in Resource Catalog
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Description of "Figure 17-14 Up Icon in Resource Catalog"





Use the catalog's Search feature to locate components by name or description. Use the Refresh the Resource Catalog icon to update the catalog with newly added components.




	
See Also:

Resource Catalogs and how to configure them are discussed in detail in Chapter 16, "Working with Resource Catalogs."












17.3.4 Providing Page Background Color, Image, and CSS Encoding

Page properties provide a means of controlling the width of page columns, specifying a page background color and image, and applying additional CSS encoding to the page. Additionally, page properties provide access to page security settings and to page parameters, which you can use in wiring pages to page components.




	
See Also:

For information about page security settings, see Chapter 23, "Securing Pages and Components." For information about page wiring, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."







To edit a page's properties:

	
Navigate to the page of interest, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Click the Page Properties button (Figure 17-15).


Figure 17-15 Page Properties Button in Page Edit Mode

[image: Page Properties button in page edit mode]

Description of "Figure 17-15 Page Properties Button in Page Edit Mode"





The Page Properties dialog opens (Figure 17-16).


	
If necessary, click the Display Options tab to bring it forward, open the color picker next to Background Color, and select a background color for the page in one of the following ways (Figure 17-16):


Figure 17-16 Page Background Color Picker

[image: Page background color picker]

Description of "Figure 17-16 Page Background Color Picker"





	
Select a color by clicking it.


	
Enter the color's RGB equivalent in the Background Color field.




	
Tip:

Enter RGB values in the format RRGGBB or #RRGGBB or r,g,b








	
Create a custom color by clicking Custom Color in the picker and selecting a color and a saturation level using the selector and the slider provided (Figure 17-17).


Figure 17-17 Custom Color Picker
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Description of "Figure 17-17 Custom Color Picker"





Click OK to enter the color value in the Background Color field.





	
In the Background Image field, enter a full URL or a URL that is relative to the application root.

For example, enter:


http://www.abc.com/image.jpg


	
In the Other CSS field, add any other CSS encoding you care to that is not covered by the other page properties.

For example, enter:


 background-position:center;


You must use standard CSS syntax for this value to be valid (for more information about Other CSS, see Section 17.5.2.7.3, "Entering Other CSS").


	
Click OK to save your changes and apply them to the page.









17.3.5 Changing the Page Layout

This section describes how to revise the page layout by adjusting underlying page columns and adding tabs and content areas. It includes the following subsections:

	
Section 17.3.5.1, "What You Should Know About Page Layouts"


	
Section 17.3.5.2, "Providing a Page Header and Footer"


	
Section 17.3.5.3, "Adjusting the Widths of Page Columns"


	
Section 17.3.5.4, "Adding New Content Regions"


	
Section 17.3.5.5, "Creating Layered Content Regions Using Tabs"






17.3.5.1 What You Should Know About Page Layouts

Page layout is defined by the number, placement, and orientation of content regions on a page and the widths of page columns. A page's initial layout is provided through your style selection when you first create a page.




	
See Also:

Table 15-2, "Default Page Styles" illustrates WebCenter default page styles.







You can adjust the width of underlying page columns through page parameters. You can add content regions to a page to change the page layout. You can also add tabs to create layered content regions.






17.3.5.2 Providing a Page Header and Footer

Many of the seeded page styles provided out-of-the-box in the Spaces application have associated page properties that you can use to add a header and footer to a page. These styles include:

	
Blank


	
Home Page


	
Left Narrow


	
Right Narrow


	
Three Column




Adding a page header adds a content area to the top of the page. Adding a page footer adds a content area to the bottom of the page. Both of these content areas are immune to user customizations, preventing them from being dragged to a new position or otherwise altered in page view mode. Figure 17-18 and Figure 17-19 illustrate a page in edit mode Design view before and after a header and footer are added.


Figure 17-18 A Page Based on the Style Three Column Before a Header or Footer Is Added

[image: Description of Figure 17-18 follows]

Description of "Figure 17-18 A Page Based on the Style Three Column Before a Header or Footer Is Added"






Figure 17-19 A Page Based on the Style Three Column After a Header and Footer Are Added

[image: Description of Figure 17-19 follows]

Description of "Figure 17-19 A Page Based on the Style Three Column After a Header and Footer Are Added"





This section steps you through the process of adding a header and footer to a page that is based on one of these styles.

To add a page header or footer:

	
Go to the page you want to change.

To navigate to a personal page in the Home space:


http://host:port/webcenter/spaces/profile/userName/page/escapedPageDisplayName





	
Tip:

The variable userName is your user name or the name of the user who owns the page in the Home space. The variable escapedPageDisplayName indicates the use of an escaped version of the page display name. For example, when you create a page with the name My Page, the URL to this page ends with My+Page.







To navigate to a page in a space:


http://host:port/webcenter/spaces/spaceName/page/escapedPageDisplayName


	
Open the page in edit mode.




	
Tip:

To open a page in edit mode, press Ctrl-Shift-E.








	
Click Page Properties (Figure 17-20) to open the Page Properties dialog.


Figure 17-20 Page Properties Button in Page Edit Mode

[image: Page Properties button in page edit mode]

Description of "Figure 17-20 Page Properties Button in Page Edit Mode"





	
Click the Parameters tab to bring it forward.


	
To add a page header, change the value of showHeader to true; to add a page footer, change the value of showFooter to true (Figure 17-21).


Figure 17-21 Default Page Parameters for the Three Column Page Style

[image: Default page parameters]

Description of "Figure 17-21 Default Page Parameters for the Three Column Page Style"





	
Click OK.


	
Add content as desired to the page header and footer layout Boxes (Figure 17-22).


Figure 17-22 Unpopulated Page with a Header and Footer

[image: Page with header and footer]

Description of "Figure 17-22 Unpopulated Page with a Header and Footer"








	
See Also:

For information about adding content to a page, see Section 17.5, "Adding Resource Catalog Components to Pages." For information about adding layout components to a page, such as images, text, HTML, and the like, see Section 18, "Adding and Configuring Page Layout Components."








	
Click Save and then Close to exit Composer.









17.3.5.3 Adjusting the Widths of Page Columns

Many seeded page styles come with parameters that control the percentage of width allotted to each underlying page column (Figure 17-23).


Figure 17-23 Default Page Parameters for the Three Column Page Style

[image: Default page parameters]

Description of "Figure 17-23 Default Page Parameters for the Three Column Page Style"





Like the default widths that are assigned with a given page style, the width values that you enter are fixed values. That is, they do not expand should you add content that exceeds the stated width.

The seeded page styles that provide column width parameters include:

	
Blank


	
Blog


	
Home Page


	
Left Narrow


	
Right Narrow


	
Three Column




The seeded page styles that do not provide column width parameters include:

	
Web Page


	
Wiki







	
See Also:

For illustrations and descriptions of seeded page styles, see Table 15-2, "Default Page Styles".







You can adjust the default values of these parameters to control the width of page layout columns.

To adjust the width of page columns:

	
Go to the page of interest.

To navigate to a personal page in the Home space:


http://host:port/webcenter/spaces/profile/userName/page/escapedPageDisplayName





	
Tip:

The variable userName is your user name or the name of the user who owns the page in the Home space. The variable escapedPageDisplayName indicates the use of an escaped version of the page display name. For example, when you create a page with the name My Page, the URL to this page ends with My+Page.







To navigate to a page in a space:


http://host:port/webcenter/spaces/spaceName/page/escapedPageDisplayName


	
Open the page in edit mode.




	
Tip:

To open a page in edit mode, press Ctrl-Shift-E.








	
Click Page Properties to open the Component Properties dialog (Figure 17-24).


Figure 17-24 Page Properties Button in Page Edit Mode

[image: Page Properties button in page edit mode]

Description of "Figure 17-24 Page Properties Button in Page Edit Mode"





	
Adjust the leftWidth, centerWidth, and rightWidth parameter values to the desired percentages (Figure 17-25).


Figure 17-25 Default Page Parameters for the Three Column Page Style

[image: Default page parameters]

Description of "Figure 17-25 Default Page Parameters for the Three Column Page Style"





	
Click OK.


	
Click Save and then Close to exit Composer.









17.3.5.4 Adding New Content Regions

You can add content regions to a page by splitting existing layout Boxes. This section describes how. It includes the following subsections:

	
Section 17.3.5.4.1, "Enabling Box Splitting"


	
Section 17.3.5.4.2, "Splitting a Layout Box"







	
See Also:

For information about Boxes and other layout components, see Chapter 18, "Adding and Configuring Page Layout Components."









17.3.5.4.1 Enabling Box Splitting

You can create additional content regions by splitting a Box into multiple Boxes. Before you can split a Box, the Box must be configured to allow it.




	
See Also:

You can also create additional content regions by adding more Boxes to a page. For more information, see Section 18.1, "Adding a Layout Component to a Page."







To enable the splitting of a Box:

	
Navigate to the relevant page, and enter page edit mode Design view.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Click the Edit icon on a Box to open the Component Properties dialog, and then click the Display Options tab to bring it forward (Figure 17-26).


Figure 17-26 Box Layout Component Display Options

[image: Box layout component Display Options]

Description of "Figure 17-26 Box Layout Component Display Options"





	
Select Show Split Action, and click OK.

Add Box icons appear on the Box's toolbar (Figure 17-27).


Figure 17-27 Add Box Icons

[image: Add Box icons]

Description of "Figure 17-27 Add Box Icons"












17.3.5.4.2 Splitting a Layout Box

To split a layout Box:




	
See Also:

Before you can split a Box, it must be configured to allow it. For more information, see Section 17.3.5.4.1, "Enabling Box Splitting."







	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Go to the layout Box you want to split, and click the Add Box icon that splits the Box in the manner you prefer (Figure 17-28).


Figure 17-28 Add Box Below Icon

[image: Add Box Below icon]

Description of "Figure 17-28 Add Box Below Icon"





Choose from:

	
Add Box Above


	
Add Box Below


	
Add Box Left


	
Add Box Right





	
Click Save and then Close.







	
See Also:

For information about setting properties on a Box layout component, see Section 18.2.2, "Working with the Box Layout Component."














17.3.5.5 Creating Layered Content Regions Using Tabs

When page real estate is tight, you can add layered content regions using tabs. Tabs are content regions that each have a tab and sit on top of other tabbed content regions (Figure 17-29).


Figure 17-29 Tabbed Content Regions

[image: Tabbed content regions]

Description of "Figure 17-29 Tabbed Content Regions"





Much of the actions you can perform on a tab, such as renaming, reordering, and so on, are available through tab properties. This section describes how to add tabbed content regions and how to perform various actions on tabs through tab properties.

This section includes the following subsections:

	
Section 17.3.5.5.1, "Enabling the Addition of Tabbed Content Regions"


	
Section 17.3.5.5.2, "Adding Tabbed Content Regions"


	
Section 17.3.5.5.3, "Creating a Tab Set"


	
Section 17.3.5.5.4, "Reordering and Renaming Tabs"


	
Section 17.3.5.5.5, "Adding an Icon to a Tab"


	
Section 17.3.5.5.6, "Stretching Tab Content"


	
Section 17.3.5.5.7, "Hiding and Showing Tabs"


	
Section 17.3.5.5.8, "Deleting Tabs"







	
See Also:

For information about working with tab properties, see Section 18.2.10.4, "Setting panelTabbed Properties," and Section 18.2.10.6, "Setting sidebarItem Properties."









17.3.5.5.1 Enabling the Addition of Tabbed Content Regions

The creation of tabbed content regions takes place initially on a Box layout component. Before you can create tabs on a Box, the Box must be configured to allow the creation of tabs.

To enable a Box to support the creation of tabs:

	
Navigate to the relevant page, and enter page edit mode Design view.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Click the Edit icon on a Box to open the Component Properties dialog, and then click the Display Options tab to bring it forward (Figure 17-30).


Figure 17-30 Box Layout Component Display Options

[image: Box layout component Display Options]

Description of "Figure 17-30 Box Layout Component Display Options"





	
Select Show Tab Action, and click OK.

The Add a Tab Set or a Tab icon appears on the Box's toolbar (Figure 17-31).


Figure 17-31 Add a Tab Set or a Tab Icon

[image: Add a Tab Set or a Tab icon]

Description of "Figure 17-31 Add a Tab Set or a Tab Icon"












17.3.5.5.2 Adding Tabbed Content Regions

Each tab you add to a page provides its own region to which you can add content. In page edit mode, you will note the Add Content button on the tab.




	
Note:

The icon for adding tabs appears on Box layout components only when the Box is configured to allow the creation of tabs. For more information, see Section 17.3.5.5.1, "Enabling the Addition of Tabbed Content Regions."







To add tabbed content regions:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Go to the region on which to add tabs, and click the Add a Tab Set or a Tab icon (Figure 17-32).


Figure 17-32 Add a Tab Set or a Tab Icon

[image: Add a Tab Set or a Tab icon]

Description of "Figure 17-32 Add a Tab Set or a Tab Icon"





A tab appears, containing the content present in the layout region on which the tab was created (Figure 17-33).


Figure 17-33 A Newly-Added Tab

[image: A newly-added tab]

Description of "Figure 17-33 A Newly-Added Tab"





	
Continue adding tabs as desired.

Click Save and then Close to exit Composer.







	
See Also:

For information about renaming a tab, see Section 17.3.5.5.4, "Reordering and Renaming Tabs."












17.3.5.5.3 Creating a Tab Set

When you intend to create tabs you are likely to want to create a set of tabs rather than just one. A quick way to accomplish this is available through tab properties.

To create a tab set:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Click the Edit icon on the tab you want to include in your tab set (Figure 17-34).


Figure 17-34 Edit Icon on a Tab

[image: Edit icon on a tab]

Description of "Figure 17-34 Edit Icon on a Tab"





	
In the resulting Component Properties dialog, bring the Tabs tab forward and click the Add Tab button to add a tab to the list headed Reorder the tabs (Figure 17-35).


Figure 17-35 Add Tab Button in Component Properties Dialog

[image: Add Tab button in Component Properties dialog]

Description of "Figure 17-35 Add Tab Button in Component Properties Dialog"





	
Continue in this manner until you have the desired number of tabs.




	
See Also:

For information about renaming a tab, see Section 17.3.5.5.4, "Reordering and Renaming Tabs."








	
Click OK to save your changes and exit the dialog.


	
Click Save and then Close to exit Composer.









17.3.5.5.4 Reordering and Renaming Tabs

Once you create a tab, you can use tab properties to change its default name, New Tab. You can also use page properties to change the tab order.

To rename and reorder tabs:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctrl-Shift-E.








	
Click the Edit icon on the tab you want to rename or reorder.


	
In the resulting Component Properties dialog, bring the Tabs tab forward, select the tab you want to rename or reorder in the Reorder the tabs list, and do one of the following.

	
To rename the tab, enter the new name in the Text field.


	
To reorder the tab, click a Move icon to the right of the Reorder the tabs list.





	
Click OK to save your changes and exit the dialog.


	
Click Save and then Close to exit Composer.









17.3.5.5.5 Adding an Icon to a Tab

You may want to add a meaningful icon to a tab to make its purpose obvious to knowledgeable users. Added icons are rendered to the left of the tab display name (Figure 17-36).


Figure 17-36 Icon on a Tab

[image: Icon on a tab]

Description of "Figure 17-36 Icon on a Tab"





To add an icon to a tab:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctr-Shift-E.








	
Click the Edit icon on the tab to which to add an icon.


	
In the resulting Component Properties dialog, bring the Tabs tab forward, select the tab in the Reorder the tabs list, and provide the URI of an image in the Icon Location field.

This property supports these various types of URIs:

	
An absolute path to the image, such as:


http://oracleimg.com/admin/images/ocom/hp/oralogo_small.gif


	
A path located relative to the source page, such as


bullet.jpg


	
A path relative to the application's context root, such as


/images/error.png


	
A path relative to the application server, such as


//adf-richclient-demo-context-root/images/error.png 





	
Click OK to save your changes and exit the dialog.


	
Click Save and then Close to exit Composer.









17.3.5.5.6 Stretching Tab Content

Using tab properties, you can stretch a single component to fill the tab's available display area. When you do this, the tab can display only the single component. You cannot add a second component to the tab region.

To stretch tab content:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctr-Shift-E.








	
Click the Edit icon on the tab of interest.


	
In the resulting Component Properties dialog, bring the Tabs tab forward and click the Stretch Contents checkbox.


	
Click OK to save your changes and exit the dialog.


	
Click Save and then Close to exit Composer.









17.3.5.5.7 Hiding and Showing Tabs

You can take a tab out of action by hiding it. Hiding a tab might be preferable to deleting because it leaves you the option of returning it to view. Hidden tabs are listed in tab properties, so you always have access to them.




	
Tip:

If you hide all tabs in a tab set, you can access their properties in Source view of page edit mode (for more information, see Section 17.3.2, "Introducing Design View and Source View"). In Source view, select the tabs parent element, panelTabbed, and edit its properties.







To hide or show a tab:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctr-Shift-E.








	
Click the Edit icon on a tab in the tab set of interest.


	
In the resulting Component Properties dialog, bring the Tabs tab forward, select the relevant tab under Reorder the tabs, and do one of the following:

	
Select the Hide this tab checkbox to hide the tab.


	
Clear the checkbox to show a hidden tab.





	
Click OK to save your changes and exit the dialog.


	
Click Save and then Close to exit Composer.









17.3.5.5.8 Deleting Tabs

You have a few options for deleting a tab or a tab set. You can do so through Source or Design view in page edit mode, through tab properties, or on the tab itself.




	
Note:

Whether you can delete tabs and how many tabs you can delete may be controlled by the panelTabbed property Tab Removal (see Section 18.2.10.4, "Setting panelTabbed Properties").
You can delete an entire tab set by deleting panelTabbed. For example, select panelTabbed in Source view and delete it.

When you remove tabs individually through Box properties (in Design view), you can remove all but the current tab. When you remove tabs individually through Box properties, the current, active tab cannot be deleted.









To delete a tab or a tab set:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

To enter page edit mode, press Ctr-Shift-E.








	
Delete the relevant tab or tab set by doing one of the following:

	
To delete a tab set, go to Source view of page edit mode, select the relevant panelTabbed element, and click Delete (Figure 17-37).


Figure 17-37 Deleting a panelTabbed Element in Source View of Page Edit Mode

[image: Deleting a panelTabbed element]

Description of "Figure 17-37 Deleting a panelTabbed Element in Source View of Page Edit Mode"





Click Delete in the confirmation dialog.




	
See Also:

For more information about page edit mode views, see Section 17.3.2, "Introducing Design View and Source View."








	
To delete one or more tabs, go to Design view of page edit mode, click the Edit icon on one of the tabs in the tab set of interest, bring the Tabs tab forward, select the tab to delete under Reorder the tabs, and click the Delete Tab button (Figure 17-38).


Figure 17-38 Delete Tab Button in Box Component Properties Dialog

[image: Delete Tab button in Box Component Properties]

Description of "Figure 17-38 Delete Tab Button in Box Component Properties Dialog"





Click Delete in the confirmation dialog.




	
Tip:

You can also access tab set properties by selecting the panelTabbed in Source view of page edit mode and clicking the Edit button.











	
Click Save and then Close to exit Composer.















17.4 Personalizing Pages

WebCenter Personalization provides a way to tailor page content and templates to the current user. Using Personalization-related Expression Language expressions (ELs), you can present targeted content or shape the way content is presented by selecting and applying a page template based on whoever is the current user. For example, one user role sees a page through template A, while another user role sees the same page through template B.

There is a wide variety of user and application context that can determine the content a user sees. For example, content can be restricted by role through a security mechanism, such as page hierarchy security. Content can be targeted based on more dynamic user and application context, such as user profile values, session information, and the like.

When you use Personalization ELs, you personalize the content that is shown based on the user or application context that is being pulled by the ELs from a Personalization Conductor Scenario. The Personalization Conductor in turn is dynamically pulling the actual content or page template from a provider source, that is, a content repository, such as Content Server.

For more information about personalization in WebCenter Portal: Spaces, see Chapter 9, "Using Personalization for WebCenter Portal."

The ELs related to the Personalization Conductor are cataloged in Section B.4.11, "EL Expressions Relevant to the Personalization Conductor." The Personalization Conductor is discussed in more detail in the chapter, "Personalizing WebCenter Portal Applications" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.






17.5 Adding Resource Catalog Components to Pages

This section generally describes how to add components from the Resource Catalog to a page, how to personalize content according to user role, and how to set properties on components. It includes the following subsections:

	
Section 17.5.1, "Adding a Component to a Page"


	
Section 17.5.2, "Setting Properties on Page Components"







	
See Also:

For information about specific types of components, see:
	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Chapter 13, "Adding Spaces Components to Your Templates"


	
Part VIII, "Creating and Managing Portlets and Task Flows at Runtime"


	
Part X, "Working with Content"


	
Part XV, "Services: Announcements through Links"


	
Part XVI, "Services: Lists through Worklist"














17.5.1 Adding a Component to a Page

The method for adding page components differs between Design view and Source view of page edit mode. In Design view, you place content using controls directly on the containing layout component. In Source view, you select the containing layout component on a hierarchical list of components and use the controls available in a common toolbar.

This section describes how to add content from the Resource Catalog to your application pages. It includes the following subsections:

	
Section 17.5.1.1, "Adding a Component to a Page in Design View"


	
Section 17.5.1.2, "Adding a Component to a Page in Source View"







	
See Also:

For information about adding components to the Resource Catalog, see Section 16.3.1.2, "Adding Resources."









17.5.1.1 Adding a Component to a Page in Design View

To add a Resource Catalog component in page edit mode Design view:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Add Content button on the target region (Figure 17-39) to open the Resource Catalog.


Figure 17-39 Add Content Button on a Box Layout Component

[image: Add Content button on a Box layout component]

Description of "Figure 17-39 Add Content Button on a Box Layout Component"





	
Navigate to the component you want to add, and click the Add link next to it (Figure 17-40).


Figure 17-40 Add Link in a Resource Catalog

[image: Add link in a resource catalog]

Description of "Figure 17-40 Add Link in a Resource Catalog"








	
Tip:

If the component you want is not present in the Resource Catalog, you may need to add it. For more information, see Section 16.3.1.2, "Adding Resources."








	
Continue to add content, or click Close to exit the Catalog.


	
Click Save and then Close to exit page edit mode.









17.5.1.2 Adding a Component to a Page in Source View

To add a Resource Catalog component in page edit mode Source view:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
From the View menu, select Source.


	
From the list of page components, select the component in which to place content.




	
Tip:

You can also select a component by clicking it in the WYSIWYG section of the page. A selected component is outlined in blue.








	
Click the Add Content button to open the Resource Catalog (Figure 17-41)


Figure 17-41 Selected Box and Add Content Button in Source View

[image: Selected Box and Add Content button]

Description of "Figure 17-41 Selected Box and Add Content Button in Source View"





	
Navigate to the component you want to add and click the Add link next to it (Figure 17-42).


Figure 17-42 Add Link in a Resource Catalog

[image: Add link in a resource catalog]

Description of "Figure 17-42 Add Link in a Resource Catalog"





	
Continue to add content, or click Close to exit the Catalog.


	
Click Save and then Close to exit page edit mode.











17.5.2 Setting Properties on Page Components

Components, such as task flows, portlets, documents, and layout components, have configurable properties that control the appearance and behavior of a particular component instance. Such properties are exposed in Composer through the Component Properties dialog (Figure 17-43).


Figure 17-43 Component Properties Dialog

[image: Component Properties dialog]

Description of "Figure 17-43 Component Properties Dialog"





Components of all types have many common properties. Typically, individuality is expressed on the Parameters and Events tabs, although there may be variations on Display Options, Style, and Content Style tabs.




	
Note:

When you enter most types of property values in the Component Properties dialog and then click Apply, the dialog remains open. With values other than expected value types, the dialog closes, and the page is refreshed to reflect the new value. For example, if a component takes a java.util.ArrayList of java.awt.Color classes, then the Component Properties dialog closes when you enter a value and Composer does a full-page-refresh.







This section discusses commonly-shared properties. It includes the following subsections:

	
Section 17.5.2.1, "What You Should Know About Customizing Page Components"


	
Section 17.5.2.2, "What You Should Know About Component Properties"


	
Section 17.5.2.3, "Setting Component Properties"


	
Section 17.5.2.4, "Working with Component Parameters"


	
Section 17.5.2.5, "Working with Component Display Options"


	
Section 17.5.2.6, "Working with Child Components"


	
Section 17.5.2.7, "Working with Style and Content Style Properties"


	
Section 17.5.2.8, "Working with Component Contextual Events"







	
See Also:

In this guide, properties that are unique to a particular component are discussed in the chapters that cover that component. For more information, see:
	
Section 27.4, "Setting OmniPortlet Properties"


	
Section 28.3, "Setting Web Clipping Portlet Properties"


	
Section 36.5.3, "Setting Notifications Task Flow Properties"


	
Chapter 42, "Setting Documents Service Task Flow and Document Component Properties"


	
Section 48.6, "Setting Blog Properties"


	
Section 51.16.2, "Setting Space Task Flow Properties"


	
Section 52.4.7, "Setting Members Task Flow Properties"


	
Part XIII, "Searching WebCenter and Other Sources"


	
Part XIV, "Gathering Intelligence Based on Activities"


	
Part XV, "Services: Announcements through Links"


	
Part XVI, "Services: Lists through Worklist"




For information about page parameters, see Section 19.3, "Wiring Components and Page Parameters."











17.5.2.1 What You Should Know About Customizing Page Components

The runtime flexibility of your portal pages is realized in both application customization and user customization. Application customization involves changes made in page edit mode. Application customizations affect all users' views of a page. User customization involves changes made in page view mode. User customizations affect only the view of the user who made them.




	
Note:

When you revise a component in page view mode (user customization) while another user deletes the same component in page edit mode (application customization), an error page opens. Simply navigate back to the original page. The deleted component does not appear, and you can continue working on other components.







In page edit mode, you see only application customizations. In page view mode, you see your user customizations layered over application customizations. If the same property is set at both the application and user levels, the user value takes precedence (in your view of a page in page view mode). For example, imagine a List task flow where an authorized user performs an application customization to display color banding every other column. In your page view, you perform a user customization on the list to instead show color banding every other row. As you toggle between page edit mode and page view mode, you see column color banding in page edit mode, but your own row color banding in page view mode.

You can perform both types of customization at the page level and at the component level. Page-level customizations include such actions as rearranging page content, changing the page layout, and the like. Component customizations—made to task flows, portlets, and layout components—include such actions as resizing and rearranging task flows and filtering content.

Through the Child Components tab in the Component Properties dialog, you can also perform page-like application customizations at the component level (for example, on a Box layout component). For example, you can rearrange, hide, and show page content. For more information, see Section 17.5.2.6, "Working with Child Components." The types of customizations available to components differ from component to component.




	
Note:

Application customizations made directly to service task flows and to portlets are committed immediately, regardless of whether you click the Save button in Composer. These types of customizations include entering page edit mode and resizing a list column, adding color banding, sorting discussion forums, and the like. They do not include changes made through the Component Properties dialog, which must be saved before they are committed.







User customization is available to users with, minimally, Personalize Page permission on the page. Provided the component supports it, some user customization settings are available through the Personalize icon that appears on the component header in page view mode. For example, Figure 17-44 shows an instance of a List Viewer task flow in page view mode with the task flow's Personalize icon (pencil) called out.


Figure 17-44 Personalize Icon on a Component Header

[image: Personalize icon on a component header]

Description of "Figure 17-44 Personalize Icon on a Component Header"





Application customization is available to users with, minimally, edit permission on the page. Provided the component supports it, some customization settings are available through the Edit icon that appears in the component header or on a floating tool palette when the component's host page is opened in Composer. For example, Figure 17-45 shows an instance of a List Viewer task flow in page edit mode, with the task flow's Edit icon (wrench) called out.


Figure 17-45 The Edit Icon on a List Task Flow

[image: Edit icon on a Personal Documents task flow]

Description of "Figure 17-45 The Edit Icon on a List Task Flow"









17.5.2.2 What You Should Know About Component Properties

Changes to component properties are always made in page edit mode and are always an application-level customization. Use component properties to adjust the appearance and behavior of a component instance and to wire components to each other and to page parameters and page definition variables.




	
See Also:

For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."







The Component Properties dialog is divided into multiple tabs. These can include all of the following tabs, but more likely include a subset of them:

	
Parameters—Settings, unique to the component type, that can control such things as the source of the component's content. For more information, see Section 17.5.2.4, "Working with Component Parameters."


	
Display Options—Settings for determining content orientation, hiding and showing a header, selecting a display method for an actions menu, and the like. For more information, see Section 17.5.2.5, "Working with Component Display Options."


	
Child Components—A list of all the components contained in the parent component. For more information, see Section 17.5.2.6, "Working with Child Components."


	
Style—Font, color, and dimension settings on the component that override such values on the parent component, the page, and the application. Style values affect component content and the elements that surround the content. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."


	
Content Style—Font, color, and dimension settings on component content that override such values specified for Style. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."


	
Events—Contextual events and event handlers for all the components on the current page that can be consumed by the currently selected component. Events are defined occurrences within the current context, and event handlers are the engines that drive the results of that occurrence. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."









17.5.2.3 Setting Component Properties

The steps outlined in this section are useful for all selectable components on a page.




	
Note:

When you enter most types of property values in the Component Properties dialog and then click Apply, the dialog remains open. With values other than expected value types, the dialog closes, and the page is refreshed to reflect the new value. For example, if a component takes a java.util.ArrayList of java.awt.Color classes, then the Component Properties dialog closes once you add a value and Composer does a full-page-refresh.







To set component properties:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
In Design view of page edit mode, click the Edit icon (wrench) on the component of interest (Figure 17-46) to open the Component Properties dialog (Figure 17-48).


Figure 17-46 Edit Icon on a Box in Design View

[image: Edit icon on a Box in Design view]

Description of "Figure 17-46 Edit Icon on a Box in Design View"





Alternatively, in Source view of page edit mode, select the relevant component, and click the Edit button (Figure 17-47) to open the Component Properties dialog (Figure 17-48).


Figure 17-47 Edit Button in Source View

[image: Edit button in Source view]

Description of "Figure 17-47 Edit Button in Source View"






Figure 17-48 Component Properties Dialog

[image: Component Properties dialog]

Description of "Figure 17-48 Component Properties Dialog"





Enter Parameters and Display Options values either unwrapped or wrapped in Expression Language syntax; for example, value or #{value}.




	
Tip:

For information about component properties and the types of values they require, see:
	
Section 17.5.2.4, "Working with Component Parameters"


	
Section 17.5.2.5, "Working with Component Display Options"


	
Section 17.5.2.6, "Working with Child Components"


	
Section 17.5.2.7, "Working with Style and Content Style Properties"


	
Section 17.5.2.8, "Working with Component Contextual Events"













	
When you finish revising component properties, click OK.


	
Click Save and then Close to exit Composer.









17.5.2.4 Working with Component Parameters

Component parameters appear on the Parameters tab of the Component Properties dialog (Figure 17-49).


Figure 17-49 Component Parameters

[image: Component parameters]

Description of "Figure 17-49 Component Parameters"








	
See Also:

For information about accessing the Component Properties dialog, Section 17.5.2, "Setting Properties on Page Components."







Component parameters vary from component to component. For example, on some components they provide the opportunity to specify the source and range of task flow content; on other components they present read-only, application-generated identifiers that are used in maintaining a task flow instance's association with its customizations.

Enter parameter values, or click the icon next to a parameter field to select and open the Expression Editor. (Figure 17-50).


Figure 17-50 Expression Builder Icon and Expression Editor

[image: Expression Builder icon and Expression Editor]

Description of "Figure 17-50 Expression Builder Icon and Expression Editor"





The editor provides a means of entering an expression when a value is discoverable, but otherwise unknown, for example, when you want a parameter value to be the name of the current user or the current application skin.




	
See Also:

For more information about using the editor and for a table of useful EL expressions, see Appendix B, "Expression Language Expressions."







In view of the uniqueness of parameters within a particular service or a particular portlet, parameter details are discussed with their associated services and portlets.

	
For information about documents and their associated parameters, see Chapter 42, "Setting Documents Service Task Flow and Document Component Properties."


	
For information about services and their associated parameters, see the chapters dedicated to a particular service or a service feature throughout this guide.


	
For information about portlets and their associated parameters, see Part VIII, "Creating and Managing Portlets and Task Flows at Runtime".









17.5.2.5 Working with Component Display Options

The Display Options tab in the Component Properties dialog provides access to properties that control a range of display-related behaviors on a given component instance (Figure 17-51).


Figure 17-51 Component Display Options

[image: Component display options]

Description of "Figure 17-51 Component Display Options"








	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."







For example, use the display options on an Image layout component to specify the image source URL and its optional link target. Use the display options on the Announcement Manager task flow to hide or show a header and enable or disable menus and other options on the header.

The showDetailFrame (Movable Box) layout component has a Display Options tab that is divided into two subtabs: Basic and Advanced.

This provides a means of separating an otherwise long list of display options into more manageable and relevant groups. Though it is not obvious in Design view of page edit mode, the showDetailFrame component is usually wrapped around the task flows provided by the various services. Consequently, the Display Options properties for task flows, and any other component wrapped in a showDetailFrame, have Basic and Advanced subtabs on their Display Options tab (see Figure 17-51).

Another consequence of being wrapped in a showDetailFrame is commonality of properties on the Display Options tab. Task flows and any other components that are wrapped in a showDetailFrame share the same Display Options properties.

For many of the properties on the Display Options tab, an Expression Editor is available for entering custom values, such as text strings and Expression Language (EL) expressions. You can tell which properties take expressions by the menu icon that displays to the right of a given property (Figure 17-52).


Figure 17-52 Edit Icon for Expression Editor

[image: Edit icon for Expression Editor]

Description of "Figure 17-52 Edit Icon for Expression Editor"








	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1. For more information about ELs in the Spaces application, see Appendix B, "Expression Language Expressions."
EL validation is not performed on non-generic display options.









Typically, the Display Options tab presents settings that affect the display elements surrounding component content (that is, its chrome). Chrome includes the header, the Actions menu, Expand and Collapse icons, and the like.

Table 17-1 lists and describes the Display Options properties that generally apply to most components (task flows, portlets, and layout components). Where there are variations, they are noted in the chapters covering specific services, task flows, and components.


Table 17-1 Display Options Properties

	Property	Description
	
Allow Minimize

	
Select whether to show the minimize action on the component header (that is, a Collapse icon on the component chrome).

	
Select the checkbox to show the Collapse icon.


	
Clear the checkbox to omit the Collapse icon.




The minimize action collapses the component like a window shade, leaving only its header on view.

[image: Collapsed Task Flow]

When a component is minimized, the icon toggles to an Expand icon, which you can use to restore the full component to view.


	
Allow Move

	
Select whether to show Move Up and Move Down (or Move Left and Move Right) options on the component Actions menu. Choose from:

	
Select the checkbox to show the Move options on the component Actions menu.


	
Clear the checkbox to omit the Move options.




The Move options that show depend on the orientation of the parent container (horizontal or vertical). Move options are context sensitive. For example, in a vertically-oriented parent container if there are no components above the current task flow the Move Up option does not appear on the Actions menu.


	
Allow Remove

	
Select whether to show the Remove icon on the component header (that is, the component chrome). Choose from:

	
Select the checkbox to show the Remove option on the component header.


	
Clear the checkbox to omit the Remove option.




[image: Remove icon]

Note that after you select to remove a component in this way in page view mode, you can restore the component only by editing the page and adding another component instance.


	
Allow Resize

	
Select whether to show a window resizer on a component instance. The window resizer enables you to increase the component height.

	
Select the checkbox to show the Resize option on the component.


	
Clear the checkbox to omit the Resize option.




[image: Window resizer]


	
Chrome Style

	
Select to specify a shade for the component background.

Enter:

	
light—Light is transparent; the prevailing background color shows through


	
medium—Medium draws an light line below the header area.


	
dark—A graduated shade moving from the bottom of the header area to the top of the component from transparent to dark.


	
coreDefault—A graduated shade slightly lighter than dark





	
Display Header

	
Select this checkbox to show a header on the component instance.

[image: Header on a Task Flow]


	
Display Shadow

	
Select to render a shadow behind the component instance.

[image: Task Flow with a drop shadow]


	
Font

	
Specify the font to use for text appearing in the component header.

Enter one or more fonts. Separate multiple values with a comma (,), for example arial,helvetica,sans serif. Enclose font names that contain spaces in single quotation marks, for example 'Times New Roman'. The browser tries to use the first value, and uses other values in turn, depending on which font is available to the local system.


	
Font Color

	
Select a color for the text appearing in the component header.

Select a color using one of the following techniques:

	
Select a color by clicking it.


	
Enter the color's RGB equivalent in the Font Color field. Enter RGB values in the format RRGGBB or #RRGGBB or r,g,b


	
Create a custom color by clicking Custom Color in the picker and selecting a color and a saturation level using the selector and the slider provided.





	
Font Size

	
Specify the size of text appearing in the component header.

Enter a value using one of the following types of values:

	
length–Sets the font size to a fixed size. For example, enter: 14px, 1.5em, and so on


	
xx-small, x-small, or small


	
medium–The default


	
large, x-large, or xx-large


	
smaller–Sets the font size to a size smaller than the parent element.


	
larger–Sets the font size to a size larger than the parent element.


	
%–Sets the current font size to a percentage of the font size of the parent element. For example, enter: 75%





	
Font Style

	
Select an option for applying a font style to the text in a component header:

Choose from:

	
Bold


	
Italic


	
Underline


	
Strikethrough





	
Short Desc

	
Provide tooltip text for the component instance. When users roll their mouse pointers over the component instance, the text you enter here pops up.


	
Show Actions On Hover

	
Select to show actions when users hover their mouse pointers over the component header.

	
Select the checkbox to show actions only when users hover their mouse pointers over the component header.


	
Clear the checkbox to always show actions on the component header.




Display Header must be selected for this option to apply.


	
Show Component

	
Option for hiding or showing the component instance on the page

	
Select to show the component.


	
Clear to hide the component.




Once you hide a component in this way, you can show it again using controls available in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Stretch Content

	
Select to stretch the content to fill the container, so that the container shows only one component at a time.


	
Text

	
Enter text to appear in the component header. If you select to hide the header, the value you enter here is ignored.












17.5.2.6 Working with Child Components

The Child Components tab in the Component Properties dialog (Figure 17-53) provides controls for hiding, showing, and rearranging the components that are contained within the current (parent) component.


Figure 17-53 Child Components Tab in Component Properties Dialog

[image: Child Components tab in Component Properties dialog]

Description of "Figure 17-53 Child Components Tab in Component Properties Dialog"








	
See Also:

For information about accessing the Component Properties dialog, Section 17.5.2, "Setting Properties on Page Components."







The changes you make through the Child Components tab are customizations that affect every user's view of the component instance.

This section provides information about how to use the controls on the Child Components tab. It includes the following subsections:

	
Section 17.5.2.6.1, "Hiding and Showing Child Components"


	
Section 17.5.2.6.2, "Rearranging Child Components"






17.5.2.6.1 Hiding and Showing Child Components

Hiding is useful for keeping a component instance out of general view while still maintaining its presence on the page. When you hide a child component through the Component Properties dialog, it is hidden in everyone's view of the page. When you are ready to show the component instance, it is a simple matter to reselect the component to show through the Child Components tab.

To hide or show child components:

	
Access component properties as described in Section 17.5.2.3, "Setting Component Properties."


	
Click the Child Components tab to bring it forward (see Figure 17-53).


	
The next step depends on whether you want to hide or show a component:

	
Clear the checkbox to the left of any components you want to hide.


	
Select the checkbox to the left of any components you want to show.





	
Click OK to exit the dialog.


	
Click Save and then Close to exit Composer.









17.5.2.6.2 Rearranging Child Components

 The Child Components tab provides a convenient and efficient way to rearrange the content within a particular container, such as a Box layout component. When you rearrange child components through the Component Properties dialog, they are rearranged on everyone's view of the page.




	
Tip:

You can also rearrange page components in a way that affects everyone's view by dragging and dropping components while in Composer.










	
Note:

When you use Box controls to split a Box, the rearrange capability is disabled in the Component Properties dialog on the Child Components tab. You can still rearrange content in such boxes by dragging and dropping on the page itself.







To rearrange a child component:

	
Access component properties as described in Section 17.5.2.3, "Setting Component Properties."


	
Click the Child Components tab to bring it forward (see Figure 17-53).


	
Click the up or down arrows next to the component you want to move, depending on where you want to move it.




	
Tip:

The direction that a child component is moved depends on the orientation of its parent container. For example, if the container is oriented vertically, child components move up (up arrow) or down (down arrow); if the container is oriented horizontally, child components move right (up arrow) or left (down arrow).








	
Click OK to exit the dialog.


	
Click Save and then Close to exit Composer.











17.5.2.7 Working with Style and Content Style Properties

Style and Content Style properties, available in the Component Properties dialog, provide an opportunity to fine-tune your application look-and-feel at the component level. Enter values for Style and Content Style properties, or specify your own values through the Other CSS property that appears on both tabs.




	
See Also:

For information about accessing the Component Properties dialog, Section 17.5.2, "Setting Properties on Page Components."







This section introduces Style and Content Style properties and provides tables that list and describe them. Additionally, it provides information about how to use the Other CSS property. It includes the following subsections:

	
Section 17.5.2.7.1, "Understanding Style and Content Style Properties"


	
Section 17.5.2.7.3, "Entering Other CSS"


	
Section 17.5.2.7.4, "Using the Other CSS Property to Change Component Borders"






17.5.2.7.1 Understanding Style and Content Style Properties

Use component Style and Content Style properties to specify color, style, and margin settings on the selected component instance.

Style settings override the style settings on hierarchically superior components, such as the component's parent container, the page, and the application. Content Style settings override Style settings. For example, Style settings control the look and feel of a Movable Box; when Content Style settings come into play, Style settings control only the Movable Box chrome. Content Style settings control the look and feel of the components contained within the Movable Box. This look and feel may, in turn, be overridden by the Style settings set on those individual components.




	
See Also:

For information on layout components, such as Movable Boxes, see Chapter 18, "Adding and Configuring Page Layout Components."







Note, however, that Content Style properties set for a container, such as a Movable Box, may not take effect if the component inside the container overrides the container Content Style properties by a means other than the component's own Content Style properties. For example, the background color set for a Movable Box that contains a task flow may not take effect if, at design time, instead of being set to inherit from the container, the task flow background color was set with a hard-coded value.






17.5.2.7.2 Style and Content Style Properties

Table 17-2 lists and describes common component Style and Content Style properties.


Table 17-2 Style and Content Style Properties

	Property	Description
	
Background Color

	
A pick-list for selecting a component background color

If you specify a background color for Content Style, then the background color specified for the Style property is not applied.


	
Background Image

	
A field for entering a URL to a component background image

Enter the URL to an image you want to render in the component background. Use standard CSS syntax. For example:

url(http://www.abc.com/image.jpg)


	
Color

	
A pick-list for selecting a default color for text

Select a default color for any text included in the component instance. For example, imagine that you have added a Text layout component to a Box layout component. When you set Box Style properties, the default text color you apply to the Box is also automatically applied to the Text layout component, unless you also define a Color value for the Text layout component.

Select a color using one of the following techniques:

	
Select a color by clicking it.


	
Enter the color's RGB equivalent in the Color field. Enter RGB values in the format RRGGBB or #RRGGBB or r,g,b


	
Create a custom color by clicking Custom Color in the picker and selecting a color and a saturation level using the selector and the slider provided.





	
Font

	
A field for specifying the font to use for component content

Select a default font for any text included in the component

The font you select here applies to any text inside the container/parent component.

Select a default font for component content. Separate multiple values with a comma (,), for example arial,helvetica,sans-serif. Enclose font names that contain spaces in single quotation marks, for example 'Times New Roman'. The browser tries to use the first value, and uses other values in turn, depending on which font is available to the local system.


	
Font Size

	
The size of component text relative to either your browser's default font size or the font size of the parent element

Enter one value from the following types of values:

	
length–Sets the font size to a fixed size. For example, enter: 14px. 1.5em, and so on


	
xx-small, x-small, or small


	
medium–The default


	
large, x-large, or xx-large


	
smaller–Sets the font size to a size smaller than the parent element.


	
larger–Sets the font size to a size larger than the parent element.


	
%–Sets the current font size to a percentage of the font size of the parent element. For example, enter: 75%





	
Font Style

	
Options for applying styles to component fonts

Choose from:

	
Bold


	
Italic


	
Underline


	
Strikethrough




The font style you select here applies to any text inside the component.


	
Height

	
A field for specifying the height of component content

Set a fixed height for component content. You can use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect. If you want your component to take up 100% of a page, consider creating a page using the Stretch page style and adding the component to it (for more information, see Section 15.1, "What You Should Know About Page Styles").

The Height property works with the Stretch Content property, available on the Display Options tab. Stretch Content enables a container to stretch its content to the specified height.


	
Margin

	
Fields for specifying the border of space to draw around the component

Enter one of the following types of values:

	
An absolute value. Include your preferred unit of measurement.

For example:


2px


Use only those units of measurement supported in standard CSS, such as pt, px, pc, li, and so on.


	
A percentage of the margin of a parent component (provide a percent sign with your value, such as 10%).


	
auto: Set the value automatically according to browser defaults.





	
Other CSS

	
A field for specifying additional CSS for the component

Add any other CSS encoding you care to that is not covered by the other Style or Content Style properties. You must use standard CSS syntax for this value to be valid (for more information about Other CSS, see Section 17.5.2.7.3, "Entering Other CSS").

Compare this with the description of Style Class.


	
Style Class

	
A field for specifying the CSS style class to use for this component

The style class may be defined in your jspx or skinning CSS file.

Note: Style classes are a set of styles bundled together and given a name. In contrast, values entered for Other CSS are individual styles. Style Class values are added to a component's styleClass attribute. Other CSS values are added to a component's inlineStyle attribute.

This property appears only on the Style tab.


	
Width

	
A field for specifying the width of component content

Set a fixed width for component content. You can use any standard CSS unit of measure, such as pt, px, pc, li, %, and so on.












17.5.2.7.3 Entering Other CSS

The Other CSS field that appears on Style and Content Style tabs offers an opportunity to apply CSS styles that are not otherwise provided on the tabs. Use standard CSS syntax (for information about standard CSS syntax, see http://www.w3.org/TR/CSS2/propidx.html). Separate multiple entries with a semicolon (;), for example:


background: #00FF00 url(http://www.google.com/intl/en_ALL/images/logo.gif) no-repeat fixed top; font-size: xx-small


Note, however, that some CSS styles are not supported by popular browsers. Moreover, some styles are specific to one browser and may not work correctly in another browser.




	
Note:

The Style tab provides a Style Class property for specifying the CSS style class to use for the component. For more information, see Table 17-2.







Table 17-3 provides a few examples of CSS you can use in the Other CSS field.


Table 17-3 Example Values for Other CSS

	Value	Description and Examples
	
background-repeat

	
Specify whether and how the background image should repeat. Enter a value in the format background-repeat: <value>

For example:


background-repeat: repeat


	
no-repeat–Forgo repeating the image.


	
repeat–Repeat the image to fill the container.


	
repeat-x–Repeat the image horizontally but not vertically.


	
repeat-y–Repeat the image vertically but not horizontally.





	
background-position

	
Set the starting position of a background image. Enter values in the format background-position: <value> <value>

For example:


background-position: top left


Except as noted, if you specify only one value, the second value defaults to center.

The first set of value pairs express horizontal and vertical as positions:

	
top left, top center, or top right


	
center left, center center, or center right


	
bottom left, bottom center, or bottom right




The second set of value pairs express horizontal and vertical positions as either percentages or units of measure:

	
x% y%–The horizontal (x) and vertical (y) positions expressed as a percentage. The top left corner is 0% 0%. The bottom right corner is 100% 100%. If you specify only one value, the second value defaults to 50%.


	
xpos ypos–The horizontal (x) and vertical (y) positions expressed as a unit of measurement. The top left corner is 0 0. Units can be pixels (0px 0px) or any other CSS units. If you specify only one value, the second value defaults to 50%.




You can mix % and positions.


	
font-size

	
The size of component text relative to either your browser's default font size or the font size of the parent element. Enter a value in the format font-size: <value>

For example:


font-size: xx-small


	
length–Sets the font size to a fixed size, for example font-size: 14px


	
xx-small, x-small, or small


	
medium–The default


	
large, x-large, or xx-large


	
smaller–Sets the font size to a size smaller than the parent element.


	
larger–Sets the font size to a size larger than the parent element.


	
%–Sets the current font size to a percentage of the font size of the parent element, for example, font-size: 75%





	
padding

	
A collective property for setting the white space (or clear space) around a component in one expression. Enter up to four values. Express values in a specific length or as a percentage of the closest element, using the syntax padding: <value> <value> <value> <value>

For example:


padding: 5px 10px 5px 10px


Where:

	
One value sets padding for all four sides. For example, padding: 10px


	
Two values set padding for top/bottom and left/right. For example, padding: 10px 15px


	
Three values set padding for top, left/right, and bottom. For example, padding: 10px 5% 10px


	
Four values set padding in turn for top, right, bottom, left. For example, padding: 5px 10px 15px 20px




Use any standard CSS unit of measure, such as pt, px, pc, li, %, and so on.


	
padding-bottom

	
Sets the white space (or clear space) at the bottom of the element. Express values in a specific length or as a percentage of the closest element. For example:


padding-bottom: 10px


	
padding-left

	
Sets the white space (or clear space) at the left side of the element. Express values in a specific length or as a percentage of the closest element. For example:


padding-left: 2%


	
padding-right

	
Sets the white space (or clear space) at the right of the element. Express values in a specific length or as a percentage of the closest element. For example:


padding-right: 1pc


	
padding-top

	
Sets the white space (or clear space) at the top of the element. Express values in a specific length or as a percentage of the closest element. For example:


padding-top: 16pt












17.5.2.7.4 Using the Other CSS Property to Change Component Borders

One application of the Other CSS property is to provide a variety of borders on task flows, portlets, and some layout components.

For example, Figure 17-54 depicts a Recent Activity task flow without borders.


Figure 17-54 Task Flow Without Borders

[image: Task flow without borders]

Description of "Figure 17-54 Task Flow Without Borders"





To create borders around the task flow, access its properties (for more information, see Section 17.5.2.3, "Setting Component Properties") and add CSS encoding. For example, enter the following code in the Other CSS field on the Style tab in the Component Properties dialog:


Example 17-1 Other CSS for Creating Borders


border-bottom-width:4px;
border-bottom-color:red;
border-bottom-style:dashed;
border-top-width:4px;
border-top-color:red;
border-top-style:dashed;
border-left-width:4px;
border-left-color:red;
border-left-style:dashed;
border-right-width:4px;
border-right-color:red;
border-right-style:dashed;




Figure 17-55 illustrates the result.


Figure 17-55 A Border Created Through the Other CSS Property

[image: Border created through Other CSS]

Description of "Figure 17-55 A Border Created Through the Other CSS Property"











17.5.2.8 Working with Component Contextual Events

Events are defined occurrences within the current context. Event handlers are the engines that drive the results of that occurrence. The Events tab in the Component Properties dialog provides a means of wiring a contextual event to an action handler to enable the passing of values from a producer component to a consumer component when the event is triggered on the producer (Figure 17-56).


Figure 17-56 Events Tab in the Component Properties Dialog

[image: Events tab in the Component Properties dialog]

Description of "Figure 17-56 Events Tab in the Component Properties Dialog"








	
See Also:

For information about accessing the Component Properties dialog, Section 17.5.2, "Setting Properties on Page Components."







For example, imagine two components: one is the producer of some kind of content (a payload) and the other consumes the content. When you wire these components to each other, you can use events to specify that when an event is triggered on the producer, the producer broadcasts a contextual event with a payLoad parameter, which the consumer component consumes through an event handler.




	
Note:

Contextual events differ from the business events that can be raised by ADF Business Components. Additionally, contextual events differ from events raised by UI components. Contextual events can be used in association with UI events. In this case, an action listener that is invoked due to a UI event can, in turn, invoke a method action binding that then raises the event.










	
See Also:

For information about business events, see Oracle Fusion Middleware Web User Interface Developer's Guide for Oracle Application Development Framework.







Not all components support contextual events because not all components were created to include them; therefore, the Events tab does not appear for all components. For events to be available at runtime, event capability must be included in a component when the component is developed.

Table 17-4 lists and describes the properties presented on an Events tab.


Table 17-4 Properties on the Events Tab

	Property	Description
	
Events

	
A list of all contextual events associated with components on the current page

An event describes the type of action that triggers another action, such as the passing of a value. The events listed in the Events pane were built-in to the component when the component was created. All components do not include events; therefore, all components are not intrinsically capable of being wired to other components.


	
Actions

	
A list of action handlers associated with the selected consumer component

The actions listed in the Actions pane vary according to which consumer component is selected. Actions enable you to associate an event with an event handler, which specifies what should happen when the triggering event occurs. The actions listed in the Actions pane were built-in to the component when the component was created.


	
Enable Action

	
A checkbox for enabling or disabling the selected event and action

When you select this checkbox, a list of selected action handler parameters appears.


	
List of selected action handler parameters

	
Fields for entering values to use to deliver the payload from the producer component to the consumer component whenever the event occurs

Enter parameter values, or click the Edit icon next to a parameter field to open the Expression Editor. For more information, see Section B.1, "Introducing the Expression Builder"

Parameter fields appear only when the Enable Action checkbox is selected.








For information about wiring components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."










17.6 Deleting Pages

You have a few options for deleting Spaces application pages:

	
If the page is rendered as a tab, you can select the Delete Page command from the page Actions menu, which you access by right-clicking the tab.


	
Navigate to the Personalize Pages page, and select the Delete Page command on the Actions menu associated with the page.


	
As the application administrator, you can navigate to the Pages tab in Administration pages and select the Delete Page command on the Actions menu associated with the page.

To navigate to the Administration Pages tab, use the following URL:


http://host:port/webcenter/spaces/admin/personalpages




For information about deleting a space, see Section 51.17, "Deleting a Space."




	
Note:

You cannot delete the Home space.















18 Adding and Configuring Page Layout Components

Layout components provide a means of enhancing a page's given layout with additional content areas, images, links, text, and the like. You can use page layout components to boost company branding (Image), provide a mission statement (Text), direct users to related information (Links and Hyperlink), and so on.

This chapter describes how to work with page layout components that are packaged with WebCenter Portal: Spaces. It includes the following sections:

	
Section 18.1, "Adding a Layout Component to a Page"


	
Section 18.2, "Working with Layout Components"


	
Section 18.3, "Deleting Layout Components"





Audience

This chapter is intended for users granted the application-level permission Pages: Create, Edit, and Delete Pages or the space-level permission Basic Services: Edit Page Access, Structure, and Content. Typically such users want to enhance page layout by adding and configuring layout components. Such users include authorized users working in the Home space and in spaces.

Your application administrator has the authority to expose or hide application resources and revise default permissions. Tasks discussed in this chapter are not available to you if the relevant resource is hidden or you are not authorized to perform them.



18.1 Adding a Layout Component to a Page

The process of adding a layout component to a page is the same for every layout component. Therefore, you can use the steps in this section for any layout component you add to a page.




	
See Also:

This section provides information about adding a layout component while the page is in Design view. For information about adding content while the page is in Source view, see Section 17.5.1.2, "Adding a Component to a Page in Source View."







To add a layout component to a page:

	
Go to the page of interest, and open it in Composer.




	
Tip:

One way to enter page edit mode (Composer) is to press Ctrl-Shift-E.








	
In the content area where you want to place the layout component, click the Add Content button to open the Resource Catalog (Figure 18-1).


Figure 18-1 Add Content Button and Resulting Resource Catalog

[image: Add Content button and resulting Resource Catalog]

Description of "Figure 18-1 Add Content Button and Resulting Resource Catalog"








	
Note:

In the Spaces application, the content of the Resource Catalog varies according to the services that are integrated with the application, the location from which the catalog is opened, and the resources provided by your administrator. For example, the components that appear in the catalog when you open it from the Home space differ from those that appear when you open it from a space. Additionally, authorized users can create custom catalogs that may or may not contain the components you want. Such users can reconfigure the catalog if needed components are not present. They can also rename catalog folders. For more information, see Chapter 16, "Working with Resource Catalogs."








	
In the catalog, click the Open link next to Web Development to display a selection of layout components (Figure 18-2).


Figure 18-2 Web Development Components in Resource Catalog

[image: Web Development components in Resource Catalog]

Description of "Figure 18-2 Web Development Components in Resource Catalog"





	
Click the Add link next to the component you want to add to the page.




	
Tip:

By default, new components are added to the top of their content areas.
When you add a component to a page, you must wait for the application status indicator to finish processing before taking additional action.










	
Click the Close button to exit the catalog.


	
Optionally, drag-and-drop the newly-added component to the desired position on the page, or use the Move icons on the component to reposition it.




	
Tip:

As you drag a component around, a dark box marks the target drop location.








	
Click Save to save your changes, and then Close to exit Composer.







	
Tip:

Some layout components are provided as part of the page infrastructure and are not obviously exposed in the Resource Catalog. An example of this is the spacer component. Although you cannot add more of them to a page, you can configure their properties. For more information, see Section 18.2.10, "Working with Internal Layout Components."












18.2 Working with Layout Components

Each layout component has associated properties that you can use to refine the appearance and behavior of a layout component instance. This section provides information about accessing and providing values for layout component properties. It contains the following subsections:

	
Section 18.2.1, "Setting Properties on a Layout Component"


	
Section 18.2.2, "Working with the Box Layout Component"


	
Section 18.2.3, "Working with the Movable Box Layout Component"


	
Section 18.2.4, "Working with the HTML Markup Layout Component"


	
Section 18.2.5, "Working with the Links Layout Component"


	
Section 18.2.6, "Working with the Hyperlink Layout Component"


	
Section 18.2.7, "Working with the Image Layout Component"


	
Section 18.2.8, "Working with the Text Layout Component"


	
Section 18.2.9, "Working with the Web Page Layout Component"


	
Section 18.2.10, "Working with Internal Layout Components"






18.2.1 Setting Properties on a Layout Component

Layout components have associated properties, which authorized users can access from the Composer Component Properties dialog.




	
Note:

When you enter most types of property values in the Component Properties dialog and then click Apply, the dialog remains open. With values other than expected value types, the dialog closes, and the page is refreshed to reflect the new value. For example, if a component takes a java.util.ArrayList of java.awt.Color classes, then the Component Properties dialog closes after you add the value, and Composer does a full-page-refresh.







There are two ways to access the Component Properties dialog: through Composer Design view and Composer Source view. This section describes both methods. It includes the following subsections:

	
Section 18.2.1.1, "Setting Layout Component Properties in Design View"


	
Section 18.2.1.2, "Setting Layout Component Properties in Source View"






18.2.1.1 Setting Layout Component Properties in Design View

To set layout components properties in Design view:

	
Go to the page of interest, and open it in Composer.




	
Tip:

One way to enter page edit mode (Composer) is to press Ctrl-Shift-E.








	
Click the Edit icon (Figure 18-3) on the layout component of interest to open the Component Properties dialog.


Figure 18-3 Edit Icon on a Layout Component

[image: Edit icon on a layout component]

Description of "Figure 18-3 Edit Icon on a Layout Component"





	
Edit component properties, and click OK when you finish.




	
Tip:

in addition to entering literal text (value), you can also enter an Expression Language (EL) expressions (#{value}). For information about EL expressions, see Appendix B, "Expression Language Expressions."










	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1. For more information about ELs in the Spaces application, see Appendix B, "Expression Language Expressions."
EL validation is not performed on non-generic display options.















	
See Also:

For information about properties associated with a particular layout component, see the section that covers the particular component. For example, see Section 18.2.2.2, "Setting Box Layout Component Properties" for information about properties associated with the Box layout component.
For detailed information about properties that are common to most types of components, see Section 17.5.2, "Setting Properties on Page Components."














18.2.1.2 Setting Layout Component Properties in Source View

To set layout component properties in Source view:

	
Go to the page of interest, and open it in Composer.




	
Tip:

One way to enter page edit mode (Composer) is to press Ctrl-Shift-E.








	
From the View menu, select Source (Figure 18-4).


Figure 18-4 Source Option on View Menu

[image: Source option on View menu]

Description of "Figure 18-4 Source Option on View Menu"





	
In the list of components, click the component of interest.


	
Click the Edit icon in the Source view header (Figure 18-5) to open the Component Properties dialog.


Figure 18-5 Edit Button and Selected Box Layout Component

[image: Edit button and selected Box layout component]

Description of "Figure 18-5 Edit Button and Selected Box Layout Component"





	
Edit component properties, and click OK when you finish.




	
Tip:

in addition to entering literal text (value), you can also enter an Expression Language (EL) expressions (#{value}). For information about EL expressions, see Appendix B, "Expression Language Expressions."










	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1. For more information about ELs in the Spaces application, seeAppendix B, "Expression Language Expressions."
For non-generic display options, EL validation is not performed.



















18.2.2 Working with the Box Layout Component

A Box is a content area that you can use to place other components on the page. Unlike its counterpart, Movable Box, a Box cannot be moved around the page at application runtime, though its content can be rearranged. This section provides an overview of the Box layout component and lists and describes its associated properties. It includes the following subsections:

	
Section 18.2.2.1, "What You Should Know About the Box Layout Component"


	
Section 18.2.2.2, "Setting Box Layout Component Properties"






18.2.2.1 What You Should Know About the Box Layout Component

The Box layout component is the landing place for the task flows, portlets, and layout components that you add to a page.

In page edit mode, a Box is typically rendered as rectangle comprised of dashed lines, an Add Content button, and Add a Tab Set or a Tab, Add Box, Edit, and Delete icons (Figure 18-6).


Figure 18-6 Box Layout Component

[image: Box layout component]

Description of "Figure 18-6 Box Layout Component"





Not all Box controls appear every time. What you see depends on your permissions, whether the Box is the top-most Box (which cannot be deleted, thus no Delete icon), whether the Box is stretched (in which case you cannot add other Boxes to it, thus no controls for doing so), and whether Box properties are set to show or omit certain controls (for more information, see Table 18-1, "Box Layout Component Display Options").

You can place content within a Box, and you can place one or more Boxes within a Box (unless the Box is configured to stretch its content, that is, the Box property Layout equals stretch). You can configure Box properties to display content horizontally, vertically, or stretched. You can specify the display of a scrollbar or set the Box to devote all its area to a single component (stretched). You can use Box controls to add Boxes above, below, or to either side of a given Box and to add a tab or a tab set within the Box.




	
See Also:

For information about adding tab sets and configuring tabs, see Section 17.3.5.5, "Creating Layered Content Regions Using Tabs."







You could, if you like, add one Box to a page, and use its controls to add all the Boxes and tabs you require, rather than adding multiple Boxes from the Resource Catalog for that purpose.






18.2.2.2 Setting Box Layout Component Properties

Box layout component properties provide a means of enabling or disabling the display of an Actions menu, a tab creation icon, and Box split icons; specifying the alignment and orientation of Box content; rearranging Box components; and providing tooltip text on the Box.

Box layout component properties include a Child Components tab with options for hiding, showing, and rearranging the Box content. For more information, see Section 17.5.2.6, "Working with Child Components."

A Style tab is available for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance— primarily the styles provided by the application skin. Box style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-1 lists and describes Box layout component display options.


Table 18-1 Box Layout Component Display Options

	Property	Description
	
Allow Action

	
Enables or disables the display of various actions on the Box and on the components you add to the box:

	
all—Show the Add Content button on the Box, show the Add Box icons, display the Actions menu on all child components that support it, and allow the movement of Movable Boxes into and out of the Box.


	
none—Hide the Add Content button on the Box, hide the Add Box icons, and disable the display of the Actions menu on all child components. Additionally, any Movable Boxes inside the Box are frozen and cannot be moved; and users cannot move Movable Boxes into the Box.





	
Horizontal Alignment

	
Specifies how Box content should align between its left and right boundaries:

	
start—Align content with the front position, determined by the reading order of the selected language. This value is provided to accommodate environments that support bidirectional languages.


	
center—Align content with the center of the Box.


	
end—Align content with the final position, determined by the reading order of the selected language. This value is provided to accommodate environments that support bidirectional languages.


	
left—Align content with the left side of the Box.


	
right—Align content with the right side of the Box.





	
Layout

	
Specifies the orientation of Box content:

	
vertical—Align Box content in a vertical orientation (that is, as a column of objects).


	
horizontal—Align Box content in a horizontal orientation (that is, as a row of objects). When Layout is set to horizontal, this component cannot be stretched by a parent component that stretches its children.


	
scroll—Align Box content vertically with a scrollbar. The scrollbar is rendered when the height/width of its content exceeds the Box's height or width.


	
stretch—The Box content stretches to accommodate the specified size of the Box. If no height (see Section 17.5.2.7, "Working with Style and Content Style Properties") is specified for the Box, it defaults to a height of 200 pixels, unless the Box is placed inside another stretching component. In this case, the Box height is controlled by its parent (but see, horizontal). When you select stretch, the Add Content button is hidden after one component is added to the Box, and you cannot drag and drop content into the Box. Additionally, you cannot split a Box with a Layout value of stretch.


	
auto—The child component is stretched only if the Box is stretched by its parent. If not, the content scrolls.





	
Short Desc

	
Specifies tooltip text for the Box

Tooltip text appears when users roll their mouse pointers over the Box.


	
Show Component

	
Hides or shows the component on the page:

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again using Composer Source view. In Source view, right-click the hidden component and select Show Component from the resulting context menu.


	
Show Split Action

	
Show or hide the icons that enable splitting a Box into one or more Boxes

	
Select the checkbox to show Add Box icons on the Box


	
Clear the checkbox to hide the icons on the Box





	
Show Tab Action

	
Show or hide the icon that enables adding tabbed regions to a Box

	
Select the checkbox to show the Add a Tab Set or a Tab icon on the Box


	
Clear the checkbox to hide the icon on the Box





	
Vertical Alignment

	
Specifies how Box content should align between its top and bottom boundaries:

	
top—Align content at the top of the Box.


	
middle—Align content with the middle of the Box.


	
bottom—Align content at the bottom of the Box.


	
baseline—Align content at the Box baseline, which is slightly above the bottom.




Vertical Alignment applies only when the layout is horizontal.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.3 Working with the Movable Box Layout Component

A Movable Box is a container wrapped around a Box that not only enables the placement of content on a page (via the Box), but also provides a means of moving all of that content at once in both page edit mode and page view mode. This section provides an overview of the Movable Box layout component. It includes the following subsections:

	
Section 18.2.3.1, "What You Should Know About the Movable Box Layout Component"


	
Section 18.2.3.2, "Setting Movable Box Layout Component Properties"






18.2.3.1 What You Should Know About the Movable Box Layout Component

The Movable Box layout component (Figure 18-7) enhances the features of a Box by adding mobility.


Figure 18-7 Movable Box Layout Component

[image: Movable Box layout component]

Description of "Figure 18-7 Movable Box Layout Component"





Users can grab the Movable Box by its header and drag it and all of its content to a new position on a page. Users can reposition a Movable Box in both page edit and page view modes. Movable Boxes can also be resized.




	
Tip:

Avoid adding a portlet to a Movable Box layout component. Adding a portlet to a Movable Box creates an unnecessary and potentially error-prone redundancy.












18.2.3.2 Setting Movable Box Layout Component Properties

The Display Options associated with Movable Boxes provide a means of hiding or showing the Movable Box header, providing header text, adding a tooltip to the Movable Box that users see when they roll their mouse pointers over the header, and other like controls.

Movable Box Display Options are common to many other types of components and are listed in Table 17-1, "Display Options Properties".

Movable Box Display Options are presented on two subtabs: Basic and Advanced (Figure 18-8).


Figure 18-8 Movable Box Layout Component Display Options

[image: Movable Box display options]

Description of "Figure 18-8 Movable Box Layout Component Display Options"





By default, each Movable Box encloses a Box layout component. For information about Box component properties, see Section 18.2.2.2, "Setting Box Layout Component Properties."








18.2.4 Working with the HTML Markup Layout Component

The HTML Markup layout component is a simple editor for adding HTML markup to a page. (This includes JavaScript embedded in HTML <script> tags.) This section provides an overview of the HTML Markup layout component and lists and describes its associated properties. It also provides a sample use case for embedding a YouTube video onto a page.

This section includes the following subsections:

	
Section 18.2.4.1, "What You Should Know About the HTML Markup Layout Component"


	
Section 18.2.4.2, "Setting HTML Markup Layout Component Properties"


	
Section 18.2.4.3, "Embedding Video, Music, Slides, and Other Types of Content"






18.2.4.1 What You Should Know About the HTML Markup Layout Component

The HTML Markup layout component is a simple editor for entering raw text and HTML tags, including JavaScript embedded in HTML <script> tags (Figure 18-9).


Figure 18-9 An HTML Markup Layout Component

[image: HTML Markup layout component]

Description of "Figure 18-9 An HTML Markup Layout Component"





Enter markup through the editor's component properties. Enter any type of valid HTML. Enclose JavaScript in the appropriate HTML markup. For example, enter (see Figure 18-10):


<script type="text/javascript">
   document.write("This is my JavaScript.");
</script>



Figure 18-10 Sample JavaScript in HTML Markup Display Options

[image: Sample JavaScript in HTML Markup component]

Description of "Figure 18-10 Sample JavaScript in HTML Markup Display Options"





The editor's header appears in page edit mode, but does not appear in page view mode. This enables you to place an individualized message on a page, for example, Welcome #{securityContext.userName}!, without cluttering the message with the component header.






18.2.4.2 Setting HTML Markup Layout Component Properties

HTML Markup layout component properties provide a means of entering a brief bit of HTML markup, JavaScript, text, or Expression Language (EL). For example, use the HTML Markup layout component to embed a personalized message to page visitors, a YouTube video, a Google Gadget, a Pandora Music Station, and the like (for more information, see Section 18.2.4.3, "Embedding Video, Music, Slides, and Other Types of Content").

In addition to content entry, use the properties on the Display Options tab to control text entry behavior and provide tooltip text (see Table 18-2).

HTML Markup layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. HTML Markup style properties are common to many other components, and are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-2 lists and describes HTML Markup layout component display options.


Table 18-2 HTML Markup Layout Component Display Options

	Property	Description
	
Escape

	
A checkbox for enabling or disabling literal evaluation of special characters

Use this property to make the output safe or not safe. Safe means that any tags, such as <script> are escaped into &lt;script&gt; so that they do not run. Not safe means whatever you enter for value finds its way onto the page, even if it does something undesirable.

	
Checked (true) enables literal evaluation of such characters as angle brackets (<|>) and HTML special characters. For example, when a user enters &#8212; it is rendered as &#8212;.


	
Cleared (false) disables literal interpretation of special characters. For example, when a user enters &#8212;, it is rendered as —. False is the default value.





	
No Wrap

	
A checkbox for enabling or disabling text wrapping

	
Checked (true) disables text wrapping. Users must enter line breaks manually.


	
Cleared (false) enables text wrapping. Lines wrap in accordance with the component width. False is the default value.





	
Short Desc

	
A field for entering tooltip text for the HTML Markup layout component

When users roll their mouse pointers over the component, this text appears as a tooltip.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Value

	
A field for specifying the content that this component renders

In addition to text, this parameter also accepts HTML, JavaScript, and Expression Language (EL) expressions. For guidelines and examples, see Section 18.2.4.1, "What You Should Know About the HTML Markup Layout Component," and Section 18.2.4.3, "Embedding Video, Music, Slides, and Other Types of Content."

After you save your changes and close the page editor, the HTML Markup component shows the evaluated value of the markup.











	
Tip:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.4.3 Embedding Video, Music, Slides, and Other Types of Content

You can use the HTML Markup layout component to publish video, music, Google Gadgets, and other types of content to your application pages. This section describes how.




	
Note:

When you add a component to a page, you must wait for the application status indicator to finish processing before taking additional action.







To embed different types of media on an application page:

	
Copy the HTML code you want to embed.

For example:


<object width="640" height="385">
  <param name="movie"
      value="http://www.youtube.com/v/cAYw2zcSIPw?fs=1&amp;hl=en_US" />
  <param name="allowFullScreen" value="true" />
  <param name="allowscriptaccess" value="always" />
  <embed src="http://www.youtube.com/v/cAYw2zcSIPw?fs=1&amp;hl=en_US"
      type="application/x-shockwave-flash" allowscriptaccess="always"
      allowfullscreen="true" width="640" height="385" />
</object>


	
Go to the application page of interest, and open the page in edit mode.




	
Tip:

One way to enter page edit mode (Composer) is to press Ctrl-Shift-E.








	
In the Box or Movable Box of interest, click the Add Content button to open the Composer Catalog.


	
Click the Open link next to Web Development, and then click the Add link next to HTML Markup.

Optionally, use the Catalog Search feature to locate the HTML Markup layout component, and then click the Add link next to the component.


	
Click the Close button to close the Catalog.


	
Click the Edit icon on the HTML Markup component (Figure 18-11) to open the Component Properties dialog.


Figure 18-11 Edit Icon on an HTML Markup Layout Component

[image: Edit icon on an HTML Markup layout component]

Description of "Figure 18-11 Edit Icon on an HTML Markup Layout Component"





	
Click the Display Options tab to bring it forward, and then, in the Value field, paste the copied HTML code.


	
Click OK to close the Component Properties dialog.


	
Click Save and then Close to exit Composer.











18.2.5 Working with the Links Layout Component

Use the Links layout component to add a navigation instance to a page. Links component navigation can include links to pages, external web sites, and application content. A browse capability is available to simplify the process of locating link targets. An advanced search feature is also available to assist in locating application objects, such as a Documents service file.

This section provides information about the Links layout component, how to set it up, and how to configure its properties. It includes the following subsections:

	
Section 18.2.5.1, "What You Should Know About the Links Layout Component"


	
Section 18.2.5.2, "Configuring the Links Component"


	
Section 18.2.5.3, "Setting Links Layout Component Properties"






18.2.5.1 What You Should Know About the Links Layout Component

The Links layout component enables you to add a single instance of navigation to an application page, outside the more formal structure of your portal's navigation (Figure 18-12).


Figure 18-12 Links Layout Component

[image: Links layout component]

Description of "Figure 18-12 Links Layout Component"





The links component is associated with the page or template on which it is placed. When you put a links component on a page and add some links, those links are associated with the page. That is, the lifecycle of the links component respects the lifecycle of the page or template on which it is placed. For example:

	
When a page containing links is copied, all the links are also copied, and the page copy has its own set of links. Modifying links on the original page does not affect the page copy. The same is true for links on page templates.


	
When a page is deleted, all links associated with the page are also deleted. The same is true for links on page templates.


	
If a space template contains pages with links, creating a new space based on the template effectively creates a clone of the template. Consequently, the new space has links that are separate from the ones in the template.


	
When a space is exported or imported, any links associated with space pages are also exported or imported.




The Links component's Add, Edit, and Delete Link UI is available in both page view and page edit modes to users with Edit Page permission on the page. Users without Edit Page permission see only the added navigation links. Changes in both edit and view modes are visible to all users who can view the page. That is, the addition of links falls outside the constraints of user customization, where changes made in page view mode are visible only to the user who made them.

A control is available for specifying that a link target is opened within the context of the current page template or in place of the page on which it was invoked. There are also controls on each link for configuring a given link's properties and deleting the link (Figure 18-13).


Figure 18-13 Controls on Individual Links

[image: Controls on individual links]

Description of "Figure 18-13 Controls on Individual Links"





The Links component's properties provide opportunities for controlling the behavior and look and feel of a Links component instance. For more information, see Section 18.2.5.3, "Setting Links Layout Component Properties."






18.2.5.2 Configuring the Links Component

This section steps you through the process of setting up informal navigation using the Links component. It includes the following sections:

	
Section 18.2.5.2.1, "Adding Navigation Links Using the Links Component"


	
Section 18.2.5.2.2, "Configuring an Advanced Search for Content Links"


	
Section 18.2.5.2.3, "Configuring a Link in the Links Component"


	
Section 18.2.5.2.4, "Reordering Navigation Links"


	
Section 18.2.5.2.5, "Deleting a Link from the Links Component"






18.2.5.2.1 Adding Navigation Links Using the Links Component

To add links using the Links component:

	
Open the Add Link menu and select a link type:

	
Page Link—Add a link that targets an application page.


	
External Link—Add a link that targets a site that is external to the application.


	
Content Link—Add a link that targets a document from a content repository.




To add a Page Link: 

	
Select Page Link to open the New Page Link dialog (Figure 18-14).


Figure 18-14 New Page Link Dialog

[image: New Page Link dialog]

Description of "Figure 18-14 New Page Link Dialog"





	
In the Name field, enter a display name for the link.


	
For Path, click Browse to open the Select a Page dialog (Figure 18-15).


Figure 18-15 Select a Page Dialog

[image: Select a page dialog]

Description of "Figure 18-15 Select a Page Dialog"





	
Select a page from the given options, or click Search to locate a page on the available list of pages.




	
Tip:

In the Home space, you can select from pages that are available to you in your view of the Home space. In other spaces, you can select from pages that are available within the scope of the current space.








	
Click Select.


	
Click OK.




To add an External Link: 

	
Select External Link to open the New External Link dialog (Figure 18-16).


Figure 18-16 New External Link Dialog

[image: New External Link dialog]

Description of "Figure 18-16 New External Link Dialog"





	
In the Name field, enter a display name for the link.


	
In the URL field, enter the URL to the link target, for example:


http://www.mywebdestination.com


	
Select Render in page template to present the link target content within the context of the current page template.

Clear this checkbox to redirect the current page to the link target.


	
Click OK.




To add a Content Link: 

	
Select Content Link to open the New Content Link dialog (Figure 18-17).


Figure 18-17 New Content Link Dialog

[image: New Content Link dialog]

Description of "Figure 18-17 New Content Link Dialog"





	
In the Name field, enter a display name for the link.


	
For Path, click Browse to open the Select Document dialog (Figure 18-18).


Figure 18-18 Select Document Dialog

[image: Select Document dialog]

Description of "Figure 18-18 Select Document Dialog"





If the link target is not on view, you can use the Filter feature to locate it. For a more pointed search, click Advanced. For more information, see Section 18.2.5.2.2, "Configuring an Advanced Search for Content Links."


	
Click Select.


	
Click OK.












18.2.5.2.2 Configuring an Advanced Search for Content Links

The Links component's Advanced Search feature provides controls for specifying additional search criteria and filters for Content Links searches (Figure 18-19).


Figure 18-19 Advanced Search Dialog

[image: Advanced Search dialog]

Description of "Figure 18-19 Advanced Search Dialog"





This search is very similar to an advanced document search. For more information, see Section 41.31.2, "Running an Advanced Document Search."






18.2.5.2.3 Configuring a Link in the Links Component

Users with Edit Page permission on the page can access a configure control on a given link to revise the link's name and target. If you can see the Configure icon to the right of a link, you are authorized to configure links (Figure 18-20).


Figure 18-20 Configure Icon on a Link

[image: Configure icon on a link]

Description of "Figure 18-20 Configure Icon on a Link"





To configure a link in the Links component:

	
Go to the Links component instance of interest.


	
Click the Configure icon to open the Edit type Link dialog (Figure 18-21).


Figure 18-21 Edit Page Link Dialog

[image: Edit Page Link dialog]

Description of "Figure 18-21 Edit Page Link Dialog"





	
Revise the values as required.




	
Note:

Different link types present different fields and require different values.
For information about the values required by Edit type Link fields, see Section 18.2.5.2.1, "Adding Navigation Links Using the Links Component."










	
Click OK.









18.2.5.2.4 Reordering Navigation Links

You can reorder navigation links in a Links layout component by dragging and dropping:

	
Click and hold on a link.


	
Drag the link to its new position on the list.


	
Release the link.









18.2.5.2.5 Deleting a Link from the Links Component

Authorized users can access a delete control on a given link to remove the link from the Links component. If you can see the Delete icon to the right of each link, you are authorized to delete links (Figure 18-22).


Figure 18-22 Delete Icon on a Link

[image: Delete icon on a link]

Description of "Figure 18-22 Delete Icon on a Link"





To delete a link from the Links component:

	
Go to the Links component instance of interest.


	
Click the Delete icon next to the link of interest.


	
Click the Delete button in the confirmation dialog.











18.2.5.3 Setting Links Layout Component Properties

The Display Options you set on the Links layout component affect only the particular instance. Links Display Options are common to many other components. Commonly shared Display Options are listed and described in Section 17.5.2.5, "Working with Component Display Options."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Links style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties." The styles you set on the Links component override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application skin.








18.2.6 Working with the Hyperlink Layout Component

Use the Hyperlink layout component to add a link to a page. The Hyperlink can point to a location that is either internal or external to the application. This section provides an overview of the Hyperlink layout component and lists and describes its unique properties.

This section includes the following subsections:

	
Section 18.2.6.1, "What You Should Know About the Hyperlink Layout Component"


	
Section 18.2.6.2, "Setting Hyperlink Layout Component Properties"






18.2.6.1 What You Should Know About the Hyperlink Layout Component

A Hyperlink layout component (Figure 18-23) is comprised of two elements: the link text and the link URL, both of which are added through component properties.


Figure 18-23 Hyperlink Layout Component

[image: Hyperlink layout component]

Description of "Figure 18-23 Hyperlink Layout Component"





Hyperlinks can take both internal and external link targets. For an internal target, you can use a relative directory path. For an external target, that is, a target outside of the Spaces application, always use the full URL.




	
Tip:

An easy way to obtain the relative directory path of a Spaces application page is to navigate to the target page and go through the motions of adding it as a Favorite. By default, the Add Favorite dialog provides the relative URL of the current page. Simply copy this information, and use it to define the Hyperlink target. For information about adding a Favorite to the Spaces application, see Section 37.3, "Adding Favorites."
An easy way to obtain the direct URL to a Spaces application page is to access its About this Page dialog. For more information, see Section 29.9.2, "Accessing Page Information."









Hyperlink layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. Hyperlink style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."






18.2.6.2 Setting Hyperlink Layout Component Properties

Hyperlink layout component properties provide a means of specifying link text, target destination, and open behavior.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-3 lists and describes Hyperlink layout component display options.


Table 18-3 Hyperlink Layout Component Display Options

	Property	Description
	
Destination

	
A field for entering the hyperlink target URL

Enter the web address of the page to link to.


	
Open in a new window

	
Option for determining link target open behavior

	
Select to open the link target in a new browser tab or window.


	
Clear to open the link target in the current browser tab or window.





	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Title

	
A field for specifying hyperlink text

Enter a word or phrase to use as link text.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.7 Working with the Image Layout Component

There are two places in the Resource Catalog from which to add images:

	
The Image layout component


	
Image files from the Documents folder




Unlike images from the Documents folder, Image layout components provide controls for associating a link target with the image. You have the option of associating or omitting a link with an Image layout component.




	
Tip:

Another difference between image files from the Documents folder and an Image layout component is that image files can be discovered in a search, Image layout components cannot, preventing a return of irrelevant search results.







This section provides an overview of the Image layout component, and lists and describes its associated properties.

This section includes the following subsections:

	
Section 18.2.7.1, "What You Should Know About the Image Layout Component"


	
Section 18.2.7.2, "Setting Image Layout Component Properties"







	
See Also:

For information about using images from the Documents service, see Section 41.1, "What You Should Know About the Documents Service Task Flows."









18.2.7.1 What You Should Know About the Image Layout Component

Use the Image layout component to add a picture, a logo, a linked image, and the like to a page (Figure 18-24).


Figure 18-24 Image Layout Component

[image: Image layout component]

Description of "Figure 18-24 Image Layout Component"





Use any web-compatible image from any accessible location. Do not use images from an external server that requires authentication.




	
Tip:

If you want to display an image that is not linked and is returned in a search, consider using the Documents service Content Presenter task flow in lieu of the Image layout component. For more information, see Section 41.1, "What You Should Know About the Documents Service Task Flows."












18.2.7.2 Setting Image Layout Component Properties

Image layout component properties provide a means of specifying the location of the image file, an optional hyperlink target, ALT text, and a target frame for the hyperlink.

Image layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. Image style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-4 lists and describes Image layout component display options.


Table 18-4 Image Layout Component Display Options

	Property	Description
	
Depressed Icon

	
A URL to the image that represents the image in a clicked state

Use any web-compatible image from any internal or publicly-accessible location.


	
Destination

	
A URL for the Image link target destination

For your link target, you can use URLs that are internal or external to the application.

For an internal target, that is, for a Spaces application page, you can use a directory path relative to the application root directory.


	
Disabled Icon

	
A URL to the image that represents the image in a disabled state

Use any web-compatible image from any internal or publicly-accessible location.


	
Hover Icon

	
A URL to the image that represents the image when a mouse pointer hovers over it

Use any web-compatible image from any internal or publicly-accessible location.


	
Icon

	
The URL to the image file that represents the image in its active, unclicked state

Use any web-compatible image from any internal or publicly-accessible location.


	
Icon Position

	
A selection of options for placement of the image

	
leading—The image renders at the start of its associated text


	
trailing—The image renders at the end of its associated text





	
Short Desc

	
Image ALT text

ALT text appears as a tooltip when users roll their mouse pointers over the image.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Target Frame

	
Open behavior for the link target

Enter any standard browser target, such as:

	
_top—Loads the link target in the current browser window (as opposed to the current frame)


	
_parent—Loads the link target in the parent frame of the current frame.


	
_self—Loads the link target within the same frame as the frame containing the link.


	
_blank—Loads the link target in a new browser tab or window, without closing the original tab or window.





	
Text

	
An optional text label to accompany the image

The Icon Position value determines whether the image is placed before or after the text specified here.


	
Text And Access Key

	
Sets both text and an access key on the image

The access key is denoted by a leading ampersand (&amp;). For example, enter &amp;click me to set the text to click me and the access key to c.

An access key provides a keyboard shortcut to an action. In this case, users press Alt-<access_key>, or Alt-Shift-<access_key> to jump to the image's target destination. The keys that users press to engage the access key depend on the requirements of their browsers.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.8 Working with the Text Layout Component

The Text layout component provides access to a simple editor you can use to add a brief statement, page instructions, or any other kind of informative content to a page. This section provides an overview of the Text layout component and lists and describes its associated properties.

This section includes the following subsections:

	
Section 18.2.8.1, "What You Should Know About the Text Layout Component"


	
Section 18.2.8.2, "Setting Text Layout Component Properties"






18.2.8.1 What You Should Know About the Text Layout Component

The Text layout component provides a convenient way to add static display text and HTML to a Spaces application page (Figure 18-25).


Figure 18-25 Text Layout Component

[image: Text layout component]

Description of "Figure 18-25 Text Layout Component"





The Text layout component provides a simplified rich text editor, which you can use to enter text, apply text styles, and add links and images (Figure 18-26).


Figure 18-26 Text Layout Component Text Editor

[image: Text layout component text editor]

Description of "Figure 18-26 Text Layout Component Text Editor"









18.2.8.2 Setting Text Layout Component Properties

The Display Options associated with the Text layout component provide a means of hiding or showing the component header, providing header text, adding a tooltip that users see when they roll their mouse pointers over the header, and other like controls.

Text Display Options are common to many other types of components and are listed in Table 17-1, "Display Options Properties".

Text layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and through the application skin. Text style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."








18.2.9 Working with the Web Page Layout Component

The Web Page layout component provides a means of opening a view onto another web page within the context of an application page. This section provides an overview of the Web Page layout component and lists and describes its associated properties.

This section includes the following subsections:

	
Section 18.2.9.1, "What You Should Know About the Web Page Layout Component"


	
Section 18.2.9.2, "Setting Web Page Layout Component Properties"






18.2.9.1 What You Should Know About the Web Page Layout Component

The Web Page layout component provides a means of displaying a window onto another web page within the context of a Spaces application page (Figure 18-27).


Figure 18-27 Web Page Layout Component

[image: Web Page layout component]

Description of "Figure 18-27 Web Page Layout Component"





The content exposed through a Web Page layout component retains all of the controls associated with the exposed web page. These controls retain their functionality, enabling you to, for example, control the volume of a video, edit a wiki, or post an entry to a blog, depending on the type of content you expose.

You can use internal and external link targets for a Web Page. For an internal target, you can use a relative directory path.




	
Tip:

In the Spaces application, an easy way to obtain the relative directory path of an application page is to navigate to the target page and go through the motions of adding it as a Favorite. By default, the Add Favorite dialog provides the relative URL of the current page. Simply copy this information, and use it to define the Web Page target.
For information about adding a Favorite to the Spaces application, see Chapter 37, "Creating and Managing Your Personal Favorites."









The Web Page layout component provides a variation on the Web Page page style offered through the Create Page dialog (for more information, see Table 15-2, "Default Page Styles"). The Web Page page style is useful for offering the full external web page experience. In contrast, the Web Page layout component is useful for including web page content along with other content types on an application page.

Web Page layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. Web Page style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."






18.2.9.2 Setting Web Page Layout Component Properties

Web Page layout component properties provide a means of specifying the URL of the content to render in the Web Page area and the ALT text to display when users roll their mouse pointers over the component border.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-5 lists and describes Web Page layout component display options.


Table 18-5 Web Page Layout Component Display Options

	Property	Description
	
Short Desc

	
A field for entering ALT text for the Web Page area

Note that, for the Web Page component, the ALT text appears only when users hover their mouse pointers over the component border. You can increase the active area by increasing the padding around the component using the Other CSS property on the Component Properties Style tab. For example, you can enter the following in the Other CSS text box:


padding-top:30px;


	
Source

	
A field for entering the fully qualified URL to the source Web content to render in the Web Page area

For example:


http://www.oracle.com


Note that www.oracle.com (that is, without http://) does not qualify. If a given URL is invalid, your content does not render within the Web Page layout component.

Note: Use the component's Style properties to adjust the width and height of the display area (for more information, see Section 17.5.2.7, "Working with Style and Content Style Properties").

If you plan to display the content of another Spaces application page, you can use a relative address. For more information, see Section 18.2.9.1, "What You Should Know About the Web Page Layout Component."


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.10 Working with Internal Layout Components

This section provides information about the types of layout components that support page infrastructure, but are not available through the Resource Catalog (thus, internal). Such components are exposed through Source view of page edit mode.

This section includes the following subsections:

	
Section 18.2.10.1, "What You Should Know About Internal Layout Components"


	
Section 18.2.10.2, "Setting panelGroupLayout Properties"


	
Section 18.2.10.3, "Setting panelStretchLayout Properties"


	
Section 18.2.10.4, "Setting panelTabbed Properties"


	
Section 18.2.10.5, "Setting showDetailFrame Properties"


	
Section 18.2.10.6, "Setting sidebarItem Properties"


	
Section 18.2.10.7, "Setting spacer/Separator Properties"






18.2.10.1 What You Should Know About Internal Layout Components

Some page layout components are not exposed for use in the Catalog. They are nonetheless on view and configurable when you edit a page and set Composer to Source view (Figure 18-28).


Figure 18-28 Internal Layout Components in Source View

[image: Internal layout components in Source view]

Description of "Figure 18-28 Internal Layout Components in Source View"





Table 18-6 lists and describes the internal layout components you are likely to encounter in Source view of page edit mode.


Table 18-6 Internal Layout Components

	Layout Component	Description
	
panelGroupLayout

	
Provides a means of arranging a series of child components vertically or horizontally (no wrapping), or consecutively (wrapping). The Layout property determines the arrangement of the child components. For more information, see Section 18.2.10.2, "Setting panelGroupLayout Properties."


	
panelStretchLayout

	
Provides a means of arranging content in defined areas on a page. Useful useful for enabling content to stretch when the browser is resized. For more information, see Section 18.2.10.3, "Setting panelStretchLayout Properties."


	
panelTabbed

	
The parent component of a tab set. For more information, see Section 18.2.10.4, "Setting panelTabbed Properties."


	
showDetailFrame

	
Renders a border, or chrome, around its child component along with a header that contains icons to enable users to perform some operations. These include a menu icon with options for moving the component, along with its content, to new positions on the page. Users can drag and drop showDetailFrame components from one panelCustomizable component to another on the page. Note that a showDetailFrame must be included inside a panelCustomizable component for it to be movable.

For more information, see Section 18.2.10.5, "Setting showDetailFrame Properties."


	
sidebarItem

	
A child component of a tab set (panelTabbed). For more information, see Section 18.2.10.6, "Setting sidebarItem Properties."


	
spacer

	
Provides a means of incorporating some blank space in pages so that the page appears less cluttered than it would if all the components were presented immediately next to each other or immediately below each other. For more information, see Section 18.2.10.7, "Setting spacer/Separator Properties."











	
See Also:

For information about setting component properties, see Section 18.2.1, "Setting Properties on a Layout Component."












18.2.10.2 Setting panelGroupLayout Properties

The panelGroupLayout component provides a means of arranging a series of child components vertically or horizontally (no wrapping), or consecutively (wrapping). The component's Layout property determines the arrangement of child components.

Properties for the panelGroupLayout component include a Child Components tab with options for hiding, showing, and rearranging component content. For more information, see Section 17.5.2.6, "Working with Child Components."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-7 lists and describes the panelGroupLayout properties that appear on the Display Options tab in the Component Properties dialog.


Table 18-7 panelGroupLayout Display Options

	Property	Description
	
Halign

	
A means of expressing the horizontal alignment of component content

Select one of:

	
start—align content horizontally, starting from the starting position

This is either left or right depending on whether the current context is localized for a left-reading or right-reading language.


	
center—align content horizontally, starting from the center


	
end—align content horizontally, starting from the ending position

This is either right or left depending on whether the current context is localized for a left-reading or right-reading language.


	
left—align content horizontally, starting from the left


	
right—align content horizontally, starting from the right





	
Landmark

	
A means of enhancing user accessibility as described by the Web Accessibility Initiative for Accessible Rich Internet Applications (WAI-ARIA). Each option describes the intended role of a content area to assist in using the area as a navigational landmark on the page.

Screen readers and other assistive technologies can make use of these landmarks in page navigation.

Select an option to clarify the role or purpose of a content area's content:

	
none—A content area that is not intended as a page navigational landmark


	
banner—A content area containing mostly site-oriented content, rather than page-specific content, such as the company logo or the portal-wide search feature

Typically, a banner appears at the top of a page and spans the page width.


	
complementary—Supporting content, designed to be complementary to the main content at a similar level on the page, but still meaningful when separated from the main content, such as related documents


	
contentinfo—A content area that contains information about the application, such as the copyright or privacy statement.


	
main—The main content area of the page


	
navigation—A collection of navigational elements (usually links) for navigating the page or related pages.


	
search—A content area that contains one or more widgets used to define and execute a search.





	
Layout

	
A means of specifying the orientation of component content

Choose from:

	
default—align content vertically.


	
horizontal—align content horizontally


	
vertical—align content vertically


	
scroll—align content vertically with a scrollbar

The scrollbar is rendered when the height/width of component content exceeds the component height or width.





	
Short Desc

	
A field for entering ALT text for the component

ALT text appears as a tooltip when users roll their mouse pointers over the component.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Theme

	
The component style theme to apply to the children of this component. Use this property to change the theme without causing associated skin changes. Application skins are the sources of the themes. Some skins may have no theme definitions.

Enter one of:

	
dark


	
medium


	
light




No theme (none) is the default.


	
Valign

	
A means of expressing the vertical alignment of component content.

Select one of:

	
middle—content is aligned with the middle of the parent component


	
top—content is aligned with the top of the parent component


	
bottom—content is aligned with the bottom of the parent component


	
baseline—content is aligned with the baseline of the parent component














	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.10.3 Setting panelStretchLayout Properties

The panelStretchLayout component provides a means of arranging content in defined areas on a page. This component is useful for enabling content to stretch when the browser is resized.

The panelStretchLayout component's defined areas are called facets (Figure 18-29).


Figure 18-29 Facets of a panelStretchLayout Component

[image: facets of a panelStretchLayout component]

Description of "Figure 18-29 Facets of a panelStretchLayout Component"








	
Note:

Figure 18-29 shows the facets when the language reading direction of the application is configured left-to-right. If instead the language direction is right-to-left, the start and end facets are switched.







Facets are controlled by the values you enter for its Display Options properties. When you set the height of the top and bottom facets, any contained components are stretched to fit the height. Similarly, when you set the width of the start and end facets, any components contained in those facets are stretched to that width. If no components are placed in a facet, then the facet does not take up any space.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-8 lists and describes the panelStretchLayout properties that appear on the Display Options tab in the Component Properties dialog.




	
Note:

All panelStretchLayout height and width facets take the value auto; however, using auto slows page performance.








Table 18-8 panelStretchLayout Display Options

	Property	Description
	
Bottom Height

	
The height of the bottom facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect. If you want your component to take up 100% of a page, consider creating a page using the Stretch page style and adding the component to it.


	
End Width

	
The width of the end facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Start Width

	
The width of the start facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.


	
Theme

	
The component style theme to apply to the children of this component. Use this property to change the theme without causing associated skin changes. Application skins are the sources of the themes. Some skins may have no themed definitions.

Enter one of:

	
dark


	
medium


	
light




No theme (none) is the default.


	
Top Height

	
The height of the top facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect. If you want your component to take up 100% of a page, consider creating a page using the Stretch page style and adding the component to it.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.10.4 Setting panelTabbed Properties

The panelTabbed layout component is the parent component of a tab or tab set. Its unique set of Display Options controls the behind-the-scenes method of tab creation, the source for the tabs dimensions, the tab's position, and the like.




	
See Also:

For information about working with tabs, see Section 17.3.5.5, "Creating Layered Content Regions Using Tabs."







Table 18-9 lists and describes Display Options associated with the panelTabbed layout component.


Table 18-9 panelTabbed Display Options

	Property	Description
	
Child Creation

	
Specifies when tab content is rendered

	
immediate—All tab content is rendered as soon as the page is accessed.


	
lazy—Tab content is rendered when the tab is brought forward and is maintained in cache thereafter. This selection may enhance performance when content is fetched from cache.


	
lazyUncached—Tab content is rendered when the tab is likely to be brought forward and may be removed when the tab is not forward.





	
Dimensions From

	
Specifies the source of the dimensions applied to the component

	
auto—Either parent or disclosedChild, depending on the panelTabbed parent container. If the parent's Layout attribute is set to stretch, then parent is used; otherwise disclosedChild is used.


	
disclosedChild—The dimension is taken from the currently active tab.


	
parent—(default) The dimension is taken from any values specified on the component; if no values are specified, then they are taken from the parent; if no values are specified on the parent, then they are taken from the skin.





	
Position

	
The position of the tab portion of the panelTabbed

	
above—(default) Tabs are shown above the tab content area.


	
below—Tabs are shown below the tab content area.


	
both—Tabs are shown above and below the tab content area.




In accessibility screen reader mode, the tab position is always above.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Tab Removal

	
Specifies whether some, none, or all tabs can be removed

	
none—Tabs cannot be deleted from the tab set


	
all—All tabs can be deleted from the tab set


	
allExceptLast—All but one the last tab can be deleted from the tab set

Note: The selection allExceptLast renders a Close icon on all except the last tab when users hover their mouse pointers over them. Additional coding is required on the panelTabbed component before the Close action can execute.

Developers must write code to respond to ItemEvent with a listener attached to the showDetailItem's itemListener attribute. For example:


<af:panelTabbed tabRemoval="allExceptLast" id="pt1">
   <af:showDetailItem itemListener="myBean.onRemove" id="sdi1">
…


Write the deletion code in a Java bean named myBean with the method onRemove.














	
See Also:

For information about working with tabs, see Section 17.3.5.5, "Creating Layered Content Regions Using Tabs."












18.2.10.5 Setting showDetailFrame Properties

The showDetailFrame component renders a border, or chrome, around its child component along with a header that contains icons to enable users to perform some operations. These include a menu icon with options for moving the component, along with its content, to new positions on the page. Users can drag and drop showDetailFrame components from one panelCustomizable component to another on the page. Note that a showDetailFrame must be included inside a panelCustomizable component for it to be movable.

A showDetailFrame component enables the following actions:

	
Collapse and expand the component


	
Move content to different positions on the page


	
Rearrange task flows using options on the Actions menu


	
Edit and save text in a text editor.




The Display Options associated with showDetailFrame are common to many other types of components and are listed in Table 17-1, "Display Options Properties" with one exception: the showDetailFrame layout component does not expose the property Allow Child Selection.

Display Options for showDetailFrame are presented on two subtabs: Basic and Advanced (Figure 18-30).


Figure 18-30 Basic and Advanced Display Options

[image: Basic and Advanced display options]

Description of "Figure 18-30 Basic and Advanced Display Options"









18.2.10.6 Setting sidebarItem Properties

The sidebarItem component is a child component of panelTabbed (see Section 18.2.10.4). Unlike panelTabbed, which provides all of the properties associated with a tab set, sidebarItem provides all of the properties associated with a single tab.

Table 18-10 describes the sidebarItem properties that appear on the Display Options tab in the Component Properties dialog.


Table 18-10 sidebarItem Display Options

	Property	Description
	
Disclosed

	
Indicates the current active tab, that is, the tab that is forward

This value is set by default depending on whether the selected tab is forward. Changes you make to this value have no effect.


	
Icon

	
The URL to an image

Use any Web-compatible image from any accessible location. That is, do not put in a path to an image on an external server that requires authentication.

Enter a full URL or a URL that is relative to the application root. Use CSS formatting. For example, enter:


url(http://www.abc.com/image.jpg)


	
Inflexible Height

	
The number of pixels the component will use when in a container that allocates size among multiple sibling items

If the component requires more than the set limit, its sibling components are pushed to overflow menus. The default is 100 pixels.

Note: This attribute is valid only when the parent container is a panelAccordion component.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Text

	
The text to render on the tab

The default value, an EL expression, evaluates to New Tab.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.10.7 Setting spacer/Separator Properties

The spacer component provides a means of incorporating some blank space in pages so that the page appears less cluttered than it would if all the components were presented immediately adjacent to each other.




	
Tip:

In the Resource Catalog, this component is called a Separator.










	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-11 lists and describes the spacer properties that appear on the Display Options tab in the Component Properties dialog.


Table 18-11 spacer Display Options

	Property	Description
	
Height

	
A field for specifying the spacer height

Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Composer Source view. In Source view, right-click the hidden component, and select Show Component from the resulting context menu.


	
Width

	
A field for specifying spacer width

Use any standard CSS unit of measure, such as pt, px, pc, li, %, and so on.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."
















18.3 Deleting Layout Components

When you delete a layout component, such as a Box, all of the component's children—that is, anything contained in the component—are also deleted. For example, if you delete a Box that contains multiple task flows, the Box and all of the task flows it contains are deleted.

The controls for deleting a component are located on the component itself in Composer Design view and on the header of the list of components in Source view. This section describes how to delete layout components in both Design view and Source view. It includes the following subsections:

	
Section 18.3.1, "Deleting a Layout Component in Design View"


	
Section 18.3.2, "Deleting a Layout Component in Source View"






18.3.1 Deleting a Layout Component in Design View

To delete a layout component in Design view:

	
Go to the page where you want to delete a layout component, and open it in Composer.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
If necessary, open the View menu and select Design.


	
Click the Remove icon on the component header or, if no header is shown, on the component's floating palette (Figure 18-31).


Figure 18-31 Remove Icon on a Layout Component

[image: Remove icon on a layout component]

Description of "Figure 18-31 Remove Icon on a Layout Component"





	
In the resulting confirmation dialog, click the Delete button.

The layout component is permanently removed from the page. If the layout component had any child components, those child components are deleted as well.









18.3.2 Deleting a Layout Component in Source View

To delete a layout component in Source view:

	
Go to the page where you want to delete a layout component, and open it in Composer.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
From the View menu, select Source (Figure 18-32).


Figure 18-32 Source Option on View Menu

[image: Source option on View menu]

Description of "Figure 18-32 Source Option on View Menu"





	
In the list of components, select the component to delete.


	
Click the Delete button on the list header (Figure 18-33).


Figure 18-33 Delete Button in Source View

[image: Delete button in Source view]

Description of "Figure 18-33 Delete Button in Source View"





	
In the resulting confirmation dialog, click the Delete button.

The layout component is permanently removed from the page. If the layout component had any child components, those child components are deleted as well.














19 Wiring Pages, Task Flows, Portlets, and UI Components

Often a page needs information from a component on the page, or a region needs information from another region. While you can pass parameters through the page URL to obtain that information, doing so makes sense only when the parameters are well-known and the inputs are accessible to the page through Expression Language (EL). For more information, see Section 19.4, "Passing Parameter Values Through the Page URL."

Consider the case where you have a task flow with multiple page fragments that contain various interesting values that could be used as input on a page in the flow. For example, consider a page devoted to the display of information specific to the company that a user specifies in an input form. If you were to use parameters to pass the value, the task flow must surface output parameters for the union of each of the interesting values on each and every fragment. This is where component wiring becomes useful. Instead, for each fragment that contains the needed information, you can use component wiring to define a contextual event that is raised when the page is submitted. The page or fragment that requires the information can then subscribe to the various events and receive the information through the event.

Composer provides tools for wiring pages and components through its Page Properties and Component Properties dialogs. This chapter describes the use of these tools in the following sections:

	
Section 19.1, "What You Should Know About Parameter and Event Wiring"


	
Section 19.2, "Wiring One Component to Another"


	
Section 19.3, "Wiring Components and Page Parameters"


	
Section 19.4, "Passing Parameter Values Through the Page URL"







	
Note:

If you navigate away from a page while editing it, unsaved changes are lost.








Audience

This chapter is intended for advanced users who have experience with and knowledge of component wiring. Interested users include those who want to create more complex relationships between a page and its components and between the components themselves.



19.1 What You Should Know About Parameter and Event Wiring

You can use parameters and events to pass values from one component to another, or from a page to a component on that page. Additionally, you can pass values to page components by specifying them in the page's URL.




	
Note:

In this chapter, component refers collectively to UI components, such as buttons; layout components, such as hyperlinks; task flows; and portlets.







Value passing is useful for synchronizing the content of a page with its components, or the content of one component to another. For example, you can wire a Parameter Form portlet so that the event of clicking its OK button triggers the passing of its user-entered values to another component on the page. One way to apply this model is to pass a user-entered name to a task flow or portlet that displays details relevant to that name.

To clarify what it going on in a parameter passing scenario, it helps to think of one component as the producer and the other component as the consumer. The producer component provides the payload that the consumer component consumes. For example, a form portlet is typically a producer. Its payload is the data that users enter into the form. An event defined on the producer triggers the passing of the producer's payload to the consumer. Consumer components use the payload in various ways. For example, as a display string, a master in a master-detail relationship, and the like. How a consumer component uses the payload is specified in an event handler that was defined when the consumer component was created.

The heavy lifting required to produce meaningful parameter and event wiring is performed mostly at application and component design time. When developers build applications and components, they specify events and event maps in page definition files. Consequently, for runtime wiring to work, the components you want to wire must provide support for wiring through elements that were built-in at design time.




	
Note:

Runtime refers to the time when users run the application in a real-world environment. Contrast this with design time, which refers to the time developers build the application.







Runtime wiring creates a relationship between a producer event and a consumer event handler. You can create these relationships in Composer. Select a component and view its events support on the Events tab of the Component Properties dialog (Figure 19-1).


Figure 19-1 Events Tab in the Component Properties Dialog

[image: Events tab in the Component Properties dialog box]



Once you select and enable an event and an event handler (see the Action section in Figure 19-1), you can define the type of payload to deliver when the event is triggered.

Composer additionally provides an opportunity to create page parameters on the Parameters tab of the Page Properties dialog (Figure 19-2).


Figure 19-2 Parameters Tab in the Page Properties Dialog

[image: Parameters tab in Page Properties dialog box]



Use the Parameters tab to create new page parameters and to revise existing page parameters. Create parameters that consume value types, including constants, EL expressions, page parameters, and page definition variables

You can easily configure page components to consume page parameters, and you can pass values to those parameters through the page URL.






19.2 Wiring One Component to Another

Components with built-in events and event handlers can be wired to each other to enable the passing of values from a producer component to a consumer component. This section describes how to set up such wiring. It includes the following subsections:

	
Section 19.2.1, "Wiring a Task Flow to a Task Flow"


	
Section 19.2.2, "Wiring a Portlet to a Portlet"


	
Section 19.2.3, "Wiring a Portlet to a Task Flow"


	
Section 19.2.4, "Wiring a Task Flow to a Portlet"


	
Section 19.2.5, "Wiring a UI Component to a Task Flow"






19.2.1 Wiring a Task Flow to a Task Flow

In addition to seeded services and task flows, you can bring custom task flows into the Oracle WebCenter Portal: Spaces application. To bring custom task flows into Spaces, you must first portletize them, so that they can be consumed by Spaces across a portlet bridge.




	
Note:

When you work with contextual event wiring across a portlet bridge and no payload or a null payload is propagated across the wire from the producer portlet to the consumer, such payloads are delivered as an empty string. If the consumer portlet is required to differentiate between an empty string and null, you can encode the null in the producer portlet payload. The consumer portlet consequently looks for this custom encoding to detect the null payload.







Custom task flows may support events and may include the capability of parameter passing. Events and parameter passing could enable one custom task flow to pass values to other custom task flows on the same page. For example, you could wire custom task flows so that when a user clicks a particular document, an event is raised that triggers parameter passing to the other custom task flows on the page. The passed parameters could cause the other custom task flows to rerender with content relevant to the clicked document.

When a custom task flow is portletized, any portlet events or public render parameters raised by the portletized task flow are automatically delivered to other portletized task flows that declare support for those events or parameters. You can also manually wire portletized custom task flows using Composer's Component Properties dialog. The events and parameters that you configure vary according to the functionality that developers build into custom task flows. The steps provided in this section describe how to perform this manual mapping.

Creating and portletizing custom task flows and using the portlet bridge are all discussed in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal. For information about consuming custom task flows and other custom components in Spaces, see Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

To manually wire a task flow to a task flow:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Edit icon on the task flow that consumes the payload provided by the producer task flow.

The Component Properties dialog opens.


	
Click the Events tab to bring it forward, and, from the Events pane, select an event associated with the producer task flow.

The Events pane lists all of the events that can be raised from any component on the page. An asterisk (*) on an event indicates that an action is handling it.


	
In the Actions pane, select the action to execute when the event occurs.

The Actions pane lists all of the event handlers associated with the consumer task flow that are supported by the selected producer task flow. Only those actions that can be invoked for the event that is selected in the Events pane are shown. An asterisk (*) on an action indicates that it is handling an event.


	
Select Enable Action to enable the selected event and action.

An asterisk (*) appears next to the selected event and action. Value options appear below the checkbox.


	
From the displayed value options, select the type of value to use to deliver the payload from the producer task flow to the consumer task flow whenever the event occurs.

Choose from:

	
Constant—Select Constant, and enter a constant or EL expression value to pass to the consumer task flow.


	
EventData—Select to pass the variable ${payLoad}, which delivers whatever payload is specified by the producer task flow.




	
Note:

The value for ${payLoad} is specified when the task flow is created.











	
Click Save at the top right of Composer to save your changes.


	
Click Close to exit Composer.


	
Test your wiring by triggering the event.









19.2.2 Wiring a Portlet to a Portlet

When a portlet is added to a page, it is automatically configured to listen to public render parameters and portlet events generated on the page and respond accordingly. This means that in many cases portlets are automatically wired, as long as the name of the public render parameter or publishing event on the producer side matches that of the public render parameter or processing event on the consumer side, or if an appropriate alias has been created to associate parameters or events.

When portlets have not been designed to explicitly work together, you can manually wire portlets as described in the steps below.




	
Note:

You cannot turn off automatic parameter and event listening in the Spaces UI. If you do want to turn off this feature for a particular portlet you must:
	
Export the space that consumes the portlet.


	
In JDeveloper, open the page definition for the page that contains the portlet.


	
Edit the portlet binding to set the listenForAutoDeliveredPortletEvents and listenForAutoDeliveredParameterChanges attributes to false:


<portlet id="p2_1"
         ...
         listenForAutoDeliveredPortletEvents="false"
         listenForAutoDeliveredParameterChanges="false"
         ...
/>


	
Import the space back into Spaces.












To manually wire a portlet to a portlet:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Edit icon on the portlet that consumes the payload provided by the producer portlet.

The Component Properties dialog opens.


	
Click the Events tab to bring it forward, and select an event associated with the producer portlet.

The Events pane lists all of the events that can be raised from any component on the page. An asterisk (*) on an event indicates that an action is handling it.


	
In the Actions pane, select the action to execute when the event occurs.

The Actions pane lists all of the event handlers associated with the consumer portlet that are supported by the selected producer portlet. Only those actions that can be invoked for the event that is selected in the Events pane are shown. An asterisk (*) on an action indicates that it is handling an event.


	
Select Enable Action to enable the selected event and action.

An asterisk (*) appears next to the selected event and action.


	
Provide values for the portlet parameters that now display at the bottom of the Events tab.

Select Constant, and enter a composite data value, for example:


${payLoad.ora_wsrp_navigparam_Parameter1}





	
Note:

The parameter names and values were specified when the portlet was created.








	
Click Save at the top right of Composer to save your changes.


	
Click Close to exit Composer.


	
Test your wiring by triggering the event.









19.2.3 Wiring a Portlet to a Task Flow

In this scenario, the portlet is the producer, providing the event payload, and the task flow is the consumer of that payload.

To wire a portlet to a task flow:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Edit icon on the task flow that consumes the payload provided by the producer portlet.

The Component Properties dialog opens.


	
Click the Events tab to bring it forward, and select an event associated with the producer portlet from the Events pane.

The Events pane lists all of the events that can be raised from any component on the page. An asterisk (*) on an event indicates that an action is handling it.


	
In the Actions pane, select the action to execute when the event occurs.

The Actions pane lists all of the event handlers associated with the consumer task flow that are supported by the selected producer portlet. Only those actions that can be invoked for the event that is selected in the Events pane are shown. An asterisk (*) on an action indicates that it is handling an event.


	
Select Enable Action to enable the selected event and action.

An asterisk (*) appears next to the selected event and action. Value options appear below the checkbox.


	
Select Constant, and enter a composite data value for a parameter associated with the producer portlet.

For example:


${payLoad.ora_wsrp_navigparam_Parameter1}


	
Click Save at the top right of Composer to save your changes.


	
Click Close to exit Composer.


	
Test your wiring by triggering the event.









19.2.4 Wiring a Task Flow to a Portlet

In this scenario, the task flow is the producer, providing the event payload, and the portlet is the consumer of that payload.

To wire a task flow to a portlet:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Edit icon on the portlet that consumes the payload provided by the producer task flow.

The Component Properties dialog opens.


	
Click the Events tab to bring it forward, and select an event associated with the producer task flow in the Events pane.

The Events pane lists all of the events that can be raised from any component on the page. An asterisk (*) on an event indicates that an action is handling it.


	
In the Actions pane, select the action to execute when the event occurs.

The Actions pane lists all of the event handlers associated with the consumer portlet that are supported by the selected producer task flow. Only those actions that can be invoked for the event that is selected in the Events pane are shown. An asterisk (*) on an action indicates that it is handling an event.


	
Select Enable Action to enable the selected event and action.

An asterisk (*) appears next to the selected event and action.


	
Provide values for the portlet parameters that now appear at the bottom of the Events tab.

Select Constant, and enter a composite data value, for example:


${payLoad.ora_wsrp_navigparam_Parameter1}





	
Note:

The parameter names and values were specified when the portlet was created.








	
Click Save at the top right of Composer to save your changes.


	
Click Close to exit Composer.


	
Test your wiring by triggering the event.









19.2.5 Wiring a UI Component to a Task Flow

In this scenario, the UI component is the producer of the payload, and the task flow is the consumer of the payload.

To wire a UI component to a task flow:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Edit icon on the task flow that consumes the payload provided by the producer UI component.

The Component Properties dialog opens.


	
Click the Events tab to bring it forward, and select an event associated with the producer UI component in the Events pane.

The Events pane lists all of the events that can be raised from any component on the page. An asterisk (*) on an event indicates that an action is handling it.


	
In the Actions pane, select the action to execute when the event occurs.

The Actions pane lists all of the event handlers associated with the consumer task flow that are supported by the selected producer UI Component. Only those actions that can be invoked for the event that is selected in the Events pane are shown. An asterisk (*) on an action indicates that it is handling an event.


	
Select Enable Action to enable the selected event and action.

An asterisk (*) appears next to the selected event and action. Value options appear below the checkbox.


	
Select the type of value to use to deliver the payload from the producer UI component to the consumer task flow whenever the event occurs.

Choose from:

	
Constant—Select Constant, and enter a constant or EL expression value to pass to the consumer task flow.


	
EventData—Select to pass the variable ${payLoad}, which delivers whatever payload is specified by the producer UI component.




	
Note:

The value for ${payLoad} was specified when the UI component was created.











	
Click Save at the top right of Composer to save your changes.


	
Click Close to exit Composer.


	
Test your wiring by triggering the event.











19.3 Wiring Components and Page Parameters

Page parameters and page variables are central to the process of creating enterprise mashups. They enable communication between components and the pages that contain them.

For example, imagine a page that contains stock ticker and stock news components. You want the ticker and the news components to both consume the same parameter value so that they both show information for the same company. Page parameters and page variables are part of a simple mechanism for setting this up.

Page parameters provide a means of storing values for passing to page components that have been configured to consume them. Create page parameters through Composer at application runtime. Page variables contain output values that are produced by portlets. Page variables are created at application design time.

This section describes how to create and consume page parameters in the following subsections:

	
Section 19.3.1, "Creating Page Parameters"


	
Section 19.3.2, "Consuming Page Parameters"






19.3.1 Creating Page Parameters

Use the Parameters tab in the Composer Page Properties dialog to create page parameters.

To create page parameters:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click Page Properties at the top left of Composer to open the Page Properties dialog (Figure 19-3).


Figure 19-3 Page Properties Dialog

[image: Page Properties dialog box]



	
Click the Parameters tab to bring it forward, and then click the Add a page parameter link.

The Add a Page Parameter dialog opens (Figure 19-4).


Figure 19-4 Add a Page Parameter Dialog

[image: Add a Page Parameter dialog box]



	
Enter a name for the new parameter, and then click Add Parameter.

The parameter displays on the Parameters tab with a value entry field and an Edit icon for opening the Expressions Editor (Figure 19-5).


Figure 19-5 A New Parameter on the Parameters Tab

[image: A new parameter (bosWell) on the Parameters tab]



	
Open the EL Editor and select from prebuilt values under Choose a value or enter a value manually under Type a value or expression.

For example, enter any of the following types of values:

	
Constant—Enter a specific, fixed value.


	
Page Parameter—Enter a page parameter to enable the page to take values through its URL.


	
EL Expression—Enter an EL expression to enable the page to take a value expressed through Expression Language (EL). For information about EL, see Appendix B, "Expression Language Expressions."

This option can provide a much more dynamic response. For example, the page could set a page parameter based on a component on the page. In this case, you would want the other components on the page to be refreshed whenever this value changed.





	
Click Save at the top right of Composer to save your changes.


	
As desired, repeat these steps to continue adding page parameters.


	
Click Close to exit Composer.









19.3.2 Consuming Page Parameters

In addition to wiring components to each other, you can wire them to page parameters. Page parameters are user-constructed name/value pairs for use in passing values to page components, such as task flows, portlets, and UI components.

You can create page parameters and configure task flows and portlets to consume them. This section describes how to wire a task flow with a page parameter.




	
Note:

Before you can take the steps outlined in this section, you must create a page parameter and provide it with a value. For more information, see Section 19.3.1, "Creating Page Parameters."







To wire a task flow to a page parameter:

	
Navigate to the relevant page, and enter page edit mode.




	
Tip:

One way to enter page edit mode is to press Ctrl-Shift-E.








	
Click the Edit icon on the task flow to be wired to a page parameter.

The Component Properties dialog opens.


	
Click the Parameters tab to bring it forward.


	
Click the Edit icon next to the property that takes the parameter value.

An editor opens, which you can use to provide the name of the page parameter.


	
Select Choose a value.


	
Under Choose a value, select Page Parameter from the first list, and the name of the relevant page parameter from the second.


	
Click OK to exit the editor.


	
Click OK to save your changes and exit the Component Properties dialog.

The task flow is refreshed, now displaying the result of the value passed through the page parameter.











19.4 Passing Parameter Values Through the Page URL

You can provide Expression Language (EL) expressions in lieu of other types of values to component parameters. This is discussed in Appendix B, "Expression Language Expressions." You can take this capability one step further by passing parameter values with your page URLs.

This section provides one scenario, which you can use as a model for other parameter passing situations.

To pass parameter values through a page URL:

	
Go to the page that contains a component to which you want to pass values through the page URL.


	
Edit the relevant component's properties.


	
Open the EL Editor for the Parameter or Display Option to which you want to pass a value.


	
Under Type a value or expression, enter #{param.val}.


	
Save your changes.


	
To pass a value to the parameter, append the following to your page URL:


?val=value


Where value represents the value you want to pass, for example, true, medium, or Default.












Part VI


Securing Your Portal

Part VI of the User's Guide provides an overview of security in WebCenter Portal: Spaces applications and describes how to set up the application roles and permissions that determine user access. It describes how to secure individual pages and page components. And it provides information about enabling users to register themselves with the application.

Part VI includes the following chapters:

	
Chapter 20, "Understanding Security"


	
Chapter 21, "Managing Users, Roles, and Permissions"


	
Chapter 22, "Enabling Self-Registration"


	
Chapter 23, "Securing Pages and Components"










20 Understanding Security

This chapter provides information about security in the Spaces application. It contains the following sections:

	
Section 20.1, "Introduction to Security in Spaces"


	
Section 20.2, "Understanding Users"


	
Section 20.3, "Understanding Application Roles and Permissions"


	
Section 20.4, "Understanding Roles and Permissions within a Space"


	
Section 20.5, "Understanding Self-Registration"





Audience

The content of this chapter is intended for Spaces administrators and anyone who wants to understand the application's security model. For detailed instructions, see Chapter 21, "Managing Users, Roles, and Permissions".

See also, "Managing Security" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.



20.1 Introduction to Security in Spaces

The Spaces application provides a comprehensive security model that enables you to control what users can see and change on your portal. You can control which users (and groups) have access to individual spaces, space hierarchies, and the Home space, and you can also control exactly what users and groups can see and do by enabling and disabling various permissions.

With a particular space you can restrict user and group access to individual pages, page content (such as task flows, portlets, documents, and folders), and resources (such as page templates, page styles, skins, resource catatlogs, and so on).


Figure 20-1 Spaces Security

[image: WebCenter: Portal Spaces Security]



User and Groups

A user is a single person in the identity store and a group contains multiple users. In the Spaces application you can grant permissions to individual users and to groups of users.

Unregistered Users and Self-Registration

Self-registration allows unregistered users to create their own login and password for the Spaces application. A user who self registers is immediately and automatically granted access to Spaces and a new user account is created in the application's identity store.

Application Roles and Space Roles

Application roles determine what a user (or group) can see and do in the Home space which, for some administrative functions, can impact the entire Spaces application. Space roles control actions within a particular spaces.

Spaces and Space Hierarchies

Spaces support the formation and collaboration of project teams and communities of interest by providing a dedicated and readily accessible area for relevant services, pages, and content and by supporting the inclusion of specified members.

A space hierarchy consists of a parent space with one or more subspaces. Subspaces can inherit the security (members, roles, and permissions) of their parent.

Home Space

The Home space is a shared space that, by default, is accessible to everyone who is logged in. Application roles apply while a user is working within the Home space. In most applications, the Home space focuses on social networking and personal content.

Resources

Various portal resources help define the overall structure, look and feel, and content in spaces, and these include page templates, page styles, skins, navigation models, resource catalogs, content presenter display templates, mashup styles, data controls, task flows. Users with appropriate privileges can build and customize portal resources for the entire application, a single space, or a space hierarchy.

Pages

Anyone authorized to edit a page can grant access and permissions to other users and groups. For example, you might grant view-only permissions to everyone in the sales group, edit permissions to sales managers, and manage permissions to a single user. Alternatively, you can specify that the page inherits its access from the application.

Page Content, Files and Folders

Some pages might contain content that you want only a select set of users, or even only one other user, to see. For example, a page aimed at sales people might include two Announcement task flows; one aimed at all sales people and the other at sales managers only. By restricting access to the second Announcement task flow, you can hide management-level announcements from anyone who is not a sales manager.






20.2 Understanding Users

A Spaces user has a login account for the Spaces application—provisioned directly from an existing identity store. See also, "Adding Users to the Embedded LDAP Identity Store" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

All users in the identity store are assigned minimal privileges in the Spaces application through the Authenticated-User role. The only exception is the Fusion Middleware Administrator (weblogic by default). Out-of-the-box, the Fusion Middleware Administrator is the only user assigned full administrative privileges through the Administrator role. For more information, read the next section Section 20.3.1.1, "Default Application Roles".

It is the Fusion Middleware Administrator's job to assign each user an appropriate application role. Alternatively, the Fusion Middleware Administrator may choose to assign the Administrator role to another user and delegate this responsibility.


Table 20-1 Default Administrator in Spaces

	User	Description
	
Fusion Middleware Administrator (weblogic)

	
Administrator for the entire application server, sometimes referred to as the super administrator. This user can manage any application on the server, including Spaces.












20.3 Understanding Application Roles and Permissions

Application roles control the level of access a user has to information and services in the Spaces application. Specifically, application roles and their permissions determine what a user can see and do in their Home space.

This section includes:

Section 20.3.1, "Understanding Application Roles"

Section 20.3.2, "Understanding Application Permissions"



20.3.1 Understanding Application Roles

Application role assignment is the responsibility of the Spaces administrator. Administrators can assign users a default application role or create additional, custom roles specific to their Spaces application. For more detail, see:

	
Section 20.3.1.1, "Default Application Roles"


	
Section 20.3.2, "Understanding Application Permissions"




Application roles only apply while a user is working within their Home space. Within all other spaces a different set of roles and permissions apply and it is the space moderator's responsibility to determine suitable role assignments for each of its members. See also Section 52.2, "Managing Roles and Permissions for a Space".




	
Note:

Application roles and permissions defined within Spaces are stored in its policy store and, consequently, apply to this Spaces application only. Enterprise roles are different; enterprise roles are stored within the application's identity store and do not imply any permissions within the Spaces application. See "Application Roles and Enterprise Roles" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









20.3.1.1 Default Application Roles

The Spaces application provides several default application roles that cannot be deleted (Table 20-2).


Table 20-2 Default Application Roles for Spaces

	Application Role	Description	Modify?
	
Administrator

	
Users with the Administrator role can set application-wide properties for Spaces, create business role pages, configure defaults for discussion forums, mail, and people connection services, register producers and external applications, as well as perform other administrative duties such as editing the login page and the self-registration page.

Administrators can also manage users and roles for the Spaces application, delegate or revoke privileges to/from other users, manage spaces and space templates, and also import and export space information.

Out-of-the-box, the Fusion Middleware Administrator is the only user assigned full administrative privileges for the Spaces application through the Administrator role.

	
Yes*

*Except for Application permissions which are read-only


	
Authenticated-User

	
Authenticated users of Spaces are granted the Authenticated-User role. Users who login are assigned with this role and, by default, have access to their own Home space, pages that they create, and public pages. These users can also view public spaces, create spaces, and create space templates.

This role inherits permissions from the Public-User role.

In the Spaces application, the Authenticated-User role is equivalent to authenticated-role—a standard OPSS (Oracle Platform Security Services) role.

	
Yes


	
Public-User

	
Anyone with access to the Spaces application who is not logged in, is granted the Public-User role. Such users are anonymous, unidentified, and can see public content only.

In the Spaces application, the Public-User role is equivalent to anonymous-role—a standard OPSS (Oracle Platform Security Services) role.

	
Yes












20.3.1.2 Custom Application Roles

Custom application roles (sometimes known as user-defined roles) are specific to your Spaces application. When setting up Spaces, it is the Spaces administrator's job to identify which application roles are required, choose suitable role names, and define the responsibilities of each role.

For example, an education environment might require roles such as Teacher, Student, and Guest. While roles such as Finance, Sales, Human Resources, and Support would be more appropriate for a corporate environment.

In the Spaces application, custom application roles inherit permissions from the Authenticated-User role.

To learn how to set up applications roles for Spaces users, see Section 21.2.2, "Defining Application Roles"








20.3.2 Understanding Application Permissions

Every application role has specific, defined capabilities known as permissions. These permissions allow individuals to perform specific actions in the Home space. Permissions are categorized as follows and listed individually in the subsequent tables:

	
Application


	
Spaces


	
Space Templates


	
Pages


	
Content Presenter Templates


	
Data Controls


	
Discussions


	
Links


	
Mashup Styles


	
Navigations


	
Page Styles


	
Page Templates


	
People Connections


	
Resource Catalogs


	
Skins


	
Task Flows




No permission, except for Manage All, inherits privileges from other permissions.


Table 20-3 Application Permissions in Spaces

	Category	Application Permissions
	
Application

	
Manage All - Enables access to all Spaces Administration pages: Spaces, Pages, Resources, Security, and Configuration. Through these pages, users can manage application security (users/roles), configure application-wide properties and services, manage resources, create business role pages, manage everyone's personal pages, customize system pages, view spaces accessible to them, as well as export/import spaces and space templates.

Some administrative tasks are exclusive to the out-of-the-box Administrator role and cannot be performed by granting the Application-Manage All permission. These tasks include editing the login page, the self-registration page, and profile gallery pages, as well as the ability to manage all spaces, all space templates, external applications, and portlet producers.

Manage Configuration - Same as the Application-Manage All permission but excludes security privileges. Users with this permission cannot access the Security page.

View Application - Enables users to view the Spaces application, and gives user access to the Home space. See also, Section 5.12, "Enabling and Disabling Access to the Home Space".



	
Spaces

	
Manage All - Enables access to all Space administration pages (General, Roles, Members, Pages, Content, Subspaces, Services, Services, Custom Attributes). Through these pages users can manage space membership, assign permissions and roles, manage, delete, and export spaces and resources, set space properties, and manage service availability.

Manage Configuration - Same as the Spaces-Manage permission but excludes security privileges. Users with this permission cannot access the Roles and Members pages unless they are a space moderator.

Manage Membership - Users can manage space membership through Roles and Members pages.

Create Spaces -Users can create spaces.



	
Space Templates

	
Manage All - Enables users to manage any space template (through the Space Templates page) and delete templates accessible to them. See also, Section 50.3, "Managing Space Templates".

Create Space Templates - Users can create space templates.



	
Pages

	
Create, Edit, and Delete - Create, edit and delete pages in your Home space.

Delete - Delete pages in your Home space.

Edit - Add or edit personal page content, rearrange content, and set page parameters and properties.

Customize - Customize your view of pages in the Home space by adding, editing, or removing content.

View - View pages in the Home space.

Create - Create or design a new page for your Home space view.


These permissions only apply to the Home space. The permissions do not apply to pages that are created within a space. Page permissions within a space are granted on a per space-basis by the moderator. See Section 52.2, "Managing Roles and Permissions for a Space".


	
Content Presenter Templates

	
Create, Edit, and Delete - Create, edit and delete content display templates for the application through Spaces Administration.

Create - Create content display templates for the application.

Edit - Edit application-level content display templates.

See also, Chapter 40, "Publishing Content Using Content Presenter".


	
Data Controls

	
Create, Edit, and Delete - Create, edit and delete data controls for the application through Spaces Administration.

Create - Create data controls for the application.

Edit - Edit application-level data controls.

See also, Section 26.2, "Creating and Managing Data Controls".


	
Discussions

	
Create, Edit, and Delete - Manage categories, forums, and topics on the back-end discussions server. Set discussion forum properties for all spaces.

See also, Section 20.3.2.2, "Understanding Discussion Server Role Mapping".



	
Links

	
Create, and Delete - Create and delete links between objects, and manage link permissions.

Delete - Delete a link between two objects.

Create - Create links between objects, and delete links that you create.



	
Mashup Styles

	
Create, Edit, and Delete - Create, edit and delete content display templates for the application through Spaces Administration.

Create - Create content display templates for the application.

Edit - Edit application-level content display templates.

See also, Chapter 40, "Publishing Content Using Content Presenter".


	
Navigations

	
Create, Edit, and Delete - Create, edit and delete navigations for the application through Spaces Administration.

Create - Create navigations for the application.

Edit - Edit application-level navigations.

See also, Chapter 11, "Working with Navigation".


	
Page Styles

	
Create, Edit, and Delete - Create, edit and delete page styles through Spaces Administration.

Create - Create page styles for the application.

Edit - Edit application-level page styles.

See also, Chapter 15, "Working with Page Styles".


	
Page Templates

	
Create, Edit, and Delete - Create, edit and delete page templates through Spaces Administration.

Create - Create page templates for the application.

Edit - Edit application-level page templates.

See also, Chapter 12, "Working with Page Templates".


	
People Connections

	
Manage People Connections -Manage application-wide settings for People Connection services.

Update People Connections Data -Edit content associated with People Connection services.

Connect with People -Share content associated with People Connection services with others.


	
Resource Catalogs

	
Create, Edit, and Delete - Create, edit and delete resource catalogs for the application through Spaces Administration.

Create - Create resource catalogs for the application.

Edit - Edit application-level resource catalogs.

See also, Chapter 16, "Working with Resource Catalogs".


	
Skins

	
Create, Edit, and Delete - Create, edit and delete skins through Spaces Administration.

Create - Create skins for the application.

Edit - Edit application-level skins.

See also, Chapter 14, "Working with Skins".


	
Task Flows

	
Create, Edit, and Delete - Create, edit and delete task flows based on a mashup style through Spaces Administration.

Create - Create task flows for the application.

Edit - Edit application-level task flows.

See also, Section 26.3, "Creating and Managing Task Flows".










20.3.2.1 Understanding the Default Permissions

Table 20-4 shows the default permissions assigned to out-of-the-box application roles.

✔ - Shows an explicitly granted permission or action.

✙ - Shows an implied permission because of an explicitly granted permission.


Table 20-4 Default Application Roles and Permissions in Spaces

	
	Default Application Roles
	Permissions	Administrator	Authenticated-User	Public-User
	
Application

	
	
	

	
Manage All

	
✔

	
	

	
Manage Configuration

	
✙

	
	

	
View Application

	
✙

	
✔

	
✔


	
Spaces

	
	
	

	
Manage All

	
✔

	
	

	
Manage Configuration

	
	
	

	
Manage Membership

	
	
	

	
Create Spaces

	
	
✔

	

	
Space Templates

	
	
	

	
Manage All

	
✔

	
	

	
Create Space Templates

	
	
✔

	

	
Pages

	
	
	

	
Create, Edit, and Delete

	
✔

	
	

	
Delete

	
	
	

	
Edit

	
	
	

	
Customize

	
	
	

	
View

	
	
	

	
Create

	
	
✔

	

	
Content Presenter Templates

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Data Controls

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Discussions

	
	
	

	
Create, Edit, and Delete

	
✔

	
	

	
Links

	
	
	

	
Create and Delete

	
✔

	
	

	
Delete

	
	
	

	
Create

	
	
	

	
Mashup Styles

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Navigations

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Page Styles

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Page Templates

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
People Connections

	
	
	

	
Manage

	
✔

	
	

	
Update

	
	
✔

	

	
Connect

	
	
✔

	

	
Resource Catalogs

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Skins

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	

	
Task Flows

	
	
	

	
Create, Edit and Delete

	
✔

	
	

	
Create

	
	
	

	
Edit

	
	
	











20.3.2.2 Understanding Discussion Server Role Mapping

Some WebCenter Portal services that need access to "remote" (back-end) resources also require role-mapping based authorization, that is, the Spaces roles that allow users to work with the Discussions service in the Spaces application, must be mapped to corresponding roles on the WebCenter Portal's discussions server.

Spaces uses application roles to manage user permissions in the Home space and space roles to manage user permissions within a particular space. On the WebCenter Portal's discussions server, a different set of roles and permissions apply.

Users who are working with discussions and announcements in Spaces automatically map to the appropriate discussions server role, shown in Table 20-5 and Table 20-6.


Table 20-5 Discussions Server Roles and Permissions - Application

	Discussion Server Role	Discussion Server Permissions	Spaces

Equivalent Application Permission
	
Administrator

	
Category Admin

	
Discussions-Create, Edit, and Delete

Create, read, update and delete sub categories, forums and topics inside the category for which permissions are granted.









Table 20-6 Discussions Server Roles and Permissions - For a Space

	Discussion Server Role	Discussion Server Permissions	Spaces

Equivalent Permissions in a Space
	
Moderator

	
Category Admin

Forum Admin

	
	
Discussions-Create, Edit, and Delete

Create, read, update and delete forums and topics.


	
Announcements-Create, Edit, and Delete

Create, read, update and delete announcements.





		
Create Message

Create Announcement

	
	
Discussions-Create, and Edit

Create and edit topics.


	
Announcements-Create, and Edit

Create and edit announcements.





		
Read Forum

Create Thread

	
	
Discussions-Reply To

Reply to discussion topics.





		
Read Forum

	
	
Discussions-View

View forums and topics.


	
Announcements-View

View announcements.











Any user assigned the Application-Discussions-Create Edit Delete permission in the Spaces application is automatically added to WebCenter Portal's discussions server and assigned the Administrator role with the Category Admin permission. Out-of-the box, the Spaces application assigns the Application-Discussions-Create Edit Delete permission to the Administrator role only, as shown in Figure 20-2.


Figure 20-2 Application Roles - Default Discussion Permissions

[image: Application Roles - Default Discussion Permissions]



Similarly, in a given space, any member assigned discussion and announcement permissions is granted the corresponding permissions on the discussions server. Figure 20-3 shows out-of-the box discussion and announcement permissions for the default roles Moderator, Participant, and Viewer.


Figure 20-3 Space Roles - Default Discussion Permissions

[image: Space Roles - Default Discussion Permissions]







20.3.2.3 Understanding Enterprise Group Role Mapping

In the Spaces application you can assign individual users or multiple users in the same enterprise group to Spaces roles. Subsequent enterprise group updates in the back-end identity store are automatically reflected in the Spaces application. Initially, when you assign an enterprise group to a Spaces role, everyone in the enterprise group is granted that role. If someone moves out of the group, the role is revoked. If someone joins the group, they are granted the role

For Spaces to properly maintain enterprise group-to-role mappings, back-end servers, such as the discussions server and content server, must support enterprise groups too. WebCenter Portal's Discussion Server and WebCenter Content's Content Server versions provided this release both support enterprise groups but previous versions may not. See also, Section 21.3, "Troubleshooting Issues with Users and Roles".










20.4 Understanding Roles and Permissions within a Space

When a user becomes a member of an particular space, a different set of roles and responsibilities apply. For details, see Section 52.2, "Managing Roles and Permissions for a Space".






20.5 Understanding Self-Registration

Spaces administrators can enable self-registration for the application. Through self-registration, invited and uninvited users can create their own login and password for the Spaces application. A user who self registers is immediately and automatically granted access to Spaces and a new user account is created in the identity store. See also, Chapter 22, "Enabling Self-Registration".









21 Managing Users, Roles, and Permissions

Application roles control the level of access a user has to information and services in the Spaces application. Specifically, application roles and their permissions determine what a user can see and do in their Home space. This chapter describes how to define and grant application roles to Spaces users. It contains the following sections:

	
Section 21.1, "Managing Users"


	
Section 21.2, "Managing Application Roles and Permissions"


	
Section 21.3, "Troubleshooting Issues with Users and Roles"




When a Spaces user becomes a member of a particular space, a different set of roles and responsibilities apply. For details, see Section 52, "Managing Space Members and Roles."


Audience

The content of this chapter is intended for Spaces administrators with the Application-Manage All permission.



21.1 Managing Users

Administrators must ensure that all Spaces users have appropriate permissions. To get permissions, users must be assigned to an appropriate application role.

This section tells you how to assign roles and contains the following subsections:

	
Section 21.1.1, "What You Need to Know About Managing Users"


	
Section 21.1.2, "Assigning Users (and Groups) to Roles"


	
Section 21.1.3, "Assigning a User to a Different Role"


	
Section 21.1.4, "Giving a User Administrative Privileges"


	
Section 21.1.5, "Revoking Application Roles"


	
Section 21.1.6, "Adding or Removing Users"






21.1.1 What You Need to Know About Managing Users

From the Users and Groups page (Figure 21-1), administrators can manage application roles for all the users who have access to the Spaces application, that is, all users defined in the identity store. From here, you can change user role assignments, grant administrative privileges, and revoke user permissions.

Only users granted special (nondefault) application privileges appear in this table. Initially, all users in the Spaces identity store are assigned minimal privileges through the Authenticated-User role. Users with the default Authenticated-User role are not listed here. See also, Section 20.3.1.1, "Default Application Roles".


Figure 21-1 Spaces Administration - Users and Groups Page

[image: Spaces Administration - Users Tab]







21.1.2 Assigning Users (and Groups) to Roles

Initially, all users in the Spaces identity store are assigned minimal privileges through the Authenticated-User role. You can assign individual users (or multiple users in the same enterprise group) to a different application role through Spaces Administration.

Updates in your back-end identity store, such as new users or someone leaving an enterprise group, are automatically reflected in the Spaces application. Initially, when you assign an enterprise group to a Spaces role, everyone in the enterprise group is granted that role. If someone moves out of the group, the role is revoked. If someone joins the group, they are granted the role.




	
Note:

For the Spaces application to properly maintain enterprise group-to-role mappings, back-end servers, such as the discussions server and content server, must support enterprise groups too. When back-end servers do not support enterprise groups, the message "Group [name] not found in the Identity Store" displays. See also, Section 21.3, "Troubleshooting Issues with Users and Roles".







To assign a user (or a group of users) to a different application role:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Security, then Users and Groups (Figure 21-1).

This page lists users to which additional roles are defined.


	
Choose User or Group from the drop down.

Select User to grant permissions to one or more users defined in the identity store. Select Group to grant permissions to groups of users.


	
If you know the exact name of the user or group, enter the name in the box provided, separating multiple names with a comma.

If you are not sure of the name you can search your identity store:

	
Click the Find icon (Figure 21-2).


Figure 21-2 Find Icon

[image: Grant Roles to Users in the Identity Store]



The Find User (or Find Group) dialog box opens (Figure 21-3).


Figure 21-3 Finding Users and Groups in the Identity Store

[image: Choosing a User From Your Identity Store]



	
Enter a search term for a user or group, then click the Search icon.

For tips on searching for a user or group in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store".

Users (or groups) matching your search criteria display in the Select User dialog box. For more details on which fields are searched, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
Tip:

	
Use * as a wildcard, for example *sales.


	
Leave the search field blank to list all users (or groups) in the identity store.


	
Enter a space between two search terms to search First Name and Last Name, for example jo sm, searches for jo in First Name and sm in Last Name.













	
Select one or more names from the list.

To assign roles to multiple users or groups, multi-select all the names required. Ctrl-Click rows to select multiple names.


	
Click OK.

The names that you select display on the User and Groups tab.





	
To assign a role, select a Role from the drop down (Figure 21-4).


Figure 21-4 Assigning a User Role

[image: Change Membership Icon]



Select an appropriate role for the selected users (or groups). Only choose Administrator to assign full, administrative privileges for the Spaces application.

If the role you want is not listed, create a new role that meets your requirements (see Section 21.2.2, "Defining Application Roles").

When no role is selected, the user assumes the Authenticated-User role. See Section 20.3.1.1, "Default Application Roles".


	
Click Grant Access.




User/user group names and new role assignment display in the table.




	
Note:

Group names are clickable enabling you to drill down to see user names of the current group members.
A list of members does not display for dynamic group based on Oracle Entitlements Server (OES) roles since OES roles are based on dynamic attributes and therefore do not have any static members. See also, "Configuring Dynamic Groups" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.














21.1.3 Assigning a User to a Different Role

From time to time, a user's role in the Spaces application may change. For example, a user may move out of sales into the finance department and in this instance, the user's role assignment may change from Sales to Finance.




	
Note:

You cannot modify your own role or the Fusion Middleware Administrator's role. See Section 20.3.1, "Understanding Application Roles".







To assign a user to a different role:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Users and Groups (Figure 21-1).


	
In the Manage Existing Grants table, scroll down to the user you want.

Only users with nondefault role assignments are listed in the table. If the user you want is not listed, grant the role required as described in Section 21.1.2, "Assigning Users (and Groups) to Roles."


	
Click the Actions icon, then choose Change Role from the drop down list.

The Change Role dialog box opens (Figure 21-5).


Figure 21-5 Changing a User's Application Role

[image: Changing Your Space Role]



	
Select roles as follows:

	
Select Administrator to assign full, administrative privileges for the Spaces application.


	
Select select one or more roles from the list available.

If the role you want is not listed, create a new role that meets your requirements (see Section 21.2.2, "Defining Application Roles").

At least one role must be selected. To revoke all role assignments, reverting user permissions to the default Authenticated-User role, see Section 21.1.5, "Revoking Application Roles".





	
Click OK.




New role assignments display in the table.






21.1.4 Giving a User Administrative Privileges

It is easy to give a user full, administrative privileges for the Spaces application through the Administrator role. Administrators have the highest privilege level and can view and modify anything in the Spaces application so take care when assigning the Administrator role.

Some administrative tasks are exclusive to the Administrator role and cannot be performed by granting the Application-Manage All permission. These tasks include editing the login page, the self-registration page, and profile gallery pages. See also, Section 20.3.1.1, "Default Application Roles".

To give a user administrative privileges:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Users and Groups (Figure 21-1).

The Role column indicates which users already have full administrative privileges through the Administrator role.


	
Click the Users and Groups tab.


	
In the Manage Existing Grants table, scroll down to the user you want.

Only users with nondefault role assignments are listed in the table. If the user you want is not listed, follow steps in Section 21.1.2, "Assigning Users (and Groups) to Roles" to grant the Administrator role.


	
Click the Actions icon, then choose Change Role from the drop down list.

The Change Role dialog box opens (Figure 21-6).


Figure 21-6 Changing a User's Application Role

[image: Changing Your Space Role]



	
Select Administrator to assign full, administrative privileges for the Spaces application.


	
Select OK.




The new role assignment displays in the table.






21.1.5 Revoking Application Roles

It is easy to revoke application role assignments that no longer apply. You can revoke roles individually or revoke all application roles assigned to a particular user at once.

Revoking all a user's application roles does not remove that user from the identity store and the user still has access to the Spaces application through the default Authenticated-User role.




	
Note:

You cannot revoke your own role assignments or the Fusion Middleware Administrator's role. See Section 20.3.1, "Understanding Application Roles".







To revoke application roles:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Users and Groups (Figure 21-1).

This page lists users to which additional roles are defined.


	
In the Manage Existing Grants table, scroll down to the user you want.


	
Click the Actions icon:

	
Choose Change Role icon to revoke one or more, specific application roles. See also Section 21.1.3, "Assigning a User to a Different Role".


	
Choose Delete Role Assignments to revoke all roles assigned to that user, and then click Delete when asked for confirmation.




Access for that user is revoked immediately.




When you delete all the roles assigned to a particular user, the user is no longer listed on the Users page. The user remains in the identity store and still has access to the Spaces application through the Authenticated-User role. See Section 20.3.1.1, "Default Application Roles".






21.1.6 Adding or Removing Users

Spaces administrators cannot add new user data directly to the Spaces identity store or remove user credentials. Identity store management is the responsibility of the systems administrator and takes place through the WLS Administration Console or directly into embedded LDAP identity stores using LDAP commands. See also, "Adding Users to the Identity Store Using the WLS Administration Console" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Spaces administrators can, however, enable self-registration for the application. Through self-registration, invited and uninvited users can create their own login and password for the Spaces application. A user who self registers is immediately and automatically granted access to the Spaces application and a new user account is created in the identity store. See also, Chapter 22, "Enabling Self-Registration".








21.2 Managing Application Roles and Permissions

The Spaces application uses application roles to manage permissions for users working in their Home space. This section tells you how to manage application roles, and their permissions from Spaces Administration pages. It contains the following subsections:

	
Section 21.2.1, "What You Need to Know About Application Roles and Permissions"


	
Section 21.2.2, "Defining Application Roles"


	
Section 21.2.3, "Modifying Application Role Permissions"


	
Section 21.2.4, "Granting Permissions to the Public-User"


	
Section 21.2.5, "Granting Permissions to the Authenticated-User"


	
Section 21.2.6, "Deleting Application Roles"






21.2.1 What You Need to Know About Application Roles and Permissions

From the Roles page (Figure 21-7), administrators can manage application roles and permissions. From here, you can edit the permissions assigned to an application role, create new application roles, or delete unused roles.


Figure 21-7 Spaces Administration - Roles Page

[image: Spaces Administration - Roles Tab]



Application roles apply when a user is working within their Home space. A different set of roles and permissions apply when a user is working within a particular space. It is the space moderator's responsibility to determine suitable role assignments for each of its members. See also, Section 21.2, "Managing Application Roles and Permissions".

The Spaces application provides several default application roles. You cannot delete default application roles but you can modify the default permission assignments for each role. For more information, see Section 20.3, "Understanding Application Roles and Permissions".






21.2.2 Defining Application Roles

Use roles to characterize groups of Spaces users and determine what they can see and do in their Home spaces.

When defining application roles, use self-descriptive role names and try to keep the role policy as simple as possible. Choose as few roles as you can, while maintaining an effective policy.

Take care to assign appropriate access rights when assigning permissions for new roles. Do not allow users to perform more actions than are necessary for the role but at the same time, try not to inadvertently restrict them from activities they must perform. In some cases, users might fall into multiple roles.

To define a new application role:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Roles (Figure 21-7).

Current application roles for the Spaces application display as columns in the table.


	
Click Create Role to define a new role for Spaces users.


Figure 21-8 Creating a New Role

[image: Creting a new role]



	
Enter a suitable name for the role.

Ensure the role names that are self-descriptive. Make it as obvious as possible which users should belong to which roles. Role names can contain alphanumeric characters, blank spaces, @, and underscores.


	
(Optional) Choose a Template Role.

The new role inherits permissions from the template role. You can modify these permissions in the next step.

Choose Administrator to create a role that inherits full, administrative privileges. Conversely, choose Public-User to create a role that typically provides minimal privileges. Alternatively, choose a custom application role to be your template.


	
Click OK.

The new role appears as a column in the table. The permissions list shows which actions users with this role can perform.


	
To modify user permissions for the role, select or clear each permission checkbox.


	
Click Apply to save any changes that you make to the role's permissions.









21.2.3 Modifying Application Role Permissions

Administrators can modify the permissions associated with application roles at any time. Application permissions are described in Section 20.3.2, "Understanding Application Permissions".

Application role permissions allow individuals to perform specific actions in their Home space. No permission, except for Manage All, inherits privileges from other permissions.




	
Note:

Application permissions cannot be modified for the Administrator role. See also Section 20.3.1.1, "Default Application Roles".







To change the permissions assigned to a role:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Roles (Figure 21-7).

Current application roles for the Spaces application display as columns in the table.


	
Select or clear Permissions checkboxes to enable or disable permissions for a role.


	
Click Apply to save.




The new permissions are effective immediately.






21.2.4 Granting Permissions to the Public-User

Anyone who is not logged in to the Spaces application assumes the Public-User role. Out-of-the-box, the Public-User role is granted minimal privileges, that is, the View Application permissions only.




	
Caution:

Take care when granting permissions to the Public-User role. Avoid granting administrative permissions such as Application-Manage All, Application-Manage Configuration, or any permission that might be considered unnecessary. See also, Section 20.3.2, "Understanding Application Permissions".








Granting the Application-View Permission

The View Application permission allows unauthenticated users to see public Spaces application pages, such as the welcome page, and also content that individual users choose to make public.

When View Application permissions are granted to the Public-User role:

	
Ensure that users understand that any personal page or personal content they choose to make public will become accessible to unauthenticated users outside of the Spaces community, that is, anyone with Web access.


	
Consider customizing the default welcome page that displays to public users before they login (Welcome Page). See Section 7.3.2, "Customizing System Pages".




If you do not want unauthenticated users to see Spaces content that is marked 'public', do not grant the View Application permission to the Public-User role. When public access is disabled, public content cannot be seen by unauthenticated users. Also, the welcome page for Spaces is not displayed; public users are directed straight to a login page. Administrators may customize the default login page, if required. See Section 7.3, "Working with System Pages".


Granting Other Permissions

Be careful when assigning permissions to the Public-User role. For security reasons, Oracle recommend that you limit what anonymous users can see and do in the Spaces application.






21.2.5 Granting Permissions to the Authenticated-User

Anyone who is logged in to the Spaces application assumes the Authenticated-User role. Out-of-the-box, the Authenticated-User role is granted minimal privileges, through the following permissions: View Application, Spaces-Create, Space Templates-Create, Pages-Create, Update People Connections Data, and Connect with People.

Other important notes:

	
The Authenticated-User role always inherits permissions from the Public-User role.


	
Custom application roles all inherit permissions from the Authenticated-User role.









21.2.6 Deleting Application Roles

When an application role is no longer required you should remove it from the Spaces application. This helps maintain a valid role list, and prevents inappropriate role assignment.

Application roles are deleted even when users are still assigned to the them. As you cannot delete any default roles, Spaces users will always have the Authenticated-User role.




	
Note:

Default roles cannot be deleted (Administrator, Authenticated-User, Public-User). See Section 20.3.1.1, "Default Application Roles".







To delete an application role:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Security, then Roles (Figure 21-7).

Current application roles for the Spaces application display as columns in the table.


	
Select the Delete Role icon next to the role you want to delete (Figure 21-9).


Figure 21-9 Deleting an Application Role

[image: Deleting a User Role]



	
Click OK to confirm that you want to delete the role.

The role is removed from the table. Any users assigned to this role only, assume the default Authenticated-User role and do not display on the Users and Groups tab.











21.3 Troubleshooting Issues with Users and Roles

For the Spaces application to properly maintain enterprise group-to-role mappings, the back-end discussions server and content server must support enterprise groups. WebCenter Portal's Discussion Server and WebCenter Content's Content Server versions provided with Oracle WebCenter Portal 11.1.1.2.0 and later both support enterprise groups but previous versions may not.If a back-end server does not support enterprise groups, an error message similar to that shown in Figure 21-10 displays when you try to add a group.

Warning: Group [name] not found in Identity Store


Figure 21-10 Error Message Displayed If Back-end Servers Do Not Support Enterprise Groups

[image: Message When Servers Do Not Support Enterprise Groups]



Also, an error is logged containing more detailed information as shown here:


[2011-03-28T01:03:07.143-07:00] [WC_Spaces] [NOTIFICATION] [WCS-07855] 
oracle.webcenter.doclib.internal.spaces.AbstractDoclibRoleMapper] [tid: pool-1-daemon-thread-1] [userId: monty] 
[ecid: a4789a41d7e6bc9f:36de4556:12efb72d049:-8000-00000000000002c0,0:5] 
[APP: webcenter#11.1.1.4.0] Adding groups [oracle.webcenter.security.common.WCGroup@18b96a3] to documents service roles [Administration, Delete Documents, Create and Edit Documents, View Documents] for
 scope Scope[name=rbgs25mar01, guid=sbf125dd4_cd43_41cc_9d3d_467d06e84100][2011-03-28T01:03:09.122-07:00] [WC_Spaces] [ERROR] [WCS-44002] [oracle.webcenter.security.rolemapping.RoleManager] 
[tid: [ACTIVE].ExecuteThread: '3' for queue: 'weblogic.kernel.Default (self-tuning)'] [userId: monty] 
[ecid: a4789a41d7e6bc9f:36de4556:12efb72d049:-8000-00000000000002c0,0] 
[APP: webcenter#11.1.1.4.0] The Role Mapping provider encountered an exception while performing security role mapping for service oracle.webcenter.doclib.
[[oracle.webcenter.security.rolemapping.spi.RoleMappingSPIException: Cannot add role null and permissions, 15, to the account for the folder, rbgs25mar01 for the user/group Admin.        at
oracle.webcenter.doclib.internal.spaces.UCMSpacesUtils$2.newException(UCMSpacesUtils.java:2595)





	
Note:

In previous releases, if a back-end server did not support enterprise groups, users belonging to enterprise groups were individually added to Spaces roles; this behavior has changed.















22 Enabling Self-Registration

Spaces administrators can enable self-registration for the application. Through self-registration, invited and uninvited users can create their own login and password for the Spaces application. This chapter describes how to enable self-registration. It contains the following sections:

	
Section 22.1, "What You Should Know About Self Registration"


	
Section 22.2, "Enabling Self-Registration By Invitation-Only"


	
Section 22.3, "Enabling Anyone to Self-Register"





Audience

The content of this chapter is intended for Spaces administrators with the Application-Manage All permission.



22.1 What You Should Know About Self Registration

Self-registration allows users to create their own login and password for the Spaces application. A user who self registers is immediately and automatically granted access to Spaces and a new user account is created in the application's identity store.

If anyone is allowed to self-register, that is any public user, a Register link or button displays below the Spaces login form. To enable this feature, see Section 22.3, "Enabling Anyone to Self-Register".

Self-registration by invitation is available too. This feature allows space moderators to send out membership invitations to people who are not currently registered with the Spaces application but might be interested in their space. Before accessing the space, invitees must create an account with the Spaces application and their account details are added to the application's identity store. If approval is required, the moderator must approve their subscription request before gaining access to the space. If the space is public or further approval is not required, then new user gains access to the space immediately he logs in for the first time. See also, Section 22.2, "Enabling Self-Registration By Invitation-Only".




	
Note:

If self-registration is not enabled for the Spaces application, identity store management takes place through the WLS Administration Console (or directly into embedded LDAP identity stores using LDAP commands) and is the responsibility of your systems administrator. See also, "Adding Users to the Embedded LDAP Identity Store" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







A self-registration page is supplied out-of-the-box. Users with the Administrator role can add new components to the page and change the page layout if required. See, Section 7.3, "Working with System Pages".

The self-registration page provided with Spaces offers to send a "user name reminder email" to anyone who tries to register with an email address that has already been used (Figure 22-1).


Figure 22-1 Email Address Already Registered

[image: Email Address Aleady Registered]



This feature only works if public credentials are defined for the external application that is providing authentication for the Mail service in the Spaces application. If users experience issues with this feature, ask your Fusion Middleware Administrator to check the mail server connection and its associated external application connection are configured correctly and that public credentials are defined. See also, "Registering Mail Servers" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.






22.2 Enabling Self-Registration By Invitation-Only

Out-of-the-box, only existing users are candidates for space membership. While this might meet the needs of most Spaces applications it is likely that some spaces will want to recruit members outside of the Spaces community.

The Spaces administrator can extend space membership to users outside of Spaces by allowing them to self-register on an invitation-only basis. When this facility is enabled, moderators can invite anyone to join their space by sending them a customizable invitation by mail. The invitation includes a secure, self-registration URL which the invited party clicks to accept space membership.

New members recruited in this way must create an account with the Spaces application before gaining access to the space. Users who self-register by invitation are added to the identity store, and to the space's member list.




	
Note:

Users who self-register by invitation will be assigned the default application role too—Authenticated-User. Out-of-the box, users with the Authenticated-User role have access to their own Home space, pages that they create, and public pages. They are also allowed to view public spaces, join any space that allows self-subscription, and create spaces of their own. When you enable self-registration, consider modifying Authenticated-User permissions to suit your exact requirements. See also, Section 21.2.3, "Modifying Application Role Permissions".







To allow external users to join Spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration, then General.


	
Select Allow Self-Registration Through Invitations (Figure 22-2).

When you deselect this option, only existing users are candidates for space membership.


Figure 22-2 Allowing Self-Registration Through Invitations

[image: Extending Space Subscription to Non-WebCenter Portal Users]



	
Click Apply.




Moderators may invite non-WebCenter users to become members of their space. See "Inviting a Non-WebCenter Spaces User" in Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces.






22.3 Enabling Anyone to Self-Register

When anyone is allowed to self-register, that is any public user, a Register link or Register button displays on the Spaces login page (Figure 22-3).


Figure 22-3 Self-Registration Available on Login Form

[image: Self-Registration Available on Login Form]



New users must create an account before gaining access to the Spaces application.

Users who self-register are added directly to the Spaces identity store and assigned the Authenticated-User application role. Out-of-the-box, users with Authenticated-User role have access to their own Home space, pages that they create, and public pages. They are also allowed to view public spaces, join any space that allows self-subscription, and create spaces of their own. If you enable self-registration, consider modifying Authenticated-User permissions to suit your exact requirements. See Section 21.2.3, "Modifying Application Role Permissions".

To allow anyone to self-register with Spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Configuration, then General.


	
Select Allow Public Users to Self-Register (Figure 22-4).

When you deselect this option, public users cannot self-register with Spaces. You still enable self-registration on an invitation-only basis if you want. See Section 22.2, "Enabling Self-Registration By Invitation-Only".


Figure 22-4 Allowing Self-Registration Through Invitations

[image: Extending Space Subscription to Non-WebCenter Portal Users]



	
Click Apply.




See also, Section 29.2, "Registering Yourself with WebCenter Portal: Spaces".









23 Securing Pages and Components

You are authorized to specify who can access any page on which you also have Edit Page permission. Among those you authorize to access the page, you can assign varying levels of access, so that some users can edit the page while others can merely view it. If you prefer, you can specify that the page inherits its access settings from the application.

You may want to open a page to many users, but limit the exposure of a particular page component to a specific user, a user group, or to users who are assigned a specific application role. You can accomplish this by associating a security-related EL expression with the component instance.

This chapter provides information about securing pages and page components. It includes the following sections:

	
Section 23.1, "Setting Access on a Page"


	
Section 23.2, "Setting Access on a Page Component"





Audience

This chapter is intended for space Moderators and Participants and for page editors with the create, edit, and delete permission on pages and on the services that provide the components to be secured. For more information about application roles and permissions, see Section 21.2, "Managing Application Roles and Permissions."



23.1 Setting Access on a Page

Page properties include a Security tab with controls for specifying who can do what to the current page (Figure 23-1).


Figure 23-1 Home Space Page: Security Tab in Page Properties Dialog

[image: Security tab in Page Properties dialog]



The options that appear on the Security tab vary according to whether you are accessing the tab from a space page or a Home space page (Figure 23-1 shows the options for a Home space page).

When you set page security on a space page, you have the additional option of inheriting page access permissions from the application or setting custom page access permissions.

This section describes how to set page access through page properties. It is also possible to set page access through the Personalize Pages page. Setting page access through the Personalize Pages page is discussed in Section 38.2, "Controlling User Access to Your Personal Pages."




	
Note:

Page access permissions set through the Page Properties dialog in Composer are committed after you click OK in the Page Properties dialog. Closing Composer without saving does not discard such changes.
Page access permissions set through the Personalize Pages page take effect after you click OK in the Set Page Access dialog.









To access the Security tab in the Page Properties dialog:

	
Go to the page you want to secure, and open it in Composer.




	
See Also:

To open a page in edit mode (Composer), press Ctrl-Shift-E.








	
Click the Page Properties button (Figure 23-2).


Figure 23-2 Page Properties Button in Page Edit Mode

[image: Page Properties button in page edit mode]

Description of "Figure 23-2 Page Properties Button in Page Edit Mode"





	
In the Page Properties dialog, click the Security tab to bring it forward (Figure 23-3).


Figure 23-3 Home Space Page: Security Tab in Page Properties Dialog

[image: Security tab in Page Properties dialog]

Description of "Figure 23-3 Home Space Page: Security Tab in Page Properties Dialog"





	
Space pages only:

	
To specify that the page should inherit access settings from the permissions established for the space, select Use Application Permissions (Figure 23-4), then click OK to save your changes and exit the dialog.




	
See Also:

For more information about setting global space permissions, see Section 52.2, "Managing Roles and Permissions for a Space."








Figure 23-4 Security Tab for a Space Page

[image: Security tab for a Space page]

Description of "Figure 23-4 Security Tab for a Space Page"





	
To set custom access on the current page, select Use Custom Access Settings.

If you select Use Custom Access Settings, continue with the next steps.





	
To grant page access permissions to all authenticated users, that is, to users who are logged in to the Spaces application, click Add Authenticated Access.

The role authenticated-role is added under Role or User.


	
To grant page access permissions to all public users, that is, users who have not logged in to the Spaces application, click Add Public Access.

The role anonymous-role is added under Role or User.




	
Note:

To grant page access to the anonymous-role (that is, to enable users who are not logged in to access the space) the space must be public. The space cannot be private or hidden.








	
To grant page access permissions to selected users, groups, and application roles, click the Add Access button to open the Add Access dialog (Figure 23-5).


Figure 23-5 The Add Access Dialog

[image: Add Access dialog box]

Description of "Figure 23-5 The Add Access Dialog"





	
In the Search field, enter a search term, such as the name of the user, group, or role for whom to enable access, and click the Search icon.




	
Tip:

Search terms must contain at least two characters.








	
Select a user, group, or role by clicking in its row.




	
Tip:

When you select a user name, the permissions you set are granted to that specific user. When you select a group or application role, the permissions you set are granted to all users who are members of that group or who are assigned that role.







To make multiple selections:

	
Ctrl-Click to select multiple rows.


	
Shift-Click to select a range of rows.





	
Click Select.

The Add Access dialog closes, and the Set Page Access dialog populates with the selected users (Figure 23-6).


Figure 23-6 Populated Security Tab in Page Properties Dialog

[image: Populated Security tab in Page Properties dialog]

Description of "Figure 23-6 Populated Security Tab in Page Properties Dialog"





	
For each user, group, or role, grant access by selecting one or more access permissions from the Page Access columns (Table 23-1).


Table 23-1 Page Access Privileges in the Set Page Access Dialog

	Icon	Name	Description
	
[image: View Page icon]


	
View Page

	
Users can access the page for viewing, but cannot perform any other actions on the page.


	
[image: Personalize Page icon]


	
Edit Page

	
Users can edit the page using Composer. This includes adding, rearranging, and deleting content; renaming the page; and changing page properties.


	
[image: Delete Page icon]


	
Delete Page

	
Users can delete the page.


	
[image: Manage Page icon]


	
Perform All Page Actions

	
Users can perform all actions on the page.


	
[image: Edit Page icon]


	
Personalize Page

	
Users can rearrange page content and personalize his or her view of task flows, provided the task flow includes personalization settings.











	
Tip:

By default, all authenticated users and user roles that you add to the Set Page Access dialog are granted page view access. The other access privileges require page view access.








	
Click OK to save your changes and close the Set Page Access dialog.









23.2 Setting Access on a Page Component

There may be pages you want to expose to many users that have components you want only a select set of users—or even only one other user—to see. For example, imagine that you have created a space for all sales people. The space's home page includes two Announcements task flow instances: one for all sales people and one for sales managers only. You can secure the second Announcements instance so that only those users assigned the custom role sales_manager can see it.

Any component that has an associated Show Component property can be secured in this way. Those components that do not have an associated Show Component property can be placed inside a component that does, and in this way be secured. For example, you can place an Announcements task flow, which does not have an associated Show Component property, inside a Box layout component, which does. You can set the property on the Box, and that setting will also affect the display of Announcements.




	
See Also:

You can also set security on the custom components that you import through the Resource Manager. For more information, see Section 10.4.4, "Setting Security for a Resource."







To set access on a component instance:

	
Go to the component instance you want to secure and access its Display Options properties.




	
See Also:

For information about accessing component properties, see Section 17.5.2, "Setting Properties on Page Components."








	
Open the Expression Builder by clicking the Edit icon to the right of the Show Component property and selecting Expression Builder (Figure 23-7).


Figure 23-7 Expression Builder Option Next to Show Component

[image: Expression Builder option next to Show Component]

Description of "Figure 23-7 Expression Builder Option Next to Show Component"





	
Under Type a Value or Expression, enter one of the following EL expressions:

	
To expose a component only to members of a particular scope who are assigned a particular role in that scope, enter:


#{WCSecurityContext.userInScopedRole['role']}


In lieu of role, enter the role name, for example Moderator.

The scope is implicitly resolved to be the current scope:

	
If you use this EL in the Home space, it resolves to Home space GUID and roles defined at the application level.


	
If you use this EL in a space scope, it resolves to roles defined for the space.





	
To expose a component only to members of a group, enter:


#{WCSecurityContext.userInGroup['group_name']}


In lieu of group_name, enter the name of the group, for example Administrators.


	
To expose a component only to a specific user, enter:


#{WCSecurityContext.currentUser['user_name']}


In lieu of user_name, enter the user name, for example jdoe.







	
See Also:

For more information about EL expressions, see Appendix B, "Expression Language Expressions." For information about EL expressions relevant to security, see Section B.4.3, "EL Expressions Relevant to Application Security."








	
Click OK to exit the Expression Builder, and click OK to save your changes and exit the Component Properties dialog.


	
Click Save and then Close to exit Composer.

The secured component appears only to those users with the name, role, or group you specified.












Part VII


Working with Multilanguage Portals

Part VII of the User's Guide provides information about the languages available with WebCenter Portal: Spaces, how to manage that availability, and how to provide translations of user content.

Part VII includes Chapter 24, "Working with Multilanguage Portals."







24 Working with Multilanguage Portals

If your portal will be viewed by users in more than one country, you can configure it to display localized content based on the user's selected language and locale. For example, if you know your page will be viewed in Italy, you can localize your page so that when Italian is selected (in browser, user preferences, space, or application settings), text strings in the page will appear in Italian.

Additionally, locale selection applies special formatting considerations applicable to the selected locale. For example, whether information is typically viewed from left to right or right to left, how numbers are depicted (such as monetary information), and the like.

This chapter includes the following sections:

	
What You Should Know About Languages in Spaces


	
Configuring Language Options


	
Enabling Users to Choose a Language






24.1 What You Should Know About Languages in Spaces

There are three main types of information that are displayed in Spaces:

	
User interface (UI) elements, such as field and button labels and seeded boilerplate text


Figure 24-1

[image: UI elements: field and button labels, boilerplate text]



	
User-entered metadata, such as space and page names


Figure 24-2

[image: user-entered metadata: Space name and page name]



	
Content added by users, such as announcements, documents, and discussion forum content


Figure 24-3

[image: User content: message, announcement, document name]





Each type of information is handled differently when it comes to translation:

	
UI elements include out-of-the-box translations for 27 languages and 100 different locales. If the default UI text is not suited to your company's needs or if your company needs to support additional languages, your Spaces administrator can edit the string files containing this text.


	
User-entered metadata can be translated by your Spaces administrator the same way that UI elements are translated, by editing the string files.


	
Content added by users is generally displayed in the language used by the contributing user, though there is a way that your Spaces administrator can display translated content using Content Presenter.




For information on translating information, see Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.



24.1.1 Display Language Precedence

The display language controls the language in which translated information is rendered in your browser.

On the Internet, browser settings normally control the display language used for the various web sites a user visits. However, Spaces provides additional controls for language selection at the application, space, and user levels. The order of precedence for Spaces display language settings from weakest to strongest is as follows:

	
Browser setting—This is the language selected in the user's browser preferences. Browser documentation describes how to change this setting.


	
Public cookie—This is the session language a public user—that is, a user who is not logged in to Spaces—can select on your portal's Welcome page. A session language is retained for the life of the cookie. If the user clears the browser cookies, the session language is also cleared.


	
Application setting—This is the application default language configured by your Spaces administrator (for more information, see Section 5.4, "Choosing a Default Display Language").


	
User preference setting—This is the language the user selects through the personal Preferences settings (for more information, see Section 35.2, "Choosing Your Preferred Display Language")


	
Current scope—This is the language set the space moderator sets for a given space (for more information, see Section 51.4.15, "Setting a Space Display Language").







	
Note:

If the server on which Spaces is running does not support the character set of the language preference set in Spaces, the output information related to spaces becomes garbled or displays as question marks.
To work around this issue, users can change the session language or their personal language preference to English. This creates new log file information. The log file is typically located at $WC_DOMAIN/servers/WLS_Spaces/logs.














24.1.2 Languages Supported Out-of-the-Box by Spaces

Spaces provides runtime translations for 27 languages and 100 different locales.


Table 24-1 Languages Available for Spaces

	A to Fi	Fr to No	P to T
	
Arabic

	
French

	
Polish


	
Brazilian Portuguese

	
German

	
Portuguese


	
Chinese (Simplified)

	
Greek

	
Romanian


	
Chinese (Traditional)

	
Hebrew

	
Russian


	
Czech

	
Hungarian

	
Slovak


	
Danish

	
Italian

	
Spanish


	
Dutch

	
Japanese

	
Swedish


	
English

	
Korean

	
Thai


	
Finnish

	
Norwegian

	
Turkish








The list in Table 24-1 includes all the languages available to Spaces out-of-the-box. Users can also select locales associated with particular languages. For example, a user can change the language to Arabic and, within that language group, select from 20 different locales, including Algeria, Bahrain, Djibouti, and so on.




	
Note:

The administrative tier that offers services to Spaces, including such tools as Oracle Enterprise Manager, provides a subset of the languages available to Spaces. These include:
	
English


	
Brazilian Portuguese


	
Chinese (Simplified)


	
Chinese (Traditional)


	
French


	
German


	
Italian


	
Japanese


	
Korean


	
Spanish




The Discussions service uses the Jive application. Out-of-the-box, the Jive application bundled with WebCenter Portal supports English and Spanish. It does not support other languages listed in Table 24-1. However, Jive is open to your own translation files. For more information, see http://www.jivesoftware.com/builds/docs/latest/documentation/developer-guide.html#i18n. This information is explicit to the Jive application user interface.
















24.2 Configuring Language Options

This section describes how to configure the language options available in Spaces. It includes the following sections:

	
	
Spaces administrators can configure the language displayed by default in Spaces and the languages available to choose from in the Spaces UI. For more information, see Section 5.4, "Choosing a Default Display Language."


	
Space moderators can configure the language displayed by default in their specific spaces and the languages available to choose from in their spaces UI. For more information, see Section 51.4.15, "Setting a Space Display Language."


	
Users can select a language preference that applies whenever they are logged in to Spaces. For more information, see Section 35.2, "Choosing Your Preferred Display Language."












24.3 Enabling Users to Choose a Language

This section describes how to enable users to choose a language by adding a Change Language component to a page. It includes the following sections:

	
Adding a Change Language Task Flow to a Page


	
Setting Change Language Task Flow Properties






24.3.1 Adding a Change Language Task Flow to a Page

You can add the Change Language task flow to any page (in a Home Space, in a Group Space, or a business role page) to allow users to choose the language in which to display the UI.

To add a Change Language task flow to a page:

	
Go to the page where you want to add the task flow, and open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content to open the Resource Catalog.


	
Locate the Change Language task flow in the Resource Catalog.




	
Note:

This task flow is not available in the default Resource Catalogs provided out-of-the-box with Spaces so you will only see the Change Language task flow if it has been added to the Resource Catalog that has been made available to the page.
For more information, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Web Development, then scroll to Change Language).










	
Click Add next to the Change Language task flow, then Close the Resource Catalog.


	
Click Save, then Close.









24.3.2 Setting Change Language Task Flow Properties

The Change Language task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 24-4).


Figure 24-4 Change Language Task Flow - Component Properties

[image: Change Language task flow component properties]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 24.3.2.1, "What You Should Know About the Change Language Task Flow Properties"


	
Section 24.3.2.2, "Change Language Task Flow Parameters"






24.3.2.1 What You Should Know About the Change Language Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 24.3.2.2, "Change Language Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






24.3.2.2 Change Language Task Flow Parameters

Table 24-1 describes the parameters that are unique to the Change Language task flow.


Table 24-2 Change Language Task Flow Parameters

	Parameter	Description
	
Display Detailed List

	
Display a detailed list of languages, including locales.

Default: Not selected


	
Persist Change to Preferences

	
Persist the user's language choice to the user's preferences.

Default: Not selected


	
Scope

	
The name or GUID of the scope to which you want this language selection to apply.

By default, the language selection is applied to the current scope. This means that a Change Language component placed on a page in the Home space affects the entire application, and a Change Language component placed in a particular space affects just that space.

To limit the language selection to a space other than the current space, set this to the intended space's GUID. For information about obtaining a space's GUID, see Section 29.9.1, "Accessing Space Information."



















Part VIII


Creating and Managing Portlets and Task Flows at Runtime

Part VIII of the User's Guide provides information about creating visualizations, such as forms, tables, and graphs, by gathering and publishing data from various data sources. It describes these tasks in terms of a data composer and seeded portlets.

Part VIII includes the following chapters:

	
Chapter 25, "Understanding Portlet Basics"


	
Chapter 26, "Creating Business Mashups"


	
Chapter 27, "Working with OmniPortlet"


	
Chapter 28, "Working with the Web Clipping Portlet"










25 Understanding Portlet Basics

This chapter provides an overview of portlets. It contains the following sections:

	
Section 25.1, "What Is a Portlet?"


	
Section 25.2, "What Does a Portlet Look Like?"


	
Section 25.3, "What Can I Do with Portlets?"


	
Section 25.4, "What Kinds of Portlets Can I Use?"





Audience

This chapter is intended for users who want to learn about portlets and how they integrate with Oracle WebCenter Portal.



25.1 What Is a Portlet?

Portlets are reusable web components that can draw content from a variety of different sources. Portlets provide a means of presenting data from multiple sources in a meaningful and related way. Portlets can display excerpts of other web sites, generate summaries of key information, perform searches, and access assembled collections of information from a variety of data sources. Because different portlets can be placed on a common page, you receive a single-source experience, though the content may be derived from multiple sources.






25.2 What Does a Portlet Look Like?

Figure 25-1 shows the sample Lottery portlet on a page in a WebCenter Portal application. Note that the same portlet displayed in a different application could look different, depending on how the portlet styles are defined.


Figure 25-1 The Sample Lottery Portlet

[image: Lottery portlet]



The following list describes some of the elements you might see in a portlet, depending on the application consuming the portlet:

	
Portlet chrome. The collection of visual elements that surround the portlet, including the header, border, resize handle, and icons.


	
Portlet header. The area of the portlet that displays the portlet title and the icons that enable interaction with the portlet. The user who added the portlet to the page may have chosen to not display the portlet header.


	
Portlet title. Text in the portlet header that indicates the purpose of the portlet. You may be able to personalize this title to make it more meaningful for your particular usage.


	
Minimize/Expand icon. An icon in the portlet header. Clicking the Minimize icon causes the portlet content to collapse so that only the portlet header is displayed. This saves space on the page and reduces clutter without permanently removing the portlet from the page. When the portlet is minimized, the icon becomes an Expand icon that you can click to display the content again.


	
Personalize icon. An icon in the portlet header. Clicking the Personalize icon enables users to personalize the portlet (that is, make changes that only that user can see).


	
Customize icon. An icon in the portlet header. Clicking the Customize icon enables users to customize the portlet (that is, make changes that are visible to everyone).


	
Actions icon. An icon in the portlet header. Clicking the Actions icon displays the Actions menu.


	
Actions menu. Lists the various other actions that you can perform on the portlet. The actions depend on whether you are logged in, your privileges, the logic of the portlet, and the specifics of how the portlet was placed on the page. Actions include Maximize, Restore, Refresh, and Move Up or Down. If the portlet provides modes such as Help and About, these are also listed in the Actions menu.

If the user who added the portlet to the page chose to not display a portlet header, the Actions menu is displayed on a fade in/fade out toolbar that displays on mouse rollover.


	
Resize handle. Enables you to make the portlet bigger or smaller.


	
Portlet content. The actual content of the portlet as determined by the portlet developer.




The appearance of a portlet is determined by the internal logic of the portlet itself, as written by the portlet developer, the attributes specified by the user who added the portlet to the page, and any of your own personalizations. For example, the portlet developer can determine, during portlet creation, whether users can personalize the portlet at runtime. The user who adds the portlet to a page can decide whether the personalize option is displayed in the Actions menu. The user at runtime can minimize the portlet so that the content is not even displayed on the page.






25.3 What Can I Do with Portlets?

If your application includes portlets, and you are logged in, you can edit those portlets to make them display the information that you, personally, want to see (this is known as personalization). To personalize a portlet, click the Personalize icon in the portlet header. The personalizations you can make depend on how the portlet developer designed the portlet. You can also hide portlets, or remove them entirely from the page. Note that the changes that you make apply only to you. If you delete a portlet, other users can still see it when they view the page (unless they have deleted it themselves).

If you have the appropriate privileges, you can also edit the way the portlet appears to all users (this is known as customization). To customize a portlet, click the Customize icon in the portlet header. The changes you make are visible to all users.

If you have the appropriate privileges to edit a page in a WebCenter Portal application, you can add portlets to that page.




	
See Also:

For more information, see Section 17.5, "Adding Resource Catalog Components to Pages."







The portlets you can add depend on the portlet producers that have been registered with the application. A portlet producer is the object that owns the portlet and makes it available to an application. If you want to add a particular portlet to a page, but cannot find it in the Resource Catalog, this could mean that the associated producer is not registered with your application. If you have the appropriate privileges, you can register portlet producers yourself through WebCenter Portal Administration.




	
See Also:

For more information, see Section 6.5, "Registering Portlet Producers."







If you do not have the privileges to register portlet producers, you must ask your WebCenter Portal application administrator to register the producer for you.




	
Note:

In Oracle WebCenter Portal: Spaces, avoid adding a portlet to a Movable Box layout component. The Movable Box layout component duplicates the showDetailFrame that the portlet provides by default. There are no additional benefits to including a portlet in a Movable Box.












25.4 What Kinds of Portlets Can I Use?

There are several different kinds of portlets available to you. Portlets fall into the following categories: prebuilt portlets provided by Oracle and third-party sources; portlets built for you by your own developers; and portlets that you can build yourself. However, you can only use portlets that the WebCenter Portal application administrator has registered with the application. When it comes to adding portlets to a page, a portlet's category and how it was created are irrelevant; all portlets are listed in the Resource Catalog and are available for inclusion.

This section includes the following subsections:

	
Section 25.4.1, "Prebuilt Portlets"


	
Section 25.4.2, "JSF Portlets"


	
Section 25.4.3, "Programmatic Portlets"


	
Section 25.4.4, "Web Clipping"


	
Section 25.4.5, "OmniPortlet"


	
Section 25.4.6, "Parameter Form and Parameter Display Portlets"






25.4.1 Prebuilt Portlets

Prebuilt portlets include partner portlets and integration solutions.

Partner portlets are available through Oracle's partnerships with leading system integrators, software vendors, and content providers. You can access these portlets by using the keywords portal or portlet when searching the Oracle PartnerNetwork (OPN) Solutions Catalog, available at:

http://solutions.oracle.com

Examples of these include portlets for the following purposes:

	
Generating point-to-point driving directions


	
Accessing Information Technology (IT) information from a wide variety of sources


	
Viewing summary information about news, stocks, and weather




If you think a particular portlet would be useful for your application, ask your WebCenter Portal application administrator to register the appropriate producer for you.






25.4.2 JSF Portlets

JSF portlets expose existing JSF applications and task flows as JSR 286 portlets. They are created using the Oracle JSF Portlet Bridge. The Oracle JSF Portlet Bridge simplifies the integration of JSF applications with WSRP portlet consumers, such as Oracle Portal. Developers create JSF portlets in Oracle JDeveloper using the JSR 286 Java Portlet Wizard or the Portlet Bridge design-time wizard for pages and task flows.

JSF portlets do not require separate source code from that of the JSF application. Since these portlets are created using the Oracle JSF Portlet Bridge, developers need only to maintain one source for both the application and the portlets. Similarly, when the JSF application is deployed, JSF portlets are also deployed with it. Therefore, using the bridge eliminates having to store, maintain, and deploy portlets separately from the application.






25.4.3 Programmatic Portlets

Programmatic portlets are portlets that have been written specifically for your organization to meet a particular requirement not met by the out-of-the-box portlets. WebCenter Portal: Framework provides two declarative wizards for simplifying the creation of standards-based JSR 286 portlets and Oracle PDK-Java portlets. These wizards assist in the construction of the framework within which developers create the portlet.

Some examples of programmatic portlets might be:

	
Photo album portlet. A portlet that facilitates uploading, storing, and viewing user photos.


	
Shopping cart portlet. A portlet that facilitates the viewing and purchasing of, for example, company-branded items, such as mouse pads, pens, flash drives, tee shirts, and so on.




Programmatic portlets are written by experienced Java developers who are familiar with the Java Portlet Specification or Oracle PDK-Java.




	
See Also:

For more information about programmatic portlets, see the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.












25.4.4 Web Clipping

Web Clipping is a publishing portlet that enables you to integrate any web application with your WebCenter Portal application. It is designed to give you quick integration by leveraging the existing user interface of a web application. With Web Clipping, you can collect web content into portlets in a single centralized web page. You can use Web Clipping to consolidate content from web sites scattered throughout a large organization.

To create a Web Clipping portlet, use a web browser to navigate to a web page that contains the desired content. Through the Web Clipping Studio, you can drill down through a visual rendering of the target page to choose the desired content.

Web Clipping supports the following:

	
Navigation through various styles of login mechanisms, including form- and JavaScript-based submission and HTTP Basic and Digest Authentication with cookie-based session management.


	
Fuzzy matching of clippings. If a web clipping gets reordered within the source page or if its character font, size, or style changes, it can still be identified correctly by the Web Clipping engine and delivered as the portlet content.


	
Reuse of a wide range of web content, including basic support of pages written with HTML 4.0.1, JavaScript, applets, and plug-in enabled content, retrieved through HTTP GET and POST (form submission).


	
Personalization, allowing you to expose input parameters that you can then modify when you personalize the portlet. You can expose these parameters as public parameters that you can map as page parameters. This feature enables you to obtain personalized clippings.


	
Integrated authenticated web content through Single Sign-On, including integration with external applications, which enables you to leverage Oracle Single Sign-On and to clip content from authenticated external web sites.


	
Inline rendering, enabling you to set up Web Clipping portlets to display links within the context of the portlet. As a result, when you click a link in the Web Clipping product, the results display within the same portlet. You can use this feature with internal and external web sites.


	
Proxy Authentication, including support for global proxy authentication and authentication for each other. You can specify the realm of the proxy server and whether all users automatically log in using a user name and password you provide, each user logs in using an individual user name and password, or all users log in using a specified user name and password.


	
Resource Tunneling of images.


	
Open Transport API for customizing authentication mechanisms to clipped sites.




Some examples of how you might use Web Clipping are:

	
Stock chart portlet. Create a portlet that displays the stock market's daily performance chart from your financial advisor's web site. You can clip this information from an external web site, even if your company is using a proxy.


	
Web mail portlet. Access your confidential web mail account through a portlet and to display your in-boxes in the portlet.







	
See Also:

For more information about using Web Clipping, see Chapter 28, "Working with the Web Clipping Portlet."












25.4.5 OmniPortlet

OmniPortlet is a data publishing portlet that you add to your application at design time, so that users can customize at runtime. Using a wizard, page designers can publish data from a variety of data sources (including SQL, XML, web services, spreadsheets, and web pages) to several different layouts, such as customizable charts and tables.

Like Web Clipping, OmniPortlet supports proxy authentication, including support for global proxy authentication and authentication for each user. You can specify whether all users automatically log in using a user name and password you provide, each user logs in using an individual user name and password, or all users log in using a specified user name and password.

Some examples of how you might use OmniPortlet are:

	
RSS news feed portlet. Create a portlet that displays live, scrolling news information to your users from a Really Simple Syndication (RSS) news feed, such as Oracle Technology Network Headlines. You can also include hyperlinks to the news source.


	
Sales chart portlet. Present up-to-date information about your company's sales results. You can choose to display the data as a pie chart and store the sales information in a remote relational database for later use.







	
See Also:

For more information about OmniPortlet, see Chapter 27, "Working with OmniPortlet."












25.4.6 Parameter Form and Parameter Display Portlets

The Parameter Form and Parameter Display portlets provide a quick and easy way to pass values between components. They are provided by the WSRP Tools producer.

The Parameter Form portlet has three output parameters that are set when values are submitted in the form inside the portlet. The parameters can then be used to drive the content of other portlets. You can customize the Parameter Form portlet to determine how many of the three fields are displayed on the form, depending on how many parameters you require.

The Parameter Display portlet enables you to quickly test the wiring from the Parameter Form portlet. However, typically you use the values passed from the Parameter Form portlet to drive the content of some other portlet, for example, to pass a ZIP code to a weather portlet, or a stock symbol to a stock ticker portlet.

Figure 25-2 shows a Parameter Form portlet that has been customized to accept a single value (ZIP code). When a user enters a ZIP code and clicks OK, the Parameter Display portlet refreshes to display the same ZIP code.


Figure 25-2 Parameter Form and Display Portlets

[image: Parameter Form and Display portlets]






	
See Also:

For more information about linking portlets, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

















26 Creating Business Mashups

Business mashups are reusable components that you can create or edit at runtime. A mashup can be an ensemble of multiple UI widgets that interact with each other. Each component in a business mashup could be working against a different data source such as SQL, Web Services, or XML. A mashup can display data retrieved from a data source as a graph or table, or write to a data source using a form.

Oracle WebCenter Portal provides a powerful way for developers, administrators, and power users to create mashups in the running portal or social and collaborative application without bringing the system to a halt. A fully-integrated data publisher enables you to perform the following tasks:

	
Create data controls to retrieve information from different data sources.


	
Create mashups by consuming data controls in task flows or application pages.


	
Provide users the flexibility to customize their view of a mashup.




This chapter explains how to perform these tasks. It includes the following sections:

	
Section 26.1, "Introducing Business Mashups"


	
Section 26.2, "Creating and Managing Data Controls"


	
Section 26.3, "Creating and Managing Task Flows"


	
Section 26.4, "Creating Data Visualizations"


	
Section 26.5, "Business Mashup Examples"





Audience

This chapter is intended for users who want to provide and manage Resource Catalogs in their Spaces application. Portal designers with the application permission Application-Resource Catalogs-Create Edit Delete can manage application-level Resource Catalogs. Space moderators with the permission Space-Resources-Create Edit Delete (simple permission model) or Space-Resource Catalogs-Create Edit Delete (detailed permission model) can manage space-level Resource Catalogs. For information about roles and permissions, see Chapter 20, "Understanding Security."



26.1 Introducing Business Mashups

Business mashups are visualizations created by gathering data from various data sources and publishing the gathered data using different layouts such as forms, tables, and graphs. The Resource Manager (Resources page), shown in Figure 26-1, provides the following options to create business mashups:

	
Data Controls: Opens the Data Controls page to create and manage SQL and Web Services data controls.


	
Task Flows: Opens the Task Flows page to create and manage task flows that can be consumed in application pages. You may want to create task flows to consume data controls and wire parameters so that users can control the data displayed in their view of the data controls.


	
Mashup Styles: Opens the Mashup Styles page to manage the templates available for creating task flows.





Figure 26-1 Mashups Section in the Resource Manager

[image: Data Controls in Resource Manager]



You can create data controls, task flows, and mashup styles at the application level and space level. While application-level resources are also available for consumption in spaces, space-level resources are available only to the space in which they were created. You cannot modify or delete application-level resources from within a space.




	
Note:

If you consume application-level data controls inside a space and want to export that space to another Spaces instance, you must perform all the necessary checks to ensure that the data control works properly. For more information, see Section 26.2.5.1, "Steps You Must Perform After an Import."







This section includes the following subsections:

	
Section 26.1.1, "Supported Data Controls"


	
Section 26.1.2, "Supported Visualizations"






26.1.1 Supported Data Controls

Spaces applications support the creation of data controls that can be used to view data from a data source and filter the data using parameters, enter data into a data source (provided the data source supports it), and drive the data in one component from the data in another component.

The advantage of creating data controls at runtime is that you can get data from different data sources and create visualizations or mashups without having to redeploy and restart your application. What's more, you can modify visualizations at any point of time and control what is retrieved from the data source and rendered. You can also write to the data sources using forms within business mashups.

The type of data control to use depends on where the data is stored and how it is exposed. For example, use a Web Service data control to call a Web Service for data. The process of collecting data is different for each data source. The Resource Manager - Data Controls page in your application or space provides options to create SQL and Web Service data controls. This section describes these data control types in brief. It includes the following subsections:

	
Section 26.1.1.1, "SQL Data Controls"


	
Section 26.1.1.2, "Web Service Data Controls"






26.1.1.1 SQL Data Controls

Used to collect data from relational databases. To create a SQL data control, you must have a data source connection from the application server to the database. You can retrieve data by specifying a SQL query. To limit the data retrieved to specific criteria, you can specify bind parameters as part of the SQL query. You can add as many bind parameters as required.

Data controls created at runtime can be used only to query the database, you cannot update the retrieved data. However, design time data controls that were created with read-write capabilities allow the retrieved data to be updated.

Bind parameters provide the following benefits:

	
They enable reuse of a data control. A data control with one or more bind variables can be used many times in different visualizations, each instance displaying different data.


	
They enable end users to control the data displayed in the data control. Data controls that you create are eventually consumed in pages or task flows and viewed by end users. You can include the data control in a task flow and wire its parameters to task flow parameters so that the task flow parameter drives the data in the data control. For more information, see Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."

Another way to control the data displayed is by wiring a data control parameter to an input text component on the task flow. You can achieve this type of wiring easily by using a parameter form task flow. For more information, see Section C.2.4, "Adding the Data Control in a Parameter Form Task Flow."


	
If a database has imposed an IO limit, and the query happens to traverse large number of records that exceed the IO limit, then adding such a data control to a page or task flow may result in an error and failure to render. You can limit the data retrieved from a database to specific criteria by specifying bind parameters in your query.




For the steps to create a SQL data control, see Section 26.2.1, "Creating a SQL Data Control."






26.1.1.2 Web Service Data Controls

Used to collect data from a business service that can be accessed over the Internet using standard protocols, such as SOAP and HTTP. To collect data from a Web Service, you must know the path to the Web Service Description Language (WSDL) file. The WSDL file describes the Web Service and specifies the methods that can be called, including the expected parameters. It also describes the returned data.

Based on the permissions you have on a Web Service data source, you can only specify values for parameters exposed by its methods; you cannot add or delete parameters. You can specify values for the following types of parameters:

	
Scalar parameters: These are simple parameters for which you can directly specify string or EL values to display data.


	
Complex parameters: These are derived parameters that take objects as parameters. They may also get their value from scalar parameters exposed by the method. Complex parameters are available in XML format.

See Section C.5, "Creating a Mashup with Data from a Siebel Data Source" for an example of how you can use complex parameters.




	
Note:

You cannot pass values to complex parameters that are recursive, that is, if A includes B and B in turn references A.








	
Array parameters: These parameters enable you to pass mulitple values at a time, thereby updating multiple records in the data source simultaneously. See Section C.5, "Creating a Mashup with Data from a Siebel Data Source" for an example of how you can use array parameters.




Apart from querying the data source, for data sources that allow updating, Web Service data controls also provide an option to update records.

For more information, see Section 26.2.2, "Creating a Web Service Data Control."








26.1.2 Supported Visualizations

The data gathered using SQL and Web Service data controls can be rendered on a page or task flow in different ways. While editing a page or task flow, when you click Add against a data control's accessor, method, or parameter in the Resource Catalog, the Add menu displays different drop handlers. The drop handlers enable you to add a data control's objects as UI elements such as tables, graphs, forms, buttons, or labels. Depending on the type of object and the flavors supported, you can different UI elements. This section describes these elements. It includes the following subsections:

	
Section 26.1.2.1, "Table"


	
Section 26.1.2.2, "Form"


	
Section 26.1.2.3, "Graph"


	
Section 26.1.2.4, "Button or Link"


	
Section 26.1.2.5, "Text or Label"






26.1.2.1 Table

This option is displayed when you select a data control accessor that returns a collection of objects that can be displayed in columns of a table. Select this option to display data in a tabular layout. When you add a data control inside a task flow, you can wire data control parameters to task flow parameters so that the table displays data based on a parameter value that you specify. You can add an editable table, or a read-only table that displays data based on your specification, but cannot be edited.

For more information, see Section 26.4.1.1, "Adding a Data Control as a Table."






26.1.2.2 Form

This option is displayed when you select a data control accessor that returns a collection of objects that can be displayed in a form. Select this option to display source data in a form. When you add a data control inside a task flow, you can wire data control parameters to task flow parameters so that the form displays data based on a parameter value that you specify. You can add an editable form, or a read-only form that displays data based on your specification, but cannot be edited. However, using an editable form makes sense only if the data source supports writing back to it.

For more information, see Section 26.4.1.2, "Adding a Data Control as a Form."






26.1.2.3 Graph

This option is displayed when you select a data control accessor that returns a collection of objects that can be displayed in a graph. This is useful for the purpose of analysis, when you want to generate a report. Graphs cannot be edited. Select this option to display your data graphically, as a bar, pie, line, or an area chart. When you add a data control inside a task flow, you can wire data control parameters to task flow parameters so that the graph displays data based on a parameter value that you specify.

For more information, see Section 26.4.1.3, "Adding a Data Control as a Graph."






26.1.2.4 Button or Link

The ADF Button, ADF Link, ADF Image Link, and ADF Toolbar Button options are displayed when you select a data control's methods or operations that perform an action. Select any of the button or link options while adding methods or operations such as Create, Update, Delete, Commit, Rollback, Save, or Close. Different options are available for different data controls depending on the methods exposed by the data source. For more information, see Section 26.4.7, "Writing to a Data Source from a Visualization."






26.1.2.5 Text or Label

The ADF Output Text, ADF Output Text w/ Label, ADF Output Formatted, ADF Output Formatted w/ Label, ADF Input Text, ADF Input Text w/ Label, and ADF Label options are displayed when you select a data control's attributes or methods that return a single object. An attribute can be a scalar parameter of an accessor, a method return, or an object member of a complex parameter. Select a text or label option depending on whether you want to display the value to users or want users to specify a value. When you add a data control inside a task flow, you can wire data control parameters to task flow parameters so that the task flow displays data based on a parameter value that you specify. You can even add an input text component and wire it to a data control parameter. For more information about this type of wiring, see Section 26.4.4, "Wiring a Data Control to a Parameter Form Task Flow."










26.2 Creating and Managing Data Controls

This section describes how to create SQL and Web Service data controls. It includes the following sections:

	
Section 26.2.1, "Creating a SQL Data Control"


	
Section 26.2.2, "Creating a Web Service Data Control"


	
Section 26.2.3, "Managing Data Controls"


	
Section 26.2.4, "Using Design-Time Data Controls"


	
Section 26.2.5, "Exporting and Importing Data Controls Across Spaces"






26.2.1 Creating a SQL Data Control

SQL data controls enable you to retrieve data from a relational database using a SQL query. Therefore, before creating the data control, you must have a database connection. The task of creating a database connection must be performed by a WebCenter Portal administrator. For reference, in addition to the steps to create a SQL data control, this section also describes how to create a database connection. It includes the following subsections:

	
Section 26.2.1.1, "Prerequisites When Using a DB2 or SQL Server Database"


	
Section 26.2.1.2, "Creating a Database Connection"


	
Section 26.2.1.3, "Creating the Data Control"






26.2.1.1 Prerequisites When Using a DB2 or SQL Server Database

If you are using a DB2 or a SQL Server database, perform the following prerequisite tasks before you create a database connection:

If You Use a DB2 or a SQL Server Database Connection:

The default SQL style for all database connections is "Oracle". If you create a database connection to an IBM DB2 or Microsoft SQL Server database, then you must perform the following tasks:

	
Manually override the SQL style with one that supports the DB2 or SQL Server database. For this, you must specify a Java system property, jbo.SQLBuilder, with the value DB2 or SQLServer. When Oracle WebLogic Server is started with this configuration, it supports the SQL style you specified.

Specify the system property as a Java command line option in either of the following ways (examples show property values for DB2):

	
Open the DomainHome/bin/setDomainEnv.sh file and add -Djbo.SQLBuilder=DB2 to the JAVA_OPTIONS line.


	
Edit the managed server start script in a text editor and add -Djbo.SQLBuilder=DB2 to the JAVA_OPTIONS line.

For more information, see "Specifying Java Options for a WebLogic Server Instance" in Oracle Fusion Middleware Managing Server Startup and Shutdown for Oracle WebLogic Server.





	
Specify Java as a typemap entry using the jbo.TypeMapEntries property as follows:


-Djbo.TypeMapEntries="Java"









26.2.1.2 Creating a Database Connection

This section describes the procedure to create a database connection from the Oracle WebLogic Server Administration Console.




	
Note:

This section is included here for reference. The task must be performed by a WebCenter Portal administrator. For more information, see "Setting Up Database Connections" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







To create a database connection:

	
In the Domain Configuration section, under Services, select Data Sources.


	
On the Summary of Data Sources page, click New and select Generic Data Source.


	
On the JDBC Data Sources Properties page, enter or select the following information:

	
Name - Enter a name for this JDBC data source.


	
JNDI Name - Enter the JNDI path to where this JDBC data source will be bound. Applications look up the data source on the JNDI tree by this name when reserving a connection.


	
Database Type - Select the DBMS of the database that you want to connect to. If your DBMS is not listed, select Other.





	
Click Next to continue.


	
Select the JDBC driver you want to use to connect to the database. The list includes common JDBC drivers for the selected DBMS.

	



	
Note:

You must install JDBC drivers before you can use them to create database connections. Some JDBC drivers are installed with WebLogic Server, but many are not installed.
For more information, see "Using JDBC Drivers with Weblogic Server" in Oracle Fusion Middleware Configuring and Managing JDBC Data Sources for Oracle WebLogic Server.













	
On the Transaction Options page, follow these steps. Depending on the driver you selected on the JDBC Data Source Properties page, you may not need to specify any of these options.

	
Supports Global Transactions - Select this checkbox (the default) to enable global transaction support in this data source. Clear this checkbox to disable (ignore) global transactions in this data source. In most cases, you should leave the option selected.

If you selected Supports Global Transactions, select an option for transaction processing: (available options vary depending on whether you select an XA driver or a non-XA driver)

	
Two-Phase Commit - Select this option to enable standard XA processing.

This option is only available when you select an XA JDBC driver to make database connections.


	
Logging Last Resource - Select this option to enable a non-XA JDBC connection to participate in global transactions using the Logging Last Resource (LLR) transaction optimization. Recommended in place of Emulate Two-Phase Commit.

This option is only available when you select a non-XA JDBC driver to make database connections.


	
Emulate Two-Phase Commit - Enables a non-XA JDBC connection to emulate participation in distributed transactions using JTA. Select this option only if your application can tolerate heuristic conditions.

This option is only available when you select a non-XA JDBC driver to make database connections.


	
One-Phase Commit - Select this option to enable the non-XA connection to participate in a global transaction as the only transaction participant.

This option is only available when you select a non-XA JDBC driver to make database connections.








	
Click Next to continue.


	
On the Connection Properties page, enter values for the following properties:

	
Database Name - Enter the name of the database that you want to connect to. Exact database name requirements vary by JDBC driver and by DBMS.


	
Host Name - Enter the DNS name or IP address of the server that hosts the database. If you are creating an Oracle GridLink service-instance connection, this must be the same for each data source in a given multi data source.


	
Port - Enter the port on which the database server listens for connections requests.


	
Database User Name - Enter the database user account name that you want to use for each connection in the data source.


	
Password/Confirm Password - Enter the password for the database user account.





	
Click Next to continue.


	
On the Test Database Connection page, review the connection parameters and click Test Configuration.

WebLogic attempts to create a connection from the Administration Server to the database. Results from the connection test are displayed at the top of the page. If the test is unsuccessful, you should correct any configuration errors and retry the test.

If the JDBC driver you selected is not installed on the Administration Server, you should click Next to skip this step.


	
Click Next to continue.


	
On the Select Targets page, select the server on which you want to deploy the data source. Select WC_SPACES to deploy the data source to your Spaces instance.


	
Click Finish to save the JDBC data source configuration and deploy the data source to the target that you selected.







	
See Also:

Oracle Fusion Middleware Configuring and Managing JDBC Data Sources for Oracle WebLogic Server for information about JDBC data sources.












26.2.1.3 Creating the Data Control

To create a SQL data control in Spaces:

	
On the Resources page, under Mashups, select Data Controls, and on the resulting Data Controls page, click Create.


	
In the Create new Data Control dialog, select SQL in the left pane (Figure 26-2).


	
In the Name and Description fields at the bottom of the dialog, enter a name and description for the data control.


	
In the Database Connection section, from the dropdown list, select the database connection that you will use for this SQL data control. For more information, see Section 26.2.1.2, "Creating a Database Connection."


Figure 26-2 New SQL Data Control Wizard

[image: Create New SQL Data Control Dialog]

Description of "Figure 26-2 New SQL Data Control Wizard"





	
In the password field, specify the connection password.

This field is used to ensure that only users who know the password to connect to the data source can create a data control. You must specify the password every time you create or edit a data control.


	
In the SQL Statement text box, enter a SQL query, for example:


SELECT * FROM Persons WHERE City LIKE 'sa%'


Specify any bind parameters as part of the query. Bind parameters are useful in controlling the data displayed in the data control. Consider the following example:


select ename, empno, mgr, deptno from emp where job in (:job) order by empno asc


This query returns details of all employees with a particular designation, for example, sales managers. In this query :job defines the parameter job, which maps to the job column in the emp database table. The query returns data based on the job value (how you specify this is explained in the next step). You can add as many parameters as required. You can also use the same parameter multiple times in a statement.




	
Notes:

	
Avoid using SQL reserved words and keywords for bind parameter names. For more information, see the topic titled "Oracle SQL Reserved Words and Keywords" in the Oracle Database SQL Language Reference in the Oracle Database documentation library.


	
If you are using a SQL Server database, you may get an error if the query contains a column with the NCHAR or NVARCHAR data type. To workaround this limitation, you must modify the query using the convert function as shown in the following example:


select convert(varchar(20), col1) col1, convert(varchar(20), col2) col2 from table1













	
If you added bind variables in your SQL query, for example, job, then click Enter bind parameter values to define initial values for those variables.


	
In the Enter bind parameter values dialog, shown in Figure 26-3, specify values for the parameters. The dialog lists all parameters that you defined as part of your SQL query.


Figure 26-3 The Dialog for Setting Bind Parameter Values

[image: Enter bind parameter values Dialog]

Description of "Figure 26-3 The Dialog for Setting Bind Parameter Values"





	
Click OK.


	
Click Test to test the query you entered.

If you added bind parameters, but did not specify initial values for the parameters, you will see a validation exception.

If the query is correct, you will see a table displaying the data retrieved from the data source. The table displays up to a maximum of 25 rows.


	
Click OK to return to the Create new Data Control dialog.


	
Click OK.




The new data control is listed on the Resources - Data Controls page. However, the data control is hidden by default. You can consume it in pages or task flows only if it is made available to the application. For more information, see Section 26.2.3.2, "Showing or Hiding a Data Control in the Resource Catalog."

You can now add this data control to a page or task flow. For more information, see Section 26.4.1, "Consuming a Data Control in a Task Flow."








26.2.2 Creating a Web Service Data Control

To create a Web Service data control:

	
On the Resources page, under Mashups, select Data Controls, and on the resulting Data Controls page, click Create.


	
In the Create new Data Control dialog, select Web Service in the left pane (Figure 26-4).


Figure 26-4 New Web Service Data Control Wizard

[image: New Web Service Data Control Wizard]

Description of "Figure 26-4 New Web Service Data Control Wizard"





	
At the bottom of the dialog, use the Name and Description fields to specify a name and description for the Web Service data control.


	
In the WSDL URL field, enter the WSDL for the data control. For example:


http://ws.cdyne.com/delayedstockquote/delayedstockquote.asmx?wsdl


	
Use the Proxy Host Name and Proxy Port Number fields to configure proxy authentication.

To ensure a secure connection to the Web Service, you must first configure your application to use proxy authentication.




	
Notes:

	
If a central WebCenter Portal proxy (or RSS proxy) is already configured, then the proxy fields are automatically populated with that proxy host name and port number. You can modify the proxy details or clear the fields if you do not want to configure proxy.

Changing the WebCenter Portal central proxy does not change the proxy setting against the Web Service data control. However, changing the Web Service data control proxy setting changes the WebCenter Portal central proxy setting.

For more information about RSS proxy, see "Setting Up a Proxy Server for the RSS Service" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
If Web Logic Domain proxy is already configured, and if you choose not to set proxy while creating or editing the Web Service data control, then the Web Logic Domain proxy is used as the default setting.













	
If you are connecting to a secured Web Service, enter user name and password to access the Web Service endpoint.

If access to the WSDL itself is secured, then you cannot connect to the Web Service from the Create new Data Control dialog. To workaround this limitation, access the WSDL in a browser by specifying the username and password, download the WSDL page, save it locally as a .wsdl document, then specify the path to this document in the WSDL URL field in the Create new Data Control dialog.


	
Optionally, click Connect to establish the connection to the producer whose WSDL you specified.

If the connection is successful, the Service Details section displays a count of the services and methods that exist in the Web Service.

If you do not click Connect at this stage, the connection is established later, when required.


	
Optionally, click View XML to view the XML content of the WSDL document.


	
Click Next.

The Methods page displays the methods available for the selected service, and the parameters exposed for each method, as shown in Figure 26-5.


Figure 26-5 Web Service Data Control Methods

[image: Web Service Data Control Methods]



A Web Service may expose scalar and complex parameters that control the data displayed in the data control. For more information, see Section 26.1.1.2, "Web Service Data Controls."

You can specify values for any exposed parameters. However, you can specify values only while consuming the data control in a task flow or a page. For more information, see "Editing Parameter Values for Web Service Data Controls".


	
From the Service dropdown list, select a different service, if required.


	
From the Port dropdown list, select one of the available ports.

All methods under that port are added to the data control. These methods are later available for selection in the Resource Catalog.


	
Click Next.


	
If the Web Service is secured using OWSM, use the OWSM Security panel to specify the policies to be used, as described in Table 26-1.


Table 26-1 OWSM Security Information

	Name	Description
	
MTOM

	
The MTOM (message transmission optimization mechanism) policy you want to use.


	
Reliability

	
The reliability policy you want to use.


	
Addressing

	
The addressing policy you want to use.


	
Security

	
Any additional security policies you want to apply.








For example, if your Web Service is secured using a policy named mycompany/wss_username_token_service_policy, populate the Security field with the client policy, which is mycompany/wss_username_token_client_policy.




	
See Also:

Oracle Fusion Middleware Security and Administrator's Guide for Web Services for more information about security policies.








	
You can override properties on the security policy that you specified in the previous step. Use the Add Property and Remove Property buttons to add or remove entries in the Override OWSM Policy Properties section.




	
Note:

Override properties are defined by the policy. Therefore, to perform this step, you must know the policy being used and the properties that you can override.







For example, if you specified a Security policy, mycompany/wss_username_token_client_policy, and the policy has a csf-key property, then in the override section, shown in Figure 26-6, click Add Property to add a value for csf-key. Note that this key must exist in configured keystore.




	
See Also:

"Configuring the Credential Store Provider" in Oracle Fusion Middleware Security and Administrator's Guide for Web Services for information about adding csf-key to the credential store.








Figure 26-6 New Web Service Data Control - OWSM Security
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Click OK.

The new data control is listed on the Resources - Data Controls page. However, the data control is hidden by default. You can consume it in pages or task flows only after it is made available to the application. For more information, see Section 26.2.3.2, "Showing or Hiding a Data Control in the Resource Catalog."




You can now add this data control to a page or task flow. For more information, see Section 26.4.1, "Consuming a Data Control in a Task Flow."






26.2.3 Managing Data Controls

In addition to creating data controls, you can also edit, copy, expose, and delete data controls on the Resources - Data Controls page. This section describes these tasks. It includes the following subsections:

	
Section 26.2.3.2, "Showing or Hiding a Data Control in the Resource Catalog"


	
Section 26.2.3.3, "Copying Data Controls"


	
Section 26.2.3.4, "Editing Data Controls"


	
Section 26.2.3.5, "Editing Data Control Bind Variables"


	
Section 26.2.3.6, "Setting Properties on a Data Control"


	
Section 26.2.3.7, "Setting Security on a Data Control"


	
Section 26.2.3.8, "Deleting Data Controls"






26.2.3.1 What You Should Know About Editing or Deleting a Data Control

The data controls that you create are consumed in pages or task flows. As a result, when you edit or delete a data control, the references to this data control in pages or task flows may be broken. Therefore, use the Edit and Delete options on a data control with caution, after considering the impact on the consuming pages and task flows.

If you added a data control inside a task flow and later deleted the data control, you can repair the task flow by removing references to the data control from the task flow's source files. Perform the following steps to repair a task flow that has broken references to a data control:

	
On the Resource Manager - Task Flows page, select the task flow that you need to repair.


	
From the Edit menu, select Edit Source.


	
Click each of the three tabs, Taskflow Definition, Fragment, and Page Definition, and remove any references to the data control from the source files.




	
Note:

To ensure that you do not end up with an invalid task flow that does not render properly, edit the source code very carefully.








	
Click OK.









26.2.3.2 Showing or Hiding a Data Control in the Resource Catalog

Data controls created from the Resources - Data Controls page must be available in the Resource Catalog so that they can be consumed in your application pages or task flows. By using the Show and Hide options from the Edit menu on the Resources - Data Controls page, you can control whether a selected data control is included in the Resource Catalog. When you mark a data control as shown, it is automatically included in the default Resource Catalog for the application or current space. Further, for a data control created at the application level, you can control whether it is available to any, all, or selected spaces in the application.

For generic information about hiding and showing resources, see Section 10.4.3, "Showing and Hiding Resources."

For generic information about resource availability in spaces, see Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces."






26.2.3.3 Copying Data Controls

You can make a copy of a data control by selecting it and choosing Copy from the Edit menu. The procedure to copy a data control is similar to that for copying any other resource. For the generic procedure, see Section 10.4.1, "Copying a Resource."




	
Note:

Avoid copying an inherited Web Service data control as you may see an internal error when you run or edit the copy.












26.2.3.4 Editing Data Controls

You can modify a data control by selecting it and choosing Edit from the Edit menu. The Edit dialog enables you to modify the values that you provided while creating the data control. For information about the fields, see the detailed steps in Section 26.2.1, "Creating a SQL Data Control" and Section 26.2.2, "Creating a Web Service Data Control."




	
See Also:

Section 26.2.3.1, "What You Should Know About Editing or Deleting a Data Control"












26.2.3.5 Editing Data Control Bind Variables

You can add or rename bind variables in existing SQL data controls by editing the SQL query used for the data control. Modify the SQL query in the Create or Edit Data Control dialog. For the detailed steps, see Section 26.2.1.3, "Creating the Data Control."




	
Note:

You cannot create or edit parameters for Web Services data controls. A Web Services data control only allows you to specify values for the parameters exposed by its methods.







When you consume a data control, you can control the display of data in the visualization by specifying proper values for the data control's bind variables or parameters. For more information, see Section 26.4.6.1, "Editing Parameter Values for a Data Control Visualization."






26.2.3.6 Setting Properties on a Data Control

Each data control has certain properties associated with it that control how it is displayed in the application or space. You can edit these properties through the Edit Properties dialog. For the generic procedure, see Section 10.4.2, "Setting Properties on a Resource."






26.2.3.7 Setting Security on a Data Control

When you create a data control, the default application-level or space-level security settings are applied to it. You can use the Security Settings option on the Edit menu to modify the default settings in the following ways:

	
Change the default permissions granted to users and roles.


	
Revoke all permissions for a user or role.


	
Grant Edit and Manage permissions to additional users and roles.




For the detailed steps, see Section 10.4.4, "Setting Security for a Resource."






26.2.3.8 Deleting Data Controls

You can delete a data control by selecting it and choosing Delete from the Edit menu. For the generic procedure, see Section 10.4.5, "Deleting a Resource."




	
See Also:

Section 26.2.3.1, "What You Should Know About Editing or Deleting a Data Control"














26.2.4 Using Design-Time Data Controls

Oracle WebCenter Portal: Framework exposes a large number of service data controls that can be added to application pages and task flows. Design-time data controls are not available out-of-the-box in the Spaces Resource Catalogs, but they are available in the Resource Registry. You can add these data controls to custom catalogs from the Resource Registry. The data controls can then be added to pages and task flows in your Spaces instance.




	
Note:

The Design-Time DataControls folder lists all the WebCenter Portal service data controls. However, adding the ConnectionsNetworkDC and KudosServiceDC data controls at runtime is not supported. Avoid adding these data controls to your page or task flow.







Design-time data controls can also be added to custom catalogs in JDeveloper. For more information, see "How to Expose Design-Time Data Controls" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.






26.2.5 Exporting and Importing Data Controls Across Spaces

WebCenter Portal: Spaces enables you to export and import runtime data controls as part of a space export and import. When you export a space, the data controls available in the space are also exported . This is the only way to export data controls created at runtime.

For the steps to export and import a space, see Section 53.5, "Importing and Exporting Spaces and Space Templates."




	
Note:

	
Unlike other portal resources, you cannot edit runtime data controls in JDeveloper. The Data Controls page in the Resource Manager does not provide Upload and Download options.


	
While importing or exporting a space that contains a Web Service data control, the Web Service must be up and accessible. If not, an import or export operation throws exceptions.














26.2.5.1 Steps You Must Perform After an Import

You must be careful while exporting and importing data controls. You may get errors if you use application-level data controls in spaces, for example, if you create an application-level data control, consume it in a space, export the space, and import it into another instance, then pages or task flows containing the application-level data control may be broken.

After a successful import, the following files on the target instance list the data controls being used in different pages, page templates, and task flows:

	
oracle/webcenter/webcenterapp/bindings/DataBindings.cpx


	
oracle/webcenter/sitetemplate/view/DataBindings.cpx




To ensure that an imported data control works properly, you must perform the following tasks after importing the space to the target instance:

	
Open pages in the imported space and verify that the data controls display properly. If a data control is available on the page but does not display any data, then you must edit the page and add that data control to the page again. For the steps to add a data control, see Section 26.4.1, "Consuming a Data Control in a Task Flow."

An imported data control may not display data due to the following issues:

	
The target Spaces instance and the imported space use different data bindings CPX files.


	
The CPX file used by the page does not contain a usage entry for that data control.





	
For SQL data controls: In the WLS Administration Console of the target instance, create a JDBC data source connection with the same name as the connection used on the source instance. For the detailed steps, see Section 26.2.1.2, "Creating a Database Connection."

An imported page or task flow that uses a SQL data control will not work in the new space until a JDBC Connection of the same name is created.


	
For Web Services data controls:

	
Edit the data control in the Resource Manager and provide the credentials afresh. Credentials are not exported or imported with the application. For the detailed steps, see Section 26.2.3.4, "Editing Data Controls."

You do not have to specify security policies again as they are imported and exported along with the application.


	
Open the DCConnections.xml file in the imported EAR and modify the proxy host name and port number to point to the target instance. The DCConnections.xml file is available in the /META-INF/mdssys/cust/adfshare/adfshare/ directory.

To ensure a secure connection to the Web Service, you must set up a proxy server on the target instance.
















26.3 Creating and Managing Task Flows

In the previous sections, you learned how to create data controls to retrieve data from different data sources. These data controls can be added to pages or task flows to provide visualizations of the gathered data. Just like pages, task flows are also containers in which you can add components such as portlets, content, and other task flows. However, task flows provide the advantage of component wiring to create mashups of your choice. When you add a data control to a page, you cannot modify or control the data displayed in the data control. If you want a more flexible setup, you can add a data control inside a task flow.

You can control the data displayed in the data control by adding it inside a task flow and wiring data control parameters to task flow parameters or input text components. For example, if you have a SQL data control, with a bind parameter DeptNo, that retrieves data from an employee database, you can add this data control inside a task flow and wire a task flow parameter to the DeptNo parameter. The data control now displays data based on the value specified for the task flow parameter. You can change the task flow parameter value in Oracle WebCenter Portal's Composer to view corresponding data in the data control.

This section describes how to create and manage task flows in the Resource Manager. It includes the following subsections:

	
Section 26.3.1, "Creating a Task Flow"


	
Section 26.3.2, "Managing Task Flows"


	
Section 26.3.3, "Using Task Flows Created at Design Time"


	
Section 26.3.4, "Managing Mashup Styles"






26.3.1 Creating a Task Flow

To create a task flow:

	
On the Resources page, under Mashups, select Task Flows, and on the resulting Task Flows page, click Create.


	
In the Create new Task Flow dialog, in the Name field, enter a name for the task flow.


	
In the Description field, enter a meaningful description of the task flow (Figure 26-7).


Figure 26-7 New Task Flow

[image: Create New Task Flow Dialog]
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Select a style for the task flow. For more information, see Section 26.3.4.1, "Out-of-the-Box Mashup Styles."


	
Click OK.

The new task flow is listed on the Resources - Task Flows page. However, the task flow is hidden by default. You cannot consume it unless it is made available to the application. For more information, see Section 26.3.2.1, "Showing or Hiding a Task Flow in the Resource Catalog."




You can now edit the new task flow and populate it with different resources, including data controls, that are available in the Resource Catalog. For more information, see Section 26.3.2.3, "Editing a Task Flow."






26.3.2 Managing Task Flows

This section includes the following subsections:

	
Section 26.3.2.1, "Showing or Hiding a Task Flow in the Resource Catalog"


	
Section 26.3.2.2, "Copying a Task Flow"


	
Section 26.3.2.3, "Editing a Task Flow"


	
Section 26.3.2.4, "Previewing a Task Flow"


	
Section 26.3.2.5, "Setting Properties on a Task Flow"


	
Section 26.3.2.6, "Setting Security on a Task Flow"


	
Section 26.3.2.7, "Deleting a Task Flow"


	
Section 26.3.2.8, "Using JDeveloper to Modify a Task Flow"






26.3.2.1 Showing or Hiding a Task Flow in the Resource Catalog

Task flows created from the Resources - Task Flows page must be available in the Resource Catalog so that they can be consumed in pages. By using the Show and Hide options from the Edit menu on the Resources - Task Flows page, you can control whether a selected task flow is included in the Resource Catalog. When you mark a task flow as shown, it is automatically included in the default Resource Catalog for the application or space. In the out-of-the-box catalog, the task flow is available in a Task Flows folder that is nested inside the Mash-Ups folder.

For generic information about hiding and showing resources, see Section 10.4.3, "Showing and Hiding Resources."

In addition to showing or hiding a task flow, you can control whether an application-level task flow is available to any, all, or selected spaces in the application. For generic information about resource availability in spaces, see Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces."






26.3.2.2 Copying a Task Flow

You can create a copy of a task flow by selecting it and choosing Copy from the Edit menu on the Resources - Task Flows page. The Copy feature enables you to replicate a local task flow in the runtime environment without having to actually export and upload the task flow.

For the generic procedure, see Section 10.4.1, "Copying a Resource."






26.3.2.3 Editing a Task Flow

You may want to edit a task flow for the following reasons:

	
Design the task flow's view fragment.


	
Create or modify task flow parameters.




The Resource Manager provides the following two options to edit a task flow:

	
Edit the task flow's view fragment in Composer.


	
Edit the source code of the task flow definition file, its view fragment, and the fragment's page definition file in a text editor.







	
Note:

To perform certain advanced editing tasks, you may need to download the task flow to JDeveloper, edit it, and upload it back to your Spaces instance. For more information, see Section 26.3.2.8, "Using JDeveloper to Modify a Task Flow."







This section describes both these editing tasks. It includes the following sections:

	
Section 26.3.2.3.1, "Editing a Task Flow in Composer"


	
Section 26.3.2.3.2, "Editing a Task Flow's Source Files in a Text Editor"






26.3.2.3.1 Editing a Task Flow in Composer

You can modify a task flow by selecting it and choosing Edit from the Edit menu on the Resources - Task Flows page. The task flow's view fragment opens in Composer. You can add a variety of resources to the view fragment from the Resource Catalog.

As this chapter focuses on how to create mashups using data from different data sources, it is useful to know how to populate task flows with data controls and bind task flow parameters to data control parameters. For more information, see Section 26.4.1, "Consuming a Data Control in a Task Flow."

For generic information about adding content to a page or task flow in Composer, see Part IX, "Organizing Your Collaborative and Social Networking Environment".






26.3.2.3.2 Editing a Task Flow's Source Files in a Text Editor

The Resource Manager provides the Edit Source option for editing the source code of the task flow fragment, its page definition, and the task flow definition file. You may want to edit a task flow's source files for the following reasons:

	
Clean up the page fragment and its page definition when you delete a referenced component, such as a data control.

When you delete a data control after it is included in a task flow, the task flow has broken links. The source editor enables you to search and delete references to the data control from the fragment and its page definition file.


	
Make adjustments to the task flow's code without having to download it, edit it in JDeveloper, and upload it back into Spaces.




To edit a task flow's source files:




	
Note:

Edit a task flow's source files only when absolutely necessary. To ensure that you do not end up with an invalid task flow that does not render properly, edit the source code very carefully.







	
Select the task flow, from the Edit menu in the Resource Manager, select Edit Source.

A simple Edit Source dialog (Figure 26-8) displays with three tabs, Taskflow Definition (task flow definition XML file), Fragment (page fragment JSFF file), and Page Definition (fragment's page definition XML file).


Figure 26-8 Edit Source Dialog for a Task Flow

[image: Edit Source dialog for a task flow]



	
Click a tab to edit the source code for that file.

The format of the code is validated and an error message is displayed if you miss any tags or add them incorrectly.


	
Click OK.











26.3.2.4 Previewing a Task Flow

Use the Preview option to see how the task flow appears when it is consumed in a page or another task flow. In preview mode, the task flow displays Edit and Close buttons. Click Close to exit preview mode. Click Edit if you want to modify the task flow in Composer. For more information, see Section 26.3.2.3, "Editing a Task Flow."






26.3.2.5 Setting Properties on a Task Flow

Each task flow has certain properties associated with it that control how it is displayed in the application or space. You can edit these properties through the Edit Properties dialog. For the generic procedure, see Section 10.4.2, "Setting Properties on a Resource."






26.3.2.6 Setting Security on a Task Flow

When you create a task flow, the default application-level or space-level security settings are applied to it. You can use the Security Settings option on the Edit menu to modify the default settings in the following ways:

	
Change the default permissions granted to users and roles.


	
Revoke all permissions for a user or role.


	
Grant Edit and Manage permissions to additional users and roles.




For the detailed steps, see Section 10.4.4, "Setting Security for a Resource."






26.3.2.7 Deleting a Task Flow

You can delete a task flow by selecting it and choosing Delete from the Edit menu on the Resources - Task Flows page. For the generic procedure, see Section 10.4.5, "Deleting a Resource."






26.3.2.8 Using JDeveloper to Modify a Task Flow

You may prefer to edit a runtime task flow in JDeveloper. To do this, you have several options:

	
Use the Edit Source option to view the source code of the task flow's source files. You can copy the contents of the dialog to JDeveloper for editing and then copy the edited code back into the dialog. For more information, see Section 26.3.4.4, "Editing a Mashup Style."


	
Download an existing Spaces task flow, import it into JDeveloper, edit it, and then upload it back to Spaces.







	
Note:

As a task flow typically involves multiple files, trying to create a task flow in JDeveloper, expose it as a portal resource, and export all files and metadata correctly can cause errors. The deployed task flow may be broken and not work poperly. Therefore, it is recommended that you use JDeveloper to only modify runtime task flows. Do not export design-time task flows as portal resources.
For information about using design-time task flows in Spaces, see Section 26.3.3, "Using Task Flows Created at Design Time."









The generic steps to upload and download a resource from Spaces are described in Section 10.5.2, "Downloading a Resource"and Section 10.5.3, "Uploading a Resource."

For information about how a task flow is imported, edited, and exported in JDeveloper, see the section "Working with Mashup Styles" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.




	
Note:

Task flows and mashup styles are similar resources and can be edited the same way in JDeveloper.







You must note that task flows created at runtime may contain components that are bound to data controls. When you download such a task flow, the referenced data controls are not downloaded. When you open such a task flow in JDeveloper, you will not see a fully running task flow because the associated data controls are not available in JDeveloper. The task flow will work properly only when you take it back to the Spaces instance.








26.3.3 Using Task Flows Created at Design Time

If you created a custom task flow in Oracle JDeveloper and want to consume it in Spaces, you must ensure that the task flow is available in the Resource Catalog. Users can then consume the task flow in their pages and task flows. To expose a custom task flow created in JDeveloper, you must deploy the application containing the task flow as a shared library to the Spaces instance. The task flow is then included automatically in the Resource Registry. You can add the task flow to custom catalogs from the Resource Registry.

Oracle WebCenter Portal: Framework provides a workspace specifically for deploying and undeploying Spaces Shared Library Extensions. You must use that workspace to deploy task flows to Spaces. For more information, see "Deploying Your Own Custom Code and Task Flows in Shared Libraries" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

Design-time data controls can also be added to custom catalogs in JDeveloper. For more information, see "How to Manage Content in the Resource Catalog" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.






26.3.4 Managing Mashup Styles

Mashup styles are templates used to create new task flows in your application. They are useful if you want to reuse a custom visualization in different task flows in your application. The Create Task Flow dialog, which is invoked from the Resources - Mashup Styles page, displays all available mashup styles. The Resource Manager (Resources page) provides options to manage mashup styles that are displayed in the Create Task Flow dialog. You can offer a wider selection of mashup styles to users or restrict mashup styles so that users build only the types of task flows that you intend.

You can manage mashup styles in the following ways:

	
Copy an out-of-the-box mashup style and modify its properties.


	
Upload a mashup style created in Oracle JDeveloper.


	
Download a custom mashup style, edit it in Oracle JDeveloper, and upload it back to the runtime application.


	
Show or hide a mashup style in the Create Task Flow dialog.


	
Edit a custom mashup style or its properties.


	
Change security settings on a custom mashup style.


	
Delete a custom mashup style.







	
Note:

The default, out-of-the-box mashup styles cannot be edited or deleted. You can only copy these styles or hide them in the Create Task Flow dialog.







See Section C.6, "Building and Using a Custom Mashup Style with Predefined Columns" for an example of how to create a custom mashup style.

This section provides information about the out-of-the-box mashup styles included in Spaces and explains how to manage mashup styles in the Resource Manager. It includes the following sections:

	
Section 26.3.4.1, "Out-of-the-Box Mashup Styles"


	
Section 26.3.4.2, "Copying a Mashup Style"


	
Section 26.3.4.3, "Showing or Hiding a Mashup Style in the Create Task Flow Dialog"


	
Section 26.3.4.4, "Editing a Mashup Style"


	
Section 26.3.4.5, "Previewing a Mashup Style"


	
Section 26.3.4.6, "Setting Properties on a Mashup Style"


	
Section 26.3.4.7, "Setting Security on a Mashup Style"


	
Section 26.3.4.8, "Deleting a Mashup Style"


	
Section 26.3.4.9, "Using JDeveloper to Build Your Mashup Style"






26.3.4.1 Out-of-the-Box Mashup Styles

Table 26-2 describes the mashup styles available out of the box.


Table 26-2 Mashup Styles

	Name	Description
	
Blank

	
A one-column task flow with one layout box into which you can add content, including additional layout components.

Switching this task flow style is allowed.


	
Stretch

	
Maximizes the task flow to take up all available space.

For an example of a page based on the Stretch style, see the Documents page or the Announcements page in your Spaces application.

Task flows based on this style cannot be switched.


	
Parameter Form

	
Provides an input text field where a user can specify a value. Out-of-the-box, the input text is wired to pageFlowScope.bindVarId. When you use this style, you can add other components to the task flow and use the input text's pageFlowScope variable as an input parameter for another component, for example, a data control.

For example, you can use this mashup style to create a task flow with a search field and a search results table. If the results table displays data from a data control, you can wire the search field parameter to the data control parameter, so that the table displays data specific to the criteria you specify in the search field.












26.3.4.2 Copying a Mashup Style

You can make a copy of an existing mashup style by selecting it and choosing Copy from the Edit menu on the Resources - Mashup Styles page. Copying a mashup style enables you to replicate a local style in the runtime environment without having to actually export and upload the mashup style. As there is no option to create a mashup style from scratch, you can create a copy of a default style and replace its code with that of a custom visualization that you want to create.

For the generic procedure, see Section 10.4.1, "Copying a Resource."

You can create a custom visualization with the required UI components and use a dummy EL value, #{dataPresenter.dummyData.collectionModel}, as a placeholder for the real data. When you create a new task flow using this style, you can replace the dummy EL value with the real binding. For an example showing how to create a custom mashup style, see Section C.6, "Building and Using a Custom Mashup Style with Predefined Columns."






26.3.4.3 Showing or Hiding a Mashup Style in the Create Task Flow Dialog

The Create Task Flow dialog displays all the mashup styles available for building task flows. You can control whether a mashup style is displayed in the Create Task Flow dialog by marking it as shown or hidden. For generic information about hiding and showing resources, see Section 10.4.3, "Showing and Hiding Resources."

Further, for a mashup style created at the application level, you can control whether it is available to any, all, or selected spaces in the application. For generic information about availability in spaces, see Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces."






26.3.4.4 Editing a Mashup Style

Use the Edit Source option in the Resource Manager to edit the source code of the mashup style's task flow definition file, view fragment, and the fragment's page definition file. You may want to edit a custom mashup style to alter its layout. You can create a create a custom visualization with the required UI components and use a dummy EL value, #{dataPresenter.dummyData.collectionModel}, as a placeholder for the real data. When you create a new task flow using this style, you can replace the dummy EL value with the real binding. For an example showing how to create a custom mashup style, see Section C.6, "Building and Using a Custom Mashup Style with Predefined Columns."

To edit a mashup style's source files:




	
Note:

Edit a mashup style's source files only when absolutely necessary. To ensure that you do not end up with an invalid style that does not render properly, edit the source code very carefully.







	
Select the mashup style, from the Edit menu in the Resource Manager, select Edit Source.

A simple Edit Source dialog displays with three tabs, Taskflow Definition, Fragment, and Page Definition, as shown in Figure 26-9.


Figure 26-9 Edit Source Dialog

[image: Edit Source dialog]



	
Click a tab and edit the source code for that file.

The format of the code is validated and an error message is displayed if you miss any tags or add them incorrectly.


	
Click OK.




To perform certain advanced editing tasks, you may need to download the style, edit it in JDeveloper, and upload it back to your Spaces instance. For more information, see Section 26.3.4.9, "Using JDeveloper to Build Your Mashup Style."






26.3.4.5 Previewing a Mashup Style

Use the Preview option to see how the style appears when it is applied to a task flow. In preview mode, the mashup style displays Edit and Close buttons. Click Close to exit preview mode. Click Edit if you want to modify the style in Composer. For more information, see Section 26.3.4.4, "Editing a Mashup Style."






26.3.4.6 Setting Properties on a Mashup Style

Default, out-of-the-box mashup styles do not have associated runtime properties. However, each custom mashup style has certain properties associated with it. You can edit these properties through the Edit Properties dialog. For the generic procedure, see Section 10.4.2, "Setting Properties on a Resource."






26.3.4.7 Setting Security on a Mashup Style

When you copy or upload a mashup style, the default application-level or space-level security settings are applied to it. You can use the Security Settings option on the Edit menu to modify the default settings in the following ways:

	
Change the default permissions granted to users and roles.


	
Revoke all permissions for a user or role.


	
Grant Edit and Manage permissions to additional users and roles.




For the generic procedure, see Section 10.4.4, "Setting Security for a Resource."






26.3.4.8 Deleting a Mashup Style

You can delete a custom mashup style by selecting it and choosing Delete from the Edit menu on the Resources - Mashup Styles page. For the generic procedure, see Section 10.4.5, "Deleting a Resource."






26.3.4.9 Using JDeveloper to Build Your Mashup Style

You may want to create a mashup style that is beyond the editing capabilites of WebCenter Portal: Spaces, or you may prefer working in JDeveloper. To do this, you have several options:

	
Use the Edit Source option to edit the source code of the mashup style's source files. You can edit the source code directly in the Edit Source dialog or you can copy the contents of the dialog to JDeveloper for editing and then copy the edited code back into the dialog. For more information, see Section 26.3.4.4, "Editing a Mashup Style."


	
Download an existing Spaces mashup style, import it into JDeveloper, for editing, and then upload it back to Spaces.


	
Create a completely new mashup style in JDeveloper and upload it to Spaces.




The generic steps to upload and download a resource from Spaces are described in Section 10.5.2, "Downloading a Resource"and Section 10.5.3, "Uploading a Resource."

Oracle provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) for developing Spaces resources, including mashup styles. The workspace offers a design environment in which to create and edit your mashup style, and also enables you to upload them to Spaces for testing. For more information and to download the JDeveloper workspace, see "Developing Spaces Resources" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

For information about how a mashup style is imported, edited, and exported in JDeveloper, see the section "Working with Mashup Styles" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal. You may need to look at the special considerations for mashup styles in JDeveloper.










26.4 Creating Data Visualizations

You have seen how to create data controls and task flows. Data controls created from the Resources - Data Controls page are available automatically in the Resource Catalog and can therefore be added to task flows and pages. You can consume data controls in task flows or pages and render them in different ways, such as tables, graphs, and forms, to create useful mashups. If you consume them in task flows, you can define parameters on the data control and bind those parameters to task flow parameters so that users can specify a value for a task flow parameter and display data based on that value.

This section describes how to consume data controls and bind data control parameters to task flow parameters. It includes the following subsections:

	
Section 26.4.1, "Consuming a Data Control in a Task Flow"


	
Section 26.4.2, "Creating Task Flow Parameters"


	
Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters"


	
Section 26.4.4, "Wiring a Data Control to a Parameter Form Task Flow"


	
Section 26.4.5, "Consuming Task Flows that Contain Visualizations"


	
Section 26.4.6, "Editing Visualizations"


	
Section 26.4.7, "Writing to a Data Source from a Visualization"






26.4.1 Consuming a Data Control in a Task Flow

When you add a data control, its accessors, or its methods to a task flow, you can select different UI options for rendering the data. Depending on the object you select and the visualizations it supports, different options are listed on the Add menu. For more information, see Section 26.1.2, "Supported Visualizations."

If you populate a task flow with different elements from a data control that uses bind parameters, then all the objects display data for the same parameter values. You cannot specify different parameter values for elements coming from the same data control.

This section describes the different ways in which you can add a data control inside a task flow. It includes the following subsections:

	
Section 26.4.1.1, "Adding a Data Control as a Table"


	
Section 26.4.1.2, "Adding a Data Control as a Form"


	
Section 26.4.1.3, "Adding a Data Control as a Graph"






26.4.1.1 Adding a Data Control as a Table

The Table option is displayed only for data control accessors that return a collection of objects that can be displayed in columns of a table. You can add a data control as a read-only table that displays data using Output Text components by default, or as an editable table that displays data using Input Text components by default. You can also display data using Output Formatted components and hyperlinks.

This section describes the steps to add a sample SQL data control as a read-only table and editable table. It includes the following subsections:

	
Section 26.4.1.1.1, "Adding a Data Control as a Read-Only Table"


	
Section 26.4.1.1.2, "Adding a Data Control as an Editable Table"


	
Section 26.4.1.1.3, "Adding a Web Services Data Control Accessor with Complex Parameters"






26.4.1.1.1 Adding a Data Control as a Read-Only Table

A read-only table displays the data retrieved from a data control in Output Text components. The content in the table cannot be edited.

To add a SQL data control as a read-only table:

	
Select the task flow in which you want to add the data control, then from the Edit menu, select Edit to open the task flow in Composer.


	
Click Add Content in the container in which you want to add the data control.


	
In the Add Content dialog, navigate to the section of the Resource Catalog that contains runtime data controls.




	
Tip:

The location of data controls depends on the Resource Catalog used for editing pages. For example, in the default Resource Catalog, runtime data controls are present in the Data Controls subfolder, which is nested inside the Web Development folder or Mash Ups folder.








	
Click the Open link next to a data control, for example PageHits, to display its content.


	
Click the Add link next to the PageHits accessor. From the dropdown menu, select Table, as shown in Figure 26-10.


Figure 26-10 Add Content Dialog - Table Option

[image: Add Content Dialog - Table Option]

Description of "Figure 26-10 Add Content Dialog - Table Option"





	
In the Create Table - Type page, shown in Figure 26-11, select Read-only Table.


Figure 26-11 Create Table - Type

[image: Create Table - Type]



	
Optionally, in the Behavior section, select the Row Selection, Filtering, and Sorting options to enable customization of the table.

Select Row Selection to enable selection of a row on which you can perform any operation.




	
Note:

Using Values from Row Selection

When you enable row selection in a table and select a row, internally, the column values of the selected row are added into a row selection bean. The column values are stored in the following EL format:


#{dataComposerViewContext.dataSelection.COLUMN_NAME}


You can use this format to reference the table columns from elsewhere in the task flow. Typically, this is useful in mashups where data visualizations are wired in a master-detail relationship.

However, row selection is not supported if the data control contains bind parameters.









Select Filtering to display a text field above each column in the table. You can specify a filter criteria in these text fields to display only rows that match the criteria.

Select Sorting to enable sorting of columns. When you select this option, the column headers display Up and Down arrows, which you can use to sort columns in an ascending or descending order.


	
Click Next.


	
In the Create Table - Items page, select the accessor attributes that you wish to display in the table and move them from the Available Items list to the Selected Items list (Figure 26-12).

The table displays columns for attributes in the same order as they are in this dialog. You can use the Up and Down arrows to the right of the Selected Items box to resequence attributes and thereby, the table columns.


Figure 26-12 Create Table - Items

[image: Create Table - Items]

Description of "Figure 26-12 Create Table - Items"





	
Click Next.


	
In the Create Table - Columns page (Figure 26-14), specify values for the table's display attributes, as follows:

	
Column Header: Specify a name to be used as a header for the selected column.


	
Display As: Select an output format for the column. Choose from:

	
Output Text

Use to display data records as styled read-only text.


	
Output Formatted

Use to display data records as read-only text with limited formatting.


	
Hyperlink

Use to display data in the selected column as a link, for example, when connecting to an employee database, you can display employee names as hyperlinks. When a user clicks a link, it takes them to the employee's profile page. Another example would be where you add a Spaces Web Service data control as a table that list the spaces; you can use the URL option to display space names as hyperlinks so that clicking a space name opens the space.





	
Align: Select whether the data in the table cells must be aligned to the center, end, left, right, or start.


	
URL: Use this field to create dynamic URLs based on the values coming from the data control. Specify the URL along with the EL value that must be appended to the URL. The URL field is enabled only if you selected Hyperlink as the column format.

For example, if you are adding a Spaces Web Service data control as a table that list the spaces of which the current user is a member, you can use the URL option, as shown in Figure 26-13, to display space names as hyperlinks. Clicking a space name in the table opens the space in a separate window.


Figure 26-13 Create Table - Columns

[image: URL option on the Create Table - Columns page]



	
Open in New Window: Select to open the URL in a separate window. This field is enabled only when you select Hyperlink as the column format.







	
Note:

The Display As field lists both Input Text and Output Text options if you selected the table type as Table.








Figure 26-14 Create Table - Columns

[image: Create Table - Columns]

Description of "Figure 26-14 Create Table - Columns"





	
Click Next.


	
In the Create Table - DC Parameters page, shown in Figure 26-15, change the default values for the exposed data control parameters, then click Create.


Figure 26-15 Create Table - DC Parameters

[image: DC Parameters page in the Create Table dialog]



The DC Parameters page is enabled only if the accessor being added has associated parameters. You can use this page to bind data control parameters to task flow parameters. For more information, see Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."

If you skip this step, the parameter values that you specified while creating the data control are used.


	
A table is created in the task flow based on the options you selected, as shown in Figure 26-16.


Figure 26-16 Data Control Added as a Read-Only Table

[image: Data Control Added as a Read-Only Table]





You can format the table by sorting data, reordering columns, and so on. For more information, see Section 26.4.6.2, "Customizing a Table."

Now that you have added the data control as a table inside a task flow, you can bind the task flow's parameters to the data control's parameters. By doing this, when you consume the task flow in a page, users can specify a value for the task flow parameter to view corresponding data in the table. For more information, see Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."






26.4.1.1.2 Adding a Data Control as an Editable Table

If the data source supports updating of records, you can add a data control accessor or operation return as an editable table. When you create an editable table, you can edit information in the table and commit those changes to the data source. In an editable table, most attributes are represented using ADF Input Text components whose values can be edited. To save your changes back to the data control, you can create command buttons using operations that can modify data records, and place those buttons in a toolbar in the table. For example, you can use the Delete operation to create a button that allows a user to delete a record from the current range. Or you can use the built-in Submit button to submit changes.

If you add an editable table and the underlying data control does not support updating, the table displays as a read-only table.




	
Note:

Data controls created at runtime do not support editing of data. Currently, only design time BC4J-based SQL data controls support editing of data through tables.







The procedure to add a data control as an editable table is similar that of adding a read-only table. This section lists the additional tasks required to add an editable table and include Create, Update, and Delete options on the table.

To add a data control accessor as an editable table:

	
Perform the steps in Section 26.4.1.1.1, "Adding a Data Control as a Read-Only Table," but with the following exceptions:

	
On the Create Table - Type page, select Table.


	
On the Create Table - Columns page, for each column that you want to make editable, set the Display As field to Input Text w/Label.




	
Note:

If the data control does not support updating of data, the columns display read-only fields.











	
A table is created in the task flow based on the options you selected, as shown in Figure 26-17.


Figure 26-17 Data Control as an Editable Table

[image: Data Control as an Editable Table]
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When you add a Web Service data control as an editable table, you can edit records in the table and write the changes back to the Web Service data source. However, you can update data only if the Web Service exposes a method to do so. For more information, see Section 26.4.7, "Writing to a Data Source from a Visualization."

For information about formatting a table and customizing it further, see Section 26.4.6.2, "Customizing a Table."

The next step is to create task flow parameters and bind the task flow's parameters to the data control's parameters. When you consume such a task flow in a page, users can specify a value for the task flow parameter to view corresponding data in the table. For more information, see Section 26.4.2, "Creating Task Flow Parameters" and Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."






26.4.1.1.3 Adding a Web Services Data Control Accessor with Complex Parameters

As explained in Section 26.1.1.2, "Web Service Data Controls," Web Services data control accessors may expose scalar or complex parameters. When you add a Web Services data control accessor as a table, you can specify values for data control parameters in the DC Parameters page of the wizard. You must specify values for scalar and complex parameters as follows:

	
Simple EL or static values for scalar parameters.


	
XML values for complex parameters. A complex parameter can expose a set of scalars using an EL value.




The steps to specify values for simple parameters is the same for all types of data controls and are explained in the previous section. However, if a Web Services data control accessor exposes complex parameters, the DC Parameters page of the table creation wizard displays an extra context menu option, Parameter Structure. The Parameter Structure option invokes a Parameters dialog, which lets you expand the complex parameter, as shown in Figure 26-18, and specify values for the complex parameter itself or its included simple parameters.


Figure 26-18 Parameters Dialog Displaying a Complex Parameter

[image: Complex parameter displayed in the Parameters dialog]



Section C.5, "Creating a Mashup with Data from a Siebel Data Source" provides an example of using the Parameters dialog to specify values for complex parameters.








26.4.1.2 Adding a Data Control as a Form

The Form option is displayed only for data control accessors that return a collection of objects that can be displayed as a form element. You can add a data control accessor as a read-only form that displays data using Output Text components, or as an editable form that typically displays data using Input Text components. You can also display data using Output Formatted components and URLs.

To add a Web Service data control as a form:

	
In the Resource Manager, select the task flow in which you want to add the data control, then from the Edit menu, select Edit to open the task flow in Composer.


	
Click Add Content in the container in which you want to add the task flow.


	
In the Add Content dialog, navigate to the section of the Resource Catalog that contains runtime data controls.




	
Tip:

The location of data controls depends on the Resource Catalog used for editing pages. For example, in the default Resource Catalog, runtime data controls are present in the Data Controls subfolder, which is nested inside the Web Development folder and Mash Ups folder.








	
Click the Open link next to a data control name, for example DelayedStockQuoteDC, to display its contents.


	
Click the Add link next to the DelayedStockQuoteDC accessor. From the dropdown menu, select Form to display the Create Form dialog.


	
Click the Add link next to the operation, and select Form to display the Create Form dialog.


	
In the Create Form - Type page, select the desired type of form, for example, Form, as shown in Figure 26-19.


Figure 26-19 Create Form - Type

[image: Create Form - Type page]



	
Select Include Submit Button to display a Submit button on the form. This option is enabled only if you are creating an editable form, because you must display a submit button if users are allowed to specify values or edit form data.


	
Select Include Navigation Controls to display First, Previous, Next, and Last buttons on the form. Navigation controls are helpful when multiple records are retrieved from the data source.




	
Note:

Navigation controls may not work properly if the data control provides bind parameters.








	
In the Create Form - Items page, from the Available Items box, select the items you wish to display in your form, then click Next.


	
In the Create Form - Fields page, define a label and form component (Figure 26-20) for each column, then click Next.


Figure 26-20 Create Form - Fields

[image: Create Form Dialog - Fields Page]
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In the Create Form - DC Parameters page, specify the parameter value to display data for that value, then click Create.




	
Note:

Ensure that you specify the parameter value at this stage as you cannot specify it later.
Unlike a table or a graph, after you create a form, if you edit it in Composer, the Component Properties dialog does not display the Data panel. Therefore, you cannot modify parameter values for a form once it is created.









The new form looks like the one in Figure 26-21.


Figure 26-21 New Form in the Task Flow

[image: New Form Displayed in the Task Flow]
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When you add a Web Service data control as an editable form, you can edit data in the form and write the changes back to the Web Service data source by clicking the Submit button. However, you can update data only if the Web Service supports it by providing methods for creating, updating, and deleting records. For more information, see Section 26.4.7, "Writing to a Data Source from a Visualization."

The next step is to create task flow parameters and bind the task flow's parameters to the data control's parameters. When you consume such a task flow in a page, users can specify a value for the task flow parameter to view corresponding data in the form. For more information, see Section 26.4.2, "Creating Task Flow Parameters" and Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."






26.4.1.3 Adding a Data Control as a Graph

To display data as a Graph:

	
Edit the task flow in Composer.


	
Click Add Content to display the Add Content dialog.


	
In the Add Content dialog, navigate to the section of the Resource Catalog that contains runtime data controls.




	
Tip:

The location of data controls depends on the Resource Catalog used for editing pages. For example, in the default Resource Catalog, runtime data controls are present in the Data Controls subfolder, which is nested inside the Web Development folder and Mash Ups folder.








	
Click the Open link next to the data control to display its accessor, operations, and methods associated with it.


	
Click the Add link next to the data control accessor or operation return. From the dropdown menu, select Graph (Figure 26-10), to display the Create Graph dialog.


	
In the Create Graph - Type page, select the desired type of form, for example, Bar, as shown in Figure 26-22, then click Next.


Figure 26-22 Create Graph - Type

[image: Create Graph - Type page]



	
In the Create Graph - Sub-Type page, select a subtype, for example Bar, as shown in Figure 26-23, then click Next.


Figure 26-23 Create Graph - Sub-Type

[image: Create Graph - Sub-Type page]



	
In the Create Graph - Layout page, select a suitable layout, then click Next.


	
In the Create Graph - Items page, from the Available Items box, select the items you wish to display in your graph, then click Next.


	
In the Create Graph - Placement page, select the appropriate placement, as shown in Figure 26-24, then click Next.


Figure 26-24 Create Graph - Placement

[image: Create Graph - Placement page]



	
In the Create Graph - Format page, define titles and labels for each graph item, then click Next.


	
In the Create Graph - DC Parameters page, specify the parameter value to display data for that value, then click Create. The new graph looks like Figure 26-25.


Figure 26-25 New Graph in the Task Flow

[image: New Graph Displayed in the Task Flow]

Description of "Figure 26-25 New Graph in the Task Flow"







For information about formatting a graph and customizing it further, see Section 26.4.6.3, "Customizing a Graph."

The next step is to create task flow parameters and bind the task flow's parameters to the data control's parameters. When you consume such a task flow in a page, users can specify a value for the task flow parameter to view corresponding data in the graph. For more information, see Section 26.4.2, "Creating Task Flow Parameters" and Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."








26.4.2 Creating Task Flow Parameters

Task flow parameters enable you to view specific content in the task flow by providing different values for the parameter. When you add a data control inside a task flow, you can wire the task flow parameter to the data control parameter so that the data control displays data based on the task flow parameter you specify. For example, if your task flow contains a data control displaying the top five page hits in a given space, and the data control provides a spacename bind variable, you can create a corresponding spacename parameter on the task flow. When a user edits the task flow and specifies a space name, the data control displays the top five page hits in that space.

To create task flow parameters:

	
Select the task flow on the Resources - Task Flows page and choose Edit from the Edit menu.

The task flow opens in Composer.


	
Click the Task Flow Properties button.


	
In the Taskflow Properties dialog, click Create to display the parameter table, shown in Figure 26-26.


Figure 26-26 Taskflow Properties Dialog

[image: Taskflow Properties dialog with Name, Type, Storage columns]



	
Enter a name, type, and storage value for the new parameter.

The storage value identifies the scope for the parameter. It specifies the location for storing the parameter value. Out-of-the-box, you are provided with four storage options, as described in Table 26-3. However, you can specify any custom storage by providing the EL value.


Table 26-3 Storage Values

	Name	Description
	
pageFlowScope

	
The value is available to all instances of the task flow on the page.


	
viewScope

	
The value is available only to the selected instance, for the current user.


	
applicationScope

	
The value is available to all instances of the task flow within the application or across applications.


	
sessionScope

	
The value is available only to the current user, for the current session.








	
Click OK.









26.4.3 Binding Data Control Parameters to Task Flow Parameters

Data control parameters are used to restrict the data displayed in the data control based on the criteria you specify; for example, if you have a data control that displays page hits in your Spaces application, you can create a spacename bind variable to limit the data retrieved to a given space only. What's more, you can add the data control inside a task flow and bind the data control parameter to a task flow parameter, which can be used to control the data displayed in the data control. As page and task flow designers can edit task flow parameters, you are allowing them to control what is displayed in the data control.




	
Note:

If you do not want to use task flow parameters or if a data control is added directly on a page, you can wire the data control's parameters to input text components on the page. This type of wiring is similar for pages and task flows. For more information, see Section 26.4.4, "Wiring a Data Control to a Parameter Form Task Flow."







This section describes, with an example, how to bind a task flow parameter to a data control parameter. Before performing the steps in this section, ensure that you have added the data control inside a task flow and created the required task flow parameters. For more information, see Section 26.4.1, "Consuming a Data Control in a Task Flow" and Section 26.4.2, "Creating Task Flow Parameters."

To bind a task flow parameter to a data control parameter, spacename:

	
Click the Task Flow Properties button on the Composer toolbar to open the Task Flow Properties dialog.


	
Select the parameter that you want to bind to a data control parameter, copy its storage value, then close the dialog.


	
Click the Edit icon on the table or graph to open the Component Properties dialog.


	
On the Data tab, shown in Figure 26-27, select a data control parameter and paste the storage value in the field next to the parameter name, for example, #{pageFlowScope.spacename}.


Figure 26-27 Data Panel in the Component Properties Dialog for a Table

[image: Data Panel in the Component Properties Dialog for a Table]



The data control now displays data specific to the task flow parameter value.

For a SQL data control, if there is no initial value defined for the task flow parameter, the data control retrieves data specific to the initial value of the bind parameter.

However, if you are using a Web Service data control for which you have not defined a parameter value, you must set an initial value for the task flow parameter. If not, the task flow displays an empty visualization (table, form, or graph). Therefore, in the Data tab for a Web Service data control, you must pass an initial value for the task flow parameter as shown in the following example:


#{empty pageFlowScope.stock_Quote ? 'ORCL' : pageFlowScope.stock_Quote}





	
See Also:

Section 26.2.2, "Creating a Web Service Data Control"








	
Click OK.


	
Click Close to exit Composer.




When you consume this task flow on a page, the data control displays data specific to the task flow parameter value. For more information, see Section 26.4.5, "Consuming Task Flows that Contain Visualizations."

To get a better idea about building mashups, see the different examples in Appendix C, "Business Mashup Examples."






26.4.4 Wiring a Data Control to a Parameter Form Task Flow

If you added a data control as a table inside a task flow, and if the task flow is based on the Parameter Form mashup style, then you can wire the input text field in the parameter form task flow to a data control parameter so that the table displays records based on the value provided in the input text field.

To wire the input text field to a data control parameter:

	
Edit the Parameter Form task flow in Composer.


	
Switch to Source view of the task flow.


	
Select Input Text in the component structure and click Edit on the toolbar.


	
Optionally, specify a suitable label for the field, for example, use Department if your task flow contains an employee details table and the data control has a bind parameter for the department ID.


	
From the Value field, copy the value, #{pageFlowScope.bindVarId} (Figure 26-28), and switch back to Design view.


Figure 26-28 Parameter Form Input Text Field Value

[image: Parameter form input text field value]



	
Click the Edit icon on the table.


	
In the Component Properties dialog for the table, click the Data tab.


	
Select the parameter that you want to bind to the Parameter Form's Input Text component and paste the #{pageFlowScope.bindVarId} value for that parameter, as shown in Figure 26-29.


Figure 26-29 Data Control Bind Variable

[image: Data control bind variable in Data panel]



	
Click OK.




The wiring is effective immediately. You can specify a value in the input text field to view the corresponding records in the table, as shown in Figure 26-30.


Figure 26-30 Data Control in a Parameter Form Task Flow

[image: Data Control in a Parameter Form Task Flow]

Description of "Figure 26-30 Data Control in a Parameter Form Task Flow"





You can find another example for this in Section C.2, "Creating a Mashup that Displays Employee Data from SQL Data Control."






26.4.5 Consuming Task Flows that Contain Visualizations

To add the task flow to a page where the visualization is displayed to users:

	
Edit the business role page in which you want to add the task flow.


	
In Composer, click Add Content in the container in which you want to add the mashup.


	
In the Add Content dialog, navigate to the section of the Resource Catalog that contains task flows created at runtime.




	
Tip:

The location of task flows depends on the Resource Catalog used for editing pages. For example, in the default Resource Catalog, task flows are present in the Mashups folder.








	
Select a task flow and click Add.


	
Click Close.

The page displays the mashup with the visualization. If the data control parameters are bound to the task flow parameters, the task flow parameters drive the data that is displayed.




	
See Also:

Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters"








	
To view data for different parameter values:

	
Select the mashup on the page and click Edit to view its properties.


	
On the Parameters tab in the task flow properties dialog, change the values for any exposed parameters, then click OK.












26.4.6 Editing Visualizations

The Resource Manager provides different options to modify data control parameter values. In addition, you can modify the visualizations that are created by adding data controls to task flows as tables, graphs, forms, or command buttons and links. This section describes the different editing tasks that you can perform on data visualizations. It includes the following subsections:

	
Section 26.4.6.1, "Editing Parameter Values for a Data Control Visualization"


	
Section 26.4.6.2, "Customizing a Table"


	
Section 26.4.6.3, "Customizing a Graph"






26.4.6.1 Editing Parameter Values for a Data Control Visualization

If a data control provides bind variables or parameters, and you consume the data control in a page or task flow, you can use the parameter values to control the display of data in the visualization.

You can change values for a data control's parameters after the data control is consumed in a page or task flow. However, for a SQL data control, you can also change the values in the Edit Data Control wizard. This section describes how to edit parameter values for SQL and Web Services data controls.


Editing Parameter Values for SQL Data Controls

You can edit SQL data control parameters in either of the following ways:

	
Edit the data control directly by selecting it on the Resource Manager - Data Controls page.


	
Edit the data control in the consuming task flow, from the Resource Manager - Task Flows page.





To edit parameters directly on the data control:

	
On the Resource Manager - Data Controls page, select the data control whose parameters you want to modify.


	
From the Edit menu, select Edit.


	
In the Edit dialog, click Enter bind parameter values.


	
In the resulting Enter bind parameter values dialog, modify values for any of the listed parameters.


	
Click OK.


	
Click OK to exit the Edit dialog.

The table, form, or graph now displays data specific to the parameter values you provided.





To edit data control parameters through the consuming task flow:

	
On the Resource Manager - Task Flows page, select the task flow containing the data control you want to edit.


	
From the Edit menu, select Edit.


	
In Composer, click the Edit icon on the header of the visualization (table or graph).


	
In the Component Properties dialog displayed for the task flow, click the Data tab.


	
Modify values for any of the listed data control parameters.


	
Click OK.


	
Click Save, then Close to exit Composer.

The table or graph now displays data specific to the parameter values you provided.





Editing Parameter Values for Web Service Data Controls

Unlike SQL data controls that allow you to expose any number of bind parameters, for Web Service data controls, you can only specify values for the parameters already exposed by the Web Service method. The Edit dialog for a Web Service data control does not provide options to specify or modify parameter values. You can specify parameter values only after adding the data control inside a page or task flow.

To specify parameter values for a Web Service data control:

	
On the Resource Manager - Task Flows page, select the task flow containing the data control you want to edit.


	
From the Edit menu, select Edit.


	
In Composer, click the Edit icon on the header of the visualization (table or graph).


	
In the Component Properties dialog, click the Data tab.

The Data tab lists all parameters exposed by the Web Service method.


	
Modify values for any of the listed data control parameters.


	
Click OK.


	
Click Save, then Close to exit Composer.

The table or graph now displays data specific to the parameter values you provided.









26.4.6.2 Customizing a Table

You can customize a table in the following ways:

	
Sort columns: If you enabled column sorting while creating the table, the column headers display Up and Down arrows, which you can use to sort the contents either in ascending or descending order.


	
Reorder columns: Edit the task flow in Composer. Click the Edit icon on the table to open the Component Properties dialog. On the Child Components tab, use the Up and Down arrows on the right to reorder table columns.


	
Hide or show columns: Edit the task flow in Composer. Click the Edit icon on the table to open the Component Properties dialog. On the Child Components tab, clear the checkbox to the left of a column name to hide it. By default all columns are displayed in the table.





Adding a Column to a Table

When you add a data control as a table, the table displays only those data columns that you selected in the Create Table dialog. However, the data control retrieves all the columns that you specified in your SQL query. These columns are just not rendered in the table. To display an additional column in the table, all you need to do is edit the source of the task flow, find the hidden column, and set its rendered attribute to true.




	
Notes:

	
You can edit the source only if the task flow or underlying mashup style was created at runtime.


	
You cannot display additional columns if the table was added to a page directly as you cannot edit the source of a page.












To display an additional column in a table:

	
On the Resource Manger - Task Flows page, select the task flow with the table.


	
From the Edit menu, select Edit Source.




	
Note:

To ensure that you do not end up with an invalid task flow that does not render properly, edit the source code very carefully.








	
Click the Fragment tab.


	
Select the column that you want to display in the table and set the rendered attribute to true.

The following example shows the source code for a table column:


<column sortProperty="MGR" filterable="true" sortable="true"
        headerText="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.label}" 
        id="column4" rendered="true">
  <af:inputText value="#{row.bindings.MGR.inputValue}"
                label="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.label}"
                required="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.mandatory}"
                columns="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.displayWidth}"
                maximumLength="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.precision}" 
                shortDesc="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.tooltip}" 
                id="inputText4">
    <f:validator binding="#{row.bindings.MGR.validator}"/>
    <af:convertNumber groupingUsed="false" pattern="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.format}"
                   id="convertNumber3"/>
  </af:inputText>
</column>


	
Click OK to save the changes.




If you want to customize the table further, you can edit the table's properties and modify attributes such as row selection, grid lines, column groups, editable cells, column stretching, and column reordering. For more information about formatting tables, see the section titled "Displaying Data in Tables" in Oracle Fusion Middleware Web User Interface Developer's Guide for Oracle Application Development Framework.






26.4.6.3 Customizing a Graph

You can edit a graph and modify its display attributes in the Component Properties dialog. For more information about formatting graphs, see the section titled "Using ADF Graph Components" in Oracle Fusion Middleware Web User Interface Developer's Guide for Oracle Application Development Framework








26.4.7 Writing to a Data Source from a Visualization

When you add a data control as an editable table or form, you can update the records in the table or form and write those values back to the data source. However, you can update records only if the following is true:

	
The data control is created for a Web Services data source that supports updating, and the insert or update operation is exposed through the published Web Service end-point.


	
For editable tables only - the data control is a BC4J-based SQL data control created at design time. SQL data controls created at runtime do not support editing of data in a table.

You can add the data control's accessor as a table inside a task flow and add the update method so that changes made to the table can be saved to the data source.




If a Web Service supports updating, then the Web Service data control may provide methods to query and update records. Further, to enable multiple records to be updated simultaneously, Web Service data controls created at runtime provide array parameters. You can wire an array parameter to multiple input fields in the task flow so that the values specified in the fields are passed to the data source in one go. This section describes the high-level steps to use the query and update methods from a Web Service data control. It contains the following sections:

	
Section 26.4.7.1, "Querying the Data Source"


	
Section 26.4.7.2, "Updating Records in the Data Source"




For an end-to-end example showing how to query and update a data source, see Section C.5, "Creating a Mashup with Data from a Siebel Data Source."

To perform the steps in this section, you must have created a Web Service data control, which provides methods to query and update data, and consumed the data control's accessor as a table inside a task flow. For the detailed steps, see Section 26.2.2, "Creating a Web Service Data Control" and Section 26.4.1, "Consuming a Data Control in a Task Flow."



26.4.7.1 Querying the Data Source

To add a query option to a task flow displaying records from a database:

	
On the Resource Manger - Task Flows page, select the task flow containing the Web Service data control.


	
From the Edit menu, select Edit.


	
Click Add Content in the container that has the table.


	
In the Add Content dialog, navigate to the Web Service data control and click Open.


	
Locate the method available for querying the data source, and click Add. You can add the method as a button or link of your choice.

The query method in this example takes only one parameter, which is already defined when you add the data control's accessor to the task flow. As a result, the query option added to the task flow is automatically wired to the task flow parameter. However,

The task flow displays the query option, as shown in Figure 26-31.


Figure 26-31 Query Button and Table Inside a Parameter Form Task Flow

[image: Query button and data table inside a task flow]



You can specify a task flow parameter value and click the query button or link to the relevant records.









26.4.7.2 Updating Records in the Data Source

To add an update option to a task flow displaying records from a database:

	
Open the task flow containing the data visualization.


	
In the Resource Catalog, locate the method available for updating the data source, and add it to the task flow. You can add the method as a button or link of your choice.




	
Note:

Methods to insert or update records are available only if the Web Service supports updating and the data control was added as an editable table or form.







Typically, an insert or update the method expects values for exposed parameters, based on which it performs the operation. Therefore, the next step is to provide UI elements to specify values for parameters.


	
Add input text components to specify the method parameter values.




	
Tip:

As the Resource Catalog does not provide ADF Faces components such as Input Text out-of-the-box, edit the task flow's source files and add the code for such components.








	
Wire the update method's parameters to the input text components value attributes. This involves:

	
Setting an input text component's value attribute using the format: #{pageFlowScope.COLUMN_NAME}.


	
Referencing the same location, #{pageFlowScope.COLUMN_NAME}, from the method's parameter. You can set this by selecting the button or link in Composer's Source view, editing its properties, and specifying the value on the Data tab.




When you specify values in the input fields and click the update method's button or link, the values are passed back as Web Service parameter values.

For an end-to-end example showing how to query and update a data source, see Section C.5, "Creating a Mashup with Data from a Siebel Data Source."













26.5 Business Mashup Examples

To help you understand better the tasks involved in creating business mashups, Appendix C, "Business Mashup Examples" describes many use cases that illustrate how to create different types of mashups.

In addition, sample applications developed to showcase the different mashup building capabilities are published on Oracle Technology Network (OTN). The following page on OTN provides links to business mashup-specific samples and other sample applications that illustrate the different WebCenter Portal: Spaces capabilities:

http://www.oracle.com/technetwork/middleware/webcenter/ps3-samples-176806.html

A readme file available with each sample on this page describes what the application illustrates and provides guidance for extending or customizing the application for real life use cases.









27 Working with OmniPortlet

This chapter provides an overview of OmniPortlet and explains the user interface elements associated with OmniPortlet. This chapter contains the following sections:

	
Section 27.1, "What You Should Know About OmniPortlet"


	
Section 27.2, "Working with the OmniPortlet Wizard"


	
Section 27.3, "Working with OmniPortlet Parameters"


	
Section 27.4, "Setting OmniPortlet Properties"


	
Section 27.5, "Troubleshooting OmniPortlet"




For information regarding troubleshooting OmniPortlet, see Section 27.5, "Troubleshooting OmniPortlet."


Audience

This chapter is intended for users who want to understand OmniPortlet and learn how to use its features. It introduces how to customize OmniPortlet at runtime and in Oracle WebCenter Portal: Spaces, in addition to troubleshooting issues with OmniPortlet.



27.1 What You Should Know About OmniPortlet

OmniPortlet is a subcomponent of Oracle WebCenter Portal: Framework that enables developers to easily publish data from various data sources using a variety of layouts without writing any code. You can base an OmniPortlet on almost any kind of data source, including web services, SQL databases, spreadsheets (that is, files with character-separated values), XML, and even application data from existing web pages.




	
Note:

If your data source is a spreadsheet, the spreadsheet must be unsecured or must require only HTTP authentication; SSO authentication is not supported.







Additionally, OmniPortlet enables developers to:

	
Sort the data to display


	
Format data using a variety of layouts, including a customized layout


	
Use portlet parameters


	
Expose personalizable settings to page viewers




To display personalized data, you can refine the results returned from a data source and parameterize the credential information used to access secure data. Out of the box, OmniPortlet provides the most common layout for portlets: tabular, chart, news, bulleted list, form, HTML, and parameter form.




	
Notes:

For more information about developing different types of portlets and information about producers and other portlet technologies, see Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
For more information about adding an instance of OmniPortlet to a page, see Section 27.2.1, "Adding an OmniPortlet Instance to a Page."














27.2 Working with the OmniPortlet Wizard

This section includes the following subsections:

	
Section 27.2.1, "Adding an OmniPortlet Instance to a Page"


	
Section 27.2.2, "Accessing the OmniPortlet Wizard"


	
Section 27.2.3, "Selecting the Data Source Type"


	
Section 27.2.4, "Identifying the Data Source"


	
Section 27.2.5, "Setting Filtering Options"


	
Section 27.2.6, "Setting View Options"


	
Section 27.2.7, "Setting Layout Options"


	
Section 27.2.8, "Customizing Your OmniPortlet"






27.2.1 Adding an OmniPortlet Instance to a Page

The steps for adding an instance of OmniPortlet to a page vary between an application built using Oracle WebCenter Portal: Framework and the Spaces application. For one thing, in a Framework application adding a portlet to a page is a design-time activity, carried out by the application developer. For information about adding OmniPortlet to a page in a Framework application, see the “Creating Portlets with OmniPortlet” chapter in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

In Spaces, portlets are added to pages at runtime—when you run the application. Portlets are available for dragging and dropping from the Composer Catalog by any user with sufficient privileges. For information about adding a portlet to a page in Spaces, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Note:

In Spaces, avoid adding a portlet to a Movable Box layout component (For information, see Section 18.2.3, "Working with the Movable Box Layout Component"). The Movable Box layout component duplicates the showDetailFrame that the portlet provides by default. Adding a portlet to a Movable Box creates an unnecessary and potentially error-prone redundancy.







When you add an instance of OmniPortlet to a page, access the portlet's Component Properties dialog and ensure that the RenderPortletInIFrame property is set to true. This displays the OmniPortlet in its own inline frame (IFRAME) in View mode.

For information about the Component Properties dialog, see Section 27.4, "Setting OmniPortlet Properties."






27.2.2 Accessing the OmniPortlet Wizard

Once you add an instance of OmniPortlet to your page, click the Customize link to start the OmniPortlet wizard.

The OmniPortlet wizard initially contains five steps:

	
Select a data source type.


	
Identify the data source.




	
Note:

If your data source is a spreadsheet, the spreadsheet must be unsecured or must require only HTTP authentication; SSO authentication is not supported.








	
Set filtering options.


	
Set view options.


	
Set layout options.




Once you complete these steps, you are done. If you want to change your initial values, you can reenter the wizard by selecting the Customize option from the portlet's Actions menu. Tabs representing the steps you took to set up OmniPortlet display. Although the data type cannot be changed, you can revise values on the Source, Filter, View, and Layout tabs.

Table 27-1 provides a high-level overview of the steps/tabs provided for configuring an OmniPortlet instance.


Table 27-1 OmniPortlet Wizard and Customize Mode

	Step/Tab	Description
	
Type

	
Provides your data source options. Displays only in the initial definition of the portlet, and is not available when customizing the portlet defaults. For more information, see Section 27.2.3, "Selecting the Data Source Type."


	
Source

	
Provides options for configuring the data source connection, such as the URL of the web service you want to use. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.4, "Identifying the Data Source."


	
Filter

	
Provides sorting options at the Framework application level to enable you to refine your results. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.5, "Setting Filtering Options."


	
View

	
Provides options for displaying portlet header and footer text, the layout style, and caching. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.6, "Setting View Options."


	
Layout

	
Provides detailed options for customizing the layout of content retrieved from the data source. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.7, "Setting Layout Options."











	
Note:

On the IBM Linux on Power platform, if the action buttons (Next, Previous, Finish, and Cancel) are minimized to dots when defining the OmniPortlet, increase the stack size shell limit to unlimited and restart the oc4j_portlet instance. Run the following command to set the stack size shell limit to unlimited: prompt> ulimit -s unlimited.







The following sections provide more detail about the different steps/tabs in the OmniPortlet wizard.






27.2.3 Selecting the Data Source Type

When you first start OmniPortlet, the Type step displays (Figure 27-1).


Figure 27-1 Type Tab of the OmniPortlet Wizard

[image: Shows Type tab of OmniPortlet.]

Description of "Figure 27-1 Type Tab of the OmniPortlet Wizard"





Use the Type step to identify the type of data to display in your OmniPortlet instance. Table 27-2 lists and describes the data types that OmniPortlet supports out of the box.


Table 27-2 OmniPortlet Supported Data Source Types

	Data Source Type	Description
	
Spreadsheet

	
Displays data from a text file containing character-separated values (CSV).

Note: If your data source is a spreadsheet, the spreadsheet must be unsecured or must require only HTTP authentication; SSO authentication is not supported.


	
SQL

	
Displays data from a database using SQL.


	
XML

	
Displays data from an XML file.


	
Web Service

	
Displays data from a discrete business service that can be accessed over the Internet using standard protocols.


	
Web Page

	
Displays data based on existing web content.








After you complete the OmniPortlet wizard, you cannot change the data source type.






27.2.4 Identifying the Data Source

Once you choose a data type, you are ready to identify a data source. The Source tab renders according to the data type you selected in step 1. That is, the options that display on the Source tab vary according to the selected data type.

Additionally, if the OmniPortlet producer has been configured to use a proxy server requiring authentication, the Source tab contains a Proxy Authentication section and a Connection section where you can provide the necessary information for connecting to the data source.

This section contains information about the settings common to all Source tabs, including settings specific to the selected data type. It contains the following subsections:

	
Section 27.2.4.1, "Proxy Authentication"


	
Section 27.2.4.2, "Connection and Portlet Parameters"


	
Section 27.2.4.3, "Spreadsheet"


	
Section 27.2.4.4, "SQL"


	
Section 27.2.4.5, "XML"


	
Section 27.2.4.6, "Web Service"


	
Section 27.2.4.7, "Web Page"






27.2.4.1 Proxy Authentication

If the OmniPortlet producer was set up at design time to use proxy authentication that requires login credentials, then a Proxy Authentication section displays on the Source tab where you can enter this information.

OmniPortlet's support for proxy authentication includes support for global proxy authentication and authentication for each user, which means you can specify a login scenario for your OmniPortlet instance:

	
All users automatically log in using a user name and password you provide.


	
Each user logs in using an individual user name and password.


	
All users log in using the same specified user name and password.




The Proxy Authentication section displays only for the following data types, and only when the specific data source requires a proxy server for access:

	
CSV (character-separated values)


	
XML


	
Web Page







	
Notes:

Configuring an OmniPortlet producer is a design-time activity applicable to Framework applications. For more information about configuring the OmniPortlet producer to use proxy authentication, see the WebCenter Portal: Framework online Help topic that displays when you click Help on the Edit Producers: OmniPortlet Producer page.
If the OmniPortlet producer is configured to require login for all users, then each user must set his or her own proxy login information at runtime as follows:

	
For page designers, set this on the Customize: Source tab.


	
For page viewers, set this on the Personalize page.




To access the Customize: Source tab, click the Customize link on the portlet's Actions menu. To access the Personalize page, click the Personalize link on the portlet's Actions menu.

If you are using the Web Page data source, then the Proxy Authentication section displays in the Web Clipping Studio when you click the Select Web Page button on the Source tab.

For more information about Web Clipping Studio, see Chapter 28, "Working with the Web Clipping Portlet."














27.2.4.2 Connection and Portlet Parameters

For each data source—except the Web Page data source—the Source step contains a Connection section, where you can define connection information for accessing secured data. The Source step for all data sources includes a Portlet Parameters section, where you can define portlet parameters (Figure 27-2).


Figure 27-2 Source Tab: Connection and Portlet Parameters Sections

[image: OmniPortlet. Source tab]

Description of "Figure 27-2 Source Tab: Connection and Portlet Parameters Sections"








	
Note:

You can use the format ##ParamN## (for example, ##Param1##) for Username, Password, or Connection String. The Test button returns an error, however, even though the connection information is correct when parameter values are substituted.







Once you define the portlet parameters, you can map them to page parameters. For more information, see Section 27.3, "Working with OmniPortlet Parameters" and Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

To edit the connection information, click the Edit Connection button to open the Connection Information page (Figure 27-3).


Figure 27-3 OmniPortlet Connection Information Page for a SQL Data Source

[image: OmniPortlet Connection Information page]

Description of "Figure 27-3 OmniPortlet Connection Information Page for a SQL Data Source"





On the Connection Information page, you can enter a name for the connection information, and also the user name and password. For a SQL data source, you can also enter information to specify the driver you want to use to connect to the data source. For more information, see Section 27.2.4.4, "SQL."




	
Note:

For more information about the Connection Information page, click Help on the Source tab of the OmniPortlet wizard.












27.2.4.3 Spreadsheet

Spreadsheets are a common method of storing small data sets. OmniPortlet enables you to share spreadsheets by supporting character-separated values (CSV) as a data source. Use the Source tab to specify the location of the CSV file (Figure 27-4).


Figure 27-4 Source Tab: Spreadsheet (CSV)

[image: Source tab for a spreadsheet data type]

Description of "Figure 27-4 Source Tab: Spreadsheet (CSV)"





If the file is located on a secure server, then you can specify the connection information in the Connection Information section illustrated in Figure 27-3. You can select the character set to use when WebCenter Portal reads the file, and also the delimiter and text qualifier.




	
Note:

	
As the OmniPortlet producer exists and executes in a tier different from the Framework application and does not have access to the session information, you must expose CSV files as PUBLIC for OmniPortlet to be able to access them.


	
The CSV file must be unsecured or must require only HTTP authentication; SSO authentication is not supported.

















27.2.4.4 SQL

A relational database is the most common place to store data. OmniPortlet enables you to use standard JDBC drivers and provides out-of-the-box access to Oracle and any other JDBC database. You can specify the driver type when you configure the connection information.

Figure 27-5 shows the Source tab for a SQL data source.


Figure 27-5 Source Tab: SQL

[image: Driver Name list on the Connection Information page]

Description of "Figure 27-5 Source Tab: SQL"





You can use DataDirect JDBC drivers to access other relational databases. To do so, you must configure OmniPortlet to recognize the driver. This is a design-time activity, typically carried out by an application developer.




	
Notes:

For information about configuring OmniPortlet to use DataDirect drivers, see Appendix E, “Additional Portlet Configuration” in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.
For more information about DataDirect drivers, see the Certification Matrix for Oracle Application Server and DataDirect JDBC on the Oracle Technology Network (OTN) at http://www.oracle.com/technetwork.









Once the driver is installed, it displays in the Driver Name dropdown list on the Connection Information page (Figure 27-6).


Figure 27-6 Driver Name Dropdown List on the Connection information Page

[image: Description of Figure 27-6 follows]

Description of "Figure 27-6 Driver Name Dropdown List on the Connection information Page"





When you enter a connection string for a DataDirect driver, keep in mind that you must enter a value in the Connection String field using the syntax: host_name:port. The host_name is the name of the server where the database is running. The port is the database's listening port.






27.2.4.5 XML

You can access XML data sources across an intranet or the Internet. On the Source tab, you can specify the URL of the XML file that contains your data (Figure 27-7).


Figure 27-7 Source Tab: XML

[image: Description of Figure 27-7 follows]

Description of "Figure 27-7 Source Tab: XML"





Use the Test buttons next to the XML URL and the XSL Filter URL fields to validate your XML data source and the XSL filter.

The specified XML file can be in a tabular (ROWSET/ROW) structure, or you can provide an XML Style Sheet (XSL) that transforms data into the ROWSET/ROW structure. Example 27-1 provides an illustration of the ROWSET/ROW structure of an XML data source.


Example 27-1 ROWSET/ROW Structure of an XML Data Source


<TEAM>
  <EMPLOYEE>
    <DEPTNO>10</DEPTNO>
    <ENAME>KING</ENAME>
    <JOB>PRESIDENT</JOB>
    <SAL>5000</SAL>
  </EMPLOYEE>
    <DEPTNO>20</DEPTNO>
    <ENAME>SCOTT</ENAME>
    <JOB>ANALYST</JOB>
    <SAL>3000</SAL>
  <EMPLOYEE>
</TEAM>




In Example 27-1, the <TEAM> tags delineate the rowset, and the <EMPLOYEE> tags delineate the rows.

Regardless of the format of the XML file, OmniPortlet automatically inspects the XML to determine the column names, which are then used to define the layout. If you want to specify this information yourself, you can supply a URL to an XML schema that describes the data.

If the XML file is located on a secured server protected by HTTP Basic Authentication, you can specify connection information on the Connection Information page.




	
Note:

Because the OmniPortlet producer exists and executes in a tier different from the Framework application and does not have access to the session information, you must expose XML files as PUBLIC in order for OmniPortlet to access them.












27.2.4.6 Web Service

A web service is a discrete business service that can be programmatically accessed over the Internet using standard protocols, such as SOAP and HTTP. Web services are specific to neither platform nor language and are typically registered with a web service broker. When you find a web service you want to use, you must obtain the URL to the Web Service Description Language (WSDL) file. The WSDL file describes the web service and specifies the methods that can be called, including the expected parameters. It also describes the returned data.

OmniPortlet supports both types of web Services: Document and Remote Procedure Calls (RPC). After a WSDL document/file is supplied, it is parsed, and the available methods that can be called display on the Source tab.

Similar to the XML data source, OmniPortlet expects the web service data in ROWSET/ROW format, though you can also use an XSL file to transform the data. OmniPortlet inspects the WSDL document/file to determine the column names, though you may also specify an XML schema to describe the returned data set.

Figure 27-8 shows the Source tab for a sample web service.


Figure 27-8 Source Tab: Web Service

[image: Source tab when a Web Service data type is specified]

Description of "Figure 27-8 Source Tab: Web Service"









27.2.4.7 Web Page

OmniPortlet enables you to use existing web content as a data source. It integrates the Web Clipping portlet's Web Clipping Studio to provide a means of clipping and rendering web content within the context of an OmniPortlet instance.

OmniPortlet's Web Page data source extends the scope offered by the Web Clipping portlet to include scraping functionality. Additional features include:

	
Navigation through various login mechanisms, including form- and JavaScript-based submission, and HTTP Basic and Digest Authentication with cookie-based session management.


	
Fuzzy matching of clippings. If a web clipping gets reordered within the source page or if its character font, size, or style changes, then it is still identified correctly by the web page data source and delivered as the portlet content.


	
Reuse of a wide range of web content, including basic support of pages written with HTML 4.0.1 and JavaScript, retrieved through HTTP GET and POST (form submission).




By default, all web clipping definitions are stored persistently in Oracle Metadata Services (MDS). However, you can also use an Oracle database. Using MDS does not require any changes in the configuration files. If you use an Oracle database as the Web Clipping repository, then at design time you must update the provider.xml file.Any secure information, such as passwords, is stored in encrypted form, according to the Data Encryption Standard (DES), using Oracle Database encryption technology.

When Web Page is selected as the data type, the OmniPortlet wizard's Source tab (Figure 27-9) includes a Select Web Page button that launches Web Clipping Studio.


Figure 27-9 Source Tab: Web Page

[image: Description of Figure 27-9 follows]

Description of "Figure 27-9 Source Tab: Web Page"





Within Web Clipping Studio, the Oracle Application Server Web Clipping online Help becomes available through the Help icon at the top of the page. You can use the Help to navigate your way through the process of sectioning and saving web content.




	
Note:

For more information about using the Web Clipping Studio or clipping content for a Web Clipping Portlet, see Chapter 28, "Working with the Web Clipping Portlet."














27.2.5 Setting Filtering Options

Once you have selected the data source and specified the data source options, you can further refine your data using OmniPortlet's filtering options. To use filtering efficiently, it is better to refine the data as much as possible at the data source level on the Source tab, then use the options on the Filter tab to streamline the data. For example, if you are using a SQL data source, then you could use a WHERE clause to return only specific data from the specified columns. In this case, you could skip the Filter tab and continue to the wizard's View tab. However, if there are no filtering options at the data source level, then you can use the options on the Filter tab to sort your data (Figure 27-10).


Figure 27-10 Filter Tab

[image: OmniPortlet Filter tab]

Description of "Figure 27-10 Filter Tab"









27.2.6 Setting View Options

Once you have specified and filtered the data, you are ready to choose view and layout options for your OmniPortlet. The View tab (Figure 27-11) provides options for adding header and footer text, enabling caching, and choosing a layout style that you can later refine on the Layout tab.


Figure 27-11 View Tab

[image: Description of Figure 27-11 follows]

Description of "Figure 27-11 View Tab"





On the View tab, you can choose from the following layouts:

	
Tabular


	
Chart


	
News


	
Bullet


	
Form


	
HTML


	
Parameter Form







	
Note:

For more information about the different layout styles you can use with OmniPortlet, see the next section or click Help in the OmniPortlet wizard.












27.2.7 Setting Layout Options

The Layout tab enables you to further customize the appearance of your OmniPortlet. The options on the Layout tab change according to your selection on the View tab. For example, when you select Chart Layout, options are provided for setting up chart hyperlinks. With chart hyperlinks, clicking a specific part of the chart triggers an event (for example, navigation to another URL).

For the other layout styles, you can define each column to display in a specific format, such as plain text, HTML, an image, a button, or a field. For example, suppose you selected a data source that includes a URL to an image. To see this image, you can select Image for the display of this column. Each column can also be mapped to an action, similar to the behavior of chart hyperlinks.

This section includes the following subsections that provide more detail about the layout options available on the OmniPortlet Layout tab:

	
Section 27.2.7.1, "Tabular Layout"


	
Section 27.2.7.2, "Chart Layout"


	
Section 27.2.7.3, "News Layout"


	
Section 27.2.7.4, "Bullet Layout"


	
Section 27.2.7.5, "Form Layout"


	
Section 27.2.7.6, "HTML Layout"


	
Section 27.2.7.7, "Parameter Form Layout"







	
Note:

Because events are not currently supported, selecting an action when designing your layout may produce unexpected results.









27.2.7.1 Tabular Layout

Typically, you use tabular layout when you have one or more columns of data to display in a table. You can choose Plain to display all rows in the table without any background color, or Alternating to display a background color for every other row in the table (Figure 27-12).


Figure 27-12 Layout Tab: Tabular

[image: Description of Figure 27-12 follows]

Description of "Figure 27-12 Layout Tab: Tabular"








	
Note:

You can control the background color of a portlet using its style properties. Portlet style properties are exposed through the Properties panel in Composer. For more information, refer to Setting OmniPortlet Properties.







The Column Layout section provides options for selecting the data columns to display in the portlet and a display format. Additionally, you can associate a URL with a column to display column data as a hyperlink. You can also specify whether the secondary web page displays in a new window. Figure 27-13 shows an example of an OmniPortlet using a tabular format.


Figure 27-13 Example of an OmniPortlet Using a Tabular Layout

[image: Shows example of portlet using tabular layout.]

Description of "Figure 27-13 Example of an OmniPortlet Using a Tabular Layout"








	
Note:

For more information about using the OmniPortlet wizard, click the Help link on the Layout tab.












27.2.7.2 Chart Layout

Use the chart layout to display your data graphically, as a bar, pie, or line chart. The Layout tab (Figure 27-14) provides options for specifying the chart style to use (Chart Style) and the data source columns to display (Column Layout).


Figure 27-14 Layout Tab: Chart

[image: Layout tab when Chart is selected on View tab]

Description of "Figure 27-14 Layout Tab: Chart"





Under the Column Layout section, you can choose the data source columns to use in the chart (Group); the values to use in creating the chart legend (Category); and the relative size of the chart's bars, lines, or pie slices (Value).




	
Note:

To group the information in the chart, you must group the information at the data level (for example, in your SQL query statement). Also, if numeric values in a data source contain formatted strings, commas, or currency (for example, $32,789.00), then they are considered to be text and ignored when the chart is generated. You should remove these formatting characters if you want them to be correctly read as numeric values.







You can also select whether the sections of the chart should point to a hyperlink and whether the link target should display in a new window.

You can define chart hyperlinks so that each bar, pie section, or line links to another web page. For example, you can place a pie chart and a report portlet on your page, then set up hyperlinks on the pie wedges. Users click a wedge to display a row in the report with detailed information about the wedge data.

Figure 27-15 displays an example of a pie chart. In this example, the Category value DEPARTMENT is used as the chart legend.


Figure 27-15 Example of an OmniPortlet Using a Pie Chart Layout

[image: Shows example of pie chart layout.]

Description of "Figure 27-15 Example of an OmniPortlet Using a Pie Chart Layout"









27.2.7.3 News Layout

Use the News layout to display links to articles and brief article descriptions. You can use the News layout to publish information in standard XML formats, such as Resource Description Framework (RDF) or RSS (Really Simple Syndication).

Use the Column Layout section (Figure 27-16) to add a heading that displays at the top of the portlet, a logo, or a scrolling layout that enables users to view all the information in the portlet as it moves vertically.


Figure 27-16 Layout Tab: News

[image: News layout options on the OmniPortlet Layout tab]

Description of "Figure 27-16 Layout Tab: News"








	
Note:

The OmniPortlet News Layout Scroll type is supported on Microsoft Internet Explorer and Netscape 7.0.







The Layout tab also provides options for associating a URL with column data. Users click column data in the portlet to navigate to your specified target location.

Figure 27-17 shows an example OmniPortlet using a News layout.


Figure 27-17 Example of an OmniPortlet Using a News Layout

[image: Shows example of portlet in a news layout.]

Description of "Figure 27-17 Example of an OmniPortlet Using a News Layout"








	
Note:

For more information about using the OmniPortlet wizard, click the Help link on the Layout tab.












27.2.7.4 Bullet Layout

Use the Bullet layout to display your data in a bulleted or numbered list. The Layout tab (Figure 27-18) provides a variety of different bullet and numbering styles.


Figure 27-18 Layout Tab: Bullet

[image: Layout tab in the OmniPortlet Wizard]

Description of "Figure 27-18 Layout Tab: Bullet"





In the Column Layout section, you can choose how the columns display in the portlet and associate a URL with column data.

Figure 27-19 shows an example of an OmniPortlet using a Bullet layout.


Figure 27-19 Example of an OmniPortlet Using a Bullet Layout

[image: Shows example of portlet with bullet style.]

Description of "Figure 27-19 Example of an OmniPortlet Using a Bullet Layout"








	
Note:

For more information about using the OmniPortlet wizard, click the Help link in the Layout tab.












27.2.7.5 Form Layout


Figure 27-20 Layout Tab: Form

[image: Layout tab with Form layout options]

Description of "Figure 27-20 Layout Tab: Form"





Use the Form layout when you want to display source data in a form with labeled fields, such as Name: <name>. You can then use portlet parameters to determine the data that displays.

Use the Column Label column to enter row labels and the Column column to specify which column to use from your data source. Additionally, you can specify data alignment, select a display mode (text, HTML, image, button, field, or hidden), associate a URL or an event with the column data, and specify whether to open the URL target in a new window.

Figure 27-21 shows an example of an OmniPortlet using a Form layout.


Figure 27-21 Example of an OmniPortlet Using a Form Layout

[image: Shows example of portlet using form style.]

Description of "Figure 27-21 Example of an OmniPortlet Using a Form Layout"








	
Note:

For more information about using the OmniPortlet wizard, click the Help link in the upper right corner of the Layout tab.












27.2.7.6 HTML Layout

Use the HTML layout to create a customized look and feel for your OmniPortlet content. The Layout tab (Figure 27-22) provides a means of selecting a built-in HTML layout and modifying the code, or creating a new layout.


Figure 27-22 Layout Tab: HTML

[image: Description of Figure 27-22 follows]

Description of "Figure 27-22 Layout Tab: HTML"





You can hand-code your own HTML or JavaScript based on data columns that OmniPortlet has retrieved from the selected data source. By coding your own HTML and JavaScript, you have full control over the portlet's appearance, enabling you to develop a rich portlet interface.

For more information about using the fields on the Layout tab, click the Help button in the wizard. For an example of using JavaScript in the HTML layout, choose the Sortable Table layout from the Quick Start dropdown list on this tab.




	
Note:

The maximum number of characters you can enter in each of the sections (Heading, Repeating, and Footer) is 30,000 (30k).







Figure 27-23 shows an example of an OmniPortlet using the HTML layout.


Figure 27-23 Example of an OmniPortlet Using the HTML Layout

[image: Description of Figure 27-23 follows]

Description of "Figure 27-23 Example of an OmniPortlet Using the HTML Layout"









27.2.7.7 Parameter Form Layout

Use the Parameter Form layout to create a customized parameter form for your OmniPortlet content. The Layout tab (Figure 27-22) provides a means of selecting a built-in parameter form layout and modifying the code, or creating a new layout.


Figure 27-24 Layout Tab: Parameter Form

[image: Description of Figure 27-24 follows]

Description of "Figure 27-24 Layout Tab: Parameter Form"





You can hand-code your own parameter form based on data columns that OmniPortlet has retrieved from the selected data source. By coding your own parameter form, you have full control over the portlet's appearance, enabling you to develop a rich portlet interface. To do so, choose the Custom style option, then use the Custom HTML field to edit the parameter form (Figure 27-25).


Figure 27-25 Layout Tab: Parameter Form Custom HTML Field

[image: Description of Figure 27-25 follows]

Description of "Figure 27-25 Layout Tab: Parameter Form Custom HTML Field"





For more information about using the fields on the Layout tab, click the Help button in the wizard.








27.2.8 Customizing Your OmniPortlet

After you have created your OmniPortlet and returned to your application, you can select the Customize option from the portlet's Actions menu to revise your original selections. When you revise a defined OmniPortlet, tabs correspond to the different steps originally presented in the OmniPortlet wizard. An exception to this is the Type step—you cannot change the originally selected data type, and so there is no corresponding Type tab.

When you revise an OmniPortlet using customize mode, keep in mind the following notes:

	
Any modifications you make to your portlet using customize mode apply to all users, regardless of the current session language and the locale of the user's browser.


	
You can personalize the portlet at runtime by clicking the Personalize link on the portlet or by selecting the Personalize option on the portlet's Action menu. Personalizing the portlet creates a copy of the personalization object. As all properties are duplicated, subsequently modifying the portlet through Customize mode does not affect the personalized version of the portlet. To ensure the latest customizations are made to the portlet, after you make modifications in Customize mode, you must click Personalize again, and then select the Reset to Defaults option.


	
The personalization of OmniPortlet is stored in a file-preference store. For more information about configuring OmniPortlet and modifying the preference store, see Appendix E, “Additional Portlet Configuration” in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.











27.3 Working with OmniPortlet Parameters

You can define up to five portlet parameters for an OmniPortlet. You can define parameters in the following screens:

	
On the Source screen of the wizard when you define the OmniPortlet


	
On the Source tab when you select Customize for a defined OmniPortlet




Figure 27-26 shows the Portlet Parameters section on the Source tab.


Figure 27-26 Source Tab: Portlet Parameters Section

[image: Portlet Parameter section on the Source tab]

Description of "Figure 27-26 Source Tab: Portlet Parameters Section"





If you select any of these portlet parameters to be personalizable (by selecting the Personalizable checkbox), you can set their values on the Personalize screen.




	
Note:

You can learn more about portlet parameters in the online Help, which you can access by clicking the Help link on the Source tab in the OmniPortlet wizard. The online Help describes portlet parameters in detail, and how to set them up for your OmniPortlet.







Once you have set up portlet parameters in your OmniPortlet, you can contextually map the portlet to other portlets or components on a page. For more information about doing so, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."






27.4 Setting OmniPortlet Properties

OmniPortlet has associated properties that users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 27-27).


Figure 27-27 OmniPortlet Component Properties

[image: Component Properties dialog]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 27.4.1, "What You Should Know About OmniPortlet Properties"


	
Section 27.4.2, "OmniPortlet Properties"






27.4.1 What You Should Know About OmniPortlet Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 27.4.2, "OmniPortlet Properties." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






27.4.2 OmniPortlet Properties

Table 27-3 describes the properties that are unique to OmniPortlet.


Table 27-3 OmniPortlet Component Properties

	Property	Description	Location
	
Param#

	
Use to map page parameters to the parameters specified when the OmniPortlet was defined. These parameters enable you to contextually wire portlets and pages. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

	
Parameters tab


	
All Modes Shared Screen

	
For OmniPortlet, set this property to false to ensure that all portlet modes, except Show, are rendered each on their own page. Setting this property to true may prevent you from editing certain sections of your OmniPortlet in the OmniPortlet wizard.

	
Display Options tab


	
Id

	
A unique identifier for the portlet instance.

	
Display Options tab


	
Partial Triggers

	
Use to initialize a partial page refresh, which is a way of refreshing an area of a page without having to redraw the entire page.

	
Display Options tab


	
Render Portlet In I Frame

	
Use to render the portlet in an inline frame (IFRAME), omit an IFRAME, or let the portlet decide. Valid values are:

	
auto (default): The portlet tag checks the portlet response and decides if an IFRAME is required


	
true: Render the portlet instance in an IFRAME


	
false: Render the portlet instance inline




Placing a portlet inline on a page provides a better user experience as compared to placing it in an IFRAME. However, at times, it may be required to include a portlet in an IFRAME. For example:

	
The portlet is a JSF portlet


	
The portlet contains a file upload element


	
The parser throws an exception because it is not able to parse the markup




	
Display Options tab


	
Title

	
Enter a title for the OmniPortlet, to display in the portlet header.

	
Display Options tab














27.5 Troubleshooting OmniPortlet

This section provides information to help you troubleshoot problems you may encounter while using OmniPortlet.


Cannot Define OmniPortlet Using the Customize Link

You are not able to define the OmniPortlet at runtime by using the Customize link.


Problem

OmniPortlet only supports a RenderPortletInIFrame value of true, which means that OmniPortlet must be rendered within an IFRAME and therefore, the OmniPortlet property, RenderPortletInIFrame, must be set to true. At design time, the RenderPortletInIFrame property is available in the Property Inspector under Display Options. At runtime, the RenderPortletInIFrame property is available on the Properties panel in Composer.


Solution

Currently, the RenderPortletInIFrame property has a value of false and, consequently, when you click the Define link at runtime, the Type tab may not display and you cannot proceed with defining the OmniPortlet.

You can choose Customize from the Action menu to define OmniPortlet, or, for Framework applications at design time, select the OmniPortlet in the Structure window in Oracle JDeveloper, and in the Property Inspector, set RenderPortletInIFrame to true.









28 Working with the Web Clipping Portlet

This chapter provides a brief description of the Web Clipping portlet and producer and explains how you can register a Web Clipping producer and use this producer to add a Web Clipping portlet to a JSP document created through Oracle JDeveloper.

This chapter includes the following sections:

	
Section 28.1, "What You Should Know About Web Clipping"


	
Section 28.2, "Working with the Web Clipping Portlet"


	
Section 28.3, "Setting Web Clipping Portlet Properties"


	
Section 28.4, "Current Limitations of Web Clipping"


	
Section 28.5, "Troubleshooting Web Clipping"






28.1 What You Should Know About Web Clipping

Web Clipping is a publishing portlet that enables you to integrate any web application with applications built using Oracle WebCenter Portal: Framework and with Oracle WebCenter Portal: Spaces. It is designed to give you quick integration by leveraging the existing user interface of the web application. With Web Clipping, you can consolidate content from web sites scattered throughout a large organization.

With Web Clipping, you can clip an entire web page, or a portion of it, and reuse it as a portlet. You can clip basic and HTML-form-based sites. Use Web Clipping when you want to copy content from an existing web page and expose it in your Framework application as a portlet.

Web Clipping supports the following features:

	
Navigation through various styles of login mechanisms

Web Clipping supports various login mechanisms including form- and JavaScript-based submission and HTTP Basic and Digest Authentication with cookie-based session management.


	
Fuzzy matching of clippings

Fuzzy matching enables the Web Clipping engine to correctly identify a web clipping and deliver it as portlet content even if the web clipping is reordered within the source page or if its character font, size, or style changes.


	
Personalization

Personalization enables you to expose input parameters that end users can modify when they personalize the portlet. Parameters can be exposed as public parameters that you can map as page parameters. This feature enables end users to obtain personalized clippings.


	
Integrated authenticated web content through single sign-on

You can use external applications and leverage Oracle Single Sign-On to clip content from authenticated external web sites.


	
Inline rendering

Inline rendering enables you to set up Web Clipping portlets to display links within the context of the portlet. When a user clicks a link in the Web Clipping portlet, the results display within the same portlet. You can use this feature with internal and external web sites.


	
Proxy authentication

Web Clipping supports proxy authentication, including global proxy authentication and authentication for each user. You can use this feature if proxy servers require authentication. You can specify proxy server authentication details, including type (Basic or Digest) and realm in the provider.xml file. In addition, you can specify a scheme for entering user credentials as follows:

	
All users automatically log in using a user name and password that you provide.


	
All users are required to log in using a user name and password that they provide.


	
All public users (not authenticated into the WebCenter Portal application) automatically log in using a user name and password that you provide, while valid users (authenticated into the WebCenter Portal application) log in using a user name and password that they provide.




For more information, see the “HTTP or HTTPS Proxy Configuration” section in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
Support for HTTPS

Web Clipping enables you to clip content from HTTPS-based external web sites if appropriate server certificates are acquired.


	
Open Transport API

By default, the Web Clipping provider supports only HTTP challenge-based authentication methods, such as Basic and Digest and form submission logins. To support custom authentication methods, such as Kerberos proxy authentication, you can use the Web Clipping Transport API. For more information, see the “Using Web Clipping Open Transport API” section in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
Reuse of a wide range of web content

Web Clipping provides basic support of pages written with JavaScript, applets, and plug-in enabled content, retrieved through HTTP GET and POST methods of form submission.

Web Clipping also supports clipping of content from pages written with HTML 4.01, including:

	
Clipping of <applet>, <body>, <div>, <embed>, <img>, <object>, <ol>, <span>, <table>, and <ul> tagged content


	
Preservation of <head> styles and fonts, and CSS


	
Support for UTF-8 compliant character sets


	
Navigation through hyperlinks (HTTP GET), form submissions (HTTP POST), frames, and URL redirection





	
Globalization support

Web Clipping provides globalization support in URLs and URL parameters. For information about how Web Clipping determines the character set of clipped content, see Section 28.4, "Current Limitations of Web Clipping."


	
Persistent storage of Web Clipping definitions

Web Clipping definitions are stored persistently in a repository. For information about Web Clipping repository, see the “Web Clipping Portlet Configuration Tips” section in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
Encryption of secure information

Any secure information, such as passwords, is stored in an encrypted form, according to the Data Encryption Standard (DES), using Oracle encryption technology.









28.2 Working with the Web Clipping Portlet

This section describes how to clip content for a Web Clipping portlet and make the portlet personalizable. It includes the following subsections:

	
Section 28.2.1, "Adding a Web Clipping Portlet to a Page"


	
Section 28.2.2, "Clipping Content for Display in the Web Clipping Portlet"


	
Section 28.2.3, "Adding a Web Clipping That Users Can Personalize"






28.2.1 Adding a Web Clipping Portlet to a Page

The steps for adding a Web Clipping portlet to a page vary between a Framework application and the Spaces application. For one thing, in a Framework application adding a portlet to a page is a design-time activity, carried out by the application developer. For information about adding a portlet to a page in a Framework application, see the “Creating Content-Based Portlets with Web Clipping” chapter in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

In Spaces, portlets are added to pages at runtime—when you run the application. Portlets are available for dragging and dropping from the Composer Catalog by any user with sufficient privileges. For information about adding a portlet to a page in Spaces, see Section 17.5.1, "Adding a Component to a Page."




	
Note:

In Spaces, avoid adding a portlet to a Movable Box layout component (For information, see Section 18.2.3, "Working with the Movable Box Layout Component"). The Movable Box layout component duplicates the showDetailFrame that the portlet provides by default. Adding a portlet to a Movable Box creates an unnecessary and potentially error-prone redundancy.












28.2.2 Clipping Content for Display in the Web Clipping Portlet

Though the point at which you add a Web Clipping portlet to a page varies between Framework applications and Spaces—at design time or at runtime—Web Clipping content is defined at runtime for both scenarios.

There are two ways to clip and save web content:

	
Customize the portlet to set up a Web Clipping portlet to display content to all users


	
Personalize the portlet to set up your own, personal view of a Web Clipping portlet




Both options take you into Web Clipping Studio, where you can:

	
Browse for web content


	
Choose the exact portion of the web content to clip


	
Preview the clipped content as a portlet


	
Save the clipped content as a portlet


	
Set portlet properties and save the updated portlet information




To clip web content for display in the Web Clipping portlet:

	
Open the Find a Web clipping page:

	
To set up a Web Clipping portlet to display content to all users, open the page in edit mode (Composer) and click the Customize icon in the portlet header.


	
To set up your own, personal view of a Web Clipping portlet, click the Personalize icon in the portlet header.




The Find a Web clipping page opens (Figure 28-1).


Figure 28-1 The Find a Web Clipping Page

[image: Find a Web clipping page]

Description of "Figure 28-1 The Find a Web Clipping Page"








	
Note:

When running a portlet that has an Edit mode, the Personalize option in the portlet header appears only to authenticated users. Unauthenticated or public users do not see the Personalize option. What this means is that, for personalization to work, some form of security must be implemented for your application.
If you are a developer creating portlets and pages, then you may want a quick way to test the Edit mode of your portlet without creating a complete security model for your application. For information about how you can quickly add the necessary security for testing portlet personalization, see the “Configuring Basic Authentication for Testing Portlet Personalization” section in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.










	
In the URL Location field, enter the URL of the web page that contains or links to the content you want to clip.


	
Click Start.

Web Clipping Studio displays the page you specified (Figure 28-2).




	
Note:

You can clip Secure Socket Layer (SSL)-enabled web sites if certificates of those sites are added to the certificate store. Certificates of SSL-enabled web sites that use Equifax, VeriSign, or Cybertrust certificates are included in the default certificate store.
For information about adding certificates, see the “Adding Certificates for Trusted Sites” section in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.










Figure 28-2 A Web Page Displayed in Web Clipping Studio

[image: URL location displayed in Web Clipping Studio]

Description of "Figure 28-2 A Web Page Displayed in Web Clipping Studio"





	
If your starting web page is not the page you plan to clip, then within Web Clipping Studio browse to the content you want to clip.

As you click hyperlinks in the web page, Web Clipping Studio records your navigation links.




	
Notes:

Only the significant browsing operations are recorded for later playback during the show mode. Any browsing operations that do not contribute to the eventual web clipping are discarded. Discarded links are not visited.
For any web sites that require HTTP Basic or Digest Authentication, a form is displayed that requests user name and password information. This encoded authentication information is recorded as part of the browsing information.










	
On the page that contains the content you want to clip, click the Section icon or link on the Web Clipping Studio banner (Figure 28-3).

If you intend to clip the full web page, it is not necessary to section the page. You can clip the full page by clicking the Select icon or link instead of Section when you are on a page you want to clip.


Figure 28-3 The Section Icon and Link in the Web Clipping Studio Banner

[image: Section icon and link in Web Clipping Studio]

Description of "Figure 28-3 The Section Icon and Link in the Web Clipping Studio Banner"





Sectioning divides the target web page into its clippable sections (Figure 28-4).


Figure 28-4 Sectioned Web Page in Web Clipping Studio

[image: Description of Figure 28-4 follows]

Description of "Figure 28-4 Sectioned Web Page in Web Clipping Studio"





After you click Section, you cannot browse links in the displayed page. If you want to browse to other locations through page links, then click Unsection on the Web Clipping Studio banner. For more information about using Web Clipping, you can click the Help icon or link on any of the Web Clipping pages.




	
Note:

To adjust sectioning to encompass smaller or larger areas on the web page, use the Section Smaller and Section Larger options on the Web Clipping Studio banner. Click Section Smaller to divide the web page into more, smaller sections. For example, click Section Smaller to drill down one level of nested tables. Click Section Larger to divide the web page into fewer, larger sections.








	
At the top-left corner of the section you want to clip, click Choose.

You can choose only one section at a time. Web Clipping Studio displays a preview of your chosen section.


	
If the displayed section is the clipping you want, then click Select on the Web Clipping Studio banner.

If the displayed section is not the clipping you want, then click Unselect to return to the page containing the section. You can choose another section on the page, or click Unsection to remove sectioning, enabling you to navigate to another page.




	
Note:

Some sections may contain no data, only whitespace. For example, a web page may contain an HTML <DIV> tag that contains no text or images. If you click Choose on a section that contains no data, then Web Clipping displays a preview, but the preview correctly shows only whitespace. In this case, click Unselect on the preview page to return to the sectioned page. Then, select a section containing data.







Once you have made your selection, the Web Clipping Studio displays the Find a Web clipping page with the selected web clipping's properties.


	
Adjust the clipping's property values as necessary:

	
URL Rewriting—Controls the behavior of links embedded in the clipped content.

Select from:

	
None—To specify that link targets display on a new browser tab.


	
Inline—To specify that link targets display inside the portlet. If you have integrated with an external application or are logged into the clipped site, and if you choose Inline for URL Rewriting, then the session is maintained to the clipped site while browsing.




	
Note:

The URL Rewriting option is available only when you customize a portlet. This option is not available when you personalize a portlet.











	
Title—A title to display in the portlet header.


	
Description—A description of the clipping. The description is not displayed in the portlet.


	
Time Out (seconds)—The number of seconds to allow for the portlet to render before it times out.


	
Expires (minutes)—The number of minutes before cached portlet content expires. Once cached content expires, the next time the portlet is refreshed—either by a browser refresh or by clicking the Refresh link in the portlet itself—portlet content is retrieved from the web page from which the clipping originated.


	
Parameterize Inputs—Options for customizing parameters associated with the clipped content.

Click the Click to start parameterizing checkbox to customize parameters associated with the content, and then perform the following steps:

	
From the Parameters list, choose the parameters you intend to customize.


	
From the Personalizable list, select a parameter if you intend to enable users to provide their own parameter values when they personalize the portlet. Select None if you do not want to allow this.


	
In the Display Name field, enter a name to be displayed for the parameter.


	
In the Default Value field, enter a default value for the parameter.




For an example of personalizing the parameters of a web clipping, see Section 28.2.3.2, "Parameterizing a Web Clipping Portlet."




	
Note:

The Parameterize Inputs section displays only if you entered information in a form and then selected the section including the form for your web clipping.











	
Click OK to save changes to property values and to display the selected clipping in the Web Clipping portlet on your page.




	
Note:

Web Clipping portlets support additional properties that influence the way the portlet is rendered. For information, see Section 28.3, "Setting Web Clipping Portlet Properties."







Figure 28-5 shows the selected web clipping in your Web Clipping portlet.


Figure 28-5 Clipped Content in a Web Clipping Portlet

[image: Clipped content in a Web Clipping portlet]

Description of "Figure 28-5 Clipped Content in a Web Clipping Portlet"










	
Note:

The Refresh link in the Web Clipping portlet retrieves data from cache or from the originating web site, depending upon the value you provided for Expires (minutes).












28.2.3 Adding a Web Clipping That Users Can Personalize

This section walks you through a demonstration of how you can enable end users to personalize their own view of the content in a Web Clipping portlet. It includes the following subsections:

	
Section 28.2.3.1, "Selecting a Clipping from OTN"


	
Section 28.2.3.2, "Parameterizing a Web Clipping Portlet"


	
Section 28.2.3.3, "Personalizing a Web Clipping Portlet"






28.2.3.1 Selecting a Clipping from OTN

In this task, you navigate to the Oracle Technology Network (OTN) and search for specific information to clip.

To select a clipping from OTN:

	
In the portlet header, click the Customize icon.

The Find a Web clipping page opens.


	
In the URL Location field, enter the following URL, and click Start:


http://www.oracle.com/technology/products/ias/portal/index.html


OTN displays the Portal page.


	
Enter a search string in the Search field at the top of the page. For this example, enter web clipping portlet, then click the Search icon.

Results display in Web Clipping Studio (Figure 28-6).


Figure 28-6 OTN Search Results in Web Clipping Studio

[image: OTN search results in Web Clipping Studio]

Description of "Figure 28-6 OTN Search Results in Web Clipping Studio"





	
Click Section on the Web Clipping Studio banner.

Web Clipping Studio divides the target web page into clippable sections (Figure 28-7).


Figure 28-7 The Choose Links on an OTN Search Results Page in Web Clipping Studio

[image: Choose link on an OTN page in Web Clipping Studio]

Description of "Figure 28-7 The Choose Links on an OTN Search Results Page in Web Clipping Studio"





	
At the top-left corner of the area that contains the search results (just above the text Revise search), click Choose.

A preview of the search result section opens.


	
Click Select to confirm that the search result section is the one you want to clip.


	
On the Find a Web clipping page, click OK to display the clipped content in the Web Clipping portlet (Figure 28-8).


Figure 28-8 Clipped Content Displayed in Web Clipping Portlet

[image: Clipped content displayed in Web Clipping portlet]

Description of "Figure 28-8 Clipped Content Displayed in Web Clipping Portlet"












28.2.3.2 Parameterizing a Web Clipping Portlet

In this task, you edit the properties of the Web Clipping portlet to enable users to display different search results in the portlet.

To parameterize a Web Clipping portlet:

	
Once you have clipped the OTN search results as described in Section 28.2.3.1, "Selecting a Clipping from OTN," click the Customize icon in the Web Clipping portlet header.


	
In the Find a Web clipping page, modify the following items in the Properties section:

	
From the URL Rewriting dropdown list, choose Inline to specify that link targets open inside the portlet, rather than in a new browser window.


	
In the Title field, enter OTN Search. This title appears in the header of your Web Clipping portlet and on the pages where users can personalize parameters for the web clipping.




Figure 28-9 shows the Properties and Parameterize Inputs sections of the Find a Web clipping page.


Figure 28-9 Web Clipping Properties

[image: Portlet properties on the Find a Web clipping page]

Description of "Figure 28-9 Web Clipping Properties"





	
Because the content displayed in the portlet was reached by entering information in the Search field on OTN, you can customize the parameters used by the search to enable users to specify their own search string.


	
Under the Parameterize Inputs section, select Click to start parameterizing, and make the following changes in the parameters table:

	
In the Parameters column, select keyword from the dropdown list.


	
In the Personalizable column, select Param1 from the dropdown list.


	
In the Display Name column, enter OTN Search.


	
Make sure that Default Value displays web clipping portlet to be sure you have selected the right parameter.





	
Click OK to display the default search results in the Web Clipping portlet.









28.2.3.3 Personalizing a Web Clipping Portlet

In this task, you personalize a Web Clipping portlet to display different search results in the portlet.

To personalize a Web Clipping portlet to display different search results:

	
In the Web Clipping portlet header, click the Personalize icon.




	
Note:

When running a portlet that has an Edit mode, the Personalize option in the portlet header appears only to authenticated users. Unauthenticated or public users do not see the Personalize option. What this means is that, for personalization to work, some form of security must be implemented for your application.
If you are a developer creating portlets and pages, then you may want a quick way to test the Edit mode of your portlet without creating a complete security model for your application. For information about how you can quickly add the necessary security for testing portlet personalization, see the “Configuring Basic Authentication for Testing Portlet Personalization” section in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.










	
In the resulting Find a Web clipping page, scroll down to the Inputs section.

Notice that the parameter field for the search string is labeled OTN Search, as you specified for the Display Name while parameterizing the Web Clipping portlet. (Figure 28-10).


Figure 28-10 A Web Clipping in the Personalize Mode

[image: Parameter input fields on the Find a Web clipping page]

Description of "Figure 28-10 A Web Clipping in the Personalize Mode"





	
In the OTN Search field, enter a different search string.

For example, enter WebCenter.


	
Click OK.

The Web Clipping portlet now displays the search results for WebCenter from OTN.













28.3 Setting Web Clipping Portlet Properties

The Web Clipping portlet has associated properties that control the look and feel of the portlet on the page. Users with sufficient privileges can access these properties through the Component Properties dialog (Figure 28-11).


Figure 28-11 Web Clipping Portlet Component Properties

[image: Component Properties dialog]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 28.3.1, "What you Should Know About Web Clipping Portlet Properties"


	
Section 28.3.2, "Web Clipping Portlet Properties"






28.3.1 What you Should Know About Web Clipping Portlet Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 28.3.2, "Web Clipping Portlet Properties." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






28.3.2 Web Clipping Portlet Properties

Table 28-1 describes the properties that are unique to the Web Clipping portlet.


Table 28-1 Web Clipping Portlet Component Properties

	Property	Description	Location
	
Param#

	
Use to map page parameters to the parameters specified when the Web Clipping portlet was defined. These parameters enable you to contextually wire portlets and pages. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

	
Parameters tab


	
All Modes Shared Screen

	
For Web Clipping, set this property to false to ensure that all portlet modes, except Show, are rendered each on their own page. Setting this property to true may prevent you from editing certain sections of your web clipping in the Web Clipping wizard.

	
Display Options tab


	
Id

	
A unique identifier for the portlet instance.

	
Display Options tab


	
Partial Triggers

	
Use to initialize a partial page refresh, which is a way of refreshing an area of a page without having to redraw the entire page.

	
Display Options tab


	
Render Portlet in I Frame

	
Use to render the portlet in an inline frame (IFRAME), omit an IFRAME, or let the portlet decide. Valid values are:

	
auto (default): The portlet tag checks the portlet response and decides if an IFRAME is required


	
true: Render the portlet instance in an IFRAME


	
false: Render the portlet instance inline




Placing a portlet inline on a page provides a better user experience as compared to placing it in an IFRAME. However, at times, it may be required to include a portlet in an IFRAME. For example:

	
The portlet is a JSF portlet


	
The portlet contains a file upload element


	
The parser throws an exception because it is not able to parse the markup




	
Display Options tab


	
Title

	
Enter a title for the Web Clipping portlet, to display in the portlet header.

	
Display Options tab














28.4 Current Limitations of Web Clipping

When you use Web Clipping, you should be aware of the following limitations: 

	
If the site that you intend to clip uses a large amount of JavaScript to manipulate cookies or uses the document.write JavaScript method to modify the HTML document being written, then you may not be able to clip content from the site.


	
When you integrate with partner applications (by using mod_osso), you cannot clip directly through those partner applications in an authenticated manner. However, you can use partner applications through the external application framework.


	
You cannot use the Web Clipping portlet to clip Oracle Portal pages and ADF pages. As a workaround, reregister the same producer in the destination portal and edit the portal manually.


	
You cannot use the Web Clipping portlet to clip a web page that contains multiple frames, that is, a frameset.


	
Note the following about Web Clipping and the use of a CSS:

	
If a web page contains multiple portlets that use a CSS, then they should not conflict if the CSS uses distinct style names (such as OraRef) to specify a style within an HTML tag, rather than using an HTML tag name (such as <A>) as the name of the style.


	
If one portlet uses a CSS, and that CSS overwrites the behavior of HTML tags by using the name of the tag (such as <A>) as the name of the style, and a second portlet on the same page does not use a CSS, the second portlet is affected by the style instructions of the CSS of the first portlet.


	
If two portlets on the same page use a different CSS and each CSS overwrites the behavior of HTML tags by using the name of an HTML tag (such as <A>) as the name of the style, then the style that is displayed depends on the browser.





	
Web Clipping checks for globalization support settings in the following way:

	
Web Clipping checks the Content-Type in the HTTP header for the charset attribute. If this is present, then it assumes that this is the character encoding of the HTML page.


	
If the charset attribute is not present, then Web Clipping checks the HTML META tag on the page to determine the character encoding.


	
If the HTML META tag is not found, then Web Clipping uses the charset in the previous browsed page. If this is the first page, then it defaults to the ISO-8859-1 character encoding.


	
If the value of the charset for Content-Type or META tag is not supported (for example, if the charset was specified as NONE), then Web Clipping uses the default character set, ISO-8859-1, not the charset in the previously browsed page.





	
To use the Web Clipping portlet, you must use Microsoft Internet Explorer 5.5 or later for Windows 2000, or Microsoft Internet Explorer 6.0 or later for Windows XP. If you use browser versions older than these, then you may encounter JavaScript errors.









28.5 Troubleshooting Web Clipping

This section provides information to help you troubleshoot problems you may encounter while using Web Clipping.


Encountered "x" at line n, column n. Was expecting one of : "x", "y" ...

Parser error message written to the log file.


Problem

The web content displayed in the Web Clipping portlet contains invalid HTML or JavaScript.


Solution

This is a site-specific issue, not a Web Clipping error. Contact the site's administrator for assistance.









Part IX


Organizing Your Collaborative and Social Networking Environment

Part IX of the User's Guide steps through the process of setting up and managing a Home space and creating a social network. It includes details about social networking and collaboration and personal management tasks, such as bookmarking pages and subscribing to application objects.

Part IX includes the following chapters:

	
Chapter 29, "Exploring the Home Space"


	
Chapter 30, "Managing Your Profile"


	
Chapter 31, "Creating Your Social Network"


	
Chapter 32, "Tracking Your Connections' Activities"


	
Chapter 33, "Posting and Managing Messages and Feedback"


	
Chapter 34, "Liking, Commenting On, and Sharing Objects"


	
Chapter 35, "Setting Your Personal Preferences"


	
Chapter 36, "Setting Up Your Personal Subscriptions and Notifications"


	
Chapter 37, "Creating and Managing Your Personal Favorites"


	
Chapter 38, "Creating and Managing Personal Pages"










29 Exploring the Home Space

This chapter provides basic information to get you started in the Spaces application Home space. It includes the following sections:

	
Section 29.1, "What You Can Do In the Home Space"


	
Section 29.2, "Registering Yourself with WebCenter Portal: Spaces"


	
Section 29.3, "Hiding, Opening, and Rearranging Pages"


	
Section 29.4, "Adjusting Your Page View"


	
Section 29.5, "Exposing a Space Page in Your View of the Home Space"


	
Section 29.6, "Renaming a Page"


	
Section 29.7, "Sending a Link to a Page"


	
Section 29.8, "Previewing and Printing an Application Page"


	
Section 29.9, "Viewing Space and Page Information"


	
Section 29.10, "Viewing Your Personal Profile Gallery"


	
Section 29.11, "Accessing WebCenter Portal: Spaces Online Help"





Audience

This chapter is intended for users minimally assigned the role Authenticated-User, that is, any user who is logged in, who wants to understand basic information about Spaces application self-registration, Home spaces, page access, and online help. To create and manage pages in a Home space, you must be granted, minimally, Pages: Create, Edit, and Delete Pages.



29.1 What You Can Do In the Home Space

Provided your portal administrator has granted you the permissions to do so, you can create pages in the Home space, edit those pages, rename them, rearrange them, and add content to them. Such pages are for your view only, unless you specifically share them with other users.

To have page create and manage privileges in the Home space makes almost all of the information in this guide useful to you, no matter your position in your company's hierarchy. For example, you can use the information in Chapter 38, "Creating and Managing Personal Pages," to create and manage your personal pages and to share such pages with the users you specify.




	
Note:

Application administrators may choose to prohibit the creation of personal pages in the Home space, allowing only the display of business role pages and system pages, over which you have less control.







You can use the information in Chapter 17, "Building Pages," to add content to your pages and to configure that content.

You can use the information in Part X, "Working with Content", Part XIII, "Searching WebCenter and Other Sources", Part XV, "Services: Announcements through Links", and Part XVI, "Services: Lists through Worklist" to take advantage of the many services and their associated task flows provided out of the box.




	
Tip:

Some services are active only in spaces other than the Home space. These include such services as Discussions, Events, Announcements, and Lists.







This chapter provides a basic orientation to the types of actions you can take in the Home space. Note that the actions discussed here and in the chapters cited earlier apply primarily to the personal pages you create in the Home space. There are other types of pages, too, over which you have fewer default permissions.

For example, the Home space may contain business role pages, that are provided to you by your application administrator. Business role pages are pushed to your view of the Home space based on your assigned application role. For example, if you are part of the Sales team, there may be a business role page in your view of the Home space that you and all the members of the Sales team can access.




	
See Also:

Section 7.1, "Working with Business Role Pages."







Additionally, there are system pages. System pages are typically utility pages that, in the Home space, either expose your personal view onto a given service, such as the Documents page or the Activity Stream page, or provide an application-wide function, such as the Self-Registration page.




	
See Also:

Section 7.3, "Working with System Pages."







Keep this in mind: though you own and operate your personal pages in the Home space, your application administrator sees all, and can access anyone's personal pages, no matter the security settings you put in place.






29.2 Registering Yourself with WebCenter Portal: Spaces

Your Spaces application administrator may provide the opportunity to self-register to the Spaces application. Self-registration enables you to create your own login credentials and enter the Spaces application from there forward as an authenticated user. The privileges of authentication are many: your own view of the Home space, access to other features based on your assigned user role, a broader range of available interactive features, to name a few.




	
Note:

Whether self-registration is available depends on how your Spaces application administrator configures the application.







To register yourself as a Spaces application user:

	
Open the Spaces application.

For example:


http://host:port/webcenter


Where <host>:<port> refers to the host name and port number of the system where WebCenter Portal: Spaces is installed. By default, the Spaces application is installed on port 8888.


	
Click the Register button on the application Welcome page (Figure 29-1).




	
Note:

Your Spaces application administrator can customize the look and feel of the Login page, but the information depicted in Figure 29-1 is essentially the same whatever the customization.










	
See Also:

Advanced users can extend the Spaces application by customizing, for example, where the Login fields and buttons appear. For more information, see Section 7.3.2, "Customizing System Pages."








Figure 29-1 The Register Button on the Welcome Page

[image: Register button on Welcome page]

Description of "Figure 29-1 The Register Button on the Welcome Page"





	
On the resulting Self-Registration page (Figure 29-2), enter your user information:

Note that fields marked with an asterisk require a value.




	
Tip:

Your application administrator can customize the Self-Registration page, so it may not appear as depicted in Figure 29-2.








Figure 29-2 WebCenter Portal: Spaces Self-Registration Page

[image: Self-Registration page]

Description of "Figure 29-2 WebCenter Portal: Spaces Self-Registration Page"





Before you begin, you should know that the user name and password policy is set by the underlying identity store. Your application administrator may customize the Self-Registration page to include information that explains your organization's user name and password policy.

	
Enter your preferred user name in the Choose User Name field.


	
Click the Check User Name Available button to ensure the uniqueness of your chosen user name.

If the name you entered is in use, provide another user name and test that. Continue this cycle until the check assures you that your entry is unique.


	
Provide a password in the Choose Password field.


	
Reenter the password in the Re-enter Password field.


	
Enter your first name in the First Name field.


	
Enter your last name (that is, your surname) in the Last Name field.


	
Enter your company email address in the Email Address field.




	
Note:

You can create only one user account per email address.











	
Click the Register button.

If the data you entered is accepted, a log-in dialog opens, enabling you to log in to the Spaces application.




	
Note:

By default, if a user name with the same mail ID exists, when you click Register, a dialog opens informing you that the mail ID exists. The dialog includes a button for sending a message to the mail ID associated with the existing user name.
Because you are not yet authenticated, your message is sent to a public mail box, provided your application administrator has configured public mail credentials.

Note that this default behavior may be overridden by customizations provided by your portal developers.

















29.3 Hiding, Opening, and Rearranging Pages

Showing and hiding pages is a user customization. That is, such changes affect only your view of the application. Pages are not simultaneously shown or hidden in other users' application views.

The type of navigation that is in place in a given space affects which steps you take to hide, show, open, and close that space and its pages. Administrators and space moderators can set up navigation as they choose. The procedures in this section are offered as examples of how to hide, show, open, and close spaces and pages and how to rearrange page order. Your methods may differ based on your portal's navigation.

This section includes the following subsections:

	
Section 29.3.1, "Opening Spaces"


	
Section 29.3.2, "Opening Pages"


	
Section 29.3.3, "Hiding Pages"


	
Section 29.3.4, "Showing Hidden Pages"


	
Section 29.3.5, "Rearranging Page Order"






29.3.1 Opening Spaces

Two types of spaces may be available to you in your portal: a space, which is exposed to a group of users who are working toward a common goal, and the Home space, which is for everyone (the application administrator may also provide you with options for creating and managing your own personal pages in the Home space). This section provides examples of how to open both types of space. It includes the following subsections:

	
Section 29.3.1.1, "Accessing the Home Space"


	
Section 29.3.1.2, "Accessing a Space"






29.3.1.1 Accessing the Home Space

This section provides examples of how to access the Home space. Your portal navigation may differ, and may therefore not respond to these approaches. These examples should, nonetheless, provide some ideas for how to go about this action in your own portal.

Examples of ways to access the Home space:

	
Use the following URL:


http://host:port/webcenter/spaces/home


Where <host>:<port> refers to the host name and port number of the system where WebCenter Portal: Spaces is installed. By default, the Spaces application is installed on port 8888.




	
See Also:

For additional URLs to use in navigating to pages, see Appendix A, "Spaces User Interface URLs."








	
Click your user name where it appears as a link in the application, for example, Figure 29-3.


Figure 29-3 Example of a User Name as a Link

[image: Example of user name as link]

Description of "Figure 29-3 Example of a User Name as a Link"





This takes you to the My Profile page in the Home space.


	
Open the Spaces Switcher menu and click Home Space (Figure 29-4).


Figure 29-4 Home Space Option on the Spaces Switcher Menu

[image: Description of Figure 29-4 follows]

Description of "Figure 29-4 Home Space Option on the Spaces Switcher Menu"












29.3.1.2 Accessing a Space

This section provides examples of how you can access spaces other than the Home space. Your portal navigation may differ, and may therefore not respond to all of these approaches. These examples should, nonetheless, provide some ideas for how to go about accessing a space in your own portal.

Examples of ways to access spaces other than the Home space:

	
Use the following URL:


http://host:port/webcenter/spaces/spaceName


In lieu of spaceName, enter the name of the space.

For <host>:<port>, enter the host name and port number of the system where WebCenter Portal: Spaces is installed. By default, the Spaces application is installed on port 8888.




	
See Also:

For additional URLs to use in navigating to pages, see Appendix A, "Spaces User Interface URLs."








	
In any space, open the Spaces Switcher menu and click the name of the destination space, or click Browse Spaces to access the Spaces page (Figure 29-5).


Figure 29-5 Browse Spaces Option on Spaces Switcher Menu

[image: Browse Spaces option on Spaces Switcher menu]

Description of "Figure 29-5 Browse Spaces Option on Spaces Switcher Menu"





You can use the Search feature on this page to locate a specific space.




	
Note:

The way that you open the Spaces Switcher menu depends on the page template in use. For example, you may open it by clicking a menu icon to the right of the space name.

















29.3.2 Opening Pages

You have a few options for opening pages. How you proceed depends on the controls your application administrator or space moderator has made available to you and the navigation model in use. In all configurations, however, you can open pages using a pretty URL or through the Personalize Pages page (Figure 29-6).


Figure 29-6 Personalize Pages Page

[image: Personalize Pages page]

Description of "Figure 29-6 Personalize Pages Page"





To open pages:

	
To open pages in the Home space, use the following URL:


http://host:port/webcenter/spaces/page/escapedPageDisplayName


For <host>:<port>, enter the host name and port number of the system where the Spaces application is installed. By default, the application is installed on port 8888.




	
Tip:

The variable escapedPageDisplayName indicates the use of an escaped version of the page display name. For example, when you create a page with the name My Page, the URL to this page ends with My+Page.








	
To open pages in a space, use the following URL:


http://host:port/webcenter/spaces/spaceName/page/escapedPageDisplayName





	
See Also:

For additional URLs to use in navigating to pages, see Appendix A, "Spaces User Interface URLs."








	
Open the Personalize Pages page, and click the name of the page you want to open (Figure 29-7).


Figure 29-7 Opening a Page through the Personalize Pages Page

[image: Opening a page through Personalize Pages]

Description of "Figure 29-7 Opening a Page through the Personalize Pages Page"












29.3.3 Hiding Pages

As you add pages to spaces, it may become useful to hide some less-frequently-used pages. Once a page is hidden, it is easy to restore it to view (see Section 29.3.4, "Showing Hidden Pages").

To hide a page:

	
Go to the space with pages you want to hide, and open the Personalize Pages page.




	
See Also:

For more information, see Section 29.3.2, "Opening Pages."








	
Clear the Show Page checkbox for each page you want to hide.




	
Note:

If you clear the Show Page checkbox for the current page, the Personalize Pages page closes and the current page is hidden.
Within a particular scope, such as a space or the Home space, one page must always be shown; therefore, you cannot use this method to hide all pages within a particular scope.

















29.3.4 Showing Hidden Pages

To show a hidden page:

	
Go to the space with pages you want to show, and open the Personalize Pages page.




	
See Also:

For more information, see Section 29.3.2, "Opening Pages."








	
Select the Show Page checkbox for each page you want to show.









29.3.5 Rearranging Page Order

In a space, you can use the Personalize Pages page to change the order in which pages are listed or arranged. When you change page order on the Personalize Pages page, you are doing so in your own view only. That is, it is a user customization that affects only your view of the page.




	
Note:

There are two ways of defining the order and the visibility of pages in a space: from the Administration pages (described in Section 7.1.7, "Setting a Default Display Order for Business Role Pages") and from the Personalize Pages page (described here). The difference between the two is that the Administration change is an application customization and the Personalize Pages change is a user customization. Keep in mind that user customizations override application customizations in a given user's view.










	
See Also:

F or more information about user customization, see Section 29.4.1, "What You Should Know About User Customizations on a Page."
For information about the difference between user- and application-level customizations, see Section 17.5.2.1, "What You Should Know About Customizing Page Components."









To rearrange page order:

	
Go to the space with pages to rearrange, and open the Personalize Pages page.




	
See Also:

For more information, see Section 29.3.2, "Opening Pages."








	
Use the icons in the Reorder column to rearrange page order (Figure 29-8).


Figure 29-8 Reorder Icons on the Personalize Pages Page

[image: Reorder icon on the Personalize Pages page]

Description of "Figure 29-8 Reorder Icons on the Personalize Pages Page"







Pages are now arranged in the order you specified.








29.4 Adjusting Your Page View

The Spaces application provides many opportunities for changing your view of a given page. This includes rearranging your view of page content, hiding components, changing your page layout, and the like. All of these options are user customizations, that is, they affect only your view of the application. All other users' views remain unchanged.




	
See Also:

For information about the difference between user- and application-level customizations, see Section 17.5.2.1, "What You Should Know About Customizing Page Components."







This section steps you through the process of adjusting your own page view through user customization. It includes the following subsections:

	
Section 29.4.1, "What You Should Know About User Customizations on a Page"


	
Section 29.4.2, "Performing User Customizations on Your Page View"


	
Section 29.4.3, "Removing All of Your User Customizations from a Page"






29.4.1 What You Should Know About User Customizations on a Page

You can customize the way pages appear in many ways without opening the page editor (Composer). For example, you can reposition, remove, resize, and collapse components, all within just your view of a page.

User customizations are yours and yours alone. That is, the changes you make through the procedures described in the following sections affect only your view of the Spaces application. No other users are affected by your changes.

For example, when you reposition page components in page view mode, that change applies only to your view of the page. Other users may reorganize their own views of pages, and their changes do not affect your view—only their own.




	
Note:

When you revise a component in page view mode while another user deletes the same component in page edit mode, a WebCenter error page opens. Simply navigate back to the original page. The deleted component does not appear, and you can continue working on other components.










	
See Also:

Advanced users with sufficient permission can change everyone's view of a page. For more information, see Section 17.3, "Editing Pages."












29.4.2 Performing User Customizations on Your Page View

Whether you can customize a page depends on permissions granted to you or your application role and on how user customizations are configured. You can tell if you have such permission by the presence or absence of the controls discussed in this section. If you do not see these controls, contact your application administrator to ask for a higher-level of access or for a configuration change.




	
Tip:

An Administrator link for contacting your application administrator may be available to you in the Spaces UI, depending on the design of your portal.







This section describes how to perform the user customizations rearrange, resize, minimize, and maximize. It includes the following subsections:

	
Section 29.4.2.1, "Rearranging Page Content"


	
Section 29.4.2.2, "Removing Components from Your View of a Page"


	
Section 29.4.2.3, "Resizing Components"


	
Section 29.4.2.4, "Collapsing and Expanding Components"






29.4.2.1 Rearranging Page Content

Use drag-and-drop to rearrange the position of a component on a page. Components moved by drag-and-drop can be moved into any open position on a page.

Dragging and dropping is arguably the easiest and least restricted way to rearrange components on a page. Simply drag the component over the spot you want to place it and drop it there. A shadow indicates a receptive drop location (Figure 29-9).


Figure 29-9 Shadow Indicating a Receptive Drop Location

[image: Solid box indicating a receptive drop location]

Description of "Figure 29-9 Shadow Indicating a Receptive Drop Location"





To rearrange components by dragging and dropping:

	
Go to the page of interest.




	
See Also:

For more information, see Section 29.3.2, "Opening Pages."








	
Click and hold the header of the component you want rearrange, drag it to its target position, and drop it onto the page.

A shadow indicates where the component is placed when you drop it (Figure 29-10).


Figure 29-10 Dragging an Issues List Above an Events Task Flow

[image: Dragging to reposition a Task Flow]

Description of "Figure 29-10 Dragging an Issues List Above an Events Task Flow"












29.4.2.2 Removing Components from Your View of a Page

If you find that a component, such as a task flow or portlet, is not useful to you and the component displays a Remove icon (Figure 29-11), you can remove it from your view of the page.


Figure 29-11 Remove Icon on a Task Flow

[image: Remove icon on a task flow]

Description of "Figure 29-11 Remove Icon on a Task Flow"





Keep in mind that you can restore a removed component only by editing the page and adding a new component instance (for more information, see Section 17.5, "Adding Resource Catalog Components to Pages").

To remove a component from your view of a page:

	
Go to the page of interest.




	
See Also:

For more information, see Section 29.3.2, "Opening Pages."








	
Click the Remove icon on the component header (see Figure 29-11).

The component is removed from your view of the page.









29.4.2.3 Resizing Components

The border and header surrounding a component, such as a task flow or a portlet, is also known as chrome. Chrome can clarify the boundaries of the component and provide an access point for component actions, such as those on the Actions menu and those embedded in the chrome itself. In the latter case, the chrome may include a Resize handle that you can use to increase or decrease the height of the component (Figure 29-12).


Figure 29-12 Resize Handle on a Task Flow

[image: Resize handle on a task flow]

Description of "Figure 29-12 Resize Handle on a Task Flow"








	
Note:

The position of the resize handle differs for bidirectionally displayed components. Those components displayed in a right-to-left orientation display the resize handle on the left side.







To use this feature, click and hold the Resize handle and drag it up to decrease the height of the component or down to increase the height of the component.






29.4.2.4 Collapsing and Expanding Components

With one click, you can collapse some components, such as task flows or portlets, so that they roll up like a window shade, leaving only their headers on view (Figure 29-13).


Figure 29-13 Collapsed Task Flow

[image: Collapsed task flow]

Description of "Figure 29-13 Collapsed Task Flow"





With another click, you can expand a collapsed component (Figure 29-14).


Figure 29-14 Collapse/Expand Icon on a Task Flow

[image: Collapse/Expand icon on a task flow]

Description of "Figure 29-14 Collapse/Expand Icon on a Task Flow"





Collapsing is useful for removing the visual noise of an unused component from your application view. Collapse is available when a component shows a header.

To collapse and expand components:

	
Go to the page of interest.




	
See Also:

For more information, see Section 29.3.2, "Opening Pages."








	
Click the Collapse icon on the component header to roll the component up like a window shade (Figure 29-15).


Figure 29-15 Collapse/Expand Icon on a Task Flow

[image: Collapse/Expand icon on a task flow]

Description of "Figure 29-15 Collapse/Expand Icon on a Task Flow"





	
Click the Expand icon on the component header to restore the full component to view (Figure 29-16).


Figure 29-16 Collapsed Task Flow

[image: Collapsed task flow]

Description of "Figure 29-16 Collapsed Task Flow"














29.4.3 Removing All of Your User Customizations from a Page

A control is available for removing all of your user customizations from a selected page. Using this control removes such personal changes as rearrangement, resizing, or collapsing of task flows. It does this in only your view of the page.

To remove all of your user customizations from your view of a page:

	
In the space of interest, open the Personalize Pages page.

For information on how to navigate to this page, see Section 29.3.2, "Opening Pages."


	
From the Actions menu next to the target page, select Reset Layout.


	
In the resulting dialog, click OK.











29.5 Exposing a Space Page in Your View of the Home Space

You can expose some space pages within your view of the Home space. For example, if you would like to keep close track of a space page named Sales Results, you can specify that the Sales Results page should be available in your view of the Home space.




	
Note:

System pages that are exposed in a space, such as Events, Lists, and Announcements, do not provide the option of being exposed in the Home space, nor do wiki and blog pages. For information about System pages, see Section 7.3, "Working with System Pages."







The page is available for viewing and revising from within your view of the Home space according to your permissions on the page. The space name is prepended to the page name, so, in your view of the Home space, the Sales Results page in the space Finance becomes Finance - Sales Results.

If you delete such a page from your view of the Home space, it remains a part of its original space. In other words, deleting it from the Home space simply removes it from your view; it does not actually delete the page. If the page is deleted from its parent space, it is unavailable in your view of the Home space. To clear it from your view, you must refresh the page list in the Home space's Personalize Pages page.




	
Tip:

Personalize Pages is an option on the Page and Spaces Actions menu. How you access this menu depends on your portal design. [image: Page and Spaces Actions menu]

Description of the illustration wcsug_learn_pandsactions.gif







To expose a space page in your view of the Home space:

	
Go to the space that contains the page of interest.




	
See Also:

For more information, see Section 29.3.1, "Opening Spaces."








	
Access the space's Personalize Pages page.


	
Open the Actions menu next to the page of interest, and select Add to Home Space (Figure 29-17).


Figure 29-17 Add to Home Space Option on the Actions Menu

[image: Add to Home Space option on Actions menu]

Description of "Figure 29-17 Add to Home Space Option on the Actions Menu"












29.6 Renaming a Page

When you rename a page, keep in mind that any pretty URLs that use the old name will be broken. Also note that system pages, such as the Announcements, Lists, and Events pages, do not provide the option of being renamed.




	
See Also:

For information about pretty URLs, see Appendix A, "Spaces User Interface URLs."







To rename a page:

	
Go to the space that contains the page of interest.




	
See Also:

For more information, see Section 29.3.1, "Opening Spaces."








	
Access the space's Personalize Pages page.


	
Open the page's Actions menu, and select Rename Page (Figure 29-18).


Figure 29-18 Rename Page Option on Actions Menu

[image: Rename Page option on Actions menu]

Description of "Figure 29-18 Rename Page Option on Actions Menu"





	
Revise the page name, and click Save.









29.7 Sending a Link to a Page

To send a link to a page:

	
Go to the space that contains the page of interest.




	
See Also:

For more information, see Section 29.3.1, "Opening Spaces."








	
Open the space's Personalize Pages page.


	
Open the page's Actions menu, and select Send Mail (Figure 29-19).


Figure 29-19 Send Mail Option on Actions Menu

[image: Send Mail option on Actions menu]

Description of "Figure 29-19 Send Mail Option on Actions Menu"





A compose mail window containing the URL to the current page opens. Compose and send the message as you would any other mail message.




The compose message window opens either in your native mail application or in the Spaces application mail compose window, depending on how your application administrator has configured this feature. If the administrator has made such controls available to users, you may define for yourself which mail client opens. For more information, see Section 65.3, "Selecting Your Preferred Mail Connection."






29.8 Previewing and Printing an Application Page

Use the Print Preview option to preview and print pages that largely contain text. Print options are useful for pages where content is mainly text, such as the Announcements page, wiki and blog pages, and other custom pages comprised primarily of text.

Note that the Print Preview link may not be present if your application designer has not made it available.




	
See Also:

For information about the Print Preview link, see Section 13.2.27, "Print Preview."







To preview and print an application page:

	
Go to the space that contains the page of interest.




	
See Also:

For more information, see Section 29.3.1, "Opening Spaces."








	
Click the page's Print Preview link.

A printable version of the page opens in a new browser tab or window. Print the page by pressing Ctrl-P, or simply preview the page.









29.9 Viewing Space and Page Information

Every space and every page has associated information, called metadata. space and page metadata include such information as display name, internal identification (GUID), description, membership role (spaces only, that is, not the Home space), user name of the creator, date created, and direct URL.

This section provides information about how to access space and page information. It includes the following subsections:

	
Section 29.9.1, "Accessing Space Information"


	
Section 29.9.2, "Accessing Page Information"






29.9.1 Accessing Space Information

To access information about a space:

	
Go to the Spaces page.




	
See Also:

For information about accessing the Spaces page, see Section 29.3.1.2, "Accessing a Space."








	
Right-click the space of interest, and select About and then About this Space (Figure 29-20) to open the About Space dialog (Figure 29-21).


Figure 29-20 About this Space Option on Space Context Menu

[image: About this Space option on context menu]

Description of "Figure 29-20 About this Space Option on Space Context Menu"






Figure 29-21 About Space Dialog

[image: About Space dialog]

Description of "Figure 29-21 About Space Dialog"





	
Click OK to close the dialog.









29.9.2 Accessing Page Information

To access information about a page from the Personalize Pages page:

	
Go to the Personalize Pages page in the Home space or the space that includes the page of interest.




	
Tip:

Personalize Pages is an option on the Page and Spaces Actions menu. How you access this menu depends on your portal design. [image: Page and Spaces Actions menu]

Description of the illustration wcsug_learn_pandsactions.gif








	
Open the page's Actions menu (Figure 29-22), and select About This Page to open the Page Information dialog (Figure 29-23).


Figure 29-22 About this Page Option on Personalize Pages Page

[image: About this Page option]

Description of "Figure 29-22 About this Page Option on Personalize Pages Page"






Figure 29-23 Page Information Dialog

[image: Page Information dialog]

Description of "Figure 29-23 Page Information Dialog"





	
Click OK to close the dialog.











29.10 Viewing Your Personal Profile Gallery

When you log in to the Spaces application, you may notice your user name at some position in the application user interface. Click this to open your personal profile gallery (Figure 29-24).


Figure 29-24 Profile Page

[image: Profile page]

Description of "Figure 29-24 Profile Page"





Your personal profile gallery presents a series of tabs, each devoted to information of interest to you:

	
Activities—Provides a Publisher, which you can use to make statements about your personal status and provide links to external or internal objects; and an Activity Stream, which streams information about the activities of you and your connections. For more information, see Chapter 32, "Tracking Your Connections' Activities," and Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Connections—Provides a view of all of your connections and features for managing your connections. Chapter 31, "Creating Your Social Network."


	
Documents—Provides a view of your personal document library. For more information, see Part X, "Working with Content".


	
Organization—An organization chart that depicts you and the organization members directly associated with you. For more information, see Chapter 30, "Managing Your Profile."


	
About—Your personal profile details. For more information, see Chapter 30, "Managing Your Profile."









29.11 Accessing WebCenter Portal: Spaces Online Help

Wherever you see a Help link or a Help button, click it to access help.

The Help link (Figure 29-25) opens the application's main help page. From there, you can navigate to topics of interest.


Figure 29-25 Help Link

[image: Help link]

Description of "Figure 29-25 Help Link"





Help buttons, located throughout the application, open help topics that describe what is currently shown.


Figure 29-26 Help Button

[image: Help button]

Description of "Figure 29-26 Help Button"












30 Managing Your Profile

In WebCenter Portal: Spaces, your Profile is a collection of useful data about you. It can include contact information, a photo, your location within the company hierarchy, and so on. The social networking capabilities in WebCenter Portal: Spaces enable you to view and manage your own Profile and to view the Profiles of others if they have made them available to you.

This chapter provides an overview of Profile-related features and steps you through the process of Profile viewing and managing. It includes the following sections:

	
Section 30.1, "What You Should Know About Profile"


	
Section 30.2, "Specifying a Management Chain for Organization View"


	
Section 30.3, "Setting Profile Preferences"


	
Section 30.4, "Adding a Profile Task Flow to a Page"


	
Section 30.5, "Viewing and Editing Personal Profiles"


	
Section 30.6, "Setting Profile Task Flow Properties"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission Update People Connections Data. Users who plan to edit task flow properties must be assigned a role that also includes the permission Pages: Edit Pages. In a space (other than the Home space), users must be assigned a role that includes the permission Edit Page Access and Structure.



30.1 What You Should Know About Profile

Profile provides a variety of views into your own and other users' personal profile information. Such information can include your mail address, phone number, office location, department, manager, direct reports, and so on. In a typical WebCenter Portal: Spaces installation, Profile takes the bulk of its information from the back-end identity store that provides your WebCenter application with its users (for more information, see Section 30.2, "Specifying a Management Chain for Organization View"). Additionally, Profile may offer opportunities for altering some of this information and for providing additional data not included in the identity store.

When you connect with other users, you give them access to your Profile, and gain access to theirs. You can control how much of your Profile a connection can view through Profile Preferences. For information about setting your Profile Preferences, see Section 30.3, "Setting Profile Preferences."

Before you access your Profile or Profile Preferences, your application administrator can set global application defaults that affect what all users may see and do with their own and other users' Profiles. For more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."

You can access a view of a Profile, including your own, by clicking a user name wherever you see it in WebCenter Portal: Spaces. In addition to brief, popup views of user Profiles, you can see a full view of your Profile on the WebCenter Portal: Spaces Profile page. The Profile page is a business role page that is pushed to all authenticated users' views of the Home space (Figure 30-1).


Figure 30-1 Profile Page

[image: Profile page]






	
Tip:

Authenticated users are users who are logged in to WebCenter Portal: Spaces.










	
See Also:

For information about business role pages, see Section 7.1, "Working with Business Role Pages."







By default, the Profile page presents a series of subpages that include your view of the Activity Stream (Activities), a detailed view of your connections (Connections), a view of the documents and folders in the Public folder of your personal document library (Documents), a chart view of your location within the organization (Organization), and a view of your full Profile (About).

Of all of these subpages, only Organization and About pull their content from the identity store and belong to the Profile family of task flows. The other subpages pull their content from other features and services as follows:

	
Activities comes from the Activity Stream feature of the People Connections service (for more information, see Chapter 32, "Tracking Your Connections' Activities")


	
Connections comes from the Connections feature of the People Connections service (for more information, see Chapter 31, "Creating Your Social Network")


	
Documents comes from the Documents service (for more information, see Part X, "Working with Content".




Your portal designer can revise the default Profile business role pages to include additional components, remove existing components, and revise the page look and feel. Consequently, the page described here may finally have little to do with the final Profile page that you see.




	
See Also:

For information about revising business role pages, see Section 7.1, "Working with Business Role Pages."







In addition to Profile business role pages, Profile provides several task flows that each offer a unique view of a user's Profile information. Provided you have edit permission on a page, you can place a Profile task flow wherever you find it of use.

Profile provides the following task flows:

	
Organization View for a graphical depiction of the current user's position within the company—that is, a detail of the overall organization chart. In Organization View, you can cycle through three views of the current user's Profile information, including contact information; the user's address and the current time in the user's locale; and a summary About Me statement. It also provides a link to a full-blown profile of the current user (Figure 30-2).


Figure 30-2 Organization View Task Flow

[image: Organization View task flow]






	
See Also:

For information about enabling a hierarchical view of your organization, as depicted in Figure 30-2, see Section 30.2, "Specifying a Management Chain for Organization View."








	
Profile for displaying a user's profile details, uploading a photo, and (if enabled) editing Profile details (Figure 30-3)


Figure 30-3 Profile Task Flow

[image: Profile task flow]



	
Profile Gallery for accessing all of your social networking information from one view (Figure 30-4)


Figure 30-4 Profile Gallery Task Flow

[image: Profile Gallery task flow]



	
Profile - Snapshot for viewing a user photo and status message (Figure 30-5)


Figure 30-5 Profile - Snapshot Task Flow

[image: Profile Snapshot task flow]








	
See Also:

For information about working with Profile task flow features, see Section 30.5, "Viewing and Editing Personal Profiles."







Profile task flows have associated properties that you can use to control the appearance and behavior of a task flow instance. For example, you can use Profile properties to specify that the statements you enter into a Publisher task flow (see Section 33.1.1, "What You Should Know About Message Board") are included in those Profile views that provide a status message. You can control whether a Profile allows the display of a photo and whether the photo can be updated in page view mode.




	
See Also:

For more information about Profile properties, see Section 30.6, "Setting Profile Task Flow Properties."







For information about using Profile features, see Section 30.5, "Viewing and Editing Personal Profiles."






30.2 Specifying a Management Chain for Organization View

The Organization View task flow and the Organization subpage on a Profile page can provide a visualization of your management chain, that is, they can render a view of a manager and the manager's direct reports (Figure 30-6).


Figure 30-6 Organization View of a Manager and the Manager's Direct Reports

[image: Organization view of manager and direct reports]

Description of "Figure 30-6 Organization View of a Manager and the Manager's Direct Reports"





Organization views of a user profile are available on a user's Profile page—on the Organization subpage—and through the Organization View task flow. By default, the values that define the management chain for these organization views are blank. This means that managers are not automatically specified for users in the back-end identity store that provides user details.




	
Tip:

The value for Manager on the Profile page's About subpage is also defined by the methods suggested in this section.







For the management chain to be rendered in organization views, the back-end identity store that is used for WebCenter Portal: Spaces authentication must be set up in such a way that direct report users have a manager attribute. And the manager attribute must be defined as the Distinguished Name (DN) of their manager user (see "Example Embedded LDAP Configuration").




	
Tip:

In an LDAP environment, a user can be managed by only one person; in the same environment, a user can manage many people.








Example Embedded LDAP Configuration

You can specify a management chain within the Oracle WebLogic Server (WLS) embedded LDAP or within an external LDAP, such as Oracle Internet Directory (OID). Note, however, that the management chain you define through the embedded LDAP is for testing or proof of concept and not for production. For production, you must use an external LDAP, such as OID, for the identity store for WebCenter Spaces authentication.




	
See Also:

For more information, see the chapter "Configuring the Identity Store," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal, or refer to the documentation provided with your LDAP implementation.







This example describes how to define a management chain within the embedded LDAP in WebLogic Server for testing or proof of concept.




	
Note:

The steps provided in this example are similar to those you take for an external LDAP. That is, you create an attribute (manager) and set a value on the attribute for each user. For this value, enter the DN of the selected user's manager.







In this example, there are three users:

	
user1


	
user2


	
manager_user




To define a management chain with these users:

	
Enable browsing of the embedded LDAP using an external viewer, such as Apache Directory Studio:

	
Go to the WLS Administration Console, and log in as the administrator user.


	
Click your domain, for example, wc_domain, then open the Security Tab and then the Embedded LDAP Sub-tab (Figure 30-7).


Figure 30-7 Oracle WebLogic Server Administration Console

[image: Partial view of the WLS Administration Console]

Description of "Figure 30-7 Oracle WebLogic Server Administration Console"





	
Enter a value in the Credential field, and then reenter that value in the Confirm Credential field.




	
Tip:

The default credential is a randomly generated password. Set it to something memorable.








	
Restart your administration and managed servers.





	
Start up the LDAP viewer you selected in Step 1, and create a connection using the following details:

	
hostname (for example, example.com)


	
port (the WLS administration port, for example 7001)


	
Bind DN (cn=Admin)


	
Password (that is, the credential you set in Step 1c)





	
Navigate to user1 by finding the users within the DIT tree (Figure 30-8).

For example, click in succession:

	
dc=wc_domain


	
ou=myrealm


	
ou=people


	
uid=user1





Figure 30-8 Selecting a User in the DIT Tree of an LDAP Browser

[image: DIT tree in an LDAP browser]

Description of "Figure 30-8 Selecting a User in the DIT Tree of an LDAP Browser"





	
In the Attribute Description column, add a new attribute of type manager.




	
Tip:

Press Ctrl-Shift-+ to open the New Attribute dialog.








	
For the attribute value, choose the DN for manager_user (Figure 30-9).

For example, under the root choose in succession:

	
dc=wc_domain


	
ou=myrealm


	
ou=people


	
uid=manager_user





Figure 30-9 Select DN Dialog

[image: Select DN dialog]

Description of "Figure 30-9 Select DN Dialog"





	
Repeat Steps 3 through 5 for user2.




Now user1 and user2 are managed by manager_user. You can check this by logging in to WebCenter Portal: Spaces as user1 and navigating to the About subpage of the My Profile page. The user manager_user is displayed as the manager (Figure 30-10).


Figure 30-10 About Subpage of the My Profile Page

[image: About subpage of the My Profile page]

Description of "Figure 30-10 About Subpage of the My Profile Page"








	
Tip:

Click the value for Manager (in this example, manager_user) to view the manager's profile. Access the Organization subpage to see the organization view associated with the currently viewed profile (see Figure 30-6).












30.3 Setting Profile Preferences

The Profile details that are affected by your Preferences settings appear in your full Profile view, for example, in the Profile task flow and on the About subpage of the default My Profile business role page (Figure 30-11).


Figure 30-11 About Subpage on Profile Page

[image: About subpage on Profile page]



Full profiles are presented in four sections: Summary, Employee, Business Contact, Personal Information. Each section provides information related to the section heading. For example, Summary includes a collection of basic details, such as your user name, mail address, and office location.




	
Note:

Your portal administrator can control every users' access to their own Profile information. For example, the administrator can control whether a Profile section is shown, whether a given section is editable, and who can see what Profile information. Consequently, the control you can exercise over your own Profile preferences is determined by the actions of your administrator. For more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."
Only the administrator can control access to the Summary section. For more information, see Section 6.4.3.4, "Configuring Profile."









Use Profile preferences to specify who can view different types of information associated with your personal profile.

To set Profile preferences:

	
Open the Preferences dialog.


	
Click People Connections to display People Connections preferences.


	
Click the Profile tab to bring it forward (Figure 30-12).


Figure 30-12 Profile Preferences

[image: Profile Preferences]



For each section of your personal profile, specify the users who can view it:

	
Everyone—All users, including users who are not logged in, can view the associated section of your Profile.


	
Authenticated Users—Only users who are logged in can view the associated section of your Profile.


	
User's Connections—Only you and your connections can view the associated section of your Profile.


	
User Only—Only you can view the associated section of your Profile.





	
Click OK.









30.4 Adding a Profile Task Flow to a Page

For the steps to add a Profile task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






30.5 Viewing and Editing Personal Profiles

Profile task flows provide quick access to contact and status information about you and your connections. This section describes how to use the features offered through Profile task flows. It includes the following subsections:

	
Section 30.5.1, "Viewing Profile Details"


	
Section 30.5.2, "Editing Your Personal Profile"


	
Section 30.5.3, "Uploading and Updating a Personal Profile Picture"







	
See Also:

Advanced users can extend WebCenter Portal: Spaces by customizing user Profile attributes. For more information, read the white paper, "Using WebCenter Portal: Spaces Extension Samples (11.1.1.4.0)," available on the Oracle Technology Network at http://www.oracle.com/technetwork/index.htm.









30.5.1 Viewing Profile Details

You can view your full profile details by clicking your user name, provided it appears in the application chrome. For example, in Figure 30-13 the user name Josie Smith appears at the top of the application.


Figure 30-13 User Name at Top of Application

[image: User name at top of application]



On the resulting page, click the About tab to view your full profile details (Figure 30-14).


Figure 30-14 About Subpage on Profile Page

[image: About subpage on Profile page]



You can view summary profile details for yourself, all of your connections, and all of the members of the spaces for which you have access (through the Members task flow) simply by clicking a user name wherever it appears in the application context. Clicking a name opens a Profile popup (Figure 30-15).


Figure 30-15 Profile Popup

[image: Profile popup]



In some application contexts, such as in a Document Library or on an announcement, a context menu opens in lieu of a Profile popup. Click the user name and select View Profile Gallery from the resulting context menu (Figure 30-16) to access a view of the user's profile gallery.


Figure 30-16 View Profile Gallery Option on the Documents Page

[image: View Profile Gallery option on Documents page]







30.5.2 Editing Your Personal Profile

Your application administrator determines how much of your personal profile you may revise (for more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."). When you have permission to revise your Profile, an Edit link is shown on the Profile page (Figure 30-17).


Figure 30-17 Edit Button on a Profile

[image: Edit button on a Profile]



Click the Edit button to open an edit view of your personal profile.




	
Note:

Even when your application administrator has enabled the editing of a particular Profile section, all fields in that section may not be editable.







To edit your personal profile:

	
Open your Profile page.




	
See Also:

For more information, see Section 30.5.1, "Viewing Profile Details."








	
Click Edit to open your Profile in edit mode (Figure 30-18).


Figure 30-18 Profile in Edit Mode

[image: Profile in edit mode]



	
Make your changes, and click Save.









30.5.3 Uploading and Updating a Personal Profile Picture

Provided the Profile task flow is configured to allow it, users with a personal Profile can upload or update their Profile image.




	
Note:

The file must have the mime-type image, and cannot have the extension *.ico.
The task flow property Allow photo upload must be set to #{true}. For more information, see Section 30.6, "Setting Profile Task Flow Properties."









To upload or update your profile image:

	
Open your Profile page.




	
See Also:

For more information, see Section 30.5.1, "Viewing Profile Details."








	
Click the Change Photo link to open the Upload Photo dialog (Figure 30-19).


Figure 30-19 Change Photo Link and Upload Photo Dialog

[image: Change Photo link and Upload Photo dialog]



	
Click Browse to locate and select a photo.


	
Click OK to complete the upload.




When you update your profile photo (as opposed to providing a new one), additional dialogs may come into play. When you click the Change Photo link, the Upload Photo dialog opens, displaying the name of the current file along with an Update button (Figure 30-20).


Figure 30-20 Upload Photo Dialog (Update Photo)

[image: Upload Photo dialog for updating a photo]



Click Update to open the Upload Photo dialog depicted in Figure 30-19, and complete the process as described in this section.








30.6 Setting Profile Task Flow Properties

Profile task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 30-21).


Figure 30-21 Profile Task Flow Component Properties Dialog

[image: Profile task flow Component Properties dialog]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with Profile task flows and describe the properties available on the Parameters tab:

	
Section 30.6.1, "What You Should Know About Profile Task Flow Properties"


	
Section 30.6.2, "Profile Task Flow Parameters"


	
Section 30.6.3, "Using Properties to Configure a Profile Task Flow Instance"






30.6.1 What You Should Know About Profile Task Flow Properties

When you set property values on a Profile task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog can affect the default task flow content. For descriptions of the parameters on this tab, see Section 30.6.2, "Profile Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














30.6.2 Profile Task Flow Parameters

Table 30-1 describes the parameters that are unique to Profile task flows.


Table 30-1 Profile Task Flow Parameters

	Parameter	Description
	
Allow photo upload

	
A Boolean value representing whether the task flow exposes a means of uploading a profile photo

Check for #{true}, clear for #{false}.

This parameter is associated with the Profile - Snapshot task flow.


	
Allow status update

	
A Boolean value representing whether the Profile - Snapshot task flow exposes a means of entering a personal status message

Check for #{true}, clear for #{false}.

If status updates are enabled (#{true}), users can enter updates through an embedded Publisher task flow. For information about the Publisher task flow, see Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow."

This parameter is associated with the Profile – Snapshot task flow.


	
Control Panel Shown

	
A Boolean value representing whether a control panel for manipulating the style, alignment, and size of the content is available on the runtime task flow instance

Check for #{true}, clear for #{false}.

This parameter is associated with the Organization View task flow.


	
Edit Mode

	
A means of determining whether to display Profile details as editable without requiring specific navigation to an editable view

	
Enter #{true} to always show Profile details in edit mode.


	
Enter #{false} to show Profile details as read-only.




When the value is set to #{false}, users click an Edit button to take Profile details into edit mode. Note that this parameter is recognized only if the parameter sectionWiseEditEnabled is set to #{false}.

This parameter is associated with the Profile task flow.


	
Image Size

	
The size of the Profile photo to show

Values can be one of: ORIGINAL, LARGE, MEDIUM, SMALL.

This parameter is associated with the Profile – Snapshot task flow.


	
Org Bread Crumbs Shown

	
A Boolean value representing whether a breadcrumbs component delineating the user's upward path in the organization hierarchy is shown

Check for #{true}, clear for #{false}.

This parameter is associated with the Profile - Snapshot task flow.


	
Profile Edit Link Shown

	
A Boolean value representing whether a link to edit the user Profile is shown

Check for #{true}, clear for #{false}.

This link does not perform any operation, but instead leads to a region navigation event (to the same view), which the consumer can listen to and perform navigation appropriately.

Out of the box, the My Profile business role page, which contains the Profile - Snapshot task flow, is wired to the Profile task flow on the About subpage. Upon receiving a region navigation event from the Profile - Snapshot task flow, clicking the Edit link switches the Edit Mode parameter of the Profile task flow on the About subpage, effectively toggling the mode. Because of this out-of-the-box wiring, the Edit link works on the My Profile business role page. If you plan to expose the Profile Edit link, you must retain the code to listen to the region navigation event and provide the same type of wiring to the target task flow.

This parameter is associated with the Profile - Snapshot task flow.


	
Profile ID

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Profile task flow.


	
Resource Id

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Profile Gallery task flow.


	
Section-Wise Edit Enabled

	
A means of enabling or disabling section-by-section edit capability on the task flow

	
Enter #{true} to enable section-by-section editing. An Edit button is shown on each editable Profile section.


	
Enter #{false} to disable section-by-section editing. One Edit button is shown for the whole task flow.




This parameter is associated with the Profile task flow.


	
User Id

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Organization View task flow.


	
User Name

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Profile - Snapshot task flow.












30.6.3 Using Properties to Configure a Profile Task Flow Instance

This section provides examples of how you use property values to affect the behavior of a given task flow instance. It includes the following subsections:

	
Section 30.6.3.1, "Change Profile Photo in Profile - Snapshot Task Flow"


	
Section 30.6.3.2, "Post a Status Update"


	
Section 30.6.3.3, "Expose Additional Controls in Organization View"


	
Section 30.6.3.4, "Enable Continuous Edits of Profile Details"


	
Section 30.6.3.5, "Setting Size of Profile Images in Profile - Snapshot Task Flow"


	
Section 30.6.3.6, "Exposing Navigational Breadcrumbs in Profile - Snapshot"


	
Section 30.6.3.7, "Enabling Section-By-Section Profile Editing"






30.6.3.1 Change Profile Photo in Profile - Snapshot Task Flow

Use the property Allow photo upload to enable users to upload their own Profile photos in an instance of the Profile - Snapshot task flow. Photos uploaded to Profile - Snapshot are persisted to all other Profile task flows that expose a photo.

To enable users to change their Profile photo in the Profile - Snapshot task flow:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Allow photo upload:

	
Select the checkbox (#{true}) to enable users to change their Profile photo on the task flow instance. When you apply this change, Upload and Refresh controls appear close to the photo display area (Figure 30-22).


Figure 30-22 Upload and Refresh Icons on Profile - Snapshot Task Flow

[image: Upload and Refresh icons on task flow]



	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









30.6.3.2 Post a Status Update

Use the property Allow Status Update to show or hide a means of entering a personal status message in the Profile - Snapshot task flow. If status updates are enabled, users can enter their status messages through an embedded Publisher task flow (Figure 30-23).


Figure 30-23 Publisher Task Flow in Profile - Snapshot

[image: Publisher task flow in Profile - Snapshot]






	
See Also:

For information about the Publisher task flow, see Section 34.3.3.1, "What You Should Know About the Publisher Task Flow."







When this property is enabled, whenever the current user posts a status message using the Publisher task flow, it is also posted as a Profile status message to Profile - Snapshot, Profile Gallery, and Profile task flows.

To enable users to post a status update to their Profile:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Allow Status Update:

	
Select the checkbox (#{true}) to expose controls for updating Profile status in the Profile - Snapshot task flow.


	
Clear the checkbox (#{false}) to hide this feature.





	
Click OK.









30.6.3.3 Expose Additional Controls in Organization View

The Organization View task flow provides additional controls for manipulating your view of task flow content (Figure 30-24).


Figure 30-24 Control Panel Shown in Organization View

[image: Control panel shown in Organization View]



Use additional controls to zoom in and out and select a display format.

Use the property Control Panel Shown to expose these controls in an instance of the Organization View task flow.

To expose additional controls in an Organization View task flow:

	
Edit the properties of an Organization View task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Control Panel Shown:

	
Select the checkbox (#{true}) to expose the Organization View control panel.


	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









30.6.3.4 Enable Continuous Edits of Profile Details

Use the property Edit Mode to enable users to edit Profile details without having to specifically enter an edit mode. Users navigate to the task flow instance and make changes to editable fields without having to first click an Edit button or link.




	
Note:

This parameter is recognized only if the parameter sectionWiseEditEnabled is set to #{false}. For more information, see Section 30.6.3.7, "Enabling Section-By-Section Profile Editing."







To enable continuous edits of Profile details:

	
Edit the properties of a Profile task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Edit Mode:

	
Enter #{true} to always show Profile details in edit mode.


	
Enter #{false} to disable this feature. When the value is set to #{false}, users click an Edit button to take Profile details into edit mode.





	
Click OK.









30.6.3.5 Setting Size of Profile Images in Profile - Snapshot Task Flow

Use the property Image Size to specify the display size of images that are uploaded through a Profile - Snapshot task flow. The value you enter affects the size of the photo in only the given task flow instance. No other types of Profile task flows and no other task flow instances are affected.

To set the size of a Profile image in the Profile - Snapshot task flow:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Enter a value for the property Image Size:

	
ORIGINAL (Figure 30-25)


Figure 30-25 Image Size Set to ORIGINAL

[image: Image Size set to ORIGINAL]



	
SMALL (Figure 30-26)


Figure 30-26 Image Size Set to SMALL

[image: Image Size set to SMALL]



	
MEDIUM (Figure 30-27)


Figure 30-27 Image Size Set to MEDIUM

[image: Image Size set to MEDIUM]



	
LARGE (Figure 30-28)


Figure 30-28 Image Size Set to LARGE

[image: Image Size set to LARGE]






	
Click OK.









30.6.3.6 Exposing Navigational Breadcrumbs in Profile - Snapshot

Use the property Org Bread Crumbs Shown to enable the display of breadcrumbs that visualize the current users position in the organization hierarchy (Figure 30-29).


Figure 30-29 Breadcrumbs in Profile - Snapshot Task Flow

[image: Breadcrumbs in Profile - Snapshot task flow]



Users can click a name in the hierarchy to navigate to a view of that user's Profile.

To expose navigational breadcrumbs in a Profile - Snapshot task flow:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Set a value for Org Bread Crumbs Shown:

	
Select the checkbox (#{true}) to expose hierarchical breadcrumbs.


	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









30.6.3.7 Enabling Section-By-Section Profile Editing

Use the Section-Wise Edit Enabled property to specify whether section-by-section editing is enabled, exposing Edit buttons on each editable section of a Profile task flow instance, or disabled, exposing only a single Edit button for the entire Profile (Figure 30-30).


Figure 30-30 Section-Wise Edit Enabled Parameter Enabled

[image: Enabled Section-Wise Edit Enabled parameter]






	
Note:

Whether Profile details are editable in all Profile task flow instances is determined by your application administrator. For more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."







To enable section-by-section editing in a Profile task flow instance:

	
Edit the properties of a Profile task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Set a value for Section-Wise Edit Enabled:

	
Enter (#{true}) to enable section-by-section editing of the Profile task flow instance. Edit buttons are shown on each details section.


	
Clear the checkbox (#{false}) to disable section-by-section editing of the Profile task flow instance. One Edit button is shown for all Profile details.





	
Click OK.
















31 Creating Your Social Network

In WebCenter Portal: Spaces, Connections provides a means of establishing a social network that is comprised of your work friends and associates. Once you have connected with others, you can set up your working environment to provide different levels of access to those who are and are not connected to you. For example, you can enable access to your views of Profile, Message Board, Activity Stream, and Feedback to just your connections, leaving the unconnected without access. For Message Board and Feedback, you can give everyone view access, but limit post access to just your connections or to a limited set of your connections through a connections list.

This chapter provides an overview of Connections task flows and steps you through the tasks you can accomplish using them. It includes the following subsections:

	
Section 31.1, "What You Should Know About Connections"


	
Section 31.2, "Setting Connections Preferences"


	
Section 31.3, "Adding a Connections Task Flow to a Page"


	
Section 31.4, "Setting Up Your Social Network"


	
Section 31.5, "Setting Connections Task Flow Properties"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission People Connections: Connect with People. To work with connections lists, users must also be granted the permission People Connections: Update People Connections Data.

Users who plan to edit task flow properties must be assigned a role that also includes the permission Edit Pages. In a space (other than the Home space), users must be assigned a role that includes the permission Edit Page Access and Structure.



31.1 What You Should Know About Connections

Connections provides a means of collecting your business friends and contacts into a social network. It furnishes tools for managing your own connections and viewing the connections of others. Using People Connections Preferences, you can grant differing levels of access to those who are and are not your connections. For example, you can limit view privileges on your Profile to just your connections or enable your connections to view certain sections of your Profile, while hiding those sections from users who are not your connections.




	
See Also:

For information about setting your Connections Preferences, see Section 31.2, "Setting Connections Preferences."







When you connect with other users, you give them access to your People Connections views, and gain access to theirs.




	
Note:

The People Connections service encompasses Connections, Profile, Activity Stream, Message Board, and Feedback. For more information, see:
	
Chapter 30, "Managing Your Profile"


	
Chapter 32, "Tracking Your Connections' Activities"


	
Chapter 33, "Posting and Managing Messages and Feedback"












Before you begin to build your social network, your application administrator can set global application defaults that affect what all users may see and do with their own and other users' connections. For more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."

WebCenter Portal: Spaces provides the following Connections task flows:

	
Connections for viewing and managing your connections, creating connections lists, and sending and responding to invitations to connect (Figure 31-1)


Figure 31-1 Connections Task Flow

[image: Connections task flow]



	
Connections - Card for photos, status messages, and instant contact options to your connections (Figure 31-2)


Figure 31-2 Connections - Card Task Flow

[image: Connections - Card task flow]



	
Connections - Detailed View for photos and quick access to your connections and to features for inviting new connections, managing existing connections, and organizing your connections into lists (Figure 31-3)


Figure 31-3 Connections - Detailed View Task Flow

[image: Connections - Detailed View task flow]



	
Connections - Quick View for photos and quick access to your connections (Figure 31-4)


Figure 31-4 Connections - Quick View Task Flow

[image: Connections - Quick View task flow]





Connections task flows have associated properties that you can use to control the appearance and behavior of a task flow instance. For example, you can use Connections properties to specify the number of connections to show or the number of rows to show in Connections - Card and Connections - Quick View task flows.




	
See Also:

For more information about Connections properties, see Section 31.5, "Setting Connections Task Flow Properties."







For information about using Connections features, see Section 31.4, "Setting Up Your Social Network."






31.2 Setting Connections Preferences

You use Connections Preferences to specify who can view information about the people you have connected with and whether to accept invitations to be others' connections automatically.

To set Connections preferences:

	
Click the Preferences link next to the Administration link. This opens the Preferences dialog.


	
Click People Connections to display People Connections preferences.


	
Click the Connections tab to bring it forward (Figure 31-5).


Figure 31-5 Connections Preferences

[image: Connections Preferences]



	
From the Grant View Access to dropdown list, select the users who can view your list of connections:

	
Everyone—All users, including users who are not logged in, can see information about your connections.


	
Authenticated Users—Only users who are logged in can view your connections.


	
User's Connections—Only you and your Connections can view your connections.


	
User Only—Only you can view your connections.







	
Note:

The Grant View Access to dropdown is disabled in your view if the administrator disables user override for these settings in Connections configuration settings. For more information, see Section 6.4.3.3, "Configuring Connections."








	
Select Accept Invitations Automatically to automatically accept invitations to connect with another user.

Clear this checkbox to leave yourself the option of accepting, refusing, or ignoring an invitation to connect with another user.


	
Click OK.









31.3 Adding a Connections Task Flow to a Page

For the steps to add a People Connections service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






31.4 Setting Up Your Social Network

Connections provides the core features for building and visualizing your social network. Use Connections task flows to invite other users to connect, to accept connection invitations, to create connections lists, and to remove obsolete connections.




	
Note:

The level of access you have to a connection is determined by the People Connections defaults set by the application administrator, a given connection's People Connections Preference settings, and properties set on a Connections task flow instance.
For information about Connections Preferences, see Section 31.2, "Setting Connections Preferences." For information about People Connections defaults set by the application administrator, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application." For information about Connections task flow properties, see Section 31.5, "Setting Connections Task Flow Properties."









This section provides information about using Connections to set up and manage your personal social network. It contains the following subsections:

	
Section 31.4.1, "Viewing Your Connections"


	
Section 31.4.2, "Inviting Others to Connect"


	
Section 31.4.4, "Responding to Invitations to Be a Connection"


	
Section 31.4.5, "Creating and Managing Connections Lists"


	
Section 31.4.6, "Removing a Connection"






31.4.1 Viewing Your Connections

You can view your connections in any Connections task flow. One of these is always available on the Connections page, which you can navigate to by clicking your user name wherever it appears in the application. In large lists of connections, you can use a search feature to locate a particular connection.

This section describes how to access the Connections page and view or search through your connections. It includes the following subsections:

	
Section 31.4.1.1, "Viewing Your Connections"


	
Section 31.4.1.2, "Searching Through Your Connections"






31.4.1.1 Viewing Your Connections

To view your connections:

	
Go to the Home space, and open your profile page, for example, by clicking on your user name in the UI.

You can also use the following URL to navigate to a Profile page:


http://host:port/webcenter/spaces/profile/userName





	
Tip:

For userName:
	
When userName matches the current user or is not specified, this URL navigates to your view of the Profile page.


	
When userName is not the current user's, it navigates to the specified user's view of the Profile page.













	
On the resulting page, click the Connections tab to bring it forward (Figure 31-6).


Figure 31-6 Connections Tab on Profile Page

[image: Connections Tab on Profile Page]



	
From the Show dropdown, select All Connections.









31.4.1.2 Searching Through Your Connections

The Connections search feature provides an efficient way to locate a particular connection in an otherwise long list of connections.

To search through your connections:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
From the Show dropdown, select All Connections.


	
In the Filter field, enter the user name of the connection, and click the Find connection icon next to the field.




	
Tip:

Click a connection name to open a Profile dialog and view profile details.










To exit the search, click the Clear icon that appears to the right of the Filter field (Figure 31-7).


Figure 31-7 Clear Icon Next to Filter Field

[image: Clear icon next to Filter field]









31.4.2 Inviting Others to Connect

Connecting to another user potentially provides view access to that user's personal Profile and Activity Stream, and view and post access to the user's Message Board. The level of access you have to a connection is determined by the People Connections defaults set by the application administrator, the individual user's People Connections Preference settings, and properties set on the task flow instance.




	
See Also:

For information about Connections Preferences, see Section 31.2, "Setting Connections Preferences." For information about People Connections defaults set by the application administrator, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application." For information about Connections task flow properties, see Section 31.5, "Setting Connections Task Flow Properties."







You can issue invitations from the Connections - Detailed View task flow and from the Connections page that you access in the Home space. This section describes the Connections page method.

To invite another user to connect:

	
Go to the Connections page, for example, by clicking your user name in the UI and then selecting the Connections subpage on the resulting Profile page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
On the Connections page, click the Invite People link to open the Invite People dialog.


	
In the Find User field, enter the user name of the person you want to invite to be your connection, then click the Find user icon (Figure 31-8).




	
See Also:

For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."








Figure 31-8 Invite People Dialog

[image: Invite People dialog]



	
Click the Invite link next to the user of interest to open the Invitation Message dialog (Figure 31-9).


Figure 31-9 Invitation Message Dialog

[image: Invitation Message dialog]



	
Enter a connection invitation or use the default message.


	
Optionally, from the Select connection lists dropdown, select one or more connections lists to which to add the user once the invitation is accepted.


	
Click Invite.

If the person you have invited set Preferences to automatically accept all invitations, you are connected immediately. Otherwise, the invitation becomes available in the recipient's view of the Connections page.




	
Tip:

You can also view invitations from the Connections - Detailed View task flow For more information, see Section 31.4.3, "Viewing Invitations to Connect."










	
See Also:

For information about Connections Preferences, see Section 31.2, "Setting Connections Preferences."















31.4.3 Viewing Invitations to Connect

You can view the invitations you have sent and received in the Connections - Detailed View task flow and on the Connections page. This section describes the Connections page case. It includes the following subsections:

	
Section 31.4.3.1, "Viewing Invitations You Have Sent"


	
Section 31.4.3.2, "Viewing Invitations You Have Received"






31.4.3.1 Viewing Invitations You Have Sent

To view invitations you have sent:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
From the Show menu, select Sent Invitations.

The Connections page refreshes, now showing a list of the pending invitations to connect that you have sent (Figure 31-10).


Figure 31-10 Sent Invitations View

[image: Sent Invitations View]






	
Note:

In the Show menu, the number next to Sent Invitations represents the number of pending invitations you have sent.















31.4.3.2 Viewing Invitations You Have Received

To view invitations you have received:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
From the Show menu, select Pending Invitations.

The Connections page refreshes, now showing a list of the pending invitations to connect that you have received (Figure 31-11).


Figure 31-11 Pending Invitations View

[image: Pending Invitations view]






	
Tip:

In the Show menu, the number next to Pending Invitations represents the number of pending invitations you have received.

















31.4.4 Responding to Invitations to Be a Connection

Connections provides two methods for responding to an invitation to connect:

	
You can set your Connections Preferences to accept such invitations automatically.




	
See Also:

For information about setting Connections Preferences, see Section 31.2, "Setting Connections Preferences."








	
You can manually accept, decline, or ignore such invitations through the Connections - Detailed View task flow or in your view of the Connections page.




This section describes the manual method of responding to invitations to connect from the Connections page.

To respond to invitations to connect:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
From the Show menu, select Pending Invitations to display a list of your pending invitations (Figure 31-12).


Figure 31-12 Pending Invitations View Showing Accept, Decline, and Ignore Buttons

[image: Accept, Decline, and Ignore buttons]






	
Tip:

Alternatively, click the Invitations icon (flag).








	
Next to a given invitation, click your desired response.

Choose from:

	
Accept—Make the connection.


	
Decline—Refuse the connection, with notification. When you decline an invitation to connect, the issuer becomes aware of this by watching his sent invitations.


	
Ignore—Remove the connection, without responding. When you ignore an invitation to connect, the issuer does not become aware of this by watching his sent invitations.




Once you respond to an invitation, it is removed from the list of received invitations. The users whose invitations you accept appear in your view of the Connections page.


	
Optionally, return to your default view of the Connections page by selecting All Connections from the Show menu.









31.4.5 Creating and Managing Connections Lists

Connections provides a means of grouping your connections into lists for managing the display of your connections and your connections activities. For example:

	
You can select a list and view just its members on your Connections page.


	
You can configure a Connections - Card task flow instance to display only the connections on a specified list (for more information, see Section 31.5, "Setting Connections Task Flow Properties").


	
You can configure Activity Stream Preferences to show activities only from specified connections lists (for more information, see Chapter 32, "Tracking Your Connections' Activities").




This section describes how to create and manage lists of connections. It includes the following subsections:

	
Section 31.4.5.1, "Creating a Connections List"


	
Section 31.4.5.2, "Adding a Connection to a List"


	
Section 31.4.5.3, "Removing a Connection from a List"


	
Section 31.4.5.4, "Deleting a Connections List"






31.4.5.1 Creating a Connections List

You can create a connections list using the Connections and Connections - Detailed View task flows and on the Connections page. This section describes how to create a connections list on the Connections page.

To create a list of connections:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
Click Organize to open the Organize Connections and Lists dialog (Figure 31-13).


Figure 31-13 Organize Button and Resulting Dialog

[image: Organize button and resulting dialog]



	
Click New Connection List to open the Create List dialog


	
Enter a name for your list of connections, and click OK to create the list and open it in the Organize Connections and Lists dialog (Figure 31-14).


Figure 31-14 New ST Team Connections List

[image: New Connections list]






	
Tip:

To view all of your connections, click All connections.










	
See Also:

For information about adding connections to a list, see Section 31.4.5.2, "Adding a Connection to a List."















31.4.5.2 Adding a Connection to a List

You can add connections to a Connections list using the Connections page and the Connections and Connections - Detailed View task flows. This section describes the Connections page case.

To add a connection to a Connections list:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
Click Organize to open the Organize Connections and Lists dialog, and select All connections, to show all of your connections (Figure 31-15).


Figure 31-15 Organize Connections and Lists Dialog

[image: Organize Connections and Lists dialog]



	
Click Add to List next to the user, and select one or more lists from the resulting dialog (Figure 31-16).


Figure 31-16 Add to List Dialog

[image: Add to List dialog]



	
Click Save and Close.




	
Tip:

Click All to add the selected user to all of your Connections lists.








	
Repeat steps 3 and 4 until you are done.


	
Click OK to close the Organize Connections and Lists dialog.









31.4.5.3 Removing a Connection from a List

To remove a connection from a list:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
Click Organize to open the Organize Connections and Lists dialog, and select the list from which to remove a connection to show the list (Figure 31-17).


Figure 31-17 Organize Connections and Lists Dialog with ST Team List Selected

[image: Organize Connections and Lists dialog]



	
Click Remove from List next to the user to open the Remove from List dialog (Figure 31-18).


Figure 31-18 Remove from List Dialog

[image: Remove from List dialog]



	
Select one or more lists from which to remove the selected user, or select My Connections and All My Lists to remove the selected user from all lists and as your connection.


	
Click Save and Close.


	
Repeat steps 3 through 5 until you are done.


	
Click OK to close the Organize Connections and Lists dialog.









31.4.5.4 Deleting a Connections List

When you delete a Connections list, you are not deleting the connections you added to the list. You are deleting only the selected grouping, that is, the list itself. The connections that were on the deleted list continue to be your connections.

You can delete a Connections list from the Connections page and from the Connections and Connections - Detailed View task flows. This section describes the Connections page case.

To delete a connections list:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
Click Organize to open the Organize Connections and Lists dialog.


	
Click the Actions icon next to the Connections list you want to delete, and select Delete List from the resulting menu (Figure 31-19).


Figure 31-19 Delete List Option on Actions Menu

[image: Delete List option on Actions menu]



	
In the resulting confirmation dialog, click Yes to delete the list.


	
Click OK to close the Organize Connections and Lists dialog.











31.4.6 Removing a Connection

Included in the process of managing your connections is the occasional necessity of weeding people out: they may leave your group or the company, or there may no longer be a compelling reason to stay connected.

Controls for removing a connection are available through the Connections page and the Connections and Connections - Detailed View task flow. This section describes the Connections Page case.

To remove one of your connections:

	
Go to the Connections page.




	
See Also:

For more information, see Section 31.4.1.1, "Viewing Your Connections."








	
Click Organize to open the Organize Connections and Lists dialog.


	
Click the Remove button next to the connection to remove.


	
In the resulting dialog, click Yes to remove the selected connection (Figure 31-20).


Figure 31-20 Confirmation Dialog for Remove Connection Action

[image: Confirmation dialog for Remove Connection action]



	
Click OK to close the Organize Connections and Lists dialog.











31.5 Setting Connections Task Flow Properties

Connections task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 31-21).


Figure 31-21 Connections Task Flow Component Properties

[image: Connections task flow component properties]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with Connections task flows and describe the properties available on the Parameters tab:

	
Section 31.5.1, "What You Should Know About Connections Task Flow Properties"


	
Section 31.5.2, "Connections Task Flow Parameters"


	
Section 31.5.3, "Using Properties to Configure a Connections Task Flow Instance"






31.5.1 What You Should Know About Connections Task Flow Properties

When you set property values on a Connections task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 31.5.2, "Connections Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














31.5.2 Connections Task Flow Parameters

Table 31-1 describes the parameters that are unique to Connections task flows.


Table 31-1 Connections Task Flow Parameters

	Parameter	Description
	
Allow Remove

	
A Boolean value representing whether a control is available on the task flow for removing a connection

Enter either true or false.

This value is honored only when the task flow instance is rendered in list format. For more information, see Profile Format.

This parameter is associated with the Connections - Card task flow.


	
Connection List Name

	
The name of a grouped list of connections

Use this parameter to limit the display of connections to those on the specified Connections list.

Enter the name of a Connections list.

This parameter is associated with the Connections - Card task flow.


	
Current View

	
The view to display by default

Valid values include:

	
connections—(the default value) a list of connections


	
receivedInvitations—a list of connections invitations you received


	
sentInvitations—a list of connections invitations you sent


	
people—a search field for finding people with whom to connect




When users access the task flow instance, the view specified here is the first one they see. All selections, except people, provide controls for navigating to the application default view (connections). Selecting people provides search and select controls for inviting other users to connect.

This parameter is associated with the Connections task flow.


	
Filter Pattern

	
A value to act as a filter against task flow content

For example, to show only those connections with a user name that includes the term pat (including patrick or sripathy), enter pat in the Filter Pattern field.

This parameter is associated with the Connections - Card task flow.


	
Hide Footer

	
A Boolean value representing whether to hide the task flow footer

Use this parameter to show or hide a link at the bottom of the task flow that enables users (when shown) to navigate to a detailed view of Connections when the number of available connections exceeds the number of connections that are shown.

	
Select the checkbox (#{true}) to hide the task flow footer.


	
Clear the checkbox (#{false}) to show the task flow footer.




This parameter is associated with the following task flows:

	
Connections – Card


	
Connections – Quick View





	
Hide Header

	
A Boolean value representing whether to hide the task flow header

Use this parameter to show or hide a link at the bottom of the task flow that enables users (when shown) to navigate to a detailed view of Connections when the number of available connections exceeds the number of connections that are shown.

	
Select the checkbox (#{true}) to hide the task flow header.


	
Clear the checkbox (#{false}) to show the task flow header.




This parameter is associated with the Connections - Quick View task flow.


	
Number of Columns

	
The number of columns to show in the task flow

For example, with six connections to show, a value of 2 means those connections are shown in two columns with three rows.

When a user's number of connections exceeds the number of connections allowed after column and row restrictions are applied, Previous and Next links are shown, enabling the user to page through his connections. (See also Number of Rows.)

This parameter is associated with the following task flows:

	
Connections - Card


	
Connections - Quick View





	
Number of Connections per page

	
The number of connections to show in the given task flow instance

Enter a numeric value, such as 10, 2, 15, and so on.

The number you enter here limits the number of connections that are shown in the task flow instance. If a user's number of connections exceeds the specified value, a More link is shown, enabling the user to navigate to a full view of the Profile page's Connections subpage.

This parameter is ignored if both the number of rows and the number of columns have been specified together as parameters.

This parameter is associated with the following task flows:

	
Connections - Card


	
Connections - Detailed View


	
Connections - Quick View





	
Number of Rows

	
The number of rows to show in the task flow

For example, with six connections to show and a value of 2 for Number of Columns, a value of 2 for Number of Rows means connections are shown in two columns with two rows. That is, four connections are shown.

When a user's number of connections exceeds the number of connections allowed after column and row restrictions are applied, Previous and Next links are shown, enabling the user to page through his connections. (See also, Number of Columns.)

This parameter is associated with the following task flows:

	
Connections - Card


	
Connections - Quick View





	
Number of Rows (list layout)

	
The number of rows to show in a list layout of the Connections task flow

This value is honored only when the view of the Connections task flow is set to connections. (For more information, see Current View.)

When a user's number of connections exceeds the number of connections allowed after row restrictions are applied, Previous and Next links are shown, enabling the user to page through his connections.

This parameter is associated with the Connections task flow.


	
Profile Format

	
The layout style for the task flow

Enter one of the following:

	
vcard—Renders each connection in a virtual business card and includes the connection's user name and status message and quick-access buttons for interacting with your connections.


	
iconic—Renders the connection's personal profile photo and shows the user name below the photo.


	
list—Renders connections in a list, showing the personal profile photo, user name, information about recent profile updates, and quick-access buttons for interacting with your connections.


	
tiled—Renders the connection's personal Profile photo and shows the user name and job title beside the photo.




This parameter is associated with the Connections - Card task flow.


	
Profile Launched on Selection

	
A Boolean value representing whether a Profile popup should open when a user clicks a connection listed in the task flow

	
Select the checkbox (#{true}) to enable a Profile popup to launch when a user clicks a connection.


	
Clear the checkbox (#{false}) to suppress this option.




This parameter is associated with the Connections - Card task flow.


	
Sort Criteria

	
The connections sort order

Enter LAST_ACTIVITY_TIME to sort connections in descending date/time order. Leave blank to sort alphabetically by name.

This parameter is associated with the following task flows:

	
Connections - Card


	
Connections - Detailed View





	
User Id

	
The ID of the user to show in the task flow

This value is set automatically (#{securityContext.userName}). Do not edit this value.

This parameter is associated with the following task flows:

	
Connections - Quick View


	
Connections - Detailed View





	
User Name

	
The ID of the user to show in the task flow

This value is set automatically (#{securityContext.userName}). Do not edit this value.

This parameter is associated with the following task flows:

	
Connections - Card


	
Connections















31.5.3 Using Properties to Configure a Connections Task Flow Instance

This section provides examples of how you use property values to affect the behavior of a given task flow instance. Because you make these changes in page edit mode (Composer), they affect all users' views of the affected task flow instance.

This section includes the following subsections:

	
Section 31.5.3.1, "Adding a Remove Button to Connections - Card"


	
Section 31.5.3.2, "Restricting Connections Displayed to Those on a Named List"


	
Section 31.5.3.3, "Specifying an Initial View for a Connections Task Flow Instance"


	
Section 31.5.3.4, "Limiting the Number of Displayed Connections"


	
Section 31.5.3.5, "Specifying Numbers of Rows and Columns"


	
Section 31.5.3.6, "Applying a Filter to a Connections - Card Task Flow Instance"


	
Section 31.5.3.7, "Selecting a Display Format for a Connections - Card Task Flow Instance"


	
Section 31.5.3.8, "Invoking a Profile Popup from a Connections - Card Task Flow Instance"






31.5.3.1 Adding a Remove Button to Connections - Card

By default, the Connections - Card task flow does not provide a control for permanently removing a connection. You can use the Allow Remove property on a Connections - Card task flow instance to render a Remove button next to each listed connection. Allow Remove is honored when the task flow's Profile Format property is set to List or Virtual Business Card.

To enable the removal of a connection in a Connections - Card task flow:

	
Edit the properties of a Connections - Card task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Set Profile Format to list.


	
Provide a value for Allow Remove:

	
Select the checkbox (#{true}) to enable the display of a Remove button next to a listed connection (Figure 31-22).


Figure 31-22 Remove Icon on a Connections - Card Task Flow

[image: Remove icon on a Connections - Card task flow]



	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









31.5.3.2 Restricting Connections Displayed to Those on a Named List

In an instance of the Connections - Card task flow, you can use the Connection List Name property to restrict the display of connections to only those users included on a named Connections list.




	
See Also:

For information about Connections lists, see Section 31.4.5, "Creating and Managing Connections Lists."







To restrict a Connections - Card task flow to a particular Connections list:

	
Edit the properties of a Connections - Card task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
In the Connection List Name field, enter the name of the Connections list to use to limit the display of connections.


	
Click OK.









31.5.3.3 Specifying an Initial View for a Connections Task Flow Instance

Use the Current View property to specify the initial view of a Connections task flow instance. For most views, users can change the default you specify here. The exception is the people view, in which there are no controls for switching to a different view.

To specify an initial view for a Connections task flow instance:

	
Edit the properties of a Connections task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
For Current View, select one of the following:

	
connections—(the default value) a list of connections


	
receivedInvitations—a list of connections invitations you received


	
sentInvitations—a list of connections invitations you sent


	
people—a search field for finding people with whom to connect





	
Click OK.









31.5.3.4 Limiting the Number of Displayed Connections

The Connections - Card, Connections - Detailed View, and Connections - Quick View task flows provide the property Number of Connections per page for limiting the number of connections to show at a time. If a user's number of connections exceeds the specified value, a link is shown at the bottom of the task flow to enable the user to navigate to a full view of the Profile page's Connections subpage.

To limit the number of displayed connections in a Connections - Card, Connections - Detailed View, or Connections - Quick View task flow instance:

	
Edit the properties of a Connections - Card, Connections - Detailed View, or Connections - Quick View task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for Number of Connections per page.


	
Click OK.









31.5.3.5 Specifying Numbers of Rows and Columns

The Connections, Connections - Card, and Connections - Quick View task flows provide properties for controlling the number of columns and rows to show at a time. When column and row values are both specified, and a user's number of connections exceeds the specified values, Previous and Next links are shown, enabling the user to page through his connections.

To specify the number of rows and columns of connections to show:

	
Edit the properties of a Connections, Connections - Card, or Connections - Quick View task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Enter a numeric value to control the number of rows to show:

	
For Connections, enter a number for Number of Rows (list layout).


	
For Connections - Card and Connections - Quick View, enter a number for Number of Rows.





	
For Connections - Card and Connections - Quick View, enter a numeric value in the Number of Columns field to control the number of columns to show.


	
Click OK.









31.5.3.6 Applying a Filter to a Connections - Card Task Flow Instance

The Filter Pattern property enables you to apply a filtering term that limits the display of connections in a Connections - Card task flow instance to only those who meet the filtering criteria. For example, to show only those connections with a user name that includes the term pat (including patrick or sripathy), enter pat for the Filter Pattern property.

The filter is applied to all of the information in a given card, so you can filter against things like the user's job title or name. For example, entering the term manager, ensures that only those connections whose job title includes manager are displayed in the task flow instance.

To apply a filter to a Connections - Card task flow instance:

	
Edit the properties of a Connections - Card task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Enter a filtering term for Filter Pattern.




	
Tip:

For example, enter a job title, a user name, or partial values, such as man.








	
Click OK.









31.5.3.7 Selecting a Display Format for a Connections - Card Task Flow Instance

The Profile Format property provides options for controlling the arrangement of connections within a Connections - Card task flow instance. Both the placement of information and the amount of information shown are affected by your selection.

To select a display format for a Connections - Card task flow instance:

	
Edit the properties of a Connections - Card task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select a format from the Profile Format dropdown list:

	
Virtual Business Card—Renders each connection in a virtual business card and includes the connection's user name and status message and quick-access buttons for interacting with your connections (Figure 31-23).


Figure 31-23 Connections - Card in Virtual Business Card Format

[image: Connections - Card in virtual business card format]



	
Iconic—Renders the connection's personal profile photo and shows the user name below the photo (Figure 31-24).


Figure 31-24 Connections - Card in Iconic Format

[image: Connections - Card in Iconic format]



	
List—Renders connections in a list, showing the personal profile photo, user name, information about recent profile updates, and quick-access buttons for interacting with your connections (Figure 31-25).


Figure 31-25 Connections - Card in List Format

[image: Connections - Card in List format]



	
Tiled—Renders the connection's personal Profile photo and shows the user name and job title beside the photo (Figure 31-26).


Figure 31-26 Connections - Card in Tiled Format

[image: Connections - Card in Tiled format]






	
Click OK.









31.5.3.8 Invoking a Profile Popup from a Connections - Card Task Flow Instance

The Profile Launched on Selection property provides a means of launching a Profile popup when users click a connection name in a Connections - Card task flow instance (Figure 31-27).


Figure 31-27 Invoking a Profile Popup from the Connections - Card Task Flow

[image: Invoking a Profile popup from Connections - Card]



When this option is not selected, clicking a connection name in the task flow simply selects the connection.

To enable the launch of a Profile popup from a Connections - Card task flow instance:

	
Edit the properties of a Connections - Card task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select an option for Profile Launched on Selection:

	
Select the checkbox (#{true}) to enable a Profile popup to launch when a user clicks a connection.


	
Clear the checkbox (#{false}) to suppress this option.





	
Click OK.
















32 Tracking Your Connections' Activities

The social networking capabilities in WebCenter Portal: Spaces enable you to view and manage your own Activity Stream and to view the Activity Streams of others if they have made them available to you. Additionally, all members of a given space can view the streamed activities of all other members without formally connecting to them when the Activity Stream is scoped to that space.

This chapter provides an overview of Activity Stream and its associated features and functions, and catalogs the properties associated with Activity Stream task flows. It includes the following sections:

	
Section 32.1, "What You Should Know About Activity Stream"


	
Section 32.2, "Setting Activity Stream Preferences"


	
Section 32.3, "Adding an Activity Stream Task Flow to a Page"


	
Section 32.4, "Working with Activity Stream Task Flows"


	
Section 32.5, "Setting Activity Stream Task Flow Properties"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission People Connections: Update People Connections Data. Users who plan to edit task flow properties must be assigned a role that also includes the permission Edit Pages. In a space (other than the Home space), users must be assigned a role that includes the permission Edit Page Access and Structure.



32.1 What You Should Know About Activity Stream

In WebCenter Portal: Spaces, Activity Stream provides a streaming view of the activities of your connections, actions taken in spaces, and business activities. For example, Activity Stream can note when you or a connection posts feedback, uploads a document, and creates a discussion forum. Additionally, it streams messages and attachments entered through the Publisher task flow.




	
See Also:

For information about the Publisher task flow, see Chapter 34, "Liking, Commenting On, and Sharing Objects."







Through Activity Stream Preferences, you can select to show connection and space activities. (Note, however, that your application administrator may disable all users from overriding application-level settings.) Through application programming interfaces (APIs), you can control the display of business activities.




	
See Also:

For information about tracking business activities using APIs, see Oracle Fusion Middleware Java API Reference for Oracle WebCenter.







In addition to streaming messages, your Activity Stream can provide access to file attachments and web links added through the Publisher task flow. Supported mime types can be fully previewed in the Activity Stream. Unsupported mime types are rendered as links, which you can use to access the file.

Activity Stream previews files through either a native web format or through Oracle WebCenter Content slide rendition. The previewer used depends on the mime type of the file to be previewed.

The mime types that use the native web format include:

	
image


	
htm


	
text




The mime types that use Oracle WebCenter Content slide rendition include:

	
pdf


	
powerpoint


	
powerpnt


	
pptx







	
Note:

PDF file previews are available in Activity Stream when the mime type is pdf, webContextRoot is specified in the Oracle WebCenter Content connection, and the WebCenter Portal: Spaces application is accessed through an Oracle HTTP Server.







Note that the mime types shown in these bullet lists are the only mime types that are previewed. Other mime types appear as links. The mime types docx and xlsx are not previewed in Activity Stream. Note also that a parameter associated with an Activity Stream task flow instance can be set to omit file previews (for more information, see Section 32.5.2, "Activity Stream Task Flow Parameters").

Users can share a streamed activity and its attachments using a Share feature, available on each streamed item.




	
See Also:

For information about sharing, see Section 32.4.7, "Sharing Files and other Objects Through an Activity Stream Item."







Table 32-1 lists and describes the types of activities that are reported through Activity Stream.




	
Note:

Delete activities do not appear per se in the Activity Stream. But references to objects, such as Joe Smith created the document file.xml, are removed from the stream when such objects are deleted.








Table 32-1 Activities Tracked by Activity Stream

	Service	Tracked Activities	Scope	Activities Shared or Private
	
Announcements

	
	
Create announcement


	
Edit announcement




	
space


	
Shared with other space members


	
Blogs

	
	
Create blog


	
Update blog




	
	
space


	
Home space





	
	
Activities on space blogs are shared with other space members.


	
Activities on Home space blogs are shared with the blogger's connections.





	
Connections

	
	
Invitations to connect


	
People are connected




	
Home space


	
Shared with invitor and invitee's connections


	
Discussions

	
	
Create forum


	
Create topic


	
Reply to topic




	
space


	
Shared with other space members


	
Documents

	
	
Create document


	
Edit document


	
Add tag


	
Remove tag




	
	
space


	
Home space





	
	
Activities on space documents are shared with other space members.


	
Activities on Home space documents are private to user.





	
Feedback

	
	
Feedback left


	
Feedback received




	
Home space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 33.2, "Setting Message Board and Feedback Preferences."


	
Lists

	
	
Create a list


	
Add a row to a list


	
Edit a list row




	
space


	
Shared with other space members


	
Message Board

	
	
Message left


	
Message received




	
Home space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 33.2, "Setting Message Board and Feedback Preferences."


	
Pages

	
	
Create page


	
Edit page


	
Add tag


	
Remove tag




	
	
space


	
Home space





	
	
Activities on space pages are shared with other space members.


	
Activities on Home space pages are private to user.





	
Profiles

	
	
Photo updated


	
Profile updated


	
Personal status note updated




	
Home space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 30.3, "Setting Profile Preferences."


	
Space Events

	
	
Create an event


	
Edit an Event




	
space


	
Shared with other space members


	
Spaces Management

	
	
Create space


	
Join space




	
space


	
Shared with other space members


	
Tagging

	
	
Add tag


	
Remove tag




	
space


	
	
Activities in a space are shared with all space members.


	
Activities in a Home space are shared with whomever is permitted to view such activities (for more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences").











In page view mode, use Activity Stream Preferences to specify who can view your Activity Stream and the types of activities to show. For more information about Preferences relating to Activity Stream task flows, see Section 32.2, "Setting Activity Stream Preferences."

In page edit mode, use Activity Stream task flow properties to hide or show various controls on everyone's view of a task flow instance and to limit the types of services and objects and the specific spaces that are tracked. For more information about Activity Stream task flow properties, see Section 32.5, "Setting Activity Stream Task Flow Properties."

WebCenter Portal: Spaces provides the following Activity Stream task flows:

	
Activity Stream for viewing application activities and the activities of your connections and for providing access to the attachments added through the Share link (Figure 32-1)


Figure 32-1 Activity Stream Task Flow

[image: Description of Figure 32-1 follows]

Description of "Figure 32-1 Activity Stream Task Flow"





This full view of Activity Stream functionality includes options for liking and commenting on listed activities and for sharing different types of objects, such as images, URLs, documents, and the like. Activity Stream also provides a means of hiding the activities and posts of a given user. You can use Activity Stream Options to show those users you have hidden.

The Activities page in the Home space combines an instance of the Publisher task flow with the Activity Stream task flow.




	
See Also:

For information about the Publisher task flow, see Section 34.3.3.1, "What You Should Know About the Publisher Task Flow."








	
Activity Stream - Quick View provides a summary view of application activities and the activities of your connections (Figure 32-2)


Figure 32-2 Activity Stream - Quick View Task Flow

[image: Description of Figure 32-2 follows]

Description of "Figure 32-2 Activity Stream - Quick View Task Flow"





Unlike the full view of Activity Stream, Activity Stream - Quick View does not display Like, comments, and Share links.




A hierarchy of configuration settings control what you can do with your view of the Activity Stream. The application administrator sets application-wide values on the Administration page. You can set your own personal values through People Connections Preferences. You can also set values on a given task flow instance in both page edit mode, which affects all users' views of the task flow instance (application customization), and page view mode, which affects only your view of the task flow (user customization).




	
Tip:

If you adjust a setting through Preferences that does not seem to affect the behavior of a task flow as you expected, it may be because settings on the task flow itself override Preferences settings.







The Activity Stream task flow provides an Options link for accessing configuration settings for a given task flow instance (Figure 32-3).


Figure 32-3 Options Link for Activity Stream Options

[image: Description of Figure 32-3 follows]

Description of "Figure 32-3 Options Link for Activity Stream Options"





The Activity Stream - Quick View provides access to its own configuration settings through a pencil icon (Change the source, filter, and display options) (Figure 32-4).


Figure 32-4 Pencil Icon and Resulting Configure Dialog

[image: Description of Figure 32-4 follows]

Description of "Figure 32-4 Pencil Icon and Resulting Configure Dialog"





Use these controls to adjust an individual task flow instance with the same kinds of settings that are provided for all of your views of Activity Stream task flows through Activity Stream Preferences (for more information, see Section 32.2, "Setting Activity Stream Preferences," and Section 32.4, "Working with Activity Stream Task Flows").

Clicking an object in an Activity Stream opens the object. For example, clicking the name of a newly created document in an Activity Stream opens the document. Clicking a user name in an Activity Stream opens a user profile pop-up. Clicking an attachment, such as a file or a URL, navigates you to that attachment.




	
See Also:

You can attach object to messages streamed from the Publisher task flow to the Activity Stream. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."







Activity Stream compares somewhat to the Recent Activities service, which also tracks and reports on application activities (for more information, see Chapter 69, "Working with the Recent Activities Service"). Both track the application activities of integrated services, though Activity Stream tracks a broader range. For example, Recent Activities tracks the Document, Announcements, and Discussions services, as well as page-related activities. Activity Stream tracks all of these as well as People Connections, Wikis, and Blogs. Recent Activities tracks activities no matter who performs the action. Activity Stream tracks activities performed by a user's connections. Activity Stream can be scoped to the space (including the Home space) in which it is placed. It also provides the name of the person performing the action. Recent Activities cannot be scoped to the Home space, and it does not provide the name of the person who performed the action.

To summarize the basic difference between these two services: Recent Activities provides an overview of what is happening in an application. Activity Stream provides an overview of what is happening with a user's connections.

For more information, see Section 32.4, "Working with Activity Stream Task Flows."

Advanced users, such as application administrators, can archive streamed activities to relieve the burden on your storage and to maintain a record of past activities. For more information, see the section, "Activity Stream," in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.






32.2 Setting Activity Stream Preferences

Use Activity Stream Preferences to specify who can view your Activity Stream; the users, services, and spaces for which to track activities; and the activities to show in an Activity Stream task flow.




	
See Also:

For information about the services that Activity Stream tracks, see Table 32-1, "Activities Tracked by Activity Stream".







To set Activity Stream preferences:

	
Open the Preference dialog.


	
Click People Connections to display People Connections preferences.


	
Click the Activity Stream tab to bring it forward (Figure 32-5).


Figure 32-5 Activity Stream Preferences

[image: Activity Stream Preferences]



	
Under People, specify whose activities to show in your view the Activity Stream:




	
Tip:

This setting relates only to the activities that stream from the People Connections service. Such activities include making connections, posting Feedback and Messages, adjusting your Profile, and so on.







From the dropdown list, select one option from:

	
Only Me—Show only your own activities in your view of the Activity Stream.


	
Me and My Connections—Show only your activities and the activities of your connections in your view of the Activity Stream.


	
No Personal—Do not show any user activities in your view of the Activity Stream, including your own.


	
Selected Connection Lists—Show the activities of only those users on the selected connections lists in your view of the Activity Stream.

When you select this option, all available connections lists appear below it. Select one or more connections lists to limit the display of activities to the users on those lists.




	
Note:

Use this option only after you have created one or more connections lists (for more information, see Section 31.4.5, "Creating and Managing Connections Lists").











	
Under Spaces, select to show activities from:

	
All Spaces—Stream activities from all available spaces.


	
My Spaces—Stream activities from the spaces of which you are a member.


	
No Spaces—Do not stream any activities from spaces other the Home space.





	
Under Service Categories, select the services for which to track activities.

Select a checkbox to track the activity of a particular service; clear a checkbox to ignore the activity of a particular service.




	
Tip:

Selecting No Spaces in the previous step affects the outcome of your service selection: despite their selection here, services publish no activities to your view of the Activity Stream.








	
Under Privacy, identify the types of users who can see your view of the Activity Stream:

	
Everyone—All users, whether they are logged in, can see your view of the Activity Stream.


	
Authenticated Users—All users who are logged in can see your view of the Activity Stream.


	
My Connections—The people to whom you are connected can see your view of the Activity Stream.


	
Myself—Only you can see your view of the Activity Stream.





	
Click OK.









32.3 Adding an Activity Stream Task Flow to a Page

For the steps to add a People Connections service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






32.4 Working with Activity Stream Task Flows

In page view mode, you can perform user customizations on a task flow instance that affect only your view of that task flow. Activity Stream task flows provide user customization controls for determining whose activities and what activities are streamed.

In page edit mode, you can perform application customizations on a task flow instance that affect everyone's view of that task flow. For example, Activity Stream provides controls for enabling or disabling the display of links for liking, sharing, and commenting on individual Activity Stream items. In view of this, some of the actions described in this section may not be available, depending on such customizations.




	
See Also:

For information about performing application-level customizations on Activity Stream task flows, see Section 32.5, "Setting Activity Stream Task Flow Properties."







This section provides information about controlling whose activities what activities are shown in a given task flow instance, as well as how to like and comment on a streamed item, and how to share a file or URL with other users through the Activity Stream.

This section includes the following subsections:

	
Section 32.4.1, "Selecting the People to Stream in an Activity Stream Instance"


	
Section 32.4.2, "Selecting the Spaces to Stream in an Activity Stream Instance"


	
Section 32.4.3, "Selecting the Services to Stream in an Activity Stream Instance"


	
Section 32.4.4, "Hiding and Showing the Activities of a Selected User"


	
Section 32.4.5, "Hiding and Showing the Activities of a Selected Space"


	
Section 32.4.6, "Liking and Commenting On Activity Stream Items"


	
Section 32.4.7, "Sharing Files and other Objects Through an Activity Stream Item"






32.4.1 Selecting the People to Stream in an Activity Stream Instance

Use the Options link on an Activity Stream task flow instance to specify the people from whom to stream activities in your view of an Activity Stream instance. Use the pencil icon on an Activity Stream - Quick View task flow to perform the same operation.

To select the people from whom to stream activities in your view of an Activity Stream task flow instance:

	
Go to an instance of an Activity Stream or Activity Stream - Quick View task flow.


	
On an Activity Stream task flow, click Options.

On an Activity Stream - Quick View task flow, click the Change the source, filter, and display options icon (pencil).


	
For Activity Stream only: in the resulting dialog, click the Settings tab to bring it forward.


	
Under People, select the people from whom to stream activities:

	
Only Me—Show only your own activities in your view of the Activity Stream.


	
Me and My Connections—Show only your activities and the activities of your connections in your view of the Activity Stream.


	
No Personal—Do not show any user activities in your view of the Activity Stream, including your own.


	
Selected Connection Lists—Show the activities of only those users on the selected connections lists in your view of the Activity Stream.

When you select this option, all available connections lists appear below it. Select one or more connections lists to limit the display of activities to the users on those lists.




	
Note:

Use this option only after you have created one or more connections lists (for more information, see Section 31.4.5, "Creating and Managing Connections Lists").











	
Click Save to save your changes and exit the dialog.









32.4.2 Selecting the Spaces to Stream in an Activity Stream Instance

Use the Options link on an Activity Stream task flow instance to select the spaces from which to stream activities. Use the pencil icon on an Activity Stream - Quick View task flow to perform the same operation.

To select the spaces from whom to stream activities in an Activity Stream task flow instance:

	
Go to an instance of an Activity Stream or Activity Stream - Quick View task flow.


	
On an Activity Stream task flow, click Options.

On an Activity Stream - Quick View task flow, click the Change the source, filter, and display options icon (pencil).


	
For Activity Stream only: in the resulting dialog, click the Settings tab to bring it forward.


	
Under Spaces, select to show activities from all available spaces in your view of the Activity Stream (All Spaces), or omit the display of any space activities (No Spaces).




	
Tip:

Selecting No Spaces affects the outcome of your service selection (see Section 32.4.3): despite their selection, services publish no activities to your view of the Activity Stream.








	
Click Save to save your changes and exit the dialog.









32.4.3 Selecting the Services to Stream in an Activity Stream Instance

Use the Options link on an Activity Stream task flow instance to select the services from which to stream activities. Use the pencil icon on an Activity Stream - Quick View task flow to perform the same operation.

To select the services from whom to stream activities in an Activity Stream task flow instance:

	
Go to an instance of an Activity Stream or Activity Stream - Quick View task flow.


	
On an Activity Stream task flow, click Options.

On an Activity Stream - Quick View task flow, click the Change the source, filter, and display options icon (pencil).


	
For Activity Stream only: in the resulting dialog, click the Settings tab to bring it forward.


	
Under Service Categories, select the services for which to track activities.

Select a checkbox to track the activity of a particular service; clear a checkbox to ignore the activity of a particular service.




	
Tip:

Selecting No Spaces in Section 32.4.2 affects the outcome of your service selection: despite their selection here, services publish no activities to your view of the Activity Stream.








	
Click Save to save your changes and exit the dialog.









32.4.4 Hiding and Showing the Activities of a Selected User

Some of your connections may post activities with a frequency that is more of a distraction than a help. In this case, or for any other reason, you can select to hide the activities streamed from selected users in your view of the Activity Stream task flow (or from the Activities page in the Home space).

You can easily reverse this action by showing one or more hidden users through the Options link on the affected Activity Stream task flow.

This section describes how to hide or show the activities of individual users in an Activity Stream task flow instance. It includes the following subsections:

	
Section 32.4.4.1, "Hiding the Activities of a Selected User"


	
Section 32.4.4.2, "Showing the Activities of a Hidden User"






32.4.4.1 Hiding the Activities of a Selected User

To hide the activities streaming from a selected user in an Activity Stream task flow instance:

	
Go to an instance of an Activity Stream task flow.


	
Open the Hide menu next to the user you want to hide, and select the relevant user name (Figure 32-6).


Figure 32-6 The Hide Option in the Activity Stream

[image: Hide option in the Activity Stream]



	
Click OK in the confirmation dialog.

The page refreshes, and the task flow no longer shows activities from the selected user.







	
See Also:

For information about showing a hidden user, see Section 32.4.4.2, "Showing the Activities of a Hidden User."












32.4.4.2 Showing the Activities of a Hidden User

To reinstate the streaming of activities from a hidden user:

	
Go to an instance of an Activity Stream task flow where a user's activities are hidden.


	
Click Options.


	
In the resulting dialog, click the People tab to bring it forward.


	
Next to the person whose activities you want to show, click Show (Figure 32-7).


Figure 32-7 The Options Link and the Show Button

[image: Options link and Show button]












32.4.5 Hiding and Showing the Activities of a Selected Space

If there is a space that streams activities that are not currently of interest to you, you can hide that space's activities from a selected instance of the Activity Stream task flow (or from the Activities page in the Home space).

You can easily reverse this action by showing one or more hidden spaces through the Options link on the affected Activity Stream task flow.

In order to be able to hide the activities streaming from a particular space, the affected Activity Stream task flow instance must be configured to show All Spaces (for more information, see Section 32.2, "Setting Activity Stream Preferences," and Section 32.4.2, "Selecting the Spaces to Stream in an Activity Stream Instance").




	
Tip:

Whether or not the activities streaming from space are shown can be determined at the application level, in personal Preferences, and on an individual task flow instance in both page view mode and page edit mode. If you find you cannot hide or show activities streaming from spaces, it is likely that at one of these levels, the facility to see such activities has been blocked.







This section describes how to hide the activities streaming from a particular space, and how to show those hidden activities. It includes the following subsections:

	
Section 32.4.5.1, "Hiding the Activities of a Selected Space"


	
Section 32.4.5.2, "Showing the Activities of a Hidden Space"






32.4.5.1 Hiding the Activities of a Selected Space

To hide the activities streaming from a selected space in an Activity Stream task flow instance:




	
Note:

Your Preference settings may prevent any space activities from streaming. For information about Activity Stream Preferences, see Section 32.2, "Setting Activity Stream Preferences."







	
Go to an instance of an Activity Stream task flow.


	
Open the Hide menu next to an activity that has streamed from the space you want to hide, and select the relevant space name (Figure 32-8).


Figure 32-8 Selecting to Hide the Space teamsite2

[image: Hiding Space teamsite2]



	
Click OK in the confirmation dialog.

The page refreshes, and the task flow no longer shows activities from the selected space.







	
See Also:

For information about showing a hidden space, see Section 32.4.5.2, "Showing the Activities of a Hidden Space."












32.4.5.2 Showing the Activities of a Hidden Space

To reinstate the streaming of activities from a hidden space:

	
Go to an instance of an Activity Stream task flow where a space's activities are hidden.


	
Click Options.


	
In the resulting dialog, click the Spaces tab to bring it forward.


	
Next to the space whose activities you want to show, click Show (Figure 32-9).


Figure 32-9 The Options Link and the Show Button in Activity Stream Options Dialog

[image: Show button in Activity Stream Options dialog]












32.4.6 Liking and Commenting On Activity Stream Items

Provided the Activity Stream task flow has been configured to do so, you and the users to whom you have provided access to your Activity Stream can express a liking for or comment on a particular streamed item.

To express a liking for a streamed item, go to an Activity Stream task flow and click the Like link. You can remove your liking by clicking the resulting Unlike link.

To comment on a streamed item, click the comments link, enter a comment in the resulting field, and click the Comment button. For each comment you add, a delete icon is provided to enable you to remove your comment.




	
See Also:

For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."












32.4.7 Sharing Files and other Objects Through an Activity Stream Item

Provided the Activity Stream task flow is configured to support it, you can share a streamed item with all of the users who are allowed to view your streamed activities. This could be all of your connections or all of the users on a selected connections list. Who an item is shared with is determined by how you or your application administrator has configured your Activity Stream.

If you prefer, you can send a streamed item through mail, and consequently select all recipients yourself.

To share a streamed item:

	
Go to the streamed item of interest.


	
Select an option from the Share menu (Figure 32-10).





Figure 32-10 Share Menu on a Streamed Activity

[image: Share menu on a streamed activity]



	
Select This activity to stream a URL to the item (such as a new space, a new announcement or discussion topic, and the like) to all enabled users.


	
Select Send Mail to send a mail with a link to the item to all specified recipients.







	
See Also:

For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."














32.5 Setting Activity Stream Task Flow Properties

Activity Stream task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 32-11).


Figure 32-11 Activity Stream Task Flow Component Properties

[image: Activity Stream component properties]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with Activity Stream task flows and describe the properties available on the Parameters tab:

	
Section 32.5.1, "What You Should Know About Activity Stream Task Flow Properties"


	
Section 32.5.2, "Activity Stream Task Flow Parameters"


	
Section 32.5.3, "Using an Advanced Query to Filter Activity Stream Items"


	
Section 32.5.4, "Using Properties to Configure an Activity Stream Task Flow Instance"






32.5.1 What You Should Know About Activity Stream Task Flow Properties

When you set property values on an Activity Stream task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 32.5.2, "Activity Stream Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














32.5.2 Activity Stream Task Flow Parameters

Table 32-2 describes the parameters that are unique to Activity Stream task flows.


Table 32-2 Activity Stream Task Flow Parameters

	Parameter	Description
	
Advanced Query

	
A field for specifying a custom query to filter streamed items

For more information, see Section 32.5.3, "Using an Advanced Query to Filter Activity Stream Items."

This parameter is associated with the Activity Stream task flow.


	
Enable Context Info

	
A checkbox for specifying whether contextual information is shown when users click a Context Info icon

[image: Context info icon and dialog]
For example, if the item John created the purchase order General Supplies appears in the Activity Stream with a Context Info icon (the reddish dot), users who see the streamed item can click the icon to view the PO in a popup or navigate to the PO, depending on how the event is configured.

This parameter is primarily for use with WebCenter Portal: Framework applications. In WebCenter Portal: Spaces, unless otherwise handled (such as the Profile popup on a user name), resources are rendered within the Resource Viewer system page (see Table 7-2, "Seeded System Pages").

	
Select the checkbox to enable context information (#{true}).


	
Clear the checkbox to prevent the display of context information (#{false}).




This parameter is associated with the Activity Stream task flow.


	
Hide Comments

	
A checkbox for specifying whether a comments link is shown on a task flow instance

	
Select the checkbox to show the comments link (#{true}).


	
Clear the checkbox to hide the comments link (#{false}).




This parameter is associated with the Activity Stream task flow.


	
Hide Configuration Button

	
A checkbox for specifying whether the Options link appears on the Activity Stream task flow or the pencil icon appears on Activity Stream - Quick View

	
Select the checkbox to show the configuration control (#{true}).


	
Clear the checkbox to hide the configuration control (#{false}).




This parameter is associated with the following task flows:

	
Activity Stream - Quick View


	
Activity Stream





	
Hide Footer

	
A checkbox for specifying whether a More link is shown at the base of the task flow

Users click the More link to navigate to the Activities business role page in the Home space.

	
Select the checkbox to hide the More link (#{true}).


	
Clear the checkbox to show the More link (#{false}).




This parameter is associated with the Activity Stream - Quick View task flow.


	
Hide Header

	
A checkbox for specifying whether to hide the controls that appear in the task flow header

	
Select the checkbox to hide the task flow header (#{true}). The Refresh and pencil icons are hidden.


	
Clear the checkbox to show the task flow header (#{false}).




This parameter is associated with the Activity Stream - Quick View task flow.


	
Hide Inline Preview

	
A checkbox for specifying whether to hide previews of streamed files

	
Select the checkbox to hide previews of streamed files (#{true}). Links to streamed files are provided but previews are omitted.


	
Clear the checkbox to show previews of streamed files (#{false}). Both links to and previews of streamed files are shown.




For information about the mime types that are supported for file previewing in Activity Stream, see Section 32.1, "What You Should Know About Activity Stream."

This parameter is associated with the Activity Stream task flow.


	
Hide Like

	
A checkbox for specifying whether to hide the Like link on streamed items

	
Select the checkbox to hide the Like link (#{true}).


	
Clear the checkbox to show the Like link (#{false}).




This parameter is associated with the Activity Stream task flow.


	
Hide Share

	
A checkbox for specifying whether to hide the Share menu on streamed items

	
Select the checkbox to hide the Share menu (#{true}).


	
Clear the checkbox to show the Share menu (#{false}).




This parameter is associated with the Activity Stream task flow.


	
No of activities to display per page

	
A field for entering the number of streamed items to show per page

This parameter is associated with the following task flows:

	
Activity Stream


	
Activity Stream - Quick View





	
Pagination

	
A checkbox for specifying whether to provide Previous and Next links to enable users to page through streamed activities

	
Select the checkbox to show Previous and Next links (#{true}).


	
Clear the checkbox to hide them (#{false}).




This parameter is associated with the Activity Stream task flow.


	
Profile Only

	
A checkbox for specifying whether to stream activities only from user profiles

	
Select the checkbox to stream only those activities associated with the current user (#{true}).


	
Clear the checkbox to stream the activities of other users along with those associated with the current user (#{false}).




This parameter is associated with the Activity Stream task flow.


	
Profile User Id

	
A field for entering the ID of the current user

This value is provided by default, #{securityContext.userName}.

This parameter is associated with the Activity Stream - Quick View task flow.


	
Resource Id

	
A field for entering the ID of the current user

This value is provided by default, #{securityContext.userName}. Users should not change this value when the task flow instance appears in the context of a space. You can use it in the Home space to view the activities of a named user.

This parameter is associated with the Activity Stream task flow.


	
Service Categories

	
A field for entering the IDs of services from which to stream activities

Use this parameter to limit the display of streamed activities to only those associated with the specified service or services. Enter the service category ID or the service ID. For a list of valid service IDs, see Table B-19, "Service IDs".

This parameter is associated with the Activity Stream task flow.


	
Spaces

	
A field for entering the names of spaces from which to stream activities

Use this parameter to limit the display of streamed activities to only those associated with the specified space or spaces.

Enter the GUID of the space or the space's internal name. The space internal name is the name specified by the Space URL on the General page of a space's administration settings.

Note that the activities that are streamed in an Activity Stream task flow that is scoped to a particular space are visible to all members of that space, regardless of whether they are formally connected to each other.

This parameter is associated with the Activity Stream task flow.












32.5.3 Using an Advanced Query to Filter Activity Stream Items

The Activity Stream task flow provides an Advanced Query parameter, which you can use to create custom filters against streamed activities using a SQL WHERE clause. For example, using SQL you can set up an Activity Stream instance to show only those activities relating to the Page service or streaming from the current user or a named user.

This section provides an overview of the Activity Stream Advanced Query option and steps you through the process of entering an advanced query. It includes the following subsections:

	
Section 32.5.3.1, "What You Should Know About the Activity Stream Advanced Query Option"


	
Section 32.5.3.2, "Entering an Advanced Query Against an Activity Stream Task Flow Instance"






32.5.3.1 What You Should Know About the Activity Stream Advanced Query Option

Use Advanced Query to create filters against user names, service IDs, and object details, such as a document's display name. You can use SQL syntax for parameter values. Additionally you can place EL expressions within the SQL.

You can construct queries against specific database objects, which are represented by aliases that are prefixed to the inquiry. Table 32-3 lists and describes the types of database objects against which you can construct a query and provides their alias prefixes.




	
See Also:

In many cases, you can use EL expressions to obtain the value you require for the supported fields and columns listed in Table 32-3. For more information, see Appendix B, "Expression Language Expressions."








Table 32-3 Supported Database Objects for Constructing a SQL WHERE Clause

	Database Object	Alias Prefix	Supported Fields/Columns
	
ACTIVITY

	
AE

	
	
SCOPE_ID—The GUID of the scope (e.g., #{serviceCtx.scope.GUID}).


	
SERVICE_ID—The service ID of the service to track. See Table B-19, "Service IDs" for a list of service IDs.


	
ACTIVITY_TIME—The time the activity occurs.

Use the datetime format that is supported in the SQL or target database. You can also use Oracle database SQL constructs, such as to_date().


	
ACTIVITY_TYPE—The type of activity to track

For a list of valid activity type names, see Table 32-4.





	
ACTIVITY (ACTOR)

	
AD

	
ACTOR_NAME—The user name of the person performing the activity.


	
ACTIVITY (OBJECT)

	
OD

	
	
SERVICE_ID—The service ID of the service from which the tracked object issues. See Table B-19, "Service IDs" for a list of service IDs.


	
OBJECT_ID—The GUID of the object.


	
DISPLAY_NAME—The object display name.


	
OBJECT_TYPE—The object type.

Object type names for use with Advanced Query include:

	
event


	
announcement


	
forum


	
topic


	
bookmark


	
list


	
page


	
blog


	
document


	
wiki















Table 32-4 Activity Type Names for Advanced Query

	Service	Activity Type Name
	
Events

	
	
createEvent


	
updateEvent





	
Announcements

	
	
createAnnouncement


	
updateAnnouncement





	
Discussions

	
	
createForum


	
createTopic


	
replyTopic





	
Tags

	
	
updateBookmark





	
Lists

	
	
createList


	
editList





	
Page

	
	
createPage


	
editPage





	
Documents

	
	
create-blog


	
update-blog


	
create-document


	
create-wiki


	
update-document


	
update-wiki





	
People Connections (Profile)

	
	
updateStatus


	
updateProfile


	
updatePhoto





	
People Connections (Message Board)

	
	
postScope


	
postself


	
post


	
sharescope


	
shareself


	
share


	
shareobjectscope


	
shareobjectself


	
shareobject


	
updatescope


	
updateself


	
update





	
People Connections (Connections)

	
	
connect


	
inviteForConnection





	
People Connections (Feedback)

	
	
post











The SQL string that is passed as the advanced query parameter complies with SQL standards. That is, it supports SQL constructs, such as AND, OR, IN, and the like. Note, however, that it does not support INSERT, UPDATE, DELETE, SELECT, JOIN constructs. The syntax of the advanced query must contain only the WHERE clause portion of a SQL query. Because SELECT is not supported, the WHERE clause cannot have nested queries or subqueries.

The Advanced Query parameter also supports EL expressions, which can be embedded in the WHERE clause or used to generate the whole WHERE clause.

All the literals in the query must be escaped by prepending a backward slash (\), otherwise such characters generate syntax errors (see Table 32-5 for examples).

Note that the advanced query WHERE clause is always AND'ed to the internal query that is generated by Activity Stream based on the current user, space membership, connection list, and the like. This is to prevent a user from viewing activities to which he or she does not have access.

Table 32-5 lists examples of advanced queries.


Table 32-5 Examples of Advanced Queries for Use with Activity Stream

	Use Case	Query Syntax
	
Stream only document creation activities.

	
AE.SERVICE_ID = \'oracle.webcenter.doclib\'


	
Stream activities only from an object or current space.

	
OD.OBJECT_ID = \'objectA\' OR AE.SCOPE_ID = \'#{serviceCtx.scope.GUID}\'


	
Stream activities only about wikis created by the current user.

	
OD.OBJECT_TYPE = \'Wiki\' AND AD.ACTOR_NAME = \'#{securityContext.userName}\'


	
Stream activities for documents and discussions, but only create activities or all activities for the current user.

	
(AE.SERVICE_ID IN (\'oracle.webcenter.doclib\', \'oracle.webcenter.collab.forum\') AND AE.ACTIVITY_TYPE IN (\'createDocument\', \'createTopic\')) OR AD.ACTOR_NAME = \'#{securityContext.userName}\'












32.5.3.2 Entering an Advanced Query Against an Activity Stream Task Flow Instance

To enter an advanced query against an instance of the Activity Stream task flow:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward (Figure 32-12).


Figure 32-12 Activity Stream Task Flow Component Properties

[image: Activity Stream component properties]

Description of "Figure 32-12 Activity Stream Task Flow Component Properties"





	
Provide a value for the property Advanced Query:




	
See Also:

See Section 32.5.3.1, "What You Should Know About the Activity Stream Advanced Query Option," for information about the type and format of values to provide for this field.








	
Click OK.




Going forward, streamed activities are filtered by your query.








32.5.4 Using Properties to Configure an Activity Stream Task Flow Instance

This section provides examples of how you use property values to affect the behavior of a given task flow instance. It includes the following subsections:

	
Section 32.5.4.1, "Preventing Users from Customizing an Activity Stream"


	
Section 32.5.4.2, "Hiding File Previews in Streamed Items"


	
Section 32.5.4.3, "Preventing Users from Commenting on Streamed Items"


	
Section 32.5.4.4, "Preventing Users from Liking Streamed Items"


	
Section 32.5.4.5, "Preventing Users from Sharing Streamed Items"


	
Section 32.5.4.6, "Limiting the Stream to Activities from One or More Spaces"


	
Section 32.5.4.7, "Limiting the Stream to One or More Services"


	
Section 32.5.4.8, "Limiting the Stream to Your Own Activities"






32.5.4.1 Preventing Users from Customizing an Activity Stream

By default, Activity Stream task flows provide user customization controls that enable users to specify whose actions they want to see and from what services and spaces in a given Activity Stream task flow. On the Activity Stream task flow, this is the Options link. On the Activity Stream - Quick View task flow, this is the pencil icon.

The Hide Configuration Button property is available when you want to prevent users from overriding application-level customizations with their own user-level customizations.

To prevent users from customizing an Activity Stream task flow instance:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Hide Configuration Button:

	
Select the checkbox (#{true}) to omit the display of the Options link or pencil icon on the task flow instance.


	
Clear the checkbox (#{false}) to show these controls on the task flow instance.





	
Click OK.









32.5.4.2 Hiding File Previews in Streamed Items

By default, in most cases where an Activity Stream item has an associated file, such as a document or an image, both a file link and a file preview are shown with the item (Figure 32-13).


Figure 32-13 Previewed File in Activity Stream

[image: Previewed file in Activity Stream]



Activity Stream previews files through either a native web format or through Oracle WebCenter Content slide rendition. The previewer used depends on the mime type of the file to be previewed.

The mime types that use the native web format include:

	
image


	
htm


	
text


	
pdf




The mime types that use Oracle WebCenter Content slide rendition include:

	
powerpoint


	
powerpnt


	
pptx




Note that the mime types shown in these bullet lists are the only mime types that are previewed. Other mime types appear as links.

You can use the Hide Inline Preview property to suppress the file preview, leaving the link for accessing the file should users want to do so.

The Hide Inline Preview property is provide with the Activity Stream task flow.

To hide a file preview in streamed items:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Hide Inline Preview:

	
Select the checkbox (#{true}) to omit the display of a file preview with items streamed from the Documents service.


	
Clear the checkbox (#{false}) to show inline previews with items streamed from the Documents service.





	
Click OK.









32.5.4.3 Preventing Users from Commenting on Streamed Items

By default, a comments link is shown with all items in an Activity Stream task flow to enable users to comment on a given item (Figure 32-14).


Figure 32-14 Comments Link on a Streamed Item

[image: Comments link on a streamed item]



You can use the Hide Comments property to suppress the display of the comments link and, consequently, prevent users from commenting on streamed items in a given task flow instance.

To prevent users from commenting on streamed items:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Hide Comments:

	
Select the checkbox (#{true}) to hide the comments link on streamed items.


	
Clear the checkbox (#{false}) to show the comments link on streamed items.





	
Click OK.









32.5.4.4 Preventing Users from Liking Streamed Items

By default, a Like link is shown with all items in an Activity Stream task flow to enable users to express a favorable opinion of a given item (Figure 32-15).


Figure 32-15 Like Link on a Streamed Item

[image: Like link on a streamed item]



Once clicked, the Like link switches to an Unlike link to enable users to undo their favorable opinion.

You can use the Hide Like property to suppress the display of the Like link, and, consequently, prevent users from liking streamed items in a given task flow instance.

To prevent users from liking streamed items:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Hide Like:

	
Select the checkbox (#{true}) to hide the Like link on streamed items.


	
Clear the checkbox (#{false}) to show the Like link on streamed items.





	
Click OK.









32.5.4.5 Preventing Users from Sharing Streamed Items

By default, a Share menu is shown with all items in an Activity Stream task flow to enable users to share a streamed item with their connections (Figure 32-16).


Figure 32-16 Share Menu on a Streamed Item

[image: Share menu on a streamed item]



You can use the Hide Share property to suppress the display of the Share menu, and, consequently prevent users from sharing streamed items from a given task flow instance.

To prevent users from sharing streamed items:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Hide Share:

	
Select the checkbox (#{true}) to hide the Share menu on streamed items.


	
Clear the checkbox (#{false}) to show the Share menu on streamed items.





	
Click OK.









32.5.4.6 Limiting the Stream to Activities from One or More Spaces

Configuration options in both the Activity Stream and Activity Stream - Quick View task flows provide all-or-none options for streaming activities from spaces (see Section 32.4.2, "Selecting the Spaces to Stream in an Activity Stream Instance"). The Spaces property associated with the Activity Stream task flow provides the additional dimension of selecting specific spaces from which to stream activities.

To limit the stream to activities from one or more spaces:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
In the Spaces field, enter a comma-separated list of the space names or space GUIDs from which to stream activities in this task flow instance.




	
Tip:

Enter the space internal name. The space internal name is the name specified by the Space URL on the General page of a space's administration settings.
You can obtain the space GUID from the About Space dialog (see Section 29.9.1, "Accessing Space Information") or by using the EL expression.










	
Click OK.









32.5.4.7 Limiting the Stream to One or More Services

Configuration options for both the Activity Stream and Activity Stream - Quick View task flows provide a means of selecting the service categories from which to stream activities (see Section 32.4.3, "Selecting the Services to Stream in an Activity Stream Instance").

The Service Categories property associated with the Activity Stream task flow extends this capability by enabling you to enforce a particular selection. For example, you can specify the service category documents, and only those connections' activities that stream from the Documents service are shown in the task flow instance.

To limit streamed activities to one or more services:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
In the Service Categories field, enter a comma-separated list of the services from which to stream activities in this task flow instance.




	
Tip:

Enter the service category ID or the service ID. For a list of valid service IDs, see Table B-19, "Service IDs"








	
Click OK.









32.5.4.8 Limiting the Stream to Your Own Activities

You can use the Profile Only property associated with the Activity Stream task flow to limit the display of streamed activities to just your own activities.

To limit streamed activities to just your own:

	
Edit the properties of an Activity Stream task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Profile Only:

	
Select the checkbox (#{true}) to show only your own activities.


	
Clear the checkbox (#{false}) to stream your own and your connections' activities.





	
Click OK.
















33 Posting and Managing Messages and Feedback

WebCenter Portal: Spaces provides task flows for posting messages and Feedback to your connections. Use Message Board task flows to post, view, and manage messages to and from your connections. Use Feedback task flows to post, view, and manage Feedback to and from your connections.

This chapter provides an overview of Message Board and Feedback and steps you through the process of enabling, viewing, and managing messages and Feedback. It includes the following sections:

	
Section 33.1, "What You Should Know About Message Board and Feedback"


	
Section 33.2, "Setting Message Board and Feedback Preferences"


	
Section 33.3, "Enabling Other Users to Post Messages and Feedback for You"


	
Section 33.4, "Working with Message Board and Feedback Task Flows"


	
Section 33.5, "Setting Message Board and Feedback Task Flow Properties"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission People Connections: Update People Connections Data. Users who plan to edit task flow properties must be assigned a role that also includes the permission Edit Pages. In a space (other than the Home space), users must be assigned a role that includes the permission Edit Page Access and Structure.



33.1 What You Should Know About Message Board and Feedback

This section provides an overview of the task flows and features associated with Message Board and Feedback. It includes the following sections:

	
Section 33.1.1, "What You Should Know About Message Board"


	
Section 33.1.2, "What You Should Know About Feedback"






33.1.1 What You Should Know About Message Board

Message Board provides a means of viewing and posting messages and attachments to Message Boards and Activity Streams. Messages posted to and received on a Message Board (even those marked private) are shared with all of your connections and all of the recipient's connections in their views of the Activity Stream, depending on your portal configuration and your Activity Stream preference settings.




	
Note:

The messages you mark private are shown only to you and the recipient in your views of Message Board. However, private messages are shared with all of your connections and with all of the recipient's connections in their views of Activity Stream, unless your administrator configures Activity Stream to omit showing actions from Message Board or you do so through your personal Activity Stream preferences. For more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences."







In your view of the Home space, Message Board enables you to view messages and attachments from your connections.

Message Boards in your connections' view of the Home spaces enable you to view the messages and attachments they have received and to post messages and attachments to their Message Boards, provided they have granted you access.

In spaces other than the Home space, Message Board provides a means of viewing and posting messages within the scope of the space. In a space, every instance of a Message Board task flow shows the same content: messages left by authorized users who are members of the space. The space Message Board leverages Page service permissions as its permission model.

Table 33-1 lists the page permissions required for performing actions in a space Message Board.


Table 33-1 Page Permissions for a space Message Board

	Page Permission	Post	View	Update	Delete
	
View Page

	
No

	
Yes

	
No

	
No


	
Personalize Page

	
Yes

	
Yes

	
Yes for messages posted by this user

	
Yes for messages posted by this user


	
Perform All Page Actions

	
Yes

	
Yes

	
Yes for all messages

	
Yes for all messages











	
See Also:

For information about space permissions, see Chapter 52, "Managing Space Members and Roles."







When you connect with other users, you potentially give them access to your Message Board and gain access to theirs. Access to other users' Message Boards must be specifically granted through Message Board Preferences.




	
See Also:

You can grant access to your Message Board through People Connections Preferences. For more information, see Section 33.2.1, "Setting Message Board Preferences."







Before you access your Message Board or Message Board Preferences, your application administrator can set global application defaults that affect what all users may see and do with their own and other users' Message Boards. For more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."

WebCenter Portal: Spaces provides the following Message Board task flows:

	
Message Board for adding, viewing, updating, hiding, deleting, and managing your view of messages, and for marking messages as private and sharing private messages (Figure 33-1)


Figure 33-1 Message Board Task Flow

[image: Message Board task flow]



	
Message Board - Quick View for adding, viewing, updating, hiding, and deleting messages, and for marking messages as private and sharing private messages (Figure 33-2)


Figure 33-2 Message Board - Quick View Task Flow

[image: Message Board - Quick View task flow]








	
See Also:

The Publisher task flow has many qualities in common with Message Board, but is a separate feature. For more information about the Publisher task flow, see Chapter 34, "Liking, Commenting On, and Sharing Objects."







For more information about Message Board features, see Section 33.4, "Working with Message Board and Feedback Task Flows."






33.1.2 What You Should Know About Feedback

Feedback provides a means of viewing, posting, and managing feedback remarks. By default, you can view Feedback in your own Feedback view. You can view and post Feedback in your connections' Feedback views—provided they have granted you access.




	
Note:

The feedback you mark private are shown only to you and the recipient in your views of Feedback task flows. However, private Feedback is shared with all of your connections and with all of the recipient's connections in their views of Activity Stream, unless your administrator configures Activity Stream to omit showing actions from Feedback or you do so through your personal Activity Stream preferences. For more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences."







When you connect with other users, you potentially give them access to your Feedback view and gain access to theirs. Access to other users' Feedback views must be specifically granted through Feedback preferences.




	
See Also:

You can grant access to your view of Feedback through People Connections preferences. For more information, see Section 33.2.2, "Setting Feedback Preferences."







Feedback posts are also streamed to the Activity Stream, unless the application administrator has configured the Activity Stream not to show Feedback activity. Additionally, you can elect not to show Feedback activity in your own view of the Activity Stream through your personal Preference settings.




	
See Also:

For information about administrator-level Activity Stream settings, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application." For information about your personal Activity Stream Preferences, see Section 32.2, "Setting Activity Stream Preferences."







Before you access your view of Feedback or your Feedback Preferences, your application administrator can set global application defaults that affect what all users may see and do with their own and other users' views of Feedback. For more information, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application."

WebCenter Portal: Spaces provides the following Feedback task flows:

	
Feedback for viewing, posting, and managing Feedback (Figure 33-3)


Figure 33-3 Feedback Task Flow

[image: Feedback task flow]



	
Feedback - Quick View for viewing and posting Feedback (Figure 33-4)


Figure 33-4 Feedback - Quick View Task Flow

[image: Feedback - Quick View task flow]








	
See Also:

For information about business role pages, see Section 7.1, "Working with Business Role Pages."







For more information about Feedback features, see Section 33.4.2, "Working with Feedback Task Flows."








33.2 Setting Message Board and Feedback Preferences

This section describes how to use Message Board and Feedback Preferences to specify who can view and who can post messages to your view of these task flows. It includes the following subsections:

	
Section 33.2.1, "Setting Message Board Preferences"


	
Section 33.2.2, "Setting Feedback Preferences"






33.2.1 Setting Message Board Preferences

Use Message Board preferences to specify who can view and post to your Message Board.

To set Message Board Preferences:

	
Open the Preferences dialog.


	
Click People Connections to display People Connections Preferences.


	
Click the Message Board tab to bring it forward (Figure 33-5).


Figure 33-5 Message Board Preferences

[image: Message Board Preferences]



	
Set your Preferences for the Message Board.

Table 33-2 lists and describes each option.


Table 33-2 Message Board Preference Options

	Option	Description
	
Grant View Access to

	
Select who can view your Message Board:

	
Everyone—All users, including users who are not logged in, can view your Message Board messages.


	
Authenticated Users—Only users who are logged in can view your Message Board messages.


	
User's Connections—Only you and the users you your Connections can view your Message Board messages.


	
User Only—Only you can view your Message Board messages.





	
Grant Post Access to

	
Select who can post messages to your Message Board:

	
Everyone—All users, including users who are not logged in, can post messages to your Message Board.


	
Authenticated Users—Only users who are logged in can post messages to your Message Board.


	
User's Connections—Only you and your Connections can post messages to your Message Board.


	
User Only—Only you can post messages to your Message Board.











	
Click OK.









33.2.2 Setting Feedback Preferences

Use Feedback preferences to specify who can view the Feedback you have given and received and who can post Feedback in your view of Feedback task flows.

To set Feedback Preferences:

	
Open the Preferences dialog.


	
Click People Connections to display People Connections Preferences.


	
Click the Feedback tab to bring it forward (Figure 33-6).


Figure 33-6 Feedback Preferences

[image: Feedback Preferences]



	
Set your Preferences for Feedback.

Table 33-3 lists and describes each option.


Table 33-3 Feedback Preference Options

	Option	Description
	
Grant View Access to

	
Select who can view Feedback given to you.

	
Everyone—All users, including users who are not logged in, can view the Feedback you have given.


	
Authenticated Users—Only users who are logged in can view the Feedback you have given.


	
User's Connections—Only you and your Connections can view the Feedback you have given.


	
User Only—Only you and the user for whom you have provided Feedback can view the Feedback you have given.





	
Grant Post Access to

	
Select who can provide Feedback to you.

	
Everyone—All users, including users who are not logged in, can post Feedback messages to you.


	
Authenticated Users—Only users who are logged in can post Feedback messages to you.


	
User's Connections—Only you and your Connections can post Feedback messages to you.


	
User Only—No one can post Feedback messages to you.





	
Grant View Feedback Given Access to

	
Select who can view Feedback you have received.

	
Everyone—All users, including users who are not logged in, can view Feedback you have received.


	
Authenticated Users—Only users who are logged in can view Feedback you have received.


	
User's Connections—Only you and your Connections can view Feedback you have received.


	
User Only—No one can view Feedback you have received.











	
Click OK.











33.3 Enabling Other Users to Post Messages and Feedback for You

To set up your Message Board and Feedback task flows so that users can post messages and Feedback specifically for you, you must add a Message Board or Feedback task flow to a page in your view of the Home space, and share that page with your connections. Additionally, you must set a parameter on the task flow to identify yourself as the task flow owner. Once this is set up, your connections can access this page and post messages and Feedback for you. This section steps you through this process.

To enable other users to post messages and Feedback for you:

	
Go to the page in the Home space to which to grant access to your connections, or create such a page.




	
See Also:

For more information, see Chapter 38, "Creating and Managing Personal Pages."








	
Set page access to enable your connections to view and personalize the page.




	
See Also:

For more information, see Section 38.2, "Controlling User Access to Your Personal Pages."










	
Tip:

When you share one of your personal pages in the Home space with other users, the shared page appears in their Personalize Pages page. Such users can use controls on the Personalize Pages page to show the page in their own views of the Home spaces.








	
Enter page edit mode and add a Message Board or Feedback task flow to the page.




	
See Also:

For information about editing a page and adding content, see Section 17.5, "Adding Resource Catalog Components to Pages."








	
Edit the task flow instance.




	
See Also:

For information about editing a task flow instance, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward and enter your user name in the required field:

	
For Message Board and Message Board - Quick View task flows, enter your user name in the User Name field.


	
For the Feedback task flow, enter your user name in the Resource Id field.


	
For the Feedback - Quick View task flow, enter your user name in the User Id field.





	
Save your changes and exit page edit mode.




If you care to, you can send a link to this page to your connections, inviting them to leave you messages or Feedback whenever they are moved to do so. For more information, see Section 29.7, "Sending a Link to a Page."

All users who have access to the page see the Message Board or Feedback task flows that you place there. But only the users to whom you have granted access, through Preferences, see any content in the task flows.




	
See Also:

For information about setting Message Board and Feedback Preferences, see Section 33.2, "Setting Message Board and Feedback Preferences."












33.4 Working with Message Board and Feedback Task Flows

This section steps you through using the features provided with Message Board and Feedback task flows. It includes the following subsections:

	
Section 33.4.1, "Working with Message Board Task Flows"


	
Section 33.4.2, "Working with Feedback Task Flows"







	
See Also:

The properties available on a given task flow instance provide additional opportunities to affect the appearance and behavior of the task flow. For more information, see Section 33.5, "Setting Message Board and Feedback Task Flow Properties."









33.4.1 Working with Message Board Task Flows

Message Board task flows provide a means of viewing and posting messages to your connections and attaching files and URLs to your posts. This section discusses how to post messages and attachments and how to edit, hide, show, sort, filter, and delete messages. It includes the following subsections:

	
Section 33.4.1.1, "Viewing Messages"


	
Section 33.4.1.2, "Posting Messages"


	
Section 33.4.1.3, "Editing Message Board Messages"


	
Section 33.4.1.4, "Sorting and Filtering Message Board Messages"


	
Section 33.4.1.5, "Hiding Messages in Your View of Message Board"


	
Section 33.4.1.6, "Showing Hidden Messages"


	
Section 33.4.1.7, "Deleting Message Board Messages"






33.4.1.1 Viewing Messages

Once you and your connections have set up your own Message Boards, you can see your own and, potentially, each other's messages. This section provides information about how to view each other's messages post-set-up. It includes the following subsections:

	
Section 33.4.1.1.1, "Viewing Messages Others Have Left for You"


	
Section 33.4.1.1.2, "Viewing Messages Others Have Received"


	
Section 33.4.1.1.3, "Viewing Messages Sent to a Selected space"







	
Tip:

For information about setting up your view of Message Board, see Section 33.3, "Enabling Other Users to Post Messages and Feedback for You."









33.4.1.1.1 Viewing Messages Others Have Left for You

To view Message Board messages other users have left for you, go to the personal page in the Home space that you have set up to receive Message Board messages (Figure 33-7).


Figure 33-7 Message Board Task Flow

[image: Message Board task flow]







33.4.1.1.2 Viewing Messages Others Have Received

To view Message Board messages other users have received (including those you have left for them), go to the page the user has made available to you in your view of the Home space. You can access this page through the Home space Personalize Pages page. For more information, see Section 29.3.2, "Opening Pages."






33.4.1.1.3 Viewing Messages Sent to a Selected space

Message Boards placed in a space provide a means of viewing and posting messages within the space context. All default Message Board task flow instances within a given space display the same content: messages left by authorized users who are members of the space. All users with access to the space can see the posted messages.








33.4.1.2 Posting Messages

This section describes the various ways you can post messages and attachments. It includes the following subsections:

	
Section 33.4.1.2.1, "Posting a Message to all of Your Connections"


	
Section 33.4.1.2.2, "Posting a Message Scoped to a Selected space"


	
Section 33.4.1.2.3, "Posting a Private Message"


	
Section 33.4.1.2.4, "Sharing a Private Message"


	
Section 33.4.1.2.5, "Attaching a File or URL to a Message Board Message"






33.4.1.2.1 Posting a Message to all of Your Connections

Using the Share menu on the Message Board - Quick View task flow, you can select whether to post a message to all of your connections or to all of your connections who belong to a selected space.

This section describes how to share a message with all of your connections. For information about sharing a message with all of your connections in a space, see Section 33.4.1.2.2, "Posting a Message Scoped to a Selected space."




	
See Also:

For information about Connections, see Chapter 31, "Creating Your Social Network."







To post a Message Board message to a selected audience:

	
Go to your view of the Message Board - Quick View task flow.


	
From the Share something with menu, select Everyone (Figure 33-8).


Figure 33-8 Share Option on Message Board - Quick View Task Flow

[image: Share Option on Message Board - Quick View]



	
Enter a message in the field provided, and click Publish (Figure 33-9).


Figure 33-9 Publish Button on a Message Board - Quick View Task Flow

[image: Publish button]



The message appears in all of your connections' views of Message Board and Activity Stream.









33.4.1.2.2 Posting a Message Scoped to a Selected space

The Message Board - Quick View task flow provides a means of posting a message that is pushed to the Message Boards and Activity Streams of a selected space.

To post a message scoped to a selected space:

	
Go to your view of the Message Board - Quick View task flow.


	
From the Share Something With menu, select the space and go to step 5; or, if the space is not listed, select More Spaces, and go to step 3.


	
In the resulting Select a space dialog, open the Show spaces menu and select to show:

	
All—all spaces that are available to you


	
Joined—The spaces you have joined


	
Public—The spaces that do not require a user to be logged in


	
Moderated—The spaces that you moderate




If you prefer, search for the space name using the provided field.


	
Select a space from the resulting list, and click OK.


	
Enter your message.


	
Optionally, attach a file or URL.




	
See Also:

For more information, see Section 33.4.1.2.5, "Attaching a File or URL to a Message Board Message."








	
Click Share to post your message.

The message is posted to Message Boards and Activity Streams in the selected space.









33.4.1.2.3 Posting a Private Message

Provided you are authorized to do so, you can post a private message to any of your connections. When you mark a message as private, only you and the recipient can see the message in your views of Message Board; however, all of your connections and all of the recipient's connections can see private messages in Activity Stream, unless the application is configured to omit Message Board activity from the Activity Stream or you have configured your Activity Stream preferences to do so.




	
See Also:

For more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences."







To post a private message:

	
Go to your My Profile page and click Connections to bring it forward.




	
Tip:

If necessary, set the Show menu to All Connections.








	
Click the name of the user for whom to leave a message to open the Profile popup, and click Add Message (Figure 33-10).


Figure 33-10 Add Message Link in Profile Popup

[image: Add Message link in Profile popup]



	
Enter your message in the Add Message dialog (Figure 33-11).


Figure 33-11 Add Message Dialog

[image: Add Message dialog]



	
Select the Private checkbox to allow only the recipient to see the message.


	
Click Save and Close when you have finished.

The message appears in the recipient's views of Message Board and Activity Stream.









33.4.1.2.4 Sharing a Private Message

When you receive a private message, you can opt to share that message with all users who have access to your Message Board by marking it as shared. When someone sends you a message marked private, only you and the sender can see it in the Message Board (though all of your connections and the sender's connections can see the message in their Activity Streams, unless the Activity Stream in configured to omit Message Board activity).




	
See Also:

For information about omitting services from Activity Stream at the application and personal levels, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences."







When you mark a private message as shared, you open it up to those permitted to see your view of the Message Board.

To mark a message as shared:

	
Go to the message you want to mark as shared in your view of the Message Board task flow.


	
Click the Share link next to the relevant message (Figure 33-12).


Figure 33-12 Share Link on a Private Message

[image: Share link on a private message]



The message can be viewed by everyone who can access your Message Board.









33.4.1.2.5 Attaching a File or URL to a Message Board Message

Provided the task flow is configured to allow it, you can attach files and URLs to the messages you post to a Message Board - Quick View task flow in a Home space.




	
Note:

Message Boards in spaces, other than the Home space, cannot be posted to any space other than the current space.







To attach a file or URL to a message:

	
Go to the Home space, and enter a message in a Message Board - Quick View task flow.


	
Next to Attach, click the File or Link icon (Figure 33-13).


Figure 33-13 Attach Options on a Message Board - Quick View Task Flow

[image: Attach options]



	
For File, click Browse to locate and select the file to share (Figure 33-14)


Figure 33-14 Attach File Feature

[image: Attach File feature]



For Link, enter the target URL, and click Attach (Figure 33-15).


Figure 33-15 Attach Link Feature

[image: Attach Link feature]



	
Click Share.











33.4.1.3 Editing Message Board Messages

Your application administrator can configure the Message Board feature to enable users to revise the messages they leave. Provided this permission is in place, you can edit any message you post.




	
See Also:

For information about configuring application-level Message Board settings, see Section 6.4.3.5, "Configuring Message Board."







To edit a Message Board message:

	
Go to the message you want to edit.


	
Click the Edit link associated with the message (Figure 33-16).


Figure 33-16 Edit Link on a Message

[image: Edit link on a message]



The Edit Message dialog opens with a rich text editor prepopulated with your message text (Figure 33-17).


Figure 33-17 Edit Message Dialog

[image: Edit Message dialog]



	
Revise your message, and click Save.









33.4.1.4 Sorting and Filtering Message Board Messages

Your full view of the Message Board task flow includes sorting and filtering features for managing your view of your messages. Use the sorting feature to sort your messages by date or by the person who left the message. Use the filtering feature to show messages posted on a particular date or within a given date range.

To sort and filter your Message Board messages:

	
Go to the Message Board task flow.


	
From the Sort By menu, select a sorting option (Figure 33-18):


Figure 33-18 Options on Sort By Menu

[image: Options on Sort By menu]



	
Date—Sort your messages by the date they were posted, from most recent to oldest.


	
Person Name—Sort your messages by the user name of the person who posted them, from A to Z.





	
To show messages between a particular range of dates, enter the beginning and end of the range respectively in the fields after From and To (Figure 33-19).


Figure 33-19 Sort By Date Range Options

[image: Sort By date range options]






	
Tip:

Instead of entering dates, you can click the Select Date icon next to a field to select a date from a calendar.










	
Accessibility Note:

In WebCenter Portal: Spaces, you cannot use the keyboard to select a date from the calendar that pops up when you click the Select Date icon. Instead, manually enter the date into the field.








	
Click the button to the right of the fields to apply the filter.

The Message Board refreshes, showing only those messages that fit your sorting and filtering criteria.







	
Tip:

To remove the date filtering criteria from your Message Board view, click the Clear Date icon to the right of the date range fields. [image: Clear Date icon]












33.4.1.5 Hiding Messages in Your View of Message Board

You can hide any message you have received on your Message Board. Hiding provides a means of removing messages from your own view without actually deleting them. It is a non-permanent way to reduce the visual clutter of your Message Board view.

Users to whom you have given access to your messages can still see the messages that you have hidden.

To hide Message Board messages:

	
Go to the message you want to hide in your view of the Message Board task flow.


	
Click the Hide link next to the message you want to hide (Figure 33-20).


Figure 33-20 Hide Link on a Message

[image: Hide link on a message]



The message is hidden in your view of the Message Board. Other users you have permitted to view your Message Board can see this message when they visit your view.









33.4.1.6 Showing Hidden Messages

Use the Hidden checkbox on the Message Board task flow to show all of the messages you have hidden. The Hidden checkbox provides a means of showing all hidden messages in one operation, making it available to be unhidden or deleted.

To show hidden Message Board messages:

	
In your view of the Message Board task flow, select the Hidden checkbox to show the messages you have hidden (Figure 33-21).


Figure 33-21 Hidden Checkbox on a Message Board Task Flow

[image: Hidden checkbox]



	
Click the Unhide link next to the message you want to show (Figure 33-22).


Figure 33-22 Unhide Link on a Message Board Task Flow

[image: Unhide link]



	
Optionally, clear the Hidden checkbox to hide the messages that are still marked as hidden.









33.4.1.7 Deleting Message Board Messages

Your application administrator can configure the Message Board to allow users to delete the messages they send. Provided this permission is in place, you can delete any message you send.




	
See Also:

For information about configuring application-level Message Board settings, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application.".







To delete a message you sent:

	
Go to your view of the Message Board, and click the Delete icon next to the message you want to delete (Figure 33-23).


Figure 33-23 Delete Icon on a Message

[image: Delete icon on a message]



	
In the resulting confirmation dialog, click the Delete button.











33.4.2 Working with Feedback Task Flows

Feedback provides a means of viewing and posting remarks on the job performance of your connections. In your own view of the Feedback task flow, you can view the Feedback you have posted and that was posted for you. In a connection's view of the Feedback task flow, you can post Feedback for that connection and view all of the Feedback left for that connection, provided he has granted you view and post access.




	
See Also:

Feedback is also posted to the Activity Stream, unless Activity Stream is configured not to show Feedback activity. For more information, see Section 33.1.2, "What You Should Know About Feedback."







When you view another user's Feedback, you can view only the Feedback they have received. To view the Feedback they have sent, you must go to the recipients' views of the Feedback task flow.




	
See Also:

Use Preferences settings to configure user access to your Feedback. For more information, see Section 33.2.2, "Setting Feedback Preferences."







This section discusses how to view, hide, show, sort, filter, post, and delete Feedback messages. It includes the following subsections:

	
Section 33.4.2.1, "Viewing Feedback"


	
Section 33.4.2.2, "Posting Feedback"


	
Section 33.4.2.3, "Deleting Feedback"






33.4.2.1 Viewing Feedback

This section provides information about accessing the Feedback you have posted or received and hiding and unhiding posted Feedback. It includes the following sections:

	
Section 33.4.2.1.1, "Viewing Feedback You Have Posted or Received"


	
Section 33.4.2.1.2, "Sorting and Filtering Feedback Posts"


	
Section 33.4.2.1.3, "Hiding Feedback in Your Own View"


	
Section 33.4.2.1.4, "Showing Hidden Feedback"


	
Section 33.4.2.1.5, "Marking Feedback Received as Private"






33.4.2.1.1 Viewing Feedback You Have Posted or Received

A View menu on Feedback task flows provides a means of viewing the Feedback you have posted for others and the Feedback you have received from others.

To view Feedback you have posted or received:

	
Go to your view of a Feedback task flow in the Home space.


	
Select an option from the View menu (Figure 33-24):

	
Given—To view the Feedback you have posted for others


	
Received—To view the Feedback others have left for you





Figure 33-24 Feedback Task Flow View Menu

[image: Feedback task flow View menu]










33.4.2.1.2 Sorting and Filtering Feedback Posts

The main Feedback task flow includes sorting and filtering features for controlling what is shown in your view. Use the sorting feature to sort your Feedback by date or by person—that is, the user name of the person who left the Feedback. Use the filtering feature to display Feedback posted on a particular date or within a given date range.

To sort and filter your Feedback:

	
Go to your view of the main Feedback task flow.


	
Select an option from the Sort By menu (Figure 33-25):


Figure 33-25 Sort By Menu on Feedback Task Flow

[image: Sort By menu on Feedback task flow]



	
Date—To sort Feedback posts from the most recent to the oldest.


	
Person Name—To sort Feedback posts by the name of the user who left it for you (View is set to Received) or by the name of the user you left it for (View is set to Given).





	
To specify a date range, enter a start date in the field that follows From and enter an end date in the field that follows To (Figure 33-26).


Figure 33-26 Sort By Date Range Fields on Feedback Task Flow

[image: Sort By date range fields]






	
Tip:

You must enter both a start and end date, even when you want to view Feedback posts from a given day. In such a case, enter the same date in both fields.
Instead of entering dates, you can click the Select Date icon next to a field to select a date from a calendar.












	
Accessibility Note:

In WebCenter Portal: Spaces, you cannot use the keyboard to select a date from the calendar that pops up when you click the Select Date icon. Instead, manually enter the date into the field.








	
Click the Search Feedback icon.

All of the Feedback posts (either received or given) that fall within the specified date range appear in the Feedback task flow.







	
Tip:

To remove the date filtering criteria from your Feedback view, click the Clear Date icon.












33.4.2.1.3 Hiding Feedback in Your Own View

You can hide any Feedback in your own view of the Feedback task flow. Hiding provides a means of removing Feedback posts from your own view without actually deleting them. Users to whom you have given access to your Feedback can still see the posts you have hidden.




	
See Also:

For information about undoing this action, see Section 33.4.2.1.4, "Showing Hidden Feedback").







To hide Feedback in your own view:

	
Go to your view of the main Feedback task flow.


	
Click the Hide link next to the Feedback message you want to hide (Figure 33-27).


Figure 33-27 Hide Link on a Feedback Message

[image: Hide link on a Feedback message]










33.4.2.1.4 Showing Hidden Feedback

Use the Hidden checkbox on the Feedback task flow to show all the Feedback you have hidden. The Hidden checkbox provides a means of showing all hidden Feedback in one operation, making it available to be unhidden or deleted.

To show hidden Feedback posts:

	
Go to your view of the Feedback task flow.


	
Select the Hidden checkbox (Figure 33-28).


Figure 33-28 Hidden Checkbox on a Feedback Task Flow

[image: Hidden checkbox on a Feedback task flow]



	
All the Feedback posts you have hidden are shown.


	
Click the Unhide link to the right of the Feedback you want to show (Figure 33-29).


Figure 33-29 Unhide Link on a Feedback Task Flow

[image: Unhide link on a Feedback task flow]



	
To remove hidden Feedback posts from your view, clear the Hidden checkbox.









33.4.2.1.5 Marking Feedback Received as Private

When you view Feedback you have received, you typically have the option of clicking a Private link to shield the Feedback from other viewers (Figure 33-30).


Figure 33-30 Private Link on a Feedback Message

[image: Private link on a Feedback message]



It is possible to set a property on the task flow that suppresses the Private link (for more information, see Section 33.5, "Setting Message Board and Feedback Task Flow Properties"). Also, unless Activity Stream is configured at the application level or the personal level (through Preferences) to omit Feedback activity, your connections and the poster's connections can see even private Feedback in their Activity Streams.




	
See Also:

For more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences."














33.4.2.2 Posting Feedback

Use Feedback to pass along remarks to your connections about their efforts and results. Keep in mind that a wider audience than just your connections may see your Feedback message.

To post a Feedback message:

	
Go to the page the user has set up to receive Feedback.




	
See Also:

For more information, see Section 33.3, "Enabling Other Users to Post Messages and Feedback for You."








	
Click Add Feedback (Figure 33-31).


Figure 33-31 Add Feedback Button on a Feedback Task Flow

[image: Add Feedback button on a Feedback task flow]



	
In the resulting Add Feedback dialog, enter your Feedback in the text area (Figure 33-32).




	
Tip:

The Add Feedback dialog provides an integrated rich text editor that enables you to add styles, links, and other HTML encoding to your Feedback.








Figure 33-32 Add Feedback Dialog with Rich Text Editor

[image: Add Feedback dialog with RTE]



	
When you finish entering text, click Add.




Once you click Add, your Feedback appears in the selected user's view of the Feedback task flow.






33.4.2.3 Deleting Feedback

You can delete Feedback you have posted to other users, provided your WebCenter Portal: Spaces administrator has enabled you to do so.

If Activity Stream is configured to show Feedback activity, deleted Feedback posts nonetheless continue to show in the Activity Stream of the recipient and all of your connections.




	
See Also:

for information about administrator-level Feedback settings, see Section 6.4, "Configuring People Connections Defaults for the Spaces Application." For information about configuring your personal Activity Stream Preferences, see Section 32.2, "Setting Activity Stream Preferences."







To delete Feedback you have posted:

	
Go to your view of the Feedback task flow.


	
From the View menu, select Given.


	
Click the Delete icon next to the post you want to delete (Figure 33-33).


Figure 33-33 Delete Icon on a Feedback Message

[image: Delete icon on a Feedback message]



	
Click Delete in the resulting confirmation dialog.

The Feedback is deleted from your view and from the view of the user for whom you left it.













33.5 Setting Message Board and Feedback Task Flow Properties

Both Message Board and Feedback task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 33-34).


Figure 33-34 Component Properties Dialog for a Feedback Task Flow

[image: Feedback component properties dialog]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties of Message Board and Feedback task flows and describe the properties on the Parameters tab:

	
Section 33.5.1, "What You Should Know About Message Board and Feedback Task Flow Properties"


	
Section 33.5.2, "Message Board and Feedback Task Flow Parameters"


	
Section 33.5.3, "Using Parameters to Configure Message Board and Feedback Task Flow Instances"






33.5.1 What You Should Know About Message Board and Feedback Task Flow Properties

When you set property values on a Message Board or Feedback task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog can affect the default task flow content. For descriptions of the parameters on this tab, see Section 30.6.2, "Profile Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














33.5.2 Message Board and Feedback Task Flow Parameters

Table 33-4 describes the parameters that are unique to Message Board and Feedback task flows.


Table 33-4 Message Board and Feedback Task Flow Parameters

	Parameter	Description
	
Display Message Size

	
The number of characters to show for each Feedback message

Messages exceeding the specified value are truncated.

This parameter is associated with the Feedback – Quick View task flow.


	
End Date

	
The ending date for a date range within which to show messages and posts

Use the format YYYY/MM/DD. Use this parameter with Start Date.

This parameter is associated with the following task flows:

	
Feedback


	
Feedback - Quick View


	
Message Board





	
Group Space

	
Specifies the space for which to show messages

Enter the space internal name. The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the banner at the top of a space.

This parameter is associated with the following task flows:

	
Message Board


	
Message Board - Quick View





	
Hide Actions

	
Specifies whether to show or hide the actions normally associated with a Feedback or Message Board entry, such as Private, Edit, Hide, and Delete

	
Select the checkbox to hide actions associated with a Feedback or Message Board entry (#{true}).


	
Clear the checkbox to show such actions (#{false}). When no value is entered, this is the default.




This parameter is associated with the following task flows:

	
Feedback – Quick View


	
Message Board – Quick View





	
Hide Footer

	
Specifies whether to hide the task flow footer

	
Select the checkbox to hide the task flow footer (#{true}).


	
Clear the checkbox to show the task flow footer (#{false}).




This parameter turns the More link on (#{false}) or off (#{true}). Note that it does not affect the Previous and Next links that may also display toward the bottom of the task flow.

This parameter is associated with the following task flows:

	
Feedback - Quick View


	
Message Board - Quick View





	
Hide Given

	
Specifies whether to enable or disable the display of Feedback left for others

	
Select the checkbox to disable the display of Feedback left for others in a given task flow instance (#{true}).


	
Clear the checkbox to allow the display of Feedback left for others in a given task flow instance (#{false}).




Selecting Hide Given hides the View menu so that only Feedback received is shown.

This parameter is associated with the following task flows:

	
Feedback


	
Feedback - Quick View





	
Hide Header

	
Specifies whether to show or hide the task flow header

	
Select the checkbox to hide the task flow header (#{true}).


	
Clear the checkbox to show the task flow header (#{false}).




This parameter is associated with the following task flows:

	
Feedback


	
Feedback - Quick View


	
Message Board


	
Message Board - Quick View





	
Hide Publisher

	
Specifies whether to show or hide the message entry field and the upload file and URL controls (the Publisher)

	
Select the checkbox to disable the display of the message entry field in a given task flow instance (#{true}).


	
Clear the checkbox to allow the display of the message entry field in a given task flow instance (#{false}).




This parameter is associated with the following task flows:

	
Message Board


	
Message Board - Quick View





	
No of Feedback items

	
The number of Feedback items to show in the task flow

For example, enter 5 to specify that a maximum of five items can appear in the task flow. In quick view, a More link appears at the bottom of the task flow when there are more items than the specified number of items. Users click More to open the main view of the task flow where all items are accessible. In main view, Previous and Next links are shown. Users click these to page through entries.

This parameter is associated with the following task flows:

	
Feedback


	
Feedback - Quick View





	
No of Messages

	
The number of messages to show in the task flow

For example, enter 5 to specify that a maximum of five items can appear in the task flow. In quick view, a More link appears at the bottom of the task flow when there are more items than the specified number of items. Users click More to open the main view of the task flow where all items are accessible. In main view, Previous and Next links are shown. Users click these to page through entries.

This parameter is associated with the following task flows:

	
Message Board


	
Message Board - Quick View





	
Resource Id

	
The ID of the user to show in the task flow

This value is set automatically, #{securityContext.userName}, which returns the name of the current user.

Note: For information about this and other EL expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Feedback task flow.


	
Start Date

	
The starting date for a date range within which to show messages and posts

Use the format YYYY/MM/DD. Use this parameter with End Date.

This parameter is associated with the following task flows:

	
Feedback


	
Feedback - Quick View


	
Message Board





	
User Id

	
The ID of the user to show in the task flow

This value is set automatically, #{securityContext.userName}, which returns the name of the current user.

Note: For information about this and other EL expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Feedback - Quick View task flow.


	
User Name

	
The ID of the user to show in the task flow

This value is set automatically, #{securityContext.userName}, which returns the name of the current user.

Note: For information about this and other EL expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the following task flows:

	
Message Board


	
Message Board - Quick View















33.5.3 Using Parameters to Configure Message Board and Feedback Task Flow Instances

The properties associated with Message Board and Feedback task flows make it possible to control such things as the number of messages to show, the maximum length of Feedback posts, the presence or absence of a message input field, and so on.

Setting task flow properties affects every users' view of the task flow instance.

This section provides examples of how to use task flow parameters to achieve these results. It includes the following subsections:

	
Section 33.5.3.1, "Hiding Action Links and Icons on a Task Flow Instance"


	
Section 33.5.3.2, "Limiting the Number of Messages and Feedback Posts Shown"


	
Section 33.5.3.3, "Limiting the Length of Posts in a Feedback - Quick View Task Flow"


	
Section 33.5.3.4, "Preventing Users from Adding Messages to a Message Board"


	
Section 33.5.3.5, "Hiding the Feedback You Have Left for Others"


	
Section 33.5.3.6, "Scoping the Display of Messages to a Named Space"


	
Section 33.5.3.7, "Specifying the Date Range of Shown Messages and Feedback"






33.5.3.1 Hiding Action Links and Icons on a Task Flow Instance

Users with page edit privileges can set the Hide Actions parameter on a Message Board - Quick View or Feedback - Quick View task flow to hide the actions normally associated with each posted message. Such actions include the Edit, Hide, and Private links and the Delete icon (Figure 33-35).


Figure 33-35 Actions on a Feedback Message

[image: Actions on a Feedback message]



To hide actions on a Message Board - Quick View or Feedback - Quick View task flow instance:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
Select the Hide Actions checkbox.




	
Note:

To show hidden actions, clear this checkbox.








	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.









33.5.3.2 Limiting the Number of Messages and Feedback Posts Shown

Parameters on all Message Board and Feedback task flow types enable you to specify how many messages or Feedback posts to show in a given task flow instance. When the number of messages or posts exceeds the value that you provide:

	
Previous and Next icons appear on the full task flow views, enabling users to page through all messages and posts.


	
A More link appears on task flow quick views. Users click this to launch a dynamically-generated page that shows all messages or posts.




For Message Board and Message Board - Quick View task flows, use the No of Messages parameter. For Feedback and Feedback - Quick View task flows, use the No of Feedback Items parameter.

To limit the number of messages and Feedback posts shown in a given task flow instance:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
Enter the number of messages or Feedback posts you want to allow in the task flow instance:

	
For Message Board and Message Board - Quick View task flows, enter a number for the parameter No of Messages.


	
For Feedback and Feedback - Quick View task flows, enter a number for the parameter No of Feedback Items.





	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.









33.5.3.3 Limiting the Length of Posts in a Feedback - Quick View Task Flow

Use the Display Message Size parameter on a Feedback - Quick View task flow instance to limit the number of characters that can be entered for a given post. Posts that exceed the limit are truncated.

To limit the number of characters allowed for a post to a Feedback - Quick View task flow:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
For the Display Message Size parameter, enter the number of characters to allow for a given post.


	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.









33.5.3.4 Preventing Users from Adding Messages to a Message Board

You can use the Hide Publisher parameter to hide the message input field and its associated icons in a Message Board or Message Board - Quick View task flow instance. This is useful when you want a Message Board to be a window onto current messages without also being a point of input.

To prevent users from adding messages to a Message Board task flow instance:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
Select the Hide Publisher checkbox to hide the message input field and its associated Share document and Share link icons.


	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.









33.5.3.5 Hiding the Feedback You Have Left for Others

You can use the Hide Given parameter to prevent the display of the Feedback you have left for others in both types of Feedback task flows. Selecting Hide Given hides the View menu, so that only Feedback received is shown.

To hide the Feedback you have left for others:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
Select the Hide Given checkbox to hide the Feedback you have left for others by hiding the View menu.


	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.









33.5.3.6 Scoping the Display of Messages to a Named Space

Both types of Message Board task flows provide the Group Space parameter for specifying the space for which to display messages. For example, imagine that, from the Home space, you want to see the messages people are entering in the Standards space. You can place either type of Message Board task flow on a page in the Home space, and configure it to show the messages entered in the Standards space.

To scope the display of messages to a named space:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
In the Group Space field, enter the internal name of the space of interest.




	
Tip:

The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the banner at the top of a space.








	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.









33.5.3.7 Specifying the Date Range of Shown Messages and Feedback

You can use the Start Date and End Date parameters on the Message Board, Feedback, and Feedback - Quick View task flows to limit the display of messages and Feedback posts to those entered between the two specified dates.

For both parameters, use the date format YYYY-MM-DD, for example 2010-01-02.

To limit the display of messages and Feedback posts to those entered within a specified date range:

	
Edit the task flow instance's properties as described in Section 17.5.2, "Setting Properties on Page Components."


	
In the Component Properties dialog, click the Parameters tab to bring it forward.


	
In the Start Date field, enter the date after which to show messages and posts.


	
In the End Date field, enter the date before which to show messages and posts.


	
When you finish revising component properties, click OK.


	
Save your changes, and exit page edit mode.
















34 Liking, Commenting On, and Sharing Objects

Opportunities are available throughout your portal to express a favorable judgment on an application object, through liking, and associate a comment with an application object, through commenting. Opportunities to share application objects, files, and URLs are also readily available.

This chapter provides information about liking, commenting, and sharing in WebCenter Portal: Spaces. It includes the following sections:

	
Section 34.1, "Liking and Unliking Application Objects"


	
Section 34.2, "Commenting on Application Objects"


	
Section 34.3, "Sharing Files, URLs, and Streamed Items with Other Users"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission People Connections: Update People Connections Data. Users who plan to edit task flow properties must be assigned a role that also includes the permission Edit Pages. In a space (other than the Home space), users must be assigned a role that includes the permission Edit Page Access and Structure.



34.1 Liking and Unliking Application Objects

Liking is an accumulative rating system that enables you to see at a glance which objects are liked and who likes those objects. A counter keeps track of the number of users who like the object and a link is available for viewing the users who like it. In a group of objects, you can determine the most favored by its number of likes (Figure 34-1).


Figure 34-1 Like Link on a Streamed Item

[image: Like link on a streamed item]



You can like streamed items that include objects. For example, you can like "Jack has updated doc.xml," but you cannot like "Jack and Jill are now connected."

You can express liking for the following types of application objects:

	
Message Board messages (for more information, see Section 33.1.1, "What You Should Know About Message Board")


	
Activity Stream items (for more information, see Section 32.1, "What You Should Know About Activity Stream")




	
Tip:

Whether you or any user can like an Activity Stream or Message Board object depends on whether the administrator has enabled liking for these features. For more information, see Section 6.4.3, "Configuring the People Connections Service for Spaces."








	
Documents (for more information, see Section 41.29, "Liking and Unliking a File")




To like something, click the Like link or icon (a star) (Figure 34-2).


Figure 34-2 Like Icon on a Document

[image: Like icon on a document]



To see who likes the document, click the number to the right of the star (X-REF TO IMAGE).

To remove your favorable rating (that is, unlike the object), click Unlike or click the Like icon again (Figure 34-3).


Figure 34-3 Unlike Link on a Streamed Item

[image: Unlike link on a streamed item]







34.2 Commenting on Application Objects

Commenting provides a means of adding your thoughts, opinions, and questions directly to a given application object.

You can comment on the following types of application objects:

	
Message Board messages (for more information, see Section 33.1.1, "What You Should Know About Message Board")


	
Activity Stream items (for more information, see Section 32.1, "What You Should Know About Activity Stream")




	
Tip:

You can comment on streamed items that include objects. For example, you can comment on "Jack has updated doc.xml," but you cannot comment on "Jack and Jill are now connected."








	
Documents and other types of files (for more information, see Section 41.5.2, "Menus and Actions in the Document Viewer Preview Pane or Window")




	
Tip:

When you comment on a file through the Activity Stream, the comment appears with the file in the Document Library as well as in the Activity Stream.










	
Note:

Public users viewing a public document cannot comment on the document.








	
Wikis (for more information, see Chapter 47, "Working with Wiki Documents")


	
Blogs (for more information, see Chapter 48, "Working with Blogs")




To comment on an object:

	
Click an object's associated Comment link (Figure 34-4).


Figure 34-4 Comment Link on a Streamed Item

[image: Comment link on a streamed item]



	
Fill in the resulting field (Figure 34-5)


Figure 34-5 Write a Comment Text Field

[image: Write a Comment text field]



	
Click the Comment button to save the comment.




To delete the comment, click its associated Delete icon (Figure 34-6).


Figure 34-6 Delete Icon on a Comment

[image: Delete icon on a comment]







34.3 Sharing Files, URLs, and Streamed Items with Other Users

This section provides an overview of the different types of sharing that are available through WebCenter Portal: Spaces, and steps you through each type. It includes the following subsections:

	
Section 34.3.1, "What You Should Know About Sharing"


	
Section 34.3.2, "Sharing Streamed Items with a Wider Audience"


	
Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow"






34.3.1 What You Should Know About Sharing

Sharing provides a means of on-the-spot distribution of items, files, and URLs of particular interest to a selected audience. Sharing is available in a few different forms:

	
Share an item you receive in your Activity Stream by posting it to your connections' Activity Streams (for more information, see Section 34.3.2.1, "Reposting Streamed Items").


	
Share an item you receive in your Activity Stream through email (for more information, see Section 34.3.2.2, "Emailing Streamed Items").


	
Share an item, file, or URL through the Publisher task flow (for more information, see Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow").




To share an item directly from your Activity Stream, the item must contain an object. For example, you can share "Jack has updated doc.xml," but you cannot share "Jack and Jill are now connected." Less obvious, you can share anything you post through the Publisher task flow because the post itself is an object.






34.3.2 Sharing Streamed Items with a Wider Audience

You can share items that appear in your view of the Activity Stream with a wider audience. For example, when your view of the Activity Stream reports that one of your connections updated a document of great interest to all of your connections, you can share that streamed item with all of your connections.

You can do so by posting the streamed item to all of your connections' Activity Streams or to the Activity Streams of connections who belong to a named space. You can also share streamed items through email, enabling you to share it with users to whom you are not connected or to make use of mail distribution lists.




	
Note:

To share an item directly from your Activity Stream, the item must contain an object. For more information, see Section 34.3.1, "What You Should Know About Sharing."







This section includes the following subsections:

	
Section 34.3.2.1, "Reposting Streamed Items"


	
Section 34.3.2.2, "Emailing Streamed Items"






34.3.2.1 Reposting Streamed Items

Use the Share menu's This activity option to share a streamed item with your connections through their view of the Activity Stream.

To repost a streamed item to your connections' Activity Streams:

	
Go to the item you want to share, and from the Share menu select This activity (Figure 34-7)


Figure 34-7 This Activity Option on the Share Menu

[image: This Activity option on the Share menu]



	
In the resulting Share dialog:

	
Select Everyone to share the item with all of your connections (Figure 34-8).


Figure 34-8 Everyone Option on Share Something With Menu

[image: Everyone option on Share menu]



	
Select a space, or select More spaces to share the item with those of your connections who have access to the selected space.

Selecting More spaces opens the Select a space dialog, from which you can choose a space (Figure 34-9).


Figure 34-9 Select a space Dialog

[image: Select a Space dialog]



From the Show spaces menu:

	
Select All to show all of the spaces to which you have access.


	
Select Joined to show all of the spaces you have explicitly joined.


	
Select Moderated to show all of the spaces for which you are a moderator.


	
Select Public to show all public spaces.




Alternatively, enter the name of a space in the Search field and execute the search. Results appear in the dialog.

Highlight a space, and click OK.


	
Optionally, in the Share dialog, enter a message to accompany the link (Figure 34-10).


Figure 34-10 Adding a Message to a Shared Link

[image: Adding a message to a shared link]






	
Note:

When you share a message, rather than a file or a link, you cannot enter another message to accompany it.








	
Click OK.




The item is posted to the Activity Streams of the selected recipients.









34.3.2.2 Emailing Streamed Items

Use the Share menu's Send Mail option to share a streamed item through email. The Send Mail option is available on streamed items that include objects, such as a document. It is otherwise not available.

To share a streamed item through email:

	
Go to the item you want to share, and from the Share menu select Send Mail (Figure 34-11)


Figure 34-11 Send Mail Option on the Share Menu

[image: Send Mail option on the Share menu]



A mail message opens, prepopulated with a link to the selected item.


	
Address, write, and send the message as you would any other email.











34.3.3 Sharing Items, Files, and URLs Through the Publisher Task Flow

The Publisher task flow provides a means of publishing messages, files, and URLs to the Activity Streams of all of your connections or to those connections who have access to a specified space. Publisher also has an associated property, Is Update Status, that enables users to publish a message as their Profile status message.

This section steps you through Publisher features and provides information about its associated properties. It includes the following subsections:

	
Section 34.3.3.1, "What You Should Know About the Publisher Task Flow"


	
Section 34.3.3.2, "Selecting the Recipients of a Published Message"


	
Section 34.3.3.3, "Sharing Files Through the Publisher Task Flow"


	
Section 34.3.3.4, "Sharing Links Through the Publisher Task Flow"


	
Section 34.3.3.5, "Setting Publisher Task Flow Properties"







	
See Also:

For information about Activity Stream, see Chapter 32, "Tracking Your Connections' Activities." For information about Profiles, see Chapter 30, "Managing Your Profile." For information about properties associated with the Publisher task flow, see Section 34.3.3.5, "Setting Publisher Task Flow Properties."









34.3.3.1 What You Should Know About the Publisher Task Flow

The Publisher task flow is very similar in operation to Message Board task flows (see Chapter 33, "Posting and Managing Messages and Feedback"). It differs in a few ways:

	
You can use it to send out messages, but not to receive them. It provides no feature for viewing messages.


	
It is specifically made to work in conjunction with Activity Stream, where the messages you enter are published.


	
It has its own distinct set of properties (see Section 34.3.3.5, "Setting Publisher Task Flow Properties").


	
It is not controlled by configuration settings at the application level nor through your own personal Preferences. You specify who sees your published messages through a control on the task flow itself. You can also exercise some control over the message destination through task flow properties. For example, the Publisher task flow has an associated property, Is Update Status, that enables users to publish a message as their Profile status message.




	
See Also:

For information about Profile, see Chapter 30, "Managing Your Profile."










There is one Publisher task flow (Figure 34-12).


Figure 34-12 Publisher Task Flow

[image: Publisher task flow]



In default WebCenter Portal: Spaces installations, the Publisher task flow is placed on the Activities business role page, which is provided in the Home space for all authenticated users (that is, users who are logged in).

The default Activities business role page also contains an Activity Stream task flow where the messages you enter through the Publisher are published.




	
See Also:

For information about business role pages, see Section 7.1, "Working with Business Role Pages."












34.3.3.2 Selecting the Recipients of a Published Message

The Publisher task flow has a menu at the top where you can select who may see your message in their Activity Streams (Figure 34-13).


Figure 34-13 Share Something With Menu on Publisher Task Flow

[image: Share something with menu on Publisher]



To select the recipients of a published message:

	
Go to the Activities page in the Home space.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through an Activities link.








	
In the Publisher task flow, select a value from the Share something with menu:

	
Select Everyone to share the item with all of your connections.


	
Select a space, or select More spaces to share the item with those of your connections who have access to the selected space.

Selecting More spaces opens the Select a space dialog, from which you can choose a space (Figure 34-14).


Figure 34-14 Select a space Dialog

[image: Select a Space dialog]



From the Show spaces menu:

	
Select All to show all of the spaces to which you have access.


	
Select Joined to show all of the spaces you have explicitly joined.


	
Select Moderated to show all of the spaces for which you are a moderator.


	
Select Public to show all public spaces.




Alternatively, enter the name of a space in the Search field and execute the search. Results appear in the dialog.

Highlight a space, and click OK.





	
Click in the text area, and enter your message (Figure 34-15).


Figure 34-15 Adding a Message to a Shared Link

[image: Adding a message to a shared link]






	
Note:

When you share a message, rather than a file or a link, you cannot enter another message to accompany it.








	
Click Share.

Your message appears in your view of the Activity Stream and in the Activity Streams of the selected recipients.









34.3.3.3 Sharing Files Through the Publisher Task Flow

In addition to sharing messages through the Publisher task flow, you can select to share files. When you share a file through the Publisher task flow, the uploaded file is also stored in the Public folder of your personal document library.




	
Tip:

If you prefer to have greater control over where a shared file is stored in your document library, you can upload it to the folder you prefer. Such uploads are also reported in your connection's activity streams, provided your activity stream is configured to show them. For more information, see Section 32.2, "Setting Activity Stream Preferences."







A Publisher task flow can be configured to hide the Attach: File link. If you do not see this link below the task flow, it could be because the instance is configure, through the Hide Document Uploader property, not to show it. For more information, see Section 34.3.3.5.3, "Prohibiting File Uploads Through a Publisher Task Flow Instance."

To share files through the Publisher task flow:

	
Go to an instance of the Publisher task flow, and select the recipients of your message.




	
See Also:

For more information, see Section 34.3.3.2, "Selecting the Recipients of a Published Message."








	
Optionally, click in the text area and enter the message you want to accompany the file.


	
Next to Attach, click the File link to open a file upload feature (Figure 34-16)


Figure 34-16 Attach File Field on Publisher Task Flow

[image: Attach File field on Publisher task flow]



	
Click Browse to navigate to and select the file you want to share.


	
Click Publish.

The file is streamed to your Activity Stream and to the Activity Streams of your selected recipients.




	
See Also:

Whether a file or a link to a file is shown depends on how the Activity Stream task flow instance is configured. For more information, see Section 32.5.4.2, "Hiding File Previews in Streamed Items."















34.3.3.4 Sharing Links Through the Publisher Task Flow

In addition to sharing messages through the Publisher task flow, you can select to share links.

To share links through the Publisher task flow:

	
Go to an instance of the Publisher task flow, and select the recipients of your message.




	
See Also:

For more information, see Section 34.3.3.2, "Selecting the Recipients of a Published Message."








	
Optionally, click in the text area and enter the message you want to accompany the link.


	
Next to Attach, click the Link link to open a field for entering a URL (Figure 34-17)


Figure 34-17 Attach Link Field on Publisher Task Flow

[image: Attach Link field on Publisher task flow]



	
Enter the URL you want to share, and click Attach.


	
Click Publish.

The link is streamed to your Activity Stream and to the Activity Streams of your selected recipients.









34.3.3.5 Setting Publisher Task Flow Properties

The Publisher task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 34-18).


Figure 34-18 Publisher Parameters in the Component Properties Dialog

[image: Publisher parameters in Component Properties]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with the Publisher task flow and describe the properties available on the Parameters tab:

	
Section 34.3.3.5.1, "What You Should Know About Publisher Task Flow Properties"


	
Section 34.3.3.5.2, "Publisher Task Flow Parameters"


	
Section 34.3.3.5.3, "Prohibiting File Uploads Through a Publisher Task Flow Instance"


	
Section 34.3.3.5.4, "Limiting the Scope of Recipients"


	
Section 34.3.3.5.5, "Using the Publisher as a Profile Status Updater"


	
Section 34.3.3.5.6, "Using the Publisher as a File Uploader"






34.3.3.5.1 What You Should Know About Publisher Task Flow Properties

When you set property values on the Publisher task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog can affect the default task flow content. For descriptions of the parameters on this tab, see Section 34.3.3.5.2, "Publisher Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














34.3.3.5.2 Publisher Task Flow Parameters

Table 34-1 describes the parameters that are unique to the Publisher task flow.


Table 34-1 Publisher Task Flow Parameters

	Parameter	Description
	
Hide Attach Links

	
Specifies whether the Attach: File|Link option is shown or hidden

	
Check for #{true} to hide the Attach: File|Link option.


	
Clear for #{false} to show the Attach: File|Link option.





	
Hide Document Uploader

	
Specifies whether the Share document icon is available on the task flow for uploading a document

	
Check for #{true} to hide the Share document icon


	
Clear for #{false} to show the Share document icon.





	
Hide Sharing Picker

	
Specifies whether the Share something with option is shown or hidden

	
Check for #{true} to hide the Share something with option.


	
Clear for #{false} to show the Share something with option.





	
Is Update Status

	
Indicates whether the message entered in the task flow instance should also be published as the user's Profile status message

	
Check for #{true} to publish the message as the user's Profile status message and in the selected recipients' Activity Streams.


	
Clear for #{false} to publish the message only in the selected recipients' Activity Streams.




If you attach a file or URL to a published message, then no matter what the state of Is Update Status, the message is not also used as a Profile status message.

For information about Profiles, see Chapter 30, "Managing Your Profile."


	
Keep open the Publisher after publish

	
Specifies whether the text box remains active after a user clicks the Publish button

	
Check for #{true} to keep the text box open after a message is published.


	
Clear for #{false} to close the text box after a message is published.





	
Message key of hints text

	
Specifies the resource bundle class and message key for hint text

Use the format key[,RBClass]. __EMPTY__ as the predefined key for no hint text. This is the default value.


	
Object Id

	
The ID of the object to be shared

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so using an EL expression. For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Object Type

	
The type of object to be shared

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so using an EL expression. For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Scope Id

	
The ID of the scope to which to publish

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so using an EL expression. For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Service Id

	
The service ID of the service to which the shared object belongs

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so by entering a specific service ID or using an EL expression. For a list of valid service IDs, see Table B-19, "Service IDs". For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
space Name

	
The name of the space in which to publish the messages entered in this task flow instance

Enter the space internal name and not the space display name. The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the space banner at the top of the space.


	
Upload Document Only

	
Specifies that only the file upload feature is available in the task flow instance, hiding the text entry area and the Share link icon

	
Check for #{true} to show only the file upload feature and hide the text entry area and the Share link icon.


	
Clear for #{false} to show the text entry area and the Share link and Share document icons.





	
User Name

	
The name of the user who owns the current view

This value is supplied by default. We recommend that you do not change the default value, #{o_w_w_i_v_b_resourceViewerBean.username}.


	
Via User

	
The user name of the person who provided the object the current user is sharing

For example, John is sharing a document with everyone that Jane originally shared with him. In this case, Jane is the via user.












34.3.3.5.3 Prohibiting File Uploads Through a Publisher Task Flow Instance

You can use the Hide Document Uploader property to omit the display of the Share document icon on a Publisher task flow instance. Users will be able to share links but not files.

To prohibit file uploads through a Publisher task flow instance:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select the checkbox for the property Hide Document Uploader.


	
Click OK.









34.3.3.5.4 Limiting the Scope of Recipients

You can use the Space Name property to limit the scope of recipients of published messages to a user's connections in a particular space. When you do this, the message does not even stream to your own view of the Activity Stream in the Home space. It is streamed only to your and your connections' views of the Activity Stream in the named space.

To limit the scope of recipients to a particular space:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Enter the internal name of the space in the space Name field.




	
Tip:

The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the space banner at the top of the space.








	
Click OK.

Messages posted through that Publisher task flow instance will be shared with only those connections who have access to the named space.









34.3.3.5.5 Using the Publisher as a Profile Status Updater

You can use the Is Update Status property to specify that all messages without attachments are published not only to specified recipients, but also as the user's Profile status message (Figure 34-19).


Figure 34-19 Published Message Used as Profile Status

[image: Published message used as Profile status]



Messages that have an attached file or link are not simultaneously published as a Profile status message.

To specify that messages are also published as Profile status messages:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select the Is Update Status checkbox.


	
Click OK.

Messages that do not include attachments that are posted through that Publisher task flow instance are also shared as the user's personal Profile status message.









34.3.3.5.6 Using the Publisher as a File Uploader

You can use the Upload Document Only property to limit the functionality of the Publisher task flow to a file uploader (Figure 34-20).


Figure 34-20 Publisher Task Flow as Document Uploader

[image: Publisher as document uploader]



Files uploaded through the Publisher task flow are placed in the Public folder in the document library of the selected scope. That is:

	
In the Home space:

	
Select Everyone to publish the file to the Public folder in each of your connections' personal Document Library.


	
Select a named space to publish the file to the Public folder in the selected space's Document Library.





	
In a space, the file is published to the Public folder in the space's Document Library.




To use the Publisher task flow as a file uploader:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select the Upload Document Only checkbox.


	
Click OK.

The Publisher task flow instance renders as a file uploader (see Figure 34-20). The text area and the Share link icon are not rendered.


















35 Setting Your Personal Preferences

Your personal preferences provide easy configuration settings for tailoring the application to your particular working style. These include settings for your preferred application display language; your preferred application look and feel; your Spaces application password; and the like. Additionally, Spaces application preferences provide an accessibility setting to optimize the application user interface for use with a screen reader, such as JAWS.

Preferences settings are a user-level customization that affects only your view of the Spaces application.

This chapter describes how to specify your personal preferences. It includes the following sections:

	
Section 35.1, "Accessing the Preferences Dialog"


	
Section 35.2, "Choosing Your Preferred Display Language"


	
Section 35.3, "Setting Date and Time Preferences"


	
Section 35.4, "Enabling or Disabling Application Accessibility Options"


	
Section 35.5, "Changing the Home Space Look and Feel in Your View"


	
Section 35.6, "Changing Your Application Password"


	
Section 35.7, "Providing Login Information for External Applications"







	
See Also:

Preferences associated with specific services are discussed in the chapters that cover each service.
For information about Messaging, Subscription, and Notifications preferences, see:

	
Section 36.2, "Establishing and Managing Your Messaging Channels and Filters"


	
Section 36.3.1, "Setting Application-Level Subscriptions"


	
Section 36.4, "Viewing and Cancelling Your Subscriptions"




For information about People Connections preferences, see:

	
Section 30.3, "Setting Profile Preferences"


	
Section 31.2, "Setting Connections Preferences"


	
Section 32.2, "Setting Activity Stream Preferences"


	
Section 33.2, "Setting Message Board and Feedback Preferences"




For information about Instant Messaging and Presence preferences, see Section 62.2, "Identifying Your Preferred Instant Messaging Provider"

For information about Search preferences, see Section 56.5, "Setting Individual Preferences for Search Results"

For information about Mail preferences, see Section 65.3, "Selecting Your Preferred Mail Connection"










Audience

This chapter is intended for users minimally assigned the authenticated-role (that is, users who can log in to the Spaces application) who want to set general preferences. This includes selecting a display language, identifying preferred date and time formats, specifying a time zone, providing external application login information, and the like.



35.1 Accessing the Preferences Dialog

The easiest way to open the Preferences dialog is to click the Preferences link (Figure 35-1).


Figure 35-1 Preferences Link

[image: Preferences link]



The availability of navigational links, such as the Preferences link, is determined by the people who design and build your portal. This being so, you may not see a Preferences link. In such a case, ask your application administrator to make the Preferences link available.






35.2 Choosing Your Preferred Display Language

The display language controls the language in which user interface (UI) elements are rendered in your browser. UI elements include button and field labels, application links, screen text, and so on. The display language also provides options for reflecting the current locale. Locale controls the appearance of symbols, such as monetary symbols, and the reading direction in which UI text is rendered.

To set a display language:

	
Open the Preferences dialog (Figure 35-2).


Figure 35-2 Preferences Dialog

[image: Preferences dialog]






	
See Also:

For information about accessing the Preferences dialog, see Section 35.1, "Accessing the Preferences Dialog."








	
Click General to access general preferences.


	
From the Language dropdown list, select your preferred display language-locale (Figure 35-3).


Figure 35-3 Language List in Preferences Dialog

[image: Language list in Preferences dialog]



Alternatively, select No Preference to accept the application-level default set by your Spaces application administrator.




	
See Also:

For information about setting the application-level default display language, see Chapter 5, "Configuring Global Defaults." For information about display languages in the Spaces application, see Chapter 24, "Working with Multilanguage Portals."








	
Click OK to save your change and exit the Preferences dialog, or click Apply to save your change without exiting.









35.3 Setting Date and Time Preferences

Use date and time preferences to specify your preferred date and time formats and your current locale's time zone:




	
Note:

Some services may be developed with an intrinsic time display format. In such cases, these services are not influenced by your date and time format selections.







To set your preferred time format, date format, and time zone:

	
Open the Preferences dialog (for more information, see Section 35.1, "Accessing the Preferences Dialog").


	
Click General to access general preferences.


	
Set your date and time preferences.

Table 35-1 lists and describes the date and time options available on the General panel in the Preferences dialog.


Table 35-1 Date and Time Preference Settings

	Preference	Setting Options
	
Time Format

	
The following list shows time formats; the formats in the Preferences dialog show the current time:

	
No Preference—To display the default Time Format established by the administrator


	
H:M AM/PM—To display hour, minutes, and AM or PM, such as 4:47 PM


	
H:M:S AM/PM—To display hour, minutes, seconds, and AM or PM, such as 4:47:52 PM


	
H:M:S AM/PM Time Zone—To display hour, minutes, seconds, AM or PM, and the abbreviation of the specified time zone, such as 4:47:52 PM PDT





	
Date Format

	
The following list shows date formats; the formats in the Preferences dialog show the current date:

	
No Preference—To use the default date format set by the administrator


	
M/D/YY—To use a number format, such as 6/18/10


	
MON D, YYYY—To use an abbreviation format and the full year, such as Jun 18, 2010


	
MONTH D, YYYY—To display the full month name and the full year, such as June 18, 2010


	
DAY, MONTH D, YYYY—To display the full month name, the full year, and include the day of the week, such as Friday, June 18, 2010





	
Time Zone

	
From the Time Zone pick list, select your preferred time zone. Alternatively select No Preference to accept the application-level default set by the application administrator.








	
Click OK to save your changes and exit the Preferences dialog, or click Apply to save your changes without exiting.









35.4 Enabling or Disabling Application Accessibility Options

The General panel in the Preferences dialog provides options related to user accessibility. Select an option to optimize the application user interface (UI) for use with a screen reader, such as JAWS; for users with non-visual impairments, such as mouse usage issues; or to disable such optimizations.

This section provides information about application accessibility options and steps you through the process of enabling or disabling such optimizations.

This section includes the following subsections:

	
Section 35.4.1, "What You Should Know about Application Accessibility Options"


	
Section 35.4.2, "Applying Accessibility Options"






35.4.1 What You Should Know about Application Accessibility Options

The Spaces application provides accessibility features to enable visually and non-visually impaired users to navigate successfully through the application user interface. This section contains some tips to assist you in using them successfully.

Use the Accessibility Settings option Disable Screen Reader to enable keyboard-centric accessibility capabilities for a sighted user with non-visual impairments, such as mouse usage issues. This option also handles color contrasts.

Use the Accessibility Settings option Enable Screen Reader to optimize the UI for the JAWS screen reader. Once you set your screen reader preference to enabled, click OK to exit Preferences. If you want to set other options in Preferences, then reopen the Preferences dialog. The other Preferences panels, Password, My Accounts, Messaging, People Connections, Presence, Subscriptions, Search, and Mail, are redrawn as radio buttons, enabling the screen reader to detect and access them.

Normally, JAWS announces the links associated with a menu selection. With the Actions menu, JAWS does not announce the submenu items. For example, JAWS does not read the submenu items under Manage on the Actions menu. The workaround is to select the menu items using direct keyboard navigation. That is, instead of using JAWS Links Chooser, navigate to the Manage submenu of the Actions menu using the Tab key on your keyboard.

Not all dropdown menus, fields, and radio buttons on Spaces application administration pages are labeled. As a result, the JAWS screen reader renders a pound sign (#) instead of a label when the JAWS command Insert-F7 is invoked. The problem occurs in the following areas:

	
Dropdown menus in space administration pages


	
Radio buttons on space administration pages


	
Fields on the Documents page




The workaround is to use the Tab and arrow keys to navigate to each individual form field in order to hear each form field read.

When you add resources from the Resource Catalog, JAWS announces all Resource Catalog items as Add. This makes it difficult to identify the selected resource. To work around this issue, press the Tab key to get to the Add link for the resource, then press the Down Arrow key. JAWS then reads the description of the resource.






35.4.2 Applying Accessibility Options

To apply accessibility options to the application UI:

	
Open the Preferences dialog (for more information, see Section 35.1, "Accessing the Preferences Dialog").


	
Click General to access general preferences.


	
From the Accessibility Settings pick list, select your preferred accessibility setting.

Choose from the following options:

	
No Preference—Accessibility capabilities are not enabled. Screen readers can still process the application UI, but the UI is not optimized.


	
Enable Screen Reader Mode—Specifically for the visually impaired, enables the use of JAWS, the screen reader software.

Once you enable screen reader mode, click OK to exit the Preferences dialog. If you want to set other preference options, then reopen the Preferences dialog. The other preferences panels: Password, My Accounts, Messaging, People Connections, Presence, Subscriptions, Search, and Mail, are redrawn as radio buttons, enabling the screen reader to detect and access them.


	
Disable Screen Reader Mode—Enables keyboard-centric accessibility capabilities for a sighted users with non-visual impairments, such as mouse usage issues. Additionally, in this mode color contrasts are handled.





	
Click OK to save your change and exit the Preferences dialog, or click Apply to save your change without exiting.

Alternatively, click Cancel to cancel your change and exit the Preferences dialog.











35.5 Changing the Home Space Look and Feel in Your View

The General panel in the Preferences dialog provides a pick-list of application skins for your view of the Home space. Application skins specify the application background color, screen fonts, and, with some skins, the shapes and images used for application buttons and icons. The skin you select through the Preferences dialog affects the look and feel of your view of the Home space. No other users' views and no other areas of the application are affected.

To change the Home space skin in your view:

	
Open the Preferences dialog (for more information, see Section 35.1, "Accessing the Preferences Dialog").


	
Click General to access general preferences.


	
From the Application Skin pick list, select your preferred application skin.

Choose from the following options:

	
No Preference—To defer to the application's configured skin setting


	
Skin_Name—To select a predefined application skin from the list of skins available to you





	
Click OK to save your change and exit the Preferences dialog, or click Apply to save your change without exiting.

The application refreshes, using the skin you selected for your view of the Home space.







	
See Also:

Advanced users can create custom application skins and deploy them to the Spaces application. For more information, see the chapter, "Creating and Managing Skins," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.












35.6 Changing Your Application Password

Provided your application administrator has enabled you to do so, you can change your Spaces application password. Changing your password on a regular basis is one way you can participate directly in securing your application software.




	
See Also:

Your application administrator can prohibit you from changing your application password. If this feature is disabled, you cannot take the steps described in this section. For more information, see Section 6.4.3.4, "Configuring Profile."







To change your Spaces application password:

	
Open the Preferences dialog (for more information, see Section 35.1, "Accessing the Preferences Dialog").


	
Click Password to open the Password panel (Figure 35-4).


Figure 35-4 Preferences Password Panel

[image: Preferences Password panel]



	
In the Old Password field, enter your current password.


	
In the New Password field, enter your new password.




	
Note:

The requirements for this password are driven by the identity store that manages Spaces application application users. Every ID store has its own password policy that enforces rules such as password length, password history, and so on. If you have issues setting a new password, contact your application administrator for the password requirements and restrictions of your ID store.








	
In the Confirm New Password field, enter your new password again.


	
Click OK to save your change and exit the Preferences dialog, or click Apply to save your change without exiting.









35.7 Providing Login Information for External Applications

The My Accounts panel in the Preferences dialog provides one-stop access to login credentials for all external applications that have been configured by your application administrator. My Accounts provides a way to store application login credentials so that you provide them only once for the life of the credential. Once you have provided your credentials, every time you access an external application within the Spaces application, the login credentials are provided automatically. This gives you a single-sign-on type of experience where one login (to the Spaces application) provides access to multiple applications.




	
Note:

If you change the login credentials for an application, you must enter them again into the My Accounts panel in the Preferences dialog as described in this section.







To provide login credentials for external applications:

	
Open the Preferences dialog (see Section 35.1, "Accessing the Preferences Dialog").


	
Click My Accounts to open the My Accounts panel (Figure 35-5).


Figure 35-5 Preferences My Accounts Panel

[image: Preferences My Accounts panel]



	
Select an application from the Applications list.

Log-in credential fields and checkboxes for the selected application are shown in the right pane.




	
Tip:

The applications you see on the My Accounts panel are the ones that were configured by your application administrator. Contact your application administrator to request additional applications.








	
Enter log-in credentials as required for the selected application.

Fields requiring values are marked with an asterisk (*).




	
Note:

Login credentials vary from one application to another. For example, some applications may require user name and password, while others may require those values along with additional values, such as your mail address.








	
Select Remember my login information to enable automatic authentication to the selected application every time you log in to the Spaces application.




	
Note:

When you do not select Remember my login information, the login information that you enter is used only for the current user session. This means the next time you log in to the Spaces application, you must also log in to this application.








	
Click OK to save your change and exit the Preferences dialog, or click Apply to save your change without exiting.












36 Setting Up Your Personal Subscriptions and Notifications

Use Subscriptions and Notifications to receive timely notice of changes to your portal and to content surfaced through your portal. Track changes that occur to your connections, your space memberships, and services scoped to specific spaces and to the application objects that are important to you. Specify how you are notified: through phone text, mail, or your Worklist.

This chapter describes how to subscribe and unsubscribe to spaces and application objects, specify how you are notified when they are changed, and manage your subscriptions.

This chapter includes the following sections:

	
Section 36.1, "What You Should Know About Subscriptions and Notifications"


	
Section 36.2, "Establishing and Managing Your Messaging Channels and Filters"


	
Section 36.3, "Subscribing at the Application, Space, and Object Level"


	
Section 36.4, "Viewing and Cancelling Your Subscriptions"


	
Section 36.5, "Working with Notifications Task Flows"





Audience

This chapter is for users interested in being notified when changes occur to the spaces and application objects that are important to them.

Your application administrator can enforce certain application defaults that prevent you from setting subscription and notification preferences for yourself. In such cases, you will be unable to perform some of the actions described in this chapter.




	
See Also:

For information about administrative settings associated with Notifications, see the chapter, "Managing Subscriptions and Notifications," in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









36.1 What You Should Know About Subscriptions and Notifications

Notifications provides an automated means of triggering notices across different messaging channels. Messages are triggered when the spaces and application objects to which you have subscribed change.

Messaging channels can include phone text, mail, or Worklist (depending on how your administrator has configured Notifications). For example, you can receive a mail message when a particular document changes, a text message when someone responds to a particular discussion topic, a Worklist alert when you receive an invitation to connect. All messages contain links that take you to the scene of the change.

You can choose the objects that trigger a notice by subscribing to them. In Spaces, there are three levels of subscription:

	
Application, which you can use to receive notices about changes to your space memberships, Message Board, Connections, and Feedback

Such notifications occur only for application-level activities that involve you as the user.


	
Space, for changes to a subscribed service, such as Events, Discussions, Announcements, Documents, and Blogs, that occur within the scope of a selected space


	
Object, for changes to the application objects to which you have specifically subscribed, such as a particular document, wiki, blog, and so on




Table 36-1 describes the types of activities that can trigger a notification and indicates the level and location of the associated subscription (for more information, see Section 36.3, "Subscribing at the Application, Space, and Object Level").




	
Note:

Owning an object, such as a document, wiki, or blog, does not automatically subscribe you to that object. You must explicitly subscribe to an object to receive subscription-related notifications about it, unless the administrator has set and enforced company-wide subscription defaults. For more information about object-level subscriptions, see Section 36.3.3, "Setting Object-Level Subscriptions."








Table 36-1 Activities that Can Trigger Notifications

	Activity	Level	Where to Subscribe
	
A user sends you an invitation to connect

Note: Out of the box, the option to send notifications for invitations to connect is enabled and is not end-user configurable.

	
Application

	
Preferences (for more information, see Section 36.3.1, "Setting Application-Level Subscriptions")


	
Your space role changes, for example from participant to moderator

	
Application

	
Preferences


	
You are added as a member of a space

	
Application

	
Preferences


	
Your space membership is removed

	
Application

	
Preferences


	
A user posts a message to your Message Board

	
Application

	
Preferences


	
A user likes your Message Board post (messages explicitly set on a Message Board and not those added from Publisher to the Activity Stream)

	
Application

	
Preferences


	
A user comments on your Message Board post (messages explicitly set on a Message Board and not those added from Publisher to the Activity Stream)

	
Application

	
Preferences


	
A user posts feedback for you

	
Application

	
Preferences


	
An announcement is created

	
Space


	
On the space, for example, from the Actions menu on a space in Browse spaces (for more information, see Section 36.3.2, "Setting Space-Level Subscriptions")


	
A new event is created

	
Space


	
On the space


	
An event is updated

	
Space


	
On the space


	
An event is deleted

	
Space


	
On the space


	
A new discussion topic is created

	
Space


	
On the space


	
A new discussion forum is created

	
Space


	
On the space


	
A new document is created or uploaded

	
Space


	
On the space


	
A wiki document is created

	
Space


	
On the space


	
A new blog entry is posted

	
Space


	
On the space


	
A user replies to a discussion topic

	
Object

	
On the topic (for more information, see Section 36.3.3, "Setting Object-Level Subscriptions")


	
A user comments on a discussion topic

	
Object

	
On the topic


	
A user deletes a discussion topic

	
Object

	
On the topic


	
A user comments on a document

	
Object

	
On the document


	
A user likes a document

	
Object

	
On the document


	
A user updates a document

	
Object

	
On the document


	
A user deletes a document

	
Object

	
On the document


	
A user comments on a wiki document

	
Object

	
On the wiki


	
A user likes a wiki document

	
Object

	
On the wiki


	
A user updates a wiki document

	
Object

	
On the blog entry


	
A user deletes a wiki document

	
Object

	
On the blog entry


	
A user comments on a blog entry

	
Object

	
On the blog entry


	
A user likes a blog entry

	
Object

	
On the blog entry


	
A user updates a blog entry

	
Object

	
On the blog entry


	
A user deletes a blog entry

	
Object

	
On the blog entry








You can establish your preferred messaging channels through the Messaging panel in the Preferences dialog (for more information, see Section 36.2, "Establishing and Managing Your Messaging Channels and Filters"). Additionally, you can use messaging preferences to create filters for the types of notifications you want to receive.

Messaging configuration is available when your application administrator selects a BPEL server as the connection type for outbound notifications. If the administrator selects a Mail server, the only available messaging channel is mail; consequently, you are neither required nor able to configure your own messaging channels when your administrator selects a Mail server as the connection type for outbound notifications.




	
See Also:

For information about administrative settings associated with Notifications, see the chapter, "Managing Subscriptions and Notifications," in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







Default settings for application-level subscriptions are configurable by the application administrator. This means that your initial view of application-level Subscription Preferences is determined by these administrator defaults. Application-level subscriptions appear on the General Subscriptions tab of the Subscriptions panel in the Preferences dialog (Figure 36-1).


Figure 36-1 General Subscriptions Preferences

[image: General Subscriptions preferences]



For each functional area or service on the General Subscriptions tab, the application administrator controls two settings:

	
Is subscription enabled for the function or service?


	
Are users allowed to change the default setting?




The answers to these questions determine how and whether general subscription options appear on your view of the tab. Table 36-2 illustrates how administrator-level subscription settings affect the appearance of the General Subscriptions tab.


Table 36-2 Effect of Administrator Defaults on Subscriptions Preferences

	Subscription EnabledFoot 1 	User Can Change Default	Option in Preferences
	
True

	
True

	
Rendered normally, checkbox checked


	
False

	
True

	
Rendered normally, checkbox cleared


	
True

	
False

	
Grayed out, checkbox checked


	
False

	
False

	
Hidden, checkbox hidden








Footnote 1 Rather than enabling or disabling the entire subscription capability, the subscription-enabled attribute merely sets the initial state of the preference option. For example, if subscription-enabled="true", then the associated subscription option is checked by default in Spaces' Preferences dialog. If subscription-enabled="false", then the associated subscription option is not checked by default in the dialog.




	
See Also:

For information about administrative settings associated with Notifications, see the chapter, "Managing Subscriptions and Notifications," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







You can view and delete all of your subscriptions from one location: the Current Subscriptions tab on the Subscriptions panel in the Preferences dialog (Figure 36-2).


Figure 36-2 Current Subscriptions Preferences

[image: Current Subscriptions Preferences]



Use the Subscriptions panel to view and manage all of your application-, space-, and object-level subscriptions. For more information, see Section 36.4, "Viewing and Cancelling Your Subscriptions."






36.2 Establishing and Managing Your Messaging Channels and Filters

Out of the box, your mail address is your default messaging channel, and, with no filters defined, a subscription is sufficient to trigger a notification, provided your administrator has configured the external application associated with the Mail server connection to contain shared credentials and provided mail is selected as the messaging default.




	
See Also:

For information about administrative settings associated with Notifications, see the chapter, "Managing Subscriptions and Notifications," in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.
The administrator's selection of a mail server as the messaging default presupposes that the administrator has also established a connection with a mail server. Additionally, the external application associated with the mail server connection must contain shared credentials. For information about connecting to a mail server, see the chapter "Managing the Mail Service," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









Once you have subscribed to an application object, no additional configuration is required to receive a notification through your mail when that object changes.

However, if you want to receive notifications over your phone, through your Worklist, or via an alternate mail address, a little configuration is required. First you must establish a messaging channel. Then you must define a messaging filter. The channel identifies the delivery medium and its associated address (user ID, mail, or phone number). The filter refines the types of notifications you receive and sets the conditions under which a notification is triggered.

This section steps you through the process of setting up your messaging channels and filters. It includes the following subsections:

	
Section 36.2.1, "Accessing Messaging Configuration Settings"


	
Section 36.2.2, "Establishing a Messaging Channel"


	
Section 36.2.3, "Editing a Messaging Channel"


	
Section 36.2.4, "Deleting a Messaging Channel"


	
Section 36.2.5, "Creating and Applying Messaging Filters"


	
Section 36.2.6, "Editing Messaging Filters"


	
Section 36.2.7, "Deleting Messaging Filters"






36.2.1 Accessing Messaging Configuration Settings

The Messaging panel in the Spaces application's Preferences dialog provides a Manage Configuration button for navigating to User Messaging Preferences.

User Messaging Preferences derive from the User Messaging Service.




	
See Also:

For information about the User Messaging Service, see the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.







To access messaging configuration settings:

	
Open the Preferences dialog, and click Messaging to bring the Messaging panel forward.


	
Click the Manage Configuration button to open User Messaging Preferences login page.




	
Note:

The Manage Configuration button is active only when a BPEL server is configured with the Spaces application. Because the BPEL server provides notification features to services, the Manage Configuration button may be active even when your application administrator elects to use a mail server in lieu of a BPEL server for Notifications.








	
Log in to the User Messaging Server (this is not required if single sign-on is implemented).

This opens the User Messaging Preferences panel (Figure 36-3).


Figure 36-3 Messaging Panel in Preferences Dialog

[image: Messaging panel in Preferences]





The Messaging Channels tab provides controls for creating and managing messaging channels and a view of all configured messaging channels, such as WORKLIST, EMAIL, and SMS. The EMAIL channel is always available. By default, it uses your email address from the LDAP identity store. If the WORKLIST driver is deployed by your application administrator, it is also automatically added for each user.

The Messaging Filters tab provides a means of defining the conditions under which you are notified and associating a messaging channel with a defined set of conditions.

For information about messaging configuration, see the following subsections:

	
Section 36.2.2, "Establishing a Messaging Channel"


	
Section 36.2.3, "Editing a Messaging Channel"


	
Section 36.2.4, "Deleting a Messaging Channel"


	
Section 36.2.5, "Creating and Applying Messaging Filters"


	
Section 36.2.6, "Editing Messaging Filters"


	
Section 36.2.7, "Deleting Messaging Filters"







	
Note:

In environments where multiple BPEL connections are registered against the WebCenter Portal's Worklist component, the messaging preferences repository is shared by all. When you set messaging preferences for one connection, you set them for all.












36.2.2 Establishing a Messaging Channel

Establishing a messaging channel involves selecting the channel over which a notification is sent and providing the delivery address for that channel.

To establish a messaging channel:

	
Go to the User Messaging Preferences page as described in Section 36.2.1, "Accessing Messaging Configuration Settings."


	
If necessary, click the Messaging Channels tab to bring it forward.


	
Click the Create icon to open the Add Channel dialog (Figure 36-4).


Figure 36-4 Create Icon and Add Channel Dialog

[image: Create icon and Add Channel dialog]



	
In the Name field, enter a display name for the channel.

For example, enter MyPhone.


	
From the Type list, select the channel over which to send notifications:




	
Tip:

The presence of a channel is determined by the application administrator, who deploys them and makes them available.







	
EMAIL to specify that notifications are sent to you through your mail


	
SMS to specify that notifications are sent as text messages to your phone


	
WORKLIST to specify that notifications are posted to your Worklist





	
In the Address field, enter an address for the selected type:

	
For EMAIL, enter the address of the mail account to which to send notifications, for example, my.name@mycompany.com.


	
For SMS, enter the phone number to which to send notifications in the format <country_code><area_code><number>, for example, 14154444444.


	
For WORKLIST, your user name is provided as a read-only value.





	
For the Default checkbox:

	
Select to identify one or more channels as the default channel over which to send notifications.

Default channels are the channels over which are sent all notifications that do not meet any of your defined filtering conditions.


	
Clear to prevent selected channels from being used as defaults.





	
Click OK to save your changes and exit the dialog.




To complete your configuration, see Section 36.2.5, "Creating and Applying Messaging Filters."






36.2.3 Editing a Messaging Channel

To revise messaging channel values:

	
Go to the User Messaging Preferences page as described in Section 36.2.1, "Accessing Messaging Configuration Settings."


	
If necessary, click the Messaging Channels tab to bring it forward.


	
Select the messaging channel you want to revise, and click the Edit icon to open the Modify Channel dialog.


	
Change values as desired.


	
Click OK to save your changes and exit the dialog.









36.2.4 Deleting a Messaging Channel

When you delete a messaging channel, any filters that rely on the deleted channel revert to the channel identified as the default. In the absence of a specifically identified default channel, the mail channel is used for sending notifications.

To delete a messaging channel:

	
Go to the User Messaging Preferences page as described in Section 36.2.1, "Accessing Messaging Configuration Settings."


	
If necessary, click the Messaging Channels tab to bring it forward.


	
Select the messaging channel you want to delete, and click the Delete icon.


	
Click OK in the resulting Confirmation dialog.









36.2.5 Creating and Applying Messaging Filters

Messaging filters enable you to qualify the types of notifications you want to receive and weed out the notifications of no interest. Filters also provide a means of associating a selected messaging channel with a particular type of notification. For example, using messaging filters, you can specify that all notifications about document updates go to mail while all notifications about event changes go to your phone, provided your administrator has configured Notifications to use multiple messaging channels.

Two important things to know about setting up messaging filters:

	
Text values in your filtering conditions are case-sensitive. For example, messaging filters differentiate between Document and document.


	
Create separate conditions for multiple terms. For example, for a Subject that contains Monty gave feedback, create three filtering conditions, one for each term.




To create and apply messaging filters:

	
Go to the User Messaging Preferences page as described in Section 36.2.1, "Accessing Messaging Configuration Settings."


	
If necessary, click the Messaging Filters tab to bring it forward.


	
Click the Create icon to open a filter-creation page.


	
In the Filter Name field, enter a display name for the filter.


	
Optionally, enter a filter description in the Description field.


	
From the Matching list, select from:

	
All of the following conditions to require that all of the conditions you specify are met


	
Any of the following conditions to require that at least one of the conditions you specify is met





	
From the first Add Filter Condition list, select from:

	
Subject to base a condition on words appearing in the message subject

It is likely that the most useful filter condition option is Subject. The subjects of notification messages are standardized and can therefore be anticipated. This makes subjects ideal for setting up filtering conditions. See Table 36-4 for a list of standard notification message subjects and examples of filter conditions.


	
From to base a condition on the message sender

All notification messages are sent from the same entity—as configured by your application administrator.


	
Date to base a condition on when the message was generated

Date and Time options may be useful for ad hoc situations, for example, you want to ensure that any notifications about events delivered on the day of the event are sent right to your phone.


	
Time to base a condition on the time the message was generated







	
Note:

Of all the filter conditions available on the Add Filter Condition list, Subject, From, Date, and Time are the options that are relevant to and work with the types of messages generated by Notifications. The other options have no effect.








	
From the second Add Filter Condition list, select an operator for the condition.




	
See Also:

See Table 36-3 for an alphabetical list of operators that are relevant to the attributes Subject, From, Date, and Time.








	
Click the Click to add filter condition icon.


	
From the Messaging Option list, select from:

	
Send No Messages to omit notification for the defined filter conditions


	
Send Messages to all Selected Channels to send notification through all channels selected from the Add Notification Channel list


	
Send to the First Available Channel to send notification through the first open channel of all the selected channels





	
From the Add Notification Channel list, select the channel over which to send the notification messages that meet your defined filter conditions, and then click the Click to add channel to this filter icon.

The Add Notification Channel list is populated with the channels that are defined on the Messaging Channels tab. You can add multiple channels in turn.


	
Click OK to save and apply the messaging filter.




	
Tip:

If your defined filtering conditions do not match an incoming notification, the User Messaging Server will send notifications over all the channels you have identified as default channels.










Table 36-3 provides an alphabetical list of operators that are relevant to the attributes Subject, From, Date, and Time and describes the values they require.


Table 36-3 Operators relevant to Subject, From, Date, and Time

	Operator	ValueFoot 1 	Attributes
	
Between

	
In the fields provided:

	
For Date, enter a start date and end date between which to apply the filter


	
For Time, select a start time (hours and minutes) and end time between which to apply the filter




	
Date, Time


	
Contains

	
Enter a string that must be included in the message Subject or return address (From)

Separate multiple values with commas.

	
Subject, From


	
isEqual

	
Enter the literal value that must be used for the message Subject, Date, Time, or return address (From)

	
Subject, From, Date, Time


	
isGreaterThan

	
Enter the message delivery date beyond which to apply the filter

	
Date


	
isGreaterThanOrEqual

	
Enter the message delivery date on which to start applying the filter

	
Date


	
isLessThan

	
Enter the message delivery date before which to start applying the filter

	
Date


	
isLessThanOrEqual

	
Enter the message delivery date on which to stop applying the filter

	
Date


	
isNotEqual

	
Enter a literal value that must be ignored for the message Subject, Date, Time, or return address (From)

	
Subject, From, Date, Time


	
isWeekday

	
No value is required. This operator applies to messages sent on weekdays.

	
Date


	
isWeekend

	
No value is required. This operator applies to messages sent on weekends.

	
Date


	
NotContains

	
Enter a string that must be excluded from the message Subject or return address (From).

Separate multiple values with commas.

	
Subject, From








Footnote 1 String values are case sensitive. Multiple values in strings must be separated by a comma.

Table 36-4 provides a list of standard notification message subjects and examples of condition formulations.


Table 36-4 Standard Notification Message Subjects

	Standardized Notification Subject	Example Filter Conditions
	
userName has invited you to become a connection

	
	
Subject Contains connection


	
Subject Contains Monty

You can set the condition action to route or ignore all messages concerning a named user for any subject that includes a user name.





	
userName posted message on your message board

	
	
Subject Contains message


	
Subject Contains board





	
userName commented on your message board posting

	
Subject Contains commented


	
userName likes on your message board posting

	
Subject Contains likes


	
userName gave feedback to you

	
	
Subject Contains gave


	
Subject Contains feedback





	
Space Membership Change

	
Subject isEqual Space Membership Change


	
userName created the documentType documentName

Note: For documentType, either Document or Wiki Document is returned. This means that all file types, except wikis, are identified in the subject as Document.

	
	
Subject Contains Document


	
Subject Contains Wiki


	
Subject Contains java.txt


	
Subject Contains Monty





	
userName changed the documentType documentName

	
	
Subject Contains changed


	
Subject Contains myFile.docx





	
userName deleted the documentType documentName

	
	
Subject Contains deleted


	
Subject Contains document


	
Subject isNotEqual java.txt





	
userName posted a comment on the documentType documentName

	
	
Subject Contains Monty


	
Subject Contains comment


	
Subject Contains movingforward.docx





	
userName likes the documentType documentName

	
	
Subject Contains likes


	
Subject Contains movingforward.docx





	
userName created the blog post blogName

	
	
Subject Contains kirk


	
Subject Contains tribbles





	
userName changed the blog post blogName

	
Subject NotContains tribbles


	
userName deleted the blog post blogName

	
	
Subject Contains deleted


	
Subject Contains blog





	
userName posted a comment on the blog post blogName

	
	
Subject Contains comment


	
Subject Contains blog





	
userName likes the blog post blogName

	
	
Subject Contains like


	
Subject Contains blog





	
userName created the forum forumName

	
	
Subject Contains Monty


	
Subject Contains created


	
Subject Contains forum





	
userName created the discussion topic topicName

	
	
Subject Contains Monty


	
Subject Contains topic




This example affects both created and deleted topics. Consider adding the verb, for example, created or deleted, in the filter condition when you want to make a distinction between the two types of actions.

Note, however, that the verb alone is not likely to have the effect you want. For example, if you set the filter condition, Subject Contains deleted, messages for all types of objects upon which a delete action is performed are handled by the filter.


	
userName replied to the discussion topic topicName

	
	
Subject Contains replied


	
Subject Contains topic


	
Subject Contains NewTech





	
userName deleted the discussion topic topicName

	
	
Subject Contains deleted


	
Subject Contains topic





	
userName posted a comment on the discussion topic topicName

	
	
Subject Contains comment


	
Subject Contains topic


	
Subject Contains NewTech





	
userName likes the discussion topic topicName

	
	
Subject Contains likes


	
Subject Contains NewTech





	
userName created the event eventName

	
	
Subject Contains Java


	
Subject Contains Summit





	
userName changed the event eventName

	
	
Subject Contains Java


	
Subject Contains Summit


	
Subject Contains changed





	
userName deleted the event eventName

	
	
Date isEqual 5/31/10


	
Subject Contains event


	
Subject Contains Java


	
Subject Contains Summit




On the day of the event, all notifications concerning the Java Summit event are routed to a selected channel. You can omit the term event, and receive other related notifications, such as an announcement concerning Java Summit.


	
userName created the announcement announcementName

	
	
Subject Contains created


	
Subject Contains announcement





	
userName changed the announcement announcementName

	
	
Subject Contains Monty


	
Subject Contains announcement





	
userName deleted the announcement announcementName

	
	
Subject Contains announcement


	
Subject Contains mySpace















36.2.6 Editing Messaging Filters

To edit a messaging filter:

	
Go to the User Messaging Preferences page as described in Section 36.2.1, "Accessing Messaging Configuration Settings."


	
If necessary, click the Messaging Filters tab to bring it forward.


	
Select the filter condition to edit, and click the Edit icon.


	
Make your changes.


	
Click OK to save and apply your changes.









36.2.7 Deleting Messaging Filters

To delete a messaging filter:

	
Go to the User Messaging Preferences page as described in Section 36.2.1, "Accessing Messaging Configuration Settings."


	
If necessary, click the Messaging Filters tab to bring it forward.


	
Select the filter condition to delete, and click the Delete icon.


	
Click OK in the resulting Confirmation dialog.




	
Note:

You can remove a filtering condition without deleting the entire filter. Follow the steps in Section 36.2.6, "Editing Messaging Filters," and click the Delete icon next to the condition to remove.

















36.3 Subscribing at the Application, Space, and Object Level

Where you perform a subscription varies according to the level at which the subscription is applied as well as the type of object being subscribed to. For example:

	
Application-level subscriptions are made through your personal preferences.


	
Space-level subscriptions are made on the space's Actions menu on the Browse Spaces page.


	
Object-level subscriptions are made on the object itself.




This section steps you through these subscription scenarios. It includes the following subsections:

	
Section 36.3.1, "Setting Application-Level Subscriptions"


	
Section 36.3.2, "Setting Space-Level Subscriptions"


	
Section 36.3.3, "Setting Object-Level Subscriptions"






36.3.1 Setting Application-Level Subscriptions

Set application-level subscriptions on the Subscriptions panel in the Preferences dialog (Figure 36-5).


Figure 36-5 General Subscriptions Preferences

[image: General Subscriptions preferences]



You can use subscription preferences to specify whether to receive notifications from the People Connections service for activities related to Connections, Feedback, and Message Board. Additionally, you can use subscriptions preferences to subscribe to space management activities, such as changes to any of your space memberships or roles.

Application-level subscriptions are affected by the defaults set by the application administrator. In your view of Preferences, some subscription options may appear but be unavailable, while others may be hidden completely. For more information, see Section 36.1, "What You Should Know About Subscriptions and Notifications."

To set application-level subscriptions:

	
Open the Preferences dialog, click Subscriptions to open the Subscriptions panel, and, if necessary, click the General Subscriptions tab to bring it forward.


	
Select the checkbox next to an option for which to receive notifications through mail or other selected channels.




	
See Also:

For more information about messaging channels, see Section 36.2, "Establishing and Managing Your Messaging Channels and Filters."







Select from:

	
Message Board to receive notification when other users post messages to your Message Board, like your posts, and comment on your posts


	
Space Management to receive notification when you are added or removed as a member or your role changes


	
Connections to receive notification when another user invites you to connect


	
Feedback to receive notification when other users leave feedback for you




Clear the checkbox next to the options for which to omit notifications.


	
Click Apply to apply your changes and remain in the dialog; or click OK to save your changes and exit the dialog.







	
See Also:

For information about managing application-level subscriptions, see Section 36.4.1, "Viewing and Cancelling Application-Level Subscriptions."












36.3.2 Setting Space-Level Subscriptions

Subscribe to a space on the space's Actions menu on the Spaces page (Figure 36-6).


Figure 36-6 Subscribe Option on Space's Actions Menu

[image: Subscribe option on a space’s Actions menu]



You can use space-level subscriptions to trigger notification messages whenever any of the following actions occur within the scope of the subscribed space:

	
An announcement is created


	
An event is created, updated, or deleted


	
A discussion forum or topic is created


	
A document is created or uploaded


	
A wiki document is created


	
A blog entry is posted




To subscribe to a space:

	
Navigate to the Spaces page (Figure 36-7).


Figure 36-7 Browse Spaces Option on the Spaces Menu

[image: Browse Spaces option on the Spaces menu]



	
Right-click the space's icon or name, and select Contact and then Subscribe (Figure 36-8).


Figure 36-8 Subscribe Option on Space's Actions Menu

[image: Subscribe option on a space’s Actions menu]



	
In the Subscribe dialog, select one or more of the following options:




	
Note:

An option appears in this dialog only when its associated service has been provided to the space. For example, if the space is not provided with the Discussions service, the Discussions option does not appear in this dialog.







	
Space Event, to receive notice whenever an event is created, updated, or deleted from this space


	
Documents, to receive notice whenever a document is created or uploaded to this space




	
See Also:

To see a more detailed level of notifications regarding a specific document, such as when it is updated, subscribe to the document at the object level. For more information, see Section 36.3.3.1, "Subscribing to a File."








	
Blogs, to receive notice whenever a blog entry is posted in this space




	
See Also:

To see a more detailed level of notifications regarding a specific blog entry, such as when it is edited, liked, or commented on, subscribe to the blog entry at the object level. For more information, see Section 36.3.3.3, "Subscribing to a Blog Entry."








	
Discussions, to receive notice whenever a discussion topic is created in this space




	
See Also:

To see a more detailed level of notifications regarding a specific discussion topic, such as when it is edited, liked, or commented on, subscribe to the topic at the object level. For more information, see Section 36.3.3.4, "Subscribing to a Discussion Topic."








	
Announcements, to receive notice whenever an announcement is created in this space





	
Click Save to save your settings and exit the dialog.




Once you have subscribed to a space, the subscription is reflected on the Current Subscriptions tab on the Subscriptions panel in the Preferences dialog. Here you can view all of your space- and object-level subscriptions. For more information, see Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."






36.3.3 Setting Object-Level Subscriptions

You can use object-level subscriptions to trigger notification messages for actions performed on a selected document, wiki, blog entry, or discussion topic. This section describes how to subscribe to each. It includes the following subsections:

	
Section 36.3.3.1, "Subscribing to a File"


	
Section 36.3.3.2, "Subscribing to a Wiki Document"


	
Section 36.3.3.3, "Subscribing to a Blog Entry"


	
Section 36.3.3.4, "Subscribing to a Discussion Topic"






36.3.3.1 Subscribing to a File

When you subscribe to a file, whenever a user revises or deletes the file, or likes or comments on it, you are notified through your selected messaging channel.




	
See Also:

For more information, see Section 36.2, "Establishing and Managing Your Messaging Channels and Filters."







To subscribe to a file:

	
Go to the location where the file you want to subscribe to is listed.


	
Click the file link to open the file in the Document Viewer.


	
From the File menu, select Subscribe (Figure 36-9).


Figure 36-9 Subscribe Option on a File Menu

[image: Subscribe option on a File menu]








	
See Also:

For information about unsubscribing, see Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."












36.3.3.2 Subscribing to a Wiki Document

When you subscribe to a wiki, whenever a user performs a major edit on, deletes, likes, or comments on the selected wiki, you are notified through your selected messaging channel.




	
Tip:

Users can identify a wiki document edit as major, in which case notification is sent. If the edit is not marked as major, no notification is sent.







To subscribe to a wiki:

	
Go to the wiki you want to subscribe to.


	
Open the File menu, and select the Subscribe option (Figure 36-10).


Figure 36-10 Subscribe Option on a File Menu

[image: Subscribe option on a File menu]








	
See Also:

For information about unsubscribing, see Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."












36.3.3.3 Subscribing to a Blog Entry

When you subscribe to a blog entry, whenever a user edits, likes, comments on, or deletes the selected blog entry, you are notified through your selected messaging channel.




	
See Also:

For more information, see Section 36.2, "Establishing and Managing Your Messaging Channels and Filters."







To subscribe to a blog entry:

	
Go to the blog that contains the entry you want to subscribe to.


	
Click the link to the blog entry of interest to display its content.


	
From the File menu, select Subscribe (Figure 36-11).


Figure 36-11 Subscribe Option on a File Menu

[image: Subscribe option on a File menu]








	
See Also:

For information about unsubscribing, see Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."












36.3.3.4 Subscribing to a Discussion Topic

When you subscribe to a discussion topic, whenever a user, edits, deletes, likes, or comments on the selected discussion topic, you are notified through your selected messaging channel.




	
See Also:

For more information, see Section 36.2, "Establishing and Managing Your Messaging Channels and Filters."







To subscribe to a discussion topic:

	
Go to the discussion topic you want to subscribe to.


	
Click the Subscribe link at the top of the topic (Figure 36-12).


Figure 36-12 Subscribe Link on a Discussion Topic

[image: Subscribe link on a Discussion topic]








	
See Also:

For information about unsubscribing, see Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."
















36.4 Viewing and Cancelling Your Subscriptions

Where you view and cancel your current subscriptions depends on the level of the subscription:

	
In addition to making application-level subscriptions, you can view and cancel application-level subscriptions on the General Subscriptions tab on the Subscriptions panel in the Preferences dialog.


	
View and cancel space- and object-level subscriptions on the Current Subscriptions tab on the Subscriptions panel in the Preferences dialog.




	
See Also:

The settings available on the Current Subscriptions tab are also provided through the Subscriptions Viewer task flow. For more information, see Section 36.5, "Working with Notifications Task Flows."










This section provides information about how to view and cancel your application-level subscriptions and how to view and cancel your space- and object-level subscriptions. It includes the following subsections:

	
Section 36.4.1, "Viewing and Cancelling Application-Level Subscriptions"


	
Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions"






36.4.1 Viewing and Cancelling Application-Level Subscriptions

View and cancel application-level subscriptions through Preferences or through the Subscription Preferences task flow (for more information, see Section 36.5, "Working with Notifications Task Flows").

To view or cancel application-level subscriptions:

	
Open the Preferences dialog, click Subscriptions to open the Subscriptions panel, and, if necessary, click the General Subscriptions tab to bring it forward.

Here you can readily view and change your current application-level subscriptions.


	
To cancel a subscription, clear its checkbox.









36.4.2 Viewing and Cancelling Space- and Object-Level Subscriptions

Both space- and object-level subscriptions are listed in the Preferences dialog on the Subscriptions panel. Use the controls on the Current Subscriptions tab to adjust your view of these subscriptions and to cancel (or unsubscribe from) a space- or object-level subscription.




	
Tip:

Space- and object-level subscriptions can be cancelled through the same action you took to create the subscription. At the space- and object-levels, subscription options toggle between subscribed and unsubscribed. Follow the steps outlined in Section 36.3.2, "Setting Space-Level Subscriptions," and Section 36.3.3, "Setting Object-Level Subscriptions," but select to unsubscribe instead.










	
See Also:

The settings available on the Current Subscriptions tab are also provided in the Subscriptions Viewer task flow. For more information, see Section 36.5, "Working with Notifications Task Flows."







To view and cancel space- and object-level subscriptions:

	
Open the Preferences dialog, click Subscriptions to open the Subscriptions panel, and, if necessary, click the Current Subscriptions tab to bring it forward.


	
Use the View menu to control the display order of columns and to hide or show individual columns.


	
To cancel or unsubscribe from a space- or object-level subscription, select the subscription, and click Unsubscribe.


	
In the resulting Unsubscribe Notification Subscription dialog, click Unsubscribe.

The selected subscription no longer appears on the list of subscriptions.


	
Click OK to exit the Preferences dialog.











36.5 Working with Notifications Task Flows

The Notifications task flows duplicate the features provided through Notifications preferences, with the added benefit of flexibility. That is, you can place Notifications task flows on any page on which you have Edit permission. Additionally, the Subscription Preferences task flow changes scope according to where it is placed.

The options available through Notifications task flows duplicate those available in Subscription Preferences and in space-level subscription dialogs. These options are discussed in Section 36.3, "Subscribing at the Application, Space, and Object Level."

This section provides an overview of Notifications task flows and catalogs their associated task flow parameters. It includes the following subsections:

	
Section 36.5.1, "What You Should Know About Notifications Task Flows"


	
Section 36.5.2, "Adding Notifications Task Flows to a Page"


	
Section 36.5.3, "Setting Notifications Task Flow Properties"






36.5.1 What You Should Know About Notifications Task Flows

Two Notifications task flows are available through the Resource Catalog:




	
Note:

The content of the Resource Catalog is determined by the application administrator. For example, by default, the Subscription Preferences task flow is not available in the Resource Catalog, but your application administrator can add it. Consequently, it is documented here. For more information, see Section 16.3.1.2, "Adding Resources."







	
Subscription Preferences, which provides subscription options according to where its is placed:

	
A Subscription Preferences task flow on a Home space page provides application-level subscription options (Figure 36-13).


Figure 36-13 Subscription Preferences Task Flow on a Home Space Page

[image: Subscription Preferences in Home Space]



	
A Subscription Preferences task flow on a space page provides space-level subscription options (Figure 36-14).


Figure 36-14 Subscription Preferences Task Flow on a Space Page

[image: Subscription Preferences on a Space page]








	
See Also:

For information about controls for:
	
Application-level subscriptions, see Section 36.3.1, "Setting Application-Level Subscriptions," and Section 36.4.1, "Viewing and Cancelling Application-Level Subscriptions."


	
Space-level subscriptions, see Section 36.3.2, "Setting Space-Level Subscriptions," and Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."













	
Subscription Viewer, which provides the same controls that are available on the Current Subscriptions tab of the Subscriptions panel in the Preferences dialog (Figure 36-15)


Figure 36-15 Subscription Viewer Task Flow

[image: Subscription Viewer task flow]






	
See Also:

For information about the controls that are available on the Current Subscriptions tab, see Section 36.4.2, "Viewing and Cancelling Space- and Object-Level Subscriptions."















36.5.2 Adding Notifications Task Flows to a Page

The process of adding a Notifications task flow to a page is the same for all task flows (for more information, see Section 17.5, "Adding Resource Catalog Components to Pages").






36.5.3 Setting Notifications Task Flow Properties

Notifications task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 36-16)


Figure 36-16 Subscription Preferences Task Flow Component Properties

[image: Subscription Preferences task flow properties]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with Notifications task flows and describe the properties available on the Parameters tab:

	
Section 36.5.3.1, "What You Should Know About Notifications Task Flow Properties"


	
Section 36.5.3.2, "Notifications Task Flow Parameters"


	
Section 36.5.3.3, "Hiding Save and Refresh Actions on Subscription Preferences"


	
Section 36.5.3.4, "Displaying Subscription Controls for One Space in Another"






36.5.3.1 What You Should Know About Notifications Task Flow Properties

When you set property values on a Notifications task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog can affect the default task flow content. For descriptions of the parameters on this tab, see Section 36.5.3.2, "Notifications Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














36.5.3.2 Notifications Task Flow Parameters

Table 36-5 describes the parameters that are unique to the Subscription Preferences task flow. The Subscription Viewer task flow does not have associated parameters.


Table 36-5 Subscription Preferences Task Flow Parameters

	Parameter	Description
	
Hide Actions

	
A control for showing or hiding the Save button and Refresh icon

	
true to hide these controls


	
false to show them (default)





	
Scope Name

	
The name of the space for which to display space-level subscription options

Use the space internal name, available on the General Settings page under space Settings. The space internal name is at the end of the value in the space URL field. For example, in the following URL, the space internal name is standards:


http://myHost[...]/webcenter/spaces/standards












36.5.3.3 Hiding Save and Refresh Actions on Subscription Preferences

The Subscription Preferences task flow has an associated parameter, named Hide Actions, that you can use to hide the Save button and Refresh icon on a selected task flow instance.

To hide the Save and Refresh actions on a task flow instance:

	
Go to the page that contains the task flow instance you want to change.


	
Open the page in edit mode.


	
Click the Edit icon (wrench) on the task flow header to open the Component Properties dialog.


	
Click the Parameters tab to bring it forward.


	
Click the menu icon next to Hide Actions, and select Expression Builder to open an Expression Language (EL) editor.


	
Select Type a value or expression, remove the current value in the field, and enter #{true}.


	
Click OK to exit the editor.


	
Click OK to exit the Component Properties dialog.


	
Click Save to save the page, and click Close to exit edit mode.




	
Tip:

To show the Save and Refresh actions, repeat the steps in this section, entering #{false} in lieu of the current value.















36.5.3.4 Displaying Subscription Controls for One Space in Another

The Subscriptions Preferences task flow has an associated parameter, named Scope Name, that enables you to display the subscription options for one space in another space.

Scope Name can be handy in a few use cases. For example, normally, a Subscription Preferences task flow shows application-level subscription options when it is situated in the Home space. Instead, you could use Scope Name to control your subscription options for a particular space from the Home space. You could also set up a control center from which to control settings for various spaces from one location.

To display subscription controls for one space in another:

	
Go to the page that contains the task flow instance you want to change.


	
Open the page in edit mode.


	
Click the Edit icon (wrench) on the task flow header to open the Component Properties dialog.


	
Click the Parameters tab to bring it forward.


	
In the Scope Name field, enter the name of the space for which to display subscription controls.




	
Note:

Use the space internal name, available on the General Settings page under space Settings. The space internal name is at the end of the value in the Space URL field. For example, in the following URL, the space internal name is standards:

http://myHost[...]/webcenter/spaces/standards










	
Click OK to exit the Component Properties dialog.


	
Click Save to save the page, and click Close to exit edit mode.




	
Tip:

To change the instance to show subscription controls for the current scope, repeat the steps in this section, but remove the value in the Scope Name field.






















37 Creating and Managing Your Personal Favorites

Use Favorites to keep your own personal list of favorites to access from any browser you choose. This chapter describes how to create, organize, and manage a list of personal favorites.

This chapter includes the following sections:

	
Section 37.1, "What You Should Know About Favorites"


	
Section 37.2, "Accessing the Favorites User Interface"


	
Section 37.3, "Adding Favorites"


	
Section 37.4, "Adding Favorites Folders"


	
Section 37.5, "Managing Favorites"





Audience

This chapter is intended for users who want to create and manage portable links to their favorite and most useful web sites.



37.1 What You Should Know About Favorites

The great advantage to Spaces application Favorites is their portability. They are not dependent on a particular type of browser, so any browser you use to access your Spaces application provides access to your Spaces Favorites. You can create favorite links to sites internal or external to the Spaces application. This makes Spaces the best choice for managing and tracking your favorites list.

Favorites are personal. The favorites you see on the Favorites menu are the favorites you create. No other user sees your favorites, and you do not see any other user's favorites. If you like, though, you can share favorites with other users, by making one or more of them discoverable in a search.

Favorites are created at the application level; consequently, when you move from one space to another, the favorites on the Favorites menu stay the same.

The Spaces application provides a Manage Favorites dialog, which you can use to further customize your favorites. Use the Manage Favorites dialog to:

	
Control the order of display of links on the Favorites menu


	
Specify a method for opening a favorite target


	
Create folders for organizing your favorites


	
Create, edit, or delete favorite links and folders




For more information about the Manage Favorites dialog, see Section 37.5, "Managing Favorites."






37.2 Accessing the Favorites User Interface

The easiest way to access the Favorites user interface is to open the Favorites menu. However, the availability of navigational links and menus, such as the Favorites menu, is determined by the people who design and build your portal. This being so, you may not see a Favorites menu.

The Favorites Menu and Add To Favorites link are available as spaces components. If the Spaces application administrator adds these components to the Resource Catalog that is used for personal pages, then you can edit the page (provided you are authorized) and add the Add To Favorites or Favorites Menu component to your page.

In a space, these components must be included in the Resource Catalog that is provided for all spaces or the space of interest.




	
See Also:

For information about Resource Catalogs and spaces components, see the following:
	
For information about adding components to a Resource Catalog, see Section 16.3.1.2, "Adding Resources."


	
For information about configuring the application or a space to use a particular Resource Catalog, see Section 16.10.1, "Configuring the Application-Level Resource Catalog," and Section 16.10.2, "Configuring the Space-Level Resource Catalog."


	
For more information, see Section 13.2.4, "Add to Favorites," and Section 13.2.14, "Favorites Menu," in Chapter 13, "Adding Spaces Components to Your Templates."

















37.3 Adding Favorites

Add favorite links for quick access to Spaces application pages and the web sites you find most useful. If you like, you can share favorites with other users by making one or more of them discoverable in a search. This section describes how to add new favorites and how to share them with other users.




	
Note:

This section describes how to add favorites through the Favorites menu. You can also add favorites through the Manage Favorites dialog. For more information, see Section 37.5.1, "Adding a Favorite Using the Manage Favorites Dialog."
You can add files, including wikis and blogs, to your Favorites through the Document Previewer. For more information, see Section 41.30, "Adding a Folder or File to Your Favorites."









To add a favorite:

	
The way you obtain your favorite's URL differs depending on the circumstances:

	
For pages external to the Spaces application, go to a favorite web location and copy its URL.


	
For Spaces application pages, log in and go to the page you want to make a favorite.


	
If you know the URL, enter it manually when the time comes.





	
Open the Add To Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
In the Name field, enter a display name for the favorite (Figure 37-1).


Figure 37-1 Add To Favorites Dialog

[image: Add To Favorites dialog]






	
Note:

The value you enter for Name becomes the favorite's link text. The name of the current page is provided by default. You can change this or leave it as is.








	
In the Web Address field, enter the target URL for the favorite.

The default entry for this field is the URL of the current Spaces application page; you have three options:

	
Leave the default entry (the path to the current page) as is.


	
Paste the URL you copied in step 1.


	
Enter the URL manually.





	
From the Create In pick list, select the favorites folder in which to create the favorite.




	
See Also:

WebCenter provides one top-level default folder: Favorites. You can also create your own folders by clicking the New Folder button. For more information, see Section 37.4, "Adding Favorites Folders."








	
To enable this favorite to be discovered by other users during a search, select the Shared checkbox.

Clear the Shared checkbox if you do not want other users to have any kind of access to this favorite.


	
Click OK to add the favorite to the Favorites menu and the Manage Favorites dialog.









37.4 Adding Favorites Folders

To keep your list of favorites manageable, you can organize them into folders. The folder hierarchy you create appears on the Favorites menu and in the Manage Favorites dialog. Because the favorite folders you create are user-level customizations, they display only in your application view.




	
Note:

This section describes one way to create favorites folders. You can also create them in the Manage Favorites dialog. For more information, see Section 37.5.3, "Editing Favorites and Favorites Folders."







To add a favorites folder:

	
Open the Add To Favorites dialog.




	
See Also:

For more information, see Section 37.2, "Accessing the Favorites User Interface."








	
Click the New Folder button to open the Create Folder dialog (Figure 37-2).


Figure 37-2 New Folder Button and Create Folder Dialog

[image: New Folder button and Create Folder dialog]



	
In the Folder Name field, enter a name for the new folder.


	
Click Create to save the new folder and close the Create Folder dialog.

The new folder appears as a selection in the Add To Favorites dialog on the Create In pick list.


	
Click OK to close the Add To Favorites dialog.









37.5 Managing Favorites

The Spaces application Manage Favorites dialog provides a convenient, one-stop location for creating, editing, and deleting favorite links and folders and rearranging their display order on the Favorites menu (Figure 37-3).


Figure 37-3 Manage Favorites Dialog

[image: Manage Favorites dialog]



This section describes how to use the controls available in the Manage Favorites dialog. It contains the following subsections:

	
Section 37.5.1, "Adding a Favorite Using the Manage Favorites Dialog"


	
Section 37.5.2, "Adding a Favorites Folder Using the Manage Favorites Dialog"


	
Section 37.5.3, "Editing Favorites and Favorites Folders"


	
Section 37.5.4, "Rearranging Favorites and Favorites Folders"


	
Section 37.5.5, "Searching for Favorites"


	
Section 37.5.6, "Deleting Favorites and Favorites Folders"






37.5.1 Adding a Favorite Using the Manage Favorites Dialog

When you want to add multiple favorites, the best place to do this is in the Manage Favorites dialog. This is because the Manage Favorites dialog remains open until you close it, saving you steps in the creation process.

To add favorites through the Manage Favorites dialog:

	
Go to the web page of interest, and copy its URL.

You can skip this step if you plan to enter the URL manually. For information about getting the URL of an application page, see Section 29.9, "Viewing Space and Page Information."


	
Open the Manage Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
Select the folder of interest.




	
Tip:

Select a folder by clicking in its row.








	
Click the Add button in the toolbar at the top of the window (Figure 37-4).


Figure 37-4 Add Button in Manage Favorites Dialog

[image: Add button in Manage Favorites dialog]



	
In the resulting Add To Favorites dialog, go to the Name field and enter a display name for the favorite (Figure 37-5).


Figure 37-5 The Add To Favorites Dialog

[image: Add to Favorites dialog from Manage Favorites window]



	
In the Web Address field, paste the URL you copied in step 1, or enter a URL manually.


	
To enable the sharing of this favorite in other users' search results, select Shared.


	
Click OK.

The new favorite appears in the Manage Favorites dialog and on the Favorites menu (Figure 37-6).


Figure 37-6 New Favorite on Favorites Menu

[image: New Favorite on Favorites menu]



	
Click Close to exit the Manage Favorites dialog.









37.5.2 Adding a Favorites Folder Using the Manage Favorites Dialog

To keep your list of favorites manageable, you can organize them into folders. The folder hierarchy you create appears on the Favorites menu and in the Manage Favorites dialog. Because the favorite folders you create are user-level customizations, they display only in your application view.

In addition to adding favorites folders through the Add To Favorites dialog (see Section 37.4, "Adding Favorites Folders") you can add them through the Manage Favorites dialog.

To add a favorites folder through the Manage Favorites dialog:

	
Open the Manage Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
Select the folder in which to create the new folder, and click the New button in the toolbar at the top of the window (Figure 37-7).


Figure 37-7 New Button in Manage Favorites Dialog

[image: New button in Manage Favorites dialog]



	
In the resulting Create Folder dialog, go to the Folder Name field and enter a display name for the favorite folder (Figure 37-8).


Figure 37-8 Create Folder Dialog

[image: Create Folder dialog]



	
Click Create.

The new folder appears in the Manage Favorites dialog and on the Favorites menu.


	
Click Close to exit the Manage Favorites dialog.









37.5.3 Editing Favorites and Favorites Folders

The Manage Favorites dialog provides controls for editing favorites and favorites folders. Use this feature to revise a folder or favorite name, a favorite target URL, or a favorite open behavior.

Open behavior determines how a favorite target URL opens from the Favorites menu or the Manage Favorites dialog. Choose from opening a favorite target in the current browser window or a new browser window or tab.

To edit a favorite or favorite folder:

	
Log in, and, navigate to the Manage Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
If necessary, expand favorites folders to access the favorite or folder you want to edit.




	
Tip:

To expand a folder, click the Expand icon to the left of the folder.








	
Select the favorite or favorite folder you want to edit, and click the Edit button in the toolbar to open the Edit Favorite or Folder dialog (Figure 37-7).




	
Tip:

To select a favorite or a folder, click in its row.








Figure 37-9 Edit Favorite Dialog

[image: Edit Favorite dialog]



Table 37-1 lists and describes the types of values you can enter for the Edit Favorite and Edit Folder dialogs.


Table 37-1 Values Taken By Edit Favorite and Edit Folder Dialogs

	Label	Applies To	Value
	
Name

	
Edit Favorite and Folder

	
The display name of the favorite or folder. This is the name that appears on the Favorites menu and in the Manage Favorites dialog.

This field is editable.


	
Location

	
Edit Favorite

	
The favorite target URL.

This field is editable


	
Shared

	
Edit Favorite

	
Specify whether to allow other users to discover this favorite through a search.

Checked means yes, cleared means no.

This checkbox is editable.


	
Open Behavior

	
Edit Favorite

	
An option for specifying how a favorite opens

Choose from:

	
New Window—The favorite opens in a new browser tab or window.


	
Current Window—The current browser window redraws, displaying the favorite target.




This field is editable.

Note: The open behavior you specify for a Favorite does not apply to Favorites returned in a search. To control the open behavior of a Favorite returned in a search, right click the search result and select an open behavior from your browser's context menu.


	
Type

	
Edit Favorite

	
The link type, always URL

This field is read-only.


	
Icon

	
Edit Favorite and Folder

	
An option for providing an icon to display along with the display name shown in the Favorites menu

Enter the full URL to the icon.

This field is editable.


	
Created On

	
Edit Favorite and Folder

	
The date the favorite or folder was created

This field is read-only.


	
Last Visited On

	
Edit Favorite

	
The date the favorite was last visited using the favorites link

This field is read-only.








	
Make your changes to the fields and pick lists.


	
Click OK to save your changes and close the Edit Favorites dialog.









37.5.4 Rearranging Favorites and Favorites Folders

The Manage Favorites dialog provides controls for moving a favorite or a favorite folder higher or lower on the Favorites menu. You can accomplish a move by clicking icons or by dragging and dropping. Use this feature to arrange your view of the Favorites menu exactly to your liking.

To rearrange favorites and favorites folders:

	
Open the Manage Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
If necessary, expand favorites folders and then select the favorite or folder you want to rearrange.




	
Tip:

To select a favorite or a folder, click in its row.








	
Click the Move Up or Move Down icon in the toolbar to rearrange the selected favorite or folder (Figure 37-10).


Figure 37-10 Move Icons in Manage Favorites Dialog

[image: Move icons in Manage Favorites dialog]



Alternatively, drag the favorite or folder to its target position.




	
Accessibility Note:

In the Spaces application, you cannot move a favorite into an existing folder using only the keyboard. To work around this issue, create a duplicate favorite within the target folder, then delete the original favorite.








	
Click Close to exit the Manage Favorites dialog.

The favorite or folder is repositioned in the Manage Favorites dialog and on the Favorites menu.









37.5.5 Searching for Favorites

The Manage Favorites dialog includes a search feature that enables you to locate favorites. You can use the favorites search feature to search for favorite display names or target URLs. This search feature does not search for favorite folder names. Search results display in the Manage Favorites dialog.

To search for favorites:

	
Open the Manage Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
Enter a search term in the Search field, and click the Search icon (Figure 37-11).


Figure 37-11 Filter Feature in Manage Favorites Dialog

[image: Filter feature in Manage Favorites dialog]



Results display in the Manage Favorites dialog.




	
Tip:

To exit search results, you must exit the Manage Favorites dialog. Alternatively, you can delete the search term from the Search field and click the Search icon. A search without a search term returns the Manage Favorites dialog to its default view.








	
Click Close to close the Manage Favorites dialog.









37.5.6 Deleting Favorites and Favorites Folders

When you delete a favorite or a favorites folder, it is permanently removed from both the Favorites menu and the Manage Favorites dialog. Additionally, when you delete a favorites folder all the favorites it contains are also deleted.

To delete favorites and favorites folders:

	
Open the Manage Favorites dialog (for more information, see Section 37.2, "Accessing the Favorites User Interface").


	
Select the favorite or favorite folder you want to delete.




	
Tip:

To select a favorite or favorite folder, click in its row.








	
Click the Delete button on the toolbar (Figure 37-12).


Figure 37-12 Delete Button in Manage Favorites Dialog

[image: Delete button in Manage Favorites dialog]



	
In the confirmation dialog, click Delete.

The selected favorite or favorite folder and any favorites the folder contained are permanently removed from the Manage Favorites dialog and the Favorites menu.


	
Click Close to close the Manage Favorites dialog.














38 Creating and Managing Personal Pages

Provided your administrator has enabled you to do so, in the Home space you can create, secure, edit, copy, and delete your own personal pages. This chapter steps you through these processes in the Home space. It includes the following sections:

	
Section 38.1, "Creating Personal Pages in the Home Space"


	
Section 38.2, "Controlling User Access to Your Personal Pages"


	
Section 38.3, "Editing a Personal Page"


	
Section 38.4, "Copying a Personal Page"


	
Section 38.5, "Deleting a Personal Page"







	
Note:

Application administrators may choose to prohibit the creation of personal pages in the Home space, allowing only the display of business role pages and system pages, over which you have less control.
For information about business role pages and system pages, see Chapter 7, "Preparing Your Initial Portal Pages ."










Audience

This chapter is intended for users granted the application-level permission Pages: Create, Edit, and Delete Pages. Typically such users want to create and manage pages for their personal use. This includes creating personal pages in the Home space and copying, hiding or showing, securing, editing, and performing other like actions such pages.

The actions described in this chapter are for the personal pages that you create in your own view of the Home space. Other types of pages, such as business role pages, may also be exposed in the Home space and do not provide the same level of access.



38.1 Creating Personal Pages in the Home Space

Provided the proper permissions are in place, in the Home space you can create your own personal pages and populate them with layout components, such as Text editors and Boxes, and content, such as task flows, portlets, and documents.

The Spaces application provides a feature for setting up page creation defaults. This enables you to predetermine the options that are selected in the Create Page dialog by default and even to skip the dialog entirely by enforcing your selections.

This section describes how to set up page creation defaults and how to create pages. It includes the following subsections:

	
Section 38.1.1, "Setting Page Creation Defaults for Personal Pages"


	
Section 38.1.2, "Creating a Personal Page in the Home Space"






38.1.1 Setting Page Creation Defaults for Personal Pages

In the Home space, provided your Spaces application administrator has made the option available, you can set page creation defaults to reduce the number of steps required to create a personal page. That is, you can use page creation defaults to specify the options that are selected by default when you open the Create Page dialog. You can take this further by enforcing your selections, turning page creation into a one-click operation. When you enforce your selections, you are telling the application that you want to bypass the Create Page dialog and create pages based on your default selections.




	
Tip:

When you skip the Create Page dialog, your result is a page with a generic name. For information about renaming pages, see Section 29.6, "Renaming a Page."







Use page creation default settings to specify a default page style and enable or disable one-click page creation. The style describes the page layout (for examples of seeded page styles, see Table 15-2, "Default Page Styles").




	
Note:

The settings you establish for yourself override any page-creation settings an administrator may provide.







This section provides examples of how to access page creation default settings and how to set personal page creation defaults. It includes the following subsections:

	
Section 38.1.1.1, "Accessing Page Creation Default Settings"


	
Section 38.1.1.2, "Setting Personal Page Creation Defaults"







	
See Also:

The application administrator can set application-wide page creation defaults for personal pages. Individual users can override these defaults by following the steps in this section.
The page creation defaults an administrator sets for business role pages also affect personal pages. For more information about application-level page creation defaults, see Section 7.1.2, "Setting Page Creation Defaults for Business Role Pages."











38.1.1.1 Accessing Page Creation Default Settings

In a Home space, page creation default settings are available to authorized users from the Personalize Pages page (Figure 38-1).


Figure 38-1 Set Page Defaults on Personalize Pages

[image: Set Page Defaults on Personalize Pages]



The person who designs the template that is used for pages in the Home space determines if access to this page or dialog is easily available. The designer may select a default, out-of-the-box template that provides easy access to the Personalize Pages page via an Actions menu, for example Figure 38-2.


Figure 38-2 Personalize Pages Option on Actions Menu

[image: Personalize Pages option on Actions menu]



Additionally, the designer may create a custom page template and include the Manage Pages component. Authorized users can access the Manage Pages dialog by clicking this component (Figure 38-3).


Figure 38-3 Manage Pages Link and Dialog

[image: Manage Page link and dialog]







38.1.1.2 Setting Personal Page Creation Defaults

To set personal page creation defaults:

	
Go to the Home space.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Open the Personalize Pages page (Figure 38-4).


Figure 38-4 Set Page Defaults on Personalize Pages

[image: Set Page Defaults on Personalize Pages]






	
See Also:

For methods of accessing Personalize Pages or Manage Pages, see Section 38.1.1.1, "Accessing Page Creation Default Settings."








	
Click Set Page Defaults to open the Set Page Defaults dialog (Figure 38-5).


Figure 38-5 Set Page Defaults Dialog

[image: Set page Defaults dialog]



	
To set page creation defaults:

	
Select a layout from the Style dropdown list.




	
See Also:

For examples of seeded page styles, see Table 15-2, "Default Page Styles". Note, however, that your application administrator may provide additional custom page styles or restrict page styles to a shorter list.








	
Select an option next to Enable One-Click Page Creation:

Yes—When you create personal pages in the Home space, skip the Create Page dialog, and create the page using the default page style you set here.

No—When you create personal pages in the Home space, have the default page style you set here preselected in the Create Page dialog.





	
Click Save to save your changes and exit the dialog.




Going forward, when you create personal pages in the Home space, the default page style you set here determines the style that is preselected for the new page and whether the Create Page dialog opens.








38.1.2 Creating a Personal Page in the Home Space

Depending on how your portal navigation is implemented, in the Home space you can find the Create Page command on the Personalize Pages page and through the Manage Pages dialog (Figure 38-6).


Figure 38-6 Create Page Option on Personalize Pages Page

[image: Create Page option on Personalize Pages]






	
Tip:

There is a Create Page user interface component that your portal designers can add to page templates. So another way to initiate the creation of a page is to click this control if it is provided. For more information, see Section 13.2.9, "Create Page."







This section describes both methods for creating personal pages in your own view of the Home space.

To create a personal page in the Home space:

	
Go to the Home space.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Open the Personalize Pages page and click Create Page to open the Create Page dialog (Figure 38-7).


Figure 38-7 Create Page Dialog

[image: Create Page dialog]



If you (or the application administrator) set page creation defaults to one-click page creation, then, this dialog does not open. After this step, the new page is created and opened. If you did not select one-click page creation, continue with the next step.




	
See Also:

For more information, see Section 38.1.1, "Setting Page Creation Defaults for Personal Pages."
The application administrator can set an attribute on a custom page style that determines whether a newly created page that is based on that style opens in page edit mode or page view mode. For more information, see Section 15.4.2, "Setting Properties on a Custom Page Style."










	
In the Page Name field, enter a display name for the new page.




	
Note:

For wiki pages, you must not use the following characters in the page name:

? \ / : [ ] * ' " |


For wiki names, you can use letters, numbers, character spaces, and periods (.).










	
Select a page style to define the page structure.




	
See Also:

For examples of seeded page styles, see Table 15-2, "Default Page Styles". Note, however, that your application administrator may provide additional custom page styles or restrict page styles to a shorter list.








	
Click the Create button.

The new page opens in Composer, the application page editor, ready for adding content (Figure 38-8).


Figure 38-8 A New Page

[image: A new page]



For information about editing personal pages in the Home space, see Section 38.3, "Editing a Personal Page." For information about working with the page layout, look, and feel, see Section 29.4, "Adjusting Your Page View."











38.2 Controlling User Access to Your Personal Pages

By default, the personal pages you create in the Home space are accessible to you and no one else (except your application administrator). You can use page access settings to enable other users to view and work with your personal pages and to remove that access. Page access settings are available through the Set Page Access dialog, which you can open from the Manage Pages dialog and the Personalize Pages page (Figure 38-9).


Figure 38-9 Set Page Access Option on Actions Menu on Personalize Pages Page

[image: Set Page Access option]



When you grant access to one of your personal pages to another user, the other user must deliberately show the page in his or her view. The user must take this step for each session because shared pages are not automatically shown on login.




	
See Also:

For information about how to show a hidden page, see Section 29.3.4, "Showing Hidden Pages."







This section provides information about setting and revoking user access to your personal pages. It includes the following subsections:

	
Section 38.2.1, "Granting User Access to Your Personal Pages"


	
Section 38.2.2, "Revoking User Access to a Personal Page"






38.2.1 Granting User Access to Your Personal Pages

When you share one of your personal pages with other users, the shared page appears in those users' views of the Manage Pages dialog or the Personalize Pages page in the Home space. They can use the Show Page control in Manage Pages or Personalize Pages to show the shared page in their own views of the Home space (for more information, see Section 29.3.4, "Showing Hidden Pages").

To enable other users to access one of your personal pages:

	
Go to the personal page you want to share.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Open the Manage Pages dialog or the Personalize Pages page, and, from the page's Actions menu, select Set Page Access (Figure 38-10).


Figure 38-10 Set Page Access Option on Actions Menu on Personalize Pages Page

[image: Set Page Access option]






	
See Also:

For methods of accessing Manage Pages or Personalize Pages, see Section 38.1.1.1, "Accessing Page Creation Default Settings."







This opens the Set Page Access dialog (Figure 38-11).


Figure 38-11 Set Page Access Dialog

[image: Set Page Access dialog]



	
To grant page access permissions to all authenticated users, that is, to users who are logged in to the Spaces application, click Add Authenticated Access.

The role authenticated-role is added under Role or User.


	
To grant page access permissions to all public users, that is, users who have not logged in to the Spaces application, click Add Public Access.

The role anonymous-role is added under Role or User.


	
To grant page access permissions to selected users, groups, and application roles, click the Add Access button to open the Add Access dialog (Figure 38-12).


Figure 38-12 The Add Access Dialog

[image: Add Access dialog box]

Description of "Figure 38-12 The Add Access Dialog"





	
In the Search field, enter a search term or the name of the user, group, or role for whom to enable access, and click the Search icon.




	
Tip:

Search terms must contain at least two characters.








	
Select a user, group, or role by clicking in its row.




	
Note:

When you select a user name, the permissions you set are granted to that specific user. When you select a group or application role, the permissions you set are granted to all users who are members of that group or who are assigned that role.







To make multiple selections:

	
Ctrl-Click to select multiple rows.


	
Shift-Click to select a range of rows.





	
Click the Select button.

The Add Access dialog closes, and the Set Page Access dialog populates with the selected users (Figure 38-13).


Figure 38-13 Set Page Access Dialog

[image: Set Page Access dialog]



	
Repeat the previous steps to add all the users and roles of interest to the Set Page Access dialog.


	
For each user, group, or role, grant access by selecting one or more access privileges from the Page Access columns (Table 38-1).


Table 38-1 Page Access Privileges in the Set Page Access Dialog

	Icon	Name	Description
	
[image: View Page icon]


	
View Page

	
Users can access the page for viewing, but cannot perform any other actions on the page.


	
[image: Personalize Page icon]


	
Edit Page

	
Users can edit the page using Composer. This includes adding, rearranging, and deleting content; renaming the page; and changing page properties, such as the page scheme.


	
[image: Delete Page icon]


	
Delete Page

	
Users can delete the page.


	
[image: Manage Page icon]


	
Perform All Page Actions

	
Users can perform all actions on the page.


	
[image: Edit Page icon]


	
Personalize Page

	
Users can rearrange page content and personalize his or her view of task flows, provided the task flow includes personalization settings.











	
Tip:

By default, all authenticated users and user roles that you add to the Set Page Access dialog are granted View Page access. All users for whom you are granting privileges must have View Page access.








	
Click OK to save your changes and close the Set Page Access dialog.









38.2.2 Revoking User Access to a Personal Page

To revoke user access to a personal page:

	
Go to the personal page from which to revoke user access.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Open the Manage Pages dialog or the Personalize Pages page, and, from the page's Actions menu, select Set Page Access (Figure 38-14).


Figure 38-14 Set Page Access Option on Actions Menu on Personalize Pages Page

[image: Set Page Access option]






	
See Also:

For methods of accessing Manage Pages or Personalize Pages, see Section 38.1.1.1, "Accessing Page Creation Default Settings."








	
Select the user or role from which to revoke page access, and click Delete Access (Figure 38-15).


Figure 38-15 Delete Access Button

[image: Delete Access button]



	
Click Delete in the resulting confirmation dialog.











38.3 Editing a Personal Page

When you edit a personal page, you can add or remove content, set properties on content and on the page itself, and perform additional customizations that affect the view of everyone who has access to the page.

Depending on how your portal is designed, you can enter page edit mode from a page Actions menu, an Actions menu next to a page in the Manage Pages dialog or Personalize Pages page, or by pressing Ctrl-Shift-E.

Additionally, your page designer may provide an Edit Page link on the template you use to create the page.

To edit a personal page:

	
Go to the Home space page you want to edit.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Using one of the methods described at the beginning of this section, open the page in edit mode.


	
Edit the page.




	
See Also:

For information about adding content to the page, see Section 17.5, "Adding Resource Catalog Components to Pages.".








	
Click Save to save your changes.


	
Click Close to exit page edit mode.









38.4 Copying a Personal Page

When you copy a page, all content from the original page is also copied. The copy opens in page edit mode (Composer) so that you can start immediately making the adjustments you planned for the copy.

Note that a copy does not also include the original page's access settings. You must set access on the copy as if it were a new page (for more information, see Section 38.2, "Controlling User Access to Your Personal Pages").

Depending on your portal design, you can initiate a page copy from the Actions menu next to a page in the Manage Pages dialog on the Personalize Pages Page (Figure 38-16)


Figure 38-16 Copy Page Option on Actions Menu

[image: Copy Page option on Actions menu]



To copy a personal page:

	
Go to the personal page you want to copy.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Open the Manage Pages dialog or the Personalize Pages page, and then select Copy Page from the page's Actions menu (see Figure 38-16).




	
See Also:

For methods of accessing the Manage Pages dialog or Personalize Pages page, see Section 38.1.1.1, "Accessing Page Creation Default Settings."








	
In the Copy Page dialog, enter a name for the copy in the Page Name field (Figure 38-17).


Figure 38-17 Copy Page Dialog

[image: Copy Page dialog]



	
Click OK.

The copied page opens in page edit mode (Composer).


	
Make the adjustments you planned for the copy (you can always edit the copy at another time).


	
Click Save to save your changes.


	
Click Close to exit Composer.









38.5 Deleting a Personal Page

Depending on your portal design, you can delete a personal page from the Actions menu next to a page in the Manage Pages dialog or the Personalize Pages page (Figure 38-18).


Figure 38-18 Delete Page Option on Actions Menu

[image: Delete Page option on Actions menu]



To delete a personal page:

	
Go to the Home space.

For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Open the Manage Pages dialog or the Personalize Pages page.




	
See Also:

For methods of accessing Manage Pages or Personalize Pages, see Section 38.1.1.1, "Accessing Page Creation Default Settings."








	
Select Delete Page from the page's Actions menu (see Figure 38-18).


	
Click Delete in the confirmation dialog.












Part X


Working with Content

Part X of the User's Guide provides information about the various content management features readily available in WebCenter Portal: Spaces.

Part X includes the following chapters:

	
Chapter 39, "Introduction to Adding and Managing Content"


	
Chapter 40, "Publishing Content Using Content Presenter"


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components"


	
Chapter 42, "Setting Documents Service Task Flow and Document Component Properties"


	
Chapter 43, "Working with Workflow-Enabled Content"


	
Chapter 44, "Creating and Managing Content at Runtime"


	
Chapter 45, "Collaborating on Documents"


	
Chapter 46, "Working with Microsoft Office and Explorer Integration"


	
Chapter 47, "Working with Wiki Documents"


	
Chapter 48, "Working with Blogs"










39 Introduction to Adding and Managing Content




	
See Also:

For an overview of content management in Spaces, see Section 2, "Leveraging Content Management."







In a Spaces application, you can add content from one or more connected content repositories to the application in a variety of ways. You can use the Content Presenter task flow to precisely customize the selection and presentation of content, or you can use a Documents service task flow that suits your purposes for presenting content management functionality. You can also add individual folders and files to a page using links, images, or previews.

This chapter introduces the functionality available to add and manage content in a Spaces application in the following sections:

	
Section 39.1, "What You Should Know About Adding and Managing Content"


	
Section 39.2, "What You Should Know About Content Management Selections in the Resource Catalog"





Audience

This chapter is intended for Spaces users who want to learn about the functionality available in Spaces to add and manage content using Content Presenter and the Documents service.



39.1 What You Should Know About Adding and Managing Content

Spaces provides the following types of containers in which to display and manage content:

	
Content Presenter. Enables you to precisely customize the selection and presentation of content in a Spaces application. The Content Presenter task flow is available only when the connected content repository is Content Server and your Spaces administrator has completed the prerequisite configuration. With Content Presenter, you can select a single item of content, contents under a folder, a list of items, query for content, or select content based on the results of a Personalization Conductor scenario, and then select a template to render the content on a page in a Spaces application. Content Presenter has no dependency on the Documents service for adding or managing the content it displays.




	
Learn More:

For more information about Content Presenter, see Chapter 40, "Publishing Content Using Content Presenter."








	
Documents service task flows. Provide a variety of formats to display folders and files, including wikis and blogs, on a page in a Spaces application. You can choose the task flows appropriate for your application to provide features for accessing, adding, and managing folders and files; configuring and viewing file and folder properties; and searching file and folder content in the connected content repositories. The Documents service task flows are available when the connected content repository is Content Server, Oracle Portal, or SharePoint, and your Spaces administrator has completed the prerequisite configuration.




	
Learn More:

For information about the Documents Service task flows available in Spaces, and the unique characteristics of each task flow, see Section 41.1, "What You Should Know About the Documents Service Task Flows."








	
Document components. Display an individual file on a page as a linked document, an inline preview, or an image.




	
Learn More:

For information about document components you can add to a page in a Spaces application, see Section 41.2, "What You Should Know About Document Components."








	
Wikis. Enable multiple users to create and edit content that is relevant, useful, and up-to-date.




	
Learn More:

For information about including wikis in a Spaces application, see Chapter 47, "Working with Wiki Documents."








	
Blogs. Enable users to create and manage personal blogs to record experiences and opinions, and group related blog posts.




	
Learn More:

For information about including blogs in a Spaces application, see Chapter 48, "Working with Blogs"















39.2 What You Should Know About Content Management Selections in the Resource Catalog

Spaces users with permissions to edit pages use the Resource Catalog to add content to a page.

In Design view of page edit mode, you open the Resource Catalog by clicking the Add Content button on the region where you want to add content (Figure 39-1).


Figure 39-1 Add Content in Design View of Page Edit Mode Displaying Default Resource Catalog

[image: Add Content button in Design view]

Description of "Figure 39-1 Add Content in Design View of Page Edit Mode Displaying Default Resource Catalog"





The presence or location of the content selections in the Resource Catalog depends on how the Resource Catalog is configured. In the default Resource Catalog, open the Content Management section to expose the content task flows and document components (Figure 39-2).


Figure 39-2 Opening the Content Management Section in the Resource Catalog

[image: Content Management Section in the Resource Catalog]



In the Content Management section of the Resource Catalog, you can add content containers in either of the following ways:

	
Click Add next to a task flow to add the task flow standalone to the current page , independent of content (Figure 39-3). After adding the task flow, you can populate it with content.


Figure 39-3 Resource Catalog Content Management: Adding a Content Task Flow

[image: Adding a Content Task Flow]



	
Click Open next to All Content, Space Documents (in a space), or Personal Documents (in the Home space) to drill down to a folder or file that you want to add to the current page, then click Add to display a menu where you can choose the content container in which to display the folder or file (Figure 39-4, Figure 39-5, and Figure 39-6).


Figure 39-4 Resource Catalog Content Management: Adding a Folder

[image: Add Menu for Folder]




Figure 39-5 Resource Catalog Content Management: Adding an HTML File

[image: Add Menu for HTML File]




Figure 39-6 Resource Catalog Content Management: Adding an Image File

[image: Clicking Add Link Next to Image File]





Table 39-1 describes the selections available in the Content Management section of the default Resource Catalog and references the sections that provide more information about working with them:


Table 39-1 Content Management Selections in the Default Composer Resource Catalog

	Item	Task Flow?	Description and Use
	
All Content

	
No

	
A virtual node that exposes a list of all folders and files to which you have access. Click Open to drill down, or enter a file name in the Search field. When you reach the target folder or file, click Add to display a menu where you can choose the content container in which to display the folder or file. See Section 41.3, "Adding a Selected Folder or File to a Page."


	
Space Documents

Personal Documents

	
No

	
A shortcut that exposes a list of folders and files associated with the current space or your personal documents in the Home space. Click Open to drill down, or enter a file name in the Search field. When you reach the target folder or file, click Add to display a menu where you can choose how to display the folder or file. See Section 41.3, "Adding a Selected Folder or File to a Page."


	
Content Presenter

	
Yes

	
Available only when the content repository is Content Server. Displays the selected folders or files in a predefined template. See Chapter 40, "Publishing Content Using Content Presenter."


	
Document Explorer

	
Yes

	
Displays folders and files in two panes, combining the functionality of the Document Navigator and Folder Viewer task flows. Provides in-place previewing and editing, and robust management capabilities. See Section 41.1.1, "Understanding the Document Explorer Task Flow."


	
Document List Viewer

	
Yes

	
Displays folders and files in a single pane as a flat listing. Provides preview and editing in a separate window, and some management capabilities. See Section 41.1.2, "Understanding the Document List Viewer Task Flow."


	
Document Manager

	
Yes

	
Shown in the default Resource Catalog only if it has been added by the Spaces administrator. Displays folders and files as specified by its Layout property: Explorer, Table, or Tree Table. See Section 41.1.3, "Understanding the Document Manager Task Flow."


	
Document Navigator

	
Yes

	
Shown in the default Resource Catalog only if it has been added by the Spaces administrator. Displays a simple listing of folders and files in a single pane, providing expand/collapse on folders to show the full hierarchy. There are no menu options available for this task flow. See Section 41.1.4, "Understanding the Document Navigator Task Flow."


	
Folder Viewer

	
Yes

	
Displays the contents of a folder in a single pane as a flat listing, providing in-place preview and editing, and robust management capabilities. See Section 41.1.5, "Understanding the Folder Viewer Task Flow."















40 Publishing Content Using Content Presenter

In a Spaces application, you can add content from one or more connected content repositories to the application, as described in Chapter 39, "Introduction to Adding and Managing Content."

This chapter describes how to publish content on a page in a Spaces application using the Content Presenter task flow:

	
Section 40.1, "What You Should Know About the Content Presenter Task Flow"


	
Section 40.2, "Adding a Content Presenter Task Flow to a Page"


	
Section 40.3, "Displaying the Content Presenter Configuration Dialog"


	
Section 40.4, "Selecting Content"


	
Section 40.5, "Selecting a Display Template"


	
Section 40.6, "Previewing the Results"


	
Section 40.7, "Adding Links from Content to Navigation Nodes"


	
Section 40.8, "Authoring Site Studio Content to Optimize Presentation in Content Presenter"


	
Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog"


	
Section 40.10, "Creating and Editing Files In-Context in a Content Presenter Task Flow"


	
Section 40.11, "Approving and Rejecting Files in Workflow"


	
Section 40.12, "Setting Content Presenter Task Flow Properties"





Audience

This chapter is intended for Spaces users assigned, minimally, the Pages-Edit Pages permission who want to add content in a Content Presenter task flow to a page in a Spaces application.



40.1 What You Should Know About the Content Presenter Task Flow

Content Presenter enables you to precisely customize the selection and presentation of content in a Spaces application. The Content Presenter task flow is available only when the connected content repository is Content Server and your Spaces administrator has completed the prerequisite configuration.




	
See Also:

For more information, see:
	
"Content Server Prerequisites" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal


	
"How to Create a Content Repository Connection Based on the Content Server Adapter" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal












With Content Presenter, you can select a single item of content, contents under a folder, a list of items, query for content, or select content based on the results of a Personalization Conductor scenario, and then select a template to render the content on a page in a Spaces application.




	
Note:

Content Server exposes a content item only after it has a revision status of Released. If a content item does not have Released status, you will not be able to configure Content Presenter to show the item. You can find the status of a content item in Content Server on the Content Information Page, as described in "Determining the Revision Status" in Oracle Fusion Middleware User's Guide for Oracle Content Server.







In addition to displaying the folders and files in Content Server, Content Presenter integrates with Oracle Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template. For more information, see Section 40.1.1, "Understanding Site Studio Integration."

Content Presenter has no dependency on the Documents service for adding or managing the content it displays.



40.1.1 Understanding Site Studio Integration

Oracle Site Studio is a powerful, flexible web development application suite that offers a comprehensive approach to designing, building, and maintaining enterprise-scale web sites. Site Studio uses Content Server as the main repository for a web site.

Site Studio region templates are defined in Site Studio Designer. They define the layout and look-and-feel of the data in contribution regions within web pages. They are partial HTML files in that they do not have a head and body section. At runtime, the Site Studio contributor data file (a Content Server document) is merged with the Site Studio region template to create the HTML fragment. This allows Site Studio region templates to be inserted into other HTML code as the web pages are generated for the Site Studio site.

Content Presenter integrates with Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template.




	
Note:

Oracle Site Studio files can also be included in the Folder Viewer, Document Explorer, and Document Manager task flows, and previewed using the Document Viewer. See Section 41.1.7, "Understanding the Document Viewer Task Flow."







Before you can display Site Studio contributor data files in Content Presenter, the WebCenter Portal administrator must complete the followings tasks, described in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal:

	
Enable Site Studio components (SiteStudio, SiteStudioExternalApplications, as described in "Configuring Content Server 11g for All WebCenter Portal Applications."


	
Disable or hide Site Asset categories that are not needed for typical Content Presenter implementations, as described in "Disabling Undesirable Site Asset Categories in Oracle Site Studio."


	
Enable the WebCenterConfigure component to allow for adding and editing Site Studio documents from within Content Presenter, as described in "What You Should Know About the WebCenterConfigure Component."




For proper surfacing in Content Presenter, the following link types can be used in both Site Studio region templates, as well as in a Site Studio contributor data file:

	
Links to nodes in the default navigation model, as described in Section 40.7, "Adding Links from Content to Navigation Nodes."


	
Links to inlined images.


	
Links to documents (except for absolute or relative path links). When clicking the link at runtime, it renders within the context of the application and displays the document using the Default View display template.


	
Absolute HTTP links, whether created in Site Studio contributor mode or in Site Studio Designer region template HTML.




The following Site Studio link types are not supported in Content Presenter:

	
Links to Site Studio sections.


	
Absolute or relative path links to Site Studio documents.




For guidelines on authoring recommendations for displaying a Site Studio contributor data file in Content Presenter, see Section 40.8, "Authoring Site Studio Content to Optimize Presentation in Content Presenter."

You can create and edit Site Studio contributor data files from the Content Presenter Configuration dialog (see Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog") or in-context when displayed in Content Presenter at runtime (see Section 40.10, "Creating and Editing Files In-Context in a Content Presenter Task Flow").

For more information about creating and using Site Studio contributor data files and Site Studio region templates, refer to the Oracle Site Studio documentation library.








40.2 Adding a Content Presenter Task Flow to a Page

To add a Content Presenter task flow to a page:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to the folders and files in the connected content repository.




	
Tip:

The presence or location of this section depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, next to Content Management, click Open to expose the content selections (Figure 40-1).








Figure 40-1 Opening the Content Management Section in the Resource Catalog

[image: Content Management Section in the Resource Catalog]



For information about the selections shown in the default Resource Catalog, see Section 39.2, "What You Should Know About Content Management Selections in the Resource Catalog."


	
Add the Content Presenter task flow to the page in one of two ways:

	
Next to Content Presenter, click Add (Figure 40-2).


Figure 40-2 Adding a Content Presenter Task Flow to a Page

[image: Oracle Composer Catalog: Add Content Presenter task flow]



A new empty region appears on your page (Figure 40-3).


Figure 40-3 Adding a Content Presenter Task Flow to a Page

[image: Content Presenter empty region]



	
Or, drill down in the Resource Catalog to the folder or file you want to display on the page: In the default Resource Catalog, next to All Content (or, in a Spaces application, Space Documents or Personal Documents), click Open until you locate the target content, then click Add, and choose Content Presenter from the menu (Figure 40-4).




	
Note:

Content Server exposes a content item only after it has a revision status of Released. If content item does not have Released status, you will not be able to configure Content Presenter to show the item. You can find the status of a content item in Content Server on the Content Information Page, as described in "Determining the Revision Status" in Oracle Fusion Middleware User's Guide for Oracle Content Server.








Figure 40-4 Adding Content to a Content Presenter Task Flow

[image: Add Content Presenter task flow]



The selected folder or file displays in a default display template, as shown in Figure 40-5 and Figure 40-6.

:

Figure 40-5 Content Presenter Task Flow: Default Template for Word Document

[image: CP Task Flow: Default Template for Word Document]




Figure 40-6 Content Presenter Task Flow: Default Template for Image File

[image: CP Task Flow: Default Template for Image File]













40.3 Displaying the Content Presenter Configuration Dialog

The Content Presenter Configuration dialog enables you to easily configure the Content Presenter task flow to select or change content, or choose a different display template.




	
Note:

You can also specify content and a display template by clicking the properties Edit icon (the second wrench icon in the task flow chrome) and specifying parameters on the Parameters tab of the Component Properties dialog. However, specifying parameters in this way is generally intended for use at design time by developers creating a WebCenter Portal: Framework application, or for advanced users who want to bind a parameter to an EL expression. If you modify a property value in the Component Properties dialog, the new value overrides the value specified in the Content Presenter Configuration dialog, and that value cannot subsequently be changed through the Content Presenter Configuration dialog. For information about Content Presenter task flow parameters, see Section 40.12, "Setting Content Presenter Task Flow Properties."







To display the Content Presenter Configuration dialog:

	
In the Content Presenter task flow (see Section 40.2, "Adding a Content Presenter Task Flow to a Page"), click the task flow Edit icon (the first wrench icon in the task flow chrome) (Figure 40-7).


Figure 40-7 Editing a Content Presenter Task Flow

[image: Edit Content Presenter task flow]



The Content Presenter Configuration dialog opens (Figure 40-8).


Figure 40-8 Content Presenter Configuration Dialog

[image: Content Presenter Configuration dialog]



A green check mark alongside an item indicates that the required information is complete and valid.









40.4 Selecting Content




	
Note:

Content Presenter does not support non-ASCII characters in files that are encoded using the non-UTF-8 character encoding. When users preview such files in Content Presenter, non-ASCII characters appear garbled.







Depending on the type of content you want to display, follow the steps in one of the following sections:

	
Section 40.4.1, "Selecting a Single Content Item"


	
Section 40.4.2, "Selecting the Contents of a Folder"


	
Section 40.4.3, "Selecting Content Based on the Results of a Query"


	
Section 40.4.4, "Selecting a List of Content Items"


	
Section 40.4.5, "Selecting Content Based on the Results of a Scenario"






40.4.1 Selecting a Single Content Item

To select a specific item (including a Site Studio contributor data file) to display in a Content Presenter display template or Oracle Site Studio region template (see Section 40.1.1, "Understanding Site Studio Integration"):

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Content or the Content tab.


	
On the Content page, expand the Content Source list, and select Single Content Item (Figure 40-9).


Figure 40-9 Selecting the Content Source: Single Content Item

[image: Selecting content source: Single Content Item]



	
Click Browse to locate the content item.




	
Note:

Content Server exposes a content item in the Browse list only after it has a revision status of Released. The revision status of a new content item changes from Done to Released after it has reached its specified release date (specified by the dInDate property). Content items that do not have Released status will not appear in the Browse list. You can find the status of a content item in Content Server on the Content Information Page, as described in "Determining the Revision Status" in Oracle Fusion Middleware User's Guide for Oracle Content Server.
An alternative way to display a single content item in Content Presenter is to navigate to the file and select Content Presenter from its Add menu, as described in Section 41.3, "Adding a Selected Folder or File to a Page." However, even though you are able to select the content item in this way, it will display in Content Presenter only if it has a revision status of Released. If the content item has a different revision status, but had a status of Released in the past, then Content Presenter will display the Released version of the content item, not the latest version that is not yet released.









If the Spaces application is connected to multiple Content Server repositories, the browse tree shows the parent folder for the current user, or for the current space, in the repository that is specified as the primary connection. To access other connected repositories, click the navigation icon in the toolbar to expose the VCR parent node. Click VCR to show all connected content repositories.


Figure 40-10 Navigating to Other Content Repositories

[image: Navigating to Other Content Repositories]






	
Note:

If the content repository includes an invalid type configuration, then no content displays when you click Browse. Instead, an error message reports Unable to retrieve content type information.















40.4.2 Selecting the Contents of a Folder

To select a folder to display its contents on a page (in the order stored in the folder) in a Content Presenter display template:

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Content or the Content tab.


	
On the Content page, expand the Content Source list, and select Contents Under a Folder (Figure 40-11).


Figure 40-11 Selecting the Content Source: Contents Under a Folder

[image: Selecting the Content Source: Contents Under a Folder]



	
Click Browse to locate a folder. To select the folder as the content source, click in the folder row, not on the folder name (clicking the folder name navigates into the folder).

If the Spaces application is connected to multiple Content Server repositories, the browse tree shows the parent folder for the current user, or for the current space, in the repository that is specified as the primary connection. To access other connected repositories, click the Show Hierarchy navigation icon to the left of the repository name to expose the VCR parent node. Click VCR to show all connected content repositories.


Figure 40-12 Navigating to Other Content Repositories

[image: Navigating to Other Content Repositories]






	
Note:

If the content repository includes an invalid type configuration, then no content displays when you click Browse. Instead, an error message reports Unable to retrieve content type information.















40.4.3 Selecting Content Based on the Results of a Query

To enter query criteria to refine the selection of the content to display in a Content Presenter display template:

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Content or the Content tab.


	
On the Content page, expand the Content Source list, and select Results of a Query (Figure 40-13).


Figure 40-13 Selecting the Content Source: Results of a Query

[image: Selecting the Content Source: Results of a Query]



	
In the Results of a Query pane (Figure 40-14 and Figure 40-15), enter desired values in the fields that you want the query to retrieve, as described in Table 40-1.


Figure 40-14 Results of a Query Pane: All Content Types

[image: Results of a Query Pane: All Content Types]




Figure 40-15 Results of a Query Pane: Selected Content Type

[image: Results of a Query Pane: Selected Content Type]




Table 40-1 Specifying Query Criteria for Results of a Query

	Element	Description
	
File Name

	
Enter the name of a file in the specified Repository that you want to display in the selected template. You can use * as a wild card character to retrieve multiple files; for example: *.jpg.


	
Keywords

	
Enter any value that may be present in the content of the documents. The value may be one or more words or phrases. Keyword search requires full-text search to be configured in Content Server by enabling FullText Search Option, as described in "Configuring the Oracle Content Server Instance" in Oracle Fusion Middleware Installation Guide for Oracle Enterprise Content Management Suite.


	
Content Type

	
Choose All Content Types to retrieve content items regardless of the content type. Or, choose the name of a content type profile or Site Studio region template definition (see Section 40.1.1, "Understanding Site Studio Integration") defined in Content Server. A content type profile specifies properties that define a specific type of content (for example, a press release, or a news flash, or an image). The content type IDC:GlobalProfile is the name of a default content type profile defined in Content Server that can be applied if no other content type profiles are defined.


	
Limit Results

	
Specify the maximum number of content items to be returned by the query.


	
Dates

	
In the Created and/or Last Modified fields, select a modifier to search for content items matching an exact date (is), a following date (is after), a preceding date (is before), or a date between two other dates (is between), which adds an additional date field for entering the second date. Click the Select Date icon to select a date in the correct format (mm/dd/yy), for example 11/18/11, or enter a date manually.


	
Users

	
In the Created By (user who uploaded) and Last Modified By fields, enter a user name for the creator or last modifier of the content item, or click the Browse icon to open the Search Users dialog where you can select from a list of users or search for a user name. For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


	
Additional Query Filters

	
Not applicable when Content Type is set to All Content Types. For a selected content type profile (prefixed IDC:), click the Add icon to list all the properties that are defined for the selected  profile (Figure 40-15). Select one or more properties to refine the query to find content items with specific property settings.


	
Sort Order

	
Not applicable when Content Type is set to All Content Types. For a selected content type profile (prefixed IDC:), specify a sort order for the properties shown in the Sort On list.








	
Click Preview Results to see the results of the query.




	
Note:

If the content repository includes an invalid type configuration, then no content displays when you click Preview Results. Instead, an error message reports Unable to retrieve content type information.















40.4.4 Selecting a List of Content Items

Content Presenter allows you to create a list of multiple content items. The order you use when creating the list is the order in which they are presented at runtime.

To browse or search for any number of items to add to a list, and delete or reorder the items before adding the list to a page in a Content Presenter display template:

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Content or the Content tab.


	
On the Content page, expand the Content Source list, and select List of Items (Figure 40-9).


Figure 40-16 Selecting the Content Source: List of Items

[image: Selecting the Content Source: List of Items]



	
In the Select Items to Display pane (Figure 40-17), click Add to browse or search for any number of items to add to a list.


Figure 40-17 Selecting Items to Display

[image: Selecting Items to Display]



If your Spaces application is connected to multiple Content Server repositories, the browse tree shows the parent folder for the current user, or for the current space, in the repository that is specified as the primary connection. To access other connected repositories, click the Show Hierarchy navigation icon to the left of the repository name to expose the VCR parent node. Click VCR to show all connected content repositories.


Figure 40-18 Navigating to Other Content Repositories

[image: Navigating to Other Content Repositories]






	
Note:

If the content repository includes an invalid type configuration, then no content displays when you click Browse. Instead, an error message reports Unable to retrieve content type information.















40.4.5 Selecting Content Based on the Results of a Scenario

If your Spaces application is configured to run Personalization Conductor scenarios using Content Presenter, you can select content based on the results of a WebCenter PersonalizationConductor scenario. For more information, see "Personalizing WebCenter Portal Applications" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal and "Configuring Content Presenter" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

To enter Personalization Conductor scenario criteria to refine the selection of the content to display in a Content Presenter display template:

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Content or the Content tab.


	
On the Content page, expand the Content Source list, and select Results of a Scenario (Figure 40-19).


Figure 40-19 Selecting the Content Source: Results of a Scenario

[image: Selecting the Content Source: Results of a Scenario]



	
In the Results of a Scenario pane, review the list of scenarios that have been tagged for Content Presenter consumption, select those for which you want to generate results, and enter required parameters (Figure 40-20).


Figure 40-20 Results of a Scenario Pane

[image: Results of a Scenario Pane]



	
Click Preview Results to see the results of the selected scenarios.




	
Note:

If the content repository includes an invalid type configuration, then no content displays when you click Preview Results. Instead, an error message reports Unable to retrieve content type information.
Any results that are returned from a scenario for use by Content Presenter must return a valid CMIS query, as Content Presenter takes the return value and runs it (as a CMIS query) against the repository specified within the Conductor URL. For information about how to format the query and examples, see Oracle Fusion Middleware Content Management REST Service Developer's Guide.



















40.5 Selecting a Display Template

The display template for the content you have selected on the Content page of the Content Presenter Configuration dialog may be one of the out-of-the-box templates provided with Spaces (see Table 40-2 and Table 40-3), a custom template designed for your organization in JDeveloper, or a Site Studio region template (see Section 40.1.1, "Understanding Site Studio Integration").

For information about creating custom display templates in JDeveloper, and uploading them for use by your Spaces application, see "Creating Custom Content Presenter Display Templates" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal. For information about creating and using Site Studio region templates, refer to the Oracle Site Studio documentation library.

By default, Spaces selects an appropriate display template based on the type of content selected. You can change the default template as required.

The Spaces administrator can show, hide, and manage the custom display templates on the Resources page of the application administration settings. For more information, see Section 10.4, "Managing Resources."

To change the display template for the selected content:

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Template or the Template tab.

The templates that are available for selection in the Template list are those that are identified by Content Presenter as suitable for displaying the selected content item(s). For more information, see "Identifying Display Templates for Selected Content Items" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
On the Template page:

	
If the Content Source selected on the Content page is a Site Studio contributor data file or any other single content item, select a Site Studio region template or a Content Presenter display template, respectively, from the Template list.

The list of available Site Studio region templates includes only the templates that match the region definition of the Site Studio contributor data file selected on the Content page. To identify the Site Studio region templates, hover your mouse pointer over the templates in the list to display hint text identifying the Site Studio region templates. For more information, see Section 40.1.1, "Understanding Site Studio Integration."




	
Note:

If you create a Site Studio contributor data file directly from the Content Presenter Configuration dialog, as described in Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog", the Site Studio region templates that match the region definition of the Site Studio contributor data file may not be immediately shown in the Template list. In this case, select the default template, and click Save. Then, open the Content Presenter Configuration dialog again to find the Site Studio region templates in the Template list.







The Content Presenter display templates in the list include the out-of-the-box templates for single content items (see Table 40-2). Other selections that may be available in the list are custom display templates that the application administrator has uploaded to your Spaces application. For more information, see the "Creating Content Presenter Display Templates" chapter in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

Figure 40-21 shows the Template list, with a Site Studio region template named PressReleaseFullDisplay selected.


Figure 40-21 Selecting the Custom Display Template

[image: Selecting the Custom Display Template]

Description of "Figure 40-21 Selecting the Custom Display Template"





	
If the Content Source selected on the Content page is a multiple content item (Contents Under a Folder, Results of a Query, or List of Items), select the desired Template Category (Figure 40-22), then the Template (Figure 40-23).


Figure 40-22 Selecting the Template Category (for Multiple Content Items)

[image: Selecting the template category]




Figure 40-23 Selecting the Display Template (for Multiple Content Items)

[image: Selecting the multiple content item template]



By default, there is only one category: Default Templates. This selection defines the collection of out-of-the-box templates available for multiple content items (see Table 40-3).

Other selections that may be available are custom template categories and display templates that the application administrator has uploaded to your Spaces application. For more information, see the "Creating Content Presenter Display Templates" chapter in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.





Table 40-2 Out-of-the-Box Templates for Displaying Single Content Items

	Single Content Item Templates	View ID	Description
	
Default Document Details View

	
oracle.webcenter.content.templates.default.document.details

	
Displays detailed information about any single content item including creation date, modification date, created by username, modified by username, path, and any comments.


	
Default List Item View

	
oracle.webcenter.content.templates.default.list.item

	
Displays a single line with an icon and item name as a link that either displays or downloads the item when clicked.


	
Default View

(default when no template is selected)

	
oracle.webcenter.content.templates.default.detail

	
Displays any single content item, either directly in the browser (images, HTML, text) or as a link that downloads the associated file when clicked.

For example, when the selected document type is .doc, the Default View template is assigned to be the Default Document Details View template.









Table 40-3 Out-of-the-Box Templates for Displaying Multiple Content Items

	Multiple Content Item Templates	View ID	Description
	
Accordion View

	
oracle.webcenter.content.templates.default.list.panel.accordion

	
Displays multiple content items in an accordion format, where each item can be expanded to display its details.


	
Bulleted View

	
oracle.webcenter.content.templates.default.list.bulleted

	
Displays multiple content items in a bulleted list format. Only content items display; folder items are omitted.


	
Bulleted with Folder Label View

	
oracle.webcenter.content.templates.default.list.bulleted.label

	
Displays multiple content items in a bulleted list format. The name of the folder containing the first item in the list displays as a label above the list. This template is intended to be used with Content Source set to Contents Under a Folder to ensure that all items have the same parent folder. Only content items display; folder items are omitted.


	
Carousel View

	
oracle.webcenter.content.templates.default.list.carousel

	
Displays multiple content items in a carousel format, where items can be browsed by moving a slider left or right.


	
Icon View

	
oracle.webcenter.content.templates.default.list.tile

	
Displays multiple content items in a tiled format with large icons and file names.


	
List View

(default when no template is selected)

	
oracle.webcenter.content.templates.default.list.simple

	
Displays multiple content items in a simple list.


	
List with Details Panel View

	
oracle.webcenter.content.templates.default.list.details.panel

	
Displays multiple content items in a list on the left, with a panel to the right displaying the details of a selected item.


	
Sortable Table View

	
oracle.webcenter.content.templates.default.list.tabular

	
Displays multiple content items in a sortable table that includes the document name, date created, and date modified.


	
Tabbed View

	
oracle.webcenter.content.templates.default.list.panel.tabbed

	
Displays multiple content items as tabs that can be selected to display item details.















40.6 Previewing the Results

To see a preview of your selected content before adding it to the page:

	
Click Preview or the Preview tab.




The appearance of the content on the Preview page is dependent on whether the selected display template uses a stretch or flow layout. While the final view of the task flow can be configured to use either a stretch layout or a flow layout, the Preview page only uses a flow layout. As a result, the preview of content using templates that were designed for a stretch layout displays unstretched at a fixed default size. This is the normal behavior of stretchable content when displayed in non-stretching flow layout. To allow stretchable content to stretch to its full size and fill the task flow space entirely, click the Edit icon for the task flow to display the Component Properties dialog, and select the Stretch Content property (on the Display Options tab). For more information, see Section 17.5.2.5, "Working with Component Display Options."




	
Note:

Content Presenter does not support non-ASCII characters in files that are encoded using the non-UTF-8 character encoding. When users preview such files in Content Presenter, non-ASCII characters appear garbled.







From the Preview tab, you can click Edit Web Content (Figure 40-24) to edit HTML and Site Studio files in-context, as described in Section 40.10, "Creating and Editing Files In-Context in a Content Presenter Task Flow".

If the file is in workflow, you will see a workflow notification area at the top, as described in Section 40.11, "Approving and Rejecting Files in Workflow."


Figure 40-24 Previewing an Oracle Site Studio Contributor Data File

[image: Previewing an Oracle Site Studio Contributor Data File]







40.7 Adding Links from Content to Navigation Nodes

When you expose content stored in a Content Presenter task flow, consider whether or not you want to add one or more links from the content to a node in the default navigation model (see Section 11.2.2.1.8, "Setting Display Options for Navigation Items").

When the content displays in Content Presenter at runtime, an end user can click the links to navigate to the desired navigation model node.

You can create a link in the following content items in:

	
a document of MIME type text/html (typically HTML files)


	
a Site Studio contributor data file (in a Rich Text element)


	
a Site Studio region template




To add a link to a node in the default navigation model from a content item:

	
Edit the content item, as described in:

	
Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog"


	
Section 40.10, "Creating and Editing Files In-Context in a Content Presenter Task Flow"





	
Add a link using the following syntax:


$wcUrl('externalId')


where externalId is the external identifier as configured in the Spaces default navigation model.

For example:


<a target="" href="$wcUrl('NEWCUSTOMERSLINK')">New Customers</a>









40.8 Authoring Site Studio Content to Optimize Presentation in Content Presenter

Content Presenter integrates with Oracle Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template. For more information, see Section 40.1.1, "Understanding Site Studio Integration."

To optimize the presentation of Oracle Site Studio content in Content Presenter, follow the guidelines provided in the following sections:

	
Section 40.8.1, "Best Practices for Images"


	
Section 40.8.2, "Best Practices for Defining Styles"


	
Section 40.8.3, "Best Practices for JavaScript"






40.8.1 Best Practices for Images

Keep the following guidelines in mind as you work with images in Site Studio that will be displayed using Content Presenter:

	
Store images in Content Server in a common location (filed).


	
Insert images into WYSIWYG elements using the Site Studio Contributor image wizard.


	
Set the image tag src attribute to a relative link to an image file in Content Server. This attribute is rewritten by Content Presenter during rendering to use the GET_FILE service.


	
For performance improvement, use web proxy to cache artifacts at URLs from Content Server, and set expiration based on tolerance for updates in Content Server.

Example for Apache mod_cache:

	
CacheEnable mem /cs


	
CacheDefaultExpire 3600 (one hour)












40.8.2 Best Practices for Defining Styles

Keep the following guidelines in mind as you work with style definitions for Site Studio contributor data files that will be displayed using Content Presenter:

	
Define styles in CSS files.


	
Store CSS files either in Content Server or in your Spaces application.

	
If stored in Content Server, add <link> in <head> of page template.





	
Load style class names into WYSIWYG region element definitions.


	
Select your CSS to format HTML in WYSIWYG elements.


	
For performance improvement, use web proxy to cache artifacts at URLs from Content Server, and set expiration based on tolerance for updates in Content Server.

Example for Apache mod_cache:

	
CacheEnable mem /cs


	
CacheDefaultExpire 3600 (one hour)












40.8.3 Best Practices for JavaScript

Keep the following guidelines in mind as you work with JavaScript in Site Studio contributor data files that will be displayed using Content Presenter:

	
Recommended: Do not use JavaScript within web content that is rendered within Spaces applications.


	
If your web content uses JavaScript, follow these guidelines:

	
Add <link> in <head> of page template


	
For performance improvement, use web proxy to cache artifacts at URLs from Content Server, and set expiration based on tolerance for updates in Content Server.

Example for Apache mod_cache:

	
CacheEnable mem /cs


	
CacheDefaultExpire 3600 (one hour)

















40.9 Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog

Content Presenter integrates with Oracle Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template. For more information, see Section 40.1.1, "Understanding Site Studio Integration."




	
Note:

To create or edit Oracle Site Studio content in a seamless interface within Spaces, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the frontend to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.




Without this configuration, it is still possible to create or edit Site Studio content from within Content Presenter, but the create and edit actions launch new browser windows (or tabs) rather than opening within the Content Presenter task flow.









To create or edit Oracle Site Studio content from the Content Presenter Configuration dialog:

	
In the Content Presenter Configuration dialog (see Section 40.3, "Displaying the Content Presenter Configuration Dialog"), click Select Content or the Content tab.


	
On the Content page, click Create Web Content (Figure 40-25).


Figure 40-25 Selecting the Content Source: Site Studio

[image: Selecting the Content Source: Site Studio]






	
Tip:

The Create Web Content button displays only when the Content Source field displays Single Content Item and when at least one Content Server repository (11g or higher) has the Site Studio component installed.







The Oracle Site Studio Choose Region Content pane opens (Figure 40-26).


Figure 40-26 Adding Site Studio Content: Choose Region Content

[image: Adding Site Studio Content: Choose Region Content]



	
In the Choose Region Content pane, select a Site Studio region definition on which the content you want to create or edit is based.


	
Click Next.

The Choose content file pane opens (Figure 40-27).


Figure 40-27 Adding Site Studio Content: Choose Content File

[image: Adding Site Studio Content: Choose Content File]



	
In the Choose content file pane, select one of the following:

	
New Contributor data file to open the Check-in Content pane (Figure 40-28), where you can specify the standard document properties for the new Site Studio contributor data file that you want to check in to Content Server.


Figure 40-28 Adding Site Studio Content: Check-in Content

[image: Adding Site Studio Content: Check-in Content]



	
Existing file from server to open Content Server (Figure 40-29), showing Site Studio contributor data files that are based on the selected region definition.


Figure 40-29 Content Server: Search Results

[image: Oracle Content Server: Search Results]






	
Make note of the file name, then click Next.

The Check-in Confirmation pane opens (Figure 40-30).


Figure 40-30 Adding Site Studio Content: Check-in Confirmation

[image: Adding Site Studio Content: Check-in Confirmation]



	
In the Check-in Confirmation pane, choose one of the following:

	
Edit content item now to open the Site Studio Contributor editor, where you can edit the content item as described in Section 40.10.2, "Editing Site Studio Files In-Context" (beginning with Step 4).


	
Exit without editing to make no changes to the file.





	
Click Finish to return to the Content Presenter Configuration dialog.

	
If you access the Spaces application through Oracle HTTP Server (OHS) and have configured the webContextRoot parameter, as described in the Note at the top of this section, the Site Studio contributor data file you selected is shown auto-selected in the Content Presenter Configuration dialog.


	
If OHS and the webContextRoot parameter are not configured, you can now select the Site Studio contributor data file to display in the Content Presenter task flow: On the Content page, browse to the Site Studio file, select it, and click Select.





	
In the Content Presenter Configuration dialog, click Save.









40.10 Creating and Editing Files In-Context in a Content Presenter Task Flow

In-context editing refers to editing content directly in a Spaces application at runtime, where the editor opens in a separate window.

With appropriate permissions, end users can edit HTML and Site Studio content in-context in a Content Presenter task flow.




	
Note:

Users must have permissions to view and edit the page containing the Content Presenter instance, as well as being assigned a role with write permissions on Content Server. For more information, see Chapter 20, "Understanding Security" and the chapter "Managing WebCenter Portal Application Security" in Oracle Fusion Middleware System Administrator's Guide for Oracle Content Server.







The following sections describe how to perform in-context editing:

	
Section 40.10.1, "Editing Wiki Documents or HTML Files In-Context"


	
Section 40.10.2, "Editing Site Studio Files In-Context"


	
Section 40.10.3, "Creating New Site Studio Content In-Context"


	
Section 40.10.4, "Changing the Edit Mode Key Sequence"






40.10.1 Editing Wiki Documents or HTML Files In-Context

With appropriate permissions, end users can edit wiki documents or HTML files in-context in a Content Presenter task flow.

To edit a wiki or HTML file in a Content Presenter task flow:

	
In the Content Presenter task flow, click anywhere in the file content.


	
Press Ctrl-Shift-C to enter the in-context edit mode. The editable areas of the web page are highlighted with a dashed border.

Note that you can change the key sequence to enter in-context edit mode if you wish. See Section 40.10.4, "Changing the Edit Mode Key Sequence."


	
Click the Edit icon in the upper right corner of the document chrome (Figure 40-31) to open the file in the Document Viewer preview pane.


Figure 40-31 Entering In-Context Edit Mode In a Content Presenter Task Flow

[image: Entering In-Context Edit Mode In CPTask Flow]



If the file is in workflowworkflow controls also display (Figure 40-32). For more information, see Chapter 43, "Working with Workflow-Enabled Content."


Figure 40-32 Workflow Controls in In-Context Edit Mode in a Content Presenter Task Flow

[image: Worfklow Controls in In-Context Edit Mode]



	
In the Document Viewer preview pane, click the Edit action (Figure 40-33) to automatically check the file out and open it for editing in the Rich Text Editor (RTE).




	
See Also:

For information about the RTE, see Section 41.11, "Using the Rich Text Editor (RTE)."








Figure 40-33 Opening the Rich Text Editor

[image: Opening the Rich Text Editor]



	
Make required updates, then save and close the file.

The modified file is automatically checked back in.


	
In the Content Presenter task flow in the Spaces application, press Ctrl-Shift-C again to exit the in-context editing mode.









40.10.2 Editing Site Studio Files In-Context

Content Presenter integrates with Oracle Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template. For more information, see Section 40.1.1, "Understanding Site Studio Integration."

With appropriate permissions, end users can edit Site Studio contributor data files in-context in a Content Presenter task flow.

To edit a Site Studio file in a Content Presenter task flow:

	
In the Content Presenter task flow, click anywhere in the Site Studio file content.


	
Press Ctrl-Shift-C to enter the in-context edit mode. The editable areas of the web page are highlighted with a dashed border.

Note that you can change the key sequence to enter in-context edit mode if you wish. See Section 40.10.4, "Changing the Edit Mode Key Sequence."


	
Click the Edit icon in the upper right corner of the document chrome (Figure 40-34) to open the file in Site Studio Contributor


Figure 40-34 Entering In-Context Edit Mode in a Content Presenter Task Flow

[image: Entering In-Context Edit Mode In CP Task Flow]



	
In the Site Studio Contributor Data File editor, click a region to edit, as shown in Figure 40-35.

For information about editing files in Site Studio Contributor, see the Oracle Site Studio documentation.


Figure 40-35 Editing a File in Site Studio Contributor

[image: Editing a File in Site Studio Contributor]



	
Click Save And Close to exit the Site Studio Contributor editor and return to the Spaces application.


	
In the Content Presenter task flow in the Spaces application, press Ctrl-Shift-C again to exit the in-context editing mode.









40.10.3 Creating New Site Studio Content In-Context

Content Presenter integrates with Oracle Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template. For more information, see Section 40.1.1, "Understanding Site Studio Integration."

With appropriate permissions, end users can create new web content in Site Studio during in-context editing in a Content Presenter task flow.

In-context creation of Site Studio files is slightly different than creating Site Studio files in the Content Presenter Configuration dialog, as described in Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog." When creating a new Site Studio file in-context, you are limited to creating content that is of the same region definition, file location, security group, and document type as the content selected in the Content Presenter task flow.

To create a new Site Studio file in a Content Presenter task flow:

	
In the Content Presenter task flow, click anywhere in the currently displayed Site Studio file.


	
Press Ctrl-Shift-C to enter the in-context edit mode. The editable areas of the web page are highlighted with a dashed border.

Note that you can change the key sequence to enter in-context edit mode if you wish. See Section 40.10.4, "Changing the Edit Mode Key Sequence."


	
Click the Create icon in the upper right corner of the document chrome (Figure 40-36).


Figure 40-36 Selecting the Create Icon in a Site Studio File

[image: Selecting the Create Icon in a Site Studio File]



	
In the Choose Content window, select New Contributor data file, then click Next (Figure 40-37).


Figure 40-37 Choose New Content File Window

[image: Choose New Content File Window]



	
Fill out the Check-in Content form. This form provides the metadata for the contributor data file and checks the file into Content Server. The file is empty until you (or another contributor) edits it. For more information on filling out this form, see "Checking in Files" in Oracle Fusion Middleware User's Guide for Oracle Content Server.


	
In the Check-in Confirmation window, select Edit content item now.


	
Click Finish.

The Site Studio Contributor Data File editor opens (Figure 40-38).


Figure 40-38 Site Studio Contributor File Editor

[image: Site Studio Contributor File Editor]



	
Edit the file, then click Save and Close.









40.10.4 Changing the Edit Mode Key Sequence

To change the edit mode key sequence used to enter in-content editing mode for a Site Studio file in Content Presenter, edit the <key-sequence> entry in the application's adf-config.xml file:


******** Content Contributor Mode adf-config.xml entries ***************
 
<page-editor-config xmlns="http://xmlns.oracle.com/adf/pageeditor/config">
   <mode-switch-key>
      <enabled>true</enabled>
      <key-sequence>ctrl e</key-sequence>
   </mode-switch-key>
</page-editor-config>








40.11 Approving and Rejecting Files in Workflow

You can view content items displayed in Content Presenter while they are in a workflow, including Site Studio contributor data files displayed in a Site Studio region template. As long as the content item has at some point had Released status in Content Server, you can display the content item in Content Presenter. Then, if a revision of the content item is pending in workflow, Content Presenter allows approvers for the content item to toggle between the published version and the version in workflow in page edit mode (Figure 40-39) or in-context edit (contributor) mode, and also provides links to approve or reject the item in workflow, and view additional details about the item (including workflow name, steps performed, action performed, date of action, and who performed the action).


Figure 40-39 Preview File in Workflow to Approve or Reject in Content Presenter

[image: Page Edit Mode: Approve or Reject in CP]



For more information about working with files in workflow in Content Presenter, see Section 43.3.2, "Viewing Workflow Files in a Content Presenter Task Flow."






40.12 Setting Content Presenter Task Flow Properties

The Content Presenter task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 40-40).


Figure 40-40 Content Presenter Task Flow Component Properties

[image: Content Presenter Task Flow Component Properties]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Content Presenter task flow and describe the properties on the Parameters tab:

	
Section 40.12.1, "What You Should Know About the Content Presenter Task Flow Properties"


	
Section 40.12.2, "Content Presenter Task Flow Parameters"






40.12.1 What You Should Know About the Content Presenter Task Flow Properties




	
Note:

The Content Presenter properties are intended for use at design time by developers creating a WebCenter Portal: Framework application (see "Adding Content Task Flows and Document Components to a Portal Page" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal), or for advanced users who want to bind a parameter to an EL expression. If you modify a property value in the Component Properties dialog, the new value overrides the value specified in the Content Presenter Configuration dialog, and that value becomes read-only in the Content Presenter Configuration dialog.







The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 40.12.2, "Content Presenter Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






40.12.2 Content Presenter Task Flow Parameters

Table 40-4 describes the parameters that are unique to the Content Presenter task flow.


Table 40-4 Content Presenter Task Flow Parameters

	Parameter	Description
	
Data Source

	
The data source of the content. The value depends on the value of Data Source Type:

	
When Data Source Type=Single Node, set Data Source to a single node identifier in the format:

connection_name#dDocName:content_id

For example: myconnection.us.oracle.com#dDocName:STAN_IDC-007619


	
When Data Source Type=Folder Contents, set Data Source to a single node identifier in the format:

connection_name#dCollectionID:collection_id

For example: myconnection.us.oracle.com#dCollectionID:45535


	
When Data Source Type=Query Expression, set Data Source to a CMIS (Content Management Interoperability Services) query expression.

Examples:

select * from cmis:document where cmis:name like \'test%\'

connectionName=connection_name#select * from cmis:document where cmis:createdBy = \'weblogic\'

Note: If connectionName is not specified, then the primary connection will be used.

For more information about how to format the query and for more examples, see Oracle Fusion Middleware Content Management REST Service Developer's Guide.


	
When Data Source Type=Multi Node, set Data Source to a set of comma-delimited node identifiers in the format:

connection_name#dDocName:content_id, connection_name#dDocName:content_id, ...

For example: myconn#dDocName:DOCUMENT_ID_12345,myconn#dDocName:DOCUMENT_ID_56789




	
When Data Source Type=Scenario Results, set Data Source to the results from a scenario in the format:

conductor-connection-name=conductor_conn_name,namespace=scenario_namespace,scenario-name=scenario_name,inputparm1=value1,inputparm2=value2, ...

For example:

conductor-connection-name=ConductorServiceLocal,namespace=CPNamespace,scenario-name=GetRelatedDocsScenario,topic=outdoors,interests=hiking

For information about the Personalization Conductor and scenarios, see "Personalizing WebCenter Portal Applications" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.





	
Data Source (cont'd)

	
where:

	
connection_name = the name of the content repository connection.


	
content_id = the Content ID for the content specified on the content information page for the item in Content Server, or the CollectionID value on the content server.


	
collection_id = the dCollectionID found in the URL for the folder information page in Content Server.


	
conductor_connection_name = the name of the URL connection that points to the Personalization Conductor (this name must start with Conductor). This value must match the Reference name attribute value in the connections.xml file for this URL connection. For more information, see "Configuring Content Presenter" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal and the appendix "Files for WebCenter Portal Applications" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


	
namespace = the name of the namespace that contains the specified scenario.


	
scenario_name = the name of the scenario that Content Presenter will be using.





	
Data Source Type

	
The data source type of the content. Corresponds to the Content Source value in the Content Presenter Configuration dialog. Valid values are:

	
Single Node: A single content item.


	
Folder Contents: The contents of a folder.


	
Query Expression: The results of a query.


	
Multi Node: An ordered list of content items.


	
Scenario Results: The results of the specified scenario created using the Scenario Editor in JDeveloper. See "Personalizing WebCenter Portal Applications" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.





	
Maximum Results

	
The maximum number of results to display when Data Source Type is Query Expression.

Default: 100


	
Region Template

	
Specifies whether the display template is a Site Studio region definition template. This value is valid only with Content Server 11g or higher:

	
${true}: Display template is a Site Studio region definition template. The TemplateView ID value is set to the Content ID of the region template.


	
${false} (default): Display template is not a Site Studio region definition template.




For information about creating and using Site Studio region templates, see Section 40.1.1, "Understanding Site Studio Integration" and the Oracle Site Studio documentation library.


	
Task Flow Instance ID

	
The unique identifier of this task flow instance, used internally to maintain the association of the task flow instance with its customization and personalization settings. Do not edit this value.


	
Template Category ID

	
The display template category ID to use in rendering results for multiple content items. This ID may reference the default template category for an out-of-the-box display template (Table 40-3) or a custom category created for a display template for multiple content items (see "Creating Content Presenter Display Templates" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal).


	
Template View ID

	
The display template view ID to use in rendering results for single content items. Enter the view ID of a template that is configured in the Resource Manager for a specific content type, or for list-based templates by category ID. This ID may reference one of the out-of-the-box display templates (Table 40-2), a custom display template (see "Creating Content Presenter Display Templates" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal), or set to the contentID of a region template if the content is a region.

















41 Working with the Documents Service Task Flows and Document Components

In a WebCenter Portal: Spaces application, you can add content from one or more connected content repositories to the application, as summarized in Chapter 39, "Introduction to Adding and Managing Content."




	
See Also:

For an overview of content management in Spaces, see Section 2, "Leveraging Content Management."







This chapter describes how to use the Documents service task flows and document components to access, add, and manage folders and files in a Spaces application:

	
Section 41.1, "What You Should Know About the Documents Service Task Flows"


	
Section 41.2, "What You Should Know About Document Components"


	
Section 41.3, "Adding a Selected Folder or File to a Page"


	
Section 41.4, "Adding a Documents Service Task Flow to a Page"


	
Section 41.5, "Understanding the Documents Service Task Flow Menus and Actions"


	
Section 41.6, "Personalizing Your View"


	
Section 41.7, "Creating a Folder"


	
Section 41.8, "Creating a File"


	
Section 41.9, "Opening a Folder"


	
Section 41.10, "Opening a File"


	
Section 41.11, "Using the Rich Text Editor (RTE)"


	
Section 41.12, "Editing and Updating a File"


	
Section 41.13, "Renaming a Folder or File"


	
Section 41.14, "Copying and Pasting Folders and Files"


	
Section 41.15, "Moving Folders and Files"


	
Section 41.16, "Deleting Folders and Files"


	
Section 41.17, "Refreshing Folder Contents"


	
Section 41.18, "Hiding and Showing Folders"


	
Section 41.19, "Viewing, Entering, and Deleting Comments on a File"


	
Section 41.20, "Working with Tags"


	
Section 41.21, "Viewing and Deleting File Version History"


	
Section 41.22, "Viewing and Modifying Folder and File Properties"


	
Section 41.23, "Working with Links"


	
Section 41.24, "Working with Recommendations"


	
Section 41.25, "Opening or Saving PDF Files"


	
Section 41.26, "Sharing the URL for a Folder or File"


	
Section 41.27, "Setting Security Options on a Folder or File"


	
Section 41.28, "Subscribing to a File"


	
Section 41.29, "Liking and Unliking a File"


	
Section 41.30, "Adding a Folder or File to Your Favorites"


	
Section 41.31, "Searching for Documents"







	
Note:

Many of the tasks described in this chapter can also be accomplished for Microsoft Office (Word, Excel, and PowerPoint) files using the task pane available through Microsoft Office shared document management functionality, as described in Chapter 46, "Working with Microsoft Office and Explorer Integration."








Audience

This chapter is intended for Spaces users who want to view, create, edit, and manage folders and files as individual items or in one of the Documents service task flows on a page in a Spaces application.

To perform the tasks described in this chapter, users need to be assigned a role that includes the Edit Pages, View Documents, Create and Edit Documents, and Delete Documents permissions. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



41.1 What You Should Know About the Documents Service Task Flows

The Documents service task flows provide a variety of formats to display folders and files, including wikis and blogs, on a page in a Spaces application. You can choose the task flows appropriate for your application to provide features for accessing, adding, and managing folders and files; configuring and viewing file and folder properties; and searching file and folder content in Content Server, Oracle Portal, or SharePoint content repositories, and your Spaces administrator has completed the prerequisite configuration




	
Note:

The availability of SharePoint as a content repository requires the installation of the SharePoint adapter. Administration for SharePoint is performed using WLST commands, not Oracle Enterprise Manager Fusion Middleware Control Console.







In a space, you can add Documents service task flows to a page without necessarily enabling the Documents service in the space. If the Documents service is not enabled in a space, adding a Documents service task flow to a page does not auto-populate the task flow with folders and files by default, unless you edit the default task flow properties. Once you enable the Documents service in the space (see Section 51.10.1, "Enabling and Disabling Services Available to a Space"), the following additional content functionality is made available:

	
Documents service task flows added to the space are auto-populated by default with folder and file listings based on the default content repository connection.


	
Documents added to the space are stored in a folder whose security is managed by the space.


	
You can add a Documents service task flow that displays only the documents belonging to the current space (in the Content Management section of the Composer Resource Catalog, select Space Documents).




Table 41-1 provides an overview of the Documents service task flows, which offer different ways to display folder and file listings to add and manage content in the connected content repository, or to display individual files in Spaces.


Table 41-1 Documents Service Task Flows

	
	Folder and File Listings	Individual Folders	Individual Files
	
Document Explorer task flow. Displays folders and files in two panes, combining the functionality of the Document Navigator and Folder Viewer task flows. It provides in-place previewing and editing, and robust document management capabilities with an interface that should be familiar to users of Windows Explorer. Size: medium to full page width.

	
X

	
X

	

	
Document List Viewer task flow. Displays folders and files in a single pane as a flat listing. It provides preview and editing in separate window, and some management capabilities. Size: narrow to medium page width.

	
X

	
X

	

	
Document Manager task flow. Displays folders and files as specified by its Layout property: Explorer, Table, or Tree Table. The Explorer layout is identical to the Document Explorer task flow, without the properties Show Documents, Show Folders, and Collapse Tree Navigation.

	
X

	
X

	

	
Document Navigator task flow. Displays a nested hierarchy of folders and files in a single pane, providing expand and collapse on folders to show the full hierarchy. Size: narrow to medium page width.

	
X

	
X

	

	
Folder Viewer task flow. Displays the contents of a folder in a single pane as a flat listing, providing in-place preview and editing, and robust document management capabilities with a straightforward interface that should be familiar to Windows users. Size: medium to full page width.

	
X

	
X

	

	
Recent Documents task flow. Displays a list of the files most recently created or modified in the current folder. This task flow is available only when the connected content repository is Content Server.

	
X

	
	

	
Document Viewer task flow. Displays a preview of a file, or file properties for files that do not support a preview. A tabbed set of panes at the bottom of the task flow provide access to comments, tags, history, info (properties), and links.

	
	
XFoot 1 

	
X


	
Document Mini Properties task flow. Displays the Basic properties of a file in a read-only view.

	
	
X1

	
X


	
Document Properties task flow. Displays both Basic and Advanced properties of a file, along with an Edit button to allow you to modify property values.

	
	
X1

	
X


	
Document Version History task flow. Displays a list of versions of a file, allowing for deletion of a selected version.

	
	
	
X








Footnote 1 To show folder information in a Document Viewer, Document Mini Properties, or Document Properties task flow, you can set the task flow's Item ID or Resource ID property to the ID of the target folder. See Chapter 42, "Setting Documents Service Task Flow and Document Component Properties."

For more information about each Documents service task flow, refer to the following sections:

	
Section 41.1.1, "Understanding the Document Explorer Task Flow"


	
Section 41.1.2, "Understanding the Document List Viewer Task Flow"


	
Section 41.1.3, "Understanding the Document Manager Task Flow"


	
Section 41.1.4, "Understanding the Document Navigator Task Flow"


	
Section 41.1.5, "Understanding the Folder Viewer Task Flow"


	
Section 41.1.6, "Understanding the Recent Documents Task Flow"


	
Section 41.1.7, "Understanding the Document Viewer Task Flow"


	
Section 41.1.8, "Understanding the Document Mini Properties Task Flow"


	
Section 41.1.9, "Understanding the Document Properties Task Flow"


	
Section 41.1.10, "Understanding the Document Version History Task Flow"






41.1.1 Understanding the Document Explorer Task Flow

The Document Explorer task flow displays a list of folders and files in two panes, combining the functionality of the Document Navigator and Folder Viewer task flows. The left pane shows folders in a nested hierarchy, and the right pane shows the contents of the currently selected folder (Figure 41-1). This task flow provides robust document management capabilities with an interface that should be familiar to users of Windows Explorer. The size of this task flow is medium to full page width.


Figure 41-1 Document Explorer Task Flow

[image: Document Explorer Task Flow]



This is the task flow used to display folders and files on the Documents page in a space, as shown in Figure 41-2 (see Section 7.3.1, "What You Should Know About System Pages").


Figure 41-2 Documents Page in a Space

[image: Documents Page in a Space]






	
Note:

The Documents service is exposed on the Documents page and administration settings in a space only with Content Server 11g. If the connected content repository is Content Server 10g, the Documents page is not shown in a space, and the Documents service is not available in the space administration settings (Services and Roles). To use the Documents service functionality in 10g, you can create a page in a space and add Documents service task flows to the page (see Section 41.4, "Adding a Documents Service Task Flow to a Page").







If you see only a single pane (default), click the Restore Pane icon at the bottom left of the task flow to expose the left pane (Figure 41-3).


Figure 41-3 Restore Pane Icon

[image: Restore Pane Icon]



Conversely, click the Collapse Pane icon at the bottom left of the task flow to hide the left pane (Figure 41-4).


Figure 41-4 Collapse Pane Icon

[image: Collapse Pane Icon]



The Document Explorer task flow is a feature-rich Documents service task flow for viewing, managing, and collaborating on folders and files. In the Document Explorer task flow, you can:

	
Click the expand and collapse icons for a folder to show and hide the subfolders.


	
Click a folder in the left or right pane to display the contents of that folder in the right pane, and drill down further into subfolders.


	
Click a file in the right pane to display a preview of the file contents in the Document Viewer preview pane, with file management options, including in-place editing for some file types. If the file type does not support a preview (for example, .mp3 music files, video files, or .zip files), the preview pane displays the file properties (see Section 41.1.7, "Understanding the Document Viewer Task Flow").


	
Click in a row (not on the folder or file name) in the right pane to perform menu actions on the folder or file in that row (see Section 41.5.1, "Menus and Actions in the Documents Service Task Flows").

Alternatively, right-click a folder or file to display a context menu of available actions (see Section 41.5.1.6, "Folder Context Menu" and Section 41.5.1.7, "File Context Menu").


	
Drag and drop folders and files in the task flow hierarchy to reorganize the file or folder structure.




To add a Document Explorer task flow to a page, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." In the default Resource Catalog, open Content Management, then click Add next to Document Explorer to display the default listing of folder and files in the root folder of the active content repository connection.



41.1.1.1 Changing the Document Explorer Task Flow Default Listing

You can change the default listing displayed in a Document Explorer task flow in either of the following ways:

	
Selecting a Specific Folder in the Resource Catalog


	
Modifying Properties





Selecting a Specific Folder in the Resource Catalog

To change the default listing displayed in a Document Explorer task flow by selecting a specific folder to display:

	
Drill down to a target folder in the Resource Catalog, then click the corresponding Add link, and choose Document Explorer (Figure 41-5). For more information, see Section 41.3, "Adding a Selected Folder or File to a Page."


Figure 41-5 Add Menu for Folder

[image: Add Menu for Folder]






Modifying Properties

To change the default listing displayed in a Document Explorer task flow by modifying the task flow properties:

	
Edit the page, and click the properties Edit icon (wrench) in the task flow chrome (Figure 41-6) to open the Component Properties dialog.


Figure 41-6 Edit Icon in Task Flow Chrome

[image: Edit Icon in Task Flow Chrome]



	
To change the target folder, set the Connection Name and Root Folder Path properties on the Parameters tab (see Table 42-1, "Document Explorer Task Flow Parameters").











41.1.2 Understanding the Document List Viewer Task Flow

The Document List Viewer task flow displays the contents of a folder in a single pane as a flat listing (Figure 41-7). In this task flow, you can navigate a folder hierarchy, and customize search queries. While this task flow may be useful for a specific need, its search functionality is replicated and enhanced by using the Content Presenter task flow instead. The size of this task flow is narrow to medium page width.


Figure 41-7 Document List Viewer Task Flow (with Show Folders enabled)

[image: Document List Viewer Task Flow]



In the Document List Viewer task flow, you can:

	
Click a folder to display the contents of that folder, and drill down further into subfolders.


	
Click a file to display a preview of the file contents in a separate Document Viewer preview window, with file management options, including editing for some file types. If the file type does not support a preview (for example, .mp3 music files, video files, or .zip files), the preview window displays the file properties. See Section 41.1.7, "Understanding the Document Viewer Task Flow."


	
Click in a row to perform View menu actions on the folder or file in that row. View is the only menu available for this task flow.




To add a Document List Viewer task flow to a page, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." In the default Resource Catalog, open Content Management, then click Add next to Document List Viewer.



41.1.2.1 Changing the Document List Viewer Task Flow Default Listing

You can change the default listing displayed in a Document List Viewer task flow in any of the following ways:

	
Selecting a Specific Folder in the Resource Catalog


	
Modifying Properties


	
Specifying Detailed Content Source Criteria





Selecting a Specific Folder in the Resource Catalog

To change the default listing displayed in a Document List Viewer task flow by selecting a specific folder to display:

	
Drill down to a target folder in the Resource Catalog, then click the corresponding Add link, and choose Document List Viewer (Figure 41-8). For more information, see Section 41.3, "Adding a Selected Folder or File to a Page."


Figure 41-8 Add Menu for Folder

[image: Add Menu for Folder]






Modifying Properties

To change the default listing displayed in a Document List Viewer task flow by modifying the task flow properties:

	
Edit the page, and click the properties Edit icon (the second wrench icon in the task flow chrome) (Figure 41-9) to open the Component Properties dialog.


Figure 41-9 Properties Edit Icon in Document List Viewer Task Flow Chrome

[image: Properties Edit Icon in Document List Viewer task flow]



	
To display folders as well as files, select the Show Folders parameter checkbox .


	
To change the target folder, set the Connection Name and Root Folder Path properties on the Parameters tab (see Table 42-2, "Document List Viewer Task Flow Parameters").





Specifying Detailed Content Source Criteria

To change the default listing displayed in a Document List Viewer task flow to list content that matches specified criteria:

	
In the task flow heading, click the configuration Edit icon (the first wrench icon in the task flow chrome) (Figure 41-10) to open the Document List Viewer Configuration dialog.


Figure 41-10 Configuration Edit Icon in Document List Viewer Task Flow Chrome

[image: Configuration Edit Icon in Document List Viewer task flow]



	
In the Document List Viewer Configuration dialog (Figure 41-11), select from the Content Source dropdown list:


Figure 41-11 Document List Viewer Configuration Dialog

[image: Document List Viewer Configuration Dialog]



	
Contents Under a Folder (folders display in the task flow pane only when the Show Folders parameter is selected). Click the Browse icon, navigate to and select the folder with the content you want to initially display in the task flow, then click Save.


	
Results of a Query. In the Results of a Query pane (Figure 41-12 and Figure 41-13), enter desired values in the fields that you want the query to retrieve, as described in Table 41-2.


Figure 41-12 Results of a Query Pane: All Content Types

[image: Results of a Query Pane: All Content Types]




Figure 41-13 Results of a Query Pane: Selected Content Type

[image: Results of a Query Pane: Selected Content Type]




Table 41-2 Specifying Query Criteria for Results of a Query

	Element	Description
	
File Name

	
Enter the name of a file in the specified Repository that you want to display in the Document List Viewer task flow. You can use * as a wild card character to retrieve multiple files; for example: *.jpg.


	
Keywords

	
Enter any value that may be present in the content of the documents. The value may be one or more words or phrases. Keyword search requires full-text search to be configured in Content Server by enabling FullText Search Option, as described in "Configuring the Oracle Content Server Instance" in Oracle Fusion Middleware Installation Guide for Oracle Enterprise Content Management Suite.


	
Content Type

	
Choose All Content Types to retrieve content items regardless of the content type. Or, choose the name of a content type profile defined in Content Server. A content type profile specifies properties that define a specific type of content (for example, a press release, or a news flash, or an image). The content type IDC:GlobalProfile is the name of a default content type profile defined in Content Server that can be applied if no other content type profiles are defined.


	
Limit Results

	
Specify the maximum number of content items to be returned by the query.


	
Dates

	
In the Created and/or Last Modified fields, select a modifier to search for content items matching an exact date (is), a following date (is after), a preceding date (is before), or a date between two other dates (is between), which adds an additional date field for entering the second date. Click the Select Date icon to select a date in the correct format (mm/dd/yy), for example 11/18/11, or enter a date manually.


	
Users

	
In the Created By (user who uploaded) and Last Modified By fields, enter a user name for the creator or last modifier of the content item, or click the Browse icon to open the Search Users dialog where you can select from a list of users or search for a user name. For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


	
Additional Query Filters

	
Not applicable when Content Type is set to All Content Types. For a selected content type profile (prefixed IDC:), click the Add icon to list all the properties that are defined for the selected profile (Figure 41-13). Select one or more properties to refine the query to find content items with specific property settings.


	
Sort Order

	
Not applicable when Content Type is set to All Content Types. For a selected content type profile (prefixed IDC:), specify a sort order for the properties shown in the Sort On list.











	
Click the Preview tab to view the content that will display in the Document List Viewer task flow.




	
Note:

If the content repository includes an invalid type configuration, then no content displays on the Preview tab. Instead, an error message reports Unable to retrieve content type information.

















41.1.3 Understanding the Document Manager Task Flow

The Document Manager task flow displays folders and files as specified by its Layout property (see Section 42.4, "Setting Document Manager Task Flow Properties"):

	
Explorer layout (default): Displays folders and files in two panes; the left pane shows folders, and the right pane show the contents of the currently selected folder (Figure 41-14). This layout is identical to the Document Explorer task flow, without the properties Show Documents, Show Folders, and Collapse Tree Navigation (see Section 42.2, "Setting Document Explorer Task Flow Properties").


	
Table layout: Displays only the contents of the current folder in a single pane, with the capability to click a folder to drill down, refreshing the pane with the folder contents (Figure 41-15).


	
Tree Table layout: Displays the folder hierarchy in a single pane, beginning with the root folder, with the capability to expand and collapse folders (Figure 41-16). This layout may be familiar to Mac OS X users.





Figure 41-14 Document Manager Task Flow: Explorer Layout

[image: Document Manager Task Flow: Explorer Layout]




Figure 41-15 Document Manager Task Flow: Table Layout

[image: Document Manager Task Flow: Table Layout]




Figure 41-16 Document Manager Task Flow: Tree Table Layout

[image: Document Manager Task Flow: Tree Table Layout]



In the Document Manager task flow, you can:

	
Click the expand and collapse icons for a folder to show and hide the contents in the folder within the folder hierarchy.


	
Click a folder to display the contents of only that folder, and drill down further into subfolders.


	
Click a file to display a preview of the file contents in the Document Viewer preview pane, with file management options, including in-place editing for some file types. If the file type does not support a preview (for example, .mp3 music files, video files, or .zip files), the preview pane displays the file properties. See Section 41.1.7, "Understanding the Document Viewer Task Flow."


	
Click in a row (not on the folder or file name) in the right pane to perform menu actions on the folder or file in that row (see Section 41.5.1, "Menus and Actions in the Documents Service Task Flows").

Alternatively, right-click a folder or file to display a context menu of available actions (see Section 41.5.1.6, "Folder Context Menu" and Section 41.5.1.7, "File Context Menu").


	
Drag and drop folders and files in the task flow hierarchy to reorganize the file or folder structure.




To add a Document Manager task flow to a page, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." In the default Resource Catalog, open Content Management, then click Add next to Document Manager to display the default listing of folders and files in the root folder of the active content repository connection.




	
Note:

The Document Manager task flow is not shown under Content Management in the default Composer Resource Catalog provided out-of-the-box with Spaces, so you will only see an entry for this task flow if it has been added to a custom Resource Catalog that has been made available to the page. However, if you navigate to a specific folder in the default Resource Catalog, this task flow is selectable from the Add menu for the folder (Figure 41-17).
For information about creating a custom Resource Catalog, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Documents for a list of all available content task flows).











41.1.3.1 Changing the Document Manager Task Flow Default Listing

You can change the default listing displayed in a Document Manager task flow in either of the following ways:

	
Selecting a Specific Folder in the Resource Catalog


	
Modifying Properties





Selecting a Specific Folder in the Resource Catalog

To change the default listing displayed in a Document Manager task flow by selecting a specific folder to display:

	
Drill down to a target folder in the Resource Catalog, then click the corresponding Add link, and choose Document Manager (Figure 41-17). For more information, see Section 41.3, "Adding a Selected Folder or File to a Page."


Figure 41-17 Add Menu for Folder

[image: Add Menu for Folder]






Modifying Properties

To change the default listing displayed in a Document Manager task flow by modifying the task flow properties:

	
Edit the page, and click the properties Edit icon (wrench) in the task flow chrome (Figure 41-18) to open the Component Properties dialog.


Figure 41-18 Edit Icon in Task Flow Chrome

[image: Edit Icon in Task Flow Chrome]



	
To change the target folder, set the Connection Name and Root Folder Path properties on the Parameters tab (see Table 42-3, "Document Manager Task Flow Parameters").











41.1.4 Understanding the Document Navigator Task Flow

The Document Navigator task flow displays a nested hierarchy of folders and files in a single pane, with the capability to expand and collapse folders to view folder hierarchy within the current folder (Figure 41-19). There are no menu options available for this task flow. The size of this task flow is narrow to medium page width.


Figure 41-19 Document Navigator Task Flow

[image: Document Navigator Task Flow]



In the Document Navigator task flow, you can:

	
Click the expand and collapse icons for a folder to show and hide the contents in the folder within the folder hierarchy.


	
Drag and drop folders and files in the task flow hierarchy to reorganize the file or folder structure.




To add a Document Navigator task flow to a page, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." In the default Resource Catalog, open Content Management, then click Add next to Document Navigator to display the default listing of folders in the root folder of the active content repository connection.




	
Note:

The Document Navigator task flow is not shown under Content Management in the default Composer Resource Catalog provided out-of-the-box with Spaces, so you will only see an entry for this task flow if it has been added to a custom Resource Catalog that has been made available to the page. However, if you navigate to a specific folder in the default Resource Catalog, this task flow is selectable from the Add menu for the folder (Figure 41-20).
For information about creating a custom Resource Catalog, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Documents for a list of all available content task flows).











41.1.4.1 Changing the Document Navigator Task Flow Default Listing

You can change the default listing displayed in a Document Navigator task flow in either of the following ways:

	
Selecting a Specific Folder in the Resource Catalog


	
Modifying Properties





Selecting a Specific Folder in the Resource Catalog

To change the default listing displayed in a Document Navigator task flow by selecting a specific folder to display:

	
Drill down to a target folder in the Resource Catalog, then click the corresponding Add link, and choose Document Navigator (Figure 41-20). For more information, see Section 41.3, "Adding a Selected Folder or File to a Page."


Figure 41-20 Add Menu for Folder

[image: Add Menu for Folder]






Modifying Properties

To change the default listing displayed in a Document Navigator task flow by modifying the task flow properties:

	
Edit the page, and click the properties Edit icon (wrench) in the task flow chrome (Figure 41-21) to open the Component Properties dialog.


Figure 41-21 Edit Icon in Task Flow Chrome

[image: Edit Icon in Task Flow Chrome]



	
To change the target folder, set the Connection Name and Start Folder Path properties on the Parameters tab (see Table 42-4, "Document Navigator Task Flow Parameters").











41.1.5 Understanding the Folder Viewer Task Flow

The Folder Viewer task flow displays the contents of a folder in a single pane as a flat listing (Figure 41-22), providing in-place preview and editing of the contents of the folder, and robust document management capabilities with a straightforward interface that should be familiar to Windows users. The size of this task flow is medium to full page width.


Figure 41-22 Folder Viewer Task Flow

[image: Folder Viewer Task Flow]



In the Folder Viewer task flow, you can:

	
Click a folder to display the contents of that folder, and drill down further into subfolders.


	
Click a file to display a preview of the file contents in the Document Viewer preview pane, with file management options, including editing for some file types. If the file type does not support a preview (for example, .mp3 music files, video files, or .zip files), the preview pane displays the file properties. See Section 41.1.7, "Understanding the Document Viewer Task Flow."


	
Click in a row (not on the folder or file name) in the right pane to perform menu actions on the folder or file in that row (see Section 41.5.1, "Menus and Actions in the Documents Service Task Flows").

Alternatively, right-click a folder or file to display a context menu of available actions (see Section 41.5.1.6, "Folder Context Menu" and Section 41.5.1.7, "File Context Menu").


	
Drag and drop folders and files in the task flow hierarchy to reorganize the file or folder structure.




To add a Folder Viewer task flow to a page, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." In the default Resource Catalog, open Content Management, then click Add next to Folder Viewer to display the default listing of folders and files in the root folder of the active content repository connection.



41.1.5.1 Changing the Folder Viewer Task Flow Default Listing

You can change the default listing displayed in a Folder Viewer task flow in either of the following ways:

	
Selecting a Specific Folder in the Resource Catalog


	
Modifying Properties





Selecting a Specific Folder in the Resource Catalog

To change the default listing displayed in a Folder Viewer task flow by selecting a specific folder to display:

	
Drill down to a target folder in the Resource Catalog, then click the corresponding Add link, and choose Folder Viewer (Figure 41-23). For more information, see Section 41.3, "Adding a Selected Folder or File to a Page."


Figure 41-23 Add Menu for Folder

[image: Add Menu for Folder]






Modifying Properties

To change the default listing displayed in a Folder Viewer task flow by modifying the task flow properties:

	
Edit the page, and click the properties Edit icon (wrench) in the task flow chrome (Figure 41-24) to open the Component Properties dialog.


Figure 41-24 Edit Icon in Task Flow Chrome

[image: Edit Icon in Task Flow Chrome]



	
To change the target folder, set the Connection Name and Start Folder Path properties on the Parameters tab (see Table 42-5, "Folder Viewer Task Flow Parameters").











41.1.6 Understanding the Recent Documents Task Flow

The Recent Documents task flow displays a listing of the files most recently created or modified by the current user (Figure 41-25), .


Figure 41-25 Recent Documents Task Flow

[image: Recent Documents task flow]



In the Recent Documents task flow, you can:

	
Click a file to display a preview of the file contents in a separate Document Viewer preview window, with file management options, including editing for some file types. If the file type does not support a preview (for example, .mp3 music files, video files, or .zip files), the preview window displays the file properties. See Section 41.1.7, "Understanding the Document Viewer Task Flow."




To add a Recent Documents task flow to a page, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." In the default Resource Catalog, open Content Management, then click Add next to Recent Documents to display the most recently created or modified files in the current space.

The default property settings add a listing of the most recently created or modified files in the entire root folder of the active content repository connection to the page. See Section 42.7, "Setting Recent Documents Task Flow Properties" to modify the property settings for the Recent Documents task flow.






41.1.7 Understanding the Document Viewer Task Flow

The Document Viewer task flow can display:

	
Folder properties and settings. To show folder information in a Document Viewer task flow, you can set the task flow's Item ID property to the ID of the target folder. See Section 42.8, "Setting Document Viewer Task Flow Properties."


	
For files that do not support a preview (for example, .mp3 music files, video files, or .zip files), the file's properties (Figure 41-26).


Figure 41-26 Document Viewer: File Properties in Preview Pane

[image: Document Viewer: File Properties in Preview Pane]



	
For file types that support a preview, a preview of the file's content. Under the preview, the Document Viewer includes the following tabbed panes:

	
Comments: Enter or delete comments for a file to provide additional information that you want to convey to other users about the file. See Section 41.19, "Viewing, Entering, and Deleting Comments on a File."


	
Tags: Specifies keywords related to the content of the file. Tags are useful for making a file more widely discoverable in search results. See Section 41.20, "Working with Tags."


	
History: Provides version information about the current file, and allows you to selectively delete versions. For more information, see Section 41.21, "Viewing and Deleting File Version History."


	
Info: Provides the option to edit some properties such a file name and description. In the Advanced section, displays metadata property settings for the file. See Section 41.22, "Viewing and Modifying Folder and File Properties."


	
Links: Provides a way to view, access, and associate related information by linking a file to a discussion, document, event, note, or URL. For example, you can create a link to associate a project plan document with a list of project issues. See Section 41.23, "Working with Links."


	
Recommendations: Provides suggestions of other documents you might want to view, based on the current document. This list uses the Similar Items task flow of the Activity Graph service, which must be configured to display this pane. See Section 41.24, "Working with Recommendations."







For file types that support content preview, the Document Viewer task flow includes selections unique to the file type:

	
A preview of a Microsoft Office document includes an Edit with Application action to open the file in-place in its Microsoft Office application (Figure 41-27).


	
A preview of an image includes only the selections available to all file types: File menu, View menu, Upload New Version action, and Download action (Figure 41-28).


	
A preview of an HTML file or a wiki document includes an Edit action to open the HTML file or wiki document in the Rich Text Editor (RTE), as well as a New Wiki Document action (Figure 41-29).


	
A preview of an Oracle Site Studio file includes a Select Template menu for choosing a Site Studio region display template or a custom Content Presenter display template to preview how the Site Studio file will look in the selected template (Figure 41-30).







	
Note:

The Document Viewer task flow is intended to provide only a preview of Site Studio content based on a selected template. To publish the content on a page, use the Content Presenter task flow. See Chapter 40, "Publishing Content Using Content Presenter."








Figure 41-27 Document Viewer Task Flow for Microsoft Office Word Document

[image: Document Viewer Pane for Word Document]




Figure 41-28 Document Viewer Task Flow for Image File
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Figure 41-29 Document Viewer Task Flow for Wiki Document

[image: Document Viewer Task Flow for Wiki Document]




Figure 41-30 Document Viewer Task Flow for Site Studio File
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To add a Document Viewer task flow to a page, refer to Section 41.3, "Adding a Selected Folder or File to a Page." In the default Resource Catalog, open Content Management, navigate to the folder or file that you want to add to the page, then click the Add link next to the folder or file, and choose Document Viewer.

For information about setting properties on the Document Viewer task flow, see Section 42.8, "Setting Document Viewer Task Flow Properties."






41.1.8 Understanding the Document Mini Properties Task Flow

The Document Mini Properties task flow can display:

	
Folder properties and settings. To show folder information in a Document Mini Properties task flow, you can set the task flow's Resource ID property to the ID of the target folder. See Section 42.9, "Setting Document Mini Properties Task Flow Properties."


	
The Basic properties of an individual file in a read-only view (Figure 41-31). This choice is available for all file types.


Figure 41-31 Mini Properties Task Flow for File

[image: Mini Properties Pane for File]





To add a Document Mini Properties task flow to a page, refer to Section 41.3, "Adding a Selected Folder or File to a Page." In the default Resource Catalog, open Content Management, navigate to the folder or file that you want to add to the page, then click the Add link next to the folder or file, and choose Mini Properties.

For information about setting properties on the Mini Properties task flow, see Section 42.9, "Setting Document Mini Properties Task Flow Properties."






41.1.9 Understanding the Document Properties Task Flow

The Document Properties task flow can display:

	
Folder properties and settings. To show folder information in a Document Properties task flow, you can set the task flow's Item ID property to the ID of the target folder. See Section 42.10, "Setting Document Properties Task Flow Properties."


	
Both Basic and Advanced properties of an individual file, along with an Edit button to allow you to modify property values (Figure 41-32). This choice is available for all file types. See Section 41.22, "Viewing and Modifying Folder and File Properties."


Figure 41-32 Document Properties Task Flow for File
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To add a Document Properties task flow to a page, refer to Section 41.3, "Adding a Selected Folder or File to a Page." In the default Resource Catalog, open Content Management, navigate to the folder or file that you want to add to the page, then click the Add link next to the folder or file, and choose Document Properties.

For information about setting properties on the Document Properties task flow, see Section 42.10, "Setting Document Properties Task Flow Properties."






41.1.10 Understanding the Document Version History Task Flow

The Document Version History task flow displays a list of versions of an individual file, allowing for deletion of a selected version (Figure 41-33). This choice is available for all file types. See Section 41.21, "Viewing and Deleting File Version History."


Figure 41-33 Version History Task Flow for File

[image: Version History Pane for File]



To add a Document Version History task flow to a page, refer to Section 41.3, "Adding a Selected Folder or File to a Page." In the default Resource Catalog, open Content Management, navigate to the file that you want to add to the page, then click the Add link next to the file, and choose Version History.

For information about setting properties on the Document Version History task flow, see Section 42.11, "Setting Document Version History Task Flow Properties."








41.2 What You Should Know About Document Components

The Documents service provides features for adding document components to a page in a Spaces application. As described in Section 41.3, "Adding a Selected Folder or File to a Page", you use the Resource Catalog to add a document component to a page as a container for a selected folder or file (Figure 41-34).


Figure 41-34 Add Menu for HTML File in Resource Catalog

[image: Add Menu for HTML File]



Document components enable you to display an individual file on a page in a variety of ways, depending on the file type:

	
A Link displays the name of a selected file as a link, which end users can click to display the file content in its native application (Figure 41-35).


Figure 41-35 Link Component (for Microsoft Word file)

[image: Link Component (for Microsoft Word file)]



	
An Inline Frame displays the content of a selected file as a preview (Figure 41-36).


Figure 41-36 Inline Frame Component (for HTML file)

[image: Inline Frame Component (for HTML file)]



	
An Image displays a selected file as an image (Figure 41-37).


Figure 41-37 Image Component (for JPEG file)

[image: Image Componet (for JPEG file)]





Table 41-3 shows the content types that support each of these document components.


Table 41-3 Components for Folders and FIles

	Content Type	Document Components
	
Folder

	
Link


	
Documents of various types (XML, PDF, JAVA, TXT, DOC, XLS, HTM)

	
Link


	
Documents that can be rendered in a browser (HTML, flash, PDF and image)

	
Inline frame


	
Images (PNG, JPG, GIF)

	
Link

Inline frame

Image








To display a folder or file using one of these document components, see Section 41.3, "Adding a Selected Folder or File to a Page."






41.3 Adding a Selected Folder or File to a Page

If you want to add a Documents service task flow standalone to a page, independent of content, refer to Section 41.4, "Adding a Documents Service Task Flow to a Page." This section describes how to display an individual folder or file from a connected content repository on a page, by choosing the required container for the selected folder or file in the Resource Catalog, as shown inFigure 41-38 and Figure 41-39.




	
Note:

When you add a folder or file from Content Server to a page in a Spaces application, it can be viewed and managed from within Spaces. However, any folder shortcuts created in Content Server cannot be viewed and managed from within Spaces.








Figure 41-38 Add Menu for Folder in Resource Catalog

[image: Add Menu for Folder]




Figure 41-39 Add Menu for Image File in Resource Catalog

[image: Clicking Add Link Next to Image File]



Table 41-4 lists all containers available for for displaying folders and files on a portal page.


Table 41-4 Adding Individual Folders and Files to a Page

	For Folders	For Individual Files
	
	
Content Presenter task flow


	
Document Explorer task flow


	
Document List Viewer task flow


	
Document Manager task flow


	
Document Navigator task flow


	
Folder Viewer task flow


	
Document Viewer task flowFoot 1 


	
Document Mini Properties task flow1


	
Document Properties task flow1




	
	
Content Presenter task flow


	
Document Viewer task flow


	
Document Mini Properties task flow


	
Document Properties task flow


	
Document Version History task flow


	
Link component


	
Inline Frame component


	
Image component











Footnote 1 To show folder information in a Document Viewer, Document Mini Properties, or Document Properties task flow, you can set the task flow's resource ID parameter to the ID of the target folder. See Chapter 42, "Setting Documents Service Task Flow and Document Component Properties."

For more information about any of the containers listed inTable 41-4, see Section 41.1, "What You Should Know About the Documents Service Task Flows" and Section 41.2, "What You Should Know About Document Components."




	
Note:

Another way of adding folders and files to a page is through a custom navigation model added to a page. Spaces application designers can build custom navigation models, which can be added to the page templates for a space to allow end users to navigate the documents in the space. For more information, see Section 11.2.2.1.1, "Adding a Document to a Navigation Model."










	
Note:

When an item that is stored in a content repository is added to a page, the Spaces application instructs the browser to check whether the content is up-to-date before a cached copy, if available, displays in the browser. The default content validation process supports collaboration use cases that require real-time content exchange.
For static content or content that does not change frequently, content validation checks incur an unnecessary performance overhead. For static content, Oracle recommends the following:

	
Content Server: use Content Presenter to display static content stored in Content Server. Content Presenter shows the latest released version of content; and provides controls to preview unreleased content that is in workflow.


	
Other content repositories, such as SharePoint: ask your administrator to override the default content cache setting by editing the Web Tier mod_wl_ohs configuration file (mod_wl_ohs.conf). This is fully explained in "Setting the Cache-Control Response Header" in the white paper "Integrating the SharePoint 2007 Adapter with Spaces" available from Oracle Technology Network at http://www.oracle.com/technetwork/middleware/webcenter/overview/index.html.












To add a selected folder or file to a page in a Spaces application:

	
Go to the page where you want to add a folder or file, and open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to the folders and files in the connected content repository.




	
Tip:

The presence or location of this section depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, next to Content Management, click Open to expose the content selections (Figure 41-40).








Figure 41-40 Opening the Content Management Section in the Resource Catalog

[image: Content Management Section in the Resource Catalog]



	
The next link you click depends on your current location in the application. If you are using the default Resource Catalog (Figure 41-41):

	
Click All Content to display all folders and files to which you have access.


	
In a space, click Space Documents, which provides a shortcut to a list of all of the folders and files to which you have access in the current space. This selection is shown only if the Documents service is enabled in the space (see Section 51.10, "Managing Space Services").


	
In the Home space, click Personal Documents, which provides a shortcut to a list of all the folders and files to which you have access in the Home space.





Figure 41-41 Content Selections in a Space

[image: Content under the Documents Folder in a Home Space]



	
Continue to drill down into folders until you arrive at the folder or file that you want to add to the page, then click the Add link next to the folder or file to display a menu of available containers for the folder or file, applicable to the file type (Figure 41-42, Figure 41-43, Figure 41-44, and Figure 41-45).




	
Note:

When you drill down to the folders and files in the connected content repository, you are drilling into the live connection with the content repository. The documents you see listed are not static resources, but reflect the latest status of folders and files in the content repository associated with your Spaces application.








Figure 41-42 Add Menu for Folder in Resource Catalog
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Figure 41-43 Add Menu for Microsoft Word File in Resource Catalog

[image: Add Menu for Microsoft Word File]




Figure 41-44 Add Menu for HTML File in Resource Catalog

[image: Add Menu for HTML File]




Figure 41-45 Add Menu for Image File in Resource Catalog

[image: Clicking Add Link Next to Image File]



	
Choose the content task flow or document component that you wish to use. The menu displays only those containers that support the selected folder or file.




	
Note:

The Content Presenter task flow is available only when the connected content repository is Content Server. When you select the Content Presenter task flow, the folder or file displays in a default display template for its type. For more information, see Chapter 40, "Publishing Content Using Content Presenter."








	
Click Save, then Close.









41.4 Adding a Documents Service Task Flow to a Page

See Section 41.1, "What You Should Know About the Documents Service Task Flows" to help you select the task flow most appropriate for your needs.

If you want to add and manage a specific folder or file in a Documents service task flow, refer to Section 41.3, "Adding a Selected Folder or File to a Page." This section describes how to select and add a Documents service task flow independent of a specific folder or file. The task flow is autopopulated with the folders and files in the connected content repository.

To add a Documents service task flow to a page in a Spaces application:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to the folders and files in the connected content repository.




	
Tip:

The presence or location of this section depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, next to Content Management, click Open to expose the content selections (Figure 41-46).








Figure 41-46 Opening the Content Management Section in the Resource Catalog

[image: Content Management Section in the Resource Catalog]

Description of "Figure 41-46 Opening the Content Management Section in the Resource Catalog"





For information about the selections shown in the default Resource Catalog, see Section 39.2, "What You Should Know About Content Management Selections in the Resource Catalog."


	
Click Add next to the task flow that you want to add to your page (Figure 41-47).


Figure 41-47 Adding a Content Task Flow

[image: Adding a Content Task Flow]






	
Note:

The Document Manager and Document Navigator task flows are not shown under Content Management in the default Composer Resource Catalog provided out-of-the-box with Spaces, so you will only see entries for these task flows if they have been added to a custom Resource Catalog that has been made available to the page. However, if you navigate to a specific folder in the default Resource Catalog, these task flows are selectable from the Add menu for the folder (see Section 41.3, "Adding a Selected Folder or File to a Page").
For information about creating a custom Resource Catalog, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Documents for a list of all available content task flows).












In a space, if the Documents service is enabled (see Section 51.10, "Managing Space Services"), the selected task flow will by default display folders and files based on the primary content repository connection, or you can display only documents belonging to the space. If the Documents service is not enabled in a space, folders and files will not display in the task flow unless you edit the default task flow properties to specify a content repository (see Chapter 42, "Setting Documents Service Task Flow and Document Component Properties").

Use the menus and actions available in the Documents service task flow you have added to work with folders and files in the connected content repository, as described in Section 41.5, "Understanding the Documents Service Task Flow Menus and Actions."






41.5 Understanding the Documents Service Task Flow Menus and Actions

The Documents service task flows that offer content management functionality are Document Explorer, Folder Viewer, and Document Manager. For these task flows, Table 41-5 summarizes the menus and actions for working with the folders and files. More detail is provided in the following sections:

	
Section 41.5.1, "Menus and Actions in the Documents Service Task Flows"


	
Section 41.5.2, "Menus and Actions in the Document Viewer Preview Pane or Window"





Table 41-5 Documents Service Task Flow Menus and Actions for Folders and Files

	Menu	Actions	In Document Explorer, Folder Viewer, and Document Manager, applicable to:
	
File Menu


	
EditFoot 1 

	
file


	
Upload New VersionFoot 2 

	
file


	
Check Out2

	
file


	
Cancel Check Out2

	
file


	
New Folder

	
folder


	
Rename

	
folder or file


	
Cut

	
folder or file


	
Copy

	
folder or file


	
Paste

	
folder or file


	
Delete

	
folder or file


	
Share

	
file


	
SecurityFoot 3 

	
folder or file


	
View Menu


	
Details

	
folder or file


	
Get a Link

	
folder or file


	
Containing Folder Info

	
folder or file


	
Refresh Content

	
folder or file


	
Hide Folders

	
folder or file


	
Columns submenu

	
folder or file


	
Reorder Columns

	
folder or file


	
	
New Wiki Document Action


	
file


	
	
Upload Action


	
file


	
	
Download Action


	
file


	
Document Viewer Preview Pane

Click a folder to display the contents of that folder.

Click a file to display a preview of file contents, with management options shown below. This allows for file previewing and editing for some file types. If the file type does not support a preview (for example, .mp3 music files, video files, or .zip files), the Document Viewer preview pane displays details about the file. See Section 41.1.7, "Understanding the Document Viewer Task Flow."


	
File Menu in Document Viewer


	
Send Mail

	
folder or file


	
Subscribe

	
file


	
Share

	
file


	
Add To Favorites

	
folder or file


	
Check Out2

	
file


	
Worklow Settings Foot 4 

	
folder


	
Security3

	
folder or file


	
View Menu in Document Viewer


	
Open in BrowserFoot 5 

	
file


	
Open as PDFFoot 6 

	
file


	
Download PDFFoot 7 

	
file


	
Comments

	
file


	
Version History

	
file


	
Properties

	
file


	
Get a Link

	
folder or file


	
Refresh Content

	
folder or file


	
	
Edit ActionFoot 8 

	
file


	
	
Upload New Version Action2

	
file


	
	
Download Action


	
file








Footnote 1 Folder/file listing pane: In-place editing available for wiki documents, blog posts, HTML, and Microsoft Office (Word, Excel, PowerPoint) files only. Wiki documents and HTML files open in RTE; Office files open in their corresponding application.

Footnote 2 Check Out, Cancel Check Out, and Upload New Version not available for wiki documents.

Footnote 3 Security available only if the Spaces administrator has configured item-level security between Content Server and Spaces.

Footnote 4 Workflow Settings available only when content repository is Content Server and the Spaces administrator has completed the prerequisite configuration

Footnote 5 Open in Browser available for image, text, and HTML files only.

Footnote 6 Open as PDF available for any file type for which Content Server is configured to convert to PDF.

Footnote 7 Download PDF available any file type for which Content Server is configured to convert to PDF.

Footnote 8 Edit or Edit with Application action available for wiki documents, blog posts, HTML, and Microsoft Office (Word, Excel, PowerPoint) files only.



41.5.1 Menus and Actions in the Documents Service Task Flows

The following sections describe the purpose of the menus and actions listed in Table 41-5 when viewing a listing of folders and/or files in a Documents service task flow:

	
Section 41.5.1.1, "File Menu"


	
Section 41.5.1.2, "View Menu"


	
Section 41.5.1.3, "New Wiki Document Action"


	
Section 41.5.1.4, "Upload Action"


	
Section 41.5.1.5, "Download Action"


	
Section 41.5.1.6, "Folder Context Menu"


	
Section 41.5.1.7, "File Context Menu"






41.5.1.1 File Menu

The File menu is available in the Document Manager, Document Explorer, and Folder Viewer task flows for folders and files. The actions available on the File menu (Figure 41-48) are:


Figure 41-48 File Menu
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Edit or Edit with Application: Active for wiki documents, HTML, and Microsoft Office (Word, Excel, and PowerPoint) files only. For a selected file, opens the file in-place in the application that corresponds to the file type and automatically checks the file out. See Section 41.12.3, "Editing Files In-Place."


	
Upload New Version: Inactive for folders and wiki documents. If you have write permissions on a selected file, opens the Upload Document pane where you can specify a new version of the file to upload to replace the existing file. See Section 41.12.4, "Uploading a New Version of an Existing File."


	
Check Out: Inactive for folders and wiki documents. For a selected file, checks the file out, locking it for update by other users. See Section 41.12.1, "Checking a File Out."


	
Cancel Check Out: Inactive for folders and wiki documents. For a selected file, cancels the checked out status without updating it, unlocking it to allowing other users to update it. See Section 41.12.1, "Checking a File Out."


	
New Folder: Opens the Create Folder dialog where you can specify a name for a new folder. The location of the new folder is dependent on the Documents service task flow used, and the current selection. See Section 41.7, "Creating a Folder."


	
Rename: Opens the Rename dialog where you can rename the selected folder or file. See Section 41.13, "Renaming a Folder or File."


	
Cut: Stores the path to the selected folder(s) or file(s) to paste elsewhere. If a folder or file is not subsequently pasted, it is restored to the location where it was cut. If a folder or file is deleted at the source location before pasting, it will not be moved to the paste location. See Section 41.15, "Moving Folders and Files."


	
Copy: Stores the path to the selected folder or file to paste as a copy elsewhere. If a folder or file is deleted at the source location before pasting, it will not be copied to the paste location. See Section 41.14, "Copying and Pasting Folders and Files."


	
Paste: Pastes the folder or file in the buffer to the current folder. See Section 41.14, "Copying and Pasting Folders and Files."


	
Delete: Deletes the selected folder or file. See Section 41.16, "Deleting Folders and Files."


	
Share: Opens a dialog where you specify the users, groups, or select a space where the URL for the selected file will be published in Activity Streams, along with a message. See Section 41.26.3, "Publishing the URL for a File to Activity Streams."


	
Security: Available only if the Spaces administrator has configured item-level security between Content Server and Spaces. Opens the Security Settings dialog, where you can set custom access permissions for the selected file, or select to inherit the permissions of the parent folder. For more information, see Section 41.27, "Setting Security Options on a Folder or File."









41.5.1.2 View Menu

The View menu is available in the Document Manager, Document Explorer, and Folder Viewer task flows, as well as theDocument List Viewer task flow, for folders and files. The actions available on the View menu (Figure 41-49) are:


Figure 41-49 View Menu
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Details: For a folder, opens a Properties pane (see Section 41.22, "Viewing and Modifying Folder and File Properties"). For a file, opens a preview of an individual file's content or properties. Previewing the content of a file is available for all file types that support a preview. For files that do not support a preview, such as audio or video files, the preview displays the file properties. Under the preview, the Document Viewer includes the following tabbed panes

	
Comments: Enter or delete comments for a file to provide additional information that you want to convey to other users about the file. See Section 41.19, "Viewing, Entering, and Deleting Comments on a File."


	
Tags: Specifies keywords related to the content of the file. Tags are useful for making a file more widely discoverable in search results. See Section 41.20, "Working with Tags."


	
History: Provides version information about the current file, and allows you to selectively delete versions. For more information, see Section 41.21, "Viewing and Deleting File Version History."


	
Info: Provides the option to edit some properties such a file name and description. In the Advanced section, displays metadata property settings for the file. See Section 41.22, "Viewing and Modifying Folder and File Properties."


	
Links: Provides a way to view, access, and associate related information by linking a file to a discussion, document, event, note, or URL. For example, you can create a link to associate a project plan document with a list of project issues. See Section 41.23, "Working with Links."


	
Recommendations: Provides suggestions of other documents you might want to view, based on the current document. This list uses the Similar Items task flow of the Activity Graph service, which must be configured to display this pane. See Section 41.24, "Working with Recommendations."





	
Get a Link: Opens the Get a Link dialog, where Direct URL provides a direct link to open the folder or file in Spaces or a WebCenter Portal: Framework application. For files, the Download URL provides a direct link to allow users to open the file in its default application, or choose to save the file to their local file system. See Section 41.26, "Sharing the URL for a Folder or File."


	
Containing Folder Info: Opens the Properties pane of the parent folder of the current folder or file. See Section 41.22, "Viewing and Modifying Folder and File Properties."


	
Refresh Content: Retrieves the contents of the current folder from the content repository to reflect all changes since the last retrieval. See Section 41.17, "Refreshing Folder Contents."


	
Hide Folders: Refreshes the listing to show only files in the current folder, or show folders if this action is currently active. See Section 41.18, "Hiding and Showing Folders."


	
Columns: Provides a submenu to select the columns that you want to display in the task flow. See Section 41.6.1, "Hiding and Showing Columns."


	
Reorder Columns: Opens the Reorder Columns dialog where you can organize the displayed columns into a different order. See Section 41.6.2, "Reordering Columns."









41.5.1.3 New Wiki Document Action

The New Wiki Document action is available in the Document Manager, Document Explorer, Document Viewer, and Folder Viewer task flows (Figure 41-50).


Figure 41-50 New Wiki Document Action

[image: New Wiki Document Action]



You can click this action to open the Rich Text Editor where you can define a new wiki document, created at the same level as the currently selected file, or in the current folder. See Section 41.8.2, "Creating a Wiki Document."






41.5.1.4 Upload Action

The Upload action is available in the Document Manager, Document Explorer, and Folder Viewer task flows (Figure 41-51).


Figure 41-51 Upload Action

[image: Upload Action]



You can click this action to upload files from your local file system or a network drive. See Section 41.8.1, "Uploading Files."






41.5.1.5 Download Action

The Download action is available in the Document Manager, Document Explorer, and Folder Viewer task flows (Figure 41-52).


Figure 41-52 Download Action

[image: Download Action]



You can click this action to save files to your local file system. See Section 41.12.2, "Downloading a File."






41.5.1.6 Folder Context Menu

You can right-click a folder on the Documents page or in a Documents service task flow to display a context menu that provides a shortcut to many menu actions (Figure 41-53).


Figure 41-53 Folder Context Menu in Documents Service Task Flows

[image: Folder Context Menu in Documents Task Flows]



	
Open: Opens a folder to display its contents and make it the top-level folder. See Section 41.9, "Opening a Folder."


	
Details: Opens a Properties pane. See Section 41.22, "Viewing and Modifying Folder and File Properties."


	
Get a Link: Opens the Get a Link dialog, where Direct URL provides a direct link to open the folder in Spaces, and the Download URL provides a direct link to allow users to open the folder in its default application, or choose to save the file to their local file system. See Section 41.26, "Sharing the URL for a Folder or File."


	
Rename: Opens the Rename dialog where you can rename the selected folder. See Section 41.13, "Renaming a Folder or File."


	
Copy: Stores the path to the selected folder to paste as a copy elsewhere. If a folder is deleted at the source location before pasting, it will not be copied to the paste location. See Section 41.14, "Copying and Pasting Folders and Files."


	
Cut: Stores the path to the selected folder(s) to paste elsewhere. If a folder is not subsequently pasted, it is restored to the location where it was cut. If a folder or file is deleted at the source location before pasting, it will not be moved to the paste location. See Section 41.15, "Moving Folders and Files."


	
Delete: Deletes the selected folder. See Section 41.16, "Deleting Folders and Files."


	
Security: Available only if the Spaces administrator has configured item-level security between Content Server and Spaces. Opens the Security Settings dialog, where you can set custom access permissions for the selected folder, or select to inherit the permissions of the parent folder. For more information, see Section 41.27, "Setting Security Options on a Folder or File."









41.5.1.7 File Context Menu

You can right-click a file on the Documents page or in a Documents service task flow to display a context menu that provides a shortcut to many menu actions (Figure 41-54):


Figure 41-54 File Context Menu in Documents Service Task Flows

[image: File Context Menu in Documents Task Flows]



	
Download: Available in the Document Manager, Document Explorer, and Folder Viewer task flows for saving files to the local file system. See Section 41.12.2, "Downloading a File."


	
Edit or Edit with Application: Active for wiki documents, HTML, and Microsoft Office (Word, Excel, and PowerPoint) files only. For a selected file, opens the file in-place in the application that corresponds to the file type and automatically checks the file out. See Section 41.12.3, "Editing Files In-Place."


	
Upload New Version: Inactive for folders and wiki documents. If you have write permissions on a selected file, opens the Upload Document pane where you can specify a new version of the file to upload to replace the existing file. See Section 41.12.4, "Uploading a New Version of an Existing File."


	
Check Out/Cancel Check Out: Inactive for folders and wiki documents. For a selected file, checks the file out, locking it for update by other users; or, cancels the checked out status without updating it, unlocking it to allowing other users to update it. See Section 41.12.1, "Checking a File Out."


	
Details: For a file, opens the Properties pane, with the option to edit some properties such a file name and description. In the Advanced section of the Properties pane, displays tabs for Comments, Tags, History, Links, and (if configured), Recommendations.


	
Get a Link: Opens the Get a Link dialog, where Direct URL provides a direct link to open the file in Spaces, and the Download URL provides a direct link to allow users to open the file in its default application, or choose to save the file to their local file system. See Section 41.26, "Sharing the URL for a Folder or File."


	
Rename: Opens the Rename dialog where you can rename the selected file. See Section 41.13, "Renaming a Folder or File."


	
Copy: Stores the path to the selected file to paste as a copy elsewhere. If a file is deleted at the source location before pasting, it will not be copied to the paste location. See Section 41.14, "Copying and Pasting Folders and Files."


	
Cut: Stores the path to the selected file(s) to paste elsewhere. If a folder or file is not subsequently pasted, it is restored to the location where it was cut. If a file is deleted at the source location before pasting, it will not be moved to the paste location. See Section 41.15, "Moving Folders and Files."


	
Delete: Deletes the selected file. See Section 41.16, "Deleting Folders and Files."


	
Share: Opens a dialog where you specify the users, groups, or select a space where the URL for the selected file will be published in Activity Streams, along with a message. See Section 41.26.3, "Publishing the URL for a File to Activity Streams."


	
Security: Available only if the Spaces administrator has configured item-level security between Content Server and Spaces. Opens the Security Settings dialog, where you can set custom access permissions for the selected file, or select to inherit the permissions of the parent folder. For more information, see Section 41.27, "Setting Security Options on a Folder or File."











41.5.2 Menus and Actions in the Document Viewer Preview Pane or Window

Table 41-5 shows which menus and actions are available when previewing a document. The following sections describe the purpose of each available action in the Document Viewer preview pane or window:

	
Section 41.5.2.1, "File Menu in Document Viewer"


	
Section 41.5.2.2, "View Menu in Document Viewer"


	
Section 41.5.2.3, "Edit Action"


	
Section 41.5.2.4, "Upload New Version Action"


	
Section 41.5.2.5, "Download Action"






41.5.2.1 File Menu in Document Viewer

In the Document Viewer preview pane or window, you can select actions from the File menu for a folder (Figure 41-55) or a file (Figure 41-56).


Figure 41-55 Document Viewer: File Menu for a Folder

[image: Document Viewer: File Menu for a Folder]




Figure 41-56 Document Viewer: File Menu for a File

[image: Document Viewer: File Menu for a File]



The File menu includes the following actions:

	
Send Mail: Opens your mail application with the body of the mail message showing the direct URL to the currently open folder or file, as well as the URL to the current space, if applicable. See Section 41.26.2, "Mailing the URL for a Folder or File."


	
Subscribe: Activates monitoring of the activities on a file. Whenever any change is made to the file, you will be notified in your personal Activity Stream in the Home space. See Section 41.28, "Subscribing to a File."


	
Share: Opens a dialog where you specify the users, groups, or select a space where the URL for the selected file will be published in Activity Streams, along with a message. See Section 41.26.3, "Publishing the URL for a File to Activity Streams."


	
Add To Favorites: Adds the selected folder or file to your Spaces Favorites list. See Section 41.30, "Adding a Folder or File to Your Favorites."


	
Check Out: Inactive for wiki documents. Checks the current file out, locking it from update by other users. See Section 41.12.1, "Checking a File Out."


	
Workflow Settings: Available only when the connected content repository is Content Server and the Spaces administrator has completed the prerequisite configuration. Opens the Workflow Settings dialog, where you can assign workflow to the selected folder in a space. For more information, see Section 43.2, "Assigning a Workflow to a Folder in a Space."


	
Security: Available only if the Spaces administrator has configured item-level security between Content Server and Spaces. Opens the Security Settings dialog, where you can set custom access permissions for the selected folder or file, or select to inherit the permissions of the parent folder. For more information, see Section 41.27, "Setting Security Options on a Folder or File."


	
Annotate with AutoVue: Available only when Oracle AutoVue is installed and the Spaces administrator has configured Oracle AutoVue functionality. Opens the selected file in the AutoVue file viewer on Content Server, where you can provide comments and individualized mark-up. For more information, see Section 45.3, "Collaborating on Documents Using Oracle AutoVue."









41.5.2.2 View Menu in Document Viewer

In the Document Viewer preview pane or window, you can select actions from the View menu for a folder (Figure 41-57) or a file (Figure 41-58).


Figure 41-57 Document Viewer: View Menu for a Folder

[image: Document Viewer: View Menu for a Folder]




Figure 41-58 Document Viewer: View Menu for a File

[image: Document Viewer: View Menu]



The View menu includes the following actions:

	
Open in Browser: Active for images, text, wiki documents, and HTML files only. Opens the current file in your default browser application. See Section 41.10, "Opening a File."


	
Open as PDF: Active for any file type for which Content Server is configured to convert to PDF. Opens the current file in the Document Viewer preview pane in PDF. See Section 41.10, "Opening a File" and Section 41.25, "Opening or Saving PDF Files."


	
Download PDF: Active for any file type for which Content Server is configured to convert to PDF. Opens a browser dialog where you can choose to open the file with Adobe Acrobat Reader, or save it to your local file system as a PDF file. See Section 41.12.2, "Downloading a File" and Section 41.25, "Opening or Saving PDF Files."


	
Comments: Opens the Comments pane for the current file in the tabbed pane area at the bottom of the Document Previewer, providing a text input area where you can enter a comment for the file. See Section 41.19, "Viewing, Entering, and Deleting Comments on a File."


	
Version History: Opens the History pane for the currently selected file in the tabbed pane area at the bottom of the Document Previewer, showing the existing versions of the file, where you can delete selected versions. See Section 41.21, "Viewing and Deleting File Version History."


	
Info: Opens the Info pane for the currently selected file in the tabbed pane area at the bottom of the Document Previewer, where you can view and edit Basic and Advanced properties. See Section 41.22, "Viewing and Modifying Folder and File Properties."


	
Get a Link: Opens the Get a Link dialog for the current folder or file, where Direct URL provides a direct link to open the folder or file in Spaces, and the Download URL provides a direct link to allow users to open the folder or file in its default application, or choose to save the file to their local file system. See Section 41.26, "Sharing the URL for a Folder or File."


	
Refresh Content: Retrieves the current folder or file from the content repository to reflect all changes since the last retrieval.









41.5.2.3 Edit Action

The Edit or Edit with Application action is active for wiki documents, HTML, and Microsoft Office 2003 or higher files (Word, Excel, and PowerPoint) only, as shown in Figure 41-59 for a wiki document and Figure 41-60 for a Miscrosoft Word file.


Figure 41-59 Edit Action in Document Viewer for Wiki Document
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Figure 41-60 Edit Action in Document Viewer for Microsoft Word File

[image: Edit Action in Document Viewer]



Select this action to automatically check the current file out, and open it in-place in the Rich Text Editor (RTE) or its Microsoft application. See Section 41.12.3, "Editing Files In-Place."






41.5.2.4 Upload New Version Action

The Upload New Version action is active for all files except for wiki documents (Figure 41-61).


Figure 41-61 Upload New Version Action in Document Viewer

[image: Upload New Version Action in Document Viewer]



If you have write permissions on the current file, select this action to open the Upload Document screen where you can specify a new version of the file to upload. See Section 41.12.4, "Uploading a New Version of an Existing File."






41.5.2.5 Download Action

The Download action is active for all files (Figure 41-62).


Figure 41-62 Download Action in Document Viewer

[image: Download Action in Document Viewer]



Select this action to open a dialog to download the current file to your local file system. See Section 41.12.2, "Downloading a File."










41.6 Personalizing Your View

The Documents service supports personalizations that enable you to change your own view of a Documents service task flow by hiding or showing columns and by rearranging the list of documents according to the sort order of a particular column, as described in the following sections:

	
Section 41.6.1, "Hiding and Showing Columns"


	
Section 41.6.2, "Reordering Columns"


	
Section 41.6.3, "Sorting Files and Folders"






41.6.1 Hiding and Showing Columns

Hiding and showing one or more informational columns is useful for simplifying or expanding the details that are displayed with folders and files.

To hide or show informational columns in your unique view of a task flow:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click the View menu, and choose Columns (Figure 41-63).


Figure 41-63 View Menu in Document Explorer Task Flow

[image: Document Manager task flow View menu]



	
Select or clear individual columns to show or hide them, or select Show All to display all available columns.

If changes do not display immediately, click the View menu and choose Refresh Content.









41.6.2 Reordering Columns

Reordering the informational columns is useful for prioritizing the details that are displayed with folders and files, depending on the information in which you are most interested.

To reorder the informational columns in your unique view of a task flow:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click the View menu, and choose Reorder Columns.

The Reorder Columns dialog opens (Figure 41-64).


Figure 41-64 Reorder Columns Dialog

[image: Reorder Columns dialog box]



	
Select one or more columns, then click the reorder icons to rearrange the order of the columns in the task flow.









41.6.3 Sorting Files and Folders

Sorting columns enables you to quickly rearrange the order of the content in a Document Manager or Document List Viewer task flow. Each task flow column provides a one-click sorting feature that you can use to instantly rearrange all task flow content according to the ascending (1, 2, 3, A, B, C) or descending (C, B, A, 3, 2, 1) order of a particular column.

To sort folders and files in your unique view of a Documents service task flow:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, move your cursor over the header of the column you want to use to sort folders and files.


	
Click the Sort Ascending icon to sort the column in ascending order (1, 2, 3, A, B, C, or smallest to largest), or click the Sort Descending icon to sort the column in descending order (C, B, A, 3, 2, 1, or largest to smallest) (Figure 41-65).


Figure 41-65 Sort Ascending and Sort Descending Icons

[image: Sort Ascending and Descending icons]






	
Note:

The sorting icons display over the column that is the current sorting column. For other columns, the icons display when you hover your mouse pointer over the column name.

















41.7 Creating a Folder

With appropriate permissions, you can create a folder in any Documents service task flow that displays folders. In the Document Manager task flow, when the task flow is configured as a Tree Table layout (see Section 41.1.3, "Understanding the Document Manager Task Flow") and the currently selected item is a file, the new folder is created in the same folder as that file; if the currently selected item is a folder, the new folder is created within that folder. In the Document Explorer or Folder Viewer task flows, the new folder is always created at the same level as the current location.

If you create a subfolder in a parent folder that is assigned a worfklow (see Section 43.2, "Assigning a Workflow to a Folder in a Space"), the subfolder inherits the workflow assignment of the parent folder.




	
Note:

Other methods to create and copy folders when the backend content repository is Content Server are:
	
Create a network place to a space, then use Windows Explorer to create and copy folders, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Use the task pane available through Microsoft Office shared document management functionality to create a new folder in a space, as described in Section 46.3.4.2, "Adding a New Folder."












To create a folder:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, navigate to the folder under which to create the new folder.


	
From the File menu, choose New Folder.

The Create Folder dialog opens (Figure 41-66).


Figure 41-66 Create Folder Dialog
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In the Folder Name field, enter a name for the folder; for example, Local Events.


	
Click Create to create the folder and close the dialog.









41.8 Creating a File

You can create new files in the connected content repository using the Documents service task flows by either uploading a file, or creating a new wiki document, as described in the following sections:

	
Section 41.8.1, "Uploading Files"


	
Section 41.8.2, "Creating a Wiki Document"






41.8.1 Uploading Files

You can upload new files from your local file system or a mapped network drive to the connected content repository, or refresh existing files with new versions.

To upload a new version of a single existing file, see Section 41.12.4, "Uploading a New Version of an Existing File."




	
Note:

Spaces does not support uploading a new wiki document or a new version of a wiki document from the file system. If you upload an HTML file, you cannot convert it to a wiki document due to differences in underlying metadata. For information about wiki documents in Spaces, see Chapter 47, "Working with Wiki Documents."










	
Note:

Other methods to upload files when the backend content repository is Content Server are:
	
Create a Windows network place to a space, then use Windows Explorer to add files of any type, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Use the Microsoft Office shared document management functionality to save a local Microsoft Word, Excel, or PowerPoint file, or use the task pane to add files of any type to the Content Server repository, as described in Section 46.3.4.1, "Adding a File."


	
Use WebDAV, which is installed with Content Server out-of-the-box, to establish a connection to your Spaces application, then drag and drop content in your Content Server repository to the folder assigned to the target space, or drag and drop content between spaces. When dragging and dropping content to the target folder, do not drag the source folder to the target; drag and drop only the content that is stored under the folder. If you do not know the WebDAV URL for the Content Server that is used to store documents, contact your Fusion Middleware Administrator. If the base URL for that Content Server is http://host:port/relative_web_root, the WebDAV root URL will be http://host:port/relative_web_root/idcplg/webdav. For example: http://wchost:16200/dav/cs/idcplg/webdav/


	
Use the Batch Loader utility, as described in "Batchloading Content" in Oracle Fusion Middleware System Administrator's Guide for Oracle Content Server.












To upload files to the connected content repository:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, navigate to the folder for the documents you plan to upload or create a new folder (see Section 41.7, "Creating a Folder").


	
Click the Upload action (Figure 41-67).


Figure 41-67 Upload Action
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The Upload Document pane opens (Figure 41-68), providing an area where you can add the files to be uploaded.


Figure 41-68 Upload Document Pane (in FireFox browser)

[image: Upload Document pane]

Description of "Figure 41-68 Upload Document Pane (in FireFox browser)"





	
For the files you want to upload, either:

	
(In FireFox or Chrome browsers only) Select the file(s) in your local file system and drag them into the Upload Document pane.


	
Click Select Files to open the File Upload dialog, then navigate to and select the file(s) you want to upload.







	
Note:

By default, the maximum upload size for files is 2 MB for Spaces applications. System administrators can customize the maximum file upload size by editing the uploadedFileMaxDiskSpace parameter in the webcenter-config.xml file. For details, see "webcenter-config.xml" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.








	
If the original versions of the files are associated with a content type profile in Content Server, select from the Upload Profiles list:




	
Note:

To enable the Upload Profiles selection list, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the frontend to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.












	
Leave the default selection as <None> to upload files without an associated content profile.


	
Alternatively, select a content profile (defined in Content Server) for the file(s) you want to upload (Figure 41-69). Selecting a content profile enforces uniformity by requiring values for certain metadata fields that must be provided before the file(s) can be uploaded. For example, a press release profile might include fields about who to contact, release date, and so on.




	
Note:

For information about creating content profiles in Content Server, refer to "Managing Content Profiles" in Oracle Fusion Middleware Application Administrator's Guide for Content Server.








Figure 41-69 Selecting Content Type for Document(s)

[image: Selecting Content Type for Document(s)]



The Profile Upload pane displays the metadata fields for the selected content profile (Figure 41-70), where you can enter metadata field values to associate with the file(s) you want to upload, then click Check In.


Figure 41-70 Content Profile Metadata Fields

[image: Content Profile Properties]






	
Note:

Content Server may require certain mandatory metadata field values for a selected content profile to ensure a successful checkin. Mandatory fields are identified in the dialog by an asterisk and red text.
For information about content profile metadata field requirements for Content Server, refer to Oracle Fusion Middleware User's Guide for Oracle Content Server, specifically the chapter "Checking In Files". The fields described in the "Content Check-In Form" section in the appendix are mandatory for Content Server. All content profiles must include them, otherwise the checkin will fail.

In addition to the mandatory metadata field values required by Content Server for specific content profiles, every content profile must include additional metadata fields required by Spaces. For a list and descriptions of the required fields, which should be added to a content profile as hidden fields so that the end user cannot override the values populated by Spaces, see "What You Should Know About Creating Content Profiles in Content Server" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.













	
In the Upload Document pane, optionally, provide a description of the file(s) in the Description field. This description is assigned to all the files in the upload set.


	
If you are uploading new versions of files that already exist in the connected content repository, select Always create a new version (Figure 41-71) if you want to overwrite the existing files. Clear the checkbox if you want to be notified that a file with the same name already exists in the target folder in the content repository.


Figure 41-71 Always Create a New Version Checkbox

[image: Always Create a New Version Checkbox]



	
Click Upload.

	
If a file with the same name already exists in the target folder, and Always create a new version is selected, a new version of the file is added at same level as the currently selected file, or under the currently selected folder.


	
If a file with the same name already exists in the target folder, and Always create a new version is selected, but the file is checked out by another user, an Information dialog notifies you that the file cannot be uploaded and provides the name of the user who has it checked out (Figure 41-72).


Figure 41-72 Information Dialog: File Checked Out

[image: Information Dialog: File Checked Out]



	
If a file with the same name already exists in the target folder, and Always create a new version is not selected, the Resolve Name Conflict pane opens. Figure 41-73 shows the pane for files that are checked in, and Figure 41-74 shows the pane when a file is checked out by another user.


Figure 41-73 Resolve Name Conflict Pane: File Not Checked Out

[image: Resolve Name Conflict Pane: File Not Checked Out]




Figure 41-74 Resolve Name Conflict Pane: File Checked Out
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Select the desired action:

	
Ignore this file to cancel the upload operation for the current file. This is useful when uploading multiple files to skip only the current file, and continue to upload subsequent files in the batch.


	
Create a new version of the existing file to create a new version of the file. See Section 41.21, "Viewing and Deleting File Version History."

If the file is already checked out to another user, this selection is disabled.




	
Note:

If the connected content repository does not support versioning, this selection is Overwrite the existing file to replace the existing file with the new file.







If you do not have the permissions required to create a new version or overwrite the file, this selection is disabled.


	
Use another name for the uploaded file to display a Name field where you can enter a new name for the file. If you specify a name that matches another existing file, a message notifies you to enter a different name.












41.8.2 Creating a Wiki Document

In addition to uploading files (see Section 41.8.1, "Uploading Files") to the connected content repository, you can create wiki documents using either of the following two methods:

	
New Wiki Document action through Documents service task flows, as described in Section 47.4.1, "Creating a Wiki Document Using the New Wiki Document Action"


	
Wiki page syle, as described in Section 47.4.2, "Creating a Wiki Document Using the Wiki Page Style"




For more information about wiki documents in Spaces, see Chapter 47, "Working with Wiki Documents."








41.9 Opening a Folder

You can open a folder to display its contents in all Documents service task flows except the Recent Documents task flow, which does not display folders.




	
Note:

Other methods to open folders when the backend content repository is Content Server are:
	
Create a network place to a space, then use Windows Explorer to open folders and files, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Use the task pane available through Microsoft Office shared document management functionality to open folders in a space, as described in Section 46.3.4.7, "Managing Folders"












To open a folder to display its contents and make it the top-level folder:

	
On the Documents page or in a Documents service task flow, either:

	
Click the folder name.


	
Or, right-click in the folder's row to display the folder context menu (Figure 41-53) and choose Open.












41.10 Opening a File

With appropriate permissions, you can open files of any type in all Documents service task flows to preview file contents or properties in a read-only view.

The Document Explorer, Document Manager, and Folder Viewer task flows open files in-place in a Document Viewer preview pane; the Document List Viewer and Recent Documents task flows open files in a separate Document Viewer preview window.




	
Note:

Another method to open files when the backend content repository is Content Server is:
	
Create a network place to a space, then use Windows Explorer to open folders and files, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."












To open a read-only view of a file:

	
On the Documents page or in a Documents service task flow, click the file name to open the file in a Document Viewer preview pane or window.




	
Note:

Some file types do not support a preview. An attempt to open such a file displays the properties of the file in the Document Viewer.







The appearance of the file in the preview pane or window depends on the file type:

	
For files that support PDF format: The file displays either in an in-place PDF viewer (Figure 41-75) or in a slide viewer (Figure 41-76).


Figure 41-75 File Preview in PDF Viewer
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Note:

To enable the slide preview functionality, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the frontend to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.













Figure 41-76 File Preview in Slide Viewer (see Note)

[image: File Preview in Slide Viewer]



	
For HTML, text, image, XML files: In the preview pane or window, click the View menu and choose Open in Browser to open the file in a separate tab in your browser.


	
For any file type for which Content Server is configured to convert to PDF: In the preview pane or window, click the View menu and choose Open as PDF to open a PDF version of the file.







To edit files, see Section 41.12, "Editing and Updating a File".






41.11 Using the Rich Text Editor (RTE)

The Rich Text Editor (RTE) is a fully-integrated HTML text editor, which you can use to create and edit wiki documents and blog posts, and edit HTML files in the content repository. Figure 41-77 shows create mode, and Figure 41-78 shows edit mode.


Figure 41-77 New Wiki Document in Rich Text Editor

[image: New Wiki Document in Rich Text Editor]




Figure 41-78 Editing Blog Post in Rich Text Editor

[image: Editing Blog Post in Rich Text Editor]



The RTE provides four tabbed panes where you can create and edit your wiki and HTML documents, and blog posts:

	
Rich Text. Create and revise content in a WYSIWYG environment using the icons and controls in the RTE toolbar (see Table 41-6).


	
HTML. Enter HTML manually. This includes entering source code for HTML not handled by the WYSIWYG icons and conrols on the Rich Text tab.




	
Note:

The RTE ignores the following types of tags when entered in HTML because they are irrelevant or redundant within the RTE context:
	
script tags


	
form elements, such as input, select, textarea, and form


	
frame/frameset


	
document tags, such as html, head, body, meta, and title


	
unknown tags; for example: <foo></foo>













	
Wiki Markup. Enter your own wiki markup. For examples of wiki markup, click the Wiki Markup Help icon (Figure 41-79).


Figure 41-79 Wiki Markup Help Icon

[image: Wiki Markup Help Icon]



	
Preview. Shows a preview of your document or post as it will appear when published.




Table 41-6 describes the RTE toolbar icons and controls on the Rich Text tab:


Table 41-6 Rich Text Editor Toolbar Icons and Controls on Rich Text Tab

	Control	Description
	
[image: RTE font style icons]


	
Bold, Italic, Underline, and Strike Through. Select text, and click the desired font style icon; or click an icon, and enter text. Click the icon again to exit the font style.


	
[image: RTE Paragraph Format drop-down menu]


	
Paragraph Format. Select a format, then enter text; or highlight text, then select a format.


	
[image: RTE Font Name drop-down menu]


	
Font Name. Select a font, then enter text; or highlight text, then select a font.


	
[image: RTE Font Size drop-down menu]


	
Font Size. Select a size, then enter text; or highlight text, then select a size.


	
[image: RTE color drop-down menus]


	
Text Color or Background Color. Select text, and click the desired text or background color icon, then select a color. Or, click an icon and select a color, then enter text.


	
[image: RTE justify icons]


	
Left Justify, Center Justify, and Right Justify. Select text, and click to apply the desired text alignment; or click an icon, and enter text.


	
[image: RTE indent icons]


	
Decrease Indent and Increase Indent. Select text, and click the desired indent icon to move text left or right.


	
[image: RTE list icons]


	
Numbered List and Bulleted List. Start a new line, click the desired list type icon, and enter text. Or, select lines of text and click an icon. Click the icon again to remove the list formatting. Alternately, end list mode by pressing Enter twice after the last item.


	
[image: RTE Remove Format icon]


	
Remove Format. Select text, and click this icon to remove all font styling, such as font types, sizes, weights, and colors. Lists and indents are not affected.


	
[image: RTE Select Resource, New Resource, and Embed Image icons]


	
Select Resource. Select text to link to an existing Spaces resource, then click this icon to open the Select Resource dialog. Select a resource (for example, a document or an announcement) in the current space to be linked from the selected text. Clicking the linked text in the document opens the selected resource in the Document Viewer preview pane.

New Resource. Select text to link to a new Spaces resource, then click this icon to open the New Resource dialog. Select a resource to be linked from the selected text, then create the resource (for example, a note or announcement), specify the external location of the resource (for example, a URL), specify the name of the resource (for example, a wiki document), or upload the resource from your local file system or a connected network drive (for example, a document). For information about creating links to resources in Spaces, see Chapter 63, "Working with the Links Service."

Note: If you create a new wiki document in this manner, Spaces creates a placeholder for the new wiki document in the current folder. To add content to the new wiki document, you must navigate to it and open it in the RTE.

Embed Image. Click to open the Embed Image dialog:

	
Click Select Image to select an image in the current space.


	
Click Upload Image to upload an image from your local file system or a connected network drive.





	
[image: RTE Image, Table, and Insert Horizontal Line icons]


	
Table. Click to open the Table Properties dialog, where you can specify the number of rows and columns, sizing, spacing, alignment, caption, and summary for a table. Click OK to insert the table into the document.


	
[image: RTE Image, Table, and Insert Horizontal Line icons]


	
Insert Horizontal Line. Click to insert a horizontal line at the current cursor location.


	
[image: RTE Maximize icon]


	
Tools:

	
Maximize/Minimize. Click to expand the RTE to fill the entire screen, or reduce the RTE to display inside the Spaces application.


	
Select All. Select all content in the body in the text input area.


	
Find or Replace. Click to open the Find and Replace dialog, where you can search for a string, or replace a given string with specified text.


	
Snippet. In a blog post, select a portion of text, then click this icon to display that portion as a summary of the blog post on the blog summary page (or digest page), with a Read More link to allow users to view the full blog. In a wiki document, this functionality is not available.





	
[image: RTE Cut, Copy, and Paste icons]


	
Cut, Copy, or Paste. Select text, then right-click to display context menu to cut or copy selected text, or paste text in the buffer at the current cursor location.


	
Ctrl-x

	
Use this key combination to cut highlighted selections to the clipboard.


	
Ctrl-c

	
Use this key combination to copy highlighted selections to the clipboard.


	
Ctrl-v

	
Use this key combination to paste the content on the clipboard at the current cursor location.








To use the RTE:

	
Open the RTE either by creating a new wiki document (see Section 41.8.2, "Creating a Wiki Document") or blog post (see Section 48.7.2, "Creating a Blog Post"), or editing a wiki, blog post, or HTML file (see Section 41.12.3, "Editing Files In-Place").


	
For a new wiki document or blog post, enter a display name in the Title field.


	
Add, revise, and preview text, formatting, styling, and links in the Rich Text, HTML, Wiki Markup, and/or Preview tabbed panes.


	
When editing a file, select the Minor Edit? checkbox if you do not want to notify space members about your changes.

Leaving this checkbox cleared updates the Activity Stream and sends notifications after you save your changes.


	
In the tabbed panes along the bottom of the RTE, you can add comments, tags, links pertinent to the document or post. For more information, see Section 41.19, "Viewing, Entering, and Deleting Comments on a File," Section 41.20, "Working with Tags," and Section 41.23, "Working with Links."


	
Save your changes:

	
To create and save a new wiki document or blog post, click Create.


	
To save updates to an existing wiki, blog post, or HTML file, click Save and Close.












41.12 Editing and Updating a File

In a Documents service task flow or in the Document Viewer preview pane, you can check a file out, download it to your local file system for editing, edit a file in-place, or upload a new version of an existing file. The actions available to you depend on the file type:

	
For all file types except wiki documents, check the file out to lock it from being updated by other users.


	
For all file types, download the file to your local file system for saving or editing locally.


	
For wiki and HTML documents, edit the file in-place using the Rich Text Editor (RTE).


	
For all file types except wiki documents, upload a new version of the file.




The following sections provide more information:

	
Section 41.12.1, "Checking a File Out"


	
Section 41.12.2, "Downloading a File"


	
Section 41.12.3, "Editing Files In-Place"


	
Section 41.12.4, "Uploading a New Version of an Existing File"






41.12.1 Checking a File Out

When you want to retain exclusive use of a file—for example, when you're editing it on your local machine, or need to prevent other users from modifying it—you must check the file out. Other Spaces users can view the file, but they cannot upload a file of the same name into the same folder while the file is checked out.




	
Note:

When you edit a file in-place (see Section 41.12.3, "Editing Files In-Place"), it is automatically checked out of the content repository. When you save it, it is automatically checked back in.







When you're ready to release the file, you can either check the file back in, or cancel file check out. Checking a file back in involves uploading the revised file (see Section 41.12.4, "Uploading a New Version of an Existing File"). Cancelling check out removes the file's checked out status without requiring a file upload.




	
Note:

To use the task pane available through the Microsoft Office shared document management functionality to check a Microsoft Word, Excel, or PowerPoint file out or in when the backend content repository is Content Server, see Section 46.3.4.3, "Checking a File Out" and Section 46.3.4.4, "Checking a File In"







To check a file out:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file you want to check out.

Alternatively, you can check out an open file in the Document Viewer preview pane.




	
Notes:

	
File check out is not available for wiki documents. In-place editing is the optimal way to update wiki documents, as described in Section 41.12.3, "Editing Files In-Place."


	
To check out a file in workflow, the file must be associated with a workflow that contains the step review the current revision or create new revisions and you must be an approver for the workflow. See Section 43.1.1, "Understanding Workflow Types."













	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the File menu and choose Check Out, or right-click to display the file's context menu (Figure 41-54) and choose Check Out.


	
In the Document Viewer preview pane, click the File menu and choose Check Out.





	
On the Documents page or in a Documents service task flow, click the View menu and choose Refresh Content to confirm that the Checked Out (padlock) icon appears in the file's Checked Out column:

	
Roll your mouse pointer over the icon to see details about the user who has checked the file out.


	
Click the icon to expose actions to upload a new version of the file, or cancel the checkout (Figure 41-80).





Figure 41-80 Checked Out Icon with Details

[image: Checked Out icon]





To cancel the checked out status of a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can cancel the checked out status of an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the Checked Out (padlock) icon in the file's row and choose Cancel Check Out (Figure 41-80), click the File menu and choose Cancel Check Out, or right-click to display the file's context menu (Figure 41-54) and choose Cancel Check Out.


	
In the Document Viewer preview pane, click the Cancel Check Out action.





	
On the Documents page or in a Documents service task flow, click the View menu and choose Refresh Content to confirm that the Checked Out (padlock) icon no longer appears in the file's Checked Out column.









41.12.2 Downloading a File

When you want to save a file to your local file system, you can download it from the content repository.

To download a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file you want to download to your local file system.

Alternatively, you can download an open file in the Document Viewer preview pane.


	
Depending on your view and the file type, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the Download action, or right-click to display the file's context menu (Figure 41-54) and choose Download.


	
In the Document Viewer preview pane, click the Download action.


	
(For any file type for which Content Server is configured to convert to PDF) In the Document Viewer preview pane, click the View menu and choose Download PDF to save a PDF version of the open file to your local file system.





	
In the Open/Save dialog, select Save File to open the Save dialog, where you can navigate to the folder in which to save the file.









41.12.3 Editing Files In-Place

With appropriate permissions, end users can directly edit the following types of files in-place:

	
Wiki documents


	
Blog posts


	
HTML files


	
Microsoft Office 2003 or higher files (Word, Excel, PowerPoint)




	
Note:

If you are using Windows 7 or a 64-bit machine with Firefox 3.6, you may need to install the Java plugin available at http://support.mozilla.com to edit a Microsoft Office file. This plugin is included in Java 6 Update 15 and above.










In-place editing refers to editing content directly in a Spaces application at runtime, where the editor opens in the document preview pane. When you edit a file in-place, it is automatically checked out of the content repository. When you save it, it is automatically checked back in.

To edit HTML and Site Studio files that display in a Content Presenter task flow, see Section 40.10, "Creating and Editing Files In-Context in a Content Presenter Task Flow."

To edit a file in-place:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file you want to edit, but not on the file name.

Alternatively, you can edit an open file in the Document Viewer preview pane.


	
Depending on your view and the file type, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the File menu and choose Edit or Edit with Application, or right-click to display the file's context menu (Figure 41-54) and choose Edit or Edit with Application.


	
In the Document Viewer preview pane, click the Edit (Figure 41-81) or Edit with Application (Figure 41-82) action.


Figure 41-81 Edit Action in Document Viewer for Wiki Document

[image: Edit Action in Document Viewer for Wiki Document]




Figure 41-82 Edit Action in Document Viewer for Microsoft Word File

[image: Edit Action in Document Viewer]








	
Notes:

	
If the file is already checked out by another user, the File in Use dialog opens. See Section 41.12.3.1, "Opening a File Already Checked Out By Another User."


	
To edit a file in workflow, the file must be associated with a workflow that contains the step review the current revision or create new revisions and you must be an approver for the workflow. See Section 43.1.1, "Understanding Workflow Types."












The file opens in the appropriate editor:

	
Wiki documents, blog posts, and HTML files open in-place in the Rich Text Editor (RTE). For information about the RTE, see Section 41.11, "Using the Rich Text Editor (RTE)."


	
Microsoft Office (Word, Excel, PowerPoint) files may first display a confirmation prompt, then an authentication dialog. Use the same credentials used to log in to Spaces to open the file in-place in its corresponding application.




	
Note:

The user name and password must contain only ASCII characters. A user name or password containing multi-byte characters cannot be successfully authenticated.







When the connected content repository is Content Server, you must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port to allow for full integration of Microsoft Office with Spaces. For information about setting up OHS as the front-end to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Additionally, your Spaces administrator must modify system properties and server configuration files, and set up a virtual host for your Spaces application. These configuration requirements are described in "Configuring SSO with Virtual Hosts" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.





	
When the file opens, it is automatically checked out. In Spaces, click the Refresh icon to show the Checked Out icon for the selected file (Figure 41-83).


Figure 41-83 Checked Out Icon in Spaces

[image: Checked Out Icon in WebCenter Spaces]



	
Make required updates, then save and close the file.

The modified file is automatically checked back in.






41.12.3.1 Opening a File Already Checked Out By Another User

If the file that you attempt to open is already checked out by another user, the Document Viewer specifies the name of the user who has it checked out. (Figure 41-84).


Figure 41-84 Document Viewer: File Checkout Out

[image: Document Viewer: File Checkout Out]



You can download the file to your local system to edit it, but you cannot upload the changed file to the content repository until it is checked in and made available again.








41.12.4 Uploading a New Version of an Existing File

If you have write permissions on a file, you can replace the file with a new version that you have saved on your local file system.

To upload new versions of multiple files at once, which allows you to also specify whether to create new versions of existing files or overwrite existing files, follow the steps in Section 41.8.1, "Uploading Files."




	
Note:

Spaces does not support uploading a new wiki document or a new version of a wiki document from the file system. If you upload an HTML file, you cannot convert it to a wiki document due to differences in underlying metadata. For information about wiki documents in Spaces, see Chapter 47, "Working with Wiki Documents."







To upload a new version of a single file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file you want to replace.

Alternatively, you can upload a new version of an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click the Checked Out (padlock) icon in the file's row and choose Upload New Version (Figure 41-85), click the File menu and choose Upload New Version (Figure 41-48), or right-click to display the file's context menu (Figure 41-54) and choose Upload New Version.


Figure 41-85 Checked Out Icon: Upload New Version

[image: Checked Out Icon: Upload New Version]



	
In the Document Viewer preview pane, click the Upload New Version action (Figure 41-86).


Figure 41-86 Document Viewer: Upload New Version

[image: Document Viewer: Upload New Version]





The Upload New Version pane opens (Figure 41-87).


Figure 41-87 Upload New Version Pane

[image: Upload New Version pane]






	
Note:

if a file is associated with a content type profile, it will be uploaded using that content type profile. You cannot change a file's content type profile by uploading a new version. See Section 41.8.1, "Uploading Files" for information about selecting a content type profile when a file is first uploaded.








	
Either:

	
(In FireFox or Chrome browsers only) Select the new file in your local file system and drag it into the Upload New Version pane.


	
Click Select file to open the File Upload dialog, then navigate to and select the file you want to upload.







	
Note:

By default, the maximum upload size for files is 2 MB for Spaces applications. System administrators can customize the maximum file upload size by editing the uploadedFileMaxDiskSpace parameter in the webcenter-config.xml file. For details, see "webcenter-config.xml" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.








	
In the Upload Document pane, optionally, provide a description of the file in the Description field.


	
Click Upload.

Upload new version will use the current profile for the document, or if it does not have one use the upload screen you are showing below. You cannot change a document's profile by uploading a new version.

	
If the file is not checked out by another user, a new version of the file replaces the existing file. For information about viewing versions of a file, see Section 41.21, "Viewing and Deleting File Version History."


	
If the file is checked out by another user, the Resolve Name Conflict pane opens (Figure 41-88).


Figure 41-88 Resolve Name Conflict Pane

[image: Resolve Name Conflict Pane]





Select the desired action:

	
Ignore this file to cancel the upload operation for the current file. This is useful when uploading multiple files to skip only the current file, and continue to upload subsequent files in the batch.


	
Use another name for the uploaded file to display a Name field where you can enter a new name for the file. If you specify a name that matches another existing file, a message notifies you to enter a different name.







To upload new versions of multiple files at once, which allows you to also specify whether or not to create new versions of existing files, follow the steps in Section 41.8.1, "Uploading Files."








41.13 Renaming a Folder or File

In a Documents service task flow, you can rename a folder or file as described in the following sections:

	
Section 41.13.1, "Renaming a Folder or File Using a Menu"


	
Section 41.13.2, "Renaming a File and Revising Its Description Through Properties"







	
Note:

To use Windows Explorer to rename folders and files in a space when the backend content repository is Content Server, see Section 46.4.2, "Working with Files Using Windows Explorer."









41.13.1 Renaming a Folder or File Using a Menu

To rename a folder or file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder or file you want to rename.


	
Click the File menu and choose Rename, or right-click in the folder or file's row to display the context menu (Figure 41-53 and Figure 41-54) and choose Rename.

The Rename Folder or Rename Document dialog opens (Figure 41-89).


Figure 41-89 Rename Document Dialog

[image: Rename Document dialog box]



	
In the Name field, enter a new folder or file name.


	
Click Rename.









41.13.2 Renaming a File and Revising Its Description Through Properties

To rename a file or revise its description through its properties, see Section 41.22, "Viewing and Modifying Folder and File Properties."








41.14 Copying and Pasting Folders and Files

In a Documents service task flow, you can copy and paste folders and files in the following ways:

	
Use menu actions as described in the steps below.


	
Drag and drop into a target folder while pressing the Ctrl key. You can even drag and drop into another Documents service task flow on the same page as long as both task flows are connected to the same content repository.


	
Copy a file to your local file system, as described in Section 41.12.2, "Downloading a File."




To copy one or more folders (including all of its subfolders and files) or files using menu actions:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder(s) or file(s) you want to copy.

To select multiple folders or files, Ctrl-click in the rows.


	
Click the File menu and choose Copy, or right-click to display the context menu (Figure 41-53 and Figure 41-54) and choose Copy.


	
Navigate to the folder where you want to paste the copied folder(s) or file(s).

You can also navigate to a folder in another Documents service task flow on the same or a different page as long as both task flows are connected to the same content repository.


	
Click the File menu and choose Paste, or right-click to display the folder's context menu (Figure 41-53) and choose Paste. After pasting, the Paste action becomes inactive in the current folder. You can continue to paste the copied content to other folders as needed.

If you are copying into another Documents service task flow, you may need to refresh the target folder if the Paste menu action is not active (see Section 41.17, "Refreshing Folder Contents").

The selected folder(s) and file(s) are copied to the current folder.




	
Note:

If a folder or file is deleted at the source location before pasting, it will not be copied to the paste location.















41.15 Moving Folders and Files

In a Documents service task flow, you can move folders and files in the following ways:

	
Use the menu actions as described in the steps below.


	
Drag and drop into a target folder. You can even drag and drop into another Documents service task flow on the same page as long as both task flows are connected to the same content repository.







	
Note:

To use Windows Explorer to move folders and files in a space when the backend content repository is Content Server, see Section 46.4.2, "Working with Files Using Windows Explorer."







To move one or more folders (including all of its subfolders and files) or files using menu actions:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder(s) or file(s) you want to move.

To select multiple folders or files, Ctrl-click in the rows.


	
Click the File menu and choose Cut, or right-click to display the context menu (Figure 41-53 and Figure 41-54) and choose Cut.


	
Navigate to the folder where you want to move the folder(s) or file(s).

You can also navigate to a folder in another Documents service task flow on the same or a different page as long as both task flows are connected to the same content repository


	
Click the File menu and choose Paste, or right-click to display the folder's context menu (Figure 41-53) and choose Paste. After pasting, the Paste action becomes inactive in the current folder.

If you are moving folders or files into another Documents service task flow, you may need to refresh the target folder if the Paste menu action is not active (see Section 41.17, "Refreshing Folder Contents").

The selected folder(s) and file(s) are moved to the current folder.




	
Note:

If you do not paste the cut folder(s) or file(s), they are restored to the location where they were cut. If a folder or file is deleted at the source location before pasting, it will not be moved to the paste location.















41.16 Deleting Folders and Files

When you delete a folder, all the subfolders and files the folder contains are also deleted in the content repository.




	
Note:

The root folder of the task flow cannot be deleted.










	
Note:

To use Windows Explorer to move folders and files in a space when the backend content repository is Content Server, see Section 46.4.2, "Working with Files Using Windows Explorer."







To delete one or more folders or files:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder(s) or file(s) you want to delete.

To select multiple folders or files, Ctrl-click in the rows.


	
Click the File menu and choose Delete, or right-click to display the context menu (Figure 41-53 and Figure 41-54) and choose Delete.

The Delete dialog opens (Figure 41-90).


Figure 41-90 Deleting a File

[image: Delete a File]



	
Click Delete to delete your selection from the content repository.









41.17 Refreshing Folder Contents

Refreshing the contents of the current folder retrieves all changes made in the content repository since the last retrieval.

To refresh folder contents:

	
On the Documents page or in a Document Explorer, Document Manager, or Folder Viewer task flow, click the View menu and choose Refresh Content.


	
In the Document List Viewer task flow, click the Refresh icon.









41.18 Hiding and Showing Folders

To hide or show the folders in a listing of folders and files:

	
On the Documents page or in a Document Explorer, Document Manager, or Folder Viewer task flow, click the View menu and choose Hide Folders.

When folders are hidden, a checkmark displays alongside the Hide Folders menu selection.









41.19 Viewing, Entering, and Deleting Comments on a File

You can associate comments with a file to provide additional information that you want to convey to other users about the file.




	
Note:

Users viewing a public document are not given the ability to comment on the document.







To view, enter, or delete comments on a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can view comments for an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, open the Comments pane in any of the following ways:

	
Click the View menu, and choose Details.


	
Right-click to display the file's context menu (Figure 41-54) and choose Details.


	
Click the value in the Comments column (Figure 41-91) for the file. This value indicates the number of comments that have been entered for each file.


Figure 41-91 Comments Column for a File

[image: Comments Column in Documents Task Flow]






	
In the Document Viewer preview pane, scroll to the bottom of the document and click the Comments tab (Figure 41-92).


Figure 41-92 Comments Pane

[image: Comments Pane]






	
To add a comment, enter it in the input area, then click Comment.


	
To delete a prior comment that you have entered, click the red Delete icon beneath the comment (Figure 41-93).


Figure 41-93 Deleting a Comment

[image: Deleting a Comment]










41.20 Working with Tags

Tags specify keywords related to the content of the file. Tags are useful for making a file more widely discoverable in search results.

To work with the tags for a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can view the tags of an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the View menu and choose Details, or right-click to display the file's context menu (Figure 41-54) and choose Details.


	
In the Document Viewer preview pane, scroll to the bottom of the document and click the Tags tab (Figure 41-94).


Figure 41-94 Tags Pane

[image: Tags Pane]






	
In the Tags pane, enter new tags, and edit or delete existing tags as your permissions allow, then click Save.




	
See Also:

For information about tags in Spaces, see Chapter 57, "Working with the Tags Service."















41.21 Viewing and Deleting File Version History

If you edit and save a file, or upload a file with Always create a new version selected in the Upload dialog (Figure 41-95), Spaces creates a new version of the file if it already exists in the current folder. When a file has multiple versions, it has a version history.


Figure 41-95 Upload Document Screen (in FireFox browser)

[image: Upload Document pane]

Description of "Figure 41-95 Upload Document Screen (in FireFox browser)"





This section describes how to view a file's version history to track when a file was last revised, to determine which user revised it, and to delete a particular file version. For wiki documents and blog posts, you can also compare versions.




	
Note:

To use the the task pane available through Microsoft Office shared document management functionality to work with a Microsoft Word, Excel, or PowerPoint file's version history, see Section 46.3.4.10, "Working with File Version History."







To view or delete versions of a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can view comments for an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the View menu and choose Details, or right-click to display the file's context menu (Figure 41-54) and choose Details.


	
In the Document Viewer preview pane, scroll to the bottom of the document and click the History tab (Figure 41-96).


Figure 41-96 History Pane

[image: Version History screen]






	
Select a version of the file to display a preview of that version in the preview pane.


	
To delete a particular version, select it in the History pane, then click Delete (Figure 41-97).




	
Note:

The Delete icon displays only if you have been granted delete permissions.








Figure 41-97 Deleting a Version of a File

[image: Delete button on the Version History screen]



	
(For wiki documents and blog posts only) To compare a particular version with the current version of the file, select it in the History pane, then click Compare to open the Compare Versions dialog, showing the differences (Figure 41-98 and Figure 41-99).


Figure 41-98 Comparing Older Version with Current Version (Wiki or Blog)

[image: Comparing Older Version with Current Version]




Figure 41-99 Compare Versions Dialog (Wiki or Blog)

[image: Compare Versions Dialog (Wiki or Blog)]










41.22 Viewing and Modifying Folder and File Properties

Folder and file properties provide access to informational details. You can use file properties to perform activities such as rename a file, provide or revise a file description, or obtain a reusable link to the file.

Additionally, both folder and file properties provide read-only information about location, type, and creation and modification dates. Folder and file properties also provide contact information for the users who created or last modified the folder or file.

To access folder or file properties, refer to the steps in the following sections:

	
Section 41.22.1, "Working with Folder Properties"


	
Section 41.22.2, "Working with File Properties"






41.22.1 Working with Folder Properties

To view or modify folder properties:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder.


	
Click the View menu and choose Details, or right-click to display the context menu (Figure 41-53) and choose Details.

The Basic properties pane opens (Figure 41-100).


Figure 41-100 Folder Properties

[image: Folder Properties]










41.22.2 Working with File Properties

To view or modify file properties:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can view properties of an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the View menu and choose Details, or right-click to display the context menu (Figure 41-54) and choose Details.


	
In the Document Viewer preview pane:

	
If the file type supports an in-place preview of the file contents, scroll to the bottom of the preview and click the Info tab (Figure 41-101).


	
If the file type does not support a preview (for example, .mp3 music files, video files, or .ini files), the preview pane displays the file properties (Figure 41-102).





Figure 41-101 Document Viewer: File Properties in Tabbed Info Pane

[image: Document Viewer: File Properties in Tabbed Info Pane]




Figure 41-102 Document Viewer: File Properties in Preview Pane

[image: Document Viewer: File Properties in Preview Pane]






	
To modify the editable Basic properties, click Edit in the Basic properties area. In the Edit dialog (Figure 41-103), revise the file name and description as desired, then click Save.


Figure 41-103 Edit Dialog for Basic Properties

[image: Edit Dialog for Basic Properties]



	
To modify the editable Advanced properties, click Edit in the Advanced properties area. In the Edit dialog (Figure 41-104), revise the property values as desired, then click Save.




	
Note:

To enable Edit functionality on Advanced properties, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the frontend to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.













Figure 41-104 Advanced Properties Edit Dialog

[image: Advanced Properties Edit Dialog]






	
Note:

Most advanced properties are unique to the content repository (such as Content Server) where the file is stored.

















41.23 Working with Links

Links provide a way to view, access, and associate related information by linking a file to a discussion, document, event, note, or URL. For example, you can create a link to associate a project plan document with a list of project issues.

To work with the links for a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can view the links of an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the View menu and choose Details, or right-click to display the file's context menu (Figure 41-54) and choose Details.


	
In the Document Viewer preview pane, scroll to the bottom of the document and click the Links tab (Figure 41-105).


Figure 41-105 Links Pane

[image: Links Pane]






	
To create a link to a new discussion, document, event, note, or URL: click Link to New, then choose the required item (Figure 41-106).


Figure 41-106 Adding a Link to a New Discussion, Document, Event, Note, or URL

[image: Adding a Link to a New item]



	
To create a link to an existing announcement, discussion, document, or event: click Link to Existing, then choose the required item (Figure 41-107).


Figure 41-107 Adding a Link to an Existing Announcement, Discussion, Document, or Event

[image: Adding a Link to an Existing Item]








	
See Also:

For information about creating links in Spaces, see Chapter 63, "Working with the Links Service."












41.24 Working with Recommendations




	
Note:

The Recommendations pane displays only if the Activity Graph service is configured in your application. For more information, see "Activity Graph Service Prerequisites" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







The Recommendations pane provides suggestions of other documents you might want to view, based on the current document. This list uses the Similar Items task flow of the Activity Graph service. For more information, see Section 58.2.4, "Working with the Similar Items Task Flow."

To work with the recommendation for a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file.

Alternatively, you can view the links of an open file in the Document Viewer preview pane.


	
Depending on your view, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, click the View menu and choose Details, or right-click to display the file's context menu (Figure 41-54) and choose Details.


	
In the Document Viewer preview pane, scroll to the bottom of the document and click the Recommendations tab (Figure 41-105).





	
Click the Display Options icon (Figure 41-108) to open the Display Options dialog (Figure 41-109), where you can select the items you want to show in the Recommendations section.


Figure 41-108 Recommendations Display Options Icon PLACEHOLDER

[image: Recommendations Display Options Icon]




Figure 41-109 Display Options for Recommendations PLACEHOLDER

[image: Display Options for Recommendations]



	
In the Recommendations pane:

	
Click the Delete icon to delete the associated recommendation.


	
Click the link text for each recommendation to view that document.


	
Click the Refresh icon to display the most recent recommendations.










	
See Also:

For more information about working with recommendations, see Chapter 58, "Working with the Activity Graph Service."












41.25 Opening or Saving PDF Files

From the Document Viewer preview pane, you can open or save the PDF version of the currently open file to your local file system. This choice is available for any file type for which Content Server is configured to convert to PDF.




	
Note:

To enable the conversion of wikis and blogs into PDF, your application administrator must configure the WebCenter Conversion component, as described in "Enabling the Conversion of Wikis and Blogs into PDFs" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







To open or save a file in PDF:

	
In the Document Viewer preview pane, click the View menu and choose:

	
Open as PDF to open the file in a new tab in your browser in Adobe Acrobat Reader's PDF Viewer plug-in.


	
Download PDF to open a browser dialog where you can save the file to your local file system as a PDF file.












41.26 Sharing the URL for a Folder or File

With appropriate permissions, users can directly access folders and files by clicking the URL, or entering it in a browser. You can retrieve and share the URL to a folder or file in several ways, as described in the following sections:

	
Section 41.26.1, "Retrieving the URL for a Folder or File"


	
Section 41.26.2, "Mailing the URL for a Folder or File"


	
Section 41.26.3, "Publishing the URL for a File to Activity Streams"






41.26.1 Retrieving the URL for a Folder or File

Every folder and file that resides in a connected content repository can be accessed through a direct URL, which you can provide to other users. If they have permissions to access the folder or file, they can click the URL link to open the folder or file directly in a Spaces application, open the file in its default application, or save the file to their local file system.

To retrieve the URL for a folder or file:

	
Open the Get a Link dialog in any of the following ways:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder or file, then click the View menu and choose Get a Link.


	
Right-click in the folder or file's row to display the context menu (Figure 41-53 and Figure 41-54) and choose Get a Link.


	
If you are already viewing a file in the Document Viewer preview pane, click the View menu and choose Get a Link.




The Direct URL provides a direct link to open the folder or file in Spaces application. For files, the Download URL provides a direct link to allow users to open the file in its default application, or choose to save the file to their local file system (Figure 41-110).


Figure 41-110 Clicking Download URL Value in Get a Link Dialog

[image: Clicking Download URL Value in Get a Link Dialog]



	
Drag your mouse pointer over the URL to select it, then press Ctrl-c to copy it so that you can paste it wherever you need it.









41.26.2 Mailing the URL for a Folder or File

From the Document Viewer preview pane, you can send a mail message to other users with the body of the message populated with the direct URL to the currently open folder or file. If the folder or file is in a space, the direct URL to the space is also included.




	
Note:

To use the task pane available through the Microsoft Office shared document management functionality to send a message to any user who has a mail address defined in Spaces, see Section 46.3.4.12, "Sending a Message."







To send the URL to folder or file in a mail message:

	
Open the folder or file in the Document Viewer preview pane in either of the following ways:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder or file, then click the View menu and choose Details.


	
Right-click in the folder or file's row to display the context menu (Figure 41-53 and Figure 41-54) and choose Details.





	
In Document Viewer preview pane, click the File menu and choose Send Mail ro open the mail message in your default mail application.


	
Modify the mail message as desired, and send it.









41.26.3 Publishing the URL for a File to Activity Streams

You can publish the URL for the currently open file to the Activity Stream on the Home page of the current space, and to the personal Activity Stream in the Home space for all users or groups who have permissions to access to the file.

To publish a file's URL to Activity Streams:

	
Open the Share dialog (Figure 41-111) in any of the following ways:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the file, then click the File menu and choose Share.


	
Right-click in the file's row to display the context menu (Figure 41-53 and Figure 41-54) and choose Share.


	
If you are already viewing a file in the Document Viewer preview pane, click the File menu and choose Share.





Figure 41-111 Share Dialog

[image: Publish URL to Activity Stream Dialog]



	
Optionally, enter a comment to appear with the URL.


	
Click Publish.

The URL to the file is added to the Activity Stream on the Home page of the current space, and to the personal Activity Streams for all users or groups who have permission to access the file, along with your comments, if any.











41.27 Setting Security Options on a Folder or File

Security can set be on a folder or a file through inheritance from the parent folder, or by setting custom permissions. If set on a folder, the security is propagated to child files and folders that do not already have their own custom permissions defined. A child file or folder (at any depth) that already has custom permissions defined will retain that security definition.

You must have Document Administration permission to set security options on a folder or file. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."

To set security options on a folder or file:

	
Verify that the Spaces administrator has completed the prerequisite steps before setting security options on folder or file, as described in "Configuring Item Level Security between Content Server 11g and Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Open the Security Settings dialog (Figure 41-112) in any of the following ways:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder or file, then click the File menu and choose Security.


	
Right-click in the folder or file's row to display the context menu (Figure 41-53 and Figure 41-54) and choose Security.


	
If you are already viewing a file in the Document Viewer preview pane, click the File menu and choose Security.





Figure 41-112 Security Settings Dialog

[image: Security Settings Dialog]



	
Select the Access Method:

	
To specify that the folder or file should inherit access settings from the parent folder, select Inherit Parent Folder Permissions, then click OK to save your changes and exit the dialog.


	
To set custom access on the current folder or file, select Use Custom Permissions, and continue with the next steps.





	
To grant access permissions to all authenticated users (that is, to users who are logged in to Spaces), click the Add Authenticated Role for Logged in User Access icon (Figure 41-113).


Figure 41-113 Add Authenticated Role for Logged in User Access Icon

[image: Add Authenticated Role for Logged in User Access Icon]



The role authenticated-role is added under Role or User with default Read access to the folder or file.


	
To grant access permissions to all public users (that is, users who have not logged in to Spaces), click the Add Anonymous Role for Public Access (Figure 41-114).


Figure 41-114 Add Anonymous Role for: Access Icon

[image: Add Anonymous Role for Public Access Icon]



The role anonymous-role is added under Role or User with default Read access to the file.


	
To grant access permissions to selected members of the space, click Add Users or Add Groups to open the corresponding Search dialog where you can select users or groups to populate the list in the Security Settings dialog. For tips on searching for a user or group in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


	
For each user, group, or role, grant access by selecting one or more access privileges from the Access columns: Administer, Delete, Write, and Read.


	
Click OK to save your changes and close the Security Settings dialog.









41.28 Subscribing to a File

To monitor the activities on a file, you can subscribe to it. Whenever any change is made to the file, you will be notified in your personal Activity Stream in the Home space.

To subscribe to a file:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click the file to open it in the Document Viewer preview pane.


	
Click the File menu and choose Subscribe.


	
If you no longer wish to monitor the activities on a file, click the File menu and choose Unsubscribe.









41.29 Liking and Unliking a File

To indicate that a file is of particular interest to you, you can "like" it. Liking a file simply highlights the Like icon for the file to show that you have given it this preference. If a file is already liked, you can "unlike" it if you no longer wish to highlight it in any way. If a number greater than zero displays alongside the Like icon, you can click the number to view a list of other users who have "liked" the file.




	
See Also:

For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."







To like or unlike a file:

	
Click the Like icon for the file in either of the following locations:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click the Like icon in the file's row (Figure 41-115).


Figure 41-115 Like Icon in Documents Service Task Flow: Like This File

[image: Like Icon in Documents Task Flow]



	
In the Document Viewer preview pane, click the Like icon in the menu bar (Figure 41-116).


Figure 41-116 Like Icon in Document Viewer: Like this File

[image: Like Icon in Document Previewer]





The number alongside the Like icon (Figure 41-117) indicates the number of users that like the file. You can click the number to view a list of other users who have "liked" the file.


Figure 41-117 Like Icon Count

[image: Like Icon Count]



	
To "unlike" the file if you no longer wish to highlight it in any way, click the Like icon (Figure 41-118).


Figure 41-118 Like Icon in Document Viewer: Unlike this File

[image: Like Icon in Document Viewer: Unlike this File]










41.30 Adding a Folder or File to Your Favorites

For quick access to a folder or file (including wki documents and blog posts), you can add it to your personal favorites.




	
See Also:

For more information, see Chapter 37, "Creating and Managing Your Personal Favorites."







To add a folder file to your personal Spaces favorites:

	
Open the folder or file in the Document Viewer preview pane in either of the following ways:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click in the row of the folder or file, then click the View menu and choose Details.


	
Right-click in the folder or file's row to display the context menu (Figure 41-53 and Figure 41-54) and choose Details.





	
In Document Viewer preview pane, click the File menu and choose Add To Favorites (Figure 41-119).


Figure 41-119 Adding a File to Personal Favorites

[image: Adding a File to Personal Favorites]










41.31 Searching for Documents

In addition to the WebCenter Search service, which searches a particular space or across an entire Spaces application (see Chapter 56, "Working with the Search Service"), the Documents service provides its own search engine for file searches. A Documents service search saves time and increases the relevancy of results by narrowing the scope of a search to files.

In Spaces, the document search searches within a specific space root folder. In a WebCenter Portal: Framework application, the document search searches through all files to which you have access.

The document search feature is exposed in the Document Manager, Document Explorer, and Folder Viewer task flows. It provides two levels of search: Basic and Advanced. To perform Basic and Advanced searches for files, refer to the following sections:

	
Section 41.31.1, "Running a Basic Document Search"


	
Section 41.31.2, "Running an Advanced Document Search"






41.31.1 Running a Basic Document Search

A basic document search searches the connected content repository for the specified file name. To include more search criteria, see Section 41.31.2, "Running an Advanced Document Search."

To perform a basic document search:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, enter a full or partial file name in the Filter field (Figure 41-120). You can * as a wild card character; for example: *.jpg.


Figure 41-120 Filter Field

[image: Filter field in documents task flow]



	
Press the Enter key, or click the Search icon.

The search results pane displays files matching the search string (Figure 41-121).


Figure 41-121 Search Results Pane

[image: Document search results]



In the search results pane, the presence of the highlighted area indicates that you're looking at the results of a query, not the contents of a folder. Look in the Location column to determine where a file or folder is located. Alternatively, click the file name to open it from the Search Results pane.


	
In the Search Results pane .

	
Click the Clear action to clear the Filter field and return to the default folder display.


	
Click Edit Search Criteria action to open the Advanced Search dialog, where you can specify additional search criteria, as described in Section 41.31.2, "Running an Advanced Document Search."












41.31.2 Running an Advanced Document Search

The advanced document search includes searches the connected content repository for the specified file name, keywords, folder, content type, dates, users, or properties that are defined for the selected content profile.

To perform an advanced document search:

	
Open the Advanced Search dialog in either of the following ways:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, click Advanced next to the Filter field.


	
Click Edit Search Criteria in the highlighted toolbar area of the search results pane (Figure 41-121).




The Advanced Search dialog opens (Figure 41-122).


Figure 41-122 Advanced Search Dialog

[image: Advanced Search dialog]

Description of "Figure 41-122 Advanced Search Dialog"





	
Enter search terms in one or more of the fields:

	
File Name: Enter a full or partial file name. You can use * as a wild card character; for example: *.jpg..


	
Keywords: Enter any keywords related to the content of the file.


	
Look In: Click the Browse icon to open a list of content repository folders, then drill down to the desired folder.


	
Content Type: Choose All Content Types to retrieve content items regardless of the content type. Or, choose from the list the name of a content type profile defined in the Content Server repository. A content type profile specifies the properties that define a specific type of content (for example, a press release, or a news flash, or an image). The content type IDC:GlobalProfile is the name of a default content profile defined in Content Server that can be applied if no other content profiles are defined.


	
Limit Results: Specify the maximum number of files to be returned by the search.


	
Dates: In the Created and/or Last Modified fields, select a modifier to search for files matching an exact date (is), a following date (is after), a preceding date (is before), or a date between two other dates (is between).

Selecting is between adds an additional date field for entering the end date (Figure 41-123). Enter a beginning date and an end date; the end date is not inclusive.


Figure 41-123 Dates Search Pane

[image: Dates Search pane]



Click the Select Date icon to select a date in the correct format (mm/dd/yy), for example 11/18/11, or enter a date manually.


	
Users: In the Created By (user who uploaded) and Last Modified By fields, enter a user name for the creator or last modifier of the file, or click the Browse icon to open the Search Users dialog where you can select from a list of users or search for a user name. For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
Note:

In the Spaces application, when you search in a space, the user selection list and the user search find user names for current members of the space.








	
Additional Query Filters: Not applicable when Content Type is set to All Content Types. For a selected content type profile (prefixed IDC), click the Add icon (Figure 41-124) to list all the properties that are defined for the selected profile. Select one or more properties to refine the query to find files with specific property settings.


Figure 41-124 Additional Query Filters Search

[image: Filters Search Pane]






	
Click Search to execute the advanced search.

Files matching the search criteria display in the Search Results pane.














42 Setting Documents Service Task Flow and Document Component Properties

All Documents service task flows and individual document components in WebCenter Portal: Spaces have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 42-1).


Figure 42-1 Document Explorer Task Flow Properties

[image: Document Explorer Task Flow Component Properties]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Documents service task flows and document components (links, inline frames, and images) and describe the properties on the Parameters tab for each Documents service task flow and document component:

	
Section 42.1, "What You Should Know About Documents Service Task Flow and Document Component Properties"


	
Section 42.2, "Setting Document Explorer Task Flow Properties"


	
Section 42.3, "Setting Document List Viewer Task Flow Properties"


	
Section 42.4, "Setting Document Manager Task Flow Properties"


	
Section 42.5, "Setting Document Navigator Task Flow Properties"


	
Section 42.6, "Setting Folder Viewer Task Flow Properties"


	
Section 42.7, "Setting Recent Documents Task Flow Properties"


	
Section 42.8, "Setting Document Viewer Task Flow Properties"


	
Section 42.9, "Setting Document Mini Properties Task Flow Properties"


	
Section 42.10, "Setting Document Properties Task Flow Properties"


	
Section 42.11, "Setting Document Version History Task Flow Properties"


	
Section 42.12, "Setting Document Link Component Properties"


	
Section 42.13, "Setting Document Inline Frame Component Properties"


	
Section 42.14, "Setting Document Image Component Properties"




For the steps to add a Documents service task flow or document item to a page, see Chapter 41, "Working with the Documents Service Task Flows and Document Components."


Audience

This chapter is intended for Spaces users who want to change the properties of Documents service task flows and document components (links, inline frames, and images).



42.1 What You Should Know About Documents Service Task Flow and Document Component Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. These properties are unique to the task flow type. For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor.




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.







For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






42.2 Setting Document Explorer Task Flow Properties

The Document Explorer task flow displays a list of folders and files in two panes: the left pane shows folders, and the right pane show the contents of the currently selected folder. It is a feature-rich Documents service task flow for viewing, managing, and collaborating on folders and files.




	
See Also:

Section 41.1.1, "Understanding the Document Explorer Task Flow"







Properties that are unique to the Document Explorer task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-2).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-2 Document Explorer Task Flow Properties

[image: Document Explorer Task Flow Component Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.2.1 Document Explorer Task Flow Parameters

Table 42-1 describes the parameters that are unique to the Document Explorer task flow.


Table 42-1 Document Explorer Task Flow Parameters

	Parameter	Description
	
Collapse Tree Navigation

	
Specifies whether to collapse the panel containing the tree navigation:

	
Selected (default): Collapse panel.


	
Cleared: Expand panel.





	
Connection Name

	
The name of the content repository connection. If no value is selected from the list, the default connection specified by the application developer or administrator is used. For information about configuring content repository connections, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Default: The connection selected as default in the Create Content Repository Connection dialog box by the application developer, which can be changed by the administrator.


	
Features Off

	
A list of disabled features for the task flow. Use commas or spaces to separate items. Valid values are exposed in the JavaDoc: checkin, checkout, clipboard, close, delete, download, dnd, editwiki, editoffice, newfolder, newwiki, rename, upload, multifile-upload, profile-upload, search, advancedSearch, workflow, properties, history, comments, likes, links, tags, recommendations, autovue, title, related-items, social, sidebars, ils.

Example:

${'search, advancedSearch, clipboard, dnd, rename, newfolder, upload, newwiki, checkin, checkout, editoffice, edithtml, delete, sidebars, history'}


	
Page Size

	
The maximum number of rows to show in the task flow. If the listing of folders and files in the task flow is larger than the specified number of rows, the task flow displays a scroll bar. Default: 27

Typical scenarios where you may wish to alter this value are:

	
The majority of end users have bigger screens, allowing for the display of more rows.


	
You want to fit this task flow into a smaller area of a page.




Note: If you set Page Size to a value that is too big for the size of the screen, the end user will experience difficulty coordinating the task flow scroll bar with the application scroll bar.


	
Read Only

	
Specifies whether to disable and hide all content management operations:

	
Selected: Disable content management.


	
Cleared (default): Expose content management to users.





	
Resource ID

	
The currently focused resource. This value can be a folder ID or a document ID. Click the magnifier icon to open the Pick a Value dialog and navigate to the desired folder or file; select the folder or file to set the Resource ID value.

The Resource ID value is checked for coherence with the Connection Name and Start Folder Path values, and influences their default values when they are not explicitly specified. For example, if Resource ID alone is specified, the Connection Name value will be inherited from it and the Start Folder Path will be either the resource itself for a folder or the parent folder for a file.


	
Show Documents

	
Specifies whether the navigation tree shows documents and folders in the tree (left-side) navigation page, or folders only:

	
Selected: Show documents and folders.


	
Cleared (default): Show folders and hide documents.





	
Show Folders

	
Specifies whether the navigation tree shows documents and folders in the table (right-side) navigation pane, or documents only:

	
Selected (default): Show folders and documents.


	
Cleared: Show documents and hide folders.





	
Start Folder Path

	
The name of the folder to use as the root folder in the current task flow instance. Click the magnifier icon to open a dialog where you can navigate the connected content repository and select a folder.

This is a content-scoping parameter that assists with determining the source and range of content to display in the task flow instance.

There is no need to set this value for task flows that display the content of the current space's default root folder. But it is useful, for example, when you want the start folder to be other than a space's default root folder and when you want to display content from another space.

Example:

	
/PersonalSpaces/monty/Public


	
/WebCenterB5/Proj_X/Specs




You can specify an EL expression to set this value. See Section B.4.12, "EL Expressions Relevant to the Documents Service" in Appendix B.

Default: The root folder of the content repository configured with the specified connection for the current space.














42.3 Setting Document List Viewer Task Flow Properties

The Document List Viewer task flow displays folders and files in a single pane as a flat listing. In this task flow, users can navigate a folder hierarchy, and customize search queries. While this task flow may be useful for a specific need, its search functionality is replicated and enhanced by using the Content Presenter task flow instead.




	
See Also:

Section 41.1.2, "Understanding the Document List Viewer Task Flow"







Properties that are unique to the Document List Viewer task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-3).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-3 Document List Viewer Task Flow Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.3.1 Document List Viewer Task Flow Parameters

Table 42-2 describes the parameters that are unique to the Document List Viewer task flow.


Table 42-2 Document List Viewer Task Flow Parameters

	Parameter	Description
	
Connection Name

	
The name of the content repository connection. If no value is selected from the list, the default connection specified by the application developer or administrator is used. For information about configuring content repository connections, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Default: The connection selected as default in the Create Content Repository Connection dialog box by the application developer, which can be changed by the administrator.


	
Created After

	
A filtering value to limit the display of task flow content to folders and files created after a specified date and time. Click the magnifier icon to open a dialog where you can select the date from a calendar.

The value uses the ISO 8601 format:


yyyy-mm-ddThh:mm:ss.sssTZFoot 1 


Example:


2010-11-17T18:24:36.000+01:00


This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Created Before

	
A filtering value to limit the display of task flow content to folders and files created before a specified date and time. Click the magnifier icon to open a dialog where you can select the date from a calendar.

The value uses the ISO 8601 format:


yyyy-mm-ddThh:mm:ss.sssTZ1


Example:


2010-11-17T18:24:36.000+01:00


This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Creator

	
A filtering value to limit the display of task flow content to folders and files created by a particular user. Enter the user name as specified by the user login credentials. Only one user name may be entered. If no value is entered, then content created by any user is shown.

Example: ${'monty'}

This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Last Modified After

	
A filtering value to limit the display of task flow content to folders and files last modified after a specified date and time. If no value is entered, then content modified in the last three months is shown. Click the magnifier icon to open a dialog where you can select the date from a calendar.

The value uses the ISO 8601 format:


yyyy-mm-ddThh:mm:ss.sssTZD1


Example:


2010-11-17T18:24:36.000+01.00


This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Last Modified Before

	
A filtering value to limit the display of task flow content to folders and files modified before a specified date and time. If no value is entered, then no such filtering is applied is applied. Click the magnifier icon to open a dialog where you can select the date from a calendar.

The value uses the ISO 8601 format:


yyyy-mm-ddThh:mm:ss.sssTZD1


Example:


2010-11-17T18:24:36.000+01:00


This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	

Last Modifier

	
A filtering value to limit the display of task flow content to folders and files last modified by a particular user. Enter the user name as specified by the user login credentials. Only one user name may be entered. If no value is entered, then all modified documents are shown.

Example: ${'monty'}

This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Page Size

	
The maximum number of rows to show in the task flow. If the listing of folders and files in the task flow is larger than the specified number of rows, the task flow displays a scroll bar. Default: 27

Typical scenarios where you may wish to alter this value are:

	
The majority of end users have bigger screens, allowing for the display of more rows.


	
You want to fit this task flow into a smaller area of a page.




Note: If you set Page Size to a value that is too big for the size of the screen, the end user will experience difficulty coordinating the task flow scroll bar with the application scroll bar.


	
Root Folder Path

	
The name of the folder to use as the root folder in the current task flow instance. Click the magnifier icon to open a dialog where you can navigate the connected content repository and select a folder.

This is a content-scoping parameter that assists with determining the source and range of content to display in the task flow instance.

There is no need to set this value for task flows that display the content of the current space's default root folder. But it is useful, for example, when you want the start folder to be other than a space's default root folder and when you want to display content from another space.

Example:

	
/PersonalSpaces/monty/Public


	
/WebCenterB5/Proj_X/Specs




You can specify an EL expression to set this value. See Section B.4.12, "EL Expressions Relevant to the Documents Service" in Appendix B.

Default: The root folder of the content repository configured with the specified connection for the current space.


	
Show Folders

	
Specifies whether the navigation tree shows documents and folders, or documents only:

	
Selected (default): Show folders and documents.


	
Cleared: Show documents and hide folders.





	
Task Flow Instance ID

	
The unique identifier for this task flow instance, used internally to maintain the association of the task flow instance with its customization and personalization settings and to manage saved queries. Do not edit this value.








Footnote 1 "TZ" is the time zone indicator. If the time being described is in UTC (Coordinated Universal Time), then the time zone indicator is "Z". If the time is from any other time zone, then TZ describes the offset from UTC of the time zone. For example, if the time is in California in December (Pacific Standard Time, PST), then the TZ indicator would be "-08:00".








42.4 Setting Document Manager Task Flow Properties

The Document Manager task flow displays folders and files as specified by its layout parameter: it may display folders and files in two panes (Explorer layout), or a single pane showing only the content of the current folder (Table layout), or a single pane showing the folder hierarchy starting from the root folder (Tree-Table layout). The Document Manager task flow provides comprehensive document management functionality, such as copying, moving, pasting, and deleting folders and files.




	
See Also:

Section 41.1.3, "Understanding the Document Manager Task Flow"







Properties that are unique to the Document Manager task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-4).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-4 Document Manager Task Flow Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.4.1 Document Manager Task Flow Parameters

Table 42-3 describes the parameters that are unique to the Document Manager task flow.


Table 42-3 Document Manager Task Flow Parameters

	Parameter	Description
	
Connection Name

	
The name of the content repository connection. If no value is selected from the list, the default connection specified by the application developer or administrator is used. For information about configuring content repository connections, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Default: The connection selected as default in the Create Content Repository Connection dialog box by the application developer, which can be changed by the administrator.


	
Features Off

	
A list of disabled features for the task flow. Use commas or spaces to separate items. Valid values are exposed in the JavaDoc: checkin, checkout, clipboard, close, delete, download, dnd, editwiki, editoffice, newfolder, newwiki, rename, upload, multifile-upload, profile-upload, search, advancedSearch, workflow, properties, history, comments, likes, links, tags, recommendations, autovue, title, related-items, social, sidebars, ils.

Example:

${'search, advancedSearch, clipboard, dnd, rename, newfolder, upload, newwiki, checkin, checkout, editoffice, edithtml, delete, sidebars, history'}


	
Layout

	
A target layout for the task flow. Choose from:

	
Explorer (default): Displays folders and files in two panes; the left pane shows folders, and the right pane show the contents of the currently selected folder. This layout looks identical to the Document Explorer task flow, without the properties Show Documents, Show Folders, and Collapse Tree Navigation.


	
Table: Displays only the contents of the current folder in a single pane, with the capability to click a folder to drill down, refreshing the pane with the folder contents.


	
Tree Table: Displays the folder hierarchy in a single pane, beginning with the root folder, with the capability to expand and collapse folders.





	
Page Size

	
The maximum number of rows to show in the task flow. If the listing of folders and files in the task flow is larger than the specified number of rows, the task flow displays a scroll bar. Default: 27

Typical scenarios where you may wish to alter this value are:

	
The majority of end users have bigger screens, allowing for the display of more rows.


	
You want to fit this task flow into a smaller area of a page.




Note: If you set Page Size to a value that is too big for the size of the screen, the end user will experience difficulty coordinating the task flow scroll bar with the application scroll bar.


	
Read Only

	
Specifies whether to disable and hide all content management operations:

	
Selected: Disable content management.


	
Cleared (default): Expose content management to users.





	
Resource ID

	
The currently focused resource. This value can be a folder ID or a document ID. Click the magnifier icon to open the Pick a Value dialog and navigate to the desired folder or file; select the folder or file to set the Resource ID value.

The Resource ID value is checked for coherence with the Connection Name and Start Folder Path values, and influences their default values when they are not explicitly specified. For example, if Resource ID alone is specified, the Connection Name value will be inherited from it and the Start Folder Path will be either the resource itself for a folder or the parent folder for a file.


	
Start Folder Path

	
The name of the folder to use as the root folder in the current task flow instance. Click the magnifier icon to open a dialog where you can navigate the connected content repository and select a folder.

This is a content-scoping parameter that assists with determining the source and range of content to display in the task flow instance.

There is no need to set this value for task flows that display the content of the current space's default root folder. But it is useful, for example, when you want the start folder to be other than a space's default root folder and when you want to display content from another space.

Example:

	
/PersonalSpaces/monty/Public


	
/WebCenterB5/Proj_X/Specs




You can specify an EL expression to set this value. See Section B.4.12, "EL Expressions Relevant to the Documents Service" in Appendix B.

Default: The root folder of the content repository configured with the specified connection for the current space.














42.5 Setting Document Navigator Task Flow Properties

The Document Navigator task flow displays folders and files in a single pane, with the capability to expand and collapse folders to view folder hierarchy within the current folder. There are no menu options available to the end user for this task flow.




	
See Also:

Section 41.1.4, "Understanding the Document Navigator Task Flow"







Properties that are unique to the Document Navigator task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-5).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-5 Document Navigator Task Flow Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.5.1 Document Navigator Task Flow Parameters

Table 42-4 describes the parameters that are unique to the Document Navigator task flow.


Table 42-4 Document Navigator Task Flow Parameters

	Parameter	Description
	
Connection Name

	
The name of the content repository connection. If no value is selected from the list, the default connection specified by the application developer or administrator is used. For information about configuring content repository connections, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Default: The connection selected as default in the Create Content Repository Connection dialog box by the application developer, which can be changed by the administrator.


	
Features Off

	
A list of disabled features for the task flow. Use commas or spaces to separate items. Valid values are exposed in the JavaDoc: checkin, checkout, clipboard, close, delete, download, dnd, editwiki, editoffice, newfolder, newwiki, rename, upload, multifile-upload, profile-upload, search, advancedSearch, workflow, properties, history, comments, likes, links, tags, recommendations, autovue, title, related-items, social, sidebars, ils.

Example:

${'search, advancedSearch, clipboard, dnd, rename, newfolder, upload, newwiki, checkin, checkout, editoffice, edithtml, delete, sidebars, history'}


	
Page Size

	
The maximum number of rows to show in the task flow. If the listing of folders and files in the task flow is larger than the specified number of rows, the task flow displays a scroll bar. Default: 27

Typical scenarios where you may wish to alter this value are:

	
The majority of end users have bigger screens, allowing for the display of more rows.


	
You want to fit this task flow into a smaller area of a page.




Note: If you set Page Size to a value that is too big for the size of the screen, the end user will experience difficulty coordinating the task flow scroll bar with the application scroll bar.


	
Read Only

	
Specifies whether to disable and hide all content management operations:

	
Selected: Disable content management.


	
Cleared (default): Expose content management to users.





	
Resource ID

	
The currently focused resource. This value can be a folder ID or a document ID. Click the magnifier icon to open the Pick a Value dialog and navigate to the desired folder or file; select the folder or file to set the Resource ID value.

The Resource ID value is checked for coherence with the Connection Name and Start Folder Path values, and influences their default values when they are not explicitly specified. For example, if Resource ID alone is specified, the Connection Name value will be inherited from it and the Start Folder Path will be either the resource itself for a folder or the parent folder for a file.


	
Show Documents

	
Specifies whether the navigation tree shows documents and folders, or folders only:

	
Selected (default): Show documents and folders.


	
Cleared : Show folders and hide documents.





	
Start Folder Path

	
The name of the folder to use as the root folder in the current task flow instance. Click the magnifier icon to open a dialog where you can navigate the connected content repository and select a folder.

This is a content-scoping parameter that assists with determining the source and range of content to display in the task flow instance.

There is no need to set this value for task flows that display the content of the current space's default root folder. But it is useful, for example, when you want the start folder to be other than a space's default root folder and when you want to display content from another space.

Example:

	
/PersonalSpaces/monty/Public


	
/WebCenterB5/Proj_X/Specs




You can specify an EL expression to set this value. See Section B.4.12, "EL Expressions Relevant to the Documents Service" in Appendix B.

Default: The root folder of the content repository configured with the specified connection for the current space.














42.6 Setting Folder Viewer Task Flow Properties

The Folder Viewer task flow displays a listing of the contents of a folder in a single pane as a flat listing.




	
See Also:

Section 41.1.5, "Understanding the Folder Viewer Task Flow"







Properties that are unique to the Folder Viewer task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-6).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-6 Folder Viewer Task Flow Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.6.1 Folder Viewer Task Flow Parameters

Table 42-6 describes the parameters that are unique to the Folder Viewer task flow.


Table 42-5 Folder Viewer Task Flow Parameters

	Parameter	Description
	
Connection Name

	
The name of the content repository connection. If no value is selected from the list, the default connection specified by the application developer or administrator is used. For information about configuring content repository connections, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Default: The connection selected as default in the Create Content Repository Connection dialog box by the application developer, which can be changed by the administrator.


	
Features Off

	
A list of disabled features for the task flow. Use commas or spaces to separate items. Valid values are exposed in the JavaDoc: checkin, checkout, clipboard, close, delete, download, dnd, editwiki, editoffice, newfolder, newwiki, rename, upload, multifile-upload, profile-upload, search, advancedSearch, workflow, properties, history, comments, likes, links, tags, recommendations, autovue, title, related-items, social, sidebars, ils.

Example:

${'search, advancedSearch, clipboard, dnd, rename, newfolder, upload, newwiki, checkin, checkout, editoffice, edithtml, delete, sidebars, history'}


	
Page Size

	
The maximum number of rows to show in the task flow. If the listing of folders and files in the task flow is larger than the specified number of rows, the task flow displays a scroll bar. Default: 27

Typical scenarios where you may wish to alter this value are:

	
The majority of end users have bigger screens, allowing for the display of more rows.


	
You want to fit this task flow into a smaller area of a page.




Note: If you set Page Size to a value that is too big for the size of the screen, the end user will experience difficulty coordinating the task flow scroll bar with the application scroll bar.


	
Read Only

	
Specifies whether to disable and hide all content management operations:

	
Selected: Disable content management.


	
Cleared (default): Expose content management to users.





	
Resource ID

	
The currently focused resource to display in the task flow. This value can be a folder ID or a document ID. Click the magnifier icon to open the Pick a Value dialog and navigate to the desired folder or file; select the folder or file to set the Resource ID value.

The Resource ID value is checked for coherence with the Connection Name and Start Folder Path values, and influences their default values when they are not explicitly specified. For example, if Resource ID alone is specified, the Connection Name value will be inherited from it and the Start Folder Path will be either the resource itself for a folder or the parent folder for a file.


	
Show Folders

	
Specifies whether the navigation tree shows documents and folders, or documents only:

	
Selected (default): Show folders and documents.


	
Cleared: Show documents and hide folders.





	
Start Folder Path

	
The name of the folder to use as the root folder in the current task flow instance. Click the magnifier icon to open a dialog where you can navigate the connected content repository and select a folder.

This is a content-scoping parameter that assists with determining the source and range of content to display in the task flow instance.

There is no need to set this value for task flows that display the content of the current space's default root folder. But it is useful, for example, when you want the start folder to be other than a space's default root folder and when you want to display content from another space.

Example:

	
/PersonalSpaces/monty/Public


	
/WebCenterB5/Proj_X/Specs




You can specify an EL expression to set this value. See Section B.4.12, "EL Expressions Relevant to the Documents Service" in Appendix B.

Default: The root folder of the content repository configured with the specified connection for the current space.














42.7 Setting Recent Documents Task Flow Properties

The Recent Documents task flow displays a listing of the most recently created or modified files by the current user, when the connected content repository is Content Server.




	
See Also:

Section 41.1.6, "Understanding the Recent Documents Task Flow"







Properties that are unique to the Recent Documents task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-7).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-7 Recent Documents Task Flow Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.7.1 Recent Documents Task Flow Parameters

Table 42-6 describes the parameters that are unique to the Recent Documents task flow.


Table 42-6 Recent Documents Task Flow Parameters

	Parameter	Description
	
Connection Name

	
The name of the content repository connection. If no value is entered, the default connection specified by the application developer or administrator is used. For information about configuring content repository connections, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Default: The connection selected as default in the Create Content Repository Connection dialog box by the application developer, which can be changed by the administrator.


	
Space

	
(Used in Spaces only)

The name of a space that is the source of the recently created or modified documents listed in the task flow. Valid values are:

	
no value or ${null} (default): Displays documents for the entire connected content repository.


	
Display name or ID of a specific space: Displays documents in that space.


	
${'all'}: Displays documents from any space, excluding non-space documents.





	
Last Modified After

	
A filtering value to limit the display of task flow content to folders and files last modified after a specified date and time. If no value is entered, then content modified in the last three months is shown. Click the magnifier icon to open a dialog where you can select the date from a calendar.

The value uses the ISO 8601 format:


yyyy-mm-ddThh:mm:ss.sssTZDFoot 1 


Example:


2010-11-17T18:24:36.000+01.00


This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Last Modified Before

	
A filtering value to limit the display of task flow content to folders and files modified before a specified date and time. If no value is entered, then no such filtering is applied is applied. Click the magnifier icon to open a dialog where you can select the date from a calendar.

The value uses the ISO 8601 format:


yyyy-mm-ddThh:mm:ss.sssTZD1


Example:


2010-11-17T18:24:36.000+01:00


This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Last Modifier

	
A filtering value to limit the display of task flow content to folders and files last modified by a particular user. Enter the user name as specified by the user login credentials. Only one user name may be entered. If no value is entered, then all modified documents are shown.

Example: ${'monty'}

This parameter is available for contextual wiring. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components".


	
Maximum Documents

	
The maximum number of files to show.If no value or 0 is entered, then up to 10 of the most recently accessed documents are shown.

Example: ${10}

Note that there is no single quote surrounding the value.

Default: ${null}


	
Most Recent First

	
Specifies the sort order of files in the task flow:

	
${true} (default): Most recent documents listed first.


	
${false}: Oldest documents listed first.











Footnote 1 "TZ" is the time zone indicator. If the time being described is in UTC (Coordinated Universal Time), then the time zone indicator is "Z". If the time is from any other time zone, then TZ describes the offset from UTC of the time zone. For example, if the time is in California in December (Pacific Standard Time, PST), then the TZ indicator would be "-08:00".








42.8 Setting Document Viewer Task Flow Properties

The Document Viewer task flow displays a preview of an individual file in the default template for its file type.




	
See Also:

	
Section 41.1.7, "Understanding the Document Viewer Task Flow"


	
Section 41.3, "Adding a Selected Folder or File to a Page"












Properties that are unique to the Document Viewer task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-8).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-8 Document Viewer Task Flow Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.8.1 Document Viewer Task Flow Parameters

Table 42-6 describes the parameters that are unique to the Document Viewer task flow.


Table 42-7 Document Viewer Task Flow Parameters

	Parameter	Description
	
Features Off

	
A list of disabled features for the task flow. Use commas or spaces to separate items. Valid values are exposed in the JavaDoc: checkin, checkout, clipboard, close, delete, download, dnd, editwiki, editoffice, newfolder, newwiki, rename, upload, multifile-upload, profile-upload, search, advancedSearch, workflow, properties, history, comments, likes, links, tags, recommendations, autovue, title, related-items, social, sidebars, ils.

Example:

${'search, advancedSearch, clipboard, dnd, rename, newfolder, upload, newwiki, checkin, checkout, editoffice, edithtml, delete, sidebars, history'}


	
Initial Sidebar

	
Specifies the tabbed pane to have initial focus in the Document Viewer. Valid values are:

	
${'comments'} (default). Displays the Comments pane (see "Section 41.19, "Viewing, Entering, and Deleting Comments on a File").


	
${'tags'}. Displays the Tags pane (see Section 41.20, "Working with Tags").


	
${'history'} (default). Displays the History pane (see Section 41.21, "Viewing and Deleting File Version History").


	
${'docInfo'}. Displays the Info pane (see Section 41.22, "Viewing and Modifying Folder and File Properties").


	
${'links'}. Displays the Links pane (see Section 41.23, "Working with Links").


	
${'autovue'}. When Oracle AutoVue is installed, displays the AutoVue pane showing the AutoVue markup for the current document in a table of hyperlinked markup names (see Section 45.3, "Collaborating on Documents Using Oracle AutoVue").




Note: Values are case-sensitive.


	
Item ID

	
The ID of the document to display in the Document Viewer.


	
Read Only

	
Specifies whether to disable and hide all content management operations:

	
Selected: Disable content management.


	
Cleared (default): Expose content management to users.

















42.9 Setting Document Mini Properties Task Flow Properties

The Document Mini Properties task flow displays the basic properties of a selected file in a read-only view. This choice is available for all file types.




	
See Also:

	
Section 41.1.8, "Understanding the Document Mini Properties Task Flow"


	
Section 41.3, "Adding a Selected Folder or File to a Page"


	
Section 41.22.2, "Working with File Properties"












Properties that are unique to the Document Mini Properties task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-9).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-9 Document Mini Properties Task Flow Properties

[image: Mini Properties Task Flow Component Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.9.1 Document Mini Properties Task Flow Parameters

Table 42-8 describes the parameters that are unique to the Document Mini Properties task flow.


Table 42-8 Document Mini Properties Task Flow Parameters

	Parameter	Description
	
Resource ID

	
The ID of the current document for which to display basic properties.














42.10 Setting Document Properties Task Flow Properties

The Document Properties task flow displays both Basic and Advanced properties of a selected file, along with an Edit button to modify property values. This choice is available for all file types.




	
See Also:

	
Section 41.1.9, "Understanding the Document Properties Task Flow"


	
Section 41.3, "Adding a Selected Folder or File to a Page"


	
Section 41.22.2, "Working with File Properties"












Properties that are unique to the Document Properties task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-11).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-10 Document Properties Task Flow Properties

[image: Document Properties Task Flow Component Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.10.1 Document Properties Task Flow Parameters

Table 42-8 describes the parameters that are unique to the Document Properties task flow.


Table 42-9 Document Properties Task Flow Parameters

	Parameter	Description
	
Item ID

	
The ID of the document for which to display properties.


	
Read Only

	
Specifies whether or not to allow end user to edit document properties:

	
Selected: Do not display Edit button in Basic and Advanced properties panes, thus disabling the ability for the end user to edit document properties.


	
Cleared (default): Display Edit button in Basic and Advanced properties panes, allowing end users to edit document properties.

















42.11 Setting Document Version History Task Flow Properties

The Document Version History task flow displays a list of versions of a selected file in a read-only view. This choice is available for all file types.




	
See Also:

	
Section 41.1.10, "Understanding the Document Version History Task Flow"


	
Section 41.3, "Adding a Selected Folder or File to a Page"


	
Section 41.21, "Viewing and Deleting File Version History"












Properties that are unique to the Document Version History task flow are shown on the Parameters tab of the Component Properties dialog (Figure 42-11).


Figure 42-11 Version History Task Flow Properties

[image: Version History Task Flow Component Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.11.1 Document Version History Task Flow Parameters

Table 42-8 describes the parameters that are unique to the Document Version History task flow.


Table 42-10 Document Version History Task Flow Parameters

	Parameter	Description
	
Horizontal Layout

	
Specifies the layout orientation for the version history information:

	
Selected: Horizontal orientation.


	
Cleared (default): Vertical orientation.





	
Item ID

	
The ID of the document for which to display version history.


	
Read Only

	
Specifies whether to disable and hide all content management operations:

	
Selected: Disable content management.


	
Cleared (default): Expose content management to users.

















42.12 Setting Document Link Component Properties

The Link component displays the file name of a selected file as a link on the page.




	
See Also:

Section 41.3, "Adding a Selected Folder or File to a Page"







Properties that are unique to the Link component are shown on the Display Options tab of the Component Properties dialog (Figure 42-4).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-12 Link Component Properties

[image: Link Component Properties]



For information about the properties on the Style tab, which is common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.12.1 Document Link Component Display Options

Table 42-11 describes the properties that are unique to the link component.


Table 42-11 Link Component Properties: Display Options

	Property	Description
	
Title

	
The display name of the selected file.

Default: file name.


	
Destination

	
Path to the file relative to the application root.

Example:

/resources/images/cologo.gif


	
Open in a new window

	
Specifies where the file opens:

	
Selected: Open file in new browser tab or window.


	
Cleared (default): Open file in current browser window.




This option is relevant only to files that open in a browser. Some files, such as Microsoft Word files, open in their native applications.


	
Show Component

	
Specifies whether to show or hide the link component on the page:

	
Selected (default): Show the link component.


	
Cleared: Hide the link component.




Once you hide a component in this way, any child components are also hidden. You can show the component again through Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.














42.13 Setting Document Inline Frame Component Properties

The Inline Frame component displays a preview of the file content of a selected file. This choice is available for HTML and TXT types.




	
See Also:

Section 41.3, "Adding a Selected Folder or File to a Page"







Properties that are unique to the inline frame component are shown on the Display Options tab of the Component Properties dialog (Figure 42-4).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-13 Inline Frame Component Properties

[image: Inline Frame Component Properties]



For information about the properties on the Style tab, which is common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.13.1 Document Inline Frame Component Display Options

Table 42-12 describes the properties that are unique to the inline frame component.


Table 42-12 Inline Frame (IFRAME) Component Properties: Display Options

	Property	Description
	
Short Desc

	
The ALT text to display when the mouse pointer hovers over the component.

The default is the name of the document.


	
Source

	
The path to the file relative to the Spaces application root. Example:

/resources/images/cologo.gif


	
Show Component

	
Specifies whether to show or hide the inline frame component on the page:

	
Selected (default): Show the inline frame component.


	
Cleared: Hide the inline frame component.




Once you hide a component in this way, any child components are also hidden. You can show the component again through Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.














42.14 Setting Document Image Component Properties

The Image component displays a selected file as an image on a page. This choice is available only for image file types (such as JPG, PNG, and GIF).




	
See Also:

Section 41.3, "Adding a Selected Folder or File to a Page"







Properties that are unique to the image component are shown on the Display Options tab of the Component Properties dialog (Figure 42-4).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 42-14 Image Component Properties

[image: Image Component Properties]



For information about the properties on the Style tab, which is common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



42.14.1 Document Image Component Display Options

Table 42-13 describes the properties that are unique to the image component.


Table 42-13 Image Component Properties: Display Options

	Property	Description
	
Image Map Type

	
The map type when the selected file is an image map. Choose from:

	
none


	
server





	
Long Desc URL

	
A URL to a file containing a description of the image.

Example:

http://www.abc.com/image_desc.htm


	
Short Desc

	
The ALT text to display when users hover their mouse pointers over the image component.

The default is Display Spaces Information. The default is the rendered value of the Expression Language (EL) expression #{uib_o_w_w_r_WebCenter.GLOBAL_LINK_ABOUT_DESC}.


	
Source

	
The path to the image file relative to the Spaces application root.

Example:

/resources/images/cologo.gif


	
Show Component

	
Specifies whether to show or hide the image component on the page:

	
Selected (default): Show the image component.


	
Cleared: Hide the image component.




Once you hide a component in this way, any child components are also hidden. You can show the component again through Composer Source view. Right-click the hidden component, and select Show Component from the context menu.

















43 Working with Workflow-Enabled Content

WebCenter Portal: Spaces includes the following types of workflows:

	
Internally-defined workflows, available through the Worklist service, are discussed in Chapter 70, "Working with the Worklist Service." For example, space moderators receive a workflow notification in their worklists for space subscription requests, or when a new file is checked in or uploaded to the space. The Oracle Fusion Middleware Installation Guide for Oracle WebCenter describes how to install and configure internally-defined workflows for Spaces.


	
Externally-defined workflows enabled in a Workflow server that comes with Oracle SOA Suite, also available through the Worklist service discussed in Chapter 70, "Working with the Worklist Service." The definition of these workflows is an administrative or development task in Oracle SOA Suite.


	
Workflows defined on space folders that reside in Content Server. When a folder is assigned a workflow, any file (including wiki documents and blog posts) checked in or uploaded to that folder must be approved or rejected by one or more assigned approvers. Documents service task flows, Content Presenter, and the Oracle Workflow Queue portlet from the Universal Content Management Portlet Suite provide access to the workflow-enabled content. This chapter discusses this type of workflow.




	
See Also:

For more information about working with workflows in the Content Server user interface, see the "Working with Workflows" chapter in Oracle Fusion Middleware User's Guide for Oracle Content Server.










The following sections describe how to work with workflows on content in a space:

	
Section 43.1, "What You Should Know About Content Workflows"


	
Section 43.2, "Assigning a Workflow to a Folder in a Space"


	
Section 43.3, "Viewing Files in Workflow"


	
Section 43.4, "Viewing Workflow Status and File Information"


	
Section 43.5, "Changing or Deleting a Workflow"


	
Section 43.6, "Participating in a Workflow"





Audience

This chapter is intended for Spaces users who want to assign and manage workflows on folders in a space when the connected content repository is Content Server.

You must have Document Administration permission to define workflow settings. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



43.1 What You Should Know About Content Workflows

Workflows on content in Spaces are available only when the connected content repository is Content Server and your Spaces administrator has completed the prerequisite configuration.




	
See Also:

For more information, see:
	
"Content Server Prerequisites" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal


	
"How to Create a Content Repository Connection Based on the Content Server Adapter" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal












A workflow provides for review and approval of a file before it is released to the system. The workflow notifies approvers through mail messages when they have a file to review and approve.

In Spaces, you can define workflows by assigning a workflow to a folder in a Documents service task flow. Out-of-the-box, Spaces includes three workflow types that you can assign to space folders (see Section 43.1.1, "Understanding Workflow Types"). These seeded workflows are available only to a folder in a space. They are not available to your personal folders in the Home space.

Once you assign a workflow to a folder in a space, Spaces automatically assigns the workflow to every file subsequently checked in or uploaded to the folder. Documents service task flows, the Content Presenter task flow, and the Oracle Workflow Queue portlet from the Universal Content Management Portlet Suite provide access to the workflow-enabled content.

In all Documents service task flows, any user with privileges to view the contents of a folder that is assigned a workflow can view the files while they are in a workflow, showing the pending changes. Content Presenter allows you to view both the published version of a content item (not showing the pending changes), and the pending changed version while it is in workflow. REST APIs, on the other hand, show only the published version of a file, and do not show the pending changes in unreleased versions of files that are in workflow.

The following sections provide conceptual information about workflow on files in Spaces:

	
Section 43.1.1, "Understanding Workflow Types"


	
Section 43.1.2, "Understanding Workflow Steps"


	
Section 43.1.3, "Understanding Workflow Process"






43.1.1 Understanding Workflow Types

Spaces provides three built-in workflows for content in a space. These are single-step workflows that allow one or more approvers to approve, reject, or edit a file in workflow:

	
AllApprover: A single-step workflow that requires all assigned approvers to approve the document to release it from workflow. Approvers of this workflow type are not able to edit the file while it is in worfklow.


	
AllReviewer: A single-step workflow that requires all assigned approvers to approve the document to release it from workflow. Approvers of this workflow type may optionally edit the file.


	
SingleApprover: A single-step workflow that requires only one assigned approver to approve the document to release it from workflow. Approvers of this workflow type are not able to edit the file while it is in workflow.







	
Note:

The seeded workflows are available only to a folder in a space. They are not available to your personal folders in the Home space.







For more information about configuring Content Server to enable the built-in workflows, see "What You Should Know About the WebCenterConfigure Component" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.






43.1.2 Understanding Workflow Steps

The three workflows provided with Spaces (AllApprover, AllReviewer, and SingleApprover) each contain a workflow contribution step and an approval step. Different users will typically participate in each of the steps.


Table 43-1 Workflow Steps

	Step Type	Description
	
contribution

	
This is the initial step of a workflow. In this step, the user who participates as the contributor is the Spaces user who submits the document or edits an existing document in a folder that has workflow enabled on it.


	
ApprovalStep

	
In this step, approvers can approve or reject the file. Editing is allowed by an approver during this step only if the workflow contains the step review the current revision or create new revisions' (in the seeded workflows, this applies only to the AllReviewer worfklow).












43.1.3 Understanding Workflow Process

The workflow process is as follows:

	
A document enters the workflow approval step by exiting the initial contribution step as a result of a new document upload or editing an existing document that was previously uploaded into a workflow-enabled folder. See Section 43.1.2, "Understanding Workflow Steps."


	
If any approver rejects a revision, it goes back to the most recent contribution step for editing.


	
When approvers approve a revision in the workflow, the content item is released to the system.











43.2 Assigning a Workflow to a Folder in a Space

With appropriate permissions (the Spaces administrator, or space members with Manage Configuration permissions), you can assign a workflow to a folder in a space when the connected content repository is Content Server. Once you assign a workflow to a space folder, Spaces automatically assigns the workflow to every file subsequently checked in or uploaded to the folder.

Out-of-the-box, Spaces includes three workflow types that you can assign to space folders (see Section 43.1.1, "Understanding Workflow Types"). These seeded workflows are available only to a folder in a space. They are not available to your personal folders in the Home space.

If you create a subfolder in a parent folder that is assigned a workflow, the subfolder automatically inherits the workflow assignment of the parent folder.

To assign a workflow to a folder:

	
On the Documents page or in a Documents service task flow in a space, create a new folder (see Section 41.7, "Creating a Folder"), or click in the row of an existing folder.




	
Note:

The Documents page is exposed in a space only with Content Server 11g. If the connected content repository is Content Server 10g, you can create a page in a space and add Documents service task flows to the page (see Section 41.4, "Adding a Documents Service Task Flow to a Page").








	
Click the View menu and choose Details, or right-click to display the folder's context menu and choose Details.

The Basic properties pane for the folder opens (Figure 43-1).


Figure 43-1 Folder Properties

[image: Folder Properties]



	
From the File menu, choose Workflow Settings.


	
In the Workflow Settings dialog, select from the Workflow Name list (Figure 43-2) to apply a workflow to the folder.




	
Note:

The selections in the Workflow Name list are preceded with the Spaces installation name used during the installation procedure.








Figure 43-2 Workflow Settings Dialog

[image: Workflow Settings Dialog]



For information about the out-of-the-box workflows, see Section 43.1.1, "Understanding Workflow Types." Additional workflows may be listed if they have been defined in Content Server and added by the system administrator. For more information about defining workflows, see the "Working with Workflows" chapter in Oracle Fusion Middleware User's Guide for Oracle Content Server.


	
After selecting a workflow name, click Add Approvers (Figure 43-3).




	
Note:

Spaces does not support group names as approvers.








Figure 43-3 Workflow Settings Dialog

[image: Workflow Settings Dialog]



	
In the Select User window, search for and select a user to whom to assign the workflow. Click OK. Repeat for all required approvers.


	
In the Workflow Settings dialog, click OK to save the workflow.




Every assigned approver receives a mail message to notify them that they are assigned to the workflow as document approvers. The format and contents of the mail message are controlled by how the system administrator installed and configured the Content Server.

With a workflow established on a folder in a space, Spaces automatically enters every file that is subsequently checked in or uploaded to the folder into workflow. If you want to assign the workflow to a file that was already in the space prior to the workflow being defined, you can save the file to your local file system, delete the file from the space, then reupload the file into the folder so that the file can inherit the workflow properties of the folder. See Section 41.8.1, "Uploading Files."

A workflow icon alongside a file in a Documents service task flow indicates that the file is assigned to a workflow (Figure 43-4). For more information, see Section 43.3, "Viewing Files in Workflow." Note that the only way to determine if a folder has a workflow defined on it is to view its workflow settings, as describedin the steps above.


Figure 43-4 Workflow Icon

[image: Workflow Icon]







43.3 Viewing Files in Workflow

You can view files in workflow and view workflow details in a Documents service task flow, Content Presenter task flow, or in an Oracle Workflow Queue portlet:

	
Section 43.3.1, "Viewing Workflow Files in a Documents Service Task Flow"


	
Section 43.3.2, "Viewing Workflow Files in a Content Presenter Task Flow"


	
Section 43.3.3, "Viewing Workflow Files in a Workflow Queue"






43.3.1 Viewing Workflow Files in a Documents Service Task Flow

On the Documents page or in a Documents service task flow in a space, a workflow icon alongside a file in a Documents service task flow indicates that the file is assigned to a workflow (Figure 43-5).


Figure 43-5 File in Workflow Showing Workflow Icon

[image: Workflow Icon]






	
Note:

The Documents page is exposed in a space only with Content Server 11g. If the connected content repository is Content Server 10g, you can create a page in a space and add Documents service task flows to the page (see Section 41.4, "Adding a Documents Service Task Flow to a Page").







To view a file that is in workflow:

	
Click the file name to open the file in the Document Viewer preview pane.

The Document Viewer preview pane displays workflow controls to show that the file is in workflow (Figure 43-6). The preview of the file shows the pending changes.


Figure 43-6 Document Viewer Preview Pane Showing File in Workflow

[image: Document Viewer Preview Pane Showing File in Workflow]



	
To view further details about the workflow, click Details to display the workflow information in Content Server (Figure 43-7).


Figure 43-7 Workflow Information in Content Server

[image: Workflow Information in Content Server]






	
Note:

To enable the availability of the workflow Details link in the Document Viewer preview pane, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the front-end to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.













	
If you are an approver or reviewer for the file, click Approve or Reject to indicate the result of your review of the file. These links are active only when the file is pending approval. If you reject the file, enter the justification for your rejection. For other ways to approve or reject a file, see Section 43.6.1, "Approving or Rejecting a File in Workflow."




	
Note:

To edit a file in workflow, the file must be associated with a workflow that contains the step review the current revision or create new revisions and you must be an approver for the workflow. The seeded workflow that meets these requirements is AllReviewers.










When a file in workflow is approved, it is released from workflow, and the workflow icon no longer displays for the file (Figure 43-8). If you edit the file and make further changes, it will return to workflow.


Figure 43-8 File Released From Workflow Showing No Workflow Icon

[image: File Released From Workflow Showing No Workflow Icon]



When a file in workflow is rejected, it remains in workflow, returning to the contribution step. It must be updated by the file owner for the Approve and Reject controls to display.






43.3.2 Viewing Workflow Files in a Content Presenter Task Flow

You can view content items displayed in Content Presenter while they are in a workflow, including Site Studio contributor data files displayed in a Site Studio region template. As long as the content item has at some point had Released status in Content Server, you can display the content item in Content Presenter. Then, if a revision of the content item is pending in workflow, Content Presenter allows approvers for the content item to toggle between the published version and the version in workflow in page edit mode or in-context edit (contributor) mode, and also provides links to approve or reject the item in workflow, and view additional details about the item.

To view a file in workflow in Content Presenter:

	
Add a Content Presenter task flow to a page (see Section 40.2, "Adding a Content Presenter Task Flow to a Page"), selecting the file that is in workflow.


	
To view the current workflow state of the file in Content Presenter, view the page in edit mode (Figure 43-9), or view the file in in-context edit (contributor) mode (Figure 43-10).

Content Presenter displays workflow controls to show that the file is in workflow. The initial view of the the file shows the published version of the file.




	
See Also:

To view the page in edit mode, or view the file in in-context edit (contributor) mode, respectively, see:
	
Section 17.3.1, "Entering and Exiting Page Edit Mode"


	
Section 40.10, "Creating and Editing Files In-Context in a Content Presenter Task Flow"













Figure 43-9 Page Edit Mode: Workflow Controls in Content Presenter

[image: Page Edit Mode: Workflow Controls in CP]




Figure 43-10 In-Context Edit (Contributor) Mode: Workflow Controls in Content Presenter

[image: In-Context Edit (Contributor) Mode: Worfklow Controls in CP]



	
To view further details about the workflow, click Details to display the workflow information in Content Server (including workflow name, steps performed, action performed, date of action, and who performed the action).




	
Note:

To enable the availability of the workflow Details link in the Document Viewer preview pane, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the front-end to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.













	
If you are a workflow approver, click Preview pending changes to preview the changes to the file, then Approve or Reject the changes in either page edit mode (Figure 43-11), or in-context edit (contributor) mode (Figure 43-12). These links are active only when the file is pending approval. If you reject the file, enter the justification for your rejection. For other ways to approve or reject a file, see Section 43.6.1, "Approving or Rejecting a File in Workflow."


Figure 43-11 Page Edit Mode: Preview File in Workflow to Approve or Reject in Content Presenter

[image: Page Edit Mode: Approve or Reject in CP]




Figure 43-12 In-Context Edit (Contributor) Mode: Preview File in Workflow to Approve or Reject in Content Presenter

[image: In-Context Edit Mode: Approve or Reject in CP]





When a file in workflow is approved, it is released from workflow, and the workflow controls no longer display in Content Presenter. If you edit the file and make further changes, it will return to workflow and the workflow controls will display again.

When a file in workflow is rejected, it remains in workflow, returning to the contribution step. It must be updated by the file owner for the Approve and Reject controls to display.






43.3.3 Viewing Workflow Files in a Workflow Queue

If you have Content Portlet Suite installed, you can add the Oracle Workflow Queue portlet to a page to list the files in workflow, along with details about each workflow. For information about how to deploy Content Portlet Suite, see Oracle Fusion Middleware Deployment Guide for Content Portlet Suite.

To add the Oracle Workflow Queue portlet to a page:

	
Create a new page in a space or go to the page where you want to add the portlet, and open the page in edit mode.




	
See Also:

For more information, see Section 51.7.2, "Creating a Page in a Space" and Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content to open the Resource Catalog.


	
Locate the Oracle Workflow Queue portlet in the Resource Catalog.




	
Tip:

The presence or location of the Oracle Workflow Queue portlet depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, click Portlets, then <Host> Portlets to locate the Oracle Workflow Queue portlet.








	
Click Add next to the Oracle Workflow Queue portlet to add it to the page, then Close the Resource Catalog.

On the page, the Oracle Workflow Queue portlet (Figure 43-13) displays a list of all the files in workflow assigned to you to approve or reject.


Figure 43-13 Oracle Workflow Queue Portlet

[image: Oracle Workflow Queue Portlet]





In the Oracle Workflow Queue portlet, you can perform the following actions if you have appropriate permissions:

	
In the Title column, click a file name to open it in its native application.


	
In the Workflow Info column, click a link to display the Workflow Step Information pane, which provides steps required to complete the workflow, the current step, the number of approvals required, and the remaining reviewers. For more information, see Section 43.4.1, "Viewing Detailed Workflow Status."


	
In the Actions column, click Approve or Reject to indicate the result of your review of the file. These links are active only when the file is pending approval. If you reject the file, enter the justification for your rejection. For other ways to approve or reject a file, see Section 43.6.1, "Approving or Rejecting a File in Workflow."


	
In the Info column, click the Content Information icon to display the Content Info pane, which provides access to actions you can perform, file metadata information, and revision history. For more information, see Section 43.4.2, "Viewing Content Information and Actions."











43.4 Viewing Workflow Status and File Information

As an approver or owner of a file in workflow, you may want to get more information about the current state of the workflow, details about the file itself, or perform file management actions to update or share the file to advance its approval:

	
Section 43.4.1, "Viewing Detailed Workflow Status"


	
Section 43.4.2, "Viewing Content Information and Actions"






43.4.1 Viewing Detailed Workflow Status

To view the details of the workflow status of a file:

	
Go to the Oracle Workflow Queue portlet that lists the file.

To add an Oracle Workflow Queue portlet to a page, see Section 43.3.3, "Viewing Workflow Files in a Workflow Queue."


	
In the Workflow Info column, click the workflow step link to display the Workflow Step Information pane (Figure 43-14), which includes the steps required to complete the workflow, the current step, the number of approvals required, and the remaining reviewers. For information about workflow steps, see Section 43.1.2, "Understanding Workflow Steps."


Figure 43-14 Workflow Step Information
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Click Back to return to the Oracle Workflow Queue portlet.









43.4.2 Viewing Content Information and Actions

To display a Content Info pane that provides details about a file in workflow and perform file management actions to update or share the file to advance its approval:

	
Go to the Oracle Workflow Queue portlet that lists the file.

To add an Oracle Workflow Queue portlet to a page, see Section 43.3.3, "Viewing Workflow Files in a Workflow Queue."


	
In the Info column, click the Content Information icon to display the Content Info pane (Figure 43-15), which provides access to actions you can perform, file metadata information, and revision history. For more information, see "Content Information Page" in Oracle Fusion Middleware User's Guide for Oracle Content Server.


Figure 43-15 Content Info Pane

[image: Content Info Pane]



	
Optionally, from the Actions list, choose any of the following actions:

	
Check Out to check the file out so that you can lock it from changes by other contributors while you are making updates.


	
Update to display the Info Update Form, where you can update editable metadata of the file without creating a new revision of the file. Only the Spaces administrator, space members with Manage Configuration permissions, or file owners can edit the file properties. For more information, see "Info Update Form" in Oracle Fusion Middleware User's Guide for Oracle Content Server.


	
Check in Similar to display the Content Check In Form, where you can update editable metadata of the file and check the file in to Content Server. Only the Spaces administrator, space members with Manage Configuration permissions, or file owners can edit the metadata properties. For more information, see "Content Check-In Form" in Oracle Fusion Middleware User's Guide for Oracle Content Server.


	
Send link by e-mail to open your e-mail application with a new message that contains a link to the URL of the web-viewable file, which you can mail to other users with requests for input or review to further the approval of the file.





	
Click Back to return to the Oracle Workflow Queue portlet.











43.5 Changing or Deleting a Workflow

With appropriate permissions (the Spaces administrator, or space members with Manage Configuration permissions), you can change or delete the workflow assigned to a folder in a Documents service task flow when the connected content repository is Content Server.

To change or delete the workflow assigned to a folder:

	
On the Documents page or in a Documents service task flow in a space, click in the row of the folder.




	
Note:

The Documents page is exposed in a space only with Content Server 11g. If the connected content repository is Content Server 10g, you can create a page in a space and add Documents service task flows to the page (see Section 41.4, "Adding a Documents Service Task Flow to a Page").








	
Follow the steps in Section 43.2, "Assigning a Workflow to a Folder in a Space":

	
To change the workflow, choose a different workflow from the Workflow Name list, and optionally add or delete approvers.


	
To delete the workflow, choose <None> from the Workflow Name list.




	
Note:

If you change or delete the workflow assigned to a folder, the files that were previously in that folder remain assigned to the prior workflow. Only files that are subsequently checked in or uploaded to the folder inherit the new workflow settings.


















43.6 Participating in a Workflow

The workflow process is as follows:

	
A document enters the workflow approval step by exiting the initial contribution step as a result of a new document upload or the editing of an existing document that was previously uploaded into a workflow-enabled folder.


	
If any reviewer rejects a revision, it goes back to the contribution step for editing.


	
When a revision is approved at the last step in the workflow, the content item is released to the system.




The following sections describe how to work with a file through the workflow process:

	
Section 43.6.1, "Approving or Rejecting a File in Workflow"


	
Section 43.6.2, "Working with a Rejected Revision"






43.6.1 Approving or Rejecting a File in Workflow

As an assigned approver for a workflow, you will need to review and either approve or reject the files to which you are assigned. A file is released from workflow when it is approved in accordance with its workflow type (see Section 43.1.1, "Understanding Workflow Types").

To approve or reject a file in workflow:

	
View the files for which you are an assigned approver in either of the following ways:

	
In the Document Viewer preview pane, as described in Section 43.3.1, "Viewing Workflow Files in a Documents Service Task Flow."


	
In a Content Presenter task flow, as described in Section 43.3.2, "Viewing Workflow Files in a Content Presenter Task Flow."


	
In an Oracle Workflow Queue portlet, as described in Section 43.3.3, "Viewing Workflow Files in a Workflow Queue."





	
Click Approve or Reject to indicate the result of your review of the file. These links are active only when the file is pending approval. If you reject the file, enter the justification for your rejection.




When a file in workflow is approved, it is released from workflow, and the workflow icon no longer displays for the file (Figure 43-16). If you edit the file and make further changes, it will return to workflow.


Figure 43-16 File Released From Workflow Showing No Workflow Icon

[image: File Released From Workflow Showing No Workflow Icon]



When a file in workflow is rejected, it remains in workflow, but must be updated by the file owner for the Approve and Reject controls to display.






43.6.2 Working with a Rejected Revision

If a file in workflow is rejected, it remains in workflow and returns to the original submitter in the contribution workflow step. The contributor can then revise the file and save it. After saving, the file automatically moves back into the workflow approval step again to be approved or rejected by assigned approvers.











44 Creating and Managing Content at Runtime

End users of a WebCenter Portal: Spaces application can create and manage content at runtime using the content task flows:

	
The Documents service task flows offer capabilities to create, open, edit, delete, copy, rename, move, share, search, view, and manage information about folders and files in any connected content repository, including wikis and blogs. For more information about the Documents service task flows, see Section 41.1, "What You Should Know About the Documents Service Task Flows."


	
In a Content Presenter task flow, end users can edit wiki documents, HTML files, or Site Studio files in-context, and create new Site Studio files in the connected Content Server content repository. For more information about the Content Presenter task flow, see Section 40.1, "What You Should Know About the Content Presenter Task Flow."




This chapter offers pointers to the information that will assist you in creating and managing content at runtime using the content task flows.

To create and manage content at runtime using one of the Documents service task flows, refer to the steps in the following sections:

	
Section 41.6, "Personalizing Your View"


	
Section 41.9, "Opening a Folder"


	
Section 41.10, "Opening a File"


	
Section 41.7, "Creating a Folder"


	
Section 41.8.1, "Uploading Files"


	
Section 41.8.2, "Creating a Wiki Document"


	
Section 41.12.1, "Checking a File Out"


	
Section 41.12.2, "Downloading a File"


	
Section 41.13, "Renaming a Folder or File"


	
Section 41.14, "Copying and Pasting Folders and Files"


	
Section 41.15, "Moving Folders and Files"


	
Section 41.16, "Deleting Folders and Files"


	
Section 41.17, "Refreshing Folder Contents"


	
Section 41.18, "Hiding and Showing Folders"


	
Section 41.19, "Viewing, Entering, and Deleting Comments on a File"


	
Section 41.20, "Working with Tags"


	
Section 41.21, "Viewing and Deleting File Version History"


	
Section 41.22, "Viewing and Modifying Folder and File Properties"


	
Section 41.23, "Working with Links"


	
Section 41.24, "Working with Recommendations"


	
Section 41.25, "Opening or Saving PDF Files"


	
Section 41.26, "Sharing the URL for a Folder or File"


	
Section 41.27, "Setting Security Options on a Folder or File"


	
Section 41.28, "Subscribing to a File"


	
Section 41.29, "Liking and Unliking a File"


	
Section 41.31, "Searching for Documents"




To create and manage content at runtime using Content Presenter, refer to the steps in the following sections:

	
Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog"


	
Section 40.10.1, "Editing Wiki Documents or HTML Files In-Context"


	
Section 40.10.2, "Editing Site Studio Files In-Context"


	
Section 40.10.3, "Creating New Site Studio Content In-Context"










45 Collaborating on Documents

Almost every enterprise spends a lot of time collaborating on documents. This includes joint authoring, sharing, reviewing, approving, editing, and so on. WebCenter Portal: Spaces provides several ways to collaborate on documents, both during the development of a document, or when a document is available to all users of a Spaces application:

	
Section 45.1, "Collaborating on Documents Using the Documents Service"


	
Section 45.2, "Collaborating on Documents through Workflows"


	
Section 45.3, "Collaborating on Documents Using Oracle AutoVue"







	
Note:

The Documents service is exposed on the Documents page and administration settings in a space only with Content Server 11g. If the connected content repository is Content Server 10g, the Documents page is not shown in a space, and the Documents service is not available in the space administration settings (Services and Roles). To use the Documents service functionality in 10g, you can create a page in a space and add Documents service task flows to the page.








Audience

This chapter is intended for Spaces users interested in sharing and collaborating on documents in a Spaces application.



45.1 Collaborating on Documents Using the Documents Service

The Documents service provides features for accessing, adding, and managing folders and files; configuring and viewing file and folder properties; and searching file and folder content in the connected content repositories.

Within the context of managing documents, the Documents service provides features for collaborating on documents. These features include:

	
Viewing a document in-place. See Section 41.10, "Opening a File."


	
Tagging a document. See Section 41.20, "Working with Tags."


	
Linking to supporting documents. See Section 41.23, "Working with Links."


	
Viewing recommendations for similar documents. See Section 41.24, "Working with Recommendations."


	
Commenting on a document. See Section 41.19, "Viewing, Entering, and Deleting Comments on a File."


	
Sharing the link to a document. See Section 41.26, "Sharing the URL for a Folder or File."


	
Subscribing to a document. See Section 41.28, "Subscribing to a File."


	
Liking a document. See Section 41.29, "Liking and Unliking a File."


	
Adding a document to your list of favorites. See Section 41.30, "Adding a Folder or File to Your Favorites."


	
Adding wiki documents to a Spaces application, allowing multiple users to collaborate to create content that is relevant, useful, and up-to-date. See Chapter 47, "Working with Wiki Documents."


	
Adding blogs to record experiences and opinions, and allowing multiple users to contribute through blog posts. See Chapter 48, "Working with Blogs."









45.2 Collaborating on Documents through Workflows

While a document is being developed, it must typically be reviewed and approved by a number of people. To assist in managing this process, Spaces provides a built-in workflow capability to move a document through required approvals by assigned approvers. This capability is available when the connected content repository is Content Server.

For information about assigning, viewing, updating, and participating in document workflows, see Chapter 43, "Working with Workflow-Enabled Content."






45.3 Collaborating on Documents Using Oracle AutoVue

In addition to the wide range of functionality offered by Spaces to manage and collaborate on documents through workflows, wiki documents, and spaces, you also have the option to use Oracle AutoVue.




	
Note:

To enable Oracle AutoVue functionality, both of the following two requirements must be met:
	
You must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the frontend to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Spaces must be connected to a Content Server repository, with the webContextRoot parameter set to a Content Server host name. For information on setting webContextRoot, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. To set webContextRoot through WLST, see "createJCRContentServerConnection" and "setJCRContentServerConnection" in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.












Oracle AutoVue, packaged separately from Spaces, integrates easily with a Content Server back-end repository to provide document review and collaboration features. AutoVue supports a wide range of file types, including Word, Excel, PDF, as well as 2D and 3D CAD file types. For more information about Oracle AutoVue, see http://www.oracle.com/applications/autovue/index.html.

To use Oracle AutoVue to review and collaborate on a file:

	
In the Document Viewer preview pane, click the File menu and choose Annotate with AutoVue.

The Content Server login screen opens.


	
Log in to Content Server to open the file in the AutoVue file viewer, where you can provide comments and individualized mark-up.


	
To view the file containing the AutoVue markup, click the AutoVue icon in the Document Viewer preview pane Sidebar (Figure 45-1).


Figure 45-1 AutoVue Icon

[image: AutoVue icon]













46 Working with Microsoft Office and Explorer Integration

WebCenter Portal: Spaces integrates with Microsoft Office and Windows Explorer to provide you with flexibility in managing files in a space when the content repository is Content Server.




	
Note:

The Documents service is exposed on the Documents page and administration settings in a space only with Content Server 11g. If the connected content repository is Content Server 10g, the Documents page is not shown in a space, and the Documents service is not available in the space administration settings (Services and Roles). To use the Documents service functionality in 10g, you can create a page in a space and add Documents service task flows to the page.







The differences in Microsoft Office 2003, 2007, and 2010 mean that each version may support a particular feature in a different way, and one or more versions may not support some of the tasks described in this chapter. Each section in this chapter provides information about which Microsoft Office version supports the task described, and how that support is implemented, where there are differences.

This chapter includes the following sections:

	
Section 46.1, "What You Should Know About Microsoft Office and Explorer Integration"


	
Section 46.2, "Configuring Microsoft Office Integration with Spaces"


	
Section 46.3, "Working with Microsoft Word, PowerPoint, and Excel Integration"


	
Section 46.4, "Working with Microsoft Windows Explorer Integration"





Audience

This chapter is intended for Spaces users interested in using Microsoft Office applications and Windows Explorer to manage information in a space.



46.1 What You Should Know About Microsoft Office and Explorer Integration

This following sections provide an overview of the added functionality provided by integration with Microsoft Office and Windows Explorer:

	
Section 46.1.1, "Understanding Microsoft Office Word, PowerPoint, and Excel Integration"


	
Section 46.1.2, "Understanding Microsoft Windows Explorer Integration"






46.1.1 Understanding Microsoft Office Word, PowerPoint, and Excel Integration

Using the Microsoft Office shared document management functionality, you can work with Word, PowerPoint, or Excel files in any space, including the Home space, from the task pane in the Office application. This functionality is available in Microsoft Office 2003 and later, when the backend content repository is Content Server.




	
Note:

The differences in Microsoft Office 2003, 2007, and 2010 mean that each version may support a particular feature in a different way, and one or more versions may not support some of the tasks described in this chapter. Each section provides information about which version supports the task described, and how that support is implemented, where there are differences.







Microsoft Office shared document management functionality offers alternate ways to perform tasks that can also be performed within Spaces, as summarized in Table 46-1.


Table 46-1 File Management Tasks

	Task	Microsoft Office Document Management	Spaces Application
	
Opening a file.

	
See Section 46.3.2, "Opening and Editing a File."

	
See Section 41.10, "Opening a File."


	
Editing a file.

	
See Section 46.3.2, "Opening and Editing a File."

	
See Section 41.12, "Editing and Updating a File."


	
Adding a new file to a space.

	
See Section 46.3.4.1, "Adding a File."

	
See:

	
Section 41.14, "Copying and Pasting Folders and Files."


	
Section 41.8.1, "Uploading Files."





	
Adding a new folder to a space.

	
See Section 46.3.4.2, "Adding a New Folder."

	
See Section 41.7, "Creating a Folder."


	
Checking a file out and in.

	
See Section 46.3.4.3, "Checking a File Out" and Section 46.3.4.4, "Checking a File In."

	
See Section 41.12.1, "Checking a File Out."


	
Performing actions on the currently open file.

	
See Section 46.3.4.5, "Managing the Currently Open File."

	
See Chapter 41, "Working with the Documents Service Task Flows and Document Components."


	
Performing actions on other files in the current folder.

	
See Section 46.3.4.6, "Managing Other Files in the Current Space."

	
See Chapter 41, "Working with the Documents Service Task Flows and Document Components."


	
Performing actions on subfolders in the current folder.

	
See Section 46.3.4.7, "Managing Folders."

	
See Chapter 41, "Working with the Documents Service Task Flows and Document Components."


	
Viewing link targets.

	
See Section 46.3.4.8, "Viewing Link Targets."

	
See Section 63.2.3, "Accessing Link Targets."


	
Working with file version histories.

	
See Section 46.3.4.10, "Working with File Version History."

	
See Section 41.21, "Viewing and Deleting File Version History."


	
Adding new members to a space.

	
See Section 46.3.4.11, "Adding Members to a Space."

	
See Section 51.14.4, "Granting Spaces Users Access to a Space."


	
Sending a mail message.

	
See Section 46.3.4.12, "Sending a Message."

	
See:

	
Section 41.26.2, "Mailing the URL for a Folder or File"


	
Section 65.1, "What You Should Know About the Send Mail Feature"


	
Section 65.4.6, "Composing and Sending Mail Messages."















46.1.2 Understanding Microsoft Windows Explorer Integration

In Windows Explorer, you can manage the folders and files in a space when the backend content repository is Content Server. To use this functionality, you create a network place in Windows Explorer for the space documents. See Section 46.4, "Working with Microsoft Windows Explorer Integration."








46.2 Configuring Microsoft Office Integration with Spaces

To allow for full integration of Microsoft Office with Spaces, you must access the Spaces application through Oracle HTTP Server (OHS) to expose Content Server and the Spaces application under the same host and port. For information about setting up OHS as the front-end to Spaces, see "Content Server - Configuration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Additionally, your Spaces administrator must modify system properties and server configuration files, and set up a virtual host for your Spaces application. These configuration requirements are described in "Configuring SSO with Virtual Hosts" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.






46.3 Working with Microsoft Word, PowerPoint, and Excel Integration

Spaces integrates with the Microsoft Office shared document management functionality for working with Microsoft Word, Excel, or PowerPoint files. This functionality is available in Microsoft Office 2003 and later, when the backend content repository is Content Server. For more information, see Section 46.1.1, "Understanding Microsoft Office Word, PowerPoint, and Excel Integration."

Many of the tasks you can perform using the Microsoft Office shared document management functionality can also be performed in Spaces, as shown in Table 46-1, and described in Chapter 41, "Working with the Documents Service Task Flows and Document Components."

This section provides steps to perform the following tasks using Microsoft Office shared document management:

	
Section 46.3.1, "Creating a Space from a Microsoft Office Document"


	
Section 46.3.2, "Opening and Editing a File"


	
Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane"


	
Section 46.3.4, "Working with the Microsoft Office Task Pane"

	
Section 46.3.4.1, "Adding a File"


	
Section 46.3.4.2, "Adding a New Folder"


	
Section 46.3.4.3, "Checking a File Out"


	
Section 46.3.4.4, "Checking a File In"


	
Section 46.3.4.5, "Managing the Currently Open File"


	
Section 46.3.4.6, "Managing Other Files in the Current Space"


	
Section 46.3.4.7, "Managing Folders"


	
Section 46.3.4.8, "Viewing Link Targets"


	
Section 46.3.4.9, "Viewing Document Information"


	
Section 46.3.4.10, "Working with File Version History"


	
Section 46.3.4.11, "Adding Members to a Space"


	
Section 46.3.4.12, "Sending a Message"





	
Section 46.3.5, "Closing a File"







	
Note:

Spaces does not implement administrative features of the Microsoft Office shared document management functionality, such as creating a workspace using the task pane, deleting a workspace, or changing a workspace title.









46.3.1 Creating a Space from a Microsoft Office Document




	
Note:

This feature is available only in Microsoft Office 2007. It is not available in Microsoft Office 2003 or 2010.







With Microsoft Office 2007, you can create a space from a Microsoft Office document, as long as your permissions on the document are the same as your permissions in Spaces.

To create a space from a Microsoft Office document:

	
If you are using Internet Explorer as a browser, add Spaces to your list of trusted sites in the browser settings.


	
In the Microsoft Office document, click the Office Button (Figure 46-1) in the top left corner of the Microsoft Office application.


Figure 46-1 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]



	
From the Publish menu, choose Create Document Workspace (Figure 46-2).


Figure 46-2 Creating a Space from an Office Document

[image: Creating a Space from an Office Document]



	
The Microsoft Office application displays the Document Management task pane, displaying the file name as the default workspace name.




	
Note:

If the pane does not display, see Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane."








Figure 46-3 Document Management Task Pane: Document Workspace

[image: Document Management Task Pane: Document Workspace]



	
In the Document Workspace name field, type a name for the space if you want to change the default name.


	
In the Location for new workspace field, type the Explorer URL for the Spaces instance. For example:


http://myserver.oracle.com:8888/wcsdocs/conn/myserver-ucm11g/spaces
/WebCenter/


You can find this URL in the About Space dialog for an existing space, as described in Section 49.5, "Viewing Information About a Space."


	
Click Create.


	
At the prompt, enter your Spaces login credentials.




Spaces creates the new space in Spaces.

In Microsoft Office, the Status section of the Microsoft Office task pane (see Table 46-2) displays one of the following status messages:


This document is up to date.  If you have unsaved changes, you must save the document before you can update the workspace copy.

A copy of this document is stored in a Document Workspace.  Changes made to your document have not been udpated in the workspace copy.


If you update the document in Microsoft Office, you can simply click the Update Workspace Copy link to synchronize the document with the version in the space (on the server).






46.3.2 Opening and Editing a File

When you open a Microsoft Office file from Spaces, the file is automatically checked out of the Content Server repository. When you refresh the page in Spaces, the Status column for the file shows a Checked Out icon. To make your changes available to other users, you can save and close it in Microsoft Office, or explicitly check the file in using the Microsoft Office task pane.

To open a Microsoft Word, Excel, or PowerPoint file from Spaces in-place in its Microsoft Office application:




	
Note:

If you are using Windows 7 or a 64-bit machine with Firefox 3.6, you may need to install the Java plugin available at http://support.mozilla.com to edit a Microsoft Office file. This plugin is included in Java 6 Update 15 and above.







	
On the Documents page, or in a Documents service task flow on a page, click in the row of the file you want to edit, but not on the file name.

Alternatively, you can edit an open file in the Document Viewer preview pane.


	
Depending on your view and the file type, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, from the File menu or the context (right-click) menu, choose the Edit action that opens the file in-place in its Microsoft Office application. For example, for Microsoft Word files, choose Edit with Word (Figure 46-4)


Figure 46-4 Open a File in Microsoft Word

[image: Open a Document in Microsoft Word]



	
In the Document Viewer preview pane, click the Edit action.







	
Note:

If the file is already checked out by another user, the File in Use dialog opens. See Section 46.3.2.1, "Opening a File Already Checked Out By Another User."








	
If prompted, enter the same credentials used to log in to Spaces to open the file in-place in its corresponding application.




	
Note:

The user name and password must contain only ASCII characters. A user name or password containing multi-byte characters cannot be successfully authenticated.







	
In Microsoft Office 2003. The Microsoft Office application displays a Shared Workspace task pane by default (Figure 46-5).


	
In Microsoft Office 2007. The Microsoft Office application displays no task pane by default. To display the Document Management task pane, see Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane."





Figure 46-5 Microsoft Office 2003 Shared Workspace Task Pane

[image: Microsoft Office 2003 Shared Workspace Task Pane]



	
When the file opens, it is automatically checked out. In Spaces, click the Refresh icon to show the Checked Out icon for the selected file (Figure 46-6).


Figure 46-6 Checked Out Icon in Spaces

[image: Checked Out Icon in WebCenter Spaces]



	
Make required updates, then save and close the file.

The modified file is automatically checked back in.




You can use the Microsoft Office task pane to open other files in the space directly from Microsoft Office, instead of from Spaces. See Section 46.3.4.6, "Managing Other Files in the Current Space."



46.3.2.1 Opening a File Already Checked Out By Another User

If the file that you attempt to open is already checked out by another user, the File In Use dialog opens (Figure 46-7).


Figure 46-7 File in Use Dialog

[image: File in Use Dialog]



In the File In Use dialog, select the desired option:

	
Open a Read Only copy to open the file in its default application to view it.


	
Create a local copy and merge your changes later is not supported.


	
Receive notification when the original copy is available to open a read-only copy of the file until it is available for editing. When the file is available, the File Now Available dialog (Figure 46-8) notifies you; in the dialog, click Read-Write to change the read-only state to editable.


Figure 46-8 File Now Available Dialog

[image: File Now Available Dialog]












46.3.3 Displaying and Hiding the Microsoft Office Task Pane




	
Note:

The Microsoft Office task pane is available only in Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







In Microsoft Office 2003, the task pane displays by default when you open a file, whereas in Microsoft Office 2007, the task pane does not display by default.

You can manage the display of the Microsoft Office task pane as described in the following sections:

	
Section 46.3.3.1, "Displaying or Hiding the Task Pane Manually"


	
Section 46.3.3.2, "Displaying or Hiding the Task Pane By Default"






46.3.3.1 Displaying or Hiding the Task Pane Manually

To display or hide the Microsoft Office task pane manually:

In Microsoft Office 2003:

	
From the Tools menu, choose Shared Workspace to toggle between displaying and hiding the task pane.




In Microsoft Office 2007:

	
Click the Office Button (Figure 46-9) in the top left corner of the Microsoft Office application.


Figure 46-9 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]



	
From the Server menu, choose Document Management Information to toggle between displaying and hiding the Document Management task pane (Figure 46-10).


Figure 46-10 Microsoft Office 2007 Document Management Task Pane

[image: MS Office 2007 Document Management Task Pane]










46.3.3.2 Displaying or Hiding the Task Pane By Default

To display or hide the Microsoft Office task pane automatically by default every time you open a Microsoft Word, Excel, or PowerPoint file:

In Microsoft Office 2003:

	
From the Tools menu, choose Options.


	
In the Options dialog, on the General tab, click Service Options.


	
In the Shared Workspace category, select or clear the checkbox The document is part of a workspace or SharePoint site to respectively display or hide the task pane by default.




In Microsoft Office 2007:

	
At the bottom of the Microsoft Office task pane, click Options (Figure 46-11).


Figure 46-11 Options Link in Task Pane (Microsoft Office 2007)

[image: Options Link in Task Pane]



	
In the Service Options dialog, select or clear the checkbox The document is part of a workspace or SharePoint site to respectively display or hide the task pane by default.











46.3.4 Working with the Microsoft Office Task Pane




	
Note:

The Microsoft Office task pane is available only in Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







The Microsoft Office task pane provides information pertaining to the currently open file and access to tasks for all folders and files in the current space, as described in Table 46-2.


Table 46-2 Microsoft Office Task Pane for Files in a Space

	Task Pane Area	Description
	
Top section in Microsoft Office 2003:

[image: Task pane top section 2003]
Top section in Microsoft Office 2007:

[image: Task pane top section 2007]
Dropdown menu:

[image: Task pane top section dropdown menu]	
For a file in the Home space:

	
Shows the user name.


	
Open site in browser. Click to display the Spaces Home page.




For a file in a space:

	
Shows the space name.


	
Open site in browser. Click to display the space Home page.




Additionally, the top section provides a dropdown menu of actions available for the user or space:

	
Open Site in Browser. See above.


	
Change Site Title. Not supported.


	
Change Site Settings. For the Home space, displays the Spaces Home page; for a space, displays the Settings tab of the space.


	
Disconnect from Workspace. Not supported.


	
Delete Workspace. Not supported.





	
Status section in Microsoft Office 2003:

[image: Task pane Status section 2003]
Status section in Microsoft Office 2007:

[image: Task pane Status section 2007]
Dropdown menu:

[image: Task pane Status section menu]	
Displays information only if the file is checked out.

Shows the following information:

	
The user who checked out the file.


	
Check in link. See Section 46.3.4.4, "Checking a File In."

After checking a file in, you can subsequently check the file out again. See Section 46.3.4.3, "Checking a File Out."




Additionally, the Status section provides a dropdown menu of actions available for the user:

	
Schedule a Meeting. Opens the Microsoft Outlook calendar scheduler.


	
Call. Not supported.


	
Send Mail. Opens a Microsoft Outlook message with the To field populated with the mail address that is specified for the user in Spaces. See Section 46.3.4.12, "Sending a Message." This selection has the same effect as clicking the user name in the Members section.


	
Additional Actions. Not supported.


	
Add to Outlook Contacts. Opens the Microsoft Outlook Contacts page populated with contact information for the user.


	
Outlook Properties. Opens the Microsoft Outlook E-mail Properties dialog.





	
Members section:

[image: Task Pane Members section]
Dropdown menu:

[image: Task pane Members section menu]	
For a file in the Home space:

	
Lists the current people connections.


	
Add new members. Not supported for Home space.


	
Send e-mail to all members. See Section 46.3.4.12, "Sending a Message."




For a file in a space:

	
Lists the user editing the file, followed by the user and group names of all space members, up to the limit of 99 members. The distinction between Online and Not Online users is not supported; all space members show in the list as Not Online.


	
Add new members. See Section 46.3.4.11, "Adding Members to a Space."


	
Send e-mail to all members. See Section 46.3.4.12, "Sending a Message."




Additionally, the Members section provides a dropdown menu of actions available for the listed member(s). The actions in this menu are not supported.

To send a message to any member, simply click the member's user name to open a Microsoft Outlook window with the To field populated with the mail address that is specified for the member in Spaces.


	
Tasks section:

[image: Task pane Tasks section]	
Not supported.


	
Documents section:

[image: Task pane Documents section]	
Provides access to other files in the current space directly from Microsoft Office.

Sort by. Choose from the menu to sort the list of documents by Creation Date, Modified Date, File Name, File Type, Ascending, or Descending.

	
Shows all folders and files in the folder where the open file resides. See Section 46.3.4.6, "Managing Other Files in the Current Space."

Note: Navigating upward in the folder hierarchy from the current document is not supported; you can drill down and then back up to the current level.


	
Provides a menu of actions available on the currently open file. See Section 46.3.4.5, "Managing the Currently Open File."


	
Provides a menu of actions available on other documents in the list. See Section 46.3.4.6, "Managing Other Files in the Current Space."


	
Provides a menu of actions for each folder listed. See Section 46.3.4.7, "Managing Folders."


	
Add new document. See Section 46.3.4.1, "Adding a File."


	
Add new folder. See Section 46.3.4.2, "Adding a New Folder."


	
Alert me about documents. Not supported. Opens the Home page in Spaces.





	
Links section:

[image: Task pane Links section]	
The Links section shows all document and URL links defined in Spaces to the currently open file.

Sort by. Choose from the menu to sort the list of links by Creation Date, Modified Date, URL, Ascending, or Descending.

	
Lists all links for the currently open file. See Section 46.3.4.8, "Viewing Link Targets." Click a link to navigate to the linked object.





	
Document Information section (Microsoft Office 2003 only):

[image: Task pane Document Info section]	
Provides information about the currently open document:

	
Document Information. See Section 46.3.4.9, "Viewing Document Information."


	
Restrict permission. Not supported.


	
Alert me about this document. Not supported. Opens the Home page in Spaces.


	
Check out or Check in. See Section 46.3.4.3, "Checking a File Out" and Section 46.3.4.4, "Checking a File In."


	
Version history. See Section 46.3.4.10, "Working with File Version History."





	
Bottom section:

[image: Task pane bottom section]	
Includes:

	
Get Updates. Refreshes the files and associated information from the Spaces server.


	
Options. Opens the Service Options dialog. Refer to the Microsoft Office online help for more information.


	
Shows the date and time that the file was last modified.











The following sections describe the tasks you can perform using the Microsoft Office task pane:

	
Section 46.3.4.1, "Adding a File"


	
Section 46.3.4.2, "Adding a New Folder"


	
Section 46.3.4.3, "Checking a File Out"


	
Section 46.3.4.4, "Checking a File In"


	
Section 46.3.4.5, "Managing the Currently Open File"


	
Section 46.3.4.6, "Managing Other Files in the Current Space"


	
Section 46.3.4.7, "Managing Folders"


	
Section 46.3.4.8, "Viewing Link Targets"


	
Section 46.3.4.9, "Viewing Document Information"


	
Section 46.3.4.10, "Working with File Version History"


	
Section 46.3.4.11, "Adding Members to a Space"


	
Section 46.3.4.12, "Sending a Message"






46.3.4.1 Adding a File

Using the Microsoft Office shared document management functionality, you can add a new file to the Content Server repository, exposing the file in a space, as described in the following sections:

	
Section 46.3.4.1.1, "Saving a File As a New File in a Space" (Microsoft Word, Excel, or PowerPoint file only)


	
Section 46.3.4.1.2, "Adding a New File Using the Task Pane" (files of any type)







	
Note:

Other methods to add a file to the connected content repository are:
	
Create a network place to a space, then use Windows Explorer to add files of any type when the backend content repository is Content Server, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
In Spaces, copy and paste, upload, or create a file using the Rich Text Editor (RTE), as described in Section 41.14, "Copying and Pasting Folders and Files," Section 41.8.1, "Uploading Files," and Section 41.12, "Editing and Updating a File."














46.3.4.1.1 Saving a File As a New File in a Space

To save a local Microsoft Word, Excel, or PowerPoint file to a space:




	
Note:

This feature is supported in Microsoft Office 2003 and 2007 only.







	
Add the space as a new network place in Windows Explorer, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Open the file in its Microsoft Office application.


	
(In Microsoft Office 2007 only) Set save options for shared documents:

	
Click the Office Button in the top left corner of the Microsoft Office application, then click Word Options (Figure 46-12) at the bottom of the menu.


Figure 46-12 Office Button Menu: Word Options

[image: Office Button Menu: Word Options]



	
In the Word Options dialog, select Save in the left pane (Figure 46-13).


	
Under Offline editing options for document management server files, select The web server (Figure 46-13).


Figure 46-13 Word Options Dialog

[image: Word Options Dialog]






	
Publish the file to the space:

In Microsoft Office 2003. From the File menu, choose Save As.

In Microsoft Office 2007. Click the Office Button, then choose either:

	
Publish, then Document Management Server.


	
Or, Save As, then Application Document.





	
In the Save As dialog, select the space network place, then click Save. For more information about space network place URLs, see Section 46.4.1, "Adding a Space as a Network Place."


	
Enter login credentials for Spaces, then click OK.


	
In Spaces, on the Documents page of the space, click the Refresh icon to confirm that the file was added.




	
Note:

To make the file visible to others, you must check the file in. See Section 46.3.4.4, "Checking a File In."








	
To display the Microsoft Office task pane in the open file, see Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane."









46.3.4.1.2 Adding a New File Using the Task Pane

To add a new file to a space using the Microsoft Office task pane:




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







	
Open a Microsoft Word, Excel, or PowerPoint file to use the Microsoft Office shared document management functionality (see Section 46.3.2, "Opening and Editing a File").


	
At the bottom of the Documents section of the task pane, click Add new document (Figure 46-14).


Figure 46-14 Task Pane Documents Section: Adding a New File

[image: Task Pane Documents Section: Bottom Area]



The Add New Document dialog opens (Figure 46-15).


Figure 46-15 Add New Document Dialog

[image: Add New Document dialog]



	
Browse to the file that you want to add to the current space.




	
Note:

Spaces supports files up to 2GB in size.







The checkbox Make workspace updates available when I open my copy is not supported.


	
Click OK.

The new file displays at the top of the document list in the Documents section of the Microsoft Office task pane. When you refresh the Documents page of the space in Spaces, the file appears in the document list in alphabetical order.











46.3.4.2 Adding a New Folder

Using the Microsoft Office shared document management functionality, you can add a new folder to the Content Server repository, exposing the folder in a space.




	
Note:

Other methods to add a new folder to a space are:
	
Create a network place to a space, then use Windows Explorer to add a folder, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Use the Spaces application to add a folder to any connected content repository, as described in Section 41.7, "Creating a Folder."












To add a new folder to a space using the Microsoft Office task pane:

	
Open a Microsoft Word, Excel, or PowerPoint file in the space to use the Microsoft Office shared document management functionality (see Section 46.3.2, "Opening and Editing a File").


	
At the bottom of the Documents section of the task pane, click Add new folder (Figure 46-16).


Figure 46-16 Task Pane Documents Section: Adding a New Folder

[image: Task Pane Documents Section: Adding a New Folder]



The Add New Folder dialog opens (Figure 46-17).


Figure 46-17 Add New Folder Dialog

[image: Add New Document Dialog]



	
Enter a name for the new folder, then click OK.




	
Note:

The rules for folder names follow the Windows Explorer standards.







The new folder displays at the top of the document list in the Documents section of the Microsoft Office task pane. When you refresh the Documents page of the space in Spaces, the folder appears in the folder list in alphabetical order.









46.3.4.3 Checking a File Out




	
Note:

To check any file out using the Spaces application, see Section 41.12.1, "Checking a File Out."







When you open a Microsoft Office file in a space using the Microsoft Office shared document management functionality, the file is automatically checked out from the Content Server repository. If you have been granted the appropriate permissions, you can open and check a file out in two environments:

	
From Spaces. Open a file in-place (see Section 46.3.2, "Opening and Editing a File") to automatically check out the file.


	
(Microsoft Office 2003 and 2007) From the Microsoft Office task pane. In the Documents section of the task pane, click a file name to automatically check out the file and open it in its default Microsoft Office application.






46.3.4.3.1 Checking the Currently Open File Out Again After Checking It In

After you check a file in (see Section 46.3.4.4, "Checking a File In"), the file remains displayed in Microsoft Office until you close it (see Section 46.3.5, "Closing a File"). If you want to check in further changes to the file, it must be checked out again:

	
In Microsoft Office 2003. In the Document Information section of the Microsoft Office task pane, you can optionally click Check out to check the file out again (Figure 46-18). However, even if you do not explicitly check out the file, you can continue to edit the file, then save it, and the Status and Document Information sections of the task pane automatically provide a Check in link to check the changed file back in to the repository.


Figure 46-18 Checking Out a Checked In File

[image: Checking Out a Checked In File]



	
In Microsoft Office 2007 and 2010. When you check a file in, the Check In dialog (Figure 46-21) provides a checkbox labeled Keep the document checked out after checking in this version:

	
Select the checkbox to keep the file checked out after checking in the current version. This allows you to refresh the version of the file available to other users, yet still retain the checked out status to make further changes.


	
Clear the checkbox to check the file in and cancel the checked out status.




If you clear the checkbox, you can optionally check the file out again:

	
Click Edit Document in the area below the toolbar (Figure 46-19).

After you check a file in, Microsoft Office 2007 locks editing that file until you click Edit Document.


Figure 46-19 Checking Out and Editing the Current Document

[image: Checking Out and Editing the Current Doc]















46.3.4.4 Checking a File In

When you open a file using the Microsoft Office shared document management functionality, you can check it back in to the repository, whether or not you have made changes to it.




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.
In Microsoft Office 2010, you can find file checkin and checkout information on the Info tab (from the File menu, choose Info). When a file is opened in Microsoft Office 2010, it is automatically checked out, changes are (temporarily) applied when saved, and the file is automatically checked in when the file is closed, with a default checkin comment. There is no explicit Check in option in Microsoft Office 2010.












	
Note:

Intermittently saving the file saves it on the server, but changes are not visible to others until you check the file in. To update the file stored in the Spaces repository, you must either save and close it, or explicitly check it in. If you close the Microsoft Office application and do not check the file in when prompted, your changes are lost.







To check a file in:

	
In the Status section of the Microsoft Office task pane, click Check in.




	
Note:

In Microsoft Office 2003, you can also find Check in in the Document Information section of the task pane.








	
In Microsoft Office 2003. In the Check In Comments dialog (Figure 46-20), optionally enter comments about the changes made to the file since it was last checked out.


Figure 46-20 Check In Comments Dialog (Microsoft Office 2003)

[image: Check In Comments Dialog (Office 2003)]



In Microsoft Office 2007. In the Check In dialog (Figure 46-21), optionally enter comments about the changes made to the file since it was last checked out, and select the state in which to leave the file:


Figure 46-21 Check In Dialog (Microsoft Office 2007 and 2010)

[image: Check In Comments Dialog (Office 2007)]



	
Select the checkbox to keep the file checked out after checking in the current version. This allows you to refresh the version of the file available to other users, yet still retain the checked out status to make further changes.


	
Clear the checkbox to check the file in and cancel the checked out status. To check the file out again, see Section 46.3.4.3.1, "Checking the Currently Open File Out Again After Checking It In."





	
Click OK.

If the file was modified since its prior version, it is automatically saved and checked in to Spaces as a new version. If check in comments were entered in the Check In dialog, a new file revision is created with the new comments, which display as the file description in Spaces (Figure 46-22).


Figure 46-22 Documents Listing in Spaces after Check In

[image: Documents Listing in WebCenter Spaces after Check In]



	
After checking a file in, the file remains displayed in Microsoft Office until you close it (see Section 46.3.5, "Closing a File"). If you wish to make further changes to the file, see Section 46.3.4.3.1, "Checking the Currently Open File Out Again After Checking It In.":


	
When you have finished making changes and checking in the file, close the Microsoft Office application (see Section 46.3.5, "Closing a File").









46.3.4.5 Managing the Currently Open File




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To manage the currently open file using the Microsoft Office task pane:

	
In the Documents section of the task pane, click the dropdown menu icon to the right of the file name (Figure 46-23).


Figure 46-23 Task Pane Documents Section: Current File Menu

[image: Task Pane Documents Section: Current File Menu]



	
Select an available action, as described in Table 46-3:


Table 46-3 Dropdown Menu Actions for Currently Open File

	Menu Action	Description
	
Open in Microsoft Office Application

	
Not applicable.


	
Delete

	
Not supported. To delete a file in a space, you must use the Spaces application (see Section 41.16, "Deleting Folders and Files") or Windows Explorer (see Section 46.4, "Working with Microsoft Windows Explorer Integration").


	
Alert Me About This Document

	
Not supported. Opens the home page of the space in Spaces.


	
Check Status

	
Displays the Status section of the task pane.


	
Document Updates

	
Not supported.


	
Save Updatable Copy

	
Not supported.


	
Create Document Workspace

	
Not supported.


	
Publish Back to Source Location

	
Not supported.















46.3.4.6 Managing Other Files in the Current Space




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To manage a file other than the currently open file in the current space using the Microsoft Office task pane:

	
In the Documents section of the task pane, navigate to the file.




	
Note:

Navigating upward in the folder hierarchy from the current document is not supported; you can drill down and then back up to the current level.








	
To open the file, click its name.

Depending on the file type, the file opens as described in Section 46.3.2, "Opening and Editing a File" for Microsoft Word, Excel, and PowerPoint files, or Section 41.10, "Opening a File" for other file types (such as HTML files or images).




	
Note:

If you have OpenOffice installed, an error may occur when attempting to open a file from the task pane. To resolve the error, uninstall OpenOffice.








	
To perform other actions, click the dropdown menu icon to the right of a file name (Figure 46-24):


Figure 46-24 Task Pane Documents Section: Other Files Menu

[image: Task Pane Documents Section: Other Fles Menu]



	
Select an available action, as described in Table 46-4:


Table 46-4 Dropdown Menu Actions for Other Files

	Menu Action	Description
	
Open in Microsoft Office Application

	
Attempts to check out the file: if checked out by another user, it opens read-only; if not checked out, the file opens in its Microsoft Office application for editing. For more information, see Section 46.3.2, "Opening and Editing a File."


	
Delete

	
Not supported. To delete a file in a space, you must use the Spaces application (see Section 41.16, "Deleting Folders and Files") or Windows Explorer (see Section 46.4, "Working with Microsoft Windows Explorer Integration").


	
Alert Me About This Document

	
Not supported. Opens the home page of the space in Spaces.















46.3.4.7 Managing Folders




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To manage a folder under the current folder using the Microsoft Office task pane:

	
In the Documents section of the task pane, navigate to the folder.




	
Note:

Navigating upward in the folder hierarchy from the current document is not supported; you can drill down and then back up to the current level.








	
To open the folder, click its name.


	
To perform other actions, click the dropdown menu icon to the right of the folder name (Figure 46-25):


Figure 46-25 Task Pane Documents Section: Folder Menu

[image: Task Pane Documents Section: Folder Menu]



	
Select an available action, as described in Table 46-5:


Table 46-5 Dropdown Menu Actions for a Folder

	Menu Action	Description
	
View Contents

	
Refreshes the list of files with the contents of the folder only (same effect as clicking the folder name). Click the folder name to refresh to the original list.


	
Delete

	
Not supported. To delete a folder in a space, you must use the Spaces application (see Section 41.16, "Deleting Folders and Files") or Windows Explorer (see Section 46.4, "Working with Microsoft Windows Explorer Integration").















46.3.4.8 Viewing Link Targets




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







The Links section of the Microsoft Office task pane lists the links defined in Spaces that are associated with the currently open file (Figure 46-26). Files can have links to related documents, discussions, announcements, events, and notes; the Links section in the task pane shows the links to associated documents and notes.

Links are prefixed with the name of the service with which they are associated. For example, a link to another document is prefixed Document, a link to a note is prefixed URL.


Figure 46-26 Task Pane Links Section

[image: Task Pane Links Section]



To display the target of a link, simply click the link:

	
Document links open in the same way as files in the Document section, namely Microsoft Word, Excel, and PowerPoint files open in Microsoft Office with a task pane, and other file types open in their default viewer or a browser.


	
URL links open a browser window displaying the link target.









46.3.4.9 Viewing Document Information




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







In Microsoft Office 2003: The Document Information section of the Microsoft Office task pane shows the user who last modified the file and the modified date (Figure 46-27).


Figure 46-27 Task Pane Document Information Section (Microsoft Office 2003 Only)

[image: Task Pane Document Information Section]



In Microsoft Office 2007. Information about the user who last modified the file and the modified date is shown in the Version History. See Section 46.3.4.10, "Working with File Version History."






46.3.4.10 Working with File Version History

Whenever you check in a file or upload a file into a folder that already contains a file of the same name, Spaces creates a new version of the file. When a file has multiple versions, it has a version history.




	
Note:

To use the Spaces application to work with the version history of a file in any connected content repository, see Section 41.21, "Viewing and Deleting File Version History."







In Microsoft Office 2003: To view the version history of the currently open file using the Microsoft Office task pane:

	
In the Document Information section of the task pane, click Version history (Figure 46-28).


Figure 46-28 Task Pane Document Information Section: Version History

[image: Task Pane Document Information Section: Version History]



The version history dialog for the file opens (Figure 46-29):


Figure 46-29 Version History for Currently Open File in Microsoft Office 2003

[image: Version History for Currently Open File]



In the version history dialog, select a file version, then select the desired action:

	
Open to open the selected file version read-only.


	
Restore is not supported.


	
Delete to delete the selected file version (inactive for the most recent version).


	
View Comments to display the comments entered for the selected file version (most useful when the comments are especially long).





	
To open the Documents page in the current space, click Modify settings for document versions.




In Microsoft Office 2007: To view the version history of the currently open file:

	
Click the Office Button (Figure 46-30) in the top left corner of the Microsoft Office application.


Figure 46-30 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]



	
From the Server menu, choose View Version History.

The version history dialog for the file opens (Figure 46-31):


Figure 46-31 Version History for Currently Open File in Microsoft Office 2007

[image: Version History for Current File in Office 2007]



	
In the version history dialog, select a file version, then select the desired action:

	
Open to open the selected file version read-only.


	
Compare to compare the selected file version with the currently open file.


	
Restore is not supported.


	
Delete to delete the selected file version (inactive for the most recent version).





	
To view the check in comments for a file version, click the link under Comments.


	
To open the Documents page in the space, click the link next to Versions saved to.




In Microsoft Office 2010: To view the version history of the currently open file:

	
From the File menu, choose Info.

The Info tab shows version history information on the Info tab in the Versions section. Refer to the Microsoft Office online help for more information.









46.3.4.11 Adding Members to a Space




	
Note:

To add members to a space using the Spaces application, see Section 52.3, "Managing Members and Assigning Roles."







If you are granted the moderator role or Manage All permissions in a space, you can add new members to a space using the Microsoft Office task pane. The currently open file must be a space document.




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To add members to a space when the currently open file is a space document:

	
In the Members section of the task pane, click Add new members.

The Add New Members dialog opens (Figure 46-32).


Figure 46-32 Add New Members Dialog

[image: Add New Members dialog]



	
Enter the login names or mail addresses of the users you want to add to the space, separated by semicolons.




	
Note:

Users who are already members of the space cannot be added again. The user names that you enter must have an associated mail address defined in Spaces.








	
From the site group dropdown list, select the role to be given to the listed users. The listed roles are those defined for the current space. The permissions granted to each role are defined by the Spaces administrator or space moderator. For more information about space roles, see Section 52.2, "Managing Roles and Permissions for a Space."




	
Note:

To define different roles to different users, limit the list of users to those who should be assigned the same role, finish this assignment, then click Add new members again to assign a different role to one or more different users.








	
Click Next.


	
Confirm or modify the member information, then click Finish.


	
In the Add New Members dialog (Figure 46-33), select or clear the checkbox to send an invitation to the new members to join the space, then click OK.


Figure 46-33 Add New Members Dialog

[image: Add New Members Dialog]










46.3.4.12 Sending a Message

From the Microsoft Office task pane, you can send a message to any user who has a mail address defined in Spaces:

	
Section 46.3.4.12.1, "Sending a Message to the Current User"


	
Section 46.3.4.12.2, "Sending a Message to Your Connections"


	
Section 46.3.4.12.3, "Sending a Message to Members of a Space"







	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.










	
Note:

To send messages using the Spaces application, see Section 51.15, "Sending Mail to Space Members or Moderators", Section 65.1, "What You Should Know About the Send Mail Feature", and Section 65.4.6, "Composing and Sending Mail Messages."









46.3.4.12.1 Sending a Message to the Current User

To send a message to the user who has the currently open document checked out:

	
In the Status section of the Microsoft Office task pane, click the dropdown menu icon next to the user name, and choose Send Mail (Figure 46-34).


Figure 46-34 Send a Message to the Current Document User

[image: Send a Message to the Current User]



A Microsoft Outlook message composition window opens with the To field populated with the mail address that is specified for the user in Spaces.









46.3.4.12.2 Sending a Message to Your Connections

To send a message to your connections when you are working with a document in the Home space:

	
In the Members section of the Microsoft Office task pane:

	
To send a message to an individual who is one of your connections, click the user name in the Members list (Figure 46-35):


Figure 46-35 Send a Message to a Connection

[image: Send Mail to Individual Connection]



	
To send a message to all of your connections, click Send e-mail to all members (Figure 46-36).


Figure 46-36 Send a Message to All Connections

[image: Send a Message to All Connections]





A Microsoft Outlook message composition window opens, where the Home space name is the subject, and the To field is populated with the mail address(es) specified for the people connection(s) in Spaces.


	
Modify the addresses and content of the message as desired, then click Send.









46.3.4.12.3 Sending a Message to Members of a Space

To send a message to the members of a space when you are working with a document in a space:

	
In the Members section of the Microsoft Office task pane:

	
To send a message to an individual who is a member of the space, click the user name in the Members list (Figure 46-37):


Figure 46-37 Send a Message to an Individual Space Member

[image: Send Mail to Individual in People Connections]



	
To send a message to all members of the space, click Send e-mail to all members.


Figure 46-38 Send a Message to All Space Members

[image: Send a Message to All Group Space Members]





A Microsoft Outlook message composition window opens, where the space name is the subject, and To field is populated with the mail address(es) specified for the space member(s) in Spaces


	
Modify the addresses and content of the message as desired, then click Send.













46.3.5 Closing a File

You can close a file opened in a Microsoft Office application with or without checking it in, as described in the following sections:

	
Section 46.3.5.1, "Closing a File After Checking It In"


	
Section 46.3.5.2, "Closing a File Before Checking It In"






46.3.5.1 Closing a File After Checking It In

After checking a file in, the file remains open in the Microsoft Office application until you close it.

To close a file after you have checked it in (see Section 46.3.4.4, "Checking a File In"):

	
From the File menu, choose Close.









46.3.5.2 Closing a File Before Checking It In

If you attempt to close a file or the Microsoft Office application before you have checked the file in, the Check In dialog provides the opportunity to check it in or cancel the check out and discard changes to the file. The selections in the Check In dialog are dependent on whether or not the file has been modified since the last time it was checked in.



46.3.5.2.1 Closing an Unchanged File

In Microsoft Office 2003: To close a file that has not been modified since the last time it was checked in:

	
From the File menu, choose Close.


	
In the Check In dialog (Figure 46-39), select one of the following actions:


Figure 46-39 Check In Dialog for File with No Changes (Microsoft Office 2003)

[image: Check In Dialog for File with No Changes]



	
Check in file to check the file in with no changes. In the Check In Comments dialog (Figure 46-20), optionally enter new comments, then click OK.


	
Keep checked out to close the file, but keep it in a checked out and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out."


	
Discard changes and undo check out to cancel the checked out status.





	
Click OK.




In Microsoft Office 2007: To close a file that has not been modified since the last time it was checked in:

	
Click the Office Button (Figure 46-40) in the top left corner of the Microsoft Office application, then choose Close.


Figure 46-40 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]





Microsoft Office 2007 does not prompt you to first check the file back in again, so the file remains in a checked out state and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out."






46.3.5.2.2 Closing an Updated File

In Microsoft Office 2003: To close a file that has been modified since the last time it was checked in:

	
From the File menu, choose Close.


	
In the Check In dialog (Figure 46-41), select one of the following actions:


Figure 46-41 Check In Dialog for File with Changes (Microsoft Office 003)

[image: Check In Dialog for File with Changes]



	
Save changes and check in to save the changes since the last check in and check the file in.


	
Save changes only to save changes since the last check in, but keep the file checked out and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out."


	
Discard changes and undo check out to retain the prior saved version of the file and cancel the checked out status.


	
Discard changes only to retain the prior saved version of the file and keep the file checked out.





	
Click OK.




In Microsoft Office 2007: To close a file that has been modified since the last time it was checked in:

	
Click the Office Button (Figure 46-42) in the top left corner of the Microsoft Office application, then choose Close.


Figure 46-42 Office Button in Microsoft Office
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If you have not already saved the changes, respond to the confirmation prompt to save or discard your changes.


	
In the confirmation dialog (Figure 46-43), respond to the prompt:


Figure 46-43 Close File Confirmation Prompt (Microsoft Office 2007)

[image: Close File Confirmation in Office 2007]



	
Yes to display the Check In dialog where you can enter version comments and select whether or not you want the file to remain checkout out (see Section 46.3.4.4, "Checking a File In"). If you choose to keep the file checked out and locked to changes by other users, see Section 41.12.1, "Checking a File Out" to later cancel the checked out status.


	
No to keep the file checked out and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out." 


















46.4 Working with Microsoft Windows Explorer Integration

Spaces integrates with Microsoft Windows Explorer to manage the folders and files in the Home space or a group space when the backend content repository is Content Server.

In Spaces, the most useful feature of Windows Explorer integration is the ability to add multiple files at once to a space, rather than uploading up to 10 files at a time (see Section 41.8.1, "Uploading Files"). It is important to be aware that Windows Explorer is not designed as a content repository, so if you try to open, delete, or rename a file that is checked out by another user, an error message displays to notify you that the operation failed, but the error message will not be specific as to the cause of the failure.

To expose the folders and files in a space in Windows Explorer, you create a new Windows network place to work with the files, as described in the following sections:

	
Section 46.4.1, "Adding a Space as a Network Place"


	
Section 46.4.2, "Working with Files Using Windows Explorer"






46.4.1 Adding a Space as a Network Place

To expose the folders and files in a space using Windows Explorer, you can add the space as a Windows network place.

To add a space as a Windows network place:

	
In Microsoft Windows, open My Network Places and click Add Network Place. Refer to the Microsoft Windows online help for more information.


	
In the Add Network Place wizard, enter the network address using the following format:

	
To access all spaces in your Spaces application through Windows Explorer:

http://hostname:port/wcsdocs/conn/repository_server/spaces/

For example:

http://myserver:8888/wcsdocs/conn/myserver-ucm/spaces/


	
To access the Home space through Windows Explorer:

http://hostname:port/wcsdocs/conn/repository_server/spaces/PersonalSpaces/username

For example:

http://myserver:8888/wcsdocs/conn/myserver-ucm/spaces/PersonalSpaces/wcsadmin


	
To access a specific space through Windows Explorer, open the About Space dialog, and copy the Explorer URL. See Section 49.5, "Viewing Information About a Space."

http://hostname:port/wcsdocs/conn/repository_server/spaces/instance/spacename

For example:

http://myserver:8888/wcsdocs/conn/myserver-ucm/spaces/WebCenter/philatelists







	
Tip:

The host name and port is shown in the browser URL for your Spaces application.
To find the name of the repository server, view the information for any space in the Spaces application, and note the name of the content repository specified by the Explorer URL. See Section 49.5, "Viewing Information About a Space."










	
At the prompt, enter your Spaces login credentials.


	
Optionally enter a name for the space network place, then click Finish.

Windows Explorer displays a drive for all spaces or the folders and files of a space, depending on the URL you entered.









46.4.2 Working with Files Using Windows Explorer

Once you have created a Windows network place to a space (see Section 46.4.1, "Adding a Space as a Network Place"), you can manage the folders and files using Windows Explorer.




	
Note:

If you change the internal name of a space (see Section 51.14.2, "Changing a Space URL"), the original network place to that individual space is no longer accessible. You will need to add the space as a Windows network place again using the new space internal name. Changing the internal name of a space has no effect if you create a network place to the parent URL for all spaces (http://hostname:port/wcsdocs/conn/repository_server/spaces/).







In Windows Explorer, navigate to the network place for the space to perform any of the following actions:

	
Copy and paste folders and files from your local file system.


	
Create folders and files.


	
Delete folders and files if not checked out by another user.


	
Open Microsoft Word, Excel, and PowerPoint files using the Microsoft Office shared document functionality. See Section 46.3, "Working with Microsoft Word, PowerPoint, and Excel Integration."


	
Open other file types in their default applications.




When you open a file, an attempt is made to check the file out. If it is checked out by another user, or you do not have permissions to update the file, it will open read-only. A file remains checked out until you check it back in (see Section 46.3.4.4, "Checking a File In").

The changes you make in Windows Explorer are reflected in Spaces, and vice versa.




	
Note:

To use the Spaces application to manage folders and files in a space in any connected content repository, see Chapter 41, "Working with the Documents Service Task Flows and Document Components."

















47 Working with Wiki Documents

WebCenter Portal: Spaces enables you to create wiki documents, which multiple users can use to create and edit content that is relevant, useful, and up-to-date.

This chapter describes how to create and manage wiki documents. It includes the following sections:

	
Section 47.1, "Prerequisites for Enabling Wiki Functionality"


	
Section 47.2, "What You Should Know About Wiki Documents"


	
Section 47.3, "Permissions Required for Working with Wiki Documents"


	
Section 47.4, "Creating a Wiki Document"


	
Section 47.5, "Editing a Wiki Document"


	
Section 47.6, "Exposing an Existing Wiki Document"


	
Section 47.7, "Managing Wiki Documents"







	
Note:

The tasks described in this chapter are available only if Content Server 11g is configured as the content repository.








Audience

This chapter is intended for Spaces users interested in creating and managing wiki documents. To perform the tasks described in this chapter, users need to be assigned a role that includes the Edit Pages and Create and Edit Documents (which includes delete permissions on wiki documents that you create).

To delete wiki documents that are not your own, you must have Delete Documents permission. To configure workflows or access control settings, you must have Document Administration permission. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



47.1 Prerequisites for Enabling Wiki Functionality

To support wiki functionality, the Documents service relies on Content Server, the content repository that stores the wiki documents. For wiki functionality to be available in Spaces, the following prerequisites must be met:

	
Content Server 11g must be configured as the default content repository for Spaces. The wiki functionality is not available with Content Server 10g. For information about installing and configuring Content Server 11g, see the "Managing Content Repositories" chapter in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
A connection to Content Server 11g must be established, as described in "Configuring Content Repository Connections" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal


	
The Documents service must be enabled for the space in which you plan to create wiki documents. For information, see Section 51.10.1, "Enabling and Disabling Services Available to a Space."









47.2 What You Should Know About Wiki Documents

Wiki documents epitomize the concepts of community and collaboration by allowing all authorized community members to contribute their information to a body of knowledge. Wiki documents are web pages that offer in-place editing using HTML or a simple mark-up language called wiki mark-up. Users with sufficient permissions on a wiki document can add, revise, or delete content. Wikipedia (http://www.wikipedia.com) is a widely-known example of the use of wiki documents. Users from all over the world collaborate to create and edit Wikipedia pages, resulting in a rich, dynamic knowledge base for everyone's benefit.

In Spaces, you can create a wiki document using either of the following two methods:

	
New Wiki Document action, available on the Documents page and Documents service task flows.


	
Wiki page syle, to create a dedicated wiki page with a default wiki document that offers a simplified user interface and a dedicated wiki experience.

Anyone with appropriate permissions on the wiki page can create additional wiki documents using the New Wiki Document action. These wiki documents are siblings of the default wiki document, and are all stored in the dedicated folder that is automatically created for the wiki page.




Wiki documents created using either of the two methods offer the same in-place editing features thorugh the Rich Text Editor (RTE).

The method you choose for creating wiki documents really depends on your preferences. If you want to expose a wiki document as a separate page in your Spaces application, and want users to feel that there is a dedicated area for wikis, use the Wiki page style method. If you do not require these features, and just want to create a wiki document (among other types of documents) in your space's document hierarchy, use the New Wiki Document action.

Table 47-1 summarizes the differences between the two methods of creating wiki documents:


Table 47-1 Distinguishing Features Between Methods of Creating Wikis

	Feature	New Wiki Document Action

(Section 47.4.1, "Creating a Wiki Document Using the New Wiki Document Action")	Wiki Page Style

(Section 47.4.2, "Creating a Wiki Document Using the Wiki Page Style")
	
Exposure

	
In the default side navigation page template, does not display wiki documents as a separate page in the space navigation area.

A wiki document is exposed as a file in the folder where it was created on the Documents page of the space, just like any other file.

	
Exposes wiki documents within a dedicated page in the navigation area of a space (the location depends on the page template used). The screenshot shows an example of navigation to a wiki page in a space using the default side navigation page template.

A wiki page is exposed as a folder on the Documents page of the space, just like any other page.

[image: Wiki document]
	
Document storage

	
Does not create a separate folder to store a wiki document, and the navigation is not constrained.

The screenshot shows Savs Wiki as the wiki document created in the document hierarchy.

	
Automatically creates a new folder (with the same name as the wiki page) under the root folder in the document hierarchy, and creates a default wiki document in the folder, with the same name as the page name. This method restricts navigation to start at this folder.

The screenshot shows the folder named MyWikiPage. It contains a default wiki document named MyWikiPage. The folder and the wiki document were automatically created when the Wiki page style method was used for creating a page named MyWikiPage.

[image: Wiki document in the Documents page hiearchy]
	
Permissions inherited by a wiki document

	
Inherits permissions from the folder in which it is created.

	
In a space, the newly created wiki page inherits space permissions (where Moderator and Participant roles have Create, Edit, and Delete permissions, and Viewer role has only View permission).

In the Home space, a newly created wiki page inherits the same permissions as a public folder; the owner is granted the Administer, Read, Write, and Delete permissions, and public users are granted only the Read access.


	
Permissions required to create wiki documents

See also Section 47.3, "Permissions Required for Working with Wiki Documents"

	
Create and Edit Documents permission.

	
To create a page based on the Wiki page style and then be able to create wiki documents within the page, users require:

	
Create Pages or Create, Edit, Delete Pages permission for the Page service.


	
Create and Edit Documents permission for the Documents service.














	
Note:

The root folder where Content Server stores a space is /spaces/space_name; a Home space is stored in /spaces/user_name.












47.3 Permissions Required for Working with Wiki Documents

The following sections discuss the permissions required to create and manage wiki documents:

	
Section 47.3.1, "Permissions for Using the New Wiki Document Action"


	
Section 47.3.2, "Permissions for Working with Wiki Pages"






47.3.1 Permissions for Using the New Wiki Document Action

To create a wiki document using the New Wiki Document action and edit the document, you must be granted the Create and Edit Documents permission (Figure 47-1). To delete wiki documents, you require the Delete Documents permission. These permissions are available to the Moderator and Participant roles by default.


Figure 47-1 Documents Service Permissions for Working with Wiki Documents

[image: Documents permissions]

Description of "Figure 47-1 Documents Service Permissions for Working with Wiki Documents"









47.3.2 Permissions for Working with Wiki Pages




	
Note:

By default the authenticated-role role is granted View permission on wiki pages. This means that all authenticated users logged into Spaces can view a wiki page in the Home Space, or any space to which they have access. Additional permissions on the page are determined by the security set on the page, as described in Section 23.1, "Setting Access on a Page."







To create and edit wiki documents using the Wiki page style, you must be granted Page service permissions in addition to the Documents service permissions:

	
Standard permission model: If this permission model is used, creating and editing wiki documents requires:

	
Create and Edit Documents permission for the Documents service (Figure 47-1).


	
Edit Page Access, Structure, and Content permission for Basic Services (Figure 47-2).


Figure 47-2 Basic Services Permission for Working with Wiki Documents

[image: Page service permissions required for blogs]

Description of "Figure 47-2 Basic Services Permission for Working with Wiki Documents"








	
Advanced permission model: If this permission model is used, creating and editing wiki documents requires:

	
Create and Edit Documents permission for the Documents service (Figure 47-1).


	
Create Pages or Create, Edit, and Delete Pages permission for the Pages service (Figure 47-3).








Figure 47-3 Page Service Permissions for Working with Wiki Documents

[image: Page service permissions required for wiki documents]

Description of "Figure 47-3 Page Service Permissions for Working with Wiki Documents"











47.4 Creating a Wiki Document

The following sections describe how to create a wiki document in a Spaces application:

	
Section 47.4.1, "Creating a Wiki Document Using the New Wiki Document Action"


	
Section 47.4.2, "Creating a Wiki Document Using the Wiki Page Style"


	
Section 47.4.3, "Creating a Wiki Document Within a Wiki Page"






47.4.1 Creating a Wiki Document Using the New Wiki Document Action

To understand the differences between the two methods of creating a wiki document, see Section 47.2, "What You Should Know About Wiki Documents."

To create a wiki document using the New Wiki Document action on the Documents page or in a Documents service task flow:

	
Navigate to the Documents page or the page that contains a Document Explorer, Document Viewer, Document Manager, or Folder Viewer task flow. Browse to the folder where you want to create a wiki document.


	
Click New Wiki Document (Figure 47-4).


Figure 47-4 Creating a New Wiki Document

[image: Creating a New Wiki Document]



The Rich Text Editor (RTE) opens (Figure 47-5), displaying a blank wiki document.


Figure 47-5 Rich Text Editor Displaying New Wiki Document

[image: New Wiki Document in Rich Text Editor]



	
In the Title field, enter a display name for the wiki document.




	
Note:

When naming wiki documents, the following characters are not allowed:

\ / : [ ] * ' " | ?


Spaces and periods (.) are allowed.










	
Add and preview the text, formatting, styling, and links in the Rich Text, HTML, Wiki Markup, and/or Preview tabbed panes. For information about RTE toolbar icons and controls, see Section 41.11, "Using the Rich Text Editor (RTE)."


	
Click Create to save your changes and exit the editor.

The new wiki document displays in the Document Viewer, ready to be edited by other space members (Figure 47-12).


Figure 47-6 Wiki Document Created Using New Wiki Document Action

[image: Wiki Document Created Using New Wiki Document Action]



On the Documents page in the space, the new wiki document (Release Schedule) is saved as a document in the current folder, as shown in Figure 47-13.


Figure 47-7 Wiki Document Created Using New Wiki Document Action

[image: Wiki Document Created Using New Wiki Document Action]










47.4.2 Creating a Wiki Document Using the Wiki Page Style

To understand the differences between the two methods of creating a wiki document, see Section 47.2, "What You Should Know About Wiki Documents."

To create a wiki document using the Wiki page style:

	
Navigate to the space in which you want to create a wiki document and open the Create dialog.


	
In the Page Name field, enter a display name for the dedicated wiki page.

The name that you enter here is also shown as the name of dedicated folder that is created, and the name of the first, default wiki document created within the folder.




	
Note:

While there are restrictions on naming wiki documents, there are no naming restrictions for page names. However, while any of the following characters can be used to name the wiki page, the page title will include the character(s) but the associated wiki document will replace the illegal character with "_".

\ / : [ ] * ' " | ?


For example, if you create a wiki page named "What's In a Name?", the page will have this title, but the associated wiki document will be named "What_s In a Name_".










	
From the Page Style options, select Wiki (Figure 47-8).


Figure 47-8 Creating a Wiki Document Using the Wiki Page Style

[image: Create dialog with Wiki page option]

Description of "Figure 47-8 Creating a Wiki Document Using the Wiki Page Style"








	
Note:

The Wiki page style becomes available in the Create dialog in a space only if Spaces is integrated with Content Server 11g, and the Documents service is enabled for the space.
For information about setting up a connection to Content Server, see "Registering Content Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. For information about enabling the Documents service, see Section 51.10.1, "Enabling and Disabling Services Available to a Space."










	
Click Create.

The newly created wiki displays as a separate page, containing a default wiki document with default text (Figure 47-9). The breadcrumbs at the top display the path where the wiki document is created in the document hierarchy. In the wiki document, you can replace the default text with the desired content. For information, see Section 47.5, "Editing a Wiki Document."


Figure 47-9 Default Wiki Document Created Using the Wiki Page Style

[image: A newly created wiki document]

Description of "Figure 47-9 Default Wiki Document Created Using the Wiki Page Style"





On the Documents page, you can find the newly created wiki document stored in a separate folder for the wiki page under the root folder, as shown in Figure 47-10. Both the folder and the default wiki document share the same name.


Figure 47-10 Default Wiki Document for a Wiki Page in the Document Hierarchy

[image: A Newly Created Wiki Document in Document Hierarchy]

Description of "Figure 47-10 Default Wiki Document for a Wiki Page in the Document Hierarchy"












47.4.3 Creating a Wiki Document Within a Wiki Page

A page based on the Wiki page style contains a default wiki document. Anyone with appropriate permissions on the wiki page can create additional wiki documents using the New Wiki Document action. These wiki documents are siblings of the default wiki document, and are all stored in the dedicated folder that is automatically created for the wiki page.

You can create an additional wiki document within a wiki page in either of the following ways:

	
Navigate to the folder for the page, and create a new wiki document as described in Section 47.4.1, "Creating a Wiki Document Using the New Wiki Document Action."


	
Navigate to the wiki page and select the New Wiki Document action, as described in the following steps:

	
In the wiki page, select the New Wiki Document action.

The way you select this action depends on the page template used in your space.

Figure 47-11 shows a wiki page open in a space that uses a side navigation page template. Clicking the page name in the breadcrumbs or the dropdown arrow next to the page name displays a menu that contains the New Wiki Document action.


Figure 47-11 The New Wiki Document Option Available for a Wiki Page

[image: The New Wiki Document Option]

Description of "Figure 47-11 The New Wiki Document Option Available for a Wiki Page"





	
In the Rich Text Editor (RTE), in the Title field, enter a name for the new wiki document (for example, Project Plan).


	
Add, revise, and preview text, formatting, styling, and links in the Rich Text, HTML, Wiki Markup, and/or Preview tabbed panes. For information about working with the RTE, see Section 41.11, "Using the Rich Text Editor (RTE).".


	
Click Create to save your changes and exit the editor.

The new wiki document displays in the Document Viewer, ready to be edited by other space members (Figure 47-12).


Figure 47-12 New Wiki Document Associated with a Wiki Page

[image: New Wiki Document Associated with a Wiki Page]



On the Documents page in the space, the new wiki document (Project Plan) is saved as a document under its parent wiki folder (ProjectWiki), along with the wiki document created as the default wiki page document (ProjectWiki) , as shown in Figure 47-13.


Figure 47-13 Wiki Document Created Within a Wiki Page

[image: Wiki Document Created Within a Wiki Page]

Description of "Figure 47-13 Wiki Document Created Within a Wiki Page"





In the wiki page, the dropdown arrow next to the page name in the breadcrumbs displays a menu that includes the wiki documents created within the page (in this example, Project Plan) (Figure 47-14).


Figure 47-14 List of Wiki Documents Associated with Wiki Page

[image: List of Wiki Documents]

Description of "Figure 47-14 List of Wiki Documents Associated with Wiki Page"

















47.5 Editing a Wiki Document

You use the Rich Text Editor (RTE) to add or revise the content of your wiki documents.

When you open a wiki document for editing, Spaces automatically checks the file out. If another user is already editing a wiki document when you try to open it, the Documents service displays a message that the wiki document has already been checked out. On the Documents page or in a Documents service task flow, a lock icon displays alongside a wiki document that is checked out. When you hover the mouse cursor over the lock icon, the name of the user who has checked out the wiki document displays.

Whenever you save changes to a wiki document, Spaces automatically checks the file in and creates a new version of the wiki document. This means that the last saved version of a wiki document appears as the current version.

To edit a wiki document:

	
Open your wiki document in edit mode in any of the following ways, depending on your view:

	
On the Documents page or in a Documents service task flow, click in the row of the wiki document you want to edit. From the File menu, choose Edit, or right-click the file and choose Edit from the context menu to open the wiki document in the RTE.


	
In the Document Viewer preview pane, click the Edit action (Figure 47-15).


Figure 47-15 Wiki Document in Document Viewer Preview Pane

[image: Wiki Document in Document Viewer Preview Pane]



	
In a wiki page, click the Edit action to edit the default wiki document.


	
In a wiki page, click the dropdown arrow next to the page name in the breadcrumbs to select and open a wiki document created within the page.(Figure 47-16), then click the Edit action.


Figure 47-16 List of Wiki Documents Associated with Wiki Page

[image: List of Wiki Documents]

Description of "Figure 47-16 List of Wiki Documents Associated with Wiki Page"








	
In the RTE, add, revise, and preview text, formatting, styling, and links in the Rich Text, HTML, Wiki Markup, and/or Preview tabbed panes. For information about working with the RTE, see Section 41.11, "Using the Rich Text Editor (RTE).".


	
Select the Minor Edit? checkbox if you do not want to notify space members about your changes.

Leaving this checkbox cleared updates the Activity Stream and sends notifications after you save your changes.


	
Click Save to save your changes and continue editing, or click Save and Close to save your changes and exit the editor.









47.6 Exposing an Existing Wiki Document

This section includes the following sections:

	
Section 47.6.1, "Exposing an Existing Wiki Document as a Wiki Page"


	
Section 47.6.2, "Exposing an Existing Wiki Document Using Content Presenter"






47.6.1 Exposing an Existing Wiki Document as a Wiki Page

When you create a wiki page using the Wiki page style, it is listed in the document hierarchy, and is exposed as a separate page in the navigation area in your space. However, when you create a wiki document using the New Wiki Document action, the wiki document is listed in only in the document hierarchy. For easy access to such a wiki document, you can publish it to appear as a page in the navigation area.

To publish an existing wiki document as a page in the navigation area:

	
On the Documents page, create a folder with the same name as the existing wiki document at the root level of the space (see Section 41.7, "Creating a Folder"). For example, if the existing wiki document is named Project Plan, create a folder named Project Plan (Figure 47-17).


Figure 47-17 Folder Created at the Space Root Level

[image: Folder Created at the Space Root Level]

Description of "Figure 47-17 Folder Created at the Space Root Level"





	
Move the existing wiki document to the newly created folder (see Section 41.15, "Moving Folders and Files").




	
Note:

The wiki document must have been originally created using the New Wiki Document action, as described in Section 47.4.1, "Creating a Wiki Document Using the New Wiki Document Action."








	
Open the Create dialog to create a new page in the space.


	
In the Page Name field, enter the display name of the existing wiki document that you want to expose; for example, Project Plan.




	
Note:

When naming wiki documents, the following characters are not allowed:

\ / : [ ] * ' " | ?


Character spaces and periods (.) are allowed.










	
From the Page Style options, select Wiki.


	
Click Create.

The wiki document is now exposed as a separate page in the navigation area. The location depends on the page template used in your space. Figure 47-18 shows the Project Plan wiki document eposed as a page in the navigation area in a space, under Wikis.


Figure 47-18 A Wiki Document Exposed as a Page

[image: A Wiki Document Exposed Under the Wiki Category]

Description of "Figure 47-18 A Wiki Document Exposed as a Page"












47.6.2 Exposing an Existing Wiki Document Using Content Presenter

The Content Presenter task flow allows you to select a wiki document, and render its content in a specific template on a page. For information, see Section 40, "Publishing Content Using Content Presenter."








47.7 Managing Wiki Documents

Table 47-2 lists the tasks that you can perform to manage wiki documents, with links to the steps that describe how to perform each task for any kind of file.


Table 47-2 Managing Wiki Documents

	Task	Description	For more information, see...
	
Opening a wiki document for viewing

	
You can open a wiki document on the Documents page or in a Documents service task flow.

If your wiki document is exposed through a wiki page, you can open the wiki page, then access the wiki document from the wiki page's dropdown menu, as shown in Figure 47-14.

	
Section 41.10, "Opening a File"



	
Downloading a wiki document

	
You can download a wiki document from the content repository to your local file system. You can access the Download action from the Documents page, Documents service task flows, or the Document Viewer preview pane.

Note: Spaces does not support uploading a new wiki document or a new version of a wiki document from the file system. If you upload an HTML file, you cannot convert it to a wiki document due to differences in underlying metadata.

	
Section 41.12.2, "Downloading a File"



	
Renaming a wiki document

	
You can rename a wiki document as desired.

	
Section 41.13, "Renaming a Folder or File"

Section 41.22.2, "Working with File Properties"



	
Deleting a wiki document

	
You can delete a wiki document if it is no longer required.

	
Section 41.16, "Deleting Folders and Files"



	
Viewing, adding, and deleting comments on a wiki document

	
You can associate comments with a wiki document to provide additional information that you may want to convey to other users about it.

	
Section 41.19, "Viewing, Entering, and Deleting Comments on a File"



	
Viewing and adding tags to a wiki document

	
You can add tags to a wiki document to specify keywords related to the content of the post to make it more widely discoverable in search results.

	
Section 41.20, "Working with Tags"



	
Viewing and deleting versions of a wiki document

	
Every time you save a wiki document, Spaces saves a new version of the post and maintains the version history. You can view and delete the various versions. However, you cannot restore an older version of a wiki document.

	
Section 41.21, "Viewing and Deleting File Version History"



	
Viewing and modifying properties of a wiki document

	
You can view the basic and advanced properties associated with a wiki document. However, you can modify only the name and description of a wiki document.

	
Section 41.22.2, "Working with File Properties"



	
Viewing and adding links to a wiki document

	
You can add links from a wiki document to a discussion, document, event, note, or URL to provide a way to view, access, and associate related information.

	
Section 41.23, "Working with Links"



	
Opening or saving wiki documents as PDF files

	
You can open or save the PDF version of the currently open wiki document. This choice is available if Content Server is configured to convert wiki documents to PDF format, and your application administrator must configure the WebCenter Conversion component, as described in "Enabling the Conversion of Wikis and Blogs into PDFs" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

	
Section 41.25, "Opening or Saving PDF Files"



	
Sharing the URL of a wiki document

	
You can directly access a wiki document using its URL. You can share the link by publishing it to the Activity Stream or sending the link in a mail message.

	
Section 41.26, "Sharing the URL for a Folder or File"



	
Setting up the security for a wiki document

	
You can secure a wiki document by setting custom access permissions or choosing to inherit the permissions of the parent folder.

The option to set security for wiki documents is available if item level security has been enabled on Content Server.

	
Section 41.27, "Setting Security Options on a Folder or File"



	
Subscribing to a wiki document

	
You can subscribe to a wiki document to receive notifications for activities such as when it gets updated or when a user posts comments or likes it. You are notified through your selected messaging channel.

	
Section 41.28, "Subscribing to a File"



	
Liking or unliking a wiki document

	
To indicate that a wiki document is of particular interest to you, you can "like" it. If a wiki document is already liked, you can "unlike" it if you no longer wish to highlight your preference.

	
Section 41.29, "Liking and Unliking a File"
















48 Working with Blogs

You can create and manage personal blogs in your WebCenter Portal: Spaces application to record experiences and opinions, and group related blog posts contributed by multiple users.

This chapter describes how to create and manage blogs. It includes the following sections:

	
Section 48.1, "Prerequisites for Enabling Blog Functionality"


	
Section 48.2, "What You Should Know About Blogs"


	
Section 48.3, "Permissions Required for Working with Blogs"


	
Section 48.4, "Creating a Blog"


	
Section 48.5, "Subscribing to a Blog"


	
Section 48.6, "Setting Blog Properties"


	
Section 48.7, "Working with Blog Posts"







	
Note:

The tasks described in this chapter are available only if Content Server 11g is configured as the content repository.








Audience

This chapter is intended for Spaces users interested in adding, editing, and managing blogs.

To perform the tasks described in this chapter, users need to be assigned a role that includes the Edit Pages and Create and Edit Documents (which includes delete permissions on blogs that you create). To delete blogs that are not your own, you must have Delete Documents permission. To configure workflows or access control settings, you must have Document Administration permission. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



48.1 Prerequisites for Enabling Blog Functionality

To support blog functionality, the Documents service relies on Content Server, the content repository that stores the blogs. For blog functionality to be available in Spaces, the following prerequisites must be met:

	
Content Server 11g must be configured as the default content repository for Spaces. The blog functionality is not available with Content Server 10g. For information about installing and configuring Content Server 11g, see the "Managing Content Repositories" chapter in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
A connection to Content Server 11g must be established, as described in "Configuring Content Repository Connections" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal


	
The Documents service must be enabled for the space in which you plan to create a blog. For information, see Section 51.10.1, "Enabling and Disabling Services Available to a Space."









48.2 What You Should Know About Blogs

Blogs are typically personal records of an individual user's experience and opinions. The word blog is a contraction of the term Web log. It was coined to describe the online diaries spawned in the late 1990s.

Blogs provide a useful tool for discussing and/or evangelizing any type of idea, strategy, or point of view. Blogs may be projected out to a select group of people or to a wider audience. Typically, each blog contains various blog posts, with the most recently added blog post displayed at the top. Blogs invite readers to comment on the overall concepts

In Spaces, you can create blogs to group related blogs posts. For example, you can group posts by the same author or related topics.

In Spaces, you can create a blog using either of the following two methods:

	
Blog task flows, to expose a customized blog view on a page along with other page components.


	
Blog page style, to create a dedicated blog page.




The following sections discuss the blog functionality and the requirements for creating and managing blogs in a Spaces application:

	
Section 48.2.1, "Understanding the Blog Task Flows"


	
Section 48.2.2, "Understanding the Blog Page Style"






48.2.1 Understanding the Blog Task Flows

If you want to include a blog on a page, along with other page components, you can use the blog task flows to add one or more elements of a blog to a page in a Spaces application. Table 48-1 lists and describes the blog task flows:


Table 48-1 Blog Task Flows

	Blog Task Flow	Description	Example as Exposed on a Page
	
Archives

	
Displays a composite list of blogs based on dates.

	
[image: Blog Archives task flow]



	
Banner

	
Displays a banner for the blog.

	
[image: Blog Banner task flow]



	
Blog Main View

	
Displays a blog or blog post with a default design.

	
[image: Blog Main View task flow]



	
Blog Viewer

	
Displays a blog or blog post.

	
[image: Blog Viewer task flow]



	
Blog Recent Posts

	
Displays a list of most recent blog posts.

	
[image: Blog Recent Posts task flow]









To work with blog task flows, see:

	
Section 48.3.1, "Permissions for Working with Blog Task Flows"


	
Section 48.4.1, "Creating a Blog Using Blog Task Flows"









48.2.2 Understanding the Blog Page Style

Out-of-the-box, the Spaces application includes several page styles for selection when creating a new page. One of these page styles is the Blog page style, which enables you to create a dedicated blog page (Figure 48-1).


Figure 48-1 A Blog Page

[image: A blog page]

Description of "Figure 48-1 A Blog Page"





On a blog page, the Archives section on the right provides links to blog posts by year and by month. Clicking a month displays all blog posts created during that month.

A blog page displays various details for each blog post. These include the blog post title, the blog post content, date of creation or modification, name of the user who created or last modified the post, and the number of comments on the blog post. Authorized users can click the Edit Post icon to edit a post, and click the Post comments link to enter comments on a blog post.

Clicking a blog post title opens the blog post to occupy the entire the blog page (Figure 48-2), providing controls to manage the blog post. For more information, see Section 48.7, "Working with Blog Posts."


Figure 48-2 A Blog Post

[image: A Blog Post]

Description of "Figure 48-2 A Blog Post"





In a space or the Home space, blog pages are stored in a separate folder named Blogs under the root folder of the space in the document hierarchy. When you create a new blog page, an empty folder is created for that blog under the Blogs folder. All blog posts that you create in that blog are stored in the blog's folder.

Figure 48-3 illustrates the directory structure for the example MyBlog, which contains two blog posts. The breadcrumb at the top shows that the blog posts are created in the MyBlog folder in the space.


Figure 48-3 Directory Structure of a Blog

[image: Directory structure of a blog in the document hierarchy]

Description of "Figure 48-3 Directory Structure of a Blog"





To work with blog pages, see:

	
Section 48.3.2, "Permissions for Working with a Blog Page"


	
Section 48.4.2, "Creating a Blog Using the Blog Page Style"











48.3 Permissions Required for Working with Blogs

The following sections discuss the permissions required to create and manage blogs:

	
Section 48.3.1, "Permissions for Working with Blog Task Flows"


	
Section 48.3.2, "Permissions for Working with a Blog Page"


	
Section 48.3.3, "Permissions for Working with Blog Posts"






48.3.1 Permissions for Working with Blog Task Flows

To create and manage blogs using blog task flows, you must be granted the Create and Edit Documents permission (Figure 48-4). To delete blogs, you require the Delete Documents permission. These permissions are available to the Moderator and Participant roles by default.


Figure 48-4 Documents Service Permissions for Working with Blogs

[image: Documents Service Permissions for Working with Blogs]

Description of "Figure 48-4 Documents Service Permissions for Working with Blogs"









48.3.2 Permissions for Working with a Blog Page




	
Note:

By default the authenticated-role role is granted View permission on blog pages. This means that all authenticated users logged into Spaces can view a blog page in the Home Space, or any space to which they have access. Additional permissions on the page are determined by the security set on the page, as described in Section 23.1, "Setting Access on a Page."







To create and manage a blog using the Blog page style, you must be granted Page service permissions in addition to the Documents service permissions.

	
Standard Permission Model: If this permission model is used, creating and managing blogs requires:

	
Create and Edit Documents permission for the Documents service (Figure 48-4).


	
Edit Page Access, Structure, and Content permission for Basic Services (Figure 48-5).


Figure 48-5 Basic Services Permission for Working with Blogs

[image: Page service permissions required for blogs]

Description of "Figure 48-5 Basic Services Permission for Working with Blogs"








	
Advanced Permission Model: If this permission model is used, creating and managing blogs requires:

	
Create and Edit Documents permission for the Documents service (Figure 48-4).


	
Create Pages or Create, Edit, and Delete Pages permission for the Page service (Figure 48-6).


Figure 48-6 Page Service Permissions for Working with Blogs

[image: Page service permissions required for blogs]

Description of "Figure 48-6 Page Service Permissions for Working with Blogs"















48.3.3 Permissions for Working with Blog Posts

By default, all users can create blog posts in the Home space. To create blog posts in other spaces, users must be granted the Create and Edit Documents permission (Figure 48-7).

All users with View Documents permission can post comments on blog posts.


Figure 48-7 Documents Service Permissions for Creating Blog Posts in a Space

[image: Documents Service Permissions for Working with Blogs]

Description of "Figure 48-7 Documents Service Permissions for Creating Blog Posts in a Space"











48.4 Creating a Blog

The following sections describe how to create a blog in a Spaces application:

	
Section 48.4.1, "Creating a Blog Using Blog Task Flows"


	
Section 48.4.2, "Creating a Blog Using the Blog Page Style"






48.4.1 Creating a Blog Using Blog Task Flows

To understand the differences between the two methods of creating a blog, see Section 48.2, "What You Should Know About Blogs."

The Documents service provides various task flows that you can add to a page, offering different views and sets of capabilities for working with documents in your content repository.

Instead of creating a dedicated blog page, you may want one or more blogs to appear along with various other components on a page. You can do this by creating a folder for a blog, and then exposing it on a page using a combination of blog task flows. For descirptions of the blog task flows provides by Spaces, see Section 48.2.1, "Understanding the Blog Task Flows"

To add a blog task flow to a page:

	
On the Documents page or in a Documents service task flow, create a folder under the Blogs folder.


	
Right-click the newly created folder, and choose Details to display the folder properties.


	
From the Identifier field, copy the value (Figure 48-8).

This value is the resource ID that uniquely identifies the folder. You will copy this resource ID to the blog task flow properties to expose the folder as a blog.


Figure 48-8 Resource ID of a Folder

[image: Resource ID of a Folder]

Description of "Figure 48-8 Resource ID of a Folder"





	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to the blog task flows.




	
Tip:

The presence or location of this section depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, next to Social and Communication, click Open next to Blogs.








Figure 48-9 Blogs Folder in Default Resource Catalog

[image: Blogs Folder in Default Resource Catalog]



	
Click Add next to the blog task flow that you want to add to your page (Figure 48-10). For descirptions of the blog task flows provides by Spaces, see Section 48.2.1, "Understanding the Blog Task Flows"


Figure 48-10 Adding a Blog Task Flow

[image: Adding a Blogs Task Flow]

Description of "Figure 48-10 Adding a Blog Task Flow"





	
Click Close to close the Resource Catalog.

The selected blog task flow is added to the page, displaying a message that the resource ID is missing or invalid (Figure 48-11).


Figure 48-11 Blog Task Flow Added to a Page

[image: Blog task flow added to a page in Oracle Composer]

Description of "Figure 48-11 Blog Task Flow Added to a Page"





	
Click the Edit icon, highlighted in Figure 48-11.


	
In the Component Properties dialog, on the Parameters tab, paste the resource ID that you copied in step 3 into the Resource Id field (Figure 48-12).


Figure 48-12 Component Properties Dialog of a Blog ViewerTask Flow

[image: Components Properties Dialog of a Blog Task Flow]

Description of "Figure 48-12 Component Properties Dialog of a Blog ViewerTask Flow"





For information about the other blog properties that you can set in the Component Properties dialog, see Section 48.6, "Setting Blog Properties."


	
Click OK.

The new blog task flow is added to the page (Figure 48-13).


Figure 48-13 A New Blog Viewer Task Flow

[image: A Folder Exposed in a Blogs Task Flow]

Description of "Figure 48-13 A New Blog Viewer Task Flow"







After adding a blog task flow, you can peform blog actions provided by the task flow, such as adding blog posts, as described in Section 48.7.2, "Creating a Blog Post."






48.4.2 Creating a Blog Using the Blog Page Style

To understand the differences between the two methods of creating a blog, see Section 48.2, "What You Should Know About Blogs."

To create a dedicated blog page using the Blog page style:

	
Navigate to the space in which you want to create a blog and open the Create dialog.


	
In the Page Name field, enter a display name for the dedicated blog page. Special characters (such as \ / : [ ] * ' " | ?) are allowed.


	
From the Page Style options, select Blog (Figure 48-14).


Figure 48-14 The Blog Page Style

[image: The Blog page style]

Description of "Figure 48-14 The Blog Page Style"








	
Note:

The Blog page style becomes available in the Create dialog in a space only if Spaces is integrated with Content Server 11g, and the Documents service is enabled for the space.
For information about setting up a connection to Content Server, see "Registering Content Repositories" section in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. For information about enabling the Documents service, see Section 51.10.1, "Enabling and Disabling Services Available to a Space."










	
Click Create.

The newly created blog page displays as a separate page (Figure 48-15). The location of the page depends on the page template used in your space.


Figure 48-15 A Blog Created Using the Blog Page Style

[image: Blog Created Using Blog Page Style]

Description of "Figure 48-15 A Blog Created Using the Blog Page Style"





You are to add blog posts to your newly created blog. For information, see Section 48.7.2, "Creating a Blog Post."











48.5 Subscribing to a Blog

Users can subscribe to be notified whenever a blog entry is posted or commented upon in a space. Owning a blog does not automatically subscribe a blog owner to it. A blog owner must also explicitly subscribe to receive blog notifications. For information about how to subscribe to a blog, see Section 36.3.2, "Setting Space-Level Subscriptions." Whenever there is a change, you are notified through your selected messaging channel. For information about messaging channels, see Section 36.2, "Establishing and Managing Your Messaging Channels and Filters."

There is no subscription available for blogs in the Home space. However, you can subscribe to be notified of changes to specific blog posts. For information about subscribing to a specific blog post, see Section 48.7.5, "Managing Blog Posts."






48.6 Setting Blog Properties

The blog task flows and the Blog page style have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer.

The following sections provide information about properties of the blog task flows and Blog page style and describe the properties on the Parameters tab for each blog task flow and the Blog page style:

	
Section 48.6.1, "What You Should Know About Blog Properties"


	
Section 48.6.2, "Setting Blog Archives Task Flow Properties"


	
Section 48.6.3, "Setting Blog Banner Task Flow Properties"


	
Section 48.6.4, "Setting Blog Main View Task Flow Properties"


	
Section 48.6.5, "Setting Blog Viewer Task Flow Properties"


	
Section 48.6.6, "Setting Recent Posts Task Flow Properties"






48.6.1 What You Should Know About Blog Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. These properties are unique to the task flow type For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. This tab is available for a Blog page style, but not for blog task flows. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor.




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.







For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






48.6.2 Setting Blog Archives Task Flow Properties

The blog Archives task flow displays a composite list of blogs based on dates.




	
See Also:

Section 48.2.1, "Understanding the Blog Task Flows"







Properties that are unique to the Archives task flow are shown on the Parameters tab of the Component Properties dialog (Figure 48-16).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 48-16 Blog Archives Task Flow Properties

[image: blog_tf_arch_prp.gif]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



48.6.2.1 Blog Archives Task Flow Parameters

Table 48-2 describes the parameters that are unique to the blog Archives task flow.


Table 48-2 Blog Archives Task Flow Parameters

	Parameter	Description
	
Resource Id

	
The resource ID of the blog folder.














48.6.3 Setting Blog Banner Task Flow Properties

The blog Banner task flow displays a banner for the blog.




	
See Also:

Section 48.2.1, "Understanding the Blog Task Flows"







Properties that are unique to the blog Banner task flow are shown on the Parameters tab of the Component Properties dialog (Figure 48-17).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 48-17 Blog Banner Task Flow Properties

[image: Banner Task Flow Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



48.6.3.1 Blog Banner Task Flow Parameters

Table 48-3 describes the parameters that are unique to the blog Banner task flow.


Table 48-3 Blog Banner Task Flow Parameters

	Parameter	Description
	
Banner image URL

	
(Optional) The background image to be used in the blog banner. When not specified, the background image will default to an image provided by the current skin.


	
Resource Id

	
The resource ID of the blog folder.


	
Title

	
(Optional) The title to be used for the blog banner.

Default: The blog folder name.














48.6.4 Setting Blog Main View Task Flow Properties

The Blog Main View task flow displays a blog or blog post with a default design.




	
See Also:

Section 48.2.1, "Understanding the Blog Task Flows"







Properties that are unique to the Blog Main View task flow are shown on the Parameters tab of the Component Properties dialog (Figure 48-18).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 48-18 Blog Main View Task Flow Properties

[image: Blog Main View Task Flow Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



48.6.4.1 Blog Main View Task Flow Parameters

Table 48-4 describes the parameters that are unique to the Blog Main View task flow.


Table 48-4 Blog Main View Task Flow Parameters

	Parameter	Description
	
Hide Comments

	
Specifies whether the Comments feature is exposed:

	
Selected: Hide the Comments link and pane.


	
Cleared (default): Show the Comments link and pane.





	
Number of blog posts displayed

	
The number of blog posts displayed in the Blog Main View before the Next and Previous icons are enabled.

Default: 10


	
Resource Id

	
The target blog resource to display. This can be either a folder ID, in which case the blog listing for this folder will display, or a document ID, in which case the blog post will display.














48.6.5 Setting Blog Viewer Task Flow Properties

The Blog Viewer task flow displays a blog or blog post.




	
See Also:

Section 48.2.1, "Understanding the Blog Task Flows"







Properties that are unique to the Blog Viewer task flow are shown on the Parameters tab of the Component Properties dialog (Figure 48-19).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 48-19 Blog Viewer Task Flow Properties

[image: Blog Viewer Task Flow Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



48.6.5.1 Blog Viewer Task Flow Parameters

Table 48-5 describes the parameters that are unique to the Blog Viewer task flow.


Table 48-5 Blog Viewer Task Flow Parameters

	Parameter	Description
	
Hide Comments

	
Specifies whether the Comments feature is exposed:

	
Selected: Hide the Comments link and pane.


	
Cleared (default): Show the Comments link and pane.





	
Filter Month

	
A number from 1 to 12 specifying the target month used to filter blog entries. For this parameter to take effect, the Filter Year parameter must also be specified.

Example: 10 (October)


	
Number of blog posts displayed

	
The number of blog posts displayed in the Blog Digest Viewer before the Next and Previous icons are enabled.

Default: 10


	
Resource Id

	
The target blog resource to display. This can be either a folder ID, in which case the blog listing for this folder will display, or a document ID, in which case the blog post will display.


	
Filter Year

	
A Aour-digit number specifying the target year used to filter blog entries.

Example: 2012














48.6.6 Setting Recent Posts Task Flow Properties

The Recent Posts task flow displays a list of most recent blog posts.




	
See Also:

Section 48.2.1, "Understanding the Blog Task Flows"







Properties that are unique to the Recent Posts task flow are shown on the Parameters tab of the Component Properties dialog (Figure 48-20).




	
Tip:

For information about accessing the Component Properties dialog, see Section 17.5.2, "Setting Properties on Page Components."








Figure 48-20 Recent Posts Task Flow Properties

[image: Recent Posts Task Flow Properties]



For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



48.6.6.1 Recent Posts Task Flow Parameters

Table 48-6 describes the parameters that are unique to the Recent Posts task flow.


Table 48-6 Recent Posts Task Flow Parameters

	Parameter	Description
	
Recent Posts List Size

	
The number of recent posts to display.

Default: 10


	
Resource Id

	
The resource ID of the blog folder.
















48.7 Working with Blog Posts

The following sections describe how to add and manage blog post:

	
Section 48.7.1, "What You Should Know About Blog Posts"


	
Section 48.7.2, "Creating a Blog Post"


	
Section 48.7.3, "Viewing a Blog Post"


	
Section 48.7.4, "Editing a Blog Post"


	
Section 48.7.5, "Managing Blog Posts"






48.7.1 What You Should Know About Blog Posts

For each blog post, you can use the controls on the blog post page to perform tasks such as edit, subscribe to, share, and comment on the post (Figure 48-21). For information about these tasks, see Section 48.7.5, "Managing Blog Posts."


Figure 48-21 A Blog Post

[image: A blog post in the view mode]

Description of "Figure 48-21 A Blog Post"





When you create a blog post, a file is created in the content repository with the same name as the blog post title. Subsequently, you can change the blog post title when editing the blog post, but keep in mind that this changes only the display title; the name of the file for the blog post remains the original name. Therefore, you cannot later create a new blog post with the same initial title as the original title, as that file name already exists.

You use the Rich Text Editor (RTE) to add the content and style elements to a blog post. The RTE provides features such as the ability to embed images, create new resources on the fly, and add links. For more information, see Section 41.11, "Using the Rich Text Editor (RTE)."

By default, the entire content of a blog post gets displayed on the blog page. You can choose to display only a snippet. You can do this by using the Snippet icon in the RTE.

When you create a blog post, the blog post file is marked as a blog entry in the metadata Type field. Uploading an HTML file into a blog folder does not expose it as as blog post, unless its Type is set to blog.






48.7.2 Creating a Blog Post

To create a blog post:

	
Navigate to the blog in which you want to create a blog post.


	
Click New Post to open the Rich Text Editor (RTE).


	
In the RTE, in the Title field, enter a display name for the blog post (Figure 48-22), up to 250 characters.


Figure 48-22 Creating a Blog Post

[image: Creating a Blog Post]

Description of "Figure 48-22 Creating a Blog Post"





	
Add and preview the text, formatting, styling, and links in the Rich Text, HTML, Wiki Markup, and/or Preview tabbed panes. For information about RTE toolbar icons and controls, see Section 41.11, "Using the Rich Text Editor (RTE)."


	
On the Preview tab, choose a mode for publishing the blog post:

	
Draft: Select to mark the blog post as a draft. On a blog page, a draft blog post is marked as "Draft". Only the author of a blog post and space moderators can view draft posts. Users with just the viewing permissions can view only published posts.


	
Publish: Select to publish the blog post. On a blog page, a published post is marked as "Posted".

By default, a post is published with the current date and time details. If you want the blog post to be published on a future date and time, use the date picker. The blog post will be published automatically on the specified date.




	
Note:

The Activity Stream shows a blog post that has a publish date, regardless of the publish date. Only draft posts are not listed in the Activity Stream.











	
Click Create to save your changes and exit the editor.




The new blog post appears as the top-most entry in its blog (Figure 48-23).


Figure 48-23 Blog Page Displaying Blog Post

[image: Blog Page Displaying Blog Post]



On the Documents page in the space, the new blog post (Presidential Stamps) is saved as a document under its parent blog folder (MyBlog), which in turn, is stored under the Blogs folder, as shown in Figure 48-24.


Figure 48-24 Blog and Blog Post in the Document Hierarchy

[image: A blog post in the document hierarchy]

Description of "Figure 48-24 Blog and Blog Post in the Document Hierarchy"









48.7.3 Viewing a Blog Post

You can view a blog post by opening the page in which it resides, or by opening it as a document in the Document Viewer preview pane.

To view a blog post from a page in which it resides:

	
Open the page containing the blog task flow, or created used the Blog page style. The way you open the page depends on the page template in use in your space.

Figure 48-25 shows a blog post on a page in a space that uses a side navigation page template.


Figure 48-25 Opening a Blog Post from the Blog Page Style Mode

[image: Opening a blog post from Blog page style mode]

Description of "Figure 48-25 Opening a Blog Post from the Blog Page Style Mode"







To view a blog post in a Document Viewer preview pane:

	
On the Documents page or in a Document Manager, Document Explorer, or Folder Viewer task flow, navigate to the Blogs folder.


	
Open the blog folder that contains the blog post.


	
Click the blog post file to open it in the Document Viewer preview pane.

Figure 48-26 shows a blog post in the document hierarchy.


Figure 48-26 Opening a Blog Post in the Document Viewer Preview Pane

[image: Opening a blog post in Document Viewer preview pane]

Description of "Figure 48-26 Opening a Blog Post in the Document Viewer Preview Pane"





From the Document Viewer preview pane, if you want to view just the content of the blog post in a separate tab in your browser, click the View menu and choose Open in Browser.









48.7.4 Editing a Blog Post

You use the Rich Text Editor (RTE) to add or revise the content of your blog posts.

When you open a blog post for editing, Spaces automatically checks the file out. If another user is already editing a blog post when you try to open it, the Documents service displays a message that the blog post has already been checked out. On the Documents page or in a Documents service task flow, a lock icon displays alongside a blog post that is checked out. When you hover the mouse cursor over the lock icon, the name of the user who has checked out the blog post displays.

Whenever you save changes to a blog post, Spaces automatically checks the file in and creates a new version of the blog post. This means that the last saved version of a wiki blog post appears as the current version.

To edit a blog post:

	
Open your blog post in edit mode in any of the following ways, depending on your view:

	
On the Documents page, or in a Documents service task flow, click in the row of the blog post file you want to edit, then click the File menu and choose Edit, or right-click the file and choose Edit from the context menu to open the blog post in the RTE.


	
In the Document Viewer preview pane, click the Edit action.


	
In a blog page or a blog task flow, click the Edit icon for the required blog post.


	
In a blog page or a blog task flow, open the blog post by clicking its title, then click the Edit action.





	
In the RTE, add, revise, and preview text, formatting, styling, and links in the Rich Text, HTML, Wiki Markup, and/or Preview tabbed panes. For information about working with the RTE, see Section 41.11, "Using the Rich Text Editor (RTE)."


	
Select the Minor Edit? checkbox if you do not want to notify space members about your changes.

Leaving this checkbox cleared updates the Activity Stream and sends notifications after you save your changes.


	
Click Save to save your changes and continue editing, or click Save and Close to save your changes and exit the editor.









48.7.5 Managing Blog Posts

Table 48-7 lists the tasks that you can perform to manage blog posts, with links to the steps that describe how to perform each task for any kind of file.


Table 48-7 Managing Blog Posts

	Task	Description	Documentation
	
Opening a blog post for viewing

	
You can open a blog post on the Documents page or in a Documents service task flow.

If your blog post is exposed through a blog page, you can open the blog page to view the blog post in the page.

	
Section 48.7.3, "Viewing a Blog Post"



	
Downloading a blog post

	
You can download blog posts from the content repository to your local system. You can access the Download action from the Documents page, Documents service task flows, or the Document Viewer preview pane.

The Download action is not available when you open a blog post directly from the page that contains it.

Note: Spaces does not support uploading a blog post from the file system. If you upload an HTML file, you cannot convert it to a blog post due to differences in underlying metadata.

	
Section 41.12.2, "Downloading a File"



	
Renaming a blog post

	
You can rename a blog post as desired.

	
Section 41.13, "Renaming a Folder or File"

Section 41.22.2, "Working with File Properties"



	
Deleting a blog post

	
You can delete a blog post if it is no longer required.

	
Section 41.16, "Deleting Folders and Files"



	
Viewing and adding tags to a blog post

	
You can add tags to a blog post to specify keywords related to the content of the post to make it more widely discoverable in search results.

	
Section 41.20, "Working with Tags"



	
Viewing, adding, and deleting comments on a blog post

	
You can associate comments with a blog post to provide additional information that you may want to convey to other users about it.

Note: A user with view-only permissions can add comments to a blog post.

	
Section 41.19, "Viewing, Entering, and Deleting Comments on a File"



	
Viewing and deleting versions of a blog post

	
Every time you save a blog post, Spaces saves a new version of the post and maintains the version history.

	
Section 41.21, "Viewing and Deleting File Version History"



	
Viewing and modifying properties of a blog post

	
You can view the basic and advanced properties associated with a blog post. However, you can modify only the name and description of a blog post.

	
Section 41.22.2, "Working with File Properties"



	
Viewing and adding links to a blog post

	
You can add links from a blog post to a discussion, document, event, note, or URL to provide a way to view, access, and associate related information.

	
Section 41.23, "Working with Links"



	
Opening or saving blog posts as PDF files

	
You can open or save the PDF version of the currently open blog post. This choice is available if Content Server is configured to convert blog posts to PDF format, and your application administrator must configure the WebCenter Conversion component, as described in "Enabling the Conversion of Wikis and Blogs into PDFs" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

	
Section 41.25, "Opening or Saving PDF Files"



	
Sharing the URL of a blog post

	
You can directly access a blog post by using its URL. You can share the link by publishing it to the Activity Stream or sending the link in a mail message.

	
Section 41.26, "Sharing the URL for a Folder or File"



	
Setting security options for a blog post

	
You can specify whether you want to use custom access permissions or inherit the permissions of the parent folder for a blog post.

The option to set security for a blog post is available if item level security has been enabled on Content Server.

The Security option is available when you open a blog post using the Documents page or a Documents service task flow. It is not available when you open the post directly from the page that contains the post.

	
Section 41.27, "Setting Security Options on a Folder or File"



	
Subscribing to a blog post

	
You can subscribe to a blog post to monitor activities such as when a user posts comments, updates, or deletes a blog entry. You are notified through your selected messaging channel.

	
Section 41.28, "Subscribing to a File" and Section 36.3.3.3, "Subscribing to a Blog Entry"


	
Liking or unliking a blog post

	
To indicate that a blog post is of particular interest to you, you can "like" it. If a post is already liked, you can "unlike" it if you no longer wish to highlight your preference.

	
Section 41.29, "Liking and Unliking a File"


















Part XI


Planning and Building a Space

Part XI of the User's Guide describes how to build and manage spaces other than Home spaces (for information about Home spaces, see Chapter 29, "Exploring the Home Space"). It includes general information about spaces as well as the specifics of managing space members and roles, administering space resources, and working with a space hierarchy that includes subspaces.

Part XI includes the following chapters:

	
Chapter 49, "Understanding Space Basics"


	
Chapter 50, "Working with Space Templates"


	
Chapter 51, "Managing a Space"


	
Chapter 52, "Managing Space Members and Roles"


	
Chapter 53, "Administering Spaces and Templates"


	
Chapter 54, "Working with a Space Hierarchy"










49 Understanding Space Basics

WebCenter Portal: Spaces supports the formation and collaboration of project teams and communities of interest through spaces. A space provides a dedicated and readily accessible area for relevant services, pages, and content and supports the inclusion of specified members, each of whom have defined roles associated with permissions in the space. Spaces bring people together in a virtual environment for ongoing interaction and information sharing—in essence, spaces enable the formation and support of social networks.

This chapter provides information about working with spaces. It contains the following sections:

	
Section 49.1, "What You Should Know About Spaces"


	
Section 49.2, "What Does a Space Look Like?"


	
Section 49.3, "Interacting with Spaces Before Logging In (Public User)"


	
Section 49.4, "Viewing Available Spaces"


	
Section 49.5, "Viewing Information About a Space"


	
Section 49.6, "Searching for a Space"


	
Section 49.7, "Joining a Space"


	
Section 49.8, "Searching in a Space"


	
Section 49.9, "Viewing Pages in a Space"


	
Section 49.10, "Showing or Hiding Pages in Your View of a Space"


	
Section 49.11, "Creating Your Own Page in a Space"


	
Section 49.12, "Managing Your Pages in a Space"


	
Section 49.13, "Editing Your Pages in a Space"


	
Section 49.14, "Removing All of Your User Customizations from a Page"


	
Section 49.15, "Copying a Page to Your View of a Space"


	
Section 49.16, "Renaming Your Pages in a Space"


	
Section 49.17, "Controlling User Access to Your Space Pages"


	
Section 49.18, "Deleting Your Pages in a Space"


	
Section 49.19, "Exposing a Space Page in Your View of the Home Space"


	
Section 49.20, "Sending a Link to a Page in a Space"


	
Section 49.21, "Viewing Information About a Page in a Space"


	
Section 49.22, "Changing Your Role in a Space"


	
Section 49.23, "Cancelling Space Membership"





Audience

This chapter is intended for Spaces users who want to learn more about working with spaces in a Spaces application.



49.1 What You Should Know About Spaces

Within any company, large groups or departments frequently must break into smaller groups to focus on a particular goal, project, or even topic. Or, outside of a professional environment, communities of people with a common interest may wish to share and post information to foster the community. To help these groups organize themselves, Spaces provides the notion of spaces, which bring content together through a single access point, accessible through the Spaces application or by direct URL, to help groups of people share information and interact in a collaborative social network. For example:

	
Internal departments within your company that must share common information, such as HR, Sales, and so on.


	
Software projects that must bring together the efforts and input of Development, Quality Assurance, Product Management, Documentation, and Curriculum Development.


	
Special interest groups that share a common interest in a particular topic.




Many features and tools to facilitate teamwork are built into the space framework, instantly allowing space members to share documents, discuss issues, schedule meetings, exchange messages, create lists, and much more. Spaces can be monitored through RSS feeds, which you can add to your personalized view of the Home space or view in any external RSS reader.

Spaces provides templates for creating spaces that support different types of endeavors. The flexibility of space templates means that every space can have a different look and feel. You can use an out-of-the-box template, or create your own custom templates using an existing space as the basis for the template. For information about space templates, see Chapter 50, "Working with Space Templates." After creation, Spaces can be completely customized, including the navigation controls, the color scheme, and the look and feel of any task flow or portlet, all from within the browser.

When you create a space, you are the space moderator. As the moderator, you manage the space and establish the rules for membership to a space (see Section 52.1, "Setting Up the Membership Policy for a Space"). When a new space is created, Spaces creates default space roles with default permissions. The space moderator can assign space members to these roles and modify the default permissions as required, or create new custom roles (see Section 52.2, "Managing Roles and Permissions for a Space" and Section 52.3, "Managing Members and Assigning Roles").

Any space can be parent to one or more subspaces. This allows you to develop a space hierarchy. For more information, see Chapter 54, "Working with a Space Hierarchy."






49.2 What Does a Space Look Like?

A newly created space may look similar to Figure 49-1 (side navigation) or Figure 49-1 (top tabbed navigation). It is important to realize, however, that your Spaces administrator or the space moderator has most likely created and applied a custom page template to expose or hide tabs, features, and display a unique look and feel for your organization. A new space that you create may look nothing like these examples.


Figure 49-1 Home Page of a New Space Using the Default Side Navigation Page Template

[image: New Space Using Side Navigation Page Template]




Figure 49-2 Home Page of a New Space Using the Default Top Navigation Page Template

[image: New Space Using Top Navigation Page Template]



Each page in a space provides access to related information. In the example space above, the Home page summarizes important information about the Philatelists club, the Documents page lists folders and files associated with the Philatelists club, the Discussions page provides a view of ongoing discussions with discussion forum management features, and so on. The space moderator (or any space member assigned the Moderator role or a custom role that includes the Spaces-Manage Configuration permission) uses the pages available through the space administration settings to build and manage the space, expanding and customizing it as needs change and grow. For information about administration tasks in a space, see Chapter 50, "Working with Space Templates," Chapter 51, "Managing a Space," Chapter 52, "Managing Space Members and Roles." For information about adminstering all spaces and space templates as the Spaces application administrator, see Chapter 53, "Administering Spaces and Templates."






49.3 Interacting with Spaces Before Logging In (Public User)

Public spaces are available to anyone with Internet access, without logging in to Spaces, allowing a space to be shared with non-members and people outside of the Spaces community.

Public users who are not registered Spaces users can access public spaces in two ways:

	
Directly, using the space URL provided to them.


	
From the Spaces Welcome page, if their installation is configured to display this page (Figure 49-3).


Figure 49-3 Public Spaces Link on Welcome Page

[image: Public Group Spaces link on Welcome page]

Description of "Figure 49-3 Public Spaces Link on Welcome Page"







The Spaces administrator controls what a public user can see or do at the application level. For more information, see Section 21.2.4, "Granting Permissions to the Public-User."

When a space is made public, the Public-User role in the space is automatically granted View Pages and Content permission in the space, which allows public users to view pages, lists, events, links and notes. To view announcements, discussions, and documents, the space moderator must explicitly grant these permissions, as described in Section 51.14.5, "Granting Public Access to a Space." The public permissions granted by the space moderator override the public permissions set by the administrator at the application level.






49.4 Viewing Available Spaces

You can participate in multiple spaces and manage your space memberships through the Spaces Switcher menu, a Spaces Browser task flow, or the Spaces page, which displays all the spaces that are available to you.

To display a list of available spaces:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

Your Spaces application may provide other ways to access the Spaces available to you. See Section 29.3.1, "Opening Spaces."








	
On the Spaces page, from the Show list, choose:

	
All Spaces (Figure 49-4) to show all spaces that are available to you, both public and private. Spaces defined as hidden when created are not shown.


Figure 49-4 Showing All Spaces

[image: Show All Spaces]

Description of "Figure 49-4 Showing All Spaces"





	
Joined by Me to display spaces of which you are a member.


	
Moderated by Me to display names of spaces for which you have moderator privileges.


	
Closed Spaces to display Spaces available to you that have been closed by the space moderator (see Section 51.4.5, "Closing or Reactivating a Space"). The content of a closed space remains accessible and searchable to those who still want to reference it and space members can continue working in the space either by selecting Closed Spaces as described here, or by direct URL (http://host:port/webcenter/spaces/space name.





	
To list one or more specific spaces, enter a full or partial search term in the Filter field, then click the Filter icon to refresh the list with all spaces for which a match is found in the Display Name, Description, or Search Keywords (specified on the General page in the administration settings for the space).


	
To clear the current search string and display all spaces, click the Clear Filter icon.


	
To refresh the list of spaces, first ensure that any prior search is cleared (click the Clear Filter icon), then click the Refresh icon.


	
To go to the Home page of a space, click the space name or icon.


	
To display a menu of actions available on the space, right-click a space icon or name to explore the actions that are available to you, depending on your permissions in the space (Figure 49-5):


Figure 49-5 Space Actions Menu

[image: Space Actions Menu]






	
Note:

Space administration selections (Manage Settings, Rename Space URL, and Delete the Space) are shown only if you are the space moderator or have Manage Configuration permission on the space.







Choose:

	
Manage Settings to open the space administration settings pages. See Chapter 51, "Managing a Space."


	
Rename Space URL to change a space URL that other people use to navigate to the space. See Section 51.14.2, "Changing a Space URL."


	
Delete the Space to delete the space. See Section 51.17, "Deleting a Space."


	
Contact menu:

	
Subscribe to open the Subscribe dialog, where you can select notification messages that you want to receive whenever the listed actions occur within the scope of the space. See Section 36.3.2, "Setting Space-Level Subscriptions."


	
Send Mail to Members and Send Mail to Moderators. See Section 51.15, "Sending Mail to Space Members or Moderators."





	
Membership menu:

	
Change Role to change your role in the space. See Section 49.22, "Changing Your Role in a Space"


	
Cancel Membership to cancel your membership in the space. See Section 49.23, "Cancelling Space Membership".





	
About menu:

	
About this Space to view information about the space. See Section 49.5, "Viewing Information About a Space."


	
Similar Spaces to open the Similar Spaces dialog, which provides suggestions of other spaces similar to the current space. A space is considered similar to another space if the same people perform similar actions in it, especially if they edit the content. Similar Spaces is provided by the Activity Graph service. For more information, see Chapter 58, "Working with the Activity Graph Service."


	
Share Link to share the URL link to the space with others. See Section 51.14.1, "Publishing the Link to a Space."















49.5 Viewing Information About a Space

To view information about a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

Your Spaces application may provide other ways to access the Spaces available to you. See Section 29.3.1, "Opening Spaces."








	
On the Spaces page, locate the space that you want to learn about (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose About, then About this Space (Figure 49-6).


Figure 49-6 Space Actions Menu: About this Space (for non-moderator role)

[image: Space Actions Menu: About this Space]



The About Space dialog opens (Figure 49-7).


Figure 49-7 About Space Dialog (for non-member)

[image: About Space Dialog]



	
Explore the information in the About Space dialog:

	
Name: Internal name of the space displayed in the space URL. To change the internal space name, see Section 51.14.2, "Changing a Space URL." Caution: When you change the internal space name, bookmarks to the space must be updated as they will no longer work.


	
Display Name: Display name of the space. This name displays at the top of the space and other places where spaces are available for selection, such as the Spaces Switcher menu and the Spaces page. To change the space display name, see Section 51.4.1, "Renaming a Space." Changing the display name does not impact the URL that people use to navigate to the space.


	
Internal ID: ID of the space, which other applications may use to reference this space.


	
Description: A description of the space, specified when creating the space or in the space administration settings, as described in Section 51.4.2, "Modifying the Description or Keywords for a Space."


	
Membership: Your role in the space. If you are not a member of this space and the space allows self-service membership, a Join Space button displays here. See Section 49.7.1, "Joining a Space (Registered Spaces User)."


	
Created By: User name of the space creator.


	
Date Created: Date and time that the space was created.


	
Explorer URL: URL used expose the folders and files in a space using Windows Explorer. See Section 46.4.1, "Adding a Space as a Network Place."


	
Direct URL: URL that provides direct access to the space.












49.6 Searching for a Space

To search for a space by a string in the Name or Description:

	
On the Spaces page (see Section 49.4, "Viewing Available Spaces"), enter a search string in the Filter field.


	
Click the Filter icon (Figure 49-8).


Figure 49-8 Filter Icon

[image: Filter Icon]



The Spaces page displays spaces where the search string is found in the Name or Description.


	
To clear the current search string and display all spaces, click the Clear Filter icon (Figure 49-8).


Figure 49-9 Clear Filter Icon

[image: Clear Filter Icon]










49.7 Joining a Space

To become a member of a space, you can join the space. You may be registered with Spaces, or you may be a public user. If a space allows self-service membership (see Section 52.1.1, "Managing Self-Service Membership for a Space"), you can request membership to the space. Or, you may receive an invitation to join a space.

This section includes the following subsections:

	
Section 49.7.1, "Joining a Space (Registered Spaces User)"


	
Section 49.7.2, "Joining a Space (Unregistered Spaces User)"






49.7.1 Joining a Space (Registered Spaces User)

To become a member of a space, you can join the space. If a space is configured to allow self-service membership, you can request membership to the space. Or, you may receive an invitation to join a space.

Some membership requests require approval from the space moderator so you may not gain access immediately. You will receive a Worklist notification when your membership is approved.

To join a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

Your Spaces application may provide other ways to access the Spaces available to you. See Section 29.3.1, "Opening Spaces."








	
On the Spaces page, from the Show menu, choose All Spaces.


	
To join a space, you may have several options available to you, depending on the page template in use. For example, you may be able to simply click a space to open the Request Membership dialog.

A generally available method to join a space is through the About Space dialog: right-click the space icon or name, and choose About, then About this Space (Figure 49-10).


Figure 49-10 Space Actions Menu: About this Space (for non-moderator role)

[image: Space Actions Menu: About this Space]



	
In the About Space dialog, next to Membership, click Join Space (Figure 49-11).


Figure 49-11 About Space Dialog (for non-member)

[image: Group Space Information Dialog Box]






	
Note:

Join Space is active only if the space allows self-service membership (see Section 52.1.1, "Managing Self-Service Membership for a Space"). If Join Space is disabled, contact the space moderator directly to request membership.







A space membership request page similar to Figure 49-12 opens, showing the default Request Membership page. Because the space moderator may customize this page, the page and roles you see may be different to the example shown here.


Figure 49-12 Requesting Space Membership

[image: Requesting Space Membership]

Description of "Figure 49-12 Requesting Space Membership"





	
Select the type of Role you want to play in this space.




	
Note:

Out-of-the-box space roles include Viewer, Participant, and Moderator, but a subset of these or other custom roles names may display, depending on what roles the space moderator has defined for the space.








	
(Optional) In the Purpose field, enter an explanation of why you need access to the space with the role you have requested.


	
Click Request Membership.

You should see a confirmation message similar to Figure 49-13, depending on whether or not the selected role requires moderator approval.


Figure 49-13 Confirmation Message (No Approval Required)

[image: Confirmation Message (No Approval Required)]



	
Click OK.


	
On the Spaces page, click the Refresh icon to confirm your new membership status.




	
Note:

If membership requests require approval, you do not gain access immediately. Check back later or monitor your Worklist—you will receive notification as soon as your membership is approved.















49.7.2 Joining a Space (Unregistered Spaces User)

If you are not a registered Spaces user, you can still view public Spaces, but you cannot join a space unless you receive a mail message from the space moderator inviting you to join a space (see Section 52.3.4.5, "Inviting a Non-Registered User"). If you want to join a space, you must become a registered Spaces user.

Some membership requests require approval from the space moderator so you may not gain access immediately. You will receive a Worklist notification when your membership is approved.

	
In the mail message you receive inviting you to join a space, click the Register Yourself link included in the invitation mail to open the Self-Registration page, similar to Figure 49-14. Because the space moderator may customize this page, the page you see may be different to the example shown here.




	
Note:

For the Self-Registration page to display, the membership options for the space administration settings must have either of the following enabled:
	
Allow Self-Service Membership or Self-Service Membership Change (All Roles Available)


	
Allow Self-Service Membership or Self-Service Membership Change (Selected Roles Available)




For more information, see Section 52.1.1, "Managing Self-Service Membership for a Space."










Figure 49-14 Registering with Spaces

[image: Self-Registration page]



	
Choose a suitable User Name. The user name restrictions depend on the underlying identity store that is configured with Spaces.

Click Check User Name Available to determine whether a Spaces user is registered with that name. Click OK to dismiss the confirmation message and, if necessary, enter a different name.


	
Enter a suitable Password, and then Re-enter Password for verification. The password restrictions depend on the underlying identity store that is configured with Spaces.


	
Enter your First Name and Last Name, and an Email Address.


	
Click Register.




Once your User Name and Password are registered with Spaces, the space to which you were invited opens.








49.8 Searching in a Space

Spaces includes the Search field at the top of the application for global (that is, application-wide) searches. To perform searches limited to a single space, the space administrator must create a new Resource Catalog, add the Search task flow from the library to the Catalog, and then assign this Catalog to the space. The Search task flow is not available in the default Resource Catalog. For more information, see Section 56.4, "Narrowing the Scope of Search."

To search for individual pages in a space, see Section 51.7.4, "Searching for Pages in a Space."






49.9 Viewing Pages in a Space

In a space, members have access to system pages (see Table 7-2, "Seeded System Pages") and member-created pages. The content on a space page is typically targeted to a particular audience or objective.

The way that you access the pages of a space depends on the page template that is defined for the space. At the application level, the Spaces administrator can define the page template to be used for all new spaces, but anyone with Manage Configuration permission on a space can modify the page template of an individual space (see Section 51.4.9, "Changing the Page Template for a Space").




	
Note:

If you view a page at the same time that another user is editing the page, you may not immediately see the results of changes made by the other user in your session. To reliably see any changes, you must view the page after the other user has saved their edits.












49.10 Showing or Hiding Pages in Your View of a Space

To show or hide pages in your personal view of a space:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.








	
On the Personalize Pages page, select or clear the Show Page checkbox for the pages you want to show or hide.









49.11 Creating Your Own Page in a Space

If you are granted permission to create pages (see Table 52-2, "Space Permissions - Simple Permission Model"), you can add your own pages to a space.

The pages you create can be viewed by you and anyone to whom you grant access (see Section 49.17, "Controlling User Access to Your Space Pages").

To create your own page in a space:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.








	
On the Personalize Pages page, click Create Page (Figure 49-15)


Figure 49-15 Creating Your Own Page in a Space

[image: Creating Your Own Page in a Space]



	
In the Create Page dialog, specify the name and style for the new page.

For detailed information about each page style, see Section 15.1, "What You Should Know About Page Styles."




The new space page opens in edit mode (Composer), where you can add content, then Save and Close the page.




	
See Also:

For information about adding content to a space page, see:
	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components"

















49.12 Managing Your Pages in a Space

Space moderators and members with page management permissions (see Table 52-2, "Space Permissions - Simple Permission Model") can manage space pages at the application level on the Pages page in the administration settings for the space, which configures the default page settings for all members of the space. For more information, see Section 51.7, "Creating and Managing Space Pages."

As a space member, you can manage your pages in the space. The actions available to you depend on the permissions you are granted in the space or on a particular page. If you have permissions to delete, edit, or set access privileges to a page, performing these actions affect all members in the space as these actions alter the page itself. Actions such as reordering or showing and hiding pages is reflected in your "personal" view of the space only.

To manage your pages in a space:

	
In the space, display the Personalize Pages page (Figure 49-16)




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.








Figure 49-16 Personalize Pages Page

[image: Manage Pages Dialog]



	
On the Personalize Pages page, perform any of the actions available to you on the the Actions menu for a specific page (Figure 49-17):


Figure 49-17 Personalize Pages: Page Actions Menu

[image: Personalize Pages: Page Actions Menu]



	
Edit Page. Edit a page that you own or have privileges to edit. See Section 49.13, "Editing Your Pages in a Space."


	
Reset Layout. Remove all of your user customizations from a selected page. This action removes such personal changes as rearrangement, resizing, or collapsing of task flows in only your view of the page. See Section 49.14, "Removing All of Your User Customizations from a Page."


	
Copy Page. Make a personal copy of a page. See Section 49.15, "Copying a Page to Your View of a Space."


	
Rename Page. Rename a page that you own or have privileges to manage. See Section 49.16, "Renaming Your Pages in a Space."


	
Set Page Access. Add or remove access to a page by user role. See Section 49.17, "Controlling User Access to Your Space Pages."


	
Delete Page. Delete a page that you own or have privileges to manage. See Section 49.18, "Deleting Your Pages in a Space."


	
Add to Home Space. Add a page to your personal view of the Home space. See Section 49.19, "Exposing a Space Page in Your View of the Home Space."


	
Send Mail. Send a link to a page that you own or have privileges to manage. See Section 49.20, "Sending a Link to a Page in a Space."


	
About This Page. View information about a page. See Section 49.21, "Viewing Information About a Page in a Space."












49.13 Editing Your Pages in a Space

If you own or have write permissions on a page, you can edit the page. However, you should be aware that edit actions affect all members in the space as these actions alter the page itself, not only your personalized view.

To edit a page that you own or have permission to edit:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Edit Page to display the page in edit mode (Composer).




	
See Also:

For information about adding content to a space page, see:
	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components"


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components"




















49.14 Removing All of Your User Customizations from a Page

To remove all of your user customizations, such as rearrangement, resizing, or collapsing of task flows in only your view of a page:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Reset Layout to open the Reset Layout dialog.


	
To confirm your intent to remove all of your user customization from the page, click Reset.









49.15 Copying a Page to Your View of a Space

To copy a page in a space for your own purposes:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Copy Page to open the Copy Page dialog.




The new page is available only to you, unless you make it available to others (see Section 49.17, "Controlling User Access to Your Space Pages."






49.16 Renaming Your Pages in a Space

If you own or have privileges to manage a page, you can rename the page. However, you should be aware that renaming a page affects all members in the space as this action alters the page itself, not only your personalized view.

When you rename a page, keep in mind that any pretty URLs that use the old name will be broken. Also note that system pages, such as the Announcements, Lists, and Events pages, do not provide the option of being renamed.




	
See Also:

For information about pretty URLs, see Appendix A, "Spaces User Interface URLs."







To rename a page that you own or have privileges to manage:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Rename Page to open the Rename Page dialog.


	
Enter a new name for the page, and click the Save icon.









49.17 Controlling User Access to Your Space Pages

By default, the pages you create in a space are accessible only to you and other space members assigned the Moderator role or a custom role that includes the Spaces-Manage Configuration permission. You can use page access settings to enable other members to view and work with your pages and to remove that access.

When you grant access to one of your own space pages to another user, the other user must deliberately show the page in his or her view. The user must take this step for each session because shared pages are not automatically shown on login.




	
See Also:

For information about how to show a hidden page, see Section 49.10, "Showing or Hiding Pages in Your View of a Space."







To control the access for other space members to your pages:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Set Page Access to open the Set Page Access dialog (Figure 49-18).


Figure 49-18 Set Page Access Dialog

[image: Set Page Access dialog box]



	
Select the Access Method:

	
To specify that the page should inherit access settings from the permissions established for the space, select Use Application Permissions, then click OK to save your changes and exit the dialog. For information about setting global space permissions, see Section 52.2, "Managing Roles and Permissions for a Space."


	
To set custom access on the current page, select Use Custom Access Settings, and continue with the next steps.





	
To grant page access permissions to all authenticated users (that is, to users who are logged in to Spaces), click Add Authenticated Access.

The role authenticated-role is added under Role or User with default Read access to the page.


	
To grant page access permissions to all public users, that is, users who have not logged in to Spaces, click Add Public Access.

The role anonymous-role is added under Role or User with default Read access to the page.


Figure 49-19 Authenticated and Public User Read Access to a Page

[image: Authenticated and Public User Read Access to a Page]



	
To grant page access permissions to selected users, groups, and application roles, click Add Access to open the Add Access dialog (Figure 49-20).


Figure 49-20 The Add Access Dialog

[image: Add Access dialog box]

Description of "Figure 49-20 The Add Access Dialog"





	
In the Search field, enter a search term or the name of the user, group, or role for whom you want to enable access, and click the Search icon. For tips on searching for a user or group in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
Note:

In the Add Access dialog, you can add the default roles Moderator, Participant, and Viewer, and any custom roles that have been created for the space.
For more information about space roles, see Section 52.2, "Managing Roles and Permissions for a Space"










	
Select a user, group, or role by clicking in its row.




	
Note:

When you select a user name, the permissions you set are granted to that specific user. When you select a group or application role, the permissions you set are granted to all users who are members of that group or who are assigned that role.







To make multiple selections:

	
Ctrl-Click to select multiple rows.


	
Shift-Click to select a range of rows.





	
Click Select to close the Add Access dialog, and populate the Set Page Access dialog with the selected users, group, or roles (Figure 49-21).


Figure 49-21 Set Page Access Dialog

[image: Set Page Access dialog]



	
In the Set Page Access dialog, set the Page Access permissions as desired for each user, group, or role (Table 49-1).




	
Note:

If you set page access permissions for the anonymous-role (public users), the space must also be made public to allow this page to be seen by public users. See Section 51.14.5, "Granting Public Access to a Space."








Table 49-1 Page Access Privileges in the Set Page Access Dialog

	Icon	Name	Description
	
[image: View Page icon]


	
View Page

	
Users can access the page for viewing, but cannot perform any other actions on the page.


	
[image: Personalize Page icon]


	
Edit Page

	
Users can edit the page using Composer. This includes adding, rearranging, and deleting content; renaming the page; and changing page properties, such as the page scheme.


	
[image: Delete Page icon]


	
Delete Page

	
Users can delete the page.


	
[image: Manage Page icon]


	
Perform All Page Actions

	
Users can perform all actions on the page.


	
[image: Edit Page icon]


	
Personalize Page

	
Users can rearrange page content and personalize his or her view of task flows, provided the task flow includes personalization settings.











	
Tip:

By default, all authenticated users and user roles that you add to the Set Page Access dialog are granted page view access. The other access privileges must be explicitly granted.








	
If you wish to delete access to the page for a user role, select the user or role from which to revoke page access, and click Delete Access (Figure 49-22).


Figure 49-22 Delete Access Button

[image: Delete Access button]



	
Click OK to save your changes and close the Set Page Access dialog.









49.18 Deleting Your Pages in a Space

If you own or have manage permissions on a page, you can delete the page. However, you should be aware that deleting a page affects all members, not only your personalized view.

To delete a page that you own or have permission to manage:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Delete Page to display the Delete Page dialog.


	
Confirm deletion of the page, and click Delete.









49.19 Exposing a Space Page in Your View of the Home Space

You can make a space page is available for viewing and revising from within your view of the Home space according to your permissions on the page. The space name is prepended to the page name, so the Sales Results page in the space Finance becomes Finance - Sales Results in your view of the Home space.




	
Note:

System pages that are exposed in a space, such as Events, Lists, and Announcements, do not provide the option of being exposed in the Home space. For information about System pages, see Section 7.3, "Working with System Pages."







If you delete such a page from your view of the Home space, it remains a part of its original space. In other words, deleting it simply removes it from your view of the Home space; it does not actually delete the page. If the page is deleted from its parent space, it is unavailable in your view of the Home space. To clear it from your view, you must refresh the page list in the Home space's Personalize Pages page.

To add a space page to the list of pages in the Home space, visible only to you in your personalized view of the Home space:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and select Add to Home Space.




When you add a space page to your view of the Home space, the page scope remains that of the space.






49.20 Sending a Link to a Page in a Space 

If you own or have manage permissions on a page, you can send other space members a link to the page.

To send mail to other space members populated with a link to a particular page:

	
In the space, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose Send Mail to open your mail application compose window, showing a URL link to the page.









49.21 Viewing Information About a Page in a Space

To view information about a page that you can view in a space:

	
In the space administration settings, display the Personalize Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Personalize Pages page, click the Actions icon for the page, and choose About This Page to open the Page Information dialog, which shows Name, Created By, Date Created, Last Modified, and Direct URL.









49.22 Changing Your Role in a Space

If you are unable to perform all the actions that you would like in your space, you can request a change to your membership role. For example, you might want to participate in an interesting discussion thread or raise a new issue but in your current role you are only allowed to view ongoing discussions.

Role change requests may or may not require approval, depending on how the space moderator has defined membership changes for a particular role (see Section 52.1.1, "Managing Self-Service Membership for a Space"). You will receive a Worklist notification when your new role is approved.

To change your space role:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

Your Spaces application may provide other ways to access the Spaces available to you. See Section 29.3.1, "Opening Spaces."








	
On the Spaces page, locate the space in which you want to change your role (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose Membership, then Change Role (Figure 49-23).


Figure 49-23 Change Membership Role

[image: Change Membership Role]



	
In the Change Membership dialog (Figure 49-24), choose your preferred role from the New Role list.




	
Note:

The New Role list is active only if the space allows self-service membership changes (see Section 52.1.1, "Managing Self-Service Membership for a Space"). If New Role selections are disabled, contact the space moderator directly to request a member role change.







If you wish to cancel your membership in the space, click Cancel Membership.


Figure 49-24 Change Membership Dialog

[image: Change Membership Dialog]



The space moderator controls the list of roles displayed here. Out-of-the-box space roles include Viewer, Participant, and Moderator but a subset of these or other custom roles may display. For more information, see Section 52.1.1, "Managing Self-Service Membership for a Space"


	
Click OK.

A confirmation message displays whether or not the selected role change requires approval.


	
Click OK to acknowledge the confirmation message.


	
On the Spaces page, click the Refresh icon to confirm your membership status has changed for the space.




	
Note:

Your new role is not effective immediately when membership change requests require approval. Check back later or monitor your Worklist; your new role will be effective as soon as the space moderator approves it.















49.23 Cancelling Space Membership

When you no longer want or need membership in a space, you can cancel your membership.

Some cancellation requests require approval from the space moderator so you may not be removed from the space immediately (see Section 52.1.1, "Managing Self-Service Membership for a Space"). You will receive a Worklist notification when your membership is removed.

Once you have successfully cancelled your membership in a space, it will no longer be shown on the Spaces page when you select Joined by Me from the Show menu.

To cancel your membership in a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

Your Spaces application may provide other ways to access the Spaces available to you. See Section 29.3.1, "Opening Spaces."








	
On the Spaces page, locate the space from which you want to remove your membership (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose Cancel Membership (Figure 49-23).


Figure 49-25 Cancelling Space Membership

[image: Cancelling Space Membership]



A confirmation message displays to confirm that you want to cancel your membership in the space.


	
Click OK to acknowledge the confirmation message.


	
On the Spaces page, select Joined by Me from the Show menu, then click the Refresh icon to confirm that the space no longer displays.




	
Note:

If a cancellation request requires approval, you are not removed from the space immediately. Check back later or monitor your Worklist; you will receive notification when your unsubscription request is approved or rejected by the space moderator.


















50 Working with Space Templates

If you have been granted the Spaces-Create permission by the WebCenter Portal: Spaces administrator, you can create a space using one of the out-of-the-box space templates, your own custom space template, or a published space template created by others. Space templates provide a consistent look and feel and an efficient way to get started creating a space that is configured exactly as required by an organization.

This chapter includes the following sections:

	
Section 50.1, "What You Should Know About Space Templates"


	
Section 50.2, "Creating a Custom Space Template"


	
Section 50.3, "Managing Space Templates"





Audience

This chapter is intended for users who want to know more about space templates, create custom space templates, and manage space templates.

To perform the tasks described in this chapter, users need to be assigned a role that includes the Manage Configuration and Manage Membership permissions. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."

The Spaces administrator has the authority to expose or hide some features and services for all spaces. Contact your administrator if some tasks discussed in this chapter are not available to you.



50.1 What You Should Know About Space Templates

When you create a space, you can base it on a template, either provided out-of-the-box by Spaces or a custom template that you or the Spaces administrator design, as described in the following sections:

	
Section 50.1.1, "Understanding Out-of-the-Box Space Templates"


	
Section 50.1.2, "Understanding Custom Space Templates"






50.1.1 Understanding Out-of-the-Box Space Templates

Spaces provides several space templates out-of-the box from which you can choose when creating a new space. These templates are named according to their general purpose, and can be used as a starting point for developing your own custom templates.

The out-of-the-box space templates are:

	
Blogger: Template for a space where members can publish their opinions through blogs, and preconfigures announcements, discussions, documents, events, lists, and mail.


	
Discussion Site: Template for a space where members can exchange ideas in discussion forums to quickly resolve issues, come up with new product ideas, resolve customer escalations, determine new service offerings, and more.


	
Document Exchange: Template for a space centered around sharing and organizing documents to enable teams to quickly hone in on delivering agreed upon wording and messaging. This template also enables checkin and workflow around document approvals and working in teams.


	
Portal Site: Template for a space appropriate for a large organization with several smaller groups or departments, each of which needs to store their own content, engage in discussions, and more. This template speeds enterprise portal construction and delivery and enables teams to easily provide their unique value to the company, promoting their group's charter to all other organizations while securely collaborating within their team or organization.

This template provides an essentially unpopulated, unconfigured starting point for building a space exactly to your specifications. When you create a space using this template, it results in a blank Home page. All space services such as discussions, announcements, and so on, are disabled.


	
Project Site: Template for a space where members can share information about a common project and maintain a common calendar. This template provides an optimal structure for supporting a core project team where members might come from different departments to work together toward reaching a common goal.

The focus of a space based on this template is to streamline the process of starting a new project, defining the project team, and executing on project deliverables. Members can share documents, communicate with one other, keep up to date on status, and generally function better as a team than as individuals working side by side.


	
Team Site: Template for a space that provides an optimal structure for supporting communities of people who are working together to achieve a common goal, collaborating through document sharing, team announcements, discussion forums, mail, wikis, and more.

The focus of a space based on this template is to learn more about a subject area through the sharing of expertise, ideas, and content. Team Site spaces provide a consistent, dynamic, timely, and interactive participant experience. For example, all the Java programmers responsible for supporting your customer-facing Web site might want a place to keep up with what's happening in the Java world using discussion forums, links to articles about upcoming patches, and so on.







	
Note:

The out-of-the-box space templates available in prior releases (Basic, Community of Interest, and Group Project) are deprecated. However, if needed, you can expose them in your Spaces application by following the steps in "Exposing Spaces Templates From a Previous Release" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.












50.1.2 Understanding Custom Space Templates

A custom space template may be simple, or may include robust functionality such as:

	
Preseeded data, such as discussions, documents, lists, member information (including roles), pages, or site resources. When you select such a template to build a new space, the new space includes all the preseeded data.


	
Custom java code that executes when you select the template for a new space. For example, custom code may include logic to automatically create a mailing list for a new space. For more information, see the chapter "Extending Spaces Using JDeveloper" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.











50.2 Creating a Custom Space Template

You cannot modify or delete the out-of-the-box space templates described in Section 50.1, "What You Should Know About Space Templates", but any user with Create Space Template or higher permission can create new space templates.

To create a custom space template, you start by creating a space based on an existing template (see Section 51.2, "Creating a New Space"), and customize it according to your requirements. Then, you can create a new space template based on the customized space that you have developed. During the creation of a space template, you can select to inherit the discussions, documents, lists, member information (including roles), pages, or site resources from the parent space. The security settings for the parent space are inherited by the template




	
Note:

When creating a new space template, the template does not inherit announcements from a parent space.







As a space template creator, you can publish space templates for others to use; otherwise, they remain private and hidden from others. To make the template public, you must be granted Space Templates-Manage All permission.




	
Note:

Spaces administrators can also create space templates to be made available at the application level, and import and export custom space templates from and to other Spaces applications, including seeded data. For more information, see Chapter 53, "Administering Spaces and Templates."







To create a space template:

	
In the Home space, go to the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates").


	
On the Space Templates page, click Create.

The Create a Space Template dialog opens (Figure 50-1).


Figure 50-1 Create a Space Template Dialog: Setup Step

[image: Create a Space Template Dialog: Setup Step]

Description of "Figure 50-1 Create a Space Template Dialog: Setup Step"





	
In the Setup step, enter a suitable Space Template Name and (optionally) Description. Choose a name that describes the space template and other Spaces users will recognize. Note that this is your only opportunity to enter a space template description.

Space template names can contain alphanumeric characters, underscores, spaces, multi-byte characters, and special characters such as & and #. The maximum allowable length is 200 characters. The following reserved keywords are not allowed as the full space template name in either upper or lower case, or a combination of both—webcenter, pages, page, spaces, space, group, groups, webcenter space, webcenter spaces, webcenter administration, my spaces, admin, last. These reserved words are allowable as part of a longer name (for example, Sales Group).


	
Click Next.


	
In the Spaces step, select a space to use as the basis for your new space template, then click Next.


	
In the Content step, select the services that contain data that you want the space template to inherit from the parent space (Figure 50-2).




	
Note:

Space templates can not inherit Announcements from a parent space.
List definitions are always copied; checking Lists in this step specifies that you want to copy the list data, too.










Figure 50-2 Create a Space Template Dialog: Content Step

[image: Create a Space Template Dialog: Content Step]



	
Click Create.




	
Note:

If an error message notifies you that the template creation failed because selected services could not be provisioned, the most likely cause is that backend servers (such as UCM or JIVE server) are down. Contact your Spaces administrator to resolve this issue.







The new space template displays on your Space Templates page in the Home space. By default, the template is private, which means that only you as the template creator can see the template on your personal Space Templates page in the Home space. Other users will not see the private template on their personal Space Templates page in the Home space, but users granted the Application-Manage Configuration permission can view and manage private templates on the application-level Space Templates page. For more information, see Chapter 53, "Administering Spaces and Templates."


	
To publish your space template to make it available to all Spaces users, you must be granted the Space Templates-Manage All permission by the Spaces administrator. If you have this permission, select the template name, then click the Edit menu, and choose Make Public.

The template is published and displays on the Space Templates page in the Home space for all users.









50.3 Managing Space Templates

You cannot modify or delete the out-of-the-box space templates provided by Spaces (see Section 50.1.1, "Understanding Out-of-the-Box Space Templates"), but any user with Create Space Template or higher permission can create new space templates, based on spaces that they own (see Section 50.2, "Creating a Custom Space Template"), and manage the space templates that they own.

The Space Templates page in the Home space displays the out-of-the-box space templates, space templates created by the current user, and published templates available for general use.

The following sections describe the management tasks available to space template creators, Spaces administrators, and users granted the Space Templates - Manage All permission by the Spaces administrator:

	
Section 50.3.1, "Viewing Available Space Templates"


	
Section 50.3.2, "Viewing Information About a Space Template"


	
Section 50.3.3, "Searching for a Space Template"


	
Section 50.3.4, "Renaming a Space Template"


	
Section 50.3.5, "Setting Up Access to a Space Template"


	
Section 50.3.6, "Publishing or Hiding Space Templates"


	
Section 50.3.7, "Deleting Space Templates"






50.3.1 Viewing Available Space Templates

To display the Space Templates page, showing the space templates available to you for creating new spaces:

	
In the Home space, open the Space Templates page (Figure 50-2).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Personalize Pages link.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."









If the Space Templates page is not exposed in the Home space, refer to Section 29.3.4, "Showing Hidden Pages."


Figure 50-3 Space Template Page in Home Space

[image: Space Template Page in Home Space]










50.3.2 Viewing Information About a Space Template

To view information about a space template:

	
In the Home space, open the Space Templates page (Figure 50-3).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Personalize Pages link.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."









If the Space Templates page is not exposed in the Home space, refer to Section 29.3.4, "Showing Hidden Pages."


Figure 50-4 Space Template Page in Home Space

[image: Space Template Page in Home Space]



	
On the Spaces Template page, click in the row of the space template that you want to learn about, then click About Space Template (Figure 50-5).


Figure 50-5 Opening About Space Template Dialog

[image: Opening About Space Template Dialog]



The About Space Template dialog opens (Figure 50-6).


Figure 50-6 About Space Template Dialog

[image: About Space Template Dialog]



	
Explore the information in the About Space Template dialog:

	
Name: Internal name of the space template displayed in the space URL. You cannot change the internal name of a space template.


	
Display Name: Display name of the space template. This name displays in places where the templates are available for selection, such as the Create a Space dialog and the Space Templates page. You cannot change the display name of an out-of-the-box space template. To change the display name of a custom space template that you create, see Section 50.3.4, "Renaming a Space Template."


	
Internal ID: ID of the space template, which other applications may use to reference this space template.


	
Description: A description of the space template, specified when creating the space template. You cannot modify the description of a space template, unless you rename the template, where you can enter a new descirption in the Rename dialog, as described in Section 50.3.4, "Renaming a Space Template."


	
Created By: User name of the space template creator.


	
Date Created: Date and time that the space template was created.


	
Direct URL: URL that provides direct access to the space template.












50.3.3 Searching for a Space Template

To search for a space template by a string in the Name or Description:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), enter a search string in the Filter field.


	
Click the Filter icon (Figure 50-7).


Figure 50-7 Filter Icon

[image: Filter Icon]



The Space Templates page displays space templates where the search string is found in the Name or Description.


	
To clear the current search string and display all space templates, click the Clear Filter icon (Figure 50-8).


Figure 50-8 Clear Filter Icon

[image: Clear FIlter Icon]










50.3.4 Renaming a Space Template

To rename a space template:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the space template.


	
From the Edit menu, choose Rename Space Template.

The Rename Space Template dialog opens.


	
In the Display Name field, enter a new name for the space template. Optionally, enter a Description.


	
Click OK.









50.3.5 Setting Up Access to a Space Template

You can grant specific users and groups read-only or manage access to a space template.

To set up access to a space template:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the space template.


	
From the Edit menu, choose Set Template Access.

The Set Template Access dialog opens (Figure 50-9).


Figure 50-9 Set Template Access Dialog
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In the Set Template Access dialog:

	
Click Add Users to open the Search Users dialog where you can select from a list of users or search for a user name.


	
Click Add Groups to open the Search Groups dialog where you can search for a user group.




For tips on searching for a user or group in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


	
For each user or user group listed in the Set Template Access dialog, specify the level of access granted to grant:

	
Select the View checkbox to grant read-only access to the space template.


	
Select the Manage checkbox to grant full access to the space template.





	
Click OK.









50.3.6 Publishing or Hiding Space Templates

When you create a space template (see Section 50.2, "Creating a Custom Space Template"), it is private by default. This means that only you as the template creator can see the template on your personal Space Templates page in the Home space. Other users will not see the private template on their personal Space Templates page in the Home space, but users granted the Application-Manage Configuration permission can view and manage private templates on the application-level Space Templates page. For more information, see Chapter 53, "Administering Spaces and Templates."

To publish or hide space templates that you create to make them available to all Spaces users, you must be granted the Space Templates-Manage All permission by the Spaces administrator. If you have this permission:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the space template(s).

To select multiple space templates, Ctrl-click each template.


	
From the Edit menu, choose either of the following, depending on the template's current state:

	
Make Public to publish the template to all Spaces users.


	
Remove Public Access to hide the template from all other Spaces users (except yourself, as the template creator).




	
Note:

If you are in the process of creating a new space (see Section 51.2, "Creating a New Space"), and the space template you select for the space is made private by another user before you have completed creating the space, the template remains valid for your use while you are still creating the space.


















50.3.7 Deleting Space Templates

To delete one or more space templates:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the space template(s).

To select multiple space templates, Ctrl-click each template.


	
From the Edit menu, choose Delete Space Template.

In the confirmation prompt, click Delete.







	
Note:

Out-of-the-box space templates cannot be deleted. However, Spaces administrators and users granted the Space Templates-Manage All permission can hide the out-of-the-box templates from everyone's view by making them private on the application-level Space Templates page, if granted the Application-Manage Configuration permission by the Spaces administrator. For more information, see Chapter 53, "Administering Spaces and Templates."

















51 Managing a Space

This chapter provides information about configuring and managing an environment dedicated to a group effort or an area of interest in WebCenter Portal: Spaces. It describes how to access space administration pages, manage services, and perform administrative tasks for all members of a space. It contains the following sections:

	
Section 51.1, "Who Is the Space Moderator?"


	
Section 51.2, "Creating a New Space"


	
Section 51.3, "Accessing Space Administration Pages"


	
Section 51.4, "Managing General Administration Settings for a Space"


	
Section 51.5, "Managing Space Roles"


	
Section 51.6, "Managing Space Members"


	
Section 51.7, "Creating and Managing Space Pages"


	
Section 51.8, "Managing Space Content"


	
Section 51.9, "Managing Subspaces"


	
Section 51.10, "Managing Space Services"


	
Section 51.11, "Managing Space Resources"


	
Section 51.12, "Defining Custom Attributes for a Space"


	
Section 51.13, "Adding Wikis or Blogs to a Space"


	
Section 51.14, "Making a Space Available"


	
Section 51.15, "Sending Mail to Space Members or Moderators"


	
Section 51.16, "Working with the Space Task Flows"


	
Section 51.17, "Deleting a Space"





Audience

This chapter is intended for users who want to create and manage spaces.

To perform the tasks described in this chapter, users need to be assigned a role that includes the Manage Configuration and Manage Membership permissions. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



51.1 Who Is the Space Moderator?

If you have been granted the Spaces-Create permission by the Spaces administrator, you can create a space. When you create a space, you become the default space moderator, which means that you assigned the Moderator role. In this role, you have full control over the space presentation and content, as well as administrative responsibilities, as listed in Section 52.2.1.1, "Understanding the Default Roles for a Space".

Other users may be assigned the Moderator role, or granted the permissions to manage specific areas of the space. For more information, see Section 52.2, "Managing Roles and Permissions for a Space"






51.2 Creating a New Space

A space provides an environment dedicated to a group effort or an area of interest. For more information, see Section 49.1, "What You Should Know About Spaces." If you have been granted the Spaces-Create permission by the Spaces administrator, you can create a space in a Spaces application.

Spaces creates a single discussion forum for a new space. You can modify this default setting to allocate multiple discussion forums to the space. See Section 51.10.3, "Modifying Discussion Forum Settings for a Space."

To create a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, click Create a Space.

If you do not see this option, ask your Spaces administrator to grant you Create Spaces permission.

The Create a Space dialog opens.


	
In the Setup step (Figure 51-1), specify a space name and, optionally, a description and keywords for the space. Enter any keywords related to the content of the space to make it more easily discoverable in search results. Separate keywords with a space or comma.


Figure 51-1 Create a Space Dialog: Setup Step

[image: Create a Space Dialog]

Description of "Figure 51-1 Create a Space Dialog: Setup Step"





The name that you enter here displays at the top of the space and other places where spaces are available for selection, such as the Spaces Switcher menu and the Spaces page. Space names can contain alphanumeric characters, underscores, spaces, multibyte characters, and special characters such as & and #. The maximum allowable length is 200 characters. The following reserved keywords are not allowed as the full space name either in upper or lowercase, or a combination of both—webcenter, pages, page, spaces, space, group, groups, space, spaces, webcenter space, webcenter spaces, webcenter administration, my spaces, admin, last. These reserved words are allowable as part of a longer name (for example, Sales Group).




	
Note:

Spaces removes any character spaces in the display name specified here to derive the initial internal name for the space, appended with the date

(for example, spacename_14November2011).








	
Click Next.


	
In the Access step (Figure 51-2), modify the default URL (spacename_date) for the space if desired. The internal name of the space is derived from this field. This URL is the pretty URL to access the space.


Figure 51-2 Create a Space Dialog: Access Step

[image: Create a Space Dialog: Access Step]



	
Choose an access level for the space:

view is granted / available to public. No edit/create / other permissions are granted to public / can be granted to public.

	
Public (default): Anyone can visit the space, whether they are a registered Spaces user or not. When this setting is selected, the Public-User role in the space is automatically granted permissions to view pages, lists, events, links, notes, announcements, discussions, and documents. Public users to not have edit, create , or manage permissions in the space.


	
Private: To access the space, membership is required (either through invitation or self-registration if enabled). The space will be shown in the list of available spaces on the Spaces page and will appear in search results.


	
Hidden: To access the space, membership is required (through invitation). The space will not be shown in the list of available spaces on the Spaces page and will not appear in search results.





	
Click Next.


	
In the Content step (Figure 51-3), select a space template to use as the basis for your new space. Use the Filter field to search for templates by name.


Figure 51-3 Create a Space Dialog: Content Step

[image: Create a Space Dialog: Content Step]






	
See Also:

For more information, see Section 50.1, "What You Should Know About Space Templates".










	
Note:

A custom space template may include preseeded data, such as discussions, documents, lists, member information (including roles), pages, or site resources. When you select such a template, the new space includes all the preseeded data.










	
Note:

When you select a template on which to base a new space, then subsequently the template is made private by another user before you have completed creating the space, the template remains valid for your use while you are still creating the space.








	
Click Create.

The Space Creation Status dialog (Figure 51-4) shows the progress, and provides notification when the space is created, along with links to navigate to diferent areas of the space.


Figure 51-4 Space Creation Status Dialog

[image: Space Creation Status Dialog]



	
Perform any of the following actions:

	
Click Close to close the dialog and return to the Home space.


	
Click Navigate to Space to open the Home page of the new space.


	
Click Add Members to open the Members page in the space administration settings. For more information, see Section 51.6, "Managing Space Members."


	
Click Create Pages to open the Pages page in the space administration settings. For more information, see Section 51.7, "Creating and Managing Space Pages."


	
Click Upload Documents to open the Documents page of the new space.







Any space can be parent to one or more subspaces. This allows you to develop a space hierarchy. For more information, see Chapter 54, "Working with a Space Hierarchy."






51.3 Accessing Space Administration Pages

Space moderators (or anyone granted Manage permissions in the space) can access the administration pages for the space:


	Page	Description
	General	Use this page to set various space properties. For more information, see Section 51.4, "Managing General Administration Settings for a Space."
	Roles	Use this page to manage space roles and permissions. For more information, see Section 51.5, "Managing Space Roles."
	Members	Use this page to manage space members and assign member roles. For more information, see Section 51.6, "Managing Space Members."
	Pages	Use this page to manage space pages. For more information, see Section 51.7, "Creating and Managing Space Pages."
	Content	For more information, see Section 51.8, "Managing Space Content."
	Subspaces	Use this page to manage child spaces of the space. For more information, see Chapter 54, "Working with a Space Hierarchy."
	Services	Use this page to enable and disable services operating in the space; for example: Announcements, Discussions, Documents, Events, and Lists. For more information, see Section 51.10, "Managing Space Services."
	Resources	Use this page to manage the resources for the space. For more information, see Section 51.11, "Managing Space Resources."
	Custom Attributes	Use this page to define custom attributes for the space. For more information, see Section 51.12, "Defining Custom Attributes for a Space."






To access administration pages for a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Spaces menu.
See also Section 29.3.1, "Opening Spaces."










	
On the Spaces page, select the space.

See also Section 49.4, "Viewing Available Spaces".


	
Display the space administration settings pages.




	
Tip:

The way you access these pages depends on the page template in use. For example, in a side navigation template, you may access space administration pages through a Manage menu.
You can also navigate to these pages using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."









If you do not have access to the space administration pages, you do not have Manage permissions for this space. See Section 49.22, "Changing Your Role in a Space".









51.4 Managing General Administration Settings for a Space

The General page of the space administration settings provides access to the tasks described in the following sections:

	
Section 51.4.1, "Renaming a Space"


	
Section 51.4.2, "Modifying the Description or Keywords for a Space"


	
Section 51.4.3, "Taking a Space Offline"


	
Section 51.4.4, "Bringing a Space Back Online"


	
Section 51.4.5, "Closing or Reactivating a Space"


	
Section 51.4.6, "Enabling or Disabling RSS News Feeds for a Space"


	
Section 51.4.7, "Changing the Space Icon"


	
Section 51.4.8, "Changing the Space Logo"


	
Section 51.4.9, "Changing the Page Template for a Space"


	
Section 51.4.10, "Changing the Skin for a Space"


	
Section 51.4.11, "Changing the Resource Catalogs for Pages and the Page Template for a Space"


	
Section 51.4.12, "Changing the Navigation for a Space"


	
Section 51.4.13, "Displaying or Hiding a Page Footer in a Space"


	
Section 51.4.14, "Customizing the Copyright Statement and Privacy URL"


	
Section 51.4.15, "Setting a Space Display Language"


	
Section 51.4.16, "Changing the Access to a Space"






51.4.1 Renaming a Space

A space display name displays at the top of the space and other places where spaces are available for selection, such as the Spaces Switcher menu and the Spaces page.




	
Note:

Changing the display name does not affect the internal name and URL for the space. To change the internal name of a space, see Section 51.14.2, "Changing a Space URL".







To change the display name of a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, modify the Display Name.


Figure 51-5 Changing a Space Display Name

[image: General subtab Configure Group Space Information section]



	
Click Apply to save.









51.4.2 Modifying the Description or Keywords for a Space

A space description appears in the listing of the space on the Spaces page. Keywords are useful to make a space more easily discoverable in search results.

To enter or change the description of keywords for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, enter or modify the Description and/or Search Keywords for use in searches on the Spaces page. Separate keywords with a space or comma.


Figure 51-6 Modifying a Space Description or Keywords

[image: Modifying a Space Description or Keywords]



	
Click Apply to save.









51.4.3 Taking a Space Offline

You can take a space temporarily offline for maintenance. For example, if you notice inappropriate content, you can take a space offline to make required updates, then bring it back online. Only the Spaces administrator or space members with Manage Configuration permission can access a space that is offline. Other members see the Space Unavailable page (see Section 7.3, "Working with System Pages.").

To permanently close down a space that is not being used any more, see Section 51.4.5, "Closing or Reactivating a Space."

To take a space offline:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, select Take Space Temporarily Offline (Figure 51-7).


Figure 51-7 Taking a Space Offline

[image: Take Group Space Offline enabled]

Description of "Figure 51-7 Taking a Space Offline"





	
Click Apply to save.









51.4.4 Bringing a Space Back Online

When a space is offline, only the Spaces administrator or space members with Manage Configuration permission can bring the space back online.

To bring a space back online:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, clear the Take Space Temporarily Offline checkbox (Figure 51-8).


Figure 51-8 Bringing a Space Back Online

[image: Take Group Space Offline disabled]

Description of "Figure 51-8 Bringing a Space Back Online"





	
Click Apply to save.









51.4.5 Closing or Reactivating a Space

You can close a space that is no longer being actively used. Closing a space archives its content. When you close a space, it is removed from everyone's Spaces Switcher menu and displays in the Spaces browser (Spaces page) only when a member selects Closed Spaces from the Show list. The content of a closed space remains accessible and searchable to those who still want to reference it and space members can continue working in the space either by displaying closed spaces on the Spaces page, or by direct URL (http://host:port/webcenter/spaces/space name).

When a space is closed, any activities performed in the space are no longer reflected in the Activity Stream in the Home space. Only the Home page of the closed space shows activity in the space.

To close down a space temporarily, take the space offline instead. See Section 51.4.3, "Taking a Space Offline."

To close a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, select the Close Space checkbox (Figure 51-9).


Figure 51-9 Closing a Space

[image: Close the Group Space enabled]

Description of "Figure 51-9 Closing a Space"





To reactivate the space, clear the Close Space checkbox.


	
Click Apply to save.









51.4.6 Enabling or Disabling RSS News Feeds for a Space

Space members can find out what is happening in a space through RSS news feeds. Within the context of a space, members can:

	
Monitor recent activities.


	
Track contributions to discussion forums.


	
View announcements.


	
Watch for revisions to lists.




For more information about publishing RSS new feeds, see Chapter 68, "Working with the RSS Service".

To enable or disable RSS news feeds for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, set Publish RSS as follows:

	
To allow members access to space information through RSS feeds, select Enable RSS Publishing (Figure 51-10).


	
To disable RSS feeds for this space, clear Enable RSS Publishing.





Figure 51-10 Enabling and Disabling Space RSS Feeds

[image: Enable RSS Publishing on General subtab]

Description of "Figure 51-10 Enabling and Disabling Space RSS Feeds "





	
Click Apply to save.









51.4.7 Changing the Space Icon

The space icon displays alongside the space display name in menus and smaller areas. For example, it may display on the Spaces Switcher menu (Figure 51-11) or at the top of the space (Figure 51-12).


Figure 51-11 Space Icon in Spaces Switcher Menu

[image: Space Icon in Spaces Switcher Menu]




Figure 51-12 Space Icon at Top of Space

[image: Space Icon at Top of Space]



A default icon is provided by the template used when you create the space, but you can assign a different icon if desired.

To change the space icon:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, click Change next to the current space icon to open the Select an Icon dialog (Figure 51-13).


Figure 51-13 Select an Icon Dialog

[image: Select an Icon Dialog]






	
Note:

The icon image file can be up to 1 MB. Supported file formats are .gif or .GIF, .png or .PNG, and .jpg or .JPG.








	
In the Select an Icon dialog, click Browse to upload a new icon image, or enter the URL to an icon image. Click OK.


	
Click Apply to save.









51.4.8 Changing the Space Logo

The space logo displays alongside the space name in larger areas. For example, it may display at the top of the space, and on the Spaces page (Figure 51-14).


Figure 51-14 Space Logo on Spaces Page

[image: Space Logo on Spaces Page]



A default logo is provided by the template used when you create the space, but you can assign a different logo if desired.

To change the space logo:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, click Change next to the current space logo to open the Select a Logo dialog (Figure 51-15).


Figure 51-15 Select a Logo Dialog

[image: Select a Logo Dialog]






	
Note:

The logo image file can be up to 1 MB. Supported file formats are .gif or .GIF, .png or .PNG, and .jpg or .JPG.








	
In the Select a Logo dialog, click Browse to upload a new logo image, or enter the URL to a logo image (beginning with http://). Click OK.


	
Click Apply to save.









51.4.9 Changing the Page Template for a Space

A page template defines how individual pages and groups of pages display on a user's screen. For more information about page templates, see Chapter 12, "Working with Page Templates."

Spaces provides several out-of-the-box page templates (see Section 12.1.1, "Out-of-the-Box Page Templates"). Alternatively, portal designers can create custom page templates to offer more ways to display pages on the screen, as described in Section 12.2, "Creating a Page Template." Within a space, you can copy or customize an existing page template, as described below and in Section 51.11, "Managing Space Resources."

By default, a space inherits the page template defined for the space template that you choose when you create the space.




	
Note:

If the space template does not specify a page template, the space uses the default page template specified by Spaces administrator. See Section 5.8, "Choosing a Default Page Template".







You can optionally choose a different page template for the space, overriding the space template setting and the application setting.

To change the page template for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Page Template (Figure 51-16).


Figure 51-16 Choosing a Page Template for a Space

[image: Choosing a Page Template for a Space]



The Spaces administrator may choose to hide one or more out-of-the-box page templates (see Section 12.5.1, "Showing and Hiding a Page Template"). The [system default] selection applies the page template specified for the application by the Spaces administrator (see Section 5.8, "Choosing a Default Page Template"). Additional custom page templates may be listed if they have been added to the application or the space.

You can add custom page templates for the space to this list in two ways:

	
Copy an existing page template into a new page template, completely separate from the original, as described in Section 51.11, "Managing Space Resources."


	
Customize an application-level page template to create a new page template for the space. Any changes that are subsequently made to the page template at the application level are automatically cascaded down to the page template at the space level. See Section 12.4, "Customizing a Page Template for a Space."







	
Note:

If you create a new page template for a space, the custom page template is not shown in the Page Template list for subspaces of the space. To set the page template for a subspace to the same page template used by its parent space, you must use an EL expression. To make a custom page template available in the Page Templates list for all spaces and subspaces, it must be created at the application-level (see Section 12.2, "Creating a Page Template").







If you want Spaces to determine the page template dynamically based on certain criteria, click the Expression Builder icon next to the Page Template list to open the editor, and then enter an EL expression that specifies the required behavior. For example: in a subspace, the following EL expression sets the Page Template to the same setting as the parent space:


{srmContext.resourceType['siteTemplate'].displayName['parent_page_template'].singleResult}


	
Click Apply.









51.4.10 Changing the Skin for a Space

A skin defines the appearance and look and feel of the application or a space. For more information about skins, see Chapter 14, "Working with Skins."

Spaces provides several out-of-the-box skins (see Section 14.1, "What You Should Know About Skins"). Alternatively, portal designers can develop custom skins to reflect a personality, or to incorporate specific branding, as described in Section 14.2, "Creating a Skin." Within a space, you can copy an existing skin, as described below and in Section 51.11, "Managing Space Resources."

By default, a space inherits its skin from the application-level settings, described in Section 5.7, "Choosing a Default Skin."

You can optionally choose a different skin for the space, overriding the application setting. When you change the skin for a space, the skin is applied to all the pages of the space. However, the space administration pages are not affected. They always appear with the default skin, Fusion FX.

To change the skin for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Skin in which to wrap the space (Figure 51-17).


Figure 51-17 Choosing a Skin for a Space

[image: Choosing a Skin for a Space]



The Spaces administrator may choose to hide one or more out-of-the-box skins (see Section 14.4.1, "Showing and Hiding a Skin"). The [system default] selection applies the skin specified for the application by the Spaces administrator (see Section 5.7, "Choosing a Default Skin"). Additional custom skins may be listed if they have been added to the application or the space.

You can add custom skins for the space to this list by copying an existing skin into a new skin. For more information, see Section 51.11, "Managing Space Resources."




	
Note:

If you create a new skin for a space, the custom skin is not shown in the Skin list for subspaces of the space. To set the skin for a subspace to the same skin used by its parent space, you must use an EL expression. To make a custom skin available in the Skin list for all spaces and subspaces, it must be created at the application-level (see Section 14.2, "Creating a Skin").







If you want Spaces to determine the skin dynamically based on certain criteria, click the Expression Builder icon next to the Skin list to open the editor, and then enter an EL expression that specifies the required behavior.


	
Click Apply to save.









51.4.11 Changing the Resource Catalogs for Pages and the Page Template for a Space

When you edit a page or page template in a space and click Add Content, a Resource Catalog displays. A Resource Catalog lists items that users may typically want to add to the page or page template, such as page layout components, portlets, and task flows. You can select items in the Resource Catalog to add them to your page or page template. For more information about Resource Catalogs, see Chapter 16, "Working with Resource Catalogs."

Spaces provides two out-of-the-box Resource Catalogs for pages and the page template in a space:

	
Default Space Catalog for editing individual pages and task flows in a space.


	
Default Page Template Catalog for editing page templates.




For more information, see Section 16.1.1, "Understanding the Out-of-the-Box Resource Catalogs."

Alternatively, portal designers can develop custom Resource Catalogs, as described in Section 16.2, "Creating Resource Catalogs." Within a space, you can create a new Resource Catalog from scratch or copy an existing Resource Catalog into a new Resource Catalog, as described below and in Section 51.11, "Managing Space Resources."

By default, a space inherits the Resource Catalogs for its pages and the page template from the application-level settings, described in Section 5.10, "Choosing Default Resource Catalogs."

You can optionally choose different Resource Catalogs for the space, overriding the application settings.

To change the Resource Catalogs used to edit pages or the page template in a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Resource Catalog from the Resource Catalog for Pages or Resource Catalog for Page Templates lists (Figure 51-18).


Figure 51-18 Choosing a Resource Catalog for a Space

[image: Choosing a Resource Catalog for a Space]



The Spaces administrator may choose to hide one or more out-of-the-box Resource Catalogs (see Section 16.4, "Showing and Hiding a Resource Catalog"). The [system default] selection applies the Resource Catalogs specified for the application by the Spaces administrator (see Section 5.10, "Choosing Default Resource Catalogs"). Additional custom Resource Catalogs may be listed if they have been added to the application or the space.

You can add custom Resource Catalogs for the space to this list by creating a new Resource Catalog from scratch or by copying an existing Resource Catalog into a new Resource Catalog. For more information, see Section 51.11, "Managing Space Resources."




	
Note:

If you create a new Resource Catalog for a space, the custom Resource Catalog is not shown in the Resource Catalog lists for subspaces of the space. To set the Resource Catalogs for a subspace to the same Resource Catalogs used by its parent space, you must use an EL expression. To make a custom Resource Catalog available in the Resource Catalog lists for all spaces and subspaces, it must be created at the application-level (see Section 16.2, "Creating Resource Catalogs").







If you want Spaces to determine the Resource Catalog dynamically based on certain criteria, click the Expression Builder icon next to the Resource Catalog lists to open the editor, and then enter an EL expression that specifies the required behavior.


	
Click Apply to save.









51.4.12 Changing the Navigation for a Space

Navigation enables space members to see what information the space provides and to get to that information quickly and easily. For more information about navigation models, see Chapter 11, "Working with Navigation."

Spaces provides the following out-of-the-box navigation models for a space:

	
Spaces Administration Options contains administration options for a space. By default, it includes a Manage dropdown menu to provide access to administration settings


	
Spaces Default Navigation Model displays links to space pages. By default, it is positioned at the top of the sidebar on the left-hand side of a space.


	
Spaces Navigation with Blogs/Wikis/Lists Submenus displays links to space pages, and links to any documents, blogs, wikis, and lists. By default, it is positioned at the top of the sidebar on the left-hand side of a space.




For more information, see Section 11.1.1, "What You Should Know About Navigation Models."

Alternatively, portal designers can develop custom navigations, as described in Section 11.2, "Building a Navigation Model." Within a space, you can create a new navigation from scratch or copy an existing navigation into a new navigation, as described below and in Section 51.11, "Managing Space Resources."

By default, a space inherits its navigation from the application-level settings, described in Section 5.9, "Choosing a Default Navigation."

You can optionally choose a different navigation for the space, overriding the application settings.

To change the navigation for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Navigation (Figure 51-19).


Figure 51-19 Choosing a Navigation for a Space

[image: Choosing a Navigation for a Space]



The Spaces administrator may choose to hide one or more out-of-the-box navigation models (see Section 10.4.3, "Showing and Hiding Resources"). The [system default] applies the navigation specified for the application by the Spaces administrator (Section 5.9, "Choosing a Default Navigation"). Additional navigation models may be listed if they have been added to the application or the space.

You can add custom navigations for the space to this list by creating a new navigation from scratch or by copying an existing navigation into a new navigation. For more information, see Section 51.11, "Managing Space Resources."




	
Note:

If you create a new navigation for a space, the custom navigation is not shown in the Navigation list for subspaces of the space. To set the navigation for a subspace to the same navigation used by its parent space, you must use an EL expression. To make a custom navigation available in the Navigation list for all spaces and subspaces, it must be created at the application-level (see Section 11.2.1, "Creating a Navigation Model").







If you want Spaces to determine the navigation dynamically based on certain criteria, click the Expression Builder icon next to the Navigation list to open the editor, and then enter an EL expression that specifies the required behavior.


	
Click Apply to save.









51.4.13 Displaying or Hiding a Page Footer in a Space

A page footer can display copyright details for the space and a link to its Privacy Statement.

To display or hide a page footer for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, select the Page Footer checkbox to display a page footer, or clear the checkbox to hide the page footer.


	
Click Apply to save.









51.4.14 Customizing the Copyright Statement and Privacy URL

When enabled, the copyright statements and URL to the privacy statement specific to the space display in the page footer of the space (Figure 51-20 and Figure 51-21):


Figure 51-20 Spaces Copyright Statement

[image: WebCenter Spaces Copyright Statement]




Figure 51-21 Spaces Privacy URL

[image: WebCenter Spaces Privacy URL]



To customize the copyright statement and privacy URL for a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, select Display Page Footer to display the area at the bottom of the space for the copyright statement and privacy URL (Figure 51-22). Clear the checkbox to hide the page footer, including the copyright statement and privacy URL.


Figure 51-22 Customizing the Copyright Statement and Privacy URL

[image: Customizing the Copyright and Privacy URL]



	
In the Copyright and Privacy URL fields, enter appropriate values.


	
Click Apply to save.









51.4.15 Setting a Space Display Language

You can optionally set a space display language to control the language in which the user interface (UI) elements of a particular space render in Spaces. UI elements include button and field labels, application links, screen text, and so on.

For more information about working with languages in Spaces, and the different levels at which a display language can be set, see Chapter 24, "Working with Multilanguage Portals."

Within the scope of viewing a space, the space display language setting is given precedence over all other language settings. For example, if a space named WebCenter Portal Central has its display language set to German, and Monica (a member of WebCenter Portal Central) sets her user preference language to Dutch, assuming no other language settings are in effect:

	
Monica views the WebCenter Portal Central space in German, and cannot change this language setting.


	
Monica views other parts of Spaces, outside the WebCenter Portal Central space, in Dutch.







	
Note:

If you create a space based on a space template that is defined to use a specific language, that language setting is not inherited by the space. Instead, the initial language setting for a new space is based on the order of precedence described in Section 24.1.1, "Display Language Precedence.".







To set a space display language:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, select a language for the space from the Default Language list (Figure 51-23).


Figure 51-23 Setting the Space Display Language

[image: Setting Group Space Display Language]



If you want Spaces to determine the language dynamically based on certain criteria, click the Expression Builder icon next to the property field to open the editor, and then enter an EL expression that specifies the required behavior.


	
To customize the languages displayed in the Default Language list, click Customize. For example, your Spaces application might be available in 27 different languages, but you may only need to display the content in your space in three or four different languages, so you could filter the list to display a subset of languages.









51.4.16 Changing the Access to a Space

Access to a space is defined when the space is created (see Section 51.2, "Creating a New Space"). This access can be changed to make the space more visible or less visible.

To change the access to a space:

	
In the space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Access, select how you want the space to be exposed:


Figure 51-24 Space Access Settings

[image: Space Access Settings]



	
Public: Anyone can visit the space, whether they are a registered Spaces user or not. When this setting is selected, the Public-User role in the space is automatically granted View Pages and Content permission in the space, which allows public users to view pages, lists, events, links, and notes. To grant public users permissions to view announcements, discussions, and documents, you need to grant these permissions, as described in Section 51.14.5, "Granting Public Access to a Space."


	
Private: To access the space, membership is required (either through invitation or self-registration if enabled). The space will be shown in the list of available spaces on the Spaces page and will appear in search results.


	
Hidden: To access the space, membership is required (through invitation). The space will not be shown in the list of available spaces on the Spaces page and will not appear in search results.





	
Click Apply to save.











51.5 Managing Space Roles

To manage the roles for assigning permissions in a space:

	
In the space administration settings, display the Roles page (Figure 51-25).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 51-25 Space Administration: Roles Page

[image: Space Administration: Roles Page]



	
To work with space roles, refer to Chapter 52, "Managing Space Members and Roles."









51.6 Managing Space Members

To manage the members of a space:

	
In the space administration settings, display the Members page (Figure 51-26).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 51-26 Space Administration: Members Page

[image: Space Administration: Members Page]



	
To work with space members, refer to Chapter 52, "Managing Space Members and Roles."









51.7 Creating and Managing Space Pages

In a space, members have access to member-created pages and system pages. The content on a space page is typically targeted to a particular audience or objective.

System pages are provided to support a rapid deployment of your portal. They fulfill a range of needs, from a finished informational page (the Unauthorized page) to pages that provide content that is generated on the spot and tailored to members of the space (the Activity Stream page). For complete information about system pages, including how to customize them, see Section 7.3, "Working with System Pages."


Figure 51-27 Space Administration: Pages Page

[image: Space Administration: Pages Page]

Description of "Figure 51-27 Space Administration: Pages Page"





The following sections describe how to create and manage pages in a space:

	
Section 51.7.1, "Setting a Default Page Style"


	
Section 51.7.2, "Creating a Page in a Space"


	
Section 51.7.3, "Showing or Hiding Pages in a Space"


	
Section 51.7.4, "Searching for Pages in a Space"


	
Section 51.7.5, "Editing a Page in a Space"


	
Section 51.7.6, "Copying a Page in a Space"


	
Section 51.7.7, "Renaming a Page in a Space"


	
Section 51.7.8, "Changing Access Permissions on a Space Page"


	
Section 51.7.9, "Deleting a Page in a Space"


	
Section 51.7.10, "Exposing a Space Page in the Home Space"


	
Section 51.7.11, "Sending a Link to a Page in a Space"


	
Section 51.7.12, "Viewing Information About a Page in a Space"






51.7.1 Setting a Default Page Style

To specify a default style for new pages in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click Set Page Defaults to display the Set Page Defaults dialog (Figure 51-28).


Figure 51-28 Set Page Defaults Dialog

[image: Set Page Defaults Dialog]

Description of "Figure 51-28 Set Page Defaults Dialog"





For information about each page style, see Section 15.1, "What You Should Know About Page Styles."


	
Select an option next to Enable One-Click Page Creation:

Yes: Pages created for this space must always use the Page Style chosen here. This enforces a common look and feel across the entire space by skipping the Create Page dialog, and creating pages directly using this style.

No: Space members can create pages with a different style, with the selected Page Style displayed as the initial style in the Create Page dialog.









51.7.2 Creating a Page in a Space

To create a new page in a space:

	
Use either of the following methods:

	
In the space, click Create Page. This method is available to anyone granted permission to create pages in the space (see Table 52-2, "Space Permissions - Simple Permission Model")




	
Tip:

The location of the Create Page link depends on the page template in use. For example, in a side navigation template, you may access it through an Actions menu.








	
In the space administration settings, display the Pages page, then click Create Page. This method is available to anyone granted permission to manage pages in the space (see Table 52-2, "Space Permissions - Simple Permission Model")




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."












Spaces will either:

	
Open the Create Page dialog.


	
Immediately create a new page with a default style, if specified in the Set Page Defaults dialog (see Section 51.7.1, "Setting a Default Page Style").





	
If the Create Page dialog opens, specify the name and style for the new page.

For detailed information about each page style, see Section 15.1, "What You Should Know About Page Styles."




The new space page opens in edit mode (Composer), where you can add content, then Save and Close the page.




	
See Also:

For information about adding content to a space page, see:
	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components."


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components."

















51.7.3 Showing or Hiding Pages in a Space

You can control the display of pages in the space in either of the following ways:

	
Define a navigation model for the space to control what pages display and in what order and hierarchy. See Section 51.11, "Managing Space Resources" to access the Navigations resource for the space and Chapter 11, "Working with Navigation" to build a navigation that includes the pages of the space.


	
If the navigation used by the space shows all pages in the space, selectively show or hide pages in the space administration settings on the Pages page.




To show or hide pages for all members in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, select or clear the Show Page checkbox for the pages you want to show or hide.









51.7.4 Searching for Pages in a Space

To search for pages in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, use either of the following search methods:

	
Filter search: Enter a full or partial search string in the Filter field, then click the Filter icon to refresh the list with all space pages for which a match is found in Name or Created By. To clear the current search string and display all space pages, click the Clear Filter icon.


	
Filter panel: Click the Show or hide the filter panel icon to display a filter panel above the page list, then enter a full or partial search string in the fields above Name and/or Created By, and press Enter to refresh the list with all space pages that match the filtering criteria. To clear the current search string and display all space pages, clear the filter panel fields and press Enter.







To refresh the list of pages, first ensure that any prior filter is cleared (click the Clear Filter icon), and no filter is specified in the filter panel, then click the Refresh icon.






51.7.5 Editing a Page in a Space

To edit a page in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Edit Page to display the page in edit mode (Composer).




	
See Also:

For information about adding content to a space page, see:
	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components."


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components."




















51.7.6 Copying a Page in a Space

To copy a page in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Copy Page to open the Copy Page dialog.


	
Enter a name for the new page, and click OK.




	
Note:

You must have the Spaces-Manage All permission (see Table 52-2, "Space Permissions - Simple Permission Model") to copy a page that is available to all members of a space. If you have not been granted this permission, then the Copy Page selection is not available to you.















51.7.7 Renaming a Page in a Space

When you rename a page, keep in mind that any pretty URLs that use the old name will be broken. Also note that system pages, such as the Announcements, Lists, and Events pages, do not provide the option of being renamed.




	
See Also:

For information about pretty URLs, see Appendix A, "Spaces User Interface URLs."







To rename a page in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Rename Page to open the Rename Page dialog.


	
Enter a new name for the page, and click the Save icon.









51.7.8 Changing Access Permissions on a Space Page




	
Note:

To make an entire space public, see Section 51.14.5, "Granting Public Access to a Space."







As the space moderator, you are authorized to view and manage security for any page in the space. Page owners normally determine who can see the space pages they create (see Section 49.17, "Controlling User Access to Your Space Pages"), but when a page owner is not available, the space moderator may be required to make changes.

In a public space, public users (who are assigned the Public-User role by Spaces) are granted View Pages and Content permission in the space by default, which allows public users to view pages, lists, events, links and notes. If you want to restrict access to a specific page, you can remove public view access from the page. Spaces provides a shortcut to remove and grant public read-only access to a page using the page Actions icon menu:

	
To restrict access to a specific page to space members only, click the Actions icon for the page, and choose Remove Public Access.


	
To grant read-only access to a specific page in a public space, click the Actions icon for the page, and choose Make Public.







	
Note:

These selections are active only if the space is public (see Section 51.14.5, "Granting Public Access to a Space").







To control the access to an individual page in a space:

	
In the space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Roles page, select the role for which you want to specify page access permissions, then click Edit Permissions (Figure 51-29). For information about the default Spaces roles in this list, see Section 52.2.1.1, "Understanding the Default Roles for a Space."


Figure 51-29 Granting Spaces User Access to Space

[image: Granting WebCenter Spaces User Access to Group Space]

Description of "Figure 51-29 Granting Spaces User Access to Space"





	
In the Edit Permissions dialog, clear any checkboxes for page permissions under Basic Services, which apply to all pages in the space. For information about the permissions listed in the Edit Permission dialog, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."


	
Click Save.


	
In the space administration settings, display the Pages page.


	
To modify user access to a page, click the Actions icon for the page, and choose Set Page Access to open the Set Page Access dialog (Figure 51-30).


Figure 51-30 Set Page Access Dialog

[image: Set Page Access dialog box]



	
Select the Access Method:

	
To specify that the page should inherit access settings from the permissions established for the space, select Use Application Permissions, then click OK to save your changes and exit the dialog. For information about setting global space permissions, see Section 52.2, "Managing Roles and Permissions for a Space."


	
To set custom access on the current page, select Use Custom Access Settings, and continue with the next steps.





	
To grant page access to all authenticated users (that is, to users who are logged in to Spaces), click Add Authenticated Access.

The role authenticated-role is added under Role or User with default Read access to the page.


	
To grant page access to all public users (that is, users who have not logged in to Spaces), click Add Public Access.

The role anonymous-role is added under Role or User with default Read access to the page (Figure 51-31).


Figure 51-31 Authenticated and Public User Read Access to a Page

[image: Authenticated and Public User Read Access to a Page]



	
To grant page access permissions to selected users, groups, and application roles, click Add Access to open the Add Access dialog (Figure 51-32).


Figure 51-32 The Add Access Dialog

[image: Add Access dialog box]

Description of "Figure 51-32 The Add Access Dialog"





	
In the Search field, enter a search term or the name of the user, group, or role for whom you want to enable access, and click the Search icon. For tips on searching for a user or group in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
Note:

In the Add Access dialog, you can add the default roles Moderator, Participant, and Viewer, and any custom roles that have been created for the space.
For more information about space roles, see Section 52.2, "Managing Roles and Permissions for a Space"










	
Select a user, group, or role by clicking in its row.




	
Note:

When you select a user name, the permissions you set are granted to that specific user. When you select a group or application role, the permissions you set are granted to all users who are members of that group or who are assigned that role.







Ctrl-click or Shift-click to make multiple selections.


	
Click Select to close the Add Access dialog, and populate the Set Page Access dialog with the selected users, group, or roles.





	
In the Set Page Access dialog, set the Page Access permissions as desired for each user, group, or role (Table 51-1).




	
Note:

If you set page access permissions for the anonymous-role (public users), the space must also be made public to allow this page to be seen by public users. See Section 51.14.5, "Granting Public Access to a Space."








Table 51-1 Page Access Privileges in the Set Page Access Dialog

	Icon	Name	Description
	
[image: View Page icon]


	
View Page

	
Users can access the page for viewing, but cannot perform any other actions on the page.


	
[image: Personalize Page icon]


	
Edit Page

	
Users can edit the page using Composer. This includes adding, rearranging, and deleting content; renaming the page; and changing page properties, such as the page scheme.


	
[image: Delete Page icon]


	
Delete Page

	
Users can delete the page.


	
[image: Manage Page icon]


	
Perform All Page Actions

	
Users can perform all actions on the page.


	
[image: Edit Page icon]


	
Personalize Page

	
Users can rearrange page content and personalize his or her view of task flows, provided the task flow includes personalization settings.











	
Tip:

By default, all authenticated users and user roles that you add to the Set Page Access dialog are granted page view access. The other access privileges all require page view access.








	
Click OK to save your changes and close the Set Page Access dialog.









51.7.9 Deleting a Page in a Space

To delete a page in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Delete Page to display the Delete Page dialog.


	
Confirm deletion of the page, and click Delete.









51.7.10 Exposing a Space Page in the Home Space

To add a space page to the list of pages in the Home space, visible to all Spaces users:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and select Add to Home Space.




When you add a space page to the Home space, the page scope remains that of the space.






51.7.11 Sending a Link to a Page in a Space  

To send mail to space members prepopulated with a link to a particular page:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Send Mail to open your mail application compose window, showing a URL link to the page.









51.7.12 Viewing Information About a Page in a Space

To view information about a page in a space:

	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose About This Page to open the Page Information dialog, which shows Name, Created By, Date Created, Last Modified, and Direct URL.











51.8 Managing Space Content

To manage the content in a space in a centralized location:

	
In the space administration settings, display the Content page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Content page (Figure 51-33), click the subtab for the service that supports the content with which you want to work:

	
Announcements. For more information, see Chapter 59, "Working with the Announcements Service."


	
Documents. For more information, see Section 41.1.1, "Understanding the Document Explorer Task Flow."


	
Discussions. For more information, see Chapter 60, "Working with the Discussions Service."


	
Events. For more information, see Chapter 61, "Working with the Events Service."


	
Lists. For more information, see Chapter 64, "Working with the Lists Service."


	
Polls. For more information, see Chapter 67, "Working with the Polls Service."





Figure 51-33 Space Administration: Content Page
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The subtabs provide quick access to creating and managing content made available through the services that are enabled in the space:






51.9 Managing Subspaces

To manage the subspaces of a space:

	
In the parent space administration settings, display the subspaces page (Figure 51-34).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 51-34 Space Administration: Subspaces Page

[image: Space Administration: Subspaces Page]



	
To work with subspaces, refer to Chapter 54, "Working with a Space Hierarchy."









51.10 Managing Space Services

Most service-related configuration is the responsibility of the Fusion Middleware administrator. The administrator configures and maintains service connections, which make the services available in Spaces. For more information, see "Managing Oracle WebCenter Portal Services" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. Also see Section 53.4, "Enabling and Disabling Services."

You can check the Services page to see which services are available and can enable or disable services as required. If a service is not shown on the Services page, then the administrator has not configured that service connection.

You use the Roles page to configure role permissions for each service that is enabled in the space. If a service is not shown on the Roles page, then the service is disabled in the space. For more information, see Section 52.2.3, "Viewing and Editing Permissions of a Space Role".

When you enable a service in a space, you are automatically granted Manage permissions on that service.

The following sections describe service-related configuration activities that space moderators can perform in a space:

	
Section 51.10.1, "Enabling and Disabling Services Available to a Space"


	
Section 51.10.2, "Configuring a Custom Space Mail Distribution List"


	
Section 51.10.3, "Modifying Discussion Forum Settings for a Space"


	
Section 51.10.4, "Publishing Space Mail in a Discussion Forum"


	
Section 51.10.5, "Configuring a Shared Mail Connection for a Space"


	
Section 51.10.6, "Creating and Managing Space Event Categories"






51.10.1 Enabling and Disabling Services Available to a Space

Most services operating within a space are optional. Optional services include Announcements, Discussions, Documents, Space Events, Instant Messaging and Presence, and Lists.

When you disable a service, task flows associated with the service are no longer available. For example, if you disable the Discussions service:

	
The Discussions page is not shown in the space.


	
Discussions task flows included in custom space pages are replaced with a message Service was not enabled for this space.


	
Discussions task flows are not offered in the Resource Catalog for space pages.




Additionally, permissions granted for disabled services are removed, and any existing data associated with the Discussions, Announcements, Documents, Space Events, and Lists services is deleted from the space when you disable these services.

Space members do not automatically gain access to service-related task flows when you enable them here. You must also grant appropriate usage permissions for the service on the Roles page, as described in Section 52.2.3, "Viewing and Editing Permissions of a Space Role".

To enable or disable a service in your space:

	
In the space administration settings, display the Services page (Figure 51-35).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 51-35 Space Administration: Services Page
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Description of "Figure 51-35 Space Administration: Services Page "





	
On the Services page, select or clear checkboxes to enable or disable services, respectively.




	
Note:

If you disable the Mail service, Spaces deletes the default distribution list that was automatically created for the space. Attempts to send mail to all members of the space opens the mail window with the To field blank instead of pre-populated with the mail distribution list.
If you previously specified a custom distribution list (see Section 51.10.2, "Configuring a Custom Space Mail Distribution List"), then disable the Mail service, the custom distribution list is not deleted, but the relationship between the distribution list and the space is deleted.












	
Note:

The Documents service is exposed on the Services page in a space only with Content Server 11g. If the connected content repository is Content Server 10g, the Documents service is not available in the space administration settings (Services and Roles). To use the Documents service functionality in 10g, you can create a page in a space and add Documents service task flows to the page (see Section 41.4, "Adding a Documents Service Task Flow to a Page").







Refer to the online help for the Services page for more information about each of the services.


	
Click Apply to save.


	
To allow space members to access the enabled services, you must grant appropriate permissions to the services for each member role on the Roles page. See Section 52.2.3, "Viewing and Editing Permissions of a Space Role".









51.10.2 Configuring a Custom Space Mail Distribution List

Mail distribution lists provide an efficient mechanism for space communication. Spaces creates a default distribution list for every space if the Mail Server is Microsoft Exchange and active directory connection details (LDAP) are provided in the mail server connection settings. For more information, see "Managing the Mail Service" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

A default distribution list is named as follows: space_name@mail_domain.

For example, the default distribution list for a space named Finance Project is FinanceProject@mail_domain, where mail_domain is derived from the LDAP Domain setting in the Edit Mail Server Connection screen (accessed through Oracle Enterprise Manager). As members leave or join the space, Spaces updates the default distribution list.

If you disable the Mail service, Spaces deletes the default distribution list that was automatically created for the space. Attempts to send mail to all members of the space (see Section 51.15, "Sending Mail to Space Members or Moderators") opens the Mail Compose dialog with the To field blank instead of prepopulated with the mail distribution list.

If you create a new custom distribution list for the space, members of the new custom distribution list are not managed by Spaces. As members leave or join the space, they are not automatically removed from or added to the custom distribution list. If you create a new custom distribution list, then disable the Mail service, the custom distribution list is not deleted, but the relationship between the distribution list and the space is deleted.

To configure a custom space mailing list:

	
In the space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Services page, select Mail (Figure 51-36).


Figure 51-36 Configuring the Space Mail Distribution List

[image: Configuring the Group Space Mail Distribution List]

Description of "Figure 51-36 Configuring the Space Mail Distribution List"





	
To change the current space mail distribution list, type a new Distribution List. Allowable characters are alphanumeric, dash (-), and underscore (_). Any other character is converted to a dash (-), and spaces are removed.

If the Distribution List field is left blank, the mail window will open with the To field blank.


	
Under 'Send Mail' Options, select one, both, or neither of the checkboxes:

	
Select Include the Distribution List to populate the To field with the name of the space distribution list.


	
Select Include the Email Addresses of Space Members to populate the To field with the individual email address of the space members.





	
Click Apply.









51.10.3 Modifying Discussion Forum Settings for a Space

By default, Spaces creates a single discussion forum for a new space. You can modify this default setting to allocate multiple discussion forums to the space.

Spaces stores all discussion forums and categories under the application root category on the discussions server. The Spaces administrator can change the root category, as described in Section 6.2.2, "Specifying Where Discussions and Announcements are Stored on the Discussions Server". If required, you can change the default storage location for the discussion forums for a particular space.

For more information about the discussions server, see "Setting Up Discussions Server Connections" and "Setting Defaults for Discussion Forums" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. For more information about the Discussions service, see Chapter 60, "Working with the Discussions Service."

To modify the discussion forum settings for a space:

	
In the space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Services page, select Discussions.


	
(Optional) To launch the Jive Forums Administration Console, the Web-based tool for configuring and managing discussion forums, click Forum Administration.


	
To allocate multiple discussion forums to the space, select Support Multiple Forums for the Space (Figure 51-37).


Figure 51-37 Space Discussion Forum Settings: Single Forum

[image: Specifying Where Discussions are Stored: Single Forum]

Description of "Figure 51-37 Space Discussion Forum Settings: Single Forum"





The page refreshes to show a category, under which the multiple forums are stored.


	
To store space discussions in a different category and discussion forum than those specified by Category Name and Forum Name, click the Find icon (Figure 51-38) to change the storage location.


Figure 51-38 Space Discussion Forum Settings: Multiple Forums

[image: Specifying Where Discussions are Stored: Multiple Forums]



	
Click Apply on to save the settings.









51.10.4 Publishing Space Mail in a Discussion Forum

Communication through the space mail distribution list can be published as discussion forum posts. When a mail message is new, a new topic is created for it. When a mail message is a reply to an existing mail message, a topic reply is created for it.




	
Note:

Spaces supports Microsoft Exchange server or any mail server that supports IMAP4 and SMTP. To enable Spaces users to access mail within a Spaces application and perform basic operations such as read, reply, and forward, you must first register the appropriate mail server with the Spaces application. The Mail service is not configured out-of-the-box. Refer to "Setting Up Mail Server Connections" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







To publish space mail in a discussion forum:

	
In the space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Services page, select Discussions.


	
To publish space mail on a discussion forum of your choice, select Monitor Incoming Email (Figure 51-39)

To disable this feature so that mail is not published for any space, clear this checkbox.


Figure 51-39 Space Discussion Forum Settings: Mail
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Enter the space Mail Account.

This is the distribution list used to mail space members. For details, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List".


	
In the IMAP Host field, enter the name of the computer where the IMAP (Internet Message Access Protocol) service is running; in IMAP Port, enter the port on which the IMAP service listens.


	
Select Use SSL if a secured connection (SSL) is required for incoming mail over IMAP.


	
Enter the User Name and Password of a space member with sufficient privileges to modify these settings (Manage privilege).


	
To publish space mail on a different discussion forum than the forum specified by Forum Name, edit the value in Forum Name or Forum ID

Click the magnifier icon to display list of available forums in the space (Figure 51-40).


Figure 51-40 Selecting a Forum for Space Mail

[image: Available forums]

Description of "Figure 51-40 Selecting a Forum for Space Mail"





	
Single-click a forum in the list to select it.

Alternatively, create a forum from scratch. Click Create Forum, then enter a suitable name and description.




	
Note:

If you specify a mail distribution list that has been defined as the distribution list for a different space, then the mail sent to that distribution list are by default archived in the discussion forum specified in the Mail Settings for that space. Mail sent to a space distribution list can only be archived one time in one forum, on a first come first served basis.








	
Click Apply to save the settings.







	
Note:

If no forum is specified for mail archiving, or the specified forum is deleted, mail sent to the distribution list is not archived anywhere.












51.10.5 Configuring a Shared Mail Connection for a Space

When a space is configured to use a shared mail connection, users do not have to specify credentials when sending mails using the WebCenter Portal Mail Service.

To configure a shared mail connection for a space:

	
Confirm that Spaces is using the WebCenter Portal Mail service to send mail.

See Section 6.3.1, "Enabling Shared Mail Connections for Send Mail Notifications".


	
Ask your Fusion Middleware administrator to set up a mail connection that uses an external application configured with the shared credentials you require, and then record the name of that mail connection.

For details, see "Setting Up a Shared Mail Connection" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
In the space administration settings, display the Custom Attributes page.


	
Add the custom attributes listed in Table 51-2 (and as shown in Figure 51-41):


Table 51-2 Custom Attributes for Shared Mail Connections

	Name	Value
	
collab.mail.compose.sharedConnectionName

	
Name of the shared mail connection. For example: MySharedMailConnection


	
notifications.use.mail.composer

	
Must be set to true.









Figure 51-41 Setting Shared Mail Connection Attributes for a Space
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(Optional). By default, Send Mail notifications are disabled for public/anonymous users. To enable them in a space, add the following space custom attribute:


notifications.anonymous.enabled = true









51.10.6 Creating and Managing Space Event Categories

Space event categories enable users to group certain events together (for example, Team Meeting, Vacation, Customer Meeting, and so on).

Categories have a name and an optional color. If a color is selected, events belonging to the category are displayed in that color on the Events page or in an Events task flow.

To create and manage event categories in a space:

	
In the space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Services page, select Space Events (Figure 51-42).


Figure 51-42 Working with Space Event Categories

[image: Space Events on the Services tab]



	
To create a new space event category, click Create. In the Create Category dialog, enter a Category Name, and select a color for the event category, then click OK.

For information about assigning a category to an event, see Chapter 61, "Working with the Events Service," and specifically Section 61.2.4, "Scheduling Events."

The category to which an event belongs also displays when a user hovers the mouse pointer over the event on the Events page or in an Events task flow. Users can also filter the Events page or an Events task flow to display events belonging to one or more specific categories. For more information see Section 61.2.3.4, "Filtering Events by Category."


	
To edit or delete a space event category, select the category, then click either Edit or Delete (Figure 51-43).


Figure 51-43 Editing or Deleting a Space Event Category

[image: Space Events on the Services tab]












51.11 Managing Space Resources

The resources for a space and the tasks associated with managing those resources are identical to the resources for the entire Spaces application. For more information, see Chapter 10, "Working with the Resources that Compose a Portal or Community." Any custom resources that you create for a space can be managed in both the space and by the Spaces administrator.

Table 51-3 describes the support available for creating various resources in a space.


Table 51-3 Support for Creating Resources in a Space

	Resource	Can You Create the Resource in a Space?	How can the Resource be Created?
	
Page Templates

	
Yes

	
Only by extending another page template.


	
Navigations

	
Yes

	
From scratch or by extending another navigation


	
Resource Catalogs

	
Yes

	
From scratch or by extending another Resource Catalog


	
Skins

	
Yes

	
Only by making a copy of another skin


	
Page Styles

	
No

	
(Not applicable)


	
Content Presenter templates

	
No

	
(Not applicable)


	
Mashup Styles

	
No

	
(Not applicable)


	
Data Controls

	
Yes

	
Only from scratch


	
Task flows

	
Yes

	
Only from scratch








To view, manage, or create resources for a space:

	
In the space administration settings, display the Resources page (Figure 51-40).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 51-44 Space Administration: Services Page
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On the Resources page, select the resource you want to view or manage:


	
Refer to the following sections for tasks related to working with space resources:

	
Section 10.1.5, "Viewing Information About a Resource"


	
Section 10.2, "Creating Resources"


	
Section 10.4, "Managing Resources"












51.12 Defining Custom Attributes for a Space

Every space includes built-in attributes such as name, description, date created, icon, and so on. In addition to these built-in attributes, you can add custom attributes that are unique to the space and its characteristics.

Custom attributes let you specify additional space information (metadata). Custom attributes are propagated throughout the space. Any space pages, task flow, or portlet that delivers customized content based on parameter values can accept custom attribute values and display content accordingly using the following Expression Language (EL) syntax to access the custom attribute value:


#{spaceContext.currentSpace.metadata.customAttributes[attributeName]} 


A custom attribute is simply a name value pair (such as customerId=400, orderId=11, or userName=Smith). The custom attribute name is unique within a space. For example, if you build a space for customer analysis purposes, it might contain several custom task flows that take the parameter customerId as an input: task flows such as Customer Sales History, Customer Satisfaction Rating, Future Sales Prospects, or Customer Contact Information. With a custom attribute defined named customerId with an appropriate customer value, all the task flows that can accept a customerId can display information specific to that customer.

A custom attribute can also be dynamic, using Expression Language (EL) expressions. For example, a custom attribute could use an EL expression to read a value that is passed in. A URL that displays the space could pass the attribute value in the URL (for example, customerid=10), which would be applied to the custom attribute using the EL expression. For more information, see Section 19.4, "Passing Parameter Values Through the Page URL."

New spaces based on a space template that includes custom attributes will inherit the custom attributes and their values.

To add a custom attribute for a space:

	
In the space administration settings, display the Custom Attributes page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Custom Attributes page, click Add Attribute (Figure 51-45).


Figure 51-45 Space Administration: Custom Attributes Page
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Description of "Figure 51-45 Space Administration: Custom Attributes Page"





The Add Attribute dialog opens (Figure 51-46).


Figure 51-46 Entering Custom Attribute Name and Value

[image: Add Attribute dialog]

Description of "Figure 51-46 Entering Custom Attribute Name and Value"





	
Enter a unique Name for the attribute.


	
Optionally, enter a Value for the custom attribute. You can type a static value, or specify a dynamic value by entering an Expression Language (EL) expression. See Appendix B, "Expression Language Expressions."


	
Click Add to save the custom attribute and display it in the list on the Custom Attributes page.


	
To edit or delete a selected attribute, click the Actions icon for the attribute and select the desired action:

	
Edit Attribute to display the Edit Attribute dialog to modify the attribute name or value.


	
Delete Attribute to display the Delete Attribute dialog to remove the attribute from the space.












51.13 Adding Wikis or Blogs to a Space

You can include wikis and blogs as pages in a space.

Wiki pages are populated and monitored by a collaborative group of users with common interests and goals. Users with sufficient permission on a wiki can edit the page to add to, revise, or remove information. Everyone works together to create resource pages that are relevant, useful, and up-to-date. For more information, see Chapter 47, "Working with Wiki Documents."

Blogs, however, are more personal records of experiences and opinions. Blog pages provide a useful means of capturing and publishing the knowledge and opinions of subject matter experts who are members of the space. For more information, see Chapter 48, "Working with Blogs."






51.14 Making a Space Available

Once you have created a space, you probably want others to be able to use it. As the space moderator, you can determine whether the space should be discoverable only by other Spaces users, or publicly available:

	
Section 51.14.1, "Publishing the Link to a Space"


	
Section 51.14.2, "Changing a Space URL"


	
Section 51.14.3, "Making a Space Known (Discoverable)"


	
Section 51.14.4, "Granting Spaces Users Access to a Space"


	
Section 51.14.5, "Granting Public Access to a Space"






51.14.1 Publishing the Link to a Space

You can share a new space or updates to an existing space by publishing the link to the space. With appropriate permissions, users can directly access a space by clicking the link that specifies the space display name.

To publish the direct link to a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the space you want to share (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose About, then Share Link (Figure 51-47).


Figure 51-47 Space Actions Menu Selection: Share Link
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The Share Link dialog opens (Figure 51-48).


Figure 51-48 Share Link Dialog for a Space

[image: Share Dialog]



	
Optionally, enter a comment to appear with the link.


	
Click Publish.

The URL to the space is added to the Activity Stream in the Home space for all users or groups who have permission to access the space, along with your comments, if entered.









51.14.2 Changing a Space URL

You can change the URL that other people use to navigate to a space, which also changes the internal name of the space. The format of a space pretty URL is as follows:

http://host:port/webcenter/spaces/internal_space_name

For example: http://mycompany:8888/webcenter/spaces/release_meetings.

When you change the space URL, it is important to note that any existing bookmarks to the space will no longer work. If you wish to simply change the display name; that is, the name displayed at the top of the space and on dialogs and pages where users can select the space, see Section 51.4.1, "Renaming a Space."

To change a space URL:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the space that you want to rename (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose Rename Space URL (Figure 51-49).


Figure 51-49 Space Actions Menu Selection
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In the Rename Space URL dialog (Figure 51-50), revise the space internal name portion of the URL as desired.


Figure 51-50 Rename Space URL Dialog

[image: Rename Space URL dialog]

Description of "Figure 51-50 Rename Space URL Dialog"





	
Click OK.









51.14.3 Making a Space Known (Discoverable)

You can make a space discoverable by other Spaces users on their Spaces page and in search results to let them know that it exists. Making a space discoverable does not make its content accessible. Users interested in the space can request membership through self-service (if enabled) or by mail.

To make a space discoverable by other Spaces users:

	
Set general access to the space:

	
If you are creating a new space, select either Public or Private in the Access step of the Create a Space dialog, as described in Section 51.2, "Creating a New Space."


	
If the space is currently Hidden, select either Public or Private on the General page of the space administration settings, as described in Section 51.4.16, "Changing the Access to a Space."





	
(Optional) To allow users to join the space, you can enable self-registration too (you can still retain control by requiring approval for any subscription request). See Section 52.1.1, "Managing Self-Service Membership for a Space".


	
To add or invite specific Spaces users and groups to the space, allow Spaces users to self-subscribe, or invite non-Spaces users to subscribe to the space, see Section 52.3, "Managing Members and Assigning Roles."









51.14.4 Granting Spaces Users Access to a Space

After making the space discoverable (see Section 51.14.3, "Making a Space Known (Discoverable)"), the next step is to assign the permissions that you want different user roles to have in the space, if the default permissions are not satisfactory.

Spaces users have the default Authenticated-User role. A space is not fully accessible until you give the Authenticated-User role permissions to access the pages of the space:

	
To grant access to the entire space: In the Edit Permissions dialog, under Pages, select the desired checkboxes for page permissions, which apply to all pages in the space. See Section 52.2, "Managing Roles and Permissions for a Space." for detailed information.


	
To grant access to a limited number of individual pages in the space, see Section 51.7.8, "Changing Access Permissions on a Space Page.".







	
Note:

To use the task pane available through the Microsoft Office shared document management functionality (while editing a Microsoft Word, Excel, or PowerPoint file in a space) to add members to a space, see Section 52.3.4, "Adding Members to a Space."












51.14.5 Granting Public Access to a Space

You can make a space available to anyone with access to the Spaces instance that contains the space. Registering for a Spaces account is not required. The public information provided allows the space to be shared with non-members and people outside of the Spaces community.

Public users who are not registered Spaces users can access public spaces in two ways:

	
Directly, using the space URL provided to them.


	
From the Spaces Welcome page, if their installation is configured to display this page (Figure 51-51).


Figure 51-51 Public Spaces Link on Welcome Page

[image: Public Group Spaces link on Welcome page]

Description of "Figure 51-51 Public Spaces Link on Welcome Page"







Public users are assigned the Public-User role, which has no access to space information by default. To grant public access to a space, including its pages and any content and services you want to expose on the public pages:

	
Specify the general access settings for the space:

	
If you are creating a new space, select Public in the Access step of the Create a Space dialog, as described in Section 51.2, "Creating a New Space."


	
If the space is currently Hidden or Private, select Public on the General page of the space administration settings, as described in Section 51.4.16, "Changing the Access to a Space."




When a space is made public, the Public-User role is automatically granted View Pages and Content permission in the space, which allows public users to view pages, lists, events, links and notes.

To see what the public view of a space will look like, copy the Direct URL value in the About Space dialog (see Section 49.5, "Viewing Information About a Space"), log out of Spaces, and paste the URL into your browser. Because you are logged out of Spaces, only pages designated as public display.


	
(Optional) To allow public users to join your space, you may want to enable self-registration too (you can still retain control by requiring approval for any subscription request). See Section 52.1.1, "Managing Self-Service Membership for a Space".


	
Now that you have made the space public, the next step is to assign additional permissions that you want Public-User user role to have in the space, if the default read-only View Pages and Content permission is not sufficient. You can additionally grant public users permissions to view announcements, discussions, and documents.

In the space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Roles page, select Public-User, then click Edit Permissions (Figure 51-52).


Figure 51-52 Granting Public User Access to Space
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Description of "Figure 51-52 Granting Public User Access to Space"





	
In the Edit Permissions dialog, select the checkboxes for the desired public permissions for the space to view announcements, discussions, or documents. For information about the permissions listed in the Edit Permission dialog, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."

The public permissions that you grant here override the public permissions set by the administrator at the application level (see Section 21.2.4, "Granting Permissions to the Public-User").


	
If you want to restrict public access to certain pages in the space, see Section 51.7.8, "Changing Access Permissions on a Space Page."


	
On the Roles page, click Apply to save.











51.15 Sending Mail to Space Members or Moderators

You can send mail to the members or the moderators of a space using the default mail distribution list for the space, and a custom distribution list. For more information, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List."




	
Note:

To use the task pane available through the Microsoft Office shared document management functionality (while editing a Microsoft Word, Excel, or PowerPoint file in a space) to send mail to members of a space, see Section 46.3.4.12, "Sending a Message."







To send mail to space members or moderators:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the space to which the members or moderators belong (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose Contact, then Send Mail to Members or Send Mail to Moderators (Figure 51-53).


Figure 51-53 Space Actions Menu Selection: Send Mail
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Your mail application opens, where you can compose and send mail to all members or moderators of the space.









51.16 Working with the Space Task Flows

Spaces provides two space task flows that you can add to a page (Figure 51-54):

	
Space Members: Adds an area that shows the space members and provides controls to add new members, send a mail message to all members, filter the list by role, and search for members. For more information about this task flow, see Section 52.4, "Working with the Members Task Flow."


	
Spaces Browser: Adds an area that operates identically to the Spaces page, as described in Section 49.4, "Viewing Available Spaces."





Figure 51-54 Space Task Flows: Space Members and Spaces Browser
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The following sections provide information about working with the space task flows:

	
Section 51.16.1, "Adding a Space Task Flow to a Page"


	
Section 51.16.2, "Setting Space Task Flow Properties"






51.16.1 Adding a Space Task Flow to a Page

To add a space task flow to a page:

	
Go to the page where you want to add the task flow, and open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content to open the Resource Catalog.


	
Locate the Space Members and Spaces Browser task flows in the Resource Catalog.




	
Note:

These task flows are not available in the default Resource Catalogs provided out-of-the-box with Spaces, so you will only see entries for the space task flows if they have been added to the Resource Catalog that has been made available to the page.
For more information, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Spaces Browser and/or Space Members). Once you have added a task flow to a custom Resource Catalog, you need to Show that catalog, then make that Resource Catalog active for pages in the space, as described in Section 51.4.11, "Changing the Resource Catalogs for Pages and the Page Template for a Space."










	
Click Add next to the space task flow you want to add to the page, then Close the Resource Catalog.


	
Click Save, then Close the page.









51.16.2 Setting Space Task Flow Properties

The Space Members and Spaces Browser task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 51-55 and Figure 51-56).


Figure 51-55 Space Members Task Flow Component Properties
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Figure 51-56 Spaces Browser Task Flow Component Properties

[image: Spaces Browser Task Flow Component Properties]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the spaces task flows and describe the properties on the Parameters tab for each task flow:

	
Section 51.16.2.1, "What You Should Know About the Spaces Task Flow Properties"


	
Section 51.16.2.2, "Setting Space Members Task Flow Properties"


	
Section 51.16.2.3, "Setting Spaces Browser Task Flow Properties"






51.16.2.1 What You Should Know About the Spaces Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 51.16.2.3, "Setting Spaces Browser Task Flow Properties" and Section 51.16.2.2, "Setting Space Members Task Flow Properties." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Expression Builder icon next to a property field to open the editor.




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.









For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






51.16.2.2 Setting Space Members Task Flow Properties

See Section 52.4.7, "Setting Members Task Flow Properties."






51.16.2.3 Setting Spaces Browser Task Flow Properties

Properties that are unique to the Spaces Browser task flow are shown on the Parameters tab of the Component Properties dialog (Figure 51-57).


Figure 51-57 Spaces Browser Task Flow Component Properties
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For information about the properties on the other tabs, which are common to all Spaces components, see Section 17.5.2, "Setting Properties on Page Components."



51.16.2.3.1 Spaces Browser Task Flow Parameters

Table 51-4 describes the parameters that are unique to the Spaces Browser task flow.


Table 51-4 Spaces Browser Task Flow Parameters

	Parameter	Description
	
Advanced Query

	
Specifies an EL expression to retrieve a list of spaces based on custom criteria. The expression may include the population from which to choose, a WHERE clause, and sort criteria. The expression must not be enclosed in #{ and }, and any backlashes and quotes must be escaped (using a backslash).

Examples:

	
To display a list of publicly accessible spaces created by user scott, sorted alphabetically by display name:

spaceContext.spacesQuery.unionOf[\'PUBLIC_ACCESSIBLE\'].whereClause[\'sp.createdBy = \\\'scott\\\'\'].sortCriteria[\'sp.displayName asc\']


	
To filter the results that display in the Spaces Browser task flow based on a keyword (in this example, the keyword is "portal"):

spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.search[\'portal\']




For additional help with syntax, refer to the JavaDoc for oracle.webcenter.spaces.query.SpacesQueryParameters


	
Display Tool Bar

	
Specifies whether the tool bar displays:

	
#{true} (default): Display the toolbar.


	
#{false}: Hide the toolbar.





	
Display View

	
Specifies the type of layout in which to display spaces in the Spaces Browser.

	
Card Layout: Display spaces in a card view.


	
Tiled Layout (default): Display spaces in a tiled view.





	
Filter

	
Specifies which spaces should display in the Spaces Browser task flow.

	
Show All (default)


	
Show Joined


	
Show Moderated


	
Show Public


	
Show Discoverable (all Public and Private spaces)





	
Space Launched on Selection

	
Specifies whether to navigate to a space when selected in the Spaces Browser task flow:

	
#{true} (default): Clicking a space opens the space on the Home page.


	
#{false}: Clicking a space does not navigate to the space. Instead, allows user to select the space, staying on the same page with the selected space highlighted.





















51.17 Deleting a Space

When a space has been closed or inactive for some time, you may want to remove it from Spaces. The Spaces administrator can remove any space in the application, as described in Section 53.2.6, "Deleting a Space." If you are the moderator, creator, or member with Manage Configuration permission of a particular space, you can delete that space, as described in the steps below. Deleting a space is permanent; it cannot be restored after it is deleted.

Deleting a space means that:

	
All pages associated within the space are deleted.


	
All space data managed by Spaces (links, lists, notes, tags, and space events) is deleted.


	
All space roles and membership is deleted.


	
Content managed by discussions and announcements is deleted when it is stored in the default forum or category created by Spaces. However, content managed by nondefault forums or categories is not deleted (see Section 51.10.3, "Modifying Discussion Forum Settings for a Space").


	
The space mail distribution list that is automatically created bySpaces is deleted. However, distribution lists that are customized by the space moderator are not deleted (see Section 51.10.2, "Configuring a Custom Space Mail Distribution List").


	
Content managed by external services, such as content repositories, mail, and so on, is removed.




To delete a space:

	
In the Home space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

Your Spaces application may provide other ways to access the spaces available to you. See Section 29.3.1, "Opening Spaces."








	
On the Spaces page, locate the space that you want to delete (see Section 49.4, "Viewing Available Spaces"), then right-click the space icon or name, and choose Delete the Space (Figure 51-58).


Figure 51-58 Deleting a Space

[image: Deleting a Space]

Description of "Figure 51-58 Deleting a Space"





	
In the confirmation prompt, click Delete to confirm or Cancel to preserve the space.












52 Managing Space Members and Roles

This chapter provides information about managing members and roles for a space. It contains the following sections:

	
Section 52.1, "Setting Up the Membership Policy for a Space"


	
Section 52.2, "Managing Roles and Permissions for a Space"


	
Section 52.3, "Managing Members and Assigning Roles"


	
Section 52.4, "Working with the Members Task Flow"





Audience

This chapter is intended for users who are responsible for managing space members and their role assignments. It describes how to set up a space membership policy and define member roles and responsibilities.

This chapter is intended for users assigned, minimally, the space Moderator role or a custom role that includes the default permissions granted to a moderator.

The Spaces administrator has the authority to expose or hide some features and services for all spaces. Contact your administrator if some tasks discussed in this chapter are not available to you.




	
Note:

For more information about space roles, see Section 52.2.1, "What You Should Know About Roles and Permissions for a Space".









52.1 Setting Up the Membership Policy for a Space

Space moderators determine the membership policy for their space, choosing between an "invitation only" membership policy, allowing users to join themselves by subscribing to (and unsubscribing from) the space, adding new members directly, or using any combination of these membership options.

Enabling self-service does not necessarily mean that users automatically gain access to a space. Moderators can still control who joins (or leaves) the space through an approval process.

Default membership permissions are derived from the template used to create the space. Moderators can change these settings at any time. This section describes:

	
Section 52.1.1, "Managing Self-Service Membership for a Space"


	
Section 52.1.2, "Managing Self-Service Membership Removal from a Space"






52.1.1 Managing Self-Service Membership for a Space

As space moderator, you can limit access to a space, or allow users to join themselves, without an invitation, through self-service.

Additionally, you may allow users to join a space or change their space membership without approval, or require approval for certain roles. When membership requests require approval, new members do not automatically gain access when they subscribe to a space. Instead, the moderator receives a subscription notification that he or she can either accept or reject.

To manage self-service for a space:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select Membership Options in the toolbar.


	
Under Membership Self-Service:

	
To prevent non-members from joining the space through self-service or requesting changes to their current membership, select Do Not Allow Self-Service Membership or Self-Service Membership Change (Figure 52-1).


Figure 52-1 Disabling Self-Service
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Description of "Figure 52-1 Disabling Self-Service"





	
To allow non-members to join a space and members to request changes to their current membership, select Allow Self-Service Membership or Self-Service Membership Change (All Roles Available).




	
Note:

If you select this option, make sure that other people can see the space through their Spaces page and through searches (see Section 51.14.3, "Making a Space Known (Discoverable)").







When you select this option, the following additional options become available through the Spaces page:

	
Spaces that allow self-service display a Join Space button in the Space Information dialog box (select About> About this Space from the space's Actions menu, as described in Section 49.7, "Joining a Space").


	
Select Membership> Change Role from the space's Action menu.








	
To be notified of self-service requests so you can approve or reject them before users become members of the space, select Moderator Approval Required.




	
Tip:

This checkbox only displays when Spaces workflows are configured for your application and the Worklist service is up and running.








	
To specify which roles users see on Request Membership and Change Membership pages, select Allow Self-Service Membership or Self-Service Membership Change (Selected Roles Available) to display a table showing all the roles available (Figure 52-2).

	
Select Enable to offer the role on the Request Membership and Change Membership pages. Clear Enable to hide a role.


	
Select Approval Required to specify that moderator approval is required before the request is granted. The request is sent to the moderator's Worklist to approve or reject (if the space has multiple moderators, all moderators receive the request; only one moderator must process the request). Clear Approval Required to allow the change without moderator approval.

The Approval Required checkbox only displays when Spaces workflows are configured for your application and the Worklist service is up and running.





Figure 52-2 Choosing Roles Available on Self-Service Membership
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Description of "Figure 52-2 Choosing Roles Available on Self-Service Membership "





	
Click Save.




New members can now join this space through self-service. For more information, see Section 49.7, "Joining a Space".






52.1.2 Managing Self-Service Membership Removal from a Space

If moderator approval is required to unsubscribe from a space, an unsubscription request is sent to the moderator's Worklist when a member leaves to either accept or reject.

To configure approval options for space unsubscription:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select Membership Options in the toolbar.


	
Under Membership Self-Service (Figure 52-3):

	
To specify that moderator approval is required to leave a space, select Moderator Approval Required for Self-Service Membership Removal.


	
To allow members to leave without approval, clear Moderator Approval Required for Self-Service Membership Removal.







	
Tip:

This checkbox only displays when Spaces workflows are configured for your application and the Worklist service is up and running.








Figure 52-3 Specifying Unsubscribe Request Approval Requirements
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Description of "Figure 52-3 Specifying Unsubscribe Request Approval Requirements"





	
Click Save.











52.2 Managing Roles and Permissions for a Space

The space moderator is responsible for setting up roles to control what members can do in the space. Space moderators can manage permission assignments for existing roles, create new roles, and delete roles that are no longer required.

This section describes how moderators manage member roles and permissions:

	
Section 52.2.1, "What You Should Know About Roles and Permissions for a Space"


	
Section 52.2.2, "Defining Custom Roles for a Space"


	
Section 52.2.3, "Viewing and Editing Permissions of a Space Role"


	
Section 52.2.4, "Using the Advanced Permission Model"


	
Section 52.2.5, "Deleting Roles in a Space"






52.2.1 What You Should Know About Roles and Permissions for a Space

When you create a new space, the Spaces application automatically creates some defaults roles, with default permissions. If the default roles do not meet the needs of the space, space moderators can define custom roles. This section provides the following information:

	
Section 52.2.1.1, "Understanding the Default Roles for a Space"


	
Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space"


	
Section 52.2.1.3, "Understanding Custom Roles in Spaces"






52.2.1.1 Understanding the Default Roles for a Space

Several default roles are created in a new space, as shown in Table 52-1.




	
Note:

These default roles are always available for spaces based on out-of-the-box templates. Spaces based on user-defined templates may offer a different set of default roles. The default permissions assigned to the default roles are shown in Table 52-2.








Table 52-1 Default Roles for Spaces

	Space Role	Description	Modify Permissions	Delete Role
	
Moderator

	
The Moderator role is automatically assigned to the creator of a space. This role is automatically granted the highest level of permissions, as shown in Table 52-2.

The space moderator or anyone with the space Manage All permission can modify permissions as necessary and appropriate.

	
Yes (except for Manage All)

	
No


	
Participant

	
The Participant role is automatically granted the default permissions shown in Table 52-2.

The space moderator or anyone with space Manage All permission can grant additional permissions as necessary and appropriate.

	
Yes

	
Yes


	
Viewer

	
The Viewer role is automatically granted the default permissions shown in Table 52-2.

The space moderator or anyone with space Manage All permission can grant additional permissions as necessary and appropriate.

	
Yes

	
Yes


	
Authenticated-User

	
The Authenticated-User role is given to authenticated users of the Spaces application, with no access to space information by default. Once logged in, users assigned this role typically have access to the Home space, and always inherit any permissions granted to the Public-User role.

To grant access to a space, additional permissions must be granted by the space moderator or anyone with space Manage All permission (see Section 52.2.3, "Viewing and Editing Permissions of a Space Role").

	
Yes

	
No


	
Public-User

	
Any user with access to the Spaces application who is not logged in assumes the Public-User role. Users with the Public-User role have no access to space information by default. Such users are anonymous, unidentified, and space permissions must be granted explicitly by the space moderator or anyone with space Manage All permission (see Section 52.2.3, "Viewing and Editing Permissions of a Space Role" and Section 51.14.5, "Granting Public Access to a Space").

	
Yes

	
No












52.2.1.2 Understanding Permissions and Permission Models in a Space

Members can perform actions within a space as specified by the permissions assigned to their role.

When assigning roles, moderators can choose one of two permission models:

	
Standard permission model:

	
Basic Services collectively control access to pages, lists, events, links and notes


	
Resources collectively control access to all resources types, including page templates, navigations, skins, resource catalogs, and so on




Table 52-2 lists the permission categories and permissions that are available when standard permissions are enabled.


	
Advanced permission model:

	
Separate service categories enable you to control access on a service-by-service basis. Separate permissions are provided for the following services: Pages, Events, Links, Lists, Notes.


	
Separate resource categories enable you to control access on a resource-by-resource basis. Separate permissions are provided for the following resources: Skins, Page Templates, Navigations, Resource Catalogs, Page Styles, Content Presenter Templates, Data Controls, Task Flows.




While detailed permissions give you more flexibility over role assignments, they can become complex to manage and maintain. Table 52-3 lists the permission categories and permissions that are available when advanced permissions are enabled.




It is the space template that determines the default permission model for a space. Spaces that are based on out-of-the-box space templates adopt the simpler, standard permission model by default, but moderators can switch to the advanced permission model if required. For more information. see Section 52.2.4, "Using the Advanced Permission Model".




	
Note:

Permissions do not inherit the privileges of "lesser" permissions. Therefore, be careful to assign the appropriate set of permissions to allow users to perform required actions. For example, whenever you assign the Create permission, select the View permission too.








Table 52-2 Space Permissions - Simple Permission Model

	Permission Category	Permissions	Roles Granted Permission By Default
	
Administration

	
Manage All - Enable access to all Space Administration Settings pages.

Includes Manage Configuration and Manage Membership permissions.

	

Moderator


	
	
Manage Configuration - Same as the Manage All permission but excludes security privileges. Users with this permission cannot access the Roles and Members pages.

Users with the Configure permission must be allowed to view the space.

	

	
	
Manage Membership -Enables access to the Roles and Members pages in the space administration settings. Through these pages, users can create, edit and delete members and roles for the space.

	

	
Basic Services

(Events, Links, Lists, and Notes)

	
Edit Page Access, Structure, and Content - Create, edit and delete pages in the space. Manage page access and edit page properties. Add and remove task flows and portlets. Create, edit, and delete lists, events, links, and notes.

Specifically, users with this permission can perform the following operations within the space:

	
Events - Create, delete, edit, and view events


	
Links - Create, and delete links


	
Lists - Create, delete, edit, update, and view lists


	
Notes - Create, delete, edit, and view events




	

Moderator


	
	
Edit Page Access and Structure - Manage page access and edit properties of pages in the space. Add and remove task flows and portlets.

	

Moderator
Participant


	
	
Customize Pages and Edit Content - Customize your view of pages in the space. Add and remove list content, events, links, and notes.

	

Moderator
Participant


	
	
View Pages and Content - View pages, lists, events, links, and notes in the space.

	

Moderator
Participant
Viewer


	
Announcements

	
Create, Edit, and Delete Announcements - Perform any operation on announcements associated with the space.

Note: This permission does not take effect for the Public-User role.

	

Moderator


	
	
Create and Edit Announcements - Create and edit announcements. Delete announcements that you create.

Users with the Edit permission must be allowed to view announcements.

Note: This permission does not take effect for the Public-User role.

	

Participant


	
	
View Announcements - View announcements.

	

Participant
Viewer


	
Discussions

	
Create, Edit, and Delete Discussions - Perform any operation on discussions associated with the space; create topics and replies. Edit and delete any topic or reply.

Note: The Manage permission does not take effect for the Public-User role.

	

Moderator


	
	
Create and Edit Discussions - Create topics and replies. Edit topics and replies that you create. Users with this permission must be allowed to view discussions.

	

Participant


	
	
Reply To Discussions - Reply to existing topics and edit replies that you create. Users with this permission must be allowed to view discussions.

	

Participant


	
	
View Discussions - View discussions.

	

Participant
Viewer


	
Documents

	
Administration - Configure document workflows and access control settings.

	

Moderator


	
	
Delete Documents - Delete any folder and any file in the space, including wikis and blogs. Users with this permission can also move folder and files.

Users with the Delete permission must be allowed to create and view folders and files.

	

Moderator
Participant


	
	
Create and Edit Documents - Create files, wikis, blogs, and folders, and upload files. Delete files, wikis, blogs, and folders that you create. Delete other files and folders if permissions allow.

Users with the Create permission must be allowed to view folders and files.

	

Moderator
Participant


	
	
View Documents - Browse files, wikis, blogs, and folders.

	

Moderator
Participant
Viewer


	
Resources

	
Create, Edit, and Delete Resources - Create, edit, and delete resources owned by the space, such as page, templates, navigations, resource catalogs, skins, page styles, content presenter templates, mashup styles, task flows, and data controls.

	

Moderator


	
	
Create Resources - Create new resources for the space.

	





	
	
Edit Resources - Edit resources owned by the space.

	








Table 52-3 Space Permissions - Advanced Permission Model

	Permission Category	Permissions	Roles Granted Permission By Default
	
Administration

	
Manage All - Enable access to all space administration pages.

Includes Manage Configuration and Manage Membership permissions.

Manage Configuration - Same as the Manage All permission but excludes security privileges. Users with this permission cannot access the Roles and Members pages.

Users with the Configure permission must be allowed to view the space.

Manage Membership -Enables access to the Roles and Members pages in the space administration settings. Through these pages, users can create, edit and delete members and roles for the space.


	

Moderator


	
Pages

	
Create, Edit, and Delete Pages - Create and delete pages in the space. Manage page access and edit page properties. Add and remove page content.

	

Moderator


	
	
Create Pages - Create pages in the space.

	

	
	
Edit Pages - Edit page properties and content for any page in the space.

	

Moderator
Participant


	
	
Delete Pages - Delete any page in the space.

	

	
	
Customize Pages - Customize your page view.

	

Moderator
Participant


	
	
View Pages - View pages in the space.

	

Moderator
Participant
Viewer


	
Announcements

	
Create, Edit, and Delete Announcements - Perform any operation on announcements associated with the space.

Note: This permission does not take effect for the Public-User role.

	

Moderator


	
	
Create and Edit Announcements - Create and edit announcements. Delete announcements that you create.

Users with the Edit permission must be allowed to view announcements.

Note: This permission does not take effect for the Public-User role.

	

Participant


	
	
View Announcements - View announcements.

	

Participant
Viewer


	
Content Presenter Templates

	
Create, Edit, and Delete Content Presenter Templates - Create, edit and delete content display templates for the space.

Create Content Presenter Templates - Create content display templates for the space.

Edit Content Presenter Templates - Edit space-level content display templates.

See also, Chapter 40, "Publishing Content Using Content Presenter".


	

	
Discussions

	
Create, Edit, and Delete Discussions - Perform any operation on discussions associated with the space; create topics and replies. Edit and delete any topic or reply.

Note: The Manage permission does not take effect for the Public-User role.

	

Moderator


	
	
Create and Edit Discussions - Create topics and replies. Edit topics and replies that you create. Users with this permission must be allowed to view discussions.

	

Participant


	
	
Reply To Discussions - Reply to existing topics and edit replies that you create. Users with this permission must be allowed to view discussions.

	

Participant


	
	
View Discussions - View discussions.

	

Participant
Viewer


	
Documents

	
Administration - Configure document workflows and access control settings.

	

Moderator


	
	
Delete Documents - Delete any folder and any file in the space. Users with this permission can also move folder and files.Users with the Delete permission must be allowed to create and view folders and files.

	

Moderator
Participant


	
	
Create and Edit Documents - Create files and folders, and upload files. Delete files and folders that you create. Delete other files and folders if permissions allow.

Users with the Create permission must be allowed to view folders and files.

	

Moderator
Participant


	
	
View Documents - Browse files and folders.

	

Moderator
Participant
Viewer


	
Links

	
Create, and Delete Links - Create and delete links between objects, and manage link permissions.

Create Links - Create links between objects.

Delete Links - Delete a link between two objects.


	

	
Lists

	
Create, Edit, and Delete Lists - Create, edit, and delete lists and list data.

Create Lists - Create lists.

Edit Lists - Edit list column definitions.

Delete Lists - Delete any list.

Edit List Data - Add, edit, and delete list data.

View Lists - View lists and list data.

	

	
Mashup Styles

	
Create, Edit, and Delete Mashup Styles - Create, edit and delete mashup styles for the space.

Create Mashup Styles - Create mashup styles for the space.

Edit Mashup Styles - Edit space-level mashup styles.

See also, Section 26.3.4, "Managing Mashup Styles".

	

	
Navigations

	
Create, Edit, and Delete Navigations - Create, edit and delete navigations for the space.

Create Navigations - Create navigations for the space.

Edit Navigations - Edit space-level navigations.

See also, Chapter 11, "Working with Navigation".

	

	
Notes

	
Create, Edit, and Delete Notes - Create, edit and delete notes for the space.

Create Notes - Create notes for the space.

Edit Notes - Edit notes.

Delete Notes - Delete notes.

View Notes - View notes.

	

	
Page Styles

	
Create, Edit, and Delete Page Styles - Create, edit and delete page styles for the space.

Create Page Styles - Create page styles for the space.

Edit Page Styles - Edit space-level page styles.

See also, Chapter 15, "Working with Page Styles".

	

	
Page Templates

	
Create, Edit, and Delete Page Templates - Create, edit and delete page templates for the space.

Create Page Templates - Create page templates for the space.

Edit Page Templates - Edit space-level page templates.

See also, Chapter 12, "Working with Page Templates".

	

	
Resource Catalogs

	
Create, Edit, and Delete Resource Catalogs - Create, edit and delete resource catalogs for the space.

Create Resource Catalogs - Create resource catalogs for the space.

Edit Resource Catalogs - Edit space-level resource catalogs.

See also, Chapter 16, "Working with Resource Catalogs".

	

	
Skins

	
Create, Edit, and Delete Skins - Create, edit and delete skins for the space.

Create Skins - Create skins for the space.

Edit Skins - Edit space-level skins.

See also, Chapter 14, "Working with Skins".

	

	
Space Events

	
Create, Edit, and Delete Events - Create, edit and delete events for the space.

Create Events - Create events.

Edit Events - Edit any event.

Delete Events - Delete any event.

View Events - View events.

	

	
Task Flows

	
Create, Edit, and Delete Task Flows - Create, edit and delete task flows based on a mashup style for the space.

Create Task Flows - Create task flows for the space.

Edit Task Flows - Edit space-level task flows.

See also, Section 26.3, "Creating and Managing Task Flows".

	











52.2.1.3 Understanding Custom Roles in Spaces

If the default roles do not meet the requirements of your space, moderators can define custom roles that better suit its members. See Section 52.2.2, "Defining Custom Roles for a Space".

Alternatively, moderators can modify the permissions assigned to the default roles. See Section 52.2.3, "Viewing and Editing Permissions of a Space Role".








52.2.2 Defining Custom Roles for a Space

If the default roles provided by the Spaces application do not meet the needs of the space, you can define custom roles to better suit the requirements of your members.

To create a new role for a space:

	
In the space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."









On the Roles page, current roles defined for this space display as columns in the table.


	
To define a new role for this space, click Create Role.

The Create Role dialog box opens (Figure 52-4).


Figure 52-4 Creating a New Role for a Space

[image: Create Role dialog]

Description of "Figure 52-4 Creating a New Role for a Space"





	
Enter a suitable Role Name. Names can contain alphanumeric characters, blank spaces, @, and underscores. Ensure that role names are self-descriptive to make it as obvious as possible which member should belong to which roles.


	
Enter a Description for the role.


	
Optionally, choose a Template Role.

The new role inherits permissions from the template role. You can modify these permissions in the next step. If you do not choose a template role, the new role is created with no permissions.

Choose Moderator to create a role that inherits full administrative privileges for the space. Choose Viewer (if available) to create a role starting with minimal, view-only privileges.


	
Click OK.

The new role appears as a column in the table on the Roles page.


	
To modify permissions for the role, select Edit Permissions, and then select or clear each permission checkbox. For details, see Section 52.2.3, "Viewing and Editing Permissions of a Space Role".

Take care to assign appropriate access rights when assigning permissions for new roles. Do not allow users to perform more actions than are necessary for the role but at the same time, try not to inadvertently restrict them from activities they must perform.









52.2.3 Viewing and Editing Permissions of a Space Role

The Edit Permissions dialog lists permissions available for the space, pages in the space, space resources, and services that are enabled for the space. If a service is not shown, then either no permissions are required for that service (for example, the Mail service), or the service is disabled in the space. For more information, see Section 51.10.1, "Enabling and Disabling Services Available to a Space".

If the default permissions assigned by the Spaces application do not meet the needs of the space, or you want to change previously assigned permissions, you can modify the permissions to better suit your role requirements.




	
Note:

The Moderator role permission Manage All cannot be modified.







To change the permissions assigned to a role:

	
In the space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select the role you want to change, then click Edit Permissions.


	
On the Edit Permissions for <role_name> dialog, select or clear the checkboxes to enable or disable permissions for a role (Figure 52-5).


Figure 52-5 Modifying Permissions for a Space
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Description of "Figure 52-5 Modifying Permissions for a Space"





	
Click Save.




New permissions are effective immediately.




	
Note:

For more detailed information about granting access permissions to a space, and to individual pages within a space, refer to Section 51.14.4, "Granting Spaces Users Access to a Space".












52.2.4 Using the Advanced Permission Model

Advanced permissions are detailed permissions that give you more flexibility over role assignments, but can become complex to manage and maintain. For example, you can set create, edit, view, and delete permissions for individual services and resources, rather than setting the same permission for all services or all resource types.If you switch to using the advanced permission model, you cannot revert back to standard permissions later. See also, Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space".

To use advanced permissions:

	
In the space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Click Advanced Permissions.

A warning message displays.


	
Click OK to continue.









52.2.5 Deleting Roles in a Space

When a role is no longer required, the space moderator can remove it from the space. This helps maintain a valid role list and prevents inappropriate role assignment.




	
Note:

The roles Moderator, Authenticated-User, and Public-User cannot be deleted.







To delete a role in a space:

	
In the space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select the role you want to delete, then click Remove Role (Figure 52-6).


Figure 52-6 Deleting a Role for a Space
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In the Delete Role confirmation dialog box, click Delete to confirm that you want to delete the role.











52.3 Managing Members and Assigning Roles

This section describes how moderators manage membership for a space. It includes the following subsections:

	
Section 52.3.1, "What You Should Know About Space Membership"


	
Section 52.3.2, "Viewing Members of a Space"


	
Section 52.3.3, "Composing Messages to New Members"


	
Section 52.3.4, "Adding Members to a Space"


	
Section 52.3.5, "Changing Member Role Assignments"


	
Section 52.3.6, "Approving Requests for Membership of a Space"


	
Section 52.3.7, "Communicating with Moderators and Members of a Space"


	
Section 52.3.8, "Revoking Membership"






52.3.1 What You Should Know About Space Membership

Member participation is central to any space. It is the moderator's responsibility to manage membership and determine member participation through the permissions assigned to the various roles defined for the space. A space can gather members in several ways:

	
If a space is marked as discoverable (see Section 51.14.3, "Making a Space Known (Discoverable)"), it can be made known to anyone logged in to the spaces application through searches and through their Spaces page.


	
If a space is made public (see Section 51.14.5, "Granting Public Access to a Space"), it is available to anyone with access to the Spaces application providing that the Public-User role is granted with appropriate permissions.


	
Moderators can add or invite individual members or groups at the time a space is created, or later (see Section 52.3.4, "Adding Members to a Space").









52.3.2 Viewing Members of a Space

To review current membership for a space:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
In the Members table, review the current list of members and their current role assignment.


	
Using the Filter dropdown, choose All Members to see a full list or choose the name of a role to list members with a particular role.









52.3.3 Composing Messages to New Members

When you add or invite someone to your space, they receive a message through the Mail service (if configured) and through their Worklist (if Worklists are set up). Before you start recruiting new members, take some time to compose suitable greetings and messages for the following scenarios:

	
Adding an existing user as a member of your space.


	
Inviting an existing user to join your space.


	
Inviting someone to register with the Spaces application and join your space.




To compose messages sent out to new members:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select Membership Options in the toolbar.

The Membership Options dialog displays (Figure 52-7).


Figure 52-7 Editing Messages to New Members

[image: Description of Figure 52-7 follows]

Description of "Figure 52-7 Editing Messages to New Members"





	
Enter a short message to include in membership notifications or invitations in the appropriate sections, as required.

	
Add Member Message - Enter a short message to include in membership notifications. Use the message text to welcome new members and introduce your space. Membership notifications display in a user's Worklist. The notification includes a link to the space.


	
Invite Member Message - Enter a short message to include in membership invitations to users who are registered with Spaces. Use the message text to describe the space and how it might be of use to them.

This option requires that workflows are configured for the application. Membership invitations display in a user's Worklist and the invitation includes a secure URL that the invited party must click to accept the membership invitation.


	
Invite Non-Registered Users - Enter a short message to include in membership invitations to people who are not registered Spaces users. Use the message text to describe the space and how it might be of use to them. Membership invitations are sent by e-mail. The invitation includes a secure URL that the invited party must click to accept the membership invitation. The unregistered users will then be prompted to register with Spaces before gaining access to your space.





	
Click OK to save.









52.3.4 Adding Members to a Space

This section describes various ways that a moderator can enlist members for your space:

	
Section 52.3.4.1, "Searching for a User or Group in the Identity Store"


	
Section 52.3.4.2, "Adding Registered Users and Groups"


	
Section 52.3.4.3, "Inviting a Registered User"


	
Section 52.3.4.4, "Allowing a Registered User to Self-Subscribe"


	
Section 52.3.4.5, "Inviting a Non-Registered User"






52.3.4.1 Searching for a User or Group in the Identity Store

The search mechanism used by Spaces to locate users and groups in the identity store follows specific rules. Keep the following tips in mind when you construct your search terms:

	
The search operates on First Name, Last Name , Mail Address, User ID, and Common Name. For example, in Oracle Internet Directory (OID), the search operates on givenname, sn, mail, uid, and cn.

For information about mapping user attributes to their corresponding names in different LDAP directory servers, see "Mapping User Attributes to LDAP Directories" in Oracle Fusion Middleware Application Security Guide.


	
If you specify a wild card (*) character anywhere in the search term, it is ignored. Additionally, the following characters are ignored:

! @ # $ % ^ & ( ) + = [ ] { } | ; ' \ " , < > / ? ` ~ -


	
The search is not case-sensitive.


	
Leave the search term blank to list all users (or groups) in the identity store.


	
To search for a First Name, Last Name, Mail Address, User ID, or Common Name, specify one search term, specifying at minimum the first letter in any of these values.


	
To search for First Name or Last Name, specify two search terms separated by a space to search in First Name and Last Name, respectively. Specify at minimum the first letter in each value.


	
To search for a First Name or Last Name, either of which have multiple names, specify multiple search terms separated by spaces. The multiple names are treated as a single field, including the space character. The first search term specifies the search on the First Name field and the last search term specifies the search on the Last Name field. The intervening search terms are ignored. Specify at minimum the first letter of each value.




For example, the following entry in the identity store defines a Spaces user:



First Name (givenname)=James Robert

Last Name (sn)=van Order

Mail Address (mail)=jim.van.order@oracle.com

User ID (uid)=jimbo

Common Name (cn)=Jim

Table 52-4 lists search terms that will show this user in the search results. For search terms that will not show this user in the search results, see Table 52-5.


Table 52-4 Search Terms That Find James Robert van Order

	Search Terms	Search Results
	
James

james

*James

	
Wild card character (*) is ignored; James found in First Name.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.


	
Jam

jam

Jam*

	
Wild card character (*) is ignored; Jam found in First Name.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.


	
van

Van

	
van found in Last Name.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.


	
jimbo

Jimbo

	
jimbo found in User ID.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.


	
jim

Jim

	
jim found in Mail Address, User ID, and Common Name.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.


	
James Order

james order

	
James found in First Name; Order not found in Last Name.

Results show all users where first search term begins the First Name, or second search term begins the Last Name.


	
Robert van

robert Van

	
Robert not found in First Name; van found in Last Name.

Results show all users where first search term begins the First Name, or second search term begins the Last Name.


	
James van Order

james Van order

	
James found in First Name, Order not found in Last Name.

Results show all users where first search term begins the First Name, or last search term begins the Last Name. Intervening term is ignored.


	
James Robert van Order

james robert Van order

	
James found in First Name; Order not found in Last Name.

Results show all users where first search term begins the First Name, or last search term begins the Last Name. Intervening terms are ignored.








Table 52-5 lists search terms that will not show this user in the search results.


Table 52-5 Search Terms That Do Not Find James Robert van Order

	Search Terms	Search Results
	
ame

	
ame not found in First Name, Last Name, Mail Address, User ID, or Common Name.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.


	
Robert Order

robert order

	
Robert not found in First Name, and Order not found in Last Name.

Results show all users where first search term begins the First Name, or second search term begins the Last Name.


	
*ames

	
Wild card character (*) is ignored; ames not found in First Name, Last Name, Mail Address, User ID, or Common Name.

Results show all users where search term begins the First Name, Last Name, Mail Address, User ID, or Common Name.












52.3.4.2 Adding Registered Users and Groups

As space moderator, you can add any user currently registered with Spaces to become a member of your space. Existing users receive notification through the Mail service (if configured) and through their Worklist (if Worklists are set up).

To add a member to your space:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
(Optional) Click Membership Options to edit the greeting messages sent to new members (see Section 52.3.3, "Composing Messages to New Members") and then click Save to close the Membership Options dialog.


	
Choose one of:

	
Add People to add one or more individual users as members of the space.


	
Add Groups to add multiple users belonging to a named user group in the identity store.





	
If you know the exact name of the person or group, enter the name in the box provided, separating multiple names with a comma (Figure 52-8).

If you are not sure of the name you can search the identity store. Enter one or more characters of the name you are looking for and click the Filter icon. Users (or groups) matching your search criteria display in the table.


Figure 52-8 Adding a New Member

[image: Add People on Members subtab]



	
Select one or more user names from the list.




	
Note:

Adding the PUBLIC user to a space does not make the space available to the public. To find out how to make a space public, see Section 51.14.5, "Granting Public Access to a Space".








	
Select a role for the new (or invited) members. If the role you want is not listed, create a role that meets your requirements (see Section 52.2.2, "Defining Custom Roles for a Space").


	
Click Add.




All the users and groups you select display in the Members table.




	
Note:

Some additional notes about adding groups:
	
Names of user groups are clickable enabling you to drill down to see individual user names of group members.


	
A list of members does not display for dynamic group based on Oracle Entitlements Server (OES) roles since OES roles are based on dynamic attributes and therefore do not have any static members. See also, "Configuring Dynamic Groups" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
For the Spaces application to properly maintain enterprise group-to-role mappings, back-end servers, such as the discussions server and content server, must support enterprise groups too. When back-end servers do not support enterprise groups, the message "Group [name] not found in the Identity Store" displays. See also, Section 21.3, "Troubleshooting Issues with Users and Roles".

















52.3.4.3 Inviting a Registered User

As space moderator, you can invite anyone who is currently registered with Spaces to become a member of your space. Invited users receive notification through the Mail service (if configured) and through their Worklist (if Worklists are set up).

To invite someone to become a member of your space:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
(Optional) Click Membership Options to edit the greeting message sent to invited members (see Section 52.3.3, "Composing Messages to New Members") and then click Save to close the Membership Options dialog.


	
Click Invite People, then Invite Registered Users to invite individual users to become a member of the space.

Note: This option does not display if the Mail service or the Worklist service is not configured.


	
If you know the exact name of the person, enter the name in the box provided, separating multiple names with a comma (Figure 52-8).

If you are not sure of the name you can search the identity store. For search tips, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store". The First Name, Last Name, Mail Address, and CN fields are included in the search.




	
Search Tips:

	
Use * as a wildcard, for example *sales.


	
Leave the search field blank to list all users (or groups) in the identity store.


	
Enter a space between two search terms to search First Name and Last Name, for example jo sm, searches for jo in First Name and sm in Last Name.













Figure 52-9 Inviting a New Member

[image: Invite People on Members subtab]



	
Select one or more user names from the list.




	
Note:

Adding the PUBLIC user to a space does not make the space available to the public. To find out how to make a space public, see Section 51.14.5, "Granting Public Access to a Space".








	
Select a role for the invited members. If the role you want is not listed, create a role that meets your requirements (see Section 52.2.2, "Defining Custom Roles for a Space").


	
Click Invite.




If you want to cancel an ivite, delete the invited member from the list.






52.3.4.4 Allowing a Registered User to Self-Subscribe

Self-service enables existing Spaces users to request membership without an invitation from the space moderator. Certain types of spaces, especially interest-based communities, are particularly suited to this form of member enrollment as the space often reaches a wider audience.

The capabilities of self-service members depends on which roles you decide to offer on the Request Membership page. For more information, see Section 52.1.1, "Managing Self-Service Membership for a Space".






52.3.4.5 Inviting a Non-Registered User

If your Spaces application allows unregistered people to become members, space moderators can invite anyone with a valid mail address to join the space. Prospective members receive an invitation by mail, inviting them to join the space. Upon accepting the invitation, unregistered users are prompted to register with the Spaces application before gaining access to the space.

To invite someone outside the Spaces community to join your space:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Click Membership Options to edit the greeting message that is sent to people who are not yet registered Spaces users (see Section 52.3.3, "Composing Messages to New Members") and then click Save to close the Membership Options dialog.


	
Click Invite People, then Invite Non-Registered Users.




	
Note:

The Invite Non-Registered Users section displays only when self-registration is enabled through Spaces Administration:
	
Allow Self-Registration Through Invitations


	
Allow Public Users to Self-Register




See also, Chapter 22, "Enabling Self-Registration".










	
Enter the Email Address(es) for one or more prospective members, separated by commas.


	
Select a Role for the prospective members. If the role you want is not listed, create a role that meets your requirements (see Section 52.2.2, "Defining Custom Roles for a Space").


	
Click Invite.




Prospective members receive an mail invitation to join the space with the message you compose using the Invite Non-Registered User Message (see Section 52.3.3, "Composing Messages to New Members"). The invitation includes a secure, self-registration URL that the invited party can click to register with the Spaces application and accept space membership (see Section 49.7.2, "Joining a Space (Unregistered Spaces User)".








52.3.5 Changing Member Role Assignments

Moderators can change a member's role at any time. Users are notified of membership changes through their Worklist.

To change a member's current role:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select one or more members, and then click the Change Role icon.


	
In the Change Role dialog box, choose a different role.

If you are not sure which role to choose, click the Roles tab to determine the range of actions that current roles allow (see Section 52.2.3, "Viewing and Editing Permissions of a Space Role"). If the existing roles do not meet your requirements, consider creating a new role (see Section 52.2.2, "Defining Custom Roles for a Space").


	
Click OK.









52.3.6 Approving Requests for Membership of a Space

If someone requests membership of your space or an existing member requests a new role, a notification appears in your Worklist. As space moderator, you can approve or reject these requests.

The person making the request receives notification of your decision. If you reject a request, you should explain the reasons why.

For details, see Chapter 70, "Working with the Worklist Service".






52.3.7 Communicating with Moderators and Members of a Space

You can send messages to individual members, and also to the moderator(s) or all the members of a space. The Spaces application creates a default distribution list for every space if the Mail server is Microsoft Exchange and active directory connection details (LDAP) are provided in the mail server connection settings. As members leave or join the space, the default distribution list updates automatically.

For information about setting up a custom space mail distribution list, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List".

There are several ways to communicate with the moderator(s) and members of a space:

	
(Moderators/members only) Sending a Message from the Spaces Browser


	
(Moderators only) Sending a Message from the Members Page


	
(Moderators/members and non-members) Contacting Space Moderator(s)






52.3.7.1 Sending a Message from the Spaces Browser

(Members only) To send a message to the moderator(s) or all members from the Spaces page:

	
In the Home space, click Spaces.


	
On the Spaces page, find the space to which you want to send mail. If it is not shown, use Filter or Search to list it (see Section 49.4, "Viewing Available Spaces").


	
Right-click the Space's icon, and then choose Contact> Send Mail to Members or Send Mail to Moderators (Figure 52-10).

These options are available only to members.


Figure 52-10 Actions Menu
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52.3.7.2 Sending a Message from the Members Page

(Moderators only) To send a message to all members, or an individual member, from the Members page:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Under Members:

	
To send a message to all members of the space, click Mail Members in the toolbar.


	
To send a message to an individual member, click the member's icon, and then click the members mail address.












52.3.7.3 Contacting Space Moderator(s)

You can contact a space moderator from the Spaces browser:

	
In the Home space, click Spaces.


	
On the Spaces page, find the space to which you want to send mail. If it is not shown, use Filter or Search to list it (see Section 49.4, "Viewing Available Spaces").


	
Right-click the space's icon, and then choose Contact> Send Mail to Moderators (Figure 52-10).

These options are available only to members.


Figure 52-11 Actions Menu
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52.3.8 Revoking Membership

Moderators can revoke user membership for a space at any time. Users receive notification through their Worklist when you cancel their membership.

To revoke membership:

	
In the space administration settings, display the Members page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select one or more members in the table, and then click Remove Member. (Figure 52-12)


Figure 52-12 Removing a Member
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Description of "Figure 52-12 Removing a Member"





	
In the Remove Member dialog box, click Remove to confirm.











52.4 Working with the Members Task Flow

The Spaces application provides a Members task flow which lists all the members of a particular space. This task flow is an abbreviated version of the Members page in the space administration settings, as described in Section 52.3.2, "Viewing Members of a Space."

To add a Members task flow to a page, see Section 51.16.1, "Adding a Space Task Flow to a Page."

This section includes the following subsections:

	
Section 52.4.1, "What You Should Know About the Members Task Flow"


	
Section 52.4.2, "Managing Space Membership Through the Members Task Flow"


	
Section 52.4.3, "Contacting All Space Members"


	
Section 52.4.4, "Contacting Individual Members of a Space"


	
Section 52.4.5, "Sorting Members"


	
Section 52.4.6, "Filtering Members"


	
Section 52.4.7, "Setting Members Task Flow Properties"






52.4.1 What You Should Know About the Members Task Flow

The Members task flow enables you to get an at-a-glance view of the members of a space. It lists the members of the space and also shows each user's role within the space, for example, Moderator, Participant, and Viewer. The Members task flow also provides a quick way of getting to the space administration Members page where you can manage space membership, if you have the appropriate permissions.

To add a Members task flow to a page, see Section 51.16.1, "Adding a Space Task Flow to a Page."




	
Note:

Names of user groups are clickable enabling you to drill down to see individual user names of group members.
A list of members does not display for dynamic group based on Oracle Entitlements Server (OES) roles since OES roles are based on dynamic attributes and therefore do not have any static members. See also, "Configuring Dynamic Groups" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.














52.4.2 Managing Space Membership Through the Members Task Flow

Moderators can quickly access the tools for managing space membership from the Members task flow.

To manage space membership:

	
Log in and locate the Members task flow.


	
In the Members task flow, click the Add icon (Figure 52-13).

The Add icon only displays to moderators or members with the space permission Manage All.


Figure 52-13 The Add Icon in the Members Task Flow
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This takes you to the Members tab where you can add members as described in Section 52.3.4.2, "Adding Registered Users and Groups."


	
On the Members tab, you can also remove members, invite users to join the space, and edit exiting members' roles within the space. For more information, see Section 52.3, "Managing Members and Assigning Roles."









52.4.3 Contacting All Space Members

If you have a message to send to all members of the space, you can do this from the Members task flow.

To contact all space members:

	
Log in and locate the Members task flow.


	
Click Mail All Members in the Members task flow toolbar (Figure 52-14).

You may be presented with a login window. If so, then enter your user name and password for your mail application. If your preferences are set up to deliver your login credentials automatically, then you can start your message right away. For more information about login credentials and preferences, see Chapter 35, "Setting Your Personal Preferences."


Figure 52-14 Mail All Members Icon in the Members Task Flow
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Compose your message and click Send.









52.4.4 Contacting Individual Members of a Space

It's easy to contact a space member from the Members task flow:

To contact a member:

	
Log in and locate the Members task flow.


	
In the Members task flow, click the name of the member you want to contact (Figure 52-15).


Figure 52-15 Contacting a Member Using the Members Task Flow
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By default, when you click a member's name their profile summary displays. From here, you can contact the member by mail, send them an instant message, and so on. See also, Section 30.5.1, "Viewing Profile Details."

The profile does not display if the Profile Launched on Selection parameter is disabled, for details see Section 52.4.7.2, "Members Task Flow Parameters".









52.4.5 Sorting Members

You can sort the list of members by name or by recent activity. Use the Sort Criteria parameter described in Section 52.4.7.2, "Members Task Flow Parameters".






52.4.6 Filtering Members

Use filtering to help find a particular member in the Members task flow.

To filter the list of members:

	
Log in and locate the Members task flow.


	
In the Members task flow, enter a full or partial name in the Filter field (Figure 52-16), and then click the Filter arrow icon to the right of the field.


Figure 52-16 Filtering Options in the Members Task Flow
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The list of members refreshes, displaying only those members that match the search term.

Filtering searches against a listed member's user name. For example, if your search criteria is "c", the search results might include members named "chris", "vicki", or "weblogic".


	
Alternatively, filter the members by role by selecting a Role from the dropdown list.


	
To return the list of members to its default display, click the Clear Filter icon (Figure 52-17) and select All Members from the Role dropdown.


Figure 52-17 Clear Search Icon in the Members Task Flow
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52.4.7 Setting Members Task Flow Properties

The Members task flow has associated properties, which users with sufficient privileges can access from the Component Properties dialog in Composer (Figure 52-18).


Figure 52-18 Members Task Flow Component Properties
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Members task flow and describe the properties on the Parameters tab:

	
Section 52.4.7.1, "What You Should Know About Members Task Flow Properties"


	
Section 52.4.7.2, "Members Task Flow Parameters"






52.4.7.1 What You Should Know About Members Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 52.4.7.2, "Members Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






52.4.7.2 Members Task Flow Parameters

Table 52-6 describes the parameters that are unique to the Members task flow.


Table 52-6 Members Task Flow Properties: Parameter Tab

	Parameter	Description
	
Space Name

	
The name of the space for which to display members. The default value is the current space. Use this parameter to display member details for a different space.

You can obtain a space's name from its About this Space dialog.

Express values using the following formats:

	
Constant—Express a constant value, such as Marketing.


	
Page parameter—Enter a page parameter to fetch the value from the page on which the task flow is placed. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."


	
EL expression—Enter an Expression Language (EL) expression.





	
Number of Columns

	
The number of columns used to display members. The default is null which means 'no limit' and in this case member details wrap to fill the entire width of the task flow.

To fix the number of members displayed in each row, enter the number of 'columns' you require. Horizontal scroll bars display if there is not enough space to display the number of members specified here.

Express values using the following formats:

	
Constant—Express a constant value, such as 2 or 5.


	
Page parameter—Enter a page parameter to fetch the value from the page on which the task flow is placed. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."


	
EL expression—Enter an Expression Language (EL) expression.





	
Number of Rows

	
The number of rows used to display members. The default is null which means that member details wrap to fill the space available. Vertical scroll bars display if there is not enough space to display all the members.

To fix the maximum number of rows displayed, enter the number of 'rows' you require. Previous and Next buttons automatically display if more member details are available.

Express values using the following formats:

	
Constant—Express a constant value, such as 2 or 5.


	
Page parameter—Enter a page parameter to fetch the value from the page on which the task flow is placed. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."


	
EL expression—Enter an Expression Language (EL) expression.





	
Profile Launched on Selection

	
Determines whether to launch a profile popup when you select a member's name.

Deselect this option if you do not want to launch profile details.


	
Sort Criteria

	
The order in which to sort the members.

Specify LAST_ACTIVITY_TIME to sort the members in descending order of date/time at which they were last involved in any activity. If not specified, members are sorted by name, alphabetically.



















53 Administering Spaces and Templates

This chapter describes how a Spaces administrator with Spaces-Manage All or Space Templates-Manage All permissions can manage everyone's spaces and space templates in Spaces.

It includes the following sections:

	
Section 53.1, "Understanding Space Management and Migration"


	
Section 53.2, "Performing Administrative Tasks for All Spaces"


	
Section 53.3, "Performing Administrative Tasks for All Space Templates"


	
Section 53.4, "Enabling and Disabling Services"


	
Section 53.5, "Importing and Exporting Spaces and Space Templates"


	
Section 53.6, "Troubleshooting"




For more information about exporting and importing an entire Spaces application, see "Exporting and Importing Entire Spaces Application for Data Migration" Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


Audience

This chapter is intended for Spaces administrators with the Manage Configuration, and Spaces-Manage All or Space Templates-Manage All permissions.



53.1 Understanding Space Management and Migration

Spaces administrators with Spaces-Manage All or Space Templates-Manage All permissions can manage any space or space template from Spaces Administration (Figure 53-1). From here, you can take any space temporarily offline and close down any spaces deemed inactive. Administrators can rename and edit any space, as well as delete spaces when they are no longer required.

Space moderators do not have access to this page. While moderators may perform some of these tasks for spaces that they own through space administration pages, the Spaces administrator can manage all of them.

The Spaces Administration pages also offers import and export services that enable you to back up or move information between Spaces applications, and stage or production environments. Import and export options are only available to users with full administrative permission, that is, have the Application-Manage All permission. See also Section 53.5, "Importing and Exporting Spaces and Space Templates."


Figure 53-1 Spaces Administration - Spaces

[image: Spaces Administration - Spaces Tab]



Table 53-1 shows which application-level permissions are required to perform administrative tasks through these tabs. See also, Section 20.3, "Understanding Application Roles and Permissions".


Table 53-1 Permission Requirements for Space Administration and Migration

	Administrative Tasks	Application Permissions Required
	
Spaces Tab

	
Application-Manage Configuration


	
- About Spaces

	
Application-Manage Configuration


	
- Create Spaces

	
Spaces-Create


	
- Edit Spaces

	
Spaces-Manage All


	
- Delete Spaces

	
Spaces-Manage All


	
- Import/Export Spaces

	
Application-Manage All


	
	

	
Space Templates Tab

	
Application-Manage Configuration


	
- About Space Templates

	
Application-Manage Configuration


	
- Create Space Templates

	
Space Templates-Create


	
- Edit Space Templates

	
Space Templates-Manage All


	
- Delete Space Templates

	
Space Templates-Manage All


	
- Import/Export Space Templates

	
Application-Manage All












53.2 Performing Administrative Tasks for All Spaces

Spaces administrators can change the status of any space. This section describes the steps to perform the following tasks:

	
Section 53.2.1, "Viewing Space Information"


	
Section 53.2.2, "Taking Any Space Offline"


	
Section 53.2.3, "Bringing Any Space Back Online"


	
Section 53.2.4, "Closing Any Space"


	
Section 53.2.5, "Reactivating Any Space"


	
Section 53.2.6, "Deleting a Space"


	
Section 53.4, "Enabling and Disabling Services"






53.2.1 Viewing Space Information

Spaces administrators can view and manage any space through Spaces Administration. From here, you can quickly see whether spaces are active, online, offline, how recently the space was accessed, as well as membership numbers.

The toolbar offers additional options for editing, changing status, and deleting spaces, and if you select About Space you can access useful information such as the space's direct URL and internal ID (Figure 53-2).


Figure 53-2 About Space Dialog
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By default, spaces are listed alphabetically. To view the information sorted by a different column, click the sort icon for the column. Sort icons appear when you hover the mouse cursor over the column header.

To display the Administration page for all spaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages.".


	
Click Spaces, then Spaces (Figure 53-1).









53.2.2 Taking Any Space Offline

When a space is offline, members of the space who do not have Spaces-Manage All permission are unable to access the space. If members try to access the space, they will see the Space Unavailable page. See also Section 7.3, "Working with System Pages."

Administrators and members with the Spaces-Manage All permission can access a space that is offline. So if, for example, an administrator who notices inappropriate content can take a space offline, fix the content, and bring it back online later.

To permanently close down a space that is not being used any more, see Section 53.2.4, "Closing Any Space".

To take a space offline:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces (Figure 53-1).


	
On the Spaces page, select the space you require by highlighting the row in the table. Ctrl-Click rows to select more than one.


	
From the Edit menu, select Offline for Maintenance (Figure 53-3).


Figure 53-3 Taking a Space Offline

[image: Taking a Space Offline]



	
Click OK.









53.2.3 Bringing Any Space Back Online

To bring any space back online:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces (Figure 53-1).


	
On the Spaces page, select the required space by highlighting the row in the table. Use Ctrl-Click to select more than one.


	
From the Edit menu, select Bring the Space Online (Figure 53-4).


Figure 53-4 Bringing a Space Online
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Click OK.









53.2.4 Closing Any Space

A Spaces administrator can close any space that is no longer being used. When you close a space, the content is archived. The space is removed from everyone's "Spaces switcher menu" to avoid clutter. The space's content remains accessible and searchable to those who still want to reference it and space members can continue working in the space.

If you want to close down a space temporarily, take the space offline instead. See Section 53.2.2, "Taking Any Space Offline".

To close a space:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces (Figure 53-1).


	
On the Spaces page, select the required space by highlighting the row in the table. Use Ctrl-Click to select more than one.


	
From the Edit menu, select Close to All Users (Figure 53-5).


Figure 53-5 Closing a Space
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Click OK.









53.2.5 Reactivating Any Space

Spaces administrators and space moderators may close a space if it is no longer being used. If you want to reopen a space, you can do so.

To reactivate a space:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces (Figure 53-1).


	
On the Spaces page, select the required space by highlighting the row in the table. Use Ctrl-Click to select more than one.


	
From the Edit menu, select Activate the Space (Figure 53-6).


Figure 53-6 Activating a Space
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Click OK.









53.2.6 Deleting a Space

Spaces administrators with the Spaces-Manage All permission can delete any space. Once a space is removed from Spaces it cannot be recovered. Spaces are permanently removed and current members will no longer see the space in their view.

When you delete a space:

	
All pages associated with the space are deleted.


	
Links, lists, notes, tags, and events) associated with the space is deleted.


	
Space roles and membership details are deleted.


	
Content managed by discussions and announcements is deleted when it is stored in the default forum or category created by the space. Content managed by nondefault forums or categories is not deleted (for details, see Section 51.10.3, "Modifying Discussion Forum Settings for a Space").


	
The space mail distribution list that is automatically created by the Spaces application is deleted. However, distribution lists that are customized by the space moderator are not deleted (for details, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List").


	
Content managed by external services, such as content repositories, mail, and so on, is removed.


	
If the space is a parent in a space hierarchy, child subspaces are deleted too.




You cannot delete a space while the moderator is editing space settings, but there are no other restrictions.

To delete a space that is no longer required:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces (Figure 53-1).


	
On the Spaces page, select the required space by highlighting the row in the table. Use Ctrl-Click to select more than one.


	
Select the Edit menu, and choose Delete the Space(s) (Figure 53-7).


Figure 53-7 Deleting a Space
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Click Delete to confirm that you want to delete the space(s).




If the delete process fails for any reason, the space is not removed from the administrator's Spaces tab; this sometimes happens when a back-end server cannot be contacted. If the administrator clicks Delete again from here, the space will be removed.








53.3 Performing Administrative Tasks for All Space Templates

Spaces administrators with the Space Templates-Manage All permission can review, publish, hide, and delete any space template. This section describes how to perform these tasks:

	
Section 53.3.1, "What You Should Know About Managing Space Templates"


	
Section 53.3.2, "Viewing Space Templates"


	
Section 53.3.3, "Publishing and Hiding Space Templates"


	
Section 53.3.4, "Deleting a Space Template"






53.3.1 What You Should Know About Managing Space Templates

Several space templates are provided out-of-the-box. In addition, users with the Space Templates-Create permission can create customized templates from spaces and share them with other users. For more information, see Section 50.2, "Creating a Custom Space Template".

Spaces administrators with the Space Templates-Manage All permission can manage every space template from Spaces Administration (Figure 53-8). You can see which space templates are currently available and delete space templates when they are no longer required. You can also publish templates—making them available to everyone—or restrict them to private use only.

It is important to keep the template list up to date and valid. Anyone who creates a space will see public templates as well as their own private templates.

The Space Templates page provides import and export services, too. For more information, see Chapter 53, "Importing and Exporting Spaces and Space Templates".


Figure 53-8 Spaces Administration - Space Templates Page
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53.3.2 Viewing Space Templates

Spaces administrators with the Space Templates-Manage All permission can view and manage any space through Spaces Administration. From here, you can quickly see who created each space template (a space moderator), and the date on which it was created. The Actions menu offers additional options for deleting space templates, and you can publish and hide templates from here, too.

By default, space templates are listed alphabetically. To view the information sorted by a different column, click the sort icon for the column. Sort icons appear when you hover the mouse cursor over the column header.

To see a list of every space template in Spaces, together with their description, creator, and other useful information:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces, then Templates (Figure 53-8).









53.3.3 Publishing and Hiding Space Templates

While the Spaces application can accommodate any number of templates, a limited number of templates is sometimes more effective. The Spaces administrator or users granted the Space Templates-Manage All permission can maintain the template list through Spaces Administration. To view the Space Templates page, a user must additionally be granted Application-Configure permission by the Spaces administrator.

To publish or hide a space template:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces, then Templates (Figure 53-8).


	
Select the required space templates by highlighting the row in the table. Ctrl-Click rows to select more than one.


	
From the Edit menu, choose:

	
Make Public to share the template with everyone.


	
Remove Public Access to remove the template from the space template list. The template owner can use the template, but nobody else will see it.





	
Confirm your selection.







	
Note:

The seeded (out-of-the-box) templates can be made private and published by the Spaces administrator or users granted the Space Templates - Manage All permission. If made private, they are not shown on the Space Templates page in the Home space; they can only be seen on the Spaces Administration-Space Templates page.












53.3.4 Deleting a Space Template

Spaces administrators with the Space Templates-Manage permission can delete any Space template except out-of-the-box templates such as Blogger and Team Site.

To delete a space template that is no longer required:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces, then Templates (Figure 53-8).


	
Select the required space templates by highlighting the row in the table. Ctrl-Click rows to select more than one.


	
From the Edit menu (Figure 53-9), select Delete Space Template.


Figure 53-9 Deleting a Space Template
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Click Delete to confirm that you want to delete the selected template(s).











53.4 Enabling and Disabling Services

 You can enable and disable services for individual spaces. In most cases, the space moderator will manage service requirements for their own space, but Spaces administrators can also perform this task if required to do so. For details, see Section 51.10.1, "Enabling and Disabling Services Available to a Space".

Spaces services, such as Discussions and Mail, are configured by your Fusion Middleware Administrator through Fusion Middleware Control or using the WLST command-line tool. All services automatically become available in the Spaces application when the application starts up—no additional configuration is required inside Spaces.

There is no facility to disable services for the entire application as the Fusion Middleware Administrator takes care of this through Fusion Middleware Control. See "Getting the Spaces Application Up and Running" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.






53.5 Importing and Exporting Spaces and Space Templates

Spaces provides a set of export and import utilities that enable you to back up or move information between Spaces applications, and stage or production environments. To use these utilities you must have the Spaces Administrator role or a custom role that grants the Application-Manage All permission.

This section describes how to export and import spaces and space templates through Spaces Administration pages. It includes the following sections:

	
Section 53.5.1, "Exporting Spaces"


	
Section 53.5.2, "Importing Spaces"


	
Section 53.5.3, "Exporting Space Templates"


	
Section 53.5.4, "Importing Space Templates"


	
Section 53.6.3, "Troubleshooting Issues with Space Import and Export"




Fusion Middleware Administrators can also export and import spaces and space templates using WLST commands. To find out more about these WLST commands, how to migrate the back-end data associated with spaces, and also how to export an entire Spaces application, see "Exporting and Importing Entire Spaces Application for Data Migration" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.



53.5.1 Exporting Spaces

Spaces administrators can export individual spaces and import them into other Spaces applications. Each space must be taken offline, even if only temporarily, to prevent data conflicts during the export process. See, Section 51.4.3, "Taking a Space Offline."

Space information is exported into a single export archive (.ear file). The EAR file contains a metadata archive (.mar file) and, optionally, a single XML file containing space security policy information. You can save export archives to your local file system or to a remote server file system.

For more information about what is exported, read "Understanding Spaces Export and Import" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

The export process does not include data associated with external services such as Mail, Discussions, Announcements, Instant Messaging and Presence, Events, and Documents, as all this data is stored on external servers. To learn how to move data associated with these services, refer to documentation for that product. See also, "Migrating Back-end Components for Individual Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.




	
Note:

Space artifacts must be located in the content directory to be exported. For example, icons and images, and so on, associated with a page template must be placed in the page template's content directory to be exported. For more information, see Section 10.4.2.1, "What You Should Know About a Resource's Properties".
If the space contains Web Service data controls, all the associated Web Services must be up and accessible for the export to succeed.

Out-of-the-box templates and user customizations are never exported. For information on user customizations, see Section 29.4.2, "Performing User Customizations on Your Page View."









Spaces administrators can export spaces through Spaces Administration as described here. Fusion Middleware administrators can also export spaces using WLST commands. For details, see "Importing Spaces Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

You can also export space templates but this is a separate process. You cannot export spaces and space templates into a single archive. For details, see Section 53.5.3, "Exporting Space Templates".

To export one or more spaces through Spaces Administration

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces.


	
Select the space required by highlighting the row in the table.

Ctrl-click rows to select more than one.

Ensure that all the spaces you select (and subspaces) are offline. Spaces must be taken offline, even if only temporarily, to prevent data conflicts during the export process. Unsaved changes are not exported. See also Section 51.4.3, "Taking a Space Offline."




	
Note:

Other members with the Spaces-Manage All permission should not edit Spaces during the export process.








	
Click Export in the toolbar.

The Export Spaces dialog box opens (Figure 53-10).


Figure 53-10 Exporting Spaces
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Change the Archive Name or accept the default name.

To ensure uniqueness, the default .ear filename contains a timestamp: webcenter_<timestamp>.ear


	
Click Export.


	
If any of the spaces selected for export include custom portal resources, you must specify whether or not you want to include resource-specific content in the space archive (Figure 53-11).


Figure 53-11 Exporting Custom Resource Content
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Do one of the following:

	
Click Yes to export content, such as images and icons, that is referenced by portal resources in the archive (skins, page templates, and so on).

The Spaces application stores content for all portal resources under a 'shared' directory (oracle\webcenter\siteresources\scopedMD\shared\...) rather than on a space-by-space basis. Consider the following before exporting content directories for the resources in your archive:

	
Entire content directories are exported rather than individual files. For example, if a skin references two files (...\shared\skins\logos\mylogo.gif and ...\shared\skins\icons\myicon.gif), the entire content of both directories (\logos and \icons ) are exported.


	
The size of \shared\... content directories. If your Spaces installation utilizes a large number of portal resources (both at the application-level as well as by individual spaces and space templates) then the number of files stored under the \shared directory or a \shared subdirectory is potentially large.


	
On import, all files under the content directories are uploaded to the target application and existing files with the same name are overwritten. While you can opt not to upload content directories on import, it's an all or nothing approach, that is, you cannot upload content specific to a particular resource or space.





	
Click No to exclude content under the \shared directory that is referenced by portal resources.





	
Progress information is displayed during the export process (Figure 53-12).

When the export process is complete, specify a location for the export archive (.ear).


Figure 53-12 Exporting Spaces In Progress
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Select one of:

	
Download - Saves the export EAR file to your local file system.

Your Browser downloads and save the archive locally. The actual download location depends on your Browser set up.


	
Save to Server - Saves the export .ear file to a server location.

When the Save to Server dialog box displays (Figure 53-13), enter a suitable path in Server Location, for example, /tmp, and then click Save. Ensure that the server directory you specify has write permissions.


Figure 53-13 Saving Space Export Archives to a Server Location
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Description of "Figure 53-13 Saving Space Export Archives to a Server Location"








	
Click Close to dismiss the Export Spaces window.




The export archive (.ear) is saved to the specified location.






53.5.2 Importing Spaces

Spaces administrators can import a space archive (.ear) into another Spaces application.

On import, all spaces included in the archive are created or re-created on the target application. Existing spaces are deleted then replaced, and new spaces are created.

If you intend to import spaces with names identical to those available on the target application, ensure that those spaces are offline in the target application. It is not possible to overwrite a space, on import, if it is online. For details, see Section 51.4.3, "Taking a Space Offline."

Spaces are locked during an import operation to prevent simultaneous imports/exports of the same space. If someone else is importing a particular space, all subsequent attempts to import (or export) the same space are blocked.

All spaces need a security policy to work properly so, when you import a brand new space for the first time, you must include the space's security policy. Existing spaces have a security policy in place so in this case, it's up to you whether to overwrite the security information on import or maintain the existing security policy.

When you import a space with security, security policy updates do not apply immediately. Any user logged in to the Spaces application must log out and log back in to adopt new security policies for the space.

If data migration is important, you can elect to import data associated with the space such as activity streams, events, feedback, lists, links, message boards, people connections, and profiles. Documents and discussions can be migrated for individual spaces too but migrating externally stored data is a separate process, as described in "Migrating Back-end Components for Individual Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Spaces administrators can import spaces through Spaces Administration as described here. Fusion Middleware administrators can also import spaces using WLST commands. For details, see "Importing Spaces Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

To import one or more spaces or subspaces:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces.


	
Click Import in the toolbar.




	
Tip:

To import one or more spaces as a subspace of an existing space, select the target space before clicking the Import button.







The Import Spaces dialog box opens (Figure 53-14).


Figure 53-14 Importing Spaces
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Specify the location of your space archive (.ear). Select one of:

	
On Local System - Enter the location in the text box. Alternatively, click Browse to locate the directory on the local file system where the .ear file is stored.


	
On Server - Enter the path, including the archive filename, in the text box. For example, /tmp/MySpaceExport.ear. You can specify any shared location accessible from this Spaces application.





	
Click Browse Archive to review the content available for import.


	
Set import options as required. For details, see Table 53-2:


Table 53-2 Space Import Options

	Field	Description
	
Include Services Data

	
Select to import the following

	
Data stored in the WebCenter repository for the following services: Activity Streams, Events, Feedback, Lists, Links, Message Boards, People Connections, Profiles, and Tags


	
Default settings for Profiles, Message Boards, Feedback, Connections, Activity Streams


	
Activity Stream Task Flow Customizations




Deselect this option if you do not want to export any data associated with lists, events, tags, links, connections, profiles, message boards, activity streams, and feedback. For example, when moving a space from a test environment to a stage or production environment where test data is not required.


	
Include Customizations

	
Select to import space customizations. For information about which customizations are optional on import, read "Understanding Spaces Export and Import" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

If you deselect this option:

	
New spaces are imported without customizations (that is, default task flows are imported without any customizations and the default space settings are used).


	
If you are importing a space that already exists on the target, existing customizations on the target are preserved.




Note: Portlet and page customizations are always imported.


	
Include Security Policy

	
Select to import security information with the space.

When selected, the following security related information is imported:

	
Space roles (and permissions assigned to each role).


	
Space members (and member role assignments).




Deselect this option if you do not want to import space security information. This option is useful when importing spaces between a stage and production environments, where:

	
Members used during testing are not required in the production environment.


	
The space exists on the production instance and you do not want to overwrite the security information.




Note: When importing a brand new space, always select (check) this option as you cannot import a new space without a security policy.


	
Overwrite Resource Content Directories

	
(Only displays if the archive specified includes custom portal resources)

Select to import all content directories referenced by portal resources (skins, page templates, and so on).

Important: The Spaces application stores content used by portal resources, such as images and icons, under the 'shared' directory (oracle\webcenter\siteresources\scopedMD\shared\...). If selected, content directories in the archive are imported along with the resource itself; existing content directories are overwritten.

If you deselect this option, only new files are imported, that is, content directories and files and do not already exist on the target.








	
Click Import.

If you try to import spaces that exist in the target Spaces application, you must confirm whether you want to overwrite them. To delete existing spaces and replace them with imported versions, answer Yes. Answer No to cancel the import process.

If the import process detects a conflict between the spaces you are trying to import and those which exist on the target, a message displays to help you resolve the issue. For example, conflict messages display if a space on the target application has the same name but a different GUID to a space you are trying to import. In this instance you could change the name of the source space and create a new export archive, or rename the conflicting space in the target application and import the same archive.

An information message displays when all spaces import successfully.


	
Click Close to dismiss the Import Space window.




Imported spaces are offline initially because, mostly, some additional work is required before they are ready for general use. For example, you may want to migrate data associated with back-end components. For details, refer to the "Migrating Back-end Components for Individual Spaces" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal:

Once content and membership details are finalized you may bring the space online, see Section 51.4.4, "Bringing a Space Back Online."






53.5.3 Exporting Space Templates

Spaces administrators can export space templates and import them into other Spaces applications. Out-of-the-box templates cannot be exported.

Space templates can include pages, resources, discussions, lists, service information, and security information such as custom roles and current members; no other data, such as documents, are stored with the template.

While export and import utilities are primarily used to move information between Spaces applications, the space template export feature is also useful as a backup service, and for sharing and exchanging templates with others.

Space template information is exported into a single export archive (.ear file). The EAR file contains a metadata archive (.MAR file) and a single XML file containing space security policy information.

You can save export archives to your local file system or to a remote server file system.

Spaces administrators can export space templates through Spaces Administration as described here. Fusion Middleware administrators can also export space templates using WLST commands. For details, see "Exporting Space Templates Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.




	
Note:

You can also export space information but this is a separate process. For details, see Section 53.5.1, "Exporting Spaces". You cannot export spaces and space templates into a single archive.







To export one or more spaces templates from Spaces Administration:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces, then Space Templates.


	
Select the space template required by highlighting the row in the table.

Ctrl-click rows to select more than one.


	
Click Export on the toolbar.

The Export Space Template dialog box opens (Figure 53-15).


Figure 53-15 Exporting Space Templates
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Change the Archive Name or accept the default name.

To ensure uniqueness, the default .ear filename contains a timestamp: webcenter_<timestamp>.ear


	
Click Export.


	
If any of the space templates selected for export include custom portal resources, you must specify whether or not you want to include resource-specific content in the space template archive (Figure 53-11).


Figure 53-16 Exporting Custom Resource Content
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Do one of the following:

	
Click Yes to export content, such as images and icons, that is referenced by portal resources (skins, page templates, and so on).

The Spaces application stores content referenced by portal resource under the 'shared' directory (oracle\webcenter\siteresources\scopedMD\shared\...) rather than on a template-by-template basis. Consider the following before exporting content directories for the resources in your archive:

	
Entire content directories are exported rather than individual files. For example, if a skin references two files (...\shared\skins\logos\mylogo.gif and ...\shared\skins\icons\myicon.gif), the entire content of both directories (\logos and \icons ) are exported.


	
The size of \shared\... content directories. If your Spaces installation utilizes a large number of portal resources (both at the application-level as well as by individual spaces and space templates) then the number of files stored under the \shared directory or a \shared subdirectory is potentially large.


	
On import, all files under the content directories are uploaded to the target application and existing files with the same name are overwritten. While you can opt not to upload content directories on import, it's an all or nothing approach, that is, you cannot upload content specific to a particular resource or space template.





	
Click No to exclude content in the \shared directory that is referenced by portal resources.





	
Progress information is displayed during the export process (Figure 53-17).

When the export process is complete, specify a location for the export archive (.ear).


Figure 53-17 Exporting Space Templates In Progress
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Select one of:

	
Download - Saves the export EAR file to your local file system.

Your Browser downloads and save the archive locally. The actual download location depends on your Browser set up.


	
Save to Server - Saves the export .ear file to a server location. For example, /tmp. Ensure that there are write permissions on the server directory that you specify.

After clicking Save to Server, enter the Server Location and then click Save.





	
Click Close to dismiss the Export Space Templates window.




The export archive (.ear) is saved to the specified location.






53.5.4 Importing Space Templates

Spaces administrators can import a space template archive (.ear) into another Spaces application.

On import, all space templates included in the archive are re-created on the target application. If a space template exists on the target, then it is deleted and replaced. If a space template does not exist, then it is created.

Newly imported space templates are not immediately available for general use. You must publish the imported templates to make them available to everyone. See Section 10.4.3, "Showing and Hiding Resources."

If you want the Documents service to be enabled in spaces created from imported templates you must migrate the space template's folder (on Oracle Content Server) to the target instance as well. For details, see "Importing the Back-end Folder for a Space Template" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Spaces administrators can import space templates through Spaces Administration as described here. Fusion Middleware administrators can also import space templates using WLST commands. For details, see "Importing Space Templates Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.




	
Note:

If the archive contains content directories for custom portal resources, only new content is uploaded on import. There is no option to upload all content, that is, overwite existing content directories/files through Spaces Administration. An option to overwrite content directories is available using the importGroupSpace WLST. For details, see "Importing Space Templates Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







To import one or more space templates through Spaces Administration:

	
Open Spaces Administration.

For details, see Chapter 4, "Accessing Spaces Administration Pages."


	
Click Spaces, then Space Templates.


	
Click Import on the toolbar.

The Import Space Templates dialog box opens (Figure 53-18).


Figure 53-18 Importing Space Templates
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Specify the location of your space template archive (.ear). Select one of:

	
On Local System - Enter the location in the text box. Alternatively, click Browse to locate the directory on the local file system where the .ear file is stored.


	
On Server - Enter the path, including the archive filename, in the text box. For example, /tmp/MySpaceTemplateExport.ear. You can specify any shared location accessible from this Spaces application.





	
Click Browse Archive to review the content available for import.


	
Click Import.

If you try to import a space template that exists in the Spaces application, you must confirm whether you want to continue. To delete existing space templates and replace them with imported versions, answer Yes. Answer No to cancel the import process.

An information message displays when all templates import successfully.


	
Click Close to dismiss the Import Space Templates window.




Newly imported space templates are not immediately available for general use. You must publish the imported templates to make them available to everyone. See Section 10.4.3, "Showing and Hiding Resources."








53.6 Troubleshooting

This section includes troubleshooting information in the following sections:

	
Section 53.6.1, "Troubleshooting Spaces Workflows"


	
Section 53.6.2, "Troubleshooting WebCenter Service Issues"


	
Section 53.6.3, "Troubleshooting Issues with Space Import and Export"






53.6.1 Troubleshooting Spaces Workflows

If you experience issues with Spaces workflows, review the following sections:

	
Section 53.6.1.1, "Validating the SpacesWorkflow Configuration"


	
Section 53.6.1.2, "Troubleshooting Issues with Spaces Workflows"






53.6.1.1 Validating the SpacesWorkflow Configuration

The Oracle Fusion Middleware Installation Guide for Oracle WebCenter describes how to install and configure Spaces workflows. For details, see "Back-End Requirements for Spaces Workflows". You can validate the workflow configuration as follows:

	
Log in to Spaces.


	
Create a space and then navigate to the Members tab (Space Settings).


	
Invite a new member with any role (say User2).


	
Log out, and then log in as User2.


	
Navigate to a Worklist task flow.


	
Open the invite notification and click the Accept button.


	
Open the space.




If the Spaces workflows are working properly, the newly created space ia available to User2. If the space is not available or listed, there is some issue with the configuration.






53.6.1.2 Troubleshooting Issues with Spaces Workflows

If Spaces workflows are not working properly, follow these steps to help troubleshoot the issue:

	
Check that Spaces workflows are deployed on the Oracle SOA server:

	
Log in to Fusion Middleware Control.


	
Check that WebCenterWorklistDetailApp.ear is deployed.


	
Verify that sca_CommunityWorkflows.jar is deployed.




For details, see "Oracle SOA Server - Extending the Domain" in Oracle Fusion Middleware Installation Guide for Oracle WebCenter .


	
Ensure the Web Service connection between the Oracle SOA server and the Spaces application is secure:

	
Check the alias in the keystore file on the Oracle SOA server.

For example, use the following command to list the content of the keystore file on the Oracle SOA server:

keytool -list -v -keystore bpel.jks -storepass <password>

There should be an entry with:


Alias name: webcenter_spaces_ws



See "Setting Up the SOA Domain" in Oracle Fusion Middleware Installation Guide for Oracle WebCenter.


	
Verify that the credential stores for both Spaces and Oracle SOA server are configured correctly.

See "Updating the Credential Store" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Check that keystores exist at both ends of the connection, for example:

- webcenter.jks (copied to Spaces server end)

- bpel.jks (copied to Oracle SOA server end)

For example, the following commands generate webcenter.jks and bpel.jks:


keytool -genkeypair -keyalg RSA -dname "cn=webcenter,dc=us,dc=oracle,dc=com" -alias webcenter -keypass mypassword -keystore webcenter.jks -storepass mypassword -validity 360
keytool -exportcert -v -alias webcenter -keystore webcenter.jks -storepass mypassword -rfc -file webcenter.cer
keytool -importcert -alias webcenter_spaces_ws  -file webcenter.cer -keystore bpel.jks -storepass mypassword
keytool -genkeypair -keyalg RSA -dname "cn=bpel,dc=us,dc=oracle,dc=com" -alias bpel -keypass mypassword -keystore bpel.jks -storepass mypassword -validity 360
keytool -exportcert -v -alias bpel -keystore bpel.jks -storepass mypassword -rfc -file bpel.cer
keytool -importcert -alias bpel -file bpel.cer -keystore webcenter.jks -storepass mypassword


See "Creating the SOA Domain Keystore" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.


	
Configure role members for the BPMWorkflowAdmin application role in Oracle SOA server (soa-infra).

When associating the domain with an identity store that does not contain the user weblogic, you must assign some other valid user to the application role BPMWorkflowAdmin. Use WLST commands to do this from the SOA Oracle home, for example, to assign a user named "monty" that exists in LDAP:


cd $SOA_ORACLE_HOME/common/bin/
wlst.sh
 
connect('<admin username>','<admin password>', 'mysoahost.us.oracle.com:7001')
revokeAppRole(appStripe="soa-infra", appRoleName="BPMWorkflowAdmin", principalClass="oracle.security.jps.service.policystore.ApplicationRole", principalName="SOAAdmin")
grantAppRole(appStripe="soa-infra", appRoleName="BPMWorkflowAdmin", principalClass="weblogic.security.principal.WLSUserImpl", principalName="monty")



See "Security Commands" in the Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.














53.6.2 Troubleshooting WebCenter Service Issues

When you create a space, an error similar to the following may display if enabling a service exceeds the time allowed:


Space created with the following warning(s) : Issues were faced while
provisioning the service(s) - List Service. Check the space services
settings page if these services have been provisioned.


When a space is created, services are enabled in parallel in multiple threads. If provisioning a service exceeds the specified timeout, the thread is interrupted. The timeout may be exceeded due to time needed to copy the metadata when the latency between the midtier and the database is too high, network issues, database performance issues, and so on.

To check if the issue is due to exceeding the timeout, search the log file for a message similar to the following:


[2009-10-19T08:43:22.659+00:00] [WC_Spaces] [WARNING] []
[oracle.webcenter.webcenterapp] [tid: [ACTIVE].ExecuteThread: '0' for queue:
'weblogic.kernel.Default (self-tuning)'] [userId: weblogic] [ecid:
0000IHfxTHMDScX_TtCCyc1Ar22000002f,0] [APP: webcenter] Concurr: The thread is
timed out in 5000 milisec. for oracle.webcenter.list:Execution timedout[[
    queued :   13 ms
    suspended :    0 ms
    running : 5787 ms
    timeout : 5000 ms
    service : oracle.webcenter.community
    resource : oracle.webcenter.list
    source : oracle.webcenter.concurrent.RunnableTask@43c4d1
             (oracle.webcenter.concurrent.RunnableTask)
    submission : 3
]]


In this case, the running time of 5787 ms exceeded the timeout of 5000 ms.

If possible, the root cause of the timeout should be addressed; for example, resolve networking or database performance issues. Once this is done, the space can be created again and the error should not be encountered. If the performance cannot be improved and the error persists, the timeout value may be increased for the service encountering the error. Refer to the chapter "Oracle WebCenter Portal Performance Tuning" in the Oracle Fusion Middleware Performance and Tuning Guide for more information on setting concurrency management parameters in adf-config.xml.






53.6.3 Troubleshooting Issues with Space Import and Export

This section contains the following subsections:

	
Section 53.6.3.1, "Space Blocked After Unsuccessful Export or Import"


	
Section 53.6.3.2, "Page or Space Not Found Message After Import"


	
Section 53.6.3.3, "Space Import Archive Exceeds Maximum Upload File Size"


	
Section 53.6.3.4, "Maximum Number of Spaces Exceeded on Export"


	
Section 53.6.3.5, "Lists Not Imported Properly"






53.6.3.1 Space Blocked After Unsuccessful Export or Import

If an error occurs during a space export/import operation, some space(s) may appear blocked. To unblock a space, bring the space back online temporarily, and then take the space offline again to complete the export/import operation. Switching between the online and offline modes will unblock the space.






53.6.3.2 Page or Space Not Found Message After Import

When users first login to Spaces after an import operation they may see a "Page not found" or "Space not found" message if the page or space they last visited no longer exists. Last accessed page information is retained during import operations which is why these messages display sometimes.






53.6.3.3 Space Import Archive Exceeds Maximum Upload File Size


Problem

There is a file size limitation uploading content to Spaces. If your export archive exceeds the maximum upload size then the import operation through Spaces Administration will fail.


Solution

Ask your system administrator to import the space archive using WLST. For details, see "Importing Individual Spaces Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

Alternatively, modify the maximum upload size in webcenter-config.xml. The default maximum upload size is 2 MB. See also, "Changing the Maximum File Upload Size" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.






53.6.3.4 Maximum Number of Spaces Exceeded on Export


Problem

The maximum number of spaces that you can export must be less than or equal to 80% of the connection pool size specified for the MDS Data Source. If you try to export too many spaces you might see a ResourceLimitException error:


Weblogic.common.resourcepool.ResourceLimitException



Solution

Export fewer spaces. Alternatively, ask your system administrator to modify the connection pool setting. For details, see "Setting JDBC Data Source" in Oracle Fusion Middleware Performance and Tuning Guide.






53.6.3.5 Lists Not Imported Properly


Problem

Lists are not importing properly due to list definition differences in the source and target systems.


Solution

Consider exporting and importing list data. This ensures that list data is consistent with the list definitions being imported.

If you choose to import without data, the list data in the target system is migrated to be consistent with the imported list definitions. If a list column data type is changed, the column values are converted from the target data type to the imported data type, if possible, otherwise the value is deleted. If a list column is removed during import, the column values are deleted.






53.6.3.6 Importing from the Subspaces Page


Problem

When you import a space from the Space Administration-Spaces page, the imported space does not automatically become a subspace of the current space. The newly imported space displays in the Spaces switcher menu, Spaces Browser task flow, or the Spaces page, which display all the spaces that are available to you.


Solution

You can import a space as a subspace from Spaces Administration, by selecting the parent space before you import the archive.













54 Working with a Space Hierarchy

This chapter provides information about working with a space hierarchy consisting of a parent space and its subspaces in WebCenter Portal: Spaces. It contains the following sections:

	
Section 54.1, "What You Should Know About Space Hierarchies"


	
Section 54.2, "Understanding Inheritance in Space Hierarchies"


	
Section 54.3, "Creating a Subspace"


	
Section 54.4, "Viewing a Space Hierarchy"


	
Section 54.5, "Creating a Custom Space Hierarchy Navigation"


	
Section 54.6, "Moving Subspaces"


	
Section 54.7, "Managing a Subspace"





Audience

This chapter is intended for users who want to create and manage subspaces in a space hierarchy.

To perform the tasks described in this chapter, users need to be assigned a role that includes the Manage Configuration permission. For information about roles and permissions, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."

The Spaces administrator has the authority to expose or hide some features and services for all spaces. Contact your administrator if some tasks discussed in this chapter are not available to you.



54.1 What You Should Know About Space Hierarchies

A space hierarchy consists of a parent space and one or more subspaces. A subspace is simply a child space created in an existing space. A space hierarchy provides several benefits:

	
Organization: Spaces with related content can be grouped together under a parent space. For example, in a software development environment, subspaces can be dedicated to primary features under the parent product space. Or, each department can maintain a subspace under a company's parent space. Other hierarchical structures may be specific to your company, such as the unique requirements of a Spaces applications that are provided to your customers.


	
Navigation. The hierarchical organization provides for logical navigation and drilling down into required areas for more information. For example, users can navigate through a product hierarchy from product family to products to demos, or into different departments and functions in a company.


	
Delegated administration: A subspace can be managed by a user who does not necessarily have access to the parent space. In this way, an administrator can maintain control of a parent space, and assign individual owners to any number of subspaces, who in turn can delegate administration to others.


	
Inherited membership: A subspace can optionally inherit the membership defined for the parent space as a starting point. Subsequently, membership can be modified to suit the purposes of the subspace.


	
Security. Content may be generally accessible, where a limited number of users have administrative permissions, or security may be identical to the parent space, or completely overridden by the administrator of the subspace.




For information about creating a subspace, see Section 54.3, "Creating a Subspace."






54.2 Understanding Inheritance in Space Hierarchies

A newly created subspace inherits all services enabled for the parent space, along with the security (members, roles, and permissions) defined in the parent space.




	
Note:

Folders and files in the parent space are not automatically available to the subspace.









54.2.1 Inheriting Security

When you create a subspace, the initial security (members, roles, and permissions) is inherited from the parent space.

To change the security settings of members, roles, and permissions in a subspace, see Section 54.7.1, "Modifying Security Settings for a Subspace."

Any roles that are defined in the template that is used to create the subspace are ignored.






54.2.2 Inheriting Services

If security inheritance is enabled (see Section 54.7.1, "Modifying Security Settings for a Subspace."), the subspace initially inherits all services enabled for the space template on which it is based. You can further limit services available to the subspace, but cannot provision new services in the subspace that are not enabled in the parent space.If the space template used to create the subspace has additional services enabled that are not enabled in the parent space, those additional services will not be available in the subspace. Conversely, if the template has fewer services enabled than the parent space, the subspace will inherit only the subset of services that are enabled in the template.

For example:

	
If a template used to create a subspace has the Discussions, Lists, and Documents services enabled, and the parent space has only Discussion and Lists enabled, then the subspace will have only Discussion and Lists enabled, not Documents.


	
If a template used to create a subspace has the Discussions and Lists services enabled, and the parent space has Discussions, Lists, and Documents enabled, then the subspace will have only Discussions and Lists enabled, not Documents.




If security inheritance is not enabled, then the subspace inherits all services that are enabled in the space template.








54.3 Creating a Subspace

You can create one or more subspaces (child spaces) in any space. From a parent space, you can navigate to its subspaces.




	
Note:

If you create a new resource (page template, skin, Resource Catalog, or navigation) for a parent space, the new custom resource is not shown for selection in the administration settings for subspaces of the space. To set a resource for a subspace to the same custom resource used by its parent space, you must use an EL expression (see Section 51.4, "Managing General Administration Settings for a Space"). To make a custom resource available for selection in all spaces and subspaces, it must be created at the application-level (see Section 16.2, "Creating Resource Catalogs").







To create a subspace of the current space:

	
Do either of the following, depending on the permissions you have been granted:

	
On the Home page of the space, click the link to create a subspace




	
Tip:

The location of the Create Subspace link depends on the page template in use by the space. For example, in a side navigation template, you may access it through a Subspaces menu, or an Actions menu.








	
In the space administration settings, display the Subspaces page, then click the Create icon.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."












If you do not see these options, ask your Spaces administrator to grant you Create Spaces permission.

The Create a Subspace dialog opens.


	
In the Setup step (Figure 54-1), specify a subspace name and, optionally, a description and keywords for the subspace. Enter any keywords related to the content of the subspace to make it more easily discoverable in search results. Separate keywords with a space or comma.


Figure 54-1 Create a Subspace Dialog: Setup Step

[image: Create a Space Dialog: Setup Step]



The name that you enter here displays at the top of the subspace and other places where spaces are available for selection, such as the Spaces Switcher menu and the Spaces page. Subspace names can contain alphanumeric characters, underscores, spaces, multi-byte characters, and special characters such as & and #. The maximum allowable length is 200 characters. The following reserved keywords are not allowed as the full subspace name either in upper or lowercase, or a combination of both—webcenter, pages, page, spaces, space, group, groups, space, spaces, webcenter space, webcenter spaces, webcenter administration, my spaces, admin, last. These reserved words are allowable as part of a longer name (for example, Sales Group).


	
Click Next.


	
In the Access step (Figure 54-2), modify the last value of the URL for the subspace if desired. This value can be same as the space name. This value value can be same as the subspace name.


Figure 54-2 Create a Subspace Dialog: Access Step

[image: Create a Space Dialog: Access Step]






	
Note:

The initial security (members, roles, and permissions) is inherited from the parent space. To change the security settings of members, roles, and permissions in a subspace, see Section 54.7.1, "Modifying Security Settings for a Subspace."








	
Click Next.


	
In the Content step, select a template to use as the basis for your new subspace. Use the Filter field to search for templates by name.




	
See Also:

For more information, see Section 50.1, "What You Should Know About Space Templates".










	
Note:

A custom space template may include seeded data, such as folders and files, discussion forums, wikis, lists, announcements, or links. When you select such a template, the new subspace includes all the seeded data.
Any roles that are defined in the template that is used to create the subspace are ignored.










	
Click Create.

The new subspace opens, displaying its Home page. As the subspace creator, you are automatically granted the Moderator role for this subspace, and can begin to populate, customize, and manage the subspace as required.







	
Note:

Folders and files in the parent space are not automatically available to the subspace.












54.4 Viewing a Space Hierarchy

The extent to which you can see subspaces and parent spaces depends on your role and permissions, as described in the following sections:

	
Section 54.4.1, "Viewing Subspaces of a Parent Space"


	
Section 54.4.2, "Viewing Parent Spaces of a Subspace"






54.4.1 Viewing Subspaces of a Parent Space

To view the subspaces of a space, do any of the following, depending on the permissions you have been granted:

	
On the Home page of the parent space, click Subspaces to expose a list of the subspaces for the space.




	
Tip:

The location of the Subspaces link depends on the page template in use by the space. For example, it may be available through a Subspaces menu in a side navigation, or through a Subspaces link at the top of the application in top tabbed navigation.








	
In the space administration settings, display the Subspaces page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
(Spaces administrator only) Open Spaces Administration (see Chapter 4, "Accessing Spaces Administration Pages"), and on the Spaces page, click a link under the Subspaces column that shows the number of subspaces belonging directly to a parent space. The Spaces page refreshes with a list of subspaces for the parent space, which may in turn show another level of subspaces.

For more information about application-level space administration, see Chapter 53, "Administering Spaces and Templates."









54.4.2 Viewing Parent Spaces of a Subspace

Navigating from a subspace to a parent space can be accomplished by adding a link to the page template for the subspace. This is a design decision made by the page template developer, and may be exposed depending on whether or not the security of the parent space allows direct access from the subspace.








54.5 Creating a Custom Space Hierarchy Navigation

Spaces application designers can build custom navigation models, which can be added to the pages for a space to allow end users to easily navigate the space hierarchy. For more information, see Section 11.2.2.1.5, "Adding a List of Subspaces to a Navigation Model."






54.6 Moving Subspaces

With appropriate permissions, you can move subspaces from their current parent space. All of the metadata (such as pages, navigation, security, and so on) and data is maintained when a subspace is moved.

To move one or more subspaces from their current parent space:

	
In the space administration settings, display the Subspaces page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the Subspaces page, click in the row of the subspace that you want to move. Ctrl-click to select multiple subspaces.


	
From the Edit menu, choose Change Parent for Space(s).


	
In the Select New Parent dialog, choose the new parent space, or select the No Parent Space checkbox to move the subspace to the root space of the space hierarchy.




	
Note:

All spaces and subspaces in the Spaces application are listed, which means you can move the selected subspace lower in the space hierarchy, under another subspace.








	
Click OK.


	
In the confirmation prompt, click OK.









54.7 Managing a Subspace

Within a subspace, management tasks are the same as within any top-level space, as described in the following chapters:

	
Chapter 49, "Understanding Space Basics"


	
Chapter 51, "Managing a Space"


	
Chapter 52, "Managing Space Members and Roles"


	
Chapter 53, "Administering Spaces and Templates"




Additionally, subspaces include the following administrative tasks that are not applicable to parent spaces:

	
Section 54.7.1, "Modifying Security Settings for a Subspace"


	
Section 54.7.2, "Importing Subspaces"






54.7.1 Modifying Security Settings for a Subspace

On creation, a subspace inherits its initial security (members, roles, and permissions) from the parent space. If you set custom security for the subspace, you cannot revert back to inheriting security from the parent space.

To modify the members, roles, and permissions of a subspace:

	
In the subspace administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, clear the Security Setting checkbox to specify that the subspace should not inherit security settings from the parent space (Figure 54-3).


Figure 54-3 Inheriting Security from a Parent Space

[image: Inheriting Security from a Parent Space]



Once this checkbox has been cleared, it becomes inactive and you cannot revert back to inheriting security from the parent space.


	
Click Apply to save.

Note that the administration settings now expose the Roles and Members pages, and the Access section displays on the General page.









54.7.2 Importing Subspaces

This is no longer true. When a Space is imported in the subspaces tab, it does get imported as a subspace and it appears on the same page. You can change this note to say that when you select a space and import it, it will go in as a subspace of the selected space no matter where you are. If you don't select any space and just import it, it will go in as a space at the level that you are in. For example: if you are in the main Administation -> Spaces page, the space will go in as a root space. if you go to one of the subspaces pages, it will go in as a subspace and start appearing on the same subspaces page.

You can import subspaces into your Spaces application, as described in Section 53.5.2, "Importing Spaces." Begin the import process in either of the following ways:

	
Select the parent space anywhere in the Spaces application, then import a space.


	
Navigate to the Subspaces page of a parent space, then import a space.




In both cases, the imported space becomes a subspace of the selected parent space.











Part XII


Analyzing and Monitoring Your Portal


Part XII of the User's Guide provides information about analyzing your portal's usage and performance metrics.

Part XII includes Chapter 55, "Analyzing Usage and Performance Metrics."







55 Analyzing Usage and Performance Metrics

The Analytics service offers real-time usage and activity reporting for your portal. This chapter describes how to use the pages and task flows provided through the Analytics service. It includes the following sections:

	
Section 55.1, "What You Should Know About the Analytics Service"


	
Section 55.2, "Working with Analytics Task Flows"


	
Section 55.3, "Setting Analytics Task Flow Properties"




For Analytics task flows to work, the Analytics schema(ACTIVITIES) must be installed and configured, and a connection set up between your application and the Analytics Collector. For more details on the Analytics schema and information on managing the Analytics service backend, see “Managing the Analytics Service” in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. This chapter describes how to add Analytics task flows to application pages at runtime; to learn how to add Analytics task flows at design time, using Oracle JDeveloper, see Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.


Audience

This chapter is intended for Spaces administrators with the Application-Manage Configuration permission and individual space moderators who want to analyze activity within their spaces.



55.1 What You Should Know About the Analytics Service

The Analytics service allows Spaces administrators and moderators to track and analyze Spaces traffic and usage. The Analytics service provides the following basic functionality:

	
Usage Tracking Metrics: The Analytics service collects and reports metrics of common Spaces functions, including community and portlet traffic.


	
Behavior Tracking: The Analytics service can be used to analyze Spaces metrics to determine usage patterns, such as page visit duration and usage over time.


	
User Profile Correlation: The Analytics service can be used to correlate metric information with user profile information. Usage tracking reports can be viewed and filtered by user profile data such as country, company or title.




	
Note:

Profile information is cached meaning that changes to a user profile are not visible in reports until the cache is updated. The default cache time is 60 minutes, but this value can be changed by your administrator.










This section contains the following topics:

	
Understanding the Analytics Administration Page in Spaces


	
Understanding Analytics Task Flows in Spaces


	
Access to Analytics Task Flows in Spaces






55.1.1 Understanding the Analytics Administration Page in Spaces

An analytics console that displays metrics for the entire Spaces application is available to Spaces administrators with the Manage Configuration permission. The console consists of four pages, grouping several different reports:

	
Summary Metrics - portal traffic, page views, and login metrics


	
Space Metrics - Space usage and response times


	
Portlet Metrics - portlet views and response times


	
Service Metrics - Usage of searches, documents, wikis, blogs and discussions





Figure 55-1 Analytics Console for Administrators

[image: Analytics Console for Administrators]



Out-of-the-box, this console is available through a business role page named Analytics. It is the Spaces administrator's responsibility to grant people permissions to see the Analytics page. This page is intended for anyone who needs to analyze access and usage statistics; this could include administrators, sales or marketing managers or directors, business analysts, and so on.

Just like other business role pages, the Analytics page is pushed to all the users to whom it is assigned, appearing in the Home Space. Once the Analytics page is available in the Home Space, users can show and hide the page through the Manage Page dialog.

See also, Section 7.1.4, "Specifying the Target Audience for a Business Role Page".






55.1.2 Understanding Analytics Task Flows in Spaces

This section lists and describes all the Analytics task flows that are provided with Spaces. The following task flows are available out-of-the-box:


Application Analytics:

	
WebCenter Traffic


	
Page Traffic


	
Login Metrics





Space Analytics:

	
Space Traffic


	
Space Response Time





Portlet Analytics:

	
Portlet Traffic


	
Portlet Instance Traffic


	
Portlet Response Time


	
Portlet Instance Response Time





Service Analytics:

	
Search Metrics


	
Discussion Forum Metrics


	
Document Metrics


	
Wiki Metrics


	
Blog Metrics







	
Note:

The images shown in the following sections represent one view of each report. However each report can be customized to display the data in different ways (for example, a bar chart, a pie chart, a line chart, or a table). For information on customizing reports, see Section 55.2.2, "Customizing Analytics Reports" and Section 55.2.3, "Personalizing Your Analytics Report View."









55.1.2.1 WebCenter Traffic

The WebCenter Traffic task flow (Figure 55-2) displays a summarized view for common events within the portal.

Use this task flow to track application-wide events—space views, page views, portlet views, logins, number of searches, wiki views, blog views, discussion forum views, and document views.


Figure 55-2 Analytics Task Flow - WebCenter Traffic
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55.1.2.2 Page Traffic

The Page Traffic task flow (Figure 55-3) displays the number of page hits and the number of unique users that have visited any portal page.

Use this task flow to quickly see the most visited pages (top pages) and/or the least visited pages (bottom pages). You can view page data by hits (total number of page views) and/or users (unique number of users who viewed pages). You can filter the report to show data only for specific pages (in the Display options list, select Specify, then click Select, select pages, then click OK) or pages from specific spaces (in the Spaces query options).


Figure 55-3 Analytics Task Flow - Page Traffic
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Note:

Pages belonging to the Home Space are excluded by default but there is an option to include this information if you want to do so.












55.1.2.3 Login Metrics

The Login task flow (Figure 55-4) reports the number of times users log in to Spaces.

Use this task flow to see the total number of portal logins and/or the number of times unique users logged into the portal.


Figure 55-4 Analytics Task Flow - Login Metrics
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55.1.2.4 Space Traffic

The Space Traffic task flow (Figure 55-5) displays usage information—the number of page hits, number of unique users, and the number of unique visits (multiple consecutive page views within the same space during the same Spaces session is treated as one visit)—for individual Spaces.

Use this task flow to quickly see the most popular spaces (top), and the least popular spaces (bottom). You can filter the data to only show specific spaces or show all spaces.


Figure 55-5 Analytics Task Flow - Space Traffic
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Note:

The Home Space is not included in the data.












55.1.2.5 Space Response Time

The Space Response Time task flow (Figure 55-6) displays page performance information—average, minimum, or maximum response time—for individual spaces over any time period you specify.

Use this task flow to quickly see the slowest spaces (bottom), and the fastest spaces (top). You can filter the data to only show specific spaces or show all spaces.


Figure 55-6 Analytics Task Flow - Space Response Time
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Note:

The Home Space is not included in the data.












55.1.2.6 Portlet Traffic

The Portlet Traffic task flow (Figure 55-7) displays portlet usage information—the number of portlet hits (the number of times a portlet is displayed) and number of unique users that access a portlet.

Use this task flow to quickly see the most popular portlets (top), and the least popular portlets (bottom). You can filter the data to only show specific portlets or show all portlets. Similarly, you can filter the portlet data by Space.


Figure 55-7 Analytics Task Flow - Portlet Traffic
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Note:

The Home Space is not included in the data.












55.1.2.7 Portlet Instance Traffic

The Portlet Instance Traffic task flow (Figure 55-8) displays usage information—the number of portlet hits (the number of times a portlet is displayed) and number of unique users that access a portlet—for individual portlet instances. If the same portlet displays on several different pages, each placement is considered as a portlet instance.

Use this task flow to quickly see the most popular portlet instances (top), and the least popular portlet instances (bottom). You can filter the data to only show specific portlet instances or show all portlet instances. Similarly, you can filter the portlet data by space.


Figure 55-8 Analytics Task Flow - Portlet Instance Traffic
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Note:

The Home Space is not included in the data.












55.1.2.8 Portlet Response Time

The Portlet Response Time task flow (Figure 55-9) displays performance information—average, minimum, and maximum response time—for individual portlets.

Use this task flow to quickly see the slowest portlets (bottom), the fastest portlets (top), and compare performance data. Portlet response times are important because there is often a direct link between page performance and the slowest portlets. When troubleshooting poor performance within a space, it is important to identify the worst performing portlets. You can filter the data to only show specific portlets or show all portlets. Similarly, you can filter the portlet data by space.


Figure 55-9 Analytics Task Flow - Portlet Response Time
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55.1.2.9 Portlet Instance Response Time

The Portlet Instance Response Time task flow (Figure 55-10) displays performance information—average, minimum, and maximum response time—for individual portlet instances. If the same portlet displays on several different pages, each placement is considered as a portlet instance.

Use this task flow to quickly see the slowest portlet instances (bottom), the fastest portlet instances (top), and compare performance data. You can filter the data to only show specific portlet instances or show all portlet instances. Similarly, you can filter the portlet data by space.


Figure 55-10 Analytics Task Flow - Portlet Instance Response Time
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55.1.2.10 Search Metrics

The Search Metrics task flow (Figure 55-11) tracks searches performed within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) search phrases.


Figure 55-11 Analytics Task Flow - Search Metrics
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55.1.2.11 Document Metrics

The Document Metrics task flow (Figure 55-12) tracks how often a document is accessed.

Use this task flow to quickly see the most popular (top) and least popular (bottom) documents. You can filter the data to only show specific spaces or show all spaces.




	
Note:

Documents in the Home Space are included in this report.










	
Note:

If you have two different documents with the same name, they are treated as two separate documents. The metrics include the parent folder for context.








Figure 55-12 Analytics Task Flow - Document Metrics
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55.1.2.12 Wiki Metrics

The Wiki Metrics task flow (Figure 55-15) tracks how often wikis are accessed within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) wikis. You can filter the data to only show specific spaces or show all spaces.


Figure 55-13 Analytics Task Flow - Wiki Metrics
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55.1.2.13 Blog Metrics

The Blog Metrics task flow (Figure 55-14) tracks how often blogs are accessed within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) blogs. You can filter the data to only show specific spaces or show all spaces.


Figure 55-14 Analytics Task Flow - Blogs Metrics
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55.1.2.14 Discussion Forum Metrics

The Discussion Forum Metrics task flow (Figure 55-15) tracks discussion forums within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) discussions. You can filter the data to only show specific spaces or show all spaces.


Figure 55-15 Analytics Task Flow - Discussion Metrics
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55.1.3 Access to Analytics Task Flows in Spaces

In Spaces, Resource Catalogs only display analytics task flows to users with appropriate permissions:

	
Administrators - Users with the Administrator role have access to all the Analytics task flows


	
Moderators - Within a space, members with the Moderator role can only access task flows specific to that space




After a task flow is added to a page, anyone with access to the page can see the task flow.








55.2 Working with Analytics Task Flows

This section contains the following topics:

	
Adding Analytics Task Flows to a Page


	
Customizing Analytics Reports


	
Personalizing Your Analytics Report View






55.2.1 Adding Analytics Task Flows to a Page

The process of adding an Analytics task flow to a page is the same as for any other task flow (for more information, see Section 17.5, "Adding Resource Catalog Components to Pages"). The process varies only in where you can find these task flows in the Resource Catalog. All the Analytics task flows are under the Analytics folder.


Figure 55-16 Analytics Folder in Resource Catalog
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Note:

When you add an Analytics task flow to a space, it displays information for that space, not for all spaces.












55.2.2 Customizing Analytics Reports

If you want to set defaults for Analytics reports, you can do so by editing the report settings in page Edit mode. Any changes you make while in Edit mode will become the default report settings for all users in page View mode. For example, you can edit the Analytics page, changing the following settings on the Summary Metrics page in the Traffic report: set the report type to pie chart, set the time frame to this week, and remove Discussion Forums from the display. When users visit the Analytics page, those settings will be applied by default. Users can then edit the report as necessary for their needs. This can be useful if there are particular settings you know are commonly used by your users, or to customize a particular instance of an Analytics task flow on a group-specific page.

You can also configure the report settings to determine the controls available to users in View mode. In page Edit mode, click the Configure report preferences icon to display the Report Settings popup. In this popup, you can specify whether to show or hide the following report settings:

	
Chart

	
Chart Style list allows you to select a color scheme for reports


	
Chart Type Options allows you to show or hide the chart types (bar, pie, line, table) at the top of the report





	
Data Selection

	
Report Summary allows you to show or hide the Report Summary section to the left of the report


	
Metrics Selector allows you to show or hide the list of metrics (Hits, Unique Users, and such)


	
Display Options (not available with Logins) allows you to show or hide the list of display options (Spaces, Pages, Portlets, and such)


	
Selection Button (not available with Traffic, Logins, Space Traffic, Space Response Time, Search Metrics, Document Metrics, Wiki Metrics, Blog Metrics, Discussion Forum Metrics) allows you to show or hide the Specify option in the Display list and the Select button at the top of the report


	
Additional Options (not available with Traffic, Logins, Space Traffic, Space Response Time, Portlet Traffic, Portlet Instances Traffic, Portlet Response Time, Portlet Instances Response Time, Search Metrics, Document Metrics, Wiki Metrics, Blog Metrics, Discussion Forum Metrics) allows you to show or hide the Additional Options section to the left of the report





	
Filtering

	
Time Frame Filters allows you to show or hide the Time Frame section to the left of the report


	
User Property Filters allows you to show or hide the User Property section to the left of the report


	
Space Filter (not available with Traffic, Logins, Search Metrics) allows you to show or hide the Spaces section to the left of the report





	
Grouping

	
Group By Options allows you to show or hide the Grouping Options section to the left of the report












55.2.3 Personalizing Your Analytics Report View

Analytics task flows include display options at the top of the report and query options to the left of the report. These options enable you to personalize the report for your needs by changing the metrics included in the report and the way the report is presented. Most options are the same for all Analytics task flows.



55.2.3.1 Report Display Options

The report display options at the top of the report enable you to select the type of report, select the type of metrics to include, and, for some task flows, control the top/bottom range to display.


Report Types

You can display your report as a bar chart, pie chart, line chart, or table depending on the display and query options you select. To choose your report type, click the associated icon.

Table 55-1 lists the report types available for different display and query options. It includes the following columns:

	
Selected Metrics specifies what has been selected in the list of metrics, a single metric or multiple metrics.




	
Note:

Search Metrics and Document Metrics task flows show only those single metrics; there is no list to select metrics.








	
Group By Options specifies what has been selected in the Grouping Options section to the left of the report, No Selection or one of the available selections.


	
Bar, Pie, Line, and Table specify whether you can view that type of report with the specified selections.





Table 55-1 Display Options for the Analytics Task Flows

	Selected Metrics	Group By Option	Bar	Pie	Line	Table
	
Single metric

Login Traffic task flow

	
No selection

	
N

	
N

	
N

	
Y


	
Single metric

All other task flows

	
No selection

	
Y

	
Y

	
N

	
Y


	
Single metric

	
Time interval, user property, or Both*

	
Y

	
N

	
Y

	
Y


	
Multiple metrics

WebCenter Traffic and

Login Traffic task flows

	
No selection

	
Y

	
Y

	
N

	
Y


	
Multiple metrics

All other task flows

	
No selection

	
Y

	
N

	
Y

	
Y


	
Multiple metrics

WebCenter Traffic and Login Traffic task flows

	
Time interval or user property

	
Y

	
N

	
Y

	
Y


	
Multiple metrics

All other task flows

	
Time interval or user property

	
N

	
N

	
N

	
Y


	
Multiple metrics

Login Traffic task flow

	
Both*

	
N

	
N

	
N

	
Y








* The grouping option Both is available only for the Login Traffic task flow.


Metrics

You can select which type of metrics to include in your report. Your metrics options differ depending on the task flow you are using:

	
WebCenter Traffic: Spaces, Pages, Portlets, Logins, Searches, Wikis, Blogs, Discussion Forums, Documents


	
Page Traffic: Hits, Unique Users


	
Login Metrics: Logins, Unique Users


	
Space Traffic: Hits, Unique Users, Visits


	
Space Response Time: Average Response Time, Minimum Response Time, Maximum Response Time


	
Portlet Traffic: Hits, Unique Users


	
Portlet Instance Traffic: Hits, Unique Users


	
Portlet Response Time: Average Response Time, Minimum Response Time, Maximum Response Time


	
Portlet Instance Response Time: Average Response Time, Minimum Response Time, Maximum Response Time


	
Search Metrics: This task flow shows only search metrics, so it does not include an option to select metrics.


	
Document Metrics: This task flow shows only document metrics, so it does not include an option to select metrics.


	
Wiki Metrics: Views, Unique Users


	
Blog Metrics: Views, Unique Users


	
Discussion Forum Metrics: Views, Unique Users




To select which metrics to include in your report, select the metrics from the list above the report.


Figure 55-17 Analytics Task Flow - Metrics Selection
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Top, Bottom, or Custom Ranges

With some task flows you can specify whether you want to see the top, bottom, all, or a custom ranges of metrics in your report. Use these options to see the most and least popular items in your portal.

To display the top or bottom ranges of metrics in your report, in the lists above the report, select Top or Bottom, and then select a number to define the range.

To display a custom range, in the list above the report, select Specify, then click Select.

The top and bottom options are available for Pages, Portlet Traffic, Portlet Instances Traffic, Response Time, Portlet Response Time, Portlet Instances Response Time.

The custom range option is available for Pages, Traffic, Response Time, Portlet Traffic, Portlet Instances Traffic, Response Time, Portlet Response Time, Portlet Instances Response Time, Search Metrics, Document Metrics, Wiki Metrics, Blog Metrics, Discussion Forum Metrics.






55.2.3.2 Query Options

Analytics task flows include the following query options to the left of the report:

	
Report Summary

Displays a summary of the selected display and query options shown in the report.


	
Time Frame

Enables you to specify the date range for the metrics displayed in the report. You can select from the following options: Yesterday, Today, This Week, Last Week, This Month, Last Month, Last Three Months, Last Six Months, This Year, Last Year, or you can specify your own date range.


	
User Property

Enables you to filter your report by user property. After selecting a property from the list, you can specify a value that the property must contain or must not contain, and only metrics that apply to the filtered property display in the report.

	
Property: Select a property on which to filter the report. You can select City, Company, Country, Department, Display Name, Employee ID, IM User, Manager, Phone, State or Province, Street, Title, or ZIP code


	
Operator: Select how you want to filter the property. You can select Contains or Does Not Contain.


	
Value: Type a value on which to filter the property.







	
Note:

To search using a wildcard (for example, % or ?), you must prefix the wildcard with a forward slash (\). For example, to search for give or giving, type giv\% in the Value box.








	
Additional Options

Enables you to include Home Space pages in report data. These options are available with the Pages task flow (in the Page Traffic report).


	
Spaces

When Analytics task flows display in the Home Space or on a business role page, you can choose which spaces to include in your report. When Analytics task flows are used within a particular space, only metrics only for that space display; the Spaces option is unavailable (grayed out).

To specify the spaces to include in your report, click the Space Filter icon to display the Specify Spaces popup. Select the spaces you want to include in your report, using CTRL+click and SHIFT+click to select multiple spaces.

This option is not available with the Traffic, Logins, or Search Metrics task flows.


	
Grouping Options

Enables you to select an option by which to group the metrics in your report. You can group by a time interval (Hour, Day, Week, Month, or Year), a user property, or, with the Logins task flow, both.




	
Note:

This setting affects the available display options for the report (see Table 55-10).



















55.3 Setting Analytics Task Flow Properties

The Analytics service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 55-18).


Figure 55-18 Analytics Task Flow - Component Properties
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 55.3.1, "What You Should Know About the Analytics Service Task Flow Properties"


	
Section 55.3.2, "Analytics Service Task Flow Parameters"






55.3.1 What You Should Know About the Analytics Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 55.3.2, "Analytics Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor.




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1. For more information about ELs in WebCenter Spaces, seeAppendix B, "Expression Language Expressions."
EL validation is not performed on non-generic display options.














55.3.2 Analytics Service Task Flow Parameters

Table 55-2 describes the parameters that are unique to the Analytics service task flows.


Table 55-2 Analytics Task Flow Parameters

	Parameter	Description
	
Analytics Report Title

	
Specifies the display title that appears above the analytics data.

Note:

	
Use the Analytics Report Title rather than the Text property on the Display Options page. Changing the Text value has no effect on Analytics task flows.


	
You cannot change the report titles in the Analytics console.





	
Analytics Resource Id

	
Specifies the MDS document used to store user customizations/application customizations for the task flow instance in MDS.

Warning: Do not edit this value.


	
Application Name*

	
Specifies the WebCenter Portal application for which you want to display analytics data. For Spaces, this is always webcenter.

The analytics database can be used to store event data from multiple applications so this parameter is required to identify which application data to display.

If omitted, the task flow displays analytics data for all supported WebCenter Portal applications.


	
Max Data Points Per Series

	
Indicates the maximum number of data points to be displayed in a bar or line chart. The default value is 25. Valid values are between 1 and 1000.

Note: Increasing the number of data points might increase the time it takes to render the report.

















Part XIII


Searching WebCenter and Other Sources

Part XIII of the User's Guide provides information about searching both WebCenter Portal: Spaces and sources outside of WebCenter Portal: Spaces. It includes information about creating your own search terms using the Tags service.

Part XIII includes the following chapters:

	
Chapter 56, "Working with the Search Service"


	
Chapter 57, "Working with the Tags Service"










56 Working with the Search Service

This chapter describes how to use the features provided through WebCenter Portal's Search.

This chapter includes the following sections:

	
Section 56.1, "What You Should Know About Searching in WebCenter Portal"


	
Section 56.2, "Searching in Your Application"


	
Section 56.3, "Working with the Search Service Task Flows"


	
Section 56.4, "Narrowing the Scope of Search"


	
Section 56.5, "Setting Individual Preferences for Search Results"


	
Section 56.6, "Customizing Search Results with Attributes and Refiners"


	
Section 56.7, "Setting Search Service Task Flow Properties"





Audience

This chapter is intended for users who want to use and manage search, as well as administrators in Spaces with the Application-Manage Configuration permission and individual space moderators who want to configure search within their spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



56.1 What You Should Know About Searching in WebCenter Portal

The Search service enables information discovery through an intuitive user interface. With all relevant information easily navigable, you do not have to switch between applications performing multiple searches. You can run, refine, and save custom searches.

By default, the search looks for your search terms in every searchable service enabled in the application.

	
Administrators can narrow the scope of searches to specific spaces, services, and document types. They also can add attributes to the list of standard attributes returned with each search result item, and they can hide standard refiners available to users with search results. For more information, see Section 56.4, "Narrowing the Scope of Search" and Section 56.6, "Customizing Search Results with Attributes and Refiners."


	
Individual users can configure the services to which a search has access with personal preferences. They also can configure the order of search results. For more information, see Section 56.5.1, "Selecting the Services to Search."




In all cases, searches return only the results you are authorized to view. For example, if you are not a member of the Finance space, then any search results from that space do not display.

Information is searched by name and content. When a search is run for a term that has been added as a tag to a document, the document is returned in the results, and the related tags appear in the Tag refiner section. For more information about tagging, see Chapter 57, "Working with the Tags Service."

In addition to WebCenter Portal's Search, the Documents service provides its own search engine for file searches. This saves time and increases the relevancy of results by narrowing the scope of a search to files. The Documents service searches within a specific space's document library. For more information, see Section 41.31, "Searching for Documents."

Another type of search is used for finding users in the identity store (for example, by clicking the Find User icon in a Mail compose window (Figure 56-1). For more information, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


Figure 56-1 Find User Icon in a Mail Compose Window

[image: Find user icons in a Compose window]

Description of "Figure 56-1 Find User Icon in a Mail Compose Window"







56.1.1 Using the Oracle Secure Enterprise Search Adapter

WebCenter Portal provides two ways of searching your application:

	
Oracle Secure Enterprise Search (SES) adapter


	
Oracle WebCenter Portal live search adapters




With WebCenter Portal: Spaces applications, the internal live search adapters are set as the default search platform; however, large-scale implementations should be configured to use Oracle SES for best performance. Oracle SES provides unified ranking results for the following resources:

	
Documents, including wikis and blogs


	
Announcements and Discussions


	
Spaces, lists, page content, and people resources in Spaces







	
Note:

WebCenter Portal: Spaces includes the additional Oracle SES crawler that indexes spaces, lists, pages, and people resources in Spaces. This crawler is not supported in WebCenter Portal: Framework applications.







For example, when you run a search for a user name, most likely, you are looking for that persons's contact information (that is, the exact user name in the People Connections service), not necessarily documents that the user wrote. The unified ranking in Oracle SES enables you to see the most relevant results, across all different types of searches, without configuring Search Preferences.

Additionally, with Oracle SES as the search engine, you can use the wildcard character [*] in the middle or end of a term for wildcard matching. For example, when you search for keywords like wiki or page, Oracle SES does not return the wiki page MyWikiPage in search results. However, My* or My*Page does return MyWikiPage.




	
See Also:

"Configuring Search with WebCenter Portal's Search Adapters" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal












56.1.2 Limitations with Search

Note the following limitations with searching in WebCenter Portal:

	
Several special characters are filtered out in WebCenter Portal search. For example, when you search for the keyword Q2?Total, WebCenter Portal does not return the wiki page named Q2?Total in search results.

With Oracle SES, the following special characters are not recognized:

! % ^ & ( ) + = [ ] { } | ; ' \ , < > / ? ` ~

With WebCenter Portal live search, the following special characters are not recognized:

! @ # $ % ^ & ( ) + = [ ] { } | ; ' \ " , < > / ? ` ~ - *

Because quotation marks are filtered out in WebCenter Portal live search, if you require exact term searches (such as "United Arab Emirates" as opposed to United + Arab + Emirates), then you must use Oracle SES.


	
In WebCenter Portal: Spaces, not all fields in the User Profile are searched. For example, searching for profile information in the Expertise or Personal Status fields do return results, but searching for profile information in the Employee Type or Department fields do not return any results.


	
WebCenter Portal's live search adapters do not support wildcard searching.











56.2 Searching in Your Application

WebCenter Portal provides global (that is, application-wide) search. By default, the search field is at the top-right of the application.

This section contains the following subsections:

	
Section 56.2.1, "Running a Global Search"


	
Section 56.2.2, "Refining the Display of Search Results"


	
Section 56.2.3, "Saving Searches"






56.2.1 Running a Global Search

To perform a global search:

	
Locate the global search field and enter a search term.

For example, Figure 56-2 shows the search field at the top right of the application.


Figure 56-2 Global Search Field in Spaces
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Press Enter or click the Search icon next to the global search field (Figure 56-3).


Figure 56-3 Search Icon
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Results display in the search Results page (Figure 56-4).


Figure 56-4 Global Search Results

[image: search results]



	
Click a link to open a result.




Administrators can configure the scope of searches to specific spaces, services, and document types. They also can add attributes to the list of standard attributes returned with each search result item, and they can hide standard refiners available to users with search results. For more information, see Section 56.4, "Narrowing the Scope of Search" and Section 56.6, "Customizing Search Results with Attributes and Refiners."

Additionally, users can individually configure how their search results are displayed. Specifically, each user can control which services are included in their search and the order in which those services are listed in the results. Set this in the Preferences dialog (for information see Section 56.5, "Setting Individual Preferences for Search Results").






56.2.2 Refining the Display of Search Results

Users can narrow down their searches with refiners to produce a smaller set of results. For example, to see all documents that one particular person posted, rather than scrolling through pages of results to find them, you can just click that name or profile picture, and the results are filtered to show only results from that person.

	
With WebCenter Portal's live search adapters, you can narrow the search by creator (author) or last modified date using the Refine Search section. An estimated number of results is not included. Click the Previous and Next links to view any additional results. These links may appear even if no additional results are available.


	
With the Oracle SES adapter, you can narrow the search by creator and last modified date, and also by content type, space, and tag. An estimated number of search results appears with Oracle SES results (Figure 56-5).


Figure 56-5 Estimated Number of Search Results
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Description of "Figure 56-5 Estimated Number of Search Results "










	
Note:

Results from people, tags, tagged items, and favorites, which do not supply refiners to the Search service, do not appear in refined searches.







To refine the display of search results:

	
Perform a global search as described in Section 56.2.1, "Running a Global Search."

The search results display on the Search results page.


	
To refine the display of search results by date, choose a time-range limitation from the Last Modified box (Figure 56-6).


Figure 56-6 The Last Modified Refiner on the Search Results Page
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Description of "Figure 56-6 The Last Modified Refiner on the Search Results Page"





Click Past 7 Days to view all results that originated in the past week. Click March 2010 to view all results that originated in March 2010. The number next to each time range indicates the search's best guess at how many search results fall within the specified range.

Some date selections, such as years or months, provide additional refinement options when you choose them. For example, when you refine a search by all results occurring within 2007, your refined results display and additional refinements appear in the Last Modified box.

Click Custom Date Range and enter a date in the field provided (optionally, with an end date also), or click the Select Date icon and choose a date from a date picker (Figure 56-7).


Figure 56-7 Date Picker for Custom Date Range
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To refine the display of search results by creator (that is, by the user name of the person who authored, uploaded, or originated the result), choose someone from the Creator box (Figure 56-8).


Figure 56-8 The Creator Box on the Search Results Page

[image: Contributor box on Search Results page]

Description of "Figure 56-8 The Creator Box on the Search Results Page"





For example, click vicki to view all results contributed by the user Vicki.

The number next to each user name indicates the search's best guess at how many search results are associated with the specified user.

Click More... or Less... to see more or less authors listed in the Creator box.


	
When a refinement is selected, it appears above the Results list with a Delete icon, enabling you to remove the refinements you have applied to search results (Figure 56-9).


Figure 56-9 Delete Icon to Remove Refinement of Search Results
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Description of "Figure 56-9 Delete Icon to Remove Refinement of Search Results"





Click the Delete icon to remove that particular search results refinement and broaden the list of displayed results.









56.2.3 Saving Searches

After you have performed a search, you can save it so that you can run it again later without having to reenter the search terms. You can also share the saved search with spaces.




	
Note:

You can save searches only if you are logged in to the application.







This section includes the following subsections:

	
Section 56.2.3.1, "Saving a Search"


	
Section 56.2.3.2, "Running a Saved Search"


	
Section 56.2.3.3, "Sharing a Saved Search in Spaces"


	
Section 56.2.3.4, "Customizing a Saved Search"


	
Section 56.2.3.5, "Deleting a Saved Search"






56.2.3.1 Saving a Search

Saved searches are useful for the searches you run frequently. They assist in keeping you current as new information is added to the search pool.

To save a search:

	
Perform a global search as described in Section 56.2.1, "Running a Global Search."

The search results display on the Search results page.


	
Click Save below the search field (Figure 56-10).


Figure 56-10 Save and Manage Buttons

[image: Manage button]



The Create Saved Search dialog opens (Figure 56-11).


Figure 56-11 The Create Saved Search Dialog

[image: Create New Saved Search dialog box]



	
In the Name field, enter a meaningful name for the search.

The value you enter in the Name field is the value that appears on the dropdown list of saved searches.

The search that was in the Search field is saved, no matter what name you give it. For example, if the search term was admin, but you enter jcr in the Name field. The saved search searches for the term admin and not jcr.


	
Optionally, in the Description field, enter a description of the search.


	
Select the Share in space checkbox to enable other members of the space to see this search on the space's dropdown list of saved searches. Only one space can be specified.


	
Click the Spaces icon to select the spaces in which to share the saved search.


	
Click OK to save the search.









56.2.3.2 Running a Saved Search

The All Saved Searches task flow provides a quick and easy way to see all saved searches. The saved searches to which you have access depends on the location.

	
Go to the Home space. After you have saved searches, there is a dropdown list for Saved Searches in the Home space.


	
Go to any page containing the All Saved Searches task flow (Figure 56-12).

In a space, the All Saved Searches task flow lists all your saved searches for the space and all shared saved searches for the space (made both by yourself and other users). It does not list your global saved searches or saved searches made against other spaces. In a Home space, the All Saved Searches task flow lists all your global saved searches.


Figure 56-12 The All Saved Searches Task Flow

[image: All Saved Searches task flow]



	
Go to any page where the saved search was placed.

The Saved Search task flow shows the results of the particular search.




To run a saved search:

	
Log in and find the saved search:

	
Locate the page containing the All Saved Searches task flow.


	
Locate the page containing the saved search. In this case, the search results are immediately visible.





	
From the All Saved Searches task flow or the Saved Search panel in the Home space, click the link for the saved search you want to run.




	
Tip:

The description is rendered as a tooltip when you move your cursor over the name of the saved search.








	
View the results on the dynamically-generated Search Results page.









56.2.3.3 Sharing a Saved Search in Spaces

In WebCenter Portal: Spaces, you can share a saved space search if you think the results of a search might be useful for other space members.

To share a saved search:

	
Go to the space where the search was performed and saved.


	
Click Manage (Figure 56-17).


Figure 56-13 Save and Manage Buttons

[image: Manage button]



The Manage Saved Searches window opens (Figure 56-18).


Figure 56-14 The Manage Saved Searches Window

[image: Manage (saved searches) window]



In the Saved searches dropdown list, select the saved search you want to share.


	
Select the Share in space checkbox, and click the Spaces icon to select the spaces in which you want to share this saved search.

The saved search is now available for other members of the space to run. The search is listed in the Saved Searches list for all space members and in the All Saved Searches task flow, if one exists.


	
Click Apply, then OK.









56.2.3.4 Customizing a Saved Search

After you have added the results of a saved search to a page, you can customize it.

Click the Personalize icon (Figure 56-15) to make changes to the saved search.


Figure 56-15 Personalize Icon

[image: Personalize icon]



In the Customizing Saved Searches dialog, you can to change the search terms, add refiners, or choose the services to search (Figure 56-16).


Figure 56-16 Customizing Saved Searches Dialog

[image: Description of Figure 56-16 follows]

Description of "Figure 56-16 Customizing Saved Searches Dialog"









56.2.3.5 Deleting a Saved Search

To delete a saved search:

	
Click Manage (Figure 56-17).


Figure 56-17 Save and Manage Buttons

[image: Manage button]



The Manage Saved Searches window opens (Figure 56-18).


Figure 56-18 The Manage Saved Searches Window

[image: Manage (saved searches) window]



	
In the Saved searches dropdown list, select the saved search you want to delete.


	
Click the Delete button, then Apply and OK.













56.3 Working with the Search Service Task Flows

Table 56-1 lists the Search service task flows.


Table 56-1 Search Service Task Flows

	Task Flow	Definition
	
Search 

	
This task flow provides a rich search experience with features for refining and saving search results.


	
All Saved Searches

	
This task flow enables you to create a simple launch pad for running saved searches within the application.


	
Search Preferences

	
This task flow enables users to select which WebCenter Portal services to search.


	
Search Toolbar

	
This task flow enables users to enter simple search criteria and run the search from the application. Search results are rendered as links.








For the steps to add a Search service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Note:

The Search, Search Preferences, and Search Toolbar task flows are not available in the default Resource Catalog, so you will only see entries for these task flows if they have been added to the Resource Catalog that has been made available to the page.
For more information, see Chapter 16, "Working with Resource Catalogs," specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Search for a list of all available content task flows.














56.4 Narrowing the Scope of Search

With the Search service task flow parameters, you can restrict search results to include only specific services, document types, and spaces. This section describes how to set these parameters. It includes the following subsections:




	
See Also:

Section 56.7.2, "How to Set Parameters to Narrow Searches"







	
Section 56.4.1, "Searching Specific Services"


	
Section 56.4.2, "Searching Specific Document Types"


	
Section 56.4.3, "Searching Specific Spaces"






56.4.1 Searching Specific Services

You can restrict search results to one or more WebCenter Portal services with the Services to be Included parameter.

For example, to display only profiles and documents in the Content Server, set this parameter to oracle.webcenter.peopleconnections.profile, oracle.webcenter.doclib. If nothing is specified, then all services are searched.






56.4.2 Searching Specific Document Types

You can restrict search results to one or more types of documents in the Content Server (such as PDF, PPT, or DOC) with the Mimetype parameter.

Examples of common MIME type values are as follows:

	
application/excel


	
application/msword


	
application/pdf


	
application/powerpoint


	
text/html


	
text/plain




The MIME types can be any standard MIME type value, such as those available from Microsoft Office.

For example, to search only web pages and Microsoft Word documents, set the Mimetype parameter to text/html,application/msword. If nothing is specified, then all document types are searched.

To see a MIME type value for a document, in the Content Server, select the Info icon in the Actions column.


Figure 56-19 Document Formats in the Content Server

[image: Document Formats in the Content Server]



The format is listed in the Formats field, as shown in Figure 56-20.


Figure 56-20 Document Format Value

[image: Document Format Value]






	
Note:

If the Content Server is configured for web rendition, then items in the Content Server are rendered in PDF format. The content item's native MIME type rendition is overwritten. For example, the MIME type of a Microsoft Office Word document is 'application/msword', but when the Content Server uses web rendition the MIME type becomes 'application/pdf'. A search query with the Mimetype parameter set to 'application/msword' does not return Word documents.
If your Content Server is configured to use web rendition, the WebCenter Portal administrator must configure the Content Server metatdata list to include the dFormat value so that required MIME types are exported to Oracle SES. For steps, see "Managing Oracle SES Search in WebCenter Portal" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.














56.4.3 Searching Specific Spaces

WebCenter Portal search performs global (that is, application-wide) searches. However, you can restrict search results to one or more spaces with the Search Scope parameter.

Set this parameter to the comma-separated list of GUIDs of the spaces to search. If nothing is specified in this parameter, then all spaces are searched.

For example:


#{spaceContext.currentSpaceGUID}
#{serviceCtx.scope.GUID}
#{spaceContext.space['Travel'].metadata.guid} 


where Travel is the name of the space.

To search the current space as well as all subspaces, enter the following:


#{spaceContext.currentSpace.subspaceGuids} 








56.5 Setting Individual Preferences for Search Results

In addition to the customizations the space administrator can make to the way search results are displayed, individual users also can customize the way they see their results.

When you search content, you may find that the results from one service are more relevant to you than results from other services. You may find it useful to be able to exclude some services from a search and specify the order in which the results from selected services are listed.

Use search preferences to choose the services to search and specify the display order for search results. This section contains the following subsections:

	
Section 56.5.1, "Selecting the Services to Search"


	
Section 56.5.2, "Specifying a Display Order for Search Results"







	
See Also:

Section 41.31, "Searching for Documents"









56.5.1 Selecting the Services to Search

Your WebCenter Portal administrator makes services available to the application. By default, all enabled services are selected to be searched. You can disable any service from which you do not want to see search results. For example, if you frequently search for a particular type of technology, including your personal contacts in the search is probably not useful.

To specify which services should be searched:

	
Click the Preferences link at the top of the application.


	
Click Search to open the Search Preferences pane (Figure 56-21).


Figure 56-21 The Search Preferences Pane

[image: Search Preferences pane in Preferences dialog]



	
To add a service to a search, choose one or more services on the Available Services list and click the Move selected items to list icon to move them to the Selected Services list.

To remove services from search, choose one or more services on the Selected Services list and click the Remove selected items from list icon to move them to the Available Services list.




	
Note:

When Oracle SES is configured in the application, Oracle SES cannot be deselected, and services that do not support searching with Oracle SES (such as Notes) are not listed.








	
Click OK to save your changes and exit the Preferences dialog.

Alternatively, click Apply to save your changes without exiting.




The services you add to the Selected Services list are included in future searches. The services on the Available Services list are not searched.






56.5.2 Specifying a Display Order for Search Results

Of all the services you include in a search, you may find that some services provide more relevant results than others. For example, you may find that search results from the Documents service prove more useful that search results from other services. Preferences provide controls for specifying the order in which services are listed in search results.

To specify a display order for search results:

	
Click the Preferences link at the top of the application.


	
Click Search to open the Search Preferences panel (Figure 56-22).


Figure 56-22 Search Preferences

[image: Search Preferences panel in Preferences dialog box]



	
Choose one or more services on the Selected Services list and click the Move icons to the right of the list to move your selections higher or lower on the list.

The order you specify here determines the order each service is listed in search results.


	
Click OK to save your changes and exit the Preferences dialog.

Alternatively, click Apply to save your changes without exiting.











56.6 Customizing Search Results with Attributes and Refiners

A set of standard attributes (such as creator and size) is shown in each search result item. However, you can add additional attributes by specifying one or more attributes in the Custom Attributes parameter.




	
See Also:

Section 56.7.3, "Search Service Task Flow Parameters"







For example, Figure 56-23 shows search results with attributes added for DocumentName, DocumentType, FileName, DocumentID, and CreatedDate.


Figure 56-23 Search Results with Custom Attributes Added

[image: Description of Figure 56-23 follows]

Description of "Figure 56-23 Search Results with Custom Attributes Added"





An attribute is shown only if there is a value.




	
Note:

All attributes must be added to the Metadata List parameter in the Content Server. For these attributes, the following list would need to be included in the Metadata List parameter:
DocumentName:dDocName,DocumentType:dDocType,FileName:dOriginalName,DocumentID:dID,CreatedOn:dDocCreatedDate

For more information, see "Managing Oracle SES Search in WebCenter Portal" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









Additionally, if you do not want users to see certain standard refiners in their search results, then set the Refiners to hide parameter to a list of one or more refiners you want hidden. For example, you might want to hide the space refiner to give the appearance that no other spaces exist.

The following predefined refiners can be hidden:

	
Date


	
Author


	
Space


	
Service


	
Tag




If nothing is specified, then all refiners are shown.




	
See Also:

Section 56.2.2, "Refining the Display of Search Results" and Section 56.7.3, "Search Service Task Flow Parameters"












56.7 Setting Search Service Task Flow Properties

The Search service task flows have associated properties, which users with sufficient privileges can access from the Component Properties dialog in Oracle Composer (Figure 56-24).


Figure 56-24 Search Task Flow Component Properties

[image: Component Properties dialog]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Search service task flows and describe the properties on the Parameters tab.

	
Section 56.7.1, "What You Should Know About the Search Service Task Flow Properties"


	
Section 56.7.2, "How to Set Parameters to Narrow Searches"


	
Section 56.7.3, "Search Service Task Flow Parameters."






56.7.1 What You Should Know About the Search Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 56.7.3, "Search Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor.




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1. For more information about ELs in WebCenter Portal: Spaces, see Appendix B, "Expression Language Expressions."
EL validation is not performed on non-generic display options.














56.7.2 How to Set Parameters to Narrow Searches

The parameters to scope your search results to specific spaces, services, and document types are available in the Search task flow.

The space administrator either can modify the space's page template to edit the Search task flow parameters, or the administrator can add the Search task flow to the space and edit its task flow parameters.

	
Section 56.7.2.1, "Editing the Search Task Flow in a Page Template"


	
Section 56.7.2.2, "Editing the Search Task Flow in a Space"







	
See Also:

	
Section 56.4, "Narrowing the Scope of Search"


	
Section 12, "Working with Page Templates"














56.7.2.1 Editing the Search Task Flow in a Page Template

To edit the page template, first display the space administration page.




	
Tip:

The way you access the space administration pages depends on the page template in use. For example, in a top navigation template, you may access space administration pages through a Manage menu (Figure 56-25).
You can also navigate to these pages using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










Figure 56-25 Manage Menu in the Top Navigation Template

[image: Description of Figure 56-25 follows]

Description of "Figure 56-25 Manage Menu in the Top Navigation Template"





Click the Resources tab to get to the Page Templates page. Select Edit - Copy to copy the page template, and enter a name for this new template.

Click Edit - Show to make this page template available, and then select Edit - Customize to edit the Search task flow parameters (Figure 56-26).


Figure 56-26 Customizing the Page Template

[image: Description of Figure 56-26 follows]

Description of "Figure 56-26 Customizing the Page Template"





In the page template, click View - Source (Figure 56-27).


Figure 56-27 View - Source

[image: Description of Figure 56-27 follows]

Description of "Figure 56-27 View - Source"





Select the Search region, and click Edit to set any of the Search task flow parameters (Figure 56-28). For more information on the parameters, see Section 56.7.3, "Search Service Task Flow Parameters."


Figure 56-28 Editing Search Task Flow Parameters Dialog

[image: Description of Figure 56-28 follows]

Description of "Figure 56-28 Editing Search Task Flow Parameters Dialog"









56.7.2.2 Editing the Search Task Flow in a Space

The Search task flow is not available in the default Resource Catalog, so editing the Search task flow in a space generally involves adding the Search task flow to the Resource Catalog, and then assigning this catalog to the space. For example:

	
Go to Administration - Resources - Resource Catalogs, and either click to create a new resource catalog or select an existing resource catalog and select Edit - Copy.


	
Enter a name for this new Resource Catalog (Figure 56-29).


Figure 56-29 Editing a Default Resource Catalog to Include Search

[image: Description of Figure 56-29 follows]

Description of "Figure 56-29 Editing a Default Resource Catalog to Include Search "





	
Click Edit - Edit, Add, then Add from Library.


	
Select Task Flows, then scroll down to select the Search task flow, and click Add (Figure 56-30).


Figure 56-30 Add Resource Catalog Item Dialog

[image: Description of Figure 56-30 follows]

Description of "Figure 56-30 Add Resource Catalog Item Dialog"





	
You see the Search task flow added to the Resource Catalog. Optionally, you can drag and drop the task flow into a folder. With the Search task flow selected, click Edit (pencil) to add a description for this new catalog item (Figure 56-31).


Figure 56-31 New Resource Catalog with the Search Task Flow Added

[image: Description of Figure 56-31 follows]

Description of "Figure 56-31 New Resource Catalog with the Search Task Flow Added"





	
On the Target tab, add a description (Figure 56-32).


Figure 56-32 Edit Resource Catalog Item - Target Tab

[image: Description of Figure 56-32 follows]

Description of "Figure 56-32 Edit Resource Catalog Item - Target Tab"





	
On the Options tab, for New Attribute Name select Icon URI, and for New Attribute Value, enter /adf/webcenter/search_qualifier.png (Figure 56-33).


Figure 56-33 Edit Resource Catalog Item - Options Tab

[image: Description of Figure 56-33 follows]

Description of "Figure 56-33 Edit Resource Catalog Item - Options Tab"





	
Click Add, then OK and OK again to close the Edit. You see the new icon and description appear in the Resource Catalog (Figure 56-34).


Figure 56-34 Search Task Flow Icon and Description

[image: Search task flow icon]



	
Back on the Administration - Resources - Resource Catalogs page, select this new Resource Catalog, and click Edit - Show to make it available.


	
In your space, display the General page of the space administration settings.


	
For Resource Catalog for Pages, select the new Resource Catalog, and click Apply (Figure 56-35).


Figure 56-35 Space Administration Settings for New Resource Catalog

[image: Description of Figure 56-35 follows]

Description of "Figure 56-35 Space Administration Settings for New Resource Catalog"





	
In the new space, create a new page (Figure 56-36).


Figure 56-36 Create New Page Dialog

[image: Description of Figure 56-36 follows]

Description of "Figure 56-36 Create New Page Dialog"





	
On the new page, click Add Content, navigate to the Search task flow, and click Add to add the Search task flow to the page. Edit any parameters you choose, and click Close.


	
Click Save, then Close.


	
Run a search term in the Search field (Figure 56-37).


Figure 56-37 Search Task Flow in a Space

[image: Description of Figure 56-37 follows]

Description of "Figure 56-37 Search Task Flow in a Space"







After the task flow has been added, you can edit the task flow parameters. For more information, see Section 56.7.3, "Search Service Task Flow Parameters."








56.7.3 Search Service Task Flow Parameters

Table 56-2 describes the parameters that are unique to Search service task flows.


Table 56-2 Search Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Custom Attributes

	
List of custom attributes to show when displaying search results.

To include one or more custom attributes in the search results, set this to a list of custom attribute names, separated by commas. An optional label prefix may be provided with the custom attribute name to display instead of its associated custom attribute name. Use the format: label:name.

	
Search

Search Toolbar


	
Mimetype

	
List of content types to limit the search.

To limit the search to certain document types, set this to the list of MIME types of the documents (such as PDF, PPT, DOC), separated by commas.

Note: To limit search to Microsoft Word documents and WebCenter Portal pages, set this parameter to application/msword, and set the Services to be Included parameter to oracle.webcenter.doclib,oracle.webcenter.page.

For more information, see Section 56.4.2, "Searching Specific Document Types."

	
Search

Search Toolbar


	
Refiners to Hide

	
List of refiners to hide when displaying search results.

To hide one or more refiners, set this to a list of refiner names, separated by commas (choose from creator, date, space, content, and tags).

	
Search

Search Toolbar


	
Search Scope

	
List of unique IDs to limit the search scope.

To limit the search to a particular space, set this to the GUID of the space; for example, #{spaceContext.currentSpaceGUID}. If nothing is specified in this parameter, then all spaces are searched.

For more information, see Section 56.4.3, "Searching Specific Spaces."

	
Search

Search Toolbar


	
Search Box Size

	
Value to limit the size of the search box.

The default value is 42. Enter a lower number (for example, 30) to shorten the length of the search box. This also changes the size of the search box in the Search task flow.

	
Search Toolbar


	
Search Taskflow ID

	
Task flow ID of global search; for example, /oracle/webcenter/search/controller/taskflows/searchResults#search-view

	
Search Toolbar


	
Services to be Included

	
List of IDs of services or executors to include when displaying search results.

For example, to display only announcements, enter oracle.webcenter.collab.announcement.For a list of service IDs, see Table G-7 "Service IDs" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

	
Search

Search Toolbar


	
Show or hide input box

	
Show or hide the input box.

Set to true (default) to show the input box, or set to false to hide it.

	
Search


	
Search Scope ID

	
List of unique objects to limit the search scope.

Note: This parameter has been deprecated. Use the Search Scope parameter instead. (If a value is set for this parameter, then any value in Search Scope is ignored.)

	
Search Toolbar


	
Resource Scope

	
List of unique IDs to limit the search scope.

Note: This parameter has been deprecated. Use the Search Scope parameter instead.

	
Search


	
Resource ID

	
Either search keywords or the saved search GUID.

Note: This parameter is for internal use only. Do not change this value unless you want coded search main views. If you do change this value, then you must also specify Resource Type.

	
Search


	
Resource Type

	
Marker specifying whether the Resource ID parameter searches keywords or saved search GUID.

Note: This value is set automatically and is for internal use only. Do not change it unless you want coded search main views.

	
Search


	
Services to be Excluded

	
List of IDs of services or executors to omit when displaying search results.

Note: This parameter is for internal use only. Do not change this value.

	
Search











	
Note:

The All Saved Searches and the Search Preferences task flows do not have any unique properties.

















57 Working with the Tags Service

This chapter describes how to use the features provided through the Tags service. Tagging enables users to apply their own meaningful terms to application items, making those items more easily discoverable in search results and the Tag Center.

This chapter includes the following sections:

	
Section 57.1, "What You Should Know About the Tags Service"


	
Section 57.2, "Working with Tags Service Features and Task Flows"


	
Section 57.3, "Setting Tags Service Task Flow Properties"





Audience

This chapter is intended for users who want to use and manage tags. Such users must be granted, minimally, the space-level permission View Pages and Content to view tags. They can view shared tags only for resources for which they have view permission.

Authenticated users who plan to create and manage tags require the space-level permission Customize Pages and Edit Content. They must have view permission on the resource.

WebCenter Portal: Spaces administrators with the Application-Manage Configuration permission and individual space moderators can add tags to a page template. Page creation permissions are required to add task flows to a page. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter may not be available if the Tags service is not enabled in the current space.









57.1 What You Should Know About the Tags Service

The Tags service provides a means of bookmarking application objects, making them easy to locate the next time you go looking for them. You can tag pages and documents in WebCenter Portal applications. This section provides an overview of the Tags service: what tags are and how to use tags. It contains the following subsections:

	
Section 57.1.1, "Understanding Tags"


	
Section 57.1.2, "Understanding the Tag Center"






57.1.1 Understanding Tags

A tag is a word you associate with application pages or documents, applying your own classification to improve search results. For example, you could apply the tag jcr to a page that provides useful insight into Java Content Repositories. When you search for information about JCRs, the tagged page appears in the results.

Tags are available for viewing in the Tags task flow, in search results, and in the Tag Center, where you can see what tags were used and what items were tagged. Tagging assists with building a knowledge network where each user can benefit from the assessments of all users.

Your tags help provide a higher level of relevance from search results for yourself and others by augmenting results with relevant items that you or others have tagged. Additionally, classifying an item with a tag enables you to gather disparate items into a cohesive body of knowledge and share it with others.

You have the option of sharing tags or keeping them to yourself. Share tags to enable other users to discover them in their searches. When you do not share a tag, users searching on an identical term do not discover the items you tagged with that term, unless some other user tagged the item with the same term and shared that tag.

Anywhere you see the Tags icon (Figure 57-1), you can apply a tag.


Figure 57-1 The Tags Icon

[image: Tag icon]

Description of "Figure 57-1 The Tags Icon"





When you place your cursor over the Tags icon, you see a list of any tags you have applied to the item and the tags that have been applied most frequently to the item by you and other users. To see the items associated with a displayed tag, click the tag.

When looking at tags in search results, note the number of times the tag was applied to a particular object. This number indicates the tag's relevance to that object, and ultimately causes a collective classification scheme popularly known as a folksonomy. This can make information easier to search and navigate over time.

The scope of tags is both personal and application-wide. The tag data you view in the Tags task flow includes only the tags you apply; however, when you tag data through the Tag Center or through a Tags service task flow you see application-wide tag data.

Application-wide (global) searches look for tagged items wherever they might be. You can run global searches from the search field near the top-right of the application.

You can provide one or multiple tags to a given item. And multiple users can use the same tag term that you used and apply it to the same item. Duplicates of tags across users are tabulated and provide extra weight to the relevance of the tag term.






57.1.2 Understanding the Tag Center

The Tag Center is a dynamically-generated page that displays all the tags you and other users have applied to application pages and documents (Figure 57-2).


Figure 57-2 The Tag Center

[image: Tag Center]

Description of "Figure 57-2 The Tag Center"





The Tag Center offers the most complete use of tag data by providing access not only to your tags, but to the tags applied by other users. Additionally it provides a visual depiction of tag popularity, which enables you to refine tag results using filters. Filter for multiple tags simultaneously or filter by other users who have applied the same tags. A sorting feature provides an additional means of controlling your view of tagged items.

The Tag Center has three sections:

	
The Tag Cloud section, which you can use to view a cloud or list of the tags currently applied to items in your application.


	
The Refine Tag Results section with two types of list: a list of all other tags used on items that also use the currently-selected tag and a list of other users who have applied the selected tag.


	
The Selected tag section, which provides a list of all items to which you have access that use the currently-selected tag and options to edit, sort, and filter the items.




The Tag Cloud is a visual depiction of currently-applied tags (Figure 57-3).


Figure 57-3 The Tag Cloud

[image: Tag cloud]



Tags are presented according to the frequency of their use. More frequently used tags display in bold fonts and varying font sizes—the larger the font, the more the tag has been applied. Click a tag in the tag cloud to execute a search that returns a list of all items to which you have access that use the tag.

To learn how to work with tags in the Tag Center see Section 57.2.7, "Working with Tags and Tagged Items in the Tag Center."








57.2 Working with Tags Service Features and Task Flows

This section provides information about tagging and describes how to make best use of tags. It includes the following subsections:

	
Section 57.2.1, "Adding a Tags Service Task Flow to a Page"


	
Section 57.2.2, "Adding the Tags Icon to Pages"


	
Section 57.2.3, "Tagging Application Pages"


	
Section 57.2.4, "Tagging Application Documents"


	
Section 57.2.5, "Working with Tags and Tagged Items in the Tags Task Flow"


	
Section 57.2.6, "Viewing Tags and Tagged Items in Search Results"


	
Section 57.2.7, "Working with Tags and Tagged Items in the Tag Center"


	
Section 57.2.8, "Understanding the Tag Cloud and the Tag Selection Task Flows"


	
Section 57.2.9, "Understanding the Similarly Tagged Items Task Flow"






57.2.1 Adding a Tags Service Task Flow to a Page

For the steps to add a Tags service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






57.2.2 Adding the Tags Icon to Pages

If you do not see the Tags icon on pages, then your WebCenter Portal administrator or space moderator must follow these steps to add the Tags icon to pages.

	
On the Administration - Resources tab, edit the page template. Select Edit - Copy, and enter a meaningful name for this new page template (Figure 57-4).


Figure 57-4 Copying Page Templates

[image: Copying Page Templates]

Description of "Figure 57-4 Copying Page Templates"





	
Click Edit - Edit, and add the Tags icon to the template page. For example, at the top of the page, click Add Content, click to open the Template Development folder, and then click to add Tags.


	
Click Save, then Close to stop editing the template.


	
On the Administration - Resources - Page Templates tab, select this template. Click Edit - Show to make the template available.


	
On the Administration - Configuration - General tab, set this new template as the Default Page Template, and click Apply.

The Tags icon displays on the page (Figure 57-5).


Figure 57-5 Tags Icon on a Page

[image: Tags Icon on a Page]

Description of "Figure 57-5 Tags Icon on a Page"












57.2.3 Tagging Application Pages

This section steps you through the process of applying tags to application pages. You can apply a tag to any application page on which you see the Tags icon and link (Figure 57-6).


Figure 57-6 A Page's Tags Icon and Link

[image: Page’s Tags icon and link]



To tag a page in your application:

	
Go to the page you want to tag.


	
Click the page's Tags icon or link.

The Tag this Page dialog opens (Figure 57-7).


Figure 57-7 Tag This Page Dialog

[image: Tag this Item dialog box]



	
Enter tag values:

	
Page Name—The page's display name, a read-only value.


	
Tags—List of tags already applied to this page.


	
Add Tags—Enter one or more tags, separated with a space. Use underscores or hyphens in multi-word tag entries.


	
Shared—Imagine that you have tagged a page with the term essential and selected the Shared checkbox. When other users search using the term essential, the page you tagged appears in their search results. If you clear the Shared checkbox, then other users' search on the term essential does not include this page in their results (unless others, too, have tagged it essential or another user tagged it essential and shared the tag). Regardless of whether you select or clear Shared, when you search on the term essential, the page you tagged with that term appears in your search results.

If your administrator disabled the Shared checkbox, then it does not appear.





	
Click Save to apply the tag and close the dialog.







	
Note:

For information about tags and searches, see Section 57.2.6, "Viewing Tags and Tagged Items in Search Results."












57.2.4 Tagging Application Documents

The section steps you through the process of applying tags to documents. You can apply tags to any documents you can view.

To tag a document in your application:

	
Go to a Document Library main view, either the task flow or the Documents page, and locate the document you want to tag.


	
Click the document to open it, then click Tags icon. The Tags section displays the tags you have put on the document. It also lets you update these tags and add new tags. (Figure 57-8).


Figure 57-8 Related Items - Tags

[image: Related Items - Tags]



	
Enter tag values:

	
Tags—List of tags already applied to this page.


	
Add Tags—Enter one or more tags, separated with a space. Use underscores or hyphens in multi-word tag entries.


	
Recommended Tags—Recommended tags are automatically generated using a ranking algorithm. They indicate the system's best estimation of tags that suit the document you are currently tagging. Click a recommended tag to add it to the Tags field.


	
Shared—Imagine that you have tagged a document with the term essential and selected the Shared checkbox. When other users search using the term essential, the document you tagged appears in their search results. If you clear the Shared checkbox, then other users' search on the term essential does not include this document in their results (unless they, too, have tagged it essential). Regardless of whether you select or clear Shared, when you search on the term essential, the document you tagged with that term appears in your search results.

If your administrator disabled the Shared checkbox, then it does not appear.





	
Click Save to apply the tag.







	
Note:

For information about tags and searches, see Section 57.2.6, "Viewing Tags and Tagged Items in Search Results."












57.2.5 Working with Tags and Tagged Items in the Tags Task Flow

This section describes how to work with tags in the Tags task flow. It contains the following subsections:

	
Viewing Tags and Tagged Items in the Tags Task Flow


	
Sorting Tags and Tagged Items


	
Filtering Tags and Tagged Items


	
Renaming a Tag from the Tags Task Flow


	
Deleting a Tag from the Tags Task Flow






57.2.5.1 Viewing Tags and Tagged Items in the Tags Task Flow

The Tags task flow (available in the Composer Catalog) provides a view of the tags you have added to your application and the items you have tagged (Figure 57-9).


Figure 57-9 Tags Task Flow

[image: Tags task flow]

Description of "Figure 57-9 Tags Task Flow"





You can use the Tags task flow to navigate to a tag's associated resources or to open the Tag Center and further refine your resource selection (see Section 57.2.7, "Working with Tags and Tagged Items in the Tag Center"). You can also use it to display a tag cloud or the items you have tagged in your application.

To view a tag cloud depiction of your tags, choose Tag Cloud.

To view tagged items, choose Tagged Items from the display options menu. The task flow redraws to display all the items that you have tagged in your application.






57.2.5.2 Sorting Tags and Tagged Items

When your tag list is long, sorting the list makes it easier to find specific tags. Sort the tag list by name, date, or popularity. This section describes how.

To sort the tags in the Tags task flow:

	
Click the Sorting options icon at the top of the Tags task flow.

The Sorting options dialog opens (Figure 57-10).


Figure 57-10 The Sorting Options Dialog
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From the Sorting options dialog, choose a sorting criteria.

Choose from:

	
Name—Sorts the list alphabetically from 1 to 9 and a to z.


	
Date—When tags are shown, Date sorts the list from the tags you applied most recently to the oldest tags you applied. When tagged items are shown, Date sorts the list from the items you tagged most recently to the items with the oldest tags you applied.


	
Popularity—When tags are shown, Popularity sorts the list from the tags you have applied most frequently to those you have applied least frequently. When tagged items are shown, Popularity sorts the list from the items that have been tagged by the most people to the items tagged by the fewest.





	
Click Save to apply your selection and close the dialog.









57.2.5.3 Filtering Tags and Tagged Items

Filtering provides a way to eliminate all tags on the list except for those that meet the filtering criteria. This section describes how to apply a filter to the Tags list in the Tags task flow:

To filter the Tags list in the Tags task flow:

	
Click the Filter icon to open a filtering term field (Figure 57-11).


Figure 57-11 The Filter Icon
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Filtering works for both Tags and Tagged Items views of the task flow.


	
Enter a filtering term, and click the Search icon.

The Tags list refreshes, showing only those tags that match or include the filtering term.


	
Clear the filtering term, and click the Search icon to restore all of your tags to view.


	
Click the Filter icon to exit filtering.









57.2.5.4 Renaming a Tag from the Tags Task Flow

When you rename a tag, you rename all instances of the tag that you applied. If other users applied the same tag, their instances are not renamed.

To rename tags from the Tags task flow:

	
Choose Rename from the menu next to the tag you want to rename (Figure 57-12).


Figure 57-12 The Rename Command on a Tag Menu

[image: Rename command on tag drop-down menu]



	
In the Rename dialog, enter a new name for the selected tag, and click Rename (Figure 57-13).


Figure 57-13 The Rename Dialog

[image: Rename dialog box]



All of the tags you created using the original tag name, are renamed.









57.2.5.5 Deleting a Tag from the Tags Task Flow

When you delete a tag, it is deleted wherever you applied it. If others applied the same tag, their tags are left as is.

To delete a tag from the Tags task flow:

	
Choose Delete from the menu next to the tag you want to delete (Figure 57-14).


Figure 57-14 The Delete Command on a Tag Menu

[image: Delete command on a tag drop-down menu]



	
Click Delete in the Delete dialog (Figure 57-15).


Figure 57-15 The Delete Dialog

[image: Delete dialog box]



The tag is removed from the Tags task flow and from any items to which you applied it.











57.2.6 Viewing Tags and Tagged Items in Search Results

Tag search results appear under two headings:

	
Tags, which shows tags that at least partially match the search criteria; for example, if you search for page, the following tags are returned: page, pages, or pager.


	
Tagged Items, which shows items that are associated with a tag that matches the search criteria exactly; for example, if you search for page, only items associated with the tag page are returned; items associated with the following tags are not returned: pages or pager.




Under these headings, tag search results appear like any other search results; however, tags in tag search results behave a little differently. When you click tagged items in tag search results or when you click other types of search results, their associated content is shown. When you click a tag in tag search results, the Tag Center opens with that tag preselected.

To view tags and tagged items in search results:

	
Run a search as described in Section 56.2, "Searching in Your Application."


	
The search results open in the Search page (Figure 57-16). The Tags section shows the number of items to which a tag has been applied. The Tagged Items section shows the number of users who have applied a tag to an item.


Figure 57-16 Search Page with Tag Results

[image: Tags in search results]






	
Note:

Results appear different if you are using WebCenter Portal's live search adapters or Oracle SES for the search engine. For more information, see Section 56.1.1, "Using the Oracle Secure Enterprise Search Adapter."















57.2.7 Working with Tags and Tagged Items in the Tag Center

This section describes how to work with tags in the Tag Center. It contains the following subsections:

	
Opening the Tag Center


	
Selecting Different Views and Arrangements of Tags in the Tag Cloud


	
Selecting Different Views and Arrangements of Tagged Items


	
Refining the Display of Information in the Tag Center


	
Discovering Who Has Used a Tag in the Tag Center






57.2.7.1 Opening the Tag Center

There are several ways to open the Tag Center (Figure 57-17):


Figure 57-17 The Tag Center
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Click a tag displayed in the Tags task flow


	
Click a tag returned as a search result


	
Click a tag that appears when you hover over the Tags icon




Additionally, the administrator can add a page for the Tag Center in the Home space.

The selected tag determines all the other tag-related information that appears in the Tag Center. For example:

	
The selected tag is highlighted in the tag cloud (Figure 57-18).


Figure 57-18 A Tag Cloud
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You can choose another tag in the tag cloud to change the information that is displayed in the Tag Center. Additionally, you can use the controls above the tag cloud to rearrange your tag-cloud view (see Section 57.2.7.2, "Selecting Different Views and Arrangements of Tags in the Tag Cloud").


	
Other tags used on items that also use the currently-selected tag display in the Tagged with panel (Figure 57-19).


Figure 57-19 Tagged with Panel in the Tag Center

[image: Refine Selection pane in Tag Center]



	
Other users who applied the selected tag are listed in the Tagged by panel (Figure 57-20).


Figure 57-20 Tagged by Panel in the Tag Center

[image: Others who use this tag pane in Tag Center]



	
Items tagged with the currently-selected tag appear in the right panel of the Tag Center (Figure 57-21). Click an item link to display the item.


Figure 57-21 Items Tagged with "Concurrency" in the Tag Center

[image: Items tagged with "concurrency" in the Tag Center]










57.2.7.2 Selecting Different Views and Arrangements of Tags in the Tag Cloud

The Tag Center's Tag Cloud displays the tags currently applied to items. You can adjust your view of the Tag Cloud using its sorting and filtering features.

To display the tag cloud:

	
Open the Tag Center as described in Section 57.2.7.1, "Opening the Tag Center."

The Tag Center opens with the tag cloud displayed in the top left corner (Figure 57-22).


Figure 57-22 The Tag Cloud

[image: Tag cloud]





To adjust your view of the tag cloud:

	
To search for tags, enter a search term in the text box on the tag cloud toolbar, and click the Search icon to the right of the text box.

The tag display refreshes showing only those tags that meet the search criteria. To show just your matching tags or to remove the search criteria, choose an option from the menu above the tag cloud:

	
All Tags—Removes the search criteria, showing every tag used in your application


	
My Tags—Removes the search criteria, showing just the tags you have applied


	
All tags containing '<search term>'—Shows all tags in your application that meet the search criteria


	
My tags containing '<search term>'—Shows just the tags which you have applied that meet the search criteria





	
To switch between displaying the tags in cloud view or list view, click the cloud icon (Figure 57-23).


Figure 57-23 Tags Displayed in a List

[image: Tags displayed in a cloud and in a list]



	
To sort the tags:

	
Click the Sorting options icon on the tag cloud toolbar.

The Sorting options dialog opens (Figure 57-24).


Figure 57-24 The Sorting Options Dialog
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From the Sorting options dialog, choose sorting criteria.

Choose from:

	
Name—Sorts the list alphabetically. If you choose Ascending, the list is sorted from 1 to 9 and a to z. If you choose Descending, the list is sorted from z to a and 9 to 1.


	
Date—Sorts the list based on when you applied the tags. If you choose Ascending, the tags are sorted from the ones you applied most recently to the ones applied longest ago. If you choose Descending, the tags are sorted from the ones applied longest ago to the ones applied most recently.


	
Popularity—Sorts the list based on how frequently the tag has been applied. If you choose Ascending, the tags are sorted from the ones that have been applied most frequently to the one that have been applied least frequently. If you choose Descending, the tags are sorted from the ones applied least frequently to the ones applied most frequently.





	
Click Sort to apply your selection and close the Sorting options dialog.





	
To refresh the list of tags, click the Refresh tags icon.


	
To show all tags or just your tags, choose an option from the menu above the tag cloud:

	
All Tags—Shows every tag used in your application


	
My Tags—Shows just the tags you have applied












57.2.7.3 Selecting Different Views and Arrangements of Tagged Items

The Tag Center provides a selection of sorting criteria to enable you to display tagged items in the way that you prefer. Using the Tagged by and Sort By options above the list of tagged items (Figure 57-25), you can choose which tags to show and the order in which to show them.


Figure 57-25 Tagged by and Sort By Options for Tagged Items in the Tag Center

[image: Tagged by and Sort By options for tagged items]



To choose the tagged items to view, choose from:

	
Tagged by Me—Click to show only the items that use the selected tag that you have tagged yourself.


	
Tagged by Anyone—Click to show all items that use the selected tags.




To arrange the order of displayed tagged items, choose from:

	
Popularity—To sort the list from items that have been tagged most frequently with the current tag to those tagged least frequently


	
Name—To sort the list alphabetically from 1 to 9 and a to z


	
Date—To sort the list from items that have been tagged most recently to the ones tagged longest ago









57.2.7.4 Refining the Display of Information in the Tag Center

You can further refine your view of information in the Tag Center by selecting additional tags in the Tagged with panel (Figure 57-26).


Figure 57-26 Tagged with Panel in the Tag Center

[image: Refine Selection pane in Tag Center]



The Tagged with panel displays all the other tags used on objects that also use the currently-selected tag. Click a tag in the Tagged with panel to further restrict the information in the Tag Center to information associated with both the selected tag and the related tag you clicked.

For example, imagine that the Tag Center displays all items tagged with the term help. Click jcr_docs in the Tagged with panel to further refine the information in the Tag Center to information that is associated with both help and jcr_docs.






57.2.7.5 Discovering Who Has Used a Tag in the Tag Center

You can further refine your view of information in the Tag Center by selecting other users in the Tagged by panel (Figure 57-27).


Figure 57-27 Tagged by Panel in the Tag Center

[image: Others who use this tag pane in Tag Center]



The Tagged by panel lists all other users who have applied the selected tag or tags. Click a user in the Tagged by panel to limit the information in the Tag Center to information tagged with the selected tag and also tagged by the user you clicked.

Using Figure 57-27 as an example, and assuming the currently-selected tag is help, clicking orcladmin shows information associated with the tag help, applied by orcladmin.








57.2.8 Understanding the Tag Cloud and the Tag Selection Task Flows

The Tag Cloud task flow and Tag Selection task flow are similar in that they both display a tag cloud, which is a visual depiction of all the tags used. Tags are presented according to the frequency of their use. More frequently used tags display in bold fonts and varying font sizes—the larger the font, the more the tag has been applied.

With the Tag Cloud task flow (Figure 57-28), when you click a tag in the tag cloud, you are redirected to Tag Center, where that tag is selected (Figure 57-29).


Figure 57-28 Tag Cloud Task Flow

[image: Tag Cloud Task Flow]




Figure 57-29 Clicking a Tag in the Tag Cloud Task Flow

[image: Clicking a Tag in the Tag Cloud Task Flow]






	
See Also:

Section 57.1.2, "Understanding the Tag Center"







With the Tag Selection task flow (Figure 57-30), when you click a tag, it marks the tag as selected and you see the results in the Tag Cloud Related Resources task flow (Figure 57-31). You are not redirected to the Tag Center.


Figure 57-30 Tag Selection Task Flow
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Figure 57-31 Clicking a Tag in the Tag Selection Task Flow

[image: Clicking a Tag in the Tag Selection Task Flow]







57.2.9 Understanding the Similarly Tagged Items Task Flow

The Similarly Tagged Items task flow (Figure 57-32) provides a list of links to other pages or documents that have at least one tag in common with the currently-displayed page.


Figure 57-32 The Similarly Tagged Items Task Flow
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57.3 Setting Tags Service Task Flow Properties

The Tags service task flow has associated properties, which users with sufficient privileges can access from the Component Properties dialog in Oracle Composer (Figure 57-33).


Figure 57-33 Similarly Tagged Items Task Flow Properties

[image: Similarly Tagged Items Task Flow Properties]
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Tags service task flows and describe the properties on the Parameters tab.

	
Section 57.3.1, "What You Should Know About the Tags Service Task Flow Properties"


	
Section 57.3.2, "Tags Service Task Flow Parameters"






57.3.1 What You Should Know About the Tags Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 57.3.2, "Tags Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about ELs in Spaces, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














57.3.2 Tags Service Task Flow Parameters

Table 57-1 describes the parameters that are unique to the Tags service task flows.


Table 57-1 Tags Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Resource ID

	
Unique ID of the item or resource within a given service that is used to find similarly tagged items. This value is set automatically. Do not change this value unless you want to show items similar to a different resource.

	
Tagging - Related Links

Similarly Tagged Items


	
Service ID

	
This parameter has a different meaning for the Similarly Tagged Items task flow and the Tags task flow.

	
In Tagging - Related Links, it is a resourceId/serviceId pair that describes what item the listed objects are similar to. This value is set automatically. Do not change this value unless you want to show items similar to a different resource belonging to a different service.


	
In Tags, it limits the tags and tagged items to this service; for example, oracle.webcenter.page.




	
Tagging - Related Links

Similarly Tagged Items

Tagging - Personal View

Tags


	
Scope of Tags

	
Scope of tags. This value is set automatically. Do not change this value.

	
Tag Cloud

Tag Selection

Tagging - Tagged Items

Tag Cloud Related Resources


	
Redirect URL

	
Redirection URL for anonymous page login. This must include the /faces prefix; for example, /faces#{facesContext.viewRoot.viewId} If null or empty, then no login is displayed.

	
Tagging Dialog











	
Note:

You should not change the Tags service task flow properties unless you want to show items from a different resource or different service.

















Part XIV


Gathering Intelligence Based on Activities

Part XIV of the User's Guide provides information about accumulating portal and community usage intelligence from the actions of your users.

Part XIV includes Chapter 58, "Working with the Activity Graph Service."







58 Working with the Activity Graph Service

The Activity Graph service provides a means of enlarging your sphere of interest in Oracle WebCenter Portal: Spaces by offering recommendations for new connections, suitable items, and relevant spaces, and by returning more relevant search results. It does this by tracking application activities across users for a period of time. Based on these activities the Activity Graph engine starts to provide recommendations.

This chapter provides an overview of Activity Graph service features and describes how to use them. It includes the following sections:

	
Section 58.1, "What You Should Know About the Activity Graph Service"


	
Section 58.2, "Working with Activity Graph Service Task Flows"


	
Section 58.3, "Setting Activity Graph Service Task Flow Properties"




For Activity Graph task flows to work, the Analytics schema (activities) must be installed and configured, and a connection set up between your application and the Analytics Collector.




	
See Also:

For more information, see the chapter "Managing the Analytics Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









58.1 What You Should Know About the Activity Graph Service

The advent of Enterprise 2.0 has enabled users to contribute content at unprecedented rates. In view of this, there is now a need for better information retrieval technologies that are seamlessly integrated with Enterprise 2.0 products, such as Spaces. The Activity Graph service provides the solution by leveraging collective intelligence, gathered by the underlying Activity Graph engine, to benefit search and social applications.

The Activity Graph service provides suggestions of people that a user may be interested in connecting with, based on existing connections and shared interaction with objects in the application. It also directs users to spaces or items that may be of interest, based on similar interactions with those spaces or items the user is currently viewing.

The Activity Graph service presents these suggestions based on data gathered and analyzed by the Activity Graph engine. The Activity Graph engine provides a central repository for actions that are collected by enterprise applications.

The Activity Graph service serves up its recommendations in the following three out-of-the-box task flows:

	
Recommended Connections

Use the Recommended Connections task flow (Figure 58-1) to view and connect with users similar to you.


Figure 58-1 The Recommended Connections Task Flow

[image: Description of Figure 58-1 follows]

Description of "Figure 58-1 The Recommended Connections Task Flow"








	
See Also:

For more information about this task flow, see Section 58.2.2, "Working with the Recommended Connections Task Flow."








	
Similar Spaces

Use the Similar Spaces task flow (Figure 58-2) to identify and interact with spaces that may be of interest to you.


Figure 58-2 The Similar Spaces Task Flow
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Description of "Figure 58-2 The Similar Spaces Task Flow"








	
See Also:

For more information about this task flow, see Section 58.2.3, "Working with the Similar Spaces Task Flow."








	
Similar Items

Use the Similar Items task flow (Figure 58-3) to identify and interact with WebCenter Portal content that may be of interest to you.


Figure 58-3 The Similar Items Task Flow

[image: Description of Figure 58-3 follows]

Description of "Figure 58-3 The Similar Items Task Flow"








	
See Also:

For more information about this task flow, see Section 58.2.4, "Working with the Similar Items Task Flow."













	
Note:

The Activity Graph service task flows display recommendations only if the Activity Graph service is configured in your application. For more information, see the section "Activity Graph Service Prerequisites" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







Out of the box, the Activity Graph service tracks certain WebCenter Portal objects and actions. However, you can extend the service to track other WebCenter Portal objects or actions, or objects and actions from other applications.




	
See Also:

For more information, see the section "Extending the Activity Graph Service" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.












58.2 Working with Activity Graph Service Task Flows

The Activity Graph service task flows expose the functionality available from the Activity Graph service.

This section includes the following subsections:

	
Section 58.2.1, "Adding an Activity Graph Service Task Flow to a Page"


	
Section 58.2.2, "Working with the Recommended Connections Task Flow"


	
Section 58.2.3, "Working with the Similar Spaces Task Flow"


	
Section 58.2.4, "Working with the Similar Items Task Flow"






58.2.1 Adding an Activity Graph Service Task Flow to a Page

By default, the Recommended Connections task flow is included in each user's Profile Gallery, available through the Home space. The Similar Items task flow is included, by default, in the Document Viewer Related Items pane for files, to show items similar to the currently viewed file.

To include any of the Activity Graph service task flows anywhere else, you must add the task flow to the appropriate page.

To add an Activity Graph service task flow to a page:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that contains the Activity Graph service task flows or search for the task flow.




	
Tip:

The presence or location of this component depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, next to Social and Communication, click Open to expose a list that includes the Activity Graph service task flows.








	
Click Add next to the task flow that you want to add to your page.









58.2.2 Working with the Recommended Connections Task Flow

The Recommended Connections task flow enables viewing and connecting to people considered to be similar to you.




	
Note:

The recommendations provided in the task flow reflect the contents of the activity graph when the Activity Graph Engines were last run. Activities that occurred after the last run are not included. For more information, see the section "Preparing Data for the Activity Graph Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







This section includes the following subsections:

	
Section 58.2.2.1, "Learning More About a Recommended Connection"


	
Section 58.2.2.2, "Inviting a Recommended Connection to Connect with You"


	
Section 58.2.2.3, "Removing a User from Your Recommended Connections"







	
See Also:

For general information about connections, see Chapter 31, "Creating Your Social Network."









58.2.2.1 Learning More About a Recommended Connection

Before you connect with someone new, you probably want to find out a bit more about that person to determine whether it is really a connection that you want to make. The Recommended Connections task flow enables this by providing access to the user profile information and by including reasons why the recommendation has been made.

To view information about a recommended connection:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home space.








	
For each of your recommended connections, the task flow includes the name, title, and profile icon of the user. This provides a snapshot to help you decide quickly if you want to connect to this person.


	
To find out more information about the user, click name of the user to display the User Detail popup.




	
Note:

Alternatively, you can click the user icon to display the user's Profile Gallery.








	
In the User Detail popup (Figure 58-4), you can view additional information about the user, such as his or her location and current status. You can also choose to view the full profile or contact the user by email or instant message.


Figure 58-4 The User Detail Popup

[image: Description of Figure 58-4 follows]

Description of "Figure 58-4 The User Detail Popup"








	
Note:

The information in the User Detail popup depends on the information that the user has provided in their profile, and the services that are enabled in the space.








	
Click anywhere away from the popup to close it.


	
The task flow may also provide a reason why each person was recommended as a potential connection. For example, you may be connected to some of the same people or you may have worked on the same documents or wikis.

Reasons for recommending a connection are:

	
You share connections with the user


	
You and the user edited one or more of the same items


	
You and the user worked in one or more of the same spaces


	
You and the user tagged one or more of the same items




Click the reason to find out more details. For example, a list of the connections you have in common, or a list of the objects that you have both worked on (Figure 58-5).


Figure 58-5 Details for Reasons for Recommended Connections

[image: Description of Figure 58-5 follows]

Description of "Figure 58-5 Details for Reasons for Recommended Connections"





	
Click anywhere away from the popup to close it.


	
After examining this information you can decide whether to connect to this person, or remove him or her from the list of recommended connections.









58.2.2.2 Inviting a Recommended Connection to Connect with You

If you find a person in the list of recommended connections that you want to connect with, you can do so quickly from the User Detail popup or the user's Profile Gallery.

To invite a recommended connection to connect with you:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home space.








	
Find the person in the list of recommended connections.


	
Click the name of the user to display the User Detail popup, or the user icon to display the user's Profile Gallery.


	
Click Get Connected (Figure 58-6).


Figure 58-6 The Get Connected Link

[image: Description of Figure 58-6 follows]

Description of "Figure 58-6 The Get Connected Link"





	
In the Invitation Message dialog (Figure 58-7), enter your own message or keep the default.


Figure 58-7 The Invitation Message Dialog

[image: Description of Figure 58-7 follows]

Description of "Figure 58-7 The Invitation Message Dialog"





	
From the Select connection lists dropdown list, select the connection list to which you want to add this user.




	
See Also:

For more information about connections lists, see Section 31.4.5, "Creating and Managing Connections Lists."








	
Click Invite.

If the person you have invited set Preferences to automatically accept all invitations, you are connected immediately. Otherwise, the invitation becomes available in the recipient's Connections page.




	
See Also:

For more information, see Section 31.4.3, "Viewing Invitations to Connect."















58.2.2.3 Removing a User from Your Recommended Connections

If the list of recommended connections includes people that you do not want to connect with, you can remove them, making space for more recommendations. You might also choose to remove someone after you have issued them an invitation to connect. If you do so, the recommendation is removed from the list, but the invitation is not canceled.

To remove a recommended connection:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home space.








	
Find the person in the list of recommended connections.


	
Click the Do not show this person icon next to the user in the list (Figure 58-8).


Figure 58-8 The Do Not Show This Person Icon

[image: Description of Figure 58-8 follows]

Description of "Figure 58-8 The Do Not Show This Person Icon"





	
The task flow is refreshed with a new recommended connection taking the place of the one you removed.









58.2.2.4 Setting the Number of Users to Display in the Recommended Connections Task Flow

You can control the number of users that are displayed in the Recommended Connections task flow.

To set the number of recommended connections to display:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home space.








	
Click the Display Options icon.


	
In the Display Options dialog, in the Number of People field (Figure 58-9), enter how many recommended connections you want to list in the task flow. The default value is 5.


Figure 58-9 The Number of People Field

[image: Description of Figure 58-9 follows]

Description of "Figure 58-9 The Number of People Field"





	
Click OK.









58.2.2.5 Controlling Which Users to Include in the Recommended Connections Task Flow

By default, the Recommended Connections task flow includes all recommended connections except those with whom you are already connected. You can change this setting by editing the task flow's display options. For example, you could use the task flow to show users who are similar to you, rather than to show recommended connections. In this case, you might want to include existing connections.

To control which users to include in the task flow:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home space.








	
Click the Display Options icon.


	
In the Display Options dialog, select the Users I am connected with checkbox (Figure 58-10) to include users in the list of recommended connections even if you are already connected with them.

Deselect the checkbox to remove users from the list if you are already connected with them.


Figure 58-10 The Users I Am Connected With Option

[image: Description of Figure 58-10 follows]

Description of "Figure 58-10 The Users I Am Connected With Option"








	
Note:

This checkbox is not selected by default.








	
Click OK.











58.2.3 Working with the Similar Spaces Task Flow

The Similar Spaces task flow can be placed on any page in a space. It provides you with suggestions of other spaces that are similar to the one you are currently viewing. A space is considered similar to another space if the same people interact with it, especially if they edit the content.

Only spaces that you are permitted to view are listed in the Similar Spaces task flow.




	
Note:

The suggestions made in the Similar Spaces task flow are determined based on the currently viewed space only; they are not specific to the current user.










	
Note:

The recommendations provided in the task flow reflect the contents of the activity graph when the Activity Graph Engines were last run. Activities that occurred after the last run are not included. For more information, see the section "Preparing Data for the Activity Graph Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







This section includes the following subsections:

	
Section 58.2.3.1, "Learning More About a Suggested Space"


	
Section 58.2.3.2, "Joining a Suggested Space"


	
Section 58.2.3.3, "Removing a Space from the Task Flow"


	
Section 58.2.3.4, "Setting the Number of Spaces to Display in the Similar Spaces Task Flow"


	
Section 58.2.3.5, "Controlling Which Spaces to Include in the Similar Spaces Task Flow"






58.2.3.1 Learning More About a Suggested Space

When looking at a space in the Similar Spaces task flow, one of the first things you will probably want to do is find out more about that space. This will help you determine whether the space is one that you are interested in joining or not.

To learn more about a suggested space:

	
Go to the Similar Spaces task flow that includes the space about which you want to learn more.


	
For each of the suggested spaces, the task flow includes the name and description of the space. This provides a snapshot to help you decide quickly if the space is one that you might be interested in.


	
To go to the space to find out more about it, click the name.


	
Examine the contents of the space to determine if you are interested in it.


	
After examining the space you can decide whether to join the space, or remove it from the task flow.









58.2.3.2 Joining a Suggested Space

If you find a space in Similar Spaces task flow that you want to join, you can do so by visiting the space.

To join a suggested space:

	
Go to the Similar Spaces task flow that includes the space that you want to join.


	
Find the space that you want to join.


	
Click the space name to open the space.


	
In the space, subscribe to the space. Some membership requests require approval from the space moderator so you may not gain access immediately.




	
See Also:

For more information, see Section 49.7, "Joining a Space."















58.2.3.3 Removing a Space from the Task Flow

If you decide that you are not particularly interested in a space listed in the Similar Spaces task flow, you can remove it, making space for more suggestions. The space is removed only from your view of the task flow; the space will continue to be listed for other users, as long as they have permission to view it.

To remove a space from the task flow:

	
Go to the Similar Spaces task flow that includes the space that you want to remove.


	
Find the space that you want to remove.


	
Click the Do no show this space icon next to the space (Figure 58-11).


Figure 58-11 The Do Not Show This Space Icon

[image: Description of Figure 58-11 follows]

Description of "Figure 58-11 The Do Not Show This Space Icon"





	
The task flow is refreshed with a new similar space taking the place of the one you removed.









58.2.3.4 Setting the Number of Spaces to Display in the Similar Spaces Task Flow

You can control the number of spaces that are displayed in the Similar Spaces task flow.

To set the number of similar spaces to display:

	
Go to the Similar Spaces task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, in the Number of Spaces field (Figure 58-12), enter how many similar spaces you want to list in the task flow. The default value is 5.


Figure 58-12 The Number of Spaces Field

[image: Description of Figure 58-12 follows]

Description of "Figure 58-12 The Number of Spaces Field"





	
Click OK.









58.2.3.5 Controlling Which Spaces to Include in the Similar Spaces Task Flow

By default, the Similar Spaces task flow does not include spaces that you are already a member of, but it does include spaces that you have already viewed. You can change these settings by editing the task flow's display options.

To which spaces to include in the task flow:

	
Go to the Similar Spaces task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, select the Show spaces I have worked on before checkbox (Figure 58-13) to display spaces in which you have performed an action (excluding viewing) in the list of similar spaces.

Deselect the checkbox if you do not want to include spaces that you have worked on.


Figure 58-13 The Show Spaces I Have Worked on Before Option

[image: Description of Figure 58-13 follows]

Description of "Figure 58-13 The Show Spaces I Have Worked on Before Option"








	
Note:

This checkbox is not selected by default.








	
Select the Show spaces I have visited before checkbox (Figure 58-14) to include spaces in the list of similar spaces even if you have already viewed them.

Deselect the checkbox to remove spaces from the list if you have already viewed them.


Figure 58-14 The Show Spaces I Have Visited Before Option

[image: Description of Figure 58-14 follows]

Description of "Figure 58-14 The Show Spaces I Have Visited Before Option"








	
Note:

This checkbox is selected by default.








	
Click OK.











58.2.4 Working with the Similar Items Task Flow

The Similar Items task flow provides you with suggestions of other items you might want to view, based on the item you have currently selected on the page.




	
Note:

The suggestions made in the Similar Items task flow are determined based on the currently selected item only; they are not specific to the current user.










	
Note:

The recommendations provided in the task flow reflect the contents of the activity graph when the Activity Graph Engines were last run. Activities that occurred after the last run are not included. For more information, see the section "Preparing Data for the Activity Graph Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.







This section includes the following subsections:

	
Section 58.2.4.1, "Populating the Similar Items Task Flow"


	
Section 58.2.4.2, "Viewing a Suggested Item"


	
Section 58.2.4.3, "Removing an Item from the Similar Items Task Flow"


	
Section 58.2.4.4, "Setting the Number of Items to Display in the Similar Items Task Flow"


	
Section 58.2.4.5, "Controlling Which Items to Include in the Similar Items Task Flow"






58.2.4.1 Populating the Similar Items Task Flow

The Similar Items task flow lists items that are similar to the currently selected item on the page. When you initially display a page that contains the Similar Items task flow, the task flow will probably be empty. To populate the task flow, you need to select an item for which you want to see similar items.




	
Note:

If the page containing the Similar Items task flow also contains the Document Viewer, the document currently displayed in the Document Viewer drives the content of the Similar Items task flow and you do not need to explicitly select an item.







To populate the Similar Items task flow:

	
Go to the page containing the Similar Items task flow.


	
In one of the other task flows on the page, select the item for which you want to see similar items.

The Similar Items task flow works in conjunction with the following task flows:

	
Documents service task flows:

	
Recent Documents


	
Document List Viewer


	
Document Navigator


	
Document Explorer


	
Folder Viewer


	
Document Manager


	
Document Browser





	
Discussions Manager task flow





	
The Similar Items task flow refreshes to display items that are similar to the one you selected.









58.2.4.2 Viewing a Suggested Item

If you see an item in the Similar Items task flow that you think might be useful, you can go ahead and view it.

To view a suggested item:

	
Go to the Similar Items task flow that includes the item that you want to view.


	
Click the item's name to display the item.

The way the item is displayed depends on the type of item. For example, documents are displayed in the Document Viewer task flow.









58.2.4.3 Removing an Item from the Similar Items Task Flow

If you decide that you are not particularly interested in an item listed in the Similar Items task flow, you can remove it, making space for more suggestions. The item is removed only from your view of the task flow; the item will continue to be listed for other users, as long as they have permission to view it.

To remove an item from the task flow:

	
Go to the Similar Items task flow that includes the item that you want to remove.


	
Find the item that you want to remove.


	
Click the Do not show this item icon next to the item (Figure 58-15).


Figure 58-15 The Do Not Show This Item Icon

[image: Description of Figure 58-15 follows]

Description of "Figure 58-15 The Do Not Show This Item Icon"





	
The task flow is refreshed with a new similar item taking the place of the one you removed.









58.2.4.4 Setting the Number of Items to Display in the Similar Items Task Flow

You can control the number of items that are displayed in the Similar Items task flow.

To set the number of items to display in the task flow:

	
Go to the Similar Items task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, in the Number of items field (Figure 58-16), enter how many similar items you want to list in the task flow. The default value is 5.


Figure 58-16 The Number of Items Field

[image: Description of Figure 58-16 follows]

Description of "Figure 58-16 The Number of Items Field"





	
Click OK.









58.2.4.5 Controlling Which Items to Include in the Similar Items Task Flow

By default, the Similar Items task flow include items that you have already viewed. It also includes all types of supported items (documents, wiki pages, blogs, and discussion topics). You can change these settings by editing the task flow's display options. For example, you could use the task flow to show only discussion topics that are similar to the selected item.

To control which items to include in the task flow:

	
Go to the Similar Items task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, select the Show items I have viewed before checkbox (Figure 58-17) to include items in the list of similar items even if you have already viewed them.

Deselect the checkbox to remove items from the list of similar items if you have already viewed them.


Figure 58-17 The Show Items I Have Viewed Before Option

[image: Description of Figure 58-17 follows]

Description of "Figure 58-17 The Show Items I Have Viewed Before Option"








	
Note:

This checkbox is selected by default.








	
Select the Show items I have worked on before checkbox () to include items in the list of similar items even if you have already interacted with them in some way (other than viewing).

Deselect the checkbox to remove items from the list of similar items if you have interacted with them already.


Figure 58-18 The Show Items I Have Worked on Before Option

[image: Description of Figure 58-18 follows]

Description of "Figure 58-18 The Show Items I Have Worked on Before Option"








	
Note:

This checkbox is not selected by default.








	
Select or deselect the following checkboxes as required to determine which types of items to display in the task flow (Figure 58-19):

	
Show documents


	
Show wiki pages


	
Show blogs


	
Show discussion topics





Figure 58-19 Options for Displaying Different Types of Items

[image: Description of Figure 58-19 follows]

Description of "Figure 58-19 Options for Displaying Different Types of Items"








	
Note:

These checkboxes are selected by default.








	
Click OK.













58.3 Setting Activity Graph Service Task Flow Properties

The Activity Graph service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 58-20).


Figure 58-20 Recommended Connections Task Flow - Component Properties

[image: Description of Figure 58-20 follows]

Description of "Figure 58-20 Recommended Connections Task Flow - Component Properties"





For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Activity Graph service task flows and describe the properties on the Parameters tab:

	
Section 58.3.1, "What You Should Know About the Activity Graph Service Task Flow Properties"


	
Section 58.3.2, "Activity Graph Service Task Flow Parameters"






58.3.1 What You Should Know About the Activity Graph Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 58.3.2, "Activity Graph Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














58.3.2 Activity Graph Service Task Flow Parameters

Table 58-1 describes the parameters that are unique to the Activity Graph service task flows.


Table 58-1 Activity Graph Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Resource Id

	
The ID of the person, space, or item to use as a context for recommendations.

For connections, the default value is the expression language token for the logged in user.

For spaces, the default value is the expression language token for the resource ID of the space containing the task flow.

For items, the value is derived from the selection event using the EL expression #{wcEventContext.events.WebCenterResourceSelected}

	
Recommended Connections

Similar Spaces

Similar Items


	
Class URN

	
The class of the context. By default the information is derived from the selection event.

	
Similar Items


	
Object Name

	
The name of the space or item to use as a context for recommendations.

For spaces, the default value is the expression language token for the resource ID of the space containing the task flow.

For items, the default value is derived from the selection event.

	
Similar Spaces

Similar Items


	
Recipe

	
A comma separated list of registered similarity calculation = weight pairs. The list determines what recommendations appear and how they are ordered.

For more information about the default recipes for Activity Graph task flows, see the section "Activity Graph Service Task Flows" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

	
Recommended Connections

Similar Spaces

Similar Items


	
Class URN Restrictions

	
A comma separated list of object classes to exclude from recommendations.

	
Similar Items


	
Exclude Object Actions

	
A comma separated list of registered actions. The task flow will not show people, spaces, or items on which the logged in user took any of the listed actions.

	
Recommended Connections

Similar Spaces

Similar Items


	
Service Id

	
Used in conjunction with resourceId, and optionally resourceType, as an alternative to classURN for identifying the node class of an object.

	
Similar Items


	
Resource Type

	
Used in conjunction with resourceId and serviceId, as an alternative to classURN for identifying the node class of a WebCenter Portal object.

For example resourceType is used by the Documents service to identify whether an object is a wiki, blog, or document.

	
Similar Items


	
Suppress Popup

	
Determines whether links in the task flow launch content in inline popups (false) or in browser windows (true).

The default value is false.

	
Similar Items

















Part XV


Services: Announcements through Links

Part XV of the User's Guide provides overview and usage information about services from Announcements through Links.

Part XV includes the following chapters:

	
Chapter 59, "Working with the Announcements Service"


	
Chapter 60, "Working with the Discussions Service"


	
Chapter 61, "Working with the Events Service"


	
Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)"


	
Chapter 63, "Working with the Links Service"










59 Working with the Announcements Service

This chapter describes how to use the features provided with the Announcements service. Announcements offer a quick, convenient way to create and distribute messages instantly or at a time you specify.

This chapter includes the following sections:

	
Section 59.1, "What You Should Know About the Announcements Service"


	
Section 59.2, "Working with Announcements Service Task Flows"


	
Section 59.3, "Setting Announcements Service Task Flow Properties"





Audience

This chapter is intended for users who want to view, create, and manage space announcements. To perform announcement-related tasks, you must have appropriate permissions: Create, Edit, and Delete Announcements, Create and Edit Announcements, or View Announcements. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the Announcements service is not enabled in the current space.









59.1 What You Should Know About the Announcements Service

The Announcements service provides the ability to post announcements about important activities and events to all authenticated users. For example, an application administrator can use this service to announce the availability of a new feature or the plan to shut down the application temporarily for maintenance (Figure 59-1).


Figure 59-1 Sample Announcement in the Announcements - Quick View Task Flow

[image: sample announcement]



The Announcements service is integrated with many other services, such as Activity Stream, RSS, and Instant Messaging and Presence, and you can link announcements to other services, such as Events and Discussions. For example, suppose your company is announcing a new product. You can link from the announcement directly to a discussion forum, where potential customers can ask other customers about the product, or link to an instant messenger where customers can chat with a customer service representative about the product. With Oracle WebCenter Portal live search, announcement titles are searchable, and with Oracle Secure Enterprise Search, announcement titles and text are searchable.

In Spaces, announcements are scoped to the space where you create them. In Home space pages, announcements are scoped application-wide, to all logged-in (authenticated) users.

The Announcements page is added to spaces created with certain templates (Figure 59-2). The Announcements page is available in every space, provided the space is configured to display announcements. For information about enabling services in a space, see Section 51.10.1, "Enabling and Disabling Services Available to a Space."


Figure 59-2 The Announcements Page in a Space

[image: Announcements page]







59.2 Working with Announcements Service Task Flows

Both the Announcements and the Announcements - Quick View task flows display current announcements. The Announcements task flow additionally offers tools for managing announcements within the task flow. With the Announcements - Quick View task flow, you must click the Open Announcement Manager icon to manage announcements.

The Announcements - Quick View task flow includes numerous parameters to customize your view. For example, administrators can remove the link to the Announcement Manager. This lets you present announcements to end users where manage controls are not needed. The task flow lists 10 announcements by default, but you can change this number and change how much of the announcement is displayed. The More Announcements ... link launches a popup containing the complete list of all announcements with pagination behavior. This is called the Extended Quick View (or Extended Mini View).

Depending on the privileges you have on the page, you can perform some or all tasks described in this section:

	
View announcements in the Announcements task flow—All participants in Home spaces and space moderators


	
Create announcements—All participants


	
Edit announcements—Creator of the announcement, discussions server administrators in Home spaces, and space moderators


	
Delete announcements—Discussions server system administrators in Home spaces and space moderators




This section contains the following subsections:

	
Section 59.2.1, "Adding an Announcements Service Task Flow to a Page"


	
Section 59.2.2, "Working with the Announcements Task Flow"


	
Section 59.2.3, "Working with the Announcements - Quick View Task Flow"


	
Section 59.2.4, "Sending Mail from an Announcement"


	
Section 59.2.5, "Linking Announcements"






59.2.1 Adding an Announcements Service Task Flow to a Page

For the steps to add an Announcements service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Notes:

	
You cannot add an Announcements task flow to the Home space page. The Announcements task flow only displays in the component catalog if you have manage privilege and if you are adding content in a space page. By default, this privilege is available to a space moderator.


	
All instances of the Announcements task flow in an application run against the same back-end server and therefore, it serves no purpose to add multiple Announcements task flow instances.












The Announcements task flow is displayed on your page, as shown in Figure 59-3.


Figure 59-3 Announcements Task Flow

[image: Announcements task flow]



Users with Edit privileges can access the task flow's region parameter through the Component Properties dialog in Composer to specify the ID of the discussion forum under which announcements must be created.

For information about accessing the Component Properties dialog and editing properties, see Section 59.3, "Setting Announcements Service Task Flow Properties."




	
Note:

The Announcements - Quick View task flow opens in a space, regardless of the discussion forum ID specified.







For more information about setting task flow properties, see Section 59.3, "Setting Announcements Service Task Flow Properties."






59.2.2 Working with the Announcements Task Flow

The Announcements task flow not only provides the tools to create, edit, and delete announcements, it also provides controls for determining when an announcement is published and when it expires and is consequently removed from the task flow. It provides Show lists, which you can use to personalize your view of announcements. After you create an announcement, you are offered the option to mail or link the announcement.

Depending on the privileges you have on the page and whether the required services are configured in your application, you may see only a subset of these options in the Announcement Manager. For example, the Delete icon is displayed only to users with manage privilege.

This section provides information about viewing, creating, and managing announcements through the Announcements task flow. Discussions server administrators in Home spaces and space moderators can access the Announcements task flow.

This section contains the following subsections:

	
Section 59.2.2.1, "Viewing Announcements in the Announcements Task Flow"


	
Section 59.2.2.2, "Adjusting Your View of the Announcements"


	
Section 59.2.2.3, "Creating an Announcement"


	
Section 59.2.2.4, "Editing Announcements"


	
Section 59.2.2.5, "Deleting an Announcement"






59.2.2.1 Viewing Announcements in the Announcements Task Flow

To view announcements in the Announcements task flow, either select the Announcements task flow on a page, or select the Announcements page.

Figure 59-4 shows an announcement in the Announcements task flow.


Figure 59-4 An Announcement in the Announcements Task Flow

[image: announcements in the Announcements task flow]



If Announcements is not available, then in the space administration settings, display the Services page. On the Services page, choose Announcements. For more information, see Chapter 51, "Managing a Space."




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."














59.2.2.2 Adjusting Your View of the Announcements

You can customize your own view of the Announcements task flow, which does not affect other users' view of announcements. All users who can view the Announcements task flow can customize it.

A Show list provides options for displaying only those announcements that were created within a selected time range. Choose from displaying all announcements to displaying only those created today, since yesterday, and so on—up to 30 days. For example, you may select the option Today from the Show menu, and only those announcements posted today display in the task flow.

Another Show list provides options to display current, future or expired announcements.

To adjust your view of the Announcement Manager:

	
Go to the application page that contains the Announcements task flow.


	
In the task flow, expand the Show menu and select from the listed display options (Figure 59-5).


Figure 59-5 Show Menu on Announcements

[image: Show drop-down menu on Announcements page]



Choose:

	
All— To display all available announcements.


	
Today—To display only today's announcements.


	
Since Yesterday—To display today and yesterday's announcements.


	
Last 7 Days—To display all announcements made in the last seven days.


	
Last 30 Days—To display all announcements made in the last 30 days.




The Announcements task flow refreshes and displays the announcements that match your selection.


	
Expand the other dropdown list to show active, future or expired announcements (Figure 59-6).


Figure 59-6 Active, Future or Expired Announcements

[image: Active, Future, or Expired announcements]



Table 59-1 shows what different combinations of these Show lists display.


Table 59-1 Announcements Displayed Based on Show Lists

	Days Range	Announcement Type	Display Result
	
All

	
Active

	
All announcements as of today


	
Today

	
Active

	
All announcements with a start date of today.


	
Since Yesterday

	
Active

	
All announcements with a start date as of yesterday.


	
Last 7 Days

	
Active

	
All announcements for the last seven days.


	
Last 30 Days

	
Active

	
All announcements for the last 30 days.


	
All

	
Future

	
All announcements scheduled for a later date.


	
Today

	
Future

	
All announcements scheduled for a later date.


	
Since Yesterday

	
Future

	
All announcements scheduled for a later date.


	
Last 7 Days

	
Future

	
All announcements scheduled for a later date.


	
Last 30 Days

	
Future

	
All announcements scheduled for a later date.


	
All

	
Expired

	
All expired announcements.


	
Today

	
Expired

	
No announcements.


	
Since Yesterday

	
Expired

	
All expired announcements as of yesterday.


	
Last 7 Days

	
Expired

	
All expired announcements for the last seven days.


	
Last 30 Days

	
Expired

	
All expired announcements for the last 30 days.















59.2.2.3 Creating an Announcement

Create an announcement to distribute information to all members of an application or a space in one operation. For example, if you are an administrator and want to shut down the application for maintenance, you can create an announcement to inform all application users about the down time. On the publication date you specify while creating the announcement, the announcement appears in the Announcements and Announcements - Quick View task flows, and on the Activity Stream.

In WebCenter Portal: Spaces, all participants can create announcements.

To create a new announcement:

	
Access the Announcements task flow, access the Announcements page, or open the Announcement Manager from the Announcements - Quick View task flow. For more information, see Section 59.2.2.1, "Viewing Announcements in the Announcements Task Flow."


	
Click Create (Figure 59-7).


Figure 59-7 Create an Announcement

[image: Create button on an Announcements page]



The Create Announcement dialog opens (Figure 59-8).


Figure 59-8 The Create Announcement Dialog

[image: Create Announcement dialog box]



	
In the Subject field, enter a heading for the announcement.


	
In the message body text box, enter the text of the announcement.

The message body is provided through the rich text editor. You can style the announcement with colors, special fonts, and images. For information about rich text editor controls, see the online help.

Styling information is applied when the announcement is configured with the Content View Only region parameter set to true. For more information, see Section 59.3, "Setting Announcements Service Task Flow Properties."


	
Under Announcement Active Date, choose:

	
Make Active Now — To post the announcement immediately (the default option)


	
Make Active on Specific Date — To select a date and time to post the announcement

Click the Select Date icon to the right of the text field to open the Select Date pop-up calendar (Figure 59-9).


Figure 59-9 The Select Date Pop-Up Calendar

[image: Select Date pop-up calendar]

Description of "Figure 59-9 The Select Date Pop-Up Calendar"





In the calendar, click a date to select it. The current date is marked by a solid box.

Alternatively, use the controls at the top of the calendar to select a month and year for publication.

After you select a date, the calendar closes.





	
Under Announcement Expire Date, choose:

	
Never Expires — To post the announcement indefinitely (the default option)


	
Expire After Days — To specify the number of days the announcement is active

Enter the number of days to display the announcement.


	
Expire on a Specific Date — To set the date and time to expire and remove the announcement

Click the Select Date icon next to the text field to open the Select Date pop-up calendar (Figure 59-10).


Figure 59-10 The Select Date and Time Icon

[image: Select Date and Time icon]

Description of "Figure 59-10 The Select Date and Time Icon"





In the calendar, only those dates after the publication date are enabled for selection.





	
Click Create to create the announcement.

If you chose to post the announcement immediately, then the new announcement appears in following locations: in any Announcements task flow included on a page, on the Activity Stream, and at the top of the list of announcements in the Announcements - Quick View task flow.









59.2.2.4 Editing Announcements

After you have created an announcement, you easily can modify it. For example, if the details of an announcement change, or you want to change the font or color of the announcement text, you can quickly make these changes using the Announcement Manager. You can change an announcement's title, content and expiration date. However, you cannot change its publication date, which is the date on which the announcement is made active (Announcement Active Date).




	
Note:

To change an announcement's publication date, you must delete the announcement, and re-create it with the correct publication date. For information about deleting an announcement, see Section 59.2.2.5, "Deleting an Announcement." For information about creating an announcement, see Section 59.2.2.3, "Creating an Announcement."







You can edit an announcement only if you created that announcement or have been granted privileges to do so. Typically, space moderators have privileges to edit all announcements in the Announcements task flow.

To edit an announcement:

	
Open the Announcements task flow. For information, see Section 59.2.2.1, "Viewing Announcements in the Announcements Task Flow."


	
Click the Edit Announcement icon (Figure 59-11) on the announcement you want to edit.


Figure 59-11 Edit Announcement Icon

[image: Edit Announcement icon]



The Edit Announcement dialog opens (Figure 59-12).


Figure 59-12 The Edit Announcement Dialog

[image: Edit Announcement dialog box]



	
Make the changes you want to the announcement. For example, you can change the text of the announcement, or modify its look and feel.

The Edit Announcement dialog provides rich text editor controls for styling announcement text. For information on rich text editor controls, see the online help.

You can change an announcement's title and content and, also its expiration date. However, you cannot change its publication date.


	
Click Save to save your changes and close the dialog.









59.2.2.5 Deleting an Announcement

After you've created an announcement, you can delete it if you are a space moderator. Other users do not have privileges to delete announcements.

To delete an announcement:

	
Open the Announcements task flow. For information, see Section 59.2.2.1, "Viewing Announcements in the Announcements Task Flow."


	
Click the Delete Announcement icon on the announcement you want to delete (Figure 59-13). This icon only displays if you have the appropriate privileges.


Figure 59-13 The Delete Announcement Icon on an Announcement

[image: Delete Announcement icon]



	
In the Delete Announcement dialog (Figure 59-14), click Delete to delete the announcement and close the dialog.


Figure 59-14 Delete Announcement Dialog

[image: Delete Announcement dialog box]



The selected announcement is removed from the Announcements task flow, the Announcements - Quick View task flow, and the Activity Stream.











59.2.3 Working with the Announcements - Quick View Task Flow

The Announcements - Quick View task flow is essentially a viewer for convenient access to current announcements. More robust features, for such actions as creating and editing announcements, are offered in the Announcements task flow (see Section 59.2.2).

By default, announcements in the Announcements - Quick View task flow show announcement titles as links. But you can configure the task flow to display only announcement titles, titles with some amount of content, or only content.

This section contains the following subsections:

	
Section 59.2.3.1, "Viewing Announcements in the Quick View Task Flow"


	
Section 59.2.3.2, "Managing Announcements in the Quick View Task Flow"






59.2.3.1 Viewing Announcements in the Quick View Task Flow

The Announcements - Quick View task flow provides a read-only view of announcements. To view announcements in an Announcements - Quick View task flow:

	
In the Announcements - Quick View task flow, click the announcement you want to view (Figure 59-15).


Figure 59-15 The Announcements - Quick View Task Flow

[image: Announcements - Quick View Task Flow]



The announcement details display in the Announcement dialog (Figure 59-16). Similar to the announcement content displayed in the Announcements task flow, this dialog displays content with all the formatting that was applied to it


Figure 59-16 Announcement Accessed from Quick View Task Flow

[image: Announcement accessed from Quick View Task Flow]

Description of "Figure 59-16 Announcement Accessed from Quick View Task Flow"





	
Click Close to exit the dialog.









59.2.3.2 Managing Announcements in the Quick View Task Flow

You can manage announcements in the Announcements - Quick View task flow with the Announcement Manager. The Announcement Manager provides the functionality in the Announcements task flow.

Administrators can remove the link to the Announcement Manager. If your administrator allows this functionality, then you see the Open Announcement Manager icon (Figure 59-17). The Announcement Manager lets you create, edit, delete, mail, and link announcements.


Figure 59-17 Open Announcement Manager Icon

[image: open announcement icon]









59.2.4 Sending Mail from an Announcement

Each announcement in the Announcements or Announcements - Quick View task flow has an associated Send Mail icon in its toolbar (Figure 59-18). Click the Send Mail icon to initiate a mail message containing the announcement text, location, author, and date it was created. This feature makes it easy for you to communicate interesting announcements to others.


Figure 59-18 Send Mail Icons on Announcement Headers

[image: Send mail icons on announcement toolbars]



The WebCenter Portal administrator determines the mail client to use with the Send Mail icon. If a local mail client was set, then a plain text message opens. If WebCenter Portal's Mail service was set as the mail client, then the HTML Mail Compose dialog opens. With either mail client, you can add or edit the standard, prepopulated message before sending.






59.2.5 Linking Announcements

Each announcement in the Announcement Manager or Announcements task flow has an associated Links icon in its toolbar to link other objects to the announcement. For example, you can link an announcement to a new discussion, document, event, note or URL, or you can link an announcement to an existing announcement, discussion, document, or event.

The Links icon displays to all users accessing the Announcements and Announcement Manager task flows, if the Links service is configured in the application (Figure 59-19).


Figure 59-19 Links Icon with Announcements

[image: Links icon in announcements]



For more information, see Chapter 63, "Working with the Links Service."








59.3 Setting Announcements Service Task Flow Properties

The Announcements service task flows have associated properties, which users with sufficient privileges can access from the Component Properties dialog in Oracle Composer (Figure 59-20).


Figure 59-20 Announcements Task Flow Component Properties

[image: Announcement Task Flow Component Properties parameters]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Announcements service task flows and describe the properties on the Parameters tab.

	
Section 59.3.1, "What You Should Know About the Announcements Service Task Flow Properties"


	
Section 59.3.2, "Announcements Service Task Flow Parameters"






59.3.1 What You Should Know About the Announcements Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 59.3.2, "Announcements Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














59.3.2 Announcements Service Task Flow Parameters

Table 59-2 describes the properties that are unique to the Announcements task flows.


Table 59-2 Announcements Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Expand All Announcements in Extended Mini View

	
Select to display details for all announcements in the extended quick view. The default value is unselected, in which case announcements display the announcement title only.

	
Announcements - Quick View


	
Number of Expanded Announcements

	
The number of announcements to display announcement details. Announcements exceeding this value display the announcement title only. Use only when Content View Only is unselected.

Express values using the following formats:

	
Constant—Express a constant value, such as 2 or 5.


	
Page parameter—Enter a page parameter to grab the value from the page on which the task flow is placed. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."


	
EL expression—The default. Enter an Expression Language (EL) expression.




	
Announcements - Quick View


	
Content View Only

	
Select to remove the announcement title and display just the announcement content. Leave unchecked to render the title.

When selected, the values for Announcement Length and Number of Expanded Announcements are ignored.

	
Announcements - Quick View


	
Hide Toolbar

	
Hides the Announcements toolbar.

	
Announcements - Quick View


	
Navigate to Announcement Viewer

	
Select to navigate to the announcement resource. Default behavior (unselected) is to launch in a popup.

	
Announcements - Quick View


	
Number of Announcements on Extended Mini View

	
The number of announcements to show in a page on extended mini view.

	
Announcements - Quick View


	
Forum ID

	
The ID of the forum under which announcements are created in the back-end discussions server.

In WebCenter Portal: Spaces, this property is blank by default. However, internally it maps to the forum ID associated with the current space. For Home spaces, global (system) announcements are returned. You can edit this property to specify a different forum ID.

	
Announcements - Quick View

Announcements


	
Announcement Length

	
The number of characters to show in announcement details. Use only when Content View Only is unselected.

If no value is specified, then WebCenter Portal displays 200 characters.

This parameter takes effect with Number of Expanded Announcements.

Express values using the following formats:

	
Constant—Express a constant value, such as 200 or 500.


	
Page parameter—Enter a page parameter to grab the value from the page on which the task flow is placed. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."


	
EL expression—The default. Enter an Expression Language (EL) expression.




The value you enter for Announcement Length is ignored if Content View Only is selected.

	
Announcements - Quick View


	
Number of Announcements to Show

	
The number of announcements to show on the quick view.

	
Announcements - Quick View

















60 Working with the Discussions Service

This chapter describes how to use the features provided through the Discussions service. The Discussions service provides a means of creating and participating in text-based discussions with other members of a space. Use Discussions service task flows to create forums, post questions, and search for answers. Discussion forums additionally provide the means to preserve and revisit discussions.

This chapter includes the following sections:

	
Section 60.1, "What You Should Know About the Discussions Service"


	
Section 60.2, "Working with Discussions Service Task Flows"


	
Section 60.3, "Setting Discussions Service Task Flow Properties"





Audience

This chapter is intended for users who want to view, create, and manage space discussion forums and topics. To perform discussion-related tasks, you must have appropriate permissions: Create, Edit, and Delete Discussions, Create and Edit Discussions, or View Discussions. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the Discussions service is not enabled in the current space.









60.1 What You Should Know About the Discussions Service

You can use the Discussions service to post, respond to, and preserve topical information in discussion forums scoped to spaces or to entire applications. Users post topics to a discussion forum, and other users post information relevant to those topics. All of this information is preserved within the forum.

The back-end server that provides the Discussion service (Oracle WebCenter Portal's Discussion Server) manages content in a hierarchy. At the top of the hierarchy are categories, below that are forums, and then topics. Where categories are exposed in your application, authorized users can create multiple forums within a given scope and multiple topics under those forums. Where categories are not exposed, authorized users can create multiple topics under one forum within a given scope.

A new space is assigned a single discussion forum by default. Space moderators can allocate multiple forums to a space if required, as described in Section 6.2, "Configuring Discussion Forum Options for the Spaces Application." However, only users who are system administrators on Oracle WebCenter Portal's Discussion Server can switch from a single forum to multiple forums in a space.

The Discussions service is scoped to spaces. That is, you can create forums and topics only within the context of a space. You can view and participate in discussions in both spaces and Home spaces, depending on your application permissions.

Access to discussions is influenced by application security. The Spaces application is, by default, a secure application. Users can access discussions according to the permissions they are granted by their specific user roles within a given space.

Scoping additionally limits the users who can view and participate in discussions. For example, only members of the Finance space can view discussions that transpire in Finance space forums.

To expose a discussion forum to a specific set of users, you must add just those users as members of the space where you hold the forum (for more information, see Section 51.14.4, "Granting Spaces Users Access to a Space"). To open a discussion to all users, you must create a publicly-accessible space (for more information, see Section 51.14.5, "Granting Public Access to a Space").

Most Discussions service task flows provide configuration settings for specifying which forum content to show. This is of particular use in Home spaces, which exist outside a specific space scope (for more information, see Section 60.3, "Setting Discussions Service Task Flow Properties").




	
Note:

You can add a Discussions task flow to your page from the Catalog dialog in Oracle Composer. For information about adding a task flow, see Section 17.5, "Adding Resource Catalog Components to Pages."
However, all instances of the Discussions task flow in an application run against the same back end and it serves no purpose to add multiple Discussions task flow instances. This is true for all service task flows that require connections to back-end servers, for example, task flows from IMP, Announcements, and Mail services.









The Discussions service provides a wide variety of task flows for viewing and participating in discussions. These include:

	
Discussion Forums provides controls for creating discussion forums; creating, replying to, and managing discussion forum topics; and selecting watched forums and watched topics (Figure 60-1).


Figure 60-1 Discussion Forums Task Flow

[image: Discussion Forums task flow]



In WebCenter Portal: Spaces, the Discussion Forums task flow is additionally exposed on a Discussions page. You cannot add Discussion Forums to a Home space.


	
Forums - Quick View provides a means of accessing all possible views of a particular space's discussions: Recent Topics, Popular Topics, Watched Topics, and Watched Forums (Figure 60-2).


Figure 60-2 Forums - Quick View

[image: Forums - Quick View]

Description of "Figure 60-2 Forums - Quick View"





The Forums - Quick View task flow also provides controls for determining the data to show in addition to the forum or topic title. Click the Personalize icon (pencil) in the task flow toolbar to open the Display Settings (Figure 60-3).


Figure 60-3 Display Settings Dialog

[image: Display Settings dialog box]



The available display settings vary according to the option currently selected on the task flow Display Options menu (Figure 60-4).


Figure 60-4 Display Options Menu (Forums - Quick View)

[image: Display Options menu]



For example, when Recent Topics is selected on the menu, the Display Settings dialog offers the options Author, Date, and Replies. When the task flow displays Watched Forums, the Display Settings dialog offers the options Date and Topics.

The Forums - Quick View task flow is available for placement on any application page, regardless of whether the page is scoped to a Home space or space.


	
Popular Topics (Figure 60-5) provides a look at the most frequently viewed discussion topics in all the discussion forums in a given space.


Figure 60-5 Popular Topics Task Flow

[image: Popular Topics task flow]

Description of "Figure 60-5 Popular Topics Task Flow"





The Popular Topics task flow also provides controls for determining the data to show in addition to the topic title. Click the Personalize icon in the task flow header to open a panel with controls for selecting the type of additional data to show (Figure 60-6).


Figure 60-6 Show Panel in a Popular Topics Task Flow

[image: Show panel in a Popular Topics task flow]



The Popular Topics task flow is available for placement on any application page, regardless of whether the page is scoped to a Home space or space.


	
Recent Topics (Figure 60-7) provides a look at the most recently accessed discussion topics in all the discussion forums in a given space.


Figure 60-7 Recent Topics Task Flow

[image: Recent Topics task flow]

Description of "Figure 60-7 Recent Topics Task Flow"





Access to space discussion topics is restricted to those spaces of which you are a member.

The Recent Topics task flow also provides controls for determining the data to show in addition to the topic title. Click the Personalize (pencil) icon in the task flow header (Figure 60-8) to open a panel with controls for selecting the type of additional data to show.


Figure 60-8 Show Panel in a Recent Topics Task Flow

[image: Show panel in a Recent Topics task flow]



The Recent Topics task flow is available for placement on any application page, regardless of whether the page is scoped to a Home space or space.


	
Watched Forums (Figure 60-9) provides a means of viewing all discussion forums you have selected to watch from a particular space or from all spaces.


Figure 60-9 Watched Forums Task Flow

[image: Watched Forums task flow]

Description of "Figure 60-9 Watched Forums Task Flow"





The Watched Forums task flow also provides controls for determining the data to show with the topic title. Click the Personalize icon in the task flow header (Figure 60-10) to open a panel with controls for specifying the type of additional data to show. See Section 60.2.4, "Watching Forums and Topics."


Figure 60-10 Show Panel in a Watched Forums Task Flow

[image: Show panel in a Watched Forums task flow]



The Watched Forums task flow is available for placement on any application page, regardless of whether the page is scoped to a Home space or space.


	
Watched Topics (Figure 60-11) provides a cohesive view of all the topics you have selected to watch from a particular space or from all spaces.


Figure 60-11 Watched Topics Task Flow

[image: Watched Topics task flow at run time]



The Watched Topics task flow also provides controls for determining the data to show with the topic title. Click the Personalize icon in the task flow header (Figure 60-12) to open a panel with controls for specifying the type of additional data to show. See Section 60.2.4, "Watching Forums and Topics."


Figure 60-12 Show Panel in a Watched Topics Task Flow

[image: Show panel in a Watched Topics task flow]



The Watched Topics task flow is available for placement on any application page, regardless of whether the page is scoped to a Home space or space.







	
Note:

All instances of the Mail task flow in an application run against the same mail server and it serves no purpose to add multiple Mail task flow instances. This is true for all service task flows that require connections to back-end servers, for example, task flows from Announcements, Mail, and IMP services.







The Discussions service is tightly integrated with other services, such as Links and Mail. For example, all mail sent to a space distribution list can additionally be posted to that space's default discussion forum. The space moderator must choose Monitor Incoming Mail in the space settings for the Discussions service (see Section 51.10.4, "Publishing Space Mail in a Discussion Forum"). Every discussion topic provides the opportunity to link from the topic to another space item, such as a document or an announcement. (For information about the Mail service, see Chapter 65, "Working with the Mail Service." For information about the Links service, see Chapter 63, "Working with the Links Service.")






60.2 Working with Discussions Service Task Flows

The Discussions service task flows expose all of the functionality available from the Discussions service. The Discussion Forums is the most feature-rich task flow, providing controls for creating and managing discussion forums and posting and managing discussion topics and replies. The other task flows are useful windows into discussion forum content. They provide different views of the discussion forums and topics available to a particular space or all spaces.




	
Note:

For information about configuring a Discussions service task flow to display the discussions from a particular space or from all spaces, see Section 60.3, "Setting Discussions Service Task Flow Properties."







Most of the subsections in this section describe tasks you can accomplish through the Discussion Forums task flow. When you can use other task flows to perform the described actions, this is noted.

This section contains the following subsections:

	
Section 60.2.1, "Adding a Discussions Service Task Flow to a Page"


	
Section 60.2.2, "Creating and Managing Forum Topics and Replies"


	
Section 60.2.3, "Showing and Hiding Additional Discussion Forum Information"


	
Section 60.2.4, "Watching Forums and Topics"


	
Section 60.2.5, "Sending Mail from Discussion Topics"


	
Section 60.2.6, "Creating a Discussion Forum"


	
Section 60.2.7, "Editing the Forum Name and Description"






60.2.1 Adding a Discussions Service Task Flow to a Page

To add a Discussions service task flow to a page in a Spaces application:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to the discussions task flows.




	
Tip:

The presence or location of this section depends on how the Resource Catalog is configured. In the default Resource Catalog, next to Social and Communication, click Open.








Figure 60-13 Opening the Discussions Section in the Resource Catalog

[image: Discussions Section in the Resource Catalog]



	
Click Add next to the task flow that you want to add to your page (Figure 60-14).


Figure 60-14 Adding the Forums Task Flow

[image: Description of Figure 60-14 follows]

Description of "Figure 60-14 Adding the Forums Task Flow"








	
Note:

Not all discussions task flows are not available in the default Oracle Composer Resource Catalog, so you will only see entries for these task flows if they have been added to the Resource Catalog that has been made available to the page.
For more information, see Chapter 16, "Working with Resource Catalogs," specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Discussions for a list of all available content task flows.

















60.2.2 Creating and Managing Forum Topics and Replies

The life of a discussion forum takes place in its topics and replies. There users can ask questions, post information, exchange ideas, and otherwise communicate in interesting and useful ways.

This section describes how to work with discussion forum topics and replies. It contains the following subsections:

	
Section 60.2.2.1, "Posting a New Forum Topic"


	
Section 60.2.2.2, "Replying to Topic Posts"


	
Section 60.2.2.3, "Viewing Topic Posts and Replies"


	
Section 60.2.2.4, "Editing Topics and Replies"


	
Section 60.2.2.5, "Deleting Topic Posts and Replies"


	
Section 60.2.2.6, "Selecting the Number of Topics or Forums to Display"


	
Section 60.2.2.7, "Switching Between Topic View Modes"






60.2.2.1 Posting a New Forum Topic

When you consider discussion forums hierarchically, the forum is the top container and topics are the next level down. Each posted topic can have subordinate replies, and the replies themselves may have replies (Figure 60-15).


Figure 60-15 A Posted Topic and a Reply to the Topic

[image: Posted topic and replies]

Description of "Figure 60-15 A Posted Topic and a Reply to the Topic"





This section describes how to post topics using the Discussion Forums task flow. For information about replying to a posted topic, see Section 60.2.2.2, "Replying to Topic Posts."

To post a topic under a discussion forum:

	
Go to the Discussion Forums task flow in which to post a topic, and click Create Topic (Figure 60-16).


Figure 60-16 Create Topic

[image: Create Topic button]



The Create Topic dialog opens (Figure 60-17).


Figure 60-17 The Create Topic Dialog

[image: Create Topic dialog]



	
In the Subject field, enter the topic subject.

Enter up to 255 characters.


	
In the Message field, enter your post about the topic.

Enter up to 4000 characters.


	
Click Create.

The newly-posted topic appears under the selected forum in Discussion Forums. Click the topic subject to view the message (Figure 60-18).


Figure 60-18 A New Discussion Forum Topic

[image: New discussion forum topic]

Description of "Figure 60-18 A New Discussion Forum Topic"












60.2.2.2 Replying to Topic Posts

This section describes how to reply to topic posts through the Discussion Forums, though you can reply to a topic post through any other Discussions service task flow.

By default, the Discussion Forums task flow is exposed as the Discussions page.

To reply to topic posts:

	
Go to the Discussions task flow in which to read and reply to topic posts, and click the relevant topic (Figure 60-19).


Figure 60-19 Discussion Forums Topic

[image: Discussion forum topic]



The selected topic opens.


	
Click Reply Topic (Figure 60-20).


Figure 60-20 Reply Topic

[image: Reply Topic button]



The Reply Topic dialog opens (Figure 60-21).


Figure 60-21 The Reply Topic Dialog

[image: Reply Topic Dialog]

Description of "Figure 60-21 The Reply Topic Dialog"





	
In the Subject field, either leave the text as is or revise it.

Enter up to 255 characters.


	
In the Message text box, enter your reply to the topic.

Enter up to 4000 characters.


	
Click Reply.

Your reply appears below the main topic post (Figure 60-22).


Figure 60-22 A Topic Post and a Reply

[image: Viewing a recent topic]

Description of "Figure 60-22 A Topic Post and a Reply"







To post a reply to a reply, click the Reply to message icon (Figure 60-23) and follow the steps described in this section (starting with step 5).


Figure 60-23 Reply to message Icon

[image: Reply to message icon]







60.2.2.3 Viewing Topic Posts and Replies

With the Discussion Forums task flow, topics and replies to the topic open directly in the Discussions Forums task flow. To navigate back up the forum hierarchy, click the breadcrumbs that display above the topic reply area (Figure 60-24).


Figure 60-24 Forum Breadcrumbs

[image: Forum breadcrumbs]

Description of "Figure 60-24 Forum Breadcrumbs"





With all the other Discussions service task flows, topics open in a separate window (Figure 60-25).


Figure 60-25 Viewing a Topic in the Discussions - Popular Topics Task Flow

[image: Viewing a recent topic]

Description of "Figure 60-25 Viewing a Topic in the Discussions - Popular Topics Task Flow"





To return to the task flow main view, click Close button in the window.






60.2.2.4 Editing Topics and Replies

After you post a topic or a reply, you retain the option of returning to it and revising its content. Only you and space moderators can edit your replies. This section describes how.

To edit a topic or a reply:

	
Go the Discussion Forums task flow that displays the topic or reply you want to edit, and click the relevant topic.

The selected topic opens.


	
Your next step depends on whether you want to edit a topic or a reply:

	
To edit the topic, click the Edit Topic link at the top of the topic screen (Figure 60-26).


Figure 60-26 Edit Topic Link

[image: Edit Topic link]



	
To edit a reply, click the Edit message icon (pencil) associated with the reply (Figure 60-27).


Figure 60-27 Edit message Icon

[image: Edit message icon on a reply]





The Edit Topic (or Edit Message) dialog opens (Figure 60-28).


Figure 60-28 The Edit Topic Dialog

[image: Edit Topic dialog]



	
Revise the topic (up to 255 characters) or reply (up to 4000 characters).


	
Click Edit in the Edit Topic dialog, or click Reply in the Edit Reply dialog.

Your changes are posted to the forum.









60.2.2.5 Deleting Topic Posts and Replies

When you delete a topic, the original topic post and all of its subordinate replies are deleted. When you delete a reply, you can select to delete the original reply as well as all of its subordinate replies or to delete only this message and keep its replies.

The steps to delete topics and replies are similar.




	
Note:

To delete a topic post or reply, you must have created it or you must have access equivalent to space moderator.







To delete a topic or a reply:

	
Go to the Discussion Forums task flow that displays the topic or reply you want to delete, and click the relevant topic (Figure 60-29).


Figure 60-29 Discussion Forum Topic

[image: Discussion forum topic]



The selected topic opens.


	
Your next step depends on whether you want to delete a topic or a reply:

	
To delete a topic, click the Delete Topic link at the top of the topic screen (Figure 60-30).


Figure 60-30 Delete Topic Link

[image: Delete Topic link]



A Delete Topic confirmation dialog opens (Figure 60-31).


Figure 60-31 Delete Confirmation Dialog for Topics

[image: Edit Topic dialog]



	
To delete a reply, click the Delete message icon associated with the reply (Figure 60-32).


Figure 60-32 Delete Message Icon

[image: Delete message icon on a reply]



A Delete Message confirmation dialog opens, letting you select if you want to delete this message and all its replies or delete only this message. (Figure 60-33).


Figure 60-33 Delete Confirmation Dialog for Topic Replies

[image: Delete Confirmation Dialog for Topic Replies]






	
Click Delete to delete your selection.









60.2.2.6 Selecting the Number of Topics or Forums to Display

You can decide how many topics or forums to display; for example, 10, 25, 50, 75, or 100 (Figure 60-34).


Figure 60-34 Number of Topics to Display

[image: Number of Topics to Display]



For example, if you choose to display 10 topics, and if there are more than 10 topics available, then you click the More link to see the next 10 topics, and so on.

When the Do Not Show More Link task flow parameter is set to true, the More link does not appear. For more information, see Section 60.3, "Setting Discussions Service Task Flow Properties."






60.2.2.7 Switching Between Topic View Modes

You have the option of viewing a topic and all of its replies in a hierarchical, indented mode or a flat, unindented mode. The hierarchical mode (Figure 60-35) uses indenting to indicate whether a reply is to the topic or to another reply.


Figure 60-35 Hierarchical View Mode

[image: Hierarchical view mode]

Description of "Figure 60-35 Hierarchical View Mode"





For example, in Figure 60-35 the first entry is the main topic, the second is a reply to the topic, and so on.

The flat mode (Figure 60-36) makes no such distinctions.


Figure 60-36 Flat View Mode

[image: Flat view mode]

Description of "Figure 60-36 Flat View Mode"





All Discussion task flows that show topics and replies in the same screen provide view mode options.

To switch between topic view modes:

	
Go to the Discussions task flow that contains the topic you want to view, and click the topic.


	
From the Show dropdown list, choose either Flat or Hierarchical.

The topic view rerenders according to your selection.











60.2.3 Showing and Hiding Additional Discussion Forum Information

Most discussions task flows provide personalization settings for determining information to show in addition to the forum or topic title (the Discussion Forums task flow does not provide such settings). Additional information can include forum or topic author, creation date, and replies or topics.

How you set these display settings is personal, affecting only your view of a task flow instance. How you access these display settings varies slightly from task flow to task flow.

This section describes how to configure display settings for Discussions service task flows. It contains the following subsections:

	
Section 60.2.3.1, "Showing or Hiding Information in the Forums - Quick View Task Flow"


	
Section 60.2.3.2, "Showing or Hiding Information in the Popular Topics Task Flow"


	
Section 60.2.3.3, "Showing or Hiding Information in the Recent Topics Task Flow"


	
Section 60.2.3.4, "Showing or Hiding Information in the Watched Forums Task Flow"


	
Section 60.2.3.5, "Showing or Hiding Information in the Watched Topics Task Flow"






60.2.3.1 Showing or Hiding Information in the Forums - Quick View Task Flow

To show or hide additional information in the Discussions - Quick View task flow:

	
Go to the Discussions - Quick View task flow where you want to configure display settings.


	
Click the Select the data to display icon in the task flow toolbar (Figure 60-37).


Figure 60-37 Select the data to display Icon in the Forums - Quick View Task Flow

[image: Edit icon in the forums task flow]



The Display Settings dialog opens (Figure 60-38).


Figure 60-38 Display Settings Dialog

[image: Display Settings dialog]



	
Choose the data you want to show, or clear the checkbox of data you want to hide. Choose or clear one or more from:

	
Author—The user name of the person who created the forum or topic


	
Date—The date the forum or topic was last updated


	
Replies—The replies associated with the topic (for Watched Forums, this displays forums)





	
Click Save to save your changes and close the dialog.









60.2.3.2 Showing or Hiding Information in the Popular Topics Task Flow

To show or hide additional information in the Popular Topics task flow:

	
Go to the Popular Topics task flow where you want to show or hide additional information.


	
Click the Personalize icon in the task flow header.

This opens a panel where you can choose or clear additional data (Figure 60-39).


Figure 60-39 Show Panel in a Popular Topics Task Flow

[image: Show panel in a Popular Topics task flow]



	
Choose the data you want to show, or clear the checkbox of data you want to hide. Choose or clear one or more from:

	
Author—The user name of the person who posted the topic


	
Date—The date the topic was last updated


	
Replies—The replies associated with the topic





	
Click Save to save your changes and close the panel.









60.2.3.3 Showing or Hiding Information in the Recent Topics Task Flow

To show or hide additional information in the Recent Topics task flow:

	
Go to the Recent Topics task flow where you want to show or hide additional information.


	
Click the Personalize icon in the task flow header.

This opens a panel where you can choose or clear additional data (Figure 60-40).


Figure 60-40 Show Panel in a Recent Topics Task Flow

[image: Show panel in a Recent Topics task flow]



	
Choose the data you want to show, or clear the checkbox of data you want to hide. Choose or clear one or more from:

	
Author—The user name of the person who posted the topic


	
Date—The date the topic was last updated


	
Replies—The replies associated with the topic





	
Click Save to save your changes and close the panel.









60.2.3.4 Showing or Hiding Information in the Watched Forums Task Flow

To show or hide additional information in the Watched Forums task flow:

	
Go to the Watched Forums task flow where you want to show or hide additional information.


	
Click the Personalize (pencil) icon in the task flow header.

This opens a panel where you can choose or clear additional data (Figure 60-41).


Figure 60-41 Show Panel in a Watched Forums Task Flow

[image: Show panel in a Watched Forums task flow]



	
Choose the data you want to show, or clear the checkbox of the data you want to hide. Choose or clear one or more from:

	
Date—The date the forum was last updated


	
Topics—The topics associated with the forum





	
Click Save to save your changes and close the panel.









60.2.3.5 Showing or Hiding Information in the Watched Topics Task Flow

To show or hide additional information in the Watched Topics task flow:

	
Go to the Watched Topics task flow where you want to show or hide additional information.


	
Click the Personalize icon in the task flow header.

This opens a panel where you can choose or clear additional data (Figure 60-42).


Figure 60-42 Show Panel in a Watched Topics Task Flow

[image: Show panel in a Watched Topics task flow]



	
Choose the data you want to show, or clear the checkbox of the data you want to hide. Choose or clear one or more from:

	
Author—The user name of the person who posted the topic


	
Date—The date the topic was last updated


	
Replies—The replies associated with the topic





	
Click Save to save your changes and close the panel.











60.2.4 Watching Forums and Topics

Watching discussion forums and topics provides a convenient means of keeping a close eye on the information most current and relevant to your efforts. The forums and topics you choose to watch are personal, in that your selections appear on your view of watch lists. No other user is affected by the forums and topics you choose to watch.

When a user places a watch on a forum or a topic, whenever users add to that forum or topic, in addition to it appearing in the user's watched forums or topics list, the user receives a mail notification.

In Spaces, all watched forums and topics are accessible from the Discussions panel in the quick view. All watched forums and topics are accessible from the Forums task flow. The Watched Forums and Watched Topics task flows provide more focussed views of watched forums or watched topics.

This section includes information about how to add, view, and manage watched topics and forums. It contains the following subsections:

	
Section 60.2.4.1, "Adding a Discussion Forum or Topic to Your Watch List"


	
Section 60.2.4.2, "Removing a Discussion Forum or Topic from a Watch List"


	
Section 60.2.4.3, "Viewing Watched Forums and Topics from the Quick View"






60.2.4.1 Adding a Discussion Forum or Topic to Your Watch List

To add a discussion forum or topic to your watch list:

	
Go to the discussion forum or topic you want to add to your watch list.


	
The next step depends on whether you want to watch a forum or a topic:

	
To watch a forum, click the Watch Forum link at the top of the forum (Figure 60-43).


Figure 60-43 Watch Forum Link on the May - June Service Requests Forum

[image: Watch Forum link on the Futures discussion forum]



	
To watch a topic, click the Watch Topic link at the top of the topic (Figure 60-44).


Figure 60-44 Watch Topic Link on the Topic Dropped calls around Sacramento

[image: Watch Topic link on a discussion forum topic]








The watched forum or topic is listed on all Watched Forums or Watched Topics lists, for example, on the Discussions panel in the quick view (Figure 60-45) and in Watched Forums and Watched Topics task flows.


Figure 60-45 Watched Forums on the Discussions Panel in the Quick View

[image: Watched Forums on Discussions Panel in Quick View]

Description of "Figure 60-45 Watched Forums on the Discussions Panel in the Quick View"









60.2.4.2 Removing a Discussion Forum or Topic from a Watch List

To remove a discussion forum or a discussion topic from your watch list:

	
Go to the discussion forum or topic you want to remove from your watch list.


	
Click the Remove Watch icon on the forum or topic (Figure 60-46).


Figure 60-46 The Remove Watch Icon

[image: Watched icon]

Description of "Figure 60-46 The Remove Watch Icon"





The selected item is removed from your forum or topic watch list.









60.2.4.3 Viewing Watched Forums and Topics from the Quick View

To view a watched forum or topic from the Quick View:

	
From the Forums - Quick View task flow, set the panel display option to Watched Forums or Watched Topics (Figure 60-47).


Figure 60-47 Watched Forums on the Forums - Quick View

[image: Watched forums in the WebCenter Spaces Sidebar]

Description of "Figure 60-47 Watched Forums on the Forums - Quick View"





	
Click the link to the discussion forum or forum topic you want to view.

The forum or topic opens (Figure 60-48).


Figure 60-48 A Watched Forum Opened from the Quick View

[image: Watched forum opened from Sidebar]

Description of "Figure 60-48 A Watched Forum Opened from the Quick View"














60.2.5 Sending Mail from Discussion Topics

Each discussion topic in has an associated Send Mail icon in its toolbar (Figure 60-49). Click the Send Mail icon to initiate a mail message containing the discussion text, location, author, and date it was created. This feature makes it easy for you to communicate interesting discussions to others.


Figure 60-49 Send Mail Icons on Discussion Topics

[image: Send Mail icons on discussion topics toolbars]



The WebCenter Portal administrator determines the mail client to use with the Send Mail icon. If a local mail client was set, then a plain text message opens. If WebCenter Portal's Mail service was set as the mail client, then the HTML Mail Compose dialog opens. With either mail client, you can add or edit the standard, perpetuated message before sending.






60.2.6 Creating a Discussion Forum

Create discussion forums on the Discussions page or with the Discussion Forums task flow.

To create forums, you must be the space moderator.




	
Note:

A new space is assigned a single discussion forum by default. Space moderators can allocate multiple forums to a space if required, as described in Section 6.2, "Configuring Discussion Forum Options for the Spaces Application."







To create a discussion forum:

	
Go to the Discussions page. If multiple forums have been enabled, then you see a Forums link pointing to the default forum (Figure 60-50).


Figure 60-50 Discussions Page with Multiple Forums Enabled

[image: Discussions page with multiple forums]



	
Click the Forum link, and then the Create Forum button (Figure 60-51).


Figure 60-51 Create Forum

[image: Create Forum button]



The Create Forum dialog opens (Figure 60-52).


Figure 60-52 The Create Forum Dialog

[image: Create Forum dialog]



	
In the Forum Name field, enter a name for the discussion forum.

Enter up to 255 characters.


	
Optionally, in the Forum Description text box, enter a description of the discussion forum.

Enter up to 4000 characters.


	
Click Create.

The new forum appears on the list of forums (Figure 60-53). Click a forum name to view forum content.


Figure 60-53 New Discussion Forum (May Service Requests)

[image: New discussion forum (Picture This)]

Description of "Figure 60-53 New Discussion Forum (May Service Requests)"












60.2.7 Editing the Forum Name and Description

To rename a discussion forum or revise its description:

	
Go to the Discussions page or the Discussions Forums task flow, and click the forum you want to edit (Figure 60-54).


Figure 60-54 Edit Forum Link

[image: Edit Forum button]



The Edit Forum dialog opens (Figure 60-55).


Figure 60-55 The Edit Forum Dialog

[image: Edit Forum dialog]



	
Optionally, in the Forum Name field enter a new name for the discussion forum.

Enter up to 255 characters.


	
Optionally, in the Forum Description text box, revise the description of the discussion forum.

Enter up to 4000 characters.


	
Click Save.











60.3 Setting Discussions Service Task Flow Properties

The Discussions service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 60-56).


Figure 60-56 Discussion Forums Task Flow Component Properties

[image: Discussion Forum Manager component properties]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Discussions service task flows and describe the properties on the Parameters tab.

	
Section 60.3.1, "What You Should Know About the Discussions Service Task Flow Properties"


	
Section 60.3.2, "Discussions Service Task Flow Parameters"






60.3.1 What You Should Know About the Discussions Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 60.3.2, "Discussions Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














60.3.2 Discussions Service Task Flow Parameters

Table 60-1 describes the properties that are unique to the Discussions task flows.


Table 60-1 Discussions Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Category ID

	
On the discussions server, the category ID under which a given set of forums is managed

For the Forums task flow, use this parameter to specify the set of forums to present. For all other discussions task flows, use this parameter to specify the parent ID of the topics to show by default.

If omitted, the value defaults to the Category ID associated with the current space. In Home spaces, it takes the root Category ID.

Use the following EL expression to return the Category ID of a named space:


#{sessionContext['oracle.webcenter.collab.forum'].groupInfo['SpaceName'].categoryId}


Enter the space internal name (not the space display name) for the variable SpaceName. The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the space banner at the top of the space.

	
	
Discussion Forums


	
Forums - Quick View


	
Popular Topics


	
Recent Topics


	
Watched Forums


	
Watched Topics





	
Forum ID

	
On the discussions server, the identifier under which topics are managed

Use this parameter to identify the default forum to show in the task flow.

Use the following EL expression to return the forum ID of a named space:


#{sessionContext['oracle.webcenter.collab.forum'].groupInfo['SpaceName'].forumId}


Enter the space internal name (not the space display name) for the variable SpaceName. The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the space banner at the top of the space.

	
	
Discussion Forums


	
Popular Topics


	
Recent Topics


	
Watched Topics





	
Hide Toolbar

	
A means of showing or hiding the task flow personalization feature (see Section 60.2.3, "Showing and Hiding Additional Discussion Forum Information")

	
If selected, then the task flow personalization feature is hiden.


	
If not selected, then the task flow personalization feature is shown. This is the default value.




	
	
Popular Topics


	
Recent Topics


	
Watched Forums


	
Watched Topics





	
Show Recursive Forums

	
Determines if you show forums either in a category only or in subcategories.

	
If selected, then all forums under a given category/subcategory are shown. This can impact performance.


	
If not selected, then only the category's direct child forums are shown. This is the default value.




	
Forums


	
Show Categories

	
A means of showing the forums grouped under the Category ID or the topics specified under the Forum ID.

	
If selected, then the task flow displays the forums classified under Category ID.


	
If not selected, then the task flow displays the topics associated with the specified Forum ID. This is the default value.




This parameter value works in combination with other parameters.

	
Forums


	
Do Not Allow Selecting Number of Topics Fetched

	
If selected, then users are not allowed to change the number of visible topics.

	
Discussion Forums


	
Number of Topics Fetched

	
Sets the number of visible topics.

	
	
Discussion Forums


	
Forums - Quick View





	
Number of Recent Topics Fetched

	
Sets the number of visible recent topics.

	
Recent Topics


	
Number of Watched Forums Fetched

	
Sets the number of visible watched forums.

	
Watched Forums


	
Number of Watched Topics Fetched

	
Sets the number of visible watched topics.

	
Watched Topics


	
Do Not Show More Link

	
If selected, then the More link (to see more topics or forums) is not visible.

	
	
Forums - Quick View


	
Recent Topics


	
Watched Forums


	
Watched Topics




















61 Working with the Events Service

The Events service provides calendars that you can use in Oracle WebCenter Portal: Spaces to schedule meetings, appointments, and any other type of occasion. A dedicated Events page is available to every space where the space moderator has enabled the Events service.

The Events service also enables you to view your own personal Microsoft Exchange calendar within the Home space. In addition, you can overlay space calendars on top of the Home space calendar, so that you can view your entire schedule in a single place.




	
Framework applications:

The Events service is also available in applications built using Oracle WebCenter Portal: Framework to provide access to users' personal calendars.







This chapter explores the features offered through the Events service. It contains the following sections:

	
Section 61.1, "What You Should Know About the Events Service"


	
Section 61.2, "Working with Events Service Task Flows"


	
Section 61.3, "Setting Events Service Task Flow Properties"





Audience

This chapter is intended for Spaces users who want to use the Events service to schedule and track events. Users with a space role that includes the permissions Create, Edit, and Delete Events or Create Events (for event-related tasks), Edit Pages (to add the Events task flow to a page), and Edit Task Flows (to enable calendar overlays). For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the Events service is not enabled in the current space.









61.1 What You Should Know About the Events Service

Events include appointments, meetings, presentations, and so on. Within Spaces, there are two kinds of events:

	
Personal events are those that are not related to a specific space. They could include personal appointments with a doctor or dentist, or lunch with a friend.

Personal events come from your Microsoft Exchange calendar and display only to you and only in Events task flows that are located on pages in the Home space.




	
Framework applications:

Personal events are also available in Framework applications.








	
Space events are those that are related to a specific space. They could include weekly meetings, presentations, or a customer visit.

Space events display to all members of the space on the space's dedicated Events page or in any Events task flow that is located on a page in the space. Members with the required level of permission can schedule or update events.




	
Framework applications:

Space events are not available in Framework applications.










	
Note:

If your application uses WebCenter Portal's default user roles, then the required permissions to create an event are included in both the participant and moderator roles. Participants and Moderators can manage all events.












61.1.1 Calendar Overlaying

In addition to displaying your personal events in the Events task flow in the Home space, you can also display space events from select spaces in the same task flows. This is referred to as calendar overlaying. In this way, you can have all your important events available in one location, the Home space, rather than having to go to multiple spaces to manage your daily schedule.

In a space, if you can create a page and add an Events task flow to it, you can also extend that task flow to display events from other spaces. This is useful if some spaces are very closely connected with similar membership lists.




	
Note:

Calendar overlaying is available only in Events task flows. A space's Events page displays events from the current space only.












61.1.2 Where to View Events

Your application may provide a variety of locations from which to view events.

	
Every space in which the Events service is enabled includes an Events page (a special page containing an Events task flow) that can be displayed or hidden. If you cannot see the Events page, it could be hidden.




	
See Also:

For information about how to show the Events page, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
If you have the appropriate permissions, you can add an Events task flow to any page in a space (Figure 61-1).


Figure 61-1 An Events Task Flow on a Space Page

[image: Events task flow]



	
You can also add the Events task flow to a page in the Home space. In the Home space, the task flow does not initially display the calendar of events. Instead it displays a link prompting you to Login to Personal Calendar (Figure 61-2).


Figure 61-2 Events Task Flow in Home Space Before Logging In

[image: Events task flow before logging into personal calendar]






	
See Also:

For information about logging in to your Microsoft Exchange calendar, see Section 61.2.2, "Accessing Your Personal Events."







If you do not have a Microsoft Exchange calendar, or do not want to display personal events, but still want to view space events in the Home space, enable calendar overlaying and then click Continue (Figure 61-3).


Figure 61-3 Events Task Flow in Home Space with Calendar Overlay Enabled

[image: Before log into personal calendar with overlay enabled]

Description of "Figure 61-3 Events Task Flow in Home Space with Calendar Overlay Enabled"








	
See Also:

For information about calendar overlaying, see Section 61.2.7, "Displaying Multiple Calendars in a Single Task Flow."















61.1.3 Integration with Other Services

Through its tight integration with the Links service, the Events service provides the opportunity to associate events with other Spaces items. Linking enables you to associate documents, notes, announcements, discussions, and URLs with an event. You can create links from an event by editing the event and clicking the Links icon. For more information, see Chapter 63, "Working with the Links Service."

The Events service also enables you to send email messages about space events to members of the space. You can send mail from an event by editing the event and clicking the Send Mail icon. For more information, see Chapter 6, "Configuring Send Mail Notifications for the Spaces Application."

You can subscribe to a space's events to receive notifications when events in the








61.2 Working with Events Service Task Flows

Meetings are a fact of life. The art is in keeping on top of all those meetings, making sure you can attend the ones that matter and keep abreast of what is going on.

The Events service provides two task flows for displaying personal and space events:

	
The Events task flow provides a fully featured calendar where as well as viewing events in a variety of layouts, you can also create and manage events and display events from multiple calendars.


	
The Events - Mini View task flow provides a more compact view of events as a list. You can view upcoming events and edit existing events. You cannot create new events in this task flow. This is useful if you want to provide information about events but do not have enough space on the page for a full calendar.







	
Note:

The steps in the following sections apply to both personal events and space events. Where there are any differences, these are noted.







This section includes the following subsections:

	
Section 61.2.1, "Adding an Events Service Task Flow to a Page"


	
Section 61.2.2, "Accessing Your Personal Events"


	
Section 61.2.3, "Viewing Events"


	
Section 61.2.4, "Scheduling Events"


	
Section 61.2.5, "Revising Scheduled Events"


	
Section 61.2.6, "Cancelling Scheduled Events"


	
Section 61.2.7, "Displaying Multiple Calendars in a Single Task Flow"


	
Section 61.2.8, "Subscribing to Events"






61.2.1 Adding an Events Service Task Flow to a Page

For the steps to add an Events service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Tip:

The presence or location of the Events service task flows depends on how the Resource Catalog is configured. In the default Resource Catalog, the Events task flows are listed under Social and Communication.










	
See Also:

For information about setting task flow properties, see Section 61.3, "Setting Events Service Task Flow Properties."












61.2.2 Accessing Your Personal Events

You may maintain a calendar of personal events outside of Spaces that does not relate to specific spaces. If you use Microsoft Exchange 2003 or 2007 for this calendar, you can include your personal events in the Home space. This keeps all your calendar information in a single place, making it much easier for you to organize your day.

You can view personal events in the Home space. You can also edit or delete personal events or create new personal events that are pushed to your Exchange calendar.




	
Note:

You can use calendar overlaying to display space events alongside personal events in the Home space, but you cannot push space events into your Exchange calendar.
For more information about calendar overlaying, see Section 61.2.7, "Displaying Multiple Calendars in a Single Task Flow."










Before You Begin

Before you can access your personal events in Spaces, your administrator must have created a connection to the Microsoft Exchange Server. For more information, see the "Managing the Events Service" chapter in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

To access your personal events:

	
In the Home space, locate the page where you want to add your personal events.


	
Add the Events task flow to the appropriate region on the page.




	
See Also:

For more detailed information, see Section 17.5, "Adding Resource Catalog Components to Pages."








	
In the Events task flow, click Login to Personal Calendar.




	
Note:

If you see the link Try Again instead of Login to Personal Calendar, there is a problem with the connection to the Microsoft Exchange Server. Contact your administrator.








	
Enter your Microsoft Exchange login credentials and click OK.


Figure 61-4 Personal Calendar

[image: A personal calendar]










61.2.3 Viewing Events

You can view events as a grid or a list; choose to display events a day, a week, or a month at a time; filter events by category; select the range of hours displayed per day; and include a second time zone in the display.

This section includes the following subsections:

	
Section 61.2.3.1, "Displaying the Events Page for a Space"


	
Section 61.2.3.2, "Using the Calendar Interface"


	
Section 61.2.3.3, "Viewing Event Details"


	
Section 61.2.3.4, "Filtering Events by Category"


	
Section 61.2.3.5, "Setting Display Preferences"






61.2.3.1 Displaying the Events Page for a Space

In every space where the Events service is available, space events display on the Events page. However, the Events page may not display by default. If so, it is easy to display the Events page using the Manage Pages dialog.




	
Note:

The Home space does not have an Events page.







To display the Events page:

	
Go to the space where you want to display the Events page.


	
In the space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.4, "User Interface URLs for Space Pages."










	
Select the Show Page checkbox for the Events page. (Figure 61-5).


Figure 61-5 Showing the Events Page through the Pages Page

[image: Manage Pages dialog box]



If you later decide that you no longer want to display the Events page, in the Pages page, deselect the Show Page checkbox for the Events page.









61.2.3.2 Using the Calendar Interface

You can use icons on the Events page or Events task flow toolbar to display events in grid form or as a list. When you display events as a grid, you can show them by day, week, or month. When you display events as a list, the number of upcoming events listed depends on the display options for the task flow.




	
See Also:

For information about changing List view display options, see Section 61.2.3.5, "Setting Display Preferences."







Usually, in grid mode, the Events page or Events task flow displays events for the current day, week, or month. To view events for a specific point in time, you can use the previous or next icons or select a date so that the calendar displays events for a specific date.

Table 61-1 lists the different icons available in the Events page and Events task flow toolbar and describes what they do.




	
Note:

The following options are not available in the Events - Mini View task flow.








Table 61-1 Calendar Icons

	Icon	Description
	[image: Previous icon]
	
Click to display the previous day's, week's, month's, or set of events.


	[image: Next icon]
	
Click to display next day's, week's, month's, or set of events.


	[image: Today button]
	
Click to display events for the current date (today).


	[image: Select Date icon]
	
Click to display events for a specific date.

In the date picker, the current date (today) is displayed in a box and the currently selected date (which may also be the current date), is highlighted. Use the date picker to select the month, year, and day.

Note: If the calendar overlay feature is enabled in Full mode for the task flow, the Date Picker is always visible to the left of the calendar.


	[image: Day icon]
	
Click to display events one day at a time.


	[image: Week icon]
	
Click to display events for the whole week.


	[image: Month icon]
	
Click to display events for the whole month.


	[image: List icon]
	
Click to display a list of upcoming events. The number of events listed depends on the task flow settings (for more information, see Section 61.2.3.5, "Setting Display Preferences").


	
[image: Event filter category pick list]


	
Select one or more event categories by which to filter the events in the calendar. Only events belonging to the selected categories are displayed in the calendar (or more information, see Section 61.2.3.4, "Filtering Events by Category").


	[image: Refresh icon]
	
Click to refresh the page or task flow with any recent changes.












61.2.3.3 Viewing Event Details

The Events page or Events task flow displays basic information about events. To view more information, such as the location, start and end times, priority, category, or links, simply hover your mouse over an event.

To view event details:

	
Go to the Events task flow, Events - Mini View task flow, or Events page where you want to view event details.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Hover the mouse over an event to display the event details.

The resulting popup (Figure 61-6), displays the following information:

	
The title of the event


	
Details of the date and time of the event, including the secondary time zone if one has been specified


	
The priority of the event


	
The category to which the event belongs


	
The location of the event, if specified


	
Any links associated with the event





Figure 61-6 An Event with Details Popup

[image: An event on the Events page]



To view any specific details of the event you must edit the event. For more information, see Section 61.2.5, "Revising Scheduled Events."









61.2.3.4 Filtering Events by Category

You can filter the events displayed in the calendar to those that belong to one or more particular categories, for example Team Meeting, Customer Meeting, Vacation, and so on.




	
See Also:

Event categories are created by the space moderator in the space administration settings. For more information, see Section 51.10.6, "Creating and Managing Space Event Categories." After they are created, you can use them to assign categories to your events, which enables you to then filter events by category.







To filter events by category:

	
Go to the Events task flow or Events page where you want to filter events.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."










	
Note:

You cannot filter events in the Events - Mini View task flow.








	
In the toolbar, from the View dropdown list (Figure 61-7), select one or more categories by which you want to filter the events displayed in the calendar.


Figure 61-7 The View Dropdown List for Filtering by Event Category

[image: Description of Figure 61-7 follows]

Description of "Figure 61-7 The View Dropdown List for Filtering by Event Category"





When you close the dropdown list, only those events that belong to the selected category or categories are displayed in the calendar.




	
Tip:

To remove event filtering, deselect any categories in the Filter Category dropdown list.















61.2.3.5 Setting Display Preferences

Events service display preferences:

	
Determine the earliest time displayed on the calendar when events are viewed by day or week.


	
Identify a secondary time zone.


	
Specify how to display events in List view: by day, week, month, or for a specified number of days.




To set these preferences, click the Set Event Preferences icon (Figure 61-8) to access the Display Preferences dialog (Figure 61-9).


Figure 61-8 The Set Event Preferences Icon

[image: Set Event Preferences icon]




Figure 61-9 The Events Display Preferences Dialog

[image: The Display Preferences dialog for the Events service]






	
Note:

The Set Event Preferences icon, and therefore the Display Preferences dialog, is not available in the Events - Mini View task flow.







This section includes the following subsections:

	
Section 61.2.3.5.1, "Setting the Calendar Start Time"


	
Section 61.2.3.5.2, "Setting a Secondary Time Zone"


	
Section 61.2.3.5.3, "Configuring List View"






61.2.3.5.1 Setting the Calendar Start Time

In Day and Week view, the calendar grid is divided into hours. If vertical space for your calendar is limited, you can specify the earliest hour to display on the calendar grid to save space. If the space available is big enough to display hours from before the specified start time up until 11PM, it does so.

To set the calendar start time:

	
Go to the Events task flow or Events page where you want to set the calendar start time.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Click the Set Event Preferences icon on the toolbar (Figure 61-8).


	
In the Display Preferences dialog (Figure 61-9), from the Start Time dropdown list, select the earliest hour to display on the grid.

Choose from 12AM to 11PM.


	
Click OK to save your changes.









61.2.3.5.2 Setting a Secondary Time Zone

In these days of distributed workforces, it is not unusual to be working in teams with members in different locations. When scheduling meetings, it is useful to know the hours most optimal to all invitees. To make this easier, you can specify a secondary time zone to see what time a meeting is in that time zone as well as your own.

When you hover your mouse over an event, the event details popup shows the time of the meeting in your time zone and in the secondary time zone (Figure 61-10).


Figure 61-10 An Event Details Popup Displaying Primary and Secondary Time Zones

[image: Primary and secondary time zones]



To set a secondary time zone:

	
Go to the Events task flow or Events page where you want to set a secondary time zone.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Click the Set Event Preferences icon on the toolbar (Figure 61-8).


	
In the Display Preferences dialog (Figure 61-9), from the Secondary Time Zone dropdown list select a secondary time zone to display along with the primary time zone.


	
Click OK to save your changes.









61.2.3.5.3 Configuring List View

You can specify how you want to display events, when the calendar is displayed in List view. You can display events by day, week, month, or for a specified number of days.

To configure List view:

	
Go to the Events task flow or Events page where you want to configure List view.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Click the Set Event Preferences icon on the toolbar (Figure 61-8).


	
In the Display Preferences dialog (Figure 61-9), from the List Type list, choose how you want to display events in List view:

	
Day Count—List all upcoming events for a specified number of days.


	
Day—List all upcoming events for the currently selected day.


	
Week—List all upcoming events for the currently selected week.


	
Month—List all upcoming events for the currently selected month.





	
If you selected Day Count in the previous step, in the List Count field, specify the number of days for which you want to display events. The default is 14.


	
Click OK to save your changes.













61.2.4 Scheduling Events

You can schedule space events and personal events. When you schedule a personal event, the details are pushed to your Microsoft Exchange calendar.




	
Note:

You cannot schedule new events in the Events - Mini View task flow.







To schedule an event:

	
Go to the Events task flow or Events page where you want to schedule the event.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Click the Create a new event icon on the toolbar (Figure 61-11).


Figure 61-11 The Create a New Event Icon

[image: Create a new event icon]



The Create Event dialog opens (Figure 61-12). The fields in the Create Event dialog are slightly different depending on whether you are creating a personal event or a space event. These differences are pointed out later in this procedure.




	
Note:

You can also easily invoke the Create Event dialog in grid view by double-clicking an empty space or right-clicking an empty space and choosing Create. The advantage of this is that the date and time of the event are automatically specified in the dialog.








Figure 61-12 The Create Event Dialog Invoked from a Space

[image: Create Event dialog box]

Description of "Figure 61-12 The Create Event Dialog Invoked from a Space"





	
In the Title field, enter a brief descriptive title for the event.

For example, Project Update.


	
In the Location field, enter the location of the event.

For example, Conference Room 5.


	
From the Calendar dropdown list, select the calendar against which you want to create the event.




	
Note:

The Calendar dropdown list is available only when the calendar overlay feature is enabled and at least one other calendar is displayed in the task flow.
The Calendar dropdown list is not available for events created from the Events page (where calendar overlaying is not available).

For more information about calendar overlaying, see Section 61.2.7, "Displaying Multiple Calendars in a Single Task Flow."










	
Select All Day Event to block out the entire day for the event.

All day events can span multiple days. In Day and Week view mode, all day events are displayed in a separate area at the top of the calendar. In Month view, all day events are displayed surrounded by a block of color.


	
In the Start Time field enter a date and time to start the event.




	
Tip:

You can click the Select Date and Time icon and select a start time from the Date Picker, if you prefer.







For all day events, you specify the date only.


	
In the End Time field enter a date and time to finish the event.




	
Tip:

You can click the Select Date and Time icon and select an end time from the Date Picker, if you prefer.







For all day events, you specify the date only.


	
(Optional) From the Priority dropdown list, select a priority for the event: Highest, High, Normal, Low, or Lowest.

The priority of an event determines where it appears when events clash. An event with Highest priority is displayed first. The event priority is also displayed in the event popup when a user hovers the mouse over the event.


	
(Optional) From the Category dropdown list, select a category to classify this event.

Categories are useful for creating distinct groups of events, organized according to their general purpose.

The event category is displayed in the event popup when a user hovers the mouse over the event. You can display events in different categories in different colors.




	
See Also:

For information about how to create and manage categories, see Section 51.10.6, "Creating and Managing Space Event Categories."







You can also filter a calendar to display events belonging to a specific category.




	
See Also:

For more information, see Section 61.2.3.4, "Filtering Events by Category."










	
Note:

The Category dropdown list is available only for space events.








	
(Optional) In the Details field, enter any additional details you want to include, up to a maximum of 4000 characters.

For example, you might want to describe the purpose of the meeting, provide a brief agenda, or indicate if attendees need to prepare anything for the meeting.




	
Note:

The details that you enter here are available only when editing the event, they do not display in the event popup when users hover over the event. You should not assume that all users will read these details. Important details about the meeting should be communicated in a different way, for example, through the meeting notification email or by using an announcement.








	
(Optional) Select Private if you do not want other users to be able to view your personal events.

If the Events task flow is included on page in the Home space that you have made available to other users, those users are not able to see the event.




	
Note:

The Private checkbox is available only for personal events.








	
Click Create to add the event to the calendar (Figure 61-13).


Figure 61-13 An Event in Day View

[image: An event on the Events page]










61.2.5 Revising Scheduled Events

You may want to change some aspect of an event; for example, it may become necessary to change the time to accommodate a particular attendee, or the location may become unavailable.

To revise a scheduled event:

	
Go to the Events task flow, Events - Mini View task flow, or Events page where you want to revise a scheduled event.




	
Tip:

If the Events page is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Click the event to open the Edit Event dialog (Figure 61-14).




	
Tip:

In the Events task flow or Events page, you can also access the Edit Event dialog by right-clicking an event and choosing Edit, or by moving the mouse pointer (or using the Tab key) to highlight an event and pressing Enter.








Figure 61-14 The Edit Event Dialog Invoked from a Space

[image: Edit Event dialog box]

Description of "Figure 61-14 The Edit Event Dialog Invoked from a Space"





	
Revise the event details.

For information about the different options available in the dialog, see Section 61.2.4, "Scheduling Events."




	
See Also:

For information about using the Send Mail feature, see Chapter 65, "Working with the Mail Service."
For information about creating links to other objects, see Chapter 63, "Working with the Links Service."










	
Click Update to save your changes.









61.2.6 Cancelling Scheduled Events

To cancel an event, you delete it from the Events page or task flow.

To cancel a scheduled event:

	
Go to the Events task flow or Events page where you want to cancel a scheduled event.




	
Tip:

If the Events tab is not available, see Section 61.2.3.1, "Displaying the Events Page for a Space."








	
Right-click the event and choose Delete (Figure 61-15).


Figure 61-15 Deleting an Event

[image: The Delete command]






	
Tip:

You can also delete an event by hovering your mouse over the event and pressing the Delete key or, in the Edit Event dialog, by clicking Delete.
To delete an event from the Events - Mini View task flow, you must go through the Edit Event dialog.










	
Click Delete in the Delete Confirmation dialog.

The event is removed from the calendar.









61.2.7 Displaying Multiple Calendars in a Single Task Flow

Within Spaces, you may be a member of several spaces. Each of those spaces may have its own calendar of events. In addition to that, you may also have your own calendar where you track those events that concern only yourself. At the start of each day, it is not practical to have to view each of these calendars individually to determine your schedule for the day.

To solve this issue, the Events service enables you to view multiple calendars in a single Events task flow. This is called calendar overlaying. You can do this in the Home space so that you can also include your personal appointments. You can also overlay calendars in an Events task flow on a space page.




	
Note:

The events from each calendar are displayed in a different color to help identify the source of the event.
If you are overlaying calendars on a space page, category colors are used only for events from the current space. All events from overlaid calendars are displayed in the color defined for that calendar, regardless of their category.









For example, you might have a sales event that involves your Marketing, Sales, and Facilities departments. You want to create a calendar that includes events and tasks for all the departments so that each group has a clear picture of the overall plan.

To create the All Events calendar:

	
Create a space called All Events.


	
Add events to the calendars for the Marketing, Sales, and Facilities spaces.


	
Add the Events task flow to a page in the All Events space, overlaying the calendars from the Marketing, Sales, and Facilities spaces.







	
Note:

Calendar overlaying is available only in Events task flows. It is not available in Events - Mini View task flows or in the Events page.







This section includes the following subsections:

	
Section 61.2.7.1, "Enabling Calendar Overlaying"


	
Section 61.2.7.2, "Displaying Additional Calendars"


	
Section 61.2.7.3, "Editing Calendar Display Options"






61.2.7.1 Enabling Calendar Overlaying

To display additional calendars in the Events task flow, you must first enable the calendar overlaying feature for the task flow.

To enable calendar overlaying:

	
Go to the Home space or the appropriate space and locate the page that contains the Events task flow.

If you have not yet added the Events task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."


	
Open the page in edit mode (Composer), for example, by pressing Ctrl+Shift+E.


	
Click the Edit icon (wrench) for the Events task flow.




	
Note:

If you are working in a space, you may not have the appropriate permissions to edit the task flow. To enable calendar overlaying, contact the space moderator.








	
In the Component Properties: Events dialog, click the Parameters tab (Figure 61-16).


	
From the Calendar Overlay Style dropdown list, choose:

	
None if you do not want to use calendar overlays.


	
Mini to use a compact view of the calendar overlay. This takes up less space on the page, but it might not be immediately obvious how to work with the overlays. Use this option if space is very limited on the page, or when your users have become familiar with calendar overlays and how to use them. Mini style is available only with Day and List view, not Week or Month.


	
Full to use a detailed calendar overlay. Use this option if space is not an issue on the page and to provide a richer user interface.





Figure 61-16 The Calendar Overlay Style Events Service Property

[image: Events properties, Calendar Overlay Style]



	
Click OK to save your changes and exit the Component Properties dialog.


	
Click Save at the top right of Composer to save your changes.


	
Click Close at the top right to exit Composer.

The Events task flow now includes an area to the left of the calendar where you can choose other calendars to display in the task flow.

If you selected the Full option for the Calendar Overlay Style, the calendar overlay area includes text as well as icons and also includes a date picker to help you easily move around your calendar (Figure 61-17).


Figure 61-17 Events Task Flow with Full Calendar Overlay Area

[image: Events task flow with full calendar overlay style]



If you selected the Mini option for the Calendar Overlay Style, the calendar overlay area is much smaller, displaying icons only and no date picker (Figure 61-18).


Figure 61-18 Events Task Flow with Mini Calendar Overlay Area

[image: Events task flow with mini calendar overlay style]






	
Note:

If you have not yet set up and logged in to your personal calendar, click the Continue link to display the calendar in the task flow. For information about how to set up your personal calendar, see Section 61.2.2, "Accessing Your Personal Events."















61.2.7.2 Displaying Additional Calendars

When the calendar overlaying feature is enabled, users can display as many calendars as they want in the Events task flow. Each calendar's events are displayed in a different color to make it easier to distinguish which calendar it belongs to.

To display additional calendars:

	
Go to the Home space or the appropriate space and locate the page that contains the Events task flow.


	
In the calendar overlay area of the Events task flow, click the Add Calendar icon (Figure 61-19).


Figure 61-19 The Add Calendar Icon

[image: Add Calendar icon]



	
In the Add Calendar dialog (Figure 61-20), select the space that provides the calendar that you want to display in the task flow.

You can select multiple spaces.


Figure 61-20 The Add Calendar Dialog

[image: Add Calendar dialog]



	
Click Add Calendar.

The calendar overlay area now includes the selected space and the calendar on the right includes events from that space. The events from each space are displayed in a different color.


Figure 61-21 The Events Task Flow Displaying Multiple Calendars

[image: Events task flow showing events for multiple calendars]










61.2.7.3 Editing Calendar Display Options

After adding a space's events to your calendar you can change various display options, including the order the calendar appears in the list and the color used to identify events from the calendar.

To edit calendar display options:

	
Go to the Home space or the appropriate space and locate the page that contains the Events task flow.


	
Click the arrow icon to the right of the space for which you want to edit display options. This displays the calendar overlay popup menu (Figure 61-22).


Figure 61-22 The Calendar Overlay Menu

[image: Calendar overlay menu]



	
From the popup menu, choose:

	
Visible to toggle the display of this space's events in the calendar.

You can also toggle the display of a space's events by clicking the space name (Full view only) or the colored square next to the space name.


	
Change display name to make the name in the list of spaces in Full view more meaningful to you than just the space name.


	
Remove Calendar to remove this space's calendar from the task flow.


	
Open Space to open the space associated with this calendar.


	
Move to Top/Move up/Move down/Move to Bottom to rearrange this space in the list.

The order in which the spaces are listed determines the order in which events are listed when events from multiple spaces occur in the same time slot. Events from the space at the top of the list are displayed first.


	
A color to change the color used for the events from this space.














61.2.8 Subscribing to Events

You can subscribe to receive notifications when events for a particular space are created, updated, or deleted.




	
See Also:

For information about how to subscribe to space events, see Section 36.3.2, "Setting Space-Level Subscriptions."







When you subscribe to a space's events, whenever an event is created, updated, or deleted in that space, a notification is sent to you. If the client to which that notification is sent supports iMIP (for example, Microsoft Outlook, Mozilla Thunderbird, Gmail, and so on), the notification email includes the ability to accept or decline the event, propose a new time for the event, and so on within the email.


Figure 61-23 Email Notification for a Space Event

[image: Description of Figure 61-23 follows]

Description of "Figure 61-23 Email Notification for a Space Event"





If you accept an event, it is added to your calendar in your email client.








61.3 Setting Events Service Task Flow Properties

The Events service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 61-24).


Figure 61-24 Events Service Task Flow Component Properties

[image: Component Properties dialog]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 61.3.1, "What You Should Know About the Events Service Task Flow Properties"


	
Section 61.3.2, "Events Task Flow Parameters"






61.3.1 What You Should Know About the Events Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 61.3.2, "Events Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














61.3.2 Events Task Flow Parameters

Table 61-2 describes the parameters that are unique to the Events task flow.


Table 61-2 Events Task Flow Parameters

	Parameter	Description
	
Calendar Overlay Style

	
Whether calendar overlay is enabled. Valid values are:

	
Empty (default): No calendar overlay


	
None: No calendar overlay


	
Mini: Calendar overlay is enabled in Mini mode, which takes up less screen space


	
Full: Calendar overlay is enabled in Full mode





	
Calendar Style Class

	
The name of the custom style class you want to apply to the calendar component.


	
Customization ID

	
A unique identifier for event view customization.

Customization ID assists with maintaining the association of this task flow instance with its customization and personalization settings. This value is set automatically. Do not edit this value.


	
Default Current Date

	
The default current date on the calendar. Valid values are:

	
Empty (default): The current date (that is, today's date)


	
Any date using the format mm/dd/yyyy





	
Disable Personalize and Customize

	
A checkbox to determine whether users can personalize or customize the task flow. If not selected, users can personalize and customize the task flow.


	
Group Space

	
The name of the space that is the source of listed events.

Valid values are:

	
Empty: Task flow displays events for the current space (that is, the space in which it is placed)


	
Any space display name: Task flow displays events for the named space




The space display name is available on the General page in the space administration settings.


	
Maximum Calendars

	
The maximum number of calendars that a user can add to the task flow.

When the maximum is reached, the Add Calendar icon no longer appears in the task flow.

Default value: 20


	
Maximum Enabled Calendars

	
The maximum number of calendars that a user can display simultaneously.

This value must not be greater than the value specified for Maximum Calendars.

Default value: The same value as that specified for Maximum Calendars












61.3.3 Events - Mini View Task Flow Parameters

Table 61-2 describes the parameters that are unique to the Events - Mini View task flow.


Table 61-3 Events - Mini View Task Flow Parameters

	Property	Description
	
Calendar Toolbox Layout

	
Custom calendar toolbox layout. The value is passed to the ADF calendar component as a toolboxLayout attribute.


	
Customization ID

	
A unique identifier for event view customization.

Customization ID assists with maintaining the association of this task flow instance with its customization and personalization settings. This value is set automatically. Do not edit this value.


	
Event Text Length

	
The maximum number of characters of the event title to display in Mini view.

Leave blank or enter 0 if you do not want the event title to be truncated.

Default value: 18


	
List Events in Number of Upcoming Days

	
The number of days for which to list upcoming events.

Default value: 30


	
Number of Events Per Page

	
The number of events to display at one time.

Default value: 5


	
Using ADF Calendar Component

	
A checkbox to select determine whether to use the ADF Calendar UI Component or a simple list with page flow.

















62 Working with the Instant Messaging and Presence Service (IMP)

This chapter describes how to use the features provided through the Instant Messaging and Presence (IMP) service. The IMP service lets you see the presence status of other authenticated application users. It provides instant access to interaction options, such as instant messages and mails. Additionally, if enterprise presence is unavailable, you can connect to a 3rd-party network presence service, such as Yahoo! Messenger.

This chapter includes the following sections:

	
Section 62.1, "What You Should Know About the IMP Service"


	
Section 62.2, "Identifying Your Preferred Instant Messaging Provider"


	
Section 62.4, "Working with IMP Service Features"





Audience

This chapter is intended for authenticated users who want to view, create, and manage instant messaging and presence. It also is intended for administrators in Spaces with the Application-Manage Configuration permission and individual space moderators who want to configure instant messaging and presence within their spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the IMP service is not enabled in the current space.









62.1 What You Should Know About the IMP Service

The IMP service enables you to observe the presence status of other authenticated users (online, offline, busy, or away) and provides instant access to interaction options, such as instant messages (IM) and mail. Any WebCenter Portal service that has a user name can integrate with the IMP service; for example, Discussions, Documents, or Mail. Wherever a user is indicated, for example as the author of a document in the document library, you can see an icon (Figure 62-1) depicting the presence state of that user.


Figure 62-1 The Presence Icon for Online Users

[image: Presence icon, online]



If you hover your mouse over the Presence icon, a tooltip displays the current status message for that user, if available. If the user has not provided a status message, or the message cannot be retrieved, then the tooltip displays the presence state of the user (online, offline, busy, or away).




	
Note:

There is no idle status. In the case of extended user inactivity, the status still displays as online.







Additionally, you can click the Presence icon to invoke a context menu (Figure 62-2).


Figure 62-2 The Presence Icon Context Menu

[image: Presence icon context menu]



From the context menu you can:

	
View the user's profile. For more information, see Section 30.5.1, "Viewing Profile Details."


	
Send mail to the user. For more information, see Section 62.4.2, "Sending a Mail Message from the Presence Icon Menu."


	
Change credentials, which works as an alternative to using an external application.


	
Send an instant message to the user. For more information, see Section 62.4.3, "Sending an Instant Message from the Presence Icon Menu."







	
Note:

The options that display on the context menu depend on what services are available to your application, how those services are configured, and which services are supported by the back-end presence server.












62.2 Identifying Your Preferred Instant Messaging Provider

The IMP service requires a back-end presence server. WebCenter Portal is certified with Microsoft Office Live Communications Server (LCS) 2005, Microsoft Office Communications Server (OCS) 2007, and Microsoft Lync 2010. When presence is not available (for example, if your enterprise uses a Jabber/XMPP presence server or has federated presence servers with users distributed across identity management systems), you can connect to a public network presence service.

Out-of-the-box, WebCenter Portal supports Yahoo! Messenger on network presence. However, the network presence model can be extended to include other providers, such as ICQ. To do so, you must build a presence network agent (PNA) that understands how to process each user's presence from a certain URL.

To enable network presence:

	
Click the Preferences link at the top of the application.


	
Click Presence to open the Presence Preferences pane.


	
Enter the IM address for the presence status and a display name (Figure 62-3).




	
Note:

PNAs run on the IM address. The IMP service consults all registered PNAs to see if one can handle this IM address. If so, then it delegates to the respective agent. If you register a new PNA where you identify every user presence with the domain mydomain.com, then your PNA handles the presence for user IM addresses like XYZ@mydomain.com.








Figure 62-3 The Presence Preferences Pane

[image: Presence Preferences panel in Preferences dialog]



	
Click OK to save your change and exit the Preferences dialog.




Presence tags for that user shows their network presence, either online (Figure 62-4) or offline (Figure 62-5).


Figure 62-4 Yahoo Presence Icon - Online

[image: Description of Figure 62-4 follows]

Description of "Figure 62-4 Yahoo Presence Icon - Online"






Figure 62-5 Yahoo Presence Icon - Offline

[image: Description of Figure 62-5 follows]

Description of "Figure 62-5 Yahoo Presence Icon - Offline"









62.3 Configuring Network Presence

To set your presence to Yahoo! Messenger:

	
Click the Preferences link at the top of the application.


	
Click Presence to open the Presence Preferences pane.


	
Enter your Yahoo! Messenger ID and a display name for yourself (Figure 62-3).


Figure 62-6 The Presence Preferences Pane

[image: Presence Preferences panel in Preferences dialog]



	
Click OK to save your change and exit the Preferences dialog.




To revert back to your enterprise presence, when you are back on your network, simply remove this information from Presence Preferences.




	
Note:

To send instant messages to an online user on Yahoo! Messenger, you also must have Yahoo! Messenger installed.












62.4 Working with IMP Service Features

Many task flows include a presence capability that enables you to make contact with other users from within the context of what you want to contact them about. For example, if you see a post in a discussion topic and want to contact the author of that post, you can do so directly from the Discussions task flow.

This section includes the following subsections:

	
Section 62.4.1, "Viewing the Status of Other Users"


	
Section 62.4.2, "Sending a Mail Message from the Presence Icon Menu"


	
Section 62.4.3, "Sending an Instant Message from the Presence Icon Menu"






62.4.1 Viewing the Status of Other Users

Many task flows support on-the-spot communication with other users. That is, wherever a task flow includes a Presence icon (Figure 62-1), you can start an instant chat or send a mail to the user associated with the icon.

The way you communicate with another user depends upon their availability. For example, if the user is online, then you could send an instant message to make immediate contact. However, if the user is offline or busy, then sending a mail is probably a better option.

Additionally, users can provide further information about their status by providing status messages. If such a status message exists for a user, hovering over the Presence icon displays that message as a tooltip. The status message enables you to make an even more informed decision about how to make contact. If there is no status message for the user, then the presence state is displayed in the tooltip instead (online, offline, busy, or away).

To view the current presence status or status message of a user, simply hover the mouse over the Presence icon next to the user's name.




	
Note:

The presence state of the user is held in a cache with a default expiry time of 60 seconds. As a result, the Presence icon may not reflect the actual status of the user if the status has changed between the initial retrieval and the cache expiry time.







Table 62-1 describes the presence state each Presence icon indicates.


Table 62-1 Presence Icon Presence States

	Presence Icon	State
	
[image: Green circle; user is available]


	
Associated user is online.


	
[image: Red circle with thick white line (no entry); user is busy]


	
Associated user is online, but busy. Please do not disturb.


	
[image: Clock; user is away]


	
Associated user is still connected but away from the computer.


	
[image: Greyed out icon with cross; user is offline]


	
Associated user is offline.












62.4.2 Sending a Mail Message from the Presence Icon Menu

Wherever you see a Presence icon, you can send a mail message to its associated user.

To send a mail message:

	
Locate a Presence icon (Figure 62-1) for the person you want to contact.

For example, you can find Presence icons associated with documents and discussion topics, and anywhere a task flow is configured to support IMP.


	
Click the Presence icon associated with the user you want to contact. The available options pop up, as in Figure 62-7.


Figure 62-7 The Presence Icon

[image: Presence icon associated with user monty]



	
From the menu, choose Send Mail.

You may be presented with a login window. If so, then enter your user name and password for your mail application. If your preferences are set up to deliver your login credentials automatically, you can start your message right away. For more information about login credentials and preferences, see Chapter 35, "Setting Your Personal Preferences."


	
Compose your message and click Send.









62.4.3 Sending an Instant Message from the Presence Icon Menu

Wherever you see a Presence icon, you can send an instant message to its associated user.

Before you can send an instant message, you must install the appropriate chat client (and only that client) on your local computer. The client must be configured to connect to the back-end presence server. To use Microsoft Live Communications Server (LCS) 2005, Microsoft Office Communications Server (OCS) 2007, or Microsoft Lync 2010, install the Microsoft Communicator.

Contact your administrator if you are not sure which client to install or how to connect to the presence server.

To send an instant message:

	
Locate a Presence icon (Figure 62-1) for the person you want to contact.

For example, you can find Presence icons associated with documents and discussion topics, and anywhere a task flow is configured to support IMP.


	
Click the Presence icon associated with the user you want to contact. The available options pop up, as in Figure 62-8.


Figure 62-8 The Presence Icon Options

[image: Presence icon associated with user monty]



	
From the menu, choose Send Instant Message.

WebCenter Portal invokes your instant messaging client, and starts a chat session with the selected user.














63 Working with the Links Service

This chapter describes how to use the features provided through the Links service. The Links service provides a way to view, access, and associate related information.

This chapter includes the following sections:

	
Section 63.1, "What You Should Know About the Links Service"


	
Section 63.2, "Working with Links Service Features"





Audience

This chapter is intended for users who want to view, create, and manage links.

Such users must be granted, minimally, the space-level permission View Pages and Content to view links. They can view shared links only for resources for which they have view permission.

Authenticated users who plan to create and manage links require the space-level permission Customize Pages and Edit Content. They must have view permission on the resource. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the Links service is not enabled in the current space.









63.1 What You Should Know About the Links Service

Linking gives users a means of explicitly associating two objects with each other through easy-access reference points, called links. The Links service assists with setting up these links from one application object to another. For example, using links you can associate a project plan document with a list of project issues. When users access the list, they can also immediately access the project plan by clicking a link that appears on the list (Figure 63-1). This service also provides a quick way to create new objects when establishing a link.


Figure 63-1 A Link on a List Row

[image: Link on a list row]



Links are scoped to spaces. For example, the links that display in the Finance space differ from the links that display in the Infrastructure space, even though links are accessed from the same places in both spaces. The objects to which you can link also depend on which services have been enabled in your application.

Anywhere you see a Links icon, you can create a link to both new and existing content.

There are two Links icons that each indicate the state of the Links dialog:

	
The gray Links icon (Figure 63-2) indicates that no links are present in the Links dialog.


Figure 63-2 The Links Icon (No Links Present)

[image: Links icon]



	
The gold Links icon (Figure 63-3) indicates that links are present in the Links dialog.


Figure 63-3 The Links Icon (Links Present)

[image: Links icon (links present)]





Use the Link to Existing option in the Links dialog to link to existing application objects, such as documents, discussion forum topics, and announcements. For more information, see Section 63.2.1, "Linking to Existing Objects."

Use the Link to New option in the Links dialog to both create an application object and link to it in a single operation. Choose Link to New to upload and link to documents, create and link to discussion forum topics, enter the URL of a web page to link to, and create and link to other types of items. For more information, see Section 63.2.2, "Linking to New Objects."

You can create links from announcements, discussions, documents, events, lists, and pages.

The items you can link to differ between the Link to New and Link to Existing lists. For example, while you can link to a new note, you cannot link to an existing note. Additionally, the items you can link to from a Home space differ from those you can link to from a space. Table 63-1 lists the types of objects you can link to and from.


Table 63-1 Linking to Objects

	Object Type	Link to New Resource	Link to Existing Resource	Home Space	Space
	
Announcement

	
No

	
Yes

	
No

	
Yes


	
Discussion Topic

	
Yes

	
Yes

	
No

	
Yes


	
Document/Wiki

	
Yes

	
Yes

	
Yes

	
Yes


	
Event

	
Yes

	
Yes

	
No

	
Yes


	
Note

	
Yes

	
No

	
Yes

	
Yes


	
URL

	
Yes

	
No

	
Yes

	
Yes








Given the right permission, other users can see your links, and you can see other users' links. For most services, what you can do with a link (such as view, create, delete) is handled by your Links permission. However, with the Notes service, you can delete a link only if you also have delete permission on the Notes service. For more information on Links permission, see the section "Managing Application Roles and Permissions" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.

What you can do with the linked object is handled by the target object's security.

Links retain their originating location. For example, if you create a link on a list row, then that link appears only on that row, and not on all the other rows in the same list. Suppose you link to an article about a particular widget from the list row that describes that widget. The link to that article appears only on that row's Links dialog (Figure 63-4). It does not display on the Links dialog associated with the other rows on the same list.


Figure 63-4 The Links Dialog

[image: Links dialog box]



Most Links are also bidirectional. That is, when you create a link from a discussion to a document, a return link from the document to the discussion is automatically created. This bidirectional relationship holds for most, though not all, links. Links on notes, URLs, and list rows do not create a reciprocal link on the link target. For example, if you create a link from a document to a note, from a document to a URL, or from a list row to a document, then a reciprocal link is not created on the link target. However, a link from an entire list (rather than an individual list row) does create a reciprocal link from the target.






63.2 Working with Links Service Features

Many task flows include a linking capability that enables you to associate application objects with other application objects, and with internal and external web pages. For example, the List task flow automatically includes a Links icon on each list and on each list row. Additionally, the Lists page has its own link (Figure 63-5).


Figure 63-5 Link Icons on the Lists Page

[image: Link icons on a List page]



Use the Links feature to link to relevant documents, discussions, notes, web pages, events, and announcements. When viewing the details of an event, you can link to the event's agenda. In a list of project assignments, you can link to the functional and design specifications relevant to each assignment. In a discussion forum, you can link to a related discussion, document, web page, or WebCenter Portal: Spaces page. No more fruitless wandering through different lines of business to find information.

This section describes how to link one thing to another and how to access those links.

This section includes the following subsections:

	
Section 63.2.1, "Linking to Existing Objects"


	
Section 63.2.2, "Linking to New Objects"


	
Section 63.2.3, "Accessing Link Targets"


	
Section 63.2.4, "Deleting a Link"


	
Section 63.2.5, "Linking in the Rich Text Editor"






63.2.1 Linking to Existing Objects

This section describes how to use the Link to Existing option on the Links dialog to link to announcements, discussion forum topics, documents, and events currently available in your application.

This section includes the following subsections:

	
Section 63.2.1.1, "Opening the Links Dialog to Link to Existing Objects"


	
Section 63.2.1.2, "Linking to an Existing Announcement"


	
Section 63.2.1.3, "Linking to an Existing Discussion Forum Topic"


	
Section 63.2.1.4, "Linking to an Existing Document"


	
Section 63.2.1.5, "Linking to an Existing Event"






63.2.1.1 Opening the Links Dialog to Link to Existing Objects

To create a link to an existing object, first go to the object from which you want to link and open the Links dialog. From there, the steps vary depending on the type of object you are linking to.

To open the Links dialog:

	
Go to the object from which you want to link.


	
Click the object's associated Links icon (Figure 63-6).


Figure 63-6 The Links Icon

[image: Links icon]



This opens the Links dialog (Figure 63-7).


Figure 63-7 The Links Dialog

[image: Links pop-up panel]



	
From the Links dialog, choose Link to Existing and then the type of object you want to link to.

For information about what to do next see:

	
Section 63.2.1.2, "Linking to an Existing Announcement"


	
Section 63.2.1.3, "Linking to an Existing Discussion Forum Topic"


	
Section 63.2.1.4, "Linking to an Existing Document"


	
Section 63.2.1.5, "Linking to an Existing Event"












63.2.1.2 Linking to an Existing Announcement

You can bring timely announcements to the highest traffic areas in your application by linking to them.

To link to an existing announcement:

	
Go to the object from which you want to link to an announcement and click the Links icon.

For more information, see Section 63.2.1.1, "Opening the Links Dialog to Link to Existing Objects."


	
From the Links dialog, choose Link to Existing and then Announcement.

A window listing announcements opens (Figure 63-8).


Figure 63-8 Existing Announcements

[image: Existing announcements window]



	
In the window, click the announcement to which you want to link.


	
Click Link.

The title of the selected announcement appears on the list of links in the Links dialog (Figure 63-9).


Figure 63-9 Newly-Added Announcement on Links Dialog

[image: Announcement on Links pop-up panel]



	
Close the Links dialog.









63.2.1.3 Linking to an Existing Discussion Forum Topic

Help users find answers to questions before they even ask them by linking to relevant discussion forum topics.

To link to an existing discussion forum topic:

	
Go to the object from which you want to link to a discussion forum message and click the Links icon.

For more information, see Section 63.2.1.1, "Opening the Links Dialog to Link to Existing Objects."


	
From the Links dialog, choose Link to Existing and then Discussion.

A window listing available topics opens (Figure 63-10). If the space or application supports multiple discussion forums, then a dropdown list at the top enables you to switch to a different forum.


Figure 63-10 Existing Discussion Topics

[image: Existing discussion topics window]



	
Click the discussion topic to which you want to link.


	
Click Link.

The title of the selected discussion topic appears on the list of links in the Links dialog (Figure 63-11).


Figure 63-11 Newly-Added Discussion Topic on Links Dialog

[image: Discussion topic on Links pop-up panel]



	
Close the Links dialog.









63.2.1.4 Linking to an Existing Document

To save users from having to search for documents in the document library, link to them directly. For example, link to a meeting's agenda directly from the meeting's event details.

To link to an existing document:

	
Go to the object from which you want to link to a document and click the Links icon.

For more information, see Section 63.2.1.1, "Opening the Links Dialog to Link to Existing Objects."


	
From the Links dialog, choose Link to Existing and then Document.

The Link to Existing Document dialog opens (Figure 63-12).


Figure 63-12 Existing Documents

[image: Existing documents window]



	
Choose the document, and click Select.

The document link appears on the list of links in the Links dialog (Figure 63-13).


Figure 63-13 A Document Link on the Links Dialog

[image: Document link on the Links drop-down menu]



	
Close the Links dialog.









63.2.1.5 Linking to an Existing Event

You can link to information about events that are relevant to the current object. For example, you could provide a link from an issues document to an event scheduled to discuss those very issues.

To link to an existing event:

	
Go to the object from which you want to link to an event and click the Links icon.

For more information, see Section 63.2.1.1, "Opening the Links Dialog to Link to Existing Objects."


	
From the Links dialog, choose Link to Existing and then Event.

A window opens listing all of the events you can access.


Figure 63-14 Existing Events

[image: Existing events window]



	
In the window, click the event to which you want to link.

The title of the selected event appears on the list of links in the Links dialog (Figure 63-15).


Figure 63-15 Newly-Added Event on Links Dialog

[image: Event on Links pop-up panel]



	
Close the Links dialog.











63.2.2 Linking to New Objects

When you use Link to New, you accomplish two things at the same time: you create a new object, and you create a link to that object. Use the Link to New option on the Links dialog to link to a new discussion forum topic, a new document, a new event, a new note, or a web page.

This section describes how to link to these types of objects. It contains the following subsections:

	
Section 63.2.2.1, "Opening the Links Dialog to Link to a New Object"


	
Section 63.2.2.2, "Adding and Linking to a Discussion Forum Topic"


	
Section 63.2.2.3, "Adding and Linking to a Document"


	
Section 63.2.2.4, "Adding and Linking to an Event"


	
Section 63.2.2.5, "Adding and Linking to a Note"


	
Section 63.2.2.6, "Linking to a Web Page"






63.2.2.1 Opening the Links Dialog to Link to a New Object

When you want to create a link to a new object, the first thing to do is go to the object from which you want to link and open the Links dialog. From there the steps vary depending on the type of object you are linking to.

To open the Links dialog:

	
Go to the object from which you want to link.


	
Click the object's associated Links icon (Figure 63-16).


Figure 63-16 The Links Icon

[image: Links icon]



This opens the Links dialog (Figure 63-17).


Figure 63-17 The Links Dialog

[image: Links pop-up panel]



	
From the Links dialog, choose Link to New and then the type of object you want to link to.

For information about what to do next see:

	
Section 63.2.2.2, "Adding and Linking to a Discussion Forum Topic"


	
Section 63.2.2.3, "Adding and Linking to a Document"


	
Section 63.2.2.4, "Adding and Linking to an Event"


	
Section 63.2.2.5, "Adding and Linking to a Note"


	
Section 63.2.2.6, "Linking to a Web Page"












63.2.2.2 Adding and Linking to a Discussion Forum Topic

You can create a new thread directly from the object that first prompted the discussion, adding a link at the same time.

To link to a new discussion forum topic:

	
Go to the object from which you want to link to a new discussion forum topic and click the Links icon.

For more information, see Section 63.2.2.1, "Opening the Links Dialog to Link to a New Object."


	
From the Links dialog, choose Link to New and then Discussion.

The Link to New Discussion Topic dialog opens (Figure 63-18).


Figure 63-18 Link to New Discussion Dialog

[image: Link to New Discussion dialog box]



	
If the space or application supports multiple discussion forums, then in the Forum list, choose the forum in which you want to create the discussion topic.


	
In the Subject field, enter a subject for the new topic.


	
In the Message field, enter the topic content.


	
Click OK.

The topic is added to the selected discussion forum, and the link is added to the Links dialog.


	
Close the Links dialog.









63.2.2.3 Adding and Linking to a Document

When viewing an object, such as a discussion forum topic, you might be aware of an informative document that would help other viewers of the object. You can add the document or wiki to the document library directly from the original object, adding a link to it at the same time.

To link to a new document:

	
Go to the object from which you want to link to a new document and click the Links icon.


	
From the Links dialog, choose Link to New and then Document.

The Upload Document dialog opens (Figure 63-19).


Figure 63-19 Link to New Document Dialog

[image: Link to New Document dialog box]



	
Click Browse, and navigate to the location of the document you want to upload.


	
Choose the document, and click Open.


	
Enter an optional description and change the default destination directory, if necessary. Click the Browse icon to locate a destination, if necessary.


	
Click Upload.

The document is uploaded, and the link is added to the Links dialog.

The location of the uploaded document depends on where you initiated the linking action. The document could be uploaded to the selected space's document library or to the root folder of your WebCenter Portal default document repository connection.


	
Close the Links dialog.









63.2.2.4 Adding and Linking to an Event

You can create a new event and immediately add a link to it, for example, to schedule a meeting to address issues raised in a discussion forum topic.

To add and link to a event:

	
Go to the object from which you want to link to a new event and click the Links icon.

For more information, see Section 63.2.2.1, "Opening the Links Dialog to Link to a New Object."


	
From the Links dialog, choose Link to New and then Event.

The Link to New Event dialog opens (Figure 63-20).


Figure 63-20 The Link to New Event Dialog

[image: Event Details dialog box]



	
Enter event details as described in Section 61.2.4, "Scheduling Events."


	
Click Create.

The event is added and the link is added to the Links dialog.


	
Close the Links dialog.









63.2.2.5 Adding and Linking to a Note

Create a personal note about another object, maybe to buy doughnuts for the team meeting, or to add an annotation to an object, like an online post-it note. The note is also linked to the object, serving as a reminder whenever you view it.

To add and link to a note:

	
Go to the object from which you want to add and link to a note and click the Links icon.


	
From the Links dialog, choose Link to New and then Note.

The Link to New Note dialog opens (Figure 63-21).


Figure 63-21 The Link to New Note Dialog

[image: Link to New Note dialog box]



	
In the Title field, enter a title for the note.


	
In the Detail field, enter the note content.


	
Click Create.

The note link is added to the Links dialog.


	
Close the Links dialog.









63.2.2.6 Linking to a Web Page

Link to a web page to provide access to additional information.

To link to a web page:

	
Go to the object from which you want to link to a web page and click the Links icon.

For more information, see Section 63.2.2.1, "Opening the Links Dialog to Link to a New Object."


	
From the Links dialog, choose Link to New and then URL.

The Link to New URL dialog opens (Figure 63-22).


Figure 63-22 The Link to New URL Dialog

[image: Link to New URL dialog box]



	
In the Name field, enter a name to use for the link.


	
In the Address field, enter the URL of the page to which you want to link.


	
Click Create.

The link is added to the Links dialog.


	
Close the Links dialog.











63.2.3 Accessing Link Targets

You access link targets from the Links dialog. Click the Links icon (Figure 63-23) associated with the item of interest, and then click the link you want to open on the resulting Links dialog (Figure 63-24).


Figure 63-23 The Links Icon

[image: Links icon]




Figure 63-24 Links in the Links Dialog

[image: Links in the Links dialog box]







63.2.4 Deleting a Link

When a link ceases to serve any purpose, you can delete it.

To delete a link:

	
Go to the object associated with the link you want to delete, such as the document, list, list row, or other item on which the link was created.


	
Click the Links icon (Figure 63-25).


Figure 63-25 The Links Icon

[image: Links icon]



This opens the Links dialog.


	
Click the Delete icon next to the link you want to delete (Figure 63-26).


Figure 63-26 Delete Icon Next to a Link

[image: Delete icon next to a link]










63.2.5 Linking in the Rich Text Editor

The Rich Text Editor (RTE) included with the Documents services is an HTML text editor, which you can use to link to existing and new WebCenter Portal resources. For example, this provides a quick way to add and link to a new, empty wiki page.

Figure 63-27 shows the highlighted RTE icons to link to existing or new resources and also to embed an image.


Figure 63-27 New Wiki Document in Rich Text Editor (RTE)

[image: New Wiki Document in Rich Text Editor (RTE)]

Description of "Figure 63-27 New Wiki Document in Rich Text Editor (RTE)"





For more information, see Section 41.11, "Using the Rich Text Editor (RTE)."











Part XVI


Services: Lists through Worklist

Part XVI of the User's Guide provides overview and usage information about services from Lists through Worklist.

Part XVI includes the following chapters:

	
Chapter 64, "Working with the Lists Service"


	
Chapter 65, "Working with the Mail Service"


	
Chapter 66, "Working with the Notes Service"


	
Chapter 67, "Working with the Polls Service"


	
Chapter 68, "Working with the RSS Service"


	
Chapter 69, "Working with the Recent Activities Service"


	
Chapter 70, "Working with the Worklist Service"










64 Working with the Lists Service

Use the Lists service to create, publish, and manage lists in the Spaces application. Create lists from Excel spreadsheets or from prebuilt templates, or create your own custom lists from scratch. When you create a list, it becomes available in the Resource Catalog. You can add lists from the catalog to any page in the space in which it was created.

This chapter describes how to use the features offered through the Lists service. It includes the following sections:

	
Section 64.1, "What You Should Know About the Lists Service"


	
Section 64.2, "Working with Lists Service Features"


	
Section 64.3, "Setting List Viewer Task Flow Properties"





Audience

This chapter is for users who are interested in viewing, creating, populating, revising, importing, exporting, and removing lists and filtering list data. Such users must be granted, minimally, the space-level permission View Pages and Content. Such users can view lists. Users who plan to create and manage lists require the space-level permission Customize Pages and Edit Content.




	
Note:

Tasks discussed in this chapter are not available if the Lists service is not enabled in the current space.









64.1 What You Should Know About the Lists Service

The Lists service provides a means of creating, publishing, and managing lists (Figure 64-1).


Figure 64-1 A List in the List Viewer Task Flow

[image: A list in the List Viewer task flow]



Lists are useful for many space activities, such as tracking issues, capturing project milestones, publishing project assignments, and much more. The lists you create in Spaces can be widely varied in their complexity. For example, you can start with a list of team members, and then include columns for contact information, project role, and links to relevant documents, such as any plans or proposals associated with a listed team member.

The Lists service is available to all spaces except the Home space. Whether it is exposed for use depends on the actions of your space moderator (for more information, see Section 51.10.1, "Enabling and Disabling Services Available to a Space"). The lists you create in a space are unique to that space. A space cannot consume the lists created in another space.

Create and populate lists using the controls on the Lists page. Place populated lists on a page using the List Viewer task flow. Users must have appropriate permissions to perform actions on lists (for more information, see Audience).

Use the controls on the Lists page to create and revise lists and list data and to view all of a space's current lists (Figure 64-2).


Figure 64-2 A List on the Lists Page

[image: List on the Lists page]



On the Lists page, you can make use of templates for rapid creation of lists and tools for designing and revising list structure. If you prefer, you can create a list from scratch, adding, and configuring all of the columns yourself, or you can create a list from an Excel spreadsheet. For more information, see Section 64.2.3, "Creating and Managing Lists."

The List Viewer task flow (Figure 64-3) provides a means of placing a particular list on a page.


Figure 64-3 A List in the List Viewer Task Flow

[image: A list in the List Viewer task flow]



The List Viewer provides easy access to all the tools required for adding and revising list data, importing/exporting list data, filtering list data, obtaining a list RSS feed, and linking to other Spaces objects from the list and from a list row.

Additionally, the List Viewer provides access to customization tools that enable you to control the look of a particular list instance and its data. For example, use customization to control color banding of rows or columns or to apply filters to list data. For more information, see Section 64.2.5, "Customizing Lists."

Use the Lists page and the List Viewer to add and revise list data throughout the life of the list (for more information, see Section 64.2.4, "Adding and Managing List Data"). Add and revise content directly on a list, or use the list Export/Import feature to send list data to an Excel file, revise it there, and then import it back into the original list in the Spaces application (for more information, see Section 64.2.7, "Exporting a List and Importing a List from an Excel Spreadsheet").

All of the lists created in a given space are available on the Lists page and through the space's Resource Catalog (Figure 64-4).


Figure 64-4 Lists in the Resource Catalog

[image: Lists in the Resource Catalog]






	
Tip:

By default, you can find lists under Lists in the Social and Communication folder in the Resource Catalog. However, the location of lists in a Resource Catalog depends on how the catalog was structured by its designer. You can use the catalog's Search feature to search for Lists or the list name.







In the Resource Catalog, click the Add link next to a list to add it to the current page (for more information, see Section 17.5.1, "Adding a Component to a Page"). The list is rendered within a List Viewer task flow.

The Lists page is available in any space where the Lists service is enabled. If the Lists page is not shown by default when you navigate to a space, you can open it through the Personalize Pages page. For more information, see Section 29.3.4, "Showing Hidden Pages."




	
Note:

The Lists service is not available in the Home space.







Through its tight integration with the Links service, the Lists service provides the opportunity to associate other Spaces items with an entire list or an individual list row. Linking enables you to associate documents, notes, and URLs with a list or a list row. For more information, see Chapter 63, "Working with the Links Service."

The Lists service additionally provides RSS feeds for all lists and for individual lists. For information about the Lists service and RSS, see Chapter 68, "Working with the RSS Service."






64.2 Working with Lists Service Features

This section provides information about using the features available through the Lists page and the List Viewer task flow. It includes the following subsections:

	
Section 64.2.1, "Adding Lists to a Page"


	
Section 64.2.2, "Viewing Lists"


	
Section 64.2.3, "Creating and Managing Lists"


	
Section 64.2.4, "Adding and Managing List Data"


	
Section 64.2.5, "Customizing Lists"


	
Section 64.2.6, "Sending a Link to a List to Other Users"


	
Section 64.2.7, "Exporting a List and Importing a List from an Excel Spreadsheet"






64.2.1 Adding Lists to a Page

For the steps to add a list to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
See Also:

If you do not find lists in the Resource Catalog, it may be that you need to add them. For more information, see Section 16.3.1.2, "Adding Resources."












64.2.2 Viewing Lists

To view the lists associated with a particular space, you must have access to that space. Once you have access, you can view all of a space's lists on its Lists page.

To view a list on the Lists page:

	
Go to the space that contains the list you want to view, and open its Lists page.

If the Lists page is not available, see Section 29.3.4, "Showing Hidden Pages."


	
From the Lists panel, select the list you want to view.

List details appear to the right (Figure 64-5).


Figure 64-5 List of Lists on a Lists Page

[image: List of lists on a Lists page]










64.2.3 Creating and Managing Lists

This section describes how to create, edit, copy, and delete lists on the Lists page.

This section includes the following subsections:

	
Section 64.2.3.1, "Creating Lists"


	
Section 64.2.3.2, "Editing List Structure"


	
Section 64.2.3.3, "Copying a List"


	
Section 64.2.3.4, "Deleting Lists"






64.2.3.1 Creating Lists

In Spaces, you can create a list using one of the following methods:

	
Create a blank list for which you create and configure all columns (up to 30).


	
Create a list from a template, and use that "as is" or as a starting point.


	
Create a list from a Microsoft Excel spreadsheet.




This section describes how to create a list using each method.

To create a list:

	
Go to the Lists page of the space where you want to create a list.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel toolbar, click the Create a new list icon (Figure 64-6).


Figure 64-6 Create a New List Icon on a Lists Page

[image: Create a new list icon on a Lists page]



	
In the resulting Create List dialog, enter a name for the list in the Name field (Figure 64-7).


Figure 64-7 Create List Dialog

[image: Create List dialog]



	
Optionally, in the Description field enter a description of the list.




	
Tip:

In a completed list, the description appears between the list title and list data.








	
Under Create From, select to create the list using a Template or from an Excel Spreadsheet.


	
If you select to create a list from a Template, select a template from the Template menu:

	
Custom List—To create a list without using a template.


	
Issues—To create a list of, for example, project issues. By default, this template provides the columns Subject, Assigned To, Closed, and Comments.


	
Milestones—To create a list of, for example, project milestones. By default, this template provides the columns Date, Description, and Status.


	
Objectives—To create a list of, for example, project objectives. By default, this template provides the columns Title, and Description.




If you select to create a list from an Excel Spreadsheet, click Browse to navigate to and select the spreadsheet:

	
The first row of the spreadsheet is used as column headings. The subsequent rows are added as data.


	
All the columns are created with the data type Plain Text. After creation, you can modify the data types as desired. For information about data types, see Table 64-1, "Data Type Selections for List Columns"







	
Tip:

You can use the Excel Spreadsheet option to import a list from a different space or from a different WebCenter Portal instance. That is, you can export the list from the space or WebCenter Portal instance and import it into the current space or instance.








	
Click OK.

The new list appears in the Lists panel on the Lists page.




You may now revise default list columns and add new columns to the list by clicking the Edit list icon. For more information, see Section 64.2.3.2, "Editing List Structure." For a custom list, you must add columns to the list before you can add rows.




	
See Also:

For information about adding new list rows, see Section 64.2.4, "Adding and Managing List Data."












64.2.3.2 Editing List Structure

When you edit list structure, you can revise everything about the list. For example, you can change column details; remove, add, and rearrange columns; and rename or redescribe the list.

This section describes the various tasks you can perform while editing a list structure. It contains the following subsections:

	
Section 64.2.3.2.1, "Renaming a List and Revising a List Description"


	
Section 64.2.3.2.2, "Adding Columns to a List"


	
Section 64.2.3.2.3, "Revising List Column Details"


	
Section 64.2.3.2.4, "Rearranging List Columns on All Instances of a List"


	
Section 64.2.3.2.5, "Deleting a List Column"






64.2.3.2.1 Renaming a List and Revising a List Description

To rename a list and revise a list description:

	
Go to the space where you want to rename a list or revise a list description, and open its Lists page.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list you want to change, and click the Edit list icon (Figure 64-8).


Figure 64-8 Edit List Icon

[image: Edit List icon]



The list enters edit list mode (Figure 64-9).


Figure 64-9 List in Edit List Mode

[image: List in edit list mode]



	
Click the Edit link to the right of the Name field to open the Edit List dialog (Figure 64-10).


Figure 64-10 Edit List Dialog

[image: Edit List dialog]



	
Revise the list name and description.


	
Click OK to close the dialog and save your changes.


	
Click the Close button in edit list mode to return to view list mode.









64.2.3.2.2 Adding Columns to a List

This procedure is useful when you create a custom list or you want to alter a list that you created from a template or a spreadsheet.




	
Note:

A list supports up to 30 columns.







When you add a column to a list, the new column is added after the selected column. If no column is selected, the new column is added as the first column.

To add columns to a list:

	
Go to the Lists page of the space where you want to add columns to a list.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list to which to add columns and click the Edit list icon (Figure 64-11).


Figure 64-11 Edit List Icon

[image: Edit List icon]



The Lists page enters list edit mode (Figure 64-12).


Figure 64-12 List in Edit List Mode

[image: List in edit list mode]



	
Under Columns, click the Create button to open the Create Column dialog (Figure 64-13).


Figure 64-13 Create Column Dialog

[image: Create Column dialog]






	
Tip:

Select a column to add a new column after it.








	
In the Name field, provide a name for this column.


	
From the Data Type list, select the type of data you want to enter in this column.




	
Note:

The data type you select affects the type of data that can be entered for the column and the way the data is rendered (see Table 64-1 and Table 64-2). It also affects the type of validation that is run on column data when you and other authorized users add list rows. For example, if you select a DateTime data type, and a user enters text that is not in the DateTime format, Spaces returns an error.







Table 64-1 lists and describes the data types available to list columns, and provides information about the additional details that appear for each type.




	
See Also:

For information about additional column details, see Table 64-2, "Data Type Column Details".








Table 64-1 Data Type Selections for List Columns

	Data Type	Description	Comments
	
Plain Text

	
Unformatted text, provides options for making the text a link

	
Additional column details include:

	
Required


	
Default Value


	
Maximum Length


	
Number of Lines for Editing


	
Allow Links


	
Link Window


	
Display Width


	
Hint





	
Rich Text

	
Rich, formatted text entered through a rich text editor, may include links

	
Additional column details include:

	
Required


	
Display Width


	
Hint





	
Number

	
Numbers

	
Additional column details include:

	
Required


	
Format


	
Default Value


	
Minimum Value


	
Maximum Value


	
Display Width


	
Hint




For Format, select from:

	
Number—an unformatted number; decimal separator is based on the currently selected locale. For more information, see Section 35.2, "Choosing Your Preferred Display Language."


	
Currency—value is formatted as a currency value; the currency symbol and decimal separator are based on the currently selected locale. For more information, see Section 35.2, "Choosing Your Preferred Display Language."


	
Percent—value is formatted as a percentage; the value 0.6 is formatted as 0.6%; the value 60 is formatted as 60%.




The Number data type supports numbers from ±1.79769313486231570e+308 with 14 to 15 significant digits.Foot 1 


	
DateTime

	
Dates and times in the format specified in a given user's Spaces Preferences (for more information, see Section 35.3, "Setting Date and Time Preferences")

	
Additional column details include:

	
Required


	
Format


	
Default Value


	
Display Width


	
Hint




For Format, select from:

	
Date—For requiring a date.


	
Time—For requiring a time.


	
Date and Time—For requiring a date and a time.




The way the selected Format is rendered is controlled by the user's date and time preferences.

The Default Value field includes a date picker, which you can use to select a default date in the correct format. The current date has a box around it, for example, March 30th in the following figure.

[image: Date picker]

This field does not require leading zeroes, for example, it does not require 05/04/2009. Instead, you can use 5/4/2009.


	
Boolean

	
Either TRUE or FALSE

	
Additional column details include:

	
Default Value


	
Display Width


	
Hint




TRUE or FALSE is rendered as a checkbox. Checked equals TRUE; cleared equals FALSE.


	
Picture

	
A directory path to an image (the image is rendered in list view mode)

	
Additional column details include:

	
Required


	
Display Width


	
Hint





	
Person

	
A valid user name

	
Additional column details include:

	
Required


	
Range of Users


	
Default Value


	
Display Width


	
Hint




The Range of Users field enables you to limit the valid range of users to the membership of the current space (or to include all users). The Default Value field includes a Find user icon, which you can use to locate and select a default user. For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."

The list column contains a presence indicator next to the user name. Click the presence indicator to open a context menu with options for making contact with the person instantly. For more information, see Section 62.4.1, "Viewing the Status of Other Users."








Footnote 1 Number data-type columns adhere to the range and precision specified for the 8 byte IEEE 754 double data type. When the maximum number of significant digits is exceeded, the number is rounded.


	
After you select a data type, enter values for the remaining fields.

Table 64-2 lists the possible remaining fields and their associated data types.


Table 64-2 Data Type Column Details

	Column Detail	Description	Associated Data Type(s)
	
Allow Links

	
Specify whether to allow column data to be hyperlinked. Specifying Allow Links enables the user to enter both a column value and a URL. If a URL is specified, the column value is rendered as a hyperlink.

	
Plain Text


	
Default Value

	
Optionally, provide a default value for the column entry, such as a default image, number, user name, and the like.

	
	
Plain Text


	
Number


	
DateTime


	
Boolean


	
Person





	
Display Width

	
Enter a value in pixels to set the column width.

	
All data types


	
Format

	
Use this pick list to specify the format for column values. For more information, see Table 64-1.

	
	
Number


	
DateTime





	
Hint

	
Enter text to assist the user in understanding the content to enter into the column. This text appears when focus is on this column in edit list data mode.

	
All data types


	
Link Window

	
Indicate how a hyperlink on column data should open.

Choose from:

	
New Window—The link opens in a new browser tab or window.


	
Current Window—The link opens in the current browser window.




	
Plain Text


	
Maximum Length

	
Enter the maximum number of characters for this column entry. This includes character spaces.

	
Plain Text


	
Maximum Value

	
Indicate the highest number that can be entered in this column.

	
Number


	
Minimum Value

	
Indicate the lowest number that can be entered in this column.

	
Number


	
Number of Lines for Editing

	
Indicate the number of lines to make available for editing. When the value is 1, the user enters data in a single line text field when editing list data. Long values scroll horizontally. When the value is greater than 1, the user enters data in a multiline text field. Long values scroll vertically. This makes entering and viewing large values much easier.

	
Plain Text


	
Range of Users

	
Indicate whether to limit the selection of users to members of the current space (space Members) or to allow a selection from all authenticated users (All Users).

	
Person


	
Required

	
Select this checkbox to require that data is entered in this column.

	
	
Plain Text


	
Rich Text


	
DateTime


	
Number


	
Picture


	
Person











	
Click OK to save your changes and exit the dialog.


	
Click Close to exit List Edit mode.









64.2.3.2.3 Revising List Column Details

You can revise every detail of a list column. That is, you can rename the column, change the column data type, require a value, or remove a value requirement. Keep in mind, however, if you change a column data type, any values currently entered in the list column are either converted to the new data type or removed irrevocably.

For example, if you move from a Plain Text data type to a Number data type, values that can be converted to a number are retained; other values are removed. Before any values are removed by the change, you are asked for confirmation. In contrast, if you move from a Number data type to a Plain Text data type, all values are retained.




	
Note:

Validation occurs only on data entry. If a user changes column details after data has been entered into the column, the existing data is not affected (that is, validated) even if it does not meet the new column detail conditions on the columns.
If you want to validate new list data, you can export the list data to an Excel spreadsheet and then import it. On import, all rows are validated. The rows that fail validation are noted. You can fix invalid rows in the spreadsheet and import again.












	
See Also:

For more information, see Section 64.2.7, "Exporting a List and Importing a List from an Excel Spreadsheet."







To revise list column details:

	
Go to the Lists page of the space where you want to revise list column details.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list you want to change and click the Edit list icon (Figure 64-14).


Figure 64-14 Edit List Icon

[image: Edit List icon]



The Lists page enters edit list mode (Figure 64-15).


Figure 64-15 List in Edit List Mode

[image: List in edit list mode]



	
Under Columns, select the list column you want to revise and click the Edit button to open the Edit Column dialog (Figure 64-16).


Figure 64-16 Edit Column Dialog

[image: Edit Column dialog]



	
Edit column details as you prefer.

For information about column details, see Section 64.2.3.2.2, "Adding Columns to a List."


	
Click OK to save your changes and close the dialog.


	
Click the Close button to exit edit list mode.









64.2.3.2.4 Rearranging List Columns on All Instances of a List

You can rearrange list columns in the list structure, affecting all instances of a list, by clicking rearrange icons or by dragging and dropping.




	
See Also:

For information about rearranging column order of a particular list instance in your view or everyone's view, see Section 64.2.5.3, "Changing Column Order on a List Instance."







To rearrange columns on all instances of a list:

	
Go to the Lists page of the space where you want to rearrange list columns.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list you want to change and click the Edit list icon to enter list edit mode.


	
Under Columns, click an icon under the Reorder column to move a column higher or lower in the order of columns (Figure 64-17).


Figure 64-17 Reorder Column Icons on Edit List Page

[image: Reorder Column icons on Edit List page]






	
Tip:

Moving a column higher causes it to appear further to the left in column display order. Moving a column lower causes it to appear further to the right.







Alternatively, drag and drop a column higher or lower in the column hierarchy.


	
Click the Close button to exit list edit mode.









64.2.3.2.5 Deleting a List Column

To delete a list column:

	
Go to the Lists page of the space where you want to delete list columns.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list you want to change and click the Edit list icon to enter list edit mode (Figure 64-18).


Figure 64-18 List in Edit List Mode

[image: List in edit list mode]



	
Select a column, and click the Delete button (Figure 64-19).


Figure 64-19 Delete Button on Edit List Page

[image: Delete button on Edit List page]



	
In the resulting confirmation dialog, click the Delete button to complete the deletion.











64.2.3.3 Copying a List

You can use an existing list as a template simply by copying it. First, copy the list, and then edit the copied list as you like.

To copy a list:

	
Go to the Lists page of the space that contains the list you want to copy.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list you want to copy.


	
Click the Copy List icon (Figure 64-20).


Figure 64-20 Copy List Icon on Lists Page

[image: Copy List icon on Lists page]



A copy of the list becomes available for selection in the Lists panel (Figure 64-21).


Figure 64-21 A List Copy

[image: A list copy]








	
See Also:

For information about changing the list name or description, see Section 64.2.3.2.1, "Renaming a List and Revising a List Description." For information about revising list structure, see Section 64.2.3.2, "Editing List Structure."












64.2.3.4 Deleting Lists

To delete a list:

	
Go to the Lists page of the space that contains the list you want to delete.




	
See Also:

For information about navigating to a Lists page, see Section 64.2.2, "Viewing Lists."








	
In the Lists panel, select the list you want to delete.

To select multiple lists, use Ctrl+Click; to select a range of lists, use Shift+Click.


	
Click the Delete list icon (Figure 64-22).


Figure 64-22 Delete List Icon on Lists Page

[image: Delete List icon on Lists page]



	
In the resulting confirmation dialog, click the Delete button.

After confirmation, the selected lists are removed from the Lists panel.











64.2.4 Adding and Managing List Data

Once you have created a list structure, you can add data to the list. This section describes how to add, edit, and refresh list data, and how to delete lists rows. It includes the following subsections:

	
Section 64.2.4.1, "Adding Data of a Given Data Type to a List"


	
Section 64.2.4.2, "Editing List Data"


	
Section 64.2.4.3, "Deleting List Rows"


	
Section 64.2.4.4, "Refreshing List Data"







	
See Also:

For information about list structure, see Section 64.2.3, "Creating and Managing Lists." For information about list data types, see Table 64-1, "Data Type Selections for List Columns" and Table 64-2, "Data Type Column Details".









64.2.4.1 Adding Data of a Given Data Type to a List

This section describes how to add data to a list. When you add data to a list, you do so row-by-row (unless you are importing a spreadsheet). The placement of a new row depends on the following considerations:

	
When you add a new row, it is created after the selected row.


	
If no row is selected, the new row is created as the first row.


	
Once you save, list data is refreshed and rows are shown in sort order.




	
See Also:

for more information, see Section 64.2.5.1, "Sorting List Data on a Column"










You can add one or multiple list rows before you add content, or you can create a list row and add content to it right away.

This section provides an overview procedure for adding list data, and steps you through how to add data for a given data type. It includes the following subsections:

	
Section 64.2.4.1.1, "Adding Data to a List"


	
Section 64.2.4.1.2, "Adding Plain Text Data to a List"


	
Section 64.2.4.1.3, "Adding Rich Text Data to a List"


	
Section 64.2.4.1.4, "Adding DateTime Data to a List"


	
Section 64.2.4.1.5, "Adding Picture Data to a List"


	
Section 64.2.4.1.6, "Adding Person Data to a List"







	
Tip:

The Number and Boolean data types are not included here because, for a Number data type, you simply enter a number, and, for a Boolean data type, you simply select or clear a checkbox.









64.2.4.1.1 Adding Data to a List

To add data to a list:

	
Go to the Lists page or the List Viewer task flow that displays the list you want to populate with data, and click the Edit List Data icon to open the list in edit list data mode (Figure 64-23).


Figure 64-23 Edit List Data Icon

[image: Edit List Data icon]






	
Tip:

You can also enter list edit mode by selecting Edit from the Actions menu or by pressing Crtl+E.








	
Click the Add a New Row icon to add a row to the list (Figure 64-24).


Figure 64-24 Add A New Row Icon on a List

[image: Add a New Row icon on a list]






	
Tip:

You can also start the add-row process by selecting Add Row from the Actions menu or by pressing Ctrl+I.







The new row is added after the selected row. If no row is selected, it is added as the first row (Figure 64-25).


Figure 64-25 A Newly Added Row

[image: A newly added row]



	
Add data to the new row.




	
Tip:

You can only edit the row with focus. Click a row to give it focus and edit it.








	
Repeat the previous two steps to create new rows and add data.


	
When you finish adding rows and data, click Save to save your changes and exit edit list data mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.










When you save your changes, the list data is refreshed and the rows are rendered in sort order (for more information, see Section 64.2.5.1, "Sorting List Data on a Column").






64.2.4.1.2 Adding Plain Text Data to a List

The Plain Text data type allows for the entry of unformatted text, and provides options for making the text a link.




	
Tip:

To create a hyperlink on a Plain Text data type, the list column must be configured to allow for the creation of hyperlinks. For more information, see Section 64.2.3.2.2, "Adding Columns to a List."







To enter Plain Text data into a list row:

	
Enter edit list data mode as described in Section 64.2.4.1.1, "Adding Data to a List."


	
Go to the column that is formatted to support the Plain Text data type:

To enter unlinked text, enter text in the field provided.

To enter linked text:

	
Click the Edit Column Link icon to the right of the data entry field (Figure 64-26).


Figure 64-26 Edit Column Link Icon

[image: Edit Column Link icon]



	
In the resulting Edit Column Link dialog, enter text in the Text field, and enter a full URL in the Link Location field (Figure 64-27).


Figure 64-27 Edit Column Link Dialog

[image: Edit Column Link dialog]



	
Click OK.







	
Tip:

To remove a link, click the Edit Column Link icon, and delete the URL from the resulting dialog.








	
When you finish adding rows and data, click Save to save your changes and exit edit list data mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.







If both text and a link location were specified, the text is rendered as a hyperlink.









64.2.4.1.3 Adding Rich Text Data to a List

The Rich Text data type allows for the entry of rich, formatted text through a rich text editor. Rich text may include links.

To enter Rich Text data into a list row:

	
Enter edit list data mode as described in Section 64.2.4.1.1, "Adding Data to a List."


	
Go to the column that is formatted to support the Rich Text data type, and click the Edit Text icon to the right of the data entry field (Figure 64-28).


Figure 64-28 Edit Text Icon

[image: Edit Text icon]



This launches the rich text editor (Figure 64-29).


Figure 64-29 The Rich Text Editor

[image: The Rich Text Editor]



	
Enter text and apply styles according to your requirements.


	
To add a link:

	
Highlight the link text, and click the Add Link icon in the editor's toolbar (Figure 64-30).


Figure 64-30 Add Link through Rich Text Editor

[image: Add Link through Rich Text Editor]



	
In the resulting dialog, enter a URL in the field provided.


	
Click OK.







	
Tip:

To remove a link, highlight the linked text and click the Remove Link icon.








	
Click OK to exit the editor.


	
When you finish adding rows and data, click Save to save your changes and exit edit list data mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.















64.2.4.1.4 Adding DateTime Data to a List

The DateTime data type allows for the entry of dates and times in the format specified in a given user's Spaces Preferences (for more information, see Section 35.3, "Setting Date and Time Preferences").

To enter DateTime data into a list row:

	
Enter edit list data mode as described in Section 64.2.4.1.1, "Adding Data to a List."


	
Go to the column that is formatted to support the DateTime data type, and enter a value or click the Select <data type> icon to the right of the data entry field (Figure 64-31).


Figure 64-31 Select Date Icon

[image: Select Date icon]



	
If you click the icon, from the resulting calendar, select a date, a time, or a date and time, according to the column's requirements (Figure 64-32).


Figure 64-32 Popup Calendar for Date Selection

[image: Popup calendar for date selection]



	
If the column requires just a date, the calendar closes once you select a value.

If the calendar requires a time or a date and time, click OK to close the calendar.


	
When you finish adding rows and data, click Save to save your changes and exit edit list data mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.















64.2.4.1.5 Adding Picture Data to a List

The Picture data type allows for the entry of a path to an image (the image is rendered in list view mode).

To enter a Picture data type into a list row:

	
Enter edit list data mode as described in Section 64.2.4.1.1, "Adding Data to a List."


	
Go to the column that is formatted to support the Picture data type, and enter a path to a picture or click the Edit Picture icon to the right of the data entry field (Figure 64-33).


Figure 64-33 Edit Picture Icon

[image: Edit Picture icon]



	
If you click the icon, in the Edit Picture dialog, enter a directory path or a URL to an image in the Picture Location field (Figure 64-34).

For example, enter:


http://www.oracleimg.com/admin/images/ocom/hp/oralogo_small.gif


Or


d:/corporateImageBank/images/myimage.png



Figure 64-34 Edit Picture Dialog

[image: Edit Picture dialog]






	
Tip:

The image must be available in a location that does not require login credentials for access.
You can select an image that is located in your Spaces Document Library. In a Documents service task flow, select the image and use the Get a Link option on the View menu to access a link to the image. Copy the link and paste it into the Picture Location field.










	
Provide ALT text for the image in the Description field.


	
Click OK.


	
When you finish adding rows and data, click Save to save your changes and exit edit list data mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.















64.2.4.1.6 Adding Person Data to a List

The Person data type allows for the entry of a user name from your company's identity store. The selection of a Person may be further limited to the members of the current space. If you search for a user name, the values returned indicate whether such a limit is in place.

To enter a Person data type into a list row:

	
Enter edit list data mode as described in Section 64.2.4.1.1, "Adding Data to a List."


	
Go to the column that is formatted to support the Person data type, and enter a user name or click the Find user icon to the right of the data entry field (Figure 64-35). For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


Figure 64-35 Find User Icon

[image: Find User icon]



Either all names in your company LDAP directory, or those users who belong to the current space, that match your search criteria appear in the results area (Figure 64-36).


Figure 64-36 Find User Dialog

[image: Find User dialog]



	
Select a user, and click OK to populate the field with your selection.


	
When you finish adding rows and data, click Save to save your changes and exit edit list data mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.

















64.2.4.2 Editing List Data

When a list is in edit mode, you can edit one or multiple list rows. In edit mode, you can initiate a row edit simply by clicking within the row. You can continue to click in rows and edit row content until you exit edit mode.

To edit list data:

	
Go to the list that contains data you want to edit, and click the Edit List Data icon to open the list in edit mode (Figure 64-37).


Figure 64-37 Edit List Data Icon

[image: Edit List Data icon]



	
Click a list row to revise its data (Figure 64-38).


Figure 64-38 A Row Open for Edit

[image: A row open for edit]






	
Tip:

The type of list data affects the action that you take:
	
To edit a Picture data type, click the Edit Picture icon next to the data entry field. Enter the URL to the picture and ALT text.


	
To edit a Rich Text data type, click the Edit Text icon next to the data entry field to launch the editor.


	
To edit a hyperlink in a column that allows links, click the Edit Link icon.













	
Continue clicking rows and revising data until you are finished.


	
Click Save to save your changes and exit edit list mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.















64.2.4.3 Deleting List Rows

You can delete one or multiple list rows in one operation.




	
Tip:

Selecting a row and clicking Delete marks a list row for deletion. The row is removed from your view, but the list data continues to exist in the WebCenter Portal's repository. The actual delete takes place when you save the change.







To delete one or multiple list rows:

	
Go to the list with rows to delete.


	
Click the Edit List Data icon to open the list in edit mode (Figure 64-39).


Figure 64-39 Edit List Data Icon

[image: Edit List Data icon]



	
Select one or more rows to delete.

In Windows, use Ctrl+Click to select multiple rows. In UNIX, simply click multiple rows. In both operating systems, use Shift+Click to select a range of rows.


	
Click the Delete button above the list (Figure 64-40).


Figure 64-40 Delete Button and Selected Rows

[image: Delete button and selected rows]



The selected rows are marked for deletion removed from your view of the list.


	
Click Save to save your changes and exit edit list mode.




	
Tip:

To save, you can also select Save from the Actions menu, or press Ctrl+M. To close, click Close, select Close from the Actions menu, or press Ctrl+Q.















64.2.4.4 Refreshing List Data

All lists come with a Refresh List icon, which you can click to refresh the display of list data (Figure 64-41).


Figure 64-41 Refresh List Icon

[image: Refresh List icon]









64.2.5 Customizing Lists

You can perform user customizations on your own view of a list instance, or you can perform application customizations on a list instance, affecting everyone's view. User customizations involve changes made in page view mode; while application customizations involve changes made in page edit mode (that is, in Composer). Everyone can perform user customizations their own view of a list; but page edit privileges are always required for application-level list customizations.

User and application customizations apply to a list rendered in a List Viewer task flow. They do not apply to lists rendered on the Lists page.

A second instance of a list is not affected by the customizations you make to the first instance. For example, imagine that you have placed the Issues list on both the Sales page and the What's New page. If you sort the list by the Number column on the Sales page, the Issues list is not automatically sorted by Number on the What's New page.

While application customizations affect everyone's view of a list instance, user customizations are layered over them. For example, someone may perform an application customization on a list containing columns A, B, and C, so that column C is first in list column order (C, A, B). You can then perform a user customization on the list so that column A is first in list column order in your personal view of the same list instance (A, C, B).




	
Note:

In page edit mode, you see only application customizations. In page view mode, you see user customizations layered over application customizations. If the same property is set at both the application and user levels, the user value takes precedence in your own view.







This section describes various application- and user-level customizations you can make to a list instance. It includes the following subsections:

	
Section 64.2.5.1, "Sorting List Data on a Column"


	
Section 64.2.5.2, "Resizing List Columns"


	
Section 64.2.5.3, "Changing Column Order on a List Instance"


	
Section 64.2.5.4, "Hiding and Showing List Columns"


	
Section 64.2.5.5, "Freezing a Column Position"


	
Section 64.2.5.6, "Wrapping Column Data"


	
Section 64.2.5.7, "Applying Color Banding to List Rows"


	
Section 64.2.5.8, "Filtering List Data"






64.2.5.1 Sorting List Data on a Column

By default, list data is sorted by create date. You can control the sort order of list data by clicking sort icons in each column's header. You can perform an advanced sort using View menu options.

Sort list data in the List Viewer task flow. You can sort list data on the Lists page, but the sort is not persisted. It will revert back if you change lists or navigate away from the page.

To sort list data on a column in your view, perform the actions described in this section in page view mode. To sort list data on a column in everyone's view, perform the actions described in this section in page edit mode.

This section describes regular and advanced sorting. It includes the following subsections:

	
Section 64.2.5.1.1, "Sorting List Data Using Column Icons"


	
Section 64.2.5.1.2, "Performing an Advanced Sort of List Data"







	
Note:

When your Spaces application is running against an Oracle database, a click on a column header in the List View results in a linguistic sort based on your locale. For non-Oracle databases, the sorting is based on the linguistic sorting specified in the database (collation in the case of SQL Server). This means when you connect to a Spaces instance in different languages, list rows are sorted according to the default collation of the database, regardless of the language your application is currently using.









64.2.5.1.1 Sorting List Data Using Column Icons

To sort list data on a column using column icons:

	
Go to the list instance you want to change.


	
Go to the column you want to use to control the sort, roll your mouse over the column header, and click the Sort Ascending icon to sort the list in ascending order (1, 2, 3, a, b, c); or click the Sort Descending icon to sort the list in descending order (c, b, a, 3, 2, 1) (Figure 64-42).


Figure 64-42 Sort Icons on a List Column

[image: Sort icons on a list column]






	
Tip:

You can also sort list data on a column by selecting a column and then selecting Sort and then Ascending or Descending from the View menu. You can right-click a column and select these options from a context menu.















64.2.5.1.2 Performing an Advanced Sort of List Data

The View menu provides an Advanced option that presents another way to sort list data.

To use the Advanced option to sort list data:

	
Go to the list instance you want to change.


	
From the View menu, select Advanced to open the Advanced Sort dialog (Figure 64-43).


Figure 64-43 Advanced Sort Dialog

[image: Advanced Sort dialog]



	
From the Sort By list, select the column to be considered first in sorting list data.

The Sort By and Then By fields are arranged in order of precedence, with Sort By considered first, and Then By in second and third positions.


	
Select either Ascending, to sort list data on the selected column in ascending order (1, 2, 3, a, b, c), or Descending, to sort list data on the selected column in descending order (c, b, a, 3, 2, 1).




	
Note:

Currently, you can sort against only one column. Look to future releases for this feature to be fully realized.








	
Click OK.







	
Tip:

You can access the options described in this section by right-clicking a column header and selecting from a context menu.














64.2.5.2 Resizing List Columns

You can control the width of a list column by dragging it wider or by setting a specific column width through a dialog. You can also control column width by expressing a default width in column details (for more information, see the Display Width detail in Table 64-2, "Data Type Column Details").

Resize columns in the List Viewer task flow. You can resize columns on the Lists page, but these are not persisted and will revert back when changing lists or navigating away.

To resize list columns in your view, perform the following actions in page view mode. To resize list columns in everyone's view, perform the following actions in page edit mode.




	
Note:

To resize list columns, the list must contain at least one row.







To resize list columns:

	
Go to the list instance you want to change.


	
Resize columns using one of the following methods:

	
Click and hold on a column splitter, and drag it to make the column wider or narrower.


	
In the list, select the column to resize.

From the Format menu, select Resize Columns.

In the resulting dialog, enter a column width and select a unit of measure (Figure 64-44).


Figure 64-44 Resize Column Dialog

[image: Resize Column dialog]



Choose from:

	
Pixels—To express column width in a specified number of pixels.


	
Percent—To express column width as a percentage of the total list width.




Click OK.







	
Tip:

You can access the options described in the section by right-clicking a column and selecting from a context menu.















64.2.5.3 Changing Column Order on a List Instance

You can rearrange the order of list columns by dragging a column and dropping it to the desired position or by using the reorder dialog.

Change column order in the List Viewer task flow. You cannot change column order on the Lists page.

To change column order on a list instance in your view, perform the following actions in page view mode. To change column order on a list instance in everyone's view, perform the following actions in page edit mode.




	
Note:

To reorder columns by dragging, the list must have at least one row.







To change column order:

	
Go to the list instance you want to change.


	
Rearrange list columns using one of the following methods:

	
Click and hold on a list column title, and drag and drop it to the desired location.


	
Select Reorder Columns from the View menu.

In the resulting dialog, select a column and click a Move icon to the right of the list of Visible Columns to reposition your selection (Figure 64-45).


Figure 64-45 Reorder Columns Dialog

[image: Reorder Columns dialog]



Repeat until you have columns arranged in the desired order.

Click OK.







	
Tip:

You can access the options described in the section by right-clicking a column and selecting from a context menu.















64.2.5.4 Hiding and Showing List Columns

You can use an option on a list's View menu to hide selected list columns. To hide or show columns in your view, perform the following actions in page view mode. To change column order in everyone's view, perform the following actions in page edit mode.

Hide or show list columns in the List Viewer task flow. You can hide or show columns on the Lists page, but this setting is not persisted and reverts back when changing lists or navigating away.

To hide or show list columns:

	
Go to the list instance you want to change.


	
On the View menu, open the Columns submenu (Figure 64-46):


Figure 64-46 Columns Submenu on View Menu

[image: Columns submenu on View menu]



	
Select a column you want to show (a check appears on the menu next to shown columns).


	
Clear a column you want to hide (no check appears on the menu next to hidden columns).


	
Select Show All to show all columns (all columns are checked on the menu).












64.2.5.5 Freezing a Column Position

When a list is too wide to display all of its columns in one view, you can scroll the list left and right. If there is a column you always want to keep in view, you can use column freezing to hold a column in place during scrolling. Freezing causes a selected column to hold its position while the columns to the right of it scroll by. You can set Freeze on one column on a given list instance. Freezing holds in place the selected column and any column to the left of it.




	
Note:

To freeze a column position in your view, perform the following actions in page view mode. To freeze a column position in everyone's view, perform the following actions in page edit mode.







To freeze a column position:

	
Go to the list with a column you want to freeze.


	
Select the relevant column by clicking its header.

The Freeze icon becomes available.


	
Click the Freeze icon (Figure 64-47).




	
Tip:

You can also freeze a column by selecting it and then selecting Freeze from the View menu.








Figure 64-47 Freeze Icon

[image: Freeze icon]





To unfreeze a column, select it as described in step 2, and click the Freeze icon again.




	
Tip:

You can access the options described in the section by right-clicking a column and selecting from a context menu.












64.2.5.6 Wrapping Column Data

Use the Wrap feature to control whether to allow column data to wrap in a selected list column. Data that wraps breaks onto additional lines if it would otherwise exceed the column width. Data that does not wrap, shows only as much data as fits into the current column width (you can widen the column to view the data if you prefer, see Section 64.2.5.2, "Resizing List Columns").




	
Note:

By default, column data is wrapped.







To wrap column data:

	
Go to the list in which to wrap column data.


	
Select the relevant column by clicking its header.


	
Click the Wrap icon.




	
Tip:

You can also wrap data by selecting the column and then selecting Wrap from the Format menu.
You can access the options described in the section by right-clicking a column and selecting from a context menu.









If any data was previously truncated, it now appears in the row with line breaks to accommodate the column's width.




To turn wrapping off, select the relevant column and click the Wrap icon again.






64.2.5.7 Applying Color Banding to List Rows

Color banding refers to a transparent overlay of color applied at specified intervals to list rows or columns. When you define color banding on a list, you specify whether to apply color banding and how often to apply it.

You can easily enhance the readability of a list by applying row or column color banding (Figure 64-48).


Figure 64-48 List with Color Banding

[image: List with color banding]



You can apply color banding to your personal view of a list instance or to everyone's view of a list instance. This section describes how. It contains the following subsections:

	
Section 64.2.5.7.1, "Applying Color Banding to Your Personal View of a List"


	
Section 64.2.5.7.2, "Removing Personal Color Banding"


	
Section 64.2.5.7.3, "Applying Color Banding to Everyone's View of a List Instance"


	
Section 64.2.5.7.4, "Removing Color Banding from Everyone's View of a List"






64.2.5.7.1 Applying Color Banding to Your Personal View of a List

You can apply color banding to list rows or to list columns.

To apply color banding to your personal view of a list instance:

	
Go to the list you want to change.


	
Click the Personalize icon on the task flow header (Figure 64-49).


Figure 64-49 Personalize Icon

[image: Personalize icon]



The List Viewer enters personalize list mode (Figure 64-50).


Figure 64-50 List in Personalize List Mode

[image: List in personalize list mode]



	
From the Banding pick list, select a banding style for the list instance.

Choose from:

	
Row—To specify color banding on list rows.


	
Column—To specify color banding on list columns.


	
None—To turn color banding off.





	
In the Interval field, enter the number of rows or columns to skip between color bands.

For example, when you apply color bands to rows, a value of 1 applies a color band to the second row, fourth row, sixth row, and so on. Figure 64-51 illustrates an interval value of 1.


Figure 64-51 List with Color Banding

[image: List with color banding]



	
Click Save to save your settings and return to the list.

List data is refreshed, now reflecting your color banding settings.









64.2.5.7.2 Removing Personal Color Banding

To remove personal color banding from a list:

	
Go to the list from which to remove color banding.


	
Click the Personalize icon on the task flow header (Figure 64-52).


Figure 64-52 Personalize Icon
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The List Viewer enters personalize list mode.


	
From the Banding pick list, select None.


	
Click Save to save your settings and return to the list.

List data is refreshed, now showing no color banding.









64.2.5.7.3 Applying Color Banding to Everyone's View of a List Instance

When you want your color banding settings to affect everyone's view of a particular list instance, follow the steps in this section.




	
Note:

If you have previously performed a user customization on a list instance to omit color banding, you may need to reset your user customization, as described in Section 64.2.5.7.1, "Applying Color Banding to Your Personal View of a List." Your user customizations take precedence over space-level customizations, and thus may prevent you from seeing the change described in this procedure.







To apply color banding to everyone's view of a list instance:

	
Go to the list you want to customize with color banded rows or columns.


	
Enter edit page mode.




	
See Also:

For information about entering edit page mode, see Section 17.3.1, "Entering and Exiting Page Edit Mode."







The page opens in Composer.


	
Go to the list instance you want to customize, and click the Edit icon on the task flow header (Figure 64-53).


Figure 64-53 Edit Icon on the Task Flow Header in Page Edit Mode

[image: Edit icon on task flow header in page edit mode]



The list enters customize list mode (Figure 64-54).


Figure 64-54 Customize List Mode

[image: Customize List mode]



	
Configure color-banding settings as described in Section 64.2.5.7.1, "Applying Color Banding to Your Personal View of a List."


	
Click Close to exit Composer.









64.2.5.7.4 Removing Color Banding from Everyone's View of a List

To remove color banding from everyone's view of a list instance:

	
Go to the list from which to remove color banding.


	
Enter edit page mode.




	
See Also:

For information about entering edit page mode, see Section 17.3.1, "Entering and Exiting Page Edit Mode."







The page opens in Composer.


	
Go to the list instance you want to customize, and click the Edit icon on the task flow header (Figure 64-55).


Figure 64-55 Edit Icon on the Task Flow Header in Page Edit Mode

[image: Edit icon on task flow header in page edit mode]



The List Viewer enters customize list mode.


	
From the Banding pick list, select None.


	
Click Save to save your changes and exit customize list mode.

The list refreshes, with color banding removed.


	
Click Close to exit Composer.











64.2.5.8 Filtering List Data

The Lists service provides data filtering options for your personal view of a list instance and for everyone's view of the instance. Filtering provides a means of limiting the display of list data to those rows that match your filtering criteria.

Temporary, personal filtering (also called ad hoc filtering) is available with both the List Viewer task flow and Lists page. Custom filtering that affects everyone's view of a list instance is available only with the List Viewer task flow.

This section describes the processes of applying ad hoc, permanent personal, and permanent list filters. It contains the following subsections:

	
Section 64.2.5.8.1, "Applying an Ad Hoc Filter to a List Instance"


	
Section 64.2.5.8.2, "Applying a Permanent, Personal Filter to a List Instance"


	
Section 64.2.5.8.3, "Removing a Permanent, Personal List Filter"


	
Section 64.2.5.8.4, "Applying Filters to Everyone's View of a List"


	
Section 64.2.5.8.5, "Removing Filters from Everyone's View of a List"






64.2.5.8.1 Applying an Ad Hoc Filter to a List Instance

Use ad hoc list filtering to easily find a particular list entry or group of entries in a list instance.




	
Note:

Ad hoc list filtering applies only to Plain Text and Person data types. Columns that use other data types, such as Date and Number, are not used in ad hoc filtering. For example, if you have dates shown in format dd-mon-yy and you filter on jan, you do not see rows with dates in January.







To apply an ad hoc filter to a list instance:

	
Go to the list that contains the data you want to temporarily filter.


	
Click the Filter Rows icon in the List toolbar (Figure 64-56).


Figure 64-56 Filter Rows Icon

[image: Filter Rows icon]






	
Tip:

You can also select Filter Rows from the Actions menu.







The Filter field opens (Figure 64-57).


Figure 64-57 The Filter Field

[image: Filter field]



	
Enter space-separated keywords in the Filter field, and click the Filter icon to execute the filter.

All row details that match any of the keywords are shown.


	
Click the Filter Rows icon again to hide the Filter field and remove the temporary filter.




	
Tip:

You can also select Cancel Filter from the Actions menu.















64.2.5.8.2 Applying a Permanent, Personal Filter to a List Instance

In addition to an ad hoc filter, you can apply a permanent personal filter to your view of a list instance. We use the term permanent to convey the fact that you can keep your list filtered in a particular way for as long as you like. The filter is retained across page navigations within a browser session and across browser sessions.

It is still possible to remove such a filter. This section describes how to apply and remove a permanent personal filter.

To apply or remove a permanent filter on your view of a list instance:

	
Go to the list that contains the data you want to permanently filter.


	
Click the Personalize icon on the task flow header (Figure 64-58).


Figure 64-58 Personalize Icon
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The list enters personalize list mode (Figure 64-59).


Figure 64-59 List in Personalize List Mode

[image: List in personalize list mode]



	
From the Add Filter list, select a column against which to apply a filter.

The selected column appears, ready for a filter definition.


	
Select an operator from the list, and enter the filter content in the field provided (Figure 64-60).


Figure 64-60 Filter Operator and Content
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The filter operators that appear on the list vary according to the data type of the selected column. Table 64-3 lists and describes filter operators as they apply to different data types.


Table 64-3 Filter Operators for List Data Types

	Data Type	Description
	
Boolean

	
Use Boolean data type filter operators to specify that Boolean values in the selected list column must:

	
= —Match the value you specify


	
<>—Not match the value you specify




The Boolean value is expressed as a checkbox. A checked box means TRUE or YES; a cleared box means FALSE or NO.


	
DateTime

	
Use DateTime data type filter operators to specify that date and time values in the selected column must be:

	
= —The same as the date or date and time that you specify


	
>= —More recent or the same as the date or date and time that you specify


	
<>—Any date or date and time other than the value you specify


	
>—More recent than the date or date and time that you specify


	
<= —Preceding or matching the date or date and time that you specify


	
<—Preceding the date or date and time that you specify





	
Number

	
Use Number data type filter operators to specify that number values in the selected column must be:

	
= —Equal to the value you specify


	
>= —Equal to or greater than the value you specify


	
<>—Greater or lesser than the value you specify


	
>—Greater than the value you specify


	
<= —Equal to or lesser than the value you specify


	
<—Lesser than the value you specify





	
Person

	
Use Person data type filter operators to specify that person values in the selected list column must:

	
= —Match the user name you specify


	
Starts With—Start with the character(s) you specify


	
Ends With—End with the character(s) you specify


	
Contains—Include the character(s) you specify


	
<>—Contain any user name other than the one you specify





	
Picture

	
You cannot apply filter operators to a Picture data type in a list.


	
Plain Text

	
Use Plain Text data type filter operators to specify that values in the selected column must:

	
= —Match the characters you specify


	
Starts With—Start with the character(s) you specify


	
Contains—Include the character(s) you specify


	
Ends With—End with the character(s) you specify


	
<>—Contain any value other than the one you specify





	
Rich Text

	
You cannot apply filter operators to a Rich Text data type in a list.








	
When you define multiple filters, Match All Any options appear:

	
Select All to require that displayed rows match all conditions.


	
Select Any to require that displayed rows match at least one condition.





	
Click Save to save your filter criteria and return to the list.

The list is refreshed, now displaying data that matches your filter criteria.









64.2.5.8.3 Removing a Permanent, Personal List Filter

To remove a permanent, personal list filter:

	
Go to the list from which you want to remove personal filtering.


	
Click the Personalize icon on the task flow header (Figure 64-61).


Figure 64-61 Personalize Icon

[image: Personalize icon]



The List Viewer enters personalize list mode.


	
Click the Remove icon next to the filtering criteria you want to remove (Figure 64-62), and then click Save.


Figure 64-62 Remove Icon on a Filter

[image: Remove icon on a filter]



List data is refreshed, now displaying any data previously hidden by a filter.









64.2.5.8.4 Applying Filters to Everyone's View of a List

If you want the list filters you create to apply to all users' views of a particular list instance, simply create the filters in page edit mode.

To apply filters to everyone's view of a list:

	
Go to the list that contains the data you want to filter from everyone's view.


	
Enter edit page mode.




	
See Also:

For information about entering edit page mode, see Section 17.3.1, "Entering and Exiting Page Edit Mode."







The page opens in Composer.


	
Go to the task flow instance you want to filter, and click the Edit icon on the task flow header (Figure 64-63).


Figure 64-63 Edit Icon on the Task Flow Header in Page Edit Mode

[image: Edit icon on task flow header in page edit mode]



The list enters customize list mode (Figure 64-64).


Figure 64-64 Customize List Mode

[image: Customize List mode]



	
Create and apply filtering criteria as described in Section 64.2.5.8.2, "Applying a Permanent, Personal Filter to a List Instance."


	
Click Close to exit Composer.







	
See Also:

For information about removing a filter from everyone's view of a list instance, see Section 64.2.5.8.5, "Removing Filters from Everyone's View of a List."












64.2.5.8.5 Removing Filters from Everyone's View of a List

To remove a filter from everyone's view of a list:

	
Go to the list from which to remove a filter.


	
Enter edit page mode.




	
See Also:

For information about entering edit page mode, see Section 17.3.1, "Entering and Exiting Page Edit Mode."







The page opens in Composer.


	
Click the Edit icon on the List Viewer task flow header (Figure 64-65).


Figure 64-65 Edit Icon on the Task Flow Header in Page Edit Mode

[image: Edit icon on task flow header in page edit mode]



The list enters customize list mode.


	
Click the Remove icon next to the filters you want to remove (Figure 64-66), and then click Save.


Figure 64-66 Remove Filter Icon

[image: Remove Filter icon]



List data is refreshed, now displaying all unfiltered data.


	
Click Close to exit Composer.













64.2.6 Sending a Link to a List to Other Users

The list Actions menu includes a Send Mail option for sending a link to a list through a mail message.

To send a link to a list through mail:

	
Log in, and go to the list instance you want to send as a link through mail.


	
From the list Actions menu, select Send Mail (Figure 64-67).


Figure 64-67 Send Mail Option on Actions Menu

[image: Send Mail option on Actions menu]



A compose message window opens, addressed to space members, with the following information:

	
The name of the space from which the list instance originates


	
The list title and description


	
A link to the space


	
A link to the list instance




Users click the link to the list instance to open a view of the list.




	
Note:

To view the list, users must have access to the space that contains the list instance.








	
Compose the message and send as you would any other mail message.









64.2.7 Exporting a List and Importing a List from an Excel Spreadsheet

The Lists service provides a means of exporting and importing lists. If you can view the list, you can export it to Microsoft Excel 1997 - 2003 and 2007 formats and revise list data in Excel. If you have sufficient privileges to edit the list, you can import the revised list back into Spaces.




	
Tip:

You can also create a list by importing an Excel spreadsheet. For more information, see Section 64.2.3.1, "Creating Lists."







This section describes how to export and import lists and provides information about additional software that may be of use in this process. It includes the following subsections:

	
Section 64.2.7.1, "What You Should Know About Exporting and Importing Lists"


	
Section 64.2.7.2, "Exporting a List to a Spreadsheet"


	
Section 64.2.7.3, "Importing an Exported List"






64.2.7.1 What You Should Know About Exporting and Importing Lists

Use list export and import to add and revise list rows in a Microsoft Excel spreadsheet. List structure and links for the list and list rows are unaffected by export and import. When exporting a list, only the list data is exported, not the list structure nor the links. When a list is imported, new links and modified links will not be affected by the import.

After you export a list, if other changes are made to list data in Spaces, they are overwritten when you import the list. Before content is overwritten, a confirmation dialog provides you with an opportunity to stop the import and preserve Spaces changes.

Importing a spreadsheet cannot be used to modify list structure. However, you can import any spreadsheet to a list that has the same columns. A warning is raised if the spreadsheet was not created from an export of the list, but you can dismiss this warning and proceed if desired. You can also export a rowless list to a spreadsheet, add rows in Excel, and then import it.

You must take care when you export a list not to revise the list structure in Excel nor in Spaces. You cannot import an exported list if the list structure is changed in Spaces after export. You can add and remove list rows in the spreadsheet; such changes are reflected in the list on import.

Adding and removing list columns in the spreadsheet does not affect the list structure. Consequently, when you import a spreadsheet with columns that were removed through Excel, the import succeeds. The columns continue to appear in the imported list; though the deleted column data does not.

When you export a list from Spaces, you are prompted for the Excel format (1997 - 2003 and 2007 formats are offered). To import a spreadsheet, the same formats are accepted.






64.2.7.2 Exporting a List to a Spreadsheet

When you can view a list, you can export the list to a Microsoft Excel file. Exporting enables you to use your Excel skills to easily add to and revise list data. Controls for exporting lists are available in both the List Viewer task flow and on the Lists page.

To export a Spaces list:

	
Go to the list you want to export, and select Export from the Actions menu.


	
Select a format for the output file:

	
MS Excel 2007


	
MS Excel 1997 - 2003





	
Follow your browser's prompts to save the exported file to your local file system.

The list is saved in the Excel format you select. The file name is the list name, with underscores in lieu of character spaces. For example, my list becomes my_list.xlsx or my_list.xls.









64.2.7.3 Importing an Exported List

After you have created or revised list data and saved it in an Excel format, you can import it using controls available in both the List Viewer task flow and on the Lists page. To import list data, you must have, minimally, Edit permission on the page that contains the list.

To import an exported list:

	
Go to the list into which to import a spreadsheet, and select Import from the Actions menu.


	
In the Import from Excel dialog (Figure 64-68), click the Browse button and navigate to and select the relevant spreadsheet.




	
Note:

The spreadsheet must have the same columns as the list.







The file must be in Excel 1997-2003 (*.xls) or 2007 format (*.xlsx).


Figure 64-68 Import from Excel Dialog

[image: Import from Excel dialog]



	
Click Import.

If the spreadsheet was not created from an export of the list, a warning is given. Click Import to proceed.

The list is refreshed, now displaying the imported data. List data is validated on import. If any rows contain validation errors, such errors are presented in a dialog and the import is terminated. You can correct validation errors in the spreadsheet and import again.













64.3 Setting List Viewer Task Flow Properties

The List Viewer task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 64-69).


Figure 64-69 List Viewer Task Flow Parameters in the Component Properties Dialog

[image: List Viewer task flow parameters]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with the List Viewer task flow and describe the parameters that are unique to it:

	
Section 64.3.1, "What You Should Know About List Viewer Task Flow Properties"


	
Section 64.3.2, "List Viewer Task Flow Parameters"






64.3.1 What You Should Know About List Viewer Task Flow Properties

When you set property values on a List Viewer task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 64.3.2, "List Viewer Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














64.3.2 List Viewer Task Flow Parameters

Table 64-4 describes the parameters that are unique to the List Viewer task flow. Note that List Viewer task flow parameter values are set automatically and should not be changed.


Table 64-4 List Viewer Task Flow Parameters

	Parameter	Description
	
List ID

	
A unique identifier for the list to show

Either List ID or Local List ID must have a value. This value is set automatically. Do not edit this value.


	
List Scope ID

	
A unique identifier for the scope containing the list

If no value is present, the current scope is used. This value is set automatically. Do not edit this value.


	
Local List Customization ID

	
A unique identifier within the scope for the list customization

This value is set automatically. Do not edit this value.


	
Local List ID

	
A unique identifier within the scope for the list to show

Either List ID or Local List ID must have a value. This value is set automatically. Do not edit this value.


	
Show List Name and Description

	
A checkbox for specifying whether to display the list name and description

If no value is present, the list name and description are not shown. Values include true and false. This value is set automatically. Do not edit this value. 

















65 Working with the Mail Service

This chapter describes how to use the Send Mail feature and also the features provided through the Mail service. The Send Mail feature does not require the Mail service. That is, even if the Mail service has not been configured in your application, you can use the Send Mail feature with your local mail client. 

This chapter includes the following sections:

	
Section 65.1, "What You Should Know About the Send Mail Feature"


	
Section 65.2, "What You Should Know About the Mail Service"


	
Section 65.3, "Selecting Your Preferred Mail Connection"


	
Section 65.4, "Working with the Mail Service Task Flow"


	
Section 65.5, "Setting Mail Service Task Flow Properties"





Audience

This chapter is intended for users who want to use and manage mail, as well as administrators in Spaces with the Application-Manage Configuration permission and individual space moderators who want to configure mail within their spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if WebCenter Portal's Mail service is not enabled in the current space.









65.1 What You Should Know About the Send Mail Feature

Throughout the application, you can click the Send Mail icon to mail directly from that resource (Figure 65-1).


Figure 65-1 Send Mail Icon

[image: Send Mail icon]



For example, Figure 65-2 shows a discussion topic with the Send Mail icon.


Figure 65-2 Send Mail Icon in a Discussion Topic

[image: Description of Figure 65-2 follows]

Description of "Figure 65-2 Send Mail Icon in a Discussion Topic"





Click the Send Mail icon to open a mail compose window prepopulated with information including the discussion topic title, author, date created, topic text, and links to the discussion and the space. You can edit and add to the mail, as necessary.


Figure 65-3 Mail Compose from a Discussion Topic

[image: Description of Figure 65-3 follows]

Description of "Figure 65-3 Mail Compose from a Discussion Topic"





The way the mail window is prepopulated depends on the resource sending it. For example, from a wiki, Send Mail opens a mail window prepopulated with the name of the wiki, the size, who created it and when, who modified it and when, and a URL link to the wiki.

Mail can be addressed to all members of the space. Space moderators (and anyone granted the Manage Configuration permission on the space) set this through the Services page in the space administration settings. For more information, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List."

If the number of recipients is so large that the mail cannot be prepopulated with the addresses, then you must either enter the addresses manually or set up a distribution list for the space.




	
Tips:

With the Microsoft Outlook local mail client, you must configure Outlook to support comma-delimited mail addresses; that is, choose the Allow comma as address separator checkbox on the Tools - Options - Preferences - E-mail Options - Advanced E-mail Options page.









65.1.1 Configuring the Send Mail Feature

The Send Mail feature does not require WebCenter Portal's Mail service. That is, even if the Mail service has not been configured in your application, the Send Mail feature is available using your local mail client.

Your administrator determines the mail client that the Send Mail feature uses: either WebCenter Portal's Mail service or a local mail client. The default value is a local mail client. If your administrator enabled users to override this mail client setting, then you can choose to use a different mail client on the Mail Preferences page (Figure 65-4).


Figure 65-4 Mail Preferences for Send Mail

[image: Mail Preferences]









65.2 What You Should Know About the Mail Service

The Mail service conveniently exposes familiar mail functionality in your WebCenter Portal application interface. The Mail service runs against the same mail server that provides your regular business mail, and the mail messages exposed in your application are the same messages you would see in your mail inbox. Many of the same actions are also supported. For example, you can send messages with attachments, forward messages, and so on. The Mail service does not replace your company mail, but rather enhances it by making it accessible within WebCenter Portal.

WebCenter Portal's Mail service enables users to perform simple mail functions, such as view, read, create and create with attachments, reply, forward, and delete. All mail is stored in your inbox and can be accessed from there through a link.

The Mail service fetches mails from the inbox folder only. It does not support fetching mails from other folders or moving messages.

The Mail service supports any mail server based on IMAP4 and SMTP protocol. A Spaces application provides access to multiple mail connections. You can use a different mail connection by selecting it in the application's Preferences settings. For more information, see Section 65.3, "Selecting Your Preferred Mail Connection."




	
Note:

You can add a Mail task flow to your page from the Catalog dialog in Oracle Composer. For information about adding a task flow, see Section 17.5, "Adding Resource Catalog Components to Pages."
However, all instances of the Mail task flow in an application run against the same mail server and it serves no purpose to add multiple Mail task flow instances. This is true for all service task flows that require connections to back-end servers, for example, task flows from Discussions, Announcements, and IMP services.









The Mail service exposes features from your mail server through the Mail task flow (Figure 65-5).


Figure 65-5 The Mail Task Flow

[image: Mail task flow]

Description of "Figure 65-5 The Mail Task Flow"





The Mail task flow presents the following features:

	
A menu for specifying which messages to display


	
A Compose icon for starting the process of creating a new message


	
A Refresh icon for updating the task flow with new messages




A space moderator can configure the Mail service to automatically create a mailing list of all space members. Once configured, as members are added to or deleted from the space, the mailing list is updated automatically. For more information, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List." All mails sent to a space mailing list are also posted to the space discussion forum.

Use the Mail service to mail other application users or any user recognized by the back-end server that supports the Mail service.

The Mail service is integrated with the Instant Messaging and Presence (IMP) service to provide additional options for contacting others. Each mail message includes the sender's user name and status icon (Figure 65-6), which you can click to open a context menu with options for starting a chat session or sending a new mail.




	
Note:

If the IMP service is not configured in your application, the status icons are grayed out.








Figure 65-6 User Name and Status Icon

[image: User name and status icon]

Description of "Figure 65-6 User Name and Status Icon "





For more information, see Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)."

Users with page-edit privileges can access the task flow's region parameter through the Component Properties dialog in Composer. For more information about setting the Mail service task flow properties, see Section 65.5, "Setting Mail Service Task Flow Properties."






65.3 Selecting Your Preferred Mail Connection

When your application provides access to multiple mail connections, it also provides a way for you to choose which connection to use. This section describes how.

To choose your preferred mail connection:

	
Click the Preferences link at the top of the application.


	
Click Mail to open the Mail Preferences panel (Figure 65-7).


Figure 65-7 The Mail Preferences Panel

[image: Mail Preferences panel in Preferences dialog box]



	
From the Connection dropdown list, choose the mail connection you want to use for accessing your mail through WebCenter Portal: Spaces.

The options available on this list depend on the connections your system administrator makes available to your application. The No Preference option uses your system-level active mail connection.


	
Under Default mail client for 'Send Mail' action, choose an option to identify the mail application to open when the SendMail command is invoked.

Choose from:

	
Local mail client—Choose to specify that the local mail client you normally use, such as Microsoft Outlook or Mozilla Thunderbird, should open a compose message window when the SendMail command is invoked.


	
WebCenter Portal's Mail Service—Choose to specify to open WebCenter Portal's Mail service compose message window when the SendMail command is invoked.





	
Click OK to save your change and exit the Preferences dialog.


	
Log out of WebCenter Portal: Spaces.


	
Log in to WebCenter Portal: Spaces.


	
If you previously saved your credentials for this mail connection to the WebCenter Portal: Spaces credential store, then you are logged in to the new mail connection automatically.

If you have not previously saved your credentials, log in to this mail connection using Preferences (see Section 35.7, "Providing Login Information for External Applications") or using the login link in a Mail task flow (see Section 65.4.2, "Logging in to Mail").









65.4 Working with the Mail Service Task Flow

The Mail task flow exposes your company's mail server features within the context of your application. Use the Mail task flow to view, respond to, and manage your personal mail.

This section provides information on how to use the Mail task flow. It contains the following subsections:

	
Section 65.4.1, "Adding the Mail Service Task Flow to a Page."


	
Section 65.4.2, "Logging in to Mail"


	
Section 65.4.3, "Personalizing Your View of the Mail Task Flow"


	
Section 65.4.4, "Opening Mail Messages"


	
Section 65.4.5, "Downloading Mail Attachments"


	
Section 65.4.6, "Composing and Sending Mail Messages"


	
Section 65.4.7, "Sending Mail with Attachments"


	
Section 65.4.8, "Removing Attachments from the Add Attachment Window"


	
Section 65.4.9, "Replying to and Forwarding Mail"


	
Section 65.4.10, "Refreshing Mail"


	
Section 65.4.11, "Deleting Mail"






65.4.1 Adding the Mail Service Task Flow to a Page

For the steps to add a Mail service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






65.4.2 Logging in to Mail

Before you can access your mail in an application, you must provide your mail login credentials. The first time you access a Mail task flow, it displays the message depicted in Figure 65-8.


Figure 65-8 Login Message in a Mail Task Flow

[image: Login message in a Mail task flow]

Description of "Figure 65-8 Login Message in a Mail Task Flow"





To log in to a Mail task flow:

	
Go to a Mail task flow, and click the Login to Mail link (Figure 65-8) to open an External Application Login dialog (Figure 65-9).


Figure 65-9 External Application Login Dialog

[image: External Application Login dialog box]

Description of "Figure 65-9 External Application Login Dialog"








	
Note:

The External Application Login dialog may include additional fields and information, depending on the requirements of the service that provides it. For more information about external applications and storing your login credentials in a WebCenter Portal: Spaces application, see Section 35.7, "Providing Login Information for External Applications."








	
Enter your user name and password and any other login credentials that your mail application requires.

Required fields are marked with an asterisk (*).


	
Optionally, choose Remember my login information to store your credentials.

The next time you log in to the application, your mail credentials are retrieved from storage and you are logged in.


	
Click OK, and the Mail task flow displays mails from your inbox.









65.4.3 Personalizing Your View of the Mail Task Flow

You can personalize your view of the Mail task flow by filtering the number of displayed messages. For example, you can choose to display only the messages that were delivered Today, Since Yesterday, This Week, or This Month. Additionally, you can choose to display All messages in your inbox.




	
Note:

By default, the Mail service displays the 50 most recent mail messages from your mail server inbox folder. However, if required, your Fusion Middleware administrator can configure this to a higher value, if your server supports the increase in memory cache that fetching additional mail requires. Care should be taken to have a value suitable to your environment. This value impacts all users. That is, if the Mail service is configured to read 200 recent mail messages, then the Mail service reads 200 recent mail messages for all users.







Personalizations affect only your view of the Mail task flow. No other user's view is changed because of your selection.

To personalize your view of the Mail task flow:

	
Go to the Mail task flow.


	
Open the menu at the top of the task flow (Figure 65-10).


Figure 65-10 The Mail Personalization Menu

[image: Mail personalization menu]

Description of "Figure 65-10 The Mail Personalization Menu"





	
Choose a display option. Choose from:

	
All—to show all messages


	
Today—to show all messages received today


	
Since Yesterday—to show all messages received yesterday and today


	
This Week—to show all messages received in this calendar week


	
This Month—to show all messages received in this calendar month




The Mail task flow redraws, displaying only those messages that match your selection.









65.4.4 Opening Mail Messages

The messages that display in your Mail task flow are the same messages that display in your regular mail application inbox. You open them in much the same way, too.

To open a mail message:

	
Go to a Mail task flow, and click the link to the message you want to open (Figure 65-11).


	

Figure 65-11 A Mail Message Link
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Description of "Figure 65-11 A Mail Message Link"





The message opens (Figure 65-12).


Figure 65-12 A Mail Message
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Description of "Figure 65-12 A Mail Message"





	
After reading the message click Cancel to close the message (Figure 65-13).


Figure 65-13 Cancel a Mail Message

[image: Close button on a mail message]

Description of "Figure 65-13 Cancel a Mail Message"










	
Note:

HTML reports, tables, images that are inlined (copy paste), and fonts viewed in a mail message may not render correctly. The Mail service requires HTML data to be well-formed to display as expected in a mail message.
The mail should show everything that your browser supports. However, some tags, like <script>, are encoded and disabled from execution.














65.4.5 Downloading Mail Attachments

Attachments display in mail messages as links (Figure 65-14).


Figure 65-14 Mail Attachments
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Description of "Figure 65-14 Mail Attachments"





Accessing files associated with attachments is the same as accessing a file from any browser window: simply click the link. Clicking an attachment link opens a download dialog that gives you the option of viewing the file in its native application or saving the file to a local drive. This is browser behavior, so the way you follow through depends on the browser you use.






65.4.6 Composing and Sending Mail Messages

Composing and sending messages through WebCenter Portal's Mail service is very much like doing so in your regular mail application.

To compose and send a mail message:

	
In a Mail task flow, click the Compose icon (Figure 65-15).


	

Figure 65-15 The Compose Icon on a Mail Task Flow

[image: Compose icon on a Mail task flow]

Description of "Figure 65-15 The Compose Icon on a Mail Task Flow"





	
In the Compose window (Figure 65-16), enter recipients in the To field. Separate multiple addresses with a comma (,).


Figure 65-16 Compose Window

[image: Compose window]

Description of "Figure 65-16 Compose Window"





Click the Options dropdown list to include Cc, Bcc, or Reply-to fields in the message. The Reply-to field is prepopulated with the user composing the mail, but it can be changed to any address. From this dropdown list, you also can select to compose the message in plain text, instead of the rich text editor.

The selected options persist until they are changed.

Figure 65-3 shows the compose window with the Cc, Bcc, and Reply-to fields added as well as the rich text editor removed.


Figure 65-17 Mail Compose Window with Different Options Selected
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Description of "Figure 65-17 Mail Compose Window with Different Options Selected"





The Compose window is directly connected to your mail server, so you can use the Find User icon (Figure 65-18) to find mail addresses and contacts.


Figure 65-18 Find User Icon in a Compose Window

[image: Find user icons in a Compose window]

Description of "Figure 65-18 Find User Icon in a Compose Window"





Click the Find User icon and, in the resulting dialog, enter a search term for a user. For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."




	
See Also:

For tips on searching with the Find User icon, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."








Figure 65-19 Select User Dialog
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Description of "Figure 65-19 Select User Dialog"





	
In the Subject field, enter a subject for your message.

Enter up to 255 characters.


	
Compose your message.


	
Click Send.









65.4.7 Sending Mail with Attachments

Just like your regular mail, you can use the Mail task flow to send messages with attachments.

To send a mail with attachments:

	
Create a mail message as described in Section 65.4.6.


	
In the Compose window, click the Attach Files link (Figure 65-20).


Figure 65-20 The Attach Link
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Description of "Figure 65-20 The Attach Link"





The Add Attachment window opens (Figure 65-21).


Figure 65-21 The Add Attachment Window

[image: Add Attachment window]

Description of "Figure 65-21 The Add Attachment Window"





	
Click Browse to locate and choose an attachment.


	
Click Attach to attach the selected file.

The file size must be greater than zero bytes but less than 2 MB. Zero-byte files do not get attached.




	
Note:

It is recommended that you avoid attaching large files, as this causes the server to slow down or not respond. If you attach large files (greater than 2MB), then because of how the HTTP protocol handles attachments, the system reports an error only after reading all of the 2MB characters.








	
Repeat steps 3 and 4 to add additional attachments.

Attachments are listed under the Attachments heading in the Add Attachment window (Figure 65-22).


Figure 65-22 Attachments in the Add Attachment Window

[image: Attachments in the Add Attachment window]

Description of "Figure 65-22 Attachments in the Add Attachment Window"





A Remove Attachment icon appears next to each attachment (Figure 65-22). Click this to remove a selected attachment from the window.


	
Click the Back to Compose link to go back to the Compose window.


	
Click Send.









65.4.8 Removing Attachments from the Add Attachment Window

You can remove attachments from the Add Attachment window and from the Compose window:

	
To remove mail attachments from the Add Attachment window, click the Remove Attachment icon next to the attachment you want to remove (Figure 65-23).


Figure 65-23 Attachments in the Add Attachment Window

[image: Attachments in the Add Attachment window]

Description of "Figure 65-23 Attachments in the Add Attachment Window"





For information about accessing the Add Attachment window, see Section 65.4.7, "Sending Mail with Attachments."


	
To remove mail attachments from the Compose window, click the Remove Attachment icon next to the attachment you want to remove (Figure 65-24).


Figure 65-24 Remove Attachment Icon in the Compose Window

[image: Remove Attachment icon in the Compose window]

Description of "Figure 65-24 Remove Attachment Icon in the Compose Window"





For information about accessing the Compose window, see Section 65.4.6, "Composing and Sending Mail Messages."









65.4.9 Replying to and Forwarding Mail

When you reply to or forward a mail, the mail content is sent as an attached HTML file instead of being displayed in the mail message window. Replying to and forwarding mail is as straightforward as in your regular mail application.

To reply to or forward a mail message:

	
Go to a Mail task flow.


	
Click the link to the message you want to reply to or forward (Figure 65-25).


Figure 65-25 A Mail Message Link

[image: Mail message link]

Description of "Figure 65-25 A Mail Message Link"





The message opens (Figure 65-26).


Figure 65-26 A Mail Message

[image: A Mail message]

Description of "Figure 65-26 A Mail Message"





	
Choose one from the following options:

	
Click Reply to reply to the sender. Figure 65-27 shows the Reply Mail window.


Figure 65-27 A Reply Mail Message Window

[image: Description of Figure 65-27 follows]

Description of "Figure 65-27 A Reply Mail Message Window"





	
Click Reply All to reply to all recipients (including users who received a blind copy).


	
Click Forward to send the message on to a third party. Figure 65-28 shows the resulting window.


Figure 65-28 A Forwarded Mail Message Window

[image: Forwarded mail message window]

Description of "Figure 65-28 A Forwarded Mail Message Window"








	
In the resulting Compose window, enter recipients in the To field as you require. Separate multiple entries with a comma (,)

Click the Options dropdown list to add Cc, Bcc, or Reply-to fields or to remove the rich text editor and use plain text.

The Compose window is directly connected to your mail server, so you can use the Find User icon to find mail addresses and contacts. Click the Find User icon and, in the resulting dialog, enter a search term for a user. For tips on searching for a user in the identity store, see Section 52.3.4.1, "Searching for a User or Group in the Identity Store."


	
Optionally, revise the subject in the Subject field.


	
In the Mail's message area, enter your reply or any forwarding message before or after the original message.


	
Optionally, add attachments as described in Section 65.4.7, "Sending Mail with Attachments."


	
Click Send.

The message is sent, and the original message reappears.


	
Click Cancel at the bottom of the original message to close the window (Figure 65-29).


Figure 65-29 Cancel Message

[image: Close button]

Description of "Figure 65-29 Cancel Message"












65.4.10 Refreshing Mail

You must perform a refresh to check for new mail messages. Because the refresh operation triggers an event to the server to check for new mails, it may take a while to get new messages. Therefore, you may have to refresh a couple of times to display new mails in the Mail task flow.

To refresh Mail:

	
Go to the Mail task flow.


	
Click the Refresh icon (Figure 65-30) on the task flow.


Figure 65-30 The Refresh Icon on the Mail Task Flow

[image: Refresh icon on the Mail task flow]

Description of "Figure 65-30 The Refresh Icon on the Mail Task Flow"





The Mail task flow displays the latest mails.









65.4.11 Deleting Mail

You can easily remove a message from your inbox.

To delete a Mail message:

	
Open the message you want to delete as described in Section 65.4.4, "Opening Mail Messages."


	
Click Delete at the top of the message (Figure 65-31).


Figure 65-31 Delete Message

[image: Delete Message button]












65.5 Setting Mail Service Task Flow Properties

The Mail service task flow has associated properties, which users with sufficient privileges can access from the Component Properties dialog in Oracle Composer (Figure 65-32).


Figure 65-32 Mail Task Flow Component Properties

[image: Description of Figure 65-32 follows]

Description of "Figure 65-32 Mail Task Flow Component Properties"





For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Mail service task flow and describe the properties on the Parameters tab.

	
Section 65.5.1, "What You Should Know About the Mail Service Task Flow Properties"


	
Section 65.5.2, "Mail Service Task Flow Parameters"






65.5.1 What You Should Know About the Mail Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 65.5.2, "Mail Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














65.5.2 Mail Service Task Flow Parameters

The Mail task flow has one associated region parameter: Tabular. Using the EL value type, enter a value of true to display the information associated with a mail message, such as its subject, sender, and, date sent, in a tabular format. Figure 65-33 illustrates a tabular format Mail task flow.


Figure 65-33 A Mail Task Flow where the Region Parameter Tabular Is Set to True

[image: Mail task flow where tabularView is set to true]

Description of "Figure 65-33 A Mail Task Flow where the Region Parameter Tabular Is Set to True"














66 Working with the Notes Service

This chapter describes the features and functions of the Notes service, and provides specific how-to information about creating personal notes.




	
Note:

The Notes service is available only in the Spaces application, not in Framework applications.







This chapter includes the following sections:

	
Section 66.1, "What You Should Know About the Notes Service"


	
Section 66.2, "Working with the Notes Service Task Flow"


	
Section 66.3, "Setting Notes Service Task Flow Properties"





Audience

This chapter is intended for Spaces users interested in creating personal notes in the Spaces application.

The Spaces administrator has the authority to expose or hide a particular service's task flows. Tasks discussed in this chapter are not available to you if the Notes service is hidden.



66.1 What You Should Know About the Notes Service

The Notes service provides useful features for writing yourself reminders in the form of personal notes. You can add notes by using the Notes task flow, which displays the personal notes of the currently logged in user (Figure 66-1). Only the notes that you create are displayed in the Notes task flow. No other user sees your notes, and you do not see any other user's notes.


Figure 66-1 A Notes Task Flow

[image: Notes task flow]

Description of "Figure 66-1 A Notes Task Flow"





You can filter your Notes list by note titles. Filtering enables you to narrow the focus of your Notes to just the notes that match your filtering criteria. Consider devising a naming scheme for your notes to make the most of filtering.

The Notes service is integrated with the Links service. In a space or Home space, by using the Link service, you can link a note to an object like a document, list, or announcement. While you can link to a new note (Figure 66-2), you cannot link to existing notes. All users who have access to the object can view the linked note too. For more information, see Section 63.2.2.5, "Adding and Linking to a Note."


Figure 66-2 Linking a Discussion Topic to a New Note

[image: Linking a Discussion Topic to a New Note]

Description of "Figure 66-2 Linking a Discussion Topic to a New Note"









66.2 Working with the Notes Service Task Flow

Every work day brings new things that you, and only you, must remember: I before E except after C. Use only bonded 25# paper for your report. John hides his candy in the coffee room stir-stick drawer. Spaces offers a way for you to keep track of these useful, sometimes vital, bits of information through Notes.

This section describes how to use the Notes task flow. It includes the following subsections:

	
Section 66.2.1, "Adding the Notes Service Task Flow to a Resource Catalog"


	
Section 66.2.2, "Adding the Notes Service Task Flow to a Page"


	
Section 66.2.3, "Creating a Note"


	
Section 66.2.4, "Filtering and Clearing Filters on Notes"


	
Section 66.2.5, "Editing Note Details"


	
Section 66.2.6, "Refreshing Your View of Notes"


	
Section 66.2.7, "Deleting Notes"






66.2.1 Adding the Notes Service Task Flow to a Resource Catalog

Spaces provides rich Resource Catalogs that expose components and connections that users can add to their pages. You can use a Resource Catalog to populate resources such as page templates, navigation models, pages, and task flows.

As the Spaces administrator or a space moderator, you can make the Notes task flow available in a custom Resource Catalog so that users can add the task flow to their pages and use it for adding personal notes.

To make the Notes task flow available in a custom Resource Catalog:

	
Create a Resource Catalog or make a copy of an existing one. Creating a Resource Catalog follows the same procedure as any other resource. For information about creating a blank Resource Catalog, see Section 10.2, "Creating Resources." For information about copying an existing Resource Catalog, see Section 10.4.1, "Copying a Resource."


	
On the Resources page, select the Resource Catalog to which you want to add the Notes task flow.


	
From the Edit menu, choose Edit.


	
If you have created folders (see Section 16.3.1.1, "Creating a Folder") and want to add resources inside a particular folder, select the folder in the Edit dialog.


	
In the Edit dialog, select Add, and then Add From Library, as shown in Figure 66-3.


Figure 66-3 Adding a Resource to a Resource Catalog

[image: Adding a Resource to a Resource Catalog]

Description of "Figure 66-3 Adding a Resource to a Resource Catalog "





	
In the Add Resource Catalog Item dialog, select Task Flows from the list displayed on the left.


	
From the list on the right, select Notes (Figure 66-4).


Figure 66-4 Adding the Notes Task Flow to a Resource Catalog

[image: Adding the Notes Task Flow to a Resource Catalog]

Description of "Figure 66-4 Adding the Notes Task Flow to a Resource Catalog"





	
Click Add.

The Notes task flow displays in the Edit dialog of your Resource Catalog (Figure 66-5).


Figure 66-5 Notes Task Flow in a Resource Catalog

[image: Notes Task Flow in a Resource Catalog]

Description of "Figure 66-5 Notes Task Flow in a Resource Catalog"





	
Click OK to close the Edit dialog.


	
Configure the Spaces application or the space to use the new catalog as the default one. For information, see Section 16.10, "Configuring Resource Catalogs in Your Application."









66.2.2 Adding the Notes Service Task Flow to a Page

To add the Notes task flow to a page, you need to click Add next to the Notes task flow in the Resource Catalog, as shown in Figure 66-5.

The procedure for adding the Notes service task flow to a page is same as adding any other component from the Resource Catalog. For the generic procedure, see Section 17.5.1, "Adding a Component to a Page."


Figure 66-6 Selecting the Notes Task Flow from the Resource Catalog

[image: Notes Task Flow in the Resource Catalog]

Description of "Figure 66-6 Selecting the Notes Task Flow from the Resource Catalog"









66.2.3 Creating a Note

Create notes to track personally relevant bits of information, such as your favorite route to the fifth floor, the place to find the most plentiful desk supplies, and so on. This section describes how to create a note.

To create a note:

	
Navigate to the page that contains the Notes task flow.


	
In the Notes task flow, click the Create a new note icon (Figure 66-7).


Figure 66-7 The Create a New Note Icon in a Notes Task Flow

[image: Create a new note icon]

Description of "Figure 66-7 The Create a New Note Icon in a Notes Task Flow"





A panel opens with fields for entering your note (Figure 66-8).


Figure 66-8 Panel for Creating a New Note

[image: Panel for creating a new note]

Description of "Figure 66-8 Panel for Creating a New Note"





	
In the Title field, enter a note title.

The note title is rendered as a link in the list of notes. You can filter your notes by their titles. Consider devising a naming scheme for your notes to make the most of filtering. For more information about filtering, see Section 66.2.4, "Filtering and Clearing Filters on Notes."


	
In the Detail field, enter note content.


	
Click Save to save the note.

When you click Save, the detail panel remains open, allowing you to create additional notes. After you finish, click Close to exit the panel.









66.2.4 Filtering and Clearing Filters on Notes

Your note list may become lengthy, making it a challenge to find a particular note. In a given session with the Notes task flow, you can shorten the list by filtering out all but the note titles that contain your filtering criteria. Enter a filtering value to temporarily limit display to notes that match the value. You can filter the Notes list against whole or partial words. Filtering looks for matches anywhere in the title.

To clear the filter, click the filtering icon again.

To filter notes:

	
Go to a Notes task flow, and click the Filter notes icon (Figure 66-9).


Figure 66-9 The Filter Notes Icon

[image: Filter notes icon]

Description of "Figure 66-9 The Filter Notes Icon"





A filtering toolbar opens.


	
Enter your filtering term in the field provided in the filtering toolbar, then click the Filter icon next to the field, to apply the filter (Figure 66-10).


Figure 66-10 Filtering Toolbar

[image: Filtering toolbar]

Description of "Figure 66-10 Filtering Toolbar"








	
Note:

Filtering terms are not case sensitive. Use whole or partial words. Filtering looks for matches anywhere in the title.








	
Click the Cancel Filter icon to remove the filter and display all notes (Figure 66-11).


Figure 66-11 The Cancel Filter Icon

[image: Cancel Filter icon]

Description of "Figure 66-11 The Cancel Filter Icon"












66.2.5 Editing Note Details

Things change. This truism may apply to the details you have entered about a particular note. If so, it's an easy matter to revise note details. This section tells you how.

To edit note details:

	
Go to a Notes task flow, then click the title of the note that you want to edit (Figure 66-12).


Figure 66-12 A Note Title in the Notes Task Flow

[image: A note title in the Notes task flow]

Description of "Figure 66-12 A Note Title in the Notes Task Flow"





Note details display at the top of the task flow (Figure 66-13).


Figure 66-13 Note Details

[image: Note details]

Description of "Figure 66-13 Note Details"





	
Edit the details in the Title and Detail fields as you prefer.


	
Click the Update button to save your changes and exit the edit panel.









66.2.6 Refreshing Your View of Notes

The Notes task flow includes a Refresh notes icon that you can use to refresh your display of notes (Figure 66-14).


Figure 66-14 The Refresh Notes Icon on a Notes Task Flow

[image: Refresh icon on a Notes task flow]



This comes in handy for updating your view of the task flow with any recent changes. Click the Refresh notes icon, and the Notes task flow redraws, reflecting recent changes.






66.2.7 Deleting Notes

When a note has outlived its usefulness, you can remove it from the Notes task flow. Each note comes equipped with its own Delete note icon. This section describes how to delete a note.

To delete a note:

	
Go to a Notes task flow, and click the Delete note icon next to the note you want to delete (Figure 66-15).


Figure 66-15 Delete Note Icon

[image: Delete note icon]

Description of "Figure 66-15 Delete Note Icon"





A Delete Note dialog opens (Figure 66-16).


Figure 66-16 Delete Note Dialog

[image: Delete Note dialog]

Description of "Figure 66-16 Delete Note Dialog"





	
Click the Delete button to delete the selected note.











66.3 Setting Notes Service Task Flow Properties

The Notes service task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 66-17). Many properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components."


Figure 66-17 Notes Service Task Flow Component Properties

[image: Component Properties dialog]

Description of "Figure 66-17 Notes Service Task Flow Component Properties"





To access the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The Notes service task flow does not have any unique properties, and therefore no Parameters tab in the Component Properties dialog.

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.

















67 Working with the Polls Service

This chapter discusses the Polls service and provides information about its task flows. The Polls service lets you create, edit, take, and analyze online polls. With polls, you can survey your audience (such as their opinions and their experience level), check whether they can recall important information, and gather feedback on the efficacy of presentations.

This chapter includes the following sections:

	
Section 67.1, "What You Should Know About the Polls Service"


	
Section 67.2, "Working with Polls Service Task Flows"


	
Section 67.3, "Setting Polls Service Task Flow Properties"





Audience

This chapter is intended for users who want to create and manage polls, as well as administrators in Spaces with the Application-Manage Configuration permission and individual space moderators who want to configure polls within their spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



67.1 What You Should Know About the Polls Service

With the Polls service, in addition to taking available polls, you can do the following:

	
Create a poll. You can create quick polls with only a name, description, and question, or you can create detailed polls.


	
Create a template for polls. Templates contain the same questions, sections, and welcome and closing content.


	
Edit an existing poll; for example, add questions to the poll, change existing questions, or publish (open) and close the poll.


	
Take a specific or the most recently-published poll.


	
View poll results.


	
See the status of all polls and available actions for each poll, such as edit, delete, publish, analyze, and clear results.




The Polls service is integrated with the Instant Messaging and Presence service in the Polls Manager.

Figure 67-1 shows a sample quick poll.


Figure 67-1 Quick Poll

[image: Quick Poll]

Description of "Figure 67-1 Quick Poll"





More detailed poll functionality is available through the Polls Manager (Figure 67-2).


Figure 67-2 Polls Manager

[image: Polls Manager at runtime]

Description of "Figure 67-2 Polls Manager"





Polls created through the Polls Manager must be published and open to be taken. Users cannot take unpublished or closed polls.






67.2 Working with Polls Service Task Flows

The Polls task flows let you create, take, and manage polls. This section includes the following subsections:

	
Section 67.2.1, "Adding a Polls Service Task Flow to a Page"


	
Section 67.2.2, "Creating a Quick Poll"


	
Section 67.2.3, "Taking Polls"


	
Section 67.2.4, "Working with the Polls Manager"


	
Section 67.2.5, "Viewing Poll Results"






67.2.1 Adding a Polls Service Task Flow to a Page

To add a Polls service task flow to a page in a Spaces application:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to polls (Figure 67-3).


Figure 67-3 Opening the Polls Section in the Resource Catalog

[image: Polls section in the resource catalog]



	
Click Add next to the task flow that you want to add to your page (Figure 67-4).


Figure 67-4 Polls Selections in a Space

[image: Task flows under Polls]






	
See Also:

Chapter 16, "Working with Resource Catalogs"















67.2.2 Creating a Quick Poll

Quick Polls allow one-question polls to be published immediately. Each quick poll needs its own Quick Poll task flow on the page.

On the General tab, enter a name and description for your poll, and the number of days for the poll to stay open. The name you enter appears in the Component Properties as a parameter in the Take Polls and View Poll Results task flows.


Figure 67-5 Quick Poll - General

[image: Quick poll - General Tab]

Description of "Figure 67-5 Quick Poll - General"





On the Question tab, design your one-question poll, and click OK.




	
Note:

The same types of questions are available in the Quick Poll task flow and in the Polls Manager task flow.








Figure 67-6 Quick Poll - Question

[image: edit quick poll]

Description of "Figure 67-6 Quick Poll - Question"





Quick polls can be managed with the Polls Manager. Or, in Edit Page mode, you can click the Design Poll button to edit the quick poll.




	
See Also:

Section 67.3.2, "Polls Service Task Flow Parameters"












67.2.3 Taking Polls

To take a poll, simply select or enter your choice, and click Vote.

The Take Polls task flow displays the most recently-published available poll, unless it is set to display a specific poll with the Poll Id parameter. After a user submits a response for that poll, this task flow displays the next most recently-published poll.




	
See Also:

Section 67.3.2, "Polls Service Task Flow Parameters"








Figure 67-7 Take Polls

[image: Take Polls with multiple choice questions]

Description of "Figure 67-7 Take Polls"









67.2.4 Working with the Polls Manager

The Polls Manager lets you create polls, view the status all current polls, and perform operations on existing polls, including edit, save (as poll or as a poll template), publish, clear results, close, analyze, and delete.

See the latest poll data by clicking the Refresh icon on the Polls Manager view (Figure 67-8).


Figure 67-8 Polls Manager

[image: Polls Manager]

Description of "Figure 67-8 Polls Manager"





To add a new poll, click Create Poll.

On the Design page, click Add to populate the poll with an existing template or with questions and surrounding text (Figure 67-9).


Figure 67-9 Polls Manager - Add

[image: Polls Manager - Design tab to add content]

Description of "Figure 67-9 Polls Manager - Add"





Click Add Section to enter any explanatory text in a rich text editor (Figure 67-10).


Figure 67-10 Polls Manager - Design Page to Create/Edit Section

[image: Create Section part of the Polls Manager]

Description of "Figure 67-10 Polls Manager - Design Page to Create/Edit Section"





Click Add Question to add each poll question (Figure 67-11). New questions are added to top of the poll, so you may want to enter poll questions in reverse order.


Figure 67-11 Polls Manager - Design Page to Create/Edit Questions

[image: Polls Manager - Design tab]

Description of "Figure 67-11 Polls Manager - Design Page to Create/Edit Questions"





There are four question types:

	
Multiple Choice (Only One Answer)


	
Multiple Choice (Multiple Answer)


	
Matrix of Choices (Only One Answer Per Row)


	
Matrix of Choices (Multiple Answers Per Row)




With matrix questions, responses are presented in columns and rows. In this example, the current design looks like Figure 67-12.


Figure 67-12 Polls Manager - Design Page

[image: Polls Manager - Design tab]

Description of "Figure 67-12 Polls Manager - Design Page"





To apply a template, you must have an existing template saved. For example, when you save any poll, you can select to save it as a template.


Figure 67-13 Saving a Poll as a Template

[image: Description of Figure 67-13 follows]

Description of "Figure 67-13 Saving a Poll as a Template"





After it is saved as a template, you later apply that poll template to other polls.


Figure 67-14 Applying a Poll Template

[image: Description of Figure 67-14 follows]

Description of "Figure 67-14 Applying a Poll Template"





On Schedule page, choose publish and close options for the poll. Polls must be published and open to be taken. Users cannot take unpublished or closed polls.

In Publish Options, choose to keep the poll in draft mode for further editing, publish it immediately, or publish it on a future date. Click the Select Date and Time icon to enter the publishing time through a calendar. Click Edit Introduction Message to customize in the rich text editor the text provided at the beginning of the poll.

In Close Options, choose to close the published poll after it reaches a certain number of responses or on a certain date. If you choose both options, then the poll closes when either condition is first met. Click the Select Date and Time icon to enter the closing time through a calendar. Click Edit Closing Message to customize in the rich text editor the text provided at the end of the poll.


Figure 67-15 Polls Manager - Schedule

[image: Polls Manager - Schedule tab]

Description of "Figure 67-15 Polls Manager - Schedule"





On the Settings page, choose what to display after the poll is taken (Figure 67-16). For example, you can set a custom JSF task flow as Thank You page that appears after the poll is taken.


Figure 67-16 Polls Manager - Settings

[image: Polls Manager - Settings]



On the Analyze page, view the poll data. Use the Questions box on the right to toggle between multiple questions (Figure 67-17).


Figure 67-17 Polls Manager - Analyze

[image: Polls Manager - Analyze tab]

Description of "Figure 67-17 Polls Manager - Analyze"









67.2.5 Viewing Poll Results

The View Poll Result task flow provides a graphical view of poll results. The View Poll Results task flow must be set to display a specific poll with the Poll Id parameter.

For more information, see Section 67.3, "Setting Polls Service Task Flow Properties."








67.3 Setting Polls Service Task Flow Properties

The Polls service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 67-18).


Figure 67-18 Task Flow Component Properties

[image: Component properties for the Poll Manager task flow]

Description of "Figure 67-18 Task Flow Component Properties"





For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Polls service task flows and describe the properties on the Parameters tab.

	
Section 67.3.1, "What You Should Know About the Polls Service Task Flow Properties"


	
Section 67.3.2, "Polls Service Task Flow Parameters"






67.3.1 What You Should Know About the Polls Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 67.3.2, "Polls Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














67.3.2 Polls Service Task Flow Parameters

Table 67-1 describes the parameters that are unique to the Polls service task flows.


Table 67-1 Polls Service Task Flow Parameters

	Parameter	Description
	
Scope

	
The space name from which polls are to be fetched. If this is supplied, then polls of that particular space are shown.

On the Home space, when this parameter is not supplied, it fetches polls from all spaces.

This parameter appears in the properties for the Polls Manager task flow.


	
Show User Data Only

	
This parameter determines whether to display only those polls created by the user.

Set to Yes to display only those polls created by the user. Set to No (default) to display all polls. If the scope parameter is specified, then this parameter works the same but within only that scope.

This parameter appears in the properties for the Polls Manager task flow.


	
Poll Id

	
The name of the poll to display, available from the dropdown list.

This parameter appears in the properties for the following task flows.

	
Take Polls


	
View Poll Results





	
Show In Edit Mode

	
This parameter determines whether users can edit a quick poll.

When this parameter is set to No, the Design Poll button for editing the quick poll only appears in page edit mode only; it is not visible to users viewing the page. When this parameter is set to Yes, the Design Poll button appears in both view and edit modes, so users can edit the quick poll.

This parameter appears in the properties for the Quick Poll task flow.

















68 Working with the RSS Service

This chapter describes how to use the RSS service. The RSS service provides the ability to publish content from Oracle WebCenter Portal: Services as news feeds in RSS 2.0 and Atom 1.0 formats. News feeds deliver content update information to your favorite RSS or Atom reader. In addition, the RSS service enables you to view news feeds from external sources on your application pages in an RSS Viewer.

This chapter includes the following sections:

	
Section 68.1, "What You Should Know About the RSS Service"


	
Section 68.2, "Obtaining Service News Feeds"


	
Section 68.3, "Working with the RSS Task Flow"


	
Section 68.4, "Setting RSS Service Task Flow Properties"





Audience

This chapter is intended for Spaces users interested in publishing news feeds from WebCenter Portal services and external sources on their application pages. Much of this information also applies to any Framework application, though it is written with Spaces users in mind. For information about Framework applications, see "Integrating the RSS Service" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter Portal.

The Spaces administrator has the authority to expose or hide some space features and services. Contact your Spaces administrator if some tasks discussed in this chapter are not available to you.



68.1 What You Should Know About the RSS Service

The RSS service exposes its features in the following ways:

	
The RSS icon on a service task flow - enables you to publish content from WebCenter Portal service as a news feed.


	
A dedicated RSS Manager page (Spaces only) - displays a list of published feeds from all accessible spaces for viewing in either RSS 2.0 or Atom 1.0 news readers.


	
The RSS task flow - adds an RSS viewer to the page for displaying feeds from external sources and WebCenter Portal service.







	
Note:

The RSS service does not support non-ASCII user names and passwords if the character encoding of the browser-based basic authentication is different from the character encoding of the system on which Oracle WebCenter Portal is deployed. On a Linux system, the character encoding is generally different, and therefore the RSS service does not support non-ASCII credentials.
If the character encoding is same, users can use corresponding non-ASCII credentials. For example, for the Oracle WebCenter Portal instance installed on French Windows Server 2003, users can use a French user name on the French Windows to pass the basic authentication using Internet Explorer.









This section includes the following subsections:

	
Section 68.1.1, "RSS Icon"


	
Section 68.1.2, "RSS Manager"


	
Section 68.1.3, "RSS Task Flow"






68.1.1 RSS Icon

RSS news feeds deliver content update information on the Recent Activities, Discussions, Lists, and Announcements services. Figure 68-1 shows the RSS icon available on the Announcements task flow in a Spaces page.


Figure 68-1 RSS Icon in the Announcements Task Flow

[image: RSS icon on a Recent Activity task flow]

Description of "Figure 68-1 RSS Icon in the Announcements Task Flow"









68.1.2 RSS Manager

In a Spaces application, you can obtain news feeds from individual task flow instances and also from the RSS Manager. Access the RSS Manager by clicking the RSS link at the bottom of the Spaces application (Figure 68-2).


Figure 68-2 The RSS Link in Spaces

[image: RSS link in WebCenter Spaces]

Description of "Figure 68-2 The RSS Link in Spaces"





The RSS Manager displays nodes for all the spaces for which RSS feeds have been enabled (Figure 68-3).


Figure 68-3 Expanded Space Nodes in the RSS Manager
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Description of "Figure 68-3 Expanded Space Nodes in the RSS Manager"





Expand a space node to obtain both RSS 2.0 and Atom 1.0 news feeds from individual services.

A space must be news feed-enabled before you can obtain feed URLs from it. For information, see Section 51.4.6, "Enabling or Disabling RSS News Feeds for a Space." Additionally, your reader of choice must support HTTP authentication.

When you access a news feed item in your reader of choice, the item links back into your application. Because the application itself requires authentication before you can access much of its content, your reader must be equipped to pass your login credentials to securely deliver access.

The level of detail provided through a service news feed depends on the feed source. For example, when you pull a news feed for recently added or modified lists, your news reader provides the list titles and (if available) shows descriptions of the most recently added or modified lists (Figure 68-4).


Figure 68-4 A Lists News Feed

[image: Group space lists news feed]

Description of "Figure 68-4 A Lists News Feed"





The list titles in a feed are linked. Click a list title, and it takes you back into your application with the selected list displayed (Figure 68-5).


Figure 68-5 A List Opened from an RSS Feed and Displayed in Spaces

[image: List displayed as top-level tab]

Description of "Figure 68-5 A List Opened from an RSS Feed and Displayed in Spaces"





In contrast, when you pull a news feed from a particular list, it shows recently added or revised row details and provides links to individual rows. When you click such a link, it also takes you back into your application, with the list content displayed.

The news feeds you obtain from a Spaces application are context-aware, providing content only from the space from which they originate. For example, if you provide a list feed from the Finance space, your news reader displays list content that is unique to the Finance space. If you add a list feed from the Languages space, your news reader displays list content that is unique to the Languages space.

The RSS service delivers news feeds from the following services:

	
Recent Activities

The recent activity news feed tracks updates to your application that are normally reflected in a Recent Activity list and that have occurred within the last three days. For more information, see Section 68.2.1, "Obtaining the Recent Activities News Feed."


	
Discussions

The discussion forums news feed tracks updates to all discussion forums in a particular space. See Section 68.2.2, "Obtaining the Discussion Forums News Feed."


	
Lists (Spaces only)

There are two types of news feeds that can be delivered from the Lists service—all newly created or changed lists in a space (from the Lists task flow) and revisions to the data of a particular list in a space (from the List Viewer task flow on the Lists page). The news feed content depends on whether you get the news feed URL from the Lists task flow or the List Viewer task flow. For more information, see Section 68.2.3, "Obtaining List News Feeds."


	
Announcements

The Announcements news feed tracks additions and revisions to announcements from a particular space, from all spaces, or application-wide, depending on the location of the feed source. For more information, see Section 68.2.4, "Obtaining the Announcements News Feed."




You can to obtain news feed URLs for all applicable services either from the RSS Manager or the required service's task flows.






68.1.3 RSS Task Flow

If you want to add a news feed from an external site to your application, the RSS service provides an RSS task flow (Figure 68-6).


Figure 68-6 The RSS Task Flow
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Description of "Figure 68-6 The RSS Task Flow"





You can add the RSS task flow to a page and configure it to display content from any external RSS feed. Additionally, the RSS task flow supports login credential passing, by using an external application.




	
See Also:

	
For information about adding the RSS task flow, see Section 68.3.1, "Adding an RSS Service Task Flow to a Page."


	
For information about specifying a feed for the RSS task flow, see Section 68.3.4, "Editing the Feed Location of an RSS Task Flow."












The RSS task flow can render news feeds outside of a corporate firewall. However, to consume external news feeds outside of the firewall, your Spaces administrator must have configured proxies for the RSS service. Contact your Spaces administrator if you cannot consume external feeds but want to do so. To contact the administrator, click the Administrator link at the bottom of the Spaces application.


Accessing External Applications

Every time you access a secure news feed item, you must log on to that secure application to view content. You can either supply login credentials each time you access an application, or let an external application store and manage your login credentials. After your credentials for a particular application are stored, you are logged in to that application automatically when you log in to your Spaces application. You can provide this capability for all frequently used external applications.

If the secured application you want to access is not registered as an external application, perform the steps listed in Section 35.7, "Providing Login Information for External Applications."








68.2 Obtaining Service News Feeds

Each participating service provides news feeds from locations unique to that service.

This section steps you through obtaining those feeds. It includes the following subsections:

	
Section 68.2.1, "Obtaining the Recent Activities News Feed"


	
Section 68.2.2, "Obtaining the Discussion Forums News Feed"


	
Section 68.2.3, "Obtaining List News Feeds"


	
Section 68.2.4, "Obtaining the Announcements News Feed"






68.2.1 Obtaining the Recent Activities News Feed

Use news feeds from the Recent Activities service to keep track of the wide range of activity happening in one or more spaces within the last three days. To consume a space Recent Activities news feed, you must be a member of the selected space and the space must be enabled to provide news feeds.

Spaces provides two locations for pulling a news feed from the Recent Activities service: the RSS Manager and the Recent Activity task flow.

Both the RSS Manager and the Recent Activity task flow provide the same news feed content: additions or revisions to spaces and space pages, documents, discussion forums, lists, and so on. For more information, see Chapter 69, "Working with the Recent Activities Service."

Assuming a default configuration, a news feed URL from a Recent Activity task flow in a space provides information about the activity in that space. A news feed URL from a Recent Activity task flow in your Home space provides information about the activities in a particular space.




	
Note:

A Recent Activity task flow can be configured to display the recent activity of a space other than the one where it has been placed. In such a case, the news feed from that list provides information on the activities of the space identified during configuration. For more information, see Section 69.3, "Setting Recent Activities Task Flow Properties."







This section describes how to obtain a news feed for the Recent Activity task flow from both the locations, the RSS Manager and the Recent Activity task flow. It contains the following subsections:

	
Section 68.2.1.1, "Obtaining a Recent Activity News Feed URL from the RSS Manager"


	
Section 68.2.1.2, "Obtaining a News Feed URL from the Recent Activity Task Flow"






68.2.1.1 Obtaining a Recent Activity News Feed URL from the RSS Manager

The RSS Manager provides news feeds for both RSS 2.0 and Atom 1.0 news readers. It lists all RSS-enabled spaces of which you are a member. Each listed space can be expanded to display the services for which it offers news feeds (Figure 68-7).


Figure 68-7 The Recent Activity Service for a Space in the RSS Manager
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Description of "Figure 68-7 The Recent Activity Service for a Space in the RSS Manager"





To obtain a Recent Activity list news feed URL from the RSS Manager:

	
Click the RSS link at the bottom of the Spaces application (Figure 68-8).


Figure 68-8 The RSS Link
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Description of "Figure 68-8 The RSS Link"





	
If required, expand the node of the space for which you want to monitor recent activities.

You can expand a space node by clicking the Expand icon, as shown in Figure 68-9, or by right-clicking the space name and selecting the Expand option from the resulting context menu.


Figure 68-9 Expand Icon in RSS Manager
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Description of "Figure 68-9 Expand Icon in RSS Manager"





	
Under the relevant space, right-click the RSS 2.0 or Atom 1.0 icon next to Recent Activity, and, from the resulting browser context menu, select the copy-link command.

The command you select depends on your current browser. For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


	
Go to your news reader and initiate an add-subscription action.

How you do this depends on the news reader you use.


	
Paste the link you copied in step 3 into the relevant field in your news reader.

You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."









68.2.1.2 Obtaining a News Feed URL from the Recent Activity Task Flow

The Recent Activity task flow has its own RSS icon. Using this icon, you can get the Recent Activity list news feed URL. Recent Activity RSS feeds provide the same information that you can find in a Recent Activity list. This includes such things as additions or revisions to pages, documents, discussion forums, lists, and so on. The news feed tracks activity occurring over the last three days.

For an RSS icon to be active in a Recent Activity task flow, you must be a member of the space from which you want to obtain the news feed and news feeds must be enabled for the relevant space.

To obtain a Recent Activity list news feed URL from the Recent Activity list:

	
Go to your Home space or the space that contains the Recent Activity list from which you want to obtain an RSS feed.

For information about navigating to a space, see Section 29.3.1, "Opening Spaces." A space may be configured to display in full-screen mode. For more information, see Section 51.4.9, "Changing the Page Template for a Space."


	
Right-click the RSS icon in the toolbar of the Recent Activity list, and from the resulting context menu, select the copy-link command.

The command you select depends on your current browser. For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.

Alternatively, drag the RSS icon onto your news reader of choice. This may allow you to skip the other steps in this procedure. If you use the drag-and-drop method, you may have to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 2 into the relevant field in your RSS reader.




	
Note:

The news feed URL in a Recent Activity task flow is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.1.1, "Obtaining a Recent Activity News Feed URL from the RSS Manager."












You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."











68.2.2 Obtaining the Discussion Forums News Feed

Use Discussion Forum news feeds to keep track of additions and revisions to a selected space's discussions. There are three locations from which to obtain discussion forums news feed URLs: the RSS Manager, the Discussions page, and the Discussion Forums task flow. All discussion RSS and Atom URLs provide the same feed; that is, additions and revisions to all discussions in a selected space.

This section contains the following subsections:

	
Section 68.2.2.1, "Obtaining a Discussion Forum News Feed from the RSS Manager"


	
Section 68.2.2.2, "Obtaining a News Feed from the Discussions Page"


	
Section 68.2.2.3, "Obtaining a News Feed from a Discussion Forums Task Flow"






68.2.2.1 Obtaining a Discussion Forum News Feed from the RSS Manager

The RSS Manager provides Discussion Forum news feeds for both RSS 2.0 and Atom 1.0 news readers. Select a feed from any news-feed-enabled space of which you are a member. Use discussion forum news feeds to track additions and revisions to a selected space's discussion forums.

To obtain a discussion forum news feed URL from the RSS Manager:

	
Click the RSS link at the bottom of the Spaces application (Figure 68-10).


Figure 68-10 The RSS Link
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Description of "Figure 68-10 The RSS Link"





	
In RSS Manager, if required, expand the node of the space that contains the discussions you want to use as a news feed.

You can expand a space node by clicking the Expand icon to the left of it or by right-clicking the space name and selecting an expand option from the resulting context menu.


	
Right-click the RSS 2.0 or Atom 1.0 icon next to Discussions (Figure 68-11), and, from the resulting context menu, select the copy-link command.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-11 RSS 2.0 and Atom 1.0 Icons Next to a Discussions Node in the RSS Manager
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Description of "Figure 68-11 RSS 2.0 and Atom 1.0 Icons Next to a Discussions Node in the RSS Manager"





Alternatively, if you drag the RSS icon onto a news reader, you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your news reader and initiate an add-subscription action.

How you do this depends on the news reader you use.


	
Paste the link you copied in step 3 into the relevant field in your preferred news reader.

You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."









68.2.2.2 Obtaining a News Feed from the Discussions Page

The Discussions page provides a convenient location for grabbing a news feed URL while monitoring discussions.

To get an RSS URL for all discussions of a space from the Discussions page:

	
Go to the space that contains the discussion forums you want to use as an RSS feed.

For information about navigating to a space, see Section 29.3.1, "Opening Spaces." For information about showing hidden pages, see Section 29.3.4, "Showing Hidden Pages."


	
Click Discussions on the navigation bar to open the Discussions page.

If the Discussions page is not available, open the Personalize Pages page and select Discussions. When the page appears on the navigation bar, click it to open it. For more information about locating and opening pages, see Section 29.3.2, "Opening Pages."


	
Right-click the RSS icon on the Discussions page (Figure 68-12), and from the resulting context menu, select the copy-link command.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-12 An RSS Icon on a Discussions Page
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Description of "Figure 68-12 An RSS Icon on a Discussions Page"





Alternatively, if you drag the RSS icon onto your news reader, you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 3 into the relevant field in your preferred RSS reader.

You may need to enter your Spaces credentials. To learn more, see Section 68.1, "What You Should Know About the RSS Service."




	
Note:

The news feed URL on the Discussions page is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, then do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.2.1, "Obtaining a Discussion Forum News Feed from the RSS Manager."




















68.2.2.3 Obtaining a News Feed from a Discussion Forums Task Flow

The Discussion Forums task flow provides another location from where you can obtain a discussions news feed for a selected space. The placement of this task flow within a space is at the discretion of the space's designers, so we cannot pinpoint where you may find this task flow. But, wherever you find it, an RSS icon is available to provide you with an RSS news feed URL. This section describes how to use it.

To obtain a news feed URL from a Discussion Forums task flow:

	
Go to the page in the required space that contains a Discussion Forums task flow.

For information about navigating to a space, see Section 29.3.1, "Opening Spaces."


	
Right-click the RSS icon on the task flow (Figure 68-13), and, from the resulting context menu, select the copy-link command.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-13 An RSS Icon in a Discussion Forums Task Flow
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Description of "Figure 68-13 An RSS Icon in a Discussion Forums Task Flow"





Alternatively, if you drag the RSS icon onto your news reader, you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 2 into the relevant field in your preferred RSS reader.




	
Note:

The news feed URL in the Discussions task flow is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.2.1, "Obtaining a Discussion Forum News Feed from the RSS Manager."












You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."











68.2.3 Obtaining List News Feeds

Lists provide a vital form of tracking just about everything within an organization. For example, a group might want a membership list that outlines assigned roles and contact information. A project lead might set up a list that tracks issue resolution.

It follows that it would be useful to track creation of and revisions to such lists from one convenient location: your favorite news reader.

The Lists service provides two options for keeping track of changes through a news reader:

	
Keep track of all recently added or modified lists in a given space.


	
Keep track of recently added or modified data rows in a given list.




You can obtain the news feed URL for lists from three locations: the RSS Manager, the Lists page, and any Lists task flow on a given page. The RSS Manager and the Lists page provide access to both types of Lists feeds. Individual List task flows provide feeds for data changes to the rows of the displayed list.

This section describes how to obtain a news feed for recently added or modified list rows or lists from a selected space. It includes the following subsections:

	
Section 68.2.3.1, "Obtaining a List News Feed from the RSS Manager"


	
Section 68.2.3.2, "Obtaining a News Feed from the Lists Page"


	
Section 68.2.3.3, "Obtaining a News Feed from a Lists Task Flow"






68.2.3.1 Obtaining a List News Feed from the RSS Manager

The RSS Manager provides two types of list news feeds: a feed of recently added or revised lists in a space and a feed of recent data changes to the rows of one particular list. Additionally, the RSS Manager provides feeds for an RSS 2.0 reader and an Atom 1.0 reader. The main requirement for any news reader you use is that it supports HTTP authentication (for more information, see Section 68.1, "What You Should Know About the RSS Service").

To obtain a list news feed from the RSS Manager:

	
Click the RSS button at the bottom of the Spaces application (Figure 68-14).


Figure 68-14 The RSS Link
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In the RSS Manager, expand the node for the space that contains the lists from which to obtain an RSS feed.


	
Right-click the RSS 2.0 or Atom 1.0 icon next to List Service to get RSS feeds for all lists in the space (Figure 68-15). Then, from the resulting context menu, select the copy-link command.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-15 The Lists Service Node on the RSS Manager Page
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Description of "Figure 68-15 The Lists Service Node on the RSS Manager Page"





Alternatively, if you drag the news feed icon onto your reader you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 3 into the relevant field in your preferred RSS reader.

You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."









68.2.3.2 Obtaining a News Feed from the Lists Page

Each space has its own Lists page from where you can access all the lists available in your space. As you navigate through space pages in your Spaces application, you may come across a list you find particularly informative, for example, a list of project issues. It may be useful to you to track recent additions and revisions to such a list. Each list comes with its own RSS news feed, making it easy to subscribe to the list on-the-spot.

This section describes how to obtain news feed URLs from the Lists page. Note that the Lists page provides news feeds for RSS 2.0 readers only. If you want to obtain a feed for an Atom 1.0 news reader, use the RSS Manager.

To obtain a news feed from the Lists page:

	
Go to the space that contains the list you want to track.

For information about navigating to a space, see Section 29.3.1, "Opening Spaces."


	
Navigate to the Lists page and open the required list.

If the Lists page is not available, open the Personalize Pages page and select the Lists page for display. For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."


	
Right-click the RSS icon (Figure 68-16), and from the resulting context menu, select the copy-link command.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-16 A List on the Lists Page
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Description of "Figure 68-16 A List on the Lists Page"





Alternatively, if you drag the news feed icon onto your reader you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 3 into the relevant field in your preferred RSS reader.




	
Note:

The news feed URL on the Lists page is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.3.1, "Obtaining a List News Feed from the RSS Manager."












You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."









68.2.3.3 Obtaining a News Feed from a Lists Task Flow

Each Lists task flow provides RSS news feeds for recent additions and revisions to all of the lists it contains and also for recent data changes to the rows of an individual list.

To obtain a news feed from a Lists task flow:

	
Go to the space that contains the list you want to track.

For information about navigating to a space, see Section 29.3.1, "Opening Spaces." For information about showing hidden pages, see Section 29.3.4, "Showing Hidden Pages."


	
To obtain a news feed of recently added and revised lists in a space, right-click the RSS icon in the Lists pane on the left side of the Lists task flow (Figure 68-16), and select the copy-link command from the resulting context menu.

To obtain a news feed of data changes to the rows of an individual list, display the list in the right pane by selecting the list name from the left pane (Figure 68-16). Right-click the RSS icon in the right pane, and select the copy-link command from the resulting context menu.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-17 A List Task Flow
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Alternatively, if you drag the RSS icon onto your news reader you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 2 into the relevant field in your preferred RSS reader.




	
Note:

The news feed URL in the List task flow is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.3.1, "Obtaining a List News Feed from the RSS Manager."












You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."











68.2.4 Obtaining the Announcements News Feed

Announcements are excellent candidates for news feeds. Usually they are short, concise, and full of timely and valuable information. If you are a member of multiple spaces, it would be convenient to be able to access all announcements from one location: your favorite news reader.

You can obtain an announcement news feed from three locations: the RSS Manager, the Announcements page, and an Announcements task flow.

This section contains the following subsections:

	
Section 68.2.4.1, "Obtaining an Announcements News Feed from the RSS Manager"


	
Section 68.2.4.2, "Obtaining a News Feed from the Announcements Page"


	
Section 68.2.4.3, "Obtaining a News Feed from the Announcements Task Flow"






68.2.4.1 Obtaining an Announcements News Feed from the RSS Manager

The RSS Manager provides two types of feeds for the Announcements service: RSS 2.0 and Atom 1.0. Use either of these to keep track of all new and revised announcements in a particular space.

To obtain an Announcements news feed from the RSS Manager:

	
Click the RSS link at the bottom of the Spaces application (Figure 68-18).


Figure 68-18 The RSS Link
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Description of "Figure 68-18 The RSS Link"





	
In the RSS Manager, expand the node for the space that contains the announcements you want to track through a news reader.


	
Right-click the RSS 2.0 or Atom 1.0 icon next to Announcements (Figure 68-15), and, from the resulting context menu, select the copy-link command.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-19 Announcements Node on the RSS Page
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Description of "Figure 68-19 Announcements Node on the RSS Page"





Alternatively, if you drag the news feed icon onto your reader, you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 3 into the relevant field in your preferred RSS reader.

You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."









68.2.4.2 Obtaining a News Feed from the Announcements Page

The Announcements service provides the Announcement Manager, which is exposed from the main Announcements page in the Spaces application. You can use it to create and revise announcements and to obtain an announcements news feed URL.

Unlike the RSS Manager, the Announcement Manager provides a news feed only for RSS 2.0 news readers. If you prefer an Atom 1.0 feed, use the RSS Manager to obtain the feed URL. For more information, see Section 68.2.4.1, "Obtaining an Announcements News Feed from the RSS Manager."

To obtain a news feed from the Announcements page:

	
Open the Announcements page. For more information, see Section 29.3, "Hiding, Opening, and Rearranging Pages."

The Announcements page is available in every space provided the space is configured to display announcements. For information about enabling services in a space, see Section 51.10.1, "Enabling and Disabling Services Available to a Space."




	
Note:

You can also access the Announcement Manager by clicking the Open Announcement Manager icon in the Announcements task flow. This icon is not displayed in the Announcements task flow if you do not have the required privileges.








	
Right-click the RSS icon on the right on the Announcements page (Figure 68-20), and select the copy-link command from the resulting context menu.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-20 The RSS Icon on the Announcements Page
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Description of "Figure 68-20 The RSS Icon on the Announcements Page"





Alternatively, if you drag the news feed icon onto your reader you can skip most of the other steps. You may need to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 2 into the relevant field in your preferred RSS reader.




	
Note:

The news feed URL on the Announcements page is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.4.1, "Obtaining an Announcements News Feed from the RSS Manager."












You may require to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."









68.2.4.3 Obtaining a News Feed from the Announcements Task Flow

The Announcements task flow also provides access to a news feed URL. Like the Announcements page, the task flow provides feeds only for RSS 2.0 news readers. If you prefer an Atom 1.0 feed, use the RSS Manager to obtain the feed URL. For more information, see Section 68.2.4.1, "Obtaining an Announcements News Feed from the RSS Manager."

To obtain a news feed from the Announcements task flow:

	
Go to the page that contains the Announcements task flow you want to view.


	
Right-click the RSS icon on the Announcements task flow (Figure 68-21), and select the copy-link command from the resulting context menu.

For example, in the Firefox browser, the copy-link command is Copy Link Location. In the Internet Explorer browser, the copy-link command is Copy Shortcut.


Figure 68-21 RSS Icon in the Announcements Task Flow

[image: RSS icon in an Announcements Task Flow]

Description of "Figure 68-21 RSS Icon in the Announcements Task Flow"





Alternatively, if you drag the news feed icon onto your reader you can skip most of the other steps. You may require to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."


	
Go to your RSS reader and initiate an add-subscription action.

How you do this depends on the RSS reader you use.


	
Paste the link you copied in step 2 into the relevant field in your preferred RSS reader.




	
Note:

The news feed URL in the Announcements task flow is for RSS 2.0 news readers only. If you prefer to use an Atom 1.0 news reader, do either of the following:
	
Append &format=ATOM1.0 to the RSS news feed URL you pasted.


	
Get the Atom 1.0 URL from the RSS Manager and use that URL here. For more information, see Section 68.2.4.1, "Obtaining an Announcements News Feed from the RSS Manager."












You may require to enter your Spaces credentials. For more information, see Section 68.1, "What You Should Know About the RSS Service."













68.3 Working with the RSS Task Flow

The RSS task flow enables you to include an RSS viewer, which you can use to view content from external news feeds within your application page.

This section contains the following subsections:

	
Section 68.3.1, "Adding an RSS Service Task Flow to a Page"


	
Section 68.3.2, "Refreshing an RSS Task Flow"


	
Section 68.3.3, "Deleting an RSS Task Flow From the Page"


	
Section 68.3.4, "Editing the Feed Location of an RSS Task Flow"






68.3.1 Adding an RSS Service Task Flow to a Page

You can incorporate news feeds from external sources into your application pages by using the RSS task flow. You can add the RSS task flow from the Resource Catalog in Composer.

Each instance of the RSS viewer displays news feeds from one source. If you plan to display multiple external news feeds on a particular page, you can place multiple RSS task flows on that page.

To display content from an external RSS feed, proxies must be configured in your application. Contact your Spaces administrator if you have problems accessing external RSS feeds in your task flow.

Spaces provide the ability to store and manage your login credentials by using external applications. After your credentials for a particular application are stored, you are logged in to that application automatically when you log on to your application. So, if an external RSS news feed or WebCenter Portal service feed requires your login credentials, when you get to the step where you specify the feed URL, you may have to also specify the name of the external application that is configured to store your login credentials for reading a secure RSS feed.

To add the RSS service task flow, you need to select the RSS service task flow from the Alerts and Updates folder in the Resource Catalog (Figure 68-22). The procedure to add the RSS task flow to a page is same as adding any other task flow. For information about the generic procedure, see Section 51.16.1, "Adding a Space Task Flow to a Page."

After adding the RSS task flow, you need to edit the task flow to specify the RSS feed location. For information, see Section 68.3.4, "Editing the Feed Location of an RSS Task Flow."


Figure 68-22 RSS Service Task Flow in the Resource Catalog
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Description of "Figure 68-22 RSS Service Task Flow in the Resource Catalog"









68.3.2 Refreshing an RSS Task Flow

The RSS task flow, along with other page components, gets refreshed with every server request. However, as the content from news feeds may be dynamic, you have the option of refreshing the RSS task flow yourself by using the Refresh icon (Figure 68-23), when required.


Figure 68-23 The Refresh Icon on an RSS Task Flow
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Description of "Figure 68-23 The Refresh Icon on an RSS Task Flow"





The task flow updates and displays latest data from the external source.






68.3.3 Deleting an RSS Task Flow From the Page

If you have the required privileges, you have the option to delete the RSS task flow from a page by using the Remove icon on the task flow (Figure 68-24) in Edit mode of the page.


Figure 68-24 Remove Icon on an RSS Task Flow
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Description of "Figure 68-24 Remove Icon on an RSS Task Flow"





When you click the Remove icon, the Delete Component dialog displays. Click Delete in this dialog to delete the task flow from the page.






68.3.4 Editing the Feed Location of an RSS Task Flow

You can change the feed URL or the external application ID specified for an RSS task flow at any point of time.

To change the feed location of an RSS task flow:

	
Go to the web site that provides the RSS feed you want to view through the RSS viewer, and copy its RSS URL.


	
Log on to your Spaces application, and go the page that contains the RSS task flow you want to modify.


	
Switch to the page's Edit mode.


	
Click the Edit icon on the header of the RSS task flow.


	
In the Component Properties dialog, click the Parameters tab, if not open already. (Figure 68-25).


Figure 68-25 Specifying the Feed Location in the RSS Task Flow
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Description of "Figure 68-25 Specifying the Feed Location in the RSS Task Flow"





	
In the RSS Feed URL field, paste the URL that you copied in step 1.

For information about the RSS task flow parameters, see Section 68.4, "Setting RSS Service Task Flow Properties."


	
If the feed you want to publish requires authentication, in the External Application ID field, specify the name of the external application configured to store your login credentials for accessing that feed.

For information about external applications, see "Accessing External Applications".


	
Click Apply to save your changes and continue editing, or click OK to save your changes and close the dialog.

Content from the external feed you specified is displayed within the RSS task flow.


	
Click Save at the top-right corner of Composer to save your changes and remain in Composer.


	
Optionally, click Close to exit Composer.











68.4 Setting RSS Service Task Flow Properties

The RSS service task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Composer (Figure 68-26).


Figure 68-26 RSS Task Flow Component Properties
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Description of "Figure 68-26 RSS Task Flow Component Properties"





For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the RSS service task flow and describe the properties on the Parameters tab:

	
Section 68.4.1, "What You Should Know About the RSS Service Task Flow Properties"


	
Section 68.4.2, "RSS Service Task Flow Parameters"






68.4.1 What You Should Know About the RSS Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 68.4.2, "RSS Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














68.4.2 RSS Service Task Flow Parameters

Table 68-1 describes the parameters that are unique to the RSS task flow.


Table 68-1 RSS Service Task Flow Parameters

	Parameter	Description
	
External Application ID

	
The name of the external application that is configured to store a user's login credentials for reading a secure RSS feed.

If you are not sure whether there is an external application configured to store your credentials, contact your Spaces administrator. To contact the administrator, click the Administrator link at the bottom of the Spaces application.


	
RSS Feed URL

	
The URL to access the RSS feed. For example, to use the Oracle Press Releases RSS feed, enter:

http://www.oracle.com/rss/rss_ocom_pr.xml

















69 Working with the Recent Activities Service

The Recent Activities service provides a means of tracking recent activities within a Spaces application. For example, the Recent Activities task flow tracks the changes you and other users make to application pages, documents, discussion forums, lists, and the like (Figure 69-1).


Figure 69-1 The Recent Activities Task Flow
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Description of "Figure 69-1 The Recent Activities Task Flow"





This chapter provides information about the Recent Activities service. It contains the following sections:

	
Section 69.1, "What You Should Know About the Recent Activities Service"


	
Section 69.2, "Working with the Recent Activities Task Flow"


	
Section 69.3, "Setting Recent Activities Task Flow Properties"







	
Note:

You can track recent activities through your favorite RSS reader. For more information, see Chapter 68, "Working with the RSS Service."








Audience

This chapter is intended for users interested in understanding and using the features of the Recent Activities service.

The Spaces administrator has the authority to expose or hide task flows from a particular service. Tasks discussed in this chapter are not available to you if the relevant service is hidden.




	
Note:

For information about seeded user roles, see Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









69.1 What You Should Know About the Recent Activities Service

The Recent Activities service provides the Recent Activities task flow, which links to the additions and revisions to some services available to your application (Figure 69-2).


Figure 69-2 The Recent Activities Task Flow
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Description of "Figure 69-2 The Recent Activities Task Flow"





Tracked changes include additions and revisions to pages, documents, discussion forums, lists (Spaces only), and events.

By default, the Recent Activity list displays 25 recent activities for a given service. If more than 25 activities have occurred, the Recent Activity list displays the 25 most recent. Your application administrator can change the default value, so your limit may be more or less than 25.

The level of information provided in the Recent Activity list depends on the context in which the list is placed. For example, in a Framework application, changes are tracked on all applicable services across the entire application.

In a space page, the Recent Activity list summarizes changes occurring in that space. In a personal space, the Recent Activities task flow must have a space specified (see Section 69.3, "Setting Recent Activities Task Flow Properties"). The Recent Activity list summarizes changes occurring in the specified space.

You can use the Recent Activity list as an access point to new and revised content. The Recent Activity list displays new and revised content as links, which you can click to go directly to the content.






69.2 Working with the Recent Activities Task Flow

With the Recent Activities task flow, there is very little to do to make the most of its features. It automatically detects recent activities on other WebCenter Portal service and reports on its findings.

There are, nonetheless, a few recent-activity-centered actions you can take on the task flow. For example, you can personalize your view of recent activities, access a changed item, and refresh your view to update the task flow with the latest changes. This section tells you how. It contains the following subsections:

	
Section 69.2.1, "Adding the Recent Activities Task Flow to a Custom Resource Catalog"


	
Section 69.2.2, "Adding the Recent Activities Task Flow to a Page"


	
Section 69.2.3, "Personalizing the Recent Activities Task Flow"


	
Section 69.2.4, "Accessing Recently Acted-On Items"


	
Section 69.2.5, "Refreshing the Recent Activities Task Flow"






69.2.1 Adding the Recent Activities Task Flow to a Custom Resource Catalog

WebCenter Portal: Spaces provides rich Resource Catalogs that expose components and connections that Spaces users can add to their pages. You can use a Resource Catalog to populate resources such as page templates, navigation models, pages, and task flows.

As a Spaces administrator or a space moderator, you can make the Recent Activities task flow available in a custom Resource Catalog so that users can add the task flow to their pages and use it for keeping track of recent activities.

To make the Recent Activities task flow available in a custom Resource Catalog:

	
Create a Resource Catalog or make a copy of an existing one. Creating a Resource Catalog follows the same procedure as any other resource. For information about creating a blank Resource Catalog, see Section 10.2, "Creating Resources." For information about copying an existing Resource Catalog, see Section 10.4.1, "Copying a Resource."


	
To add the Recent Activities task flow to the Resource Catalog, on the Resources page, select your newly created Resource Catalog.


	
From the Edit menu, choose Edit.


	
If you have created folders (see Section 16.3.1.1, "Creating a Folder") and want to add resources inside a particular folder, select the folder in the Edit dialog.


	
In the Edit dialog, select Add, and then Add From Library.


	
In the Add Resource Catalog Item dialog, click Task Flows on the left.


	
From the list on the right, select Recent Activities (Figure 69-3).


Figure 69-3 Adding the Recent Activities Task Flow to a Resource Catalog
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Description of "Figure 69-3 Adding the Recent Activities Task Flow to a Resource Catalog"





	
Click Add.

The Recent Activity task flow displays in your Resource Catalog.


Figure 69-4 Recent Activities Task Flow in a Resource Catalog
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Description of "Figure 69-4 Recent Activities Task Flow in a Resource Catalog"





	
Click OK to close the Edit dialog of your Resource Catalog.


	
Configure the application or space to use the new catalog as the default one. For information, see Section 16.10, "Configuring Resource Catalogs in Your Application."









69.2.2 Adding the Recent Activities Task Flow to a Page

To add the Recent Activities task flow to a page, you need to add Recent Activities using the Resource Catalog (Figure 69-5).


Figure 69-5 Selecting the Recent Activities Task Flow from the Resource Catalog
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Description of "Figure 69-5 Selecting the Recent Activities Task Flow from the Resource Catalog"





The procedure for adding the Recent Activities task flow to a page is same as adding any component from the Resource Catalog. For the generic procedure, see Section 17.5.1, "Adding a Component to a Page."






69.2.3 Personalizing the Recent Activities Task Flow

The Recent Activities task flow provides a way to specify the range of time within which to view changes and additions to other services. These time-range options display on the Show menu in the Recent Activities task flow toolbar (Figure 69-6).


Figure 69-6 Time-Range Options on the Recent Activity List
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Description of "Figure 69-6 Time-Range Options on the Recent Activity List"





Select an option from the Show menu to view recent activities occurring within the selected time range. The time range you select is applicable only to that task flow instance. If you have more than one Recent Activities task flow instance on the page, you can display activities from a different time range in each task flow instance.




	
Tip:

Ensure that your application Preferences reflect your own local time zone. To access your time zone preference in the Spaces application, click the Preferences link at the top of the application and then select General. For more information, see Section 35.3, "Setting Date and Time Preferences."







The default options on the Show menu include:

	
Today—The task flow displays all activities that have taken place between 12:00AM (2400 hours) and now.


	
Since Yesterday—The task flow displays all activities that have taken place between now and yesterday at 12:00AM (2400 hours).


	
Last 7 days—The task flow displays all activities that have taken place in the last 7 days.


	
Last 30 days—The task flow displays all activities that have taken place in the last 30 days.







	
Note:

These options are described according to their default meanings. In some instances, an advanced user can provide alternative definitions for them. For more information, see Section 69.3, "Setting Recent Activities Task Flow Properties."












69.2.4 Accessing Recently Acted-On Items

The Recent Activities task flow groups the different services it reports on into nodes that are named for each service (Figure 69-7).


Figure 69-7 Service Nodes in the Recent Activities Task Flow
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Expand a node, and access the changed item directly by clicking its link (Figure 69-8).


Figure 69-8 Recent Discussion Link in the Recent Activities Task Flow
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Description of "Figure 69-8 Recent Discussion Link in the Recent Activities Task Flow"





The targets of linked items open on dynamically-generated pages, or in the Spaces application, on dynamically-generated, top-level tabs. Link targets display according to their parent service. For example, click a Discussions service link to access a forum or a specific topic under a forum; click a Lists service link to access an updated list of lists or a specific updated list; click an event to display event details; and so on.






69.2.5 Refreshing the Recent Activities Task Flow

If you prefer not to wait for an automatic refresh of the Recent Activities task flow, you always have the option of refreshing the task flow yourself by clicking its Refresh icon (Figure 69-9).


Figure 69-9 The Refresh Icon on a Recent Activities Task Flow

[image: Refresh icon on a Recent Activity task flow]
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The task flow updates and indicates the number of recently-changed items by increasing the value displayed in parenthesis next to each affected service.








69.3 Setting Recent Activities Task Flow Properties

For the steps to add a Recent Activities task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."

The Recent Activities task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle WebCenter Portal's Composer (Figure 69-10).


Figure 69-10 Recent Activities Task Flow Component Properties

[image: Recent Activity task flow properties]
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Recent Activities task flow and describe the properties on the Parameters tab:

	
Section 69.3.1, "What You Should Know About the Recent Activities Task Flow Properties"


	
Section 69.3.2, "Recent Activities Task Flow Parameters"






69.3.1 What You Should Know About the Recent Activities Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 69.3.2, "Recent Activities Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. These properties are unique to the task flow type. For more information, see Chapter 17, "Setting Properties on Page Components." For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Chapter 17, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Chapter 17, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Chapter 17, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Expression Builder icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














69.3.2 Recent Activities Task Flow Parameters

Table 69-1 describes the parameters that are unique to the Recent Activities task flow.


Table 69-1 Recent Activities Task Flow Parameters

	Parameter	Description
	
Group Space Name

	
Applicable in Spaces only. Leave this field blank if the task flow is on a Framework application page.

Use this parameter to specify the space for which to display recent activities. On a personal space page, use this to narrow the range of displayed activities. Rather than tracking activities application-wide—the default behavior—you can, for example, set a Constant value of a particular space's display name.

On a space page, use this parameter to display some other space's recent activities or to display recent activities for all spaces.

Valid values include:

	
The display name or GUID of the space to search


	
null (empty), to search according to the contextual default

Use for space pages only. An empty value on a space page searches the current space.

Note: Always specify a value on a personal space page. An empty value does not return any results. If no value is specified, then the following message displays in the Recent Activities task flow:


Recent Activity in the Personal Space requires a groupSpace taskflow parameter value to use for the search.


	
defaultScope (or the defaultScope GUID), to search all spaces





	
Medium Time Period in minutes

	
Defaults to Yesterday on the Recent Activity Show menu. For defining the time range between Short and Long within which activities are displayed on the Recent Activity list.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")


	
Long Time Period in minutes

	
Defaults to Last 7 Days on the Recent Activity Show menu. Used for defining the time range between Medium and Longest within which activities are displayed on the Recent Activity list.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")


	
Longest Time Period in minutes

	
Defaults to Last 30 Days on the Recent Activity Show menu. For defining the longest range of time within which activities are displayed on the Recent Activity list.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")


	
Shortest Time Period in minutes

	
Defaults to Today on the Recent Activity Show menu. Used for defining the shortest range of time within which activities are displayed on the Recent Activity list. Today is measured from midnight in your selected time zone.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")

















70 Working with the Worklist Service

The Worklist service provides access to all the worklist items that require your attention. These worklist items are displayed on your application page, where you can view and act on all items in one place. These worklist items may be queried from all of the BPEL servers configured in your application.

This chapter contains the following sections:

	
Section 70.1, "What You Should Know About the Worklist Service"


	
Section 70.2, "Adding a Worklist Service Task Flow to a Page"


	
Section 70.3, "Working with the Worklist Service Task Flow"


	
Section 70.4, "Setting Worklist Service Task Flow Properties"





Audience

This chapter is intended for users interested in understanding and using the features of the Worklist service to track their tasks, notifications, and alerts.

The Spaces application administrator has the authority to expose or hide task flows from a particular service. Tasks discussed in this chapter are not available to you if the relevant service is hidden.




	
Note:

For information about seeded user roles, see "Managing Users and Roles for WebCenter Portal: Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.









70.1 What You Should Know About the Worklist Service

The Worklist service provides access to BPEL worklist items that are created when a BPEL workflow process is invoked, or when messages are sent to the worklist channel on the Oracle User Messaging Service.

In Spaces, the Worklist task flow (Figure 70-1) enables you to view and respond to all the worklist items that are allocated to you. If BPEL workflows are enabled in Spaces, you must add a Worklist task flow to a page if you want to see your space membership notifications, invitations to join new spaces, and so on.


Figure 70-1 Worklist Task Flow

[image: Worklist task flow]

Description of "Figure 70-1 Worklist Task Flow"





The Worklist task flow provides a fast and easy way to view and respond to messages, alerts, and notifications from the automated processes in place in your organization. You can click an item in the Worklist task flow to view details in a separate window (Figure 70-2).


Figure 70-2 Worklist Notification

[image: Description of Figure 70-2 follows]

Description of "Figure 70-2 Worklist Notification"





For example, in Spaces, if you are selected as an approver for space membership, every time a user applies to become a member of the space a notification is sent to your Worklist. This is just one example of the types of notifications and requests that can be posted on your Worklist.

One Worklist item might be a request for space membership. Response to such a request would be to approve or reject it. Another Worklist item might be a notice of acceptance as a member of a space. Response to such a notification would be to acknowledge that you have received it. These are two small examples of a much wider range of possible messages, alerts, notifications, and responses.

The Worklist only shows items from the Oracle SOA Suite BPEL Servers. Some Worklist items are kicked off by events that are associated with an externally defined workflow. A workflow maps the route an item follows after an event kicks off. For example, a workflow might define the way a project assignment is routed, such as from administrator, to moderator, and then to participant. Additionally, it specifies what happens (if anything) when the assignee responds (such as with an Acknowledge). This type of workflow is enabled in a Workflow server that comes with Oracle SOA Suite. The definition of these workflows is an administrative or development task.

The Spaces application also has internally-defined workflows. An example of an internally-defined workflow includes the process of subscribing to a space. A user requests a subscription. The request appears on the space moderator's Worklist. If the space has multiple moderators, the first response to the Worklist item is to claim ownership of the request, so that only one moderator responds to the request itself.

Messages, alerts, and notifications might also come from the User Messaging Service. The Worklist task flow includes a control for accessing messaging preferences on this server (Figure 70-3). Clicking the Messaging preferences icon displays the User Messaging Preferences page in which you can specify the channels over which to receive User Messaging Service messages and define messaging filters.


Figure 70-3 Worklist Messaging Preferences Icon

[image: Worklist Messaging Preferences icon]

Description of "Figure 70-3 Worklist Messaging Preferences Icon"





For information about setting messaging preferences for the User Messaging Service through the Spaces application, see Section 70.3.2, "Setting Messaging Preferences."

Every 15 minutes, the Worklist task flow refreshes automatically with new messages, alerts, and notifications. Optionally, you can update your view yourself by clicking the task flow's Refresh Worklist icon (Figure 70-4).




	
Note:

The Worklist task flow does not get refreshed automatically when you perform an action on any task. You must refresh the task flow to list the latest items.








Figure 70-4 The Refresh Worklist Icon

[image: Refresh icon]

Description of "Figure 70-4 The Refresh Worklist Icon"





Roll your mouse pointer over the Refresh Worklist icon to display the date and time the task flow was last refreshed.

To assist you in maintaining an organized view of your Worklist items, the Worklist task flow provides a variety of display options, accessible from the Worklist toolbar (Figure 70-5).


Figure 70-5 Worklist Display Options

[image: Worklist display options]

Description of "Figure 70-5 Worklist Display Options"





Worklist display options enable you to approach responding to messages, alerts, and notifications according to timeliness and relevance.

For more information about Worklist display options, see Section 70.3.3, "Arranging Your Display of Worklist Items."






70.2 Adding a Worklist Service Task Flow to a Page

For the steps to add a Worklist service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Note:

You can add worklist task flows in personal pages only.












70.3 Working with the Worklist Service Task Flow

The Worklist task flow provides a fast and easy way to read and respond to items from the automated processes in place in your organization. All of the information on the Worklist is specifically relevant to you.

This section provides information about the Worklist task flow and describes how to use it. This section includes the following subsections:

	
Section 70.3.1, "Viewing and Responding to Worklist Items"


	
Section 70.3.2, "Setting Messaging Preferences"


	
Section 70.3.3, "Arranging Your Display of Worklist Items"






70.3.1 Viewing and Responding to Worklist Items

To view a task, message, alert, or notification, simply click the Details link (Figure 70-6).


Figure 70-6 Selecting a Worklist Item for Viewing

[image: Selecting a Worklist item]

Description of "Figure 70-6 Selecting a Worklist Item for Viewing"





Any Worklist item that is no longer of the Assigned state is removed from the Worklist during the next refresh.






70.3.2 Setting Messaging Preferences

The Worklist Messaging preferences icon provides access to controls for specifying your messaging preferences on the User Messaging Service. Use messaging preferences to specify the channels over which to receive User Messaging Service messages and to define messaging filters. User Messaging Service messages may include Worklist notifications in addition to other notifications and alerts from other consumers of the server.

Messaging channels are the channels over which messages, notifications, and alerts are received from the User Messaging Service. These include mail, voice over internet (VoIP), and the like. Messages, notifications, and alerts come from the services that are registered with the User Messaging Service.

Messaging filters define sorting conditions for messages and specify the channels through which to send messages that meet those conditions.

You can define messaging channels and filters using the User Messaging Preferences dialog. This section provides an overview of how to use this dialog to configure messaging channels and define messaging filters for messages generated from the User Messaging Service. For more information, see the User Messaging Service online help and the chapter "Oracle User Messaging Service Applications" in Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

To access the User Messaging Preferences dialog from the Worklist task flow:

	
Log in to your application.


	
Click the Messaging preferences icon in the Worklist toolbar and specify credentials to log in to the BPEL server.




	
Note:

In Spaces, you can access the Worklist service by expanding the Worklist pane.








Figure 70-7 User Messaging Preferences

[image: Worklist Messaging Preferences icon]

Description of "Figure 70-7 User Messaging Preferences"





A web page opens with two tabs (Figure 70-7):

	
Messaging Channels—Configure channels (such as mail, voice, and so on) to receive your User Messaging Service notifications and alerts.


	
Messaging Filters—Define rules for filtering your User Messaging Service notifications and alerts.





	
Configure channels and filters by referring to the User Messaging Service online help.









70.3.3 Arranging Your Display of Worklist Items

This section describes how to use Worklist sorting and grouping options to arrange your display of the Worklist. Sorting affects the display order of Worklist items. Grouping divides items into groups that share a common attribute, such as a common category, a shared priority level, or some other common attribute.

You may notice a number next to each group (Figure 70-8). These indicate the number of items contained in a particular group. To expand a group and see the items it contains, click the Expand icon to the left of the group title.


Figure 70-8 Numbers Next to Worklist Groups

[image: Numbers next to Worklist groups]

Description of "Figure 70-8 Numbers Next to Worklist Groups"





To arrange your display of Worklist items:

	
Log in to your application.


	
Click the Display Options icon at the top of the Worklist on your application page.




	
Note:

In Spaces, you can access the Worklist by expanding the Worklist pane.








	
In the Display Options dialog box, expand the Group By list (Figure 70-9), and select an option for grouping your Worklist items.


Figure 70-9 The Worklist Group By List

[image: Worklist Group By list]

Description of "Figure 70-9 The Worklist Group By List"





Choose from:

	
Category—Group Worklist items into their assigned categories. Items that do not belong to a category are grouped under the heading Not Categorized. Whether a Worklist item includes a category is determined by the workflow developer; consequently, not all items might include categories.


	
Create Date—Group Worklist items according to the date they were created, starting with the most recent.


	
Due Date—Group Worklist items according to when they are due. Due dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Expiration Date—Group Worklist items according to when they are due to expire. Expiration dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Not Grouped—Do not group Worklist items. When you group Worklist items by Not Grouped, the Worklist displays items in a flat list. All other grouping options display the items in a tree format.


	
Priority—Group Worklist items according to priority, either high, normal, or low. Table 70-1 illustrates the priority indicators that are used in the Worklist.


Table 70-1 Worklist Priority Indicators

	High	Normal	Low
	[image: High priority indicator]
	
No indicator

	[image: Low priority indicator]







	
Worklist Server—Group Worklist items according to the server from which they originated.





	
Select a Sort By option (Figure 70-10).


Figure 70-10 Sort By Options in the Worklist Display Options Dialog Box

[image: Worklist Display Options dialog box]

Description of "Figure 70-10 Sort By Options in the Worklist Display Options Dialog Box"





Choose from:

	
Create Date—Sort Worklist items according to the date they were created, starting with the most recent.


	
Due Date—Sort Worklist items according to when they are due. Due dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Expiration Date—Sort Worklist items from the most recent expiration to the furthest away. Expiration dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Priority—Sort Worklist items from highest to lowest priority (see Table 70-1 for illustrations of priority indicators).


	
Title—Sort Worklist items first from 0 to 9 then from a to z.





	
Click Save to save your changes and close the Display Options dialog box.

The Worklist displays newest created 25 items per Worklist server connection. For items exceeding the 25-item limit, follow the link to the BPEL Worklist Application, where you can view and act on a larger volume of Worklist items.











70.4 Setting Worklist Service Task Flow Properties

The Worklist service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle WebCenter Portal's Composer (Figure 70-11). Many properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components."


Figure 70-11 Worklist Task Flow Component Properties

[image: Recent Activity task flow properties]

Description of "Figure 70-11 Worklist Task Flow Component Properties"





Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on Display Options tab provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Expression Builder icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."




	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.

















Part XVII


Appendices

Part XVII of the User's Guide catalogs short, user-friendly URLs to locations within the WebCenter Portal: Spaces UI, such as Administration pages and pages in spaces and Home spaces (pretty URLs). It also catalogs Expression Language expressions for use in a WebCenter Portal: Spaces context and provides examples of mashups you can use in a business context.

Part XVII includes the following appendices:

	
Appendix A, "Spaces User Interface URLs"


	
Appendix B, "Expression Language Expressions"


	
Appendix C, "Business Mashup Examples"










A Spaces User Interface URLs

In view of the many options available for defining navigation in your portal, a consistent and reliable method for accessing pages and application user interface pages (UI) is essential. This requirement is easily met through Spaces application user interface URLs—or pretty URLs.

Pretty URLs provide a means of delivering predictable URLs to navigate to specific locations within the Spaces application UI. For example, when you create a space, pretty URLs make it possible to know which URL to use to go to the General Settings page of that space. Imagine that you create a page template for a space or the Home space. You do not provide a link in the template for accessing the Resources page, where you can edit the template. Rather than being an error, this may very well be a choice: you can always use a pretty URL to go to the space's Resources page, under Space Settings, or, for the Home space, the Resources page in the Administration pages.

Because pretty URLs are shorter than standard URLs, you can use them to shield your users from complex application page URLs.

This appendix provides the syntax for the pretty URLs you can use to access user Profiles, pages, spaces, and administration screens in the Spaces application UI.

This appendix includes the following sections:

	
Section A.1, "User Interface URLs for User Profiles"


	
Section A.2, "User Interface URLs for Home Space Pages"


	
Section A.3, "User Interface URLs for Business Role Pages and System Pages"


	
Section A.4, "User Interface URLs for Space Pages"


	
Section A.5, "User Interface URLs for Application Administration Pages"






A.1 User Interface URLs for User Profiles

Use Profile pretty URLs to navigate to your own or another user's Profile page. Note that when you omit the user name or when the user name is the current user's name, the URL launches the My Profile page; but if the user name is provided and is not the current user's name, the URL launches the User Profile page.




	
See Also:

For information about the My Profile and User Profile pages, see Table 7-2, "Seeded System Pages".







Table A-1 lists and describes the syntax for the UI URLs you can formulate for easy access to your own or another user's Profile.


Table A-1 User Interface URLs to a User Profile

	Use Case	Pretty URL Syntax
	
Take the user to the My Profile or User Profile page that is defined at the application level

	
http://host:port/webcenter/spaces/profile/userName


	
Take the user to the My Profile or User Profile page that is defined at the space level

	
http://host:port/webcenter/spaces/spaceName/profile/userName

http://host:port/webcenter/spaces/spaceName/profile












A.2 User Interface URLs for Home Space Pages

Table A-2 lists and describes the syntax for the UI URLs you can formulate for easy access to pages in the Home space.


Table A-2 User Interface URLs to Pages in the Home Space

	Use Case	Pretty URL Syntax
	
Take user to the Home page of the Home space

	
http://host:port/webcenter/spaces/home


	
Take user to the Home space page he or she last accessed

	
http://host:port/webcenter

http://host:port/webcenter/spaces


	
Take user to a personal page in the Home space

	
http://host:port/webcenter/spaces/profile/userName/page/escapedPageDisplayName

The variable userName is your user name or the name of the user who owns the page in the Home space. The variable escapedPageDisplayName indicates the use of an escaped version of the page display name. For example, when you create a page with the name My Page, the URL to this page ends with My+Page.

Note: There is a distinction between personal pages, which users create, and business role and system pages, which can be either seeded or created by an application administrator. For the UI URL formats for business role and system pages, see Section A.3, "User Interface URLs for Business Role Pages and System Pages."












A.3 User Interface URLs for Business Role Pages and System Pages

Use the same syntax for UI URLs that target business role pages and system pages:


/webcenter/spaces/system/page/pageName


For example:


/webcenter/spaces/system/page/Documents





	
See Also:

For information about business role pages and system pages, see Chapter 7, "Preparing Your Initial Portal Pages ."












A.4 User Interface URLs for Space Pages

Table A-3 lists and describes the syntax for the UI URLs you can use to access space pages and space administration pages. Only users assigned a role that includes the permission Administration: Manage All can access space administration pages.

In Table A-3, wherever the variable spaceName is indicated, use the space name that is specified for Space URL on the General page in a space's administration settings (Figure A-1).


Figure A-1 Space Internal Name on Space Settings General Page

[image: Space internal name on Space Settings General]



You can also find the appropriate space name next to the Name label in the About Space dialog. For more information, see Section 29.9.1, "Accessing Space Information."


Table A-3 User Interface URLs to Pages in a Space

	Use Case	Pretty URL Syntax
	
Take user to the specified space, where the last-accessed page is displayed

	
http://host:port/webcenter/spaces/spaceName


	
Take user to the first page of a space

	
http://host:port/webcenter/spaces/spaceName/home


	
Take user to a specific page in a space

	
http://host:port/webcenter/spaces/spaceName/page/escapedPageDisplayName

The variable escapedPageDisplayName indicates the use of an escaped version of the page display name. For example, when you create a page with the name My Page, the URL to this page ends with My+Page.


	
Take space moderator to General page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin


	
Take space moderator to General page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/general


	
Take space moderator to Roles page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/roles

Note: When a subspace inherits its members and roles from the parent space, you cannot use a pretty URL to navigate to the subspace Roles page because it does not exist.


	
Take space moderator to Members page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/members

Note: When a subspace inherits its members and roles from the parent space, you cannot use a pretty URL to navigate to the subspace Members page because it does not exist.


	
Take space moderator to Available Pages tab on Pages page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/spacepages


	
Take space moderator to System Pages tab on Pages page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/systempages


	
Take space moderator to Services page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/services


	
Take space moderator to Subspaces page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/subspaces


	
Take space moderator to Custom Attributes page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/attributes


	
Take space moderator to Resources page in space administration

	
http://host:port/webcenter/spaces/spaceName/admin/resources












A.5 User Interface URLs for Application Administration Pages

Table A-4 lists and describes the UI URL syntax to use to access Spaces application Administration pages. These pages are accessible only to Spaces application administrators and are used for application configuration.


Table A-4 User Interface URLs to WebCenter Portal: Spaces Administration Pages

	Use Case	Pretty URL Syntax
	
Take the administrator to the application Administration page

	
http://host:port/webcenter/spaces/admin


	
Take the administrator to the General subpage of the Configuration page

	
http://host:port/webcenter/spaces/admin/general


	
Take the administrator to the Spaces subpage of the Spaces page

	
http://host:port/webcenter/spaces/admin/spaces


	
Take the administrator to the Space Templates subpage of the Spaces page

	
http://host:port/webcenter/spaces/admin/templates


	
Take the administrator to the Roles subpage of the Security page

	
http://host:port/webcenter/spaces/admin/roles


	
Take the administrator to the Users and Groups subpage of the Security page

	
http://host:port/webcenter/spaces/admin/users


	
Take the administrator to the Resources page

	
http://host:port/webcenter/spaces/admin/resources


	
Take the administrator to the Services subpage of the Configuration page

	
http://host:port/webcenter/spaces/admin/services


	
Take the administrator to the Business Role Pages subpage of the Pages page

	
http://host:port/webcenter/spaces/admin/brpages


	
Take the administrator to the Personal Pages subpage of the Pages page

	
http://host:port/webcenter/spaces/admin/personalpages


	
Take the administrator to the System Pages subpage of the Pages page

	
http://host:port/webcenter/spaces/admin/systempages















B Expression Language Expressions

When configuring page components, you can express values as variables that take advantage of the current application context by grabbing information that happens to be true at the moment. For example, you can use variables to obtain the name of the current user, the user's assigned role, the state of the current page, and the like.

Such flexibility is made possible through the Expression Builder that is provided with each Parameter and Display Option property.

This appendix provides information about the editor and useful EL expressions. It includes the following subsections:

	
Section B.1, "Introducing the Expression Builder"


	
Section B.2, "Expression Language Example Use Case"


	
Section B.3, "Desupport of Freeform JPQL WHERE and SORT Clauses"


	
Section B.4, "Expression Language Expressions"







	
See Also:

For additional information about EL APIs, see Oracle Fusion Middleware Java API Reference for Oracle WebCenter.









B.1 Introducing the Expression Builder

All properties on the Parameters and Display Options tabs provide an Expression Builder icon that opens a simple Expression Language (EL) editor, called the Expression Builder. Use the Expression Builder when you want to formulate a dynamic computation for an otherwise unknown property value, for example, to specify the current user, the current page mode, and the like.

Click the Expression Builder icon next to a property to open the editor. (Figure B-1).


Figure B-1 Expression Builder Icon Next to a Parameter Value Field and the Resulting Editor

[image: Edit icon next to a parameter value field]

Description of "Figure B-1 Expression Builder Icon Next to a Parameter Value Field and the Resulting Editor"








	
See Also:

For information about accessing component properties, see Section 17.5.2, "Setting Properties on Page Components."







The Expression Builder is particularly useful when you want a value that is retrievable but otherwise unknown, for example, when you want a value to be the name of the current user or the current application skin.

The Expression Builder provides two options for entering expressions:

	
Choose a value, for selecting a seeded EL expression


	
Type a value or expression, for entering an expression manually




The options under Choose a value are categorized according to the type of information an expression returns. Select a category from the first menu, and then select the type of value you want returned from the second menu (Figure B-2).


Figure B-2 Options Under Choose a value in the Expression Builder

[image: Options under Choose a value in the Expression Builder]

Description of "Figure B-2 Options Under Choose a value in the Expression Builder"








	
See Also:

For information about seeded EL expressions, see Section B.4.1, "Seeded Expressions in the Expression Builder."







The option Type a value or expression is followed by a text box, which you can use to manually enter the expression you intend (Figure B-3).


Figure B-3 Text Box Under Type a value or expression in the Expression Builder

[image: Text box under Type a value or expression]

Description of "Figure B-3 Text Box Under Type a value or expression in the Expression Builder"





Many expressions in the tables in this appendix are building blocks for narrowing down the object or objects you want returned. That is, they are not necessarily meant to be used by themselves, but rather in an assembly of ELs to form the desired query.

For example, the following expression uses three resource-related ELs to form a single query that returns a particular space template. It retrieves the template storesMasterTemplate from the parent space stores:


#{srmContext.resourceScope['stores'].resourceType['siteTemplate'].displayName['storesMasterTemplate'].singleResult}


In the Expression Builder, select predefined values, under Choose a value, or enter a value or an Expression Language expression, under Type a value or expression.

Use the following formats to enter values:

	
a literal number: #{123}


	
a literal string: #{'string'}


	
a literal Boolean: #{true}


	
a Java Bean called to return a value: #{generalSettings.preferredTimeStyle}




The editor provides a Test button for validating your EL entry. The Test button is available for expressions entered in the text box under Type a value or expression.

Validation checks the EL syntax and evaluates the expression. Because expression values vary according to the context in which they are executed, the resulting value that appears in the editor may differ from the value returned during actual use.

Note, however, that only EL is validated when you click Test; other types of values are not validated.

Test results are shown in a popup (Figure B-4).


Figure B-4 Test Result in EL Editor

[image: Test result in EL Editor]

Description of "Figure B-4 Test Result in EL Editor"








	
Note:

Wherever you enter EL on the generic Display Options tab in the Component Properties dialog, the entry is automatically validated. If the EL is invalid, an error appears and the value is neither applied nor saved. Generic Display Options are those cataloged in Table 17-1.
EL validation is not performed on non-generic display options.














B.2 Expression Language Example Use Case

This section provides an example of using EL expressions to display something based on a user's role, permissions, and the like.

In this example, we will use Expression Language to reveal or hide an item in the navigation model based on the user's role. Because there is Expression Language for almost every piece of metadata maintained by Spaces, using ELs to personalize the user's experience is an extremely powerful tool.

You can use the following EL to determine a user's role:


#{WCSecurityContext.userInScopedRole['Role 1'] or   WCSecurityContext.userInScopedRole['Role 2']}


This EL compares the current user's credentials (in this case, the role), against what is specified in the EL. If the result is true, that is, if the user is assigned one of the specified roles then the navigation item is visible to the user. If the result is false, the navigation item is hidden from the user.

The roles referred to in the EL can be a system role, such as Administrator, Moderator, Participant, or a custom role.

Notice that this EL joins two conditions with the use of an OR clause; that is, the user must have either Role 1 OR Role 2 to be able to see the navigational item.

These steps demonstrate how to add a navigational item (a page query for another space) that is visible only to user assigned the role Moderator.




	
Note:

This exercise assumes you have applied a custom navigation model to your space. You cannot edit a seeded navigation model.







To personalize navigation:

	
Go to space Settings, and access the Navigations panel under Resources.

You can use the following URL to navigate to the Resources subpage, from there, click Navigations:


http://host:port/webcenter/spaces/spaceName/admin/resources


	
Select the navigation model that the space is using.




	
Tip:

To find out which navigation model the current space is using, go to the General subpage under space Settings, and look for the value in the Navigation field.








	
From the Edit menu, select Edit.


	
In the Edit - navigation model dialog, expand the Add menu, and select Pages Query.


	
Bring the Target tab forward:

	
In the Name field, enter a name for your query, for example, moderatorQuery.


	
Next to Find Page in, select Space, and ensure that the current space name appears in the field.


	
Click the icon to the right of the Visible checkbox, and select Expression Builder.





	
Select Choose a value, and then select Space Info from the first dropdown and CurrentSpace Role - Moderator from the second.

The expression #{WCSecurityContext.userInScopedRole['Moderator']} appears in the text field.




	
Tip:

If you are working with a custom role, you choose CurrentSpace Role - Custom from the dropdown. In the text area, highlight CustomRole, then type in the name of your custom role.








	
Click OK until you return to the Resources tab.




To test this, add a member to the space, and assign this user any role other than Moderator. Log off and log back in as that user. You should not see the Pages Query navigational item.






B.3 Desupport of Freeform JPQL WHERE and SORT Clauses

If you have introduced an EL expression for querying spaces based on a JPQL WHERE clause, you should know that the freeform JPQL WHERE clause is desupported. Instead, use a structured WHERE clause. Freeform SORT clauses are also desupported. Instead, specify sort criteria on a space query in a structured way.

For example, imagine that you have used the following syntax to form a WHERE clause on a space query:


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].whereClause['sp.keywords like \'forquery%\' and not 
(sp.discoverable is null or sp.discoverable =  \'N\')'].listSpaces}


Going forward, you must use the following syntax to form a WHERE clause:


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].where[wCond['sp.keywords']['like']['forquery']['and'][wCond['sp.discoverable']
['is']['null']['or'][wCond['sp.discoverable']['=']['N']]['not']]].listSpaces}


Where:

	
wCond is an atomic condition that can be expressed as wCond[p][op][v].

Where:

	
p is a space attribute (a field in WcSpaceHeader, see the following bullet list).


	
op is one among a restricted set of JPQL comparison operators ('=', 'like', '!=', '<', '>', '<=', '>=', 'is').


	
v is a string whose interpretation depends on the operator op.

If the operator is is, v can be the string 'null' or 'not null', and the condition is understood as the attribute being checked for null or not null respectively in JPQL. If the operator is anything else, v is interpreted as a literal, and the condition is understood to be the attribute being compared with the literal value.




You can use any field defined in WcSpaceHeader in the WHERE clause, including:

	
closed


	
createDate


	
createdBy


	
description


	
discoverable


	
displayName


	
keywords


	
icon


	
logo


	
lastUpdateDate


	
selfSubEnabled


	
rssEnabled


	
spaceGuid


	
spaceId


	
spaceOffline


	
spacePublic


	
spacesType


	
spacesUser


	
updatedBy


	
version


	
parentGuid


	
securityParentGuid


	
ancestorPath


	
seeded


	
groupSpaceMemCount





	
sp represents the JPA entity for a space, WcSpaceHeader.

For example, you can use the following condition to create a filter for all spaces created by users having user names starting with monty on which self subscription is enabled:


sp.createdBy like 'monty%' and not (sp.selfSubEnabled is null or sp.selfSubEnabled = 'N')


	
and, or, not (along with wCond) are types of conditions.

Where:

	
and represents a conjunction of two conditions. You can express a conjunction condition as cond1['and'][cond2] where cond1 and cond2 are the expressions for the two conditions being conjoined.


	
or represents a disjunction condition. You can express a disjunction condition as cond1['or'][cond2] where cond1 and cond2 are the expressions for the two conditions being disjoined.


	
not represents a negation condition. You can express a negation condition as cond['not'] where cond is the expression for the condition being conjoined.







For example, the following EL returns a list of all spaces (to which the current user has access) that are created by users having names starting with monty and on which self subscription is enabled:


#{spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.where[wCond['sp.createdBy']
['like']['monty%'] ['and'] [wCond['sp.selfSubEnabled']['is']['null'] ['or'] [wCond['sp.selfSubEnabled']['=']['N']] ['not'] ] ].listSpaces}


Now imagine that you have used the following syntax to specify SORT criteria on a space query:


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sortCriteria
['sp.discoverabledesc, sp.keywords'].listSpaces}


Going forward, you must use the following syntax to specify SORT criteria on a space query:


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sort['sp.discoverable']
['desc'].sort['sp.keywords']['asc'].listSpaces}


Where:

	
sp represents the JPA entity for a space, WcSpaceHeader (see previous bullet list for fields defined in WcSpaceHeader).


	
desc and asc define sort order, descending and ascending, respectively.




For example, the following query returns a list of spaces to which the user has access and sorts the result set on the fields discoverable and lastUpdateDate.


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sort['sp.discoverable']
['asc'].sort['sp.lastUpdateDate']['desc'].listSpaces}


Oracle strongly recommends that you convert all existing freeform JPQL WHERE and SORT clauses to the new syntax.

If for any reason you must retain the existing syntax, your Spaces administrator must explicitly enable support for freeform JPQL in the webcenter-config.xml.xml file by setting the following global flag:


oracle.webcenter.spaces.query.DIRECT_JPQL_CLAUSE_SUPPORTED





	
Note:

The webcenter-config.xml.xml file is the customization document for webcenter-config.xml.







Set this flag to true for continued support of legacy freeform WHERE and SORT clauses. When this option is set to true, Spaces log files will contain warnings.

To set this flag in webcenter-config.xml.xml:

	
Export the latest webcenter-config.xml.xml from MDS.

For example:


exportMetadata(application='webcenter', server='WC_Spaces', toLocation='/tmp/mydata',docs='/oracle/webcenter/webcenterapp/metadata/mdssys/cust/site/webcenter/webcenter-config.xml.xml')


	
Open the file in a text editor and modify settings, as required.

For example:


<mds:insert parent="webcenter(xmlns(webcenter=http://
   xmlns.oracle.com/webcenter/webcenterapp))/webcenter:custom-attributes" 
   position="last">      <attribute name=
         "oracle.webcenter.spaces.query.DIRECT_JPQL_CLAUSE_SUPPORTED" 
         xmlns="http://xmlns.oracle.com/webcenter/webcenterapp">
            <description/>
            <type>java.lang.String</type>
            <value>true</value>
            <visible/>
      </attribute>
</mds:insert>


	
Save and close webcenter-config.xml.xml.


	
Import the updated webcenter-config.xml.xml file to Spaces.

For example:


importMetadata(application='webcenter', server='WC_Spaces', fromLocation='/tmp/mydata', docs='/oracle/webcenter/webcenterapp/metadata/mdssys/cust/site/webcenter/webcenter-config.xml.xml')









B.4 Expression Language Expressions

This section provides a series of tables that list and describe useful EL expressions. Tables are grouped according to the context in which the expressions they contain apply.

This section includes the following subsections:

	
Section B.4.1, "Seeded Expressions in the Expression Builder"


	
Section B.4.2, "EL Expressions Relevant to the Spaces Application"


	
Section B.4.3, "EL Expressions Relevant to Application Security"


	
Section B.4.4, "EL Expressions Relevant to Application Navigation"


	
Section B.4.5, "EL Expressions Relevant to Resources"


	
Section B.4.6, "EL Expressions Relevant to Specific Spaces"


	
Section B.4.7, "EL Expressions Relevant to Specific Pages"


	
Section B.4.8, "EL Expressions Relevant to Composer"


	
Section B.4.9, "EL Expressions Relevant to Event Contexts"


	
Section B.4.10, "EL Expressions Relevant to Services"


	
Section B.4.11, "EL Expressions Relevant to the Personalization Conductor"


	
Section B.4.12, "EL Expressions Relevant to the Documents Service"


	
Section B.4.13, "EL Expressions Relevant to the People Connections Service"


	
Section B.4.14, "EL Expressions Relevant to User Preferences"


	
Section B.4.15, "Utilitarian EL Expressions"






B.4.1 Seeded Expressions in the Expression Builder

In the Expression Builder editor, when you select the option Choose a value you can populate the text box in the dialog with a seeded EL expression. First, select an expression category, and then select the type of information you want the expression to return. Your selection's associated EL appears in the text box at the bottom of the dialog (Figure B-5).


Figure B-5 Options Under Choose a value in the Expression Builder

[image: Options under Choose a value in the Expression Builder]

Description of "Figure B-5 Options Under Choose a value in the Expression Builder"





This section is broken into subsections for each category. Each subsection lists and describes the ELs associated with that category.

This section includes the following subsections:

	
Section B.4.1.1, "Application Info Seeded ELs"


	
Section B.4.1.2, "Page Info Seeded ELs"


	
Section B.4.1.3, "Page Parameter Seeded ELs"


	
Section B.4.1.4, "Resource Info Seeded ELs"


	
Section B.4.1.5, "Space Info Seeded ELs"


	
Section B.4.1.6, "Space Page Info Seeded Paths"


	
Section B.4.1.7, "System Seeded ELs"


	
Section B.4.1.8, "User Info Seeded ELs"


	
Section B.4.1.9, "WebCenter Events Seeded ELs"






B.4.1.1 Application Info Seeded ELs

Application Info seeded EL expressions return values related to the Spaces application. For example, the expression #{WCAppContext.application.applicationConfig.title}, returns the application title that is specified on the Configuration page in the Spaces Administration pages.




	
See Also:

For additional EL expressions related to the application, see Section B.4.2, "EL Expressions Relevant to the Spaces Application."







Table B-1 lists the seeded EL expressions available under the category Application Info and provides an example of the types of values each returns.


Table B-1 Seeded EL Expressions Under Application Info

	Option	Expression	Example of Returned Value
	
Current Scope

	
#{serviceCtx.scope}

	
Scope[name=standards, guid=sa78185d3_9d65_49ab_ac1d_4809380d0b30]


	
Current Page Template Scope

	
#{WCAppContext.currentScope}

	
Scope[name=standards, guid=sa78185d3_9d65_49ab_ac1d_4809380d0b30]


	
Previously Set Page Template

	
#{WCAppContext.previouslySetPageTemplate}

	
Fusion Side Navigation


	
Application

	
#{WCAppContext.application}

	
oracle.webcenter.webcenterapp.internal.view.shell.WCApplication


	
Application URL

	
#{WCAppContext.applicationURL}

	
http://host:port/webcenter


	
Current WebCenter Portal URL

	
#{WCAppContext.currentWebCenterURI}

	
/oracle/webcenter/page/scopedMD/GUID/businessRolePages/Page3.jspx?wc.contextURL=%2Fspaces


	
Application Config

	
#{WCAppContext.application.applicationConfig}

	
oracle.webcenter.webcenterapp.beans.WebCenterMetadataImpl@123db9d


	
Application Config Title

	
#{WCAppContext.application.applicationConfig.title}

	
WebCenter


	
Application Config Logo

	
#{WCAppContext.application.applicationConfig.logo}

	
/oracle/webcenter/webcenterapp/metadata/images/logo.gif


	
Application Config HelpPage

	
#{WCAppContext.application.applicationConfig.helpPage}

	
/webcenterhelp/spaces?topic=welcome_main


	
Application Config CopyrightMessage CustomValue

	
#{WCAppContext.application.applicationConfig.copyrightMessage.customValue}

	
http://www.oracle.com/html/copyright.html


	
Application Config Privacy Policy URL

	
#{WCAppContext.application.applicationConfig.privacyPolicyUrl}

	
http://www.oracle.com/html/privacy.html


	
Application Config Skin

	
#{WCAppContext.application.applicationConfig.skin}

	
webcenterfx








For example, consider that you want a link to appear in all pages of a space that lets you copy and share the current page's URL. You can add an HTML Markup item to a page template, and add the EL that returns page URL.

These steps demonstrate how to use ELs to retrieve page URLs:

	
Open a custom page template in Edit mode.


	
Click Add Content.


	
In Resource Catalog, click Web Development.


	
Click Add next to HTML Markup, then click Close.


	
Click the Edit icon for the newly added HTML Markup.


	
In the Component Properties dialog, on the Display Options tab, in the Value field, enter the following EL:


<a href="javascript:{
    var returnvalue = prompt( '#{pageDocBean.title}
URL','#{WCAppContext.applicationURL}/faces#{WCAppContext.currentWebCenterURI}');
}">Share Link</a>


	
Click OK.


	
Apply the page template to your space.









B.4.1.2 Page Info Seeded ELs

Page Info seeded EL expressions return values related to Spaces pages. For example, the expression #{pageDocBean.createdBy}, returns the user name of the person who created the current page.

Table B-2 lists the seeded EL expressions available under the category Page Info and provides an example of the types of values each returns.


Table B-2 Seeded EL Expressions Under Page Info

	Option	Expression	Example of Returned Value
	
Title

	
#{pageDocBean.title}

	
Welcome Page (BRP)


	
Created By

	
#{pageDocBean.createdBy}

	
j.doe


	
Create Date String

	
#{pageDocBean.createDateString}

	
2010-11-17T13:27:52


	
Last Updated By

	
#{pageDocBean.lastUpdatedBy}

	
j.smith


	
Last Update Date String

	
#{pageDocBean.lastUpdateDateString}

	
2010-11-17T13:27:52


	
Page Path

	
#{pageDocBean.pagePath}

	
/oracle/webcenter/page/scopedMD/GUID/businessRolePages/Page3.jspx


	
Name

	
#{pageDocBean.name}

	
Page3.jspx


	
UI CSS Style

	
#{pageDocBean.UICSSStyle}

	
WCSchemeCustom


	
UI Scheme BG Image

	
#{pageDocBean.UISchemeBGImage}

	
#{facesContext.externalContext.requestContextPath}/adf/oracle/webcenter/page/images/clouds.png


	
UI BG String Color Scheme

	
#{pageDocBean.UISchemeBGColorString}

	
null


	
Page Permission

	
#{pageDocBean.pagePermission}

	
oracle.webcenter.page.model.security.CustomPagePermission


	
Page Security Target

	
#{pageDocBean.pageSecurityTarget}

	
oracle_webcenter_page_scopedMD_sa78185d3_9d65_49ab_ac1d_4809380d0b30_COIHomePageDef












B.4.1.3 Page Parameter Seeded ELs

Page Parameter seeded EL expressions return values related to Spaces page parameters. The editor lists all parameters that are defined for the current page. If no parameters are defined, the Page Parameter category is not available.

For example, the seeded page style Three Column provides five seeded page parameters (see Table B-3). The width parameters describe the percentage of total width allotted to each column. The show parameters specify whether a page header and footer are rendered. Of the seeded page styles, Blank, Home Page, Left Narrow, and Right Narrow all provide the same seeded page parameters (see Table B-3). Additionally, any page may have its own custom page parameters.

Whether seeded or custom, available page parameters are exposed in the Expression Builder editor under the Page Parameter category.




	
See Also:

For more information about creating and using page parameters, see Section 19.3, "Wiring Components and Page Parameters."







Table B-3 lists the EL expressions available under the Page Parameter category for pages based on the styles Three Column, Blank, Home Page, Left Narrow, and Right Narrow. It provides an example of the types of values each returns.


Table B-3 Seeded EL Expressions Under Page Parameter

	Option	Expression	Example of Returned Value
	
leftWidth

	
#{bindings.leftWidth}

	
25%


	
centerWidth

	
#{bindings.centerWidth}

	
50%


	
rightWidth

	
#{bindings.rightWidth}

	
25%


	
showHeader

	
#{bindings.showHeader}

	
false


	
showFooter

	
#{bindings.showFooter}

	
false












B.4.1.4 Resource Info Seeded ELs

Resource Info seeded EL expressions return values related to Spaces resources, such as templates, styles, resource catalogs, and the like. For example, the expression #{srmContext.id['ResourceID'].singleResult}, returns the resource with the specified GUID.




	
See Also:

For additional resource-related EL expressions, see Section B.4.5, "EL Expressions Relevant to Resources."







Table B-4 lists the seeded EL expressions available under the category Resource Info and provides an example of the types of values each returns.


Table B-4 Seeded EL Expressions Under Resource Info

	Option	Expression	Example of Returned Value
	
Resource ID

	
#{srmContext[wCond['id']['like']['ResourceID']].singleResult}

	
id:gsr3396194a_3a72_44d6_90b4_57fd6efe4ff7 resourceScope:Scope[name=defaultScope, guid=s8bba98ff_4cbb_40b8_beee_296c916a23ed] resourceType:siteTemplate serviceId:oracle.webcenter.siteresources.sitetemplate category: displayName:Fusion Side Navigation displayNameKey:SITE_TEMPLATE_FUS_SIDE_STRETCH_NAV_DN description:Stretching Page Layout with Side Navigation. Use Fusion FX Skin. descriptionKey:SITE_TEMPLATE_FUS_SIDE_STRETCH_NAV_DESC contentDirectory:/oracle/webcenter/siteresources/shared metadataFile: jspx:/oracle/webcenter/webcenterapp/view/templates/WCSiteTemplateSideNavStretch.jspx pageDef:/oracle/webcenter/webcenterapp/bindings/pageDefs/oracle_webcenter_webcenterapp_view_templates_WCSiteTemplateSideNavStretchPageDef.xml iconURI: excludeFrom: usesCustomSecurity:false visible:TRUE seeded:true createdBy:system createdDate:Fri Jul 02 05:44:19 PDT 2010 modifiedBy:system resourceBundle:oracle.webcenter.sitetemplate.view.resource.SiteTemplateBundle modifiedDate:Fri Jul 02 05:44:19 PDT 2010 logoUrl:/adf/webcenter/srm_dflt_logo_qualifier.png attributes:[]


	
Resource Display Name

	
#{srmContext[wCond['displayName']['like']['DisplayName']].singleResult}

	
See Resource ID for an example of a returned value.


	
Description

	
#{srmContext[wCond['description']['like']['Description']].singleResult}

	
See Resource ID for an example of a returned value.


	
Creation Date

	
#{srmContext[wCond['createdDate']['like']['CreationDate']].singleResult}

	
See Resource ID for an example of a returned value.


	
Modified By

	
#{srmContext[wCond['modifiedBy']['like']['UserName']].singleResult}

	
See Resource ID for an example of a returned value.


	
Modified Date

	
#{srmContext[wCond['modifiedDate']['like']['ModifiedDate']].singleResult}

	
See Resource ID for an example of a returned value.


	
Resource Scope

	
#{srmContext[wCond['resourceScope']['like']['ResourceScope']].singleResult}

	
See Resource ID for an example of a returned value.












B.4.1.5 Space Info Seeded ELs

Space Info seeded EL expressions return values related to spaces (other than the Home space). For example, the expression #{spaceContext.space['spaceName'].children}, returns a list of the subspaces under the named parent space.




	
See Also:

For additional space-related EL expressions, see Section B.4.6, "EL Expressions Relevant to Specific Spaces."







Table B-5 lists the seeded EL expressions available under the category Space Info and provides an example of the types of values each returns.




	
Note:

Use the EL expressions listed in Table B-5 only in the context of spaces other than the Home space.








Table B-5 Seeded EL Expressions Under Space Info

	Option	Expression	Example of Returned Value
	
NamedSpace

	
#{spaceContext.space['spaceName']}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@15fc839


	
CurrentSpace

	
#{spaceContext.currentSpace}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@d5e197


	
CurrentSpace Name

	
#{spaceContext.currentSpaceName}

	
standards


	
NamedSpace Metadata Path

	
#{spaceContext.space['spaceName'].metadataPath}

	
/oracle/webcenter/space/metadata/spaces/spaceName/space.xml


	
CurrentSpace Metadata Path

	
#{spaceContext.currentSpace.metadataPath}

	
/oracle/webcenter/space/metadata/spaces/standards/space.xml


	
NamedSpace Metadata

	
#{spaceContext.space['spaceName'].metadata}

	
oracle.webcenter.spaces.beans.SpaceMetadataImpl@1d7320a


	
CurrentSpace Metadata

	
#{spaceContext.currentSpace.metadata}

	
oracle.webcenter.spaces.beans.SpaceMetadataImpl@1096c64


	
NamedSpace Metadata DisplayName

	
#{spaceContext.space['spaceName'].metadata.displayName}

	
Standards


	
CurrentSpace Metadata DisplayName

	
#{spaceContext.currentSpace.GSMetadata.displayName}

	
Sales


	
NamedSpace Metadata Icon

	
#{WCPrepareImageURL[spaceContext.space['spaceName'].metadata.icon]['']}

	
/webcenter-spaces-resources/oracle/webcenter/space/metadata/spacetemplate/PortalSite/images/portal_icon.png


	
CurrentSpace Metadata Icon

	
#{WCPrepareImageURL[spaceContext.currentSpace.metadata.icon]['']}

	
/webcenter-spaces-resources/oracle/webcenter/space/metadata/spaces/Test_Space/images/wc_prj_icon.png


	
NamedSpace Metadata Description

	
#{spaceContext.space['spaceName'].metadata.description}

	
Central point for all standards, templates, and stylesheets for company collateral


	
CurrentSpace Metadata Description

	
#{spaceContext.currentSpace.GSMetadata.description}

	
Sales Force Team Site


	
NamedSpace Metadata CreationDate

	
#{spaceContext.space['spaceName'].metadata.creationDate}

	
java.util.GregorianCalendar[time=1290103432242,areFieldsSet=true,areAllFieldsSet=false,lenient=false,zone=java.util.SimpleTimeZone[id=,offset=-28800000,dstSavings=3600000,useDaylight=false,startYear=0,startMode=0,startMonth=0,startDay=0,startDayOfWeek=0,startTime=0,startTimeMode=0,endMode=0,endMonth=0,endDay=0,endDayOfWeek=0,endTime=0,endTimeMode=0],firstDayOfWeek=1,minimalDaysInFirstWeek=1,ERA=1,YEAR=2010,MONTH=10,WEEK_OF_YEAR=?,WEEK_OF_MONTH=?,DAY_OF_MONTH=18,DAY_OF_YEAR=?,DAY_OF_WEEK=?,DAY_OF_WEEK_IN_MONTH=?,AM_PM=0,HOUR=10,HOUR_OF_DAY=10,MINUTE=3,SECOND=52,MILLISECOND=242,ZONE_OFFSET=?,DST_OFFSET=?]


	
CurrentSpace Metadata CreationDate

	
#{spaceContext.currentSpace.metadata.creationDate}

	
java.util.GregorianCalendar[time=1290103432242,areFieldsSet=true,areAllFieldsSet=false,lenient=false,zone=java.util.SimpleTimeZone[id=,offset=-28800000,dstSavings=3600000,useDaylight=false,startYear=0,startMode=0,startMonth=0,startDay=0,startDayOfWeek=0,startTime=0,startTimeMode=0,endMode=0,endMonth=0,endDay=0,endDayOfWeek=0,endTime=0,endTimeMode=0],firstDayOfWeek=1,minimalDaysInFirstWeek=1,ERA=1,YEAR=2010,MONTH=10,WEEK_OF_YEAR=?,WEEK_OF_MONTH=?,DAY_OF_MONTH=18,DAY_OF_YEAR=?,DAY_OF_WEEK=?,DAY_OF_WEEK_IN_MONTH=?,AM_PM=0,HOUR=10,HOUR_OF_DAY=10,MINUTE=3,SECOND=52,MILLISECOND=242,ZONE_OFFSET=?,DST_OFFSET=?]


	
NamedSpace Metadata CreatedBy

	
#{spaceContext.space['spaceName'].metadata.createdBy}

	
j.doe


	
NamedSpace Metadata Keywords

	
#{spaceContext.space['spaceName'].metadata.keywords}

	
standards templates style sheets collateral


	
CurrentSpace Metadata Keywords

	
#{spaceContext.currentSpace.metadata.keywords}

	
sales salesReports salesNews salesTeam


	
NamedSpace Metadata Offline

	
#{spaceContext.space['spaceName'].metadata.offline}

	
false or true, depending on whether the named space is offline


	
CurrentSpace Metadata Offline

	
#{spaceContext.currentSpace.metadata.offline}

	
false or true, depending on whether the current space is offline


	
NamedSpace Metadata Closed

	
#{spaceContext.space['spaceName'].metadata.offline}

	
false or true, depending on whether the named space is closed


	
CurrentSpace Metadata Closed

	
#{spaceContext.currentSpace.metadata.closed}

	
false or true, depending on whether the current space is closed


	
NamedSpace Metadata SelfRegistration

	
#{spaceContext.space['spaceName'].metadata.selfRegistration}

	
false or true, depending on whether self registration is enabled for the named space


	
CurrentSpace Metadata SelfRegistration

	
#{spaceContext.currentSpace.metadata.selfRegistration}

	
false or true, depending on whether self registration is enabled for the current space


	
NamedSpace Metadata Discoverable

	
#{spaceContext.space['spaceName'].metadata.discoverable}

	
false or true, depending on whether the named space is discoverable


	
CurrentSpace Metadata Discoverable

	
#{spaceContext.currentSpace.metadata.discoverable}

	
false or true, depending on whether the current space is discoverable


	
NamedSpace Metadata PublishRSS

	
#{spaceContext.space['spaceName'].metadata.publishRSS}

	
false or true, depending on whether the named space can be published in an RSS reader


	
CurrentSpace Metadata PublishRSS

	
#{spaceContext.currentSpace.metadata.publishRSS}

	
false or true, depending on whether the current space can be published in an RSS reader


	
NamedSpace Distribution List

	
#{spaceContext.space['spaceName'].distributionList}

	
standardsGroup@myCompany.com


	
CurrentSpace Distribution List

	
#{spaceContext.currentSpace.distributionList}

	
salesTeam@myCompany.com


	
NamedSpace Metadata CustomAttributes

	
#{spaceContext.space['spaceName'].metadata.customAttributes['attributeName']}

	
Returns the value provided for the named custom attribute


	
CurrentSpace Metadata CustomAttributes

	
#{spaceContext.currentSpace.metadata.customAttributes['attributeName']}

	
Returns the value provided for the named custom attribute


	
CurrentSpace Metadata Logo

	
#{WCPrepareImageURL[spaceContext.currentSpace.metadata.logo]['']}

	
/webcenter-spaces-resources/oracle/webcenter/space/metadata/spacetemplate/PortalSite/images/portal_logo.png


	
CurrentSpace Role - Moderator

	
#{WCSecurityContext.userInScopedRole['Moderator']}

	
false or true, depending whether any users in the current scope are assigned the role Moderator


	
CurrentSpace Role - Participant

	
#{WCSecurityContext.userInScopedRole['Participant']}

	
false or true, depending whether any users in the current scope are assigned the role Participant


	
CurrentSpace Role - Viewer

	
#{WCSecurityContext.userInScopedRole['Viewer']}

	
false or true, depending whether any users in the current scope are assigned the role Viewer


	
CurrentSpace Role - Custom

	
#{WCSecurityContext.userInScopedRole['CustomRole']}

	
false or true, depending on if any users in the current scope are assigned the named custom role


	
NamedSpace Children

	
#{spaceContext.space['spaceName'].children}

	
[oracle.webcenter.spaces.internal.model.SpaceImpl@5705f4, oracle.webcenter.spaces.internal.model.SpaceImpl@147d658]

Note: The braces ([]) denote a set.


	
CurrentSpace Children

	
#{spaceContext.currentSpace.children}

	
[oracle.webcenter.spaces.internal.model.SpaceImpl@5705f4, oracle.webcenter.spaces.internal.model.SpaceImpl@147d658]

Note: The braces ([]) denote a set.


	
NamedSpace Parent

	
#{spaceContext.space['spaceName'].parent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@15fc839


	
CurrentSpace Parent

	
#{spaceContext.currentSpace.parent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@15fc839


	
NamedSpace Security Parent

	
#{spaceContext.space['spaceName'].securityParent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@1392793


	
CurrentSpace Security Parent

	
#{spaceContext.currentSpace.securityParent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@1392793


	
All visible root level spaces

	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE,DISCOVERABLE,PUBLIC_ACCESSIBLE,ALLUSER_ACCESSIBLE,USER_JOINED,USER_MODERATED'].shape['ROOT_LEVEL']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@ae34c8


	
All children and descendent spaces for specified Parent Space GUID

	
#{spaceContext.spacesQuery.parentSpaceGuid['spaceGuid'].shape['RECURSIVE_FLATTENED']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@4da22f


	
Immediate Sub Spaces for specified Parent Space name

	
#{spaceContext.spacesQuery.parentSpaceName['spaceGuid'].shape['ROOT_LEVEL']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@1089971


	
List of Spaces matching given Space Names

	
#{spaceContext.spacesQuery.containingNames['space1, space2,space3']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@68e467


	
List of Spaces matching given Space GUID

	
#{spaceContext.spacesQuery.containingGuids['spaceGuid1, spaceGuid2']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@1c56009


	
List of Spaces sorted based on criteria

	
#{spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.sort['sp.lastUpdateDate']['desc']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@6c3def


	
List of Spaces based on search pattern

	
#{spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.search['searchKeyword']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@19b2cf3


	
List of Spaces with limited page size

	
#{spaceContext.spacesQuery.unionOf.USER_JOINED.itemsPerPage[n].pageNumber[n]}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@4f8818


	
List of Spaces matching the where clause

	
#{spaceContext.spacesQuery.unionOf.USER_JOINED.where[wCond['sp.createdBy']['=']['userName']]}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@1ba816d












B.4.1.6 Space Page Info Seeded Paths

Rather than EL expressions, the selections under Space Page Info are directory paths to different application pages. Use them, for example, to provide navigation information to a specified page.

Table B-6 lists the seeded directory paths available under the category space Page Info and provides an example of the types of values each returns.


Table B-6 Seeded Paths Under Space Page Info

	Option	Path	Destination
	
COIHome.jspx

	
/faces/oracle/webcenter/page/scopedMD/se2dff4fb_202a_4f4c_b56d_c7cf59ad1c04/COIHome.jspx

	
Path to the Home page of the current space


	
GroupSpaceDocLibMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/GroupSpaceDocLibMainView.jspx

	
Path to the Documents page in the current space


	
ForumMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/ForumMainView.jspx

	
Path to Discussions page in the current space


	
AnnouncementsMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/AnnouncementsMainView.jspx

	
Path to Announcements page in current space


	
EventsMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/EventsMainView.jspx

	
Path to Events page in current space


	
ListsMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/ListsMainView.jspx

	
Path to Lists page in current space


	
GroupSpaceActivityMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/GroupSpaceActivityStreamMainView.jspx

	
Path to Activity Stream page in current space












B.4.1.7 System Seeded ELs

System seeded EL expressions return values related to system settings, such as the user name of the current user or the current user's specified locale. For example, the expression #{securityContext.userName}, returns the name of the currently logged in user. For example, if user j.doe is viewing a page where this expression is used, the returned value in j.doe's view is j.doe. If user j.smith is looking at the same page, the value returned in j.smith's view is j.smith.




	
See Also:

For additional utilitarian EL expressions, see Section B.4.15, "Utilitarian EL Expressions."







Table B-7 lists the seeded EL expressions available under the category System and provides an example of the types of values each returns.


Table B-7 Seeded EL Expressions Under System

	Option	Expression	Example of Returned Value
	
User

	
#{securityContext.userName}

	
The current user's user name


	
Locale

	
#{facesContext.externalContext.requestLocale}

	
The current user's specified locale

This may be taken from application or space-level settings or user Preferences, whichever is taking precedence.

For example:


en_US












B.4.1.8 User Info Seeded ELs

User Info seeded EL expressions return values related to a given user's Profile. For example, the expression #{webCenterProfile[securityContext.userName].description}, returns the content of the About Me attribute of the current user's Profile.




	
See Also:

For additional user-related expressions, see Section B.4.13, "EL Expressions Relevant to the People Connections Service."







Table B-8 lists the seeded EL expressions available under the category User Info and provides an example of the types of values each returns.


Table B-8 Seeded EL Expressions Under User Info

	Option	Expression	Example of Returned Value
	
About Me

	
#{webCenterProfile[securityContext.userName].description}

	
Returns the content of the About Me attribute of the current user's Profile


	
Username

	
#{webCenterProfile[securityContext.userName].userName}

	
The user name specified in the current user's Profile

Compare this with the current user's display name.


	
First Name

	
#{webCenterProfile[securityContext.userName].firstName}

	
The current user's first name


	
Middle Name

	
#{webCenterProfile[securityContext.userName].middleName}

	
The current user's middle name


	
Last Name

	
#{webCenterProfile[securityContext.userName].lastName}

	
The current user's last name


	
Initials used

	
#{webCenterProfile[securityContext.userName].initials}

	
The current user's initials


	
Display Name

	
#{webCenterProfile[securityContext.userName].displayName}

	
The current user's display name

Compare this with the current user's user name.


	
Email

	
#{webCenterProfile[securityContext.userName].businessEmail}

	
The current user's business email address


	
Department

	
#{webCenterProfile[securityContext.userName].department}

	
The current user's department


	
Job Title/Designation

	
#{webCenterProfile[securityContext.userName].title}

	
The current user's job title or designation


	
Manager

	
#{webCenterProfile[securityContext.userName].managerDisplayName}

	
The current user's manager's display name


	
Time zone

	
#{webCenterProfile[securityContext.userName].timeZone}

	
The time zone associated with the current user


	
Employee type

	
#{webCenterProfile[securityContext.userName].employeeType}

	
The current user's employee type


	
Employee Number

	
#{webCenterProfile[securityContext.userName].employeeNumber}

	
The current user's employee number


	
Preferred Language Code

	
#{webCenterProfile[securityContext.userName].preferredLanguage}

	
The current user's preferred language


	
Organization

	
#{webCenterProfile[securityContext.userName].organization}

	
The company organization to which the current user belongs


	
Organizational Unit

	
#{webCenterProfile[securityContext.userName].organizationalUnit}

	
The unit of the company organization to which the current user belongs


	
Expertise

	
#{webCenterProfile[securityContext.userName].expertise}

	
The current user's expertise, for example, Application, system, and database administration


	
Business Fax

	
#{webCenterProfile[securityContext.userName].businessFax}

	
The current user's business fax number


	
Business Mobile

	
#{webCenterProfile[securityContext.userName].businessMobile}

	
The current user's business mobile or cell phone number


	
Business Phone

	
#{webCenterProfile[securityContext.userName].businessPhone}

	
The current user's business phone number


	
Business Pager

	
#{webCenterProfile[securityContext.userName].businessPager}

	
The current user's business pager number


	
Business Street

	
#{webCenterProfile[securityContext.userName].businessStreet}

	
The street address of the current user's business office


	
Business City

	
#{webCenterProfile[securityContext.userName].businessCity}

	
The city where the current user's business office is located


	
Business State

	
#{webCenterProfile[securityContext.userName].businessState}

	
The state where the current user's business office is located


	
Business PO Box

	
#{webCenterProfile[securityContext.userName].businessPOBox}

	
The current user's business Post Office Box number


	
Business Postal Code

	
#{webCenterProfile[securityContext.userName].businessPostalCode}

	
The postal or ZIP code of the current user's business office


	
Business Country

	
#{webCenterProfile[securityContext.userName].businessCountry}

	
The country where the current user's business office is located


	
Home Address

	
#{webCenterProfile[securityContext.userName].homeAddress}

	
The current user's home address


	
Home phone

	
#{webCenterProfile[securityContext.userName].homePhone}

	
The current user's home phone number


	
Date of Birth

	
#{webCenterProfile[securityContext.userName].dateofBirth}

	
The current user's date of birth


	
Maiden Name

	
#{webCenterProfile[securityContext.userName].maidenName}

	
The current user's maiden name


	
Date of hire

	
#{webCenterProfile[securityContext.userName].dateofHire}

	
The date the current user was hired by the company


	
Name Suffix

	
#{webCenterProfile[securityContext.userName].nameSuffix}

	
Titles or credentials appended to the current user's name, for example, MD, Esq, and the like


	
Wireless Account Number

	
#{webCenterProfile[securityContext.userName].wirelessAcctNumber}

	
The account number for the current user's wireless internet account












B.4.1.9 WebCenter Events Seeded ELs

WebCenter Events seeded EL expressions return values related to document-related events, such as the name of the selected document, the document's creator, the date the document was last modified, and so on. For example, the expression #{wcEventContext.events.WebCenterResourceSelected.name}, returns the name of the currently selected document.

Table B-9 lists the seeded EL expressions available under the category WebCenter Events and provides an example of the types of values each returns.


Table B-9 Seeded EL Expressions Under WebCenter Events

	Option	Expression	Example of Returned Value
	
Selected User Name

	
#{wcEventContext.events.WebCenterUserSelected.UserName}

	
The user name of the currently selected user


	
Selected Document Name

	
#{wcEventContext.events.WebCenterResourceSelected.name}

	
The name of the currently selected document


	
Selected Document Creator

	
#{wcEventContext.events.WebCenterResourceSelected.createdBy}

	
The name of the user who created the currently selected document


	
Selected Document Last Modified

	
#{wcEventContext.events.WebCenterResourceSelected.lastModifiedBy}

	
The date the selected document was last modified














B.4.2 EL Expressions Relevant to the Spaces Application

Table B-10 lists EL expressions relevant to the Spaces application information and describes the types of functionality it provides. The Context column indicates whether the expression can be used in Spaces context (WCS) or in both Spaces and Framework applications built with Oracle JDeveloper (Both).


Table B-10 EL Expressions Relevant to Spaces Application

	Expression	Function	Context
	
#{WCAppContext}

	
An oracle.webcenter.webcenterapp.context.WCApplicationContext object that provides an access point in the current web request for all Oracle WebCenter Portal application-related information.

	
WCS


	
#{WCAppContext.currentWebCenterURI}

	
Returns a URL representing the current web request with bookmarkable Spaces URL parameters of the request appended to the end (parameters are not necessarily in a fixed order).

Example:


http://name.us.oracle.com/webcenter/faces/oracle/webcenter/page/scopedMD/someguid/SomePage.jspx?
wc.contextURL=/spaces/somename&wc.pageScope=1234

	
WCS


	
#{WCAppContext.application.applicationConfig}

	
An oracle.webcenter.webcenterapp.beans.WebCenterType bean with a payload of metadata from the current Spaces application.

	
WCS


	
#{WCAppContext.application.applicationConfig.title}

	
Returns the display name of the current Spaces application (as configured through Spaces Administration settings).

Out of the box, this returns WebCenter Portal.

	
WCS


	
#{WCAppContext.application.applicationConfig.logo}

	
If an application logo was uploaded through Spaces Administration settings, this expression returns the URL to the application logo image.

Out of the box, this returns null.

	
WCS


	
#{WCAppContext.application.applicationConfig.helpPage}

	
Returns the URL to the Help application used for the current Spaces application (as configured through Spaces Administration settings).

Out of the box, this returns /webcenterhelp/spaces.

	
WCS


	
#{WCAppContext.application.applicationConfig.copyrightMessage.customValue}

	
If a copyright message was configured through Spaces Administration settings, this expression returns the application copyright message.

Out of the box, this returns null.

	
WCS


	
#{WCAppContext.application.applicationConfig.privacyPolicyUrl}

	
Returns the URL to the document that contains the application's privacy policy (as configured through Spaces Administration settings).

Out of the box, this returns http://www.oracle.com/html/privacy.html

	
WCS


	
#{WCAppContext.application.applicationConfig.skin}

	
Returns the name of the default ADF Faces skin family to use for rendering pages in the application (as configured through Spaces Administration settings).

This expression represents only the application-level setting that may not necessarily be used in all web requests. For example, you cannot use it successfully if a user has chosen to override the skin through application Preferences (for more information, see Chapter 35, "Setting Your Personal Preferences").

	
WCS


	
#{requestContext.skinFamily}

	
Returns the name of the ADF Faces skin family being used for the current web request, depending on factors such as what has been configured at the application level, the current user's preference setting, and so on.

Returns the same value as #{adfFacesContext.skinFamily}.

	
Both












B.4.3 EL Expressions Relevant to Application Security

Table B-11 lists EL expressions relevant to application security and describes the types of functionality it provides. The Context column indicates whether the expression can be used in the Spaces context (WCS) or in both the Spaces application and Framework applications built with Oracle JDeveloper (Both).




	
See Also:

For example implementations of expressions related to component-level security, see Section 23.2, "Setting Access on a Page Component."








Table B-11 EL Expressions Relevant to Security

	Expression	Function	Context
	
#{security.authenticated}

	
Returns true when the current user is authenticated in the context in which the EL is being invoked, otherwise false.

	
Both


	
#{securityContext.userName}

	
Returns the user name of the currently logged in user. If the current user is not logged in, this expression returns no value.

	
Both


	
#{security.pageContextCommunityModerator}

	
Returns the value true if the current user is a moderator of the current space.

	
WCS


	
#{WCSecurityContext.userInScopedRole['role']}

	
Returns the value true if the current user is assigned the specified role in the current scope. Role can be Moderator, Participant, Viewer, or a custom role defined in that scope.

The scope is implicitly resolved to be the current scope. If you use this EL in the Home space, it resolves to Home space GUID and roles defined at the application level. If you use this EL in a space scope, it resolves to roles defined for the space.

	
WCS


	
#{WCSecurityContext.userInGroup['group']}

	
Returns the value true if the current user is assigned the specified group, for example, Administrators.

	
Both


	
#{WCSecurityContext.currentUser['userName']}

	
Returns the value true if the current user is the specified user.

	
Both










B.4.3.1 Example: Restricting Access to Composer's Source View Using EL Expressions

This section provides an example of using EL expressions to display something based on a user's role. In the example, you will create a page style and edit its source code to add an EL expression that allow only users granted the AdvancedEdit role to be able to access Source view of Composer in Home space.

To restrict access to Composer's Source view in Home space:

	
Create a new role called AdvancedEdit, and assign it to the user, weblogic. (For information, see Section 21.2, "Managing Application Roles and Permissions.")

The user weblogic will now have two roles: Administrator and AdvancedEdit.


	
Create a new page style, say Blank Page (For information, see Section 10.2.2, "Creating a Resource.")


	
Edit the source code of the page style to grant access to Composer's Source view only to users with the AdvancedEdit role. (For information about editing the source code, see Section 10.3.2, "Editing the Source Code of a Resource.")

Add the following attribute to the <pe: pageCustomizable> tag (Figure B-6):


toolbarLayout="message stretch statusindicator newline #{WCSecurityContext.userInScopedRole['AdvancedEdit'] ? 'menu' : ''} addonpanels stretch help button"



Figure B-6 Editing Source Code of a Page Style

[image: Description of Figure B-6 follows]

Description of "Figure B-6 Editing Source Code of a Page Style"





	
Log in as a user other than weblogic, and in Home space create a page using the Blank Page page style. When you open the page in Composer, the page appears in Design view, and no View menu is available because the user is not granted the AdvancedEdit role.

Applying this technique to all page styles available to users in Home space completely controls access to Source view. You can follow the same technique for various spaces.











B.4.4 EL Expressions Relevant to Application Navigation

Table B-12 lists EL expressions relevant to Spaces navigation and describes the types of functionality it provides. All navigation ELs can be used in both the Spaces application and Framework applications built with Oracle JDeveloper.


Table B-12 EL Expressions Relevant to Navigation

	Expression	Function
	
Navigation Context Expressions

	

	
#{navigationContext.defaultNavigationModel}

	
Returns default navigation model. It gets the value from the preference bean. The preference bean gets the value based on the preference setting in adf-config.xml, static value.

The following example returns the specified default tree model:


#{navigationContext.defaultNavigationModel.defaultTreeModel}


You can also use defaultMenuModel and defaultListModel (see next listing).


	
#{navigationContext.currentNavigationModel}

	
Returns the navigation model used to navigate to the current view (that is, the current page)

There may be a number of navigation models on the page. Only the one used to navigate to the page is the current navigation model.

The current navigation model is set only when the processAction is called.

The following example returns the default tree model for the current navigation model:


#{navigationContext.currentNavigationModel.defaultTreeModel}


You can also use defaultMenuModel and defaultListModel.

See Also: #{navigationContext.processAction}.


	
#{navigationContext.navigationModel['model_path']}

	
Returns the navigation model specified by path.

Example:


#{navigationContext.navigationModel['/oracle/webcenter/portalapp/navigations/default-navigation-model']}


User can simply enter the path in the square bracket without having to remember the parameter name. For backward compatibility, comma-separated parameters are also supported. Available parameters (with examples) are:

	
modelPath=/oracle/webcenter/portalapp/navigations/default-navigation-model


	
modelScope=/oracle/webcenter/portalapp/navigation


	
modelId=default-navigation-model




Note: modelScope and modelId are used together, for example:


#{navigationContext.navigationModel['modelScope=/oracle/webcenter/portalapp/navigations,modelId=default-navigation-model']}


	
#{navigationContext.processAction}

	
Returns the default navigation method for binding to UI component's actionListener attribute. This assumes that the target resource to navigate to is passed in through the action UI component's node or path attribute.

The node attribute is typically used for the iterative case; while the path attribute is typically used to create a static link. If both are specified, the node attribute is used. Note that when using the path attribute, you must also specify the model attribute to pass in the navigation model object. If the model attribute is not specified, the current navigation model is used.

Example using the node attribute:


<af:forEach var="node" varStatus="vs"
 items="#{navigationContext.defaultNavigationModel.rootNode.children}">
  <af:subform id="pt_sfm1">
   <af:commandLink id="pt_cl1"
    text="#{node.title}"
    inlineStyle="font-size:small;color:White;"
    actionListener="#{navigationContext.processAction}"
    action="pprnav">
   <f:attribute name="node" value="#{node}"/>
    <af:showPopupBehavior popupId="menuPopup"
     align="afterStart"
     triggerType="mouseOver"/>
  </af:commandLink>


Example using the path attribute:


<af:commandLink id="pt_cl1" text="Prescriptions"
  inlineStyle="font-size:small; color:White;"
  actionListener="#{navigationContext.processAction}"
  action="pprnav">
<f:attribute name="path" value="/prescriptions"/>
<f:attribute name="model"   value="#{navigationContext.defaultNavigationModel}"/>
</af:commandLink>


	
Navigation Model Expressions

	

	
#{navigationContext.defaultNavigationModel.defaultTreeModel}

#{navigationContext.defaultNavigationModel.defaultMenuModel}

#{navigationContext.defaultNavigationModel.defaultListModel}

#{navigationContext.defaultNavigationModel.defaultSiteMap}

	
Returns a tree/menu/list model based on the default settings

The default values for the settings are specified in the next row. For example, the default value for depth is 0.

For defaultSiteMap, it returns the XML for the sitemap of the navigation based on the default settings.

This expression returns a model of type:

	
ChildPropertyTreeModel—used in <af:tree> component


	
ChildPropertyMenuModel—used in <af:breadcrumbs> or <af:menu> component


	
List<NavigationResource>—used in <af:foreach>





	
#{navigationContext.defaultNavigationModel.treeModel['parameters']}

#{navigationContext.defaultNavigationModel.menuModel['parameters']}

#{navigationContext.defaultNavigationModel.listModel['parameters']}

#{navigationContext.defaultNavigationModel.siteMap['parameters']}

	
Returns tree/menu/list model based on the specified comma-separated parameters. Available parameters (with default values as examples) are:

	
startNode=/—specify the starting node of the model (do not need "/" prefix unless requesting the root node, for example, home).


	
includeStartNode=true—specify true if you want to include the starting node (for example, the root node above) or false to start from its children.


	
depth=0—defines the initial depth of fetching. "0" means fetch the entire tree, which may take a long time. In which case, use "1" to fetch on demand (when users click the Expand icon).


	
prefetchOnly=false—by default (true), it returns nodes up to the depth level requested initially; deeper level nodes are returned on demand. Use false if you want only the initial sets of nodes. In which case, it does not return deeper nodes later on when requested, even when there are deeper nodes.




For siteMap, the available parameters are startNode and includeStartNode.

Example:


#{navigationContext.defaultNavigationModel.treeModel['startNode=home,includeStartNode=false,depth=2']}


	
#{navigationContext.defaultNavigationModel.rootNode}

	
Returns a root node (of type NavigationResource) of the navigation model.

Example:


<af:commandLink id="pt_cl1" text="Prescriptions"
  inlineStyle="font-size:small; color:White;"
  actionListener="#{navigationContext.processAction}"
  action="pprnav">
 <f:attribute name="node"
    value="#{navigationContext.
    defaultNavigationModel.
    rootNode.children[2]"/>
</af:commandLink>


	
#{navigationContext.defaultNavigationModel.node['path']}

	
Returns a node (of type NavigationResource) based on the path specified (you do not need "/" prefix unless you are requesting the root node, for example, '/')

Example:


#{navigationContext.defaultNavigationModel.node['home/page1']}


	
#{navigationContext.defaultNavigationModel.currentSelection}

	
Returns currently selected navigation resource.


	
#{navigationContext.defaultNavigationModel.newCurrentSelection['path']}

	
Sets the current selection to a node specified by the given path (you do not need "/" prefix unless you are requesting the root node, for example, '/'). If successful, returns the newly selected node of type NavigationResource.

The user must have the ability to explicitly set the current selection without having to actually navigate to a node.

This can be used where the user enters a page directly, and no selection is set. It provides a mechanism for the user to control what is the default when there is no current selection.

Example:


<c:set  value="${navigationContext.defaultNavigationModel.newCurrentSelection['home/page1']}"
 var="currSel" scope="session"/>
<c:if test="${currSel!=null}">
 <af:forEach items="#{currSel.children}"
  var="cnode" varStatus="cnodestatus">
...</c:if>


	
#{navigationContext.defaultNavigationModel.attributes.Description}

#{navigationContext.defaultNavigationModel.attributes['Description']}

	
Returns the value of the specified attribute of the navigation model.


	
Navigation Resource Expressions

	

	
#{node.attributes.Description}

#{node.attributes['Description']}

	
Returns the value of the specified attribute of the navigation resource.


	
#{node.parameters.StockSymbol}

#{node.parameters['StockSymbol']}

	
Returns the value of the specified parameter of the navigation resource.


	
#{node.parametersRaw.StockSymbol}

#{node.parametersRaw['StockSymbol']}

	
Returns the raw value of the specified parameter of the navigation resource (before it is evaluated).


	
#{node.title}

	
Returns the title of the navigation resource.


	
#{node.path}

	
Returns the path to the navigation resource.


	
#{node.externalURL}

	
Returns the URL for the navigation resource of type External Link.


	
#{node.prettyUrl}

	
Returns the identifying path for this navigation resource.


	
#{node.prettyUrlPath}

#{node.prettyUrlPath[N]}

	
Returns a collection of identifying paths by depth to enable its use as a starting path to drive another navigation view.

For example, assuming the currentSelection is home/company/products/applications, the following EL returns home/company/products:


#{node.prettyUrlPath[3]}


	
#{node.goLinkPrettyUrl}

	
Returns the identifying path for this navigation resource suitable for goLink destination


<af:goLink id="pt_gl2" text="#{node.title}"
   destination="#{node.goLinkPrettyUrl}"
   targetFrame="#{node.attributes['Target']}"
   inlineStyle="font-size:small;#{node.selected ?
   'font-weight:bold;' : ''}"/>


Any link to a page within Spaces also needs certain context parameters, but goLinkPrettyUrl is not designed to supply those parameters. Therefore, the use of goLinkPrettyUrl does not work correctly for links within Spaces, but works properly for links that point outside of Spaces.


	
#{node.separator ? ... : ...}

	
Returns whether this resource is a separator item.


	
#{node.navigable ? ... : ...}

	
Returns whether it is possible to navigate to this resource.


	
#{node.selected ? ... : ...}

	
Returns whether this resource is currently selected.


	
#{node.currentlySelected ? ... : ...}

	
Returns whether the resource is the currently selected resource and the model is the currently selected model.


	
#{node.onSelectedPath ? ... : ...}

	
Returns whether this node lies on the selected path. This is useful for highlighting the selected tab, for example.

For example, assuming the currently selected node is home/company/products/applications, the following EL highlights the home tab.


<c:set  value="${navigationContext.defaultNavigationModel.node['home']}"
 var="home" scope="session"/>
  <af:commandImageLink id="cil1"
    icon="#{(home.onSelectedPath) ?
    '/images/caremark/nav/HomeSelected.png' :
    '/images/caremark/nav/HomeIcon.png'}"
    actionListener="#{navigationContext.processAction}"
    action="pprnav">
  <f:attribute name="node" value="#{home}"/></af:commandImageLink>


	
#{node.leaf ? ... : ...}

	
Returns whether this resource is a leaf node.


	
#{node.parent}

	
Returns the parent node (of type NavigationResource) of this node. For the root node, null is returned.


	
#{node.ancestors}

	
Returns the hierarchy list of ancestors of this node (of type NavigationResource) starting with the root node.

For example, assuming the current node is home/company/products/applications, the following ELs return the following values:

	
#{node.ancestors[1]} returns the node for home


	
#{node.ancestors[3]} returns the node for home/company/products





	
#{node.depth}

	
Returns the depth of this node from the root node. Root node has a depth of zero.


	
#{node.siblings}

	
Returns the list of siblings (of type NavigationResource) of this node (inclusive).


	
#{node.nextSibling}

	
Returns the next sibling in the list (of type NavigationResource) of this node.

For example, the following code ensures that you do not output two separators in a row:


<c:if test="${(node.separator) && (!node.nextSibling.separator}">
  <af:separator id="s166"/>
</c:if>


	
#{node.previousSibling}

	
Returns the previous sibling in the list (of type NavigationResource) of this node.


	
#{node.index}

	
Returns the zero-relative index of this node relative to its siblings.


	
#{node.children}

#{node.children[N].title}

#{node.children[N].children[N].title}

	
Returns a collection of child resources.


	
#{node.childCount}

	
Returns the number of children of this node.


	
#{node.childByIndex['index']}

	
Returns the child node (of type NavigationResource) specified by the zero-relative index

If not found, this returns null.


	
#{node.childByPath['admin']}

	
Returns the child node (of type NavigationResource) specified by the path relative to this node

The path can be deeper than one level and does not need the '/' prefix. If not found, this returns null.










B.4.4.1 Example: Using EL Expressions for Navigation

This section provides an example of using a navigation model to monitor activities of two subspaces from a shared page in the parent space. In this example, you use a page containing the Activity Stream task flow. The content of the task flow is determined by a parameter passed to the page. The navigation model includes two links that link to the page. The first link passes subspace1 as the parameter so that the Activity Stream task flow shows activities of subspace1. The second link passes subspace2 as the parameter. So, the content of the page is different depending on which link you click in the navigation.

To build a navigation model that uses ELs to monitor subspace activity from a parent space:

	
Create a space, and two subspaces. While creating subspaces, note down the internal name used (for example, subspace1 and subspace2).


	
In your space, create a page called Subspace Activity, and add the Activity Stream task flow to the page.


	
Create a page parameter, say subspaceName, for the newly created page. Use the following EL as the value of the parameter:


#{empty navigationContext.currentNavigationModel.currentSelection.parameters.subspaceName ? 'subspace1' : navigationContext.currentNavigationModel.currentSelection.parameters.subspaceName}


Where, 'subspace1' is the value to be used for the page parameter if none is passed to it from the navigation.


	
Edit the settings of the Activity Stream task flow. In the Component Properties dialog, on the Parameters tab, for the Spaces parameter, open the Expression Builder, and for Page Parameter, select subspaceName.


	
On the Display Options tab, for the Text field, specify a value that shows the name of the subspace whose activity is shown. For example, use the following EL:


#{bindings.subspaceName} Activity


	
Build a navigation that passes the space to show your page:

	
Create a navigation based on Spaces Default Navigation Model.


	
Edit the navigation by adding a Link navigation item.


	
On the Target tab, in the Name field, specify the name of the Link item as Sub Space 1.


	
In the Path field, select the Subspace Activity page.


	
On the Parameters tab, for the subspaceName field, specify the internal name of the first subspace, subspace1.





	
Copy the newly created link, and edit it to make a link for the second subspace, subspace2.

While editing, on the Target tab you only need to change the Name of the link. On the Parameters tab, you only need to change the value of the subspaceName parameter to subspace2 (the internal name of the second subspace).


	
Make sure the newly created navigation is set as the current navigation for your space.


	
You now have two links that take you to the shared Subspace Activity page, passing different values for the space depending on the link you click.











B.4.5 EL Expressions Relevant to Resources

Use the expressions in this section to query for resources. Querying for a resource through an EL expression is similar to querying for it through an API call. That is, you must set query parameters in the format ['property']['like']['value'], where property is the name of the property, for example, id, resourceScope, and the like, and value is the search value for the attribute.

A query can result in single or multiple results. The query designer must decide what is wanted. The query designer determines whether to return one or multiple results by encountering one of the following values in the expression:

	
singleResult—Returns a single resource. When no matching resource is found, null is returned.


	
resultList—Returns a list of resources. When no matching resources are found, an empty list is returned.







	
Note:

Occurrences of singleResult or resultList in the expression are used internally as the query end point, and, after this, the query is executed immediately. Anything set after the end point can result in unexpected behavior.







The following example returns the first template resource found with a display name that contains myPage:


#{srmContext[wCond['resourceType']['like']['siteTemplate']]['and'][wCond['displayName']['like']['myPage']].singleResult} 


The following example returns a list of template resources residing in the directory resourceDir, with a description that contains sampleDesc:


#{srmContext[wCond['resourceType']['like']['siteTemplate']]['and'][wCond['description']['like']['sampleDesc']]['and'][wCond['contentDirectory']['like']['resourceDir'].resultList} 


A property of this class includes any attribute of this class. Example properties include: Id, DisplayName, iconURI, contentDirectory, and the like.

The property value can be an explicit value or an EL expression that returns that type of value. For example, the following two queries return the same result:


#{srmContext[wCond['id']['like']['resourceId']].singleResult}

#{srmContext[wCond['id']['like']['spacesContext.currentSpace.uiMetadata.siteTemplateId']].singleResult}


You can use any property of this class in an EL-based query in the format property['value'] and in any order. For example, the following two queries return the same result:


#{srmContext[wCond['resourceScope']['like']['scopeName']]['and'][wCond['id]['like']['resourceId']].singleResult}

#{srmContext[wCond['id']['like']['resourceId']]['and'][wCond['resourceScope']['like']['scopeName']].singleResult}


Table B-13 lists EL expressions relevant to resources and describes the types of functionality each provides. You can use all resource EL expressions in both the Spaces application and Framework applications built with Oracle JDeveloper.


Table B-13 ELs Relevant to Resources

	EL	Function
	
#{srmContext[wCond['id']['like']['resourceGUID']]}

	
Returns the resource with the specified ID


	
#{srmContext[wCond['displayName']['like']['resourceDisplayName']]}

	
Returns any resources with the specified display name


	
#{srmContext[wCond['displayNameKey']['like']['displayNameKey']]}

	
Returns any resources with the specified display name key


	
#{srmContext[wCond['description']['like']['resourceDescription']].singleResult}

	
Returns one result of a resource that contains the specified value in its description

To get multiple results, use resultList in lieu of singleResult.


	
#{srmContext[wCond['descriptionKey']['like']['descriptionKey']].singleResult}

	
Returns one result of a resource with the specified description key

The description key is the key in the xsrt file for the resource description.

To get multiple results, use resultList in lieu of singleResult.


	
#{srmContext[wCond['createdDate']['like']['resourceCreationDate']]}

	
Returns any resource with the specified creation date


	
#{srmContext[wCond['modifiedBy']['like']['resourceLastModifiedBy']]

	
Returns any resource that was last modified by the user with the specified user name


	
#{srmContext[wCond['modifiedDate']['like']['resourceLastModifiedDate']]}

	
Returns any resource that was last modified by the specified date


	
#{srmContext[wCond['resourceScope']['like']['resourceScope']]}

	
Returns any resource that falls within the specified scope


	
#{srmContext[wCond['category']['like']['categoryName']]}

	
Returns any resource that falls within the specified category

For example:


#{srmContext[wCond['category']['like']['siteTemplates']]}


	
#{srmContext[wCond['contentDirectory']['like']['contentDirectory']]}

	
Returns any resource that is stored within the specified directory


	
#{srmContext[wCond['metadataFile']['like']['metadataFileLocation']]}

	
Returns resource metadata from the specified metadata file

For example, the following expression returns resource metadata from the following file /home/metadata/data.xml:


#{srmContext[wCond['metadataFile']['like']['/home/metadat/data.xml']]}


	
#{srmContext[wCond['jspx']['like']['jspxFileLocation']]}

	
Returns any jspx file in the specified location

For example, the following expression returns the page.jspx file:


#{srmContext[wCond['jspx']['like']['/home/web/page.jspx']]}


	
#{srmContext[wCond['pageDef']['like']['pageDefinition']]}

	
Returns any jspx file with the specified page definition


	
#{srmContext[wCond['iconURI']['like']['iconURI']]}

	
Returns the icon at the specified icon URI


	
#{srmContext[wCond['excludeFrom']['like']['excludeFromScopes']]}

	
In a larger expression, returns all specified resources except those available in the excluded scopes


	
#{srmContext[wCond['usesCustomSecurity']['like']['usesCustomSecurity']]}

	
In a larger expression, returns any resource the either does or does not use custom security

Set usesCustomSecurity to TRUE or FALSE. For example:


#{srmContext[wCond['usesCustomSecurity']['like']['TRUE']]}


	
#{srmContext[wCond['seeded']['like']['seeded']]}

	
In a larger expression, returns any resource that is or is not seeded, depending on the provided value

Set seeded to TRUE or FALSE. For example:


#{srmContext[wCond['seeded']['like']['TRUE']]}


	
#{srmContext[wCond['visibleType']['like']['visibleType']]}

	
In a larger expression, returns any resource that is of the specified type of visibility

Set visibleType to TRUE, FALSE, or NEVER to indicate that the resource is never shown. For example, the following expression returns resources that are visible, that is, resources that are set to Show:


#{srmContext[wCond['visibleType']['like']['TRUE']]}


	
#{srmContext[wCond['visible']['like']['visible']]}

	
In a larger expression, returns one or multiple resources with visibility set to either TRUE or FALSE


	
#{srmContext[wCond['createdBy']['like']['resourceCreator']]}

	
In a larger expression, returns any resource created by the specified user


	
#{srmContext[wCond['resourceType']['like']['resourceType']]}

	
In a larger expression, returns one or multiple resources of the specified type

For example, the following expression searches for a resource of the type SITE_TEMPLATE:


#{srmContext[wCond['resourceType']['like']['SITE_TEMPLATE']]}


Note that all resource types are listed in Oracle Fusion Middleware Java API Reference for Oracle WebCenter, in the GenericSiteResourceTypes class.


	
#{srmContext[wCond['version']['like']['version']]}

	
In a larger expression, returns one or multiple resources available in the application of the specified version


	
#{srmContext[wCond['resourceScope']['like']['scopeName']]}

	
In a larger expression, returns one or multiple resources available in the specified scope

For example, the following expression searches for resources in the scope (in this instance, the space) MySpace:


#{srmContext[wCond['resourceScope']['like']['MySpace']]}


To search in the default scope, that is, the application scope, use defaultScope.


	
#{srmContext[wCond['searchType']['like']['searchType']]}

	
In a larger expression, returns one or multiple resources that contain or equal the values set by other included expressions

Set searchType to CONTAINS or EQUALS.










B.4.5.1 Example: Using EL Expressions for Resources

This section provides an example of using an EL expression to display a page template based on a user's role.

In this example, you will use an EL expression to enable a specific page template to be displayed for moderators so that only they can access the features or links available in that page template.

To display a page template based on a user role:

	
Go to the desired space.


	
Go to Manage > General Settings.


	
In the Display Setting section, for Page Template click the Expression Builder icon, and click Expression Builder.


	
In the Type a value or expression, enter the following expression:


#{srmContext[wCond['resourceType']['like']['siteTemplate']][wCond['displayName']['like'][WCSecurityContext.userInScopedRole['Moderator'] ? 'Fusion Side Navigation' : 'WebCenter Spaces Top Navigation']].singleResult.id}


Where:

	
srmContext[wCond['resourceType']['like']['siteTemplate']]

Gets a list of all page templates in the scope


	
[wCond['displayName']['like'][WCSecurityContext.userInScopedRole['Moderator'] ? 'Fusion Side Navigation' : 'WebCenter Spaces Top Navigation']]

Reduces the list down to one depending on whether the current user is a moderator. If the user is a moderator, the Fusion Side Navigation page template is applied. For all other user roles, the space is rendered using the WebCenter Spaces Top Navigation page template.


	
singleResult.id

Returns the GUID of the required entry.





	
Click OK.











B.4.6 EL Expressions Relevant to Specific Spaces

Table B-14 lists EL expressions relevant to spaces and describes the types of functionality each provides. All of the listed ELs are for use in Spaces.




	
Note:

The space internal name is the name specified by the Space URL on the General page of a space's administration settings. The space display name is specified by Display Name. Many of the EL expressions in Table B-14 call for the space internal name.








Table B-14 EL Expressions Relevant to Specific Spaces

	Expression	Function
	
#{spaceContext}

	
An oracle.webcenter.spaces.context.SpacesContext object that provides an access point in the current web request for all space-related information.

The value of this expression is whatever is returned on invoking the java API: SpacesContext.getCurrentInstance()


	
#{spaceContext.currentSpace}

	
An oracle.webcenter.spaces.Space object that represents the space associated with the current web request. If the current web request is in the Home space context, it returns a value of null.

The value of this expression is whatever is returned on invoking the Java API: SpacesContext.getCurrentInstance().getCurrentSpace()


	
#{spaceContext.currentSpaceName}

	
The name of the space associated with the current web request. If the current web request is in a Home space context, it returns a value of null.

The value of this expression is whatever is returned on invoking the java API: SpacesContext.getCurrentInstance().getCurrentSpace()


	
#{spaceContext.space['spaceName']}

#{spaceContext.currentSpace}

	
An oracle.webcenter.spaces.Space object that represents the space that is named spaceName or the current space (currentSpace). For example, #{spaceContext.space['FinanceProject']} returns the space object for the space called FinanceProject.

The value of this expression is whatever is returned in Java on invoking .getSpace(...) on the current SpacesManager passing in the MDSSession of the current ADFContext.


	
#{spaceContext.space['spaceName'].metadataPath}

#{spaceContext.currentSpace.metadataPath}

	
The MDS path of the space metadata document for the space with specified name spaceName or the current space (currentSpace). For example, #{spaceContext.space['FinanceProject'].metadataPath} evaluates to /oracle/webcenter/space/metadata/spaces/FinanceProject/space.xml

The value of this expression is whatever is returned in java on invoking .getMetadataPath() on the space object for the space.


	
#{spaceContext.space['spaceName'].metadata}

#{spaceContext.currentSpace.metadata}

	
An oracle.webcenter.spaces.beans.SpaceType bean that carries metadata about the space that is named spaceName or the current space (currentSpace).

The value of this expression is whatever is returned in java on invoking .getMetadata() on the space object for the space passing in the MDSSession of the current ADFContext.


	
#{spaceContext.space['spaceName'].metadata.displayName}

#{spaceContext.currentSpace.metadata.displayName}

	
The display name of the space that is named spaceName or the current space (currentSpace). For example, if a space called Web20Space has the display name web 2.0 Space, then #{spaceContext.space['Web20Space'].metadata.displayName} evaluates to web 2.0 Space.


	
#{WCPrepareImageURL[spaceContext.space['spaceName'].metadata.icon]['']}

#{WCPrepareImageURL[spaceContext.currentSpace.metadata.icon]['']}

	
A URL to the icon associated with the space that is named spaceName or the current space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.description}

#{spaceContext.currentSpace.metadata.description}

	
The description of the space that is named spaceName or the current space (currentSpace). For example, #{spaceContext.space['FinanceProject'].metadata.description} evaluates to Conglomeration of all teams involved in financial activities.


	
#{spaceContext.space['spaceName'].metadata.creationDate}

#{spaceContext.currentSpace.metadata.creationDate}

	
A java.util.Calendar object representing the date-time on which the space with specified name spaceName or the current space (currentSpace) was created.


	
#{spaceContext.space['spaceName'].metadata.createdBy}

#{spaceContext.currentSpace.metadata.createdBy}

	
The user-name of the person who created the space that is named spaceName or the current space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.keywords}

#{spaceContext.currentSpace.metadata.keywords}

	
A comma-delimited list of searchable keywords associated with the space with the name spaceName or the current space (currentSpace). For example, if the space FinanceProject has the keywords finance, project, money, then #{spaceContext.space['FinanceProject'].metadata.keywords} evaluates to finance, project, money.


	
#{spaceContext.space['spaceName'].metadata.offline}

#{spaceContext.currentSpace.metadata.offline}

	
Boolean value that indicates whether the space that is named spaceName or the current space (currentSpace) is offline.


	
#{spaceContext.space['spaceName'].metadata.closed}

#{spaceContext.currentSpace.metadata.closed}

	
Boolean value that indicates whether the space that is named spaceName or the current space (currentSpace) is closed.


	
#{spaceContext.space['spaceName'].metadata.selfRegistration}

#{spaceContext.currentSpace.metadata.selfRegistration}

	
Boolean value that indicates whether users are allowed to register themselves with the space that is named spaceName or the current space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.discoverable}

#{spaceContext.currentSpace.metadata.discoverable}

	
Boolean value that indicates whether users can discover the existence of the space that is named spaceName or the current space (currentSpace) by searching for it or seeing it listed on the My spaces page.


	
#{spaceContext.space['spaceName'].metadata.publishRSS}

#{spaceContext.currentSpace.metadata.publishRSS}

	
Boolean value indicating whether the space that is named spaceName or the current space (currentSpace) publishes RSS feeds.


	
#{spaceContext.space['spaceName'].distributionList}

#{spaceContext.currentSpace.distributionList}

	
The email address of the mailing list associated with the space that is named spaceName or the current space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.customAttributes['attributeName']}

#{spaceContext.currentSpace.metadata.customAttributes['attributeName']}

	
The value of a specific custom attribute of the name attributeName for the space that is named spaceName or the current space (currentSpace). For example, if the FinanceProject space has a custom attribute called stockPrice with a value of 13.9, then #{spaceContext.space['FinanceProject'].metadata.customAttributes['stockPrice']} evaluates to 13.9.


	
#{WCPrepareImageURL[spaceContext.space['spaceName'].metadata.logo]['']}

#{WCPrepareImageURL[spaceContext.currentSpace.metadata.logo]['']}

	
Returns the logo URL for the space named spaceName or the current space (currentSpace).


	
#{spaceContext.spacesQuery.property['value']}

#{spaceContext.spacesQuery.property['value'].listSpaces}

	
A means of querying a space using a query parameter in the form of property['value'], where property means the name of the property, for example, unionOf, shape, and the like; and value means the criteria to use in fetching the list of all spaces, discoverable spaces, and the like.

If listSpaces is appended to the expression, the query returns the list of spaces of type GSMetadata. (For more information, see Interface GSMetadata in Oracle Fusion Middleware Java API Reference for Oracle WebCenter.)

For example, the following EL expression returns a list of all discoverable spaces.


#{spaceContext.spacesQuery.unionOf['DISCOVERABLE'].listSpaces}


If listspaces is not appended to the EL, then the EL evaluates to an object of type SpacesQueryParameter. This object type must be evaluated using SpacesManager.getSpaces(SpacesQueryParameters), which in turn returns a list of spaces of type GSMetadata.

For example, the following EL expression returns an instance of type SpacesQueryParameters with all the query conditions populated.


#{spaceContext.spacesQuery.unionOf['DISCOVERABLE']}


	
#{spaceContext.spacesQuery.unionOf['USER_JOINED'].shape['ROOT_LEVEL'].listSpaces}

	
Returns a list of all top-level spaces of which the current user is a member

This EL returns only those spaces that do not have a parent, that is, it does not return subspaces.


	
#{spaceContext.spacesQuery.unionOf['USER_JOINED'].shape['RECURSIVE_FLATTENED'].listSpaces}

	
Returns a list of all spaces of which the current user is a member

This EL also returns all the subspaces under each of the parent spaces to which the current user has access.

To see an example, refer to Section B.4.6.1, "Example: Using EL Expressions for Various Spaces".


	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sort['sortBy field picked from WcSpaceHeader']}

	
Returns spaces sorted into the order specified by the sort criteria

For example, the following query returns a list of spaces to which the user has access sorted by discoverable and lastUpdateDate fields.

Note that in the following example, the idenitifier sp represents the JPA entity for a space, WcSpaceHeader.


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sort['sp.discoverable']['asc']['sp.lastUpdateDate']['desc'].listSpaces}


	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].pageNumber[page_num].listSpaces}

	
Allows specifying the page number (0-based) to select from the results matching the query criteria

For example, the following expression returns a list of all spaces to which a user has access and returns the third page of the result set:


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].pageNumber[2].listSpaces]}


	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].itemsPerPage[page_num].listSpaces}

	
Allows specifying the number of results to be included in each page when breaking down the result space into pages

For example, the following expression returns a list of all spaces to which a user has access, listing 10 records per page.


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].pageNumber[10].listSpaces]}


	

#{spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.where[wCond['sp.createdBy']['like']['monty%'] ['and'] [wCond['sp.selfSubEnabled']['is']['null'] ['or'] [wCond['sp.selfSubEnabled']['=']['N']] ['not'] ] ].listSpaces}

	
Returns a list of all spaces a user has access which are created by a specified user, and on which self subscription is enabled. (For more information, see SpacesQueryParameters and SpacesQueryFilter in Oracle Fusion Middleware Java API Reference for Oracle WebCenter.)










B.4.6.1 Example: Using EL Expressions for Various Spaces

This section provides an example of using EL expressions to query various spaces.

In this example, you will use the following EL to display a list of all spaces of which you are a member:


"#{spaceContext.spacesQuery.unionOf['USER_JOINED'].shape['RECURSIVE_FLATTENED'].listSpaces}"


You will also use the following methods to display the logo, name, description, and number of members of a space.

	
iconURI - to display the space logo


	
displayName - to display the space name


	
description - to display the space description


	
memberCount - to display the number of space members




To query a space:

	
Create a new task flow, and mark it as available for use, as described in Section 26.3.1, "Creating a Task Flow."


	
Edit the source code of the task flow. On the Resources tab, select the task flow. From the Edit menu, select Edit Source.


	
In the Edit Source dialog, on the Fragment tab, replace the existing code with the following code:


<?xml version='1.0' encoding='UTF-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1" xmlns:pe="http://xmlns.oracle.com/adf/pageeditor" xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable" xmlns:f="http://java.sun.com/jsf/core" xmlns:af="http://xmlns.oracle.com/adf/faces/rich" xmlns:c="http://java.sun.com/jsp/jstl/core" xmlns:fn="http://java.sun.com/jsp/jstl/functions">
   <af:panelGroupLayout id="pgl1">
      <cust:panelCustomizable id="pc1">
         <table border="0" width="100%">
            <af:iterator id="it1" var="row" value="#{spaceContext.spacesQuery.unionOf['USER_JOINED'].shape['RECURSIVE_FLATTENED'].listSpaces}">
                  <c:set var="iconURI" value="#{fn:split(row.iconURI,'}')[1]}"/>
                  <c:set var="displayName" value="#{row.displayName}"/>
                  <c:set var="description" value="#{row.description}"/>
                  <c:set var="numMembers" value="#{row.memberCount}"/>
                       <tr class="PortletText1">
                              <td width="16px" rowspan="3" valign="top">
                                      <af:image id="img1"
source="/webcenter-spaces-resources/oracle/webcenter/siteresources/scopedMD/shared#{iconURI}/ICON16"/>
                               </td>
                               <td>
                                    <af:outputText id="otCol1"
                                             value="#{displayName}"
                                                         inlineStyle="color:#333333; font-size:12px; font-weight:bold;"/>
 
                                           
                                </td>
                         </tr>
                          <tr>
                              <td>
                                  <af:outputText id="otCol3"
                                                   value="#{description}"
                                                         inlineStyle="color:#666666; font-size:12px;"/>
                                </td>
                          </tr>
                          <tr>
                             <td>
                                <af:outputText id="otCol4"
                                              value="members (#{numMembers}) -"
                                                         inlineStyle="color:#666666; font-size:10px;"/>
                                     <af:spacer id="spacer1" width="5px"/>
                                     <af:goLink id="gl1"
                                                     destination="/spaces/#{row.name}"
                                                     targetFrame="_blank"
                                                     text="view"/>
                              </td>
                          </tr>
            </af:iterator>
         </table>
      </cust:panelCustomizable>
   </af:panelGroupLayout>
</jsp:root>


	
Add the task flow to a page. In the Resource Catalog, the custom task flow is available under Mash-Ups > Task Flows.

The page should now show a list of all the spaces of which you are is a member (Figure B-1).


Figure B-7 Space Query
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B.4.7 EL Expressions Relevant to Specific Pages

Table B-15 lists EL expressions relevant to application pages and describes the types of functionality it provides.


Table B-15 EL Expressions Relevant to Application Pages

	Expression	Function
	
#{pageDocBean.title}

	
Returns the page display name, for example:

FinanceProject


	
#{pageDocBean.createdBy}

	
Returns the user name of the person who created the page, for example:

monty


	
#{pageDocBean.createDateString}

	
Returns the date and time the page was created, for example:

2008-11-19T10:18:36


	
#{pageDocBean.lastUpdatedBy}

	
Returns the user name of the person who last updated the page, for example:

monty


	
#{pageDocBean.lastUpdateDateString}

	
Returns the date and time the page was last updated, for example:

2008-11-19T10:18:36


	
#{pageDocBean.pagePath}

	
Returns the file directory path to the page relative to the application root directory, for example:

/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/user/Umonty/Page4.jspx


	
#{pageDocBean.name}

	
Returns the file name of the page, for example:

Page4.jspx


	
#{pageDocBean.UICSSStyle}

	
Returns the name of the style scheme used on the page, for example:

WCSchemeEggShell


	
#{pageDocBean.UISchemeBGImage}

	
Returns the directory path and file name of the page scheme background image.


	
#{pageDocBean.UISchemeBGColorString}

	
Returns the hexadecimal value of the page scheme background color, for example:

#ffa500


	
#{pageDocBean.pagePermission}

	
Returns the permission the current user has on the page, for example:

oracle.webcenter.page.model.security.CustomPagePermission


	
#{pageDocBean.pageSecurityTarget}

	
A string of 60 or so characters that uniquely identifies the current page to the security system, for example:

oracle_webcenter_page_scopedMD_s8bba98ff_4cbb_40b8_beee_296c916a23ed_user_Umonty_Page4PageDef












B.4.8 EL Expressions Relevant to Composer

Table B-16 lists EL expressions relevant to Composer. The Context column indicates that the expression can be used both in the Spaces application and Framework applications built with Oracle JDeveloper.


Table B-16 EL Expressions Relevant to Composer

	Expression	Function	Context
	
#{composerContext.inEditMode}

	
Determines whether the current page is in View mode or Edit mode, for example:


<af:outputText id="ot1"
  value="#{composerContext.inEditMode ne
  true ? 'View mode' : 'Edit mode'} />


This example shows an ADF Faces outputText component that returns View mode when the page is in View mode and Edit mode when the page is in Edit mode.

	
Both










B.4.8.1 Example: Using EL Expressions for Composer

This section provides an example of using an EL expression to display different pages in View mode and Edit mode. Consider that you want one of your pages, say Page1, to display another page, say Page2, in View mode. However, while editing Page1, instead of Page2, you want to display a website, say www.oracle.com. You can use the EL of the following format:

#{ composerContext.inEditMode ? 'website_url' : 'url of Page2' }

This EL displays the specified website when your page is in Edit mode, and shows Page2 when in View mode.

The following steps demonstrate how to display different pages depending on the page mode.

	
Open a page named Page1 in Edit mode.


	
Click Add Content.


	
In Resource Catalog, click Web Development.


	
Click Add next to Web Page, then click Close.


	
Click the Edit icon for the newly added Web Page.


	
In the Component Properties dialog, on the Display Options tab, in the Source field, enter the value as per the following format:

#{ composerContext.inEditMode ? 'website_url' : 'url of Page2' }


	
Click OK.

In Edit mode, Page1 should now display the website you specified. Save and close the page. Page1 should now show Page2.











B.4.9 EL Expressions Relevant to Event Contexts

Table B-17 lists EL expressions relevant to the types of events that can trigger the passing of payloads (rather than events relevant to the Events service).

You can access all or part of the event payloads provided in Table B-17 once they have been raised.

For example, for the whole payload, use the following EL:


#{wcEventContext.events.<eventName>}


For example:


#{wcEventContext.events.WebCenterUserSelected}


All of the payloads for the ELs in Table B-17 are Maps. To dereference a map entry, use the standard EL for Maps:


#{wcEventContext.events.WebCenterUserSelected.UserName}





	
See Also:

For more information about event wiring, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."








Table B-17 EL Expressions Relevant to Event Contexts

	Expression	Function
	
Event Context


#{wcEventContext.events.WebCenterResourceSelected}


Document Name


#{wcEventContext.events.WebCenterResourceSelected.name}


Document Creator


#{wcEventContext.events.WebCenterResourceSelected.createdBy}


Document Last Modified By


#{wcEventContext.events.WebCenterResourceSelected.lastModifiedBy}

	
Use in context wiring between producer and consumer task flows. Returns a map that relates some piece of metadata from the producer to some piece of metadata from the consumer, for example, from a document creator to the creator's Profile.

Producer task flows include:

	
Document Manager


	
Recent Documents


	
Document List Viewer




Consumer task flows include:

	
Activity Graph - Similar Items (show other documents that may be of interest to the user)


	
Links (show the items that are linked to the selected document)


	
Profile (view the Profile of the document's author)


	
Activity Stream (view activities related to this document)


	
Tags (tags on this document and a means of accessing the Tag Center)





	
Event Context


#{wcEventContext.events.WebCenterUserSelected}


User Name


#{wcEventContext.events.WebCenterUserSelected.userName}


User GUID


#{wcEventContext.events.WebCenterUserSelected.userGUID}


space Name


#{wcEventContext.events.WebCenterUserSelected.spaceName}


space GUID


#{wcEventContext.events.WebCenterUserSelected.spaceGUID}

	
Use in context wiring between producer and consumer task flows. Returns a map that relates some piece of metadata from the producer to some piece of metadata from the consumer, for example, from a user to the user's connections.

Producer task flows include:

	
Connections


	
Space Members




Consumer task flows include:

	
Connections (show connections of the selected user)


	
Documents task flows (show documents created by the selected user)


	
Activity Stream (view this user's activities)


	
Tags (tags created by this user)


	
Profile (show this user's Profile)





	
Event Context


#{wcEventContext.events.WebCenterConnectionSelected}


Profile User Name


#{wcEventContext.events.WebCenterConnectionSelected.profileUserName}


Profile User GUID


#{wcEventContext.events.WebCenterConnectionSelected.profileUserGUID}


Connected User Name


#{wcEventContext.events.WebCenterConnectionSelected.userName}


Connected User GUID


#{wcEventContext.events.WebCenterConnectionSelected.userGUID}

	
--


	
#{wcEventContext.events.WebCenterSpaceSelected.SpaceName}

	
Returns the name of the selected space


	
#{wcEventContext.events.WebCenterSpaceSelected.SpaceGUID}

	
Returns the GUID of the selected space












B.4.10 EL Expressions Relevant to Services

Table B-18 lists EL expressions relevant to services and describes the types of functionality it provides. All listed ELs can be used in both Spaces and WebCenter Portal: Framework.


Table B-18 EL Expressions Relevant to Services

	Expression	Function
	
#{webcenterService['serviceId']}

	
An oracle.webcenter.framework.service.Service object representing the WebCenter Portal service with the service ID serviceId. For example, the following EL returns Documents Service.


#{webcenterService['oracle.webcenter.doclib']}


For service IDs, see Table B-19.


	
#{webcenterService['serviceId'].configured}

	
Returns a Boolean value that indicates whether the WebCenter Portal service with the service ID serviceId is configured for use in the Spaces application. For example, the following EL returns true if Discussions service can be used in the application, false otherwise:

#{webcenterService['oracle.webcenter.collab.forum'].configured}

For service IDs, see Table B-19.


	
#{sessionContext['oracle.webcenter.collab.forum'].groupInfo['spaceName'].forumId}

	
Returns the forum ID of the specified space discussion forum. Enter the space name in lieu of spaceName.


	
#{sessionContext['oracle.webcenter.collab.forum'].groupInfo['spaceName'].categoryId}

	
Returns the category ID of the specified space discussion forums. Enter the space name in lieu of spaceName.








Table B-19 lists service IDs associated with services at runtime.


Table B-19 Service IDs

	Service	ID
	
Announcements

	
oracle.webcenter.collab.announcement


	
Discussions

	
oracle.webcenter.collab.forum


	
Documents and Wikis

	
oracle.webcenter.doclib


	
Events

	
oracle.webcenter.collab.calendar.community


	
Space Management

	
oracle.webcenter.community


	
Instant Messaging and Presence (IMP)

	
oracle.webcenter.collab.rtc


	
Links

	
oracle.webcenter.relationship


	
Lists

	
oracle.webcenter.list


	
Mail

	
oracle.webcenter.collab.mail


	
Notes

	
oracle.webcenter.note


	
Notifications

	
oracle.webcenter.notification


	
Page

	
oracle.webcenter.page


	
People Connections: Activity Stream

	
oracle.webcenter.activitystreaming


	
People Connections: Connections

	
oracle.webcenter.peopleconnections.connections


	
People Connections: Feedback

	
oracle.webcenter.peopleconnections.kudos


	
People Connections: Message Board

	
oracle.webcenter.peopleconnections.wall


	
People Connections: Profile

	
oracle.webcenter.peopleconnections.profile


	
Polls

	
oracle.webcenter.collab.survey


	
Recent Activities

	
oracle.webcenter.recentactivity


	
Activity Graph

	
oracle.webcenter.activitygraph


	
RSS

	
oracle.webcenter.rss


	
Search

	
oracle.webcenter.search


	
Tags

	
oracle.webcenter.tagging


	
Blogs

	
oracle.webcenter.blog


	
Worklist

	
oracle.webcenter.worklist












B.4.11 EL Expressions Relevant to the Personalization Conductor

Table B-20 lists EL expressions relevant to the Personalization Conductor and describes the types of functionality it provides. All listed ELs can be used in both the Spaces application and Framework applications built with Oracle JDeveloper.


Table B-20 EL Expressions Relevant to the Personalization Conductor

	Expression	Function
	
#{p13nContext.reset}

	
Clears the state of the context object in which it is invoked.

Other examples:


#{p13nContext.conductor['ConductorConnection'].reset} 



#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].reset}



#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].reset}


	
#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].update}

	
Updates the property set with new values if bound to a form.

The update method applies only to the context PropertySetContext, and can be called only as part of a form-based action.


	
#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].results}

	
Retrieves the results of the context object. In the case of PropertySetContext, it retrieves the property set by name and property set definition, if they exist.

In the case of ScenarioExecutionContext and ParameterizedScenarioExecutionContext, the scenario results are retrieved.

Other examples:


#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].scenario['MyScenario'].results}



#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].scenario['MyScenario'].withInput['input1=val1;input2=value2;input3=value3'].results} 


	
#{p13nContext.conductor['PropertiesConnection'].namespaces['MyNamespace'].scenario['MyScenario'].results}

	
Executes a scenario by name.


	
#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].scenario['MyScenario'].withInput['input1=val1;input2=value2;input3=value3'].results}

	
Executes a scenario by name with input parameters. Input parameters must be in the following format:


<paramOne>=<valueOne>;<paramTwo>=<valueTwo>;<paramThree>=<valueThree> 


Where each parameter name and value is separated by semicolon.

The withInput method applies only to the context ScenarioExecutionContext.


	
#{p13nContext.conductor['ConductorConnection'].namespaces[myManagedBean.namespace].scenario[myManagedBean.scenario].isError}

	
Determines if an error has occurred in the current context object.

The isError method applies only to PropertySetContext and ~ScenarioExecutionContext.

Other examples:


#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].isError}


	
#{p13nContext.conductor['ConductorConnection'].namespaces['myManagedBean.namespace'].scenario['myManagedBean.scenario'].errorMessage}

	
Returns the error message if an error has occurred in the current context object.

The errorMessage method applies only to PropertySetContext and ~ScenarioExecutionContext.

Other examples:


#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].errorMessage}












B.4.12 EL Expressions Relevant to the Documents Service

Table B-21 lists EL expressions relevant to the Documents service and describes the types of functionality it provides. The Context column indicates whether the expression can be used in the Spaces context (WCS) or in both the Spaces application and Framework applications built with Oracle JDeveloper (Both).


Table B-21 EL Expressions Relevant to the Documents Service

	Expression	Function	Context
	
#{documentsService.currentGroupSpace}

	
Provides information on the space's documents. Returns a bean that provides access to documents-related information for the space.

	
WCS


	
#{documentsService.currentUser}

	
Provides information about the current user's documents.

	
WCS


	
#{documentsService.defaultConnectionName}

	
Gets the default content repository connection name. Returns null if no connection name is defined.

	
Both


	
#{documentsService.groupSpaceByGUID['GUID']}

	
Provides a way to look up a given space's documents information by the space's GUID. Returns a bean that provides documents-related information for the space.

	
WCS


	
#{documentsService.groupSpaceByName['spaceName']}

	
Provides a way to look up a given space's documents information by the space's name. Returns a bean that provides access to documents-related information for the space.

Enter the space internal name. The space internal name is the name specified by the space URL on the General page of a space's administration settings. The space display name is specified by Display Name, and is the name that appears in the banner at the top of a space. Many of the EL expressions in Table B-14 call for the space internal name.

	
WCS


	
#{documentsService.userByName['userName']}

	
Provides a way to look up user documents information by user name. Returns a bean that provides access to documents-related information for the user.

	
WCS


	
#{documentsService.configured}

	
Checks whether the Documents service is configured. Returns true if the Documents service is configured, otherwise false.

	
Both












B.4.13 EL Expressions Relevant to the People Connections Service

Table B-22 lists EL expressions relevant to the Profile feature of the People Connections service and describes the types of functionality it provides. All listed ELs can be used in both the Spaces application and Framework applications built with Oracle JDeveloper.




	
Note:

The entry securityContext.userName, included in every Profile expression, returns the name of the current user. Note also that information is returned only if it is present in the user's profile. If the information is not included in the profile, a null value is returned.








Table B-22 EL Expressions Relevant to the People Connections Service (Profile)

	Expression	Function
	
#{WebCenterProfile[userName].ManagerDisplayName}

#{WebCenterProfile[securityContext.userName].ManagerDisplayName}

	
The display name of the specified user's manager if the current user is allowed to know it.


	
#{WebCenterProfile[userName].employeeNumber}

#{WebCenterProfile[securityContext.userName].employeeNumber}

	
The specified user's employee number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPOBox}

#{WebCenterProfile[securityContext.userName].businessPOBox}

	
The post office box number associated with the specified user if the current user is allowed to know it.


	
#{WebCenterProfile[userName].timeZone}

#{WebCenterProfile[securityContext.userName].timeZone}

	
The time zone in which the specified user's home office is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].description}

#{WebCenterProfile[securityContext.userName].description}

	
A description of the specified user (from Profile "About Me") if the current user is allowed to know it.


	
#{WebCenterProfile[userName].department}

#{WebCenterProfile[securityContext.userName].department}

	
The department to which the specified user belongs if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPager}

#{WebCenterProfile[securityContext.userName].businessPager}

	
The specified user's business pager number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessCity}

#{WebCenterProfile[securityContext.userName].businessCity}

	
The city in which the specified user is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].maidenName}

#{WebCenterProfile[securityContext.userName].maidenName}

	
The specified user's surname or last name before marriage if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessFax}

#{WebCenterProfile[securityContext.userName].businessFax}

	
The specified user's business fax number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].dateofHire}

#{WebCenterProfile[securityContext.userName].dateofHire}

	
The specified user's date of hire if the current user is allowed to know it.


	
#{WebCenterProfile[userName].nameSuffix}

#{WebCenterProfile[securityContext.userName].nameSuffix}

	
Additional information appended to the user's name, such as Esq., Jr., and so on if the current user is allowed to know it.


	
#{WebCenterProfile[userName].middleName}

#{WebCenterProfile[securityContext.userName].middleName}

	
The specified user's middle name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].homePhone}

#{WebCenterProfile[securityContext.userName].homePhone}

	
The specified user's home phone number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].employeeType}

#{WebCenterProfile[securityContext.userName].employeeType}

	
The specified user's employee type classification, for example, IC4 if the current user is allowed to know it.


	
#{WebCenterProfile[userName].lastName}

#{WebCenterProfile[securityContext.userName].lastName}

	
The specified user's surname or last name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].dateofBirth}

#{WebCenterProfile[securityContext.userName].dateofBirth}

	
The specified user's birthday if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessState}

#{WebCenterProfile[securityContext.userName].businessState}

	
The state in which the specified user's home office is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].homeAddress}

#{WebCenterProfile[securityContext.userName].homeAddress}

	
The specified user's home street address if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessStreet}

#{WebCenterProfile[securityContext.userName].businessStreet}

	
The street on which the specified user's home office is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPostalCode}

#{WebCenterProfile[securityContext.userName].businessPostalCode}

	
The specified user's postal or ZIP code if the current user is allowed to know it.


	
#{WebCenterProfile[userName].initials}

#{WebCenterProfile[securityContext.userName].initials}

	
The specified user's initials if the current user is allowed to know it.


	
#{WebCenterProfile[userName].firstName}

#{WebCenterProfile[securityContext.userName].firstName}

	
The specified user's first name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].organizationalUnit}

#{WebCenterProfile[securityContext.userName].organizationalUnit}

	
The organizational unit to which the specified user belongs, for example, D10, if the current user is allowed to know it.


	
#{WebCenterProfile[userName].wirelessAcctNumber}

#{WebCenterProfile[securityContext.userName].wirelessAcctNumber}

	
The specified user's wireless account number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPhone}

#{WebCenterProfile[securityContext.userName].businessPhone}

	
The specified user's business telephone number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessCountry}

#{WebCenterProfile[securityContext.userName].businessCountry}

	
The country in to which the specified user is assigned if the current user is allowed to know it.


	
#{WebCenterProfile[userName].preferredLanguage}

#{WebCenterProfile[securityContext.userName].preferredLanguage}

	
The specified user's preferred language if the current user is allowed to know it.


	
#{WebCenterProfile[userName].displayName}

#{WebCenterProfile[securityContext.userName].displayName}

	
The specified user's display name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].userName}

#{WebCenterProfile[securityContext.userName].userName}

	
The specified user's actual name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].title}

#{WebCenterProfile[securityContext.userName].title}

	
The specified user's job title if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessEmail}

#{WebCenterProfile[securityContext.userName].businessEmail}

	
The specified user's business email address if the current user is allowed to know it.


	
#{WebCenterProfile[userName].organization}

#{WebCenterProfile[securityContext.userName].organization}

	
The organization to which the specified user belongs, for example, Sales, if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessMobile}

#{WebCenterProfile[securityContext.userName].businessMobile}

	
The specified user's cell or mobile phone number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].expertise}

#{WebCenterProfile[securityContext.userName].expertise}

	
The specified user's business expertise if the current user is allowed to know it.












B.4.14 EL Expressions Relevant to User Preferences

Table B-23 lists EL expressions relevant to user preferences and describes the types of functionality they provide. All listed ELs can be used in both the Spaces application and Framework applications built with Oracle JDeveloper.


Table B-23 EL Expressions Relevant to User Preferences

	Expression	Function
	
#{generalSettings.userTimeZone}

	
Returns the time zone the current user has selected in application Preferences. For more information, see Section 35.3, "Setting Date and Time Preferences."


	
#{generalSettings.preferredDateStyle}

	
Returns the date format the current user has selected in application Preferences. For more information, see Section 35.3, "Setting Date and Time Preferences."


	
#{generalSettings.preferredDatePattern}

	
Returns the current user's preferred date format pattern if it has been set, else, returns null.

Note that date + pattern is applicable only to Framework applications, where they take precedence over date + style if they are set.


	
#{generalSettings.preferredTimeStyle}

	
Returns the time format the current user has selected in application Preferences. For more information, see Section 35.3, "Setting Date and Time Preferences."


	
#{generalSettings.preferredTimePattern}

	
Returns the current user's preferred time format pattern if it has been set, else, returns null.


	
#{generalSettings.preferredDateTimePattern}

	
Returns the current user's preferred date and time format pattern if it has been set, else, returns null.


	
#{generalSettings.preferredAccessibilityMode}

	
Returns the current user's preferred accessibility mode (either default, inaccessible, or screenReader)


	
#{generalSettings.preferredSkinName}

	
The current user's preferred skin name if one is specified, otherwise the default value.


	
#{generalSettings.formattedCurrentDate}

	
Returns the current date in the current user's selected locale.


	
#{generalSettings.formattedCurrentTime}

	
Returns the current time in the current user's selected locale.


	
#{generalSettings.formattedCurrentDateTime}

	
Returns the current date and time in the current user's selected locale.


	
#{requestContext.skinFamily}

	
Returns the name of the ADF Faces skin family being used for the current web request, depending on factors such as what has been configured at the application level, the current user's preference setting, and so on.










B.4.14.1 Example: Using EL Expressions for User Preferences

This section provides an example of using EL expressions to personalize a page through user preferences. Consider that you want to display the current date and time in one of your pages. You can use the following EL:

#{generalSettings.formattedCurrentDateTime}

This EL uses the current user's locale to displays the current date and time.

The following steps demonstrate how to display current date and time in a page:

	
Open the required page in Edit mode.


	
Click Add Content.


	
In Resource Catalog, click Web Development.


	
Click Add next to HTML Markup, then click Close.


	
Click the Edit icon for the newly added HTML Markup.


	
In the Component Properties dialog, on the Display Options tab, in the Value field, enter the following EL:

#{generalSettings.formattedCurrentDateTime}


	
Click OK.

Your page should now display the current date and time.











B.4.15 Utilitarian EL Expressions

Table B-24 lists utilitarian EL expressions and describes the types of functionality it provides.


Table B-24 Utilitarian EL Expressions

	Expression	Function
	
#{userPreferences.currentDate}

	
Returns the current date in the format specified in the current user's preferences.


	
#{WCTruncator['text']['numberOfChars']}

	
Returns a truncation of the string specified as text to the number of characters specified as numberOfChars, followed by a trailing ellipsis, for example: #{WCTruncator['abracadabra']['5']} evaluates to abrac...


	
#{facesContext.viewRoot.locale}

#{facesContext.externalContext.requestLocale}

	
Both of these expressions return the request locale (that is, the browser locale setting).


	
#{changeModeBean.inEditMode}

	
Returns true if current application page is in Composer mode. Returns false if current application page is not in Composer mode


	
#{adfFacesContext.skinFamily}

	
Returns the current application skin family. Returns the same value as #{requestContext.skinFamily}.

















C Business Mashup Examples

To help you leverage most of the mashup building capabilities in WebCenter Portal: Spaces, this appendix describes a variety of business scenarios that require creation of business mashups, and explains how to meet those requirements. It includes the following sections:

	
Section C.1, "Creating Mashups with Data from the Analytics Service"


	
Section C.2, "Creating a Mashup that Displays Employee Data from SQL Data Control"


	
Section C.3, "Creating a Mashup with Data from the Spaces MDS Repository"


	
Section C.4, "Creating a Mashup with Data from a Spaces Web Service Data Source"


	
Section C.5, "Creating a Mashup with Data from a Siebel Data Source"


	
Section C.6, "Building and Using a Custom Mashup Style with Predefined Columns"


	
Section C.7, "Building and Using a Custom Mashup style with Date Fields"


	
Section C.8, "Creating a Mashup with a Graph That Is Wired to the Page Navigation"


	
Section C.9, "Creating a Mashup with a Graph that Is Wired to the Inherited Page Navigation"


	
Section C.10, "Creating a Master-Detail Mashup that Contains a Google Maps Task Flow"


	
Section C.11, "Creating a Mashup with a Customized RSS Feed OmniPortlet"







	
Note:

This appendix describes only the high level steps to perform a task. For the detailed steps, you are pointed to Chapter 26, "Creating Business Mashups."








Sample Applications on OTN

Sample applications created for some of the examples in this appendix are available on Oracle Technology Network (OTN). The following page on OTN provides links to business mashup-specific samples and other sample applications that illustrate the different WebCenter Portal: Spaces capabilities:

http://www.oracle.com/technetwork/middleware/webcenter/ps3-samples-176806.html

A readme file available with each sample describes what the application illustrates and provides guidance for extending or customizing the application for real life use cases.



C.1 Creating Mashups with Data from the Analytics Service

The Analytics service displays metrics, such as community traffic, portlet traffic, searched keywords, response times, and usage behavior, for the entire Spaces application. This section describes how to create a mashup with date retrieved from the Analytics service data source. It includes the following sections:

	
Section C.1.1, "Creating a Graph to Display Page Hits"


	
Section C.1.2, "Using a Parameterized Task Flow to Display a Graph of Page Hits in a Space"


	
Section C.1.3, "Creating a Graph to View Portal Site Traffic"


	
Section C.1.4, "Creating a Mashup with Two Task Flows in a Master-Detail Relationship"


	
Section C.1.5, "Creating a Table with Hyperlinks to Download Documents"




If you have configured WebCenter Portal services, Spaces provides an Analytics service connection, ActivitiesDS, out-of-the-box. You can use this connection to create a SQL data control and consume that data control as a graph to display statistics for the Spaces application.

For information about configuring the Analytics service, see "Managing the Analytics Service" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal.



C.1.1 Creating a Graph to Display Page Hits

To create a graph that displays statistics for pages in your application:

	
Create a SQL data control, PageStats, using the ActivitiesDS connection. Specify the following SQL query and bind parameters:

Query:


SELECT space.name_ spaceName, page.name_ pageName, space.id, page.id, count(1), 
fact.page_, page.resourceid_ FROM asfact_wc_pagevie_0 fact , 
asdim_wc_groupsp_0 space , asdim_wc_pages_0 page, asdim_wc_applica_0 app 
WHERE space.id = fact.groupspace_ and page.id = fact.page_ and app.id = 
fact.application_ and fact.occurred between to_date(:startdate, :dateformat) 
and to_date(:enddate, :dateformat) and app.name_ = :appname and page.personal_ 
= :ispersonal and space.name_ is not null and page.name_ is not null and 
space.id is not null and page.id is not null
and fact.page_ is not null and page.resourceid_ is not null GROUP BY 
space.name_, page.name_, space.id, page.id, fact.page_, page.resourceid_ ORDER BY count(1) desc


Bind Parameters:

startdate - 01/01/2008

dateformat - MM/DD/YYYY

appname - webcenter

ispersonal - 1

enddate - 01/01/2011

For the detailed steps, see Section 26.2.1.3, "Creating the Data Control."


	
Expose the data control in the Resource Catalog by selecting Show from the Edit menu.


	
Create a task flow, Page Hits, based on the blank mashup style.

For detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the task flow, click Add Content, and in the catalog, locate the PageStats data control and drill down to the Analytics_PageViews_DC accessor.


	
Add the accessor as a graph. In the Create Graph dialog, select the following options:

	
Select the Bar graph type.


	
On the Placement page, select the Space Name, Page Name and Page ID data columns to be mapped along the X-axis, and Count to be mapped as Bars.


	
Accept the default values on all other pages of the dialog.




For the detailed steps, see Section 26.4.1.3, "Adding a Data Control as a Graph."

The graph is displayed as shown in Figure C-1.


Figure C-1 Bar Graph Displaying Page Hits

[image: Bar Graph Displaying Page Hit Statistics]










C.1.2 Using a Parameterized Task Flow to Display a Graph of Page Hits in a Space

In the previous example, you saw how to view page hits in your Spaces application. This section describes a similar example, but with the ability to display page hits for a specific space only. In this case, the data control is added as a graph to a parameter form task flow. The input parameter allows users to specify a space name and display statistics for that space in the graph. This section includes the following subsections:

	
Section C.1.2.1, "Creating the Page Hits Data Control"


	
Section C.1.2.2, "Creating a Custom Mashup Style with a Parameter to Specify the Space Name"


	
Section C.1.2.3, "Creating a Task Flow Using the Custom Mashup Style"


	
Section C.1.2.4, "Consuming the Data Control in the Task Flow"






C.1.2.1 Creating the Page Hits Data Control

If you have configured WebCenter Portal services in your application, an Analytics service connection, ActivitiesDS, is available out-of-the-box. You can use this connection to create a SQL data control. This section describes how to create a data control to view the top five page hits for the last 7 days for a given space.

To create the data control:




	
See Also:

Section 26.2.1.3, "Creating the Data Control" for the detailed steps to create a data control.







	
Use the ActivitiesDS connection and create a SQL data control named PageHits.


	
Specify the following SQL query:


SELECT * FROM
(SELECT page.name_ pageName, space.name_ spaceName, COUNT(1) hits 
FROM asdim_users u, asdim_wc_pages_0 page, asdim_wc_applica_0 app, asdim_wc_groupsp_0 space, asfact_wc_pagevie_0 fact 
WHERE fact.page_ = page.id AND fact.userid = u.id AND fact.application_ = app.id 
AND fact.groupspace_ = space.id AND fact.occurred BETWEEN(SYSDATE-6) AND (SYSDATE+1) AND app.name_ = 'webcenter' 
AND u.userid <> 'anonymous' AND  upper(space.name_) LIKE upper(:spacename) AND space.name_ IS NOT NULL 
AND page.name_  IS NOT NULL AND space.id IS NOT NULL AND page.id IS NOT NULL 
AND fact.page_  IS NOT NULL AND page.resourceid_ IS NOT NULL 
GROUP BY page.name_, space.name_ ORDER BY hits DESC) 
WHERE rownum <= 5 ORDER BY rownum


The data control is created with the spacename bind variable.


	
Set the spacename bind variable to Home space.


	
Test the query and view the data retrieved from the data source, as shown in Figure C-2.


Figure C-2 SQL Data Control Query Test Result

[image: SQL data control query test result]










C.1.2.2 Creating a Custom Mashup Style with a Parameter to Specify the Space Name

This section describes how to create a custom mashup style, Input Space Name, with an input text field that can be wired to the SQL data control's bind variable. With this type of wiring, users can provide a space name to view page hits for that space.

To create the custom mashup style:

	
Copy an existing mashup style in the Resource Manager and name it Input Space Name.


	
Edit the source of the task flow, click the Fragment tab, and replace the entire code with the following:


<?xml version='1.0' encoding='UTF-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
          xmlns:pe="http://xmlns.oracle.com/adf/pageeditor"
          xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable"
          xmlns:f="http://java.sun.com/jsf/core"
          xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
  <af:panelGroupLayout id="pgl">
    <af:panelGroupLayout id="pg2" layout="horizontal" halign="center" inlineStyle="padding-bottom:5px;">
      <af:inputText id="ip1" value="#{pageFlowScope.bindVarId}" label="Space Name" 
                    shortDesc="Enter a Space name. The default value is home space."/>
      <af:commandButton text="#{dataComposerBundle.MASHUP_STYLES_GO}" id="cb1"/>
    </af:panelGroupLayout>
    <cust:panelCustomizable id="pc1" halign="center"/>
  </af:panelGroupLayout>
</jsp:root>


	
Select the mashup style in the Resource Manager, and from the Edit menu, click Show.




For the detailed steps to create and edit a mashup style, see Section 26.3.4, "Managing Mashup Styles."






C.1.2.3 Creating a Task Flow Using the Custom Mashup Style

In the Resource Manager, create a task flow, Top Five Page Hits for a Space, based on the new mashup style, as shown in Figure C-3.


Figure C-3 Create New Task Flow Dialog Displaying the New Mashup Style

[image: New mashup style displayed in the Create dialog]



For the detailed steps, see Section 26.3.1, "Creating a Task Flow."

From the Edit menu, select Show to include the task flow in the Resource Catalog.






C.1.2.4 Consuming the Data Control in the Task Flow

To add the page hits data control to the new task flow:

	
Edit the Top Five Page Hits for a Space task flow, and add the PageHits data control accessor as a graph, as shown in Figure C-4.


Figure C-4 Graph Option on the PageHits Data Control Accessor

[image: Graph option on the PageHits data conrtol accessor]



	
In the Create Graph dialog, on the Type page, choose Bar.


	
On the Placement page, place PAGENAME and SPACENAME on the X Axis, and HITS as the Bars.


	
On the DC Parameters page, specify the following value for the spacename parameter:

#{empty pageFlowScope.bindVarId ? 'home space' : pageFlowScope.bindVarId}









C.1.2.5 Testing the Parameter Wiring in the Task Flow

This section describes the steps you must perform to test whether the graph in the task flow displays data specific to the space name you provide.

To test the task flow:

	
Create a test page and add the task flow from the Add Content dialog.


	
To ensure that the graph displays properly on the page:

	
Edit the task flow.


	
In the Component Properties dialog, on the Basic page of the Display Options tab, deselect the Allow Resize option.


	
On the Advanced page of the Display Options tab, set Stretch Content to Auto.





	
Specify a different space name in the input text field. The graph displays data specific to that space, as shown in Figure C-5.


Figure C-5 Bar Graph Displaying Page Hits for a Given Space

[image: Graph Displaying Page Hits for a Space]












C.1.3 Creating a Graph to View Portal Site Traffic

This section explains how to retrieve the site traffic data from the Analytics service and display it as a Pie graph.

To create a mashup with the portal site traffic data:

	
Create a SQL data control, PortalStats, using the ActivitiesDS connection. Specify the following SQL query and bind parameters:

Query:


SELECT 'Spaces' Name, count(1) Hits
FROM asfact_wc_groupsp_0 fact , asdim_wc_groupsp_0 space , asdim_wc_applica_0 app
WHERE space.id = fact.groupspace_ and app.id = fact.application_ and fact.occurred between
to_date(:startdate, :dateformat) and to_date(:enddate, :dateformat) and 
app.name_ = :appname and
space.personal_ = :ispersonal
UNION ALL
SELECT 'Pages' Name, count(1) Hits
FROM asfact_wc_pagevie_0 fact , asdim_wc_pages_0 page , asdim_wc_applica_0 app
WHERE page.id = fact.page_ and app.id = fact.application_ and fact.occurred
between
to_date(:startdate, :dateformat) and to_date(:enddate, :dateformat) and
app.name_ = :appname and
page.personal_ = :ispersonal
UNION ALL
SELECT 'Portlets' Name, count(1) Hits
FROM asfact_wc_portlet_0 fact , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.occurred between to_date(:startdate,
:dateformat) and
to_date(:enddate, :dateformat) and app.name_ = :appname
UNION ALL
SELECT 'Logins' Name, count(1) Hits
FROM asfact_wc_logins_0 fact , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.occurred between to_date(:startdate,
:dateformat) and
to_date(:enddate, :dateformat) and app.name_ = :appname
UNION ALL
SELECT 'Searches' Name, count(1) Hits
FROM asfact_wc_searche_0 fact , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.occurred between to_date(:startdate,
:dateformat) and
to_date(:enddate, :dateformat) and app.name_ = :appname
UNION ALL
SELECT 'Wikis' Name, count(1) Hits
FROM asfact_wc_doclib__0 fact , asdim_wc_documen_0 doc , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.document_ = doc.id and fact.occurred
between
to_date(:startdate, :dateformat) and to_date(:enddate, :dateformat) and
app.name_ = :appname and
doc.objecttype_ like '%WIKI%'
UNION ALL
SELECT 'Blogs' Name, count(1) Hits
FROM asfact_wc_doclib__0 fact , asdim_wc_documen_0 doc , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.document_ = doc.id and fact.occurred
between
to_date(:startdate, :dateformat) and to_date(:enddate, :dateformat) and
app.name_ = :appname and
doc.objecttype_ like '%BLOG%'
UNION ALL
SELECT 'Documents' Name, count(1) Hits
FROM asfact_wc_doclib__0 fact , asdim_wc_documen_0 doc , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.document_ = doc.id and fact.occurred
between
to_date(:startdate, :dateformat) and to_date(:enddate, :dateformat) and
app.name_ = :appname and
doc.objecttype_ like '%DOCUMENT%'
UNION ALL
SELECT 'Discussions' Name, count(1) Hits
FROM asfact_wc_discuss_1 fact , asdim_wc_applica_0 app
WHERE app.id = fact.application_ and fact.occurred between to_date(:startdate,
:dateformat) and
to_date(:enddate, :dateformat) and app.name_ = :appname


Bind Parameters:

startdate - 01/01/2008

dateformat - MM/DD/YYYY

appname - webcenter

ispersonal - 1

enddate - 01/01/2011

For the detailed steps, see Section 26.2.1.3, "Creating the Data Control."


	
Expose the data control in the Resource Catalog by selecting Show from the Edit menu.


	
Create a task flow, Portal Traffic, based on the blank mashup style.

For detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the task flow, click Add Content, and in the catalog, locate the PortalStats data control and drill down to the Site_Traffic_DC accessor.


	
Add the accessor as a graph. In the Create Graph dialog, select the following options:

	
Select the Pie graph type.


	
On the Placement page, select Name data column to be plotted as slices and Hits as the pie.


	
Accept the default values on all other pages of the dialog.




For the detailed steps, see Section 26.4.1.3, "Adding a Data Control as a Graph."

The graph is displayed as shown in Figure C-6.


Figure C-6 Graph Displaying Portal Traffic Statistics

[image: Graph displaying portal traffic statistics]










C.1.4 Creating a Mashup with Two Task Flows in a Master-Detail Relationship

The example in this section describes how to wire two task flows in a master-detail relationship so that a selection in one task flow results in an action on the second one. The various tasks involved are described in the following subsections:

	
Section C.1.4.1, "Creating the Master Data Control and Task Flow"


	
Section C.1.4.2, "Creating the Details Data Control and Task Flow"


	
Section C.1.4.3, "Wiring the Master and Details Task Flows"




After performing the above configurations, if you click a user name in the master table, the details are displayed in a popup window.



C.1.4.1 Creating the Master Data Control and Task Flow

The master task flow displays a table with the top five page views for a given space during the last seven days.

To create the task flow:

	
Create a SQL data control, TopFiveDocViewsForSelectedSpace, using the ActivitiesDS connection. Specify the following SQL query:


select * from (select  u.id id , u.userid userid, count(fact.userid)  pageviewsfrom asdim_users u , asfact_wc_pagevie_0 fact,asdim_wc_applica_0 app where fact.userid=u.idand u.userid <> 'anonymous' and fact.application_ = app.id and app.name_ = 'webcenter'  and fact.occurred BETWEEN (SYSDATE-7) and ( SYSDATE+1)group by u.id,u.useridorder by pageviews desc )where rownum<11


For the detailed steps, see Section 26.2.1.3, "Creating the Data Control."

This query returns the top five page hits for a given space for the last seven days.


	
Select the new data control, and from the Edit menu, click Show.


	
Create a task flow, Top 10 Visitor Page Hits, based on the Blank mashup style.

For the detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the task flow and add the TopFiveDocViewsForSelectedSpace data control accessor as a table.

Create a read-only table. On the Columns page in the Create Table dialog, choose to display the USERID column as hyperlinks, and specify the URL to be http://www.oracle.com, as shown in Figure C-7.


Figure C-7 Display Columns as Hyperlinks

[image: Options to display columns as hyperlinks]



The table displays a user-wise listing of the top page hits. The USERID column displays user names as hyperlinks, as shown in Figure C-8.


Figure C-8 Master Task Flow Displaying Top Page Hits

[image: Task flow displaying a table with the top page hits]



	
Select the new task flow, and from the Edit menu, click Show.









C.1.4.2 Creating the Details Data Control and Task Flow

You have seen how to create a master task flow that displays the top page hits in a table, in which the user names are hyperlinked. The next step is to create a details task flow that must be displayed on clicking a user name in the master task flow. This section describes how to create a details task flow that displays a graph of all page hits for a given user.

To create the details data control and task flow:

	
Create a SQL data control, PageHitsForSelectedUser, using the ActivitiesDS connection. Specify the following SQL query and bind variable:


SELECT page.name_ pageName, space.name_ spaceName, COUNT(1) hits 
FROM asdim_users u, asdim_wc_pages_0 page, asdim_wc_applica_0 app, 
asdim_wc_groupsp_0 space, asfact_wc_pagevie_0 fact 
WHERE fact.page_          = page.id AND fact.userid = u.id  
AND u.userid=(:userid) AND fact.application_ = app.id 
AND fact.groupspace_  = space.id AND fact.occurred 
BETWEEN (SYSDATE-7) and SYSDATE and app.name_ = 'webcenter'  
AND u.userid <> 'anonymous' AND space.name_ IS NOT NULL 
AND page.name_  IS NOT NULL AND space.id         IS NOT NULL 
AND page.id IS NOT NULL AND fact.page_  IS NOT NULL 
AND page.resourceid_ IS NOT NULL GROUP BY page.name_, space.name_


Set the userid bind variable to weblogic.

For the detailed steps, see Section 26.2.1.3, "Creating the Data Control."


	
Select the new data control, and from the Edit menu, click Show.


	
Create a task flow, Page Hits for Selected User, based on the Blank mashup style.

For the detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the task flow and add the PageHitsForSelectedUser data control accessor as a graph.

Create a bar graph, and plot SPACENAME and PAGENAME along the X-Axis and HITS as Bars.

On the DC Parameters page in the Create Graph dialog, specify the following value for the userid parameter:

#{empty pageFlowScope.userid ?'weblogic': pageFlowScope.userid}

This ensures that weblogic is selected as the default user if no user name is specified for the parameter. The graph displays as shown in Figure C-9.


Figure C-9 Bar Graph Displaying Page Hits for a Selected User

[image: Bar Graph Displaying Page Hits for a User]



	
Create a task flow parameter called userid, and set its value to the pageFlowScope, as shown in Figure C-10.


Figure C-10 Parameter Defined on the Details Task Flow

[image: Parameter Defined on the Details Task Flow]



	
Select the new task flow, and from the Edit menu, click Show.









C.1.4.3 Wiring the Master and Details Task Flows

This section describes how to wire the master and details task flows so that a user can click a user name in the master task flow to pop up the details task flow displaying the page hits graph for that user.

To wire the master and details task flows:

	
Edit the source of the master task flow, Top 10 Visitor Page Hits. Click the Fragment tab in the Edit Source dialog, and paste the following code below <af:panelGroupLayout id="pgl1"> to reference the details task flow in a popup:


<af:popup id="popup1" launcherVar="source" eventContext="launcher" contentDelivery="lazyUncached">
  <af:dialog>
    <af:region xmlns:af="http://xmlns.oracle.com/adf/faces/rich" id="oc_449838760region1" 
               value="#{bindings.popTaskflow.regionModel}"/>
  </af:dialog>
  <af:setPropertyListener from="#{source.attributes.userid}"
                          to="#{viewScope.userid}" type="popupFetch"/>
</af:popup>


	
Find the <af:goLink> code segment and replace it with the following so that the USERID column displays command links that invoke a popup dialog:


<af:commandLink text="#{row.bindings.USERID.inputValue}" id="userLink">
  <af:clientAttribute name="userid" value="#{row.bindings.USERID.inputValue}"/>
  <af:showPopupBehavior popupId="::popup1" alignId="userLink" align="afterEnd"/>
</af:commandLink>


	
Click the Page Definition tab, and add a reference to the details task flow. Paste the following code within the <executable> tag and below the <iterator> tag:


<taskFlow id="popTaskflow" taskFlowId="details_taskflow_definition_path#blanktaskflow" 
          xmlns="http://xmlns.oracle.com/adf/controller/binding" Refresh="ifNeeded">
  <parameters>
    <parameter id="userid" value="#{viewScope.userid}"/>
  </parameters>
</taskFlow>


where details_taskflow_definition_path is the path to the task flow in your instance, for example, /oracle/webcenter/siteresources/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/taskFlow/gsr34e6278e_9e9a_45eb_bbbf_31aa5ae34381/taskflow-definition.xml.

You can get this path by selecting the task flow in the Resources Manger, and clicking Edit Properties on the Edit Menu. The Metadata File attribute provides the complete path to the task flow.


	
Test the master-detail relationship. Preview the Top 10 Visitor Page Hits task flow in the Resources Manager. When you click a user name link, the page hits graph for that user is displayed in a popup window, as shown in Figure C-11.


Figure C-11 Master-Detail Relationship Between Two Task Flows

[image: Master table in background and details graph in foreground]












C.1.5 Creating a Table with Hyperlinks to Download Documents

This section describes how to create a mashup with a table listing the top five documents viewed in a space. The document names in the table are displayed as hyperlinks so that a user can click a link to open the selected document in a new window. The data for the table comes from a SQL data control to the Spaces Analytics service. This section includes the following sections:

	
Section C.1.5.1, "Creating the Document Views Data Control"


	
Section C.1.5.2, "Creating a Custom Mashup Style with a Parameter to Specify the Space Name"


	
Section C.1.5.3, "Creating a Task Flow Using the Custom Mashup Style"


	
Section C.1.5.4, "Consuming the Data Control in the Task Flow"


	
Section C.1.5.5, "Testing the Parameter Wiring in the Task Flow"






C.1.5.1 Creating the Document Views Data Control

This section describes how to create a data control to view the top five document hits for the last 7 days for a given space.

	
Use the ActivitiesDS connection and create a SQL data control named Top Five Doc Views for Given Space in the Past Week and specify the following SQL query:


SELECT *
FROM( SELECT  doc.name_ name,space.name_ space,count(1) hits,doc.path_  download_url
FROM asfact_wc_doclib__0 fact , asdim_wc_documen_0 doc , asdim_wc_applica_0 app,asdim_wc_groupsp_0 space
WHERE 
app.name_ = 'webcenter' 
AND  app.id = fact.application_ 
AND fact.document_ = doc.id
AND fact.occurred BETWEEN (SYSDATE-6)  AND (SYSDATE+1)  
AND doc.name_ is not null 
AND doc.id is not null 
AND fact.document_ is not null 
AND doc.resourceid_ is not null
AND  fact.GROUPSPACE_ = space.id 
AND  upper(space.name_) LIKE upper(:spacename) 
AND space.name_ IS NOT NULL 
GROUP BY doc.name_, doc.id,space.name_ ,doc.path_
ORDER BY hits  DESC)
WHERE rownum <= 5
ORDER BY rownum


The data control is created with the spacename bind variable.


	
Set the spacename bind variable to Home space.


	
Test the query and view the data retrieved from the data source, as shown in Figure C-12.


Figure C-12 New Data Control Query Test Results

[image: Query test results for the new data control]










C.1.5.2 Creating a Custom Mashup Style with a Parameter to Specify the Space Name

This section describes how to create a custom mashup style, Input Space Name, with an input text field that can be wired to the SQL data control's bind variable. With this type of wiring, users can provide a space name to view page hits for that space.

To create the custom mashup style:

	
Copy an existing mashup style in the Resource Manager and name it Input Space.


	
Edit the source of the task flow, click the Fragment tab, and replace the entire code with the following:


<?xml version='1.0' encoding='UTF-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
          xmlns:pe="http://xmlns.oracle.com/adf/pageeditor"
          xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable"
          xmlns:f="http://java.sun.com/jsf/core"
          xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
  <af:panelGroupLayout id="pgl">
    <af:panelGroupLayout id="pg2" layout="horizontal" halign="center" inlineStyle="padding-bottom:5px;">
      <af:inputText id="ip1" value="#{pageFlowScope.bindVarId}" label="Space
                    Name" shortDesc="Enter A Space Name, by default it's all spaces"/>
      <af:commandButton text="#{dataComposerBundle.MASHUP_STYLES_GO}" id="cb1"/>
    </af:panelGroupLayout>
    <cust:panelCustomizable id="pc1" halign="center"/>
  </af:panelGroupLayout>
</jsp:root>


	
Select the mashup style in the Resource Manager, and from the Edit menu, click Show.









C.1.5.3 Creating a Task Flow Using the Custom Mashup Style

To create a task flow using the custom style:

	
In the Resource Manager, create a task flow, Top Five Doc Hits for a Given Space in a Week, based on the new mashup style, as shown in Figure C-13.


Figure C-13 New Mashup Style in the Create New Task Flow Dialog

[image: New mashup style in the Create New Task Flow dialog]



	
Select the task flow in the Resource Manager, and from the Edit menu, click Show.









C.1.5.4 Consuming the Data Control in the Task Flow

To consume the page hits data control in the new task flow:

	
Edit the Top Five Doc Hits for a Given Space in a Week task flow and add the Top Five Doc Views for Given Space in the Past Week data control accessor as a table, as shown in Figure C-14.


Figure C-14 Table Option on the Data Control Accessor

[image: Option to drop the data control accessor as a table]



Create a read-only table. On the Items page in the Create Table dialog (shown in Figure C-15), ensure that the DOWNLOAD_URL column is not displayed.


Figure C-15 Items Page of the Create Table Dialog

[image: DOWNLOAD_URL item not selected in the Create Table dialog]



On the Columns page, choose to display the Name column as hyperlinks, and specify the URL to be the following (as shown in Figure C-16):

{doc path pre fix}#{empty row.DOWNLOAD_URL ? '' : row.DOWNLOAD_URL}

where

doc path pre fix is the prefix to be used for the document URL. To find the prefix for a document path, select a document on the Documents page and click Get a Link from the View menu. The first part of the Download URL (ending in path) is the prefix to be used. For example, http://my.company.com:8889/webcenter/content/conn/xyz18-ucm11g/path.


Figure C-16 Name Column Defined as a Hyperlink

[image: Name column defined as a hyperlink]



	
On the DC Parameters page, specify the following value for the spacename parameter:

spacename: #{empty pageFlowScope.bindVarId ? '%' : pageFlowScope.bindVarId}

The data control is now shown as a table in the task flow.


	
Optionally, edit the table. In the Component Properties dialog, change the value of the Column Stretching field to last, as shown in Figure C-17. This ensures that the last column is stretched when required.


Figure C-17 Component Properties Dialog for the Table

[image: Column Stretching property]



	
To ensure that the table displays properly on the page:

	
Edit the task flow.


	
In the Component Properties dialog, on the Basic page of the Display Options tab, deselect the Allow Resize option.


	
On the Advanced page of the Display Options tab, set Stretch Content to Auto.












C.1.5.5 Testing the Parameter Wiring in the Task Flow

This section describes the steps you must perform to test whether the table in the task flow displays data specific to the space name you provide.

To test the task flow:

	
Create a test page and add the task flow from the Resource Catalog.

The task flow displays the table.


	
Specify a different space name in the input text field. The table displays data specific to that space.

The NAME column displays hyperlinks that enable you to download the documents, as shown in Figure C-18.


Figure C-18 Table with Hyperlinked Document Names

[image: Table with hyperlinked document names]














C.2 Creating a Mashup that Displays Employee Data from SQL Data Control

The tasks in this section use examples based on an employee database. This section describes how to add a visualization for the retrieved employee data and customize this visualization by performing a few simple configurations. This section describes how to add the EmpDetails data control as a table to the Employee Details task flow and perform different customizations on the table, such as showing or hiding columns and sorting rows. It includes the following sections:

	
Section C.2.1, "Creating the SQL Data Control"


	
Section C.2.2, "Adding the Data Control and Binding Task Flow Parameters to Data Control Parameters"


	
Section C.2.3, "Showing a Hidden Column in the Table"


	
Section C.2.4, "Adding the Data Control in a Parameter Form Task Flow"






C.2.1 Creating the SQL Data Control

Perform the following tasks to create a data control for the employee database:

	
Create a connection to the employee database. For the detailed steps, see Section 26.2.1.2, "Creating a Database Connection."


	
Create a SQL data control, EmpDetails, to retrieve data using this database connection. Use the following query to retrieve data:


select ename, empno, mgr, deptno from emp where job in (:jobId) order by empno asc


For the detailed steps, see Section 26.2.1.3, "Creating the Data Control."

This data control returns records for all employees whose designation matches the value of jobId. The records are sorted by employee number.


	
Create a task flow, Employee Details, based on the Blank mashup style. For the detailed steps, see Section 26.3.1, "Creating a Task Flow."









C.2.2 Adding the Data Control and Binding Task Flow Parameters to Data Control Parameters

Perform the following steps to add the data control as a table:

	
Edit the Employee Details task flow in Composer.


	
In the Add Content dialog, navigate to the EmpDetails data control's accessor, click Add, and select Table, as shown in Figure C-19.


Figure C-19 Employee Details Data Control Accessor

[image: Employee Details Data Control Accessor]

Description of "Figure C-19 Employee Details Data Control Accessor"





	
Create an editable table, enable row selection, filtering and sorting, and select columns ename, empno, and deptno to be displayed in the table.

For the detailed steps, see Section 26.4.1.1, "Adding a Data Control as a Table."

The table displays with an empty field at the top of each column, as shown in Figure C-20. You can use those fields to specify filter criteria for the columns.


Figure C-20 Table in the Employee Details Task Flow

[image: Table in the Employee Details Task Flow]

Description of "Figure C-20 Table in the Employee Details Task Flow"





	
Create a task flow parameter, designation.

For the detailed steps, see Section 26.4.2, "Creating Task Flow Parameters."


	
To use the designation parameter to drive the data displayed in the table, copy the storage value of the parameter, #{pageFlowScope.designation}, and paste it as the value for the bind variable, jobId, on the Data tab of the table's Component Properties dialog.

For the detailed steps, see Section 26.4.3, "Binding Data Control Parameters to Task Flow Parameters."


	
Create a page and add the Employee Details task flow to the page.

For the detailed steps, see Section 26.4.5, "Consuming Task Flows that Contain Visualizations."


	
Edit the Employee Details task flow on the page, and on the Parameters tab, specify a designation to view corresponding details in the table.









C.2.3 Showing a Hidden Column in the Table

In your SQL query, you specified that the data control must retrieve the columns ename, empno, deptno, and mgr. However, you chose to display only the ename, empno, and deptno columns. In this case, the data control retrieves data from all four data columns, but displays only three. You can render the fourth column in the table but editing the table's source code. To do this:

	
On the Resource Manager - Task Flows page, select the Employee Details task flow.


	
Click Edit Source, then the Fragments tab, and locate the code for the hidden column. It would be similar to the code in the following example:


<column sortProperty="MGR" filterable="true" sortable="true"
        headerText="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.label}" 
        id="column4" rendered="false">
  <af:inputText value="#{row.bindings.MGR.inputValue}"
                label="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.label}"
                required="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.mandatory}"
                columns="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.displayWidth}"
                maximumLength="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.precision}" 
                shortDesc="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.tooltip}" 
                id="inputText4">
    <f:validator binding="#{row.bindings.MGR.validator}"/>
    <af:convertNumber groupingUsed="false" pattern="#{bindings.accessor_gsrf2d136f7_d907_481d_ad3a_eb2b9dbe7c35.hints.MGR.format}"
                   id="convertNumber3"/>
  </af:inputText>
</column>


	
Set the rendered attribute to true.

The table now displays all four columns, as shown in Figure C-21.


Figure C-21 Table Displaying Four Columns

[image: Table Displaying Four Columns]

Description of "Figure C-21 Table Displaying Four Columns"







Similarly, you can hide a visible column by setting its rendered attribute to false.






C.2.4 Adding the Data Control in a Parameter Form Task Flow

The Parameter Form task flow provides an input text field where a user can specify a value. This value is passed to a data control accessor parameter so that the accessor displays data based on the user input.

You can add a data control as a table inside a Parameter Form task flow so that users can specify a value in the field to view corresponding details in the table.

To add a data control inside a Parameter Form task flow:

	
Create a task flow based on the Parameter Form mashup style.

For the detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the task flow in Composer and add the EmpDetails data control as a table inside the task flow.

For the steps, see Section C.2.2, "Adding the Data Control and Binding Task Flow Parameters to Data Control Parameters."


	
Wire the jobId parameter on the data control to the Input Text component in the Parameter Form task flow, by specifying the jobId value to be #{pageFlowScope.bindVarId}.

For detailed steps, see Section 26.4.4, "Wiring a Data Control to a Parameter Form Task Flow."




You can now specify a value in the input text field to view the corresponding records in the table, as shown in Figure C-22.


Figure C-22 Data Control in a Parameter Form Task Flow

[image: Data Control in a Parameter Form Task Flow]

Description of "Figure C-22 Data Control in a Parameter Form Task Flow"











C.3 Creating a Mashup with Data from the Spaces MDS Repository

Spaces applications are seeded with the following repository connections:

	
WebCenterDS


	
mds-owsm


	
mds-SpacesDS


	
ActivitiesDS




You can create data controls for any of these connections and consume them in pages and task flows. This section describes how to create a data control to connect to the Spaces repository and display details about the spaces and pages in the application and so on. It includes the following subsections:

	
Section C.3.1, "Creating the Data Control"


	
Section C.3.2, "Adding the Data Control as a Graph Inside a Task Flow"






C.3.1 Creating the Data Control

Create a data control, WebCenter Pages, to retrieve page-related data from the Spaces data source. Use the mds-SpacesDS connection and enter the following SQL query:


select 'Home Space Pages' metric, count(*) value from mds_paths where path_type = 'DOCUMENT'
and path_name like '%.jspx' and path_high_cn is null and path_fullname like '%/user/%'
union select 'Business Role Pages' metric, count(*) value  from mds_paths where path_type = 'DOCUMENT'
and path_name like '%.jspx' and path_high_cn is null and path_fullname like '%/businessRolePages/%'
union select 'Space Template Pages' metric, count(*) value from mds_paths where path_type = 'DOCUMENT'
and path_name like '%.jspx' and path_high_cn is null and path_fullname like '%/spacetemplate/%'
union select 'Group Space Pages' metric, count(*) value from mds_paths where path_type = 'DOCUMENT'
and path_name like '%.jspx' and path_high_cn is null and (path_fullname not like '%/user/%'
and path_fullname not like '%/businessRolePages/%' and path_fullname not like '%/spacetemplate/%')


This query retrieves information about the different type of pages and the count of each page type, as shown in Figure C-23.


Figure C-23 Data Control with Page Information from the Spaces Repository

[image: Page Information from WebCenter Spaces Repository]

Description of "Figure C-23 Data Control with Page Information from the Spaces Repository"





This type of information can be represented either in a table or a graph. The following section describes how to add this data control as a graph.






C.3.2 Adding the Data Control as a Graph Inside a Task Flow

Create a blank task flow and add the data control as a Graph. Select the Pie graph type, and place the METRIC column as slices and the VALUE column as the Pie. The graph is added to the task flow as shown in Figure C-24.


Figure C-24 Page Metrics Displayed as a Pie Graph

[image: Page Metrics Displayed as a Pie Graph]

Description of "Figure C-24 Page Metrics Displayed as a Pie Graph"











C.4 Creating a Mashup with Data from a Spaces Web Service Data Source

You can create a data control to the Spaces Web Service and retrieve information about the application and spaces, for example, list the spaces in the instance. However, you must first prepare your Spaces instance to expose Web Services.


Getting Started

Before you begin with the configurations in this section, you must configure WS-Security for your Spaces instance. For the detailed steps, see the "Configuring WS-Security" chapter in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal. If you create a mashup without configuring WS-Security, an error occurs when retrieving data from the data source.

This section describes the following use cases:

	
Section C.4.1, "Creating a Mashup to List the Spaces in the Application"


	
Section C.4.2, "Creating a Mashup with a Form to Rename Spaces"






C.4.1 Creating a Mashup to List the Spaces in the Application

This section describes how to create a mashup to display a list of spaces. The space names are displayed as hyperlinks so that a user can click a link to view the selected space.

To create a data control and task flow to display the list of spaces:

	
Create a Web Service data control, SpacesWS, (Figure C-25) using a WSDL URL with the appropriate machine name and port number, as shown in the following example:


http://myserver.us.oracle.com:8888/webcenter/SpacesWebService?WSDL


For the detailed steps, see Section 26.2.2, "Creating a Web Service Data Control."


Figure C-25 Spaces Web Service Data Control

[image: WebCenter Spaces Web Service Data Control - WSDL Page]



	
On the OWSM Security page, apply the following additional policy, as shown in Figure C-26:


oracle/wss11_saml_token_with_message_protection_client_policy



Figure C-26 Spaces Web Service Data Control - OWSM Security

[image: WebCenter Spaces Web Service Data Control - Security Page]



	
Click Create.


	
Select the data control, and from the Edit menu, select Show.


	
Create a blank task flow, Spaces, to consume the data control.

For the detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the Spaces task flow and add the SpacesWS data control accessor as a table.

For the detailed steps, see Section 26.4.1.1, "Adding a Data Control as a Table."

To display the space names as links, on the Columns page in the Create Table dialog, select Hyperlink in the Display As field. Then in the URL field (Figure C-27), specify the URL to which the space name must be appended so that it opens the space in a separate window, for example /spaces/#{row.item}.


Figure C-27 Hyperlink Option on the Table Create - Columns Page

[image: Hyperlink Option on Table Create - Columns Page]



The table displays as shown in Figure C-28


Figure C-28 Mashup Displaying a List of Spaces

[image: Table displaying one column with list of Spaces]










C.4.2 Creating a Mashup with a Form to Rename Spaces

This section references the SpacesWS Web Service data control created in the previous section and describes how to create a form that can be used to rename a given space.

To create a custom form:

	
Create a task flow, Rename Space, using the Blank mashup style.


	
Edit the task flow and click Add Content.


	
Drill down to view the SpacesWS data control, and add the renameGroupSpace method.


	
Open the renameGroupSpace method and add arg1 and arg0 attributes as ADF Input Text w/Label, as shown in Figure C-29. This step adds two input text fields, where users can specify the old space name and new space name.


Figure C-29 Options to Add renameGroupSpace Attributes

[image: Options to Add renameGroupSpace Attributes]



	
Save and close the task flow.


	
Change the labels for the input text fields:

	
Select the task flow, and from the Edit menu, select Edit Source.


	
Replace the label value for the first inputText component (#{bindings.arg0.hints.label}) to Old Space Name.


	
Replace the label value for the second inputText component (#{bindings.arg1.hints.label}) to New Space Name.


	
Click OK.




The task flow now appears as shown in Figure C-30.


Figure C-30 Task Flow to Change a Space Name

[image: Task flow with two fields and a rename button]



	
In the Resources Manager, select the task flow, and click Show from the Edit menu.

You can now add this task flow to any page and provide the capability to change space names.











C.5 Creating a Mashup with Data from a Siebel Data Source

This section describes how to create a mashup with data from a Siebel data source using a Web Service data control. It includes the following sections:

	
Section C.5.1, "Creating a Web Service Data Control"


	
Section C.5.2, "Adding a Data Control Method as a Table to a Task Flow"


	
Section C.5.3, "Querying the Data Source"


	
Section C.5.4, "Updating Data Source Records"





Prerequisites

To create a Web Service data control to the Siebel data source, you must first create an inbound Web Service and generate a WSDL for the service. Refer to the following document for the steps to be performed:

http://st-curriculum.oracle.com/obe/fmw/soa_apps_integ/10g/10_132_siebel/siebel.htm



C.5.1 Creating a Web Service Data Control

On the Resource Manager - Data Controls page, create a Web Service data control, CustData, using the WSDL for the Siebel Web Service.

For the detailed steps, see Section 26.2.2, "Creating a Web Service Data Control."

This example shows a connection to a Web Service that provides two methods, MyQueryById and MyInsertOrUpdate. MyQueryById takes a complex parameter, MyQueryById_Input, and MyInsertOrUpdate takes a parameter, MyInsertOrUpdate_Input. MyInsertOrUpdate_Input is an array parameter, which can be used to update multiple records in the table.




	
Note:

The parameter names used in this section are examples only. You can provide parameter names of your choice while creating the Web Service.







Expose the CustData data control in the Resource Catalog by selecting Show from the Edit menu.






C.5.2 Adding a Data Control Method as a Table to a Task Flow

To consume the CustData data control in a task flow:

	
On the Resource Manager - Task Flows page, create a task flow based on the Parameter Form style.

For the detailed steps, see Section 26.3.1, "Creating a Task Flow."


	
Edit the task flow and click Add Content.


	
Locate the CustomerData data control and expand it to view its contents. Open MyQueryById, Return, then ListOfAccountInterface.


	
Add Account, shown in Figure C-31, as an editable table.


Figure C-31 Table Option on the Account Method

[image: Table Option on the Account Method]



	
In the Create Table dialog, select the columns to be displayed, as shown in Figure C-32.


Figure C-32 Items Page in the Create Table Dialog

[image: Items Page in the Create Table Dialog]



	
On the DC Parameters page of the wizard, from the context menu next to the MyQueryById_Input field, click Parameter Structure.


	
In the Parameters dialog, expand the complex parameter to view the PrimaryRowId parameter, specify the binding for this parameter as #{pageFlowScope.id}, as shown in Figure C-33, then click OK.


Figure C-33 Parameters Dialog

[image: Parameters Dialog]



	
Click Create.

At this point, as the parameter passes a null value, the table displays all available records, as shown in Figure C-34.


Figure C-34 Table Inside a Parameter Form Task Flow

[image: Table Inside a Parameter Form Task Flow]



	
As the table is inside a parameter form task flow, you must wire the task flow parameter to the data control parameter. To do this:

	
From the View menu, select Source.


	
In Source view, select the inputText component at the bottom of the page and click Edit on the toolbar.


	
Change its Value attribute to #{pageFlowScope.id}, as shown in Figure C-35.


Figure C-35 Component Properties Dialog for Input Text Field

[image: Component Properties Dialog for Input Text]



	
Click OK.


	
Additionally, delete the commandButton component with the title GO.

As an alternative to this button, you will learn how to use one of the Web Service methods to query the data source.





	
Switch back to Design mode of the page.

As you deleted the GO button in the parameter form task flow, there is currently no way to query the data source from the task flow. Therefore, the next step is to add a Web Service method to query the data source.









C.5.3 Querying the Data Source

The Siebel Web Service in this example provides the MyQueryById method, which supports a single parameter, MyQueryById_Input. Add this method as a button to the task flow. As you already wired the MyQueryById_Input parameter to the task flow parameter in the previous step, the button is automatically wired to the task flow parameter.

To enable querying using the MyQueryById method:

	
Edit the task flow and click Add Content.


	
In the catalog, locate the CustData data control and expand it.


	
Add the MyQueryById method as an ADF Button.

You can now specify an account ID in the parameter field to view details for that account in the table, as shown in Figure C-36.


Figure C-36 Table and Query Button inside the Parameter Form Task Flow

[image: Table and Query Button inside Task Flow]










C.5.4 Updating Data Source Records

If a data source allows writing into it, Web Service data controls provide array parameters to update multiple records simultaneously. The Siebel Web Service in this example allows writing back to the data source. It provides the MyInsertorUpdate_Input parameter, which is a complex parameter that can be used to populate multiple records at a time. This section describes how to use array parameters to update records in the table. Input Text fields added to the bottom of the page are used to update table columns.

To update records in the table:

	
Edit the task flow and click Add Content.


	
In the catalog, locate the CustData data control and expand it.


	
Add the MyInsertOrUpdate method as an ADF Button.


	
Switch to Source view of the page, select the new button, and click Edit to view its properties.


	
Click the Data tab, and from the context menu on the MyInsertOrUpdate_Input field, select Parameter Structure.


	
In the Parameter dialog, expand MyInsertOrUpdate_Input, ListOfAccountInterface, and Account.

The Account parameter is an array type parameter and therefore displays an Add link.


	
In each row, define a bind parameter value for each column that you want to update, as shown in Figure C-37. For example, #{pageFlowScope.id1} and #{pageFlowScope.alias1} in the first row, and #{pageFlowScope.id2} and #{pageFlowScope.alias2} in the second row.




	
Tip:

To delete any of the columns you just added, leave the columns empty. Empty columns are deleted before passing the values back as Web Service parameter values.








Figure C-37 Array Parameter Definition in the Parameter Dialog

[image: Array Parameter Definition in the Parameter Dialog]



	
You can update values for two rows, Account[0] and Account[1], by default. Click Add to add more rows.


	
Click OK in the Parameters dialog, then again in the Component Properties dialog.


	
Save and close the task flow.


	
To update values in the table, at the bottom of the page, add one Input Text field for each table cell that you want to update. To do this:

	
Select the task flow in the Resource Manager and click Edit Source from the Edit menu.


	
Copy the source code for the parameter form's inputText component and paste it four times.


	
Change the id attribute value so that each ID is unique.


	
Change the value attribute to contain the values you defined in the Parameters dialog in step 7, for example, #{pageFlowScope.id1}.

Figure C-38 shows the source code for the new components.


Figure C-38 Source Code of the New Input Text Components

[image: Source Code of Input Text Components]






	
Optionally, to organize the page components better, group the four inputText components in a Box component.

The task flow is now wired to write back to the data source. Figure C-39 shows how the task flow appears. The first field is wired to the MyQueryById button and the remaining fields are used to provide values for the table. The new values are written to the data source when you click the MyInsertOrUpdate button.


Figure C-39 Task Flow with a Table and Options to Query and Update

[image: Table with query and update options]

Description of "Figure C-39 Task Flow with a Table and Options to Query and Update"














C.6 Building and Using a Custom Mashup Style with Predefined Columns

This section describes how to create a custom mashup style in the Resource Manager and use that style to create a task flow. The custom style is designed to list the top five page hits in a space in a layout similar to the Spaces Activity Stream layout. An input text field allows users to specify a space name to view page hits for that space. This section includes the following subsections:

	
Section C.6.1, "Building the Custom Mashup Style"


	
Section C.6.2, "Creating a Task Flow Based on the Custom Style"






C.6.1 Building the Custom Mashup Style

As the Resource Manager does not provide a Create option on the Mashup Styles page, the only way to build a new mashup style is by copying an out-of-the-box mashup style and replacing its source code.

To build the custom mashup style:

	
Create a copy of the blank mashup style and name it PageHitsStyle.


	
Edit the source of PageHitsStyle and replace the code on the Fragment tab with the following:


<?xml version='1.0' encoding='UTF-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
          xmlns:pe="http://xmlns.oracle.com/adf/pageeditor"
          xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable"
          xmlns:f="http://java.sun.com/jsf/core"
          xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
  <af:panelGroupLayout id="pgl1">
    <af:panelGroupLayout id="pg2" layout="horizontal" halign="center"
                         inlineStyle="padding-bottom:5px;">
      <af:inputText id="ip1" value="#{pageFlowScope.bindVarId}" label="Space Name" 
                    shortDesc="Enter A Space Name, by default it's all spaces"/>
      <af:commandButton text="#{dataComposerBundle.MASHUP_STYLES_GO}" id="cb1"/>
    </af:panelGroupLayout>
    <cust:panelCustomizable id="pc1">
      <table border="0" width="100%">
        <af:iterator id="i1" value="#{dataPresenter.dummyData.collectionModel}" var="row">
        <tr class="PortletText1">
          <td width="12px">
            <af:image id="img1" source="/adf/webcenter/star_sm_ena.png"/>
          </td>
          <td>
            <af:outputText id="otCol1" value="#{empty row.USERNAME ? '#{row.USERNAME}' : row.USERNAME}" 
                           inlineStyle="color:#333333; font-size:12px; font-weight:bold;"/>
            <af:spacer id="spacer1" width="5px"/>
            <af:outputText id="otCol2" value="viewed" inlineStyle="color:#333333; font-size:12px;"/>
            <af:spacer id="spacer2" width="5px"/>
            <af:goLink id="gl1" destination="{doc path pre fix}#{empty row.DOWNLOAD_URL ? '#{row.DOWNLOAD_URL}' : row.DOWNLOAD_URL}" 
                       targetFrame="_blank" text="#{empty row.DOCNAME ? '#{row.DOCNAME}' : row.DOCNAME}"/>
          </td>
        </tr>
        <tr>
          <td/>
          <td>
            <af:outputText id="otCol3" value="#{empty row.HITS? '#{row.HITS}' : row.HITS}" 
                           inlineStyle="color:#666666; font-size:12px;"/>
            <af:spacer id="spacer3" width="5px"/>
            <af:outputText id="otCol4" value="TIMES" inlineStyle="color:#666666; font-size:12px;"/>
            <af:spacer id="spacer4" width="5px"/>
            <af:outputText id="otCol5" value="in the last 7 days" inlineStyle="color:#333333; font-size:12px;"/>
          </td>
        </tr>
        <tr>
          <td/>
          <td>
            <af:outputText id="otCol6" value="Last Visit at " inlineStyle="color:#333333; font-size:12px;"/>
            <af:outputText id="otCol7" value="#{empty row.LASTVIEWED ? '#{row.LASTVIEWED}' : row.LASTVIEWED}" 
                           inlineStyle="color:#666666; font-size:12px;">
            <af:convertDateTime type="both"/>
            </af:outputText>
          </td>
        </tr>
        </af:iterator>
      </table>
    </cust:panelCustomizable>
  </af:panelGroupLayout>
</jsp:root>


where,

#{pageFlowScope.bindVarId} is a reference that provides the input space name

#{dataPresenter.dummyData.collectionModel} is a dummy reference that gets replaced when you use the mashup style

#{row.COLUMN} are placeholders that will reference data from data controls when the mashup style is used

{doc path pre fix} is the prefix to be used for the document URL. To find the prefix for a document path, select a document on the Documents page and click Get a Link from the View menu. The first part of the Download URL (ending in path) is the prefix to be used. For example, http://my.company.com:8889/webcenter/content/conn/xyz18-ucm11g/path.

If you preview the mashup style, it displays as shown in Figure C-40.


Figure C-40 Preview of the Custom Mashup Style

[image: Mashup Style using Activity Stream format]





You can use this mashup style to build mashups that display page hits.






C.6.2 Creating a Task Flow Based on the Custom Style

This section describes how to use the PageHits mashup style to create a mashup that displays page hits in an Activity Stream layout. To illustrate this, you must create a SQL data control using the ActivitiesDS database connection, then consume the data control in a task flow based on the PageHits mashup style. However, to display the data from the data control in an Activity Stream layout instead of the typical table or graph layout, you must perform the following tasks:

	
Create a SQL data control.


	
Create a task flow based on the new PageHits mashup style.


	
Add the data control as a table.


	
Copy the data control's accessor ID from the table's properties.


	
Hide the table.


	
Wire the input text field in the task flow to the data control using the accessor ID.




To use the custom mashup style:

	
Creare a SQL data control, Top Five Viewed Documents in a Given Space, using the ActivitiesDS connection. Specify the following query:


SELECT * FROM
(SELECT users.userid  username, doc.name_  docname,doc.path_  download_url, count(1) hits,max(fact.occurred) lastviewed
FROM asfact_wc_doclib__0 fact , asdim_wc_documen_0 doc , asdim_wc_applica_0 app,asdim_wc_groupsp_0 space , asdim_users users
WHERE app.id = fact.application_
AND app.name_ = 'webcenter' 
AND fact.occurred BETWEEN (SYSDATE-7) AND SYSDATE
AND fact.document_ = doc.id
AND doc.name_ is not null 
AND doc.id is not null 
AND fact.document_ is not null 
AND doc.resourceid_ is not null
AND  fact.GROUPSPACE_ = space.id 
AND  upper(space.name_) LIKE upper(:spacename) 
AND space.name_ IS NOT NULL 
AND fact.userid=users.id
GROUP BY users.userid, doc.name_,doc.path_
ORDER BY hits  DESC)
WHERE rownum <= 5
ORDER BY rownum 





	
See Also:

Section C.1.2.1, "Creating the Page Hits Data Control"








	
Set the spacename bind parameter value to Home Space.


	
Select the data control in the Resources Manager and click Show on the Edit menu.


	
Create a task flow, Top Five Viewed Documents in a Given Space, using the PageHits mashup style, as shown in Figure C-41.


Figure C-41 Create New Task Flow Dialog with PageHits Style

[image: Create New Task Flow Dialog with PageHits Style]



	
Edit the task flow and add the data control as a table, as shown in Figure C-42.


Figure C-42 Top Five Viewed Documents in a Given Space

[image: Top Five Viewed Documents in a Given Space]



Create a read-only table, and accept the defaults on Items and Columns pages of the Create Table dialog.

On the DC Parameters page, specify the following as the parameter value for spacename:

#{empty pageFlowScope.bindVarId ? '%' : pageFlowScope.bindVarId}


	
To get the accessor ID:

	
Switch to Source view of the task flow, and select the Table component.


	
Click Edit to view the table's properties.


	
In the Component Properties dialog, copy the value of the Value attribute. This is the accessor ID for the data control. The value may be as shown in the following example:

#{bindings.accessor_gsraffebf20_b500_480f_bf92_a9d33922a0a7.collectionModel}





	
Select the showDetailFrame component wrapping the table and click Hide on the context menu.


	
Right-click the iterator component, and click Edit.


	
Replace the value in the Value attribute with the accessor ID you copied from the table's properties.

You now have a task flow with the Activity Stream-like seeded layout.


	
Save the task flow and exit Composer.


	
In the Resources Manager, select the task flow and click Show on the Edit menu.


	
Consume the task flow in a page. It appears as shown in Figure C-43.


Figure C-43 Page Displaying Top Five Page Hits in a Space

[image: Page Displaying Top Five Page Hits in a Space]












C.7 Building and Using a Custom Mashup style with Date Fields

This section describes how to create a custom mashup style with fields to specify a date range and a content area to display a visualization of data for the specified date range. Figure C-44 shows a task flow created using such a mashup style. This section also describes how to create a task flow using the custom style. It includes the following subsections:

	
Section C.7.1, "Building the Custom Mashup Style"


	
Section C.7.2, "Creating a Task Flow Based on the Custom Style"





Figure C-44 Task Flow Using Custom Mashup Style with Date Fields

[image: Task flow with date fields and page hits graph]





C.7.1 Building the Custom Mashup Style

As the Resource Manager does not provide a Create option on the Mashup Styles page, the only way to build a new mashup style is by copying an out-of-the-box mashup style and replacing its source code.

To build the custom mashup style:

	
Create a copy of the blank mashup style and name it Input Dates.


	
Edit the source of Input Dates and replace the code on the Fragment tab with the following:


<?xml version='1.0' encoding='UTF-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
          xmlns:pe="http://xmlns.oracle.com/adf/pageeditor"
          xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable"
          xmlns:f="http://java.sun.com/jsf/core"
          xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
  <af:panelGroupLayout id="pgl">
    <af:panelGroupLayout id="pg2" layout="horizontal" halign="center" inlineStyle="padding-bottom:5px;">
      <af:panelFormLayout id="pfl1" partialTriggers="ipl" inlineStyle="padding-bottom:5px;">
        <af:inputDate id="ip1" value="#{pageFlowScope.bindVarId1}" label="Start Date" autoSubmit="true"/>
        <af:inputDate id="ip2" value="#{pageFlowScope.bindVarId2}" label="End Date"/>
        <af:commandButton text="#{dataComposerBundle.MASHUP_STYLES_GO}" id="cb1"/>
      </af:panelFormLayout>
    </af:panelGroupLayout>
    <cust:panelCustomizable id="pc1" halign="center"/>
  </af:panelGroupLayout>
</jsp:root>


The inputDate components provide the two date fields, and the panelCustomizable provides the content area. When previewed, the mashup style appears as shown in Figure C-45.


Figure C-45 Preview of Custom Style with Date Fields

[image: Custom style with date fields and Go button]



You can use this mashup style to build a mashup and populate the content area with a visualization of your choice.









C.7.2 Creating a Task Flow Based on the Custom Style

This section describes how to use the Input Dates mashup style to create a mashup that displays a graph of the page hits for a specified date range. To illustrate this, you must create a SQL data control using the ActivitiesDS database connection, then consume the data control in a task flow based on the Input Dates mashup style.

To use the custom mashup style:

	
Creare a SQL data control, Page Usage Between Two Dates, using the ActivitiesDS connection. Specify the following query:


SELECT page.name_ pageName, space.name_ spaceName, COUNT(1) hits
FROM asdim_users u, asdim_wc_pages_0 page, asdim_wc_applica_0 app, asdim_wc_groupsp_0 space, asfact_wc_pagevie_0 fact 
WHERE 
 app.name_ = 'webcenter' 
AND fact.page_ = page.id 
AND fact.userid = u.id 
AND fact.application_ = app.id 
AND fact.groupspace_  = space.id 
AND fact.occurred BETWEEN to_timestamp_tz(to_char(:startdate), :dateformat) 
AND to_timestamp_tz(to_char(:enddate), :dateformat) 
AND space.name_ IS NOT NULL 
AND page.name_ IS NOT NULL 
AND space.id IS NOT NULL 
AND page.id IS NOT NULL 
AND fact.page_ IS NOT NULL 
AND page.resourceid_ IS NOT NULL 
GROUP BY page.name_, space.name_ 


The data control is created with the bind variables startdate, dateformat, and enddate.


	
Set the bind parameter values as required, for example, to query the usage of all pages in the year 2010, as shown in Figure C-46.


Figure C-46 Bind Parameter Values for the Data Control

[image: Bind Parameter Values for the Data Control]



	
Test the query and view the data retrieved from the data source, as shown in Figure C-47.


Figure C-47 Data Control Query Test Results

[image: Data Control Query Test Results]



	
Select the data control in the Resources Manager and click Show on the Edit menu.


	
Create a task flow, Page Usage Between Two Dates, using the Input Dates mashup style, as shown in Figure C-48.


Figure C-48 Input Dates Mashup Style in the Create New Task Flow Dialog

[image: Input Dates Mashup Style in the Create New Task Flow Dialog]



	
Edit the task flow and add the data control as a graph (Figure C-49).


Figure C-49 Graph Option on the Data Control Accessor

[image: Graph Option on the Data Control Accessor]



	
In the Create Graph dialog, on the Type page, choose Bar.


	
On the Placement page, place PAGENAME and SPACENAME on the X Axis, and HITS as the Bars.


	
On the DC Parameters page, specify the following values for the bind parameters:

startdate:


#{empty pageFlowScope.bindVarId1 ? '01' : 
pageFlowScope.bindVarId1.month+1}/#{empty pageFlowScope.bindVarId1 ? '01' : 
pageFlowScope.bindVarId1.date}/#{empty pageFlowScope.bindVarId1 ? '2010' : 
pageFlowScope.bindVarId1.year+1900}


(01/01/2010 is set as the default initial start date value if no date selected)

dateformat: MM/DD/YYYY

enddate:


#{empty pageFlowScope.bindVarId2 ? '01' : 
pageFlowScope.bindVarId2.month+1}/#{empty pageFlowScope.bindVarId2 ? '01' : 
pageFlowScope.bindVarId2.date}/#{empty pageFlowScope.bindVarId2 ? '2011' : 
pageFlowScope.bindVarId2.year+1900}


(01/01/2011 is set as the default initial end date value if no date selected)





	
Create the graph, save the task flow, then exit Composer.


	
In the Resources Manager, select the task flow and click Show on the Edit menu.


	
Consume the task flow in a page. It appears as shown in Figure C-50.


Figure C-50 Mashup Showing Graph for Specified Date Range

[image: Mashup Showing Graph for Specified Date Range]












C.8 Creating a Mashup with a Graph That Is Wired to the Page Navigation

This section describes how to create a sample page that contains a navigation tree and a mashup wired in such a way that clicking a space name displays the page hits for that space in the graph, as shown in Figure C-51.


Figure C-51 Mashup with Left Navigation and a Page Hits Graph

[image: Mashup showing left navigation and a graph at the center]



The steps to build such a mashup include:

	
Section C.8.1, "Creating the Page Hits Data Control"


	
Section C.8.2, "Consuming the Data Control in a Page with a Navigation Tree"






C.8.1 Creating the Page Hits Data Control

If you have configured WebCenter Portal services in your application, an Analytics service connection, ActivitiesDS, is available out-of-the-box. You can use this connection to create a SQL data control. This section describes how to create a data control to view the top five page hits for the last 7 days for a given space.

To create the data control:




	
See Also:

Section 26.2.1.3, "Creating the Data Control" for the detailed steps to create a data control.







	
Use the ActivitiesDS connection and create a SQL data control named PageHits.


	
Specify the following SQL query:


SELECT * FROM
(SELECT page.name_ pageName, space.name_ spaceName, COUNT(1) hits 
FROM asdim_users u, asdim_wc_pages_0 page, asdim_wc_applica_0 app, asdim_wc_groupsp_0 space, asfact_wc_pagevie_0 fact 
WHERE fact.page_ = page.id AND fact.userid = u.id AND fact.application_ = app.id 
AND fact.groupspace_ = space.id AND fact.occurred BETWEEN(SYSDATE-6) AND (SYSDATE+1) AND app.name_ = 'webcenter' 
AND u.userid <> 'anonymous' AND  upper(space.name_) LIKE upper(:spacename) AND space.name_ IS NOT NULL 
AND page.name_  IS NOT NULL AND space.id IS NOT NULL AND page.id IS NOT NULL 
AND fact.page_  IS NOT NULL AND page.resourceid_ IS NOT NULL 
GROUP BY page.name_, space.name_ ORDER BY hits DESC) 
WHERE rownum <= 5 ORDER BY rownum


The data control is created with the spacename bind variable.


	
Set the spacename bind variable to Home space.


	
Test the query and view the data retrieved from the data source, as shown in Figure C-52.


Figure C-52 SQL Data Control Query Test Result

[image: SQL data control query test result]



	
Select the data control in the Resource Manager and click Show on the Edit menu.









C.8.2 Consuming the Data Control in a Page with a Navigation Tree

This section describes how to create a navigation tree to list the available spaces, consume it in a JSPX page, then add the page hits data control to the page.

To create a page with a navigation and page hits graph:

	
Create a page, Top Five Page Views for Given Space Within Past Week, using the Left Narrow page style.

The new page opens in Composer.


	
Click Page Properties and create a new page parameter, space, with the following value (Figure C-53):

#{empty navigationContext.currentNavigationModel.currentSelection.parameters.space ? 'Space_Name' : navigationContext.currentNavigationModel.currentSelection.parameters.space}

Replace Space_Name with sample1 or the name of any other space for which you want to display details by default.


Figure C-53 Page Properties Dialog with new Parameter

[image: Page Properties dialog with a new parameter]

Description of "Figure C-53 Page Properties Dialog with new Parameter"





	
Click OK.


	
Add the PageHits data control accessor as a graph, as shown in Figure C-54.


Figure C-54 Graph Option on the PageHits Data Control Accessor

[image: Graph option on the PageHits data control accessor]



In the Create Graph dialog, on the Type page, choose Bar.

On the Placement page, place PAGENAME and SPACENAME on the X Axis, and HITS as the Bars.

On the DC Parameters page, wire the data control parameter, spacename, to the page parameter, space, as follows:

#{empty bindings.space ? 'sample1' : bindings.space}


	
In the Resource Manager, create a navigation model called Spaces Navigation with three Link navigation items, Sample1, Sample2, and Sample3, as shown in Figure C-55.


Figure C-55 Navigation Component with Three Link Navigation Items

[image: Navigation Component with Three Link Navigation Items]



	
Select Sample1 and click Edit.


	
In the Edit Navigation Item dialog, specify the path to the Top Five Page Views for Given Space Within Past Week page, as shown in Figure C-56.


Figure C-56 Navigation Item Properties Dialog

[image: Navigation item properties dialog]



	
Click the Parameters tab and specify the space parameter value to be Sample1.


	
Similarly, edit the Sample2 and Sample3 links in the navigation model by repeating the previous three steps.

In these steps, you are wiring the same task flow to the three links in the navigation, but by specifying different space names for each link.


	
Click OK to close the navigation editor.


	
Select Spaces Navigation in the Resource Manager and click Show on the Edit menu.


	
Edit the Five Page Views for Given Space Within Past Week page and add a Navigation Tree component in the left column of the page.

A default navigation displays on the left of the page.


	
Click the Edit icon on the default navigation, as shown in Figure C-57.


Figure C-57 Edit Icon on the Default Navigation Tree Component

[image: Edit icon on the default navigation tree component]



	
On the Parameters tab, specify Spaces Navigation in the Navigation field, as shown in Figure C-58, then click OK.


Figure C-58 Navigation Tree Component Properties Dialog

[image: Navigation tree component properties dialog]



	
The new navigation model now displays on the left side of the page, as shown in Figure C-59.


Figure C-59 Navigation Model with Space Name Links

[image: Navigation model with space name links]



	
Click Save and Close to exit page edit mode.


	
When you view the page, it displays the navigation tree and the graph as shown in Figure C-60.


Figure C-60 Mashup with Left Navigation and Page Hits Graph for Sample1

[image: Mashup showing page hits graph for Sample1]



	
Click a different space in the navigation to view the page hits graph for that space, as shown in Figure C-61.


Figure C-61 Mashup with Left Navigation and Page Hits Graph for Sample2

[image: Mashup showing page hits graph for Sample2]












C.9 Creating a Mashup with a Graph that Is Wired to the Inherited Page Navigation

The previous example described how to create a graph of page hits for a given space and wire it to a page containing a navigation tree. Taking this one step further, this section describes how to wire the page hits graph to the navigation tree inherited from a page template.

The steps to build such a mashup include:

	
Section C.9.1, "Creating the Page Hits Data Control"


	
Section C.9.2, "Consuming the Page Hits Data Control"


	
Section C.9.3, "Creating and Applying a Custom Page Template"


	
Section C.9.4, "Testing the Wiring Between the Page Hits Graph and the Inherited Navigation"






C.9.1 Creating the Page Hits Data Control

Perform the steps in Section C.8.1, "Creating the Page Hits Data Control."






C.9.2 Consuming the Page Hits Data Control

This section describes how to consume the data control in a task flow, then consume the task flow in a page that displays the inherited navigation tree.

To consume the data control:

	
Create a task flow, Top Five Page Views for Given Space Within Past Week, using the Blank mashup style.


	
Add the PageHits data control accessor as a graph.

In the Create Graph dialog, on the Type page, choose Bar.

On the Placement page, place PAGENAME and SPACENAME on the X Axis, and HITS as the Bars.

On the DC Parameters page, set the data control parameter, spacename, to the following:

#{empty pageFlowScope.spacename ? 'home space' : pageFlowScope.spacename}

Click Create.


	
Click Task Flow Properties and create a string parameter, spacename, in pageFlowScope, as shown in Figure C-62.


Figure C-62 New Parameter in the Taskflow Properties Dialog

[image: New Parameter in the Taskflow Properties Dialog]



	
Click Save and Close to exit edit mode.


	
Select the task flow in the Resource Manager and click Show on the Edit menu.


	
Create a page, Sample8b, and add the new task flow inside the page.

This ensures that the task flow displays the page hits graph for the Home space by default.









C.9.3 Creating and Applying a Custom Page Template

This section describes how to create a custom navigation component and a page template containing a navigation tree, and how to apply the new page template.

To create a custom navigation component:

	
In the Resource Manager, create a navigation model called Spaces Navigation with three Link navigation items, Sample1, Sample2, and Sample3, as shown in Figure C-63.


Figure C-63 Navigation Component with Three Link Navigation Items

[image: Navigation Component with Three Link Navigation Items]



	
Select Sample1 and click Edit.


	
In the Edit Navigation Item dialog, specify the path to the Top Five Page Views for Given Space Within Past Week page, as shown in Figure C-64.


Figure C-64 Navigation Item Properties Dialog

[image: Navigation item properties dialog]



	
Click the Parameters tab and specify the space parameter value to be Sample1.


	
Similarly, edit the Sample2 and Sample3 links in the navigation model by repeating the previous three steps.

In these steps, you are wiring the same task flow to the three links in the navigation, but by specifying different space names for each link.


	
Click OK to close the navigation editor.


	
Select Spaces Navigation in the Resource Manager and click Show on the Edit menu.




To create and apply a custom page template:

	
Create a custom page template, Sample Template, based on the out-of-the-box Side Navigation – Flow template.


	
Add a Navigation Tree component to the template.

A default navigation displays on the left of the page.


	
Click the Edit icon on the default navigation, as shown in Figure C-65.


Figure C-65 Edit Icon on the Default Navigation Tree Component

[image: Edit icon on the default navigation tree component]



	
On the Parameters tab, specify Spaces Navigation in the Navigation field, then click OK.

The new navigation model now displays on the left side of the template, as shown in Figure C-66.


Figure C-66 Custom Page Template with a Navigation Tree

[image: Custom page template with a navigation tree]



	
Click Save and Close to exit page edit mode.


	
Select the new template in the Resource Manager and click Show on the Edit menu.


	
Navigate to the Spaces administration page, then click the Configuration tab.


	
On the General page, in the Default Page Template field, select the new sample template that you created (Figure C-67), then click Apply.


Figure C-67 Default Page Template Configuration

[image: Default page template configuration]



The navigation tree in the template now displays on all application pages.









C.9.4 Testing the Wiring Between the Page Hits Graph and the Inherited Navigation

To verify that the graph is wired to the navigation correctly:

	
Open the page, Sample8b.

It displays the navigation tree and the page hits graph for the Home space, as shown in Figure C-68.


Figure C-68 Page Hits Graph for Sample1 Selected in the Navigation

[image: Page Hits Graph for Sample1 Selected in the Navigation]



	
Click a different space in the navigation to view the page hits graph for that space, as shown in Figure C-69.


Figure C-69 Page Hits Graph for Sample2 Selected in the Navigation

[image: Page Hits Graph for Sample2 Selected in the Navigation]












C.10 Creating a Master-Detail Mashup that Contains a Google Maps Task Flow

This section describes how to create a mashup that displays two task flows wired in a master-detail relationship so that a selection in the master task flow results in an update to the Google Map address in the details task flow, as shown in Figure C-70.


Figure C-70 Mashup Displaying a Table and Google Map

[image: Mashup Displaying a Table and Google Map]



The steps to create a similar mashup include:

	
Creating a SQL data control to retrieve static data for the purpose of the demo.


	
Creating a master task flow that consumes this data control as a static table.


	
Adding hyperlinks in the user names column in the table.


	
Creating a details task flow to integrate the latest Google Maps API Version 3.


	
Wiring the master and detail task flows so that clicking a record in the master table results in a location change in the Google Map.




This section describes how to perform these tasks. It includes the following subsections:

	
Section C.10.1, "Creating the Data Control"


	
Section C.10.2, "Creating the Details Task Flow"


	
Section C.10.3, "Creating the Master Task Flow"


	
Section C.10.4, "Wiring the Master and Details Task Flows"






C.10.1 Creating the Data Control

For the purpose of this example, create a data control to get address data using select * from dual statements. You can use any existing data source connection to create the data control. In real time, you must replace it with the required SQL data source connection. To create the data control:

	
Create a SQL data control, addresses, using any available database connection, and specify the following query:


SELECT 'Steve' Buddy, 'Palo Alto' City, 'CA' State
FROM dual
UNION
SELECT 'Doris' Buddy, 'Belmont' City, 'CA' State
FROM dual
UNION
SELECT 'John' Buddy, 'New York' City, 'NY' State
FROM dual
UNION
SELECT 'Lily' Buddy, 'Boston' City, 'MA' State
FROM dual


	
Select the new data control in the Resource Manager, and from the Edit menu, click Show.









C.10.2 Creating the Details Task Flow

This section describes how to create a details task flow that will display the Google map.

To create the details task flow:

	
Create a task flow, Basic Maps, based on the Blank mashup style.


	
Select the task flow and click Edit Source on the Edit menu.


	
Replace the code on the Fragment tab with the following:


<?xml version='1.0' encoding='UTF-8'?>
<jsp:root xmlns:jsp="http://java.sun.com/JSP/Page" version="2.1"
          xmlns:pe="http://xmlns.oracle.com/adf/pageeditor"
          xmlns:cust="http://xmlns.oracle.com/adf/faces/customizable"
          xmlns:f="http://java.sun.com/jsf/core"
          xmlns:af="http://xmlns.oracle.com/adf/faces/rich"
          xmlns:trh="http://myfaces.apache.org/trinidad/html">
  <af:resource type="javascript" source="http://maps.google.com/maps/api/js?sensor=true"/>
  <af:resource type="javascript">
  var geocoder;
  var map;
function initialize(){  
  geocoder = new google.maps.Geocoder();
  var latlng = new google.maps.LatLng(37.529526, -122.263969);  
  var myOptions = {
      zoom: 3,
      center: latlng,
      mapTypeId: google.maps.MapTypeId.ROADMAP
    };
  map = new google.maps.Map(document.getElementById("map_canvas"),myOptions);
}
function navigate(event) {
initialize();
var city= event.getSource().getProperty('city')+"";
var state= event.getSource().getProperty('state')+"";
var address;
if(city== "undefined"||state== "undefined"||city== "NULL"||state== "NULL"){
address="CA, USA";
} else {
map.setZoom(8);
address=city+" "+state+" USA";  
}
  geocoder.geocode( { 'address': address}, function(results, status) 
{  
 if (status == google.maps.GeocoderStatus.OK) {
     map.setCenter(results[0].geometry.location);
     var marker = new google.maps.Marker({          
        map: map, 
        position: results[0].geometry.location
        });
      } 
else {
        alert("Geocode was not successful for the following reason: " + status);
      }
    });
}
</af:resource>
  <af:panelGroupLayout id="pgl1">
    <af:group id="g1">
      <div id="map_canvas" style="width: 600px; height: 600px"/>
    </af:group>
    <af:inlineFrame source="">
      <af:clientListener type="inlineFrameLoad" method="navigate"/>
      <af:clientAttribute name="city" value="#{empty pageFlowScope.city? '' : pageFlowScope.city}"/>
      <af:clientAttribute name="state" value="#{empty pageFlowScope.state ? '' : pageFlowScope.state}"/>
    </af:inlineFrame>
  </af:panelGroupLayout>
</jsp:root>


The code in bold, <af:inline>, calls the navigate Google Map javascript method each time the page is loaded, and it parses two pageFlowScope parameters to the navigate method to update the address on the map.


	
Click OK to exit the source editor.


	
Ensure that the task flow is selected in the Resource Manager and click Edit on the Edit menu.


	
Click Task Flow Properties and create two string task flow parameters, city and state, in pageFlowScope, as shown in Figure C-71.


Figure C-71 New Parameters on the Basic Maps Task Flow

[image: New Parameters on the Basic Maps Task Flow]










C.10.3 Creating the Master Task Flow

This section describes how to create the master task flow to consume the addresses data control as a table and the Basic Maps task flow.To create the master task flow:

	
Create a task flow, Address on Google Maps, based on the Blank mashup style.


	
Edit the task flow and add the Basic Maps task flow, as shown in Figure C-72.


Figure C-72 Basic Maps Task Flow in the Resource Catalog

[image: Basic Maps Task Flow in the Resource Catalog]



	
Add the Address on Google Maps data control accessor as a read-only table with row selection enabled.

The master task flow displays the addresses table on top and the map below it, as shown in Figure C-73.


Figure C-73 Master-Detail Task Flow with Table and Google Map

[image: Master-Detail Task Flow with Table and Google Map]










C.10.4 Wiring the Master and Details Task Flows

This section describes how to wire the master and details task flows so that a user can click a name in the table to show the corresponding location in the map.To wire the master and details task flows:

	
Click the Edit icon on the Basic Maps task flow.


	
In the Component Properties dialog, modify the values for the two task flow parameters, city and state, as follows:

city: #{empty dataComposerViewContext.dataSelection.CITY ? 'NULL' : dataComposerViewContext.dataSelection.CITY}

state: #{empty dataComposerViewContext.dataSelection.CITY ? 'NULL' : dataComposerViewContext.dataSelection.CITY}


	
To hide the header on the map, click the Display Options tab and clear the Display Header checkbox.


	
Click the Advanced link on the Display Options tab, then set Stretch Content to Auto.

This ensures that the map displays a scroll bar only when required.


	
Click OK to save your changes.

The map displays the location corresponding to the currently selected name in the table.


	
Click Save and Close to exit edit mode.

The task flow displays as shown in Figure C-74.


Figure C-74 Master-Detail Task Flow with Table and Google Map

[image: Master-Detail Task Flow with Table and Google Map]



	
Optionally, you can change the layout of the task flow so that the table displays to the left of the map. To refine the layout of the master task flow:

	
1.Edit the source of the master task flow, and on the Fragment tab, replace the following lines:


<af:panelGroupLayout id="pgl1">  
<cust:panelCustomizable id="pc1">


with


<af:panelGroupLayout id="pgl1" layout="horizontal" valign="top">
<cust:panelCustomizable id="pc1" layout="vertical" valign="top">


	
Move the end tag of </cust:panelCustomizable> to the right, after the first </showDetailFrame> tag and before the second <showDetailFrame> tag.


	
To disable default selection in the table, remove the selectedRowKeys attribute on the <table> tag.


	
To ensure that the map stretches when required, change the columnStretching attribute to last.





	
To test the master-detail task flow further, create a page and add the Address on Google Maps task flow to it.

Edit the task flow on the page and set the Stretch Content option to auto.




	
Note:

To ensure that the page reflects your recent changes, you may need to directly use the URL to open the page afresh, as against clicking the Refresh button.







The task flow displays as shown in Figure C-75.


Figure C-75 Mashup Displaying a Table and Google Map

[image: Mashup Displaying a Table and Google Map]



Click a name in the table; the map points the location corresponding to that name.











C.11 Creating a Mashup with a Customized RSS Feed OmniPortlet

This section describes how to create a mashup with an OmniPortlet instance that displays live, scrolling news information to users from a Really Simple Syndication (RSS) news feed, such as Oracle Technology Network Headlines. It also describes how to share the portlet across Spaces instances.


Registering the Producer

To consume an OmniPortlet in a task flow, you must first register the portlet producer with the application. For the detailed steps, see Section 6.5, "Registering Portlet Producers."

This section includes the following subsections:

	
Section C.11.1, "Creating a Task Flow with an OmniPortlet"


	
Section C.11.2, "Testing the Task Flow"


	
Section C.11.3, "Sharing the Task Flow with the Customized Portlet"






C.11.1 Creating a Task Flow with an OmniPortlet

To create a mashup with an Omniportlet instance:

	
Create a new task flow based on the Blank mashup style.


	
Add the Omniportlet to the task flow from the Resource Catalog, shown in Figure C-76.


Figure C-76 OmniPortlet in the Resource Catalog

[image: OmniPortlet in the Resource Catalog]



	
Click the Customize icon on the top right corner of the portlet header, shown in Figure C-77.


Figure C-77 Customize Icon on the OmniPortlet Header

[image: Customize Icon on the OmniPortlet Header]






	
See Also:

Section 27.2, "Working with the OmniPortlet Wizard" for detailed information.








	
On the Type page of the OmniPortlet wizard, shown in Figure C-78, choose XML as the data source type, then click Next.


Figure C-78 OmniPortlet Wizard Type Page

[image: Type Page of the OmniPortlet Wizard]



	
On the Source page, specify the XML URL and the XSL Filter URL to be the following, as shown in Figure C-79:

XML URL: http://www.oracle.com/technology/syndication/rss_otn_news.xml

XSL Filter URL: http://www.oracle.com/technology/products/ias/portal/viewlets/omniportletnews.xsl


Figure C-79 Source Page of the OmniPortlet Wizard

[image: Source Page of the OmniPortlet Wizard]



	
In the Portlet Parameters section, define a new parameter, Display Num, as shown in Figure C-80, then click Next.


Figure C-80 Portlet Parameters Section of the OmniPortlet Wizard Source Page

[image: Portlet Parameters Section of the Source Page]



	
On the Filter page, shown in Figure C-81, set the filter limit to ##Param1##, then click Next.


Figure C-81 Limit Section on the Filter Page of the OmniPortlet Wizard

[image: Limit Section on the Filter Page of the Wizard]



	
On the View page, in the Layout Style section, select News, as shown in Figure C-82.


Figure C-82 Layout Style Section on the View Page of the OmniPortlet Wizard

[image: Layout style section in OmniPortlet Wizard]

Description of "Figure C-82 Layout Style Section on the View Page of the OmniPortlet Wizard"





	
On the Layout page, under the Column Layout section, use two fields to specify a title and description as shown in Figure C-83.


Figure C-83 Column Layout Section on the Layout Page of the OmniPortlet Wizard

[image: Column Layout Section on the Layout Page of the Wizard]



	
Click Finish to exit the wizard.


	
Click Save and Close to exit Composer.


	
Select the new task flow in the Resource Manager, and from the Edit menu, click Show.









C.11.2 Testing the Task Flow

To verify that the portlet in the task flow renders correctly:

	
Preview the task flow or consume it in an application page.

The portlet displays ten news items.


	
Click the Personalize icon, shown in Figure C-84, on the top right corner of the task flow.


Figure C-84 Personalize Icon on the Task Flow Header

[image: Personalize Icon on the Task Flow Header]



	
In the resulting screen, shown in Figure C-85, change the value of the Display Num variable to a number of your choice.


Figure C-85 Portlet Parameter Customization Screen

[image: Portlet parameter customization screen]



The portlet displays the specified number of news items.









C.11.3 Sharing the Task Flow with the Customized Portlet

You can share the task flow containing the portlet with another Spaces instance by exporting it from your instance and importing it in that instance. However, the imported task flow renders the portlet only if the producer for the OmniPortlet is registered with the same name on the other instance also.

To share the task flow with another Spaces instance:

	
On the target instance, register the OmniPortlet producer with the same name that was used for the producer registration on your instance.

For the detailed steps, see Section 6.5, "Registering Portlet Producers."


	
Export the task flow from the Resource Manager on the source instance.

For the detailed steps, see Section 10.5.2, "Downloading a Resource."


	
Import the task flow in the Resource Manager of the target instance. For the detailed steps, see Section 10.5.3, "Uploading a Resource."

The portlet is now available with all customizations made on the source instance.














Glossary



About mode

A portlet mode that typically displays information such as copyright, version, and author of the portlet.






Activity Stream

In the People Connections service, a feature for viewing the application activities tracked for you and other users.






Activity Graph

A WebCenter Portal service that provides suggestions of people, items, and spaces that users may be interested in interacting with.

The engine used by the Activity Graph service to provide a central repository for actions that are collected by enterprise applications. The data stored in the activity graph is analyzed to calculate ranks for nodes, predict new actions, and make recommendations.






Activity Rank

Determines the relevance of a search result.






administrator

In the Spaces application there are two types of administrator:

	
Fusion Middleware administrator: Also referred to as systems administrator. A user with complete administrative capabilities. This administrator can perform the complete range of security-sensitive administrative duties, and all installation, configuration, and audit tasks.


	
Spaces administrator: A user responsible for customizing Spaces out of the box, managing and granting application roles, and maintaining the application when it is in use.









Ajax

A combination of asynchronous JavaScript, dynamic HTML (DHTML), XML, and XmlHttpRequest communication channel that enables requests to be made to the server without fully re-rendering the page. Ajax enables rich client-like applications to use standard internet technologies.






Analytics service

A WebCenter Portal service offers real-time usage and activity reporting for your portal. In the Spaces application, users can track and analyze Spaces traffic and usage.






Announcements service

A WebCenter Portal service that offers a quick, convenient way to create and widely distribute messages instantly or at a specific time.






API

Application Programming Interface. A set of exposed data structures and functions that an application can use to invoke services on an application object, such as a portlet.






application customization

Performed by an administrator, all users see the change. These are static changes to an application that affect a site or sites that do not involve changes to the application's code or schema.

See also user customization and personalization






Application Development Framework

See Oracle ADF.






Application Programming Interface

See API.






application role

Roles that are specific to a particular application and are stored in an application-specific stripe of the policy store.






application skin

Specifies the application background color, screen fonts, and, with some skins, the shapes and images used for application buttons and icons. In the Spaces application, the administrator chooses the default application skin and Spaces users may change the application skin on the General tab of the Preferences dialog.






application templates

WebCenter Portal provides templates for creating two kinds of applications: Framework applications and Portlet Producer applications. Templates ensure that the right technology scopes are set, tag libraries added, and required Java classes are added to the class path. Once you do this, relevant components are included to the Component Palette and relevant context menus become available in JDeveloper.

See also Framework application template and Portlet Producer Application template.






authenticated user

A user who is logged into a WebCenter portal application. Credentials of this user are verified against the identity store. By default, an authenticated user can access public information. To access secured information, such as pages and portlets, this user must be authorized through the policy and credential store.

Contrast with public users, who are not logged in, and can access public content only.






authentication

Identification of a user through an identity management system. You can require ADF authentication to enforce credentials for users to access the Framework application only (all ADF resources in the application remain accessible), or authentication and authorization to enforce credentials for users to access the Framework application and any ADF resources that have been secured in the application.






authorization

The policies that define the access rights of an individual or group to a secured resource. This resource may be a page or component within a page.






authorized user

An individual who has access to a secured resource. For non-public resources, this individual is also an authenticated user.






AviTrust Portal Demonstration for WebCenter Portal

An enterprise banking application built using Oracle Fusion Middleware, including Oracle WebCenter Portal: Framework and WebCenter Portal: Spaces, used to provide examples of WebCenter Portal functionality.






blog page

A page that provides a personal record of an individual user's experience and opinions. There are two kinds of blog: personal blogs are written by an individual; group blogs are written by several users.






Box layout component

A layout component available through Oracle WebCenter Portal's Composer. A container that enables the placement of content on a page created in the Spaces application. In Composer, a Box is rendered as a rectangle comprised of dashed lines. In a Framework application, this is the runtime equivalent of a Panel Customizable component.






BPEL

Business Process Execution Language. An XML-based markup language for composing a set of discrete web services into an end-to-end process flow.






business role page

A page, created by the administrators in the Spaces application, specifically provided for a given role in an organization. Business role pages provide a targeted environment for users of a particular role by delivering information that is timely and relevant to individual roles without the noise of irrelevant information from other lines of business. Business role pages appear in the Home space of users classified under the specified role.






caching

The act of storing frequently accessed information, typically web pages, in a location where it can be accessed quickly to avoid frequent content generation.

See also expiry-based caching and validation-based caching.






calendar overlay

The ability to display multiple calendars in a single Events task flow.






Change Mode Button component

In the Composer tag library that enables users to change from page View mode to page Edit mode.






Change Mode Link component

A component provided in the Composer tag library that enables users to change from page View mode to page Edit mode.






check out/check in

A mechanism that enables a user to lock information, by checking it out, so that other users cannot modify that same piece of information. This prevents users from overwriting each other's changes. After making modifications, the user releases it by checking it back in, making it available again for other users to modify.






Child Components

The components contained within a parent component. For example, the task flows contained within a Box layout component are the child components of the Box.

See also Box layout component and parent component.






chrome

Visual elements surrounding a portlet or task flow that provide an access point for actions, such as those on the Actions menu and those embedded in the chrome itself, such as the minimize icon or resize handles.






CMIS

Content Management Interoperability Services (CMIS) standard defines a domain model and Web services and Restful AtomPub bindings that can be used by applications to work with one or more Content Management repositories or systems.






component

An individual piece of an application, for example, a task flow, portlet, page, or layout element such as a box or image.






Component Catalog

A dialog, accessed from Composer, that provides access to all the content you can add to a WebCenter Portal application page.






component developer

The developer who builds components (such as portlets, JavaServer Faces components, and web services).






Component Properties

A dialog, accessed from Composer, that provides access to a component's parameters, display options, child components, style settings, and associated events.






Connections

In the People Connections service, a feature for establishing a social network with other application users.






Composer

A seamlessly integrated environment for populating, revising, and configuring portal pages. It enables users to easily build or revise page layout and content. It also provides the means of adding different components, such as task flows, portlets, content, and other objects, onto a page and then linking those components for a more relevant or personalized view of the information.






container

An application program or subsystem in which the program building block, known as a component, is run.






container runtime option

A JSR 286 feature that provides a way to customize the behavior of the portlet container and therefore customize the runtime environment.






content integration services

Services provided by Oracle WebCenter Portal to enable developers to display content from a content repository, such as by creating data controls.






Content Presenter

A feature of the Documents service that enables end users to select and search content items and then display those items using available display templates. Oracle WebCenter Portal provides out-of-the-box templates for displaying single and multiple content items on your pages. You can also define custom templates for the content that you want to display in your Framework application, or for selection by end users at runtime.






content repository

A specialized storage and management mechanism that provides such features as author-based versioning, full text searching, and content categorization and attribution. A content repository is optimized for storing unstructured information, which differentiates it from a data repository.






content repository data control

A data control sourced though a content repository. In a Framework application, you can create content repository data controls for the following content repositories: Oracle Portal, Oracle WebCenter Content, third-party repositories that support the Java Content Repository (JCR) standard, and your local file system.






credential provisioning page

A JSF (*.jspx) page used for authenticating to an external application. At runtime, the Credential Provisioning page displays login data fields consisting of the data fields specified through external application registration. Login information is passed to the producer, which in turn passes the login values to the external application. The application provides the producer with the requested portlets.

After authentication, the user's login credentials are preserved in a credential store, which subsequently supplies that information at future sessions. Unless his information changes, the user supplies his credentials only one time.






credential store

Provides storage for login credentials for its associated domain. It also preserves the login credentials that a user provides for authentication to an external application. Credential store is usually combined with the policy store as a single logical store.

Although the credentials stored in the credential store are used during subsequent logins for authentication, the main function of this store is to provide authorization for those accounts.






CSS

Cascading Style Sheet. A simple mechanism for ensuring a consistent look and feel or adding style, such as fonts, colors, and spacing, to web documents.






custom action

Icons or menu items rendered on the header or the Actions menu of a Show Detail Frame component surrounding a task flow. Custom actions can represent actions that were defined in the task flow when it was created. For example, at design time a developer can build a task flow with custom personalization settings. At runtime, users can access these settings through icons or Actions menu items provided in the task flow's surrounding chrome (or Show Detail Frame).






custom attribute

In the Spaces application, custom attributes specify information in addition to that provided by the built-in attributes. Custom attributes can be used to determine the content of the components in a space based on the parameter passed in. For example, a component can display data for a specific customer by passing in the customer ID. A custom attribute is simply a name value pair, for example customerId=400, orderId=11, userName=Smith, and so on. Custom attributes are stored within the space template.






custom page

Any page created by a user rather than one provided out of the box.






custom display template

A Content Presenter display template is a JSFF file (JSF page fragment) that defines how Content Presenter renders content items on a Framework application page. WebCenter Portal provides several out-of-the-box display templates to get you started, or, you can create your own templates.






custom resource catalog

A resource catalog that has been customized to control the components that are visible to specific users.

Contrast with default resource catalog.






custom role

A user role created by an administrator or a space moderator to meet a specific Home space or space requirement.






Customize mode

A portlet mode that enables users to set the default values for portlet preferences for all users.






customizable component

A WebCenter Portal component that can be added to a page at runtime to enable end users to perform personalizations such as move, minimize, restore, or remove on content within those components. Customizable components are the Panel Customizable component and the Show Detail Frame component.






data control

A mechanism that provides an abstraction of the business service's data model. The ADF data controls provide a consistent mechanism for clients and web application controllers to access data objects, collections, methods, and operations.






default language (application-level)

A display language specified by the Spaces administrator that is used when users log in to the Spaces application. The Spaces administrator sets the application-level default language on the General tab of the Administration page. Individual users can set their own user-level default language on the General tab of the Preferences dialog.






default language (user preference)

A user-specified display language that is rendered when the user logs in to the Spaces application. This language selection lasts until the user specifies a different default language. It can be overridden by a session language, but returns as the default when the session cookie is purged or expires. This value is set on the General tab of the Preferences dialog.






default resource catalog

The resource catalog that is provided by default for an application. It contains all of the Oracle ADF components and portlets available to the application.

Contrast with custom resource catalog.






Default Server

See Integrated WLS.






delegated administration

Provides a mechanism for securing portal resources based on user roles. You apply delegated administration to a page hierarchy, and the specific security assignments are automatically propagated down through the hierarchy through pages and sub pages.






deployment profile

A file used in application deployment that specifies the following types of information:

	
The source files, deployment descriptors, and other auxiliary files that are packages


	
The type and name of the archive file to be created


	
Dependency information


	
Platform-specific instructions


	
Other information




Oracle WebCenter Portal services provides a special deployment profile, the Framework application WAR deployment profile, that includes an option to export project metadata.






Design view (JDeveloper)

A view, in Oracle JDeveloper, that provides a WYSIWYG representation of a file.

See also Source view (JDeveloper).






Design view (Spaces)

A view, in Composer, that provides a WYSIWYG representation of a page and its components.

See also Source view (Spaces).






discoverable space

A space that can be found by anyone logged into the Spaces application, for example through a search. Any Public or Private space is discoverable. Discoverable spaces are listed on the Spaces page when All Spaces is selected from the Show list. Users wishing to join the space can request membership through self-service (if enabled) or by contacting the space moderator.






Discussions service

A WebCenter Portal service that provides a means of creating and participating in discussion forums.






display language

Controls the language in which application user interface elements, such as buttons, field labels, and screen text, are rendered in the browser. The order of precedence for Framework application display language settings from weakest to strongest is: browser setting, application setting, user preference setting, session setting, space setting.






Documents page

A predefined page provided in every Spaces group and Home space that includes the Document Manager task flow for managing content.






Documents service

A WebCenter Portal service that provides several task flows that offer a variety of formats to display folders and files on a page. You can choose the task flows appropriate for your application to provide features for accessing, adding, and managing folders and files; configuring and viewing file and folder properties; and searching file and folder content in the connected content repositories.






domain

Any tree or subtree within the Domain Name System (DNS) namespace. Domain most commonly refers to a group of computers whose host names share a common suffix: the domain name.






dynamically-generated page

A page that displays as the result of a user action, such as a search or a click on a tag. As the name suggests, dynamically-generated pages are not stored, but rather are created as and when needed.






EAR

Enterprise Archive file. A Java EE archive file that is used in deploying applications on a Java EE application server. Framework applications are deployed using both a generic EAR file, which contains the application and the respective runtime customization, and a targeted EAR file, which contains only the application for deployment to the application server. EAR files simplify application deployment by reducing the possibility of errors when moving an application from development to test, and test to production.

See also WAR.






ECMA-262 specification

A standardization of scripting programming languages, such as ECMAScript and JavaScript.






ECMAScript

A scripting programming language, standardized by Ecma International according to the ECMA-262 specification. Frequently referred to as JavaScript or JScript, which are both extensions of the ECMA-262 specification.






Edit Defaults mode

(JSR 286 portlets only.) A portlet mode that enables personalization of a JSR 286 portlet. Edit Defaults mode is a display mode for the JSR 286 portlet's properties. In a Framework application, the Edit Defaults mode displays on the portlet's Actions menu as the Customize command.

See also Edit mode.






Edit mode

A portlet mode that enables personalization of the portlet for each user, for each instance.

See also Edit Defaults mode.






edit mode

A view mode that enables users to modify the content, style, and layout of a page. Access edit mode by choosing Edit Page from the Page Actions menu.






EL

Expression Language. Provides a shorthand way of working with web application data by providing operators for retrieving and manipulating application data residing in a Java EE web container. In a Framework application, EL expressions are encapsulated in the characters "#{" and "}" and typically come in the form #{object.data} where object represents any Java object or Oracle ADF component placed in the Java EE web container's page, request, session, or application's scope.






Enterprise Archive file

See EAR.






enterprise mashup

An application that enables users to bring all sorts of content and services together in a single place.






Events service

A WebCenter Portal service that provides calendars for scheduling meetings, appointments, and so on. In the Spaces application, it provides calendars to record events relevant to the specific space. You can also integrate the Events service with Microsoft Exchange Server to enable individual users to access their personal calendars in their Home space. Personal calendars are also available in Framework application.






expiry-based caching

A caching method that uses a retention period to specify how long the item is valid in the cache before a refresh is required. When there is a request for the item beyond the retention period, it is refreshed in the cache.

See also validation-based caching.






Expression Language

See EL.






external application

Applications that do not delegate authentication to the single sign-on server. Instead, they display HTML login forms that ask for application user names and passwords. At the first login, users can choose to have the single sign-on server retrieve these credentials for them. Thereafter, they are logged in to these applications transparently.






farm

A collection of components managed by Fusion Middleware Control. A farm can contain a Managed Server domain and other Oracle Fusion Middleware system components that are installed, configured, and running on the domain.






favorites

A personal list of links to favorite pages in the Spaces application and external web sites.






Federated Portal Adapter

See FPA.






Feedback

In the People Connections service, a feature for posting informal appraisals for and receiving informal appraisals from other application users.






FPA

Federated Portal Adapter. A component of Oracle Portal that enables Oracle Portal instances to share their database portlets through the web portlet interface. Using the FPA, Oracle Portal database portlets, including PL/SQL portlets, Portlet Builder portlets, and page portlets can be made available for use in Framework applications.






Framework application

A Framework application is built on top of the ADF using the WebCenter Portal's Extension for Oracle JDeveloper. This application combines web content, portlets, content integration, and collaborative services for the end user. Developers and administrators can create a Framework application based on their roles and skill levels in the organization.

A portal also includes page hierarchies, navigation models, and delegated administration.






Framework application administrator

The administrator responsible for maintaining the Framework application. For example, in Spaces, the administrator performs tasks such as implementing the branding for the Framework application, making new content available, modifying pages, and granting and revoking privileges.

Contrast with systems administrator who has administrative rights for entire Fusion Middleware functions. The Fusion Middleware administrator is also responsible for deploying, setting up, and configuring the Framework application, and performing on-going administrative tasks for the Framework application and other WebCenter Portal components through Fusion Middleware Control.






Framework application developer

The developer who plans, builds, and maintains a Framework application using the Oracle Application Development Framework, Oracle JDeveloper, and Oracle WebCenter Portal.






Framework application end user

The runtime user of the Framework application, who accesses pages, portlets, and content, and personalizes portlets (assuming the appropriate privileges).






Framework application life cycle

The process of creating and testing a Framework application in a design time environment, deploying it to a production system, and then performing routine maintenance, such as monitoring performance and migrating customization data. The life cycle of an application also includes performing further enhancements, restaging, and then redeploying the application to the production system.






Framework application template

A JDeveloper template which includes WebCenter Portal: Framework features like site navigation, page hierarchies, delegated administration, and page templates.

See also application templates and Portlet Producer Application template.






Full Screen Mode (Spaces)

A view mode that opens the space to occupy the entire screen, thus maximizing the display space. The Sidebar is not displayed in Full Screen Mode.






Full Screen mode (Portlets)

(PDK-Java portlets only.) A portlet mode that provides more content than can be shown in the portlet when it is sharing a page with other portlets.






Fusion Middleware Control

A browser-based management application that is deployed when you install Oracle WebCenter Portal. From Fusion Middleware Control, you can monitor and administer a farm (such as Oracle WebCenter Portal).






Fusion Order Demo (FOD)

See AviTrust Portal Demonstration for WebCenter Portal.






HA

High Availability. A collection of solutions to ensure that your applications meet the required availability to achieve your business goals, eliminating single points of failure with no or minimal outage in service.






Help mode

A portlet mode that displays usage information about the functionality of the portlet.






High Availability

See HA.






Home space

A work area within Spaces that provides individual users with a private space for storing personal content, keeping notes, viewing and responding to assignments, maintaining a list of online buddies, and performing many other tasks relevant to their unique working day. Users can also extend this environment by creating additional personal pages and custom content.






HTML Markup layout component

A layout component available through Composer. A simple HTML component that renders raw HTML and JavaScript mark-up inline on the page.






Hyperlink layout component

A layout component available through Composer. A link to an internal or external web page. For designers of Framework applications, this is the runtime equivalent of a Go Link component.






IDE

Integrated Development Environment. A visual application development tool containing editors, debuggers, screen painters, object browsers, and the like. Oracle JDeveloper is an example of an IDE.






Identity Propagation

For a Framework application and associated content repositories, selecting this option allows propagation of current user's identity across the application and processes. The propagated identity is verified on the receiver's side, and then it is used to make decisions such as assigning role based access control.






Image layout component

A layout component available through Composer. An illustration that can include a hyper link. For designers of Framework applications, this is the runtime equivalent of an Image Link component.






IMP service

See Instant Messaging and Presence service.






initialization parameters

The parameters initialized upon the start-up of a standard JSR 286 portlet. Initialization parameters provide an alternative to JNDI (Java Naming and Directory Interface) variables. Use initialization parameters instead of JNDI to configure the behavior of all of the different components of the portlet—for example, servlets and other portlets—in a compatible way. In Oracle WebCenter Portal, initialization parameters are entered into the portlet.xml file.






Instant Messaging and Presence service

A WebCenter Portal service that enables users to observe the presence status of other authenticated users and provides instant access to interaction options, such as instant messages and emails.






Integrated Development Environment

See IDE.






Integrated WLS

Integrated WebLogic Server. A WLS instance used as a platform for pretesting Framework application deployments on a local computer. Integrated WLS also contains preconfigured portlet producers and several useful prebuilt portlets.






Iterative development

Iterative development lets you make changes to your Framework application while it is running on the Integrated WebLogic Server and immediately see the effect of those changes simply by refreshing the current page in your browser. The iterative development feature works by disabling certain optimization features. Iterative development allows developers to work more quickly and efficiently when building a Framework application.






JAAS

Java Authentication and Authorization Service (JAAS) is a Java package that enables applications to authenticate and enforce access controls upon users. JAAS is designed to complement Java 2 security and implements a Java version of the standard Pluggable Authentication Module (PAM) framework. This enables an application to remain independent from the authentication service, and supports the use of custom authentication modules.

JAAS extends the access control architecture of the Java 2 Security Model to support subject-based authorization. It also supports declarative security settings in deployment descriptors instead of being limited to code-based security settings.






Java Authentication and Authorization Service

See JAAS.






Java Content Repository

See JCR 1.0.






Java EE

Also known as Java EE 5. Java Enterprise Edition 5 Platform. A platform that enables application developers to develop, deploy, and manage multitier, server-centric, enterprise-level applications. The Java EE platform offers a multitiered distributed application model, integrated XML-based data interchange, a unified security model, and flexible transaction control. You can build your own Java EE portlets and expose them through web producers.






Java Enterprise Edition 5 Platform

See Java EE.






Java Portlet Specification

Standardizes how components for portal servers are to be developed. This specification defines a common portlet API and infrastructure that provides facilities for personalization, presentation, and security. Portlets using this API and adhering to the specification are product-agnostic, and can be deployed to any portal product that conforms to the specification. See also JSR 286.






Java Specification Request

See JSR 286.






JavaServer Faces

See JSF.






JavaServer Page

See JSP.






JCR 1.0

Java Content Repository 1.0. Also known as JSR 170. It proposes a standard access and interaction API for content repositories, much like JDBC does for databases.






JDeveloper

See Oracle JDeveloper.






JSF

JavaServer Faces. A standard Java framework for building web applications. It simplifies development by providing a component-centric approach to developing Java web user interfaces. JSF offers rich and robust APIs that provide programming flexibility and ensures that applications are well designed with greater maintainability by integrating the Model-View-Controller (MVC) design pattern into its architecture. As JSF is a Java standard developed through Java Community Process, development tools like Oracle JDeveloper are fully empowered to provide easy to use, visual, and productive development environments for JSF.






JSF JSP

JavaServer Faces JavaServer Page. JSF JSPs differ from plain JSPs through their support of Oracle ADF Faces components for the user interface and JSF technology for page navigation. JSF JSP pages leverage the advantages of the Oracle Application Development Framework (Oracle ADF) by using the ADF Model binding capabilities for the components in the pages.






JSP

JavaServer Page. An extension to servlet functionality that provides a simple programmatic interface to web pages. JSPs are HTML pages with special tags and embedded Java code that is executed on the web or application server. JSPs provide dynamic functionality to HTML pages. They are actually compiled into servlets when first requested and run in the servlet container.

See also JSP tags.






JSP tags

Tags that can be embedded in JSPs to enclose Java code. These tags use the <jsp: syntax and enclose action elements in the JSP with begin and end tags similar to XML elements.






JSR 286

Java Specification Request (JSR) 286. Defines a set of APIs for building standards-based portlets using Java. Portlets built to this specification can be rendered to a portal locally or deployed to a WSRP container for rendering portlets remotely. For more information, see http://jcp.org/en/jsr/detail?id=286.






JSR 170

See JCR 1.0






JSR 329

See Oracle JSF Portlet Bridge.






keystore

A file that provides information about available public and private keys that are used for authentication and data integrity. User certificates and the trust points needed to validate the certificates of peers are also stored securely in the keystore.






layout box

A container that enables placement of content on a page created in the Spaces application.






layout component

An object for enhancing the usefulness and appearance of a given page. Layout components include layout boxes, a rich text editor, images, hyperlinks, and so on.






Layout Customizable component

A component provided in the Composer tag library that enables users to select from a set of predefined layouts (for example, two column, three column, two row, and so on) and apply it to the page. Users can apply these layouts to a particular area of the page or to the entire page.






LDAP

Lightweight Directory Access Protocol. A standard, extensible directory access protocol. It is a common language that LDAP clients and servers use to communicate. The framework of design conventions supporting industry-standard directory products, such as the Oracle Internet Directory.






life cycle

See Framework application life cycle.






Lightweight Directory Access Protocol (LDAP)

See LDAP.






Links service

A WebCenter Portal service that provides a means of creating a bidirectional association between two objects, thus setting up easy access between those objects.






Lists service

A WebCenter Portal service that provides a means of creating lists and exposing them for placement on application pages at runtime. At design time, you can make the Lists task flow available in your runtime Resource Catalog. At runtime, users can add the task flow from the Catalog to a page and use the task flow to create lists.






Lists page

A predefined page that displays the space's current lists.






Look and feel

A look and feel file determines the appearance of your application, from the placement and behavior of elements on a portal page to the colors used in the portlet title bars. The look and feel is determined by skins, navigations, page templates, layouts, content display templates, and other similar components.






Mail service

A WebCenter Portal service for exposing familiar email functionality in applications.






Managed Server

In a production environment, a Managed Server hosts applications and the resources needed by those applications. A domain, which is a logically related group of Oracle WebLogic Server resources, can have any number of Managed Servers. An Administration Server manages these servers.






mashup

A web application that enables end users to pull information from different sources to create a personalized application that exactly meets their individual requirements.

See also enterprise mashup.






MBean Browser

In Fusion Middleware Control, MBean browsers enable the administrator to perform specific monitoring and configuration tasks and browse MBeans for an Oracle WebLogic Server or a selected application.






MDS

Oracle Metadata Services. A core technology of the Application Development Framework. MDS provides a unified architecture for defining and using metadata in an extensible and customizable manner.






MDS repository

An application server and Oracle relational database that keep metadata in these areas: a file-based repository, dictionary tables accessed by build-in functions, and a metadata registry. One of the primary uses of MDS is to store customizations and persisted personalization for Oracle applications.






Message Board

In the People Connections service, a feature for posting messages to and receiving messages from other application users.






metadata

Information about a content item, such as title, author, or security group. Metadata is used to describe, find, and group content items. Also referred to as content information.






Model-View-Controller

See MVC.






moderator

A Spaces user who is responsible for managing a particular space. A space moderator can add and remove members, invite new members, enable self registration, provide and update space metadata, and manage the services available to the space.






Movable Box layout component

A layout component available through Composer. A container that enables the placement of content on a page created in the Spaces application. Movable Boxes, along with their content, can be moved around on the page. For designers of Framework applications, this is the runtime equivalent of Show Detail Frame component.






MVC

Model-View-Controller. A classic design pattern often used by applications that need the ability to maintain multiple views of the same data. The MVC pattern hinges on a clean separation of objects into one of three categories: models for maintaining data, views for displaying all or a portion of the data, and controllers for handling events that affect the model or views. Because of this separation, multiple views and controllers can interface with the same model. Even new types of views and controllers that never existed before, such as portlets, can interface with a model without forcing a change in the model design.






My Spaces page

A predefined page that displays a list of all the spaces available to the currently logged in user. The user can select from the Show menu to display All Spaces, only spaces of which the user is a member (Joined by Me), or only spaces of which the user is the moderator (Moderated by Me).






navigation

WebCenter Portal provides three navigation components to create portal navigation. These components are: Breadcrumb navigation, menu navigation, and tree navigation.






navigation model

Navigation models provide data to the navigation user interface and enable navigation to resources in your application, such as pages, page hierarchies, task flows, external sites, portlets, and other entities. You can configure navigation models at both design time and runtime.






Notes service

A WebCenter Portal service that provides useful features for writing personal notes and reminders. This service is available only in Spaces, and not in Framework applications.






Notifications service

A WebCenter Portal service that provides an automated means of triggering notices across different messaging channels, such as phone, mail, Worklist, and so on. Messages are triggered when the spaces and application objects to which you have subscribed change.






Oracle ADF

Oracle Application Development Framework. A range of technologies aimed at making Java EE application development faster and simpler for developers while at the same time taking advantage of proven software patterns to ensure that the developed application is scalable, performant, and the like.






OAM

See Oracle Access Manager (OAM).






OHS

See Oracle HTTP Server (OHS).






OmniPortlet

A component of Oracle WebCenter Portal that enables you to inject portal-like capabilities, such as portlets, content integration, and customization, into your Oracle ADF Faces applications.






Oracle Access Manager (OAM)

Part of Oracle's enterprise class suite of products for identity management and security, Oracle Access Manager provides a wide range of identity administration and security functions, including several single sign-on options for Spaces and Framework applications. OAM is the recommended single sign-on solution for Oracle WebCenter Portal 11g installations.






Oracle ADF Faces

Oracle Oracle ADF Faces is a rich set of user interface components based on the new JavaServer Faces JSR (JSR 127). Oracle ADF Faces provide various user interface components with built-in functionality, such as data tables, hierarchical tables, and color and date pickers, that can be customized and reused in an application.






Oracle WebCenter Content: Content Server

A content repository for building secure business libraries with check in and check out, revision control, and automated publishing in web-ready formats. Current information is available to authorized users anytime, anywhere.

Oracle WebCenter: Content Server is a component of Oracle WebCenter Content.






Oracle WebCenter Portal's Discussions Server

Backend discussions server for the Discussions and Announcements services.






Oracle Enterprise Manager

A component that enables administrators to manage Oracle Fusion Middleware services through a single environment. The Fusion Middleware administrator uses Enterprise Manager to configure, manage, and monitor Framework applications.






Oracle HTTP Server (OHS)

Software that processes web transactions that use the Hypertext Transfer Protocol (HTTP). Oracle uses HTTP software developed by the Apache Group.






Oracle Internet Directory

Oracle's LDAP V3 compliant LDAP server. It is used as a repository for provisioning users and groups. By default, the Oracle Single Sign-On (OSSO) authenticates user credentials against Oracle Internet Directory information about dispersed users and network resources. Oracle Internet Directory combines LDAP version 3 with the high performance, scalability, robustness, and availability of the Oracle database.






Oracle JDeveloper

Oracle JDeveloper is an integrated development environment (IDE) for building applications and web services using the latest industry standards for Java, XML, and SQL. Developers can use Oracle JDeveloper to create Java portlets.






Oracle JSF Portlet Bridge

Based on and conforming to JSR 329, the Oracle JSF Portlet Bridge enables application developers to expose a JSF application or task flow as a JSR 286 portlet for consumption in another application.






Oracle Metadata Services

See MDS.






Oracle Portal

A component used for the development, deployment, administration, and configuration of enterprise class portals. Oracle Portal incorporates a portal building framework with self-service publishing features to enable you to create and manage information accessed within your portal.

See also Oracle WebLogic Portal.






Oracle Secure Enterprise Search (SES)

Provides easy-to-use search for public and secure data, with unified ranking results. With Framework applications, Oracle SES is set as the default and preferred search platform.

With Spaces applications, WebCenter Portal's internal live search adapters are set as the default search platform; however, large-scale implementations should be configured to use Oracle SES for best performance.






Oracle Single Sign-On (OSSO)

A component that enables users to log in to all features of the Oracle Fusion Middleware product suite, and to other web applications, using a single user name and password.






Oracle WebCenter Content's Site Studio

A powerful, flexible web development application suite that offers a comprehensive approach to designing, building, and maintaining enterprise-scale web sites. Site Studio uses Oracle WebCenter Content: Content Server as the main repository for a web site.

In WebCenter, Content Presenter integrates with Site Studio to allow you to create, access, edit, and display Site Studio contributor data files in either a Site Studio region template or a custom Content Presenter display template.






Oracle SOA Suite

A middleware component of Oracle Fusion Middleware. Oracle SOA Suite enables services to be created, managed, and orchestrated into SOA composite applications. Composites enable you to easily assemble multiple technology components into one SOA composite application. Oracle SOA Suite plugs into heterogeneous infrastructures and enables enterprises to incrementally adopt SOA.






Oracle Technology Network

See OTN.






Oracle WebCenter Content

Provides a flexible, secure, centralized, web-based repository that manages all phases of the content life cycle: from creation and approval to publishing, searching, expiration, and archival or disposition. It enables contributors to easily contribute content from native desktop applications, efficiently manage business content through rich library services, and securely access that content anywhere using a web browser. All content, regardless of content type, is stored in the web repository or database for management, reuse and access.






Oracle WebCenter Portal

A suite of services that enables you to build Oracle WebCenter Portal applications. Oracle WebCenter Portal reduces the front-end labor historically required to bring necessary business components to the user by capitalizing on the notion of Service Oriented Architecture (SOA). The suite includes a wide range of plug-and-play products, tools, and services that make it easy to build the applications your users need. Oracle WebCenter Portal includes:

	
Oracle WebCenter Portal services


	
Oracle WebCenter Portal: Framework


	
content integration services


	
Oracle ADF


	
Oracle Secure Enterprise Search (SES)


	
Oracle WebCenter Portal's Discussions Server


	
Mobile Services


	
Portlet Pack









Oracle WebCenter Portal: Framework

A set of features provided by Oracle WebCenter Portal that augments the Java Server Faces (JSF) environment by providing additional integration and runtime customization options. It integrates capabilities historically included in portal products, such as site navigation, page hierarchies, portlets, customization, personalization, and integration, directly into the fabric of the JSF environment. This eliminates artificial barriers for the user and provides the foundation for developing context-rich applications. You can selectively add only desired Oracle WebCenter Portal components or services to your framework application.






Oracle WebCenter Portal's Pagelet Producer

Provides a collection of useful tools and features that facilitate dynamic pagelet development.






Oracle WebCenter Portal services

A collection of Web 2.0 services that expose social networking and personal productivity features through various services.

	
Activity Graph


	
Announcements service


	
Analytics service


	
Discussions service


	
Documents service


	
Events service


	
Instant Messaging and Presence service


	
Links service


	
Lists service


	
Mail service


	
Notes service


	
Notifications service


	
People Connections service


	
Personalization for WebCenter Portal


	
Polls service


	
Recent Activities service


	
RSS service


	
Search service


	
Tags service


	
Worklist service









Oracle WebCenter Portal: Spaces

A WebCenter Portal application built using JSF, Oracle ADF, WebCenter Portal: Framework, WebCenter Portal: Services, and Composer. In the production documentation, it is commonly referred as Spaces application (Spaces).






Oracle WebLogic Server Administration Console

A browser-based, graphical user interface to manage a WebLogic Server domain. Use to:

	
Configure, start, and stop WebLogic Server instances


	
Configure WebLogic Server clusters


	
Configure WebLogic Server services, such as database connectivity (JDBC) and messaging (JMS)


	
Configure security parameters, including creating and managing users, groups, and roles


	
Configure and deploy your applications


	
Monitor server and application performance


	
View server and domain log files


	
View application deployment descriptors


	
Edit selected run-time application deployment descriptor elements









OTN

Oracle Technology Network. The online Oracle technical community that provides a variety of technical resources for building Oracle-based applications. You can access OTN at http://www.oracle.com/technetwork.






Oracle WebLogic Portal

WebLogic Portal enables you to provide a user interface to integrate your applications. WebLogic Portal lets you surface application data and functionality from heterogeneous environments into an integrated, dynamic, and customizable web-based portal user interface that can simultaneously support multiple devices. In addition to a powerful portal framework and its J2EE security foundation, WebLogic Portal provides many business services, such as content management, communities, personalization, search, and user management. WebLogic Portal provides a virtual content repository that lets you federate external content management systems into a single management interface. You can then build portals using content in those external resource. WebLogic Portal also provides a WLP content repository for creating and managing content.






Page Customizable component

A component provided in the Composer tag library that defines the editable area of a page at runtime. Within this area, users can edit properties for a component, add content to the page, arrange content, and so on.






page hierarchy

A model that associates pages in a parent-child relationship, where any page can have one or more sub pages. This parent-child model not only helps define the overall structure of the portal, but also allows child pages to inherit the security policies from their parent.






page parameter

A parameter associated with a page that can be used to store values that can then be passed to the components on the page. It also enables your page to take values through its URL. Page parameters are defined using the <parameter> tag at the top of your PageDef.xml. You can bind page parameters to your page variables.






Page Properties

A dialog, accessed from Composer, that provides access to a page's display options, security settings, and parameters.






page scheme

Determines the background image used in the page. The Spaces application provides several default page schemes and an option for specifying a custom page scheme.






page style

Determines the initial page structure, for example one column or two column. Some default page styles also include the task flows, components, and page properties useful for a particular purpose. For example, a page created using the Text page style includes a Text layout component.






page template

Lets you specify view elements that you intend to be common to all of your pages. A page template file is a JSPX file that includes ADF layout components and other elements. Typically, page templates define a page layout, with headers, footers, and content areas. In addition, the page template usually specifies the positioning and style of the navigation UI for your pages.






page variable

A variable that binds your public portlet parameter to the page. Page variables are defined within the <variableIterator> of your PageDef.xml. One page variable can be bound to multiple public portlet parameters.






Panel Customizable component

A component provided in the Composer tag library that provides a container region for a group of Oracle ADF components and portlets that are customizable at runtime. Any Show Detail Frame components and portlets added as child components to a Panel Customizable component can be moved or maximized with the Panel Customizable component.






parameter

A variable that controls the default behavior of task flow content and facilitates the wiring of a task flow to page parameters and page definition variables.






parent component

A component that contains other components, such as a Box layout component that contains task flows. The Box is the parent component of the task flows. In contrast, the task flows are the Box's child components.

See also Child Components.






participant

A Spaces user who can manipulate the content of a space. A participant can upload and share documents, initiate and take part in chats with other members, create discussion topics, create new or view existing lists.






PDK-Java

Java Portlet Developer Kit. The development framework used to build and integrate web content and applications with Oracle WebCenter Portal. It includes toolkits, samples, and technical articles that help make portal development simple. You can take existing Java servlets, JSPs, URL-accessible content and web services and turn them into portlets. It is typically used by external developers and vendors to create portlets and services.






People Connections service

A WebCenter Portal service that provides social networking tools for creating, interacting with, and tracking the activities of one's enterprise connections.

See also, Activity Stream, Connections, Feedback, Message Board, and Profile.






personalization

Dynamic changes to an application's behavior based on user context, facilitated by Personalization for WebCenter Portal.

See also application customization and user customization






Personalization for WebCenter Portal

A WebCenter Portal service that enables you to deliver content within your application to targeted application users based on selected criteria. Personalization for WebCenter Portal also provides a declarative means for specifying dynamic application flow.






personal page

A page created by a user in his or her Home space. Personal pages are viewable by other users only if specifically granted access by the user who created the page.






personal profile

A page that displays a user's personal information such as email address, phone number, office location, department, manager, direct reports, and so on.

See also, Profile.






Polls service

A WebCenter Portal service that enables you to create, edit, and take online polls on your application pages. Polls let you survey your audience (such as their opinions and their experience level) and check whether they can recall important information, and gather feedback on the efficacy of presentations.






portal

A common interface (that is, a web page) that provides a personalized, single point of interaction with web-based applications and information relevant to individual users or class of users.






portal application template

See application templates.






Portal Developer Kit

See PDK-Java.






portlet

A reusable web component that can draw content from many different sources. Portlets can display excerpts of other web sites, generate summaries of key information, perform searches, and access assembled collections of information from a variety of data sources. Because different portlets can be placed on a common page, the user receives a single-source experience, even though the content may be derived from multiple sources. Portlet resources include the many prebuilt portlets available out of the box and programmatic portlets built through WebCenter's JSR 286, PDK-Java Portlet wizards, and other portlet building tools.






portlet event

A JSR 286 feature that allows portlets to react to actions or state changes not directly related to an interaction of the user with the portlet.






portlet filter

A JSR 286 feature that allows on-the-fly transformations of information in both the request to and the responses from a portlet. A portlet filter is a reusable piece of code that can transform the content of portlet requests and portlet responses.






portlet mode

The ways by which a portlet can be called to display information. These methods include:

	
Shared Screen mode or View mode


	
Edit mode or Edit Defaults mode


	
Customize mode


	
Help mode


	
About mode


	
Full Screen mode (Portlets) or Show Details Page mode









Portlet Producer Application template

An application template, provided by JDeveloper, for creating an application with the recommended projects and technology scopes required for developing portlets. The Portlet Producer Application template consists of a single project scoped for portlet creation (Portlets).

See also Framework application template and producer.






predefined page

A page created by the Spaces application to perform a specific function. Examples of predefined pages include, Welcome pages, Search pages, and Documents pages.






Predeployment Tool

A utility for Framework applications that assists you in configuring your target system with the new producer registrations you have added to your application in Oracle JDeveloper. You must run this utility before deploying your application. You can also use this utility after deployment to migrate metadata from stage to production, for example, to export and import your customizations. This tool also enables you to define the MDS repository location to allow run-time customizations to be migrated.






pretty URL

A shortened version of a page's URL that hides the complexity of the real web address.






private parameter

A portlet parameter that is known only to the portlet itself and has no connection to the page on which the portlet resides.

Contrast with public parameter.






producer

A communication link between portlet consumers (such as a Framework application or a portal). When a consumer application renders a portlet, it calls the producer of that portlet, which in turn executes the portlet and returns the results in the form of portlet content. A producer can contain one or more portlets. A portlet can be contained by only one producer.

Oracle WebCenter Portal supports two types of producers:

	
Oracle PDK-Java producers: Deployed to a Java EE application server, which is often remote and communicates through Simple Object Access Protocol (SOAP) over HTTP.


	
Web Services for Remote Portlets (WSRP): A web services standard that enables the plug-and-play of visual, user-facing web services with portals or other intermediary web applications. Being a standard, WSRP enables interoperability between a standards-enabled container based on a particular language (such as JSR 286, .NET, Perl) and any WSRP portal. A portlet (regardless of language) deployed to a WSRP-enabled container can be rendered in any application that supports this standard.









Profile

In the People Connections service, a feature for viewing and managing information about yourself, such as your contact information, manager, and direct reports, and for viewing this information about other application users.






programmatic portlets

Portlets constructed in a non-declarative manner using APIs. Also referred to as hand- or manually-coded portlets.






public render parameters

A JSR 286 feature that enables portlets to share parameter values, allowing a form of interportlet communication.






public space

A space that is available to all users, even those who are not logged in to the Spaces application.






public page

A page within the Spaces application that is available to all users, even those who are not logged in to the application.






public parameter

A portlet parameter that is known to the page and bound to it by way of a page variable.

Contrast with private parameter.






public user

A user who can access, but is not logged into, a WebCenter Portal application. A public user can view any page that has been marked as public, but cannot personalize or edit any content, or view pages that have any form of access control.

Contrast with authenticated user.






Recent Activities service

A WebCenter Portal service that provides a means of tracking recent activities in a Framework application.






recipe

A weighted list of similarity calculations. The weighting of each calculation determines its significance in deciding the overall recommendation score. Recommendations are ordered by their total recommendation score.






resize handle

A user interface element in a task flow chrome increasing or decreasing the height of the task flow.






resource

Items users can manage through the Resource Manager, like page templates, skins, task flows, navigations, and so on. Spaces categorizes resources under the following categories: Structure, Look and Layout, and Mashups.






Resource Action Handling framework

Enables services that expose custom resources to be viewed, searched, and tagged.






Resource Catalog

A catalog that provides a federated view of one or more otherwise unrelated repositories in a unified search and browse user interface. Resources are created and published in their source repository and are then exposed to the developer in JDeveloper's Resource Palette and to the end user in the Resource Catalog Viewer. Resource catalogs can contain layout components, Oracle ADF components, portlets, service task flows, and documents.






Resource Index

The starting point for accessing WebCenter Portal REST APIs. Sending a GET request to the Resource Index URI returns a list of links to entry points for all available services.






Resource Manager

Enables users with the appropriate privileges to continue developing the portal after the application has been deployed. Using the Resource Manager users can also download runtime portal resources (from Framework applications and Spaces) and import them into Oracle JDeveloper for further development. These resources can then be exported from JDeveloper and uploaded back into the deployed application.






resource type

Defines the type of resource that a WebCenter Portal REST API link identifies. Use resource types to determine the response bodies for GET requests and allowable request bodies for POST and PUT. Also use resourceType attributes on entities to uniquely identify their type.






REST APIs

Oracle WebCenter Portal provides a set of web-based REST (REpresentational State Transfer) APIs for retrieving and modifying server data dynamically from the client. REST APIs are available for Discussions service, People Connections service, and Spaces application (Spaces).






Reverse Proxy Server

A server process that hides the physical location of internal servers by exposing the servers as a single public site. Requests to the public site are routed to the appropriate internal server.






Round-trip development

Round-trip development refers to features and techniques that allow you to retrieve resources from a deployed, runtime portal back to JDeveloper for maintenance or enhancement. After modifying a resource in JDeveloper, you can use the Resource Manager to upload the resource back to the deployed portal. WebCenter Portal's round-trip development features provide a simple, convenient way to modify portal resources without redeploying the entire application.






RSS reader

An RSS reader provided with the Spaces application that incorporates public news feeds from external sources onto application pages. This RSS reader is available only in Spaces, and not in Framework applications.






RSS service

A WebCenter Portal service that provides a means of publishing content from other services as news feeds. The RSS service supports both RSS 2.0 and Atom 1.0 formats.






Search service

A WebCenter Portal service that enables the discovery of information and people in an application, returning only the results users are authorized to see






Secure Enterprise Search

See Oracle Secure Enterprise Search (SES).






secured application page

A page created by a user that has not been made available to public users.






Self-Registration page

A predefined page where users can register with the Spaces application, thus creating themselves an identity store login account. Administrators can customize certain aspects of this page.






Self-Subscription page

A predefined page where users can register to become members of a space. Moderators can customize certain aspects of this page.






service ID

In Expression Language, the string that identifies a particular service. For example, the string oracle.webcenter.collab.announcement is the service ID for the Announcements service.

A PDK-Java producer's unique identifier. PDK-Java enables you to deploy multiple producers under a single adapter servlet. Different producers are identified by their unique service IDs. A service ID is required only when a service ID/producer name is not appended to the URL endpoint.






Service Oriented Architecture

See SOA.






servlet

A Java program that usually runs on a Web server, extending the web server's functionality. HTTP servlets take client HTTP requests, generate dynamic content (such as through querying a database), and provide an HTTP response.






session language

A display language specified by the user that remains in effect for the life of the session cookie (from log on to log off). If the user clears browser cookies, the display language reverts to the user-level default language, if specified, then to the application-level default language set by the Spaces administrator. Set the session language in the Change Language pop-up, accessible from the Welcome page.






Shared Screen mode

A portlet mode that renders the body of the portlet and enables you to display a portlet on a page that can contain other portlets. Every portlet must have at least a Shared Screen mode.

See also View mode.






Show Detail Frame component

A component provided in the Composer tag library that renders a border or chrome around the child component. It provides a header with an Actions menu and thereby providers user interface (UI) controls to customize the display of the child component. However, to customize the display of the child component, the Show Detail Frame component must be included inside a Panel Customizable component.






Show Details Page mode

A portlet mode that provides full-browser display of the portlet. For example, a portlet in Show Page mode could be limited to displaying only the ten most recently submitted expense reports, while the same portlet in Show Details Page mode could show all submissions.

Contrast with Show Page mode.






show modes

Types of portlet modes encompassing Show Page mode and Show Details Page mode.






Show Page mode

A portlet mode that provides a smaller portlet display to allow space for additional portlets and other objects in the browser window. For example, a portlet in Show Page mode could be limited to displaying only the ten most recently submitted expense reports, while the same portlet in Show Details Page mode could show all submissions.

Contrast with Show Details Page mode.






similarity calculation

Used by the Activity Graph service to provide a similarity score (a number between zero and one) that designates how similar two objects are to each other given a specific criterion. The weighting of each calculation determines its significance in deciding the overall recommendation score. Recommendations are ordered by their total recommendation score.






skin

A style sheet based on the CSS 3.0 syntax specified in one place for an entire application. Instead of providing a style sheet for each component, or inserting a style sheet on each page, you can create one skin for the entire application.






SOA

Service Oriented Architecture. A design methodology aimed at maximizing the reuse of application services.






Source view (JDeveloper)

A view, in Oracle JDeveloper, that provides a way to directly edit the source code of a file.






Source view (Spaces)

A view, in Oracle WebCenter Portal's Composer, that provides a selectable structural representation of a page and its components.

See also Design view (Spaces).






space

A work area within Spaces that supports a group of people of any size that is organized around an area of interest or a common goal.






Spaces application (Spaces)

A web-based application that offers the very latest technology for social networking, communication, collaboration, and personal productivity. Spaces uses services and applications to bring everything together that users require to exchange ideas with others, keep track of personal and work-related tasks, interact with critical applications, and zero in on projects and interests; all within a single integrated environment.






space icon

An image displayed alongside space names on the Spaces page in My Spaces to help other users with identification and location.






space logo

An image displayed on the Home space page to provide a visual identity for the space. The Home space logos also display alongside the space name at the top of the page in Full Screen Mode.






space member

A user who is participating in a space. Members can be added or invited to a space, or they can subscribe to a space themselves if self-registration is enabled.






space owner

A user who initially created a space. The space owner is automatically also a moderator of the space.






space template

A starting point for creating a new space. Spaces includes several out-of-the-box templates to get you started, and you can create custom space templates using existing spaces as the basis.






space Unavailable page

A predefined page that displays when a space member tries to open a space that is temporarily offline. Moderators can customize this page.






Spaces application administrator

See administrator.






Spaces Switcher

A menu showing three areas: Recent Spaces lists up to ten recently accessed spaces, followed by spaces to which current user most recently gained access. My Spaces lists all spaces to which the current user has access, in alphabetical order. A list of links provides direct access from the menu to the Home space, the Spaces browser page, and the Create a Space dialog.






struts

A development framework for Java servlet applications based upon the MVC design paradigm.






style properties

Used to override the style information from the skin CSS to set specific instances of component display.






Tags service

A WebCenter Portal service that enables users to apply their own terms to application objects, making it possible to search for those objects using personally meaningful terms.






task flow

A set of ADF Controller activities, control flow rules, and managed beans that interact to allow a user to complete a task. Task flows provide a modular approach for defining control flow in an application. Instead of representing an application as a single JSF page flow, developers can break it up into a collection of reusable task flows.






task flow header

An area at the top of a task flow that displays the task flow name and various tools for interacting with the task flow.






template

See space template, application templates, and custom display template.






Text layout component

A layout component available through Composer. A rich text editor for providing static page text. For designers of Framework applications, this is the runtime equivalent of a Rich Text Editor component.






Unauthorized Access page

A predefined page that is shown when someone without access permission tries to open a page.






URL parameter

See private parameter.






user customization

Changes that affects only a user's own work space.

See also application customization and personalization






validation-based caching

A caching method that uses a validation check to determine if the cached item is still valid.

Contrast with expiry-based caching.






Virtual Content Repository

Virtual Content Repository (VCR) enables you to plug in multiple, heterogeneous content repositories.






viewer

Spaces users who can look at the information in a space but cannot contribute any of their own.






View mode

(JSR 286 portlets only.) A portlet mode that enables you to display a JSR 286 portlet on a page that can contain other portlets. It is the only required mode for JSR 286 portlets.

See also Shared Screen mode.






WAR

Web application archive file. This file is used in deploying applications on a Java EE application server. WAR files encapsulate in a single module all of the components necessary to run an application. WAR files typically contain an application's servlet, JSP, and JSF JSP components.

See also EAR.






Web 2.0

Technologies, such as wiki, RSS, and blogs, that enable the construction of highly interactive web applications.

See also Oracle WebCenter Portal services.






Web Application Archive file

See WAR.






Web Clipping portlet

A browser-based declarative tool that enables you to integrate any web application with your Framework application. It is designed to give you quick integration by leveraging the web application's existing user interface. You can drag and drop Web Clipping portlets onto a *.jspx page.






Web Page layout component

A layout component available through Composer. A means of embedding another web site, wiki, or blog within the context of a page which is created in the Spaces application. For designers of Framework applications, this is the equivalent of an Inline Frame component.






Web server

A program that delivers web pages.






Web Services for Remote Portlets

See WSRP.






WebCenter Portal Application

A WebCenter portal application based on Oracle WebCenter Portal: Framework or Oracle WebCenter Portal: Spaces.






WebCenter Portal's Extension for Oracle JDeveloper

An extension available through the Oracle JDeveloper Update Wizard that installs the necessary libraries, templates, wizards, and dialogs needed to build and deploy Framework applications in Oracle JDeveloper.






WebCenter Portal: Framework

See Oracle WebCenter Portal: Framework.






WebCenter Portal systems administrator

See administrator.






WebLogic Server

See WLS.






Welcome page

There are two types of Welcome page:

	
Public Welcome page: A predefined page that users encounter before logging in to the Spaces application.


	
Personal Welcome page: A predefined page that introduces users to their Home space.









wiki page

A page that provides in-place editing using HTML or a simple mark-up language. Any user with sufficient privileges can add, revise, and remove wiki content.






WLS

WebLogic Server. A scalable, enterprise-ready Java Platform, Enterprise Edition (Java EE) application server. The WebLogic Server infrastructure supports the deployment of many types of distributed applications and is an ideal foundation for building applications based on Service Oriented Architectures (SOA).

See also Integrated WLS






WLST

WebLogic Scripting Tool. A command line tool for managing Oracle Fusion Middleware components, such as Oracle WebCenter Portal.






Worklist service

A WebCenter Portal service that provides access to notifications, alerts, and BPEL tasks assigned to the current user.






WSRP

Web Services for Remote Portlets (WSRP) is a web services standard that allows the plug-and-play of visual, user-facing web services with portals or other intermediary web applications. Being a standard, WSRP enables interoperability between a standards-enabled container based on a particular language (such as JSR 286, .NET, Perl) and any WSRP portal. A portlet (regardless of language) deployed to a WSRP-enabled container can be rendered on any portal that supports this standard.






XSL

Extensible Stylesheet Language (XSL) is the language used within style sheets to transform or render XML documents.
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	Pagination, 32.5.2
	Profile Only, 32.5.2, 32.5.4.8
	Resource Id, 32.5.2
	Service Categories, 32.5.2, 32.5.4.7
	Spaces, 32.5.2






	Add To Favorites
	
	File menu in Document Viewer, 41.5.2.1



	Add to Favorites Spaces component, 13.2.4
	ADF Faces skins, using, 5.7
	Administration component, 13.2.5
	Administration pages
	
	business role pages, 7
	General page, 4.2
	Pages page, 4.2
	personal pages, 7
	Resources page, 4.2
	Security page, 4.2
	Spaces page, 4.2
	system pages, 7



	Administrator role, 20.3.1.1
	
	assigning, 21.1.4
	default application roles, 20.3.1.1



	advanced display options, 18.2.3.2
	advanced permissions (for a space), 52.2.1.2
	Advanced Query
	
	property, 51.16.2.3.1



	Advanced Query property, 32.5.2, 32.5.3
	All Content selection in Resource Catalog, 39.2
	All Modes Shared Screen property, 27.4.2, 28.3.2
	All Saved Searches task flow, 56.2.3.2, 56.3
	Allow Action property, 18.2.2.2
	Allow Links column detail in lists, 64.2.3.2.2
	Allow Minimize property, 17.5.2.5
	Allow Move property, 17.5.2.5
	Allow photo upload property, 30.6.2
	Allow Remove property, 17.5.2.5, 31.5.2, 31.5.3.1
	Allow Resize property, 17.5.2.5
	Allow Status Update property, 30.6.2
	Analytics
	
	about, 55.1
	associated properties, 55.3
	task flow parameters, 55.3



	Analytics business role page, 7.1.1
	Analytics service
	
	See Analytics, 55.3



	Analytics system page, 7.3.1
	Annotate with AutoVue
	
	File menu in Document Viewer, 41.5.2.1



	Announcement Length property, 59.3.2
	announcements
	
	about, 59
	creating, 59.2.2.3
	creating links, 63.2.1.2
	deleting, 59.2.2.5
	editing, 59.2.2.4
	linking, 59.2.5
	sending mail, 59.2.4
	viewing, 59.2.2.1, 59.2.3.1



	Announcements - Quick View task flow
	
	about, 59.2, 59.2.3
	parameters
	
	Announcement Length, 59.3.2
	Content View Only, 59.3.2
	Expand All Announcements in Extended Mini View, 59.3.2
	Forum ID, 59.3.2
	Hide Toolbar, 59.3.2
	Navigate to Announcement Viewer, 59.3.2
	Number of Announcements on Extended Mini View, 59.3.2
	Number of Announcements to Show, 59.3.2
	Number of Expanded Announcements, 59.3.2



	using, 59.2.3
	viewing announcements, 59.2.3.1



	Announcements service
	
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	root category, 6.2.2
	subscribing to, 36.3.2
	task flows
	
	Announcements, 59.2.2
	Quick View, 59.2, 59.2.3






	Announcements system page, 7.3.1
	Announcements task flow
	
	about, 59.2.1, 59.2.2
	adding to a page, 59.2.1
	Announcements page, 59.1
	creating announcements, 59.2.2.3
	deleting announcements, 59.2.2.5
	editing announcements, 59.2.2.4
	parameters
	
	Forum ID, 59.3.2



	personalizing, 59.2.2.2
	using, 59.2.2
	viewing announcements, 59.2.2.1



	anonymous-role, 20.3.1.1
	AppConnectionManager role, 6.5.1
	application administration page URLs, A.5
	Application Navigator, 6.6.3.3
	application password, 35.6
	application permissions, 20.3.2
	application roles, 20.3
	
	Administrator, 20.3.1.1
	anonymous-role, 20.3.1.1
	assigning to enterprise groups, 21.1.2
	assigning to users, 21.1.2
	authenticated-role, 20.3.1.1
	Authenticated-User, 20.3.1.1
	changing users, 21.1.3
	creating, 21.2.2
	custom, 20.3.1.2
	default roles, 20.3.1.1
	deleting, 21.2.6
	granting permissions, 21.2.3
	permissions, 20.3.2
	Public-User, 20.3.1.1
	revoking from a user, 21.1.5



	application skins, using, 5.7
	applications, self-registering to, 29.2
	Application-View permission, granting to Public-User role, 21.2.4
	Archives task flow
	
	parameters
	
	Resource ID, 48.6.2.1






	authenticated-role, 20.3.1.1
	Authenticated-User role
	
	in a space, 52.2.1.1
	in the Home space, 20.3.1.1



	Authentication Method, 6.6.2
	authentication to Microsoft Office files, 41.12.3
	automatic login for external applications, 6.6.2
	AutoVue, 45.3
	
	menu action, 41.5.2.1








B

	Background Color property, 17.5.2.7.2
	background color, pages, 17.3.4
	Background Image property, 17.5.2.7.2
	background image, pages, 17.3.4
	banding
	
	See lists, color banding



	Banner Image URL property, 48.6.3.1
	Banner task flow
	
	parameters
	
	Banner Image URL, 48.6.3.1
	Resource ID, 48.6.3.1
	Title, 48.6.3.1






	BASIC Authentication Method, 6.6.2
	basic display options, 18.2.3.2
	Blank page style, 15.1
	Blog Archives task flow
	
	parameters
	
	Resource ID, 48.6.2.1






	Blog Banner task flow
	
	parameters
	
	Banner Image URL, 48.6.3.1
	Resource ID, 48.6.3.1
	Title, 48.6.3.1






	Blog Main View task flow
	
	parameters
	
	Hide Comments, 48.6.4.1
	Number of blog posts displayed, 48.6.4.1
	Resource ID, 48.6.4.1






	Blog page style, 15.1
	Blog Recent Posts task flow
	
	parameters
	
	Recent Posts List Size, 48.6.6.1






	Blog Recents Posts task flow
	
	parameters
	
	Resource ID, 48.6.6.1






	Blog Viewer task flow
	
	parameters
	
	Filter Month, 48.6.5.1
	Filter Year, 48.6.5.1
	Hide Comments, 48.6.5.1
	Number of blog posts displayed, 48.6.5.1
	Resource ID, 48.6.5.1






	Blogger template, 50.1.1
	blogs
	
	about, 48.2
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	adding to a space, 51.13
	blog posts
	
	about, 48.7.1
	adding links, 47.7, 48.7.5
	adding tags, 48.7.5
	creating, 48.7.2
	deleting, 48.7.5
	downloading, 48.7.5, 48.7.5
	editing, 48.7.4
	liking, 48.7.5
	managing comments, 48.7.5
	managing versions, 48.7.5
	modifying properties, 48.7.5
	opening, 48.7.3
	opening or saving as PDF, 48.7.5
	renaming, 48.7.5
	setting security, 48.7.5
	sharing the URL, 48.7.5
	subscribing, 48.7.5
	unliking, 48.7.5



	commenting, 34.2
	comparing versions, 41.21
	creating
	
	using Blogs task flow, 48.4.1



	directory structure, 48.2.2
	editing in-place, 41.12.3
	enabling functionality, 48.1
	properties
	
	about, 48.6, 48.6.1



	subscribing, 48.5
	subscribing to, 36.3.3.3
	subscriptions, 36.3.2



	bookmarks
	
	See tags
	See also favorites



	Boolean data type in lists, 64.2.3.2.2
	Boolean values, Expression Language, B.1
	borders, changing on components, 17.5.2.7.4
	Bottom Height property, 18.2.10.3
	Box layout component, 18.2.2, 18.2.2.2
	
	about, 18.2.2.1
	display options
	
	Allow Action, 18.2.2.2
	Horizontal Alignment, 18.2.2.2
	Layout, 18.2.2.2
	Short Desc, 18.2.2.2
	Show Component, 18.2.2.2
	Show Split Action, 18.2.2.2
	Show Tab Action, 18.2.2.2
	Vertical Alignment, 18.2.2.2






	browser support in Web Clipping, 28.4
	bulleted layout for OmniPortlet, 27.2.7.4
	Bulleted View display template, 40.5
	Bulleted with Folder Label View display template, 40.5
	business mashups
	
	See mashups



	business role pages, 7.1
	
	about, 7.1.1
	adding to navigation, 7.1.6.2
	choosing the default Resource Catalog, 5.10
	copying, 7.1.9
	creating, 7.1.3
	deleting, 7.1.11
	display order, 7.1.7
	editing, 7.1.8
	granting access, 7.1.4
	making public, 7.1.4.2
	revoking access, 7.1.4.1, 7.1.5
	seeded
	
	Activities, 7.1.1
	Analytics, 7.1.1
	Documents, 7.1.1
	My Profile, 7.1.1
	Space Templates, 7.1.1
	Spaces, 7.1.1
	Tag Center, 7.1.1



	setting page creation defaults, 7.1.2
	specifying a target audience, 7.1.4








C

	Calendar Overlay Style property, 61.3.2
	Calendar Style Class property, 61.3.2
	Calendar Toolbox Layout property, 61.3.3
	Cancel Check Out
	
	file context menu, 41.5.1.7
	File menu, 41.5.1.1



	Cancel Check Out action, 41.12.1
	Carousel View display template, 40.5
	Category ID property, 60.3.2
	Change Membership component, 13.2.6
	character sets, Web Clipping and, 28.4
	chart layout in OmniPortlet, 27.2.7.2
	Check Out
	
	file context menu, 41.5.1.7
	File menu, 41.5.1.1
	File menu in Document Viewer, 41.5.2.1



	child components
	
	about, 17.5.2.2, 17.5.2.6
	hiding, 17.5.2.6.1
	rearranging, 17.5.2.6.2
	showing hidden, 17.5.2.6.1



	Child Creation property, 18.2.10.4
	Chrome Style property, 17.5.2.5
	chrome, components and, 17.5.2.5
	Class URN property, 58.3.2
	Class URN Restrictions property, 58.3.2
	collaboration, documents and, 2.2.5, 45
	collaborative services, 3
	
	about, 3.3.1
	Activity Graph and, 3.3.6
	Announcements service and, 3.3.3
	blogs and, 3.3.8
	commenting and, 3.3.4
	communities and, 3.2
	Discussions service and, 3.3.3
	Events service and, 3.3.3
	instant messaging and, 3.3.5
	liking and, 3.3.4
	Links service and, 3.3.7
	Lists service and, 3.3.9
	People Connections and, 3.3.2
	Polls service and, 3.3.6
	sharing and, 3.3.4
	spaces and, 3.2
	Tags service and, 3.3.7
	wikis and, 3.3.8



	Collapse Tree Navigation property, 42.2.1
	color banding
	
	See lists, color banding



	Color property, 17.5.2.7.2
	Columns
	
	View menu, 41.5.1.2



	columns
	
	hiding, 41.6.1
	reordering, 41.6.2
	showing, 41.6.1



	Comments
	
	View menu in Document Viewer, 41.5.2.2



	comments
	
	application objects and, 34.2
	files and, 41.19



	Comments pane
	
	accessing, 41.1.7, 41.5.1.2



	communities, about, 1.1.2
	component wiring
	
	about, 19.1
	consumer components, 19.1
	page parameters and, 19.3
	portlet to portlet, 19.2.2
	portlet to task flow, 19.2.3
	producer components, 19.1
	task flow to portlet, 19.2.4
	task flow to task flow, 19.2.1
	UI component to task flow, 19.2.5



	components
	
	changing component borders, 17.5.2.7.4
	chrome, 17.5.2.5
	collapsing and expanding, 29.4.2.4
	consumer components, 19.1
	dragging and dropping, 29.4.2.1
	producer components, 19.1
	properties
	
	See properties



	rearranging, 17.5.2.6.2, 29.4.2.1
	removing, 29.4.2.2
	resizing, 29.4.2.3
	setting access on, 23.2
	setting properties on, 17.5.2.3
	wiring, 19



	Composer
	
	EL expressions relating to, B.4.8



	concurrency warning, 17.3.1
	Connection List Name property, 31.5.2, 31.5.3.2
	Connection Name property, 42.2.1, 42.3.1, 42.4.1, 42.5.1, 42.6.1, 42.7.1
	Connections, 31
	
	about, 31.1
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	configuring, 6.4.3.3
	deleting users, 31.4.6
	inviting users to connect, 31.4.2
	lists
	
	adding users to, 31.4.5.2
	creating, 31.4.5, 31.4.5.1
	deleting, 31.4.5.4
	managing, 31.4.5
	removing users from, 31.4.5.3



	preferences, 31.2
	properties, 31.5
	responding to invitations, 31.4.4
	searching, 31.4.1.2
	setting up, 31.4
	subscribing to, 36.3.1
	task flows
	
	about, 31.1
	properties, 31.5, 31.5.2



	troubleshooting, 6.4.5.2
	viewing, 31.4.1.1
	
	pending invitations, 31.4.3.2
	received invitations, 31.4.3.2
	sent invitations, 31.4.3.1






	Connections - Card task flow
	
	about, 31.1
	parameters
	
	Allow Remove, 31.5.2, 31.5.3.1
	Connection List Name, 31.5.2, 31.5.3.2
	Filter Pattern, 31.5.2, 31.5.3.6
	Hide Footer, 31.5.2
	Number of Columns, 31.5.2
	Number of Connections per page, 31.5.2, 31.5.3.4
	Number of Rows, 31.5.2, 31.5.3.5
	Profile Format, 31.5.2, 31.5.3.7
	Profile Launched on Selection, 31.5.2, 31.5.3.8
	Sort Criteria, 31.5.2
	User Name, 31.5.2






	Connections - Detailed View task flow
	
	about, 31.1
	parameters
	
	Number of Connections per page, 31.5.2, 31.5.3.4
	Sort Criteria, 31.5.2
	User Id, 31.5.2






	Connections - Quick View task flow
	
	about, 31.1
	parameters
	
	Hide Footer, 31.5.2
	Hide Header, 31.5.2
	Number of Columns, 31.5.2
	Number of Connections per page, 31.5.2, 31.5.3.4
	Number of Rows, 31.5.2, 31.5.3.5
	User Id, 31.5.2






	Connections task flow
	
	about, 31.1
	parameters
	
	Current View, 31.5.2, 31.5.3.3
	Number of Rows (list layout), 31.5.2, 31.5.3.5
	User Name, 31.5.2






	Contact Administration component, 13.2.7
	Containing Folder Info
	
	View menu, 41.5.1.2



	content
	
	adding, 17.5.1
	adding a content query to a navigation model, 11.2.2.1.2
	adding to a page, 39.1, 41.3
	collaborating on documents, 2.2.5, 45
	creating and managing at runtime, 44
	including in application, 2
	setting properties on, 17.5.2
	stretching, 17.5.2.5



	content management, overview of, 2
	content orientation, 18.2.2.1
	Content page in spaces, 51.8
	Content Presenter Configuration dialog, displaying, 40.3
	Content Presenter task flow
	
	about, 40.1
	adding to a page, 40.2
	Content Presenter Configuration dialog, 40.3
	creating Site Studio files, 40.10.3
	editing HTML files, 40.10.1
	editing Site Studio files, 40.10.2
	editing wikis, 40.10.1
	out-of-the-box display templates, 40.5
	previewing, 40.6
	properties, 40.12
	
	Data Source, 40.12.2
	Data Source Type, 40.12.2
	Maximum Results, 40.12.2
	Region Template, 40.12.2
	Task Flow Instance ID, 40.12.2
	Template Category ID, 40.12.2
	Template View ID, 40.12.2



	selecting
	
	display template, 40.5
	folder contents, 40.4.2
	results of query, 40.4.3
	results of scenario, 40.4.5
	single content item, 40.4.1






	Content Presenter templates, managing, 10.1.1
	content repositories
	
	adding content to a page, 39.1, 41.3
	adding files, 46.3.4.1
	deleting folders and files, 41.16



	content style properties
	
	about, 17.5.2.2, 17.5.2.7, 17.5.2.7.1
	properties
	
	Background Color, 17.5.2.7.2
	Background Image, 17.5.2.7.2
	Color, 17.5.2.7.2
	Font, 17.5.2.7.2
	Font Size, 17.5.2.7.2
	Font Style, 17.5.2.7.2
	Height, 17.5.2.7.2
	Margin, 17.5.2.7.2
	Other CSS, 17.5.2.7.3, 17.5.2.7.3, 17.5.2.7.4
	Width, 17.5.2.7.2



	properties Other CSS, 17.5.2.7.2



	content task flows
	
	See Content Presenter task flow



	Content Type, accessing properties for, 40.4.3, 41.1.2.1, 41.31.2
	Content View Only property, 59.3.2
	context menu
	
	files, 41.5.1.7
	folders, 41.5.1.6



	contextual events, 17.5.2.8
	Control Panel Shown property, 30.6.2
	cookies, Web Clipping and, 28.4
	Copy
	
	file context menu, 41.5.1.7
	File menu, 41.5.1.1
	folder context menu, 41.5.1.6



	Copyright Message component, 13.2.8
	copyright statement
	
	for a space, 51.4.14
	for application, 5.2



	Create Page component, 13.2.9
	Create Space component, 13.2.10
	Create Subspace component, 13.2.11
	Created After property, 42.3.1
	Created Before property, 42.3.1
	Creator property, 42.3.1
	credential provisioning
	
	public credentials, 6.6.2
	shared credentials, 6.6.2



	CSS
	
	Other CSS property, 17.5.2.7.2
	pages, 17.3.4
	Web Clipping and, 28.4
	See also Other CSS property



	Current User Profile component, 13.2.12
	Current View property, 31.5.2, 31.5.3.3
	Custom Attributes property, 56.7.3
	custom attributes, in spaces, 51.12
	Customization ID property, 61.3.2, 61.3.3
	customizations
	
	application, 17.5.2.1
	lists and, 64.2.5
	user, 17.5.2.1, 29.4.1
	Web Clipping, 28.2.2
	See also, user customizations



	Cut
	
	file context menu, 41.5.1.7
	File menu, 41.5.1.1
	folder context menu, 41.5.1.6








D

	data controls, 26.1.1
	Data Source property, 40.12.2
	Data Source Type property, 40.12.2
	data sources
	
	filtering data, 27.2.5
	using a spreadsheet, 27.2.4.3
	using an existing web page, 27.2.4.7
	using SQL, 27.2.4.4
	using web services, 27.2.4.6
	using with OmniPortlet, 27.2.4
	using with portlets, 27.2.3
	using XML, 27.2.4.5



	data, filtering portlet, 27.2.5
	database connection
	
	about, 6.1
	creating, 6.1



	database connection, OmniPortlet and, 27.2.4.2
	databases, list sorting and, 64.2.5.1
	date preference, 35.3
	DateTime data type in lists, 64.2.3.2.2
	Default Current Date property, 61.3.2
	Default Document Details View display template, 40.5
	Default List Item View display template, 40.5
	default navigation model, 11.2.4
	Default Value column detail in lists, 64.2.3.2.2
	Default View display template, 40.5
	Delete
	
	file context menu, 41.5.1.7
	File menu, 41.5.1.1
	folder context menu, 41.5.1.6



	Delete Page permission, 23.1, 38.2.1
	Depressed Icon property, 13.2.2.1, 18.2.7.2
	Design view
	
	deleting layout components in, 18.3.1
	page edit mode in, 17.3.2



	design-time defined, 19.1
	Destination property, 18.2.6.2, 18.2.7.2, 42.12.1
	Details
	
	file context menu, 41.5.1.7
	folder context menu, 41.5.1.6
	View menu, 41.5.1.2



	Dimensions From property, 18.2.10.4
	Disable Personalize and Customize property, 61.3.2
	Disabled Icon property, 13.2.2.1, 18.2.7.2
	Disclosed property, 18.2.10.6
	discoverable spaces, 51.14.3
	Discussion Forums task flow
	
	about, 60.1
	parameters
	
	Category ID, 60.3.2
	Do Not Allow Selecting Number of Topics Fetched, 60.3.2
	Number of Topics Fetched, 60.3.2
	Show Categories, 60.3.2
	Show Recursive Forums, 60.3.2






	Discussion Site template, 50.1.1
	discussions
	
	about, 60.1
	access to, 60.1
	adding to a watch list, 60.2.4.1
	categories, 60.1
	character limits, 60.2.7
	creating, 60.2.6
	creating links, 63.2.1.3, 63.2.2.2
	editing name and description, 60.2.7
	forums, 60.1
	hiding additional information, 60.2.3
	permissions, 20.3.2
	publishing space mail in, 51.10.4
	removing from a watch list, 60.2.4.2
	root category on server, 6.2.2
	sending mail, 60.2.5
	showing additional information, 60.2.3
	topics
	
	deleting posts, 60.2.2.5
	deleting replies, 60.2.2.5
	editing posts, 60.2.2.4
	editing replies, 60.2.2.4
	posting, 60.2.2.1
	replying to, 60.2.2.2
	view modes, 60.2.2.7
	viewing posts, 60.2.2.3
	viewing replies, 60.2.2.3
	watching, 60.2.4



	watching forums, 60.2.4



	Discussions - Popular Topics task flow
	
	about, 60.1, 60.2.3.2
	parameters
	
	Category ID, 60.3.2
	Forum ID, 60.3.2
	Hide Toolbar, 60.3.2






	Discussions - Quick View task flow
	
	about, 60.1
	parameters
	
	Category ID, 60.3.2
	Do Not Show More Link, 60.3.2






	Discussions - Recent Topics task flow
	
	about, 60.1, 60.2.3.3
	parameters
	
	Category ID, 60.3.2
	Forum ID, 60.3.2
	Hide Toolbar, 60.3.2






	Discussions - Watched Forums task flow
	
	about, 60.1, 60.2.3.4
	parameters
	
	Category ID, 60.3.2
	Hide Toolbar, 60.3.2






	Discussions - Watched Topics task flow
	
	about, 60.1, 60.2.3.5
	parameters
	
	Category ID, 60.3.2
	Forum ID, 60.3.2
	Hide Toolbar, 60.3.2






	Discussions server
	
	role mapping, 20.3.2.2



	discussions server
	
	about, 60.1



	Discussions service, 60
	
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	permissions, 20.3.2
	root category, 6.2.2
	subscribing to topics, 36.3.3.4
	subscriptions, 36.3.2
	task flows
	
	Discussion - Quick View, 60.1
	Discussion Forums, 60.1
	Popular Topics, 60.1, 60.2.3.2
	Recent Topics, 60.1, 60.2.3.3
	Watched Forums, 60.1, 60.2.3.4
	Watched Topics, 60.1, 60.2.3.5






	Discussions system page, 7.3.1
	discussions task flows
	
	adding to a page, 60.2.1



	Display Header property, 17.5.2.5
	Display Message Size property, 33.5.2, 33.5.3.3
	display name
	
	changing for space, 51.4.1
	viewing space, 49.5
	viewing space template, 50.3.2



	display options
	
	about, 17.5.2.2, 17.5.2.5
	basic and advanced, 18.2.3.2
	Box layout component, 18.2.2.2
	component, 17.5.2.5
	EL editor, 17.5.2.5, B.1
	HTML Markup layout component, 18.2.4.2
	Hyperlink layout component, 18.2.6.2
	Image layout component, 18.2.7.2
	Movable Box layout component, 18.2.3.2
	panelGroupLayout layout component, 18.2.10.2
	panelStretchLayout layout component, 18.2.10.3
	panelTabbed layout component, 18.2.10.4
	properties
	
	Allow Action, 18.2.2.2
	Allow Minimize, 17.5.2.5
	Allow Move, 17.5.2.5
	Allow Remove, 17.5.2.5
	Allow Resize, 17.5.2.5
	Bottom Height, 18.2.10.3
	Child Creation, 18.2.10.4
	Chrome Style, 17.5.2.5
	Depressed Icon, 13.2.2.1, 18.2.7.2
	Destination, 18.2.6.2, 18.2.7.2
	Dimensions From, 18.2.10.4
	Disabled Icon, 13.2.2.1, 18.2.7.2
	Disclosed, 18.2.10.6
	Display Header, 17.5.2.5
	Display Shadow, 17.5.2.5
	Display Type, 13.2.2.1
	End Width, 18.2.10.3
	Favorite Title, 13.2.4.1
	Favorite URL, 13.2.4.1
	Font, 17.5.2.5
	Font Color, 17.5.2.5
	Font Size, 17.5.2.5
	Font Style, 17.5.2.5
	Halign, 18.2.10.2
	Height, 18.2.10.7
	Horizontal Alignment, 18.2.2.2
	Hover Icon, 13.2.2.1, 18.2.7.2
	Icon, 13.2.2.1, 18.2.7.2, 18.2.10.6
	Icon Position, 13.2.2.1, 18.2.7.2
	Inflexible Height, 18.2.10.6
	Inline Style, 13.2.8.1
	Landmark, 18.2.10.2
	Layout, 18.2.2.2, 18.2.10.2
	Open in new window, 18.2.6.2
	Position, 18.2.10.4
	Scope Name, 13.2.2.1
	Short Desc, 13.2.2.1, 17.5.2.5, 18.2.2.2, 18.2.4.2, 18.2.7.2, 18.2.9.2, 18.2.10.2, 18.2.10.3, 18.2.10.4, 18.2.10.6, 18.2.10.7
	Show Actions On Hover, 17.5.2.5
	Show Component, 13.2.2.1, 17.5.2.5, 18.2.2.2, 18.2.4.2, 18.2.6.2, 18.2.7.2, 18.2.9.2, 18.2.10.2, 18.2.10.3, 18.2.10.4, 18.2.10.6, 18.2.10.7
	Show Label, 13.2.25.1
	Show Split Action, 18.2.2.2
	Show Tab Action, 18.2.2.2
	Source, 18.2.9.2
	Start Width, 18.2.10.3
	Stretch Content, 17.5.2.5
	Tab Removal, 18.2.10.4
	Target Frame, 18.2.7.2
	Task Flow Id, 13.2.9.1
	Text, 13.2.2.1, 17.5.2.5, 18.2.7.2, 18.2.10.6
	Text And Access Key, 18.2.7.2
	Theme, 18.2.10.2, 18.2.10.3
	Title, 18.2.6.2
	Top Height, 18.2.10.3
	Type, 13.2.3.1
	Valign, 18.2.10.2
	Value, 18.2.4.2
	Vertical Alignment, 18.2.2.2
	Width, 18.2.10.7



	separator layout component, 18.2.10.7
	showDetailFrame layout component, 18.2.10.5
	sidebarItem layout component, 18.2.10.6
	spacer layout component, 18.2.10.7
	Text layout component, 18.2.8.2
	validating expressions, B.1
	Web Page layout component, 18.2.9.2



	Display Shadow property, 17.5.2.5
	Display Style property, 11.3.2.2
	Display Tool Bar property, 51.16.2.3.1
	Display Type property, 13.2.2.1
	Display View property, 51.16.2.3.1
	Display Width column detail in lists, 64.2.3.2.2
	Do Not Allow Selecting Number of Topics Fetched property, 60.3.2
	Do Not Show More Link property, 60.3.2
	document components, about, 41.2
	Document Exchange template, 50.1.1
	Document Explorer task flow, 42.2.1
	
	about, 41.1.1
	parameters
	
	Collapse Tree Navigation, 42.2.1
	Connection Name, 42.2.1
	Features Off, 42.2.1
	Read Only, 42.2.1
	Resource ID, 42.2.1
	Show Documents, 42.2.1
	Show Folders, 42.2.1
	Start Folder Path, 42.2.1






	Document List Viewer task flow
	
	about, 41.1.2
	parameters
	
	Connection Name, 42.3.1
	Created After, 42.3.1
	Created Before, 42.3.1
	Creator, 42.3.1
	Last Modified After, 42.3.1
	Last Modified Before, 42.3.1
	Last Modifier, 42.3.1
	Root Folder Path, 42.3.1
	Show Folders, 42.3.1
	Task Flow Instance ID, 42.3.1






	Document Manager task flow
	
	about, 41.1.3
	parameters
	
	Connection Name, 42.4.1
	Features Off, 42.4.1
	layout, 42.4.1
	Page Size, 42.4.1
	Read Only, 42.4.1
	Resource ID, 42.4.1
	Start Folder Path, 42.4.1






	Document Mini Properties task flow
	
	about, 41.1.8
	parameters
	
	Resource ID, 42.9.1






	Document Navigator task flow
	
	about, 41.1.4
	parameters
	
	Connection Name, 42.5.1
	Page Size, 42.5.1
	Read Only, 42.5.1
	Resource ID, 42.5.1
	Show Documents, 42.5.1
	Start Folder Path, 42.5.1






	Document Properties task flow
	
	about, 41.1.9
	parameters
	
	Item ID property, 42.10.1
	Read Only, 42.10.1






	Document Version History task flow
	
	about, 41.1.10
	parameters
	
	Item ID, 42.11.1, 42.11.1
	Read Only, 42.11.1






	Document Viewer preview pane
	
	menu actions, 41.5.2



	Document Viewer task flow
	
	about, 41.1.7
	parameters
	
	Features Off, 42.8.1
	Initial Sidebar property, 42.8.1
	Item ID property, 42.8.1
	Read Only property, 42.8.1






	documents
	
	adding to navigation model, 11.2.2.1.1
	applying tags to, 57.2.4
	commenting on, 34.2
	creating links, 63.2.1.4, 63.2.2.3
	liking, 34.1
	subscribing to, 36.3.2



	Documents business role page, 7.1.1
	Documents service
	
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	blogs, subscribing to, 36.3.2
	EL expressions relating to, B.4.12
	parameters
	
	Features Off, 42.5.1
	Page Size, 42.3.1



	properties
	
	Data Source, 40.12.2
	Data Source Type, 40.12.2
	Maximum Results, 40.12.2
	Region Template, 40.12.2
	Task Flow Instance ID, 40.12.2
	Template Category ID, 40.12.2
	Template View ID, 40.12.2



	task flows
	
	about, 41.1
	adding to a page, 41.4
	Document Explorer, 41.1.1, 42.2
	Document List Viewer, 41.1.2, 42.3
	Document Manager, 41.1.3, 42.4
	Document Mini Properties, 41.1.8, 42.9
	Document Navigator, 41.1.4, 42.5
	Document Properties, 41.1.9, 42.10
	Document Version History, 41.1.10, 42.11
	Document Viewer, 41.1.7
	Document Viewerr, 42.8
	File menu, 41.5.1.1
	Folder Viewer, 41.1.5, 42.6
	Recent Documents, 41.1.6, 42.7
	setting properties, 42
	View menu, 41.5.1.2
	See also Content Presenter task flow



	wikis, subscribing to, 36.3.2
	task flowsSee also files



	Documents Service task flows
	
	menus and actions, 41.5



	Documents system page, 7.3.1
	Download
	
	file context menu, 41.5.1.7



	Download action, 41.5.1.5
	
	in Document Viewer, 41.5.2.5



	Download PDF
	
	View menu in Document Viewer, 41.5.2.2



	dragging and dropping files and folders, 41.14, 41.15
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	Edit
	
	file context menu, 41.5.1.7
	File menu, 41.5.1.1



	Edit action
	
	in Document Viewer, 41.5.2.3



	Edit Defaults mode in OmniPortlet, 27.2.8
	Edit Mode property, 30.6.2
	Edit Page component, 13.2.13
	Edit Page permission, 23.1, 38.2.1
	Edit Web Content, 40.6
	editors
	
	rich text, 18.2.8.1
	simple text, 18.2.4.1
	See also EL editor



	EL editor, 17.5.2.4, 17.5.2.5, B.1
	EL expressions, B
	
	application pages, B.4.7
	Composer, B.4.8
	Documents service, B.4.12
	event contexts, B.4.9
	example, B.2
	navigation operations, B.4.4
	People Connections service, B.4.13
	Personalization Conductor, B.4.11
	Profile, B.4.13
	resources, B.4.5
	security, B.4.3
	seeded, B.4.1
	
	Application Info, B.4.1.1
	Page Info, B.4.1.2
	Page Parameter, B.4.1.3
	Resource Info, B.4.1.4
	Space Info, B.4.1.5
	Space Page Info, B.4.1.6
	System, B.4.1.7
	User Info, B.4.1.8
	WebCenter Events, B.4.1.9



	service IDs, B.4.10
	services, B.4.10
	spaces, B.4.6
	Spaces application, B.4.2
	use case, B.2
	user preferences, B.4.14
	utilitarian, B.4.15
	validating, B.1
	value formats, B.1



	Enable Action property, 17.5.2.8
	Enable Context Info property, 32.5.2
	End Date property, 33.5.2, 33.5.3.7
	End Width property, 18.2.10.3
	enterprise groups, assigning to roles, 21.1.2
	Error Encountered system page, 7.3.1
	Escape property, 18.2.4.2
	event contexts, EL expressions relating to, B.4.9
	Event Text Length property, 61.3.3
	events
	
	about, 61.1
	calendar overlay, 61.2.7
	canceling, 61.2.6
	categorizing, 61.2.4
	contextual events, 17.5.2.8
	creating, 61.2.4
	creating links, 63.2.1.5, 63.2.2.4
	deleting, 61.2.6
	displaying multiple calendars, 61.2.7
	editing, 61.2.5
	Events page, 61.1.2, 61.2.3.1, 61.2.3.1
	Events tab, 17.5.2.8
	filtering by category, 61.2.3.4
	list view, configuring, 61.2.3.5.3
	personal calendar, 61.2.2
	prioritizing, 61.2.4
	refreshing, 61.2.3.2
	scheduling, 61.2.4
	secondary time zone, 61.2.3.5.2
	selecting display mode, 61.2.3.2
	setting display preferences, 61.2.3.5
	view by
	
	day, 61.2.3.2
	list, 61.2.3.2
	month, 61.2.3.2
	specific date, 61.2.3.2
	today, 61.2.3.2
	week, 61.2.3.2



	viewing, 61.1.2
	viewing details, 61.2.3.3



	Events - Mini View task flow
	
	parameters
	
	Calendar Toolbox Layout, 61.3.3
	Customization ID, 61.3.3
	Event Text Length, 61.3.3
	List Events in Number of Upcoming Days, 61.3.3
	Number of Events Per Page, 61.3.3
	Using ADF Calendar Component, 61.3.3






	Events page
	
	about, 61.1.2
	displaying, 61.2.3.1
	hiding, 61.2.3.1
	See also events



	events properties
	
	about, 17.5.2.2, 17.5.2.8
	properties
	
	Action Handlers, 17.5.2.8
	Actions, 17.5.2.8
	Enable Action property, 17.5.2.8
	Events, 17.5.2.8






	Events service
	
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	subscriptions, 36.3.2
	task flows, 61.2
	See also events



	Events system page, 7.3.1
	Events tab, 17.5.2.8
	Events task flow
	
	about, 61.1.2
	editing properties, 61.3
	parameters
	
	Calendar Overlay Style, 61.3.2
	Calendar Style Class, 61.3.2
	Customization ID, 61.3.2
	Default Current Date, 61.3.2
	Disable Personalize and Customize, 61.3.2
	Group Space, 61.3.2
	Maximum Calendars, 61.3.2
	Maximum Enabled Calendars, 61.3.2



	See also events



	Excel
	
	See Microsoft Office



	Exclude Object Actions property, 58.3.2
	Expand All Announcements in Extended Mini View property, 59.3.2
	Explorer
	
	See Microsoft Windows Explorer



	export and import
	
	space templates, 53.5
	spaces, 53.5



	Expression Language
	
	See EL expressions



	Expression Language editor
	
	See EL editor



	External Application ID property, 68.4.2
	external applications
	
	adding to a navigation model, 11.2.2.1.3
	additional login fields, 6.6.2
	deleting, 6.6.4
	launching from Applications Navigator, 6.6.3.3
	login preferences, 35.7
	registering, 6.6.2
	task flows, 6.6.3.3
	
	adding to a page, 6.6.3.1
	registering, 6.6.3.2
	required permissions, 6.6.3
	setting properties of, 6.6.3.5











F

	Favorite Title property, 13.2.4.1
	Favorite URL property, 13.2.4.1
	favorites, 37
	
	about, 37.1
	accessing, 37.2
	Add to Favorites component, 13.2.4
	adding folders, 37.4, 37.5.2
	adding links, 37.3, 37.5.1
	deleting folders, 37.5.6
	deleting links, 37.5.6
	editing folders, 37.5.3
	editing links, 37.5.3
	Favorites Menu component, 13.2.14
	making discoverable, 37.3
	managing, 37.5
	rearranging folders, 37.5.4
	rearranging links, 37.5.4
	searching, 37.5.5
	setting open behavior, 37.5.3
	sharing, 37.3



	Favorites Menu component, 13.2.14
	Features Off property, 42.2.1, 42.4.1, 42.5.1, 42.6.1, 42.8.1
	Feedback, 33
	
	about, 33.1.2
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	configuring, 6.4.3.6
	deleting, 33.4.2.3
	enabling others to post, 33.3
	filtering, 33.4.2.1.2
	hiding, 33.4.2.1.3
	marking as private, 33.4.2.1.5
	posting, 33.4.2.2
	preferences, 33.2.2
	properties, 33.5, 33.5.1
	showing hidden, 33.4.2.1.4
	sorting, 33.4.2.1.2
	subscribing to, 36.3.1
	task flows
	
	about, 33.1.2
	properties, 33.5, 33.5.1, 33.5.2
	working with, 33.4.2



	troubleshooting, 6.4.5.5
	viewing, 33.4.2.1
	
	posted, 33.4.2.1.1
	received, 33.4.2.1.1






	Feedback - Quick View
	
	parameters
	
	User Id, 33.5.2






	Feedback - Quick View task flow
	
	about, 33.1.2
	parameters
	
	Display Message Size, 33.5.2, 33.5.3.3
	End Date, 33.5.2, 33.5.3.7
	Hide Actions, 33.5.2, 33.5.3.1
	Hide Footer, 33.5.2
	Hide Given, 33.5.2, 33.5.3.5
	Hide Header, 33.5.2
	No of Feedback Items, 33.5.2, 33.5.3.2
	Start Date, 33.5.2, 33.5.3.7






	Feedback task flow
	
	about, 33.1.2
	parameters
	
	End Date, 33.5.2, 33.5.3.7
	Hide Given, 33.5.2, 33.5.3.5
	Hide Header, 33.5.2
	No of Feedback Items, 33.5.2, 33.5.3.2
	Resource Id, 33.5.2
	Start Date, 33.5.2, 33.5.3.7






	File menu
	
	Documents service task flows, 41.5.1.1
	in Document Viewer, 41.5.2.1



	files
	
	adding tags, 41.20
	adding to a page, 41.3
	adding to space
	
	in Documents service task flows, 41.8.1
	using Microsoft Office integration, 46.3.4.1



	checking in
	
	using Microsoft Office integration, 46.3.4.4



	checking out
	
	cancelling, 41.12.1, 41.12.1
	in Documents service task flows, 41.12.1
	using Microsoft Office integration, 46.3.4.3



	closing in Microsoft Office, 46.3.5
	commenting on, 41.19
	context menu, 41.5.1.7
	copying and pasting, 41.14
	creating, 41.8
	deleting, 41.16
	downloading, 41.12.2
	drag and drop, 41.14, 41.15
	editing and updating, 41.12
	editing in-place, 41.12.3
	liking, 41.29, 41.30
	linking to other items, 41.23
	mailing URL, 41.26.2
	mime types previewed in Activity Stream, 32.5.4.2
	moving, 41.15
	opening
	
	as PDF, 41.10, 41.25
	in browser, 41.10
	in Documents service task flows, 41.10
	using Microsoft Office, 46.3.2



	publishing URL, 41.26.3
	recommendations to other documents, 41.24
	renaming, 41.13
	saving local to space, 46.3.4.1.1
	saving PDF, 41.25
	searching, 41.31
	security, 41.27
	sharing, 41.26.3
	sharing through Publisher, 34.3
	sharing through Publisher task flow, 34.3.3.3
	sorting, 41.6.3
	subscribing to, 36.3.3.1, 41.28
	unliking, 41.29, 41.30
	uploading, 41.8.1
	uploading new version, 41.12.4
	URL to, 41.26.1, 41.26.2
	viewing
	
	information using Microsoft Office, 46.3.4.9
	properties of, 41.22
	version history in Documents service task flows, 41.21
	version history using Microsoft Office integration, 46.3.4.10






	Filter Month property, 48.6.5.1
	Filter Pattern property, 31.5.2, 31.5.3.6
	Filter property, 51.16.2.3.1
	Filter Year property, 48.6.5.1
	first page, selecting, 5.6
	Folder Viewer task flow
	
	about, 41.1.5
	parameters
	
	Connection Name, 42.6.1
	Features Off, 42.6.1
	Page Size, 42.6.1
	Read Only, 42.6.1
	Resource ID, 42.6.1
	Show Folders, 42.6.1
	Start Folder Path, 42.6.1






	folders
	
	adding to a page, 41.3
	context menu, 41.5.1.6
	creating, 41.7
	
	using Microsoft Office integration, 46.3.4.2



	deleting, 41.16
	drag and drop, 41.14, 41.15
	hiding and showing, 41.18
	managing using Microsoft Office, 46.3.4.7
	moving, 41.15
	opening, 41.9
	properties of, 41.22
	refreshing contents, 41.17
	renaming, 41.13
	searching, 41.31
	sorting, 41.6.3
	URL to, 41.26.1, 41.26.2



	folksonomies, tagging and, 57.1.1
	Font Color property, 17.5.2.5
	Font property, 17.5.2.5, 17.5.2.7.2
	Font Size property, 17.5.2.5, 17.5.2.7.2
	Font Style property, 17.5.2.5, 17.5.2.7.2
	footer, adding to a page, 17.3.5.2
	Format column detail in lists, 64.2.3.2.2
	forms layout in OmniPortlet, 27.2.7.5
	Forum ID property, 59.3.2, 60.3.2
	framesets in Web Clipping, 28.4
	framework application roles, 20.3.1.2





G

	General page
	
	space administration, 51.4



	Get a Link
	
	file context menu, 41.5.1.7
	folder context menu, 41.5.1.6
	View menu, 41.5.1.2
	View menu in Document Viewer, 41.5.2.2



	GET Authentication Method, 6.6.2
	Get Updates, in MS Office task pane, 46.3.4
	Global Help component, 13.2.15
	Global Help URL, 5.3
	global search field, 56.2
	globalization support in Web Clipping, 28.4
	Group Space Name property, 69.3.2
	Group Space property, 33.5.2, 33.5.3.6, 61.3.2
	group spaces
	
	See spaces



	GUID
	
	of page, 29.9.2
	of space, 29.9.1








H

	Halign property, 18.2.10.2
	headers
	
	adding to a page, 17.3.5.2
	Display Header property, 17.5.2.5



	Height property, 17.5.2.7.2, 18.2.10.7
	help
	
	accessing online, 29.11
	Global Help component, 13.2.15
	Help link, 5.3



	Hide Actions property, 33.5.2, 33.5.3.1, 36.5.3.2, 36.5.3.3
	Hide Attach Links property, 34.3.3.5.2
	Hide Comments property, 32.5.2, 32.5.4.3, 48.6.4.1, 48.6.5.1
	Hide Configuration Button property, 32.5.2, 32.5.4.1
	Hide Document Uploader property, 34.3.3.5.2, 34.3.3.5.3
	Hide Folders
	
	View menu, 41.5.1.2



	Hide Footer property, 31.5.2, 32.5.2, 33.5.2
	Hide Given property, 33.5.2, 33.5.3.5
	Hide Header property, 31.5.2, 32.5.2, 33.5.2
	Hide Inline Preview property, 32.5.2, 32.5.4.2
	Hide Like property, 32.5.2, 32.5.4.4
	Hide Publisher property, 33.5.2, 33.5.3.4
	Hide Share property, 32.5.2, 32.5.4.5
	Hide Sharing Picker property, 34.3.3.5.2
	Hide Toolbar property, 59.3.2, 60.3.2
	Hint column detail in lists, 64.2.3.2.2
	History pane
	
	accessing, 41.1.7, 41.5.1.2



	Home Page page style, 15.1
	Home space
	
	about, 1.1.1
	about, 29.1
	adding as Windows network place, 46.4.1
	adding space pages to, 49.19, 51.7.10
	choosing default page template, 5.8, 5.9
	choosing default Resource Catalog template, 5.10
	clearing deleted space page, 29.5, 49.19
	disabling the presence of, 5.12
	enabling the presence of, 5.12
	exposing space pages in, 29.5
	in Windows Explorer, 46.4.1
	managing files using Microsoft Office, 46.3.4.6
	navigating to, 29.3.1
	pages
	
	controlling access, 38.2, 38.2.1
	copying, 38.4
	creating in, 38.1.2
	deleting, 38.5
	editing, 38.3
	page creation defaults, 38.1.1
	revoking access, 38.2.2
	securing, 38.2, 38.2.1



	pretty URLs, A.2
	printing pages, 29.8
	renaming a page, 29.6
	saving local file to, 46.3.4.1.1
	user interface URLs, A.2



	Home Space component, 13.2.16
	Horizontal Alignment property, 18.2.2.2
	Hover Icon property, 13.2.2.1, 18.2.7.2
	HTML files
	
	editing in-context in Content Presenter, 40.10.1
	editing in-place, 41.12.3



	HTML Markup layout component
	
	about, 18.2.4
	display options, 18.2.4.2
	
	Escape, 18.2.4.2
	No Wrap, 18.2.4.2
	Short Desc, 18.2.4.2
	Show Component, 18.2.4.2
	Value, 18.2.4.2



	embedding media, 18.2.4.3



	Hyperlink layout component, 18.2.6.2
	
	about, 18.2.6.1
	display options
	
	Destination, 18.2.6.2
	Open in new window, 18.2.6.2
	Show Component, 18.2.6.2
	Title, 18.2.6.2











I

	Icon Position property, 13.2.2.1, 18.2.7.2
	Icon property, 13.2.2.1, 18.2.7.2, 18.2.10.6
	Icon View display template, 40.5
	icon, changing for a space, 51.4.7
	Id property, 27.4.2, 28.3.2
	IDC:GlobalProfile, 40.4.3, 41.1.2.1, 41.31.2
	Image layout component, 18.2.7, 18.2.7.2
	
	about, 18.2.7
	display options
	
	Depressed Icon, 18.2.7.2
	Destination, 18.2.7.2
	Disabled Icon, 18.2.7.2
	Hover Icon, 18.2.7.2
	Icon, 18.2.7.2
	Icon Position, 18.2.7.2
	Short Desc, 18.2.7.2
	Show Component, 18.2.7.2
	Target Frame, 18.2.7.2
	Text, 18.2.7.2
	Text And Access Key, 18.2.7.2






	Image Map Type property, 42.14.1
	Image Size property, 30.6.2
	images
	
	document image component, 41.2
	document image properties, 42.14
	
	Image Map Type, 42.14.1
	Long Desc URL, 42.14.1
	Short Desc, 42.14.1
	Show Component, 42.14.1
	Source, 42.14.1



	Image layout component, 18.2.7, 18.2.7.2
	in search results, 18.2.7



	IMP service
	
	about, 62.1
	Microsoft LCS, 62.4.3
	Microsoft Lync, 62.4.3
	Microsoft OCS, 62.4.3
	Presence icon, 62.1
	Presence icon context menu, 62.1
	presence states, 62.4.1
	sending instant messages, 62.4.3
	sending mail, 62.4.2
	status message, 62.4.1
	viewing user presence, 62.4.1



	import and export
	
	space templates, 53.5
	spaces, 53.5
	subspaces, 54.7.2



	Inflexible Height property, 18.2.10.6
	Info
	
	View menu in Document Viewer, 41.5.2.2



	Info pane
	
	accessing, 41.1.7, 41.5.1.2



	Initial Sidebar property, 42.8.1
	inline frames
	
	properties
	
	Short Desc, 42.13.1
	Show Component, 42.13.1
	Source, 42.13.1






	inline frames properties, 41.2
	Inline Style property, 13.2.8.1
	Instant Messaging and Presence (IMP)
	
	See IMP



	internal ID of a space, 49.5
	internal ID of space template, 50.3.2
	internal layout components, 18.2.10.1
	
	panelGroupLayout, 18.2.10.1, 18.2.10.2
	panelStretchLayout, 18.2.10.1, 18.2.10.3
	panelTabbed, 18.2.10.1, 18.2.10.4
	separator, 18.2.10.7
	showDetailFrame, 18.2.10.1, 18.2.10.5
	sidebarItem, 18.2.10.1, 18.2.10.6
	spacer, 18.2.10.1, 18.2.10.7



	internal name of a space, 49.5
	internal name of space template, 50.3.2
	Invite People as Connection component, 13.2.17
	Is Update Status property, 34.3.3.5.2, 34.3.3.5.5
	ISO-8859-1 character set, 28.4
	Item ID property, 42.8.1, 42.10.1, 42.11.1, 42.11.1





J

	JavaBeans, Expression Language, B.1
	JavaScript
	
	HTML Markup layout component and, 18.2.4.1
	Web Clipping and, 28.4



	JAWS, 35.4
	Join Space component, 13.2.18
	JSF portlets, 25.4.2





K

	Keep open the Publisher after publish property, 34.3.3.5.2





L

	landing page, selecting, 5.6
	Landmark property, 18.2.10.2
	languages
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This figure depicts the Mail task flow. A toolbar at the top of the panel contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This image shows the About Space dialog. It has a header with the label, "About Space," and a Close icon. It contains information labeled Name, Display Name, Internal ID, Description, Membership, Created By, Date Created, Explorer URL, and Direct URL.


This image shows the Spaces component Leave Space. It is a link with the link text, "Leave Space." It is flanked by separators and additional Spaces components.


This figure shows the Edit Navigation Item - Spaces Query dialog with the fields completed as indicated in the previous steps.


This figure shows a new Blog Viewer task flow.


This image shows the Edit Properties dialog. The dialog is divided into three main sections: General, Exclude Resource Usage, and Attributes. The Attributes section is called out. It is divided into two columns, Name and Value, with fields under each for providing attribute name/value pairs. Below the two default rows is an Add More button. Below that are the buttons OK and Cancel.


This image shows the Resource Catalog. At the top is an icon and the label, "Add Content," along with Help and Close icons. On the next line are controls for navigating up the resource hierarchy, a label that indicates the current location within that hierarchy (Content Management), a Search field and button, and a Refresh icon. In the body of the dialog, three rows are highlighted, All Content, Personal Documents, and Content Presenter. All Content has an associated Open link. Personal Documents has both Open and Add links. Content Presenter has an Add link.


This figure depicts a Worklist task flow with items grouped according to the creation date. Each group has a number in parenthesis to its right. One group node is expanded to list all items in that group.


This image shows the Text layout component text editor. Its header is labeled, "Text," and contains a Done Editing link and Edit and Delete icons. Below the header is a toolbar with controls for selecting and styling fonts, adding font and background colors, formatting bullet and numbered lists, and switching between WYSIWYG and source modes. In the body of the editor is the text, "Enter your text here."


This image shows an expanded Page and Spaces Actions menu. The menu shows the options, Edit Page, Create, Manage, Personalize Pages, Contact, Membership, and About. Personalize Pages is called out. An icon indicates that the following options have submenus, Create, Manage, Contact, Membership, and About.


This figure depicts the Creator box on the Search Results page. It contains a bullet list of creators. Each contributor includes a number in parenthesis. The number indicates how many results are associated with a particular contributor.


This figure depicts the Remove links next to the refinement criteria in the Last Modified Date and Creator boxes on the Search Results page.


This figure shows the default wiki document that is automatically created when a page is created using the Wiki page style. The name of the wiki document and the folder under which it is created are the same. The figure highlights the wiki document name and the folder name.


This figure depicts the RSS task flow in Edit mode, with the Remove icon highlighted. The tooltip on the icon reads Remove.


This figure highlights the Users I am connected with checkbox in the Display Options dialog for the Recommended Connections task flow.


This figure shows a portion of the Roles page, showing Edit Permissions selected for the Authenticated-User role.


This figure shows a list titled ProjectSpaceIssues. The list page contains a table displaying all the list items. A header above the table displays the Actions, View, and Format menu, and the Edit, Freeze, Wrap, Filter, RSS, Links, and Refresh icons.


This image shows the Activity Stream Options dialog and the Options link one uses to open it. The dialog has three tabs: People, Spaces, and Settings. The Settings tab is forward. It is divided into three sections: People, Spaces, and Service Categories. The People section provides a menu for selecting whose activities you want to see. The Spaces section provides a menu for specifying whether to see activities from spaces. The Service Categories section provides checkboxes for selecting the services from which to display activities.


This image shows the Spaces component Privacy URL. It is a link with the link text, "Privacy Statement." To the left of it are separators and additional Spaces components.


This figure shows the sample banking application navigation model displayed as a menu with the Bar style.


This figure shows the Edit Source dialog for a navigation model.


This figure shows the properties of a folder. The resource ID of the folder is highlighted.


This figure depicts the External Application Login dialog. The dialog contains the User Name, Password, Email Address, Your Name, and Reply-To Address fields. Below these fields is the Remember my login information checkbox. OK and Cancel buttons are located at the bottom of the dialog.


This figure depicts the mail message window displayed when you click Reply. The window contains a field labelled To with a Find User icon. To and Subject fields already populated with the name of the person who sent the mail and the subject of the mail. Below the Subject field, an HTML file is listed as an attachment. A Remove Attachment icon is displayed adjacent to the file name. A text area in the lower half of the window contains the original message. Send and Close buttons are displayed at the bottom of the window.


This figure shows the Add Resource Catalog Item dialog, with the Task Flows option and the Notes option highlighted.


The image shows the Add Content dialog displaying the contents of the EmpDetails data control. The Add button against the EmpDetails accessor is clicked to show three context menu options: Table, Form, Graph.


This figure shows the Layout tab when an HTML layout was selected on the View tab. It includes four sections: Quick Start, Non-Repeating Heading Section, Repeating Section, and Non-Repeating Footer Section.


This figure shows the sample banking application navigation model displayed with vertical breadcrumbs.


This figure shows the Layout tab when a Parameter Form layout was selected on the View tab. It includes three standard sections: Style, Fields, Submit Actions.


This figure shows the Recommended Connections task flow.


This screen shot shows the Search task flow added to the New Page created in the space. The task flow shows the icon and description added.


This image shows the default Resource Catalog that displays when editing a page, Alongside each item is an Open button to either further drill down into a content folder (for example, Alerts and Updates, Analytics, Content Management, Mash-ups) The context of this image is to illustrate selecting Open alongside Content Management.


This figure shows the space administration Roles page, showing current roles defined for the selected space.


This figure shows the sample banking application navigation model displayed as a tree with the start path set to the currently selected page (Current Account).


This figure shows the Edit Event dialog when editing a space event. It has three sections: a section showing the meeting title and location; a Time section showing whether this is an all day event and the event's start and end times; and an Options section showing the priority, category, and additional details. Additionally, Send Mail and Links icons display in the top-right corner of the dialog. At the bottom of the dialog, there are three buttons: Delete, Update, and Cancel.


This image shows a Recent Activity task flow that does not display borders. That is, its left and right boundaries are not outlined, but its bottom boundary is indicated with a horizontal rule.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Separator menu option is selected.


This figure shows the Layout tab when the Bullet layout style is selected on the View tab. Here you can specify the bullet style (disc, circle, square, numerals, or none), and also the column layout.


This image shows the Component Properties dialog for an Announcements task flow. It shows five tabs, Parameters, Display Options, Style, Content Style, and Events. The Display Options tab is forward. It contains checkboxes, selection lists, and fields for entering parameter values. At the top are two subtabs, Basic and Advanced. The Basic tab is forward. On this tab, the following Display Options are shown:

	
Text


	
Short Desc


	
Chrome Style


	
Font Color


	
Font


	
Font Size


	
Font Style


	
Display Header


	
Allow Remove


	
Allow Resize


	
Show Component




To the right of all but the Font properties, there is a menu icon. The Show Component property and its associated menu icon are called out. The mouse pointer is hovering over the icon, and the tooltip, "Edit," is shown. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Edit Page is called out.


This image shows the Spaces component About Space. It is a link with the link text, "About Space." To the right of it are separators and additional Spaces components.


This image shows the Spaces component About WebCenter. It is a link with the link text, "About WebCenter." It is flanked by separators and additional Spaces components.


This image shows the Page Properties dialog. The dialog is divided into three tabs, Display Options, Security, and Parameters. The Parameters tab is forward. It has five input fields, leftWidth, centerWidth, rightWidth, showHeader, showFooter. Each field has a menu icon to its right, which you can use to open the Expression editor. Below the last field is the link, "Add a page parameter."


This image shows an Image layout component. Its sides and bottom are bounded by a dotted line. Its header has the label, "Image," and Edit and Remove icons. Below the header is a placeholder graphic.


This figure shows the Target tab of the Edit Navigation Item - Folder dialog.


This image depicts a partial view of the WLC Administration Console. The Settings for wc_domain page is shown. On that page, the Security tab is selected, as is its Embedded LDAP subtab. The Embedded LDAP subtab contains a list of LDAP configuration settings that include Credential, Confirm Credential, Backup Hour, Backup Minute, Backup Copies, Cache Enabled, Cache Size, and Cache TTL.


This figure shows the preview when the Repeat Horizontally option for the background image is selected. The selected background image is aligned horizontally, and repeated across the horizontal bar of the Task Flow/Portlet target area.


This figure shows the Create Role dialog box, displaying the Role Name and Template Role fields.


This image shows the Project Issues list in page view mode. At the top is a Collapse icon, the label, "Project Issues," a Personalize icon, and a menu icon. The mouse pointer hovers over the Personalize icon showing the tooltip, "Personalize."


This figure shows the basic structure of a page template, with:

	
a header containing corporate branding and useful links


	
a navigation area


	
a main content area in the middle of the page, which can have its own style and structure


	
a footer containing copyright information, and so on at the bottom of the page





This graphic shows the Events task flow before logging in to personal calendar with calendar overlay enabled.


This screen shot shows the Resources tab, with the newly-copied page template selected, and the Edit - Customize menu highlighted.


This figure shows the space administration General page, highlighting Take Space Temporarily Offline checked.


This figure shows the User Detail popup with the Get Connected link highlighted.


This figure shows the Delete Note dialog.


This figure shows the application-level Resources page open in Spaces Administration.


This figure depicts the Add Attachment window. To the left of the window is the File field with the Browse and Attach buttons adjacent to it. The bottom right corner of the window contains the Send and Close buttons. The lower half of the window contains the Attachments area that displays the files that are already attached. Adjacent to each attached file name is the Remove Attachment icon.


The image shows the Resource Manager with the left pane listing all the resources that you can manage. Resource Catalogs is selected in this pane. Consequently, the right pane displays the three preseeded catalogs. Above the list of resources is a header with links named Create, Upload, and Download, and dropdown menus named Edit and Info. A Filter field with a Go button and a Refresh icon are displayed on the right half of the header.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Sales." Below the status message are the View menu and the Page Properties button. The mouse pointer hovers over the Page Properties button, and the button is called out. The page body shows a Box layout component enclosing a Links layout component.


This figure shows part of the Edit Permissions dialog for documents in a space. These include: Administration Capabilities, Delete Documents, Create and Edit Documents, and View Documents.


This figure shows the User Messaging Preferences page.


This figure depicts the user name and status icon highlighted in the Mail task flow. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This image shows the Spaces component Administration. It is a link with the link text, "Administration." It is flanked by separators and additional Spaces components.


This figure shows the Source tab that displays when you select Web Page on the Type tab. From this page, you can launch Web Clipping Studio to clip data from an existing web page.


This figure shows the permissions required in an Advanced Permission Model for creating content presenter templates in a space. The Manage All, Manage Configuration, and Create, Edit, and Delete Content Presenter permissions are highlighted.


This figure shows the View dropdown list in the Events page toolbar. The list is expanded to show several categories that can be selected to filter the display of events on the page.


This image shows the Spaces component Join Space. It is a link with the link text, "Join Space." It is flanked by separators and additional Spaces components.


This figure shows the blog posts available under a blog in the document hierarchy on the Documents page. The blog post named Philatelists Club can be opened by clicking its title highlighted in the figure.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component "region" is called out along with the Edit Task Flow link to its right.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component "region" is called out along with the Edit Task Flow link to its right.


This image shows the Business Role Pages subpage under Pages in Spaces Administration pages. The label "Business Role Pages" is highlighted and followed by links to Personal Pages and System Pages. Below these labels is a toolbar with links for creating new business role pages (BRPs) and setting page creation defaults. Next to these are controls for applying a temporary filter to the list of BRPs, creating a persisted filter, refreshing the list of BRPs, and accessing page help. BRPs are listed in a table with the following columns: Name, Reorder, Show Page, Created By, Last Modified, and Actions. The Reorder column provides icons for rearranging the order of BRPs. The Show Page column provides checkboxes to hiding or showing the related BRP. The Actions column provides menu icons for actions on an individual BRP.


This image shows a Box layout component that contains a Quick Poll task flow. Above the task flow are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The mouse pointer is hovering over the Add a Tab Set or a Tab icon.


This image shows a page in edit mode Source view. The component "… /folderclosed_qualifier.png" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of … /folderclosed_qualifier.png," is shown.


This figure shows the Similar Spaces task flow.


This figure shows the preview when the Repeat Vertically option for the background image is selected. The selected background image is aligned vertically, and repeated across the vertical bar of the Task Flow/Portlet target area.


The images shows a section titled Resources displaying six fields with dropdown menus. The first menu is for selecting the default page template. The other five are for selecting the Resource Catalogs for spaces, Home space, Business Role Pages, Page Templates in spaces, and Page Templates in Home space.


This figure shows the Space administration General page Membership Self-Service section.


This image shows the Expression Builder editor. The option "Type a value or expression" is selected. Under that is a text box containing the EL expression #{securityContext.userName}.


This screen shot shows the Mail compose page, with the checkbox selected to send to all space member. It has an empty To field, an Options dropdown list, and the Subject field is prepopulated with the discussion topic title. The mail text includes the discussion topic information.


This image shows an example of a Profile Gallery page. At the top, in the application chrome, the mouse pointer hovers over the Current User Profile spaces component with the hint text Josie Smith. This component is called out. The body of the page is divided into two columns. The left column contains Josie Smith's profile picture and job title and the subpages Activities, Connections, Documents, Organization, and About. The Activities tab is forward. It contains a Publisher task flow followed by an Activity Stream. The right column contains a Download vCard link and four categories of information, Contact Information, Location, About, and Recommended Connections.


This figure shows the sample banking application navigation model displayed as a menu with the Buttons style.


This image shows the Spaces component Logout. It is a link with the link text, "Logout." To the left of it are separators and additional Spaces components.


This figure depicts the Worklist task flow with the Display Options, Messaging Preferences, and Refresh icons.


This figure shows the default Request Membership page.


This figure shows Actions menu open, with the All Settings option highlighted on the Manage submenu.


This image shows a Box layout component. To the left is an Add Content button. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The icons for splitting the Box are called out.


This figure shows the Documents page of a space, with a folder created at the root level highlighted.


This screenshot shows the Create new Data Control - Web Service dialog.


This figure shows part of the Edit Permissions dialog for documents in a space. These include: Administration, Delete Documents, Create and Edit Documents, and View Documents.


This graphic shows the Add icon in the Polls Manager, with selections to add question, add section, or apply template.


This image shows the Copy Page dialog. It contains a Page Name field with the value, "Copy of Announcemnt". It lists two "Copy as" options: Business Role Page and Personal Page. Two buttons appear a the bottom of the dialog: OK and Cancel.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Pages Query menu option is selected.


This image shows a Box layout component on a tab labeled, "New Tab." The Box contains a Quick Poll task flow. Above the task flow are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The tab on the new tab is called out.


This figure shows the Parameters tab of the Component Properties dialog for the Recommended Connections task flow.


This image shows an expanded Spaces Switcher menu. The switcher is divided into two columns, Recent Spaces and My Spaces. The Recent Spaces column is bisected, with the lower portion showing the links Home Space, Browse Spaces, and Create a Space. The Home Space link and the Spaces menu label are called out.


This image shows a detail of a page in edit mode Design view. Below the status message ("Editing Page: New Page"), View menu, and Page Properties button is a concurrency warning with a warning icon (triangle with centered exclamation point) and the text, "This page is also being edited by: vicki (7 secs ago)."


This screenshot shows a WebCenter Portal: Spaces application navigation model


This image shows the Source Editor. At the top, it is labeled, "Edit Source - Standards." At the bottom are two tabs, Page and Page Definition. Page is forward. The Page tab contains the style's source code. This dialog also provides OK and Cancel buttons at the bottom.


This figure shows the RSS task flow highlighted in a Resource Catalog.


This figure shows the space administration Members page, highlighting the Membership Notification Messages section.


This figure shows the sample banking application navigation model displayed as a menu with the Tabs style.


This image shows an HTML Markup component in page edit mode. The sides and bottom are bounded by a dotted line. The component header contains the label, "HTML Markup," and Edit and Remove icons. Below the header is the text, "New HTML Markup."


This screenshot shows the Create new Data Control dialog box for creating a SQL data control.


This figure depicts a Compose window with the Remove Attachment icon highlighted next to an attached file. It includes a To field with a Find User icon. Below the subject, a file is listed as an attachment. The Remove Attachment icon is displayed adjacent to it. A text area is in the lower half of the window.


This figure shows the Layout tab that displays when the Tabular layout style is selected on the View tab. Here you can specify the column labels, column data, content alignment, display mode, and an associated URL.


This image shows the login detail of a Welcome page. The heading is, "Log in to WebCenter Portal: Spaces." Below that are fields labeled User Name and Password. This is followed by the Login button. Below that is the heading, "Need an account?" followed by a Register button.


This image shows the Spaces component Resources section on the General subpage of the Administration page. It is divided into two columns of labels and pick lists. The left column provides controls for selecting the application default page template, Resource Catalog for spaces, Resource Catalog for the Home space, and Resource Catalog for business role pages. The right column provides controls for selecting Resource Catalog for pages in spaces, Resource Catalog for pages in the Home space, and Navigation for the Home space.


This screenshot shows the Items page in the Create Table dialog.


This image shows the Component Properties dialog for an Announcements task flow. It shows five tabs, Parameters, Display Options, Style, Content Style, and Events. The Display Options tab is forward. It contains checkboxes, selection lists, and fields for entering parameter values. At the top are two subtabs, Basic and Advanced. The Basic tab is forward. On this tab, the following Display Options are shown:

	
Text


	
Short Desc


	
Chrome Style


	
Font Color


	
Font


	
Font Size


	
Font Style


	
Display Header


	
Allow Remove


	
Allow Resize


	
Show Component




To the right of all but the Font properties, a menu icon is shown. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This screen shot shows the Add Resource Catalog Item dialog, with the Search task flow selected from the Task Flows category.


This screenshot shows items under the Portlet Administration folder in the Add Content dialog.


This image calls out the Show Hierarchy icon to the left of a zoomed-in task flow (labeled "region").


This image shows the Spaces component Create Page. It is a link with the link text, "Create Page." To the right of it are separators and additional Spaces components.


This image depicts the Organization subpage of a Profile page. It shows an organization flowchart, with a manager at the top of the pyramid and two direct reports immediately below. Each user is depicted in a box with a profile picture, a Go to Profile link, and additional information, including Email, Work, and Mobile. At the bottom of each box are previous (left) and next (right) icons and an indicator (center) that shows that the first of three views is selected.


This figure shows the sample banking application navigation model displayed as a menu with the List style.


This image depicts configuration settings for Profile. The Profile tab is divided into three sections: Allow Password Change, Profile Access, and Profile Attributes - Edit Settings. The Allow Password Change section provides a checkbox for allowing or prohibiting individual users from changing their own application passwords. The Profile Access section provides controls for specifying who can view a given Profile data section, whether users can override this default, and whether users can edit their own views of a given section. The Profile Attributes - Edit Settings section provides checkboxes to enable or prohibit users from updating a particular attribute under a given profile section.


This image shows the Spaces component Create Space. It is a link with the link text, "Create a Space." It is flanked by separators and additional Spaces components.


This figure shows the Rename Space URL dialog box, displaying a field to enter a new URL for the space.


This image shows the Component Properties dialog for a Box layout component. There are three tabs, Child Components, Display Options, and Style. The Child Components tab is forward. On it is the heading, "Components," and a list of child components, including Recommended Connections, Publisher, and Announcements. To the right of each listed component is a Move icon for rearranging the order of components. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows the Connection Information page that displays when you select the SQL on the Type tab. The Driver Name dropdown list displays the sample DataDirect Driver Oracle-thin.


This image shows an HTML Markup component in page edit mode. The sides and bottom are bounded by a dotted line. The component header contains the label, "HTML Markup," and Edit and Remove icons. Below the header is the text, "New HTML Markup." The mouse pointer is hovering over the Edit icon on the header, showing the tooltip, "Edit."


This screen shot shows the Gear dropdown menu, with Manage, then All Settings selected.


This image shows the Expression Builder editor, invoked from an icon next to a parameter in the Component Properties dialog. The editor has a Help icon on the right side of the header (followed by a Close icon), and two main options: Choose a value and Type a value or expression. A Test button is available at the bottom of the dialog to test the validity of any EL expression that appears in the text box under Type a value or expression.


This image shows a Box layout component. To the left is an Add Content button. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The mouse pointer is hovering over the Add Box Below icon.


This image shows a page in edit mode Source view. The component "userProfile" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of userProfile," is shown.


This image shows the Resource Catalog. The Resource Catalog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Top"), a Search field and button, and a Refresh icon. The dialog lists various resource folders, such as Alerts and Updates, Analytics, Content Management, and so on. Each folder has an associated icon and Open link.


This image shows a Resource Catalog (labeled Add Content). Below the label is a toolbar with a navigation icon, a location label (Alerts and Updates), a Search field and icon, and a Refresh icon. Below these is a list of components, which includes Announcements. Next to the Announcements component is an Add link. The mouse pointer hovers over the Add link and shows the tooltip, "Add Announcements."


This figure shows a blog task flow added to a page, and the Edit icon highlighted. The blog does not contain any blog posts, and is not yet associated with any folder.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu are current links, each followed by Configure and Delete icons.


This figure shows the Find a Web clipping page, including the Inputs section.


This figure shows the Filter notes icon highlighted.


This image depicts configuration settings for Connections. The Connections tab is divided into two sections. The first section (unlabeled) provides controls for specifying who has access to a user's connections and whether this default can be overridden by individual users. The section, Other Settings, provides a checkbox for allowing or prohibiting the automatic acceptance of invitations to connect.


This figure depicts Due Date as selected from the Sort By options in the Display Options dialog box. Create Date, Due Date, Expiration Date, Priority, and Title are the options available.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu is the link, "Sales Figures," followed by Configure and Delete icons. The mouse pointer is hovering over the Delete icon with the hint text, "Delete."


This page shows the Page Information dialog. It has a header labeled, "Page Information," and a Close icon. It provides information labeled Name, Description, Created By, Date Created, Last Modified, and Direct URL. Note that if a page does not have a description, the Description attribute is not shown.


This figure shows the Edit Source dialog of a custom skin, with the various skin selectors listed on the CSS tab.


This figure shows the filtering toolbar highlighted.


This figure shows the home page of the AviTrust Employee Portal.


This image shows a detail of Spaces application chrome. At the top are the links Preferences, Help, and Logout. The mouse pointer hovers over the Help link with the hint text, "Help for WebCenter Portal: Spaces."


This image shows the Activity Stream - Quick View task flow. A pencil icon is visible (Change the source, filter, and display options), for configuring the task flow instance. Next to it, a Refresh icon is available for refreshing streamed data. Four items are streamed. Each streamed item shows an icon related to the type of streamed activity (such as a page, a photo, and a person); a summary of the activity, including where applicable a link to the object that was acted on; and a time stamp, such as 8 minutes ago, 19 minutes ago, indicating when the activity took place.


This figure shows the User Detail popup.


This figure depicts the highlighted Messaging Preferences icon in the Worklist task flow. The task flow also provides the Display Options and Refresh icons.


This figure shows the Discussion Forums task flow containing a list of all discussion topics. The RSS icon is highlighted.


This image shows the Spaces component Copyright Message. It is the text string, "Copyright (copyright symbol) 2010, Oracle and/or its affiliates. All rights reserved."


This figure highlights the Number of items field in the Display Options dialog for the Similar Items task flow.


This figure depicts the personalization menu in the Mail task flow. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This figure shows the Edit dialog of a custom skin. The Preview pane on the right displays a preview of the skin settings selected in the fields on the left.


This figure depicts the pop-up calendar displayed on clicking the Select Date icon in the Create Announcement dialog. The current date is marked by a solid box.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Delete Page is called out.


This figure depicts the Display Options dialog box displayed when you click the Display Options icon in the Worklist task flow. The Display Options dialog box contains a Group By list, Sort By options, and Save and Cancel buttons.

The task flow also provides the Messaging preferences and Refresh icons.


This image shows a page in edit mode Source view. The component "menu: Everyone" is selected in the hierarchy of page components, and the component itself, a menu of share options, is called out in the WYSIWYG portion of the page.


This figure shows a page template named MySpaceTemplate marked as hidden on the Resources page. The figure also shows the Create New Page Template dialog, with the MySpaceTemplate listed in the Copy from list.


This figure highlights the Show spaces I have visited before checkbox in the Display Options dialog for the Similar Spaces task flow.


This figure shows a portion of the Spaces Welcome page, highlighting the Public Spaces link.


This figure shows the Remove Members icon on the Members page.


This screen shot shows the Reply Topic window, with the following reply sent to the message titled Support Issues: "We've received a lot of calls about the new version 2.0 performance."


This figure shows the space administration General page Self-Subscription / Change Membership section, showing Do Not Allow Self-Subscription and Change Membership checked.


This figure shows the Source tab that displays when you select SQL on the Type tab. The Source tab includes a Statement field for entering a SQL statement. Additionally, it displays buttons for showing bind variables and testing your statement.


This figure shows an example list of available forums that displays when you click the Find icon.


This image shows the Spaces component Mail Space Members. It is an icon and a link with the link text, "Send Mail to Members." To the right of it are separators and additional Spaces components.


This graphic shows the Tags icon now available on pages.


This figure shows the RSS 2.0 and Atom 1.0 news feed icons displayed against the Discussions service listed under a space.


This figure shows how selecting the Personal Banking tab at the top of the page displays the rest of the navigation model (from Personal Banking down) on the side of the page.


This figure shows the General tab open under the application-level Configuration page. In the Global section, the Application Skin list is open, and a skin is highlighted.


This image shows a page in edit mode Design view after a page header or footer is added. The page is based on the page style Three Column. Accordingly, it has three layout boxes laid out horizontally. Each layout box has its own Add Content button and icons for adding tabs and more layout boxes as well as an icon for customizing the layout box through its properties. Additionally, there is a layout box at the top for the page header and a layout box at the bottom for the page footer. These provide the same controls as the layout boxes in the body of the page.


This figure shows the Source tab that displays when you select the Spreadsheet (or CSV) on the Type tab. On this page, you can enter the URL to the CSV file.


This figure depicts the Compose window. There are four fields labelled To, Cc, Bcc, and Subject. To the right of each of the first three fields is a Find User icon. A text area in the lower half of the window contains the actual message. An Attach Files link is displayed below the Subject filed. Send and Close buttons are displayed at the bottom-right corner.


This figure shows a page created using the Wiki page style. The page name is highlighted on the top navigation area of the space. The page contains a default wiki document, containing some default text related to wikis.


This image shows a collapsed Announcements task flow. The header contains an Expand icon, the heading, "Announcements," and a Remove icon. The Expand icon is called out.


This figure shows a wiki document created within a wiki page. The figure shows the name of the wiki page's folder and the newly created wiki document as highlighted. It also lists all the other wiki documents available under that folder.


This image shows the Spaces component Edit Page. It is a link with the link text, "Edit Page." To the right of it are separators and additional Spaces components.


This image shows the Expression Builder editor. The expression #{generalSettings.preferredTimeStyle} appears in the text box. The mouse pointer is depressing the Test button. A popup shows the value this EL returns: short.


This image shows the Spaces component User Preferences. It is a link with the link text, "Preferences." It is flanked by separators and additional Spaces components.


This image shows a page in edit mode Source view. The mouse pointer is hovering over the input field in a Publisher task flow. The input field is outlined in blue. The mouse pointer is rendered as a magnifying glass.


This screen shot shows the Mail Compose window with the CC, BCC and Reply-to fields added, and the rich text editor removed. The Find User icon is adjacent to the To field, the Cc field, and the Bcc field.


This figure shows a wiki document listed as a page in the space.


This figure shows the Target tab of the Edit Navigation Item - Content Query dialog.


This screenshot shows the Create New Task Flow dialog.


This figure shows a preview of the HR navigation model with the HR subspace pages listed: Benefits, Payroll, and New Hire.


The image shows a table with employee details. It has three columns, ENAME, EMPNO, and DEPTNO. An empty field is displayed at the top of each column.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Link menu option is selected.


This figure shows the permissions that can be granted on a resource. The Create, Edit, and Delete permissions for Mashup Styles, Navigation, and Page Style resources are shown as highlighted.


Tags task flow, with the display options shown: Tag List, Tag Cloud, and Tagged Items.


This graphic shows the Question page, with fields for "Select Type of Question," "Question," "Row Answer Choice" and options to Add a Comment Field and Require Answer to Question.


This figure shows the sample banking application navigation model displayed as a menu with the Choice style.


This image shows a page in edit mode set to Source view. The hierarchical list of components is zoomed-in to a particular task flow, depicted by the label, "region." To the right of region is a Close link for exiting the zoomed-in view.


This image shows a Links layout component inside a Box layout component. The Box is bounded by a dotted line. At the top of the Box are an Add Content button and a tool palette with icons for adding tabs, splitting the Box, and editing Box properties. Below these is an Add Link menu followed by the link "Sales Figures." To the right of the Add Link menu is a floating tool palette, with a move handle, an Edit icon, and a Remove icon. This palette is called out. The mouse pointer hovers over the Remove icon, showing the text, "Remove."


This figure shows the Options tab of the Edit Navigation Item dialog.


This image shows a detail of a page in edit mode Design view. At the top is the status message, "Editing Page: For Testing." Below the status message are the View menu and the Page Properties button. The View menu is expanded to show the options Design, Source, and Source Position. The mouse pointer is hovering over the Source option.


This image shows the Spaces component Parent Space. It is a link with the link text, "Navigate to Parent Space." To the right of it are separators and additional Spaces components.


This figure shows the selected section of a web page displayed in the Web Clipping portlet.


This image shows a Movable Box layout component on a page in edit mode. It has a header with a collapse icon, the label, "Movable Box," an icon for accessing Movable Box properties, and a Remove icon. Inside the Movable Box is a Box, which is bounded by a dotted line. In the Box, an Add Content button is shown to the left. To the right is an icon for accessing Box properties.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name.


This figure depicts the Worklist service task flow with a list of Worklist items. The mouse is hovering over the Details link which enables you to see the entire item.


This image shows the Tabs tab for a Box layout component in the Component Properties dialog. The dialog has four tabs, Tabs, Child Components, Display Options, and Style. The Tabs tab is forward. The Tabs tab is divided into two columns. In the left column is the label, "Reorder the tabs," which shows a list of all tabs in the current tab set and icons (to the right) for reordering tabs. On the list are the tabs Today's Quiz, Fun Facts, and Duro. The tab, "Duro," is selected. Below the list are an Add Tab button followed by a Delete Tab button. The Delete Tab button is called out. In the right column are fields and checkboxes for configuring the tab. They include Text, Icon Location, Short Description, Stretch Contents, and Hide this tab.


This figure shows the Parameters tab of the Component Properties dialog for the Navigation Tree task flow.


This figure shows the Add Access dialog. A search field appears at the top of the dialog, and a Search button sits to its right. Below the search field is a table with the columns Name and Type. At the bottom of the dialog are Select and Cancel buttons.


This screen shot shows the Add button highlighted in the Resource Catalog for the Forums task flow.


This image shows a detail of a page in edit mode Source view. At the top is the status message, "Editing Page: For Testing." Below that are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste controls. The mouse pointer hovers over the Edit button, and the button is called out. Below the toolbar is the hierarchical list of page components. A Box layout component is selected and called out. Below the list is a breadcrumb list of page components arranged hierarchically, from the page itself down to the currently selected component. In the WYSIWYG portion of the page, the selected Box layout component is outlined in blue.


This image shows the Add Access dialog. It contains a Search field and button, a table with two columns: Name and Type, and Select and Cancel buttons.


This image shows a Box layout component. At the top are three tabs, all labeled, "New Tab." The first tab in the series is forward. Within the body of the Box are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; editing Box properties; and deleting the Box.


This figure depicts the Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This figure shows Upload dialog for a resource, with the Look on my computer radio button selected.


This image shows the Spaces component Display Settings section on the General page of the Space Settings pages. This page is divided into two columns. The left column provides controls for locating and selecting a space icon and a space logo. Both fields show previews of the current selections. The right column provides controls for selecting a page template, a skin, Resource Catalogs for pages and page templates, and a navigation model for the space. A checkbox is available for specifying whether to show a page footer. There are fields for entering a copyright message and specifying a URL to the space privacy statement. Finally, there are controls for selecting a default language for the space and customizing the list of available languages.


This image shows the Page Properties dialog. At the top is an icon and the label, "Page Properties," with Help and Close icons. The dialog is divided into two tabs, Display Options and Parameters. The Display Options tab is forward. It contains a menu and two fields, Background Color, Background Image, and Other CSS. The Background Color menu is expanded, showing two buttons, Last Used Color and Default Color, a color palette, a row for showing previously selected colors, and another button, Custom Color. The mouse pointer is hovering over the middle color in the top row, and the resulting hint text is, "Beige (F5F5DC / 245,245,220)."


This figure depicts the Announcements task flow with the RSS icon on the toolbar highlighted.


This image shows a page in edit mode. Below the page status, "Editing Page: Task Flow Editor," the View menu is expanded. It shows the options Design, Source, and Source Position. The Source option is called out.


This figure shows the preview when both the Repeat Horizontally and Repeat Vertically options for the background image are selected. The selected background image is repeated across the entire Task Flow/Portlet target area.


This image shows an Announcements task flow. The header contains a Collapse icon and the heading, "Announcements." To the right of Announcements is a Remove icon. At the bottom right edge of the task flow is a Resize handle. The handle is called out.


This figure depicts a list open on the List page.


This image shows Box layout component display options in the Component Properties dialog. There are two tabs, Display Options and Style. The Display Options tab is forward. It contains menus and fields, including Allow Action, Horizontal Alignment, Layout, Short Desc, Show Split Action, Show Tab Action, Vertical Alignment, and Show Component. The properties Show Split Action and Show Tab Action are called out.


This figure shows the Invitation Message dialog. The dialog contains a field for entering an invitation message. This field is populated by default with the text "I would like to add you as my connection." The dialog also contains a dropdown list for selecting the connection list to which to add the new connection.


This image shows the Copy Page dialog. It contains a Page Name field with the value, "Copy of Sales Team Page." It lists two "Copy as" options: Business Role Page and Personal Page. Two buttons appear a the bottom of the dialog: OK and Cancel.


This figure shows a popup listing the objects that the current user has in common with one of the users listed as a recommended connection.


This image shows an expanded Spaces Switcher menu. The switcher is divided into two columns, Recent Spaces and My Spaces. The Recent Spaces column is bisected, with the lower portion showing the links Home Space, Browse Spaces, and Create a Space. The Browse Spaces link is called out.


This image shows a detail of a page in edit mode Design view. At the top is the status message, "Editing Page: For Testing." Below that are the View menu and Page Properties button. Below these is a Box layout component with an Add Content button and a palette of controls for adding tabs, splitting the Box above, below, left, or right, and an Edit icon for accessing Box properties. The mouse pointer hovers over the Edit icon showing the tooltip, "Edit."


This image shows a Recent Activity task flow bounded on all sides by a red broken line.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Folder menu option is selected.


This image shows the About subpage of the My Profile page. At the top, is the Summary section. Within this section, a placeholder for a user profile image appears to the right. To the left summary profile details are listed. These include About Me (value user2), Display Name (value user2), Email, Department, Designation, Manager (value manager_user), Direct Reports, Phone, and Time Zone.


This figure shows the Target tab of the Edit Navigation Item - Content Item dialog.


This figure shows an example of an OmniPortlet that uses the HTML layout.


This figure shows the sample banking application navigation model displayed as a tree with the start node (Current Account) displayed.


This graphic shows the Polls Manager in the page to compose or edit a section.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Sales." Below the status message are the View menu and the Page Properties button. On the line below the View menu is a toolbar with controls for editing, deleting, cutting, and pasting page components. A mouse pointer hovers over the Delete button, showing the tooltip, "Delete Links." The Delete button is called out. In the hierarchical list of components, the component showDetailFrame:Links is selected.


This figure shows the results of the search.


This image shows a list of system pages. The Task Flow Editor system page is called out, and the mouse pointer is touching the page's associated Customize link. The hint text, "Customize the Task Flow Editor page using the Oracle Composer," is shown.


This image shows the Set Page Access dialog. It lists the page name, below which are the Add Access and Delete Access options. Below these are the Add Authenticated Access and Add Public Access options. Below these is a small table with two columns: "Role or User" and "Page Access". Page Access has five subcolumns, each with an icon that depicts a type of access permission: glasses for View Page, a wrench for Edit Page, an ex for Delete Page, a wrench over a cascade of pages for Perform All Page Actions, and a pencil for Personalize Page. The role anonymous-role is selected, and the Delete Access option is called out.


This figure shows the Administration link highlighted on the Spaces banner.


New Forum - May Service Requests


This figure shows the RSS task flow containing an RSS icon and a Refresh icon on the toolbar.


This image shows the System Pages subpage under Pages in space Settings. The label System Pages is highlighted and preceded by a link to the Available Pages subpage. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over a Customize link next to the Activity Stream page, and shows the hint text, "Customize the Activity Stream page using the Oracle Composer."


This figure shows the Edit Navigation Item - Pages Query dialog with the fields completed as indicated in the previous steps.


This figure shows the Create New Navigation dialog with the fields completed as indicated in the previous steps.


This image shows the Spaces component RSS. It is a link with the link text, "RSS." It is flanked by separators and additional Spaces components.


This figure shows the Edit Properties dialog of a custom skin. The dialog shows various properties in the following three sections: General, Exclude Resource Usage, and Attributes.


This image shows the New External Link dialog. Its header contains an icon with the label, "New External Link," and a Close icon. Below the header is the text, "Enter the name and URL of the external link." Below this text are two fields, Name and URL, and a checkbox, Render in page template. At the bottom of the dialog are OK and Cancel buttons.


This figure shows the web page divided into sections. At the top left of each section, there is an icon labeled Choose.


This image shows the Spaces component Change Membership. It is a link with the link text, "Change Membership." To the right are separators and additional Spaces components.


This figure shows a preview of the AviTrust Banking Navigation Model with the pages and subspaces of the Banking subspace listed.


This figure shows a blog post on a blog page.


This image shows the Page Properties dialog. The Parameters tab is forward and shows a newly added parameter (space) and value (#{empty navigationContext.currentNavigationModel.currentSelection.parameters.space ? 'Space_Name' : navigationContext.currentNavigationModel.currentSelection.parameters.space}).


This figure shows the Create a new note icon highlighted in a Notes task flow.


This image shows the Spaces component Search. It is a task flow with a Collapse/Expand icon and the text, "Search," in the header and a Search field and icon in the body.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Three Column." Below that are a View menu and the Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste controls. The mouse pointer is hovering over the Delete button with the tooltip "Delete above." In the hierarchical list of page components, the component panelTabbed:above is called out. Below the hierarchical list is a hierarchical trail of breadcrumbs leading from the top component, the page (Three Column), to the selected component, panelTabbed:above.


This figure highlights the Do not show this space icon next to a space in the Similar Spaces task flow. The icon looks like a small red cross.


This figure shows the Expression Builder dialog, with the Type a value or expression radio button selected.


This figure provides an overview of the structure of the AviTrust Employee Portal.


The image shows a table with four columns, ENAME, EMPNO, DEPTNO, and MGR.


This figure shows an example of a portlet using the News layout.


This figure shows a sample navigation model based on a banking application. The top level nodes of the navigation model are Personal Banking, Private Banking, Business Banking, and Commercial Banking. Under the Personal Banking node there are four nodes: Current Account, Savings, Investments, and Loans. Under the Current Account node there are two nodes: Our Accounts and New Customers. Under the Our Accounts node there are another two nodes: Regular Current Accounts and Accounts with Extras.


This image shows a page template in edit mode. At the top is the status message, "Editing Page Template: WebCenter Spaces Side Navigation for testing." Below the status message, the View menu is expanded, showing the options Design, Source, and Source Position. The Source option is called out.


This figure shows the Overwrite Content Directory dialog for a resource.


This figure shows a blog created using the Blog page style. The name of the blog page is listed on the top navigation bar. The blog does not contain any blog posts. The New Post link is displayed along with a navigation area for Archives and Recent Posts.


This image shows a Help icon, which is a circle encircling a question mark. The mouse pointer hovers over the icon with the hint text, "Help."


This screen shot shows a new topic in the Discussions Forum task flow titled Suggestions for New Features. The message in the topic says, "What should we focus on for Release 2.0?"


This figure shows an example of how a pie chart portlet may look at runtime. There are four pie wedges representing the number of employees in each department.


This image shows the Select DN dialog. The top of the dialog provides various tools, including those for navigating and searching dialog content. The body of the dialog provides a tree of expandable nodes. Under the root, the relevant nodes expand from the parent dc=wc_domain. From there, in succession, the following nodes are expanded: ou=myrealm, ou=people. The node uid=manager_user is selected.


This graphic shows a sample poll from the Take Polls task flow.


This image shows a page in edit mode Design view. At the top is a status message, "Editing Page: Activities." Below the status message are the View menu, Page Properties button, and Help, Save, and Close icons. The Page Properties button is called out.


This image shows the Spaces component Status Indicator. It is an animated icon of a stylized "O" that spins when the application is processing information.


This screen shot shows the Discussion Forums task flow, with one topic, and a reply to the topic. It also has links to reply more to this topic, edit this topic, delete this topic, subscribe RSS, watch this topic, or add links to this topic.


This image shows the Page Properties dialog for a page in a space. The header contains an icon labeled, "Page Properties," and Help and Close icons. The dialog has three tabs: Display Options, Security, and Parameters. The Security tab is forward. At the top of the Security tab are Access Method options, Use Application Permissions and Use Custom Access Settings. Below Access Method options are the controls Add Access and Delete Access. Delete Access is grayed out. Below these are the controls Add Authenticated Access and Add Public Access. These are followed by a two-column table, with column headings Role or User and Page Access. The Page Access column is subdivided into five columns, each headed with an icon, View Page (glasses), Edit Page (wrench), Delete Page (ex), Perform All Page Actions (cascade of pages topped with wrench), Personalize Page (pencil). The table has three rows of users, each with View Page access. At the bottom of the dialog are OK and Cancel buttons.


This figure shows the Exclude Resource Usage section of the Edit Properties dialog, with the Add/Choose link under Selected Spaces highlighted.


This figure shows the Type tab of the OmniPortlet wizard. The Type tab lists the five data sources you can use with OmniPortlet: Spreadsheet (CSV), SQL, XML, Web Service, and Web Page.


The Similarly Tagged Items task flow Component Properties dialog, with the Resource ID and Service ID parameters.


This image shows the Add Access dialog. It contains a Search field and button, a table with two columns: "Name" and "Type", and Select and Cancel buttons.


This image shows the Layout Style section of the View page in the OmniPortlet Wizard. Down the left side are the radio buttons Tabular, Chart, News, Bullet, Form, HTML, and Parameter Form. The News radio button is selected. To the right is a depiction of the selected layout with sample data.


This figure shows the Discussions page containing a list of all discussion topics. The RSS icon is highlighted.


This figure shows the sample banking application navigation model displayed with horizontal breadcrumbs.


This image shows the New Page Link dialog. The header is labeled, "New Page Link," and includes a Close icon. Below the header is the text, "Enter the name and path of the page." Below this text are two fields, Name and Path. To the right of the Path field is a Browse button. At the bottom of the dialog are OK and Cancel buttons.


This image shows the Text layout component. Its sides and bottom are bounded by a dotted line. Its header contains the label, "Text," an Edit Text link, and Edit and Delete icons. Below the header is the text, "Enter your text here."


This image shows the Project Issues list in page edit mode Design view. At the top is a Collapse icon, the label, "Project Issues," an Edit icon, a menu icon, and controls for configuring the list's properties and for deleting this list instance. The mouse pointer hovers over the Edit icon showing the tooltip, "Edit."


This screen shot shows the Discussion Forums task flow, with one topic and one reply to that topic.


This figure shows the portlet parameters section of the Source tab that displays for every data source type. The section displays five headings: Parameter Name, Default Value, Personalizable, Personalize Page Label, and Personalize Page Description.


This figure shows the Similar Items task flow.


This screenshot shows the Enter bind parameter values dialog.


This image shows the System Pages subpage under Pages in spaces Administration pages. The label System Pages is highlighted and preceded by links to the Business Role Pages and Personal Pages subpages. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over a Customize link next to the Activities page, and shows the hint text, "Customize the Activities page using the Oracle Composer."


This figure highlights the Do not show this item icon next to an item in the Similar Items task flow. The icon looks like a small red cross.


This image shows the Activity Stream task flow. At the top, a menu is available for selecting the range of time for which to show activities. Next to it, an Options link is available for setting configuration options on the task flow instance. Additionally, a Refresh icon is visible for refreshing the task flow data. Four streamed activities are shown, each with the actor's image and a summary of the activity. Each streamed activity provides a time stamp, such as 8 minutes ago or 19 minutes ago, indicating when the activity took place, and options for adding comments, for liking the activity, and for sharing the activity with other users.


This image shows the Spaces component Share Resource. It is a link with the link text, "Share Link." To the right of it are separators and additional Spaces components.


This figure shows a part of the Edit Permissions dialog for a role in a Standard Permission model.


This figure shows the Security Settings dialog of a resource, with the Use Custom Permissions checkbox selected and the user named weblogic granted the Manage permission.


This image shows a Box layout component. At the top are three tabs, all labeled, "New Tab." The first tab in the series is forward. Within the body of the Box are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; editing Box properties; and deleting the Box. The mouse pointer is hovering over the Add a Tab Set or a Tab icon.


This figure shows a blog post open. At the bottom of the blog post, details such as the name of the user who last modified the post, modification date, version number, and file size are displayed. The blog also contains the following: File and View menus, Edit action, Archives and Recent Posts panes on the right, and Comments, Tags, and Links tabbed panes at the bottom.


This screenshot displays the new graph you created in a task flow.


This screenshot shows a page with the Application Navigator task flow added to it.


This image shows a detail of the Resource Catalog. The menu you use to navigate up the resource hierarchy is expanded to show three levels, Personal Documents, Content Management, and Top. The Top option is selected.


This figure depicts the service nodes in a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This figure shows the Add Attribute dialog, displaying the Name and Value fields.


This screen shot shows the estimated number of results: 1 - 10 of about 344, with links to the next 10 pages of results.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Statistics). It shows the options, Edit Page, Reset Layout, Copy Page, Rename Page, Set Page Access, Delete Page, Add to Home Space, Send Mail, and About This Page. The option Add to Home Space is called out.


This screen shot shows the Forums - Quick View task flow with Watched Forums selected.


This figure depicts the pop-up calendar displayed on clicking the Select Date icon next to the Expire on a Specific Date field. The current date is marked by a solid box. But only those dates after the publication date are enabled for selection.


This image shows three tabs, Today's Quiz, Fun Facts, and Duro. The first tab, "Today's Quiz," is forward. To the left of its label is an icon of a light bulb with a question mark inside of it. On the Today's Quiz tab is a Quick Poll task flow. The Today's Quiz tab (with its icon) is called out.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component "region" is at the top of the hierarchy, with a "Close" link to its right.


This figure shows the Notes option and the Add link next to it highlighted in the Add Content dialog.


This figure shows the Edit Properties dialog of an application-level task flow. The Exclude Resource Usage section is highlighted.


This image shows the Edit Page Link dialog. The header is labeled, "Edit Page Link," and includes a Close icon. Below the header is the text, "Enter the name and path of the page." Below this text are two fields, Name and Path. To the right of the Path field is a Browse button. At the bottom of the dialog are OK and Cancel buttons.


This image shows the Resource Catalog. The Resource Catalog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Web Development"), a Search field and button, and a Refresh icon. The dialog lists Web Development resources, such as Data Controls, Box, Change Language, HTML Markup, and the like. The Data Control folder has an associated icon and Open link. Each individual resource, such as Box, has an icon and Add link.


This image shows the Personal Pages subpage under Pages in Spaces Administration pages. The label Personal Pages is highlighted and flanked by links to the Business Role Pages and System Pages subpages. Below this is a toolbar with controls for applying a temporary filter to the list of personal pages, creating a persisted filter, refreshing the list of personal pages, and accessing page help. Personal pages are listed in a table with the following columns: Name, Created By, Last Modified, and Actions. The Actions column provides menu icons to commands for acting on an individual personal page. A Page Actions menu is expanded, showing the options, Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The Copy Page option is called out.


This image shows the Spaces component Favorites Menu. It is a link with the link text, "Favorites." It is flanked by separators and additional Spaces components.


This image shows a Web Page layout component. It is bounded on the bottom and both sides with a dotted line. Its header includes the label, "Web Page," and Edit and Remove icons. The body of the component includes an image of the world and the text, "This is your web page."


This screen shot shows the Save menu item, with options to Save or Save As Template.


This image shows properties of an HTML Markup layout component in the Component Properties dialog. The dialog header contains an icon with the label, "Component Properties: New HTML Markup," and Help and Close icons. The dialog presents two tabs, Display Options and Style. The Display Options tab is forward. On it are checkboxes and fields for entering property values. These include, Escape, No Wrap, Short Desc, Value, and Show Component. The Value field is called out. Each property is followed by a menu icon for accessing the Expression Editor. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows a Resource Catalog, with the blog task flows available in the default Resource Catalog.


This image shows the Spaces component Template Development folder in a Resource Catalog. Along the top are controls for navigating within the Catalog and for searching and refreshing Catalog items. The body of the image shows the folders that contain Catalog items. The folders include such classifications as Alerts and Updates, Analytics, Content Management, and the like. The Template Development folder is highlighted. To the right of each folder is an Open link, which you can use to access folder content.


This image shows the Select a Page dialog. The header contains an icon with the label, "Select a page," and a Close icon. Below the header, to the right is a Search field and icon. Within the body of the dialog is a list, headed, "Home Space Pages," with entries for all available pages in the Home space. At the bottom of the dialog are Select and Cancel buttons. The Select button is grayed out.


This image shows a task flow being dragged to a new position above another task flow. Below the dragged task flow is shadow, indicating an available drop location.


This image shows the list of all the spaces of which a user is a member.


This figure highlights the Show documents, Show wiki pages, Show blogs, and Show discussion topics checkboxes in the Display Options dialog for the Similar Items task flow.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. The Design option on the View menu is called out. A blue dot indicates that Design view is the current selection. In the page body, controls for adding content, creating layout boxes, and editing layout box properties are also called out.


This figure shows the Edit Navigation Item - Pages Query dialog with the fields completed as indicated in the previous steps.


This figure shows the Layout tab that displays after you have selected the Form layout style on the View tab. Here you can specify the form style (vertical or horizontal), and also the column layout.


This image shows a detail of a Spaces application page. At the top is a Search field and icon, a Current User Profile spaces component for the user, Josie Smith, a Spaces Switcher spaces component, and a Favorites menu. The mouse pointer hovers over the Current User Profile user's name and shows the tooltip, "Josie Smith." The user name is called out.


This figure shows the Custom HTML field of the Parameter Form Layout tab, where you can create a customized parameter form or edit an existing parameter form.


This figure shows the page templates available at the application level. The page template named MySpaceTemplate, which is a hidden resource, is not shown in this list.


This figure highlights the Show items I have worked on before checkbox in the Display Options dialog for the Similar Items task flow.


Links icons on the Documents' service Rich Text Editor.


This image shows the Spaces component. It is a link with the link text, "Manage Pages." It is flanked by separators and additional Spaces components.


The image shows the Edit dialog with the Add menu clicked to display the Folder, Component, and Add From Library options. The Add From Library option is highlighted with a red border.


This image shows a page in edit mode. Below the page status, "Editing Page: Task Flow Editor," the View menu is expanded. It shows the options Design, Source, and Source Position. The Source option is called out.


This figure provides and overview of the structure of the navigation within the AviTrust Employee Portal.


This figure shows the sample banking application navigation model displayed as a tree with the List style where the top-level nodes are folders.


This image shows the Spaces component Self Registration. It is a link with the link text, "Register." To the left of it are separators and additional Spaces components and a Search field and icon.


This figure shows a default wiki document created using the Wiki page style. The New Wiki Document action is highlighted on the wiki page's menu, which is accessed by clicking the arrow next to the wiki page's name in the breadcrumbs.


This figure highlights the Number of people field in the Display Options dialog for the Recommended Connections task flow.


This graphic shows the Polls Manager, with the Create Poll icon and the Refresh icon highlighted.


This image shows the Component Properties dialog for a Box layout component. The header contains an icon labeled, "Component Properties: Box," and Help and Close icons. The dialog shows two tabs, Display Options and Style. The Display Options tab is forward. On it are fields, checkboxes, and selection lists for providing values for Display Option properties. Next to each property is a menu icon. The menu next to the property Show Component is expanded to show the option Expression Builder. The mouse pointer hovers over this option, and the Show Component property and the Expression Builder option are called out. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This graphic shows the Recent Activities option selected in the Add Resource Catalog Item dialog.


This figure shows a part of the Find a Web clipping page. In the URL Location field, the URL http://www.oracle.com/appserver/index.html is entered.


This screen shot shows a Search Results like that has items with the following custom attributes listed: DocumentName, DocumentType, FileName, DocumentID, and CreatedOn.


This image shows the Component Properties dialog for an Announcements task flow. It shows five tabs, Parameters, Display Options, Style, Content Style, and Events. The Parameters tab is forward. It contains checkboxes and fields for entering parameter values. Parameters include:

	
Expand All Announcements in Extended Mini View


	
Number of Expanded Announcements


	
Content View Only


	
Hide Toolbar


	
Navigate to Announcement Viewer


	
Number of Announcements on Extended Mini View


	
Forum ID


	
Announcement Length


	
Number of Announcements to show




At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows a page for creating a blog post, with the various RTE icons displayed. The Publish option (on the Preview tab) is selected by default for the blog post.


This screenshot shows the Columns page in the Create Table dialog.


This image shows a page in edit mode Design view. At the top is a status message, "Editing Page: Activities." Below the status message, is the View menu, a Page Properties button, a Help icon, and Save and Close buttons. In the page body are two layout boxes, vertically aligned, each with Add Content buttons and icons for adding more layout boxes above, below, and left or right of the current layout box. Additionally, there is an icon for editing box properties. Both layout boxes contain content: the first shows the Publisher task flow; the second shows the Activity Stream.


This image shows the Advanced Search dialog. The header contains an icon labeled, "Advanced Search," and a Close icon. Below the header are the fields File Name and Keywords a menu labeled Content Type, and a counter widget labeled Limit Results. Below these are three sections, labeled Dates, Users, and Additional Query Filters. At the bottom of the dialog are Search and Cancel buttons.


This figure shows the sample banking application navigation model displayed as a tree with the start path set to the first level (Personal Banking) of the path to the currently selected page (Current Account).


This screen shot shows the Tag Center, with 3 panes: a Tag Cloud listing tags applied to the spaces page, Refine Tag Results, and tagged items.


This figure depicts the Mail task flow in which one mail is displayed as a link as the mouse pointer hovers over it. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This image shows the Select Document dialog. The header contains the label, "Select Document," and a Close icon. Below the header is a navigation icon, the icon and display name for the parent folder, a Filter field and icon, followed by an Advanced link. The body of the dialog provides a list of folders and files contained within the parent folder. At the bottom of the dialog are Select and Cancel buttons. The Select button is grayed out.


This figure shows the page http://www.oracle.com/appserver/index.html displayed in Web Clipping Studio.


The image shows the Add Resource Catalog Item dialog. This dialog has two panes. The left pane lists the various folders containing resources, for example, Business Mashups, All Documents, Spaces Components, Components, and Saved Searches. The Components folder is selected in this list to display its contents on the right pane. The dialog displays a Search field at the top right corner, a Name field at the bottom left corner, and Add and Cancel buttons at the bottom right corner.


This figure depicts the Display Options tab in the Component Properties dialog that is displayed when you edit or view the properties of an External Application task flow.


This image shows the System Pages subpage under Pages on a space Settings page. The mouse pointer hovers over a Customize link next to the Task Flow Editor page, and shows the hint text, "Customize the Task Flow Editor page using the Oracle Composer."


This screen shot shows the Search task flow Parameters dialog box.


This figure shows the space administration General page, highlighting Enable RSS Publishing checked.


This figure shows the Parameters tab in the Component Properties dialog of a Blog Viewer task flow. The tab contains the following properties, which are unique to a blog: Hide Comments, Filter Month, Number of bolg posts displayed, Resource Id, Filter Year. The Resource Id field shows the resource ID of the folder with which the blog is associated.


This screenshot shows the expression Editor with a Personalization EL.


This figure shows the Component Properties dialog for the Notes service task flow.


This figure depicts the Find User icon.


This figure shows the Target tab of the Edit Navigation Item - Spaces Query dialog.


The figure shows the custom display template selected in the Template drop down menu in the Template tab of the Content Presenter Configuration window. A Site Studio region template is selected.


This figure shows the Set Page Defaults dialog, where you can set the Default Scheme, Style, Scheme Background Color, and select whether or not to Always Use Page Defaults.


This image shows the Spaces component Global Help. It is a link with the link text, "Help." It is flanked by separators and additional Spaces components.


This image calls out the Show Hierarchy icon to the left of a zoomed-in task flow (labeled "region").


This figure depicts a mail window with the attachments highlighted. A toolbar at the top of the window contains Reply, Reply All, Forward, Compose, and Delete buttons. Below this are prepopulated rows labelled Subject, From, Date, To, and Attachment. The Attachment row contains two text files and one HTML file. A text area in the lower half of the window contains the actual mail message.


This figure shows the top portion of the space administration Custom Attributes page, showing the Add Attribute icon and link.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Sales." Below the message are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste buttons. In the body of the page is a hierarchical list of page components, including panelGroupLayout: scroll, Box, tableLayout, rowLayout, and the like.


This figure shows the Setup step of the Create a Space Template dialog, displaying the Space Template Name and Description fields.


This screen shot shows the Discussions - Popular Topics task flow at run time, with 3 topics listed.


This screen shot show the Choose from Template dialog, with the template named "What incentives do you like" selected?


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with a Create Page link, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Home). It shows the options, Edit Page, Reset Layout, Copy Page, Rename Page, Set Page Access, Delete Page, Add to Home Space, Send Mail, and About This Page. The option Rename Page is called out.


The image shows a table with two columns, METRIC and VALUE. The METRIC column displays the page category and the VALUE column displays the page count for each category.


This figure shows a list of all the wiki documents available with the current wiki page.


The image shows a task flow with MyInsertOrUpdate and MyQueryById buttons at the top. Below these buttons is the table displaying records from the data source. Below the table are five fields. The first field has a red border around it and has a description that says it is used to query the data source. The remaining fields are enclosed in a red border and the description for this red box says that the fields are used to update records.


This figure depicts the Login to Mail link that is displayed in the Mail task flow when you add the Mail task flow to the page or use it for the first time. The task flow contains a single link with the text Login to Mail.


This image shows a detail of a page in edit mode Design view. At the top is the status message, "Editing Page: For Testing." Below that are the View menu and Page Properties button. Below these is a Box layout component with an Add Content button and a palette of controls for adding tabs, splitting the Box above, below, left, or right, and an Edit icon for accessing Box properties. The mouse pointer hovers over the Edit icon showing the tooltip, "Edit."


This image shows the Activity Stream - Quick View Configure dialog and the pencil icon one uses to open it. The dialog is divided into three sections: People, Spaces, and Service Categories. The People section provides a menu for selecting whose activities you want to see. The Spaces section provides a menu for specifying whether to see activities from spaces. The Service Categories section provides checkboxes for selecting the services from which to display activities.


This figure depicts the Announcements page, with the RSS icon highlighted.


This image shows the Select Custom Color dialog. It contains smears of graduated colors, running horizontally, bordered on the right by a slider for selecting a range of hues. Below these are fields for entering values for Hex, Red, Green, and Blue. Beside these fields are two stacked boxes, the top one showing the selected color and the bottom showing the current color. At the bottom of the dialog are the buttons OK and Cancel.


This figure shows the RSS 2.0 and Atom 1.0 news feed icons displayed against the Lists service for all lists.


This figure shows the sample banking application navigation model displayed as a menu with the Menu style.


This figure shows a blog containing two blog posts. The name of the blog is listed on the top navigation bar. The Archive pane displays that the blog contains two blog posts for the month of September.


This figure shows the Link to New menu open in the Links dialog of a discussion topic. The Note option is highlighted.


This figure highlights the Do not show this person icon next to a user in the Recommended Connections task flow. The icon looks like a small red cross.


This graphic shows the Design page of the Polls Manager, with options to Add, Save, or Close.


This image shows a detail of a Self-Registration page. To the left is an image of a figure standing before a door. To the right of the figure is the heading, "Self-Registration," followed by these fields: Choose a User Name, which is next to the button, "Check User Name Availability"; Choose Password; Re-enter Password; First Name; Last Name; and Email Address. Below the Email Address field is a Register button.


This image shows a page in edit mode Source view. The mouse pointer is depressing an Add Content button, and the hint text, "Add content into the selected component," is shown. In the hierarchical list of page components, the component showDetailFrame is selected. In the WYSIWYG portion of the page, a layout box (that is, the showDetailFrame component) is outlined in dark blue.


This figure depicts the Last Modified Date box on the Search Results page or window. It contains a list of links to assorted time ranges. These include Today, Since Yesterday, Since 7 Days Ago, and so on. Each time range includes a number in parenthesis. The number indicates how many results fall within the specified range.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with a Create Page link, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Discussions). It shows the options, Send Mail and About This Page. The option Send Mail is called out.


This image shows a page in edit mode Source view. The component "menu:Everyone" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of Everyone," is shown.


This figure shows the sample banking application navigation model displayed as a tree with the start node (Current Account) displayed as the header of a box surrounding the rest of the navigation.


This image shows a page in edit mode Design view. The mouse pointer is depressing an Add Content button, and the resulting Resource Catalog is open. The Resource Catalog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Top"), a Search field and button, and a Refresh icon. The dialog lists various resource folders, such as Alerts and Updates, Analytics, Content Management, and so on. Each folder has an associated icon and Open link.


This graphic shows the Copy - Page Template dialog, with the Display Name and Description parameters.


This image shows the Create dialog. It has a required field labeled "Page Name." It provides a mixed selection of page styles, in this example: Blank, Blog, Home Page, Left Narrow, Right Narrow, Three Column, Web Page, and Wiki. The bottom of the dialog shows the buttons Create and Cancel.


This figure depicts the service nodes in a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node. The Discussions node is expanded and a recent Discussion is displayed as a link as the mouse hovers over it.


This screen shot shows the reply to a topic, with the breadcrumbs from spacesearch (forum) > QA Issues (topic).


This image shows the Spaces component Create Subspace. It is a link with the link text, "Create a Subspace." To the right of it are separators and the Create Space and Copyright Message components.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. The Reorder column is called out.


This figure shows an example of a portlet using the disc bullet layout.


This screenshot shows the Table option available on the context menu of the Add button for a data control accessor.


This image shows the System Pages subpage under Pages in Spaces Administration pages. The label System Pages is highlighted and preceded by links to the Business Role Pages and Personal Pages subpages. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over the Customize link next to the Task Flow Editor system page, and shows the hint text, "Customize the Task Flow Editor page using the Oracle Composer."


This figure shows the panel for creating a new note.


This figure depicts the Upload Document pane. It contains an area to drag and drop files, or Select files. The pane header includes Upload and Cancel buttons. Also shown is an Upload Profiles selection list , where you can optionally select a content type profile to specify additional properties for the document(s) as defined by the profile


This image shows the Expression Builder editor. The option "Choose a value" is selected. Under that are two menus, side-by-side. "Page Info" is selected from the first menu, and "Title" is selected from the second. In the text box below "Type a value or expression," the EL expression #{pageDocBean.title} appears.


This image shows a Hyperlink layout component inside a Box in page edit mode. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is the link text, "Click edit icon to define hyperlink." To the right of this text is a floating tool palette with three icons. The first is a handle for grabbing and moving the component, the next is an Edit icon, the last is a Delete icon. The mouse pointer is hovering over the link text to invoke the floating palette.


This screen shot shows the Edit Resource Catalog Item dialog for the Search task flow. On the Target tab, the descriptions Search Space has been added to the Description parameter.


This figure depicts a forwarded mail message window. There is a field labelled To with a Find User icon. Another field below these is labelled Subject and is already populated with the subject of the mail you are forwarding. Below the Subject field, a text document is listed as an attachment. A Remove Attachment icon is displayed adjacent to the file name. A text area in the lower half of the window contains the forwarded message. The bottom-right corner contains Send and Close buttons.


This image shows the Business Role Pages subpage under Pages in Spaces Administration pages. The label Business Role Pages is highlighted and followed by links to the Personal Pages and System Pages subpages. Below the subpage name is a toolbar with links for creating new business role pages (BRPs) and setting page creation defaults. The Set Page Defaults link is called out.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Make Public is called out.


This figure depicts the Advanced Search dialog in a Documents service task flow. The fields in this dialog are File Name, Keywords, Look In, Content Type, Limit Results, Dates, Users, and Additional Query Filters..


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Tag Center). It shows the options, Send Mail and About This Page. The option About This Page is called out.


This figure shows the Edit Navigation Item - Link dialog with the fields completed as indicated in the previous steps.


The image shows the Edit dialog with Add, Edit, Copy, Delete, Indent, Outdent, Up, and Down icons at the top of the dialog. The dialog lists the components in the catalog. In this image, the Portlets resource is selected. It is nested inside the Portlets folder and has an Administration resource above it, at the same level. As there is no resource below the Portlets resource, the Down option is grayed out. All other options are active.


This image shows a task flow being dragged to a new position above another task flow. Below the dragged task flow is shadow, indicating an available drop location.


This figure shows the Cancel Filter icon.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Navigation Reference menu option is selected.


This screenshot shows the Customize Search Service task flow, showing ways to edit saved searches and the ability to remove services, such as People or Personal Events, from searches.


This figure shows the Create New Skin dialog, with the Fusion FX built-in skin selected in the Copy from list.


This screen shot shows the Edit Resource Catalog Item dialog for the Search task flow. On the Options tab, the values in the text have been added to the New Attribute Name and New Attribute Value parameters


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Content Item menu option is selected.


This screen shot shows an open discussion topic with the Send Mail icon highlighted.


This figure shows the space administration General page Self-Subscription / Change Membership section, showing Select Roles Available on Self-Subscription and Change Membership checked, displaying a table of all available roles, each providing check boxes to Enable and/or specify Approval Required for Self Subscription and for Change Membership.


This screenshot shows the External Applications > Register button in the Configuration page.


This figure shows the sample banking application navigation model displayed as a tree with icons appearing next to each item in the tree.


This figure shows the Create New Page Template dialog


This figure shows a side navigation page template dynamically applied when any user other than a space moderator logs in to Spaces.


This figure depicts an Announcements task flow, with the RSS icon appearing on the right.


This figure depicts the Compose window with the Attach Files link highlighted. Below is a field labelled To with a Find User icon. A text area to contain the actual message is available in the lower half of the window. Send and Close buttons are at the bottom-right corner of the window.


This screenshot displays the Register External Application page.


This figure shows the Expression Builder dialog. The Type a value or expression radio button is selected and an expression builder statement for applying a page template based on the user role is shown.


This figure shows a portion of the Roles page for a space, showing Edit Permissions and the Public-User role selected.


This figure shows the Display Options tab in the Component Properties dialog that is displayed when you edit or view the properties of a Producer Registration task flow.


This figure shows the options that display on the Layout tab when the News layout style is selected on the View tab. Two sections display: News style (plain, logo, or scrolling) and Column Layout.


This graphic shows the Recent Activities option selected in the Add Content dialog.


This image shows the Parameters tab of the Component Properties dialog. It lists parameters associated with the Activity Stream task flow. Parameters appear in the following order: Advanced Query, Enable Context Info, Hide Comments, Hide Configuration Button, Hide Inline Preview, Hide Like, Hide Share, No of activities to display per page, Pagination, Profile Only, Resource Id, Service Categories, and Spaces. Other tabs include Display Options, Style, Content Style, and Events. At the bottom of the dialog three buttons appear: Apply, OK, and Cancel.


The image shows a table with columns ENAME, EMPNO, and DEPTNO. The table displays three records. A field below the table is populated with the value MANAGER. A Go button is displayed to the right of the field.


This screen shot shows "vicki" in the search area, with 2 results returned: vicki and vicki_coi. The user vicki coi is selected, so her title, business and email information is included in the page.


This image shows the Spaces component Home Space. It is a link with the link text, "Personal Space." To the right of it are separators and additional Spaces components.


This image shows the Spaces component Print Preview. It is a link with the link text, "Print Preview." To the right of it are separators and additional Spaces components.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu are current links, each followed by Configure and Delete icons. The Configure and Delete icons are called out.


This figure shows the space administration General page, highlighting Take Space Temporarily Offline cleared.


This figure shows the Create dialog for a page template.


This image shows the Spaces component Subscription Preferences. It is a link with the link text, "Subscribe." It is flanked by separators and additional Spaces components.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. The View menu is called out. A blue dot indicates that Source view is the current selection. On the line below the View menu is a toolbar with controls for editing, deleting, cutting, and pasting page components. The toolbar is also called out.


This screenshot shows the Application Navigator option selected in the Add Content dialog.


This image shows the Edit Source dialog of a page style. The EL for controlling access to Source view of Composer is highlighted.


This figure depicts the Parameters tab in the Component Properties dialog that is displayed when you edit or view the properties of a Recent Activities task flow. This tab contains the Shortest Time Period, Long Time Period in minutes, Longest Time Period in minutes, Medium Time Period, and Group Space fields in which you can enter or update parameter values. Edit icons available next to each field can be used to invoke the Edit dialog if you wish to select a listed value or construct your own value or EL expression.


This figure depicts the Mail task flow where the region parameter, Tabular, is set to true. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. The table of mails below the toolbar displays the columns Subject, User Name, and Date.


This figure shows the Filter tab of the OmniPortlet wizard, where you can specify sorting options. On this page, you can sort the data you retrieved on the Source tab.


This figure shows the Create New Navigation dialog.


This figure shows the sample banking application navigation model displayed as a tree with the start node not displayed.


This image shows the Spaces component Page Links. It is an icon and a link with the link text, "Links." It is flanked by separators and additional Spaces components.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. In the Name column, the page, "Documents," is called out. The mouse pointer hovers over the Documents page with the hint text, "Click to open the page."


This image shows the Resources page in Spaces Administration Pages. To the left are categorized lists of resources. The following categories are shown: Structure, Look and Layout, and Mashups. Under each category is a list of resources. The resource Page Styles is selected under the Look and Layout category. To the right, all application-level page styles are listed in a three-column table. The first column shows whether the style is hidden or shown (Available), the second column shows the page style display name and description, the third column shows the user who last modified the page style and the date and time the page style was modified.


This figure depicts the Refresh icon on a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This figure highlights the Show spaces I have worked on before checkbox in the Display Options dialog for the Similar Spaces task flow.


This image shows the Personal Pages subpage under Pages in Spaces Administration pages. The label Personal Pages is highlighted and flanked by links to the Business Role Pages and System Pages subpages. Below this is a toolbar with controls for applying a temporary filter to the list of personal pages, creating a persisted filter, refreshing the list of personal pages, and accessing page help. Personal pages are listed in a table with the following columns: Name, Created By, Last Modified, and Actions. The Actions column provides menu icons for accessing commands for page actions. A Page Actions menu is expanded, showing the options, Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page.


This image shows the System Pages subpage under Pages in Spaces Administration pages. The label System Pages is highlighted and preceded by links to the Business Role Pages and Personal Pages subpages. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over a Restore Default link next to the Activities page, and shows the hint text, "Remove all Activities page customizations."


This figure shows the Edit dialog of a Resource Catalog open. The Add From Library option is highlighted on the Add menu.


This figure shows the Create Event dialog as seen when creating a space event. It displays three sections: a section for entering the meeting title and location; a Time section for entering start and end times or indicating this is an all day event; and an Options section for assigning a priority, selecting a category, and entering additional details.


This figure shows the Download dialog containing the options that you can use for downloading your resource's EAR file.


This figure shows the section of the Source tab where you can set the connection information and the portlet-level parameters. There is an Edit Connection button you click to specify connection information.


This image shows the Spaces component Tags. It is an icon and a link with the link text, "Tags." It is flanked by separators and additional Spaces components.


This image shows the Spaces component Spaces Switcher. It is a drop-down menu labeled, "Spaces." It is flanked by separators and additional Spaces components.


This screen shot shows the page template being edited, with the View - Source menu selected.


This figure shows the Create a Space dialog with fields to enter a Space Name, Description, and keywords that can be used to search for the space.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component "region" is called out along with the Edit Task Flow link to its right.


This figure shows the target web page divided into sections. Each section contains a Choose icon in the upper-left corner.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Set Page Access is called out.


This figure shows a Source tab that displays when you select XML on the Type tab. On this page, you can enter the URL to the XML, the XSL filter, and the URL to the XML Schema. Additionally, Test buttons enable you to text your XML URL and XSL Filter URL.


This screenshot shows the OWSM Security page of the Create new Data Control dialog.


This graphic shows the Analyze page of the Polls Manager, showing a graph of the results.


This image shows the Spaces component Login. It is a link with the link text, "Login." To the left of it are separators, additional Spaces components, and a Search field. To the right of it is the Spaces component Self Registration (Register).


This figure shows the details of a note that you can update.


The image shows the Target Tab on the Edit Resource Catalog Item Dialog. The dialog contains two other tabs, Options and Parameters. The Target tab displays the Name, Description, Visible, and Path attributes.


This figure shows the Expand icon in the RSS Manager.


This figure shows the Mail service selected and the Distribution List Settings section, with an entry field for Distribution List.


This image shows the Expression Editor. In the header, it is labeled Expression Editor and provides a Help icon and a Close button. Two options are listed, "Choose a value," and "Type a value or expression." Below "Choose a value," are two menus, side-by-side. The first provides a selection list of categories from which to choose EL expressions (ELs). The second provides a selection list of expressions related to the selected category. Below "Type a value or expression," is a text entry field for entering an EL. At the bottom of the dialog are Test, OK, and Cancel buttons.


This graphic shows the Recent Activities task flow added in the custom Resource Catalog.


This figure depicts the RSS link at the bottom of the Spaces application.


This figure depicts the Compose icon on a Mail task flow. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This figure shows an email notification sent for a space event. The email client (Microsoft Outlook) supports iMIP, so the email includes options for accepting or declining the event, proposing a different time for the event, and viewing the local Outlook calendar.


This figure shows the Source tab that displays when you select Web Service on the Type tab. On this page, you can enter the URL for the WSDL, choose the method you want to use, and the URLs to the XSL filter and XML schema.


This image shows a Box layout component. To the left is an Add Content button. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The Add Content button is called out.


The image shows the Options Tab on the Edit Resource Catalog Item Dialog. The dialog contains two other tabs, Target and Parameters. The Options tab displays the fields Small Icon URI, Subject and Keywords, WEBCENTER_SERVICE_ID, attr.text, attr.contentStyle, New Attribute Name, and New Attribute Value. An Add button is available next to the New Attribute Value field.


This figure shows the Lists news feed, which displays the list title that is hyperlinked.


This image shows the Spaces component list of Spaces components that are available in the Add Resource Catalog dialog. On the left, a list of object types is shown. These include such objects as Runtime Data Controls, Business Mashups, and Spaces Components. Spaces Components is selected. On the right, a list of Spaces components are shown.


This image shows the Spaces component Mail Space Moderators. It is an icon and a link with the link text, "Send Mail to Moderators." To the right of it are separators and additional Spaces components.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Spaces Query menu option is selected.


This figure shows the Notes task flow added to a custom Resource Catalog.


This screen shot shows the Discussions - Watched Forums task flow at run time, with 7 forums listed.


This screenshot shows the Personalize Applications dialog.


This figure shows the Spaces page with the Show menu exposing the selections: All Spaces, Joined by Me, Moderated by Me, and Closed Spaces.


This figure shows the contents of the Spaces Default Navigation Model.


This screenshot shows the Add Resource Catalog Item dialog with the Application Navigator option selected.


This image shows a Box layout component on a page in edit mode. It is bounded on all sides by a dotted line. Inside the Box an Add Content button is shown to the left. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; editing Box properties; and deleting the Box.


This figure shows the application-level Resources page open in Spaces Administration. Under the Skins resource, the Fusion FX skin is selected.


This screen shot shows the General page of space administration settings, with the new Resource Catalog selected for the Resource Catalog for Pages parameter.


This figure shows the icons that are located on the top right of the Web Clipping Studio banner. These are:

	
Cancel


	
Section


	
Select


	
Help




The cursor is positioned on the Section icon.


This figure depicts the Lists task flow, with the RSS icons being called out. The page displays a Lists pane on the left with an RSS icon in the right pane for the selected list.


This image shows a Box layout component on a tab labeled, "New Tab." The Box contains a Quick Poll task flow. Above the task flow are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The Box Edit icon is called out.


This screen shot shows how topics display in the Discussions - Popular Topics task flow. This is a separate window with the topic and replies to that topic. There are no breadcrumbs. It has buttons to Maximize or Close the window.


This figure shows the Wiki page style highlighted in the Create dialog.


Yahoo presence online Yahoo icon


This figure shows the contents of the Spaces Administration Options navigation model.


This image depicts a page in edit mode Source view. At the top is a status message, "Editing Page: For Testing," Below that are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste controls. The Add Content button is called out and the mouse pointer hovers over it, showing the tooltip, "Add content into the selected component." In the hierarchical list of page components, a Box layout component is selected. Below the list is a band illustrating the pathway to the current selection. In the WYSIWYG portion of the page, the selected Box is outlined in blue. The selected Box is called out.


This image shows the Tabs tab for a Box layout component in the Component Properties dialog. The dialog has four tabs, Tabs, Child Components, Display Options, and Style. The Tabs tab is forward. The Tabs tab is divided into two columns. In the left column is the label, "Reorder the tabs," which shows a list of all tabs in the current tab set and icons (to the right) for reordering tabs. On the list is one tab, "New Tab." Below the list are an Add Tab button followed by a grayed out Delete Tab button. In the right column are fields and checkboxes for configuring the tab. They include Text, Icon Location, Short Description, Stretch Contents, and Hide this tab. In the left column, the Add Tab button is called out.


This figure depicts the RSS Manager displaying nodes for all spaces that have enabled RSS feeds. A space node is expanded to display a list of all services that have RSS feeds enabled. To the right of the service names are two columns displaying corresponding RSS 2.0 and Atom 1.0 news feed icons.


This figure shows the Copy dialog of a skin.


This figure illustrates search results displayed in the Web Clipping portlet.


This figure shows the spaces link highlighted on the Spaces banner, and on the top navigation bar of Home space.


This figure shows the Find a Web clipping page. In the Properties section, URL Rewriting is specified to be Inline and Title is specified to be OTN Search.


This image depicts configuration settings for the People Connections service in a Spaces application. The cursor points to the People Connections link on the Services subpage of the Configuration page in Spaces Administration pages. To the right are five settings tabs: Activity Stream, Connections, Profile, Message Board, and Feedback. The Connections tab is forward, presenting options for specifying whom to grant view access, whether users can override this setting, and whether all invitations to connect should be accepted automatically.


This image shows the Spaces component Add to Favorites. It is a link with the link text, "Add To Favorites." To the right of it are separators and additional Spaces components.


Yahoo presence offline icon


This figure shows the Edit Source dialog for a page template.


This screen shot shows the Create New Page dialog, with the Page Name parameter filled in with New Page and the Blank Page Style selected.


This figure shows the Parameters tab open in the Component Properties dialog of an RSS task flow.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. A blue dot indicates that Source view is the current selection. Source Position is expanded, showing the options, Top, Left, Right, and Bottom. A check mark indicates that Right is the current selection. The hierarchy of page components is shown on the right side of the page.


This figure depicts the time-range options in a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This figure shows the Recent Activity service highlighted on the RSS Manager page in Spaces. To the right of the Recent Activity service name are the RSS 2.0 and Atom 1.0 news feed icons.


This image shows an Announcements task flow. The header contains a Collapse icon and the heading, "Announcements." The Collapse icon is called out.


This screenshot shows the Save Download to Server dialog.


This image shows the Set Page Defaults dialog. The dialog provides a Page Style selection menu and radio buttons for specifying whether to enable one-click page creation. It also provides Save and Cancel buttons.


This figure depicts a Worklist notification window that displays the notification creation date and the complete message for an item selected in the Worklist task flow. An Acknowledge button is available at the top-right corner that you can use to respond to the notification.


This figure highlights the Number of Spaces field in the Display Options dialog for the Similar Spaces task flow.


The Mail task flow Component Properties dialog, showing the Tabular parameter.


This image shows Movable Box layout component display options in the Component Properties dialog. There are three tabs, Display Options, Style, and Content Style. The Display Options tab is forward. It has two subtabs, Basic and Advanced. These are called out. The Basic subtab is forward. It contains menus and fields, including Text, Short Desc, Chrome Style, Font Color, and the like.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Content Query menu option is selected.


This figure shows the Spaces Administration, with the Roles page under the Security page as open. The Manage All permission for Application is highlighted for a role.


This figure depicts the Group By list in the Display Options dialog box with the Category, Create Date, Due Date, Expiration Date, Not Grouped, Priority, and Worklist Server options.


This figure shows the About dialog of a custom skin, with the various details about the skin listed in the General, Exclude Resource Usage, and Attributes sections.


This image shows the Set Page Access dialog. It lists the page name, below which are the Add Access and Delete Access options. Below these are the Add Authenticated Access and Add Public Access options. Below these is a small table with two columns: Role or User and Page Access. Page Access has five subcolumns, each with an icon that depicts a type of access permission: glasses for View Page, a wrench for Edit Page, an ex for Delete Page, a wrench over a cascade of pages for Perform All Page Actions, and a pencil for Personalize Page. The dialog also provides a Help icon at the top and OK and Cancel buttons at the bottom.


This figure shows the Target tab of the Edit Navigation Item - Link dialog.


This image shows the Page Properties dialog for a page in a space. The header contains an icon labeled, "Page Properties," and Help and Close icons. The dialog has three tabs: Display Options, Security, and Parameters. The Security tab is forward. At the top of the Security tab are Access Method options: Use Application Permissions and Use Custom Access Settings. The Access Method options are called out. All of the controls below Access Method options are grayed out. Below Access Method options are the controls Add Access and Delete Access. Below these are the controls Add Authenticated Access and Add Public Access. These are followed by a two-column table, with column headings Role or User and Page Access. The Page Access column is subdivided into five columns, each headed with an icon, View Page (glasses), Edit Page (wrench), Delete Page (ex), Perform All Page Actions (cascade of pages topped with wrench), Personalize Page (pencil). The table shows the text, "No access defined." At the bottom of the dialog are OK and Cancel buttons.


This figure shows the Attributes section of the Edit Properties dialog of a resource. The various attributes associated with the resource and their values are displayed.


This figure shows the Delete the Space menu item for a space.


This figure highlights the Show items I have viewed before checkbox in the Display Options dialog for the Similar Items task flow.


This image shows the DIT tree in an LDAP browser. To the left, the DIT tree is expanded to show the succession of nodes described in the preceding bullet list. To the right is the detail associated with the selected user (user1). Details include an Attribute Descriptions column and a Values column.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Delete Personalization, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Copy Page is called out.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. The View menu is called out. A blue dot indicates that Design view is the current selection.


The image shows the Add Content dialog that displays a list of all components that you can add to a page.


This screen shot shows the Copy - Default Space Catalog dialog, with parameters for Display Name and Description.


This figure shows the sample banking application navigation model displayed as a tree with the List style where none of the top-level nodes are folders.


This figure shows the permissions available for Resources in the Standard Permission Model. The Create, Edit, and Delete Resources permission is shown as selected.


This figure shows the space administration Pages page, showing a list of pages within the space. A toolbar at the top of the window contains buttons for creating new pages, setting page defaults, a Filter field, a Filter icon, and a Refresh icon. The table of pages below the toolbar displays the columns Name, Reorder, Show Page, Created By, Last Modified, and Actions.


This image shows a page in edit mode Design view before a page header or footer is added. The page is based on the page style Three Column. Accordingly, it has three layout boxes laid out horizontally. Each layout box has its own Add Content button and icons for adding tabs and more layout boxes as well as an icon for customizing the layout box through its properties.


This image shows an Activity Stream - Quick View task flow. At the top is a header with a Collapse icon and the heading, "Activity Stream - Quick View." To the right of the heading is a Remove icon. The Remove icon is called out. The mouse pointer hovers over the Remove icon with the hint text, "Remove."


This figure shows a part of the Edit Permissions dialog for a role in an Advanced Permission model. The permissions that can be assigned for pages in a space are listed. These include: Create, Edit, and Delete Pages, Create Pages, Edit Pages, Delete Pages, Customize Pages, and View Pages


This figure shows an example of an OmniPortlet using the tabular layout.


This image shows the Set Page Access dialog. It lists the page name, below which are the Add Access and Delete Access options. Below these are the Add Authenticated Access and Add Public Access options. Below these is a small table with two columns: "Role or User" and "Page Access". Page Access has five subcolumns, each with an icon that depicts a type of access permission: glasses for View Page, a wrench for Edit Page, an ex for Delete Page, a wrench over a cascade of pages for Perform All Page Actions, and a pencil for Personalize Page. The text, "No access defined" appears below the table. OK and Cancel buttons appear at the bottom.


This image depicts the application-level configuration options associated with Activity Stream. The Activity Stream tab is divided into the following sections: People, Spaces, Service Categories, Privacy, and Comments and Likes. Under each section are options for specifying whose activities to stream (People), whether to stream activities from spaces or just the Home space (Spaces), the services from which to stream activities (Service Categories), the users who are allowed to view the current user's activities and whether it is allowed to override this setting (Privacy), and whether comments and likes are allowed on streamed activities (Comments and Likes).


The Tags icon


This screen shot shows the Flat mode highlighted on the a topic in the Discussion Forums task flow, where the reply is flush under the topic.


This image shows the Component Properties dialog for a portlet. At the top is the label, "Component Properties: portlet," and Help and Close icons. Below the header are the following tabs: Parameters, Display Options, Style, Content Style, and Events. The Events tab is forward. The dialog is divided in the middle by a dotted line. Above the line are two stacked fields, Events and Action. Below the dotted line are an Enable Action checkbox and the fields parameter1, parameter2, parameter3. Next to each parameter field is a menu icon. At the bottom of the dialog are the buttons Apply, OK, and Cancel.


This graphic shows the Polls Manager Task Flow Component Properties, with the Parameters page selected.


This figure shows the About dialog of a space-level skin, displaying various properties in the General and Attributes sections.


This figure shows the View tab of the OmniPortlet wizard, where you can specify sorting options. On this page, you can choose the header, footer, and layout style for your portlet.


This screenshot displays the new form you created in a task flow.


This screen shot shows a discussion forum opened from the Forums - Quick View task flow.


This image shows Box layout component display options in the Component Properties dialog. There are two tabs, Display Options and Style. The Display Options tab is forward. It contains menus and fields, including Allow Action, Horizontal Alignment, Layout, Short Desc, Show Split Action, Show Tab Action, Vertical Alignment, and Show Component.


This figure shows a Notes task flow containing various personal notes.


This screen shot shows the Remove Watch icon form a forum selected in the Forums - Quick View task flow.


This figure depicts the highlighted Refresh Worklist icon in the Worklist task flow. The task flow also provides the Display Options and Messaging preferences icons.


This figure shows the space administration settings Services page, showing configuration options for the highlighted Discussions service.


This screen shot shows the Recent Topics task flow, with the following four topics: Sales Issues, Development Issues, QA Issues, and Support Issues.


The image shows a pie graph with different colored sections representing the different page categories.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Sales." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. A blue dot indicates that Design view is the current selection. Next to the View menu is an Edit Properties button.


This graphic shows the Schedule page of the Polls Manager, with publish and close options.


This figure shows the Blog page style highlighted in the Create dialog.


This figure shows the Delete note icon highlighted in a Notes task flow.


This figure shows the Target tab of the Edit Navigation Item - Pages Query dialog.


This figure shows notes listed in a Notes task flow.


This image shows the Spaces component Contact Administration. It is a link with the link text, "Administrator." To the left and right are separators and additional Spaces components.


This screen shot shows the Hierarchical mode highlighted on the a topic in the Discussion Forums task flow, where the reply is indented from the topic.


This image depicts configuration settings for Message Board. The Message Board tab is divided into three sections. The first section (unlabeled) provides controls for specifying who can view and post messages on a user's Message Board. The section section, Additional Access Settings, provides controls for specifying who can edit or delete the messages they leave and who can delete or change the visibility of the messages they receive. The third section, Comments and Likes, provides checkboxes for allowing or prohibiting users from liking and commenting on individual messages.


This figure shows the space administration General page, highlighting Close Space checked.


This figure shows the directory structure of a blog in the document hierarchy on the Documents page. The blog's folder name is highlighted on the bread crumb, and the posts available in that folder are listed.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: For Testing." Below the status message are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, and Cut buttons. The mouse pointer hovers over the Edit button showing the hint text, "Show the properties of Box." In the hierarchical list of page components, a Box component is selected and called out.


This figure depicts an Announcement dialog displaying the announcement title and the complete content. The dialog has a Close button at the bottom-right corner.


This image shows the Page Properties dialog that was opened from a Home space page. The header contains an icon labeled, "Page Properties," and Help and Close icons. The dialog has three tabs: Display Options, Security, and Parameters. The Security tab is forward. At the top of the Security tab are the controls Add Access and Delete Access. Below these are the controls Add Authenticated Access and Add Public Access. These are followed by a two-column table, with column headings Role or User and Page Access. The Page Access column is subdivided into five columns, each headed with an icon, View Page (glasses), Edit Page (wrench), Delete Page (ex), Perform All Page Actions (cascade of pages topped with wrench), Personalize Page (pencil). The table shows one row. The first column has the entry, "weblogic"; the second column shows five checkboxes, with the fourth one, Perform All Page Actions, checked. At the bottom of the dialog are OK and Cancel buttons.


This image shows the Spaces component Current User Profile. In this example, it is a link with the link text, "Josie Smith." To the right of it are separators and additional Spaces components.


This figure shows the Target tab of the Edit Navigation Item - Navigation Reference dialog.


This figure shows an example of an OmniPortlet using a vertical form layout.


This image shows the Task Flow Editor system page in edit mode. A task flow labeled "region" is selected, and the mouse pointer is depressing the Reset Task Flow button in the toolbar.


This figure shows the Edit Navigation Item - Navigation Reference dialog with the fields completed as indicated in the previous steps.


This figure shows the Connection Information page for a SQL data source. Depending on the specified data type, the Connection Information page may include fields for entering the Connection Name, Username, Password, Connection String, and Driver Name for the connection. Additionally, you can use the Test button on this page to test the connection.


This image shows a portion of the Business Role Pages subpage under Pages in Spaces Administration pages. Business role pages (BRPs) are listed in a table with the following columns: Name, Reorder, Show Page, Created By, Last Modified, and Actions. The Reorder column provides icons for rearranging the order of BRPs. The mouse pointer hovers over an icon, and the hint text, "Move this page after the following page," is shown.


This graphic shows a sample Quick Poll, asking, "What percent complete is your project?"


This figure shows the application-level settings specified for various resources. The Expression Builder option for the Default Page Template field is shown as highlighted.


This figure shows the Expression Editor dialog with the path to the HR navigation model.


This figure shows a top navigation page template dynamically applied when a space moderator logs into Spaces.


This screen shot shows the Forums - Quick View task flow at runtime, with four topics: Sales Issues, Development Issues, QA Issues, and Support Issues.


This figure shows the Space Browser task flow.


This image depicts configuration settings for Feedback. The Feedback tab is divided into two sections. The first section (unlabeled) provides controls for specifying who can view and post Feedback and who can view Feedback left for others. The second section, Additional Access Settings, provide checkboxes for allowing or prohibiting users from deleting the Feedback they have left and changing the visibility of Feedback left for them.


This figure shows a preview of the main navigation model with the Human Resources and Banking navigation references expanded to show the contents of those embedded navigation models.


This graphic shows the Polls Manager in the page to create or edit questions.


This image shows the Spaces component Invite People as Connection. It is a link with the link text, "Invite People." It is flanked by separators and additional Spaces components.


This image shows the New Content Link dialog. Its header contains an icon with the label, "New Content Link," and a Close icon. Below the header is the text, "Enter the name and path of the content link." Below this text are two fields, Name and Path. To the right of the Path field is a Browse button. At the bottom of the dialog are OK and Cancel buttons.


This figure shows the Add Space dialog, with the various spaces available in the Spaces application listed.


This figure depicts the Display Options tab in the Component Properties dialog that is displayed when you edit or view the properties of a Worklist task flow.


This image shows the facets associated with a panelStretchLayout component. It is a rectangle divided into five labeled areas. The area Top spans the top of the rectangle. The middle area is divided into three unequal columns labeled Start, Center, End. The area Bottom spans the bottom of the rectangle.


This figure depicts the RSS task flow, with the mouse hovering over the Refresh icon at the top-right corner of the task flow. The Get the latest RSS data tooltip is displayed.


This task flow shows the new Resource Catalog, with the Search task flow included with the Default Resource Catalog.


This figure depicts the RSS Manager page of Spaces. The RSS 2.0 and Atom 1.0 icons available for the Announcements service are highlighted.


This figure depicts the Add Attachment window. To the left of the window is the File field with the Browse and Attach buttons adjacent to it. The bottom-right corner of the window contains Send and Close buttons. The lower half of the window contains the Attachments area. This area is empty as no files are attached as yet.


This figure shows page templates listed on the Resources page. The status of the page templates is highlighted, whether a page template is available or hidden.


This image shows a page with a header and footer. The header is a horizontally aligned Image, Separator, and Text component comprising a message from the space administrator. The footer is a Hyperlink component that provides a link for joining the space.


This figure depicts the mail message window. A toolbar at the top of the window contains Reply, Reply All, Forward, Compose, and Delete buttons. Below this are prepopulated rows labelled Subject, From, and Date. A text area in the lower half of the window contains the actual mail message.


This figure shows a blog post available under a blog's folder in the document hierarchy.


This image shows a detail of the Spaces page. At the top is an icon labeled, "Create a Space," and a Sort By menu with the selection, "Name." Spaces are listed in columns and rows. The context menu on the space, "Standards," is expanded, showing the options Manage Settings, Rename Space URL, Delete the Space, Contact, Membership, and About. A few options have an icon that indicates submenu items. These include Contact, Membership, and About. The About submenu is expanded to show the options About this Space, Similar Spaces, and Share Link. About this Space is called out.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu is the link, "Sales Figures," followed by Configure and Delete icons. The mouse pointer is hovering over the Configure icon with the hint text, "Configure."


This figure shows the Edit Source dialog for a skin, listing the various skin selectors.


This screenshot shows the Fields page in the Create Form dialog.


This figure depicts the Mail task flow with the mouse hovering over the Refresh icon.


This graphic shows the General page for creating a Quick Poll, showing fields for Name, Description, and Close After.


This figure shows the Layout tab that displays when the Chart layout style is specified on the View tab. Here you can specify the chart style (pie, bar, or line), the dimensions, the layout, and whether to execute an action when the chart is clicked.


This figure shows the contents of the Navigation with Blogs/Wikis/Lists navigation model.


This figure shows the administration pages of a space, with the Resources page open.


This figure shows the space administration Services page, showing a list of available services with check boxes to enable or disable.


This screenshot shows the External Application task flow in a page.


This figure depicts the Cancel button at the bottom of a forwarded mail message window.


This figure shows the Edit Properties dialog of an application-level task flow.
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